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Introduction

T-FLEX CAD is a parametric design and drawing system. T-FLEX provides high levels of drawing

flexibility and supports modifications of the drawings while maintaining constraints imposed by the

designer on the drawing elements. The unique parametric engine and a complete set of professional

tools for computer-aided design simplify the design work flow and speed up preparation of drawing

materials. T-FLEX CAD gives a designer a familiar feel of working with traditional paper and ruler

equipment.

Associative design driven by assigning and modifying variable parameters is the way to follow by all

design and drawing automation systems. The particular success of T-FLEX CAD is based, in the first

place, on the new paradigm of geometric modeling. This paradigm is about a new, deeper, level of

parameterization, compared to other systems. The idea of parameterization itself has nowadays

become a standard in CAD. By "parameterization" we usually mean a provision for a drawing

extensive reuse by means of modifying its parameters. Virtually all CAD vendors claim parametric

capabilities of their systems. However, these systems, originally introduced long before

parameterization was adopted, often use their legacy data structures that are inherently non-

parametric. This causes their solutions to suffer from ineffectiveness or limited range of applicability.

The T-FLEX CAD's revolutionary approach to the idea of parameterization and the fact that the

drawings are based on inherently parametric models provide a new dimension for parametric design.

Topics in this section:

· Conventions Adopted in the T-FLEX CAD Guidelines

· How to Use T-FLEX CAD Help

· Start Page

· Information About Protection Keys

Conventions Adopted in the T-FLEX CAD Help

The following standard conventions are adopted in this document:

Keys on the keyboard are highlighted in semi-bold font and angle brackets:

<Enter>, <Esc>

Keyboard shortcuts, which require to press buttons sequentially one by one, (hotkey sequences) are

shown in common angle brackets without any spacing between separate keys:

<3G>, <3RG>

Keyboard shortcuts, which require to press buttons simultaneously, (hotkey combinations) are shown

by addition of separate key designations:

<Alt>+<F4>, <Ctrl>+<Z>

Left mouse button click.

Right mouse button click.

Left mouse button double-click.

Mouse wheel scrolling

Mouse wheel click (middle mouse button)
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, 
Command icon

, , , Other icons (automenu options, command parameters etc.)

Names displayed in the T-FLEX CAD interface are highlighted in semi-bold font. It might be names of

commands (Extrusion, Line), dialog box buttons (OK, Cancel), various options (Select Faces, Object

Snap), input boxes (Length:, Angle:) etc.

File > Open… etc. – selection of a textual menu bar item File, followed by a pull-down menu item

Open….

A command can be invoked in T-FLEX CAD in several ways. There are three main ways: 

· typing hotkeys from the keyboard,

· clicking the command's icon on the ribbon or on a toolbar (depending on your interface

settings)

· using the textual menu.

Main ways of invoking the command are shown in a table view in the beginning of a command's

description. For instance, the Layers command's description begins with the following table: 
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Icon Ribbon

Edit > Document > Layers

3D Model > Style > Layers

Draw > Style > Layers

Assembly > Style > Layers

Sheet Metal > Style > Layers

Surfaces > Style > Layers

Weld > Style > Layers

Primitives > Style > Layers

Workplane > Style > Layers

Support Geometry > Style > Layers

Keyboard Textual Menu

<QL>,

<Shift>+<F5>
Customize > Layers

This means, the command can be invoked in the following ways:

· Press sequentially <Q> then <L>  keys on the keyboard;

· Press simultaneously <Shift> and <F5> keys on the keyboard;

· Select the Customize item in the textual menu and then select the Layers… command from the

drop-down list.

· Select the icon  in the corresponding toolbar.
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· Select the Layers command in the Document group in the Edit tab of the ribbon.

· Select the Layers command in the Style group in one of the following tabs of the ribbon:

3D Model, Draw, Assembly, Sheet Metal, Surfaces, Weld, Primitives, Workplane,

Support Geometry.

Commands may also be called from contextual menus or from the Dynamic Toolbar.

Select an element instruction in the manuals means placing the cursor over the element and pressing

left mouse button .

Select an icon, press an icon, select an input box, press a button instruction means placing the cursor

over the item (icon, input box, dialog box button) and pressing left mouse button .

Point at an element, point at an icon, point at a button means just placing the cursor over the item. 

Each command usually brings a list of options available under this command. An option is one

specific action performed within the command, as delete an element, select an element of a particular

type, switch to another mode, etc. 

Each option has a hotkey and an icon in the automenu.

Invoking an option using a hotkey might be different from using an automenu icon. Using a hotkey

instantly invokes the action, while selecting an icon may work in two ways.

First possibility – an instant action occurs, as, for instance, when specifying parameters of an element -

.

Second possibility – after selecting the icon, the system waits for a specific user action, and a symbol

representing the required action appears near the cursor. The action completes when the cursor is

pointed at an appropriate element and left mouse button  pressed.  For instance, this can be a

selection of a construction line – .

In 2D drawing commands "press " usually means that you can press either left mouse button 

 or the <Enter> key.
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In 3D modeling commands it works in a similar way upon selecting a geometry, which is mandatory

for creating an operation, but it doesn't work upon selecting an optional geometry (pressing <Enter>

after selecting a mandatory geometry leads to completing a creation of an operation).  

Start Page

After launching of T-FLEX CAD the dialog box Start Page opens up. 

It includes several sections. In the section Recent Documents a list of recently used documents is

shown. To open any of these documents, it is sufficient to point the cursor at any of them and press

. The Open button can also be used. 

Also the ability to open a folder with a document in the system explorer.

You can also pin documents using the corresponding buttons on the right.
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The section Create New Document allows creating a new document on the basis of any of the

existing templates. For convenience all templates are divided into groups (Common, Bom, Ray

Tracing, etc.). 

The content of these sections duplicates the functionality of the menu File > Recent Files and

the command Create New Document Based on Prototype. More details on how to use these

capabilities will be given in the chapter Main Concepts of System Operation. 

Below are 4 more sections - Information, Learning materials, resources, and Contacts.

The chapter Information contains information about the installed version.

The chapter Tutorial contains basic information about T-FLEX CAD. The information is useful for

novice users.

When you select Resources tab, tflexcad.ru page opens in the browser. Here you can download the

sample files, libraries, etc.

The dialog box Start Page is always visible on the screen when the standard settings of the system are

used. Its tab will be aligned with the tabs of the open documents of the system (see below). In ribbon

interface, you need to choose a special icon in the top right part of the window.

The window can be controlled by the Customize > Tool Windows > Start Page item.

Control of the displaying of the dialog box Start Page during all sessions can be carried out

through the dialog box of the command Set Systems Options parameter Show Welcome Page

at Start on the tab Startup.

Information About Protection Keys

Special protection keys created using Sentinel HASP technology are used to protect T-FLEX products

from an unauthorized usage. There are two types of protection keys - hardware and software. Keys

have their own memory, which contains information about available customer licenses.

The hardware key is recorded on a physical device that plugs into a USB port on your computer. 

Hardware HASP keys of Sentinel HL series version 4.25 and above are used for protection of T-

FLEX products. Older versions of keys are not supported.

Software key does not require the physical device. It is associated with a specific computer but can be

moved to another computer if necessary.

The keys can store network or local licenses.

https://www.tflex.com/
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The local license works only on a single computer. Protection key should be activated on the

computer.

Network license works on several computers. A number of users should not exceed the number of

purchased licenses. Only one key with network license is used in this case. The key should be activated

on one of the local network computers. We will call this computer a server.

Server – network computer, which has an installed network key.

If you are using a network license, a network administrator is granted access to manage available

licenses and to distribute them between workplaces with computers-clients. He can also browse

information about the licenses.

Computer-client – network computer, which is allowed to use license of one or several T-FLEX

products.

Activation procedure for the protection keys does not depend on the license type.

Access to the licenses management is carried out via Sentinel Admin Control Center application. Use

the http://localhost:1947 link to open it. 

For proper work of protection keys and for obtaining access to license management you need to

install prerequisites included into T-FLEX distribution.

You need to install T-FLEX Licensing utility to activate and update protection keys.

If several licenses are available on a certain computer, the one with the highest priority is used. Here is

the list of licenses in order of priority (from highest to lowest):

1. local license of a hardware key;

2. local license of a software key;

3. network license of a hardware key;

4. local license of a software key.

How Can I Activate My key?

1. Install T-FLEX Prerequisites.

· If the protection key contains local license, you need to install prerequisites on the computer

with T-FLEX.

· If the protection key contains network license, you need to install prerequisites on the server

and on all of the network computers-clients.

2. Activate a protection key

· If you want to receive a new software key or update an existing hardware key, you need to run

T-FLEX Licensing utility and Receive key or update memory of an existing key.

Note! Activation or update of a software key and update of a hardware key occurs in one

scenario.

· If you’re using a hardware key, you just need to plug it into computer and wait for indicator to

light up.

Note! For a new hardware key, there is no additional installation required!

Now the key is ready to work and you can begin using T-FLEX.

http://localhost:1947/_int_/ACC_help_index.html
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Prerequisites Installation

Make sure that HASP driver of Sentinel HASP licensing system is installed and run on your computer

before starting a protection key activation/update procedure. 

The driver is installed automatically during T-FLEX Prerequisites installation. It is recommended to

install current HASP driver version from the distribution.

The Sentinel Admin Control Center service is installed with the HASP driver.

In addition to the protection key, the Prerequisites provide a set of programs required to run T-

FLEX CAD.

Go to your browser and check http://localhost:1947. If the page doesn’t open (not found) then re-

install T-FLEX Prerequisites.

T-FLEX Licensing Utility Installation

T-FLEX Licensing utility is used for activation of new keys and update of the existing keys. The utility is

included in distribution. You can find it in the T-FLEX Licensing folder.

Two utilities T-FLEX Licensing and T-FLEX Rehost License are available after installation.

You can run the utility from the Windows menu Start > All Programs > T-FLEX Licensing.

It is recommended to install utility if you are not going to install T-FLEX CAD on your computer

or if you want to re-host a software key. 

Commands for Key Activation and Re-host in T-FLEX CAD

There are special commands in T-FLEX CAD for licenses activation and re-hosting. You can find the

commands in the drop-down list.

You should use Activate License… command to activate a key or update an existing key.

You should use Re-host license… command to move a software key between computers.

http://localhost:1947/_int_/ACC_help_index.html
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Activation/Update of software key memory and update of hardware key memory

Attention! The same procedure is used for activation and update of a hardware key and update

of a hardware key. The procedure is described below.

You need to install Prerequisites before activation/update of a key. 

Activation/Update occurs in two stages:

· Create a request for receiving/updating of a key and send it to the licensing service of the

“Top Systems” company.

· Activate a key using the file received from the licensing service.

Create Request and Send it to the Licensing Service

· If you don’t have a key and you want to receive a software key, perform one of the following

actions:

o Launch T-FLEX CAD and run Activate License… command.

o Install and run  T-FLEX Licensing utility.

In both cases, the Licensing window appears. Selected action depends only on whether T-FLEX

CAD is installed on your computer. 

· If you already have a software key or a hardware key (Sentinel HL series version 4.25 or above),

and you want to update it then you should use Activate License… command from the T-FLEX

CAD, or install and run T-FLEX Licensing utility

When you run T-FLEX CAD for the first time a Licensing dialog window appears. It displays message

License not found.

To receive/update a key you need to select Activate new software key / Update existing hardware or

software key.
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License Activation dialog appears. Here you need to select the I want to request a new or update

existing protection key option.

Attention! If you run T-FLEX Licensing utility or activated the Activate License… command from

T-FLEX CAD the License not found dialog will not appear. License activation dialog will appear

at once in this case.
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A new dialog window will appear. You need to fill in a special request to receive/update a key.
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All fields are mandatory. The Computer Name field is filled in automatically. 

In addition to the data filled in by the user, the system automatically generates a fingerprint file. A

fingerprint file is unique for each computer and is used when activating a key. A fingerprint file has a

C2V format.

A fingerprint file includes information only about your hardware components and doesn’t

contain any personal data.

Buttons below allows you to select one of the two ways for sending request and information file:

If you select the Email license request, a letter is created. It contains the request file (in XML format)

and fingerprint file (C2V format) in the ZIP archive.

The system launches a default application for sending emails to create the letter. If there is no

default application for sending letters on your computer, a warning message will appear.

Make sure that your computer has access to the internet before the letter creation.



T-FLEX CAD 17 Help

48

If you select Save file for sending from another computer a ZIP archive will be created, but you need

to send it manually from another PC to support@TopSystems.ru.

Use this option only if there is no access to the internet on the current computer.

Activation of Received Key

The licensing service of “Top Systems” company will process the request for receiving/updating of a

key and send a message with the attached file. The file contains data for a new key activation or an

update for the existing key.

A name of the attached file is a number of the software key. The file format is V2C.

You need to save the attached file to any directory on the computer and run T-FLEX CAD or T-FLEX

Licensing utility. 

· If you received a new software key, you can activate it only on the computer where the request

was created.

· If you received an update for the existing software key, you can activate it only on the

computer where the request was created. 

· If you received an update for the existing hardware key, you can activate it only on the

computer where a hardware key is plugged.

In the appeared Licensing dialog you need to select I have new software key or update for the

software/hardware key option.

mailto:support@TopSystems.ru
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You need to select the saved V2C file in the Select Protection Key File dialog. After these steps, the

key will be activated. Activation usually takes less than one minute. A message Key successfully

activated will appear.

If you receive an error message do not attempt to activate the key again. Immediately contact

technical support using support@topsystems.ru e-mail. Describe your problem in the letter and

attach a screenshot of the error.

mailto:support@topsystems.ru


T-FLEX CAD 17 Help

50

Support can also ask you to attach screenshots of Sentinel Keys, Features and Diagnostics tabs

from the Sentinel Admin Control Center.

Go to  http://localhost:1947 or click View detailed information about installed keys in the

Licensing dialog to receive information from the Sentinel Admin Control Center.

Re-host of a Software Key

Software keys with all their licenses can be moved from one computer to another. Key re-host may be

necessary in the following cases:

· If you want to move the T-FLEX CAD license to another computer,

· If you want to upgrade or replace components of the computer,

· If you want to format or repartition the hard drive,

· If you want to reinstall OS.

Important! If the license was not moved in cases mentioned above, it can be lost or damaged. 

Important! The license can be moved if the source computer and the target computer are in

working order and the license on the source computer is not damaged. If you need to replace

components of the computer, format the HDD or reinstall OS it is recommended to move the

license to another computer in advance.

Source computer – a computer where the key is currently installed.

Target computer – a computer where the key should be moved to.

Important! You can’t store data with licenses in a file and activate it on the same computer after

its upgrading. Computer’s fingerprint before and after upgrading will not be the same.

Important! Make sure that there are installed key driver and  T-FLEX Rehost License utility on

the source computer and target computer before re-hosting of the license. 

What Should I do to Re-host My Key to Another Computer?

There is special Re-host License command in the T-FLEX CAD. You need to activate the command on

the source computer for re-hosting. 

If the T-FLEX CAD is not installed on the target computer, it is necessary to install the T-FLEX Rehost

License utility.

Important! You need to release the license before key re-hosting. Therefore, T-FLEX CAD on the

source computer and target computer should be closed. 

When you call Re-host license command from T-FLEX CAD, the program is closed automatically.

A dialog window appears after calling the command from T-FLEX CAD or running T-FLEX Rehost

License utility. There are three stages for license re-hosting:

1. Create file with fingerprint of the target computer,

2. Detach software protection key from the source computer using the target computer’s

fingerprint,

3. Activate the key on the target computer.

http://localhost:1947/_int_/ACC_help_index.html
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Step 1. Create file with information about target computer
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Run the T-FLEX Rehost License utility on the target computer. 

Select the Step 1. Create file with information about target computer option.

Then File with information about computer window appears. Here you need to select a directory for

saving the computer’s fingerprint in R2H format. The fingerprint file should be moved to the source

computer.

Step 2. Detach software protection key

Run the T-FLEX Rehost License utility or Re-host License command from the T-FLEX CAD on the

source computer. 

Select the Step 2. Detach software protection key option.

A dialog window will appear. Here you can select a key that should be detached.

Important! Make sure that you selected the correct key and transfer it to the correct target

computer. After pressing Detach and Save button and selection of the R2H file from the target

computer, the license will be removed from your source computer.

If you are sure that everything is selected correctly, press the Detach and Save button.

Then you need to select the R2H file, received from the target computer in the first step.

Save the file in H2R format. The file should be activated on the target computer.

Step 3. Activate Re-hosted protection software key

Run the T-FLEX Rehost License utility on the target computer. 

Select Step 3. Activate Re-hosted protection software key. Select the file in the H2R format in the

appeared window. 
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Activation will take some time, usually not more than a minute. After activation, you will receive a

message.

If you receive an error message do not attempt to activate the key again. Immediately contact

technical support using support@topsystems.ru e-mail. Describe your problem in the letter and

attach a screenshot of the error.

Support can also ask you to attach screenshots of Sentinel Keys, Features and Diagnostics tabs

from the Sentinel Admin Control Center.

To receive information from the Sentinel Admin Control Center go to  http://localhost:1947 or

click View detailed information about installed keys In the Licensing dialog.

Trial Version

A trial usage period is available for T-FLEX CAD. 

In some countries trial period might be unavailable.

To start trial usage, you should select Start trial usage in the Licensing dialog. 

Trial usage is available for one computer only once.

mailto:support@topsystems.ru
http://localhost:1947/_int_/ACC_help_index.html


T-FLEX CAD 17 Help

54

The following dialog will be displayed when you run T-FLEX CAD during the trial period.

It displays a remaining trial period and contains links to full license purchase and activation.
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You should click Continue trial usage button to use T-FLEX CAD during the trial period.

To activate a new key click Activate another key.

For purchasing a license click I want to buy program license. You will be redirected to the Top

Systems website.

Information about Sentinel Admin Control Center

Use http://localhost:1947 link or press View detailed information about installed keys in the Licensing

dialog to open the Sentinel Admin Control Center.

Sentinel Admin Control Center opens in a browser window. You do not need an internet connection

to use it. It works locally.

There are switching language options in the lower part of the Sentinel Admin Control Center window

Help can be called in the top right corner of the window. There you can access necessary information

about using the control center. E.g. there you can find an info about network licenses distribution

between client computers.

http://localhost:1947/_int_/ACC_help_index.html
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FAQ

The main reasons why the key doesn't work: 

You have not installed the support components (install the support components).

You have installed the support components, but it has not been updated (reinstall the HASP key

driver by launching with admin rights the ReInstall.cmd from the T-FLEX Prerequisites\HInstall

folder).

You have installed support components, but you are using an old-style key (install License manager

for old-style keys from the delivery disk, or contact technical support for acquiring it).

Troubleshooting:

1. Support components cannot be installed, and the message “Unable to stop hasplms service”

appears when installing the security key driver.

You need to disable the Sentinel LDK License Manager service in Control panel > System and

security > Administration > Services and repeat the installation.

2. You have several products of the T-FLEX PLM complex installed in different versions, and one

of the products does not see the security key.

In this case, you should check the product build. The new security key is supported starting with a

specific t-FLEX CAD 14 and T-FLEX DOCs 14 build. For earlier builds, we recommend use the old

security key. For more information, please contact the managers of Top Systems.

3. After updating the build, the support components were reinstalled, the license manager

opens upon using the link  http://localhost:1947, but the program still doesn't see the key.



Introduction

57

After reinstalling the security key driver, there may be a situation where the old key driver is not

updated during installation. In this case, go to the T-FLEX Prerequisites\HInstall folder and run

the file ReInstall.cmd. It will delete the installed version of the key driver and install the new

version.

It is important to always install the key driver from the T-FLEX Prerequisites folder that comes

with the current build of the T-FLEX product, since the versions of the security driver may differ.

4. After re-installation of the equipment the key cannot be found.

Most likely, you have deleted the support components that are responsible for the key

operation.

5. After the Sentinel service stops, the key cannot be found.

Try restarting the Sentinel service. If this does not help, reinstall the key driver using the file

Reinstal.cmd, which is located in the T-FLEX Prerequisites\HInstall folder.

6. You have two security keys for t-FLEX PLM products, one of them is old and the other one is

new. They contain licenses for different products. Sometimes products of the T-FLEX PLM

complex are connected to the wrong key.

The old and new keys work through different ports. You must ask the network administrator to

configure the connection of products to keys on different ports. Then both keys will be visible

and will not interfere with each other.  

7. Employee wants to connect to the network where the network security key is installed and

work remotely. How can he do this? 

For connection your system administrator must allow an employee to access your local network

via port 1947, for example, via a VPN connection, and provide the IP address of the office.

The administrator should set a rule, that anyone who connects via the external IP address of the

office, gets access to the port of the server computer on which the product key of the T-FLEX

PLM complex is installed.

Then on the employee's computer, after installing the connection, you need to set two flags, as

in the picture below. They allow you to connect remotely and search for the key outside the local

network. 

Input the IP address of the office into the Remote License Search Parameters field. 

After completing these steps, the key connection must be available.
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Quick Start

This section will describe how to get started in the T-FLEX CAD design system. The basic concepts

necessary for successful work will be described. Also, thanks to this section, it will be possible to learn

how to start working with drawings and find out a list of basic commands and service windows.

Topics in this section:

· Drawing Basic Terms

· Getting Started

· Creating New Document

· Work with Commands

· Recent Commands

· Panels

· Types of Windows

· Document Windows Management

· Tool Windows Introduction

· Using Keyboard and Mouse

· Undo and Redo

Basic Terms

The T-FLEX CAD system provides a wide range of built-in functions to achieve the best quality models

and drawings. There are many different commands for this. These are commands for working with

support geometry, commands for creating solid and surface bodies. You can also work with sheet

metal and welding. There is a set of commands designed to automate the modeling of power supply,

ventilation and piping systems. There is also a powerful system for parametrizing 3D objects and

construction elements. In addition, there is a geometry analysis system that allows you to recognize

mass-inertial characteristics, measure objects, their curvature, gaps, deviations, and so on.

T-FLEX CAD uses several types of elements (entities). In context of this help document words

"elements" and "entities" are used mostly interchangeably. 

Three major types of elements can be distinguished: 2D, 3D and Service.

2D Elements

It's everything that being displayed on drawing sheet or in the drawing on workplane mode. 2D

elements elements can be further divided into Construction entities and Graphic entities.

Construction entities

Construction entities make the framework of a drawing. Graphic lines are drawn over the construction

entities. The construction entities include construction lines and nodes.  These construction lines and

nodes are the principal elements for defining the parametric layout of the drawing. The analog for

these in the conventional drawing is the thin pencil lines to be later marked in ink. The parametric

behavior of the drawing will be driven by the relationships between the various-type construction lines

and the nodes. This will result in a particular way in which the drawing geometry will adjust to

changing parameters. The construction entities are displayed solely for user reference. They do not

appear on printouts or plots. 

Graphic entities

These constitute the actual drawing of the drawing. Graphic entities include the graphic lines,

dimensions, text, hatches, GD&T symbols, etc. These entities may be snapped to respective

construction entities. In this case, modifications in the construction entities and nodes propagate on
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the corresponding graphic entities. This is the main technique for parametric design in T-FLEX CAD.

The other type of the parametrization is the parametrization of the graphic lines using the Constraints

command. The graphic entities constitute the drawing image on a printout or a plot. 

2D Fragments and pictures are complex graphic entities.

3D elements

These are everything that can be displayed in the 3D scene. Main types of 3D elements are Bodies,

Operations, 3D Constructions and Geometrical entities.

Bodies

There are two types of bodies - solid and surface. Bodies are created upon creation of some 3D

modeling operations.

Operations

Operations are results of applying 3D modeling commands. Upon creation of operations, sometimes

new bodies being created, other times existing bodies being edited. Final shape of a particular body

might be a result of creation of a single operation or multiple various operations.

3D Constructions

These are diverse auxiliary elements, which serve various purposes. Most 3D Constructions are used as

Support Geometry upon creating Operations. Others serve instrumental purposes (mostly for

visualization).

Geometric entities

These are faces, edges and vertices of bodies and support geometry.

Service elements 

These are variables, databases, reports, materials etc.

Getting Started

Upon the start of the system the dialog box Start Page appears on the screen. It has been explained

how to work with this dialog box at the beginning of this chapter. It is worth mentioning again that

this dialog box allows creating new documents on the basis of templates already existing in the

system, and it shows the list of the recently used documents (with the possibility of opening them).

Also, this dialog box has various links, which can be useful in working with the system.

In addition to the dialog box Start Page, to create new documents and open already existing ones,

the system commands gathered in the textual menu File can be used.

Create New Model command allows to create a new document:

Icon Ribbon

Get Started > Files > Drawing

Keyboard Textual Menu

<FN> File > New > Drawing

Create New Document Based on Prototype command displays a dialog box that allows to select a

prototype file for the new document:
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Icon Ribbon

Get Started > Files > New From Prototype

Keyboard Textual Menu

<FР> File > New > From Prototype

Open model command brings up the standard Open dialog box to open a document for editing:

Icon Ribbon

Get Started > Files > Open

Keyboard Textual Menu

<O> File > Open

Save Model command saves the current document:
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Icon Ribbon

Save

Keyboard Textual Menu

<SA> File > Save

Save Model As command allows the user to save the current document into a new file with a different

name without changing the original document:

Icon Ribbon

Save > Save As

Keyboard Textual Menu

<SV> File > Save As

Save All command saves all currently open documents:

Icon Ribbon

Save > Save All

Keyboard Textual Menu

<SL> File > Save All

Save as Prototype command saves the current document as a prototype for creating new documents:

Icon Ribbon

Save > Save as Prototype

Keyboard Textual Menu

<SY> File > Save as Prototype

Once this command is called, a dialog box appears on the screen. This dialog allows the user to

specify the name for the prototype file, specify the tab in this dialog box for this prototype or create a

new tab if desired, and also delete unnecessary files and tabs.

The prototype files are located in the Prototypes folder under the Program folder off the T-FLEX CAD

home. This is exactly the folder whose content is displayed in the dialog box by default.
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A prototype folder can be specified by the command Set System Options, Folders tab.

Save document copy to file with different name command allows to save copy of the document

without opening the copy. In this case you can continue working in the source document.

Icon Ribbon

Save > Save Copy

Keyboard Textual Menu

- File > Save Copy

Show Model Properties command displays all properties of the current document, and allows to input

a brief comment:

Icon Ribbon

Properties

Keyboard Textual Menu

<PS> File > Properties

File > Recent Files displays the list of files open during previous sessions. Select a file name in the list

to open. The number of displayed recent files can be set via the Customize > Options > Preferences

command.

Close Model command closes the current document:
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Icon Ribbon

Close

Keyboard Textual Menu

<FCL> File > Close

A document can also be closed using the button , located in the top-right corner of the document

window.

Exit system command closes the T-FLEX CAD session:

Icon Ribbon

-  > Exit

Keyboard Textual Menu

<Alt><F4> File > Exit

The system queries the user whether to save modified documents (if any) before exiting. 

Creating New Document

For creating new documents the dialog box Start Page can be used (see the chapter Getting Started).

This dialog box is always present on the screen when the standard settings of the system are used. This

dialog box enables to create new documents on the basis of the templates and also open already

existing documents from the list of recently used ones. In addition to the dialog box Start Page, the

commands grouped in the textual menu File can also be used for creating new documents. You can

find more about T-FLEX CAD Commands in followings in its section.

To create a new drawing, use the command Create New Model:

Icon Ribbon

Get started > Files > Drawing

Keyboard Textual Menu

<FN> File > New > Drawing

A command Create New 3D Model allows to create a 3D model:

Icon Ribbon

Get started > Files >3D Model

Keyboard Textual Menu

<F3> File > New > 3D Model

To create a new assembly drawing, use the command:
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Icon Ribbon

Get started > Files > Assembly Drawing 

Keyboard Textual Menu

- File > New > Assembly Drawing

To create a new 3D assembly, use the command:

Icon Ribbon

Get started > Files >3D Assembly

Keyboard Textual Menu

- File > New > 3D Assembly

Product compositions of assembly documents include records for an assembly forming. It’s their

only differ from the standard documents.

A created document name depends on the document prototype. Firstly created drawing will be called

Drawing 1, firstly created detail – Detail 1. You can assign any other name upon saving the document.

T-FLEX CAD does not distinguish between the 2D drawing and 3D drawing files. In the

document created as a 2D drawing, the 3D model can be generated afterwards. In the

document created with the use of the command Create new 3D model the new 2D drawings

could be generated.

To create new documents, template files are used that are defined in the command Customize >

Settings…, the tab Files. They contain elements and settings for the new document.

You can change prototype manually by editing of the respective template file or enter another

template file name.

The prototype files should be placed in the folder …T-FLEX CAD\PROGRAM\Template. The name

of the directory for the template files is set in the command Customize > Options…, the tab

Folders.

A user on his own can create an arbitrary number of prototype files.

A new file can be created from an existing prototype using the option New document of the dialog

box Start Page. Otherwise, use a similar dialog New From... by calling the command Create New

Document Based on Prototype.

Opening Document

A T-FLEX CAD document can be opened using the command Open Model. Call the command using:
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Icon Ribbon

Get started > Files > Open

Keyboard Textual Menu

<O>,

<Ctrl> + <O>
File > Open

The new window Open will appear on the screen. This is a standard Windows dialog box for opening

application files.

The command allows you to open not only *.grb format files, but also open files in formats of other

systems.

When you open the file of another system format, you can select the Open or Open with parameters

option.

If you select Open with parameters, a dialog similar to the import dialog for the specified format

opens. In this way, you can open the model with the specified parameters.
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More details about export can be found in the «Exporting Documents» chapter.

Work with Commands

Commands call

There are several ways to call a command in T-FLEX CAD: select from the text drop-down menu,

select from the ribbon or instrumental toolbar, select from contextual menu, or type the hotkey

sequence in the status bar. Some commands can also be called using the hotkey combinations.

Calling a command from the text drop-down menu

Point the cursor at a text menu item and click . A drop-down menu with a set of commands

will appear. Move the cursor to the desired command and click .

Calling a command from the ribbon or instrumental toolbar

Move the cursor to the icon of the desired command and click . You can call a command from

the pictographic menu regardless of whether another command is being executed or not.

Calling a command from the status bar 

It is performed by setting one, two, or three letters of the name of the required command. T-FLEX

CAD automatically identifies the command you enter. For example, the Construct line command is

automatically called after clicking <L>. You can only call a command from the status bar when

none of the system's commands are loaded (the status bar is empty).

Icon Ribbon

Draw > Construct > Line

Keyboard Textual Menu

<L> Construct > Line 

This means, you can call the command by different ways:

· You can press <L>;

· You can select Construction in textual menu, and then find row with Line command;

· Or you can simple press  on pictographic menu.

In each system element creation command, you can call the corresponding element editing

command by pressing <F4>. After you exit editing commands the system to resume execution of

the interrupted command to create.

When working with T-FLEX CAD, you can see the key sequence corresponding to the command in

the status bar tooltips field when you select a command in the text menu or in the toolbar. If a key

combination is set for a command, it is indicated in the text menu to the right of the command

name. You can change or set a combination for any command. For a detailed description, see the

section system configuration, section "Configuring toolbars and keyboard".

When specifying a command name using the keyboard, it is necessary that the system is not in a

state of execution of another command (the status line should be empty).
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It is convenient to use the context menu to run some commands. It is called up by pressing  after

selecting one or more elements. The context menu contains a list of commands that can be performed

with this choice.
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Canceling a command

To cancel a command, it is usually enough to  or <Esc>. There are complex commands that

require 2, 3, or even 4 clicks to cancel, but this is an exception. In these commands, a single click

takes you one step back or cancels the selection of items. You can also use the  icon in the

auto menu. Canceling a command clears the command input field in the status bar and the

automatic menu field.

Recent Commands

T-FLEX CAD remembers commands used by the user in the current session. Recently used commands

can be called again either from the contextual menu invoked by clicking  on an empty space in 2D

or 3D window, or from the   Recent Commands drop-down located on the quick access toolbar. 

Commands used in 2D and 3D windows are counted separately, so the list of recent commands may

contain different items depending on the currently active window.

Some commands (one by default) are displayed directly on the upper level of the contextual menu,

rest of commands - in the Recent Commands sub-menu.

Maximum number of displayed commands can be customized in the System Options dialog. The

Number of commands in Recent Commands list defines number of commands on the upper level of

the contextual menu, the Number of Items in Recent Commands submenu - self-explanatory.

Maximum number of commands displayed in the   Recent Commands drop-down on the quick

access toolbar is defined by the sum of two aforementioned parameters.
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Optionally you can add the  Recent Commands drop-down to any tab of the ribbon using the

customization dialog.

Recent Commands drop-down (2D window is active)

Contextual menu in 2D window

Recent Commands drop-down (3D window is active)

Contextual menu in 3D window

Panels

There are two interfaces in T-FLEX CAD: ribbon and textual. Ribbon interface offers a convenience of

commands usage and their easy searching. Textual interface was used in previous versions of the

system.

You can use flag Ribbon mode in the Customize system command on the Options tab.
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Ribbon

All commands on ribbon are distributed on tabs. Name of each tab reflects the content. Commands

icons are grouped.

The Quick Access Toolbar is located in the header of the window (upper left corner area). It contains

T-FLEX CAD main window controls drop-down , textual menu button , commands for

document management: Drawing, 3D Model, From Prototype, Open, Save, Print, Undo, Redo.

Drop-downs  containing additional commands are available near some of commands. These

commands are always available and do not depend on the active ribbon tab. The Document

Parameters command  is also located here, as well as the Recent Commands drop-down  . The

rightmost button of the toolbar contains its customization drop-down :
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Upper area of the quick access toolbar customization drop-down contains checkboxes for default set

of commands to be displayed on the toolbar. The More Commands... option invokes the toolbars

customization dialog for adding any other commands to the toolbar.

The Show Below the Ribbon option switches the toolbar's position. In alternative position this option

is replaced by the Show Above the Ribbon option.

The Minimize the Ribbon option is also available.

Last two options are also available in the contextual menu invoked by clicking  on any of the quick

access toolbar command icons. Additionally it contains options to remove selected command from

the toolbar and to call the toolbars customization dialog (Customize Quick Access Toolbar option) 

The textual menu  contains all T-FLEX CAD commands:
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The upper right corner of the main window contains: the field for displaying of integration with T-FLEX

DOCs, the drop-down menu  of ribbon settings, the Find Command button , the drop-down menu

of help information , the drop-down menu of system customization , the command for the

start page displaying  and the command for the full screen mode activation   with the

presentation mode available in the drop-down.

In the drop-down menu  you can specify displaying of the tabs.
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A help drop-down menu  contains commands for invoking help information about the system.

The customize drop-down menu  contains commands for changing various system settings.
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The Ribbon adjusts to the current operating mode. For example, the 3D Model and Drawing tabs

change when switching between 3D and 2D windows.

The system remembers on which tab the last selected command was located. If you select a Measure

command in the 3D window, and then continue working in the 2D window, then the next time the 3D

window is activated, the tab with the last command used in the 3D window will be active.

The Ribbon can be hidden by double-clicking on its tab. In this case, it reappears when you select any

of its tabs. You can restore the ribbon by double-clicking again.

Tabs can be switched with the mouse wheel by hovering over them and rotating the wheel.

For personalization, it is possible to edit existing tabs and create your own tabs with the necessary

commands and operations.

In the Ribbon it is possible to collapse\restore groups of commands.

The user can hide groups in the ribbon that he never uses.
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Hidden groups can be restored from the context menu, which is called when you click in an empty

space on the ribbon.

For any of the buttons in the ribbon, you can call the context menu, in which you can customize the

display style of the button or hide it without entering the Settings.
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It is possible to add fragments from libraries to the ribbon. To do this, in the Customize command on

the Ribbon tab, select the (insert fragment from library) category and drag the required files onto the

Ribbon tab. This allows you to create your own ribbon tabs with library items or add them to existing

tabs.

When you select the Create documents from prototypes, you can add an icon for creating a new

document based on the specified prototype on the selected tab.

Hints

When you hover the cursor over a command icon, a short hint appears. If you hold the cursor for three

seconds, an extended hint with an illustration will appear.
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Similar short and extended hints exist for command and operation options.
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If necessary, you can disable all extended hints in the Customize command on the Options tab.

Textual interface

Main Menu contains the textual menu of the T-FLEX CAD commands by groups.
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Main Toolbar contains icon buttons for T-FLEX CAD commands. Besides the main toolbar, the

application window of the system can contain several toolbars (including the toolbars created by the

user). Toolbars can be docked along one of the main window borders, or stand alone as floating

windows.

System Toolbar contains the fields for modifying current settings of entities, such as color, line type,

level, and layer. Also contains controls for modifying layer configuration, level configuration of the

current document, and selector settings.

Elements of T-FLEX CAD Control

 

Ruler indicates current X and Y coordinates in the active drawing.

The active document window - the graphics window for displaying the document. Documents can

only be created and edited in this window.

Tool windows - auxiliary T-FLEX CAD windows for displaying command parameters, model structure,

error messages etc. 

Window Split buttons can be used for splitting the document window into two or four view windows.

Automenu - a menu of icon buttons for the options available within the current command. If no

command is current, the automenu is empty.

Filter toolbar can be used for controlling the selection of 2D and 3D elements

Status bar contains the name of the current command, a prompt for the expected user action, the

current X and Y coordinates, and the command-dependent auxiliary coordinate.

Page Tabs and Page drop-down provide quick access to the desired page in a multi-page document.

To activate a page, select the respective tab. Tabs are not shown for the hidden pages. 

Document Tabs and Document drop-down help quick navigation through the open documents. To

activate a document, select the respective tab. 

The user can reconfigure the layout (position and visibility) of the dialog boxes and various

control bars on the main T-FLEX CAD window. Use the menu Customize > Tool Windows or

Customize > Customize….
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Lock Windows

To avoid accidental movement of panels and windows, you can use the option:

Topics in this section:

· View Toolbar

· Filter Toolbar

· Main Toolbar

· Automenu

· Dynamic Toolbar

· Text Command Menu

· System Toolbar
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View Toolbar

The View toolbar is located along the right edge of the working window.

The set of commands in it depends on whether a 2D or 3D window is active. The panel contains

frequently used commands for working with a drawing and a 3D scene.

When working in a 2D window, some of the icons allow you to quickly change document

parameters - page format and scale, font size, etc.

If the icon is displayed with a black arrow in the lower right corner, then the command contains a

drop-down list of additional modes.

A more detailed description of the View panel is located in the View chapter.

Filter Toolbar

The filters panel is located along the upper edge of the working window. With its help the selection of

highlighted objects in 2D or 3D scene is regulated. The set of filters in the filter panel varies

depending on certain scenarios.
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A more detailed description of working with the filter panel is described in the Object Snaps and

Element Selection section.

If necessary, you can change the location of the filter panel using the drop-down list called by  or

in the system settings.
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Automenu

Automenu is a special toolbar that contains icon buttons of the available command options.

Automenu is context-sensitive. This means, its content changes depending on the current command

and a state of the command. Two outcomes are possible when selecting an action-starting icon in the

automenu. First – the result comes right after selecting the icon. For instance, selecting the parameters

setting icon, , instantly brings up the parameter dialog box on screen. Second – the cursor

changes the shape according to the selected option. To obtain the result, the user needs to move

cursor to an appropriate location and press . For instance, selecting the construction line -  -

adds a line mark to the cursor. The cursor then should be moved to a line to be selected, and the

button  pressed. Only then, the construction line will be selected.

Main Toolbar

The main toolbar has a set of buttons which, depending on the currently solved problem and the

settings of the system, can be selected by the user or automatically activated.

The button sets in the main toolbar are aimed at solving different problems – geometric construction,

3D modeling, analysis, geometric construction on the workplane, operations with sheet metal, editing

specifications etc. Internal specialized modules, which are included into the T-FLEX CAD package, can
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add their own button sets into the main toolbar. For example, the application “T-FLEX CAM” adds to

the main toolbar a set of buttons which perform the functions of this particular application. 

Switching between the button sets in the main toolbar occurs automatically depending on the

operations performed in the working window of the T-FLEX CAD. For example, upon opening of the

2D document the set “2D” is turned on automatically, and upon transition to the 3D window – the set

“3D”. When a drawing is made on the workplane, the set “Workplane” or “Workplane (Sketch)”

becomes active (depending on what has been used last time in the given situation). At the beginning

of the BOM editing, the button set “BOM” is activated. Upon the exit from the BOM editing, the set,

which was active before the editing was started, turns back on in the main toolbar.

Some of the standard sets of the main toolbar are invisible by default and shown only upon activating

the corresponding command of the T-FLEX CAD. For example, the set “Text” is by default not present

in the list of the main toolbar modes, but upon entering the mode of creating/editing the text, this

particular set will appear on the main toolbar.

When the set “Compatible” gets active, the main toolbar itself represents a copy of the standard

toolbar existing in the earlier versions of the T-FLEX CAD.

Switching between the button sets can be done manually by using the button on the left side of the

toolbar . Upon pressing this button the list of available sets pops up. 

The desired set can be chosen with the help of . In addition, several sets can be activated from the

keyboard with the help of the specified for them key combinations. By default, the key combinations

are assigned only for the sets “2D”, “Sketch”, “3D”. In the dialog of the command “Show Toolbars” it is

possible to assign key combinations for other sets of the main toolbar as well.

The user selected set is stored in the window of the current document and automatically recovered

when the window becomes active. The given setting is stored in the document and gets activated

when the file is open.

It is possible to decline automatic switching between the main toolbar sets by setting on the flag

“Lock”. This flag can be found in the context menu, called with the help of  in the auto-menu field
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or any other instrument toolbar. After turning on the flag, the main toolbar state is going to be

modified only upon manual switching between its sets.

One more flag is available in the same context menu which allows controlling the view of main

toolbar – “Show Tabs”. It controls visibility of the tabs on the main toolbar. The tabs allow quick

switching between the button sets of the toolbar. The tab of the active set is marked with the color.

The flag “Show Labels” enables to add annotations to the buttons of the main toolbar. This can be

convenient at the first acquaintance with the system or while working with the high resolution monitor.

The flag “Large icons” allows turning on the mode of the large icons for the main toolbar (no matter

what the size of the icons in other system toolbars is).

The command “Show Toolbars” provides with additional possibilities for controlling the main toolbar.

Via the tab “Main Toolbar” of the dialog of this command, it is possible to do the following:

· Hide/show main toolbar sets in the list of sets (displayed upon pressing the button );

· Rename the main toolbar sets;

· Create and remove user's defined sets;

· Create a separate toolbar on the basis of any set of the main toolbar.

Dynamic Toolbar

In the command standby mode, upon selecting elements using  or , a special dynamic toolbar

appears on the screen. It contains icons of frequently used commands for elements of the given type. 

The presence of the dynamic toolbar, while choosing 2D and 3D elements using , depends on

System Options. For 3D elements the dynamic toolbar will be shown if the Use Dynamic Toolbar

checkbox is turned on in the Dynamic Toolbar tab of System options dialog. For 2D elements, the

Transparent Element Editing checkbox has to be turned off in the 2D tab of the System options

dialog. By default, the dynamic toolbar appears on the screen upon clicking  only for 3D elements.
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Upon clicking on 2D and 3D elements a dynamic toolbar is displayed independently of

aforementioned options. 

In addition to the icons of frequently used commands, the button  for calling the list of additional

commands will be shown in the dynamic toolbar. Upon calling a command from the additional list,

the selected command is automatically transferred to the main set of buttons of the dynamic toolbar

(for the elements of the given type). Modifications in the dynamic toolbar are retained in the current

Environment of the system.
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Following options are available in the contextual menu invoked by clicking  on the dynamic

toolbar:

· Hide Dynamic Toolbar

Disables the dynamic toolbar. It can be re-enabled again by enabling the Use Dynamic

Toolbar checkbox in the Dynamic Toolbar tab of the System options dialog.

· Use Transparency

When this checkbox is enabled (by default), the toolbar looks semitransparent when it appears

on the screen. The semi-transparency diminishes as the cursor moves closer to the toolbar.

When the checkbox is disabled, the toolbar is always displayed as nontransparent. This option

is also available in the Dynamic Toolbar tab of the System options dialog.

· Reset Command Usage

Restores the default set of commands available in the dynamic toolbar.

· Always visible

By default the dynamic toolbar invoked by clicking  disappears automatically after some

time has passed or after moving the cursor to a certain distance from the toolbar. Enabling

this checkbox makes toolbar disappear only upon the next  or  click. The dynamic

toolbar invoked by clicking  remains on the screen until the next click of any mouse button

independently of this option and cursor's position. This option is also available in the Dynamic

Toolbar tab of System options dialog; the Visibility Range (distance to the cursor at which

dynamic toolbar disappears) may also be customized there.  

· Settings...

Invokes the dynamic toolbar customization dialog.
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Text Command Menu

This menu is located under the title bar of the T-FLEX CAD window at the top of the screen.

The text menu of commands contains all the commands of the system, divided into groups. If you

move the cursor to a group, information about this group of commands appears.

Commands in the text menu are divided into the following groups:

File - commands for working with drawings and drawing libraries.

Edit - commands for editing system elements.

Constructions - commands for creating auxiliary building elements.

Draw - commands for creating image elements.

Operations - operations teams when working with a three-dimensional drawing model.

Title Block - drawing design module.

Parameters - commands for working with a parametric drawing model.

Tools - commands for configuring the system and setting drawing parameters.

Customize - system configuration commands.

View - commands for moving around the drawing and system screen configuration.

Window - commands for working in multi-window mode.

Help - commands for obtaining reference information on the system and commands.

Select a command from the text menu:

· Move the cursor to the name of a group of commands and click . A drop-down menu

appears with the names of the teams in the group. Move the cursor to the desired command

and click .

· To select commands from the text menu using the keyboard, press <Alt>+<Key>, where “key”

means the key on the keyboard corresponding to the letter underlined in this paragraph of the

text menu. A drop-down menu with a set of commands will appear. Move the frame using

<Up> and <Down> to the desired command and press <Enter>.

When a command is called from a text menu (for 2D commands), the current command is

automatically stopped. For teams working with three-dimensional drawing elements, the next

command can be called from the current command.
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System Toolbar

The System Toolbar can be enabled or disabled using the following command:

Icon Ribbon

Keyboard Textual Menu

Customize > Tool Windows > System Toolbar

The command is also available in the system customization drop-down menu , which is located in

the upper right corner of the T-FLEX CAD main window.

The system toolbar is a set of tools for quick definition of element parameters at creation and editing

time.

By default, this panel is located below the main toolbar.

Enabling the system toolbar disables the filter toolbar.

Fields and buttons

Layers

These buttons can control the configuration of the layers. The layer name field displays the layer name

for new and editable model elements. Learn more about working with layers in the Layers section.
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Levels

Using these buttons, you can change the settings of the visibility levels of the model elements.

Displays the layer name of the model elements being created and edited. Changing levels can be

done within element creation and editing commands. Clicking inside the box sets a text cursor. Type in

the element level. Confirm the input by pressing <Enter> or clicking  within the drawing window.

Learn more about working with levels in the Levels section.

Priority

This box displays the current priority of the model elements. Changing priority can be done within

two-dimensional element creation and editing commands. The full functionality of this option is

described in the Priority section.

Color

This box displays the color of the element being created or edited. The full functionality of this option

is described in the Color section.

These are the main items that are always present on the system toolbar. The rest of elements replace

depending on the application state. 

Selector

The functionality of this panel is completely identical to the filters panel, the capabilities of which are

described in the Object binding and item selection section.



T-FLEX CAD 17 Help

92

Types of Windows

Black frame - Main window

Red frame - Active document window

Green frame - 3D view window

Yellow frame - 2D view window

Orange frames - Tool windows

Blue frame - Modal dialog window

Launching the T-FLEX CAD starts a new session of working with the system. At the start of a session a

single main window is opened. However you can open several main windows synchronized between

each other in a single session. A session ends upon closing all of its main windows. Launching the T-

FLEX CAD again, when current session is still active, starts another session. Main windows belonging to

different sessions are not synchronized between each other. More information about main windows

can be found in the Working with Multiple Monitors chapter.

Main window contains document windows, service windows and various user interface elements.

A single main window may contain several windows of several documents. A single document

window is opened upon opening or creating a document by default. However, you can open several

document windows for the same document if necessary. Document windows representation as well as

ways of handling them depends on whether document tabs are enabled. More information about
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document windows can be found in Document Windows Management, Open New Document

Window, and Selecting Active Document Window chapters.

A single document window may contain one, two or four view windows. 2D and 3D views (2D and 3D

windows) are used most of the time, however, other specific view types are also available. 3D view

window is opened by default upon creating a new document.  When opening an existing document, a

set of windows that existed upon document saving is opened. Set of windows opened by default for

new documents can be customized. More information about view windows can be found in the View

Windows chapter.

Various tool windows are available in the T-FLEX CAD. The most commonly used tool window is the

Parameters window, which serves for setting active command's parameters. The brief description of

tool windows is available in the Tool Windows Introduction chapter. Tool windows layout can be

customized (see the Tool Windows Management chapter).

Also, there are modal dialog windows (dialogs) in the T-FLEX CAD system. The distinctive feature of

such windows is that they pop-up over windows described above, thus making them temporarily 

inaccessible. E.g.: 3D elements parameters dialog, document parameters dialog, etc. Such dialogs are

described in chapters with description of their corresponding commands.

Document Windows Management

Ways of managing document windows depend on whether document tabs are enabled or disabled.

Managing Document Windows when Document Tabs are enabled

When document tabs are enabled, it is possible to arrange document windows in horizontal or vertical

groups. You can have any number of groups at the same time. However, all groups should be either

horizontal or vertical.
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Click and hold on one of the document tabs, then drag it to the bottom or right border of the

document window without releasing . The preview of the new tabs group borders will appear in

the 

form of gray rectangular contour. Release  to confirm new tab group creation. Dragging

document tab to the bottom border of the window creates a new horizontal group, to the right

border - vertical group.
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Dragging a document tab to an area not adjacent to the right or the bottom borders of the document

window invokes a menu with New Horizontal Tab Group and New Vertical Tab Group commands. 
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Drag a document tab to an area of other group's tabs in order to transfer this document's window to

another group.
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A group can be removed by transferring all its windows into another group.

Aside from methods described above, you can use following commands for creating document tab

groups: 

New Horizontal Tab Group

Icon Ribbon

View > Window > New Horizontal Tab Group

Keyboard Textual Menu

Window > New Horizontal Tab Group

The command creates a new horizontal group of document windows, if document tabs are enabled. A

document window active at the moment of applying the command is transferred to the new group.
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New Vertical Tab Group

Icon Ribbon

View > Window > New Vertical Tab Group

Keyboard Textual Menu

Window > New Vertical Tab Group

The command creates a new vertical group of document windows, if document tabs are enabled. A

document window active at the moment of applying the command is transferred to the new group.
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Managing Document Windows when Document Tabs are disabled

When document tabs are disabled, document windows can be maximized, minimized or re-sized to

an arbitrary dimensions. 

You can use one of the following common ways of windows arrangement:

1. Tile Windows Horizontally

Icon Ribbon

View > Window > Tile Horizontally

Keyboard Textual Menu

<WHT> Window > Tile Horizontally

The command distributes the screen space between open document windows equally along the

vertical axis of the screen, avoiding windows interference.  
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2. Tile Windows Vertically

Icon Ribbon

View > Window > Tile Vertically

Keyboard Textual Menu

<WVT> Window > Tile Vertically

The command distributes the screen space between open document windows equally along the

horizontal axis of the screen, avoiding windows interference.  
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3. Cascade Windows

Icon Ribbon

View > Window > Cascade

Keyboard Textual Menu

<WCA> Window > Cascade

The command places open document windows in a cascade (each next window overlaps the previous

one without interfering its header).
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Tile Windows Horizontally, Tile Windows Vertically, and Cascade commands are available even

if document tabs are enabled. Using these commands in such case disables document tabs.

When document windows are minimized, you can easily arrange them along bottom border of the

working area using the Arrange Icons command:
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Icon Ribbon

Keyboard Textual Menu

Window > Arrange Icons

Additional Document Window

You can open several document windows for the same document using the New Document Window

command.

Closing Document Windows

Closing a single document window is described in the Document Tabs chapter both for enabled and

disabled tabs cases.

Closing all windows of the active document is performed using the Close command.

Closing windows of all documents in the current session at once is performed using the Close All

command.

Splitting the Active Document window

Active document window can be slit into several parts. More information can be found in the View

Windows chapter.
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Tool Windows Introduction

To enable or disable tool windows, use the Tool Windows drop-down list.

Icon Ribbon

View > Window > Tool Windows

Get Started > Options > Tool Windows

Keyboard Textual Menu

Customize > Tool Windows

The list is also available in the system customization drop-down menu , which is located in the

upper right corner of the T-FLEX CAD main window.

Icons of enabled windows are highlighted in the list. Click  on a tool window in the list to enable

or disable it. Set of available windows depends on set of installed applications. Enabling the T-FLEX

DOCs integration mode provides extended set of tool windows. The list of T-FLEX CAD basic module

tool windows is shown below. Links in the list lead to brief description of a particular window.

Detailed information is available in the Tool Windows chapter.

 Open Folder

 Library Explorer

 Diagnostics

 3D Model

 Parameters

 Macros

 Variables

 Assembly Structure

 Materials

 Product Composition

 Bird's Eye View

 Model Elements

 Structural Elements

 Remarks

 Model Configurations

 Layers

 Studies

 Welds

 Quality Control

 Find Command

Examples of tool windows from additional applications:

· Electrical Components

· Machining Manager
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 Open Folder

You can display in the tool window any folder available on the computer. Only T-FLEX CAD

documents and sub-folders are shown in the tool window, rest of the folder's content is ignored.

Navigation between folders is performed in the same way as in the Windows Explorer. Upper area of

the window contains buttons for switching to the next , previous , and upper level  folders.

Contextual menu, invoked by clicking  on an empty space of the folder window, contains

commands for creating T-FLEX CAD documents, pasting documents, that were cut or copied before,

and folder view options.  

 

Contextual menu invoked by clicking  on a folder contains following commands (aside from folder

view options):

·  Open with Explorer...

Opens selected folder in the Windows Explorer.

·  Open Window 

Opens new tool window for selected folder.

·  Delete from hard disk

·  Rename

Contextual menu invoked by clicking  on a document contains following commands (aside from

folder view options):

·  Open with Explorer...

·  Open...

·  Insert as Fragment

If 2D view window is active, this command insert selected document into current document as

a 2D Fragment. 

If 3D view window is active, this command insert selected document into current document as

a 3D Fragment.

·  Insert as Picture

·  Delete
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·  Rename

·  Properties

·  Cut

·  Copy

Keep in mind that upon using Cut and Copy commands in this menu you won't be able to paste

selected file from the clipboard into an active document.

 Library Explorer 

Represents libraries and documents in the current library configuration. Helps quick loading of a

desired document and browsing drawing libraries.

Diagnostics 

Displays messages about errors or failures that may occur during T-FLEX CAD operation.
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3D Model 

Displays the tree structure of a 3D model, such as existing workplanes and other auxiliary 3D entities

and their dependencies, and operations used for creating a model. 

Parameters

Is used for specifying parameters in transparent mode within most 2D and 3D commands.
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Macros 

Displays and allows to run macros of the current document and macros from T-FLEX CAD installation

folder “…\Program\Macros”.

Variables 

This is the additional window of the variable editor which enables to work with variables in the

transparent mode, and simultaneously work with the drawing window or 3D model window. Upon

changing the value of the variable, the model is regenerated transparently in the current window. All

changes are immediately reflected on the drawing. 

Assembly Structure 

Represents a tree structure of an assembly and fragments.



Quick Start

109

Materials 

Window for working with materials of 3D model and also with material libraries of T-FLEX CAD.

Product Composition

Displays product composition and BoM data. Allows adding elements to the product composition,

editing element's data, establishing links between product composition elements and 3D

model/drawing elements .
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Bird’s Eye View

Displays the fitted view of the drawing, regardless of the current pan/zoom in the drawing window.

Helps to quickly pan or zoom to any area of the drawing. 

Model Elements

All elements created in active document are shown in the Model Elements window.
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Structural Elements

Displays structural elements.

Remarks

Allows to add remarks (annotations) in 3D and 2D windows.

Model Configurations

Window for working with model configurations.
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Layers

Window for working with layers.

Studies

Displays data of the current document's FEA and Dynamics studies. Can be used in Express Analysis as

well as in T-FLEX Analysis and T-FLEX Dynamics applications.
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Welds

Contains lists of welds created in the current document.

Quality Control

Window for working with automatic quality control tools.
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Find Command 

Allows to search for system commands by name, short description, or keyboard shortcuts.

Electrical Components (available for the T-FLEX Electrical application users)

Contains various types of electrical components to create electrical diagrams.
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Machining Manager

Contains tree structure of tool paths, machining types and technological parameters existing in an

active document.

Topics in this section:

· Tool Windows Management

See also:

· Tool Windows

Tool Windows Management

System tool windows can be positioned in the main application window in various ways. Those can be

docked at the side of the working window, made hideable or set to floating mode. To save the

workspace, some windows can be joined in one group window. Unused tool window can be turned

off.
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Tool windows contextual menu

State of a tool window can be controlled via the the contextual menu invoked by clicking  on a

header. Following commands are available for all types of tool windows:

· Hide. Remove the window from the screen.

· Set floating. Turn off the snapping of a tool window to borders of a main window.

· Auto Hide. Turn on/off the auto hide mode for the window.

Additional option is available for the Parameters window:

· Show window automatically. If it's enabled, the Parameters window becomes active

automatically upon launching any command that requires parameters input.

Positioning tool windows

Click  on a tool window's header and drag the mouse to change window's position. When moving

the window snapping icons appear on the screen. Icons represent possible position of the tool

window, in relation to borders of the main window. Drag a tool window onto the desired snapping

icon to apply this snapping.
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Snapping icons can be disabled by holding <Ctrl> while dragging a window.

Grouping tool windows

Tool windows can be combined into a single group with tabs. It saves the screen space. Drag  one

window onto the header of another window. The preview of new window's position appears. Release

the  to apply the grouping.

The same result can be achieved by dragging a window onto the middle area of another window and

releasing the  on the central snapping icon (the one that represents tabs).

Navigation between grouped windows is performed via clicking their tabs.

The system switches windows automatically in some cases.
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You can also drag one of the grouped windows by its header to remove it from the group. 

Auto Hiding of Tool Windows

If you need more free working space in the main window, you can enable auto hiding of tool

windows. Automatically hidden window becomes minimized to a tab at the border of main window.

When you hover the cursor on this tab, the corresponding window will automatically appear. If you

move the cursor from the window, the window will be minimized again. 

  

Auto hiding is applicable not only to windows snapped to the main window's borders, but to floating

windows as well.

 

To enable the auto hiding mode, click  on a tool window's tab or header and enable the Auto

Hide checkbox. You can also use the  button located in the header of tool window. Upon enabling

auto hiding the button changes icon to .

To disable the auto hiding, click  on a tool window's tab or header and disable the Auto Hide

checkbox. Or use the  button located in the header of tool window.
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Floating tool windows

Sometimes can be helpful to use the floating mode. In this mode the tool window can be located at

any position on the screen without snapping to the main T-FLEX CAD window. To enable the floating

mode drag a tool window by its header or by its tab (if grouped) to the desired position using . To

make the whole group floating drag it by its header in a similar way.

You can also use the Set floating command in the contextual menu of tool window. Notice that

applying this command to a grouped window excludes it from a group.

Floating mode can be disabled by dragging the window to a snapping point using .

Using Keyboard and Mouse

Using the mouse

User interaction with T-FLEX CAD 3D is mostly performed via mouse. Functions of mouse buttons

depend on context and on whether they're used in 2D or 3D window. Most common cases of using the

mouse are listed below.

The described mouse buttons' functions are set by default, but can be customized. For more

information, refer to the System Options. 

Using the left mouse button

· Pointing the cursor at an icon or a menu line invokes a ScreenTip (tooltip with a short info

about a command or an option). Pressing  then launches a command or applies an option

represented by this icon or a menu line.

· In 3D window dragging the mouse while holding  rotates the camera. In this mode the

cursor changes it's appearance to . Doing the same while holding the <Shift> button

replaces rotation with zooming in (upon mouse pull) or out (upon mouse push). In this mode

the cursor changes it's appearance to . 
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· In 2D window dragging the mouse while holding  selects objects via the selector (by

drawing a rectangle or a curve).

· When object snap is on, pointing the cursor at an element, which fulfills an active set of filters,

highlights that element (highlight color depends on a type of an element). Holding the cursor

in this position invokes a tip, which contains an icon of element's type, a name of an element

and sometimes a number in brackets. This number is a quantity of elements which are located

behind the current cursor position and fulfill active filters (an element nearest to the camera is

selected by default). Holding the cursor in this position a little longer expands a list of

aforementioned elements. You can switch between elements in the list by scrolling . When

desired element is highlighted click  to select this element. You can also select elements by

instantly clicking , without waiting for a tip to appear.
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· Selecting an element by clicking  in 2D window or in the drawing on workplane mode

invokes a command for editing selected element.

· Selecting an element by clicking  in 3D window outside the drawing on workplane mode

invokes a dynamic toolbar.

· Double click  on a 2D or 3D element invokes the Element Parameters dialog, if no 3D

modeling command is currently active.

· Double click  in 3D window confirms a 3D modeling command, if such command is

active and its mandatory parameters are defined.

· Sequential clicking  on 2D or 3D elements while holding the <Shift> button allows to

select multiple elements.

· Element can be excluded from multiple selection by clicking  on it while holding the

<Ctrl>. 

· 2D elements can be repositioned by drag&drop (click  and drag the mouse without

releasing the ). Drag&drop works in the same way on a multiple selection of 2D elements.

·
· Drag&drop can also be used for managing libraries and customizing toolbars and dialog

boxes. 

Using the right mouse button

· While within a command, pressing  cancels the last action or the whole command. Some

commands (e.g.: spline, hatch) allow user to select an action upon clicking :

· If no command is active, pressing  invokes a contextual menu. The menu is composed of

the commands currently available for the particular element. Content of the contextual menu

depends on where the cursor is pointing (area of the 3D scene, a model element, the

command area of T-FLEX CAD, such as a dialog box, a menu, or a toolbar). To launch a

command point the cursor at the corresponding line of the context menu and press . 

· A dynamic toolbar is also displayed when invoking the contextual menu by clicking  in 2D

or 3D windows.
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· Dragging the mouse while holding  selects objects via the selector (by drawing a rectangle

or a curve) both in 2D and 3D windows.

Using mouse wheel (middle mouse button)

· Scrolling  down zooms in the camera, scrolling  up zooms out the camera.

· Dragging the mouse while holding  pans the camera. The cursor in this mode changes

appearance to .

· Scrolling  performs the standard functions of scrolling in the appropriate field of dialog

boxes.
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· Double clicking  in 2D or 3D window applies Zoom Limits.

Using the keyboard

The keyboard is used for inputting numerical and string values into various input boxes. Additionally

the keyboard can be used for calling commands or switching options via hotkeys.

Calling commands from keyboard, using an icon, from textual menu

Most T-FLEX CAD commands have keyboard shortcuts which are either key combinations, where

buttons should be pressed simultaneously, or key sequences (keyboard accelerator sequences), where

buttons shoud be pressed one by one sequentially.  The textual menu lines contain hotkey

combinations (but not sequences) for a related command if it is assigned. The combination can be

changed for any command. For detailed description, refer to the Keyboard. Customizing toolbars and

keyboard.

Key sequences and command names are displayed in ScreenTips (pop-up help) and in the message

field of the status bar. 

Most commands have additional options and sub-commands accessible via the automenu and

hotkeys. Hotkeys are displayed in tooltips, invoked by hovering the cursor over an option's icon.

Confirming actions of 3D element creation

Unlike 2D elements, a 3D element creation takes several steps. Not all of these steps are required. To

complete an element definition, use the Finish input option by clicking on the  icon or using the

<Ctrl>+<Enter> shortcut. This option becomes accessible only when all mandatory parameters of

operations are defined. 
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When calling a command, notice initial parameters. Some commands remember the last used

set of parameters, while others revert to default.

Canceling and exiting a command

Exiting a command is done by pressing <Esc> key or . Alternatively, use the  automenu icon.

If launched 3D command is in its initial state (no elements selected, no parameters changed), then

calling another 3D command makes the former command quit. However, if something has been

selected within the former command then the newly launched command does not close the former

one and becomes nested. Once done with the nested command, the system returns into the former

command. This is one of the differences between 3D and 2D command. It only works in 3D outside

the drawing on workplane mode. To return to the command-standby mode, close subsequently all

active commands. Instant exiting from all nested commands is done by simultaneously pressing

<Shift>+<Esc>. A 3D command quits automatically upon calling any 2D command.

General Shortcuts

<F1> Call Help

<F2> Switch on/off Object Snap

<F7> Refresh screen

<F11> Enter/exit Full Screen mode

<Alt>+<F4> Exit the T-FLEX CAD

<Ctrl>+<N> Create new document based on prototype

<Ctrl>+<Shift>+<N> Create new 3D model

<Ctrl>+<O> Open a document

<Ctrl>+<P> Print

<Ctrl>+<R> Import

<Ctrl>+<W> Export

<Ctrl>+<S> Save current document

<Ctrl>+<Y>,

<Ctrl>+<Backspace>
Redo (outside an active command)

<Ctrl>+<Z>,

<Alt>+<Backspace>
Undo (outside an active command)

<Ctrl>+<C>,

<Ctrl>+<Insert>
Copy selected elements to the system clipboard

<Ctrl>+<V>,

<Shift>+<Insert>
Paste elements from the system clipboard

<Esc>,
Cancel last action inside active command or quit

command 

<Shift>+<Esc> Quit all commands at any nesting level



Quick Start

125

<Space>

Call last used command. Used commands are

remembered independently for 2D window, 3D

window inside draw on workplane mode and 3D

window outside draw on workplane mode

Main 2D drawing shortcuts

<Ctrl>+<F> 
Switch drawing mode in the Graphic Line

command

<Ctrl>+<G> Switch on/off Grid snap

<Alt>+<F6>
Open Grid tab in Document Parameters for current

sheet or workplane 

Main camera shortcuts for both 2D and 3D windows)

<F3> Call Zoom Area command for managing 2D view

<Shift>+<Ctrl>+<Home> Call By Page Size command

<Shift>+<Ctrl>+<End> Call Zoom Limits command

<Ctrl>+<Left>,

<Ctrl>+<Right>,

<Ctrl>+<Down>,

<Ctrl>+<Up>

Pan the camera in corresponding direction along

screen plane

<Shift>+<Ctrl>+<PageDown> Zoom out

<Shift>+<Ctrl>+<PageUp> Zoom in

Main camera shortcuts for 3D window outside draw on workplane mode only

When using hotkeys, 15° and 90° angles of rotation are set by default. You can customize these values

on the 3D tab of the System Options.

<Left>,

<Right>
Rotate camera by 15° left/right around vertical axis

<Down>,

<Up>

Rotate camera by 15° down/up around horizontal

axis

<PageUp>
Rotate camera by 15° clockwise around axis

coinciding with the view direction

<PageDown>
Rotate camera by 15° counterclockwise around axis

coinciding with view direction

<Shift>+<Ctrl>+<Left>,

<Shift>+<Ctrl>+<Right>
Rotate camera by 90° left/right around vertical axis

<Shift>+<Ctrl>+<Down>,

<Shift>+<Ctrl>+<Up>

Rotate camera by 90° down/up around horizontal

axis
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<Ctrl>+<Num1>,

<Ctrl>+<Num2>,

<Ctrl>+<Num3>,

<Ctrl>+<Num4>,

<Ctrl>+<Num5>,

<Ctrl>+<Num6>,

<Ctrl>+<Num7>,

<Ctrl>+<Num8>,

<Ctrl>+<Num9>,

<Ctrl>+<Num0>

Apply one of standard View Points

(this also works in draw on workplane mode)

Undo and Redo

Errors unavoidably occur when working with any system, especially while learning. Correcting errors

takes time. T-FLEX CAD system helps simplify this process. A certain number of latest user actions are

remembered by the system. The user actions remembered by the system can be undone by a certain

number of steps back. This can be done by repeatedly calling the Undo command, that brings the

system back by one step. The Undo command can be called from any other command using

<Alt>+<BackSpace> or <Ctrl>+<Z> combination.

If the Undo command was called by mistake, there is the Redo command, which restores the undone

action. 

The number of steps saved in the undo/redo buffers may be customized in the Performance tab of

the System Options. 

You can undo or redo several actions at once if you click on the  button to the right of the icon

of the corresponding command. After clicking the button, a drop-down list of actions that can

be undo/redo will open. Then it is enough to simply select the required group of actions using

the .

Undo

The command can be called as follows:
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Icon Quick Access Toolbar

Keyboard Textual Menu

<UN>,

<Alt>+<BackSpace>,

<Ctrl>+<Z>

Edit > Undo

The Undo command allows you to return to the previous state in case of a mistake. If you mistakenly

called the Undo command, then use the Redo command to redo the undone action.

Redo

The "Redo Changes" command is called via:

Icon Quick Access Toolbar

Keyboard Textual Menu

<RED>,

<Ctrl>+<BackSpace>,

<Ctrl>+<Y>

Edit > Redo

The Redo command is a companion command for the Undo command.

It repeats the action canceled by the Undo command. The number of possible redo steps corresponds

to the number of actions undone by the Undo command.
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Document Management

In addition to working with models, T-FLEX CAD allows you to work with documents.

Topics in this section:

· Create and Save Documents

· Document Window

· Pages

· Show Model Properties

Create and Save Documents

Working with documents begins with the process of creating this document.

Topics in this section:

· Create New Model

· Create New 3D Model

· Save Model

· Save Model as

· Save All Modified Models

· Save as Prototype

· Create New Document Based on Prototype

Create New Drawings

A new project begins with setting up the new document. Depending on the design intent one can

select appropriate initial options for the new model. To begin with a 2D drawing creation or other 2D

construction in 2D window use the command:

Icon Ribbon

Get started > Files > Drawing

Keyboard Textual Menu

<FN> File > New > Drawing

This will bring up the 2D window. In this window a new drawing is created with the name Drawing ?

(the window number is added to this name). When saving a new drawing, you will need to provide a

name for the drawing. The settings for new drawings are taken from the prototype file, the name of

which is specified in the Files tab of the Settings command. If there is no prototype file with the

specified name, then a warning appears on the screen when the command is invoked.
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Create New 3D Model

When beginning directly with a 3D model creation, use the command for creating a new file,

Icon Ribbon

Get started > Files > 3D Model

Keyboard Textual Menu

<F3>

<Ctrl>+<Shift>+<N>
File > New > 3D Model

The command allows you to create a new document with three standard work planes already created.

When the command is called, a new 3D window opens, in which a new drawing is created with the

name 3D Model ?  (the window number is added to this name). When saving a new drawing, you will

need to provide a name for the document. The settings for new drawings are taken from the

prototype file, the name of which is specified in the Files tab of the Settings command. If there is no

prototype file with the specified name, then a warning appears on the screen when the command is

invoked.

Save Model

Calling the command:

Icon Ribbon

File > Save

Keyboard Textual Menu

<SA> File > Save

Save command saves a document with the drawing to the disk. When a drawing is saved for the first

time the program will request for its name and file path. Henceforward the drawing will be saved to

already existing file. When you call the command for an unsaved document, a standard Windows file

saving window will appear.

If you want to save the file under a different name, use the Save As command.

Save Model as

Calling the command:

Icon Ribbon

File > Save As

Keyboard Textual Menu

<SV> File > Save As

It is used, when saving a document for the first time (when using the Save command), and if it's

necessary to save a previously saved document under a different name. When you call the command

for an unsaved document, a standard Windows file saving window will appear.
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Save All

Calling the command:

Icon Ribbon

-

Keyboard Textual Menu

<SL> File > Save All

This command allows you to save all documents that are currently open in the system. Depending on

whether the document has been saved up to this point or not, the Save or Save as commands are used

for saving.

Save as Prototype

Calling the command:

Icon Ribbon

-

Keyboard Textual Menu

<SY> File > Save as Prototype

This command allows you to save the current document as a prototype for creating other documents.

After calling the command, a dialog box appears where you can define the folder and name for

saving the prototype file. By default, the system offers to store prototype files in the "Prototypes"
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directory. The prototype file is a copy of the original document. You can create a new document using

the prototype file using the Create New Document Based on Prototype command.

To work with prototype files, use the image buttons: 

· New folder - create a new folder for saving prototype files;

· Delete folder - delete the current folder;

· Delete file - deletes the prototype file.

Create New Document Based on Prototype

Calling the command:

Icon Ribbon

File > New

Get Started > New from Template

Keyboard Textual Menu

<FP>,

<Ctrl>+<N>
File > New > From Prototype...

Use this command to create a new document based on a prototype file.

A window appears on the screen to select the prototype file. When you select one of the files, the

system creates a new document based on the selected one. 

The prototype files must be located in the ...T-FLEX CAD\PROGRAM directory\Prototypes (the name of

the directory for prototype files is set in the Settings > Installations command, Folder tab).

Document History

You can enable the automatic tracking of document's changes history (Document Parameters >

Document > Save > Save > Save Document History). It can be viewed using the Document History

command:

Icon Ribbon

File > Document History

Keyboard Textual Menu

<FH> File > Document History...

Command's parameters window contains the list of sessions, in which this document was saved. By

default, following information is shown for each session:

· #

Number of session in chronological order.

· Start Time

Date and time of opening the document.

· End Time

Date and time of a last save of the document before closing. Intermediate saves in the same

session are not tracked.

· User

Windows or T-FLEX DOCs (when working in the integration mode) user-name of a user who

saved the document.



T-FLEX CAD 17 Help

132

· Comment

Comments can be added by typing text into the Comment on current session input box. The

comment is saved in history upon saving the document. Adding, editing or deleting comments

on finished sessions is not allowed.

Additional columns of the list of sessions can be enabled by clicking  on a header of any column

and selecting  the desired options in the contextual menu.

Additional columns include T-FLEX CAD Version and number of document's element, that were

Created, Changed or Deleted in session.
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The # column also allows to expand /collapse  the list of elements created, changed or deleted in

session. The list contains names of elements and icons of their types. Icons of deleted elements are

replaced by the question mark.

Following buttons are available below the list of sessions:

· Created Elements

When a session is selected in the list, the button selects elements created during this session in

2D and 3D windows, if such elements were not deleted.

· Changed Elements

When a session is selected in the list, the button selects elements changed during this session

in 2D and 3D windows, if such elements were not deleted.

Elements selected using these buttons remain selected upon exiting the Document History

command.

· Information...

Calls the  Information command for elements, that have been selected using the Created

Elements and Changed Elements buttons.

· Report...

Exports the document history into a .csv-file.

The Element input box is located in bottommost part of the command's parameters window. Any

element can be selected in 2D or 3D window upon activating  this input box. A name of a selected

element, icon indicating its type and in some cases a name of a parent element are displayed in the

Element input box. Upon selecting an element, the list of sessions is filtered so, that it contains only

sessions in which the selected element was created and edited. 

Element can be selected in advance prior to calling the command. In this case, the list of sessions will

be filtered at once upon calling the command.

If saving document history is disabled in document parameters, then the system suggests to enable it

upon calling the Document History command.
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Saved document history can be deleted by disabling it in document parameters and saving the

document.

Document Window

An integral part of working with T-FLEX CAD is interaction with document windows.

Topics in this section:

· Open Model

· Close Model

· Close All Documents

· Open New Document Window

· Selecting Active Document Window

See also:

· Document Windows Management

Open Model

Calling the command:

Icon Ribbon

File > Open

Get started > Files > Open

Keyboard Textual Menu

<O>,

<Ctrl>+<O>
File > Open

The new window titled Open will appear on the screen. This is a standard Windows dialog for opening

application files. The layout of the dialog depends on the version of Windows. The Windows 10 layout

is shown below.
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Left side of the dialog allows quick navigation between folders. Right side of the dialog displays

content of the current folder. If you click Show the preview pane button, the preview of a selected file

will be displayed in the right side of the dialog. Preview is only available for documents, which have it

enabled in the Document Parameters.

The command allows you to open not only *.grb format files, but also open files in formats of other

systems.
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When you click the Open button, the document is opened using default parameters. Click on the 

symbol in the right side of the button to select the Open with parameters option.

If you select the Open with parameters option for files in formats of other systems, a dialog similar to

the import dialog for the specified format opens. So, you can customize import parameters.

If you select the Open with parameters option for T-FLEX CAD files, the Open with Parameters dialog

appears, where you can select one of the following Types of Document Load:

· Default

The model tree, support geometry and meshed representation of bodies are loaded. Meshes

require less system resources than solids but can only be used for visualization. Full solid

representations of bodies will be loaded automatically when necessary upon editing the

model.

· Full

The model tree, support geometry, meshes and solids are loaded.

· Minimal

The model tree, support geometry are loaded along with meshes only for bodies of the

current document. Bodies of fragments are not loaded and not visible in the 3D scene. 
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Checkboxes in the bottom part of the dialog allow to Open a document as Read-Only and Set

selected Type of Document Load as Default for opening documents in the current session. Starting a

new T-FLEX CAD session resets default type of load. 

Open Fragment file

If current document contains elements (2D fragments, 3D fragments, 2D projections) based on an

external document, the contextual menu of such elements contains the  Open command, which

opens the linked document. 

Close Model

Calling the command:

Icon Ribbon

File > Close

Keyboard Textual Menu

<FCL> File > Close

The command closes all windows of an active document in all main windows of the current session.

If document contains unsaved changes, the dialog suggesting to save the document pops-up. Upon

clicking Yes, the document is saved and then closed. Upon clicking No, the document is closed

without saving. The third option is to Cancel the command.

Close All Documents

Calling the command:

Icon Ribbon

View > Window > Close All

Keyboard Textual Menu

<WCS> Window > Close All

The command close all document windows in all main windows of the current session. 

If document contains unsaved changes, the dialog suggesting to save the document pops-up. Upon

clicking Yes, the document is saved and then closed. Upon clicking No, the document is closed

without saving. Clicking Cancel cancels closing of all windows (not just the one with unsaved changes).
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Open New Document Window

Calling the command:

Icon Ribbon

View > Window > New Window

Keyboard Textual Menu

<WO> Window > New Window

The command opens a new document window for an active document in addition to already opened

windows.  

All user-actions performed in one of the windows affect all other windows of the same document. E.g.:

selecting an element in one window also makes this element selected in other windows. 

Additional windows can be used when you need to work simultaneously with multiple small elements

located far from each other. In such case you can focus different windows on different elements and

switch between windows when necessary. 

You can also split a single document window into several view windows for the same purpose.

Different document windows for the same document may be used in different main windows on

several monitors.

Upon calling the command, the Views Placement dialog appears. There you should select a view

windows layout for the new document window. Layout can be selected in the same way as described

for the Views Placement command.

When you have several main windows in one session, you can select a Main window for the new

document window using the eponymous drop-down list. By default, the new document window is

created in the current main window.

In case where several document windows are opened for a single document in one session, a number

of a window is added after a name of a document (separated by the colon) in document window's
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title. E.g.: if you have three document windows for the ISO 3D Model 1 document, windows are titled

as follows:

ISO 3D Model 1:1

ISO 3D Model 1:2

ISO 3D Model 1:3

Document windows numbering is consecutive for all main windows of the current session.

Selecting Active Document Window

The active window (the window of the current document) can be selected in different ways. When

document tabs are enabled, you can simply click  the corresponding tab. If the document tabs are

disabled, you can use the key combinations <Ctrl>+<F6> or <Ctrl>+<Tab> for sequential switching

between windows.

You can also use the list of open windows in the Window item of the textual menu. The currently

active window will be marked with a check mark in the list. To switch to another window, just point at

it with the cursor and click . The number of windows shown in this list cannot exceed ten. If a larger

number of document windows are open at the moment, then to select one of them, you can use the

command Window List command:

Icon Ribbon

View > Window > Window List...

Keyboard Textual Menu

 Window > Window List...

The command is also available in the contextual menu of document tabs.

After calling the command, the Arrange Windows dialog box appears. Here you can select a window

from the list. The list contains all document windows, that are open in the current main window. Please

note, that the set of available buttons in this window depends on whether document tabs are currently

enabled or disabled.
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With documents tabs

Without documents tabs

To the right of the window list, there are several options for manipulating these windows. Several

objects can be selected in this list. With a different number of selected windows, different options will

be available:

· Activate - closes the dialog and makes selected window active.

· OK - closed the dialog.

· Save - calls the Save command for selected windows.

· Close Window - closes selected windows.

· Cascade - applies the Cascade Windows command to selected windows (only for multiple

selection), minimizes non-selected windows.

· Tile Horizontally - applies the Tile Windows Horizontally command to selected windows (only

for multiple selection), minimizes non-selected windows.

· Tile Vertically - applies the Tile Windows Vertically command to selected windows (only for

multiple selection), minimizes non-selected windows.

· Minimize - minimizes selected windows.
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Pages

Calling the command:

Icon Ribbon

Edit > Document > Pages

Keyboard Textual Menu

<PG> Customize > Pages

Additionally, the command can be called from the View toolbar and from the contextual menu of a

page tab.

The Pages dialog pops-up upon calling the command. The dialog can be used for managing

document pages.

General information about drawing pages

For working convenience, T-FLEX CAD system provides a capability of creating multi-page documents.

For example, it is handy to have in one file, yet on separate pages, auxiliary 2D constructions used in

the main 3D model, as well as projections and sections of the 3D model with dimensions, or the BOM,

etc. The elements can meanwhile interact with each other via the created relations, variables,

databases, etc.

A T-FLEX CAD document can have an arbitrary number of pages. Each created document has at least

one page.

Pages in T-FLEX CAD are divided into 8 types, depending on their purpose and the way of creation:

 Normal,  Auxiliary,  Control,  Workplane,  Text,  Bill of Materials,  Electric

Diagram,  Projection. Such division is not strict: the type of a page in most cases can be changed

by the user. Types help controlling page display. Depending on the drawing settings, the 2D window

will display all pages in the document, or only the pages of certain types (controlling pages visibility is

described below). Therefore, the user can manage page visibility while working with multi-page

documents, hiding from display those unused at the moment.

Each page uses its own drawing settings defined in the Document Parameters, such as the paper

format, drawing scale, font parameters, detailing elements, colors, properties of element display, etc.

The settings made in the Levels command also affect only the page that was current when the settings

were made. When calling the Export command, the system processes the current page of the drawing

(except exporting to the AutoCad format, when all pages of the documents are getting converted).

Modifications of default parameters affect all pages. The same is true for managing layers in the

 Layers command.

If a T-FLEX CAD document contains several pages, the tabs with names of visible pages are displayed

in the bottom of the drawing window. Visibility of the tabs can be controlled using the Page Tabs

command. 

Switching pages is done without leaving the current command. This help creating, say, a copy or a

detail view by selecting elements located on different pages.
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Working with Pages dialog

The main pane of the dialog contains the list of pages displayed in the 2D drawing window: names

and types of pages.

The bottom portion of the dialog contains the Show Page Tabs group of checkboxes for managing

the visibility (both in the list of pages and in the drawing window) of pages of a certain type: 

· Workplane  

· Control

· Auxiliary 

· Text

· Bill of Materials

· Electric Diagram

· Projection

Pages of the Normal type are always present in the list and always displayed in the 2D window. 

The visibility of pages can also be customized in the Document Parameters.

Pages in the list can be selected using .  Type of selected page can be changed using the Page

Type drop-down list. 

Pages of the Workplane type are created only via workplane creation commands. Their type

can't be changed.

The graphic buttons at the right-hand side of the dialog box allow the following actions over the

selected page in the list:
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New. Creates a new page of the drawing. Upon pressing the button, a new page is added in the

document, launching the name editing mode. The page type is Normal by default. If necessary, you

can assign the desired type via the Page Type drop-down list.

Copy. Creates copy of the selected page with its parameters.

Delete. Deletes the drawing page selected in the list. If the page is not empty (i.e. contains some

elements), the system queries the user whether to delete objects on the page or associated with the

page. Positive answer results in deleting the page and all associated objects, the negative one cancels

deletion.

Rename. Changes the name of the page. The page name is displayed on the tab. Clicking on the name

of the selected page entry in the list highlights the name and allows its editing. When pages of the 

Workplane type are renamed, the Name parameter of the workplane changes according to the new

name of the page.

Up. Moves the selected page entry in the list one line up.

Down. Moves the selected page entry in the list one line down.

Note that the order of pages in the document, as reflected by the tabs, corresponds with their

positions in the list being described.

Naming Rules... Opens the Naming Rules dialog.

Select. Activates the selected page. Opens the selected page in the 2D drawing window.

Close. Closes the Pages dialog box. Completes the command.

Page Naming Rules

This dialog allows to customize names, which are automatically assigned to pages upon creation. The

left side of the dialog contains list of page types available in the T-FLEX CAD. Right side of the dialog

contains input boxes, where you can type name for pages of a particular type. Name may contain any

user-defined text as well as an automatically assigned number. Two numbering methods are available:

· {#} - sequential numbering within page type

Each type of pages uses independent numbering.

· {##} - consecutive numbering of all pages

Numbering doesn't depend on the type of page
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Handling multi-page documents

As mentioned above, each page of a multi-page document in T-FLEX CAD can be used for creating

various elements: nodes, construction and graphic entities, hatches, text, etc. if necessary, elements can

be moved/copied from one page to another.

Elements located on different pages of the same document can be totally independent of each other,

or, vise versa, related by various means: by the copy operation, by projective relations, via variables

and databases. Besides, T-FLEX CAD allows creating elements located on several pages

simultaneously. When creating text or BOM elements, one can define transition to the new page if the

element being created is getting out of current bounds. As a result, each page will display the

respective part of the multi-page element. Editing and parameter modification commands work on

the whole element, regardless of the portion selected in the command. 

A multi-page document, just as any other T-FLEX CAD document, can be inserted into another

document as a fragment or picture, exported in other graphic formats or printed. Each of these

situations will be reviewed separately.

· When using a multi-page document as a fragment in an assembly drawing, only one page of

the fragment document is inserted. Therefore, when inserting, the user can specify the

particular page of the fragment drawing to assemble, along with specifying fixing points or

vector and defining the fragment variables.

· When inserting a multi-page document in another drawing as a picture, only one page of the

selected document is inserted as well. The required page is determined by the user upon

inserting a picture. 

· When exporting a multi-page document into another graphic format, the output graphic file

will contain the document page that was active when the export command was called (except

exporting to the AutoCAD format).

· When printing a document, the user can specify the pages to print in the print parameters

dialog box.
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Topics in this section:

· Create Page

· Page Size

· Page Tabs

· Update Layout Elements

· Paper Format

· Paper Orientation

· Paper Scale

· Line Thickness Representation

Create Page

Additional pages can be created in a T-FLEX CAD document by the following means:

· Using the <Page Down> key. When created, such pages are automatically assigned the

Normal type.

· Via the New Page command in the contextual menu of page tabs;

· Via the Pages command;

· Automatically while working in certain commands. The type of a thus created page depends

on the actual command. For example, the Control command allows creating a page of the

Control type, while the Drawing View command – a page of Auxiliary type. The Workplane

command creates pages of the Workplane type, while the Create Report/Bill of Materials

command creates pages of the Bill of Materials type. 

The quickest way of creating a new page is use of the <Page Down> key. 

To create a new page, go to the last page of the drawing and press the <Page Down> key. After that,

confirm the new page creation query. The new page is created as a result. It is automatically assigned

a new name "Page N", where N is the page number. Automatic name assignment can be customized.

Already assigned name can be edit using the Pages command or the page tab's contextual menu.

At creation, the page settings are copied from the last active page. These settings can later be

modified by activating the page and calling the Document Parameters command.

Page Size

Each page has its own settings defined via the command "Set Document Parameters". The page size

can also be modified directly in the 2D window by the command "Set Paper Size":
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Icon Ribbon

Workplane > Modes > Page size

Keyboard Textual Menu

<PZ> Customize > Page Size

The command is used for modifying the size of a page and its position. Modifying the page size

parameters affects the "Paper size" parameters on the "Paper" tab of the command "Set Document

Parameters".  

Upon calling the command, the borders of the current page highlight, outlined by a box with graphic

controls of a square shape along the perimeter for resizing. If pointed to one of these squares, the

mouse cursor changes to . It can be dragged now with the left mouse button depressed, modifying

the size of the box diagonal. If pointed to a box mid-side square, the mouse cursor changes to  and

can be dragged now with the left mouse button depressed, modifying the vertical or horizontal size of

the box, respectively.  If within the box, the mouse cursor changes to  and can be dragged now with

the left mouse button depressed, modifying the box position.

The option  allows entering numerical values of the page corners in global coordinates. Upon

modifying the size and/or position of the page, confirm the input with the option . The grid can

be brought up on the active page, and grid snapping turned on, by using the command "Change Grid

settings".

Page Tabs

Calling the command:

Icon Ribbon

View > Window > Page Tabs

Keyboard Textual Menu

- Settings > Window > Page Tabs

The command enables/disables displaying of the page tabs in the 2D window.

If an active document contains several pages, page tabs might be displayed in the drawing window

representing names of visible pages. The set of visible pages depends not only on the presence of

pages in the document, but also on checkboxes enabled in the Show Page Tabs section of the Pages

command dialog.

Page Tabs Management

Page tabs, by default, are located along the lower border of the T-FLEX CAD document window. If

necessary, their location can be changed by moving the page tabs upwards, as it was done in old

versions of the T-FLEX CAD. To do it, it is enough to point with the cursor at the page tab, call the

context menu using  and change the condition of the Tabs placement toggle to the required one

(Top or Bottom).
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Page tabs are used for quick switching between pages of the current document. For switching to the

required page of the document, it is enough to point with the cursor at its tab and press .

Moreover, the <Page Up>, <Page Down> keys can be used for shifting between pages as well.

If the <Page Down> is pressed while being on the last page of the current document, the system will

offer to create a new page. The created page will be placed at the end of the list of pages of the

given document. It is also possible to create a new page by using the New Page command located in

the context menu for the tab of any page.

On each page tab, the page name as well as the symbol showing its type are displayed. By default, the

system gives to the pages the names “Page 1”, “Page 2”, etc. , however, afterwards these names can be

changed to more meaningful ones to make the work more convenient. To rename the page, the

Rename command can be called from the context menu of the page tab. After calling this command,

the system will shift to the mode of editing the text shown on the tab.

The order in which the pages of a document are arranged can be changed. It is possible to quickly sort

the pages by names or by types using the Sort Pages > Name and Sort Pages > Type commands

located in the same context menu called for any tab of the current document.

An arbitrary change in the page arrangement can be carried out just by dragging the page tab to

another place. To do it, bring the cursor to the required tab, press  and without releasing the

mouse button, drag the cursor to the required position in the list of tabs.

Using the  Font… command it is possible to modify font parameters used for displaying the text on

the page tabs. Upon calling this command the standard window of font parameters opens up. 
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The Delete command allows removing the page on the tab of which the context menu has been

called. If the page being removed contains some drawings, the system will inform about that and ask

a user to confirm the necessity of page removal and all its contents.

The Pages… command invokes the dialog for controlling pages of the document. This dialog allows

performing various operations with pages: create and delete pages, rename, change the type of page

and its location in the list of pages. 

The Hide Page Tabs command turns off the display of the page tabs for the document. After the tabs

were turned off, it is possible to turn the display of the page tabs back on using the Page Tabs

command.

Page drop-down

When page tabs are enabled, right side of the page tabs bar contains the button . Clicking  on

this button invokes a drop-down list of visible pages. Clicking  on a page in the list switches the

view to such page.

Update Layout Elements

Calling the command:

Icon Ribbon

Title Block > Options > Update layout elements

Keyboard Textual Menu

- Title Block > Update layout elements

The command is also available in the bottom part of the View Toolbar in 2D window.

The dialog containing following checkboxes pops-up upon calling the command:

· Title Block;

· Drawing Notes;

· Unspecified Roughness.

Enable checkboxes of elements, which have to be updated.

Following options are available in the Update drop-down list, which is located below the checkboxes:

· Current Page

Only the current page will be updated upon clicking OK.

· All Pages

All pages of the current document will be updated upon clicking OK.
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Paper Format

The drop-down list of main standard paper formats  is available in the View Toolbar in 2D

windows. The selected format is applied to the active drawing page. Selecting the Other... option

invokes the Paper tab of the Document Parameters dialog, where you can select other formats or

type in custom paper width and height.

Paper Orientation

The command for switching paper orientation of the current drawing page is available in the View

Toolbar in 2D windows. Two orientations are possible:

 Landscape;

 Portrait.

The icon of the command represents the current orientation.

Paper Scale

The drop-down list of main standard drawing scales  is available in the View Toolbar in 2D

windows. The selected scale is applied to the active drawing page. Selecting the Other... option
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invokes the Paper tab of the Document Parameters dialog, where you can select other scales or type

in custom scale value.

Line Thickness Representation

The command defining the thickness of lines representation on the screen  for the current page is

available in the View Toolbar in 2D windows.

The command invokes the drop-down list containing following options:

· No more than three pixels 

Thickness no more than three pixels will be displayed in real size, thicker lines will be

displayed in three pixels thickness.

· Actual thickness 

Lines will be displayed in real size, specified in the line parameters.

· One pixel 

The thickness of all lines will be equal to one pixel.

· Always three pixels 

Main solid graphic line types (whose thickness is defined by the Thick Lines parameter in

Document Parameters) will be displayed in three pixels thickness, other line types - in one

pixel thickness.

The selected option is saved, when saving the document.
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Show Model Properties

Calling the command:

Icon Ribbon

File > Properties

Keyboard Textual Menu

<PS> File > Properties

The command allows you to view all the characteristics of the current document.

The dialog is divided into separate tabs.

General tab

This is an information tab. Parameters located on this tab cannot be changed. These parameters

contain information about the name of the drawing, the full path to the file, its size, dates of creation,

modification and use, as well as file attributes.

Info tab

This tab contains information about the title of the drawing and topic, author and company. A

drawing may be categorized, keys for searching may be indicated, and comments on the drawing may

be described.

Закладка Статистика
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Statistics tab

This tab contains information about the dates of creation, modification and printing of the drawing

file. Please note, when using a drawing from a previous version of the program, the creation date is

the same as the date of use.

When a file is saved information about the name of the user who saved the drawing, the copy number,

and the total editing time is entered in the drawing characteristics.

You can also view statistics on the number of construction elements and images included in the

drawing.
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View. 3D Scene

This chapter will describe managing 2D and 3D view windows, their display options, working with the

3D scene and managing visibility of elements. Almost all control buttons are located on the View

panel.

Topics in this section:

· 3D Scene and View Window Interface

· View Windows

· Working with the 3D View Window

· Controlling Elements Visibility

· Manage Font Size

· Preview of Operation Result

3D Scene and View Window Interface

In this section, you can learn about the different ways to arrange windows.

Topics in this section:

· Document Tabs

· Drawing Window Scrollbars

· Rulers

· Status Bar

· Page Tabs

Document Tabs

Command call:

Icon Ribbon

View > Window > Document Tabs

Keyboard Textual Menu

Customize > Tool Windows > Document Tabs

The command is also available in the system customization drop-down menu , which is located in

the upper right corner of the T-FLEX CAD main window.
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The command enables/disables displaying of document tabs.

By default the document tabs are enabled and located above the upper border of the document

window. Their location can be changed if desired. For that, it is necessary to point at the tab of any

document with the cursor and click . The contextual menu appears, where you need to select the

Placement item.

The name of the document is shown on the tab. If document contains unsaved changes, the asterisk *

is added in front of the name. 

Clicking the  button located in the right side of the tab closes the corresponding document window.

The document window can also be closed by clicking  on its tab.

Clicking  on a tab switches the view to the corresponding document. Tabs can be reordered by

dragging the desired tab while holding .

Contextual menu of a document tab

The contextual menu of a document tab contains following options:

Close document

Closes all windows of the corresponding document in all main windows of the current session.

Close Window 

Closes the corresponding document window.
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Hide Document Tabs 

Disables document tabs and applies the Cascade command.

Placement 

Allows you to select the position of the tabs - at the bottom of the document window or at the top.

Windows… 

Invokes the Windows List.

Fixed width 

Sets the same width to all opened tabs.

New main window 

Allows to create a New main window and copy the selected tab into it.

Move to main window 

Allows to transfer tabs between main windows.

Document drop-down

When document tabs are enabled, the  button is displayed in the right side of the document tabs

bar. Clicking  this button invokes the drop-down list of all document windows present in the

current main window. Clicking  on a document in the list allows to switch to its window.

When tab groups are enabled, each group has its own document drop-down.

Document Windows appearance with enabled/disabled Document Tabs

The appearance of open document windows with enabled tabs is different from that with disabled

tabs.

When tabs are on, the windows of open documents occupy the whole space of the T-FLEX CAD main

window's working area. The active window, (i.e. the window of the current document) is on the top of

other document windows.

When the tabs are enabled, it is not possible to minimize the document window or change its size. 

When the tabs are disabled, document windows can be in one of the three states:

· Maximized (expanded). The document window occupies the whole working area of the T-

FLEX CAD main window and doesn't have the header. The name of the active document

appears only in the header of the T-FLEX CAD main window. 

· Minimized (collapsed). The window shrinks to a small header bar with the name of the

document and system buttons for controlling the window. 

· Arbitrary. The window has a smaller size than T-FLEX CAD main window's working area. It has

a header, in which the name of the document is shown.

Regardless of the window size, with the disabled tabs, the document window has three buttons

enabling to control its state or close it.

 

When the window is maximized, these buttons are located under the respective ones of the

application main window. Pay attention as to what button to use when closing a window.
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Main window control buttons

Document window control buttons

An alternative way of maximizing a window is double-clicking  on the window header.

If a window has a header bar, that is, it is not maximized, then the window management context menu

can be called by pointing at the icon at the left end of the header bar and clicking .

When a window has an arbitrary size, such size can be modified. Simply move the cursor over any

window edge until it changes to a double-headed arrow, then hold  and drag the edge of the

window to the desired size.

Drawing Window Scrollbars

Command call:

Icon Ribbon

View > Window > Scrollbars

Keyboard Textual Menu

<WSS> Window > Scrollbars

The command is also available in the system customization drop-down menu , which is located in

the upper right corner of the T-FLEX CAD main window.

The command enables/disables scrollbars located to the right side and to the bottom of the

document window. Scrollbars can be used for navigating in 3D and 2D windows. Scrollbars are

disabled by default. 
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Enabling scrollbars shrinks the working area of a window. Scrollbars functionality is not accessible via

keyboard, though there are several other tools that serve similar purpose and have even more

capabilities (e.g.: rulers, ).

If the working area of the main window is slit into several parts (view windows and/or document

windows) along horizontal axis, then the single vertical scrollbar is used for navigating the currently

active part of the window. Horizontal scrollbars are separate for each part of the window In such

cases. If the working area is split along vertical axis, then the single horizontal scrollbar and separate

vertical scrollbars are used. If the working area is split along both axes, then separate horizontal and

vertical scrollbars are used. Activating the parts of the working area is performed via pointing the

mouse cursor over the desired part and clicking any of the mouse buttons.

Rulers

 Call the command:

Icon Ribbon

View > Window > Rulers

Keyboard Textual Menu

Customize > Tool Windows > Rulers

The command is also available in the system customization drop-down menu , which is located in

the upper right corner of the T-FLEX CAD main window.

Rulers allow us to orient ourselves in 3D space, estimate the size of a model and distances between

the elements of a model. Coordinates displayed on the rulers constitute the coordinates on the

imagined plane parallel to the plane of the screen.

Also with the help of rulers of 3D window it is possible to create, in transparent mode, the new

workplanes and edit location of already existing workplanes. This will be described in more detail in

the Workplanes chapter of this user’s manual.
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The rulers display X and Y coordinates of the current drawing window. Ruler properties can be set with

the help of the context menu. 

Ruler visibility can be set via the textual menu Customize > Tool Windows > Rulers or the context

menu coming up on clicking  over any toolbar.

Rulers can be used for navigating around the drawing. In the mode when there is the button in the

corner between the vertical and horizontal rulers, the horizontal ruler can be dragged by pressing and

holding  and moving the cursor right and left. The drawing image moves together with the ruler

and cursor. Release  to fix the image in the current location. Similarly, the drawing can be moved

up and down by dragging the vertical ruler.

Pressing the button at the horizontal and vertical rulers crossing with  switches to another button

mark. In this mode, the rulers can be used for zooming the drawing in and out.

To zoom the drawing in, point the cursor at the horizontal or vertical ruler, press and hold , and

drag right or up respectively. To zoom out, drag  left or down, respectively. Releasing  fixes

the drawing image in the current zoom. 

To switch the mode back to panning, press the button at the rulers intersection once again. 

Rulers can be displayed in 3D window. In this case, they allow you to better navigate in 3D

space, estimating distances and sizes. Ruler shows 3D coordinates of the window on an

imaginary plane parallel to the screen.

With the help of rulers in 3D window, you can move and copy the workplane. More information

can be found in the Workplanes chapter.
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Status Bar

 Call the command:

Icon Ribbon

View > Window > Statusbar

Keyboard Textual Menu

Customize > Tool Windows > Statusbar

The command is also available in the system customization drop-down menu , which is located in

the upper right corner of the T-FLEX CAD main window.

The status bar is located at the bottom of the application window and contains following fields (left

to right):

1. The current command name field. 

This field displays the full name of the current command. The field can also be used as the input box

for calling a command by typing on keyboard. Type the reserved keyboard accelerator sequence or

press a function key combination. Typing a sequence that is not part of any command name

automatically clears the field. If so, type again. A correctly typed accelerator sequence causes the full

command name and a brief description to be displayed. For instance, type the following sequence,

<RO>. Once typed <O>, you enter the command for creating roughness symbols, and the field will

display Create Roughness Symbol. When hovering the mouse over a command's and option's icon or

menu items on instrumental toolbars, system toolbar, filter toolbar, view toolbar, automenu, textual

and contextual menus, this field displays a name of such command or option.

2. Help field. 

This is an information field displaying help messages and prompts for user. If a command is active,

this field displays suggested user actions. If some element is selected in the command standby mode,

this field displays a name of a selected element or number of selected elements upon multiple

selection.

3. Cursor coordinates and 2D element's parameters.
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These fields are active only when one of the 2D drawing commands is active (both in 2D window and

in drawing on a workplane mode). First field displays an X coordinate of the cursor. Second field

displays an Y coordinate of the cursor. Third field displays a main parameter of a created element

(length of a line segment, angle of a construction line, radius of a circle etc.)..

View Windows

A single document window may contain several view windows. View windows can be managed using:

· Views Placement command;

· mouse;

· window split commands;

· rulers.

You can also save the fixed set of windows.

 Views Placement

The command can be called in one of the following ways:

Icon Ribbon

View > Window > Views Placement

Keyboard Textual Menu

<WSW> Window > Views Placement

The command is also available in the top of the View Toolbar.

The View Placement dialog pops-up upon calling the command. It allows to select the desired

configuration of view windows in the current document window.
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Click  on buttons located in the upper part of the dialog allows you to select one of the preset

view windows configurations. Preset configurations contains following types of view windows

arranged in several orders:

·  2D views (drawing pages);

·   3D views with free rotation;

·    3D views with fixed camera orientation.

The area below preset configurations is split into four parts. Each part contains a drop-down list. This

represents the splitting of the document window. Enable/disable the checkbox near the bottom left

drop-down to enable/disable splitting of the document window along vertical axis. Enable/disable

the checkbox near the top right drop-down to enable/disable splitting of the document window

along horizontal axis. Type of view for a particular part of a window can be selected in a

corresponding drop-down list. Unlike preset configurations, more view types are available in drop-

down-lists:

· 2D view (drawing page);

· 3D view (with free rotation);

· Database Editor;

· SE Graph;

· Graph Editor;

· Photorealistic View.

The Main Window: field contains the name of the current main window.

Enabling the Set as default checkbox applies the selected view windows layout as default for all new

document windows in the current session. With this checkbox enabled the Views Placement dialog

does not appear upon creating a new document window. Ending the current session and starting a

new one disables this option.
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When the window is divided into parts, the active window is highlighted with a frame, the color of

which is set in the System Options. The default color is orange.

View windows layout for a particular document is saved upon saving such document.

Splitting adjustment using the mouse

Proportions of splitting a document window into several view windows may be adjusted using the

mouse. Get the cursor over the vertical or horizontal splitting line. The cursor's symbol changes to .

Then you can hold  and drag the mouse. Splitting line will follow the cursor until you release  .

Moving splitting line beyond the border of the working area closes view windows adjacent to said

border.

Window split commands

Icon Ribbon

View > Window > Split Horizontally

Keyboard Textual Menu

<WSH> Window > Split Horizontally

The command toggles splitting the active document window into two view windows by the horizontal

line.
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Icon Ribbon

View > Window > Split Vertically

Keyboard Textual Menu

<WSR> Window > Split Vertically

The command toggles splitting the active document window into two view windows by the vertical

line.

Enabling horizontal and vertical splitting at the same time makes active document window split into

four views. 

If 2D view is active, these commands add 3D view windows (with free rotation); otherwise they add 2D

view windows. 

Window split commands are also available in bottom left corner of the active view window:

Enabling a split highlights a button of a corresponding command.

Splitting the window using ruler

Rulers in 2D windows contain buttons for toggling the window split. Vertical split button is located at

the right end of the horizontal ruler. Horizontal split button is located on the bottom end of the

vertical ruler.

If a single view window is open at the moment, clicking the vertical split button creates a new 3D view

window to the right side of the current window.
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If two horizontally split view windows are open at the moment, clicking the vertical split button

creates two new 3D windows. If vertical splitting is already applied, clicking the button removes

splitting and closes the right view window.

Horizontal split button works in the similar way.

Fixed set of windows

The layout of view windows in the current document can be fixed by enabling the Fixed set of

windows checkbox in the Document Parameters dialog (Document Parameters > Document > 3D)

and saving the document. Upon next opening of such document, layout of view windows will be the

same as at the moment of saving. Changing the layout will be unavailable.

Topics in this section:

· Presentation Mode

· Full Screen

· Manage 2D View

Full Screen

Call the command:

Icon Ribbon

Keyboard Textual Menu

<FS>, <F11> View > Full Screen

The command allows you to work in the largest working window. When you call this mode, all

auxiliary windows and panels will close, the presence of which on the screen is specified in the View >

Windows menu. You can restore the previous configuration of the windows by clicking on the 

icon in the upper right corner of the screen or by choosing the menu item Window > Full Screen.

Presentation Mode

Icon Ribbon

-

Keyboard Textual Menu

<Shift>+<F11> Window > Presentation Mode
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Only 3D scene remains in the presentation mode. 3D model tree is hidden. Ribbon is available in the

full screen mode.

Manage 2D View

After creating a view window, the user can change the parameters of this view.

Zoom Selected elements

The command can be called in one of the following ways:

Icon Ribbon

View > Zoom > Selected elements

Keyboard Textual Menu

<ZS>

The command can also be called from the View Toolbar in 2D or 3D window and from the contextual

menu of selected 2D and 3D elements.
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This command reframes the working window so that it wraps up selected elements. It is useful when

you lost the sight of selected elements. Also use it when you need to find a particular object in big

assembly (select object in the tree and apply the command). 

Zoom Area

The command can be called in one of the following ways:

Icon Ribbon

View > Zoom > Zoom Area

Keyboard Textual Menu

<ZW>, <F3> View > Scale > Zoom Area

The command can also be called from the View Toolbar in 2D or 3D window.

This command can be used for panning and scaling the visible area.

An arbitrary area of the drawing can be zoomed on by specifying two opposite corners of a box.

Move the cursor to one corner of the area to be zoomed on, and press and hold . A rectangle

starts rubberbanding after the cursor. Drag it, selecting the desired area by box, and then release the

button .

Following options become available in the automenu upon calling the command:

<P> Set command options

<I> Zoom In

<O> Zoom Out

<L> Pan Left

<R> Pan Right

<U> Pan Up

<D> Pan Down

<A> Zoom Model to paper size
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<M> All Objects

<W> Set absolute window coordinates

<T> Actual Size

<BackSpace> Set previous window coordinates

<S> Save current window coordinates

<Esc> Exit command.

The Window mode dialog pops-up upon selecting the  option. There you can customize panning

and scaling increments defined as percentage of the window's size. These parameters are applicable

not only to the Zoom Area command but also to main camera keyboard shortcuts usage.

The Window coordinates dialog pops-up upon selecting the  option. There you can set position

of the working window in coordinates of the active drawing sheet. This option works in 2D window

only. 

The Window dialog pops-up upon selecting the  option. There you can type in the Window

Number, using one of the numbers from 0 to 9. Current position of the working window is saved

under the specified number upon clicking OK. You can call the previously saved position by pressing

the corresponding numerical key on the keyboard. It works only when Zoom Area command is active.

Saved positions are common for all documents in the current session. They are not written in

document files and are cleared upon quitting the T-FLEX CAD.
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Additional Zoom Area commands

Most automenu options of the Zoom Area command are also available as separate commands listed

below:

By Page Size

The command can be called in one of the following ways:

Icon Ribbon

View > Zoom > By Page size

Keyboard Textual menu

<ZA>,

<Ctrl>+<Shift>+<Home>
View > Scale > Page

The command can also be called from the View Toolbar in 2D window.

This command reframes the working window according to the drawing format size. 

Zoom Limits

The command can be called in one of the following ways:

Icon Ribbon

View > Zoom > Zoom Limits

Keyboard Textual Menu

<ZM>,

<Ctrl>+<Shift>+<End>
View > Scale > All objects

The command can also be called from the View Toolbar or by double-clicking on the middle mouse

button in 2D or 3D window.

This command reframes the working window in such way that it fits all elements of 3D model or

drawing (except some 2D constructions that are not associated with graphic lines).

Zoom In

The command can be called in one of the following ways:

Icon Ribbon

View > Zoom > Zoom In

Keyboard Textual Menu

<ZI>,

<Ctrl>+<Shift>

+<PageUp>

View > Scale > Zoom In

Zooms in the working window. Zooming increment is set in the Zoom Area command.
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Zoom Out

The command can be called in one of the following ways:

Icon Ribbon

View > Zoom > Zoom Out

Keyboard Textual Menu

<ZO>,

<Ctrl>+<Shift>

+<PageDown>

View > Scale > Zoom Out

Zooms out the working window. Zooming increment is set in the Zoom Area command.

Pan Up

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual Menu

<ZU>,

<Ctrl>+<Up>
View > Scale > Pan Up

Pans up the working window. Panning increment is set in the Zoom Area command.

Pan Down

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual Menu

<ZD>,

<Ctrl>+<Down>
View > Scale > Pan Down

Pans down the working window. Panning increment is set in the Zoom Area command.

Pan Right

The command can be called in one of the following ways:
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Icon Ribbon

-

Keyboard Textual Menu

<ZR>,

<Ctrl>+<Right>
View > Scale > Pan Right

Pans right the working window. Panning increment is set in the Zoom Area command.

Pan Left

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual Menu

<ZL>,

<Ctrl>+<Left>
View > Scale > Pan Left

Pans left the working window. Panning increment is set in the Zoom Area command.

Actual Size

The command can be called in one of the following ways:

Icon Ribbon

View > Zoom > Actual size

Keyboard Textual Menu

<ZT> View > Scale > Actual size

This command allows you to display the image of the active window (2D view or 3D view) according

to their actual dimensions.

Zoom by Coordinates

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual Menu

<ZT> View > Scale > Zoom by Coordinates

This command is only available fro 2D window.
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The Window coordinates dialog pops-up upon calling the command. There you can set position of

the working window in coordinates of the active drawing sheet. It works in a similar way as in the 

option of the Zoom Area command. 

Previous

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual Menu

<ZP> View > Scale > Previous

Restores the working window previous position.

Working with the 3D View Window

The 3D view window (the 3D window) is one of the main system tools for working with the 3D model.

It is used for the 3D scene rendering. The 3D window serves for viewing the model being created, as

well as for selection of 3D objects for performing various manipulations with them (getting

information about the selected object, editing, using as a base reference when creating operations

and 3D constructions).

What is «3D Scene»?

3D scene is the entirety of all 3D objects (3D bodies and 3D constructions) that are present in the

model. The size of the 3D scene is determined by the minimal cube fitting all 3D elements. When

determining dimensions of the cube, the invisible 3D objects hidden from display by various methods

are also included in the account.

Objects in the 3D scene are viewed using cameras. The camera that feeds the image in the 3D

window, is called the active camera. By default, only the system camera is present in the model, which

is located beyond the limits of the 3D scene. This is what is normally used to view the 3D scene. In

most cases, just the system camera is enough for working with the 3D model. The position and

orientation of the system camera can be controlled. The system camera cannot be deleted, neither can

it be moved inside the 3D scene (the distance from the camera to the center of the 3D scene cannot

be made less than half the 3D scene size).

In certain cases (for example, when surveilling inner parts of complex 3D models or when creating

animation clips) the capabilities of just the system camera may not suffice. In such cases, the user can

create and use one's own cameras for setting up a view in the 3D window. Custom cameras are

attached to local coordinate systems (LCS). An LCS position determines a camera position. The

respective section of this chapter is devoted to working with custom cameras.
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Light Sources

Illumination of bodies in the 3D scene is provided by light sources. Light sources can be divided into

two main types:

· Stationary sources created by the user in the command Create Light Source. Such light sources

are independent of the used camera and its position. How to create stationary light sources

will be described in details in the Light sources chapter of this manual;

· Dynamic light sources, "mounted" on the active camera. The position of such light sources is

defined relative to the active camera. When moving/rotating the active camera, the light

sources will be also changing their position. 

Dynamic light sources, as well as the visualization method, are characteristics of the 3D window,

that does not depend on the used camera (whether the system or a custom one). 

By default, there are two light sources in the 3D window attached to the active camera, an ambient

light source (which uniformly illuminates the entire space of the 3D scene) and a directional source of

white light, located on the camera. If necessary, the user can change their parameters (color, intensity,

and, for a directional light - the position with respect to the camera), as well as manually create

additional dynamic light sources. 

Creation and editing of light sources attached to the active camera is done in the special 3D view

parameters dialog. You can also specify there the background color of the 3D window (the

background color does not depend on the light sources present in the 3D window). The user can select

any color as the background according to one's preferences. You can use a transitional background

color (with a smooth change from one color to another).

Using 3D Views

You can use the system preset 3D views for quick setup of a 3D window. 3D View is a set of

information about a 3D window, including information about the parameters of the used camera,

about the light sources attached to it, the current rendering method, etc.

When loading one of the 3D views stored in the system, into the current 3D window, the 3D window is

automatically set up according to the data of this 3D view.

The user can edit 3D views present in the system, adding to those unique sets of data about the state

of the 3D window. 3D views are handled in the special 3D view parameters dialog.

Managing 3D Window

Use the commands located in the View textual menu to manage the 3D window and the 3D scene

display in it. Commands are grouped according to their purpose. Some of the commands are also

available on the same-name View toolbar.

There is yet another way to call these commands. Point the mouse to a free space of the 3D window

and right-click . The coming up context menu will contain all commands for managing the 3D

window. The state of the context menu icons informs you about which mode of a particular command

is currently active.

Working with Custom Cameras

Creating and using custom cameras will be described in details in the Cameras chapter. Here we will

just describe general techniques of working with them.

Custom cameras are used in the cases, when the system camera is not sufficient. In such a case, the

user can create one's own cameras in order to get the desired effect - for example, for surveilling inner

parts of complex 3D models or creating animation clips. 



View. 3D Scene

173

The position of a custom camera is defined using an LCS. This same LCS defines the viewing direction

for a custom camera. A number of parameters are defined for a camera, which define the image it

yields (for example, the projecting method).

To view the 3D window from the custom, rather than the system camera, select the custom camera as

the active camera of the given 3D window. This can be done in the command Select Camera.

Icon Ribbon

View > Properties

Keyboard Textual Menu

<3VC> View > Camera > Select Camera

After calling the commands, the "Select Camera" dialog window appears, which contains the list of all

cameras present in the current 3D model. In it, select the camera that will be used for viewing

(surveilling) the 3D scene. 

When working with multiple 3D windows, an individual active camera can be specified for each

window. 

While working with a custom camera, you can use auto resizing of the 3D scene image, using clip

plane, modify existing and create new light sources on the camera. How to move and spin the active

custom camera is described in details in the "Cameras" chapter.

Working with the 3D view parameters dialog is similar to the described case of using the system

camera, with one exception: the parameters pertaining to the active camera will not be available for

editing in the dialog. In the case of custom cameras, these parameters are defined in the parameters

dialog of the camera itself. 

You cannot modify parameters of the active custom camera. If necessary, first select another

camera as the active one (system or custom).

Topics in this section:

· 3D Scene Rotation

· View Point

· View Style

· Image Quality

· Projection Method
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· Clip Plane

· Apply Section in 3D View

· Set View Parameters

3D Scene Rotation

Controlling the System Camera. Rotating (Spinning) and Moving a Camera

Initially after opening the 3D window, the system camera is located at the distance providing visibility

of all elements of the 3D scene (that is, all 3D constructions and 3D Bodies present in the model). To

view the 3D scene, you can rotate (spin) and/or move it arbitrarily, zoom in and out, change the

orientation and view direction, as well as scale the image in the 3D window.

As the user watches the 3D window in the process of spinning (rotating) and moving the system

camera, one feels as if the 3D scene itself is moving, rather than the camera. Therefore, when

describing 3D model handling in the future, we will frequently refer to the process of rotating

(spinning) and moving the system camera as the 3D scene rotation.

Rotating the 3D Scene

When working with a 3D model, the most commonly used is the free rotation mode; therefore it is

preset in the 3D window by default. The camera can be panned, rotated, zoomed in/out using the

mouse and the keyboard. 

Notice that under "zooming in/out the camera" we mean changing the focal length of its

objective lens. The camera itself, however, stays still.  This process is similar to the function of a

real camera. 

The most common way of rotating the camera is dragging the mouse with the  depressed within

the 3D window. 

You can use additional commands described in the Manage 2D View chapter for controlling the

3D scene as well. 

Center of camera rotation

Rotating the image in the 3D window with the default system camera active is achieved by moving

the camera around the scene center. If necessary, the center of rotation can be changed via the Set

Center Of Rotation command:

Icon Ribbon

View > 3D Model > Set center of rotation > Set center of rotation

Keyboard Textual menu

<3RC> View > Rotate > Set center of rotation

The command can also be called from the contextual menu.

After the call, the current camera rotation center appears on the screen as a crosshair. Following

options become available in the Parameters window:

 Intersection point

 Solid center

X, Y and Z coordinates of a selected center of rotation are displayed below.
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Upon selecting the  option, you need to click  on an operation in the 3D scene. The crosshair

representing the rotation center will relocate to a center of mass of the body created by a selected

operation.

The  option allows to select an arbitrary point as the center of rotation. Upon selecting the

option, click  on arbitrary location in the 3D scene. A ray parallel to the view direction will be cast

from the selected location through the 3D scene. If this ray intersects with some 3D object, the

intersection point becomes the center of rotation. If this ray does not intersect any of 3D objects, the

center of rotation remains unchanged. 

It is possible to define arbitrary center of rotation without calling the Set Center of Rotation

command. This can be done by pressing  without releasing for some time at any object within 3D

scene. The crosshair will appear at the specified point. This represents the position of the new

temporary center of rotation. After finishing the rotation (when mouse button is released) center of

rotation returns to the original position.

The Reset center of rotation command is used for clearing the custom center of rotation and

reverting to the default one:

Icon Ribbon

View > 3D Model > Set center of rotation > Reset center of rotation

Keyboard Textual menu

View > Rotate > Reset center of rotation

Fixed view direction 

Is enabled via the Fix command.

Icon Ribbon

View > 3D Model > Fix

Keyboard Textual menu

<3RL> View > Rotate >  Fix

The command can also be called from the contextual menu.

Enabling this mode makes rotation of the 3D scene impossible. However, you still can pan and zoom.

This setting is saved in the active document and remains enabled upon opening the document in

other sessions.
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To disable this mode select one of the system camera rotation modes.

System camera rotation modes

There are the following system camera rotation modes:

· Free rotation.

· Rotation about one of the axes of the coordinate system located at the center of rotation. 

Axes orientation may be defined either by the global coordinate system, or by the screen

coordinate system.

· Panoramic Rotation.

Free camera rotation mode:

Icon Ribbon

View > 3D Model > Free> Free

Keyboard Textual menu

<3RF> View > Rotate > Free

The command can also be called from the contextual menu.

This mode id set by default. It allows to rotate 3D camera in any direction around a center of rotation.

Rotation around X axis mode:

Icon Ribbon

View > 3D Model > Free > Around X Axis

Keyboard Textual menu

<3RX> View > Rotate > Around X Axis

The command can also be called from the contextual menu.

At the center of the rotation is an imaginary coordinate system, relative to the X-axis of which the

rotation occurs. The orientation of the axes of this coordinate system coincides either with the

direction of the axes of the global coordinate system, or with screen coordinate system.

Rotation around Y axis mode:

Icon Ribbon

View > 3D Model > Free > Around Y Axis

Keyboard Textual menu

<3RX> View > Rotate > Around Y Axis

The command can also be called from the contextual menu.

At the center of the rotation is an imaginary coordinate system, relative to the Y-axis of which the

rotation occurs. The orientation of the axes of this coordinate system coincides either with the

direction of the axes of the global coordinate system, or with screen coordinate system.
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Rotation around Z axis mode:

Icon Ribbon

View > 3D Model > Free > Around Z Axis

Keyboard Textual menu

<3RZ> View > Rotate > Around Z Axis

The command can also be called from the contextual menu.

At the center of the rotation is an imaginary coordinate system, relative to the Z-axis of which the

rotation occurs. The orientation of the axes of this coordinate system coincides either with the

direction of the axes of the global coordinate system, or with screen coordinate system.

Orientation of the coordinate axes for three aforementioned rotation modes is defined by condition

of the Screen coordinate system mode:

Icon Ribbon

View > 3D Model > Free > Screen coordinate system

Keyboard Textual menu

<3RS> View > Rotate > Screen coordinate system

The command can also be called from the contextual menu.

When this command is active, rotation occurs in the screen coordinate system, when off - the

orientation of the rotation coordinates coincides with the global coordinate system. Screen

coordinate system is formed by two axes laying in the screen plane (one vertical, one horizontal) and

an axis coinciding with the view direction.

Panorama mode:

Icon Ribbon

View > 3D Model > Free > Panorama

Keyboard Textual menu

<3RP> View > Rotate > Panorama

The command can also be called from the contextual menu.

In this mode the Z axis cannot lean left/right. You can still lean it back/forward though. The projection

of Z axis onto a screen plane always remains vertical. The mode of the panoramic rotation can be

useful when working with the models of buildings, furniture, interiors etc.

Automatic Rotation

The command can be called in one of the following ways:
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Icon Ribbon

View > 3D Model > Free > Automatic rotation

Keyboard Textual menu

<3RA> View > Rotate > Automatic rotation

The command can also be called from the contextual menu.

Automatic rotation can be applied in any of the rotation modes mentioned above. 

To define rotation parameters, depress  and, while holding it, drag the mouse in the rotation

direction. After that, release . In that way, you define the direction and angular rotation velocity.

The automatic rotation mode is switched off by a repeated call of the same command.

Auto-Resize

The command can be called in one of the following ways:

Icon Ribbon

Keyboard Textual menu

<3VA> View > Auto-Resize

It switches on/off the mode where each regeneration of the model leads to 3D window automatically

reframing in such way that it fits all existing 3D objects.

Rotate Normal to Selected Element

The command can be called in one of the following ways:

Icon Ribbon

Keyboard Textual menu

<3VN> View > Rotate Normal to Selected Element

It makes view direction normal to selected element.

3D scene rotation via the contextual menu

3D scene rotation commands are also available in the contextual menu invoked by clicking  on an

empty space in the 3D scene in command standby mode.

An icon of a currently active mode is highlighted in menus.
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View Point

For the convenience of working in the system, a set of standard view points is prepared.

All standard view points are displayed in the View Toolbar:

Note that the resulting image depends on which projection mode is set: Parallel projection or

Perspective projection. 

Front View

Call the command:

Icon Ribbon

View > 3D View > Front View

Keyboard Textual Menu

<Ctrl>+<Num 5> View > Projection > Front View

The command applies standard front view point to main camera in the 3D scene.

Back View

Call the command:
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Icon Ribbon

View > 3D View > Back View

Keyboard Textual Menu

<Ctrl>+<Num 0> View > Projection > Back View

The command applies standard back view point to main camera in the 3D scene.

Top View

Call the command:

Icon Ribbon

View > 3D View > Top View

Keyboard Textual Menu

<Ctrl>+<Num 8> View > Projection > Top View

The command applies standard top view point to main camera in the 3D scene.

Bottom View

Call the command:

Icon Ribbon

View > 3D View > Bottom View

Keyboard Textual Menu

<Ctrl>+<Num 2> View > Projection > Bottom View

The command applies standard bottom view point to main camera in the 3D scene.

Right View

Call the command:

Icon Ribbon

View > 3D View > Right View

Keyboard Textual Menu

<Ctrl>+<Num 6> View > Projection > Right View

The command applies standard right view point to main camera in the 3D scene.

Left View

Call the command:



View. 3D Scene

181

Icon Ribbon

View > 3D View > Left View

Keyboard Textual Menu

<Ctrl>+<Num 4> View > Projection > Left View

The command applies standard left view point to main camera in the 3D scene.

Axonometric (front)

Call the command:

Icon Ribbon

View > 3D View > Axonometric (front)

Keyboard Textual Menu

<Ctrl>+<Num 7> View > Projection > Axonometric (front)

The command applies standard Axonometric (front) view point to main camera in the 3D scene.

Axonometric (bottom front)

Call the command:

Icon Ribbon

View > 3D View > Axonometric (bottom front)

Keyboard Textual Menu

<Ctrl>+<Num 1> View > Projection > Axonometric (bottom front)

The command applies standard Axonometric (bottom front) view point to main camera in the 3D

scene.

Axonometric (back)

Call the command:

Icon Ribbon

View > 3D View > Axonometric (back)

Keyboard Textual Menu

<Ctrl>+<Num 9> View > Projection > Axonometric (back)

The command applies standard Axonometric (back) view point to main camera in the 3D scene.

Axonometric (bottom front)

Call the command:
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Icon Ribbon

View > 3D View > Axonometric (bottom back)

Keyboard Textual Menu

<Ctrl>+<Num 3> View > Projection > Axonometric (bottom back)

The command applies standard Axonometric (bottom back) view point to main camera in the 3D

scene.

View Style

T-FLEX CAD supports various ways to view 3D models. The selected visualization method is applied by

default to all elements of the 3D scene. 

Note that a visualization method is a characteristics of the 3D window, and does not depend on

the camera used (whether the system or a custom one). That means, the visualization method

assigned to a 3D window is maintained even when switching the active camera (that is, the one

used at the moment for viewing the 3D scene).

The wireframe mode can be also assigned to individual 3D Bodies or operations. Such 3D object will

be rendered in the wireframe mode always, regardless of the visualization method set for the 3D

window. The sticky wireframe mode can be turned on by adjusting parameters of the respective 3D

Body or 3D operation (see the chapter General parameters of 3D elements).

For shading and shading with materials it is possible to additionally enable the mode of

semitransparent viewing. When using the semi-transparency, the 3D model is displayed according to

the rules of the main method of visualization but all faces of the bodies in the 3D scene become

semitransparent.

Transparent view can be enabled individually for any  Body of the model. But such a Body will be

displayed as transparent only when the mode of shading with materials is used. The transparent view

can be enabled in the dialog of parameters of the Body or in the dialogs of parameters of operations

included into the history of creation of the given Body (see the General Parameters of 3D Elements

chapter). 

Moreover, there is a possibility to make transparent the individual faces of Bodies. This can be done

with the help of the Apply material command. Transparency of faces is also visible only in the mode

of shading with materials. 

For quick access to the commands on the View panel there is a drop-down list:

Render

Call the command:
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Icon Ribbon

View > View Style > Render

Keyboard Textual menu

<3VD> View > Render > Render

After calling the command, a three-dimensional model with the materials assigned to the bodies and

the installed light sources will be displayed in the 3D view window of the current drawing.

In addition to material each body as whole and each individual face of a body in the 3D scene

has its own color. Colors are not visible in this view style.

Shading

Call the command:

Icon Ribbon

View > View Style > Shading

Keyboard Textual menu

<3VS> View > Render > Shading

After calling the command, the 3D view window of the current drawing will display a three-

dimensional model with shading.
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Only this view style represents colors and transparencies of particular faces set in face

parameters dialog.

Wireframe

Call the command:
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Icon Ribbon

View > View Style > Wireframe

Keyboard Textual menu

<3VM> View > Render > Wireframe

You can see the wireframe view style of your model after using this command.

Hidden Line Removal

Call the command:

Icon Ribbon

View > View Style > Hidden Line Removal 

Keyboard Textual menu

<3VH> View > Render > Hidden Line Removal 

After calling the command, the 3D view window of the current drawing will display a three-

dimensional model with the removed hidden lines.
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Precise Hidden Line Removal

Call the command:

Icon Ribbon

View > View Style > Precise Hidden Line Removal 

Keyboard Textual menu

<3VZ> View > Render > Precise Hidden Line Removal 

After calling the command, the 3D view window of the current drawing will display a three-

dimensional model with precisely removed hidden lines. The difference between this command and

the Remove hidden Lines command is that the resulting image is much more accurate ('outline' lines

are displayed on the surface of the body).
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Show Edges

Call the command:

Icon Ribbon

View > View Style > Show Edges

Keyboard Textual menu

<3V1> View > Render > Show Edges

This command is an additional setting for the main view styles. You can only use it with a Render and

a Shading. In this mode, all edges are shown.
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Show Hidden Edges

Call the command:

Icon Ribbon

View > View Style > Show Edges

Keyboard Textual menu

<3V2> View > Render > Show Edges

This command is an additional setting for the main view styles. It can only be used in conjunction with

a Hidden Line Removal command. In this mode hidden lines become dotted.
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Don't show hidden lines Show hidden lines

Show Outline Edges

Call the command:

Icon Ribbon

View > View Style > Show Outline Edges

Keyboard Textual menu

<3V3> View > Render > Show Outline Edges

This command is an additional setting for the main view styles. In this mode, outline lines are added.
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Don't show outline edges Show outline edges

Semitransparent View

Call the command:

Icon Ribbon

View > View Style > Semitransparent View

Keyboard Textual menu

<3VM> View > Render > Semitransparent View

This command is an additional setting for the main view styles.
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View by default Semitransparent View

Image Quality

The command is available in the View Toolbar in the 3D window:

Icon Ribbon

Keyboard Textual Menu

The Image Quality command allows you to adjust the quality of the display of objects in the working

window.
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There are several presets available (Ultra Coarse, Extra Coarse, Coarse, Standard, Fine, Extra Fine,

Ultra Fine).

The By default option applies Mesh Quality parameters set in the 3D tab of the Document Parameters.

The User-defined option allows you to set mesh quality parameters manually. When this option is

activated, a dialog box appears:

There you can set following parameters:

· Edge Tolerance

· Face Tolerance

· Angle Tolerance

The lower the value of each parameter, the more accurate the model will be displayed.

Values automatically set upon opening of this dialog represent the current mesh quality.

The geometrical meaning of these parameters is described in the 3D. Document Parameters chapter.

An increase in image quality can lead to a decrease in performance.

Quality may also be defined individually for a particular body using it's parameters dialog.

Projection Method

The appearance of the 3D scene in the 3D view window depends, besides the specified visualization

method, on the projecting method used by the system camera. The projecting method determines,
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how the camera will be showing objects in the 3D scene: without respect to the distance from the view

point and the field of view angle - by the orthographic (parallel) projection, or by accounting for

those parameters - the perspective projection.

Orthographic (parallel) projection Perspective projection

A projecting method, unlike a visualization method, is a characteristic of the particular used

camera, rather than the 3D window. When switching the active camera (for example, switching

from the system camera to a custom one), the image generation in the 3D window will account

for the new active camera projecting method.

For convenience, the choice of the type of projection is moved to the View panel. Parallel projection is

enabled by default.

Use the following command to select the method of projecting the system camera:

Icon Ribbon

Keyboard Textual menu

<3VO> View > Projection > Parallel

Applies parallel projection method to an active camera in the 3D scene.

Use the following command to select the method of projecting the system camera:

Icon Ribbon

Keyboard Textual menu

<3VE> View > Projection > Perspective

Applies perspective projection method to an active camera in the 3D scene.

Clip Plane

Clip Plane can be used for viewing model elements which are overlapped by other elements. It splits

the 3D scene in two areas. One area remains unchanged, another one being clipped. Bodies (surface

or solid) and their segments located in the clipped area of the scene are not displayed on the screen.

Resulting body section is filled with a color, set in Parameters of this body. Support Geometry is not

clipped. 
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Clipping affects visualization in the 3D window only. No new objects being created in the model and

no existing objects being edited upon applying a clip plane. Unlike the 3D section, clip plane cannot

be used for creating sectional or cut-out views on the drawing.

Following clip planes can be applied:

· Custom;

· In Plane of Screen;

· Front View;

· Right View;

· Top View.

Custom clip plane is created upon applying changes in the editing mode using the automenu option

. Other planes are created automatically by the system upon calling a corresponding command.

Commands for clip planes handling

Activate clip plane:

Icon Ribbon

View > Clip Plane > Active

Keyboard Textual menu

<3CL> View > Clip Plane > Active

The icon of this command is highlighted, when any one of clip planes is active.

If no clip plane is active, calling the command activates Custom clip plane (if it exists) or clip plane In

Plane of Screen (if custom plane doesn't exist).

If any one of clip planes is active, calling the command deactivates it.

In Plane of Screen:

Icon Ribbon

View > Clip Plane > In Plane of Screen

Keyboard Textual menu

<3CS> View > Clip Plane > In Plane of Screen

Calling the command activates a clip plane which is parallel to the screen plane.
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Front view:

Icon Ribbon

View > Clip Plane > Front view

Keyboard Textual menu

View > Clip Plane > Front view

Calling the command activates a clip plane which is parallel to the standard Front workplane.

Right view:

Icon Ribbon

View > Clip Plane > Right view

Keyboard Textual menu

View > Clip Plane > Right view

Calling the command activates a clip plane which is parallel to the standard Left workplane but has an

opposite normal direction.

Top View:

Icon Ribbon

View > Clip Plane > Top view

Keyboard Textual menu

View > Clip Plane > Top view

Calling the command activates a clip plane which is parallel to the standard Top workplane.

Edit clip plane:

Icon Ribbon

View > Clip Plane > Edit

Keyboard Textual menu

<3CD> View > Clip Plane > Edit

The command is available only if some clip plane is active.

Calling the command in the clip plane editing mode restores initial position and orientation of an

edited plane.

Calling the command outside the clip plane editing mode enables this mode.

Commands for clip planes handling are also available in the View Toolbar.
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Clip plane editing mode

This mode is activated upon activation of a clip plane (of any type). An active clip plane becomes

represented by a blue rectangle in the 3D scene. Following manipulators become available:

· Clip plane translation manipulator

It looks like a long red arrow pointing in clip plane normal direction from a center of a plane.

Use it in the similar way as manipulators of 3D elements translation along LCS axis. 

· Clip plane rotation manipulators

They look like blue and green arcs located around the tip of the translation manipulator

arrow. 

Use them in the similar way as manipulators of 3D elements rotation around LCS axis.

· Clipping direction manipulator

It looks like two short yellow arrows located in opposite corners of the plane rectangle.

Arrows are pointing in the non-clipped area of the 3D scene (opposite to the clip plane's

normal direction) Click  on an arrow to switch the direction. Switching the clipping

direction also switches clip plane's normal direction.

Filters toolbar contains filter for selecting faces in the clip plane editing mode. Upon selecting a face

in the 3D scene, a clip plane is either coincides with it (if selected face is flat) or becomes tangent to it

at an arbitrary point (if selected face is curved). 
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When you are done with editing a clip plane, you can use one of the following options:

· Confirm the current orientation using the  automenu option.

Clip plane remains active, but its rectangle and markers disappear. Current position and

orientation of a plane are saved as a new Custom clip plane.

· Cancel editing using the  automenu option or by clicking .

Clip plane becomes inactive. All changes in position and orientation introduced since the last

activation are canceled.

· Use the   Edit command to restore initial parameters of the plane.

Moving the clip plane outside editing mode.

Active clip plane can be moved along its normal direction without calling any command. Drag the

mouse back or forward while holding +<Ctrl>+<Shift>. 

Apply Section in 3D View

Call the command:

Icon Ribbon

View > 3D View > Apply Section

Keyboard Textual Menu

<3AS> View > Projection > Apply Section

The command applies the selected section to the 3D model. In this case, a new body, in contrast to

the Cut by Section operation, is not formed. After executing the command, the 3D view window

displays a three-dimensional body without the cut-off part. Recalculating the model restores the

previous state of the body.

There is another way to call this command. In the command standby mode, right-click  in the 3D

window and, if there is at least one section in the model, select Apply section from the menu that

appears. 

After calling the command, a window with a list of 3D sections appears on the screen, which specifies

the section to apply. If you point the mouse cursor at the section contour in the 3D window before

calling the command (the section is highlighted), the section selection dialog does not appear.
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To create sections, use the Construction > Section command, and to change them, use the Edit >

Construction > Section.

Set 3D View Parameters

Call the command:

Icon Ribbon

View > Properties

Keyboard Textual Menu

<PW> View > Properties

The command can also be called from the contextual menu invoked by clicking  on an empty

space in the 3D scene.

After calling the command, a dialog window appears, which contains all current 3D view parameters.

Preview

The 3D window contents preview pane is on the left-hand side of the dialog window. It displays all the

same as in the master 3D window, but smaller. You can work with the image in the preview pane in the

same way as with the image in the 3D view window: spin, pan, zoom. 
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To quickly view the contents of the 3D scene, you can use the View All button - clicking it scales the

image in such a way that all contents of the 3D scene are visible. All manipulations made in the

preview pane will be also applied to the image in the 3D view window (after closing its parameters

dialog).

The Show Coordinate System flag can be used for disabling the coordinate system display in the 3D

view window. 

Background

The Background group of parameters defines the background color of the 3D view window. To

achieve a smooth transition of colors, set the Gradient to flag and specify two colors by selecting

from drop-down lists. Clear the flag in order to make the 3D view window background monochrome.

In such a case, specify just one Color).

The Background Texture flag is used to enable/disable the mode of using the texture as a

background of the 3D view window. When the flag is disabled the 3D view window has the color that

is specified in the background parameters.

The Environment Texture flag is used to enable/disable the mode of using the texture as

environment for 3D model. When the flag is disabled the specified texture will be suppressed.

Light Sources

The group of parameters in the lower-left corner of the dialog window is provided to manage light

sources attached to the active camera in the 3D scene. This group includes the list of dynamic Light

sources existing in the current 3D window, buttons for adding/deleting light sources attached to the

camera, as well as control elements for defining parameters of each of the light sources.

To edit parameters of an existing light source, select this source in the drop-down list. Control

elements located below the list allow changing the brightness (Intensity) of the selected light source

(using the slider or numerically), as well as its color. The selected light source can be deleted by

clicking the button . Clicking the  button creates another directional light source attached to

the active camera. 

The position of the selected light source with respect to the camera is defined using sliders located at

the right and below the viewing pane of the 3D window contents. By default, dynamic light sources

are placed directly on the camera (the sliders being positioned in the middle of their respective

scales). By moving the sliders away from the center of the scale, one can move light sources right/left

and up/down with respect to the camera. The  button brings the light source back to the camera.

Importing/Exporting 3D view Parameters

Load scene and Save scene buttons can be used for working with scene preset files. Scene parameters

can be exported to a special file in the .tfscene format for further usage. Such file contains coloring.

textures and light sources parameters. 

Use the Save scene button to create a preset file. Use Load scene button to load an existing preset

file. You can also drag and drop preset files from windows explorer or other sources to 3D scene.

Several presets are supplied with the T-FLEX. 

View Style

The method of the 3D scene rendering in this 3D window is defined using the View Style group of

parameters. The drop-down list lets you select the desired method, while the Options button serves

for defining additional parameters of each mode. Clicking this button brings up the Options dialog,

which specifies the requirements on drawing various lines of the 3D model - edges, outline

(silhouette), hidden lines - for each visualization method. 
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View point, Projection and Offset

The View point, Projection and Offset groups of parameters define the view direction and the method

of projecting from the system camera, as well as its distance from the center of the 3D scene. In the

parallel projecting method, the camera distance is defined by the Scale parameter. This parameter

defines the degree of zooming on the image in the 3D scene.

In the perspective projection, the camera distance can be defined either by the field of view angle of

the 3D scene, or directly by the distance between the camera and the center of the 3D scene. All three

parameters are defined numerically. Additionally, the scale and the field of view angle can be

controlled using the mouse, directly in the preview pane of this dialog, similar to the way it is done in

the 3D window itself when moving/rotating the camera. The Offset parameter defines the horizontal

and vertical shift of the 3D scene center with respect to the camera.

Views

The Views group of parameters, located in the lower-right corner of the dialog, serves for quick setup

of the 3D window state. 

The Standard drop-down list lets you changing the view direction of the system camera according to

one of the engineering drafting standards (for example, Front (elevation) View, Back View, Left (side)

View, etc.). For this, simply select the desired scene orientation in the list. 

The Custom drop-down list serves for handling 3D views preset in the system. 

A custom view can be loaded (that is, the 3D window set up according to the information stored in

the 3D view), saved (by writing 3D View information about the current state of the 3D window) and

renamed. To load a 3D view, select this 3D view in the list and click the Load button. Clicking the Save

button writes information about the current state of the 3D window in the 3D View selected in the

Custom list. Clicking the Rename… button calls an additional dialog for defining a new name for the

selected 3D view.

Keep in mind that unlike standard views, selecting a custom view in the list doesn't apply this

view. You have to use the Load button for it.

Background and Environment Textures are not saved when saving views. 

Don't apply sections. Enabling this flag prevents applying sections in the current 3D window. It is

useful when you work with several 3D windows and want to have a section in one window and full

model in another window.
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Save as Default. If this checkbox is enabled, the loaded (using the Load button) standard or custom

view will be applied by default to all new 3D windows in the current document after clicking OK.

A view is applied with parameters that were present upon saving a view. If you edit parameters

and didn't click the Save button, then upon clicking OK such parameters are applied to the

current 3D window only regardless of Save as Default checkbox status.

Controlling Elements Visibility

When working with complex drawings and models, you often need to temporarily hide some 2D or

3D elements, because they obstruct the view, or hamper the perception of the drawing/model. T-FLEX

CAD provides convenient set of tools for controlling elements visibility. You can hide/show elements

individually, when selecting them one by one, hide/show the whole set of selected elements,

automatically hide/show elements of a particular type, show all previously hidden elements at once or

invert visibility (i.e. make hidden elements visible and vice versa).

Elements visibility can be controlled using:

· View Toolbar commands

· 3D elements' contextual menu commands

· The Hide/Show 2D Elements command

Using View Toolbar for Controlling 2D and 3D Elements Visibility

Additional tools for controlling 2D and 3D elements visibility are provided by the commands Hide

Construction, Hide/Show Relations, and Show/Hide group of commands. Show/Hide group contain

different sets of commands depending on which window is active (2D or 3D).

These commands are available at the View toolbar. Some of these commands are also available in the

View section of the textual menu.

3D window 2D window

Hide Construction

Hide/Show Constraints

Hide Relations

Hide 3D Annotations Hide/Show Elements

Hide Workplanes Grid Hide/Show Hyperlinks
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Hide Manipulators
Hide Coordinate

Systems

Command Hide Construction:

Icon Ribbon

Keyboard Textual Menu

<SI>,

<Ctrl>+<Shift>+<С>
View > Hide construction

This command hides all construction elements, as well as auxiliary lines and dimensions, in the current

window (the 2D view or the 3D view). Recall of the command restores the construction elements

display on the screen.

Command Hide/Show Constraints:

Icon Ribbon

Keyboard Textual Menu

This command hides all Constraints, created in the current 2D window. Recall of the command

restores the constraints display.

Command Hide Relations:

Icon Ribbon

Keyboard Textual Menu

This command hides all Relations, created in the current 2D window. Recall of the command restores

the relations display.

Command Hide 3D Annotations:
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Icon Ribbon

-

Keyboard Textual Menu

<SN> View > Hide 3D Annotations

This command hides all 3D annotations (3D dimensions, notes etc.) in the current 3D window.  Recall

of the command restores the 3D annotations display.

Command Hide Workplanes Grid:

Icon Ribbon

-

Keyboard Textual Menu

<3VQ>

This command hides workplane grid in the current 3D window.  Recall of the command restores the

workplane grid display.

Command Hide Manipulators:

Icon Ribbon

-

Keyboard Textual Menu

<3SM>

This command hides manipulators in the current 3D window.  Recall of the command restores the

manipulators display.

Command Hide/Show Hyperlinks:
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Icon Ribbon

-

Keyboard Textual Menu

This command hides hyperlinks in the current 2D window.  Recall of the command restores the

hyperlinks display.

Command Hide Coordinate Systems:

Icon Ribbon

Keyboard Textual Menu

<BRT>

This command hides coordinate systems in the current 2D window.  Recall of the command restores

the coordinate systems display.

Topics in this section:

· Show\Hide Elements

Using Contextual Menu for Controlling Elements Visibility

The Visibility group in the contextual menu, which appears upon right-clicking  3D elements in a

3D view window, in 3D model tree or in  3D Model Tree,  Assembly Structure and  Model

Elements windows, contains following commands for controlling elements visibility:

 Hide

Makes selected elements invisible in the 3D scene. If selected element is already hidden, then

the command is inaccessible.
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 Show

This command cancels the previous command, making the selected elements visible in the 3D

scene. If selected element is already visible, then the command is inaccessible.

Hide Only Selected

This command makes all selected elements invisible, and shows all the rest, if those were

previously hidden

Show Only Selected

This command makes all the selected elements visible, and hides (makes invisible) the rest;

Show All

This command makes all elements in the 3D scene visible.

 Invert Visibility

Switches visibility of each element in 3D scene to an opposite one, i.e. hides visible elements

and shows hidden elements. Alternatively, the command can be called using the <3CB> or

<Ctrl>+<Shift>+<B> keys.

Contextual menu invoked by right-clicking  an empty space of the 3D scene contains the same set

of visibility commands as listed above, if some of the 3D elements are selected at the moment of

clicking. If there are no selected elements, then such menu only contains the Show All and Invert

Visibility commands.

 

The visibility of each 3D element is indicated by an icon  (element is hidden) or  (element is

visible) in the model tree, as well as in the Visibility column of the  3D Model Tree window. The 

 Assembly structure window contains the similar Visibility in assembly column,  which uses   and 

icons. Visibility of a particular element can be switched by clicking  its visibility icon without

selecting the element itself.  

Visibility of bodies and 3D fragments can be controlled without using the aforementioned

commands. Instead, you may use the Hide parameter available in the parameters dialog of the

body/fragment or operations forming such body. Value of the parameter can be controlled by a

variable. Visibility commands of the contextual menu as well as corresponding columns of tool

windows do not affect visibility of elements, whose Hide parameter is controlled by a variable.

In such case the Visibility column of the model tree contains special icons, which indicate the

link between visibility and variable -   (element is hidden) and  (element is visible).
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Hide/Show 2D Elements

Command “Hide/Show Elements”:

Icon Ribbon

-

Keyboard Textual Menu

<ESO> -

This command controls visibility of particular 2D elements on a drawing page or on an active

workplane. The command automenu contains the following options:

<S> Show Element types possible to select

<L> Show hidden Element list

<*> Show all hidden Elements

<Esc> Exit command

The  option calls the selector dialog box defining the list of elements allowed for selection within

the current command. The selector settings made within a command do not affect the settings made

via the "Set Selector Configuration" command. Upon entering a command, the selector default

settings allow selection of all elements.

To hide an element, simply click it with . This hides the element on screen, making it a hidden

element of the drawing. Hidden elements are assigned the "Hidden" attribute by the system. These

are not displayed on screen but can be selected in 2D element creation and editing commands. The

option  brings up a window with the list of all hidden elements.  
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To restore visibility of an element, uncheck the box before the element name. The graphic buttons "+",

"-" clear/set checkmarks for all elements in the list. Calling the option  makes all hidden elements

visible.

It's worth to notice, that hidden elements can be formed as result of applying the Mark out Fragment

option within the Fragment command.

Size of Font and Arrows

It is possible to adjust the size of drawing detailing elements in 2D and 3D windows using following

buttons located on the View Toolbar:

 Enlarge font size

 Reduce font size

In result, size of font and arrows gets increased in parameters of all detailing elements (dimensions,

leader notes, texts, GD&T formlimits, roughness symbols, view designations) existing on a current

drawing page or in 3D scene, depending on which window the command is called from.

See also:

· Drawing Detailing

· Font Parameters of Drawing Detailing Elements

· 3D Annotations

Preview of Operation Result

In order to view the result without confirming the creation of an operation, there is an option in each

operation creation command:
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<F5> Preview

This option is available only when all the necessary elements for creating an operation are specified.

When this option is set, the body on which the operation is created will be displayed with the

specified parameters. If you are satisfied with the result, you can complete the entry by clicking the

icon . If the result is not satisfactory, then the view mode should be turned off by pressing the

option again and the necessary parameters should be adjusted.

Preview Solid Changes

In the commands for creating and editing the modifier operations, there is an additional mode

allowing a user to see the changes produced in the model by the current operation:

<Ctrl>+<F5

>
Preview Solid Changes

In this mode, the parts of the volume which will be added to the source body are shown with a orange

color, and the parts of the volume which will be removed from the source model are shown with a

blue color.

Similar to the option for previewing, the option  is available only when all necessary elements for

creating operation have been specified.
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System Customization

The T-FLEX CAD system has a wide range of workspace settings for more convenient work with the

system.

Topics in this chapter:

· Working with Multiple Monitors

· System Requirements

· Set System Options

· Customizing Toolbars and Keyboard

· Saving User Settings. Environments

· Reset Settings

· Document Parameters

· Default Parameters

· Main window design styles

Working with Multiple Monitors

You can open multiple windows in one session and see the same document or different documents on

multiple monitors.

For example, if your computer is connected with two monitors, you can display 3D model on one of

them and a drawing with the same model projections on the other. Changes in the model are

displayed in all main windows that are associated with the same document. So that, changes in the

model made on the first monitor are immediately displayed on the projections at another monitor

after the Regenerate all command activation.

Main windows are independent of each other in terms of user interface. Each of the windows has its

own commands, input parameters, and other user interface elements. 

The system will ask you about saving of the document only when you close the main window

with its last open copy.

You can copy document to a new main window via command New Main Window:
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Icon Ribbon

View > Window > New Main Window

Keyboard Textual Menu

Window > New Main Window 

You can transfer document to a new main window via command Move to Main Window:

Icon Ribbon

View > Window > Move to Main Window

Keyboard Textual Menu

Window > Move to Main Window

Calling the command invokes the drop-down menu containing the list of all main windows of the

current session. Current window is marked by the check mark. There's also the New Main Window

option in the top of the list. Unlike the eponymous command, this option moves the document to the

new window instead of copying it.

These commands are also available in the document tabs' context menus.

The main windows of the same session are numbered. Number of a window is displayed in its title in

parentheses. It helps to choose the main window if you want to copy or transfer a document window.

You can also have several T-FLEX CAD sessions running simultaneously on the same computer (just

launch the application several times). However, windows belonging to different sessions are not

synchronized, so you are not able to work with same document in different sessions. When opening a

document already opened in another session, the warning message is displayed above the active view
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window: "Document is opened by another user. You can save the document only with a different

name or in a different folder". Initially such document is opened in a special viewing-only mode,

where all drawing and 3D modeling commands are disabled. Upon clicking the Disable button, the

warning disappears and the viewing-only mode remains active. The same thing happens upon clicking

the  button in the top right corner of the warning message. Upon clicking the Allow editing button,

the system switches to the default editing mode, where all commands are available; however saving

changes is only possible into another document. Trying to save the edited document under the same

name in the same folder as the initial document will lead to an error.

System Requirements

It is recommended to use only discrete (non-embedded) graphic cards.

The function of photorealistic real-time rendering is available only using Intel or AMD CPU with SSE

4.1 support or NVIDIA graphic cards with support for NVIDIA CUDA technology (version 2.1. or later).

Make sure you have the latest drivers.

Minimum Requirements

Software Requirements Windows 7 SP1 x64

Processor: Intel or AMD processor with SSE3 support

RAM: 2 GB  

Memory: 3 GB

Graphic card: Graphic card with OpenGL 3.3 support 

Recommended Requirements

Software Requirements Windows 8 x64, Windows 10 x64

Processor: Core i5 processor or equivalent

RAM 16 GB or more

Memory: SSD

Graphic card:
High-performance NVIDIA or AMD graphic card with 1 GB

of memory or higher and with Open GL 4.2 support or higher
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System Options

The command for customizing the system is Options:

Icon Ribbon

Get Started > Customize > Options

Keyboard Textual Menu

<SO> Customize > Options

The command may also be called using the drop-down in the top right corner of the screen:

The command brings up a dialog box with various groups of parameters available on the respective

tabs. 
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When you select any parameter its tip appears in the bottom part of the screen. Such tips are

available for the most of parameters.

T-FLEX CAD provides a wide range of system customization capabilities. You can set color

preferences, customize dialog boxes appearance, define function key combinations for quick

command access, set tool windows location on the screen. To define this kind of parameters, a

customization group of commands is provided.

The information about the application settings is stored in the system registry. Different application

settings for different users are supported on the same computer.

The System Options dialog contains following tabs:

· User

· Startup

· 2D

· 3D

· Windows

· Folders

· Bill of Materials

· Files

· Fragments

· Snap

· Constraints and Dimensions

· Dynamic Toolbar

· Colors

· Additional Options

· Performance
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· Save

· T-FLEX DOCs

· Electrical (if T-FLEX Electrical is installed)

· Quality Control

· All

User. System Options

This tab of the dialog specifies the user name, the name of the company using the system and its

license number.

The user name and the Company name are saved in each newly created document file. Additionally,

these parameters, along with the license number, are automatically included in the text of the

message to the technical support group generated by the command Help > Technical support… 

License. License number automatically included in the text of the message to the technical support

group generated by the command ? > Technical Support….

A message to the technical support group is based on a template whose location is defined by the

parameter Technical Support Message Form.

Startup. System Options

Load Previous Session Document on Start. If this flag is set, then upon the next start of T-FLEX CAD

the documents will be automatically loaded that were open at the time of closing the previous system

session.

Disable macros automatic execution. Allows to disable automatic macros execution, appointed to

document events (opening, closing, saving and so on). This mode can be useful when user is

debugging macros.

Number of “Recent Files” in menu. Defines the number of items in the list of files opened in recent

sessions. The number should not be greater than 16. This setting affects the menu File > Recent Files

and the Start Page dialog box.

Show welcome page at startup. Defines whether to launch the “Start Page” dialog box on the

application startup.

Run as Server. The parameter is required for applications that use special Server API to work in a

separate process. 
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2D. System Options

Node construction is transparent. Setting this parameter allows calling the node creation command

from within any other command. To do so, type <N>. This will not abort the current command.

Dimension edit is transparent. This option allows editing dimension values by clicking  the value

without calling editing commands. The construction entities that are driven by the dimension are

being identified and relocated (if possible) according to the new value. If Transparent element

editing is enabled, then transparent editing of dimension values is available regardless of the state of

Dimension edit is transparent option.

Transparent element editing. When this parameter is turned on, upon selection of 2D elements in the

command waiting mode with the help of , the command of editing a selected element is

automatically started. If this parameter is turned off, nothing is happening after choosing a 2D

element, the system just waits for the user's commands. This parameter is turned on by default.

Left mouse button action. This parameter defines the action performed for drawing views on the left

mouse button push while in commands. The action is selected from the pull-down list. 

At your choice, pressing  in different modes will either bring up a context menu or cancel the

current command. For example, if the entry Menu in command… is selected, then the context menu

on pressing the right button will be duplicating the automenu while in a command.

Node Join Distance. Sets the radius in pixels for locating nodes on the screen. The join distance radius

is used when creating new nodes in the “free drawing” mode. If the cursor is within the join distance of

some node then this node will be selected instead of creating a new node. 

Node Size. Sets the size in pixels of a node on the screen.

Position marker size. Specifies the size of position marker. The position marker specifies position of

the dimension and value on it upon editing.

Topics in this section:

· Paper size list

· Custom Scale List

· Graphics Settings
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Paper size list. System Options

Paper Sizes. In the section you can edit the list of drawing paper sizes. 

In the section you can set Name, Width and Height of a general or custom format. It also defines the

measurement Units of the T-FLEX CAD system.

Besides, one can set the parameters for dividing the drawing into Zones:

· Step. Defines the X and Y dimensions of one zone.

· Offset. Defines the X and Y offsets of the area being divided into zones with respect to the

point (0,0).

· First char, X and Y. Define the characters to begin with when itemizing the zone columns and

rows respectively.

· Number, X and Y. The number of zone columns and rows respectively.

· Direction. Defines the itemization direction for zones: left to right or right to left, top down or

bottom up.

· First displayed symbol. Defines, which of the zone-defining symbols (in the X or Y axis), will

stand first in its notation.

The  button adds a new row in the Paper Size list.

The  button deletes Paper Size selected in the list.

 and  buttons reorder selected row in the list.

System clipboard can be used for editing the Paper Size list ( , ,  buttons).

Custom Scale List. System Options

You can add custom scales to this list. In the properties of the scale, you can specify a scale value and

a name.
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Graphics Settings. 2D. System Options

When the Display performance information flag is activated, the image rendering time will be

displayed in the lower right corner of the 2D window screen.

3D. System Options

This tab is specific to the three-dimensional version of the system. It defines the settings used while

working with a 3D model.

Workplanes

The Workplanes group of settings define various parameters of workplanes: 

Standard.The selected standard sets the location of the standard workplanes in the Three Standard

Views, Front and Left, Front and Top modes. ANSI – frontal elevation view, bottom-up plan view,

right-hand side view; ISO - frontal elevation view, top-down plan view, left-hand side view.
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Font. The selected font is used for displaying the name of the workplane or workplane's type

(depending on settings) in a 3D window.

Number of grid lines. This parameter defines the number of intermediate lines in the image of a

workplane in the 3D view representation. 

Selection of workplanes in the 3D view by default is restricted to picking at the outer lines (the border)

of the workplane. If necessary, the selection can be expanded on all the lines of the workplane image,

both the border and the inner grid, by setting the flag Select by all grid lines.

Brightness of 3D elements when drawing on a workplane, % specifies brightness of 3D elements,

when drawing on a face or surface.

Create 3D Axes by 2D Axes. If the parameter is activated, then after finishing drawing on the

workplane, the 2D axes will be converted to 3D axes.

Keep zoom after drawing on the workplane. If the parameter is activated, then after finishing

drawing on the workplane, the scale specified by the user will be saved.

Size of coordinate system

The following group of parameters allow setting the Size of coordinate system image on the 3D

scene:

Dragger. Defines the size of coordinate system-like draggers used in various 3D commands.

Scene. Defines the size of the coordinate system image displayed in the lower-left corner of the 3D

window.

Scene rotation

The Scene rotation group defines the modes of spinning the 3D scene by certain increments, as

follows:

Using Arrows. Defines the angle in degrees of rotating the 3D scene per a keystroke when using the

two pairs of arrow keys, plus the third pair <Page Up> and <Page Down>.

Using Shift+Arrows. Defines a second spin-with-key mode for rotating the 3D scene by a different

angle. This is similar to the Using Arrows parameter, except is used in combination with the

<Shift> key.

Smooth Rotation. This flag sets the smooth 3D scene rotation mode during reorientation to a

standard view. The input box on the right-hand side defines the reorientation duration in seconds. 
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Note that setting the mode of rotating the 3D scene with respect to the global axes (the

command Rotate About Global/Local axis) makes the 3D scene spin with respect to the axes of

the world coordinate system. Otherwise, the 3D scene will spin with respect to the axes of the

screen coordinates.

Turn workplane on activation. If this flag is set, the 3D scene will be reoriented on calling the

Activate Workplane command so that the active workplane becomes parallel to the screen.

Rotate with mouse button. This parameter allows you to change the mouse button for rotation. 

· Left mouse button is used by default. 

· If the Right mouse button is selected for rotation, selection of objects by drawing a rectangle

or a curve is carried out using the left button.

· If the Middle mouse button is selected for rotation, then panning of the camera is performed

by dragging the mouse while holding < +Ctrl>. In this case selection of objects by drawing

a rectangle or a curve can be done both by using right or left buttons.

Rotation Speed, %. This parameter allows you to set the mouse rotation speed as a percentage.

3D

When object is Created. This attribute defines the system behavior upon creating a 3D element as

follows:

· Continue. The system remains within the current 3D command after creating any element.

· Exit. The current command automatically completes upon creating any element.

· Select object. The command automatically completes upon creating any element. If the

created 3D element is a construction one, it is placed on the clipboard (gets selected). This

mode may be convenient when the user creates an element and instantly proceeds working

with it. The following is an example of such common sequence of actions: create a workplane

– activate it – use it for creating an extrusion profile.

Color for clip plane. You can select Section color, Body color or Body material from the drop-down

list. It will be used for clip plane displaying.

Transparency of face dynamic highlight. This parameter allows you to set the transparency of the

dynamic highlighting of the face when hovering over it with the mouse from 0 to 1. If value is equal to

1, only contour gets highlighted.

Display annotations over 3D model. By default, parts of 3D annotations (dimensions, leader notes,

roughness and GT&T symbols) hidden behind non-transparent elements of a 3D model are not

displayed. Enabling this checkbox makes them always visible in white color.

Projections

Don’t show warning messages while creating projections. If this flag is set, the warning message will

not be displayed while creation of 2D projection on the plane created on the base of all elements of

3D scene.
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Position of projection views. Allows you to change the position of the buttons of the projection views

in the command parameters window and the projections themselves in the Three Standard Views type

depending on the standard.

Topics in this section:

· Graphics Settings

Graphics Settings. 3D. System Options

Graphics Parameters

Mode. The option allows us to select one of the two modes:. 

· The Compatible mode is suited for the case when the graphic card is outdated or absent (the

mode of remote desktop) and graphics is not accelerated by the board.

· The Hardware mode provides more efficient and productive work of the system.
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General

Antialiasing. This parameter controls the number of pixels used for drawing the smoothed image. This

parameter allows us to decrease the “saw-toothed nature” of the line on a 3D model. The Antialiasing

parameter is available only when using the Hardware mode. By default the Antialiasing is disabled. .

Frustum culling method. Determines the way of searching for objects which are outside the camera’s

field of view and thus should be ignored during rendering and ray casting: Binary Tree or Brute Force.

Display graphics performance data. If the given mode is enabled then in the upper left corner of the

work window are displayed the graphics system’s current parameters that affect the system’s

productivity. By default this parameter is disabled. 

· Graphic adapter model;

· FPS - number of frames per second;

· Triangles - number of triangles of the model mesh currently displayed;

· Lines - number of lines currently displayed;

· Points – number of points currently displayed.

· MTr/s - mesh triangles drawing speed in millions of triangles per second.

· Memory - currently used video memory vs. total video memory available.

Don't display hidden objects. Enabling this option allows us to speed up rendering the image due to

ignoring the scene’s objects that are totally hidden by other objects. This parameter is available only

when using the Hardware mode.

Don't create cosmetic threads. When this option is activated, the cosmetic threads are not displayed

in 3D models. This option has action only on the image created in the 3D window and does not affect

2D projections and dimensions on the threaded surfaces.

Small objects

The Small objects size parameter allows us to manually select the maximum size of objects on the

screen in pixels which will not be drawn in the mode of the given optimization.

Enabling the Don’t display small objects mode does not allow the system to draw the objects with

sizes smaller than the given maximum size.

Simplifications

The settings parameter Target frames per second gives us a capability of setting up the optimum

speed for redrawing 3D bodies. 

The Simplify geometry option allows us to simplify the visible geometry depending on the size of

objects on the screen. When for specified values of frequency of frames per second the detailed

image of the model cannot be formed, the system determines which bodies have the images taking

the smallest area in the frame. These bodies (their images) are drawn in a simplified manner in the

form of parallelepipeds. Thus, the image of the entire model is simplified until the time of rendering

the frame is smaller than the frequency of redrawing the screen.
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The Maximum size of objects parameter allows us to manually select the maximum size of objects in

pixels which can be rendered as parallelepipeds when enabling this optimization.

Hide edges. If this flag is set, then the outline edges will not be drawn in dynamic picture mode and in

automatic rotation mode.

Hide constructions. If there are many constructions in the assembly (for example LCSs from 3D

fragments), the scene rotation can be slowed down because of their rendering. If the flag is set, the

constructions will be suppressed. 

Stereo

Allows to setup stereoscopic images viewing. For viewing of stereoscopic images of 3D models, it is

required to use 3D glasses. 

Enable Stereo. Activates stereoscopic displaying of models.

Stereo Mode. You can select mode of stereoscopic images creation from the drop-down list.

· Active mode uses quad buffering to receive stereoscopic image. Quad buffered stereo

provides each eye a unique view from a slightly different perspective by using four buffers

(front left, front right, back left, back right) rather than the traditional two buffers (front, back).

· Vertical. Images for right and left eyes are placed under each other.

· Horizontal. Images for right and left eyes are placed horizontally near each other.

Screen Width - width of the display or projection (if you use a projector) in millimeters.

Virtual screen plane offset specifies the offset of the stereoscopic image plane in percent according

to the current position.

Invert swaps the images for right and left eye.
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Windows. System Options

Move automenu buttons. Places automenu options in columns if there is no space for the whole

automenu.

You can setup the following parameters for ribbon mode using the drop-down lists:

· “Automenu” toolbar position, “View” toolbar position, “Selector” toolbar position, “Edit in

Assembly Mode” toolbar position, “Split 3D View Window” toolbar position allows to select

a location of the corresponding toolbars on the screen.

· Show Model Tree in 3D Views. This parameter enables displaying of the model tree in the

upper left corner of the 3D view window. The parameter is enabled by default (the tooltip is

not shown in the setup window upon the parameter selection).

· Lock Tool Windows. Denies the ability to change position of service windows on the screen.

Enabling/disabling this checkbox enables/disables the Lock Windows option in the drop-

down in the top right corner of the screen.

· Halftone Bitmap Drawing. The parameter enables halftone raster images drawing: raster

images inserted into T-FLEX CAD, photorealistic images rendering results, etc. The parameter

is enabled by default.

· Halftone Bitmap Drawing. This option turns on the halftone mode of displaying bitmaps:

raster pictures, inserted into T-FLEX CAD documents, ray-tracing results, etc. By default this

parameter is turned on.

· Use double buffering on redraws. This flag sets the double buffering mode for redrawing 2D

document windows that enhances perception of redrawing by removing flickering.

· Scale percentage. Specifies percent for zooming of the current window visible part when

using the “Zoom Area” command.

· Shift percentage. Specifies percent for panning of the current window visible part when using

the “Zoom Area” command.

These parameters can be also set in Zoom area command.

· Scale percentage using mouse wheel sets the percentage by which the visible area of the

current window will be increased or decreased when scaling using the mouse wheel.
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When new windows are created group of parameters defines the following modes:

· Add scrollbars. Displays scrollbars when opening document windows.

· Create rulers. Similar to the previous, if unset, the rulers are not created on opening the

window.

Folders. System Options

Folders group:

· Colors Catalog. This setting specifies the path to the folder that contains colors catalogs. For

example, the colors are used to create color-based materials and set colors on the Colors tab.

· Macros setting specifies the path to the folder, which content will be displayed in the Macros

window.

· Templates. This setting specifies the path to the folder whose content will be displayed in the

Start Page on the application start-up and in the Create New Document Based on Prototype

command dialog box (File > New From Prototype…).

· Handling of Templates Name Conflict. Defines how to handle name conflicts between default

files and files from user's folder.

· Fonts. This parameter indicates the path to the folder in which the files of description of SHX

fonts are located. If necessary, the user can select the fonts which are not from the standard

folder.

Structural elements group:

· Types Catalog. This setting specifies the path to the folder which content will be displayed in

the Editor of structure elements types.

Subtabs:

· Database

· Documents

· Bill of Materials

· Texture

· Fonts

These tabs are used to define a list of additional folders for searching files that could not be found in

the standard folders.

The  button adds a new string for search folder. The  button brings up a browser window for

selecting the desired folder on the disk. Select the folder on the tree using the cursor. Upon confirming

the selection with the OK button, the browser window closes and the name and path to the selected

folder will appear in the selected file type input box.

The  button allows deleting a folder selected from the list of defined folders.

The  and  buttons move the selection frame up and down the list of defined folders.

To work with search folder strings using the clipboard use buttons , , .
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Example: suppose we open a drawing file with a fragment assembled in it, while the path to the

fragment has changed. In this case, a message will be displayed about an error opening the fragment

file. The fragment itself will not be displayed on the drawing. This error can be fixed by either

changing the path to the fragment, or using the described tab and defining an additional folder where

the fragment file is located. In that case, the system will be automatically searching for the fragment

file in the additionally defined folder as well, and the error opening the file will not occur.

Bill of Materials. System Options

Folders Group:

· BOM Sections. Defines the name and the path of the database file keeping the set of BOM

groups. The specified database will be the one used in creating new and reading already

created BOMs.

· BOM Prototypes. Defines the path to the folder of template files used for creating new BOMs.

The files from this folder will be displayed in the Create Bill of Materials command dialog

box.

· Product Structure Types. Defines the path to the folder where XML files with product

structures descriptions are saved.

· BOM/Report Templates. Documents from the folder will be displayed in the templates list

when you create a new report based on the product structure.

Colors Group:

· Hidden Records Background. Defines hidden records background color. Hidden are

considered the records deleted from the BOM but yet still stored in its inner data structure. The

way of displaying hidden records in a BOM is defined accordingly.

Files. System Options

Templates group:
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· Drawing. A prototype is a T-FLEX CAD drawing file, whose data is used for initializing a new

drawing. You can create several prototype files. In the case the path is not specified with the

name of the prototype, the system will search for it in the application folder (PROGRAM).

One can save a prototype file using the command File > Save as Prototype. In this case, the prototype

will be saved in the folder …\PROGRAM\ Template. To create a new drawing with the same settings as

in this prototype, use the command File > New From Template…

· Assembly Drawing, 3D Assembly. A product composition of each assembly template includes

records for assembly forming. It’s their only differ from standard templates.

· 3D Model. This is the prototype file with the 3D window settings used for creating a new 3D

model.

· Annotation. This is the prototype file for creating a new annotation using the annotation

editor. The file path is automatically assigned upon installing the Annotation Editor. 

Files group:

· Hatch Pattern Files. The system uses hatch pattern files corresponding to the respective

AutoCAD *.PAT files. The file TCAD.PAT, included with the system installation, defines the

hatch filling patterns. You can define any hatch pattern file of your own.

· Line Type Files. The system has several built-in line types (continuous, thin, waves). The rest of

types are defined by the line type file. The system uses the file TCAD.LIN. Its format complies

with the line type files of the AutoCAD system. You can define any type file of your own.

· Function Spline Files. This special file contains data for setting up the menu of the Function

Spline creation command. (A function spline is a kind of a construction line.) To create new

functions, modify the standard file named FUNCTION.DAT or create a new file by sample, and

set its name in this input field of the dialog box.

Fragments. System Options

This tab defines the options used in inserting and editing fragments. Parameters on this tab can also

be set from the fragment parameters modified under the fragment insertion and editing commands

using the Options… button.

General group:

· Keep library names. If set, library names will be saved on inserting a fragment from a library.

Otherwise, the absolute path of the respective library folder will substitute the library name.

· Optimize file path. If set, the library name or the path will not be entered in the case the

current assembly document and the respective fragment are in the same folder. This helps

moving both the document and the fragment file to another folder without changing folder

settings. 

Input. This group defines the flags used while assembling fragments:



System Customization

227

· Create named nodes automatically. This flag defines whether the new nodes will be created

on the current assembly drawing based on the named nodes from the fragments being

inserted. The nodes created from fragments can be used for further construction, dimension

placement, etc.

· Substitute variable values. In case this parameter is set, upon the fragments' insertion, their

external variables are automatically set equal to the values, assigned for these variables in the

model of the fragment. Otherwise, the values of the variables are not prescribed.

Edit. Examples of editing fragments:

· Double click action. This attribute defines what kind of action occurs on the left mouse

double-click during fragment editing.

Fragment Actuality Check. This group of parameters defines the system behavior when the files are

modified of the fragments that enter the current document (the current 3D assembly), in various

situations:

· On open document. The parameter defines the system behavior upon opening a 3D assembly

(if it was found that a fragment files were modified since the time of saving the assembly). The

following choices can be made from the list: Update - the fragments will be updated, Don't

Update - skip updating fragments, Ask – prompt the user about how to proceed upon finding

modified fragments. The default setting is Ask.

· On document activation. This parameter defines the system behavior upon returning to a

document window (when simultaneously working with multiple T-FLEX CAD documents). In

this case, the state of the current 3D assembly is also checked for the consistency with the

fragment documents stored on the disk. If the check finds fragments, whose documents were

modified after the last check, the system will proceed according to this parameter setting:

Update, Don't Update, Ask. The default is Ask.

Snap. System Options

This tab serves to define parameters that are used when working in the object snapping mode

(including the cases of sketch creation).

· Search Radius. Sets the radius in pixels for searching the elements of the system on the screen.

This parameter is used in new element creation in object-snapping mode. Keep in mind that

this parameter setting overrides the Node Join Distance parameter defined on the 2D tab.

· Select graphic lines when creating hatch contours. Setting this parameter allows selecting

graphic lines when constructing hatches and 2D paths. This is required in cases when the

construction lines coincide with graphic lines. This option helps set up object snapping so as to

have the desired elements selectable in the complicated cases upon the cursor approaching,–

for example, graphic lines (if the parameter is set). At the same time, it is still possible to select

other elements by using the keyboard commands (<C> – select a circle, <L> – select a line,

etc.).

· Show Tooltips. Sets the pop-up tooltip display mode when selecting elements on the drawing

while in object-snapping mode.
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· Enable snap to nodes on frozen layers. If this flag is turned off, snapping to nodes, located on

“frozen” layers is not possible. Upon turning on this flag, snapping to such nodes becomes

possible.

· Spline approximation accuracy (px). Defines spline approximation accuracy in pixels when

inputting in freehand mode.

Topics in this section:

· Priority

Priority. Snap. System Options

Priority Tab determines, what snap types can be used in the object snapping mode. Snap toolbar

reflects the functionality of this tab

Most snaps can be managed even outside the command Set System Options – by using icons on

the Snaps toolbar.

A 2D node created using any-type snap can be free (not maintaining a relation with the elements

based on which it was constructed, after the creation) or constrained (tied) - where the node relation

with the source elements is maintained.

When using snaps to a construction line intersection, a circle center, end points of graphic lines,

defining points of drawing annotation elements (dimensions, leader notes, roughness symbols,

tolerances), as well as 2D fragments – then constrained nodes are always created.

When using all the rest snap types, the state of the auto parametrization mode is significant. If

the auto parametrization mode is enabled, then a constrained node is created. With the auto

parametrization mode disabled, either a free node is created, or a point with appropriate

coordinates (when creating a leader note, roughness, tolerance, cropped view symbol and 2D

fragments).
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The buttons  and  serve to modify the priority of object snaps. Snap priorities determine, in

what order the system will be offering them to the user in the case when several snap possibilities are

found. The list Enable Snaps to has the snaps positioned in the decreasing priority order.

For example, snapping to construction lines has higher priority then Vertical/Horizontal snapping (this

can be seen by their position in the list). Therefore, when constructing 2D elements using snaps, the

system will first offer the user snapping to construction lines, and only after that - snapping to

vertically/horizontally aligned nodes.

Constraints and Dimensions. System Options

The Constraint Inference Setting group allows setting parameters by default for the Find and Infer

Constraints command:

· Maximum Number of Inferred Constraints allows you to limit the number of created

constraints in the working window. This parameter allows to optimize the system operation

when there is a large number of geometric elements.

· Fix Direction of Linear Dimension. The parameter allows, when creating a dimension, to fix its

direction relative to the base geometric element. 

· Infer Constraints only for Edited Objects. If the flag is active, the newly created geometric

elements in the automatic dimensioning mode will not be attached to the existing elements.

Create Dimensions Automatically group defines the parameters for automatic creation of dimensions

in the mode of constructing geometric elements using the options of the Sketch command with the

enabled icon  on the bindings panel:

· Selection of dimensions type (Linear, Angular, Horizontal/Vertical, Circular, From Zero

Point) means their creation by default in the mode of building a sketch with the function of

automatic creation of dimensions..

· Set “Driving” Parameter when Editing. The parameter allows you to change the dimension

type to the driving type after editing its value.

· Allow Editing Dimension Value on Creation. The parameter allows to insert the value of the

driving dimension during its creation.
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Drawing Pages Setting, Workplanes Setting groups allow to you to set the required default

parameters when working with the Sketch command on workplanes and drawing pages, respectively:

· Infer Constraints. The parameter assumes that the creation of geometric elements is

accompanied by the creation of constraints, selected by default in the corresponding group.

· Create Dimensions Automatically. The creation of geometric elements is accompanied by the

creation of dimensions, the types of which are selected by default in the corresponding group.

· Create Driving Dimensions. If the flag is enabled, then in this case all created dimensions will

be driving by default.

· Show Toolbar. Allows you to display a toolbar (markers and icons that allow you to change

the position of the note jog, fill its contents and adjust the type of dimension arrows) when

working with dimensions.

· Create Auxiliary Dimensions. Parameter that assumes the creation of geometric elements

with the function of automatic creation of dimensions. The dimensions are auxiliary by default 

· Automatic Dimensions Alignment. If the option is enabled, then, when reducing the

dimension to certain values, the system automatically positions the dimensional number and

arrows outside. 

The Infer Constraints group defines the parameters of automatic creation of constraints in the mode

of constructing geometric elements using the options of the Sketch command with the enabled 

icon on the bindings panel:

· Selection of Horizontal/Vertical, Coincident, Perpendicular, Tangent, Horizontal/Vertical

Alignment constraints means their creation by default in the mode of building a sketch with

the function of automatic creation of constraints.

· Separate actions to create sketch and constraints. The parameter allows you to separate the

creation of geometric elements and constraints in separate actions, which provides convenient

edition of individual elements. 

· Automatically find tangents when creating line segments. When connecting a geometric

element with a circle or arc, the parameter automatically determines the trajectory of the

tangency.
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Dynamic Toolbar. System Options

Use dynamic toolbar. This parameter controls the image of the dynamic toolbar upon selection of 2D

and 3D elements in the command waiting mode with the help of . This toolbar includes

commands frequently used for the selected element. For 2D elements the dynamic toolbar is

displayed only when the parameter Transparent Element Editing is turned off.

Visibility Range – defines a zone around the dynamic toolbar in pixels. The dynamic toolbar is

displayed on the screen if the cursor is inside this zone. As soon as the cursor goes outside of this

zone, dynamic toolbar disappears.

Transparency. If the flag is active, the transparency of the dynamic toolbar depends on the position of

the cursor. The further the cursor is the more transparent is the toolbar. If the flag is off, the

transparency is not changed when moving the cursor.

Always visible. If the flag is active, the dynamic toolbar is visible on the screen until the command is

finished. The cursor position does not affect displaying of the toolbar.

Colors. System Options

This allows to customize colors used for highlighting various 2D and 3D elements in view windows as

well as some of the interface elements.

Some of these settings do not affect pages whose respective colors are explicitly defined in the

Document parameters.

Colors are selected from the drop-down list or from the catalog as described in the Color section.

Common

Default Construction Color. Color of construction lines.

Active View Border. Borders of the currently active view window are highlighted using this color.

Grid. Color of grid points.

Default Node Color. Color of 2D nodes on a drawing /WP.

Drawing Background. Color of 2D view windows background.

Elements with Background Color. This color is used for displaying those 2D elements on a drawing,

whose color set in elements' parameters dialog coincides with the drawing background color.

Objects Selection Control Border. This color is used in tool windows for highlighting input boxes that

require selecting an object.

Active Projection. Color of boundaries of an active drawing view or 2D projection.

3D Elements

Clip Plane. Color of clip planes in 3D windows. 
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2D Elements Highlighting

Colors that are used for highlighting selected 2D elements of various types in view windows.

2D Draggers

Color of 2D node manipulators displayed, when editing external variables of a 2D fragment within an

assembly.

3D Draggers and Decorations

Colors of 3D manipulators (except those, that have unique colors), decorations and edges of 3D

model.

3D Elements Highlighting

Colors that are used for highlighting selected 3D elements of various types in view windows.
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3D Rulers

Colors of rulers displayed, when using 3D manipulators. 

Labels

Colors of labels displayed in various 3D modeling commands.
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Drawing Views with Breaks

Colors used, when adding breaks to drawing views and 2D projections. 

Limits of inactive drawing view. Color of boundaries of an inactive drawing view or 2D projection.

Constraints

Colors used for indicating constraints, as well as auxiliary lines and dimensions.

Contour Check

Colors used for indicating results of contour check on a drawing or on an active WP.

Importing/exporting colors configuration

The settings can be saved into an external *.tfc file for future reuse. This can be done using the Save…

button. To load color settings from an external file, use the Load… button.,
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Additional Options. System Options

Additional Options 

Right mouse button action. The parameter specifies action type, which is performed upon pressing

. You can select one of the types using the drop-down list. According to your choice after pressing

 in different modes the corresponding context menu will appear or the current command will be

canceled.
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For example, if the Menu in Commands… item is selected, the context menu duplicates the automenu

upon pressing  during the command execution.

Double-click action. Specifies action type, which is performed upon double-clicking left mouse

button on model element.

Invert mouse wheel direction on zoom. This option serves to switch to the opposite the zooming

direction in the system windows with the mouse wheel spinning.

Enable dynamic delete. This flag allows us to activate the mode of “quick deletion”. To delete any 2D

element, it is sufficient to move the cursor to the element (the element will be highlighted) and press

<Del>.

Number of commands in the Last Commands list. The parameter determines the number of recent

commands that will be displayed in the context menu called in the 3D window.

Number of Items in Last Commands submenu. The parameter determines the number of recent

commands that will be displayed in the Last Commands submenu of the context menu called up in

the 3D window. 

Exit projection view context by Escape. Enabling this checkbox allows deactivation of an active

drawing view by pressing <Esc>.

Allow transparent editing commands. Enabling this checkbox allows the transparent editing of some

3D elements.

Diagnostics

Beep Noise - Messages in Diagnostics window will be accompanied by a beep noise.

Misc

Show objects ID in tooltips. When you hover the cursor over an object, its ID will be displayed in a

tooltip.
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Delay of command cancel window show, s. The window that allows to cancel a command appears on

the screen if calculating a command takes more time then value of this parameter (in seconds).

Print

Legacy printing. Use legacy Print command.

Preview timeout. If the maximum drawing time at print preview exceeds the specified value

(milliseconds), redrawing is not performed and Show button appears.

Performance. System Options

Regenerate model automatically

When this checkbox is enabled, the 3D model will be regenerated automatically in case of parameters

change (upon exiting the variables editor, changing construction line positions, etc.). If the checkbox is

disabled, then the automatic regeneration does not occur in such cases. In such case, you can only

regenerate the model manually.

Limit memory for calculation of projections, MB

Upon enabling the checkbox, you can set he memory limit for calculation of projections.

Use multithreading on calculations

This checkbox activates the mechanism of multithreaded calculations inside the system on computers

having multi-core processors or on multiprocessor systems. This enables to increase the speed of

regenerating the models. Multi-threaded data handling is used upon calculating geometry of 3D

operations, calculating finite-element meshes.

Undo/Redo buffers

You can specify the maximum number of user actions to be remembered by the Undo and Redo

commands. This parameter should be specified before opening a file. 

Maximum volume of RAM for temporary unloading parts in large assembly mode, MB

Upon working with large assemblies some of their files are unloaded to the hard drive and some are

stored in the RAM. This parameter allows you to specify maximum RAM to operate with large

assemblies.

Don’t display 2D objects smaller than, pixels

Objects, which size is smaller than the specified value, will not be displayed on the drawing. This

option helps to speed up manipulations with the large drawings.
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Maximum size of image for raster projection, pixels

The maximum image dimension for raster projections does not exceed the specified value. The aspect

ratio of the image is preserved.

Show regeneration time

The parameter allows to display information about the recalculation time to the status bar.

Save. System Options

Autosave, min. When set, the current document is automatically saved after the specified period of

time. Saving the model occurs only when switching from one command to another, and is not done

while working within the same command, in order to preserve the model data integrity.

Create Backup copies. This flag sets the mode of creating backups on saving document files. The

parameter can take the following values:

· None – no backup.

· On first save – A “.BAK” file is created on the first save of a document after opening it for

editing.

· On every save – The previous saved file version becomes the backup copy on every document

save. 

· New on every save – backups are created on each save with different extensions, as “.B01”,

“.B02”, etc.

T-FLEX DOCs. System Options

This tab can also be called from the T-FLEX DOCs connection button in the top right corner of the

screen.

This tab defines parameters of the joint work of T-FLEX CAD and T-FLEX DOCs system. The settings for

the given tab are available for editing only if T-FLEX DOCs system is installed on a given work place.
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The T-FLEX DOCs Integration parameter specifies a T-FLEX DOCs client to work with T-FLEX CAD. the

drop-down contains the No option (the system works in the regular mode without integration, this

mode is selected by default) and all T-FLEX DOCs versions installed on this workplace.

The Update fragments when opening assembly parameter sets up the mode of verification of the

actuality of files of fragments, pictures, etc., upon opening and regeneration of the assembly:

· Don't update – The file will be downloaded from the server only if it is absent. This is the most

optimal variant in terms of efficiency but there is no synchronization during the joint work.

· Update –  All files that lack actuality are automatically synchronized. This variant works more

slowly but it always guarantees the actuality if something has changed on the server.

· Check and ask – The actuality of all files in the assembly at all levels will be checked and the

question will be asked if DOCs has files newer than they are in the work folder. This is a

compromise variant.

Update product composition automatically in case of document saving. If this checkbox is enabled,

saving a document for the first time automatically invokes the command of saving the product's

composition into DOCs. Subsequent saving updates the DOCs product structure. 

Integration rule. The parameter allows to select a rule from the T-FLEX DOCs Application integration

rules.

Integration rule can be selected only after the integration is done, since integration rules are stored in

the DOCs. 

Therefore, you need to select integration type and press OK. After that you should wait for the

integration to happen, reopen dialog using the Set System Options command and select one of the

integration rules from the list.

Keep all links included in document. This checkbox sets up the mode for saving T-FLEX CAD

compound documents – documents with links to external files – to T-FLEX DOCs. If this box is

disabled, only external files of GRB format (assembly fragments) will be saved to the "Files" T-FLEX

DOCs dataset. To save external files of other formats, enable this checkbox.

By default, synchronize fragments in opened documents. This checkbox controls the default state of

the Synchronize fragments with T-FLEX DOCs checkbox, which is located in the document opening

parameters dialog
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Electrical. System Options

This tab is available only if the Electrical application is installed at this workplace.

Component Editor synchronization

Synchronization Mode. This parameter allows you to specify the conditions for synchronization of a

shared electrical product file with its local version at the workplace:

· Disabled. There is no link between the shared electrical product file and its local version in the

workspace;

· One Direction - To. The shared file changes are transferred to the local version in the

workplace;

· One Direction - From. The local version changes in the workplace are transferred to the

shared file;

· Both Directions. The mode in which synchronization is carried out in both directions.

Silent mode. If it's enabled, the system won't ask user before automatic synchronization.

Path to common File of Components. This parameter specifies the path to the folder that contains

the shared file with all information models of electrical products.

General

Contains the Ask for confirmation when finishing active command checkbox.

Quality Control. System Options

Contains options of a  Quality Control tool.

· Scripts Folder. This folder contains script templates.

· Default Script. This options sets the path to the default script.

· Load on Start. If this flag is active, the module will be loaded at system start.

All. System Options

All existing parameters are displayed on the All tab.
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The parameters can be sorted by categories or alphabet.

You can enter parameter name or part of the name into the search bar to find it.

Customizing Toolbars and Keyboard

The command for customizing the system is Customize:

Icon Ribbon

Get Started > Options > Customize

Keyboard Textual Menu

<SB> Customize > Customize…

When Ribbon Mode is off the command can also be called by selecting the Customize... option in the

contextual menu invoked by clicking on the instrumental or system toolbars.

When Ribbon Mode is on the command can also be called by selecting Customize tab... or Customize

group... options in the contextual menu invoked by clicking  on the ribbon or textual menu.

The command can also be called in the right top corner of the screen^
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The command brings up a dialog box with various groups of parameters available on the respective

tabs.

Customizing the Ribbon Interface

In the ribbon interface, all commands are divided into tabs. The title of each tab reflects the content.

Team icons are grouped.

The tape adjusts to the current operating mode. For example, the 3D Model and Drawing tabs change

when switching between 3D and 2D windows.

The system remembers on which tab the last selected command was located. If you select a command

from the Measure tab in the 3D window, and then continue working in the 2D window, then the next

time the 3D window is activated, the tab with the last command used in the 3D window will be active.

The ribbon can be hidden by double-clicking on it. In this case, it reappears when you select any of its

tabs. The tape is restored by a second double click.

Tabs can be switched with the mouse wheel by hovering over them and rotating the wheel.

If several equivalent commands in the ribbon are combined into a drop-down list, then the last

selected command is remembered.

For personalization, it is possible to edit existing tabs and create your own tabs with the necessary

commands and operations.

The user can hide groups in the feed that he never uses.



System Customization

243

In the ribbon there is an option to collapse\restore groups of commands.

Hidden groups can be restored from the context menu, which is called when you click in an empty

space on the ribbon.

For any of the buttons in the ribbon, you can call the context menu, in which you can customize the

display style of the button or hide it without entering the Settings.



T-FLEX CAD 17 Help

244

It is possible to add fragments from libraries to the ribbon. To do this, in the Customize command on

the Ribbon tab, select the Insert Fragments from Library category and drag the required files onto

the Ribbon tab. This allows you to create your own ribbon tabs with library items or add them to

existing tabs.

When you select the Create documents from prototypes, you can add an icon for creating a new

document based on the specified prototype on the selected tab.

Hints

When you hover the cursor over a command icon, a short hint appears. If you hold the cursor for three

seconds, an extended hint with an illustration will appear.
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Similar short and extended hints exist for command and operation options.
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If necessary, you can disable all extended hints in the Customize command on the Options tab.

Textual interface

Main Menu contains the textual menu of the T-FLEX CAD commands by groups.
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Main Toolbar contains icon buttons for T-FLEX CAD commands. Besides the main toolbar, the

application window of the system can contain several toolbars (including the toolbars created by the

user). Toolbars can be docked along one of the main window borders, or stand alone as floating

windows.

System Toolbar contains the fields for modifying current settings of entities, such as color, line type,

level, and layer. Also contains controls for modifying layer configuration, level configuration of the

current document, and selector settings.

Topics in this section:

· Options

· Ribbon

· Toolbars

· Commands

· Keyboard

· Environment

· Main toolbar

· 3D Input Device

Options. Customizing Toolbars and Keyboard

On the tab Options there are parameters controlling the display of the textual menu and toolbars of

the system.

The group Personalized Menus and Toolbars includes into itself parameters determining the way the

textual menus are displayed:

· Always show full menus. By default, this flag is turned on. Otherwise the T-FLEX CAD textual

menu are displayed in a shortened version, hiding the menu items which have not been used

for a long time.

· Show full menus after a short delay. This parameter is available only when the flag Always

show full menu is turned off. By default, this parameter is turned on.
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· The button Reset cancels all changes made in the settings of the standard toolbars by the user.

The group Other combines the following parameters:

· Ribbon Mode. Allows to switch between ribbon and textual interfaces. 

· Icons size. Magnifying the size of the buttons in the toolbars and automenu. You can select

small (16x16 pixels), medium (24x24 pixels) and large (32x32 pixels) icons from the drop-

down list.

· Show ScreenTips on toolbars. This parameter activates the mode of displaying tooltips upon

pointing with the cursor at the buttons of the toolbars.

o Show Extended ScreenTips. Replaces a short screentip by a more detailed illustrated version

if it's available for a certain button. This option is available only when the flag Show

ScreenTips on toolbars is on.

o Show shortcut keys in ScreenTips. This option turns on/off the mode, in which not only the

name of the command but also the shortcut keys are shown in the tooltip. This option is

available only when the flag Show ScreenTips on toolbars is on.

o Show Open API names of commands. The option enables/disables the mode in which the

tooltip shows the name of the command in Open API. The option is available only when the

Show screentips on toolbars flag is enabled.

· Menu animations. This drop down list defines a special effect used upon opening the textual

menu: System default (in accordance with the general settings of the Windows), Random,

Unfold, Slide, Fade, None.

Ribbon. Customizing Toolbars and Keyboard

The Ribbon tab of the customization dialog allows to customize the content of the Quick access

toolbar, the Dynamic toolbar and tabs of the Ribbon.

Commands existing in the T-FLEX CAD are listed in the left side of the dialog. In the drop-down list

located above the left list of commands you can select a group of commands to display.
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All commands currently available in the ribbon, the quick access toolbar and the dynamic toolbar are

listed in the right side of the dialog. Commands in this list are divided in groups and tabs. 

Use the drop-down list above the right list of commands to switch between the ribbon, the quick

access toolbar and the dynamic toolbar.

To add a command to the selected toolbar or tab of the ribbon you need to:

· Select a command in the left list.

· Select a group of commands in the right list. 

· Press the [>>] button located between two lists. The selected command will be added to the

selected group.

Following buttons are available below the right list:

· Add tab 

Only available for the ribbon. Adds a new empty tab to the ribbon.

· Add group 

Available for the ribbon, upon selecting one of the tabs, and for the dynamic toolbar.

For the ribbon adds a new empty group to the selected tab.

For the dynamic toolbar invokes a catalog of possible object types to add into the right list.

· Rename/Delete

Always available.

· Import/Export 

Available for the ribbon and the quick access toolbar. Allows to import/export ribbon or

toolbar parameters from/to the XML file. The whole ribbon/toolbar is exported, no matter

what you select in right list.

Ribbon and Quick Access Toolbar Customization

Clicking  on a command, a group of commands or a tab of the ribbon in the right list invokes the

contextual menu. For groups it contains following options:

· Rename...

· Delete...
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For commands contextual menu additionally contains the Style option, allowing to customize an

appearance of a command in the ribbon.

For tabs contextual menu contains following options along with rename and delete mentioned above:

· Tags...

Allows to add a user-defined tag into a source code of a tab.

· Export tab...

Creates an xml-file containing a source code of a tab.

Tags and Export tab options might be useful, when creating custom add-ons for T-FLEX CAD.  

Styles of Displaying Commands in the Ribbon

· Automatic

The system selects style automatically depending on the available space on the screen

· Large icon and caption

· Small icon and caption

· Small icon

· Caption

Dynamic Toolbar Customization

When customizing the dynamic toolbar, commands in the right list are divided into groups

representing types of objects. The dynamic toolbar displayed upon selecting an object of a particular

type will contain commands from the corresponding group.

Sets of commands displayed when selecting a single object and multiple objects of the same type

might be different. Groups representing selection of multiple objects are marked with (plural).
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Some types of objects can be additionally divided into sub-types. The name of the sub-type is

displayed in the brackets. For instance, the Construction type includes Circle, Ellipse, Function, Line,

Offset Curve, Path and Spline sub-types.

There are also following special types:

· 3D Operation

Includes all 3D modeling operations

· 2D View

Represents the set of commands displayed upon clicking on an empty space in the 2D window

· 3D View

Represents the set of commands displayed upon clicking on an empty space in the 3D window

Contextual menu for each type of objects in the right list contains the Add more general commands

option. E.g.: if this option is enabled for the Construction (Circle), the dynamic toolbar displayed upon

selecting of a circle additionally contains commands from the basic Construction type.

Contextual menu for commands and object types in the right list also contains the Delete option.

Additionally, there is the Show on Toolbar option available for commands (enabled by default). Using

the Delete option deletes command not only from the toolbar, but from the right list as well.

Disabling the Show on Toolbar option deletes command from the toolbar, but not from the list.

Toolbars. Customizing Toolbars and Keyboard

The Toolbars pane lists the standard (available) toolbars used in T-FLEX CAD. A toolbar visibility is

controlled by setting or clearing the checkmark in the box before the name of the respective toolbar.

The buttons at the right side of the dialog box are used for creating and editing the user's own

toolbars, and also for restoring the settings of the standard toolbars (canceling changes made by the

user).

Creating user's toolbar. Defining toolbar name

To create a new toolbar, use the button New. In the coming up dialog box, define the new toolbar

name and press OK button. A floating toolbar comes on screen. Then, open the Commands tab. Select
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the desired toolbar name from the Categories list and the button from the Commands area, and drag

the button into the newly created toolbar using .

The name of the user's toolbar can be also modified after creating the toolbar. To do this, it is enough

to select a desired toolbar in the list and press the button Rename… This makes the window for

assigning the name of the given toolbar appear on the screen again.

Creating new toolbars can be also carried out on the tab Main Toolbar.

Changing toolbar content

While in the command Show Toolbars with the Toolbars or Commands tab brought up, one can

remove or move icon buttons from visible toolbars to other toolbars by dragging with the cursor,

using . Separators can be inserted to and removed from toolbars. This is done by selecting a

button and dragging it a bit aside. The same action can be done outside any command, by

additionally holding down the <Alt> key.

Any icon button on a visible toolbar can be duplicated by dragging it with the cursor, using  while

holding down the <Ctrl>+<Alt> combination, to any other toolbar or to an isolate location, thus

creating a new floating toolbar. 

Deleting toolbar

To delete a toolbar, use the Delete button after selecting the intended toolbar in the list. Note that

only user-defined toolbars can be deleted. Standard toolbars can’t be deleted. 

Restoring content of modified toolbar

To cancel all changes, made in the standard toolbars, the button Reset can be used. Pressing this

button restores the initial state of the selected standard toolbar.
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Commands. Customizing Toolbars and Keyboard

The list Categories: contains the set of categories of the T-FLEX CAD commands. The sets of icon

buttons in the Commands area are updated upon categories selection.

A special category User Commands includes into itself user's commands, defined in the dialog box of

the command Setting > User Commands.

The tab Commands: contains the list of the commands, included into a selected category. To add a

command to a toolbar, simply drag the button by the cursor, using , to the desired toolbar.
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Keyboard. Customizing Toolbars and Keyboard

This tab defines control key combination bindings of the system commands. The tab provides for

creating new key combinations, assigning them to commands, deleting previously assigned bindings,

and resetting (restoring the original system settings) of all key combinations.

The drop down list Category: enables to choose a category which contains the command being

edited. The commands, included into the selected category, are shown in the list Commands:.

The Key assignments pane displays all control keys for each particular command currently selected in

the Commands list. If the pane stays empty upon selecting a command, no key combination is

assigned to this command. 

To assign a control key combination to a command, enter the new combination in the Press new

shortcut key input box.

Creating a new control key combination

To create a new key combination, you need to:

· Choose the commands' category in the list Category.

· Select the desired command in the Commands list.

· Place the cursor in the Press new shortcut key input box and click .

· Set the new key combination using the keyboard, for example, simultaneously press

<Ctrl><Alt><F12>. The input box will read, Ctrl+Alt+F12. If a wrong combination is entered,

simply enter the right combination over again, without trying to delete anything.

· Press the Assign button. The new combination will then appear in the current keys list.

Several control key combinations can be assigned to the same command. 

Deleting control key combination

To delete a command key combination, you need to:

· In the list Category choose the commands' category.

· Select the command in the Commands list whose control key binding is to be deleted.

· Select the intended key combination in the Keys assignments list.

· Press the Remove button.
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Reset all key combinations to the original state

To delete all manually assigned key combinations, simply press the Reset All button. All key bindings

will then be restored to the original state, the way they were assigned at the initial system installation.

3D Input Device. Customizing Toolbars and Keyboard

T-FLEX CAD supports three-dimensional multifunctional manipulators compatible with the standards

Spaceball and SpaceMouse (for example, the products of 3Dconnexion, a Logitech Company,

http://www.3dconnexion.com). The 3D manipulators allow panning, spinning and zooming objects in

the 3D window.

Once such a device is attached, the Show Toolbars dialog box gains another tab, 3D Input device.

This tab is used for setting up 3D device working environment. The user can set up device operating

options in three modes: for working with 2D drawings, for working in the 3D model window, and for

working in the 3D model window in the active workplane mode. Selection of a working mode to set

up is done in the pull-down list of the parameter View mode.

The user can change:

· Mapping of the device axes on those of the T-FLEX CAD global coordinate system; direction

of action (translation or rotation) along each axis; sensitivity of the device to impacts for each

type of input (the Axes group). The device sensitivity is adjusted by the appropriate sliders.

The more a slider shifted to the right the less impact is required on the device for

translating/rotating the model along this axis;

· The level of filtration from accidental device disturbance (the Filtering parameter). The slider

position defines the filtration coefficient in the range from 0 (all impacts handled) in the left-

most position to 100% (only strongest impacts are handled) in the right-most position.

With simultaneous impacts on several axes of the 3D device, the axis of the maximum impact is

determined by the system. This impact is considered primary and is handled always. Other impacts are

handled only when they exceed the product of the maximum impact and the filtration coefficient;

· Mapping of the device buttons. Each device button can be mapped on a T-FLEX CAD

command.

The buttons [Reset], [Save…], [Load…] allow respectively resetting the changes to default settings,

saving the new settings in an external file (“*.t3d”) and load device settings from an external.
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Environment. Customizing Toolbars and Keyboard

This tab serves to work with Environments.

Environment is a set of system settings that can be saved in the Windows Registry or in an external

file with the purpose of a future quick system setup. An environment may include the following

settings: the visibility and composition of toolbars, special system windows, library and folder

windows; the system settings, default customizations of various commands, etc.

The list of existing Environments is displayed in the left part of the dialog. Initially, the only item in the

list is Current Environment. It denotes the current system settings. In the future, all user-created

Environments are added here.

Already existing Environments can be renamed or deleted. To do that, select them in the list (using

) and click the respective button (Rename or Delete).

To apply an existing environment, select it in the list and click Apply.

You can create a new Environment either based on the current system settings (Current Environment),

or based on another existing Environment.

To create a new Environment, you need to:

· Select an Environment in the list, whose settings need to be copied to the new Environment.

You can also select the Current Environment for this purpose – in this case, the current system

settings will be saved in the newly created Environment;

· Once an Environment is selected, you will see the list of setting groups stored in it. By default,

all parameter groups are marked with checks in the list. That means, all of that will be copied

to the new Environment. To avoid copying some settings, clear the checks before the

respective group names;

The list of setting groups is closed upon another click  on the selected Environment. The

changes made in it (changes in the setting groups selection) will be remembered until selecting

another Environment in the list. To close the list, you can also use <Left>, <Right>.

· Click the button New. A new Environment with the standard name Environment 1 (2, 3, …) will

be created. Right after the Environment creation, the system goes into its name editing mode.
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You can cancel that by clicking  outside the Environment name input field. You will be able

to edit an Environment name in the future using the button Rename..

An existing Environment can be altered by overwriting the settings stored in it by the current ones. To

do that, select it in the Environments list, mark the groups of settings in its settings list, which you need

to replace, and click Overwrite. Please note that this button is unavailable for the Current

Environment item.

To save an existing Environment in an external file, use the button Export…. Upon clicking the button,

a standard file-saving window appears. The file name default is the same as the Environment name.

The file extension is – "*.2Denv" for the 2D system version, "*.3Denv" for the 3D system version.

To import an Environment from an external file, use the button Import…. Upon clicking it, the standard

file-opening dialog appears, in which you need to select an Environment file. The Environment

imported from the file appears in the Environments list. Besides that, upon importing an Environment

the system will offer to apply it.

The Environment files created in the 2D system version will not be recognized in the 3D version,

and vice versa.

The buttons Apply, Delete, Rename, Overwrite are inaccessible for the Current Environment item. But

the latter is provided the Reset Settings command, using which replaces the current settings by the

default ones.
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Main Toolbar. Customizing Toolbars and Keyboard

This tab displays the list of all main toolbar sets that are defined in the system. The sets marked in the

list by the tick are displayed on the toolbar, unmarked sets are hidden. It is possible to control visibility

of the sets independently, by removing/putting the tick (with the help of ) located next to the

name of the corresponding set.

Double pressing  on the name of any set activates the set on the main toolbar.

The button Rename enables to assign another name to any set of the main toolbar. After pressing this

button, the window for assigning the new name of the set appears.

Buttons Up and Down allow changing the order in which the sets follow in the list.

To add the new (user's) set to the main toolbar the button New is used. After pressing this button the

system prompts to assign the name of the set being created. Also, the prompt to add the standard

buttons (i.e. related to command used for working with new documents, files etc.) to the new set will

appear on the screen. In case of negative answer, an empty set is created, in case of positive one, the

set containing only the standard buttons is created. Other buttons can be added to the created set via

the tab Commands (by using “drag&drop” method).

It is possible to remove the previously created user's set by selecting it in the list and pressing  the

button Remove (for standard sets this button is not available).

The button Create toolbar enables to create a single toolbar on the basis of the set selected in the list.

Upon creating the toolbar, it is possible to automatically remove the standard buttons from it (by

default, these buttons are present practically in all standard sets of the main toolbar).

To make the work more convenient, several sets of main toolbar commands were assigned the key

combinations for quick call with the help of the keyboard (by default, these sets are 2D, Sketch, 3D). If

necessary, the key combinations can be also assigned for other sets (including user's defined ones). To

do it, the buttons Assign and Reset in the group Keyboard are used. 

After pressing the button Assign the window opens up in which the required key combination for the

selected set has to be specified. For specifying the combination, it is just enough to press the

corresponding buttons simultaneously. If the combination is specified incorrectly, it is sufficient to

press the correct combination again. After closing the window with the help of OK the specified key

combination will be displayed in the list to the right of the name of the corresponding set.



System Customization

259

To modify already defined key combination for some set, it is enough to press the button Assign and

specify new combination. 

For removing the assigned key combination without specifying a new one, it is necessary to press the

button Reset after selecting a set in the list.

The Show labels flag controls how the labels to the buttons of the main toolbar are displayed. By

default, the flag is disabled, i.e., the labels are not shown. 

The Show Labels flag has a similar action in the context menu that is invoked with the help of

 in the domain of the automenu or any toolbar. These two flags (Show Labels in the Show

Toolbars command and Show Labels in the context menu of toolbars) work in a synchronized

manner.

Additional flag called Use standard font affects how the labels to the buttons of the main toolbar are

displayed when working in Windows Vista. If in the settings of Windows Vista the large font size is

selected and the Use standard font flag is disabled, the labels to the buttons of the main toolbar will

be displayed larger than the labels in the text menu. If the flag is enabled, the font size on the main

toolbar is the same as that in the text menu.

Switching Environments

Settings made in the commands Set System Options and Show Toolbars, as well as in some other

commands, can be saved using the Environments mechanism. Created Environments are used to

quickly set up the system.

Environment is a set of system settings that can be saved in the Windows Registry: the visibility and

composition of toolbars, special system windows, library and folder windows, the system settings,

default customizations of various commands. An Environment may also include the settings made in

various system windows (variables editor, databases, etc.) and, as was already mentioned, all settings

defined in the commands Show Toolbars and Set System Options. 

Environments are created by the user. Created Environments can be edited and deleted.

By using Environments you can quickly set up the system in a desired way by simply applying an

earlier saved Environment. You can create an unlimited number of Environments. In this way, for

example, you can arrange convenient working of several users on one work seat: save each user's

Environment with one's personal settings and apply it when needed. Besides that, Environments can be

stored in external files and, therefore, be loaded from external files. This allows porting T-FLEX CAD

settings from one work seat to another one.

The main work with Environments (creating, editing, deleting, applying, export/import from an

external file) is done in the Show Toolbars command dialog on the “Environment” tab. This was

described earlier in this chapter, the section “Customize Toolbars and Keyboards”, the topic

Environment Tab. Here we will describe the method to quickly apply already created Environments.

The Environments existing in the system can be quickly loaded using the textual menu Customize >

Environment. All Environments existing in the system are added there automatically. 
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To use any of the Environments, you just need to go into the said menu and select the desired

Environment from the list. 

Customize > Environment > Customize… command serves to quickly open the Show Toolbars

command dialog on the “Environment” tab.

Reset Settings

To restore default system settings, use the item Reset Settings. The drop-down list is in the upper right

corner.

T-FLEX CAD system settings are saved in the operating system registry. Settings might be different for

different users. 

Default settings can be aslo restored using the Reset T-FLEX Parametric CAD settings shortcut in the

main menu of Windows operating system.
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Document Parameters

The command can be called in one of the following ways:

Icon Ribbon

Edit > Document > Document Parameters

Keyboard Textual Menu

<ST> Customize > Document Parameters

Each T-FLEX CAD document has its own parameters. These parameters include a variety of definitions

of both general nature and specific to particular elements. Examples of the former include setting

drawing boundaries and scale, while the latter – dimension standards, line thickness, etc. These

parameters can be defined not only at the beginning, but also at any moment while working on a

document. All parameters are saved with the document. In the case of multi-page document,

parameters can be defined separately for each page. When creating a new page, its parameters are

copied from the currently active page.

One can create a prototype document with its specific parameters. To do so, use the command File >

Save as Prototype… The prototype file will be saved in the folder “…\AppData\Local\Top Systems\T-

FLEX CAD 3D 15 x64\Eng\Templates” (see System Requirements). To create a new document with the

settings as in a prototype, use the command File > New From Prototype. The desired prototype file

can be selected from the list (multiple prototype files can be created.)

Any T-FLEX CAD document can be used as a prototype. Initially, the system is shipped with several

prototype documents “*.GRB”. These are located in the system folder (…\Program\Template). Their

parameters comply with several drawing standards. Depending on the choice of the particular

drawing standard, new documents created via File > New will assume all settings from the respective

prototype. The name of the prototype document can be redefined using the command Set System

Options, on the Files tab.

Document Parameters command dialog

Document Parameters can be specified using the eponymous command.

The command brings up a dialog with tabs holding various groups of parameters. 

When you select a parameter its tip appears in the bottom part of the screen. Such tips are

available for the most of the parameters.
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The tabs structure tree is displayed on the left side of the Document Parameters dialog. Content of

the selected tab is displayed on the right side.

Tabs are divided into two groups Page and Document

Upon selecting a group in the tree, right side of the dialog displays content of a first tab from a

selected group.

You can display content of all tabs from a group at once by selecting the All item in the tree.

Content of the Document group is applicable to a whole document. Content of the Page group is

applicable to a selected page only.
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Document group of tabs contains Annotations group whose subtabs have same names and

contain same parameters as subtabs of the Page group. In this case, parameters from the

Document group are applied to elements in the 3D scene, while parameters from the Page

group are applied to elements on the drawing.

Page and Document groups contain eponymous View tabs. These tabs contain different

parameters which are applicable to 2D and 3D windows accordingly.

A page can be selected in the drop-down list in the top of the window. It is possible to set displayed

pages type for the drop-down list using the Filter button:

Using the Copy to… button it is possible to apply parameters of a tab selected in the tree to other

pages. Clicking this button invokes the Copy parameters of pages dialog. The Parameters... filed in

the top of the dialog contains name of a tab selected for copying. The list of pages with checkboxes is

located below. Clicking OK applies selected parameters to each page with enabled checkbox.

Topics in this chapter:

· All Document Parameters

· Document group of tabs in Document Parameters

· Page group of tabs in Document Parameters
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All Document Parameters

All existing in the current group (Document or Page) parameters are displayed on the All tab. 

The parameters can be sorted by categories or alphabet.

You can enter parameter name or part of the name in the search bar to find it.

Information about a certain parameter can be found in section of help describing its tab of the

parameters dialog.

Document group of tabs in Document Parameters

This group contains following tabs:

· 3D

o Annotations

§ Font

§ Dimensions

· Alternative Dimensions

§ Symbols

§ Detailing Elements

Font, Dimensions, Alternative Dimensions, Symbols, Detailing Elements tabs in the Document

group contain similar parameters as eponymous tabs in the Page group. In this case, parameters

from the Document group are applied to elements in the 3D scene, while parameters from the

Page group are applied to elements on the drawing.

o Cable Components

o View

Page and Document groups contain eponymous View tabs. These tabs contain different

parameters which are applicable to 2D and 3D windows accordingly.

o User camera

· 2D Fragment

· 3D Fragment

o Sections

· Large Assembly Management

· Performance

· Compatibility

· External Variables

· Naming rules

· Visibility of Pages

· Save
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3D. Document Parameters

This tab collects general parameters related to 3D modeling:

Units

Units section. Defines measurement units of the elements and operations on the 3D scene.

· Mass. Defines mass units for solid objects of 3D scene.

· Length. Defines length units for 3D objects.

· Force. Defines force units for 3D objects. Used in Measure command and loads definition in

Analysis studies.

Scale Value. Parameter is used when the value of Length parameter is set to User. Value of this field

defines ratio of user-defined custom length unit of measurement to a one meter. Accepted range of

values - from 0 to 100. E.g.:

· Scale Value = 1

Custom length unit is equal to one meter.

· Scale Value = 100

Custom length unit is equal to one centimeter.

· Scale Value = 0.1

Custom length unit is equal to ten meters.

Characteristics

This tab allows to define custom mass value for current document, when it's added to an assembly as

a fragment.

Set mass manually field controls application of custom mass. Value in this field can be defined

numerically or via a variable. Depending on the value, field works in the following way:

· -1<Set mass manually<1

Value is rounded to a zero upon clicking OK. Custom mass is not applied

· Set mass manually<-1 or >1

Value is saved upon clicking OK. Custom mass is applied.

Mass - custom mass value in kilograms..

Workplanes

The Workplanes group defines the mode of displaying the workplane names and types. These

parameters are displayed in the upper-left corner of the respective workplanes.

3D Triad Orientation. Defines orientation 3D model views in the world coordinate system. 
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· The value XY-Top corresponds to the choice when axes direction of the “Top view” coincides

with the directions of X and Y axes of the world coordinate system. 

· The ISO setting defines the ISO standard orientation.

Selected orientation is used when creating projections and in the commands of 3D window viewpoint

definition («Front View», «Left View», «Right View», «Axonometric View», etc.).

Display Options. Allows you to display/hide workplane types and names in 3D scene:

· Don’t display. Workplane name and type are not displayed.

· Draw Name. Sets the mode of displaying the workplane name according to the workplane

type. Note that changing the workplane type does not affect the name. The name can be

changed manually under the workplane parameters.

· Draw Type. Sets the mode of displaying the workplane type (Front, Left, etc.).

· Draw name and type. Both workplane name and type are displayed.

Workplane font. Defines font size for workplane names.

Mesh Quality

Image Quality. This parameter allows us to specify the degree of refinement of the model mesh

consisting of planar triangular faces upon displaying the image in the 3D window. Higher quality of

the image of the model increases the number of planar faces which slows down the work for large

models or for insufficiently powerful video cards. If possible, it is recommended to minimize the

quality of the image of the model.

If you're interested in how many triangles are used for displaying a specific model with specific

mesh quality parameters, enable the Display graphics performance data checkbox in the

Graphics Settings tab of the System Options dialog.

Edge Tolerance – the maximum distance between the curves of the model and edges of the mesh

which approximate these curves;

Face Tolerance – the maximum distance between the surfaces of the model and planar faces of the

mesh which approximate these surfaces;

Angle Tolerance – the maximum angle, specified in degrees, between the curves of the model and

the edges of the mesh which approximate these curves. The angle is equal to the sum of angles

between the edges of the mesh and the tangents to the original curve at the end points of the edges.

This parameter also defines the maximally admissible angle between the surfaces of the model and

the planar faces of the mesh which approximate these surfaces (i.e., the angle between the normals to

the surface or face).

3D

Main View Coordinate System. This parameter defines the orientation of 3D model views, i.e.,

location of views (“Front view”, “Top view” etc.) in the world coordinate system. Its orientation is used
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when creating projections, as well as in the commands of 3D window view direction («Front View»,

«Left View», «Right View», «Axonometric View», etc.). This option can be helpful when working with

imported geometry, parts created in context of assembly or other analogous cases, when model is

oriented discordantly to main directions.

Local coordinate system selected as the main view coordinate system cannot be deleted.

Edit parameters after creation if file is used as template. The given parameter is also used only for

the document which will become a prototype. Moreover, the document-prototype must have a set of

external variables. Then, if the flag is enabled, upon creation of a new document on the basis of this

prototype will immediately appear the window of the editor of external variables of the document

being created.

Fixed set of windows. When the given parameter is set up, the current set of views (i.e., 2D and 3D

windows) is getting fixed in the document. Upon subsequent openings of the document, modification

of this set of views will not be possible. It will not be possible to delete one of the windows by

reducing its size to zero (when moving the window's separator), or add a new view (the button of

creation of a new view will not be available). This functionality is convenient for creation of templates

with a set of views defined in advance.

Arrow ends of 3D paths/3D profiles.

Checkbox is disabled (default) Checkbox is enabled

Selection of Transparent Faces

The Selection of Transparent Faces group of parameters allows us to control selection of transparent

faces in the 3D scene:

Transparency limit. This parameter can take values ranging from 0 to 1. It is possible to specify the

transparency limit with the help of a variable. If transparency of some face of a body is higher than the

indicated transparency limit, this face will be ignored when it is selected in the 3D scene.
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Recall that transparency 0 corresponds to the absolutely opaque body (face), 1 – absolutely

transparent. Transparency which is larger than 1 is impossible, therefore the value of the limit equal to

1 (default value) corresponds to the standard behavior of the system.

Select by Edges. If this flag is enabled, those faces whose transparency is larger than the specified

limit can be selected by their edges (as in the wireframe mode). When the flag is disabled, such faces

cannot be selected.

Mates

Mates group of parameters define performance of mates solver only for regenerating a 3D model.

Time (0-1). Defines the time limit of mates solver calculations. The limit is set as factor between 0 and

1 corresponding to “less” and “more” respectively.

Calculation method. Sets one of two available methods of calculation – precise or fast.

More information about calculation methods can be found in Mates chapter.

Precision. Specifies precision of mates calculations when regenerating a model. The parameter value

mates deviation. If mates deviation exceeds the specified value, all mates will be recalculated. If there

are no mates, which deviation exceeds the specified value, the recalculation will not be performed.

This reduces model recalculation time.

Method of contacts definition - method of contact definition for bodies, which are not primitives. It is

used in T-FLEX Dynamics, when contact analysis is included and in the command of movement of

mated bodies. Following methods are available:

· Meshes

· Parasolid

Moreover, the 3D tab contains following sub-tabs:

· Annotations

o Font

o Dimensions

§ Alternative Dimensions

o Symbols

o Detailing Elements

Font, Dimensions, Alternative Dimensions, Symbols, Detailing Elements tabs in the Document

group contain similar parameters as eponymous tabs in the Page group. In this case, parameters

from the Document group are applied to elements in the 3D scene, while parameters from the

Page group are applied to elements on the drawing.

· Cable Components

· View

Page and Document groups contain eponymous View tabs. These tabs contain different

parameters which are applicable to 2D and 3D windows accordingly.

· User camera
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Cable Components. Document Parameters

Use rounding

Enables rounding to a nearest value multiple of the Rounding Accuracy when calculating length of

wires and cable components in reports and cable drawings.

Rounding Accuracy

Measured in meters.

Round Up

Enables rounding to a ceiling multiple of the Rounding Accuracy when calculating length of wires

and cable components in reports and cable drawings.

Example:

Initial value - 3.21

Accuracy - 1

Result of rounding to a nearest value - 3

Result of rounding to a ceiling - 4

View (3D). Document Parameters

Selection:

Element selection. Defines element selection modes while in drawing and editing commands. Select

one of the two modes:

· All. When creating and editing elements, all existing elements will be allowed for selection.

· Visible only. When creating and editing elements, only the visible elements will be allowed for

selection. The element  visibility  is determined   based  on element levels and visibility

intervals defined in the command Set Levels (Customize > Levels…), as well as layer

configurations defined in the command Configure Layers (Customize > Layers…).
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View

Environment texture. File of the image containing the picture of the texture. This parameter allows us

to virtually surround the objects of the model by a 3D image which will be displayed on the faces of

the model. To specify this texture the format hdr is used.

Surrounding can be also specified in the properties of a 3D view or with the help of moving the

texture file from the Windows Guide to a 3D window.

In all windows of a 3D model the same texture of the surrounding is used. In one specific window the

use of the texture can be blocked by the corresponding flag in the properties dialog.

Parameters of the material such as "Gloss" and "Reflection" strongly affect visual properties of the

material when using the texture of surroundings.

In case when these parameters have zero values, the surrounding texture will not affect the

appearance of the model.

Background texture. File of the image containing the picture of the texture. Reference to this file can

be specified in the "Document Parameters" dialog on the 3D > View tab, in the 3D window

properties dialog or by the method of moving the file of the raster image from the Windows Guide to

the 3D window. This parameter allows us to use the texture as a background of the current drawing’s

window. 

The same background texture is used for all windows of 3D model. In one specific window the use of

the texture can be disabled; to do so there is a corresponding parameter (flag) in the properties of a

3D view. To specify the texture the files of the formats bmp, jpg, jpeg, gif, tga, tif, tiff, png can be

used.

Size

The Size group includes definitions of 3D node size (in pixels), and the sizes of coordinate systems

and arrows (in respective measurement units). 3D element sizes can be arbitrarily defined at user

preference.

Color

One color. Sets the display mode of using one color for all 3D elements. This color overrides element

own settings.

Color. Defines the color for all 3D elements when one color mode is set. The color can be selected

from the menu of colors.

User camera. Document Parameters

Step of smooth moving. Step size in smooth moving mode. Defined in percentage of the scene size.

Angular step of smooth moving. Angular rotation step in smooth moving mode (radians).

Moving in the screen plane. Effects on speed of motion. Defined in percentage from 0% to 100%.

Speed when moving by arrow keys. Speed depends on a scene size. Movement is faster when value

is bigger.
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2D Fragment. Document Parameters

On 2D Fragment tab you can define the fragment attributes on inserting the document as a fragment.

Priority. Setting this attribute allows to define a priority value to be assigned to the fragment on

inserting into an assembly drawing.

Disable Edit In Context. When set, editing this document in the assembly context is prohibited.

Enable Draggers on Edit. If set, the draggers (manipulators) will be enabled for this 2D fragment

within an assembly in the fragment editing mode. The draggers allow modifying the external variables

of the fragment by using the mouse.

Don’t show Variables List on Edit. This option hides Preview and Variables List flags in the fragment

parameters dialog box on editing. The option works only for the custom dialog boxes of fragment

variables.

Use Parameters of. This parameter allows specifying what settings of the drawing will be used upon

inserting the given document into the assembly as a fragment:

· Default. The default settings specified in the assembly for the parameters of the 2D fragment

will be used;

· Fragment Document. The settings of the current document will be used;

· Current Document. The settings of the assembly drawing will be used.

Default Fixing Vector. This parameter sets the main fixing vector used upon insertion of the given

document as a 2D fragment. This parameter duplicates the corresponding flag in the properties of the

fixing vector.

Insert on layer. This parameter specifies the name of the layer on which a 2D fragment will be placed

when the given document is inserted into the assembly.

Create dimensions in assembly. Option is used to insert dimensions existing in 2D fragment into an

assembly. When 2D fragment with dimensions is inserted into the assembly drawing, the dimensions

are transformed to separate elements as if they were created right in the assembly drawing. There are

three options:

· No. Dimensions that already exist in fragment file will be included into assembly. Such

dimensions can’t be edited because they are part of the fragment.

· Automatically. Dimensions will be automatically created after the fragment insertion. When

2D fragment with dimensions is inserted into the assembly drawing, the dimensions are

transformed to separate elements as if they were created right in the assembly drawing. These

dimensions will not be inserted from the fragment file; they will be created directly in the

assembly document. The dimensions will be created according to the dimensions from the

fragment file, i.e. their locations and attachments will be inherited from the fragment. You can
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edit the dimensions. The dimensions will be correctly displayed if you rotate fragment using

fixing vector. 

The dimensions will be created only if they are based on graphic lines. Dimensions based on

construction lines or nodes will not be created. 

If the dimension is considered to be driving in the fragment file, i.e. it’s nominal size is set by

an external variable, you can change the variable value in the assembly. The fragment and its

dimensions will be recalculated according to the new value.

· Manually. After fragment insertion, its dimensions won’t be created in the assembly. To add

dimensions into the assembly you need to use Create dimensions in assembly command in

the fragment context menu.

The dimensions will be created in the same way as for Automatically. 

Explode fragment. Allows to explode 2D fragment when it is inserted into an assembly. The fragment

is deleted after explosion and all its visible elements copies will be created in the assembly.

· No. The fragment won’t be exploded after insertion.

· Without construction. Only copies of all visible graphic elements from source document will

be created.

· With construction. Copies of all visible graphic and construction elements from source

document will be created.

Group. All fragment elements will be automatically grouped after fragment explosion.

The option is used only for exploded elements.

Never include in BOM. Fragment data is not included into product composition, when the flag is set.

3D Fragment. Document Parameters

3D fragment tab in Set Model Parameters command provides possibility to specify default LCS used

for fragment fixing, specify type of insertion, set parameters for automatic Boolean operation.
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Automatically create Boolean Operation

When inserting a 3D fragment, one can automatically create a Boolean operation of a specified type.

The target body will be the selected body in the assembly, while the tool body - one of the bodies of

the 3D fragment, or all fragment bodies at once.

Setting up automatic creation of Boolean operation is performed with the help of several parameters:

Operation Type. This parameter defines the type of the Boolean operation (addition, subtraction,

intersection) that will be created upon inserting the fragment in the assembly. The type can be

selected from the list.

Create operation with:

· Use the whole Model. With this option checked, the whole 3D model of the fragment will be

used as the target body of the Boolean operation.

· Use single operation. Selecting this option makes the Boolean use just a single operation

within the fragment. The desired operation can be selected from the list of all existing

operations.

In the case when a body is used in the Boolean, that is not visible when working with the

document of the 3D fragment, it is possible to place it in a special layer marked as Visible only

when model is used as a Fragment.

Let's take an example of the use of automatic creation of a Boolean operation when inserting a

fragment. Suppose there is a 3D model of the wall of the house in which you need to insert a window

as a 3D fragment.

1. House wall model

2. Window model in a separate fragment

To do this, the window model must be created in a certain way. You need to specially create a

parallelepiped body on top of the window, along which an opening in the wall will be cut to insert the

window.
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Then you need to open the document parameters, the 3D Fragment tab (see above). Set the

Operation Type - Subtraction, Create operation with - operation of creating a parallelepiped body

(for example, Extrusion_2).

Then you need to go to the fragment with the model of the wall of the house, call the fragment

insertion command, insert the window fragment into the desired location and click .

 

As a result, the inserted window fragment will be subtracted from the model of the house wall.

3D Fragment

Fragment Name. The parameter specifies the name with which the fragment will be displayed in the

assembly model tree in the format Name_1 (ISO 3D Model 1.grb).

Fragment name (displayed). The parameter specifies the name with which the fragment will be

displayed in the assembly model tree in the format Name_1. The fragment name can be set to a

variable, for example - {a}. When inserting such a fragment into an assembly, its name may be

different depending on the value of the variable.

Folder Name. This parameter specifies the name of the folder into which the fragment will be placed

in the assembly’s model tree.
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Fragment’s name and folder’s name are read from the fragment’s file only upon creation of the

new fragment. If the values of these parameters are changed, then upon update of the fragment

in the assembly the name and the folder will remain the same.

Copy fragment file to assembly folder. If this parameter is turned on, the file of a fragment that is

inserted into the assembly is automatically copied into the folder of the assembly document (or its

subfolder). A link to the file that has been copied and not to the original one is written in the

properties of the fragment.

You can specify a name for the subfolder to the right of the flag. The subfolder will be created inside

the folder of the assembly document into which the file of the fragment will be copied. If this field is

empty, the file is copied directly into the folder of assembly.

Default LCS used for Fragment fixing is selected from the list. The list contains all local coordinate

systems of the model that have the flag “Use for Fragment insertion” set. When inserting such

document as a 3D fragment, the thus defined coordinate system will be automatically offered as the

source LCS.

If necessary, the permitted degrees of freedom can be set in the properties of the prepared

coordinate system, which will insure the correct behavior of the given 3D fragment in an assembly in

the mode of moving mated elements (see the chapter Mates and degrees of freedom).

For uncomplicated parts, which can be conveniently inserted into the assembly in the mode of

dynamic snapping, the given mode can be turned by default.

Insert 3D fragment on layer. This parameter defines the name of the layer onto which the fragment

will be placed upon its insertion into the assembly. If in the fragment’s document the “Insert on layer”

parameter is enabled, but upon insertion of the fragment into the assembly this layer does not yet

exist, then this layer is created automatically upon request.

Don’t show the message “Fragment doesn’t have bodies”. By default this parameter is disabled. In

this case the system does not allow for insertion, into the 3D assembly, of the fragment in which the

3D model is absent or suppressed. The corresponding message in the diagnostics window appears as

comments.  When this flag is enabled the system allows for insertion of “empty” fragment without

issuing any messages.

Set Autosave Parameter. If the given parameter is set up, then upon insertion of the current document

as a 3D fragment into the assembly, the “Auto Save” parameter is automatically enabled in the

parameters of the fragment. The file of such a fragment will automatically be saved upon each saving

of the assembly, with the substitution of the values of external variables and adaptive parameters.

Set "Always regenerate 3D model" parameter. Enables the eponymous checkbox in parameters of

2D fragment. If it's enabled, 3D model of a fragment is automatically recalculated upon linked 2D

fragment's parameters alteration.

Set "Autosave configuration" Parameter. Modifies configuration/variation in fragment file when

changing variable values.

Update reports/BOM on autosave. Enable this checkbox, then insert the current document into an

assembly as 3D fragment and enable the Autosave checkbox in fragment's parameters. In result, upon

each autosave all reports and BOMs existing in the fragment document will be updated.

Include in assembly product composition. The drop-down list contains following options: By default,

Don't include, Without embedded elements, With embedded elements, Embedded elements only.

The selected option will be applied automatically in the fragment parameters (Additional Parameters

> Include in new Product Composition) upon inserting this document into an assembly. The By

default option applies the parameter that is set as default for all fragments within the assembly

document (via the By default checkbox in fragment's parameters dialog).

Type of Insertion (for application). The chosen way defines behavior of a 3D fragment at an insert

into 3D assembly.
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· Standard. Upon insertion into the assembly the translation of the fragment is possible only

with the help of the manipulator of LCS  (dynamic translation is disabled);

· Fastener. When inserted into the assembly the fragment dynamically moves after the cursor of

the mouse;

· 3D Placement. This method of insertion is used for quick creation of the arrangement in 3D

scene. In the fragment’s file special attachments to the floor, walls, ceiling, horizontal surfaces

must be created. These attachments are defined by means of connectors with the specific

parameters;

· By points. A fragment can be fixed to the selected in the 3D scene points upon insertion. Its

size changes according to the distance between the points.

· Smart fragment (macro). This method of insertion is used for parametric fragments whose

insertion scenario is described in the program (macro) stored directly in the file of the given

fragment or in the external module (DLL). When inserting the file as a fragment the user-

specified macro will be executed.

Moreover, the 3D Fragment tab contains following sub-tab:

· Sections

Sections. Document Parameters

You can define options for section views on 2D projections on the Sections tab.

The Don't apply sections in case list allows to ass conditions when fragment won't be cut upon

creating section views.

For some models (future components of assemblies) it can be helpful to define special settings for

preventing their cutting when used in section views of 2D projections. For example it is known that
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bolts should not be cut on section views of assembly drawings. This option will help to avoid time

consuming manual customization of 2D projection parameters for assemblies that contain such parts.

New condition can be created with the help of + button. Section Application Condition section will

appear with the lists of conditions and LCS names. 

Conditions are organized in relation to the alleged source fragment LCS that exists in a document of a

future 3D fragment. For example a part may remain uncut if a section plane goes through a specified

axis of the source LCS, or coincides with one of the main LCS planes.

Large Assembly Management. Document Parameters

Don't show Parts Smaller than. If this parameter is set, then 3D objects with the size less than the

specified (in model units) will not be displayed in the 3D model.

Performance. Document Parameters

Save calculation results of intermediate operations. Enabling of this option speeds up entrance to

editing commands of the intermediate operations, but it slows down the total time of recalculation

and allocates more RAM.

Saving step. System will store intermediate calculation results not for all operations, but for particular

operations with the specified step, e.g. for each 5-th operation.

Maximum number of saved results - maximum number if intermediate operations for which the

geometry will be saved.

Save results to model file. Store geometrical data of intermediate operations in file, if these

operations have such data at the time of document saving. This parameter may speed up entrance to

editing commands of intermediate operations after document opening, but will increase file size and

opening time.

Simplify Geometry. Replaces curves at intersections of surfaces by b-splines when recalculating faces.

Significantly reduces the size of the document, slightly slows down recalculation. 

Compatibility. Document Parameters

Use variables in database search conditions. When searching in databases, the names and text fields

are treated in the conditions as text variables, otherwise - as text constants.

Synchronize fragments with T-FLEX DOCs. If this flag is active, then when loading a document from

T-FLEX DOCs, fragments will be automatically created, modified and suppressed to bring the

assembly in line with the product composition.
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External Variables. Document Parameters

External variable editor. This parameter defines the means of editing external variables in the

command External Variables.

If Internal Editor is set, the model variables are edited using the Variables Editor built in the T-FLEX

CAD system.

If External Program is set, you can define a means of editing model of your own. This implies the user

writing a custom application for editing external variables. An example of such application is the

format creation functionality that provides a dialog box for filling in the format template. You can use

Open API for this purpose.

More information about OPEN API can be found in API Help.

Control. This option is used if a custom dialog is created in the document, containing parameters to

edit external variables. The document pages to be displayed in the dialog window must be checked in

the list of pages.

If there are Dialog-type pages in the document that were created within the command Create Control,

then this parameter setting is applied automatically, and the respective page is marked in the list.



System Customization

279

Regenerate 3D Model. When this flag is enabled, the 3D model of the document is automatically

regenerated upon editing of external variables.

A detailed description of creating a custom dialog and its handling techniques are provided in

the chapter Control Elements. Creating User Defined Dialog Boxes. 

Naming rules. Document Parameters

On this tab you can set names and numbering for the following pages: Normal, Workplane, Dialog,

Auxiliary and Bill of materials.

The following numbering can be set:

Sequential numbering within page type. Pages are numbered according to their types.

Consecutive numbering of all pages. Pages are numbered regardless to their types.
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Visibility of Pages. Document Parameters

This tab contains checkboxes for all types of pages available in the T-FLEX CAD.

Enabling a checkbox makes pages of a corresponding type appear in the Page Tabs.

Alternatively, you can customize visibility of pages using the Pages command. Checkboxes in the

Pages command's dialog are synchronized with checkboxes in the Document Parameters dialog.

Save. Document Parameters

This tab defines automatic creation of a preview and an icon for the current drawing. The preview and

the icon can both be created using this tab.

Icon

The Icon group defines parameters for creating the icons of the document. The document icons will

appear in all places where the display of the document icon is foreseen (on the tab of the document

upon its opening in the T-FLEX CAD, in the model menu, etc.).

Save. Defines the icon saving mode. This parameter can assume the following values:

· None. The icon is not saved. In this case, an earlier saved icon will remain with the file (if any).

· Auto – 2D. A icon with the 2D image is saved automatically on each document save.

· Auto – 3D. This icon with the image of the 3D model will be saved automatically each time

the document is saved.

· Manually. In this mode, the icon can be created manually using the command Save Preview

(Tools > Special Data > Preview). Unless using the latter command, this setting is equivalent

to None.

Size. Defines the size of the icon. The size can be selected from the list, as follows: Maximize Image,

By paper.
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Preview

The Preview group defines the parameters of the drawing preview image for its quick display in the

document preview pane of the File > Open… command dialog box.

Save. This parameter defines the preview saving mode. The parameter can assume the following

values: none, auto, manually.

· None. Preview is not saved. In this case, an earlier saved preview image will remain with the

file (if any).

· Auto. Preview is saved automatically on each document save.

· Manually. In this mode, the preview image can be created manually using the command Save

Preview (Tools > Special Data > Preview). Unless using the latter command, this setting is

equivalent to None.

Size. Defines the size of the preview image. The size can be selected from the list as follows:

· Maximize Image. With this value, the created preview is restricted to the actual drawing image

limits.

· By paper. With this value, the created preview covers the whole page according to the paper

size defined on the General tab of the same dialog box.

Format. Defines the preview file format. A format can be selected from the list: T-FLEX CAD Metafile

(BMF), Windows Bitmap (BMP) – 2D, Windows Bitmap (BMP) – 3D.

Width and Height. These parameters define the sizes, in pixels, of the bitmap image.

Save

The Configurations defines the system behavior on saving a document with configurations. The

following modes are possible when document saved:

· Ask about regeneration – if the document contains outdated configurations, then the user will

be asked at the time of saving the document, whether or not to regenerate configurations.

· Regenerate all model configurations – on saving the document, all configurations will be

regenerated and saved automatically.

· Don’t regenerate model configurations. 

Save 3D Picture data in model file. Sets the mode of saving the 3D image in the document file. This

saves the regeneration time on opening the file while taking more disk space for the file. Besides, a

file with the saved 3D image can be used as a 3D picture (see the command Operation > 3D Picture). 

Save active window settings in model file. Setting this parameter allows saving the latest settings of

the current drawing window in a file. For example, if you divided the window into two panes, one of

which contains the 3D model, then after loading the file, the sizes and locations will be restored.

Save new file after creation if used as a template. This flag is useful if the current document is

intended to be used as a prototype. If this flag is enabled, upon creation of a new document on the

basis of this prototype the window of saving the file will immediately appear. When the saving is

refused, the new document is not created.

Save Document History. Enables automatic tracking of the document history by the system.

Page group of tabs in Document Parameters

This group contains following tabs:

· Paper

o Zones

· Font

· Dimensions

o Alternative Dimensions

· Lines

· View
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· Fragments

· Symbols

· Detailing elements

· Colors

· Grid

Paper. Document Parameters

This tab defines main drawing parameters. The preview of the document layout with the specified

parameters is available in the preview pane.

Paper size

This group of parameters defines the drawing boundaries.

Format. Provides selection from the list of main formats defined by common standards, such as ISO,

ANSI, etc. If a standard format is selected then the Width and Height parameters are set

automatically. If the Custom format is selected, then the sizes can be defined manually. 

Width. Defines the format width size.

Height. Defines the format height size.

Paper

Orientation. This parameter defines the orientation of the drawing format. The orientation can be

Portrait or Landscape. 



System Customization

283

Scale. Defines the drawing scale. An arbitrary value of the scale can be defined, or otherwise be

selected from the list. It is recommended to use scale only when actually necessary. In most cases,

scaling is not necessary for the following reasons:

1. When outputting to a plotter or printer, the drawing size is not a concern.

2. Special tools are provided for scaling dimension notations of the whole drawing or a portion

thereof, as described below.

If it is still necessary to set a scale, it is better be done before starting creating the drawing. Changing

the scale setting on an existing drawing may require manual editing of some of its elements. This is

because scaling does not merely a proportional modification of all drawing element sizes.  The scale

in T-FLEX defines only the drawing lines locations, while, for instance, the size of dimension arrows

and text will stay unchanged. 

   

When working in the 2D view window, the View toolbar contains icons for quickly changing the

format, scale and orientation of the page.

Units. Defines the measurement units used by T-FLEX CAD. This parameter is selected from the list.

This parameter affects several issues, such as the following:

· Calculating dimension tolerances that is done differently in metric and inches systems;

· The menu settings when defining roughness parameters and GD&T symbols for surfaces;

· Output to a plotter;

· Exporting different formats;

· The way of converting dimension values, if a conversion system is assigned on the Dimensions

tab in groups Scale or Alternative scale to the Scale parameter.

Origin

The following parameters define the location of the origin of the drawing coordinate system.

Show Coordinate system. A page coordinate system is displayed on the drawing, it allows you to see

the start point of the page, which may be used for snapping. The option is available for both drawing

pages and workplanes. This, in turn, helps to control the workplane orientation in space when drawing

on it. The coordinate system cannot be drawn in the hidden construction lines mode, it cannot be 

printed out and it cannot be exported to external formats.

X. Defines the X coordinate of the drawing lower-left corner. 
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Y. Defines the Y coordinate of the drawing lower-left corner.

X2. Width of the drawing. The value is set automatically when format is selected from the list. Can be

defined manually if format is Custom.

Y2. Height of the drawing. The value is set automatically when format is selected from the list. Can be

defined manually if format is Custom.

The coordinate values are defined in the same units as used for creating the drawing. These are

defined under the Units item.

When defining document parameters, one can use variables that will be stored in the drawing

file. To do so, enter a variable name instead of a particular parameter value, whether numerical

or string. The variable name must be entered in {braces}. If it is a string variable, its name must

begin with “$” character. Pressing <F8> while in the intended input box allows selecting the

variable from the list of already created ones. The variable values can be modified using the

variable editor.

Projection View

Expand projection boundaries. This is the distance between boundaries of a projection and its

graphic lines.

Distance between the view and its designation. The view designation is placed by default at the

specified distance from the view.

1 - Offset specified in document parameters (non-scalable)

2 - Offset specified in view designation's parameters (scaled depending on a view's scale)

Moreover, the Paper tab contains following sub-tab:

· Zones
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Zones. Document Parameters

The Zones tab is used for defining parameters of dividing a drawing page into zones. Different

standard formats have different default parameters of dividing. Zones designations can be displayed

in 2D windows, but they're non-printable. The system can automatically detect a zone, where a view

designation is placed and add a number of zone to such designation. Also, it is possible to fill the

Zone tab of the BoM automatically, depending on the zone of the corresponding position balloon.

Zones

Detect Zones for Bills of Materials

This parameter allows automatic filling of the Zone column of the standard GOST BoM after placing

positions on an assembly drawing. Moreover, the value of this parameter affect the zones numbering

order. Following options are available in the drop-down list:

· No

The Zone column of the BoM is not filled, the zones numbering on the current page starts

anew.

· Numbering within One Page

The Zone column of the BoM is filled automatically, the zones numbering on the current page

starts anew.

· Consecutive Horizontal Numbering

The Zone column of the BoM is filled automatically, the horizontal zones numbering on the

current page continues numbering of previous pages, if previous pages have the same option

applied.

The method of numbering is shown in pictures below on example of two A0 format pages, where rest

of the Zones tab parameters are set to defaults.
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Page 1 Page 2

Numbering within One Page

Page 1 Page 2

Consecutive Horizontal Numbering

Visibility

The visibility of zones in the drawing window. Following options are available in the drop-down list:

· No 

Zones are not displayed.

· Yes

Zones are displayed regardless of the value of the Detect Zones for Bills of Materials

parameter, but numbering order depends on it.

· Visible when zones for bill of materials are turned on

Zones are displayed, if value of the Detect Zones for Bills of Materials parameter is not set

No. Numbering order also depends on it.

Show first symbol

Specifies, which of the zone-defining symbols, (the one of the X or Y axis), will come first in its

marking.
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Draw last

If this checkbox is enabled, then zones designations overlap the drawing elements; otherwise zones

designations get overlapped by drawing elements.

Color

The color of the zone border lines. The color selection is performed as described in the Color section.

Number

The number of zone columns (X) and rows (Y).

Direction

The zones numbering direction Horizontally (From Left to Right or From Right to Left) and Vertically

(From Bottom to Top or From Top to Bottom).

First char

The starting character for numbering columns (X) and rows (Y).

To keep in mind: the Document Parameters command settings affect only one page. Therefore,

for drawings spanning over multiple pages, the division into zones should be defined separately

for each page, taking into account the consecutive horizontal numbering (by X axis). 

Offset

The X and Y offsets of the area being divided into zones in relations to the Base Point, as well as

position of such point (Bottom Left or Bottom Right)

Step

Defines the X and Y dimensions of a single zone.

Font. Document Parameters

This tab defines font parameters for all standard detailing elements except those defined within the

detailing elements' parameters. These detailing elements are texts, tables, dimensions, roughness's,

leader notes, view designations and GD&T symbols. If value of a parameter in the Font tab of

detailing element's parameters is displayed in square brackets, then such value is defined by

document parameters; if value is displayed without square brackets, then it's defined by parameters of

a particular element.

Name. Defines name and type of the default font that will be used on text objects creation. T-FLEX

CAD supports two types of fonts: TrueType fonts, that are standard for Windows, and vector fonts in

SHX format. The TrueType and SHX fonts are distinguished in the font menu by the respective icons

before the names.
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Size. Defines the vertical size of the font by capital letters, as, for instance, the height of the character

“A”. Any font size is allowed, except 0.

The size of detailing elements' font can be quickly changed using the View toolbar.

Line Spacing. This is the distance between two neighboring lines of a multi-line text. Line interval is

set in relative units. To calculate the absolute value of the line interval, multiply this parameter by the

font height.

Character Spacing. Defines the additional distance between two neighboring characters in a string.

This parameter value is also relative. To calculate the absolute value of the additional interval,

multiply this parameter by the font height.

Stretch. Defines the scale factor for the width of the font symbol. It is possible to specify any value for

this factor except 0.

Style (TrueType). Defines the font style. This is a standard parameter of fonts and assumes the values

supported by Windows, namely normal, semi-bold, italic, semi-bold italic.

Index scale. Defines the scale factor for calculating the size of the subscript and superscript fonts from

the normal font size. Subscripts and superscripts are used, for example, for dimension tolerances and

other indexes.

Oblique Angle (SHX). Defines the font tilt angle. Any angle value is allowed, except 0, 180, 360, etc.

The normal (upright) font has the tilt angle value of 90 degrees.

Line Width. This parameter defines the thickness of the character contour lines. 

Fill. If set, then the characters are filled with color when applicable. Otherwise, they are drawn by

contours only. 

The Oblique Angle, Line width and Fill parameters affect only vector fonts of the SHX format. 

Dimensions. Document Parameters

Linear Dimensions 

Units. Defines the linear dimension value representation (digit separator, spacing, inches symbol).

Following representations are available:
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Minimum digits. Sometimes, a certain number of decimal digits are required to be displayed on a

dimension, including trailing zeros. This can be insured with the Minimum digits setting. For example,

setting the value “3”, then the dimension value 28.5 will be shown on the drawing as 28.500.

Accuracy. Defines rounding accuracy of the linear dimension values. For example, the accuracy "0.01"

means the dimension values will be rounded to the second decimal digit. The "0" accuracy means the

dimension values will not be rounded.

Scale

Scale. Defines the way of converting dimension values of the linear dimensions. The following

conversion systems can be selected from the list: 

· No. No dimension conversion is done.

· Inch/Metric. In this case, conversion of the dimension values will be done per the parameter

Units on the General tab. If the inches system is set, then the linear dimension values will be

converted to millimeters, that is, multiplied by the scale factor of 25.4. If the metric system is

set, then the dimension values will be converted into inches, that is, multiplied by the scale

factor of 1/25.4. Thus, one can work with a drawing in metric system while applying

dimensions with values in inches, and vise versa. 

· Custom. With this setting, an arbitrary dimension value conversion factor can be specified.

Scale factor. If Scale is Custom, you can type your own scale factor for converting dimension values of

linear dimensions. All dimension values will be multiplied by this scale factor. 

Apply scale to projections. This parameter is used in the 3D version of the system only. It has an effect

on dimension creation within 2D projections in the case when a dimension scale is defined in the

command Set Document Parameters for the 2D page that contains the projection. When the flag is

set, then the specified scale is applied to the dimensions on a 2D projection with a scale; if the flag is

cleared, the scale is ignored.

Dimensions

Standard. Defines the appearance of dimensions on a drawing. A dimension standard can be selected

from the list. Three standards are provided in the list – ANSI, BS-308 and DIN/ISO.

BS-308 stands for ANSI standard for architects or British standard. Upon changing the dimension

standard, the dimensions automatically redraw to comply with the new standard.

Alignment spacing. Specifies spacing when aligning dimensions with offset.

Tolerance grade. Defines the tolerance grade for dimensions on a drawing. If the accuracy parameter

of the dimension is set equal to this parameter then the tolerance string and limits will not be

displayed as part of the dimension.

Angular Dimensions. This group contains the following parameters:

Units. Defines the angular dimension value representation.

Minimum digits. Defines the minimum number of decimal digits for angular dimensions.

Accuracy. Defines rounding accuracy of the angular dimension values.

Spacing in tolerance text. When this option is enabled, tolerances of dimensions are separated with

spaces for easy reading.
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Alternative scale

Scale defines the way of converting dimension values of the alternative dimensions. The following

conversion systems can be selected from the list:

· No. No alternative dimension conversion is done.

· Inch/Metric. In this case, conversion of the dimension values will be done per the parameter

Units on the General tab. If the inches system is set, then the alternative dimension values will

be converted to millimeters, that is, multiplied by the scale factor of 25.4. If the metric system

is set, then the alternative dimension values will be converted into inches, that is, multiplied by

the scale factor of 1/25.4. This allows setting both metric and inches value using dual

dimensions.

· Custom. With this setting, an arbitrary scale factor can be specified for converting an

alternative dimension value. 

Scale factor. Reflects the scale factor for converting alternative dimension values per the alternative

scale parameter. 

Moreover, the Dimensions tab contains following sub-tab:

· Alternative Dimensions

Alternative Dimensions. Document Parameters

Parameters defined on this tab will only affect those alternative dimensions whose parameters are

marked Set as default.

Dual Dimensions

The group of parameters Dual Dimensions defines the presence and location of alternative

dimensions on the drawing.

Add Alternative Dimension. This attribute sets the presence of alternative dimensions on the drawing.

If alternative dimensions are not required, clear the check n the attribute field.

Location. Defines the location of alternative dimensions on the drawing with respect to the primary

dimension value.

According to the selection choice, the alternative dimension value may be displayed After, Before,

Under or Above the primary dimension value on the drawing.
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Linear Dimensions

This group includes:

Accuracy. Defines rounding accuracy of the alternative linear dimension values.

Units. Defines the alternative linear dimension value representation.

Minimum digits. Defines the minimum number of decimal digits.

Separator

Parameters of the given group define the appearance of separating signs that separate the value of

the alternative dimension from the primary one. In the drop-down list the following variants are

available:

· None. The alternative dimension value will be displayed without separators.

· []. The alternative dimension value will be displayed in brackets.

· {}. The alternative dimension value will be displayed in braces.

· ( ). The value of the alternative dimension will be shown in circular brackets.

· User. The value of the alternative dimension will be displayed with the help of arbitrary

separators that are specified by the user in the identically-named input fields of the given

group.

Before is used when Separator parameter is set to User. Allows to type any symbol, e.g. *.

After is used when Separator parameter is set to User. Allows to type any symbol, e.g. *.

Text

Before and After. Defines the text strings to precede and follow the value string of an alternative

dimension. The strings can be entered explicitly or substituted by numerical or string variables. The
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variables for the strings must be entered by their names in braces. For example, suppose, a variable

“A” is introduced in the drawing, and we want its value to be displayed as part of an alternative

dimension value string. Enter the variable name in braces, {A}, as one of the strings, Before” or After. If

this is a string variable with the value being a character string, then the first character in its name must

be the dollar sign, for example, {$Text}.

Lines. Document Parameters

Lines:

Thick lines. Defines the thickness of the main solid graphic line (CONTINUOUS).

Other lines. Defines the thickness of all the rest of graphic lines and detailing elements (the lines of

tolerances, roughness's, leader notes and dimensions).

Construction drawn last. If set, the construction elements will be drawn last upon redraws (see the

diagram on the left). Otherwise, they are drawn first (right) and may be hidden by other system

elements (fills, graphic lines, etc.).

Remove hidden lines. If set, the hidden lines will be removed from display. These are the lines behind

the fragments with hidden line removal contours. The lines will be removed according to the fragment

priorities.
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Draw auxiliary lines dashed. By default, auxiliary lines are displayed using the line type set in their

parameters. Enabling this checkbox makes all auxiliary lines displayed as dashed regardless of the line

type set in their parameters.

  

Auxiliary line and dimension, when the Draw auxiliary lines dashed option is disabled (left) and enabled

(right).

Line style:

Scale factor for dashed lines. Defines the scale factor for dashed lines with respect to the dash size

described in the file of line types (TCAD.LIN). Does not affect the display of solid lines. The file format

is the same as the format of the AutoCAD line description file.

Arrow (end) size. Defines the size of arrows (ends, tips)of the dimension leader and witness lines and

graphic lines. Any desired size can be set by the user. 

Line thickness representation. This parameter defines the graphic line appearance on the screen. The

parameter can be selected from the list:

· Not more than three pixels. All graphic lines will be displayed no more than three pixels thick.

This parameter is relevant to the lines whose line thickness is greater than three pixels.

· Actual thickness. All graphic lines will be displayed as thick as actually are. The actual line

thickness is defined by the “Line thickness” item on this tab. 

· Always three pixels. All primary graphic lines will be drawn with a thickness of 3 pixels, and all

thin graphic lines – with a thickness of 1 pixel regardless of the scale of the drawing.

· One pixel. All graphic lines will be displayed one pixel thick.

The button for quick change of the line thickness representation is available on the View Toolbar  in

the 2D window. 
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View (Page). Document Parameters

The View group of parameters defines the modes of displaying linear and angular values and the

means of searching and selecting elements. These parameters do not modify the drawing graphic

elements. Rather, these are system settings specific to the particular drawing.

Selection

Element selection. Defines element selection modes while in drawing and editing commands. Select

one of the two modes:

· All. When creating and editing elements, all existing elements will be allowed for selection.

· Visible only. When creating and editing elements, only the visible elements will be allowed for

selection. The element visibility  is determined   based  on element levels and visibility

intervals defined in the command Set Levels (Customize > Levels…), as well as layer

configurations defined in the command Configure Layers (Customize > Layers…).

Linear

Units. Defines the way of displaying linear coordinates in the information fields of the application, as,

for example, X and Y coordinates in the status bar. The parameter does not affect the display of

dimensions and other graphic elements.

  

Accuracy. Defines the accuracy of displaying linear coordinates in the information fields of the

application, as, for example, X and Y coordinates in the status bar. The parameter does not affect the

display of dimensions and other graphic elements.

Angular

Units. Serves the same purpose as Linear Units, except for angular coordinates. 
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Accuracy. Serves the same purpose as Linear Accuracy, except for angular coordinates.

Construction Lines

Search. Defines the mode of selecting straight construction lines. One of two modes can be selected,

as follows:

· In limits. The lines will be selected according  to their length defined by the Length parameter

on this tab. If construction lines are displayed as finite line segments, then the nearest segment

will be selected.

· Infinite. The lines will be selected as infinite lines, regardless of the Length parameter value on

this tab and the way of displaying the lines.

Length. Defines the way of displaying the straight construction lines. Construction lines are displayed

as either infinite lines, or finite segments bounded by their end nodes. To refresh the lines display per

the new settings, use the command Edit Construction. One can set one of the following construction

line display modes:

· Default truncated. Affects the construction lines whose Length property is Set as default. Such

lines will be displayed as segments bounded by two end nodes.

· Default infinite. Affects the construction lines whose Length property is Set as default. Such

lines will be displayed as infinite lines.

· All truncated. With this value, all construction lines will be displayed as segments bounded by

two end nodes. 

· All infinite. With this value, all construction lines will be displayed as infinite lines.

Extents. Defines extension of construction line overhangs beyond the end nodes when displaying as a

finite segment.

Text

“Transparent” text editing allows to edit paragraph text right after clicking the element with left

mouse button. If the attribute is not set, then only the variables inserted in the paragraph text can be

edited in this way.
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Fragments. Document Parameters

Dynamic Fragment Editing. When this parameter is set, dynamic regeneration of the model and

redrawing of the image occur upon inserting and editing 2D fragments. This makes the work with

fragments clearer. However, this is not suitable for drawings with large number of elements since it

slows down the work.

Insert Fragment on new Page creation. In the provided input box, enter the path to the fragment to

be automatically inserted upon new page creation. If the fragment is a multi-page document, then the

first page will be inserted. This parameter is defined automatically when creating BOM.

Symbols. Document Parameters

Font. This parameter defines the font for special symbols used in T-FLEX CAD.

Code for Degree. Defines the symbol to substitute instead of the "%%d” key in text strings on the

drawing. Default is the degree symbol code, which is 119.

Code for Diameter. Defines the symbol to substitute instead of the "%%c” key in text strings on the

drawing. Default is the diameter symbol code, which is 066.

Code for Plus/minus. Defines the symbol to substitute instead of the "%%p” key in text strings on the

drawing. Default is the plus/minus symbol code, which is 116.

When changing the font, a new symbol code can be defined manually by typing the appropriate value

or by selecting a symbol from the menu “Insert Symbol” after pressing the button [Select]. When

selecting a symbol from the table, the symbol code is entered automatically.
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Detailing elements. Document Parameters

Leader Notes

Standard. Defines the appearance of leader notes on a drawing. A leader note standard can be

selected from the list. Two standards are provided – ANSI and BS/DIN/ISO.

Upon changing the leader note standard, the leader notes automatically redraw to comply with the

new standard.

Text

Fast text mode (draw as rectangles). If enabled, all text are displayed as rectangles of the text size.

Meanwhile, the text itself will not be displayed. This setting helps speed up display of large drawings. 

2D Section View

Automatic designation of letters. Automatic assignment of letters sequence for detail, section and

auxiliary views.

· Do not designate. You can assign the same letters for different section views.

· For page only. Section views on the page will always have different letters.

· For the entire document. Letters that are used for section views will differ in the entire

document.

Reverse order of detailed views designations. When this checkbox is enabled, designations of

detailed views are assigned in reverse order (Z - A).

Add scale automatically. When this checkbox is enabled, scale will be drawn on the projections

automatically, if scale was changed.

Add sign of rotation angle automatically. When this checkbox is enabled, sign of rotation angle will

be drawn on the projections automatically, if rotation angle was changed.
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Colors. Document Parameters

Defines the color palette of the drawing and allows saving it with the drawing. These settings override

the system settings of the respective parameters done by the command Customize > Options >

Colors.

One Color

One color group defines color in the case of using one color throughout the drawing.

One color. Sets the drawing mode of using one color for all drawing elements. This color overrides

element own settings.

Color. Defines the color for all drawing elements when one color mode is set. The color can be

selected from the menu of colors. 

Colors

Colors group allows to define a color scheme that shall be stored together with the particular

drawing.

Set colors. Setting this attribute allows to define colors for the following drawing elements:

Construction Line color. Defines the color of construction lines.

Outline color. Defines the color of the border of the drawing area (also called “format”).

Grid color. Defines the color of the grid display.

Node color. Defines the color of nodes.

The colors can be selected from the color menus for each item separately.

Note that One color setting overrides the individual color settings for the elements with the

background color, construction lines and nodes.

Background color. Defines the color of the current drawing background.

Elements with background color. Defines the color of the T-FLEX CAD elements whose color is the

same as the current drawing window background. Important to keep in mind that each color in the

system has an Id. Altogether there are 256 standard colors (Ids 0-255). It is possible that two colors

visual perception is same while the Ids differ. For example, suppose, the background color is set to

black with Id equal 0, while the element color is gray 100%, that is also black, however, with Id 226. In

this case, the element will not be identified as an element with the background color.

Background

Background color:

· Everywhere. Background color is displayed inside and outside drawing border.



System Customization

299

· In Page Limits. Upon turning on this parameter, only the region inside the drawing border will

be painted with the background color of the drawing.

· In Page Limits with shadow activates the mode of displaying shades around the drawing

border.

Grid. Document Parameters

Sets parameters and visibility of grid points.

Grid snap. Defines the mode of binding elements to the grid.

Visibility (Yes\No\Visible when grid snap is enabled). Sets the display mode of the grid points. The

grid color is set in the system settings (the System Settings command).

Draw last. Defines the drawing order of grid points on the screen.

Grid point size. Determines the size of the point when displaying the grid in the drawing.

X step. Sets the grid step value along the X axis in the drawing.

Y step. Sets the grid step value along the Y axis in the drawing.

X offset. Sets the grid offset along the X axis in the drawing relative to the point (0,0).

Y Offset. Specifies the offset of the grid along the Y axis in the drawing relative to the point (0,0).

Default Parameters

When creating 2D and 3D elements, some of element's parameters are not mandatory to be defined

by the user (line type; name, size and style of a text's font, extrusion's length, primitives' dimensions

etc.). Such parameters are initially applied with default values. Then the user can confirm the element's

creation with default parameters or change parameters' values for the current element if necessary.

Full set of parameters applied by default to all new elements of a particular type can be changed

using:

· element's parameters dialog;

· command's parameters window.

Also, some of the general (layer, level, color, priority, material) default parameters can be changed

using:

· Defaults command;

· ribbon or system toolbar.
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Changing default parameters using element's parameters dialog

The Set as default checkbox is available in the left bottom part of the  parameters dialog of any

element. Enabling this checkbox applies parameters of a selected element as default parameters for

any of the newly created elements of the same type.

Parameters dialog can be called either for an existing element, using its contextual menu, or for an

element, which is currently being created, using the automenu option available in the most element's

creation commands:

<P> Set entity Parameters

Usually, the dialog invoked by this option is the same as the dialog invoked from contextual

menus of existing elements. Therefore, specified parameters are only applied to the first

element created after clicking OK in the dialog. In order to apply specified parameters as

defaults, you need to enable the Set as default checkbox as described above. However, in some

commands (e.g.: graphic line, text) the parameters dialog invoked from the automenu doesn't

contain the Set as default checkbox. In such cases specified parameters are automatically

applied as defaults for all further created elements of the same type.
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Changing default parameters using command's parameters window

The header of command's parameters window for some command contains the Save as Default

Parameters button. Clicking it applies parameters currently set in the parameters window as defaults

for all further created elements of the same type.

The Defaults command

For convenience of drawing creation, common parameters can be defined for 2D and 3D drawing

elements, such as color, layer, level and priority, and, additionally for 3D operations, the material. The

selected parameters are assigned to the newly created elements by default, but only for those whose

types were selected from the list. 

The following command is used for setting the default parameters: Set Default Parameters:

Icon Ribbon

Edit> Document > Defaults

Keyboard Textual Menu

<PD> Customize > Defaults

The command brings up the Default Parameters dialog box.

The right side of the dialog box contains the list of all element types – construction, graphic, detailing

elements, etc. Enable checkboxes for elements, whose parameters you need to change. To enable all

checkboxes at once, use the [+] button. Vise versa, to disable all checkboxes, click the [-] button. The

[+/-] button inverts the selection. 

the left side of the dialog box contains the list of available parameters. To change a parameter,

enable its checkbox. Otherwise, this parameter will not be accessible for editing. Some parameters can

not be applied to some types of elements. For example, a Material can be defined only for 3D

operations. Material can be ether selected from the drop-down list or defined via variables (type a

name of variable into the Expression input box).
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Should different default parameters be assigned to different elements, call the Default Parameters

dialog box over again.

For example, suppose, we need to set the default color blue for graphic lines. Besides, let the newly

created detailing elements be moved on a new special layer. To do so, call the Defaults command

twice. On the first time, enable only the Graphic Lines checkbox in the right list, enable the Color

checkbox in the left list and define the desired setting which is the blue color. Then complete the first

round by pressing OK. On the second time, enable checkboxes for the detailing elements – GD&T

Formlimit Symbols, Roughness Symbols, Leader Notes, Dimensions, and disable the checkbox on the

Graphic Lines element. Then enable the Layer checkbox and set the value as desired. And don't forget

to disable the Color checkbox. To complete the second round, press OK. Now, when creating graphic

lines, call the Graphic Line Parameters dialog box by typing <P> key and see that the Color

parameter is set to blue color. Similarly, watch the new default parameters of the detailing elements.

Changing default parameters using ribbon or system toolbar

While creating elements, some parameters (layer, level, color, priority, material, coating) can be

modified using the ribbon or the system toolbar. The Style group containing the aforementioned

parameters is located in the left side of many of the ribbon tabs. If parameters on the ribbon or the

system toolbar are modified while some of the 2D elements creation commands is active, then these

parameters are set as default for the current element type. In the case when no command is active,

then after modifying a parameter the Default Parameters dialog box appears (see above), where you

should define what types of elements should use the modified parameters as defaults. If parameters

on the ribbon or the system toolbar are modified while some of the 3D elements creation commands

is active, defaults remain unchanged, while the modified parameters are only applied to the element

which is being created at the current moment.

See also:

· Defining Element Parameters

· Copying Parameters of 2D Elements

· Common Parameters of 3D Elements

Main window design styles

T-FLEX CAD has a capability to modify the design style of the main window of the system. In the

context menu of the main window (textual interface) and in  drop-down menu the Theme

submenu is available which allows us to select the desired style of design.
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General Elements Management

Each element of the model in the T-FLEX CAD system has a set of parameters that can be customized.

For the convenience of working with model elements, you can use filters, search, selector.

Topics in this section:

· Defining Element Parameters

· Copying Parameters of 2D Elements

· Layer, Level, Priority, Name, Color

· Object Snaps and Element Selection

· Groups of Elements

· Search Elements

· Purge

Defining Element Parameters

General principles for setting element parameters

In the commands for creating and editing items in the menu for setting parameter values, there

are various options for values.

· The parameter value is set as a constant. For example, in the text parameters, the angle is

set to 0.

· The parameter value is replaced by a string From document. This means that the

parameter value will be substituted from the corresponding parameter in the Document

parameters command. For example, the Style > Standard parameter in the dimension

parameters menu will be substituted from the Dimensions > Standard dimensions of the

Document parameters command. Using the default parameters is very convenient for

quickly changing elements of the entire drawing as a whole. For example, if you use the

default parameters for dimensions, you can change the parameters on the Dimensions tab

of the Document parameters command to completely change the way dimensions are

displayed and, accordingly, the entire drawing. And you can change the thickness of all the

main lines in the drawing by changing the Line thickness > Main tab in the Document

parameters command.

· The values of most numerical parameters in the parameter dialogs for various elements

can be set using variables and expressions. In this case, the parameter value will be

determined by the value of the variable or the value of the expression. In this case, you can

change the value of the corresponding element parameter by changing the values of

variables. Using this mechanism, you can change any parameters of T-FLEX CAD elements:

the size of text strings, the angle of characters, the size of arrows and image lines, and so

on. You can use variables to define drawing parameters that are set in the Document

parameters command: scale, paper size, font size, and so on. You can use variables to

define the system visibility levels of elements that are set in the Levels command.

Specifics of Setting Parameters Using Variables

· When specifying numeric parameters using a variable, you must enter the variable name

or expression without any auxiliary characters. For example: A or A + B

· When specifying string parameters using variables, you must enter the variable name or

an expression enclosed in curly braces. For example: {$ NAME} or {A + B}
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· When specifying string parameters in curly braces, you can enter both real variables and

text variables.

If, when setting a parameter using variables, you specified the name of a new variable, then after

exiting the menu you need to set the value of the variable being created.

Defining parameters when creating an element

The most convenient way of defining element's parameters during its creation is using  the

parameters tool window. Some of element's parameters are mandatory to be defined by the user,

others  are initially applied with default values. Then the user can confirm the element's creation with

default parameters or change parameters' values for the current element if necessary. 

The detailed information on Default Parameters is available in the corresponding section.

In most elements' creation commands you can invoke  element's parameters dialog using the

automenu option:

<P> Set entity parameters

Usually, the dialog invoked by this option is the same as the dialog invoked from contextual

menus of existing elements (see below). Therefore, specified parameters are only applied to the

first element created after clicking OK in the dialog. In order to apply specified parameters as

defaults, you need to enable the Set as default checkbox. However, in some commands (e.g.:

graphic line, text) the parameters dialog invoked from the automenu doesn't contain the Set as

default checkbox. In such cases specified parameters are automatically applied as defaults for

all further created elements of the same type.

Some of the parameters may also be defined using the ribbon or the system toolbar.

Parameters window of some commands contain the Show Dialog for Each Element option. If it's

enabled, the parameters dialog is invoked automatically for each element upon its creation.

Changing parameters of an existing element

Parameters of an already existing element can be changed using:

·  parameters tool window without transparent editing;

·  parameters tool window with transparent editing;

·  Edit and  Recreate commands;

·  elements editing commands

·  element's parameters dialog, invoked from element's contextual menu or from the dynamic

toolbar.

The detailed information on 3D elements' parameters dialogs is available in the Common

Parameters of 3D Elements section.

The detailed information on 2D elements' parameters dialogs is available in sections describing

each particular type of 2D elements.

Some parameters may also be changed using the ribbon or the system toolbar.
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Changing parameters for different types of elements

The parameters window is used to simultaneously change the parameters of elements in the

command standby mode. In contrast to working in editing commands for various elements, you

can simultaneously change the parameters of elements of different types.

When the command is in standby mode, the Parameters window displays a dialog for changing

parameters of selected items. By default, the dialog is inactive. To activate the dialog, just go to the

parameters window and expand the Parameters tab in it. After that, any selection of items will

display their parameters in the parameters window. To open the dialog automatically, you can call

the Parameters command from the context menu after selecting items.

You can close dialog's active mode by collapsing the Parameters tab.

It should be noted that when one element is selected, calling the Parameters command from

the context menu will open the parameters dialog in a separate window for this element.

The dialog for changing the parameters of selected elements, displayed in the parameters window,

consists of two parts: the main one - Parameters and the auxiliary one - Parameter Sets.

The main part contains a table of parameters of editable elements. By default, all selected

elements are considered editable. The upper Selected field shows the total number of selected

items. You can restrict the list of editable elements to elements of the same type by selecting it in

the drop-down list of this field. In this case, the property table will contain only the properties of

elements of the selected type. The changes you make will also not affect the entire group of

selected elements, but only the elements of the specified type.

By default, the table shows all parameters of the elements that are being edited. You can use the

Only Common checkbox to restrict table contents to their Common parameters.

To change the parameters of elements, just mark the desired parameters in the table, set the

required values in the field on the right, and click  or  button at the top of the window.
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When you select the button  Finish input, the changes made are applied to the selected

elements. Working with the selected elements stops, and the selection of elements is canceled.

The  Apply changes button also allows you to apply your changes. However, in this case,

working with the selected elements does not stop. This button is convenient to use when you

need to set different parameters for different groups of elements from the selected set.

The  Exit command button allows you to cancel your changes and finish working with the

selected set of elements. You can also cancel your changes and work with the current set of

elements by simply clicking  in the drawing.

An additional button From Element allows you to select an item on the screen whose parameter

values will be used as the current values of the parameters to edit. To do this, you must first

specify the parameters in the table whose values you want to take from the object. Then click 

and use to specify the desired element on the screen. The values of the marked parameters will be

set according to the values of the parameters of the specified object.

The auxiliary part of the parameters editing dialog - Parameter Sets - allows you to save the

current set of parameters with a specific name for later use.

To save a combination of parameters as a Parameter Set, click Save. A dialog box appears on the

screen where you can specify the name of the new set. All existing named parameter sets are

displayed in the upper field of the dialog. By selecting  one of the sets, you can delete it using

the Delete button.

In the lower field of the dialog, enter a name for the saved set. After entering the name, click Save.

The dialog window will close and the saved set will appear in the drop-down list of sets. The

Cancel button closes the dialog box without saving the new set.

To load a saved set, just select it from the drop-down list of sets.
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See also:

· Copiyng Parameters of 2D Elements

· Default Parameters

· Common Parameters of 3D Elements

· Parameters Window

· Editing Techniques

· Editing and Recreating Elements

· Element Editing Commands

Copying Parameters of 2D Elements

You can apply parameters of an existing 2D element to another existing or new 2D element of the

same type. There are two ways of doing it:

· via the clipboard;

· via the automenu.

Copying parameters via the clipboard

The Copy properties command is available in the context menu for any 2D element. When this

command is called, the parameters of the selected element are copied to the internal clipboard. 
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After that, the Paste properties command will be available in the context menu when selecting any

other 2D elements. When it is called, the parameters copied to the buffer are applied to the

selected elements.

Copying parameters via the automenu

Some of the elements' creation and editing commands contain the following automenu option:

<Alt>+<P> Copy Properties from Existing Element

Upon clicking this option, you need to select  an existing element of the same type as element

being created/edited. In result, parameters of a selected element will be applied to the element being

created/edited. When using this option within element's creation command, copied parameters are

applied to all further created elements until you exit the command. Exiting the command and

launching it again restores default parameters.

See also:

· Defining Element Parameters

· Default Parameters
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· Common Parameters of 3D Elements

Layer, Level, Priority, Name, Color

Each element of the T-FLEX CAD system has its own set of parameters that you can set and change.

However, the color, level, layer, and priority parameters are present in each parameter set. 

The name field is present in the list of parameters for all 3D elements, but for 2D elements, the name

is an optional attribute.

Topics in this section:

· Layers

· Levels

· Priorities

· Names

· Colors

Layers

Layer parameters can be created, deleted and modified using the command Configure Layers:

Icon Ribbon

Edit > Document > Layers

3D Model > Style > Layers

Draw > Style > Layers

Assembly > Style > Layers

Sheet Metal > Style > Layers

Surfaces > Style > Layers

Weld > Style > Layers

Primitives > Style > Layers

Workplane > Style > Layers

Support Geometry > Style > Layers

Keyboard Textual Menu

<QL>,

<Shift>+<F5>
Customize > Layers

Layer is a parameter of each drawing element that determines its belonging to a group of drawing

elements. The layer is given by the name. Layers allow you to control the properties of item groups. It

is possible to draw them in one color, make them invisible or inaccessible for selection.

If a layer name is not specified, the element is assigned a system layer, also called the default layer.

The Layers command allows you to manage the layers of the drawing.

After calling the command, a dialog box appears on the screen:
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The list can be sorted according to various parameters of layers. Clicking an icon can modify layer

parameter without leaving the current command. The list has item «New» which allows you to create a

new layer without exiting the command and to make it active. In the window of the given dialog box

the list of the layers existing in the given document and their parameters are shown. Under this list

there are fields for assigning parameters of the layer and buttons for performing different actions with

the fields. 

The button New creates the new layer in the document. After pressing this button the system asks to

give a name to the created layer. 

The button Delete removes unused layer (it becomes available only upon selecting from the list the

layer marked with the sign ?). 

The button Rename allows assigning the new name for the layer selected from the layers list.

The Information button allows to display the list of objects located on the selected layer.

When you call a command from the system toolbar or from the Style group of the ribbon, it will not

open a dialog box, but a menu.

The functionality is completely the same as the dialog box.

The following attributes can be set for the layer selected in the list:

· Hidden;

· Frozen;

· Screen only;

· Hidden when model is used as a Fragment;

· Visible only when model is used as a Fragment;
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· Monochrome;

· Same line thickness;

· Not used;

· Group

In the Layers command, you can create a new layer, rename or delete an existing one, sort the list of

layers. To do this, left-click on the name of the Name column. The specified order of layers is taken

into account in all dialogs of the system that allow you to select a layer.

To set the parameters of a layer, select a layer in the list and set the necessary flag for it in the lower

part of the window or click  in the corresponding cell of the table. You can change the parameters

of several layers at the same time - multiple selection is carried out using standard keyboard shortcuts.

· Elements of the hidden layer are not displayed on the screen. You can control the visibility of

a layer using a variable. The variable can have two values: 0 - visible layer and 1 - invisible

layer.

Variable values different from 0 and 1, are processed by the system as follows: negative sign and

fractional part are dropped, and resulting number is matched with 0. If matching, layer will be

visible, otherwise – invisible.

· Drawing elements located on a frozen layer are not available for selection.

· If you want all elements belonging to a layer to be drawn in the drawing with the

monochrome, set the checkbox and select the required color.

· It is possible to control the visibility of elements belonging to the same layer when inserting a

document as a fragment into an assembly drawing (options Visible/Hidden when model is

used as a Fragment).

· Elements belonging to the screen layer are not printed.

· The Line thickness checkbox allows you to set the value of the thickness of the image lines

belonging to the current layer.

· The Not used parameter shows whether the objects are assigned this layer.

· Group. Layers can be grouped together.

The Delete button deletes the layer. The function of removing a layer can be performed both for

unused layers (marked with a ?), and for used ones. In the case of deleting used layers, the user is

offered two options for behavior - either delete the layer along with all the elements placed on it, or

transfer these elements to another layer.

The Information button calls a window with a list of all the elements lying on the selected layer.
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Using layers, just like using levels, you can control the visibility of construction elements and other

drawing elements. To do this, place them on a layer, and then in the Layers command make it

invisible.

A simplified version of the command is called when you click  in the layer field on the system

toolbar. In the window that appears, you can change the parameters of any layer by clicking  in the

appropriate cell. The last line in the list allows you to create a new layer.
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Levels

Command call:

Icon Ribbon

Edit > Document > levels

3D Model > Style > Levels

Draw > Style > Levels

Assembly > Style > Levels

Sheet Metal > Style > Levels

Surfaces > Style > Levels

Weld > Style > Levels

Primitives > Style > Levels

Workplane > Style > Levels

Keyboard Textual Menu

<SH> Customize > Levels

The Levels command allows you to set the visibility levels of graphic items.

Each graphic element of the system has a level. Element level is an integer that determines the

visibility of the element when redrawing. You can set the level of an element in the range from -126 to

127. The level of any element can be set with a real variable in the menu for setting parameters of an

element. The visibility of each item depends on the spacing specified in the Levels command. You can

set the interval of visibility levels with two numbers (from -126 to 127) for all elements of the system.

The visibility of elements is determined as follows:

If the first number is less than or equal to the second, then only those elements are displayed whose

level value falls within this interval (including the boundaries of the interval).

If the first number is greater than the second, then only those elements are visible whose level values ??

do not fall within the specified interval (from the lowest value to the highest, excluding the borders).

If you want to remove construction lines from the drawing, set the visibility interval for them so that

the level of these elements does not fall into it. Suppose you have a value for the Level parameter for

each construction element equal to 0. This is common for most drawings.

Then, in order for the construction elements to disappear from the screen, set the following

parameters. 
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An interesting thing is the possibility of using a variable as a level value. This allows, depending on any

calculations or conditions, to display or hide image elements. This is mainly necessary for complex

parametric models.

Priorities

Priority

When creating assemblies, especially, in engineering industry, it is often necessary that one element be

drawn on top of others. This behavior is easy to realize using parametric fragments, hidden line

removal, and an additional special parameter of graphic elements – the priority. 

The fact is, the model elements are drawn on the screen or other graphical devices in a certain order.

This order normally corresponds with the element types and the order of element creation. However,

this order can be changed using priorities. 

A priority, just like a visibility level of an element, is an integer from -126 to 127, which can be

specified by a variable value or an expression. The order of drawing elements follows the rule:

elements with lower priority are drawn before elements with higher priority. Therefore, an element

with a high priority “obstructs” the elements drawn earlier. For fully benefiting from the hidden line

removal functionality, the system provides a special attribute of the hatch contour: “Use for hidden

line removal”. When this attribute is turned on, the area of the hatch is filled with the background

color. Therefore, using priorities and special hatches allows creating assemblies using overlays. 

An example of using hidden line removal could be any assembly of co-axial parts, created from

fragments. In this case, the fragment parts are created without hidden line removal required in the

assembly. Simply set their correct priorities when assembling. 
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Using this method helps significantly speed up the process of creating assembly models and

minimizes the necessity for editing elements when modifying the assembly model parameters.

Name

It is possible to set or change the name of a 2D element while editing it. The name is a unique

attribute of the element. If the specified name coincides with an already existing name, the system will

display the message: Invalid element name or such name already exists.

When creating 3D elements, the system assigns them names by default (see Names Customization for

3D Elements). If necessary, you can change the name in the element parameters window.

Element names are used for:

· search for elements (Find);

· selection from the list (option  <Z> (for 3D), <R> (for 2D));

· work with nodes derived from a 2D fragment. 

Color

Each element has a color. 

Color of a selected element can be changed:

· in the element's parameter dialog : 

· in the system toolbar;

· in the Style group of commands available in various tabs of the ribbon. 

Setting colors via the ribbon and system toolbar is available  in creation and editing commands as

well as in the command standby mode. 

It is impossible to define color of a particular face using the ribbon or the system toolbar. Use

the face parameters dialog instead.

Upon applying a new color to a body using the ribbon or the system toolbar, you need to 

 Regenerate the model for the changes to be displayed in the 3D scene.

Colors of bodies are not visible in the  Render view style, because this style uses material

visualization.

Colors of particular faces are visible in the  Shading view style only.

In any of the methods of changing a color listed above you can use either a colors drop-down list or a

color catalog button. Both controls are usually located next to each other.

Colors drop-down list

The list of colors can be invoked by clicking  a rectangular control representing a sample of a

selected color. A color can be selected in the list using  or by scrolling the selection via keyboard

arrows and pressing <Enter>.
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Following additional controls are available at the bottom of the list:

· 256 Colors checkbox

If it's enabled, the list contains extended set of 256 colors. If it's disabled, the list only contains

the basic set of 16 standard system colors.

Upon selecting a color in some of the dialog windows this checkbox may be replaced with the

drop-down list, where you can choose between 16 colors set, 256 colors set and shades of

gray.

· Other... button

Invokes the standard dialog for selecting a color on the spectrum.
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Colors catalog

Use the  Select color from catalog of colors button to open the dialog for selecting a color from a

catalog.
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There's the drop-down list at the top of the dialog, where you can select a Catalog.

RAL Classic and Standard colors catalog are installed with the system.

Each color catalog is stored in a separate file with the .acb extension. To edit a color catalog you can

use any text editor, or one of the editors of available for working with .acb file format. By default,

available catalogs of colors are located in  the system folder Program/ColorBooks. You can change

the path for searching color catalogs in System Options (Options > Folders > Folders > Colors

Catalog).
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The Standard colors catalog contains the same 256 colors that are available in the colors drop-down

list.

The RAL Classic catalog contains folders representing main colors. Each folder contains various shades

of the corresponding main color. The list of folders is displayed in the left side of the dialog, the list of

colors in the folder - in the right side.

Below the lists of folders and colors the dialog contains slots for 10 favorite colors, which user may

add using the  button in order to have faster direct access to them.

Colors and folders are selected using . A sample of a selected color is displayed at the bottom of

the dialog along with color's name and values of its RGB components. Values of components can be

typed in manually using the keyboard.

The Other... button invokes the standard dialog for selecting a color on the spectrum. It's the same as

the one invoked from the colors drop-down list.

See Also:

· Colors. System Options

Object Snaps and Element Selection

There are two modes for selecting objects in T-FLEX CAD:

· Standard mode, in which the selection of elements in commands occurs using the automenu

or the keyboard.

· Object snap mode, in which the selected elements are dynamically highlighted, which can be

snapped to in the creation and editing commands. This mode is set by default when the

program starts.

Call the command Object Snap:
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Icon Ribbon

Keyboard Textual Menu

<F2> Customize > Snap > Object Snap

Object snap on Object snap off

When the object snapp mode is on, the selection of highlighted elements is adjusted in the filter

toolbar.

The filling of the filter toolbar directly depends on the scenario for selecting elements. So, for

example, when working with a 2D scene, in the command standby mode, filters for selecting lines,

hatches, dimensions, etc. will be available. In turn, when working with a specific operation in a 3D

scene, a completely different set of filters will be available, designed for more accurate snapping

element of the operation to the object.

A variety of filter toolbar

The filter panel changes depending on the following scenarios:

· Selection of elements in a 3D scene in command standby mode.

· Selection of elements in a 2D scene or when drawing on the workplane in command standby

mode.

· Snap to elements in 3D operations.

· Snap to elements in 2D commands.
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The first two scenarios are similar in principle and are described below.

The third scenario is similar to the first two and differs in the presence of a set of filters for selecting

the type of geometry (advanced filters), which allow you to customize the selection of elements for

snapping in more detail when working with 3D operations. So, for example, you can snap a 3D node

to the middle of an edge or select in detail the type of axis along which the rotation will be created.

The fourth scenario contains a set of snaps that are in effect when building a drawing. So, for example,

for a graphic line, you can enable the Construction lines intersection snapping, in which the

intersection of construction lines will be dynamically highlighted.

Selecting elements in a 3D/2D scene or when drawing on a workplane in command standby mode

For the first two scenarios, the filter panel consists of the following components:

1. Filters for selecting the type of elements.

2. Selector (way to select items).

3. Selector configuration.

4. Filter command.

5. Selector command.

Below is a detailed description of all the components of the filter panel when selecting elements in a

3D/2D scene or when drawing on a workplane.

Filters for selecting the type of elements.

Element type selection filters are designed to allow you to select a specific element type, for example,

edges, faces, hatches, text, etc.

If the button for selecting a certain element (for example, hatching) is active, then this object can be

selected in the scene.

If the button for selecting this object is not active, then the ability to select this object will disappear.
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In the command standby mode, two additional filters are available in the 3D scene - Selecting

operations on created faces and Selecting nested subassemblies by bodies.

In order to select all types of filters or deselect all, you can use the following options:

<Alt Num+> Select All Types of Elements

<Alt Num-> Cancel Selection of All Types of Elements

Selector (way to select items)

In addition to sequential selection of objects using the , you can select several elements at the

same time, specified in the filter for selecting the type of elements.

The process of selecting several elements at the same time by default occurs by pressing  and

moving cursor in the 3D scene.

There are 3 modes for selecting elements in the scene on the filter toolbar.

Rectangle. "Classic" mode of selection of elements with a rectangle. Items can be selected from right-

to-left and left-to-right.

If you select from left to right (marked in green), then elements that are entirely included in the

specified area will be selected.
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If you select from right to left (marked in red), then not only the elements that completely fall into the

selection rectangle are selected, but also the elements intersected by this rectangle.

Closed curve ("Lasso"). Entering an arbitrary closed contour (automatic closing between the first and

the current point of the contour): all elements inside the contour will be selected. This selection

method is especially necessary when working with drawings and models, which consist of a large

number of objects with complex geometry.
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When the Lasso button is active, it becomes possible to select objects both  and .

Cutting curve. Input of an arbitrary open contour: all elements of which the curve "touched" will be

selected.
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Selection modes are available for all operations and in command standby mode.

The following options are also available on the filter panel in the selection list of the selection

method:

Select visible. Allows to enable the mode of selecting only visible elements: not obscured by other

elements.

Smooth Elements Selection. Turns on the mode of automatic selection of a sequence of smoothly

conjugated elements.

Selector configuration

Allows you to quickly configure a specific set of desired filters. For example, you can specify the

selection of construction elements only, and as a result, only the selection of construction elements

(2D nodes and construction lines) is activated in the filter toolbar.

Filter command

The Filter is designed to set one or several conditions for the parameters of the selected objects. For

example, this command can be configured to select only green image lines.

Functionality of the command is described in the Filter section.

Command Selector

The Selector is intended for advanced filter settings. You can save the configuration of a set of filters,

select the number of nearest elements displayed in the list, etc. Functionality of the command is

described in Selector section.

General principles of element selection

When the cursor approaches an element, this element is highlighted, and the cursor itself takes the

form corresponding to the type of the highlighted element. If you hold the cursor for a short time, a

tooltip will appear with the name of the type of the selected element.
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The time of the appearance of the tooltip for the element under the cursor can be set in the System

Options on the Additional Options tab. The time is specified in milliseconds.

On the same tab, you can also set the transparency of the list. This is useful when you want to see the

selected item below the list. You need to restart T-FLEX CAD for the specified 3D graphics display

parameters to take effect.

If necessary, you can call the list of elements immediately using <Tab> or with a single click with the

middle mouse button.

After the list of appearance of elements, you can select an element in the list using the keyboard or

mouse. If you need to change the selection of an element in the list from the keyboard in the forward

direction, then you need to use the <Tab> function, if in the opposite direction - <Shift> + <Tab>.

You can confirm the selection of an item in the list by clicking the mouse, or using the <Enter> key.

Press  to select an item. To select a group of elements, you need to hold the group of elements

<Shift>.

When working with a complex model, several elements of the same or different types can fall under

the cursor. In this case, you can use the Other... context menu item, where the required element can be

selected from the list. This list consists of the elements closest to the cursor, and only those elements

whose types are present in the selector filter are included there. Another way is to move the cursor to

the desired point and not move it for a while. Then the cursor will take on a different shape and a

tooltip will appear, which indicates the total number of objects falling under the cursor, among which

you can make a selection. Using the mouse wheel, you can cycle through these objects. Pressing will

select the object that is currently highlighted.

When selecting a 3D profile, you must point to the contour line. When you select a body, you must

select Select operations in the filter toolbar and point to any area of ??the body. But it must be borne in

mind that bodies can overlap each other. Therefore, it is necessary to correctly orient the scene so that

the selected body is closer to the others.
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Selected elements are marked with color, depending on the type of object and the purpose of the

selection. All color settings are defined in the system settings. In some 3D commands, different

elements of the same type are marked with different colors. For example, when performing an

Blending three faces, you must specify the left, right and middle sets of faces. In this case, the faces of

each set are marked with different colors. In this case, the corresponding colors are displayed as icons

on the labels of the corresponding tabs with the lists of elements in the dialog of the properties

window.

Topics in this section:

· Selector

· Filter

Filter

Filter parameters can be set or modified either in the command-waiting mode or in the transparent

mode within any command. Call the command using:

Icon Filter Toolbar

Keyboard Textual Menu

<FL> Edit > Filter

Managing the filter involves setting one or more conditions on the parameters of the objects to be

selected. The elements whose parameters do not satisfy any of the filter conditions are disallowed for

selection. This is so even for elements allowed for selection by the selector.

Calling the command brings up the filter parameters dialog box.
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The current filter parameters, which are the currently active condition set, are displayed in the lower

part of the dialog. This set consists of one or several conditions joined by Boolean OR operator. Thus,

an element is allowed for selection if at least one of the conditions is satisfied among the current set.

Each condition in a set is written out on a separate line. It consists of limitations on the element

parameter values. The limitations are joined in a condition by Boolean AND operator. To satisfy a

condition, the element must comply with all and any of the limitations thereof.

To create a condition, use the main pane of the filter dialog box. This is a table of properties of all

elements in the current document. To specify limits on the value of a parameter it is required to find

this parameter in the table and press the ... button in the central column. The drop down list will

appear in which it is required to select the required type of the limit on the parameter’s value: Equal,

Not equal, Greater, Less.



T-FLEX CAD 17 Help

330

The value of the parameter for choosing the constraint is specified in the column on the right. Numeric

and text values ??are set manually. Parameter values ??for which lists of values ??exist in the system ??(for

example, color, type of line, arrow-end type, etc.) can be selected from the list. List opens

automatically when values ??are selected using .

Once all limitations are defined, press the Add button. The just created condition will appear in the

lower pane of the dialog box. If there was already a set of conditions at the time of the new condition

creation, the latter becomes part of this set.
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When creating a condition, the parameter values can be read from a specific element. To do so,

checkmark the necessary parameters, and then press the From Element button. The dialog box will

temporarily disappear from screen, making possible selection of the desired element in the drawing

window using . Once an element is selected, the filter parameters dialog box comes back on

screen. The checked parameter values will be the same as those of the selected element. 

To delete the current condition set or a part thereof, use the Delete button. To do so, first highlight

with  one or several conditions. Then press Delete, and those will be deleted.

Current condition set can be saved for further usage. This can be done using the Save... button. The

Save condition set dialog pops-up upon pressing this button.

There is a field  for entering the name of a condition set in the bottom part of the dialog. Upon

entering a name press Save button. A name can also be selected from the list of existing names using

. In this case a selected set will be overwritten upon pressing Save. You can also delete any

previously saved set. To do so select set in the list of names and press Delete button. Exit button

closes dialog.

To use previously saved condition set press Load... button in the filter parameters dialog. The Load

condition set dialog pops-up upon pressing this button.
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This dialog is similar to the Save condition set dialog. Upper left area of dialog window contains list

of available sets. Use it to select necessary name from the list.  Name of the selected set is shown in

the lower area of the window. 

Upon selecting a name, press Load button. Dialog will be closed and content of selected condition set

will be added to the list of existing conditions. You can also Delete selected set using the eponymous

button.

The specified set takes effect after closing the filter dialog. Only the elements satisfying the current

filter settings will be available for selection in any mode of T-FLEX CAD system. 

Selector

This command can be called only in the command standby mode from the filter toolbar or the textual

menu as follows:

Icon Filter Toolbar

Keyboard Textual Menu

<FT> Edit > Selector

This command sets a set of elements of the drawing and 3D-model that can be selected (similar to

the filter toolbar), and also sets additional filter parameters.

After calling the command, the selector settings dialog will appear on the screen.

The main field of this dialog, Select Elements of Types, contains the list of all system element types.

The elements allowed for selection are checkmarked at the left of their type names. By default, all

elements are allowed for selection. To disallow selection, un-check the respective type with the 

click.  The buttons +, - and +/- help quickly set, clear and invert checkmarking of the element types. 
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A specified combination of settings can be saved as a named selector configuration. To do so, check

the Save as Configuration item and enter the name for the new configuration in the box on the right-

hand side. Additional items in the selector configuration dialog box, such as Number of Elements in

"Other" List and Show "Other" List as:, allow setting different modes of the list display. The list comes

up for a selected element upon calling the Other command in the context menu.

Pressing the OK button saves the defined settings and closes the command. The Cancel button closes

the dialog box without saving changes.

Groups of Elements

For creation and deletion of groups, editing its structure, use the Groups command:

Icon Ribbon

Edit > Additional > Groups

3D Model > Additional > Groups

Draw > Additional > Groups

Assembly > Additional > Groups

Sheet Metal > Additional > Groups

Surfaces > Additional > Groups

Weld > Additional > Groups

Routing > Additional > Groups

Primitives > Additional > Groups

Support Geometry > Additional > Groups

Keyboard Textual Menu

<EU> Edit > Groups

Group – is a named logical union of several elements created by arbitrary rules. Grouping allows us to

work with heterogeneous elements as with a unique object: select, move/copy as a whole object,

specify common properties, etc. Grouping allows us to arrange the structure of a drawing (a 3D

model) and avoid undesired editing of its individual elements. 

Both 2D and 3D elements can form the groups.
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General Principles of Work with Groups

Groups of elements in the documents of T-FLEX CAD can be created in two ways: 

· Manually using the Groups command;

· Automatically by the system when various actions are performed, for example, when 2D

copies, 2D fragments, and drawing views are unfolded, 2D projections are broken. This

method of groups creation is described in more detail in the Automatic Creation of Groups

section.

Each group in the document has a unique name. Groups created by the user by default are assigned

the names of the type “Group_0”, “Group_1”, etc. This name can be changed to a more informative

one in the command of editing/creation of groups.

Any object of the drawing or of a 3D model can belong only to one group. Moreover, both 2D and 3D

elements can be combined into a single group. The group itself can be included into another group,

thus creating a hierarchy of groups of arbitrary complexity.

The system will work with objects combined into a group as with a whole. If the cursor of the mouse is

moved across the screen to an element, which belongs to some group, the entire group will be

highlighted on the screen. When selecting an element belonging to the group, all elements of the

group will automatically be selected. 

If necessary, any element of the group can be selected individually. To do so, use  with pressed key

<Alt>. For the element of the group selected in this way, it is possible to change properties and even

geometric parameters.

The structure of groups can be edited by adding new elements to them or by deleting already added

elements. The elements removed from the structure of the group remain in the drawing or in the 3D

model and the user can work with them as with independent objects.

Command for Working with Groups

The Parameters window of this command contains two lists. The upper list – Groups of elements –

shows the list-tree of groups created in the current document. In the root list of the tree, all main

groups of the current document are located. The folders, which can be expanded, contain the

embedded groups (groups included into other groups).

The lower list (Structure of group…) displays the contents of the group selected in the upper list. A

group can be selected by pressing   on the group's name. The elements included into the selected

group are also highlighted on the drawing or in the 3D scene (depending on what sort of windows are

opened in the current document).

If in the current document none of the groups were created, both lists will be empty.

In the automenu of the command, the following options for invoking various modes are available:
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<G> Group

<U> Explode group

<Y> Set name

<E> Edit

<Esc> Exit command

The  option allows us to create a new group. The  option – ungroup an already existing

group, i.e., make all elements included into it independent objects. In this case the group itself will be

deleted.

The  option is used to specify a new name of the group.

The  option allows us to modify the structure (i.e., add or delete elements) of the selected group.

Grouping (Creation of New Group)

After invoking the  option, the command will enter the mode of creation of a new group. In the

window of properties of the command, in the list of groups, the new group will appear under the

standard name “Group_? ”. When entering the mode of editing, at the header of the list of elements

the name of the new group will appear. The list of elements itself will remain empty. 

New group  will always be created at the upper level of the structure of groups (at the root of

the tree of groups).

In the automenu of the command, the following options will become available:

<Ctrl><Enter> Finish selection of elements

<M> Mode of addition of elements

<M> Mode of deletion of elements

<Y> Specify name

<Esc> Cancel editing

By default, in the automenu the  option will be active, i.e., the mode of addition of elements to

the group being created will be enabled. The elements can be selected by pointing at them in the

window of the drawing or of the 3D model, and also in the tree of the 3D model (for 3D elements).

The selected elements will be displayed in the list of elements of the group in the window of the

command's properties.

Note that when selecting the elements, the filters in the system toolbar are active.
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To correct a wrong selection, the mode of deletion of elements can be used (the  option). The

elements which are specified in the given mode are excluded from the list of the selected elements.

Only the elements that are already added to the group being edited can be selected. The state of the

filters of the selector is also taken into consideration when making a selection.

If necessary, it is possible to change simultaneously the name of the group being created with the help

of the  option. After invoking this option, the command enters the mode of editing the text of the

group's name. The new name of the group can be typed directly in the list of groups. The editing of

the name can be completed by pressing  outside the box with the edited text. 

The name of the group can also be modified outside the mode of creation/editing with the help

of the analogous option in the main menu of the command.

Creation of a group can be completed with the help of the  option (in the automenu or in the

properties window). After pressing  the command returns to the main mode of work.

Ungrouping and Editing a Group

For editing an already existing group, it is necessary to select the desired group in the list of groups

and invoke the  option.  The work in this mode is carried out exactly in the same way as in the

mode of creation of a group. 

Note that if in this mode all elements from the structure of the group are deleted, the group itself is

not deleted. Later such an “empty” group can be edited again by adding to its structure the new

elements. To remove the group, it is necessary to use the . 

Working with Groups with the Help of Context Menu

All modes of operation of the Edit groups of elements command are accessible directly from the

context menu upon selection of elements outside the command.

Commands for working with groups are combined into the “Groups” submenu. Depending on the set

of elements for which the context menu was invoked, it can contain the following commands:

· Group…. It launches the groups editing command in the mode of creation of a new group;

· Ungroup. It  ungroups  (deletes) the selected group/groups;

Edit groups… (available upon selection of only one group). It launches the groups editing command in

the mode of editing of the structure of the selected group.

Automatic Creation of Groups

Automatic creation of groups is offered by the system in the following cases:

· when creating complex elements of the draft (polygons, rectangles …). Capability of creation

of such a group is controlled with the corresponding flag in the window of properties of the

given mode of draft creation;

· when creating a 2D array, if a group is selected as one of the initial objects of the array. In this

case, by default, the new group is created that includes elements-copies of the array obtained



General Elements Management

337

on the basis of elements of the initial group. If two groups were selected for copying, two

more groups will be created, etc.;

· when unfolding fragments, projections, drawing views, copies and arrays. In this case, the

system generates an additional window-warning with the suggestion to combine the resulting

elements into a group. The group will be created in case of positive answer of the user.

When unfolding a 2D array, the number of created groups depends on the command being used

– Explode or Explode Keeping Relations. In the first case, one group is created that includes all

elements belonging to the array. In the second case, elements of each copy of the array are

combined into an individual group. This implies that the number of resulting groups is equal to

the number of copies in the array. 

If elements of the array/copy that is unfolded were already combined into groups (for example,

upon creation of an array), these groups are removed and the new groups are created.

Search Elements

Sometimes, the system might fail to calculate location of some element during regeneration. In such a

situation, the system will display an appropriate message with the Id of this element. To find this

element on the drawing, one can use the Find command:

Icon Ribbon

Edit > Additional > Find

Keyboard Textual Menu

<FD> Edit > Find

Upon calling the command a dialog box comes up on screen for searching a 2D or a 3D element. An

element can be searched by either of the two ways as follows. One way is to use the input box in the

upper part of the dialog. Enter the Id or the name of the searched element. If such element is found,

the buttons in the right part of the dialog box will become accessible. Meanwhile, the element may be

marked on the screen, depending on the Mark on screen attribute. Pressing the OK button closes the

dialog window, while highlighting (selecting) the found element on the screen. Pressing the

Information button opens the element information window (see the topic Model tree). If the element

is not found, the buttons remain inaccessible. 

A pull-down list of the input box in the upper part contains the previous queries. An Id or name can be

selected from this list if desired. 
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Another way of searching for an element is using the tree in the main pane of the dialog box that

contains all model elements. When an element is selected in the tree, the upper input box displays its

Id or name. The buttons in the right part of the dialog become accessible as well.

An additional Sort checkbox serves to sort elements in the tree by the name or by the ID in the desired

order (ascending or descending).

The search command can be called in transparent mode from within any other command. In this

case, the total list will only contain the elements that are allowed for selection in the current

command.

Purge

Icon Ribbon

Edit > Additional > Purge

Workplane > Additional > Purge

Keyboard Textual Menu

<PU> Edit > Purge

The command Edit > Purge serves to delete all 2D or 3D construction elements that were used neither

for creating graphic lines of the 2D drawing nor for operations. Upon calling the command, a list of

unused elements automatically marked for deletion appears in the Parameters window. Each row of

the list contains an element type icon, a name of element and a checkbox. Checkbox is used to control

deletion of this particular element. It's enabled by default, so corresponding element is subject to

deletion. Disabling this checkbox leads to corresponding element not being deleted. Element types

checkboxes are available over the top of the list. Enabling or disabling them adds to or removes from

the list all unused elements belonging to the corresponding type. 
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Nomenclature of available checkboxes depends on types of unused element existing in current file.

Following types of elements might be available:

· 3D Nodes;

· 3D Paths;

· 3D Profiles;

· Workplanes;

· 2D Nodes;

· Unused 2D Copies - copies, that are not displayed on a drawing sheet but remain in model

elements after lowering the number of copies in array’s parameters;

· Constructions;

· Other 2D Constructions  - other 2D elements apart from construction lines and nodes;

Named 2D elements (the ones with the name defined manually) are not deleted.

· Invisible Variables - expressions with no name;

· Visible Unused Variables - all visible variables not used in model or drawing (except variables

marked as Hidden in the variable Editor)

· Other Unused Elements

2D window elements are considered unused if none of the drawing lines or other graphic elements

use them.

3D window elements are considered unused if none of the operations use them.

Buttons allowing to  Select All,  Clear All or   Invert Selection relating to the available

checkboxes nomenclature are located to the right side of element type checkboxes.

Only on Active View checkbox is located under the list of deleted elements.

The way of its operation depends on the active object in the 2D or 3D window.

Enabling the checkbox upon calling the command from the 3D window in the Draw on Workplane

mode clears the list.

Enabling the checkbox upon calling the command from the 3D window outside the Draw on

Workplane mode excludes from the list all elements existing only in 2D window.

Enabling the checkbox upon calling the command from the 2D window with no active view clears the

list.
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Enabling the checkbox upon calling the command from the 2D window with an active view excludes

from the list all elements not related to the active view.

To the right side of the list of deleted elements the   Information about selected element button is

available. 
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Drawing Creation

This section covers the basic concepts of creating 2D objects. Usually the work starts with a drawing.

After the drawing is made or created from a 3D model, you can start working with the drawing,

namely, to set dimensions, apply tolerances and detail design work.

Topics in this section:

· Drawing Techniques

· Drawing Detailing

Drawing Techniques

A T-FLEX CAD drawing can be created in one of the following ways:

Parametric Drawing

This is the recommended drawing technique in T-FLEX CAD. Take the advantage of parametric design

capabilities of T-FLEX CAD to create a drawing that can be easily modified according to your design

intent. Such a drawing can also be added to a parametric model library to be later used in other, more

complex drawings. In the latter case, one can specify a new location for the drawing as a fragment,

and modify parameters to obtain a necessary shape.

Non-parametric Drawing (Sketch)

This is a conventional drawing similar to those created by most CAD systems. This drawing is created

by using the standard set of functions for plotting different basic entities (straight lines, arcs, circles,

ellipses, splines etc.) and by using the mechanism of objects snaps. These drawings do not have

advantages of parametric drawings as far as efficient modification of parameters (dimensions) is

concerned, however, in certain cases creating these drawings saves time and can give the benefit when

significant subsequent modification is not required.

Creating Parametric Drawing in T-FLEX CAD

In T-FLEX CAD, there are two ways to create a parametric drawing: using the Sketch and Constrains

commands, or based on construction lines.
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The first method is based on the mechanism of variational parameterization, i.e. geometric and

dimensional dependencies are created directly on the image lines. The second method is based on

the history of constructions, i.e. the user independently determines the geometric dependencies

between the lines of construction, and then based on these elements builds the image lines of the

drawing.

Creating Parametric Drawing with Construction

Entities

Creating Parametric Drawing with Constrains

The position of the geometric element relative to

previously constructed elements is determined

when it is created.

The position of the geometric element can be set

or changed at any time by means of restrictions.

Cyclic dependencies are not possible (previously

constructed elements cannot depend on

elements constructed later)

The position of the geometric element can be set

or changed at any time by means of restrictions.

The parametric model is always completely and

uniquely defined

The model may not be fully defined, which, on

the one hand, makes it convenient to modify it,

but on the other, it can lead to unpredictable

results with parametric changes

Recalculation of the model requires only a single

pass, which allows you to quickly read models

with a large number of elements

Recalculation of the model requires specialized

calculation of the constraint system, which limits

the dimension of the model and the speed of

calculations

Uses construction elements on the basis of which

image lines are created.

It does not require the use of construction lines.

Dependencies are imposed through constraints

and control dimensions.

Variables are used when setting parameters of

construction elements.

Variables are used as values ??of control

dimensions, as well as to suppress restrictions

and control sizes in order to qualitatively change

the parameterization scheme

Overriding dependencies between elements is a

rather complicated, sometimes impossible

process

Overriding dependencies between elements

comes down to removing constraints and

creating new constraints

Automatically detecting dependencies and

establishing relationships between elements is

difficult

It is possible to automatically identify

relationships and create constraints both when

creating model elements, and for previously

created elements, for example, for imported

drawings and sketches

Briefly consider each of these methods.

Creating Parametric Drawing with Constrains

A drawing is created using the «Sketch» command in the automatic constraint creation mode.
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In the process of creating image lines, the system itself establishes the dependencies between the

elements. Constraints allow you to change the geometry of models, establishing relationships

between the lines of the drawing. Control dimensions allow you to quickly and clearly change the

created drawing. Control dimensions can be created manually or in automatic mode.

Creating Parametric Drawing with Construction Entities

Creating a drawing in T-FLEX CAD begins with creating construction entities. Construction entities can

be created by various means. First, create the base construction lines that will be used as a reference

for additional construction lines. The base lines can be vertical or horizontal. Next, create straight lines

and circles dependent on the base lines. For instance, construct parallel lines, tangent circles, etc. The

way in which additional lines are created is stored in the model. The line intersections provide

reference locations for nodes that need to be created for further construction. 
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More straight lines and circles can then be created referencing the earlier ones in various ways. A line,

for instance, can be created through two nodes; a circle can be drawn through a node and tangent to

a line. All these construction steps are stored, and in future the thus created entities will be adjusting

to the base and other entity modifications according to their creation history. 

Thus, the early stage of creating a drawing involves building parametric dependencies among

construction entities that become the parametric framework of the drawing. Once the construction

framework is built, proceed with drawing the graphic entities. Create line segments, arcs and circles by

drawing over the construction lines, snapping to nodes. 

Once the actual drawing graphics is complete, proceed with the drawing layout arrangement. Create

dimensions referencing construction lines and nodes. Define hatch contours, their filling patterns and

other particulars. Add text entities. When placing text use snapping to nodes and construction lines if

necessary. This would be necessary if a text is supposed to move together with the drawing graphics.
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Further, define GD&T symbols, roughness's and leader notes. Finally, a complete parametric drawing is

created and can further be modified. One can vary construction entity parameters, such as distances

between parallel lines, angles between lines, radii of circles.

The graphic entities will subsequently adjust with the construction ones they reference. Thus, a family

of variations of the original drawing can be created. All the rest of the drawing layout will also adjust

accordingly, all done in an instant. 

Note that the above scenario for creating a parametric drawing in T-FLEX CAD is just one

recommended technique. One can create construction entities and graphic entities in an

arbitrary sequence. What is important is that the graphic entities are constrained to the

construction ones. 

The following chapters will tell how to use variables as drawing parameters, how to create an

assembly from fragments, and much more.

Creating Non-Parametric Drawing (Sketch) in T-FLEX CAD

This technique implies quick sketching of the drawing graphics, completely avoiding preliminary

creation of the construction entities. Sketching supports object snapping and provides dynamic hints

that make the drawing process simple and slick. However, thus created drawings do not share the

advantage of parametric drawings in the capability of parameter (dimension) modifications. Creating

non-parametric drawings may be somewhat preferable in the cases when no significant modifications

are expected.

Topics in this section:

· Construction Entities

· Graphic Lines

· Moving and Copying Drawing Elements. Arrays

· Copy with Clipboard

· Local Coordinate System
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· Selection of 2D Elements

· Grid

Construction Entities

In the T-FLEX system, the drawing image is applied to pre-created building elements. The construction

elements that form the drawing framework are infinite lines, circles, splines, ellipses, and offset curves

that are connected by various geometric relationships. These relationships can be parallelism, touch,

symmetry, tilt angle, and so on. By analogy with drawing on paper, construction elements can be

compared to thin lines, which are then outlined with ink. Before you draw drawing lines, you must use

the build lines to define the drawing frame. The lines of the drawing image are then applied to this

frame. The lines in the drawing image are "linked" to the construction lines, and they will follow them

when their positions change. This saves all the geometric relationships that were set for the building

elements.

As you can see in the figure above, moving the right construction line and increasing the radius of the

interface circle did not affect the geometric relationships of the drawing.

This approach, when drawing elements are interconnected with each other, allows you to get a fully

organized drawing.

Building elements in T-FLEX are building lines - straight lines, circles, ellipses, splines, and nodes.

Nodes are points where lines intersect. Building elements are not output to the printer or plotter. You

can also make them invisible at any time.

It is important to note that before creating elements for building your drawing, you need to analyze

exactly what relationships between lines you want to set. After all, this will determine the ability of

your drawing to parametric changes.

You can assign variables to drawing parameters, and in fact to parameters of construction lines

(distances, diameters, etc.). This can be done both during the creation of the build line and during its

subsequent editing. Then, setting the values of the variables, it is possible to obtain new versions of

the drawing. You can use simple mathematical formulas in the variable editor to link variables.

When you change the position of a building element or the value of a variable, the system recalculates

the drawing and then redraws it. Recalculation is performed in accordance with the geometric

relations that were laid down when it was created, as well as based on the mathematical relationships

between variables, if they were set. As a rule, a well-created parametric drawing contains several

external variables, depending on which the rest of the variables and the entire drawing are

recalculated.

Topics in this section:

· Line

· Circle

· Ellipse

· Node

· Path

· Spline

· Offset Curve
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· Function Spline

· Edit Construction

· Element Replacement

Line

To construct a line, call the command Construct Line.

Icon Ribbon

Draw > Construct > Line

Keyboard Textual Menu

<L> Construct > Line 

Direct lines are created using a specific set of options that are displayed in the automenu. The

command to create a construction line allows combining a limited set of options to obtain various

types of construction lines - straight lines. It is only necessary to make sure that when you select an

element, the cursor points to this element.

The following options become available:

<Enter> Select a line relative to which a new line is being built.

<P> Set Line Parameters 

<X> Creates two crossing Lines and Node

<H> Creates horizontal Line

<V> Creates vertical Line

<L> Selects related Line 

<N> Selects Node

<Space> Creates a node at the nearest intersection of construction lines

<C> Selects tangent Circle

<E> Selects ellipse to create Line

<S> Selects spline

<T> Creates Proportional Line

<U> Create Axis of Symmetry

<A> Selects Axis of Symmetry (straight Line)

<W> Select 2D projection
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<F4> Edit

<Esc> Deselect all items/Escape command

<F> Create insertion Point for Fragment (xn,yn)

<O> Create two Lines and Node in (0,0)

Some of these options become available only after selecting certain construction entities.

Since most often users draw 2 lines at right angles, there is a separate option for this  (<X>).

It is also necessary to consider that when creating a number of line types, even after you create one

line, you will remain in the mode of creating this line type. For example, by choosing the <X> option

and constructing two intersecting straight lines, you have the opportunity, without selecting this option

again and using only , again build two intersecting straight lines. This feature allows you to speed

up the creation of lines of the same type. In order to cancel the mode, you must press .

The option  (<O>) is convenient to use when working on the active workplane in the 3D view

window to snap to the origin.

Types of Construction lines - lines

The line creation command allows making a variety of construction line configurations by combining

the limited set of options, as follows:

· Crossing (vertical and horizontal) lines with a node at the intersection and exactly defined

placement coordinates

· Horizontal line

· Horizontal line with exactly defined coordinates

· Vertical line

· Vertical line with exactly defined coordinates

· Parallel to a line, the specified distance away 

· Parallel to a line, through a node 

· Parallel to a line, tangent to a circle 

· Parallel to a line, tangent to a ellipses

· Parallel to a line, tangent to a spline

· Through a node, at a specified angle with respect to X axis

· Through a node, at a specified angle with respect to a line

· Through a node, orthogonal to a line

· Through a node, horizontal

· Through a node, vertical

· Through a node, tangent to a circle

· Through a node, tangent to a ellipses

· Through a node, tangent to a spline

· Through a pair of nodes

· Line tangent to two circles

· Line tangent to circle, through a node

· Line tangent to circle, at a specified angle

· Line tangent to an ellipse and a circle

· Line tangent to two ellipses
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· Line tangent to an ellipse and a spline

· Line tangent to an ellipse, at a specified angle with respect to another line

· Line tangent to two splines

· Symmetrical to another line with respect to a specified axis

· Symmetry axis for a pair of lines 

· Line orthogonal to the segment spanning two nodes, dividing the segment in specified

proportion

· Line based on 2D projection

The <P> option notation in the descriptions of line constructions means a numerical parameter

is to be input. In this case, instead of calling the parameters dialog, one can use the property

window or simply click  within the drawing.

Whenever the <P> option is not present, the line does not have numerical parameters. For example,

this would be a line trough a pair of nodes.

There are different techniques of creating lines. Some lines are independent of other construction

entities. These could be a standalone horizontal or vertical line. Usually, these are the very first lines on

a drawing. By creating a vertical and a horizontal line, you define the base lines, to which all the rest

will be related. 

Other lines require the related elements to be selected at the time of creation. For example, a line

tangent to two circles requires the circles to be selected and the tangency condition defined.

A number of line creation techniques require a certain geometric parameter to be defined. For

example, consider constructing a line parallel to another line and passing at a certain distance from

the other line. 
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In all methods of creating a straight line in which the <P> option is used (set the value of the

numerical parameter of the straight line), a variable or expression can be used along with a fixed

value of the parameter. This parameter can also be set by pressing  without using the dialog

box for setting direct parameters (by cursor position). In this case, the parameter will take on the

value that was at the time of application in the display field of the status line coordinates. In all

cases when the <P> option is not specified, the line does not have numerical parameters, for

example, a line passing through two nodes.

Construction lines parameters

When using the <P> option while building or editing a line, you can set the line parameters. For those

lines that also require a numerical parameter (for example, distance), you can assign it the necessary

value.

Truncated lines

Normally, construction line entities appear on a drawing as infinite lines. However, as a drawing grows

crowded, managing it becomes difficult. A means is provided for setting shortened representation of

construction lines that allows working with lines as segments of limited length.

A trimmed, or truncated, construction line is bound by its two end nodes. The extents of trimmed

construction line overhangs can be defined in the command Set Document Parameters (the parameter

View > Extents).

 

If a construction line does not have nodes, then it will always appear as an infinite line. If a

construction line has only one node then the Extents parameter should better be set greater than zero,

as otherwise the line will disappear from display.

The line display gets up to date after executing the following options of the Edit Construction

command:

<T> Update selected Line(s) extents
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<Ctrl><T> Update all Line extents

The function of the Line length parameter significantly depends on the settings under the Set

Document Parameters command, parameter View > Length.

Four ways of line display are supported by the Set Document Parameters command:

· Default truncated. If a particular line has the parameter Line length set to Default value, then

this line is displayed as a segment. 

· Default infinite. If a particular line has the parameter Line length set to Default value, then

this line is displayed as an infinite line.

· All truncated. Any and all lines will be displayed as segments, regardless of the Line length

parameter settings.

· All infinite. Any and all lines will be displayed as infinite lines.

Another special parameter under the Set Document Parameters command is View > Search. It

defines the line selection mode. The lines are selected either within the displayed limits or as infinite

lines, regardless of other parameter settings.

Using numerical parameters

Entering the Distance parameter is a most common case of working with construction line parameters.

The positive values of this parameter correspond to locations above the reference horizontal line,

while the negative are below, respectively.

In the case of a vertical reference line, the positive values of this parameter are for the left hand-side

locations, while the negative are for the right hand-side locations, accordingly. 

These rules result from the use of the coordinate system in T-FLEX CAD. That helps keeping the once

set relations between construction entities under any modifications of the parameter values.

Topics in this section:

· Lines Parameters
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Lines Parameters

When creating and editing lines, it is often required to define various line parameters. The geometrical

parameters, such as coordinates, the distance or the angle to the related line, can be entered in

transparent mode in the property window. However, in order to define the general system parameters

of the line, one has to use the option  to bring up the dialog box of all line parameters.

Distance. This is the distance between the newly constructed line and the line selected as the reference

for the construction. 

Level. Places the line being created on the particular visibility level. Levels help hiding certain

elements from display. The level parameter can be assigned a variable.  

Layer. This parameter allows placing the line being created on a certain layer.  

Line length. Defines the way of construction line representation in display. The detailed description of

this parameter follows below. The available values of this parameter, provided in the list, are:

· Default (From Document);

· Truncated;

· Infinite. 

Color. This parameter defines the color used for displaying the line.

Line Style. drop-down lists you can choose 1 of the options for displaying the line.

· Default

· Solid

· Dash

· Long Dash

· Dot Dash

Set as default. Setting this flag means, the current parameter settings in this dialog box will be used

from now on in construction line creation, with the exception of the Distance parameter.
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Circle

To create a circle, call the command Circle.

Icon Ribbon

Draw > Construct > Circle

Keyboard Textual Menu

<C> Construct > Circle 

Circles in T-FLEX CAD are constructed similarly to lines, that is, by defining their geometrical relations

with other construction entities. Examples of such relations include placement of the circle center at a

node, tangency to a line, tangency to a circle, passing through a node, concentricity with another

circle, symmetry to another circle. 

The T-FLEX CAD circles can be divided into two main groups:

· circles, whose radius can be assigned a number (for example, a circle with the center placed at

a node, or a circle tangent to two non-parallel lines);

· circles, whose placement and radius are defined by construction (for example, a circle passing

through three given nodes).

If a circle has a numerical parameter (the radius), then the parameter can be defined by a constant, a

variable or an expression. To assign the numerical parameter, one can use the property window. The

circles are created in the command Construct Circle. The relations defined at the time of circle

construction can be modified in the command Edit Construction in a similar to line way of handling.

Types of circles

· Circle with center at a node, with a specified radius 

· Circle with center at a node, tangent to a circle

· Circle with center at a node, tangent to a line

· Circle with center in the nearest node, passing through a node

· Circle tangent to two lines, with a specified radius 

· Circle tangent to a line, passing through a node, with a specified radius  

· Circle tangent to a circle, passing through a node, with a specified radius  

· Circle passing through two nodes, with a specified radius  

· Circle tangent to a line and a circle, with a specified radius  

· Circle tangent to two circles, with a specified radius 

· Circle passing through three nodes

· Circle tangent to three lines

· Circle tangent to two lines, passing through a node 

· Circle tangent to a lines, passing through two nodes 

· Circle tangent to a line and a spline or ellipse 

· Circle tangent to a circle and a spline or ellipse 

· Circle tangent to two splines or ellipses

· Circle, concentric with another circle, with a specified radial offset 

· A circle mirrored about a symmetry axis

· Based on 2D projection

Constructing circles 

The command Construct Circle provides various options from the following list, depending on the

current state:
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<T> Select a node as the center of the circle

<T> Select a node for the circle to pass through

<P> Set circle parameters 

<L> Select tangent line 

<N> Select a node for the circle to pass through

<C> Select tangent circle 

<E> Select tangent ellipse 

<S> Select tangent spline 

<A> Select symmetry axis (line) to mirror the circle.

<O> Select concentric circle

<W> Select 2D projection

<Space> Construct a node at the nearest intersection of two construction entities

<Z> Change construction tangency

<F4> Execute Edit Construction command 

<F3> Call command Zoom Window

<Esc> Cancel selection/Exit command

In both circle construction and editing, typing <Z> can be conveniently used for traversing

configurations within the chosen type of circle construction. For example, two configurations are

possible when constructing a circle tangent to a line and another circle, with the same cursor position.

The <Z> key can be used for switching between these two configurations.

Similarly, during editing, a circle configuration can be flipped as well.

When creating circles tangent to two elements (two lines, line and circle, two circles), the options used

for creation and cancellation of snapping to a node are available in the automenu:

<G> Apply snapping to a node

<B> Cancel snapping to a node

The  option is used for snapping circles tangent to two construction lines to an additional node

that will determine the circle’s tangency choice. After this option is invoked you need to specify the

required node with the help of . As a result of applying this option, upon change in the drawing

the circle will be reconstructed in such a way that its location is as close as possible to the node. This

allows us to uniquely specify location of the circle with respect to the original lines.
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Topics in this section:

· Circle Parameters

Circle Parameters

Various parameters need to be defined when creating or editing circles. The geometrical parameters –

the radius or the offset for concentric circles can be defined in the transparent mode via the property

window. However, the general system parameters can only be accessed via the  option that provides

access to all circle parameters via a dialog box.

Radius/diameter. Defines the circle radius or diameter. Allows numerical value, variable or expression

input. 

Level. Places the circle being created on a certain visibility level, used for hiding certain elements from

display when necessary. 

Layer. Is used for linking the circle being created to a certain layer. 

Color. This parameter defines the color of displaying the circle on the screen.

Line Style. drop-down lists you can choose 1 of the options for displaying the line.

· Default

· Solid

· Dash

· Long Dash

· Dot Dash

Set as default. When this flag is set, the parameters defined in this dialog box will be used in creation

of new construction entities (except the Radius parameter).

Ellipse

To construct an ellipse, call the command Ellipse.

Icon Ribbon

Draw > Construct > Ellipse

Keyboard Textual Menu

<EL> Construct > Ellipse

These modes correspond to the following options:
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<T> Select Center Ellipse Node

<T> Select a node for the circle to pass through

<N> Set ellipse parameters 

<C> Select a node for the circle to pass through

<P> Select tangent circle 

<A> Select symmetry axis (line) to mirror the ellipse.

<W> Select 2D projection

<Space> Construct a node at the nearest intersection of two construction entities

<F4> Execute Edit Construction command 

<F3> Call command Zoom Window

<Esc> Exit command

Ellipses in T-FLEX CAD are constructed similar to circles - by defining their geometrical relations with

other construction entities. Examples of such relations are the ellipse center being snapped to a node,

tangency to a line, tangency to a circle, passing through a node, symmetry with another ellipse.

Ellipses, like other construction entities, are displayed in a thin dashed line.

Ellipses in T-FLEX CAD can be divided into two types:

· Ellipses whose size is defined by numerical parameters;

· Ellipses whose position and size are defined by geometrical relations.

Types of circles

· Ellipse with center at a node, with a specified parameters

· Ellipse with center at a node, passing through two nodes

· Ellipse with center at a node, passing through node, tangent to a line

· Ellipse with center at a node, tangent to a line, with a specified parameters

· Ellipse with center at a node, tangent to a line, passing through node

· Ellipse passing through two nodes, with a specified parameters

· Ellipse passing through three nodes

· Ellipse passing through two nodes, tangent to a line 

· Ellipse tangent to a circle, passing through node

· Ellipse, tangent to a circle and a line

When constructing graphic lines, to construct a complete ellipse, it is necessary, when none of the

nodes are selected, move the cursor to the construction line — an ellipse and press <E>. To build part

of the ellipse image, build or select a node at the intersection of the ellipse and another construction

line using <Enter> or <N>. Move the cursor to the ellipse and press <E>. The cursor will move along

the ellipse, build or select another node at the intersection of the selected ellipse and another

intersection line using <Enter> or <N>. An image line is constructed as part of the ellipse. In a similar

way, a contour line is introduced using an ellipse when defining a hatch contour.

When constructing nodes, the <E> option is also used to select the ellipse. Ellipse parameters are set

in the dialog box.
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Topics in this section:

· Ellipse Parameters

Ellipse Parameters

Various parameters need to be defined when creating or editing ellipses. The geometrical parameter

– axis. However, the general system parameters can only be accessed via the  option that

provides access to all ellipse parameters via a dialog box.

Axis. Specified by the distance between the two objects that define the ellipse. The value can be a

number, variable, or expression.. 

Level. Places the ellipse being created on a certain visibility level, used for hiding certain elements

from display when necessary. 

Layer. Is used for linking the ellipse being created to a certain layer. 

Color. This parameter defines the color of displaying the ellipse on the screen. 

Line Style. drop-down lists you can choose 1 of the options for displaying the line.

· Default

· Solid

· Dash

· Long Dash

· Dot Dash

Set as default. When this flag is set, the parameters defined in this dialog box will be used in creation

of new construction entities (except the Axis parameter).

Node

The command is called by:

Icon Ribbon

Draw > Construct > Node

Keyboard Textual Menu

<N> Construct > Node 

Main node types:

· Connected Node
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· Free Node

· Node from Fragment

As well as additional construction options.

· Node at intersection of construction lines. Such nodes are used most often in creation of

parametric models. Its position is defined by the position of two construction entities and their

intersection to which the node is related. In the case of multiple intersections between the

entities, the particular intersection shall be identified.

· Free node is defined by the absolute X and Y coordinates in the model coordinates. The

values of a free node coordinates can be defined by variables. Such nodes are of limited use in

parametric models being created, however, these are widely used in development of sketches,

various diagrams and technical figures. Free nodes are useful in the cases when there is no

strict requirement on positioning points of the image.

· Node from fragment is defined by the position of another node located on a fragment of

an assembly. This type of node is necessary for creation of parametric assemblies. It is used for

relating some element of an assembly with a point on a fragment of this assembly.

· Node created relative to another node. Its position is defined by an offset from another

node. The offset values can be defined by constants or by variables. A node of this type can be

used as an auxiliary fixing point in the cases when some element should be snapped at an

offset position of the base node rather than to that node directly.

· Node lying on a construction entity, at the specified distance from another node along the

entity.

· Node – a characteristic point of a construction entity. Among this type are nodes lying at a

circle center, at a start or end point of a spline or other curve.

· Node on a curve, dividing the curve in a specified proportion.

· Nodes placed at characteristic points of elements. This type includes nodes on dimension

witness lines, on leader notes, at the ends of lines created by copying, etc.

For a point to become a node, the node needs to be created. This can be done in various ways:

· By the command Construct Node, specifically designed for creating nodes.

· By the option <Space> in the commands Construct Line and Construct Circle. In these

commands, you can move the cursor over an intersection point of construction entities and

press <Space>.

· In the command Create Graphic Line when creating a graphic line.

· In the command Create Hatch when creating a hatch.

· In the command Create Fragment. As you add a drawing as a fragment into the current

drawing, you can automatically create nodes from fragment in the drawing. 

The last three techniques are described in the chapters that follow. In this chapter we will review in

details the command 

Upon calling the command, the following options become available in the automenu:

<Enter> Create node

<Ctrl><F> Connected node

<Ctrl><F> Free node

<P> Set Node parameters

<L> Select Line to create Node



Drawing Creation

359

<C> Select Circle to create Node

<E> Select Ellipse to create Node

<S> Select Spline to create Node

<N> Select Node for relative Node creation

<F> Select Fragment to create Node

<W> Select Fragment from list

<R> Select 2D Projection

<F4> Execute Edit Node command

<Esc> Exit command

There are following types of nodes:

1. On intersection of two entities and click

Move the cursor over an intersection of two entities and click . A node is created at this point.

2. Subsequently create two construction entities

The node is created at their intersection point. You sequentially select two construction lines using the

options <L>, <C>, <S>, <E>. Should there be two or more intersections, the one is used that was

nearest to the cursor at the time of the last entity selection. The options used for selecting various-

type construction entities are , ,  and .

Possible combinations:

<L>, <L> - a node is built at the intersection of two straight lines.

<L>, <C> or <C>, <L> - a node is created at the intersection of a straight line and a circle.

<C>, <C> - a node is built at the intersection of two circles.

To create a node in the center of a circle, you can point at it with the mouse cursor and press the <C>

key twice, or select the circle, then select the option  (<C>) in the automenu and re-specify this

circle.

When object snap is on, it is enough to move the cursor approximately to the center of the circle and,

when the point in the center is highlighted, press the left mouse button.
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<L> <E> or <E> <L> - a node is built at the intersection of an ellipse and a straight line.

<L> <S> or <S> <L> - a node is constructed at the intersection of a spline and a straight line.

<C> <S> or <S> <C> - a node is constructed at the intersection of the spline and the circle.

<E> <S> or <S> <E> - a node is constructed at the intersection of an ellipse and a spline.

<E> <C> or <C> <E> - a node is built at the intersection of a circle and an ellipse.

<S> <S> - a node is constructed at the intersection of two splines.

<E> <E> - a node is built at the intersection of two ellipses.

3. On ends points of spline

To construct a node at the start or end point of a spline or other curve, select the curve by clicking it

with . A cross-shape node will start rubberbanding along the curve. Move the cursor over one of

the endpoints of the selected curve and engage the option:

<T> Select Curve to create end Node

The option /  allows selecting the drawing mode - free or constrained. The current mode is

indicated by the kind of the option icon displayed in the automenu. The option , called prior to node

creation, opens a dialog box for defining the system-wide parameters, such as layer, level, color for

new nodes. The same dialog allows to define position of various types of nodes being created.

Clicking  constructs a node at the nearest intersection point of construction entities, while in

constrained drawing, or construct a node at the position on the drawing directly under the cursor in

free drawing.

The options , ,  and  allow creating nodes lying on the selected entities.

To construct a node relative to another node, the option  is used.

The options ,  and  help creating nodes based on fragments and on the lines of 2D

projections.

Node is a point whose coordinates are calculated depending on the node parameters or position of

other model elements. Nodes are important construction elements in T-FLEX CAD. They represent start

and end points of graphic lines. Nodes are directly involved in creation of most of the graphic

elements. They also play an important role in creation of construction entities.

4. Relative to spline

To construct a node relative to another node, as well as a node dividing the distance between two

other nodes in a given ratio, use the  (<N>) option. After selecting the source node, a set of icons

becomes available.
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<P> Set Node parameters

<L> Select Line to create Node

<C> Select Circle to create Node

<E> Select Ellipse to create Node

<S> Select Spline to create Node

<N> Select Node for relative Node creation

<Esc> Exit command

The position of the node being created will be determined relative to the selected node. The exact

values ??of the relative coordinates of the node being created are set in the properties window. You can

specify the position of the node with the mouse cursor. You can also place a node on the construction

line (line, circle, ellipse, spline) that the original node belongs to. Select the required construction line

(a dynamically moved node will appear on it) and set the position of the node by pressing  or

<P> to specify the exact distance from the original node to the created one.

To construct a node dividing the distance between two other nodes in a given ratio, you must

sequentially select two source nodes using the option . After selecting the second node, an image

of a node in the form of a small cross will appear on the screen, dynamically following the cursor. The

node will move strictly along a straight line passing through the two selected nodes. The position of a

node on a straight line can be set arbitrarily by clicking  or specifying in the properties window the

exact value of the coefficient, according to which the created node will divide the segment between

the original nodes.

A node dividing the distance between two other nodes can be built even when the original nodes are

collinear. The resulting node will also belong to the same straight line. To create such a node, it is

necessary to sequentially select the first node (option ), then the straight line (option ), then

the second node (option ). The node position is set in the same way as in the previous case.

5. Based on projection

The  (<W>) option is used for this. After selecting a 2D projection, a set of icons becomes

available.

<P> Set Node parameters

<Esc> Exit command

Select the position of the node to be created with the mouse cursor and click .

The option  also allows projecting nodes from a 3D model onto a drawing. After calling the

option and choosing a projection, it is enough to indicate the required 3D node (in the 3D window or
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in the 3D model tree). A free node appears on the 2D projection, which is the projection of the

specified 3D node.

6. Node from a fragment

This method of creating sub-assemblies is sometimes necessary in parametric assembly drawings.

Nodes from fragments are needed so that you can "bind" construction elements and image elements

of the current assembly drawing to certain points of the fragment.

Nodes from a fragment can be created automatically when inserting a fragment, if the Create

named nodes automatically checkbox is selected in the system settings (command "System

settings, Fragments tab"). In this case, when you insert a fragment, nodes will be created based

on all the named nodes in the fragment.

In addition, nodes from a fragment can be created automatically when creating dimensions and

other elements when using object snaps, if in the "System settings, Snap" command, the Priority

group, the Fragment Nodes parameter is set. When this check box is cleared, the steps below

are required to create nodes on fragments.

Nodes from a fragment can be created in the Construct Node command. When working in the object

snap mode and the Fragment Nodes checkbox is selected (the System settings command, Snap >

Priority tab), to create a node from a fragment, just move the cursor to the end of the fragment

image line. At the end of the line, a node will be highlighted with the Fragment node tooltip. When

clicked , a node is created from a fragment.

When object snapping is disabled, the  (<F>) or  (<R>) option is used. After selecting a

fragment, a set of icons becomes available.

<N> Select Node for relative Node creation

<*> Create all marked nodes

<М> Show the node names of the fragment

<А> Show all nodes of the fragment

<Esc> Exit command

If the fragment contains named nodes, they will be immediately visible in the drawing.

Option  (<M>) enables displaying the names of the fragment nodes. Option  (<A>) allows

you to view the position of all nodes of the fragment. Option  (<*>) creates all nodes of the

selected fragment on the assembly drawing. To create a specific node, you need to point to it with

the cursor and click .

On the screen, the nodes from the fragment are shown as a square with a cross.

7. Nodes at key points of elements

These nodes can only be created when the system is in object snap mode. This category of nodes

includes nodes that lie on extension lines of dimensions, on labels, tolerances and at the end points of

image lines obtained by copying or belonging to 2D projections; as well as nodes at the center of a



Drawing Creation

363

construction line-circle or ellipse, nodes at the start / end points of a spline and other curves. The

corresponding parameter must be set on the Snap tab of the System settings command.

Topics in this section:

· Connected Node

· Free Node

· Node from Fragment

· Work with Nodes

· Node Parameters

· Edit Node

Connected Node

A connected node is a node defined as the intersection point of two construction lines. In the case of a

circle, this may be a point of tangency. In the drawing, the node looks like a small crosshair.

In addition to nodes at the intersection points, there are other types of nodes (free nodes, nodes from

fragments).

In order for the intersection point of two lines to become a node, you need to create this node. You

can do this in various ways:

1. Using the Node command, which is specifically designed to create nodes.

2. Using the <Space> option in the Line, Circle, Ellipse, and Spline commands. In these commands you

can move the cursor to the necessary point and press <Space>.

3. In the Graphic line command when creating an image line.

4. In the Hatch command when applying the hatch outline.

5. The Fragment command. When you add a drawing as a fragment to the current drawing, you can

automatically create nodes from the fragment in the drawing.

6. When using the articulation point of image lines belonging to 2D fragments or 2D projections, a 2D

node is created in the commands for constructing or creating 2D elements in it.

7. To create a node in the center of the circle, just click on it  .
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Free Node

The main approach to creating drawings in T-FLEX implies use of nodes on the intersections of

construction entities. However, the system also supports so-called free nodes. These nodes are not the

points of entity intersections; rather, these are defined in absolute coordinates. Such nodes can be

used just as well as usual constrained nodes for creating either construction entities or graphic

elements. Free nodes are displayed as squares.

To create such nodes, turn on free drawing mode in the command Construct Node by using the option

/ . Alternatively, use the "Point" command in the sketch command group.

After that, select the necessary point in the drawing with the cursor and click . The node is placed

in the drawing at the point where the cursor is located. If you want to specify the exact position of the

node in the drawing, use the <A> option. You may also find it useful to use a grid, the settings of

which you can set in the "Grid" command.

The grid will allow you to more accurately determine the position of the node you are creating. In this

case, the exact coordinates of the cursor will be displayed in the coordinate window.

Free nodes can be used equally with ordinary linked nodes to create other construction elements and

to create an image.

A feature of free nodes is the ability to independently move such a node or a group of nodes, and,

accordingly, all elements associated with them, in the edit node command.

This is not possible for linked nodes. They can only move when you change the position of the

construction lines from which they were created.

For nodes not associated with construction lines (for example, for nodes raised from a fragment),

there is the possibility of converting to a free node (edit node command, option  (<F>). This
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option allows you to break the connection of the node with the original elements and convert it to a

free node whose position does not change when you move the original elements.

Semi-connected nodes are created in the same mode as free nodes on any construction line (except

for a straight line). The position of such a node on the selected construction line is determined by the

Coefficient parameter (value from 0 to 1). When you change the position of the construction line, the

position of the node will also change.

Node from Fragment

This way of node creation is quite important for support of parametric assemblies. The nodes from

fragments provide the means for “tying up” construction entities and graphic elements of the current

assembly to the fragment.

For example, you assembled a bushing on your drawing by the command Create Fragment, and now

want to create a dimension on the outer diameter of the bushing.

Since a dimension can't be created without nodes, you need to create two nodes from this fragment.

After that, nodes from fragment can be created by pointing the cursor to the necessary nodes among

the highlighted ones and clicking . Created nodes from fragment are displayed as crossed

diamonds.

Nodes from fragment can be created in the command Construct Node.

<F> select a fragment for node creation

<R> select a fragment from the list

After selecting a fragment in the automenu, a set of icons becomes available:

<N> Select node
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<*> Create all highlighted nodes

<M> Show Fragment Node Names

<A> Show all Fragment Nodes

<Esc> Cancel selection

Options  (<M>) and  (<A>) allow you to view the position of the named and all nodes of the

fragment, respectively. The option  (<*>) creates all the nodes of the selected fragment in the

assembly drawing, and the option  (<N>) allows the user to select a specific fragment node.

It is recommended to use the second method of specifying nodes in a saturated drawing, as well as if

several construction lines intersect at one point.

Work with Nodes

The <P> option allows you to set the node parameters.

To delete a node or change the values of its parameters, use the Edit node command.

In the node editing command, you can select node bindings: the binding can be the intersection of

plot lines, the center of a circle, the intersection of two bindings (for example, two perpendiculars),

and so on. Possible bindings are highlighted when the cursor hovers over them when the node editing

command is active.

When you select a node using  click, the node will be highlighted, as well as the construction lines

at the intersection of which it was construct. You can also select a node to edit in the Edit construction

command. If you use the <N> option in the Edit construction command, the system will automatically

transfer you to the node editing command.

Nodes as well as other construction elements can be made invisible at any time. To do this, enter the

Level command and set the lower limit of the visibility level of these elements to a higher value than

the value of the Level parameter for these elements. By default, all elements have a level of "0".

Therefore, it is enough to set the lower limit of the visibility range to "1", and the construction

elements disappear from the screen.

You can also use layers to make the invisible elements of the build. Place them on a layer, such as

"Construction", and then in the "Layers" command, mark this layer invisible.
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To do this, use the "Settings" command. In the Miscellaneous > Node size option on the 2D tab of

this command, you can set the size in pixels.

If during the construction process you have somehow created unnecessary nodes or other construction

elements, then to quickly remove these elements use the Delete unused construction command.

This command will remove all structural elements to which no graphic elements are associated.

Nodes are the start and end points of graphic lines. Elements of the image of all other types can be

attached to them. Nodes also play an important role when creating construction lines. For example, a

straight line passing through a knot at an angle to another straight line, or a circle centered at a knot.

Subassemblies play an important role in the creation of assembly drawings. Nodes can be linked to

the intersection points of construction lines, or located independently of them. Free nodes can also be

snapped to the grid, and can also be assigned precise coordinates in the drawing.

Node Parameters

As the parameters of the nodes, layer and level at which the node is located are set. You can use a

variable to set the level.

Color

When the flag is set in front of the color selection field, it is possible to determine the color for each

element, choosing the colors of the palette or setting the serial number of the color in the palette.

For free nodes, there are two parameters that determine their position:

X coordinate

Y coordinate

For semi-connected nodes, a parameter that determines the position of the node on the construction

line:

Coefficient (value from 0 to 1).

Default

If this option is checked, all settings will be used for newly created elements.
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Edit Node

Icon Ribbon

Keyboard Textual Menu

<EN> Edit > Construction > Node

The command Edit Node allows you to edit nodes.

After running the command, following options appear:

<Enter> Select the nearest node.

Select and edit the nearest node.

<*> Select all elements.

<R> Select a node from the list.

<Esc> Cancel selection.

<F3> Call command Zoom Window.

When you select a node using , the node will be highlighted, and also those elements of the

drawing that are associated with its construction will be highlighted. You can also select a node for

editing in the "Edit Graphic Line" command. When using the <N> option in the "Edit Graphic Line"

command, the system will automatically transfer you to the Edit Node command.

In the command for editing nodes it is possible to select anchors of a node: an intersection can be the

intersection of construction lines, the center of a circle, the intersection of two anchors (for example,

two perpendiculars), etc. Possible anchors are highlighted in color when you hover the mouse pointer

while the Edit Node command is active.

When deleting a node, on the basis of which other elements are built, the system issues a request to

confirm the deletion of elements that depend on it.

As in the case of other drawing elements, multiple selection is done by the option <*>, or by clicking

 while holding down the <Shift> key (adding to the list of selected), or <Ctrl> key (excluding form

the list of selected). Generally speaking, the following options are available in the command Edit

Node:

<Enter> Select new place for free nodes.

<P> Set selected Element(s) Parameters

<V> Mode of dynamic recalculation of model

<O> Create name for selected element

<J> Join free nodes
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<B> Break node

<F> Convert to free node

<N> Select existing node

<I> Select other element

<Del> Remove selected Element(s)

<F3> Call command Zoom Window.

<Esc> Cancel selection

The mode of dynamic recalculation is enabled by the  option. When enabling this mode the

node’s editing automatically leads to redrawing of the elements connected with the node. At the

same time preview of the elements is shown with the same quality as the final result. The mode of

dynamic recalculation of the model enhances the editing’s process intuitiveness. It can be used for

editing, for example, schemes, plans, etc.

Let us elaborate on the options  and . These options affect a group of nodes, one of which

can be constrained, and the rest - free. The option  unites several nodes into one, adjusting the

graphics accordingly.

 

The option  splits a node at a meeting point of multiple graphic entities. Each of the entities gets

its own node whose position you can modify. 

Keep in mind that free nodes are not recommended for use in parametric drawings. Drawings based

on free nodes are similar to those supported by other CAD systems, and lack the advantage of

parametric geometrical relations.

The option  is available for nodes, not related to construction entities (for example, nodes from

fragment or from 2D projection). This option allows breaking the relation between the node and its

original references by converting it into a free node, whose position will not change under

modifications to the original reference elements.

The option  is an additional tool for multiple selections. To add a node to the list of selected,

simply engage this option and pick the necessary node.

Changing the parameters of the node in the case of selecting one element is similar to setting the

parameters of the node.
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If you have selected several nodes for editing, then you need to set the parameters of multiple editing,

and then edit the parameters of the node directly.

Path

The command Construct Path is provided for constructing a 2D path.

The command is called by:

Icon Ribbon

Draw > Construct > Path

Keyboard Textual Menu

<PA> Construct > Path

A path is a construction line passing through a sequence of nodes. The segments between the nodes

can be straight lines or a portion of a construction entity between two given nodes. The following

construction entities can be used: lines, circles, ellipses, splines and other paths.

The following actions become accessible upon entering the command:

<Enter> Select a node or create a node at the nearest construction line intersection

<Ctrl><F> Connected node

<Ctrl><F> Free node

<P> Set selected Element(s) Parameters

<N> Select Node

<L> Select Line

<C> Select Circle

<E> Select Ellipse

<S> Select Spline

<F4> Execute Edit Construction command

<Esc> Exit command

The 2D path creation procedure consists of selecting 2D nodes forming a sequence. After selecting

the start node, you can select a construction line that connects this and the next node. Both nodes

must belong to this construction line.

The step-by-step process is as follows:

1. Select the start node;

2. Select a construction line connecting the start node with the end node (optional);

3. Select the end node.

Selecting the start node of the path as the end node completes the path creation.
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4. Confirm path creation or repeat the step 2. The end node selected in the step 3, becomes the

start node for the next segment of the path.

Upon selecting the start node and the first segment, you can do the following:

<Space> Select Graphic line

This option allows defining a path contour along graphic lines. Keep in mind that this approach can

only be used when the path segments coincide with the graphic lines. In the case of multiple selection

choices, the cursor should be pointing to the necessary graphic line when using the <Space> option.

To speed up the process, one can use the option:

<A> Find contour automatically

This option will search for the next path segment automatically until the contour is closed (in the case

of the closed path) or until reaches a dubious situation (when the path is ending or forking).

In both cases (when using the option <Space>, and upon automatic selection of the contour with the

help of ) the system can select, as a next segment, the graphic line located at some distance from

the last selected segment. This happens when the distance between neighboring nodes of graphic

lines does not exceed the search tolerance. It determines the maximum allowed distance between

nodes – line ends, for which these nodes are considered coinciding, and the graphic lines – connected.

The search tolerance can be changed with the help of identically named parameter in the properties

window.

One can define a path using the same operations as in graphic line creation. In other words, one needs

to define a sequence of path segment lines each having the start and the end node. To define the start

or the end of a path segment line, select existing nodes (the key <N>) or create new ones (the key

<Enter>) at intersections of construction line pairs

As in the case of graphic entity creation, an arc is defined by first selecting a node, and then the

construction circle by typing <C>.

Path by arc Path by two nodes

Otherwise, a straight line will be created between the two nodes as the path segment instead of the

arc. Including an elliptical arc or a spline or other curve segment in a path is similar to creating a

circular arc.

To define a path represented by a full circle, then without selecting any nodes point the cursor to the

circle and type  <С>. One can also construct a path from an ellipse, spline or other curve by using the

options <E> and <S>, respectively.

To reject the last input path segment line, use the option:
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<BackSpace

>
Delete last Contour segment

All three above-mentioned techniques can be combined when defining a path.

If the end node of a closed path coincides with the start node, then the contour automatically closes

and dehighlights, and an arrow is displayed in the end node indicating the direction of the defined

path. This signals that the path has been completed. 

A path can also be closed by using the option:

<Home> Close Contour

To complete definition of an open path, upon defining all segments use the option:

<Ctrl+Enter

>
Finish input

To cancel an action of path input, use the option:

<Esc> Cancel selection

Whenever two or more path segments are input in the command Construct Path, the right-click 

brings up the Right button action dialog box (this overrides the system settings).

In this dialog box one can: Cancel element creation, which is equivalent to <Esc> option; Cancel last

element selection, which is equivalent to <BackSpace> option; Finish element creation, which is

equivalent to <End> option. One can also set the flag Don't show this dialog in future. In this case,

the dialog box will not come back again, and the right-click  action will be the one set last

together with the Don't show this dialog in future flag, per the system settings.

The button [Return to Edit] brings the user back to 2D path creation mode.

Note that the same dialog is used in the Create Hatch command. A default  action setting

made in this dialog box in one of these commands will work in both commands. The selected

option will be used in all newly opened documents until the end of the application session. To

change the setting, close and reopen the application.

If the dialog box does not pop up upon  while in the command being described, and some action

is performed instead, then a default  action was already assigned earlier in the session within this

command or in Create Hatch.

Topics in this section:

· Path Parameters
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Path Parameters

When creating and editing  paths, it is often required to define various parameters.

Number of Point of Circle Approximation. This parameter is responsible for the smoothness of the

rounded sections of the path. 

Level. Places the path being created on the particular visibility level. Levels help hiding certain

elements from display. The level parameter can be assigned a variable.  

Layer. This parameter allows placing the path being created on a certain layer.  

Color. This parameter defines the color used for displaying the line.

Line Style. drop-down lists you can choose 1 of the options for displaying the line.

· Default

· Solid

· Dash

· Long Dash

· Dot Dash

Set as default. Setting this flag means, the current parameter settings in this dialog box will be used

from now on in construction line creation, with the exception of the Distance parameter.

Spline

Call the command Construct Spline:

Icon Ribbon

Draw > Construct > Spline

Keyboard Textual Menu

<SP> Construct > Spline

The following options become available to the user:

<P> Set Spline parameters

<A> Select axis of symmetry (Straight Line)

<O> Create Spline in Polar Coordinate System
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<G> Select Graphic line

Main Concepts

Splines are drawn basing on a set of points. If the location of points is changed, the spline shape

changes too. 

There are three types of splines in the spline building command:

· Spline;

· Spline by Polyline;

· Polyline.

Each of the three types can be closed.

Spline

Spline by Polyline

Closed Spline

Closed Spline by Polyline

Polyline

Closed Polyline

Spline. The spline goes through given characteristic points. 

Spline by Polyline. A broken line is built basing on the points, and the spline is built basing on the

line.

Closed Spline. A closed spline going through the given points. 

Closed Spline by Polyline. A closed spline drawn basing on the broken line specified by the

characteristic points.

Polyline. A first power spline.

Closed Polyline. A closed first power spline. 

The spline drawing command functional in construction lines and in a sketch is practically identical.

But there are some minor differences.

· Construction line spline has got no G1, G2, G3 smoothing which is connected with the

difference in parameterization mechanisms for sketches and construction lines.

· With a construction line spline you cannot bind to characteristic points of the spline, only to

construction line nodes which spline points can be bound to.

· A node can be bound to construction line spline if a relative displacement along the spline is

specified.

· A command for building a symmetrical construction line spline is in the automenu and works

the same way as it is for other types of construction line.

· The construction line parameters <P> Set Spline parameters are different from the ones for

sketch lines. 



Drawing Creation

375

Constructing Splines

Choose one of the six spline types. Specify the location of the characteristic points with . The

points can be bound to the nodes. The location of the points can be determined using object

bindings. The number and coordinates of the given characteristic points will be shown in the spline

parameters.

When building the spline a dynamic representation of the curve is shown on the screen. The last point

of the spline follows the cursor. When building the spline basing on a broken line, a representation of

the broken line is shown along with the representation of the curve. You can change the spline type

while drawing.

The spline power determines minimal number of points necessary for its construction. When building

a spline, its power grows automatically to the third, according to the number of the points added. By

default all the splines are built as cubic ones.

To finish spline input, use the option:

<Ctrl+Enter

>
Finish input

At double click  a special dialog appears.

This dialog enables you to finish building the spline, cancel it, cancel the last characteristic point to be

built or continue constructing. Single click  stops serial input of the spline characteristic points and the

spline is in the edit mode. You can continue setting the points with the help of  and  in the spline

parameters. 

 Create Spline in Polar Coordinate System option enables you to build a spiral line based on

three points. It is helpful for being compatible with previous versions of the software.

 Select axis of symmetry (Straight Line) option enables you to construct a spline symmetrical to

the initial one. After you call the option, choose a straight construction line and then the initial spline.

The spline built is parametric connected with the initial one: all the changes in the initial spline are

symmetrically shown.

 Select Graphic line option enables you to choose an image line for binding a spline point.

Spline Drawing

Spline command now supports a continuous curve input holding the left mouse button pressed, i.e.

implemented is the feature of spline painting.
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The spline points are added automatically according to the current image scale on the screen. Spline

generation accuracy by the cursor movement is set in the Options dialog in the Snap tab. Accuracy is

set in pixels, i.e. it depends on the current image scale in the working window.

Topics in this section:

· Spline Parameters

· Edit Spline

Spline Parameters

Spline parameters contain additional details on its characteristic points.

If a spline point is bound to the node, the node name is shown.

If parameters of the derivative at the point were changed for the

point, G1 limitation will be shown. If parameters of curvature at

the point were changed for the point, G2 limitation will be

shown.

The change of the access at the point parameter is shown with

the given icon.

If the point was put down, the given icon will appear.

Manual input of the coordinates is available for every point.

Command icons to create, delete and copy the spline points are available in the spline parameters. 

Add a point before the selected one. 

Add a point after the selected one.

Delete the selected point. 

Copy the selected point.

Paste the copied point after the selected one. 

The following parameters are available in this dialog, same as in other similar construction line

dialogs:

Level. Places the spline line at a definite visibility level. 

Layer. The name of the layer containing the spline line. 

Color. Sets the spline line color.
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Line style. There are variants: Default (dash), Solid, Dash, Long dash, Dash dot.

Point Parameters

Spline points parameters are available when editing the spline. You can choose the spline point from

the list in the spline parameters or at the spline itself with .

Length. The parameter sets the first derivative vector length. 

Angle. The parameter sets the first derivative vector angle. 

Radius of Curvature. The parameter sets the spline curvature radius at the point being edited.

Accuracy. The parameter sets the maximum possible deviation of the spline from the given point. 

All the given parameters of the point can be specified with the help of the manipulators at the

drawing. All the point parameters stated above are only available for the splines built by points. The

set of parameters for the splines built by a broken line or a polyline is smaller.

Weight. This parameter is only available for the splines built basing on a broken line. It determines the

degree of influence of the point on the spline. By default this value is equal to 1. 

Suppress. This parameter is available for the spline points of any type. If the flag is set or a value other

than 0 is entered, the point is excluded from the mathematical description parameters of the spline. 

Detailed information on the spline points parameters can be found in the subsection «Splines

Creation» of the sketch description section.

Additional

It includes three general parameters: the spline power, parameterization variant of the spline and

displacement variants at the start and at the end of the spline. Additional parameters for a polyline

are not available.

Spline Degree. The option is only available for changing when editing the spline. It varies from 1 (a

polyline) to 5. The range can be smaller, depending on the number of points. 

parameterization. It determines the mathematical method of spline description. There are the

following variants available: By length, Centripetal, Uniform, Local sums, Fixed.

Start extension and End extension. Displacement parameters are not available for closed splines. If

flags are set, options to specify spline extension intervals open before the first point and beyond the

last one correspondingly. 
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Control. It determines extension value input variant: By length or By Parameter.

Value. It determines the spline extension interval length. 

Extension type. It determines the mathematical method of extension interval description. The

following variants are available: By straight line, Keep curvature, Mirror, By parameter, By arc.

Details on additional parameters of the spline can be found in the subsection «Splines Creation» of

the sketch description section.

Edit Spline

There are two ways to start editing the spline.

Choose the spline with .

Call the context menu of the spline with  and choose the command:

 - Edit

When editing the spline all of its parameters and the parameters of its points are available, as well as

the spline points manipulators. To choose the necessary point you should specify it in the spline

parameters list or select the point at the spline being edited with . 

To move the existing point you should select the chosen point again with . After that the spline

point will move after the cursor. The new location of the point is set with  at the drawing. You can also

change the coordinates of the chosen point in the spline parameters.

To add a point to the spline you can use the commands  and  for adding the points or you can

specify the location of the new point at the chosen spline with . When pointing the cursor at the

spline interval being edited, where there is no point, a dynamic image of a possible new point

appears under the cursor. When creating a new point, it will be automatically selected. To build

several new points, just move the cursor along the spline and set the location of the new points with

. No additional confirmation of creating a new point is needed. The location of a new point is

changed similarly to editing the location of an existing one.

To delete a point you should select it and press an icon  in the spline parameters, or just press

<Del> button.

Offset Curve

Offset curves are created in the command Construct Offset Curve. The command is called as follows:
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Icon Ribbon

Draw > Construct > Offset Curve

Keyboard Textual Menu

<TO> Construct > Offset Curve

Offset curve is a curve offset from the original curve, at a distance specified by a number or function

(as a graph). If the offset is set by a number, i.e. it is constant, then such an offset curve will be

equidistant. The source curve can be an ellipse, spline, function, or path.

The most typical application of the offset curve is pipelines creation. It is convenient to draw only the

center line, and then build equidistant lines of the contours of the pipe itself. In addition, offset curves

are widely used in the development of the building and architectural drawings.

Creating Offset Curves

Upon entering the command, the following actions become available:

<Enter> Select element

<P> Set Construction Line parameters

<E> Select Spline

<S> Select Ellipse

<F4> Execute Edit Construction command

<Esc> Exit command

Creation of the offset curve begins with the selection of the base element, relative to which it is

necessary to construct the curve. The base element is selected using the cursor. 

The selected element is highlighted and the dynamically moving image of the offset curve appears.

The equidistant is build by default since the offset specified by the cursor is constant. After that, you

need to move the cursor to the necessary position and click  or use the option <P>. In the latter

case, the parameters dialog will appear on the screen. In the parameters dialog of the element in the

“Offset” parameter field, you can set the offset value from the base element. The sign of the

displacement determines the direction. When you use  upon the equidistant creation, the

parameters dialog does not appear on the screen. The value of the Offset parameter is taken

according to the position of the cursor. 
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The position of the offset curve, which is equidistant, can also be determined using the existing node.

To do this, select the base element for which you want to build an equidistant line, then the following

option will be available in the automenu:

<N> Select Node

You should select a node using this option. You can also select a node without calling the option

through binding.

To cancel actions for the selection of the base element use the option:

<Esc> Cancel selection

To build an offset curve with a variable offset, you should first create a graph. The graph argument will

specify the position of the point along the length of the original curve, the graph function will set the

offset for this point. The first value of the argument will correspond to the first point of the original

curve, the last value will correspond to the last point. Intermediate values of the argument will be

distributed along the length of the original curve according to their relative value to the first and last

value of the argument. The offset along the length of the original curve in the areas between the

points specified by the graph will be calculated according to the specified parameters of the graph:

by broken, smoothed or by function.  Detailed information on creating graphs may be found in the

Graph section of the T-FLEX CAD User Manual. 3D Modeling book. All graphs created in the file will

be available in the parameters dialog when the Graph option is enabled.
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Corners handling

Rounding By tangents By curves

There are 3 options for corner treatment:

· Rounding

· By tangent

· By curves

Offset curve parameters

Offset - sets the offset value of the equidistant relative to the selected construction line.

Extra clipping loops. This parameter enables the loop cutting mode. In this mode, all loops formed on

it are removed from the equidistant loop.

The Level, Priority, Layer, Name, Color of the construction line are set - equidistant.

Topics in this section:

· Offset Curve Parameters

· Editing Offset Curve

Offset Curve Parameters

The parameters of the offset curve can be set during the construction process and during editing. The

dialog window for setting the parameters of the offset curve is invoked using the option .
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Offset. The option sets the distance from the base element to the offset curve, in case the variable

offset specified by the graph is not used. The value can be a number, a variable, or an expression.

Graph. When setting a flag in the list, all graphics created in the document are available. A graph

allows you to build a curve with a variable offset.

Corners handling. The option allows selecting the variant of processing the angles appearing on the

displacement curve in the case when there were no rounded transitions on the initial path. Three

options are available: Rounding, By tangents, By curves.

Loops cutting. This parameter enables the mode of loops cutting. In this mode, all loops formed on

the contour of the offset curve are removed from it.

Create offset path. The option may be used when constructing the displacement curve from the path.

When the flag is set, the offset curve from the path will be converted to the path. The constructed

offset curve cannot be converted to a path. The option flag should be specified before construction is

completed.

Level. The option places the offset curve at a certain level of visibility.

Layer. The option allows setting the name of the layer to which the equidistant belongs.

Color. The option allows setting the color of the offset curve.

Line style. The following options are available: Default (dash), Solid, Dash, Long dash, Dash dot. A

different style is convenient for a visual distinction of the type of lines.

Sets as default. Setting this flag will mean that the parameter values specified in this dialog box will

be used for new construction lines.

Editing Offset Curve

There are two ways to enter the offset curve editing. 

In the command standby mode, point to the offset curve with the cursor and press  . 

In the standby mode of the command, call the context menu for the displacement curve and select the

command:



Drawing Creation

383

<F4> Execute Edit Construction command

The following options become available in the automenu:

<P> Set Construction Line parameters 

<V> Dynamic model regeneration mode

<L> Select Line

<C> Select Circle

<E> Select Ellipse

<S> Select Spline

<N> Select Node

<Q> Update all lines

<K> Break link with variable

<*> Select all elements

<T> Update selected elements

<I> Select Other Element

<Del> Delete selected Element(s)

<R> Select Fragment from list

<Esc> Exit command

Editing of an offset is none different from its creation.

Function Spline

The entities defined by a function are input via the command Function Spline 

Icon Ribbon

Draw > Construct > Function Spline

Keyboard Textual Menu

<FU> Construct > Function Spline

T-FLEX CAD enables users to create construction lines given by explicit mathematical description.

These lines are called functions. A function construction line enables users to define a construction
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line of virtually any kind. The main condition is the ability to define a construction line as a coordinate

functional relationship. To define a function it is necessary to specify its representation type

(parametric, explicit etc), the starting and the ending points of the parameter to be measured,

different parameters of detailed curve.

The system makes a provision for choosing pre-described functions defining various curves (parabola,

evolvent, helix etc). You can also define your own functions manually and use them in the future. In this

case you need to create a description file of add new formula and parameters set in the function

parameters setting dialog window to the existing one.

The function construction line can be drawn as a polyline or spline.

The following options are available to the user:

<Enter> Select nearest node or create node defining the function coordinate system

<Ctrl><F> Connected node

<Ctrl><F> Free node

<P> Set entity Parameters

<N> Select Node

<A> Select axis of symmetry axis (straight line)

<F4> Edit Construction

<Esc> Exit command

Drawing of the given function involves two steps: 

· To define the coordinate system location (XY). With the help of coordinate system you will be

able to locate the resulting line in the drawing as required. Coordinate system is set by

successive choosing two nodes. The first one defines the point with the coordinates (0; 0). The

second one defines the direction of the abscissa axis (X). The ordinate axis (Y) is defined

automatically, based on the origin of coordinates and the X axis location.

· To set the function type and other parameters. That is done in the function parameters setting

dialog window popping up after choosing the second node.

You can use two ways to set a functional relationship. 

· To use a pre-defined formula from the given set.

· To create a new function.

Users choose the pre-defined functions via a list. The set of pre-defined functions is stored in the file

“function.dat”. The file name is defined in the item Function spline files of the command Set System

Options tab Files. The file “function.dat” can be edited or replaced, if necessary. The parameters in this

file are denoted as follows: #1 is the first parameter, #2 is the second one (it is not always needed and

is constant for the function calculated). These parameters will be described in detail further on. 



Drawing Creation

385

After inputting all the function parameters you should close the function parameters dialog by

pressing OK. The function line will be drawn. 

Topics in this section:

· Function Spline Parameters

· Editing Function Spline

Function Spline Parameters

Following parameters are set in the dialog:

Name. You can choose a standard function name from the list or set a new name for a new function.

Type. You can choose one of the four variants.

· Plain. A Cartesian coordinate system function which sets a low of variation of the ordinate, and

the abscissa changes at some pitch in the given range. 

· Parametric. A Cartesian coordinate system function which sets a low of variation of both the

ordinate and the abscissa.

· Polar. A polar coordinate system function which sets a low of variation of the polar radius and

the polar angle changes at some pitch in the given range (in radians).

· Polar Parametric. A polar coordinate system function which sets a low of variation of both the

polar radius and the polar angle (in radians).

Y=, X=, P=, A=, The fields for inputting the low of variation for function ordinate and abscissa and for

polar radius and angle. In case you choose a function from the list, the fields are filled in

automatically. Otherwise you have to fill in the fields according to the syntactical rules.

· Y= - entry field for the variation low of the ordinate.

· X= - entry field for the variation low of the abscissa.

· P= - entry field for the variation low of the polar radius.



T-FLEX CAD 17 Help

386

· A= - entry field for the variation low of the polar angle (in radians).

· «#1» – the first parameter of the function. 

- For the Plain function type it is the variable of abscissa variation (in millimeters in the given

range).

- For the Parametric function type it is the parameter for Y= and X= fields, which varies in the

given range.

- For the Polar function type it is the variable of polar angle variation (in radians in the given

range).

- For the Polar Parametric function type it is the parameter for P= and A= fields which varies

in the given range.

- In case you choose the values from the database field it is the variable of the database line

number.

·  «#2» denotes the second parameter of the function. It is the distance between the nodes

defining the coordinate system. When calculating function line it is constant. If the distance

between the nodes changes, the constant #2 changes too. 

· «*» - multiplication, «/» - division, «**» - powering.

· «+» - addition, «-» - subtraction.

· Point divides the integral and the fractional parts.

· Two variables can be used in one function or in one field if necessary. 

· Variable names of the document can be input in the fields considered, but the function

variable name is always «#1». 

· Variable editor function denotations can be used in the fields considered. 

· A selection of values from the database can be used in the fields considered. An expression

«q.#» which returns the number of the last line in the database «q» can be used as a finite

value index (final entry in the database «q»).

In this case the parameter «#1» will define the database line number.

Start and Finish. Set the variation range of the function parameter #1.

Symmetry About Axis X. Option flag enables users to create a symmetrical reflection of the line

drawn relative to the X axis of the function coordinate system.

Scale of Axis X and Scale of Axis Y. These parameters enable users to change the scale of each of the

function coordinate system axes. The coordinate of every point used for drawing the function curve is

multiplied by the corresponding scale factor.

Change on Transformation. Setting the option on enables an automatic change of scale when scaling

transformation is performed on the function curve (when copying or moving). Setting the option off

disables automatic scaling relative to the axis.

Polyline generation group. This function can represent a polyline or a spline drawn based on the

polyline. This group defines the parameters of the polyline.

Equal steps. The function parameter changes from the start value to the end one at a constant pitch.

Number of steps. The number of steps determines the number of polyline segments: the number of

points (equal to the number of steps) is always one point more than the number of segments.

If polyline point coordinates are calculated using a database, the value of the variable

parameter is usually the line number in the database. In this case, the current value of the

variable parameter is replaced by the largest integer less than or equal to it. As a result, data

could come at uneven steps from the database. To avoid this, always define the function

parameters in such a way that the number of steps was equal to the difference between the end

and the start values of the variable parameter.

Optimized to curvature. Enables users to obtain a more frequent division into segments at the

intervals with higher curvature.
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Tolerance. Determines a maximum possible deviation of the calculated polyline coordinates from the

coordinates of the real curve when using the Optimized to curvature option.

Generate Spline from polyline group. Setting the flag on transforms the function line from a polyline

into a spline drawn basing on it.

Open. The first and the last points of the spline correspond to the calculated abscissa and ordinate of

the function at the start and end values of the function variable «#1».

Closed. The first and the last points of the function (if the function is not a closed curve) are connected

by a spline interval.

Construction line parameters group.

Level. Moves the function line to a certain level of visibility.

Layer. Layer name which the function line belongs to.

Color. Defines the function line color.

Editing Function Spline

There are two ways to enter the function editing mode.

To choose a function line with .

To call a function line context menu with   and choose the command:

<F4> Execute Edit Construction command

When editing you can redefine the nodes setting the coordinate system. Choose the node with 

and set its new location.

When editing the following options are available in the automenu:

<P> Set Function Spline Parameters

<V> Dynamic model regeneration mode

<L> Select Line

<C> Select Circle

<E> Select Ellipse

<S> Select Spline

<N> Select Node

<Q> Update all lines

<K> Break link with variable

<*> Select all elements

<T> Update selected elements

<I> Select Other Element
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<Del> Delete selected Element(s)

<R> Select Fragment from list

<Esc> Exit command

All the function parameters are available for editing in the element parameters dialog  <P> Set

entity Parameters.

Edit Constructions

The command is called as:

Icon Ribbon

Draw > Additional > 2D Construction

Keyboard Textual Menu

<EC> Edit > 2D Construction

The Edit Construction command is provided for editing construction lines. It is one of most often used

commands. This is the command that supports creation of new drawing configurations by providing a

dialog box for varying necessary construction parameters. The command allows editing all kinds of

construction entities.

To modify location of some construction entity, simply select it using , move the cursor over the

necessary location, and click  again. To specify the exact value of the placement parameter, use

the property window or the parameters dialog box via the  option. If the entity was driven by a

variable, the system will output a warning. 

To avoid the system warnings, call the option <P>  before selecting any entities. A dialog box will

come up, in which the item Auto change Variables needs to be checked. 
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To edit the parameters of several selected construction elements, use the <P> option.

If you have selected several elements for editing, then you need to set the parameters for multiple

editing, and then edit the parameters of the constructions directly.

In order for the value of construction line parameters to be set again by constants, and not by

variables, use the <K> option after selecting one or several (all) elements.

When modifying the values of construction parameters it is possible to use Relations that appear on

element selection. These Relations are temporary. They will automatically disappear on editing finish.

To modify the values of construction parameters with the help of Relations it is necessary to turn off

“Dynamic recalculation” mode (option , see below).

 

It is possible that some construction entity can't be recreated after modifying parameter values due to

geometrical incompatibilities among the entities. In such a case, the system will output an error

message and specify the particular failing relation.

 

The selected line is highlighted on the drawing. Besides, other construction entities are highlighted

that were used as references for the line creation. The following options are available in the command

Edit Construction:
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<P> Set Construction Line parameters 

<V> Dynamic model regeneration mode

<L> Select Line

<C> Select Circle

<E> Select Ellipse

<S> Select Spline

<N> Select Node

<Q> Update all lines

<K> Break link with variable

<*> Select all elements

<T> Update selected elements

<I> Select Other Element

<Del> Delete selected Element(s)

<R> Select Fragment from list

<Esc> Exit command

The option  (<K>) allows switching all parameters of the selected construction line from

dependency on variables to the constant values.

The option <O> allows specifying names for construction lines in order to define advanced

parametric dependencies. Such a name will help exactly identify a construction line and, in particular,

directly access certain proprietary data of the line in the variable editor via the command "Edit

Variables", using the function "get". The name is not required for common situations of parametric

design.

If for some reason you would like to modify the existing relations between the construction lines, this

can be easily done using the  option.

Option  - Update all lines trims the construction lines of lines and circles. Construction lines are

represented as lines or arcs bounded by nodes.
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With multiple selection, you can use the options:

<P> Set selected elements(s) parameters

<K> Break links with parameters

<T> Update selected lines

<I> Select other elements

<Del> Delete selected elements

<Esc> Cancel selection

When selecting one item, you can use the following options:

<Enter> Set new line position

<P> Set Construction Line parameters 

<L> Select Line

<C> Select Circle

<Tab> Change circle orientation

<N> Select Node

<O> Change name of construction element

<M> Modify Construction Line Relations

<T> Update selected elements

<K> Break link with variable

<G> Apply snapping to a node
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<B> Cancel snapping to a node

<I> Select Other Element

<Del> Delete selected Element(s)

<F3> Call command Zoom Window.

<Esc> Exit command

<Shift> + 

<Enter>
Select construction element for edit

The name of the construction line, which you can specify using the  <O> option, is necessary for

solving complex parametric problems. This name will allow you to accurately identify the construction

line and, in particular, will allow you to directly get any internal data about this line in the Variable

Editor using the get function. For regular parametric design, a name is not required.

Changing the relation between construction lines

You can change the relation between construction lines using  <M> Modify Construction Line

Relations. Let's see how this option works using an example. After selecting a construction line, you

can press <M> to change the construction method. After you have selected the <M> command, you

can modify this line. The difference from the line without using the <M> option is that the changeable

line and the one relative to which it is drawn remain selected on the screen. The only limitation when

changing the relation between construction lines is that there should not be a recursive assignment,

that is, the line should not be specified through itself. In this case, a message will appear and the

change will be canceled. With this exception, you can change the relations between any lines, circles,

ellipses, and splines.

Another way to change the relationship between construction elements is to use the Replace

command.

With the help of this command you can re-bind a chain of construction elements, built relative to

some direct element, to another construction element.

Topics in this section:

· Edit Circles

· Edit Path

Edit Circles

Besides, when editing a circle tangent to two lines, the automenu gains additional options for setting

and clearing a link with a node:

<G> Apply snapping to a node

<B> Cancel snapping to a node

The option  is used for constraining a circle, tangent to two lines, by an additional node defining

the tangency configuration. Upon calling the option, select the necessary node by clicking . The
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circle will be reconstructed as the result of using this option to pass as close to the node as possible.

This allows to uniquely define the circle location with respect to the reference lines.

The example below explains the use of this capability. The location of the lines on the drawing is

defined with respect to the symmetry axis using a parameter K. Both circles are constructed tangent to

the two lines. Besides, the solid-drawn circle is "linked" to the highlighted node. Meanwhile, no

reference node is defined for the second circle. Originally, with the variable K=1, the drawing looks

like shown on the diagram on the left-hand side. The right-hand side diagram shows the drawing

modification per the new variable value К=-1. The circle linked to the node adjusted correctly. The

second circle that did not reference any node, flipped with respect to the symmetry axis.

To release or re-assign a link with a node, use the option .

Edit Path

Path editing allows you to add or remove anchor points; choose another construction line connecting

the nodal points of a separate section of the path; change the direction of the path, change the

numbering of points, as well as set new parameters.

You can select the path for editing by pointing to it with the cursor and pressing, by pressing again -

we select the editing area. As a result, the selected path, the editing area and its anchor points are

marked.

Modifying relations between construction lines

To modify the type of a particular path segment, do the following steps: 

· Select a path ;

· Using the mouse , select the path segment whose type needs to be modified; 

· Select  a construction entity defining the new type of the path segment: line, circle, ellipse and

spline (including other 2D paths). Selection of a construction entity is done using the appropriate

option. The end nodes of the path segment being edited must belong to the selected construction

entities;

·  Exit the particular path segment editing mode by right-clicking  or pressing <Esc> on the

keyboard.

·  Confirm changes by the option 
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Creating additional nodal points on the path contour

To create additional nodal points of the path contour, you must perform the following set of actions:

· choose a path ;

· select a site for editing ;

· select the option Add point mode;

·

<I> Add new points

· select the position of the new point ;

· exit edit mode ;

· accept changes  or <Ctrl + Enter>.

Deleting a node inside path contour

To remove the nodal point of the path, you must perform the following set of actions:

· choose a path ;

· select a section of the path  that is limited by the node that you want to delete;

· select a node ;

· press the <Del>;

· accept changes  or <Ctrl + Enter>.

Consider an example in which a straight section of the path must be replaced by a section along an

arc of a circle. In this case, the points of tangency of the circle do not coincide with the points of start

and end of the rectilinear section.
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· choose a path ;

· select the section of the path  that you want to change;

· select and move the first node of the site to the point of tangency of the line and the circle

(moving the node is described in the subsection above);

· select and move the second site node to the point of tangency of the line and the circle;

· select the section of the path  that you want to change again;

· select the type of line according to which the path should follow (in this case, a circle);

·

<C> Select circle

<E> Select ellipse

<S> Select spline

· indicate the line  (in this case, the circle) in the drawing;

· accept changes  or <Ctrl + Enter>.

Displaying the contour point numbers

To toggle the display of the contour point numbers of a 2D path, use the option:

<Q> Show/Hide contour point numbers

With the option turned on, the points in the path are enumerated based on their position in the path

and the path direction. A point number is displayed next to the respective node. When several

subsequent points of a contour coincide, their numbers are displayed next to each other, separated by

commas.

With the option turned on, the points in the path are enumerated based on their position in the path

and the path direction. A point number is displayed next to the respective node. When several
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subsequent points of a contour coincide, their numbers are displayed next to each other, separated by

commas.

Delete contour

To delete a contour, use the option:

<Del> Delete selected contour

Edit closed paths

For closed paths, three additional options are available, to call them you need:

· choose a path ;

· choose any section of the path ;

· choose one of the three options below;

· accept changes  or <Ctrl + Enter>.
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<R> Change the direction of the path to the opposite

<F> Move start point forward

<B> Move start point back

Element Replacement

The command  Replace Element can be called by one of the following means:

Icon Ribbon

Edit> Edit > Replace

Keyboard Textual Menu

<RL> Edit > Replace

Let us reiterate that parametric properties of T-FLEX CAD models are managed by applying drawing

elements over the construction entities. Meanwhile, all construction elements are defined using various

geometrical relations with several base elements. This array of references from one element to

another makes the model parametric. The command Replace Element allows replacing a construction
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element by an element of the same type, that is, replacing all references to the original element in the

model by references to another construction element. If necessary, the original element can be

automatically deleted from the model upon the replacement.

Upon calling the command, the following options become available in the automenu:

<L> Select Line

<C> Select Circle

<E> Select Ellipse

<S> Select Spline

<N> Select Node

<I> Select Other Element

<Del> Delete Source Element After Replacement

<Esc> Exit command

Let's review the use of the command on a simple example. A hatch is created in the drawing, whose

contour was defined by a circle. We need to modify the model so that a different circle, "Circle 2", is

used in the future instead of "Circle 1".  That's use the command Replace Element for this purpose. 

When using this command, the first step is selecting the source element. 

In the example, it is a circle. It can be selected using the option . The selected element will be

highlighted in the drawing. When working with drawings crowded with elements of the same type,

one can miss the selection. The option  helps selecting a neighboring element in such a case. It

cancels the last element selection and highlights the element of the same type nearest to the previous.

 Next, you need to select the target element of the same type for replacement.
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When selecting such element, only the elements of the same type as the source element will be pre-

highlighted in the drawing. The only option available in the automenu will be the option for selecting

elements of the respective type. In this example, select the "Circle 2". Upon selecting the source and

the target construction element, confirm the element replacement using the option:  <End>

Replace Element 

In the course of the replacement, all the elements constructed relative to the source element are

rearranged with respect to the target one. In this example, it was the hatch.  If necessary, the source

construction element can be deleted from the model upon the replacement. The mode of deleting the

source element is turned on by the icon .

Parameters of construction elements

Common parameters for all construction elements (including splines and functions) are layer and

level, with which you can control the visibility of constructions.

Color. When the flag is set in front of the color selection field, it is possible to define the color for

each construction line by choosing the colors of the palette, or by specifying the ordinal number of

the color in the palette.

For some elements in the parameter window, you can set a numerical value:

· for straight lines, this can be the distance from the original object or the angle of rotation of

the straight line;

· for circles - radius or offset;

· for ellipses - the length of the semiaxis;

· for equidistant lines - offset.

You can use variables to set a numeric parameter.

For lines, you can also set how the line is displayed on the screen. This parameter is selected from the

presented list.

The parameters of splines and functions should be considered separately.
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Graphic Lines

Graphic lines are the base graphic elements that constitute the drawing image. The analogy for the

graphic lines found in conventional drafting is the lines drawn in ink. Graphic lines are created based

on construction lines and nodes. By "lines", we mean straight or curved line entities described below.

The various types of graphic lines can be defined by: 

· A line segment between two nodes. The graphic line limits are defined by the location of

these nodes.

· A full construction entity. This graphic line can only be defined by the underlying construction

entity. The construction entity can be of any type except straight line as the latter is infinite.

· A portion of construction entity between two nodes. This type of graphic entity is defined by

the underlying shape-defining construction entity and two nodes defining the line limits.

Graphic entities can be created with user-defined line types. See details in the chapter Creating

Custom Lines and Hatches.

Basic rules of graphic line creation

The user is encouraged to follow a few rules when creating graphic line entities:

To avoid errors when creating a parametric drawing, use the option <N> for applying graphic lines.

Do not use the <Enter> option if there are more than two construction entities intersecting in one

point. 

If there is a selected node, then it will be used as the start for a graphic line.

If a node is selected and user attempts to select a construction line entity, it has to be a line passing

through the selected node.

If a node and a construction line are selected, and the user selects another construction line, then a

graphic line will be created, starting in the selected node and ending at the intersection of the

selected lines.

If two construction entities intersect in more than one point (for example, a line and a circle), then the

nearest intersection is selected to the graphic cursor location at the time of pressing the option key.

If selecting a construction line entity results in nothing, that means, the lines do not intersect and the

graphic line can't be created.

Using grid in "free" drawing mode

If snapping to grid is turned on, then the start and end nodes of the graphic line will be snapping to

nearest grid knots. The grid parameters can be defined using the command "Customize > Grid…". The

grid can be assigned different steps in the vertical and the horizontal directions, and different shifts

with respect to the origin in each direction. When creating a graphic line, the status bar displays the

coordinates of the nearest grid knot to the current mouse cursor location. In the "free" drawing mode

with grid snapping turned off, a graphic line can be created at an arbitrary location in the drawing

area. It does not require constraining to any construction lines.

Topics in this section:

· Types of Graphic Lines

· Sketch

· Constraints

· Examples
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Types of Graphic Lines

Graphic lines are created in the command Create Graphic Line. Call the command via:

Icon Ribbon

Draw > Draw > Graphic Line

Keyboard Textual Menu

<G> Draw > Graphic Line

The Image command allows you to draw graphic lines. There are 2 drawing modes: constrained

drawing mode and free drawing mode. You can also create custom graphic lines. Snapping

and graphic lines are drawn to construction elements (lines, nodes), to the points of articulation of

graphic lines constructed using the Sketch command or belonging to 2D projections.

There are the following types of graphic lines.

· A straight line segment between two nodes. The beginning and end of the graphic line are

determined by the position of these nodes.

· Complete construction line. Such an image line is specified only by a construction line. A

construction line of any type can be used as a reference construction line, except for a straight

line (since it is infinite).

· A section of a construction line bounded by two nodes. Such an image line is defined by a

construction line that defines its shape and two nodes that define its boundaries.

You can use graphic lines to create chamfers and fillets.

After calling the command, the following actions are available:

<Enter>
Select a node or create a node at the closest intersection of

construction lines

<Ctrl><F> Free mode off

<Ctrl><F> Free mode on

<P> Set Graphic line Parameters

<Alt+P> Copy Properties from Existing Element

<Tab> Change arc direction

<N> Select ending Node of Graphic line

<L> Select straight Construction Line

<C> Select Construction circle

<E> Select full Ellipse Contour

<S> Select full Spline or Polyline Contour
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<Q>
Creation of graphic lines between two intersections of construction

lines

<BkSpace> Delete last Contour segment

<F4> Execute Edit Graphics command

<Esc> Cancel selection (available only when selecting a construction entity)

You can apply different types of image lines:

· Section

· Circle

· Arc of a circle

· Ellipse

· Ellipse arc

· Spline, equidistant, curve defined by function

· Arc of a spline, equidistant, a curve given by a function

Selecting a drawing mode. Free mode on and free mode off drawing modes.

Options  and  <Ctrl> <F> allow you to select one of two modes for creating construction

elements - nodes in the T-FLEX system. Either main mode (free mode off drawing), in which the

created node is the intersection point of construction lines, or free mode on, when the node is not

connected to other structural elements, and its position is determined by the absolute coordinates of

the drawing. In this case, both free and connected nodes can be present in the same drawing. When

creating a graphic line, nodes can be created automatically, so it is always important to know which

drawing mode is set. The icon in the automatic menu not only allows you to switch the mode, but also

signals which mode is currently set. If an icon  is present, then the free mode off is enabled, if the

icon is , then the free mode on is enabled. In addition to the icon, the appearance of the cursor

and the nodes being created will help in determining the drawing mode. If the cursor and nodes are

drawn in the form of a cross, then the linked drawing mode is enabled, if in the form of a square - the

free drawing mode.

The  (<BkSpace>) option removes the last plotted area of ??the graphic line. After that, you can

continue to create graphic lines.

Automatic Creation of Graphic Line between Two Intersections of Construction Lines

The option  is intended to enable/disable the mode of creating graphic lines between the

intersections of construction lines. This mode allows you to create an image line passing along the

construction line in the area between its intersections with other construction lines, with one click.

To create a graphic line, move the cursor to a construction line (straight, circle, ellipse, spline, polyline)

intersecting with other construction lines, and click . Depending on the location of the cursor, the

system finds the two nearest intersection points of construction lines and creates a graphic line and

nodes at its ends. When several lines intersect at one point, a node is created between the lines

created earlier than others.
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If in this mode, holding down the left mouse button, move the cursor along the construction line, then

the construction line will automatically continue (or shorten) in the required direction.

Double-clicking on a construction line creates a graphic line on the entire construction line (except for

a straight line).

If a graphic line was created using this command, then you cannot recreate a graphic line of the

same color at that location. If necessary, you can change the line color or hide the previously

drawn line.

Copy parameters from existing lines

The values of the parameters of the created graphic line can be quickly copied from an existing line.

To do this, you need to use the option:

<Alt+P> Copy properties from existing element

This option is available in the command automenu before the line is created, or during the

creation process.

After calling the option, it is enough to indicate the graphic line, the parameter values of which must

be passed to the created line.

In order for the copied parameter values to be assigned to all new lines, an additional option must be

enabled before selecting the original graphic line:

<S> Set properties as default

If this option is enabled, the copied parameters will be saved as default parameters.

This option simplifies the creation of graphic lines with the same parameters. However, it does

not allow you to copy individual parameters or parameters from an object of a different type. In

such cases, it is more convenient to use the general mechanism for editing the parameters of

elements in the properties window.

Creating a new line type

To add custom line type to the standard line types, just place the new line type description file in the

...\Program\LinePatterns folder. As such a file, you can use an ordinary T-FLEX CAD drawing, made in

compliance with some conventions. The description contains an image of the period (repeating part),

beginning, end and middle part. Period description is required. Special named nodes are used to

describe the keypoints of the line type. Automatic search of the hatch contour works along the lines

created by the user.
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When editing, deleting, or creating new linetype description files, they automatically appear at the

end of the linetype list. When using a new linetype in the document, the link to the original file is not

established. So, the line type is not lost when transferring a file to another computer where there is no

such type.

In general, to create a graphic line, you need:

· specify the starting node;

· specify construction line (optional). If the construction line is not selected, then the graphic line

will be a segment passing from the start to the end node.

· specify the end node.

Selecting a starting node

The (<Enter>) option allows you to mark a node as the start or end point of a graphic line. In

linked drawing mode, clicking  marks a node at the closest intersection of construction lines, if it

exists; otherwise, a new node is created and marked at this point. In freehand mode, either a new node

is created, or an existing one is marked. An existing node is flagged if the graphic cursor was within

the node detection area. The size of this zone is set in the Node Joint Distance (pixels) parameter of

the "Options" > "2D" command. The size of the zone is set in pixels.

Thus, if there are no selected nodes and construction lines, then the option  selects the nearest

node. Further, from the selected node to the mouse cursor, a dynamic image of the created line is

drawn. In linked drawing mode, either the nearest node or the closest point of intersection of

construction lines is searched, and a node is created at this point. In free drawing mode, the nearest

node is searched for - a node within the detection zone. If, when pointing with the cursor, a node

enters this zone, then it is marked. Otherwise, a new free node is created.

Option  (<N>) works similarly to option , but unlike it, only existing nodes can be checked.

No new nodes are created.

The following variant of determining the initial node is also possible: the construction line is selected

(options <L>, <C>, <S>, <E>). After specifying the element, an image of the node dynamically

moving along the selected line will appear. Then the second construction line is selected - the initial

node will be highlighted at the point of their intersection closest to the cursor (if the node was not

there, then it will be created). In this case, marking the construction line means that the initial node of

the future graphic line will necessarily be on this straight line. In this case, the second construction line

will remain highlighted and will be considered selected for creating the graphic line.

If the selected construction lines do not have intersection points, then no action is taken.

It should be noted that the junction point of the "2D fragment" or "2D projection" image lines can be

selected as the start/end node.

Selecting a construction line

The selection of the construction line is carried out using one of the options:
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<L> Select construction line - straight

<C> Draw a circle

<E> Draw an ellipse

<S> Draw a spline 

It should be noted that when object snapping is enabled, construction lines will be available for

selection by simply hovering the mouse cursor over them (in this case, the element will be highlighted

and an on-screen tip indicating its type and identifier will appear), so the use of automenu icons is

optional.

Option  (<L>) allows to mark the construction line as a straight line. The operation of this option

depends on the current state (whether there is already a marked node or construction line).

Option  (<C>) allows to mark construction line - circle. If there is a marked node, then pressing

<C> means creating an arc.

Option  (<E>) allows to mark construction line - ellipse. If there is a marked node, then pressing

<E> means creating an arc.

Option  (<S>) allows to mark construction line - spline. If there is a marked node, then pressing

<S> means creating an arc.

If only the starting node is selected, then only those construction lines on which the already marked

node is located will be available for selection. The starting node remains marked and the node cursor

begins to move along the selected line. This means that the end node of the future graphic line can be

selected at the intersection of this line with another construction line (if there is no node at the

intersection point, it will be created automatically).

Selecting an end node

The options for selecting an end node depend on the selected items.

· The starting node is selected. Options  and  (<N>) create a graphic line - a straight

line segment from the first selected node to the node selected or created when using them. In

this case, the second node is marked and the cursor is anchored to it with a dynamic display of

the line. The construction line selection options allow you to specify the end node of the

graphic line belonging to the specified line.

· The start node and construction line are selected. The  and  (<N>) options allow you

to specify an end node belonging to the selected construction line or create it at the

intersection point with another construction line.

Construction line selection options allow you to select (create) an end node at the intersection point

of the selected construction elements (already selected construction line and newly specified). An

image line is drawn from the initial node to the newly selected node (a straight line segment or an arc,

depending on the construction line previously selected). In this case, the newly selected node and

construction line are marked. The node cursor moves along the last selected line. If the specified lines

do not have intersection points, then no action is taken. This method is convenient to use in the case

when several construction lines intersect at one point, and the graphic line must end at the point of

intersection of two specific lines.
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When you select a line to draw a circle or ellipse in the automenu, the icon  (<Z>) becomes

available, with which you can change the direction of the arc to the opposite.

Graphic Axis Line

The Axis is a line segment with a dash-and-dot line type. However, the linetype cannot be changed.

Basic rules for constructing graphic lines

The user needs to remember a few basic rules:

· If you want to avoid mistakes when building a parametric drawing, then use the <N> option

to draw graphic lines. It is not recommended to use the <Enter> option if more than two

construction lines intersect at one point.

· If there is a selected node, then the graphic line always starts at this node.

· If you try to select a construction line with a selected node, then the selected node must

belong to the selected line.

· If, with the selected construction line and the selected node, another construction line is

selected, then a graphic line is created that starts at the selected node and ends at the

intersection of the selected lines.

· If the construction lines have more than one intersection point (line and circle), then the point

is selected, to which the graphic cursor was closer at the moment of pressing the key.

· If nothing happens when you select a construction line, then in this situation the lines do not

have intersection points and it is impossible to build an image line.

Using a grid in freehand drawing mode

If the snap to grid mode is set, then when you enter the end points of the graphic line, they will be

located at the nearest grid nodes. You can set the parameters of the grid using the "Grid" command.

For the grid, you can set a different step along the vertical and horizontal axes, with different offsets
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relative to the origin of coordinates on both axes. The snapping to the grid will be performed

regardless of Swhether the grid is visible on the screen or not. When you enter a graphic line, the

system panel displays the coordinates of the closest grid node relative to the current position of the

mouse cursor. If the free drawing mode is enabled and the snapping to grid mode is not set, the

graphic line can be created in an arbitrary place in the drawing area. It does not require anchoring to

any construction lines.

Intersection

Icon Ribbon

Draw > Draw > Intersection

Keyboard Textual Menu

<II> Draw > Intersection

For intersection, you can select the type.

To change the intersection, activate the line Intersection command and select a line that has

intersections with other lines.

In this case, a gray circle appears at the intersections, showing active intersections.

Next, you need to select and click on the gray circle, while it will become active, this is evidenced by

its changed color - green.
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Now you can change the shape of the intersection in the command parameters. After all the

parameters are configured, you can complete the operation .

For some forms, an option is available in the automenu:

<Z> Switch

This option allows you to change the direction of the intersection shape.

Topics in this section:

· Drawing Modes

· Chamfer and Fillet

· Creating Custom Lines and Hatches

· Automatic Contour Search Mode

· Graphic Line Parameters

· Edit Graphic Line

Drawing Modes

The mode of drawing a drawing using graphic lines is controlled by the command  Settings >

Customize > Snap > Free Drawing (<Ctrl> <F>). If the icon is in the pressed state, then the 'free'

drawing mode is enabled, otherwise - linked. Also, the icons that control the drawing mode are

located in the automenu in the commands using it.

Free mode off (parametric) drawing

Free mode off drawing is the main mode for building a parametric model. In linked drawing mode,

nodes are created only at the intersection of two construction lines. This mode corresponds to the icon

 at the top of the automatic menu of any command where a node can be created.
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Free mode on (nonparametric) drawing

Free mode on drawing - is an auxiliary drawing mode. Freehand nodes will be created at the absolute

coordinates where the cursor is, not at the intersection of construction lines.

Free drawing mode corresponds to the icon  at the top of the automatic menu.

Note

Switching from one mode to another is carried out:

· in the automatic menu - by clicking on the corresponding icon;

· using the <Ctrl> <F> key;

· in the text menu Settings > Snap.

It is recommended to use the free mode off drawing when working with a drawing and not to use

both modes in the same drawing. This can lead to errors when parametrically modifying the drawing.

Chamfer and Fillet

Icon Ribbon

Draw > Draw > Chamfer

Keyboard Textual Menu

<FE> Construct > Chamfer

The command allows you to create various types of fillets and chamfers without preliminary

construction. This modifies the existing elements of the drawing and creates new ones.

When the command is called, the Chamfer Parameters appears, where the user can select the type of

chamfer and set its parameters.

Further, using the automenu options, it is necessary to select the nodes or graphic lines that are

decisive for the formation of the chamfer.

<P> Set command options
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<N> Select Node

<Space> Select Graphic line

<Esc> Exit command

T-FLEX CAD supports three main techniques of creating chamfers:

Chamfer creation by a node through which the hatch contour is passing 

This technique is intended mainly for creating chamfers at the drafting stage when the graphic lines

are not created yet. A chamfer created in this way is drawn as a construction entity.  Later, you will

have to apply graphic lines over this chamfer manually. On the other hand, if the graphic lines were

created before introducing the chamfer, then the chamfer will be displayed as a graphic entity. This

technique is intended for constructing only isolated chamfers. Therefore, when constructing chamfers

on the surfaces of revolution or two-sided chamfers on the edges of faceted parts, you will have to

add the missing construction lines manually.

Remember that this chamfer creation technique works only in the case when the parameter is set

among the operation parameters, Auto change Hatches.

After selecting the type of the chamfer being created and defining the necessary parameters, you

need to select the node at which the chamfer will be constructed. This is done by the option .

The selected node must belong to a hatch contour. Upon selecting the node, the chamfer and the

construction entities used for its creation are constructed automatically according to the specified

parameters.

The direction of creating the angular chamfer is determined by the system automatically (depending

on where the hatch contour lies).

Chamfer creation by the node through which two graphic lines are passing 

This technique is used when the graphic lines are already applied on the drawing. A chamfer created

in this way is drawn as a graphic entity. All construction entities necessary for the chamfer creation are

produced automatically.

When creating a chamfer in this way, make sure that no more than two graphic lines are passing

through the selected node. Otherwise, we recommend using another way of chamfer creation,

described below.

To create an isolated chamfer, in the operation parameters select the necessary chamfer type and set

the necessary parameters. After that, specify the node through which two graphic lines are passing.

The direction of creating the angular chamfer is determined by the system automatically (depending

on where the graphic lines lie).



Drawing Creation

411

For inner chamfer creation, we recommend using the special chamfer types intended for this purpose.

The pointer should be positioned in this case on the necessary side of the chamfer creation.

In order to make a chamfer on the other side, it is necessary to activate the Symmetric checkbox in the

chamfer parameters or position the cursor on the other side of the node.

When creating dual chamfers, upon defining the parameters just select two nodes where two

respective pairs of graphic lines intersect. The pointer position is of no importance in this case.
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Chamfer creation by graphic lines

This technique, as well as the previous one, is used when the graphic lines are already applied on the

drawing. The chamfer created in this way is displayed as a graphic entity. The existing graphic entities

are modified, and all necessary construction entities necessary for the chamfer creation are produced

automatically in the process.

When creating an isolated chamfer in this way, then, upon selecting the chamfer type and defining the

necessary parameters, you need to specify two graphic lines intersecting in one point. The graphic line

selection is done by  or by the option:

<Space> Select Graphic line

In this case, the chamfer distance will be counted from the first selected graphic line.

When creating dual chamfers, then, upon defining the necessary parameters, you just need to select

their common graphic line lying in between. 
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In this case, each end point of this line should be connected with exactly one graphic line.

In the ambiguous cases, when more than two lines pass through the end nodes, or the lines intersect

without passing through the end nodes, then three graphic lines need to be selected for the dual

chamfer creation, in the order starting with the common line of the to chamfers. 

     

Note that a corner chamfer can only be created on straight lines in the graphic.

When creating any type of a chamfer, error messages are displayed on the screen in the cases of

incorrect element definition.

Chamfer parameters

Radius/Distance. Defines the radius of the inscribed circle in the case of the fillet-type chamfer, or the

distance in the case of the corner chamfer. 

Angle. This parameter is accessible only when the corner chamfer is selected, and defines the angle of

the chamfer being created. 

Symmetrical. This parameter is accessible only when making the corner chamfer. Setting this

parameter grays out the parameter Angle, since only the distance is required for defining the

symmetrical chamfer.

Style from original With this parameter set, the chamfer-making line strokes will have the same

parameters as the graphic lines on which the chamfer is based. Otherwise, those strokes will have the

parameters currently used by the command Create Graphic Line or Create Sketch.

Auto change Hatches. Setting this parameter causes automatic adjustment of the defining hatch to

geometry of the chamfer being created. It also makes possible creating a chamfer as a construction

element at the node through which the hatch contour is passing.

Show this dialog when command starts. If this parameter is set, this dialog box will be automatically

launched upon entering the command. If the parameter is cleared, you will have to call the dialog by

the option Set command options (the icon  <P>).

Creating Custom Lines and Hatches

T-FLEX CAD supports creation and use of user-defined custom graphic lines and hatches along with

standard types. This chapter describes methods of creating and using those entities.

T-FLEX CAD standard distribution includes several examples of custom lines and hatches that can be

used as a sample for creating your own ones.
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Graphic Lines

Image of a line is created in general case from several elements described in the line pattern

according to the special rules. 

Description of a line element constitutes a drawing of the corresponding segment of a line executed

with the use of construction lines, nodes, graphic lines, text and hatches. Description of each element

of the line must be located on a separate page of the pattern. The sequence order of pages in the

pattern’s document is not important. 

In general case the image of the line is created from the following elements: Symbol, Space, Line,

Start and End.

Element Symbol – main element of the line. It can be repeated several times on the line. The number

of repetitions is specified in the pattern of the line with the help of the variable CenterMaxCount. If

this variable is not created in the pattern, the Symbol element is drawn only once on the line. The

number of repetitions of the Symbol element can be decreased by the system if the number indicated

in the pattern can not be fitted to the specified line length. The Symbol element is not drawn at all if

the variable CenterMaxCount was assigned the value of 0 or if the line length is too small.

Start and End are the elements that determine the line endings. They are placed at the beginning and

the end of the line being created without changes. If in the line pattern the Start or End elements are

absent, it will be possible to specify standard endings for a line on a 2D drawing upon using the given

type of a line.

Space and Line – auxiliary elements of the line that are repeated many times along its length, if

required. When creating a line the system draws the Start and  End elements at the line ends, then

uniformly places along the line the required number of the elements Symbol (as many times as it can

be fitted along the line length but no more than it is specified by the CenterMaxCount variable). The

remaining intervals between Symbols are filled with the Space and Line elements. Filling in is carried

out in the following way: into each interval the maximum possible number of the Space elements is

inserted. The spaces remaining between them are covered automatically by the Line elements scaled

to the required proportion in such a way that the Space and Line elements alternate.

Any elements can be absent in the line pattern except the Space element.

The required attribute of description of each element of the line is a pair of nodes named in a special

way. The nodes determine the points of joining the given element of the line with the neighboring

elements (characteristic points). The nodes names are precisely defined for each element of the line:

· The Symbol element – specified by nodes CenterStart, CenterEnd;

· The Space element – specified by nodes Start, End;

· The Line element – specified by nodes LineStart, LineEnd;

· The Line start element – specified by nodes TailStart, TailEnd;

· The Line end element – specified by nodes HeadStart, HeadEnd.

Start and end are connected to the main part of the line by TailEnd and HeadEnd nodes,

respectively.

When creating a pattern, one can use graphic elements of different color and different width.

However, the color and width of a graphic line created from a custom type can be modified only if

the whole pattern uses the same color and line width.

The line elements may be of a quite complex shape. When a hatch is created based on graphic lines

of a custom type, the hatch contour will not follow the line shape by default; instead, it will be

composed of line segments passing through the characteristic points of the line elements. To make

the hatch contour exactly follow the line or assume other arbitrary shape, you would need to specify

additional 2D paths with special names in the line pattern drawing defining the hatch contour route.
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The paths are created separately for each line element. Each path must lie on the same page as the

respective line element. The path must start and end at characteristic nodes of its element and be

named as one of the following: Polyline – the path of the periodical part, TailPolyline – the start path,

HeadPolyline – the end path, and CenterPolyline – the path of the center part.

Working with Custom-type Line

To start using a created line type, simply place the line pattern file in the folder …

\Program\LinePatterns. Upon restarting T-FLEX CAD, the line types found in this folder will be

automatically added to the lists of line types in 2D commands. To delete a custom line type, simply

delete the pattern drawing file from …\Program\LinePatterns and restart T-FLEX CAD. 

When using a custom line type in a document, the line pattern is saved with that document. Relation

with the source file is lost at this point. Therefore, when porting a document file to a computer without

the given line type, the image does not get lost.

When porting a document containing custom line types to a computer with existing line type pattern

under the same name, the line image stays unchanged in the form of the image saved in the

document. To update a line image, you would need to redefine its type over again. To make an

update, all you need is to bring up the parameters dialog box for one of the lines and confirm the

existing value. New graphic lines of the same type that will be created in this document will take on

the current pattern.

Example of Creating Custom Line

Let's review custom line creation on a simple example. We will create the line pattern shown on the

figure. First of all, let's decide on the elements to be included in this line. The figure features: the

periodical part – interlaced crosses and segments; center part entered just once  – the text Test; start

and end as special symbols.

To create the pattern, let's open a new 2D drawing (the command Create New Model).

Description of each line element shall be placed on a separate page of the document. We will create

four pages in the pattern document. For working convenience, each page can be renamed according

to its purpose. 

To create or rename document pages, use the command Pages.

When creating descriptor drawings of line types, one can use either use simple sketched lines, or

graphic lines snapped to construction lines. For simplicity, we will use free-hand sketching.

We will begin creation of a line pattern from the main element – the periodic part. The descriptor of

the periodic part will be the drawing depicting the cross with two strokes, on either side. The points at

which this part connects to its neighboring line pieces are marked by the named nodes, Start and End,

as shown on the diagram.

A node name is defined by the command Edit Node, the path name – by the command Edit

Construction.
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The lines constituting the periodical part can be of various types, color and width, depending on the

necessary appearance of the custom line. In this example, the crosses on the line ought to be blue.

Therefore, we will make the cross strokes blue, while the lateral strokes - black. Next, we need to

decide whether to prescribe the path for hatches. Suppose, this line may be used in the future for

creating hatches, so that the hatch or fill lines are not allowed to overlap the cross strokes. For this

purpose, we will create a named path, Polyline, starting and ending in the named nodes Start and End

and passing as shown on the figure.

After describing the periodical part, let's proceed to creating the next line element – the center part.

To create it, we need to switch to another page of the pattern template.

The pattern's center part will include the text Test with two strokes on either side. The text can be

created by any text entity type (the command Create Text). The start and end of the center part are

defined by the named nodes CenterStart and CenterEnd. Additionally, we will create a named path

CenterPolyline for hatches based on this line, as shown on the figure.
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Similarly, we will create description of the tail and head of the line on separate pages, as shown on

the figure. We will have to use a hatch to create the filling. No additional paths for hatches will be

created. In this case, the contour of a hatch bounded by this line type will follow the lines connecting

the border nodes of these line elements.

What is left to do before using the created template is to save it in the folder …\Program\ LinePatterns

under the name Custom line sample.grb and restart T-FLEX CAD. After restarting, the new line with this

name will appear in the list of line types. It can be used just like a standard line type.
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Graphic Line Parameters

The option  calls the graphic line parameters dialog box.

When the dialog of parameters is invoked before creation of a line has begun, it will contain the

additional parameter called Color for the current page only. This parameter is used only for drawing

on pages of the workplanes (see the manual on three-dimensional modeling). When the flag is

enabled, the specified color will not be used for all new lines in the document, but only for those lines

that are created on the current page of the workplane.

Standard Tab

· Style

· Type. Defines the line type for drawing graphic entities. The line type is selected from the list.

The list includes both the standard (included in the system distribution) and the user-defined

line types. Standard line types are defined in the file TCAD.LIN. Their description is compatible

with that of AutoCAD system. The template files for user-defined types are located in the

folder …\Program\LinePatterns. 

· Scale factor. Defines the Scale factor for dashed line types with respect to the dash size

defined in the line type descriptor file (TCAD.LIN).  Does not affect display of solid lines. If the

scale is not defined (Default), then the scale factor will be taken from the Scale factor for

dashed lines parameter of the Lines tab in the command Set Document Parameters.

· Thickness. Defines the thickness of the graphic entities. If undefined (Default), then the

thickness for the solid thick line (CONTINUOUS) will be taken from the parameter Line

thickness > Thick lines, while all the rest – from the parameter Line thickness > Other lines on

the Lines tab in the command Set Document Parameters.

Wave line type. If the wavy line type is selected, the Wavy line graphic button becomes available,

which displays the Wavy line parameters window.

The number of periods. The parameter value sets the number of waves on the image line (the period

length is calculated by the system automatically).

Period length. Sets the value of the period length (the number of waves is calculated by the system

automatically).
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Wave height. The parameter value sets the wave height as a percentage of the period length.

· Start and end arrow type (arrow/symbol type). Each graphic line can have its start and end

marked by a special symbol. The symbol type is selected from the list. 

· Start and end arrow size (size of start and end symbols). The sizes of the start and the end

symbol are defined independently.  Any size can be set at the user's preference. If the symbol

size is not defined then the symbol is drawn proportional to the font size defined for the

drawing on the Font tab in the command Set Document Parameters.

· An additional button  serves to quickly swap the line start and end parameters.

All above parameters are set by default when using one of the standard system line type. The style

and ending type are defined for each standard type. A standard line type can be selected from the list

coming under the ... button.

The description of the standard line types is stored in the file SPECLINE.DEF. By default, the file

contains the following entries: 
Thin THIN 0 0
Continuous CONTINUOUS 0 0 
Center CENTER 28 28
Hidden HIDDEN 0 0

The file can be appended by the user as necessary. The first parameter is a comment, the second is the

line name (this name is used for identifying the line in the line descriptor file), the third and the fourth

parameters are the Ids of the start and end symbols (per the enumeration in the endings list).

· Color. The graphic line color.

· Level. The value of the visibility level of the graphic line.

· Priority. The value of the graphic line priority.

· Layer. The name of the layer of the graphic line.

Some parameters of graphic lines can be entered in the system toolbar. Especially for graphic lines,

the system toolbar provides a button for defining graphic line types, and the graphic line start and

end defining buttons.

Advanced Tab

The Advanced tab allows setting the following parameters:
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The line display mode:

· Solid line. The lines whose Width parameter is not 0, will be drawn filled with color.

· Double line. The lines whose Width parameter is not 0, will be drawn as a contour without

filling.

· Align. Defines centering of the graphic line with respect to the reference nodes: Center, Left,

Right.

· Width. Defines the width of the graphic line: constant or variable. In the case of the constant

width, the parameter Value defines the line width. If variable width is set then the line width

values On start and On end need to be defined.

· The Start and End parameters define the shape of the start and the end of the line, as follows:

None, Round, Square.

· Joints. This parameter defines the shape of joints of a graphic line created from a 2D path, as

follows: Round, Sharp, Mitered. 

The size of the rounds and miters depends on the line width setting. If Round attribute is set, the

segment joints will be rounded with the radius equal to the line half-width. With the Mitered setting,

the corners at the segment joints are mitered. The distance from the joint node to the miter top is

defined by the parameter Miter limit as a ratio of the line half-width.

                       

Edit Graphic Line

Editing graphic lines is done by the command Edit Graphic Line. Call the command via:

Icon Ribbon

Keyboard Textual menu

<EG> Edit > Drawings > Graphic line

The following options become available upon calling the command:
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<Enter> Select the nearest graphic line

Select and edit the nearest graphic line.

<W> Select group of graphic lines

<*> Select All Elements

<R> Select element from list

<Esc> Exit command

When in the command, one can select a graphic line entity by pointing the cursor and clicking . 

You can select several graphic lines at once by specifying the window with the <W> option. Only

graphic lines that completely fall within the window boundaries become marked.

All graphic lines can be selected at once by typing <*>. To add a graphic line to the set of already

selected ones, use the combination <Shift> + . To exclude a graphic line from the selected set, use

<Ctrl>+ .

The following options become available after selecting one or several graphic lines:

<P> Change graphic line parameters

<Alt+P> Copy Properties from Existing Element

<I> Select Other Element

<Del> Delete selected Element(s)

<Esc> Cancel selection

If only one graphic line is selected, then the following option is available:
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<O> Create Name for selected Element

If a graphic arc entity is selected, the following additional options become available in the automenu:

<Tab> Change arc direction

<A> Link Arc or Circle to Node

<B> Break Link with Node

If the selected graphic line is created based on a construction line, then Relations for the parent

construction line will appear in the 2D window. Those relations are temporary, meaning that those are

created by the system automatically upon entering the mode of editing a graphic line, and are

automatically deleted upon exiting the mode. Using Relations, you can modify geometrical

parameters of the parent construction line in the transparent mode.

Besides that, if the selected graphic line is created based on a construction line, then the second

click  after selecting the line (while the cursor is pointing at the line) will invoke the

command of editing the original construction line.

Learn more about these options.

Option  (<P>) allows you to change the parameters of the selected graphic lines. The parameters

of the last selected image line are taken as the initial ones.

Changing the parameters of the graphic line in case of selecting one element is the same as setting

the graphic line parameters.

If you have selected several image lines for editing, then you need to set the parameters for multiple

editing, and then edit graphic line parameters directly.

Copying parameters from existing lines

The values ??of the parameters of the created graphic line can be quickly copied from an existing line.

To do this, you need to use the option:
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<Alt+P> Copy properties from existing element

This option is available in the command automenu before the line is created, or during the

creation process.

After calling the option, it is enough to indicate the graphic line, the parameter values of which must

be passed to the created line.

In order for the copied parameter values to be assigned to all new lines, an additional option must be

enabled before selecting the original graphic line:

<S> Set Properties as Default

If this option is enabled, the copied parameters will be saved as default parameters.

This option simplifies the creation of graphic lines with the same parameters. However, it does

not allow you to copy individual parameters or parameters from an object of a different type. In

such cases, it is more convenient to use the general mechanism for editing the parameters of

elements in the properties window.

The current set of graphic line parameters defined during the editing can be saved. New graphic line

creation would then be based on this particular set of parameters.

To open the parameters dialog box for a single graphic line, one can simply double-click it ( ).

Option  (<O>) allows you to assign a unique name to the selected graphic line that uniquely

identifies this graphic line. Therefore, this option is available when only one graphic line is selected.

For graphic lines that have a name, you can get its length in the variable editor using the get() function

- LENGTH. The get() function in the variable editor for a graphic line named NAME will look like this:

get ("NAME", "LENGTH").

The option  (<Z>) allows flipping the direction of graphic arc entity creation.

The following options are available in the automenu for graphic arc entities,  and . These

options manage a locking node of graphic arcs constructed on top of a construction entity.

Throughout modifications of the drawing, the graphic arc will stay over the sector of the underlying

construction circle that is closer to the locking node.
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Let's review the following example. When moving one of the original lines, the part is supposed to get

mirrored. However, the graphic arc will stay in its original orientation as the vertical line is moved,

resulting in the wrong final shape of the part. This can be fixed by using a locking node.

To keep the arc always in the correct sector of the circle, link it to a node. After calling the command

Edit Graphic Line select the arc and use the option . Then, select the locking node using . 

Now, as the vertical line is moved, the whole drawing will be flipping, maintaining the original relative

configuration.
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To release the link with the node, use the option .

Option  (<I>) will allow you to deselect the last graphic line selection and select the next graphic

line closest to the current cursor position. This option is used if there are two closely spaced graphic

lines or overlapping graphic lines, and the wrong graphic line was selected on the first selection.

Option  (<Del>) deletes all selected graphic lines.

Option  (<Esc>) cancels the marking of the selected graphic lines.

It is possible to change the start and end nodes of the graphic line anchor. Changing the snap nodes

becomes possible when you select one line of the image. After the line is selected, the nodes forming

it are marked. You can move the cursor to the marked node and click . The cursor appears in the

form of a rubber thread, showing the new position of the graphic line. You can select the node to

which the graphic line should be anchored. After that, you need to move this line to the necessary

location and click again .
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Sketch

Use the command Create Sketch for a quick graphic lines creation.

Keyboard Ribbon

<SK> Drawing > Sketch

Icon Textual Menu

 
Drawing > Sketch

Sketch Line Creation Modes.

Continuous Line Input

Create lines with automatic constraining

T-FLEX CAD allows creating a drawing similar to most well-known CAD systems, using standard

functionalities for creating various primitives, such as: line segments, arcs, circles, ellipses, splines. 

Sketcher functionalities, including object binding and dynamic tooltips, significantly simplify and

speed up the process of drawing creation. With the help of a sketch, you can create a non-parametric

drawing, a parametric drawing or a combination of the two specified types. Non-parametric drawings

do not share the advantage of parametric drawings in the effective usage of modifiable dimensions.

However, in certain cases, development of such drawings is faster, requires less resources for

constructions calculation and can bring certain benefits, when large modifications are not expected. 

Sketching can be used as an independent way of creating parametric drawings, and in combination

with the classic for T-FLEX CAD parameterization based on the construction lines. parameterization

based on sketching with constraints makes it possible to eliminate dependence on the order of the

constructions, giving the user greater freedom when working on projects. To set or remove constraints

between elements, you can change the values of the model parameters at any time while designing. If

you remove constraints, the parametric sketch becomes non-parametric. Conversely, after creating a

nonparametric sketch on it, you can specify constraints by making parametric a drawing or its parts. 

Quick creation of drawing lines (both non-parametric and parametric based on constraints) is

performed using the "Sketch" command group. 

When you create a sketch, the created lines are called the graphic lines. 

After the command is called, options for various drawing lines creation appear on the automenu

panel. In the filters toolbar appears a list of active and disabled constructions. You can use all

available object bindings in the system when drawing.

On the filters toolbar, on the left, there are two special icons:

·  Infer Constraints

·  Create Dimensions Automatically

The Infer Constraints creates simple constraints on graphic lines.

When working with 2D detail or 2D assembly by default, automatic constraints creation is

disabled. When working with a 2D detail or a 2D assembly, a non-parametric sketch is created

by default. By default, automatic constraint creation is disabled in 3D details and assembly on a

normal page.

Automatic creation of dimensions is often useful when creating a parametric sketch with constraints.

Enabling of this option (unlike the option of automatic creation of constraints) does not imply

parametric relations creation. 
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When the icon  is disabled, a normal non-parametric sketch is created. In the sketch creation mode,

the user can construct circles, arcs, splines, or simple geometric shapes such as circles, ellipses,

rectangles, polygons by selecting the sketch line options.

Rectangles, polygons or sequentially entered segments, arcs and splines represent a set of

separate sketch segments not connected with each other. Remember! The binding to objects

that took place during construction only once, at the time of the line creation, determined the

relative positions of the characteristic points and the lines themselves (segments, arcs, splines,

etc.). When editing characteristic points or editing lines, the points that coincide upon

construction will move independently of each other and lines that are tangent, parallel or

perpendicular to each other will lose the established relationship. If, after moving the line, you

need to make sure that any specific points coincide - you need to edit the position of these

points. When editing, all available object bindings will be active again, as during the

construction of the element. As during the construction of an element, the bindings will

determine the position of the points only for the current position of the elements.

To create relations between individual sketch lines that will act independently of rebuilding, you

must specify constraints (create a parametric sketch).

When creating the listed figures and lines, you must specify the required number of coordinates of

characteristic points and geometric dimensions. For example, to create a segment, you need to specify

the coordinates of two points or the coordinate of the first point and then the angle and length of the

segment. The position of the characteristic points of the line can be specified using  or by specifying

coordinates in the command properties window. When specifying the position of the characteristic

points of the created lines, you can use object bindings to the existing elements of the drawing

(vertical/horizontal relations, tangency, perpendicularity, etc.). 

Graphic line parameters

The parameters of a graphic line can be set or changed at any time when the sketch is created or

edited. The dialogue window for setting parameters is called with the automenu option, or using the

context menu of a line. To bring up the context menu, click  on the line.

<P> Set graphic line parameters

For a detailed description of the parameters, see the chapter "Graphic lines".

You can assign the same properties for similar drawing lines: holding down <Shift>, with the help , we

select the necessary lines and further, in the "Elements properties" window we edit them.

In the context menu of the graphic line there is an Auxiliary option. This option makes the line

invisible when you print drawing. The option is also available in the Lines dialog box and in the

properties menu. If the sketch line is only needed to specify constraints or bindings, but not needed in
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the drawing, then when you enable the flag opposite the Auxiliary option, it becomes invisible when

printing. These lines are highlighted in blue on the drawing.

Example

Suppose we built a hex using Infer Constraints for which the Polygon constraint was created. Suppose

we need only two upper and two lower lines. If we delete two vertical lines that we do not need, the

constraint will also be removed. In this case, it is convenient to make the two vertical lines invisible for

printing.

Properties Window

To define the coordinates of characteristic points when creating graphic lines in a command, the

properties window is used. It defines the absolute, relative, polar coordinates of the created elements,

as well as some geometric dimensions of the created shapes.

When you move the cursor to the drawing field, the current coordinates of the cursor are tracked in

the properties window. If necessary, they can be changed in transparent mode, you may directly enter

the necessary value from the keyboard. The current field for entering values can be set by pointing to

it with the cursor and pressing , or using the keyboard. The shortcut for navigating to one or another

field in the properties window is displayed in the tooltip when you move the cursor over this field.

When you enter a value in the properties window, the flag that blocks the change of the

corresponding coordinate or parameter of the created element when the cursor is moved to the

drawing field is automatically set. To create a point after entering coordinates just press <Enter> or 

in the drawing field.

When creating elements, you can use both Cartesian and polar coordinates and their combinations, so

you can specify different options for arranging points in the most convenient way.

For example, when specifying the second point of a segment, you can enter the offset value and the

length of the radius vector. In this case, auxiliary elements appear in the drawing: circle with the center

at the beginning of the segment and the given radius and a horizontal line spaced from the first point

of the segment by a distance equal to the specified displacement along the Y axis ("dy").

The points of intersection of a circle and a straight line determine possible variants of the location of

the second point of a segment for given parameters. In the drawing, this is reflected as a free node

that moves when the mouse moves from one point of intersection of the circle and the line to the

other. When you select the necessary point and click , you can finish the creation of the segment.

When you change the sketch option, only those parameters that are relevant for this option are

displayed in the properties window. For example, the list of geometric parameters of a polygon

differs significantly from the list of arc parameters.

The list of coordinates of characteristic points and geometric sizes in the properties window also

depends on the stage of values input. For example, when constructing an arc, when you enter the
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coordinates of the first two points the properties window is the same as the window of the properties

of the segment, and when the third point of the arc is selected, the list of values changes.

Continuous Line Input

Continuous input of sketch elements is provided by an option in the automenu:

<J> Continuous Line Input

In this case, the end point of the last created element (segment, arc) will be the start point for the next.

This mode is required only when creating segments and arcs. The icon of this option will be available

in the auto-menu when creating rectangles, polygons, circles, ellipses or splines but it does not have

any effect. 

By default this option is active.

Continuous input makes the segments and arcs interconnected only at the time of construction.

If you move a segment or arc, whose ends have been associated with neighboring constructions,

then the ends of the segment or arc will lose their connection with the neighboring

constructions. That the ends of segments, arcs, or graphic lines are connected with each other

even in case of a change in their position - you need to use constraints (parameterize the

sketch). 

Topics in this section:

· Point

· Line

· Arc

· Circle

· Rectangle

· Polygon

· Ellipse and Ellipses Arc

· Spline

· Chamfer and Fillet

· Offset Curve

· Symmetry

· Methods for Modifying Graphic Lines

· Sketch Snaps

· Edit Sketch

Point

To construct a regular point, call the command Point Creation:

Keyboard Ribbon

<SK>><Shift>+<D> Draw > Sketch > Point

Icon Textual Menu

Drawing > Sketch > Point

When creating graphic lines, all characteristic points (the ends of segments, spline inflection points,

circle centers, etc.) are not independent nodes. It is a difference of T-FLEX CAD 16 version. Object
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bindings are applied for these points and they themselves can become binding objects. These points

can be moved, but all actions with them are possible only within the adjustment of the graphic line:

segment, arc, ellipse or spline circle. When the position of the characteristic point of the graphic line

changes, the properties window of the line, to which this point belongs, automatically appears.

To put a point you need to enter its coordinates in the properties window or specify its position using

. All possible object bindings are applied to the point. The constructed point can also be a binding

object for further constructions. 

Bindings to point in the sketch have some peculiarities with respect to other graphic line

bindings.

The binding to the point of the sketch line will work even if you move the sketch point, and you do not

need to create constraints to do this. If, for example, you connect the ends of two segments to the

sketch point, then when you move the point, the ends of the segments will move along with it. In this

way, you can link the ends of segments without constraints.

Bindings to a point and to other lines will act similarly. For example, associating a circle center with a

sketch point will allow you to move the circle around its center when editing the position of the point.

In this case, if you link a sketch point to graphic lines, editing the graphic lines does not change the

position of the point. In order for the position of the sketch point to depend on the sketch line after

editing the drawing, you need to use constraints.  

Line

To create a line, call the command Line Creation:

Keyboard Ribbon

<SK>><S> Draw > Sketch > Line

Icon Textual Menu

Draw > Sketch > Line

Calling the Sketch command always ensures the system status ready for insertion of segments, as

indicated by the icon  in the Ribbon and in the automenu.

The presence of a black triangle in the bottom right corner indicates that this is a group of options. If

you select this icon a little longer than usual, holding , a list of possible options appears.
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There is also a triangle that opens a list in the Ribbon under the segment icon. You do not need to

hold the segment icon in the Ribbon, just press the triangle.

Line segment

To create a simple segment (option ), you need to specify two points. Points can be set arbitrarily

by pointing the cursor in the drawing field and clicking  or by specifying the exact coordinates in

the parameters window. Position of a first point is defined by absolute coordinates X and Y. Position

of a second point may be defined by one of the following sets of parameters:

· absolute coordinates X and Y;

· offsets dx and dy from the first point;

· Length and Angle of the segment, where angle is measured counterclockwise from the

horizontal direction.

When creating a segment, you can select all available object snappings as its points.

Axis

Axis is a line segment with a dash-and-dot line type. However, the type of line cannot be changed.

Parallel Segment

To create a parallel segment, select the option:

<D> Parallel line

In this case, use the cursor to select  a line, relative to which you want to create a parallel one. A

dynamically movable straight line, parallel to the selected line, will appear on the screen. If continuous

input of lines mode is enabled, then this straight line will be parallel to the last entered line. You can

refuse to select a segment by clicking .
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After specifying the initial line, you should specify the Distance to the new line and coordinates X and

Y of its starting point. This can be done arbitrarily by moving the cursor and clicking  at the

necessary area of the drawing, or by typing exact values in the parameters window.

As you type in the Distance in the parameters window, the dynamic straight line gets fixed at a given

distance from the initial line. The dynamic point attached to the cursor, which sets the start of the new

line, will move along the dynamic line. Point's position is set by clicking . X and Y coordinates'

input boxes in the parameters window are non-editable in this case.

After defining the starting point of the new line, you need to define its ending point. A fixed line

parallel to the original line will pass through the first point. The ending point of the new line can be

set arbitrarily by moving the cursor along a straight line and clicking , or you can specify its

position precisely in the parameters window. Position of the ending point may be defined by one of

the following sets of parameters:

· Length of the line segment;

· absolute coordinates X and Y;

· offsets dx and dy from the starting point.

Perpendicular Line

The option of a perpendicular segment is allowed to create a perpendicular only to other lines. In this

case, the perpendicular reference is first created, and then the position of the perpendicular line is

specified.
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<F> Perpendicular Line

If the continuous line input mode is set, an infinite straight line will appear on the screen after

selecting this option. The line is perpendicular to the last entered line and passes through its second

point. This point will be the beginning of the created line. In this case, it is enough to move the

dynamically moving point along the line using the cursor and fix its position with the help of  (or

coordinates in the parameters window).

If it is necessary to create a perpendicular to another line or to the same line, which doesn't pass

through the last point, then you can decline the choice made by the system in the mode of continuous

line input by clicking . A single click  will cancel the selection of the starting point of the line

being created. A second  click will cancel the selection of the initial line and allow you to select

the necessary line. When you select a line, an endless dashed line follows the cursor. The position of

this line determines the position of the segment. With the help of  you can fix the line and specify

the first point of the segment (or set the coordinate of the point in the properties window). After that,

the second point of the segment moves along a straight line following the cursor. The position of the

second point is specified using  (or the length of the segment can be set in the parameters

window).  

If you need to create a perpendicular at a specific point, then it is more convenient to use the

Segment (<S>) option and object bindings. If you create a perpendicular from a specific point, then

you can create a perpendicular to the tangent of any curve: arc, spline, ellipse.

Example

Create Perpendicular line to Tangent Arc 

A line perpendicular to the tangent of the given arc should be created.

 

To do this, move the cursor to an arc in the Line <S> mode. A dynamic point will appear. The point

follows the arc behind the cursor. By pressing  we determine the position of the point from which

we will create the segment. After that, the position of the cursor determines the coordinates of the

second point of the segment. You can change the angle of the segment by moving the cursor. We find
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the position in which the binding of the perpendicular to the tangent arc is automatically determined.

The tangent will be drawn with a thin dashed line. At the point of tangency, a perpendicularity sign

will be indicated, and the icon  will appear next to the cursor. Leading the cursor along the

perpendicular line we determine the length of the segment. We finish the construction by pressing

. The exact length of the segment can be entered in the corresponding field of the parameters

window.   

Angle Segment

In order to create a segment at a given angle to another segment, you should use the automenu

option:

<G> Angle Line

This segment is constructed similarly to the perpendicular one, with the only difference that you can

set the required angle in the parameters window.

A button  in the parameters window will allow you to flip the direction of the gradient relative to

the selected segment.

Tangent Line

A tangent segment can be constructed to an arc or spline. You should use the option:

<H> Tangent Line

First, with the help of , you need to select the tangent arc or spline. After that, an auxiliary line is

displayed on the screen, tangent to an arc or spline at the extreme point of the curve. This will select

the extreme point of the arc or spline to which the cursor was closer at the moment of selecting the

element (if the spline is closed, then the first point of the spline will be selected). By moving the cursor

along with the dynamically moving node along a straight line and using the  or the parameters

window, you can fix the position of the second node.
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Tangent Line through Point

<K> Tangent line through point

With this option, you can construct a tangent segment to any curve (circle, arc, ellipse, spline). You

should select a curve using , the selected object will be highlighted (if it is an arc, then an auxiliary

circle will appear on it). An auxiliary point will move along the curve. This point will be the first point

of the segment and determine the point of contact. A line will be stretched from the node to the

cursor. It shows the position of the created segment. In order to construct a tangent line, it is necessary

to fix the position of the second point outside the circle.

The position of the second point can be set either arbitrarily, by specifying the point using  (you

can use object bindings), or you can use the parameters window, specifying the exact coordinates in it.

You cannot specify the second point inside the circle, inside the circular arc, inside the ellipse and

inside the arc of the ellipse. In this case, the tangent cannot be constructed. 

If you activate the Automatically find tangents when creating line segments in the System Options

(Options > Constraints and Dimensions > Infer Constraints), then in the segment construction mode

(Segment <S>) it will be possible to create tangent segments without calling the Tangent line option.

A point will appear after selecting any curve on it using , and if you move the cursor away, then the

point will move along the curve like when you select the Tangent line option. Further creation of the

segment will be completely analogous to the method described in this subsection. If there is a binding

in the place of the curve selection, then the point will not move along the curve and a tangent icon

will appear near the segment. If you move the cursor away, the touch sign disappears and you can

create  a regular segment.
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Axial Lines

In order to construct center lines for such elements as an arc, a circle and an ellipse, you need to select

the appropriate command. 

Keyboard Ribbon

<SK>><Ctrl>+<Q> Draw > Sketch > Axis lines

Icon Textual Menu

Draw > Sketch > Axis lines

After that, it is enough to choose any of the specified lines on the drawing with the help of , and

the axial ones will be created automatically.

If the line for which the centerline was constructed was edited, the axial lines will not be rebuilt

automatically, they will also need to be edited or re-created. 
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Arc

To create a arc, call the command Arc Creation:

Keyboard Ribbon

<SK>><C> Draw > Sketch > Arc

Icon Textual Menu

Draw > Sketch > Arc

Just as in the case of lines, a set of icons that allow you to create arcs in various ways is located in the

submenu. In the process of creating a sketch, any of the nested icons can be displayed on the Ribbon

and in the automenu. Usually this icon corresponds to the option that was called last in this command.

Arc by Three Points

<C> Arc using Three Points

The mode for creating an arc by three points is set after the option selection. The first and the third

points are the end points of the arc, and the second point determines the position of the arc.

The arc can be set arbitrarily by selecting three points using the cursor, or precisely using the

properties window. In this case, the second point is given either by absolute coordinates or by offset

relative to the first point of the arc. To specify the third point, you can use the absolute coordinates,

radius, diameter or angle of the arc in various combinations.
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Select the Arc by Two Points and Radius

To create an arc by two points, you need to activate the option in the automenu:

<V> Select the Arc by Two Points and Radius

You need to set two extreme points of the arc using the cursor or the properties window. After that,

the cursor will appear on the screen, dynamically displaying the position of the arc under construction,

in accordance with the current position of the cursor. To fix the arc, you need to move the cursor to the

necessary position and press , or enter the angle or radius (diameter) of the arc in the properties

window.

     

        

Central Arc

The arc with the center inside the circle is built in the appropriate mode, which is called using the

option:

<B> Central Arc

To construct the central arc of a circle, you should specify the center of the circle, its radius (diameter),

as well as the starting and ending angles of the arc. This can be done arbitrarily, using , or

precisely using the properties window. After setting the center of the circle, the dynamically moved

circle will appear on the screen. In the properties window, the fields for entering the radius (diameter)

and the initial angle of the arc will become available. They can also be set by moving the cursor to the

necessary point and pressing . Next, you need to move the cursor on the fixed circle in the

direction in which you want to place the arc, and press  again.
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The angle of the arc can also be set in the properties window, after which you can apply creation using

the [Enter] key or clicking .

Tangent Arc

To create an arc tangent to the graphic line (arc or segment), you need to call the appropriate option

by the icon:

<E> Tangent Arc

After that, you need to select a graphic line. The arc will exit from the extreme point of the selected

line to which the cursor was closest to at the moment of selection. In the continuous input mode, the

arc will start from the end point of the last created element. Then use the cursor to move the

dynamically displayed arc to the necessary position and fix it by pressing . 

The position of the tangent arc can be specified. To do this, specify the coordinates of the end point

of the arc or the value of the radius (diameter) and angle of the arc in the properties window after

selecting the graphic line. In the latter case, you must first set the direction of the arc using the cursor.
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Arc Tangent to Arc

You need to select a line (segment, circle or arc) to which you want to ensure the contact of the

created arc using this option.

<N> Arc tangent to arc

When you select a line, it will be highlighted and continued to a full line or circle. A dynamically

movable circle tangent to the selected line appears on the screen. The position and size of the circle

vary depending on the position of the cursor.

The second step is to create a point outside the tangent element through which the created arc will

pass. This point can be set arbitrarily by setting the cursor to the necessary position and pressing  or

setting coordinates in the properties window. As a result, the dynamically moved circle will pass

through the specified point, tangent to the line selected in the first step.

Next, you must specify a radius (diameter) of the auxiliary circle, either by specifying a specific value in

the properties window, or arbitrarily, using . As a result, the position of the auxiliary circle is fixed. 

It remains only to specify the position of the arc itself on the auxiliary circle, between the two created

points. To do this, it is enough to indicate the required position with the cursor - the dynamic image of

the arc will move along with the cursor. Press  after selecting the necessary position. The created

arc will be fixed.
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Arc Tangent to Two Elements

This automenu option allows you to create an arc tangential to two graphic lines at once (circles, arcs

or segments).

<M> Arc Tangent to Two Elements

<Space>

It remains only to show the position of the arc itself on the auxiliary circle. To do this, it is enough to

indicate the required position with the cursor - the dynamic image of the arc will move along with the

cursor. After selecting the necessary position, you should press , and the created arc locks.

or
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Circle

To create a circle, call the command Circle Creation:

Keyboard Ribbon

<SK>><O> Draw > Sketch > Circle

Icon Textual Menu

Draw > Sketch > Circle

As in the previous cases, this is a group of options, the list of which is presented in the attached menu

under the icon. A set of options allows you to create circles of various types.

Circle by Center and Radius

Such a circle can be created using the option:

<O> Circle by Center and Radius

To create a circle, you should specify the position of its center and radius (diameter). You can do it

using , or you can set the exact values of the coordinates of the center and radius (diameter) in the

properties window.

Circle by Two Points

<T> Circle through Two Points

This option is intended to create a circle passing through two points. You can set two points through

which the circle should pass, using  or by specifying coordinates in the properties window. Then

you should specify the radius (diameter) of the circle. To do this, you can use  to select the third

point to determine the position and radius of the circle or use the properties window.
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Circle Tangent to One Element

To create a circle tangent to one line (arc, circle or segment), you can use the automenu option:

<U> Circle Tangent to One Element

The construction of the circle begins with the selection of the graphic line to which it should be

tangent. The selected line is highlighted, and a dynamically movable circle tangent to the selected line

appears on the screen. The position and size of the circle vary depending on the position of the cursor.

In the properties window, you can set the exact coordinates of a point outside the tangency element,

which determines the position of the created circle. The position of this point can be set with .

Then you should specify the radius (diameter) of the circle, using  or in the properties window.

Circle Tangent to Two Elements

To create a circle tangent to two lines use the option:

<I> Circle Tangent to Two Elements

The first step for creation of a circle is a consequent selection of two tangent lines. The selected lines

will be highlighted red and a dynamically movable circle tangent to them will appear on the screen.

The position and size of the circle vary depending on the position of the cursor. You can change

position and size of the circle using <Space> key. The position and radius of the circle can be fixed by

specifying a point outside the tangent lines using  or in the properties window.
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Rectangle

To create a rectangle, call the command Rectangle Creation:

Keyboard Ribbon

<SK>><Shift>+<P> Draw > Sketch > Rectangle

Icon Textual Menu

Draw > Sketch > Rectangle

This group of options contains a set of nested icons that allow you to create a rectangle in various

ways. The created rectangles are collections of individual segments. Each such segment is edited as a

separate element.

Construct Rectangle

To create a rectangle along two vertices, use the option:

<Shift>+<P> Rectangle by two points

To construct a rectangle, it is enough to set the location of its two opposite corners. Points can be set

using , or by entering the coordinates in the properties window.

Create Rectangle by Center and Point

To create a rectangle by center and vertex, use the option:

<Shift>+<С> Rectangle by center and point

The creation of the rectangle begins with selection of the center point. The position of the point can

be set directly in the drawing window, using , or entering coordinates in the properties window.

Then you need to specify the position of the remaining vertices of the rectangle. This can be done by

simply specifying the position of one of the vertices of the rectangle in the drawing with . You can

also specify the exact values of the height and width of the rectangle in the properties window. In this

case, you should click  in the drawing window or press <Enter> after setting the parameters to

complete the creation of the element. You can also combine these two ways: for example, enter only

the height in the properties window, and define the width by specifying a point in the drawing. Before

specifying the coordinates of the second point (vertex) and applying creation, the parameters of the

rectangle can be changed. 
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Construct Rectangle by Center and Two Points

If you want to create a rectangle at a certain angle, then it is convenient to use not the Rectangle by

center and point, but the Rectangle option at angle.

<Shift>+<A> Rectangle by center and two points

The creation of a rectangle begins with specifying a point, which will be its center. You can specify a

point in the properties window by specifying its coordinates, or by using . Further, a dynamic

image of a segment appears, the center of which lies at the selected point. This segment sets the

width of the rectangle and the angle of its side. Using , you can set both the angle and the width

value at the same time, or use the properties window to set the exact values of these parameters. If

you set the width value, then an image of a circle will appear, whose diameter is equal to the specified

width of the rectangle. Diametrically located points defining the position of the side of the rectangle

will move along the circle. Angle can be specified using , or set the angle in the properties

window. If you specify values using the menu, you need apply changes by clicking  in the drawing

window, or by pressing <Enter>.

The final step in creating a rectangle is to set its height. Height can be set via the properties window

or in the drawing field by pressing . As in the previous cases, if you set the height value using the

window you need to apply creation.
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Parallelogram

To create a parallelogram, you need to set the length and angle of the first edge, then set the length

and angle of the other three edges. Points can be set either arbitrarily, using, or by entering exact

coordinates in the properties window.

Polygon

To construct a regular polygon, use the Polygon option.

Keyboard Ribbon

<SK>><Shift>+<R> Draw > Sketch > Polygon

Icon Textual Menu

Draw > Sketch > Rectangle

Options for polygon creation are different in the Ribbon and automenu. The option is included in the

same list with rectangles in the automenu. It is a separate option in the Ribbon.

The first step in a polygon creation is setting its center. The position of the point can be specified

using , or by specifying the exact coordinates in the properties window. In the same window, you can

set the number of sides and the type of the circle defining the polygon (inscribed or circumscribed).

Then it is necessary to set the radius of the defining circle and the angle of rotation of the polygon. To

do this, you can specify the second point using , which will be the vertex of the inscribed polygon or

the middle of the circumscribed side, or explicitly set the radius and angle of rotation of the polygon

in the properties window.
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Ellipse and Ellipses Arc

To construct a ellipse, call the command Ellipse Creation:

Keyboard Ribbon

- Draw > Sketch > Ellipse

Icon Textual Menu

Draw > Sketch > Ellipse

This group of options allows you to create an ellipse in two ways and an arc of an ellipse. Both in the

Ribbon and in the text menu, the group of options is combined under one icon in the drop-down list.

Ellipse by Center and Point

This option allows you to create an ellipse by specifying consequently its center, a point defining the

length of one semi-axis of the ellipse, and the value of the second semi-axis (radius).

<Ctrl>+<T> Ellipse by Center and Point

As with other sketch elements, you can set the position of points by simply clicking  in the drawing

field or by specifying exact values in the properties window.

Ellipse through Two Points

The option allows you to create an ellipse by specifying two points in succession - the ends of one of

its axes, and then specifying the length (diameter) or half-length (radius) of the second axis.

<Ctrl>+<U> Ellipse through Two Points

Elliptical Arc

To create an arc of an ellipse, use the option:

<Ctrl>+<M> Elliptical Arc

After calling the option, you should specify four points: the center of the ellipse, the starting point of

the arc, the end point of the arc, and the additional point on the arc of the ellipse defining its position.

The position of the points can be set arbitrarily, using , or exactly, using the properties window. 
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After specifying the center and boundary points, an arc of the ellipse appears. It follows the cursor.

The cursor determines the position of the additional point of the arc.

If a dynamic arc does not appear, then with such a position of the point it will be impossible to create

it. The coordinates of the point can be set in the properties window. A warning is displayed in a

special field of the properties window when you try to specify invalid coordinates of the point.

Slot

The commands for creating the slot are located in the Rectangle group.

When one of the options is activated, a menu of options opens:

All 4 types of slots have the same set of options.

This group of options allows you to construct a slot in the following ways:

· Slot - Dimensions

· Slot

· Slot by center point Dimensions

· Slot by center point

For all slots, firstly you must set the first point. You can do this either in absolute coordinates, or snap a

node to any object. The second point can be set in a variety of ways. Similarly to the first point, you
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can snap it to any object or set coordinates. Additionally, you can select a construction option: Offset

or Angle and Length.

If you select the Offset option, you must specify in coordinates the offset along the axes relative to the

first point.

Angle and Length let you set the angle of rotation of the centerline and the distance between the first

and second point.

After the points have been specified in the options, it becomes available to select the width of the

groove and the radius of the circles.

If you activate the flag next to the Radius parameter, then the radius and width can be changed only in

the value input field.

Slot - Dimensions

When constructing a slot in this way, the first and second points will be the overall dimension of the

slot length.

Slot

The first and second points of this type of slot are the centers of the slot circles.

Slot by center point Dimensions

In this case, the first point is the center of the groove, and the second defines the dimension of the slot

length.

Slot by center point

Similar to the previous version, the first point is the center of the groove, while the second point is the

center of the circle.
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Spline

To create a spline, call the command Spline Creation:

Keyboard Ribbon

<SK>><Shift>+<H> Draw > Sketch > Spline

Icon Textual Menu

Draw > Sketch > Spline

Spline construction options both in the auto menu and in the Ribbon are combined into a separate

group. You can open a group by clicking and holding  on the corresponding icon in the automenu. In

the Ribbon, the group is expanded by pressing the image of the triangle to the right of the spline icon.

By default, a regular spline will be the first in the group. It is changed by one that was used last.

In the group of splines, there are three main types:

· Spline

· Spline by Polyline

· Polyline 

Each of these types can be closed or non-closed.

Polylines are splines of the first order. Many parameters of points and additional parameters of splines

are not available for them. Therefore, the description of the polylines is given after the subsection on

the parameters of the splines. 

To start creating a spline, you need to set the first characteristic point: it can be specified using , or you

can specify its exact coordinates in the properties window.

To finish a spline creation press , <Ctrl + Enter> or complete the input using the window called by

. The spline will be built to the last defined characteristic point.

If you press  once, the sequential input of characteristic points of the spline will be stopped and the

spline will be in edit mode. You can resume entering points using  and  .

The type of the spline may be changed during the input process. To do this, click one of the icons in

the properties window. After that, a spline of a different type is constructed along the entered

characteristic points.

A spline of the first order can be constructed from two points; a spline of the second order can be

built in three points; in order to construct a cubic spline, four points are necessary. When creating a

spline, its order will automatically increase to the third. All splines by default are created as cubic. If

you finish entering before defining the fourth point, a linear or quadratic spline will be created. The



Drawing Creation

451

order of the spline is indicated in the properties window in the "Advanced" section. More information

about the additional parameters of the spline will be discussed in the section "Spline parameters".

Spline

<Shift>+<H> Spline

The spline is created by successively entering the coordinates of the characteristic points. The points

can be specified using , or you can specify their exact coordinates in the properties window. If the

coordinates are specified in the properties window, they should be confirmed by pressing <Enter> or

pressing  in the drawing field. The coordinates of the current point are located at the bottom of

the spline parameters tab

.All the characteristic points are consequently displayed on tab of the spline parameters. Their

coordinates can be changed. You can add points to the beginning or end of the spline, as well as to

any necessary place of the spline using the icons  and . 

If, for example, you need to add a new point between the second and third point, then you can select

the coordinates of the second point using  and then click . After this, the current point will be the

new point after the second. As before, its coordinates can be specified using  in the drawing field, or

by entering exact values.

Both in the case of sequential input of points, and when additional points are entered, the change in

the geometry of the spline will be dynamically displayed. Variants of the position of the new point will

be determined by the position of the cursor. When specifying the characteristic points of the spline, all

the usual bindings indicated in the bindings panel are available. Adding points with the help of 

and  icons, both at the beginning or end of the spline, and in the specified area, the creation of the

next new point will be proposed automatically. You can finish inputting new points the same way as

completing the input of the spline.

Extra spline points can be deleted using . The coordinates of the selected point can be copied

using . The copied coordinates can be passed into another point using .

New spline points can be added in the spline editing mode. To do this, just hover cursor over the

spline and a dynamic image of a point moving along the spline and following the cursor will appear

under the cursor. You should to specify the position of the point on the spline using .

Spline by Polyline

<Shift>+<J> Spline by Polyline

The principle of input of this spline is similar to the input of the usual spline Spline, where you should

consequently specify the characteristic points. However, the Spline by Polyline does not pass through

the characteristic points. In this type of spline, characteristic points define a polyline along which the

spline is constructed. 
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A polyline that defines a spline is indicated by a thin dashed line when creating or editing a spline.

The image of characteristic points - as in other lines of a drawing. The position of the current

characteristic point coincides with the cursor. The geometry of the spline is changed dynamically

according to the position of the point.

The influence of each characteristic point on the spline is determined by the Weight parameter. The

point can be suppressed - then the spline will be rearranged in the same way as if the point was

removed.

Closed Spline

A closed spline passing through nodes is constructed using the option:

<Shift>+<K> Closed spline

The principle of a closed spline creation does not differ from the standard spline creation. It is

necessary to consistently create characteristic points that will determine the form of a closed curve.

The dynamic image of the spline will appear only after entering the coordinates of the second point,

since a closed curve can be created at a minimum of three points: Two of the points will be already

set by the time the spline is displayed, and the position of the third will correspond to the position of

the cursor. 

Entering new points on a closed curve will occur in the area between the last and the first

characteristic point. If you need to add points in other areas, you can do this by clicking . Then you

should select a point, before which or after which you want to add a new point in the properties

window. Then use the icon  or . 
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Closed Spline by Polyline

<Shift>+<L> Closed Spline by Polyline

The principle of entering the characteristic points of a closed spline along a polyline is similar to the

principle in the Closed Spline option. As in the Spline by Polyline option, characteristic points define

the polyline along which the spline is created, and for each point there is an additional parameter

Weight.

Spline Points Parameters

The parameters of the characteristic points of the normal spline and spline by polyline are different.

Only one weight parameter (this parameter has already been described) and the ability to suppress

the point are available for the characteristic points of a spline by polyline. As it was already

mentioned, if you suppress a point, then it does not affect the creation of the spline, in the same way

as if you delete it. The advantage of the Suppress option is that it can be set via a variable.

The parameters of characteristic points of options Spline and Closed spline provide great

opportunities in the settings of the mathematical description of the spline. 

It is possible to set the following parameters of the point:

· The length of the first derivative (the length of the tangent vector);

· Vector Angle;
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· Radius of Curvature;

· Accuracy;

· Suppress Point.

The length of the tangent vector can be set exactly in the properties window, and an approximate

value can be set using the manipulator. By default, the length of the tangent vector is given in mm, but

the units of measurement can be changed. To do this, click  on the icon  of units.

The manipulator does not show the real length of the tangent vector, because the arrows of the

manipulator are adapted to the current scale for convenience. Similarly, you can set the angle of the

tangent vector: both with the help of the manipulator and in the properties window. The units of

measurement can be changed (by clicking the icon  in the angle input field). By default the angle is

measured in degrees [°]. 

The radius of curvature is specified in the same units as the length of the tangent vector. This is

because the radius of curvature is a quantity depending on the functions of the spline and its

derivatives. Therefore, if the units of measurement are changed in the field of values of the length of

the tangent vector, then they will also change in the field of curvature radius. The symbol of the radius

of curvature determines the direction of twisting of the spline: “-” sign will be clockwise, “+” sign will

be against clockwise.

If the length of the tangent vector, the angle or radius of curvature were changed relative to

those parameters that were calculated automatically, a flag is placed next to them and the value

will be applied. If the flag is removed, the default value will be calculated.

The accuracy sets the maximum possible deviation of the spline from the points defining it. By default,

the accuracy value is in mm, but, as is the case with the vector length, the units of measurement may

be changed.

In order for an accuracy to be assigned for the selected point, you should enable the flag next to

the field. If the accuracy flag is not active, the spline will pass through the point.

If the accuracy is not set, then the system of linear equations is solved for the spline with respect to the

specified characteristic points. If you specify tolerance, then the problem with inequality is solved,

taking into account the maximum possible given deviation.

Accuracy can be set to those points for which it is necessary, but the accuracy value for all

selected points will be the same. If you change the value of the tolerance at one point - it will

automatically change for all other points.

For example, for the 2 point of the spline, the accuracy is not active, and for the 3 and 4 it is active (for

1, 5 and 6 points, the tolerance parameter is not active).

The Suppress option influences the geometry of the spline as if the point was deleted, but if you

disable the Suppress flag, the point will again determine the geometry of the spline.
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If changes were made in the point parameters, it will be shown in the spline properties window. 

For point number 1 - no additional parameters are specified.

For point number 2 - a fixed value of the radius of curvature is set, if the vector angle of slope or

length of the tangent vector were set, the same icon will appear.

For points number 3 and number 4 accuracy is set.

Point number 5 is suppressed.

Point number 6 is bind to the node (you can bind both to the point of a sketch and to the node on a

construction line).

Spline Parameters 

Unlike the parameters of points, the general parameters of the spline are the same for both normal

splines and polylines. The following spline parameters are available:

· Spline degree;

· Type of parameterization.

For non-closed splines:

· Start extension;

· End extension.

Spline degree determines the degree of polynomials that describe the spline: polynomials of the first,

second, third or fourth degree. By default, splines are built on cubic polynomials. If you specify the

degree of the spline equal to one - the spline becomes a polyline.

The parameterization significantly affects the shape of the spline, especially in areas with closely

spaced points that change the direction of the curve.

When changing the type of parameterization, the same parameter value may correspond to a

different position on the spline. There will be a different length of the “arc” between two

characteristic points of a spline.  

The following options for spline parameterization are available:

· By length,

· Centripetal,

· Uniform,

· Local sums,

· Fixed,

By default the Centripetal parameterization is used for splines.

Uniform. The characteristic points Dk, where k = 0,1, ..., n, are set for creation of a spline. The definition

domain of the parameters is t [0,1]. The extreme parameters t0 = 0 and t1 = 1. Other parameters 1 / n,

2 / n, ..., (n-1) / n.

With uniform parameterization sharp protuberances, peaks, loops are possible more often than in

other methods. At the same time, this type of parameterization is the most simple and intuitive. 
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By length. Parameters are distributed in accordance with the length of the arcs between adjacent

points. The arcs between the points are curves constructed on polynomials, i.e. the spline can be

represented as a sequence of such arcs.  

The characteristic points Dk, where k = 0,1, ..., n, are set for creation of a spline. 

The length of all arcs (spline length) L will be determined by the expression:

Arc length Lk from D0 to Dk:

The definition domain of the parameters is t [0,1]. Each tk parameter should match the length Lk,

then:  

t0=0 ,where k=0,1,…,n-1

t1=1

The arc length parameterization method is widespread and usually works well. You should take into

account that the polynomial spline between two points is not an arc — it can be considered an arc

only approximately. If the arc is long, a spline constructed using this type of parameterization can

have a great convex. 

Centripetal. The name of the method reflects its physical interpretation. When moving along a spline

trajectory - the stronger the bend, the greater the centripetal force. The centripetal force is

proportional to the angle change. The centripetal parameterization method is an approximation to

such a physical model. From the point of view of mathematics, the centripetal method of

parameterization is a modification of the method of parameterization by length.

The characteristic points Dk, where k = 0,1, ..., n, are set for creation of a spline. The definition domain

of the parameters is t [0,1]. We introduce the exponent α, which will modify the expressions of the

method of parameterization by length:

t0=0 ,where k=0,1,…,n-1

t1=1

If α = 1, then the centripetal parameterization and parameterization along the length give the same

creation result. 

If α 1  and , then the influence of a longer arc decreases. Influence means the value of the parameter

change for the corresponding arc. 

If α<1  and , then the influence of a short arc increases.

1 - Uniform parameterization, 2 - Arc parameterization, 3 - Centripetal parameterization

Local sums

This parameterization method is available for compatibility of splines built in T-FLEX CAD 15 and

earlier. When creating splines in T-FLEX CAD 16 it is better to use the three listed above methods. 



Drawing Creation

457

Fixed. When changing the position of characteristic points or adding points, the parameterization of

the spline is recalculated. This is necessary when creating or editing a new spline, therefore, for the

spline being built or being edited, the option of fixing the parameterization is disabled. If the spline

was split (Split), or trimmed (Trimming) or imported from another system, then it will have a fixed

parameterization. In the fixed parameterization mode, spline editing is limited. This is due to the fact

that the length of the arc changes upon editing but the parameters values are fixed. When distance

between points increases, flat areas can be formed, and when it decreases, loops are formed. 

When trimming or splitting a spline, its parameterization type automatically becomes fixed. The

type of parameterization for a fixed spline can be changed, but then its geometry will change. In

the fixed parameterization mode, it is permissible to make only minor adjustments to the spline.

If the spline is built on three or two points  after editing, then changing the parameterization from

fixed to any other is not recommended. By default, splines are built on the basis of cubic polynomials,

and three points for the correct construction of a cubic spline are not enough. It is necessary either to

lower the degree of the spline, or not to change the type of parameterization.

If the spline was split (Split), or trimmed (Trimming), then to save the geometry, the first and second

derivatives are fixed at the two extreme points of the spline. If spline editing is necessary, it is

recommended to remove the fixation of derivatives.

Offset allows you to lengthen the spline, or shorten (if you set a negative offset value). If the spline is

lengthened, then it is necessary to choose the law of creation of the elongated part of the spline. For

this, there are special options in the properties menu that will become available if you set a flag to

activate the Start extension and/or End extension.

 Let us consider the offset options.

Control determines how to set the length of the offset section. If the option By length is selected, then

the length is set by the value in the selected units of measurement. If the option By parameter is

selected, then the length of the extension region is specified in relative values. The influence of the

parameter value on the length of the extension region depends on the type of parameterization of the

spline.  Negative length and parameter values will shorten the spline. 

Method of extension determines the law of the construction of the offset region. For negative offsets,

the method of elongation does not affect the geometry of the spline.

The following extension methods are available.

· By straight line. With this method, only the first derivative is a smooth function. At the point of

the beginning (end) of the spline, a tangent is constructed. Along the tangent, the

displacement is calculated. Curvature is not preserved.

· Keep curvature. Both the first and second derivatives are smooth functions. This automatically

sets a smooth decrease in curvature to zero. The offset section becomes straight with

preservation of curvature.

· Mirror. The spline is reflected symmetrically relative to the line perpendicular to the tangent

built at the point of the beginning (end) of the spline.
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1 - source spline; 2 - extension section; 3 - tangent at the point of origin; 4 - perpendicular to the tangent

· By parameter. The curvature is preserved; a smooth decrease of the curvature occurs

throughout the entire offset section. If the length of the offset section in the selected

parameterization method reaches unity, then the curvature is zero and the radius of curvature

is infinitely large.

· By arc. Only the first derivative is a smooth function, the curvature is not preserved. A tangent

arc of a circle is constructed from the point of the beginning (end) of the spline, whose radius

is equal to the radius of curvature at the point of the beginning (end) of the spline.  

Smoothness of splines at extreme points

If the extreme point of the spline coincides with the extreme point of another spline or line, then you

can specify one of three options for the smoothness of the spline at the point of its transition to

another line. The smoothness options are available in the pop-up menu when selecting the extreme

point of the spline (provided that the extreme point coincides with the extreme point of another line),

as well as in the automenu. 

Smooth variations are denoted as G1, G2, G3.

<Shift + 1> G1 -  the directions of the tangents coincide in the extreme points of the lines. This means

that the angles of the first derivative of the lines at the extreme points will either be equal or differ by

a multiple of 180°. For example, let's build two consecutive splines: the last point of the first spline

coincides with the first point of the second. For the second spline at the first point, choose the

smoothness G1. Now compare the angles of the tangent at the last point of the first spline and the first

point of the second. The figure shows that they are equal. 

It should be noted that other parameters of the extreme points when using the smoothness of the G1

are different.

The use of G1 smoothness is possible only for splines of the second order and higher.

<Shift + 2> G2 - in the extreme points of the lines the directions of the tangents coincide and the centers

of curvature coincide. This means that the equality of the radii of curvature at the extreme points of the

curves is added to the condition G1. For example, build an arc with a radius of 35 mm from which is

continued by a spline. We indicate the G2 smoothness at the first point of the spline. Now let's look at
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the radius of curvature at the first point of the spline. It can be seen from the figure that it is equal to

35 mm. 

It should be noted that the sign of the radius of curvature reflects the direction of twisting of the

spline (this was mentioned above). In addition, if you construct a tangent at the extreme point of the

arc, then you can make sure that its direction will coincide with the direction of the tangent of the

spline, since the angle of the constructed tangent is equal to the angle of the first derivative at the first

point of the spline. 

In the case when the spline and the curve to which the extreme point belongs have different twisting

directions, the point of sign change (inflection point in the case of continuity) of the curvature function

is at the extreme point of the spline. When using G2 smoothness, the inflection point will shift inside

the spline, and a bend will be added to the spline itself with the same direction of twist as the curve to

which the extreme point belongs. This is necessary to satisfy the condition of coincidence of the

centers of the circles of curvature of the lines at the extreme points. Let's give an example. Let two

consecutive splines be given. The last section of the first spline is twisted clockwise, the first section of

the second is twisted in the opposite direction. We derive the curvature for these splines using the

Show Curvature command (this command will be discussed in more detail in the next subsection).

It can be seen from the figure that the curvature function changes sign at the last point of the first

spline and the first point of the second spline, and in this case with the function breaking. 

Apply the smoothness of G2 to the last point of the first spline. It can be seen from the figure that the

inflection point has shifted into the first spline: a small section was added to the first spline with a

twisting direction corresponding to the direction of the second spline.

It should be noted that the curvature function became continuous, but at the extreme points the

smoothness of the curvature function is broken. To maintain the smoothness of the curvature function

at the extreme points of the spline, there is a third version of smoothness.
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The use of G2 smoothness is possible only for splines of the third degree and higher.

<Shift + 3> G3 - in the extreme points of the lines the directions of the tangents coincide, the curvature

centers coincide and the directions of the tangents to the curvature function coincide. This means that the

condition for the smoothness of the curvature function is added to the conditions G1 and G2. We

continue the previous example with two consecutive splines. For the extreme point of the first spline,

instead of the smoothness of G2, we choose the smoothness of G3. It can be seen from the figure that

when using G3 smoothness, the curvature function preserves smoothness at the extreme points of the

splines.

The use of G3 smoothness is possible only for splines of the fourth degree and higher. If the

spline has a lower order than the fourth, then when you select the smoothness of the G3, the

degree of the spline will be automatically increased to the fourth.

If we consider the smoothness of G1, G2, G3 from the point of view of their influence on the curvature

function, then we can formulate the following rule:

G1 - the curvature function does not preserve continuity at the extreme points;

G2 - the curvature function is continuous, but does not preserve smoothness at the extreme points;

G3 - the curvature function is continuous and retains smoothness at the extreme points.
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G1 G2 G3

A variant of the smoothness of the extreme points can be seen in the properties window of the spline.

The tangent angle at the extreme point can be changed by 180°. For this, in the pop-up menu and

automenu of the extreme points of the spline, in addition to the options for smoothness, there is also

the command <Shift + 4> Reverse Tangent Direction.

Spline Analysis

There are two main parameters in spline geometry analysis: curvature and radius of curvature.

Curvature - the reciprocal of the radius of curvature. Curvature allows you to check the smoothness of

the spline - preservation of curvature (smoothness of the second derivative). Curvature and radius of

curvature are measured using the  Curve Curvature command. This command can be called by

selecting the  Show Curvature option in the contextual menu, which appears upon right-clicking

a spline. The command displays diagrams of either curvature, or radius of curvature for the

selected curve depending on applied command's parameters. Curvature measurement helps to

understand the difference in the law of construction of offsets for a spline. Some of them allow to

preserve the smoothness of the second derivative (curvature), some - only the first (tangent).
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Offset by length: 

 first derivative is smooth function,

  second (curvature) has a break.

Offset by parameter: 

curvature without kinks, 

a smooth decrease in curvature

The  Curve Curvature command has the option to measure curvature values at any point.

<C> Measure curvature at arbitrary point

When you call this option on the spline (as on any other line), a dynamically moving point will appear.

Clicking  at the point under the cursor will measure the curvature and radius of curvature. The

curvature and the radius of curvature are measured in meters for ISO documents and in inches for

ANSI document. 

Polylines

<Shift>+<G> Polyline

<Shift>+<F> Closed Polyline

As mentioned above, the polyline is a spline of the first degree. The principle of constructing, editing

and adding new points is similar to the spline. For polylines, there are no additional spline parameters

and no point parameters. Point can only be suppressed.   

Visually, when creating a polyline, we get consecutive segments. However, the interrelations of these

segments is different than if we would draw segments in a coherent sketching mode or parametric

segments (with constraint). In contrast to the specified options, a broken polyline is a single object. 

For example, parts of a polyline cannot be rounded together, and when a segment is deleted, the

deleted part will consist of a set of segments. You can create an offset curve to the polyline. 
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Chamfer and Fillet

Chamfers and Fillets Creation

The commands for chamfering and rounding in the auto-menu are combined into one list. In the

automenu list is called when you hold the fillet or chamfer icon. When working with these sketches

commands, the list will be hidden under that icon, the command of which was called last.

In the Ribbon, chamfering and fillet are caused by separate icons that are not combined into a list.

When constructing chamfers and fillets, the existing graphic lines are modified, and new ones are

formed. Select two lines and specify the chamfer or fillet parameters to create chamfers and fillets. In

this case, the chamfer can be constructed only for straight intersecting lines. The rounding can be

constructed for any lines.

Fillet

Keyboard Ribbon

<SK>><Shift>+<B> Draw > Sketch > Fillet

Icon Textual Menu

Draw > Sketch > Fillet/Chamfer

You can round any corner: straight, obtuse, sharp.

Also, using the Fillet command, you can create tangent arcs of a given radius between sketch lines that

do not intersect.

It is necessary to select two lines successively to create fillet: you should select the first with the help of

 and place the cursor on the second. All variants of the position of tangential arcs of the specified

radius that can be constructed between the selected lines will be automatically determined: they are

shown in dotted lines. At the same time, the current fillet option is displayed by a thickened blue line

of the drawing. The first proposed rounding variant depends on the position of the cursor when
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selecting a line. You can change the position of the fillet arc by moving the cursor, or you can use the

<Z> key. 

You can also change the way of tangency to the arc with the <R> key.

You can build the current rounding option using the  or <Enter> key. 

The thickened blue line defines the geometry of the sketch line to be created. The original lines are

highlighted in red. Source lines can be trimmed: To do this, you should specify the appropriate flag in

the properties window (by default, trimming lines is enabled). If the option flag is cleared, the original

lines will remain unchanged. In the properties window you should also specify the radius of the

rounding.

If the rounding radius cannot be built for the selected lines, a corresponding warning will be

displayed. 
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After constructing the rounding radius, the resulting line will be an arc. You can change the

rounding radius only with the parameters available for the arc.  

Chamfer

Keyboard Ribbon

<SK>><Ctrl>+<B> Draw > Sketch > Chamfer

Icon Textual Menu

Draw > Sketch > Fillet/Chamfer

In addition, as in the fillet command, a chamfer can be constructed between segments that intersect at

a right, obtuse or sharp angle.

In addition, as in the fillet command, when the intersection of the segments is not at the point of their

beginning or end, there are four options for constructing a chamfer. To select the necessary variant of

chamfer construction, it is necessary to select segments in the place where it is planned to create a

chamfer. Lines beyond the chamfer can be trimmed or not trimmed, which is indicated by the

corresponding flag in the command properties window (by default, trimming of protruding lines is

active). 

If the lines do not intersect or the size of the chamfer is too large for the selected segments, then the

chamfer cannot be built and a warning will be displayed. 

After the chamfer is created, the line will become a segment. When editing a chamfer line, only

segment parameters will be available.

Three options for defining geometry are available in the chamfering command:

· Symmetrical chamfer 

· Chamfer by offset 

· Chamfer by angle and offset 
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To select the necessary type of chamfer in the properties window, click on one of the three icons. The

default is symmetrical chamfer. The selected type of chamfer changes the geometric parameters that

must be specified for its construction.

Offset Curve

This command is used to create a line that is offset to a specified distance relative to the group of

conjugate graphic line. The group of lines can include segments, circular arcs, and splines. In addition,

segments and arcs obtained by rounding and chamfering options can be included. The main condition

is that the lines should be a continuous sequence: the end of one line must correspond to the

beginning of the next. 

Keyboard Ribbon

<SK>><Ctrl>+<J> Draw > Sketch > Offset

Icon Textual Menu

Draw > Sketch > Offset of a group of graphic lines

The lines from which the offset curve is constructed can be either smoothly conjugated or not (1 -

spline; 2 - arc; 3 - segment).

It is possible to construct an offset curve from a closed contour (3 - segment; 4 - arc obtained by fillet;

5 - segment obtained by chamfer).

If the Sequence selection flag is set to create an offset curve, it is enough to specify at least one line

from a continuous sequence using , all the others will be found automatically. In the case of branching

lines, you must specify a further sequence of lines using . 

If the sequence selection mode is disabled, each line must be manually selected using .

The Copy Style flag allows you to transfer the properties of source lines (type, thickness, color, etc.) to

the offset curve. Setting the Round corners flag will result in an automatic rounding of the kinks of the

created curve (6 - offset curve with copying style; 7 - offset curve with corner rounding).
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The option Consider self-intersections - cuts off parts of the curve behind the intersection point,

leaving only a closed contour. 

In the process of creating an offset curve, a dynamic image of the created curve will be attached to

the cursor. The position of the offset curve can be set arbitrarily with  or precisely by specifying the

exact offset value in the properties window.

Symmetry

Any graphic line can be displayed symmetrically: segments (including those obtained by the Chamfer

option or when constructing rectangles and polygons), arcs (including those obtained by the Fillet

option), circles, ellipses, splines, offset lines, axial lines (including those obtained in the Axial mode),

and all lines obtained after modification.

Icon Ribbon

Draw > Sketch > Symmetry

For example, we will have a sketch containing all of the above sketch lines. To perform symmetry, it is

necessary to select the lines that need to be symmetrically copied. You may select lines first and call

Symmetry command. Other way you may call the command and then select required lines. In the

second case, you will need to confirm the selection (the key combination <Ctrl + Enter>). The choice

of lines is carried out in the usual way using  with pressed <Shift> if you need to select several lines.

Holding  can select a group of lines at once by moving the cursor. Moving the cursor from right to left

- all lines will be highlighted which touched by the area under the cursor, moving the cursor from left

to right - only those elements that completely fell into the area under the cursor. Using the <M> key,

or using the icons in the automenu, you can change the line selection mode to deselect lines and vice

versa. If during selection of lines extra elements were selected, then switching the selection mode,

without canceling the necessary lines, you can cancel selection of excess ones.
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After the necessary lines have been selected and confirmed (<Ctrl + Enter>), two points should be set

on the drawing that define the line of symmetry. You can set them using , or you can enter the exact

coordinates in the properties window. When selecting points, all standard bindings are enabled. When

a second point is selected in dynamic mode, the position of the symmetrically displayed lines will be

shown.

Methods for Modifying Graphic Lines

Extend/shorten 

Modification of lengthening and shortening can be used to edit segments of arcs and splines.

Keyboard Ribbon

<SK>><Ctrl>+<I> Draw > Sketch > Extend

Icon Textual Menu

Draw > Sketch > Extend graphic line

You need to choose a graphic line that you want to extend or shorten with the help of . The selected

item and possible options for its change will be highlighted: if it is an arc, then a fixed circle will
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appear, if it is a spline then a fixed line of the spline will appear. In this case, a spline at the first

editing can only be shortened, since beyond the spline line the position of the points is not defined.

To extend a spline, there is a special option Offset available when creating a spline (the description of

this option is given in the subsection “Spline Parameters”). When selecting a segment, no additional

lines appear. 

The editable element will be displayed in red before the change. Also, the extreme node of the

selected element is highlighted. It is the one to which the cursor was closest to the moment of

selection. This node can be moved along the displayed fixed line with the help of the cursor (or simply

along a straight line, if a segment is selected). It is possible to fix the position of the node, and,

therefore, the new display of the element using . You can also select a sketch line with which you want

to intersect by lengthen or shorten the edited element.

The geometry of the modified spline after using the extension and shorten commands will be

determined along the entire original line of the spline. After applying the considered command,

the line of the spline can be edited, including the part that is invisible after shortening. The

invisible part will be displayed as a thin dashed line. Editing such a dashed line can affect the

geometry of the visible part of the spline. In the case of spline extension, the fixed line, along

which the node bounding the visible line moves, also changes. 

Trimming

You can trim (remove part of the sketch line) any sketch line: a segment (including center lines), a

circle, an arc, an ellipse, or a spline.

Keyboard Ribbon

<SK>><Shift>+<I> Draw > Sketch > Trim

Icon Textual Menu

Draw > Sketch > Trim Graphic Lines

In order to trim a graphic line you need to select a section to be deleted using  in the Trim command

mode. The selected area can be bounded on one or two sides by any graphic line (if you choose a line

that is not limited by anything, it will be removed completely). If the free end of the line was chosen, it

will be trimmed by the nearest intersecting line. If the selected line is limited by two intersections, then

the part of the line between intersections will be removed.
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When trimming a spline line on a spline, new characteristic points appear, created at the

intersection of the spline with its bounding lines during trimming. Behind the points, the spline is

not defined by anything, i.e. unlike the Extend/Shorten command, there are no invisible lines

defining its geometry outside the visible line of the spline. Since new characteristic points

determine the geometry of the spline, after the trimming operation, then you can adjust the

spline by changing their position.

Split

Keyboard Ribbon

<SK>><Ctrl>+<K> Drawing > Sketch > Split Graphic Line

Icon Textual Menu

Design > Sketch > Split graphic line

Commands combined in one drop-down menu are used to split existing graphic lines into several

parts.  Both in the Ribbon and in the automenu the commands are grouped in the same way.

The Split command allows you to split an existing graphic line into two at a specified point. To do

this, press  to select the graphic line. It will be highlighted and a dynamically moved image of the

point dividing the element into two parts will appear on it. After pressing , the point is fixed and the

line is divided into two. The point can also be specified as the point of intersection of the selected

element with any other graphic line (line segment, circle, arc, and spline). To do this, select the graphic

line, the point of intersection with which will be the splitting point of the variable element.

When a command is executed, two characteristic points are created in the specified place: each of

which belongs to two new lines. 

If the line is closed, for example, a circle, an ellipse, or a closed spline, then you need to specify two

split points.
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Split into Parts

To split a line into an arbitrary number of equal parts, use the command:

Keyboard Ribbon

<SK>><Ctrl>+<L> Draw > Sketch > Split Graphic Line into ‘n’ Parts

Icon Textual Menu

Draw > Sketch > Split to ‘n’ parts

After calling the command, you need to press  to specify the line you want to break. If you select a

closed line (circle, ellipse, closed spline), you must additionally specify the starting point of the split.

As a result, the selected line is divided into a specified number of equal parts. The resulting lines are

not connected to each other and can be edited separately. 

The number of parts into which the line will be broken is set in the properties window. 

Sketch Snaps

Object snaps helps to set a characteristic point in the construction of drawing lines. The difference

between the principle of operation of the bindings and the principle of operation of the options for

constructing a sketch (Tangent line, Tangent arc, etc.) is that any construction option makes it possible

to choose the option of constructing one line relative to another from an infinite number of options,

and the bindings - only from specific points. When sketching, object snaps automatically look for
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points at which the constructions are perpendicular or tangent, horizontal or vertical to existing

drawing lines, look for the points of the centers of arcs, circles, ellipses, midpoints, etc. Some snaps are

illustrated by dashed lines indicating the characteristic points of the found geometric relationship.

When a snap is found next to the cursor, an explanatory pictogram appears. The pictogram simplifies

the geometric relationship found. Object snaps make drawing easier, and sometimes can replace

sketch options such as the Perpendicular Segment, Tangent Segment, and others.

Edit Sketch

Use Edit Sketch for sketch editing. The command is called via:

Keyboard Ribbon

<ESK>

Icon Textual Menu

Edit > Drawing > Sketch

You can also call the command by:

· Call the command Change sketch.

· Click  in the command waiting mode.

· Call the Edit command from the context menu after pressing .

· Select option  <F4> in the automenu of Sketch command.

Sketch lines are graphic lines. That is why you can use Edit Graphic Lines for their editing.

The following options are available after the command calling:

<*> Select all

<R> Select element from list

<Esc> Exit command

After calling the command, you should select sketch line by clicking  on it. The selected element will

be highlighted. You can select several elements by clicking <Shift>+ on them. To deselect element

you may should use  with pressed <Ctrl>.

The following options are available in the automenu after selecting one or several sketch lines:
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<P> Set selected Element(s) Parameters

<Alt>+<P> Copy Properties from Existing Element

<I> Select Other Elements

<Del> Delete selected Elements(s)

<Esc> Cancel selection

If a single line is selected, the following option appears in automenu:

<O> Create Name for selected Element

You should select required characteristic point using  to edit it after selecting a line. The

properties window will correspond the selected line: segment (line), arc, circle, ellipse, spline. When

you edit geometric parameters of a line you can use properties window.

When you move/insert sketch elements the coordinates that define their new position, can be set in

the properties window.

Edit circle or ellipse.

If the selected element is a circle or an ellipse then double pressing  on a line will enable radius edit

mode. You can specify a new radius using properties window or by changing dynamic image position

and pressing . To move a circle to another location it is required to click  on the marker in the center

of the element.

Edit arc or rounding.

You can change any arc type if you select one of the end points and move the dynamic preview to the

required position.

An additional option is available when you select an arc of a circle.

<Z> Change Arc Direction

The option changes the selected arc on the other belonging to the same circle.

When editing the arc of an ellipse, in addition to the two extreme points of the arc, two more points

are available: the point of the center of the ellipse and the point on its arc. To edit the position of any

point of the arc of the ellipse, after selecting the ellipse using , click  on the point.

Edit spline.

To change a position of the characteristic spline point, you should select the spline using , select a

characteristic point of the spline  (parameters of the spline point will become available). Then click  on

the point and enable edit mode. More information about creation and editing of splines can be found

in "Spline creation" section.

Edit Sketch with Constraints

In the case when constraints are already created for lines and points of a sketch, selection of

characteristic point for editing may be difficult in the command waiting mode. One of the ways for

enabling editing mode is to select a line using  in the command waiting mode. Then you should select

a characteristic point using . If a Coincide constraint is created (it is usually required for end points of
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a parametric sketch) for the point then a point and a constraint will obstruct each other. You should

select point, not a constraint for editing. You should suppress constraints or disable filter for selecting

them. 

To suppressed icons of constraints on the drawing you should click icon  on the View toolbar. The you

can enable sketch edit mode in the command waiting mode: select a sketch line and a point. You can

show icons again by pressing the icon again.

To disable constraints selection upon pressing  you should press  Selector icon and disable

Constraints flag in the appeared window.

After that you can enable sketch edit mode from the command waiting mode: select a sketch line and

a point. Constraints selection using  will not be able until the flag is disabled.

Constraints

Thanks to the tools of variation design, it became possible to define connections between geometric

elements (lines, circles, curves, etc.) by means of constraints — geometric and dimensional

relationships.

Keyboard Ribbon

<SC> Draw > Constraints

Icon Textual Menu

Draw > Constraints

Methods for creating Automatic Constraint.

· Infer Constrains (Automatic constraining in process of sketching)

· Find and Infer Constraints (Automatic constraining on existing sketch)

All possible variants of geometric relations are in a separate block of the Ribbon.

To set or remove constraints between elements, you can change the values of the model parameters

at any time while designing.

Geometric elements do not have a rigid hierarchical relationship and therefore constraints can be

freely assigned between them in any order. 

To create a parametric sketch based on constraints and driving dimensions, you need to create the

basic geometric elements of the future model using Sketch command. It is not necessary to

immediately define the relationship between the elements of the drawing.

Constraints and dimensions for created items can be created automatically. Automatically

created dimensions and constraints can be replaced by others. By default, automatic constraints

are disabled for 2D, and enabled for 3D. Automatic dimensioning for both 2D and 3D is

disabled. 
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You can enable and disable automatic constraints and automatic driving dimensions on the bindings

panel, using icons  and .

The list of automatically created constraints can be changed: Settings on the “Constraints and

Dimensions” tab in the “Automatically create constraints” and “Automatically create dimensions”

sections, you can specify or exclude some types of constraints and dimensions. 

Icon Ribbon

Constraints > Constraints and Dimensions Settings

When creating constraints in the sequence of selecting graphic lines and points, there is no hierarchy:

to fulfill the constraint, both the whole line and only its characteristic point can move (by changing the

line to which it belongs), both the first selected element and the second one can move. This is

connected with the very idea of variable parameterization, when the entire set of possible geometrical

positions corresponds to each interrelation (constraint) of elements. To specify all interrelations

between lines, geometry of lines and their position on a plane, you need to specify the required

number of constraints and driving dimensions.

If upon creation of the drawing construction lines are used it is necessary to remember - they

have priority. When editing a drawing, the construction lines will act as constants, relative to

which the sketch will be parametrically rearranged. In this case, the parameterization of the

construction lines themselves will be preserved, having priority over the lines of the sketch.

The following rule should be used.

You can snap sketch lines to construction lines, but you cannot tie construction lines to sketch

lines.

The created constraints can be seen as in the drawing - they are displayed with icons similar to icons

in the Ribbon, as well as in the “Model Elements” window. The icons in the drawing are located next to

those points and lines to which the corresponding limiting relationships are applied. In the "Model

Elements" window, you can highlight any constraint- then the drawing will highlight those lines and

points to which this constraint is imposed, as well as the icon for this constraint. A similar highlight will

appear if in the drawing field you move the cursor over the constraint icon.

The context menu of the constraint can be accessed by clicking  on it in the “Model Elements” window

or by clicking  on the constraint icon in the drawing. The context menu for constraints contains a

standard set of options and commands, similar to the options and commands for construction lines

and sketch lines. Consider only options and commands specific to constraints. 
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For any constraint, you can call its parameters ("Constraint properties"). The window will contain the

name of the constraint and the ability to suppress the constraint by setting the flag in the appropriate

field. You can also put the Suppress command on the variable. You can also suppress the constraint

through the context menu. If the constraint is suppressed, then there will be a special icon next to the

constraint. Similar icon appears on the drawing. 

Using the context menu, you can remove the constraint. You can also remove the constraint by

highlighting its icon in the drawing with , and then pressing the <Del> key.

Sketch Lines Degrees of Freedom

Constraints specify the absolute and relative position of the drawing lines in the drawing. In other

words they limit the degrees of freedom of graphic lines and their characteristic points. The number of

degrees of freedom of the drawing can be viewed in the properties window of the constraints when

invoking any constraint. The number of degrees of freedom determines the number of translation

options for all lines in the drawing. For example, if you draw a segment, then it will have four degrees

of freedom: we can change its length, move it vertically and horizontally and rotate. Otherwise: its end

points have two degrees of freedom. If you fix one point, then the degrees of freedom will be 2: only

one point will have 2 degrees of freedom, or else - the segment can only be rotated and its length

changed. If, in addition to fixing the point, you fix the length of the segment, then one degree of

freedom will remain rotation of a segment or moving a point along a circle.

If you draw a circle, then it will have 3 three degrees of freedom: moving vertically and horizontally, as

well as changing the radius. If segment and circle are in the drawing there will be 7 degrees of

freedom. 

The properties window always displays the total number of degrees of freedom of the drawing, taking

into account the constraints created. 

To understand which graphic lines still have degrees of freedom in the properties window of

constraints, there is a special option Show under defined lines. The option is enabled by setting the

flag. Then on the drawing the selected color (blue by default) will highlight all lines that have at least

one degree of freedom.

If the sketch is completely defined, i.e. if it does not have degrees of freedom, then the icons of the

coincidence constraint will be displayed in green, and the control dimensions will be on a green

background.

When creating parametric models, it is extremely important to fully define the sketch. When

changing driving parameters, all undetermined lines will be rearranged randomly.
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Another important point in the parameterization of the sketch with the help of constraints and control

dimensions is the fixing of the direction of the driving dimensions.

If, in parametric constructions, the control size specifies the distance between the lines, which as

a result of the parameterization can change their position, then it is necessary to fix the direction

of the control size. 

Otherwise, the relative position of the elements after rebuilding can be reversed. 

Infer Constraints 

Allows you to automatically create the most obvious and simple constraints when creating a drawing.

The mode of Infer Constraints when working with a 2D part is disabled by default, when working with

a 3D part, on work planes, it is turned on by default. You can enable and disable automatic constraints

creation is performed using  icon on the bindings toolbar. 
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Icon / Keyboard Bindings Toolbar

 <SK> > <Ctrl + F2> Infer Constraints

The types of automatically created constraints can be set in the Options > Constraints and

Dimensions > Infer Constraints group of system options. It is convenient to call the section

“Constraints and dimensions” using Ribbon, using icon  Constraints and Dimensions Settings. By

default, the constraints Horizontality and Verticality, Coincident, Tangent and Perpendicular are

automatically created. If any line is drawn tangentially to another, then a touch constraint is

automatically created, if the end point of one line coincides with a point of another line or with the

line itself - then a coincidence constraint is automatically created, Verticality and Horizontality

constraints will be automatically created for all vertical and horizontal segments. The constraint of

perpendicularity is created on all perpendicular segments, except for the case when these segments

are horizontal and vertical, since horizontal and vertical segments are already perpendicular to each

other due to constraints of verticality and horizontal position.    

Example

Consider the same drawing as in the example of the previous subsection “Driving Dimensions”. In the

previous example, the constraints on the lines were created by the user. In fact, it is faster and easier to

make constraints for such a drawing in automatic mode. To do this, after calling the command Sketch,

before starting drawing on the panel of bindings we turn on the mode of Infer Constraints  <Ctrl

+ F2>. Next, using the sketch options, create a drawing.

Create a circle, then create segments: automatically creates a Tangent constraint for a segment

tangent to a circle, for it, since the segment is located vertically, a Verticality constraint is created. For

the next, the Horizontality constraint is automatically created. For the third segment, since it is also

tangent to the circle - the constraint Tangent is created. For all points that coincide with other points

or lines, Coincidence constraint is automatically created. 
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We create a fillet using Fillet command: Four constraints are automatically created: two tangency and

two coincidence. When using the Fillet command, the Trim source curves option was turned on, as a

result, on the continuation of the trimmed segments, there remained their intersection point at which

the coincidence constraint was set. This constraint is not duplicating, since if the trim option was not

enabled, it would define the length of the segments before they intersect. But for this sketch, neither

the point nor the constraint itself is needed, so they can be removed.

Thus, using the automatic creation of constraints, a parametric sketch was created without the direct

participation of the user in the creation of the parameterization. Further, using driving dimensions, it is

possible to specify the dimensions of a parametric drawing, thereby eliminating the uncertainty of the

constructions. Regarding the origin, the sketch will be determined by the constraint Fix created for the

center point of the circle.

Find and Infer Constraints (Automatic Creation of Parametric Sketch when Construction is

Completed)

If the sketch was created when the Infer Constraints is turned off, but you need to make the sketch

parametric, then you do not have to create all the constraints manually — use the Find and Infer

Constraints command. This command allows you to create not only constraints, but also driving

dimensions, in other words, automatically create a parametric sketch. The logic of the automatic

creation of constraints and constraints includes algorithms that exclude cases when the drawing is

over defined during automatic parameterization. 

Icon / Keyboard Ribbon

Constraints  > Find and Infer Constraints

To automatically create constraints and driving dimensions on an existing sketch, select the Find and

Infer Constraints command in the Ribbon using , then select lines in the drawing using  for the

constraint creation. Holding  can select a group of lines at once by moving the cursor. Moving the

cursor from right to left - all lines which touched by the area under the cursor will be selected, moving

the cursor from left to right - only those elements that completely fell into the area under the cursor

will be selected. You can select all the lines by clicking the icon (or the <*> key). 

In the command properties window, you can customize the types of constraints and driving

dimensions that are created, by setting or clearing the flag opposite the name of a particular

constraint or driving dimension. It is possible, by removing the flag in the appropriate field, to cancel

the creation of driving dimensions or constraints, if it is necessary, for example, to create only

constraints or driving dimensions. For dimensions, Auxiliary option is available - then the created

driving dimensions will not be visible when printing the drawing. From Zero Point option creates

additional driving dimensions for defining of lines position according to the origin. The up  and
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down  icons determine the direction for creating driving dimensions relative to the lines: You can

create the dimension above or below.

The command properties window also displays the total number of degrees of freedom for the lines

in the drawing, and the Show Under Defined lines option is available. After the drawing lines have

been selected, the options for creating driving dimensions and constraints are adjusted - we complete

the input using  or <Ctrl + Enter>. The principle of creating automatic constraints in a drawing is

similar to Infer Constraints command. 

Example

Automatic parameterization of Sketch After Construction

Consider an example from the previous subsections "Driving Dimensions" and "Infer Constraints".

Suppose the sketch has already been constructed, but so far there are no constraints on it. Call the

Find and Infer Constraints option. In the command properties window, the current number of degrees

of freedom of the sketch is 20. We first cancel the creation of driving dimensions and leave only the

creation of constraints. Next, click the icon  to select all the lines, and click the icon  to complete the

command  or <Ctrl + Enter>. Eleven constraints were created automatically - information on

automatically created constraints and dimensions is displayed in a special message after the

completion of Find and Infer Constraints command. Auto-created constraints set the connection of

all graphic lines. Five tangencies created: 2 coincidence of the circle and the extreme points of the

segments, 2 coincidence of the extreme points of the arc and the extreme points of the segments and

1 coincidence of the extreme points of the segments. Thus, all successive lines are parametric

interconnected. Four tangencies created: Two tangencies between a circle and segments and 2

tangencies between an arc and segments. One Verticality constraint is created for vertical section and

one Horizontality constraint for horizontal section.

Again, go to the command Find and Infer Constraints. In the properties window of the command, you

can see that, after creating constraints, the degrees of freedom of the drawing were reduced to 6. Let

us create automatic dimensions. Since we have already created the constraints, then we will remove

the flag for creating constraints, and we will set the flag for creating driving dimensions. Add another

flag for creating dimensions from zero, i.e. from the origin - this will allow you to completely

determine the drawing. Again, select all the lines , and press the icon  to complete the command 

or <Ctrl + Enter>. The message window displays information about the created dimensions and

constraints. Close the window. The driving dimensions were automatically created, which established a

clear interrelation of all lines of the drawing, taking into account the constraints, and the specified
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driving dimensions from the origin were also created. The automatically created driving dimensions

completely determined the drawing, which is visible due to the green background under the

dimension values. It should be noted that it is not necessary to create constraints and driving

dimensions separately  — it is more convenient and faster to do this at the same time.

Special Constraints

This type of constraint is created only in the automatic mode when creating a sketch, i.e. when the

option  is enabled, for certain commands of the graphic lines: Polygon, Offset Curve, Linear

Array, Circular Array.

If the specified commands were not executed in the Infer Constraints  mode, then, using the

Find and Infer Constraints command, it will not be possible to create special constraints — the

usual constraints will be created (from the list of possible ones) for the Find and Infer

Constraints command.

Topics in this section:

· Coincidence

· Concentric

· Collinearity

· Parallel

· Perpendicularity

· Tangent

· Fixation and Full Fixation

· Fixed Length

· Fixed Angle

· Horizontality and Verticality

· Horizontal and Vertical Alignment

· Equal Length

· Equal Radius

· Middle

· Symmetry

· Driving Dimension

· Polygon Constrain

· Offset

· Linear Array

· Circular Array

· Smoothness

Coincident

This constraint creates a connection between two points (one of the points can be the origin) or

between a point and a line. The point of one object will coincide with the point or line of another

object.
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Icon Ribbon

Draw > Constraints > Coincident

Keyboard Textual Menu

<C>

If points (or point and line) do not coincide when constructing a sketch, then when using the constraint

Coincidence, lines will automatically move to such a position that the points (or point and line)

coincide. 

If the point is bound by Coincidence with another point or line, then any editing or parametrization

will keep the coincidence.

The constraint can be set simultaneously for several points (or for several points and lines).

Examples

The coincidence of the ends of the segments

Select the first point of the end of the segment with , the second point of the beginning of another

segment with  and end the input  or press <Ctrl + Enter>. The order of points is not important.

The properties menu will show the selected objects.

A yellow square marker in the drawing indicates the coincidence. If the coincidence is set incorrectly,

the marker will be red. The specified points coincide both before creating the constraint and after. The

difference is that if we move any of the segments, the other segment will be rearranged so that the

points coincide. When sketching without constraints, the segments would be independent of each

other.

The coincidence of the segment and the center of the ellipse

Select the first point of the center of the ellipse with , then the second point of the beginning of

the segment with  and finish the input  or by pressing <Ctrl + Enter>. If the selected points did

not match, then one of the objects will move so that the points match.
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When moving a segment, the center of the ellipse moved with the starting point of the segment and

the ellipse was rebuilt, since the center point shifted along with the cut, and the point defining its

semi-axis remained in place. 

The coincidence of the end of a segment and a circle

Select the first point of the beginning of the segment with the help of , then select the line of the

circle  and end the input  or <Ctrl + Enter>. The circle has moved so that the point of the

beginning of the segment began to coincide with it.

You can change the position of the circle and its radius - the point of the beginning of the segment

will always coincide with the circle.

Coincidence of Multiple Points



T-FLEX CAD 17 Help

484

Select (in any order) points sequentially with , and end input  or <Ctrl + Enter>. The

properties window will indicate that several elements of the second object have been selected (in this

case, four).

As a result, four constraints will be created for five points - for each pair of the second object with the

first one. In the drawing, it will not be visible, because the constraint icons will be located one under

the other, but this can be seen in the “Model Elements” window. Moving any of the five lines will

rebuild the rest.

Concentric

This constraint moves the points of the centers so that they coincide. This constraint can be applied to

circles, arcs and ellipses. If arcs are obtained as a result of the Fillet or Offset Curve command, then

the Concentric constraint can also be applied to them.

Icon Ribbon

Draw > Constraints > Concentric

Keyboard Textual Menu

<N>

Examples

Concentricity of Two Circles

Select the first line of the circle with the help of , then the second  and end the input  or <Ctrl

+ Enter>. One of the circles moved so that the centers of the two circles coincide. In the drawing, the

constraint is indicated by an icon similar to the one that indicates this constraint in the Ribbon.

Now, if you move one circle, the second one moves so that the centers of the circles coincide.
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Concentricity of Arc and Ellipse

First, select, for example, the arc line , then the ellipse line  and end input using  or <Ctrl +

Enter>. The ellipse or arc will move so that their centers coincide.

If you move, for example, an ellipse, then the arc is rebuilt so that its center and the center of the

ellipse coincide, while the other two points defining the arc geometry remain in place. As a result, the

arc geometry changes significantly. If it is necessary for some parameters of the arc to be preserved,

you need to create additional constraints.

Concentricity of Several Lines

Concentricity can be created for several elements at once.

Select the lines with  in any order, and end input using  or <Ctrl + Enter>. The properties

menu will indicate that several second objects have been selected (in this case, three). All objects will

move so that their centers coincide.

As a result, three constraints will be created for the four lines: each line of object 2 will be concentric

with the line of object 1. 

When moving any of the four lines or when editing a line that changes the position of the center, all

elements are rearranged in such a way that their centers coincide.
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Collinear

The constraint moves the segments so that they are always on the same line. This constraint can be

applied only to segments, including those that were obtained when constructing polygons or when

using the Chamfer command.

Icon Ribbon

Draw > Constraints > Collinear

Keyboard Textual Menu

<Q>

Examples

Collinearity of Two Segments

Sequentially select the segments with the help of , end input using  or <Ctrl + Enter>.  One of

the segments (in this case, the one that does not belong to the polygon) is moved to stay on the same

line with the second.

If the segments are located at a distance from each other, then a thin dashed line will be created

between them. However, the segments may partially overlap one another, or the short segment will

completely overlap the longer one. 

When creating a constraint, an icon appears on the drawing that is similar to the one that invokes the

command. 

When editing one of the segments, the second one will change its position to stay in line with the first.

In this case, the segments can begin to overlap or completely overlap one another.
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Collinearity of Several Segments

Select the segments in any order with the help of  and end input using  or <Ctrl + Enter>.

 The properties window will indicate that several second objects have been selected (in this case,

four). In this case, all the segments have moved to be on the same line.

Four constraints were automatically created for the five segments: one constraint for each pair of lines

of object 2 with object 1. As in the case of two segments, editing or parameterization of any of the

five segments will lead to a change in the position of the others.

Parallel

This constraint moves the segments so that they are parallel. Parallel constraint can be applied only to

segments with one exception: You can create a constraint between the axis of the ellipse and the

segment.

Icon Ribbon

Draw > Constraints > Parallel

Keyboard Textual Menu

<P>

You can create the parallelism of two or several segments. When creating a constraint, icons appear in

the drawing: one for each segment. The icon is similar to the icon in the Ribbon.

Examples

Parallelism of Several Segments
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Select the segments in any order with the help of , then end input using  or <Ctrl + Enter>.

The properties window will indicate that several second objects have been selected (in this case, five).

In this case, all the segments have moved to be parallel.

Five constraints were automatically created for the six segments: one constraint for each pair of object

1 lines with object lines 2. Each of the five segments is parallel to the first one - this is indicated using

the icons in the drawing. When editing or set parameterization for any of the six segments, the

positions of the others change in such a way that parallelism is preserved.

Segment and Axis of the Ellipse Parallelism

Having chosen the parallelism constraint, we select, with the help of , the line of the ellipse and

the segment. When we select the line of the ellipse, two points that define the axis of the ellipse are

visible.

If you edit a line or ellipse, the parallelism of the axis of the ellipse and the line will be preserved.

Perpendicular

A constraint can be assigned practically between any lines in the drawing. 

· Between two segments.

· Between a segment and a curve. In this case, the segment will be perpendicular to the tangent

to this curve.

· Between two curves. In this case, tangents to these curves will be perpendicular.

The location of the tangent occurs randomly. This is due to the fact that for any curve you can hold an

infinite set of tangents. If you want to determine the point where the tangent passes, to which the

perpendicularity constraint will be assigned, then you need to impose additional constraints. 
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Icon Ribbon

Draw > Constraints > Perpendicular

Keyboard Textual Menu

<O>

When creating a constraint, if the perpendicular segment does not intersect with another segment or

is tangent to the curve, then a thin dashed line will be added to the intersection. The dashed line will

also extend the arc to the intersection. 

Example

Perpendicularity of Segment and Spline at a Given Point

Let us be given a spline and we need to make sure that the segment to the right of the spline is

perpendicular to the spline at the point under the cursor (was perpendicular to the tangent drawn to

the spline at the point under the cursor).

If we set the limit of perpendicularity between the spline and the segment, then the point at which the

segment will be perpendicular to the spline will be chosen randomly from an infinite set of possible

ones. Therefore, you first need to set the Coincidence constraint and associate the start point of the

segment and the specified spline point. Then only one intersection point with the spline will be

specified for the segment. However, if you set the constraint of coincidence between a point on a

spline and a point on a segment, then both a segment point and a spline point can move. If you move

the spline point, the spline changes the geometry. Suppose it is undesirable for us. Then fix the spline.

We use the Fix constraint for this (this constraint will be discussed later in the corresponding section).

If during further work we do not need the constraint of fixation, then it can be removed.

Thus, there is the following sequence of actions.

· Fix the spline by Fixation constraint.

· We combine the points of the beginning of the segment and the given point on the spline by

the Coincidence constraint.

· Make the segment perpendicular to the tangent of the spline. To do this, select

Perpendicularity constraint in the Ribbon. With the help of  choose the lines of the spline and

the segment, then we finish the input  or <Ctrl + Enter>.  
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Tangent

The constraint can be created between any two sketch lines. The only exception is two segments. If

there is no additional constraint, then there are infinitely many ways for the tangency of two lines. The

point of contact will be determined randomly. In this case, the lines can change the geometry.

Icon Ribbon

Draw > Constraints > Tangent

Keyboard Textual Menu

<T>

Examples

Tangency of Ellipse and Circles

Let us be given an ellipse and two circles. Select the tangency constraint.

 

By pressing  in an arbitrary order, select a circle and an ellipse. Since no additional constraints are

specified, both the circle and the ellipse can move. The tangency can be from either side of the ellipse

and the circle. As a rule, the constraint is created in such a way that the elements move along the

shortest distance - i.e. in a straight line to the nearest possible point of contact. For example, if the

initial position of the circle was different, then the point of contact would be different.
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Finish typing using  or <Ctrl + Enter>. An icon indicating the constraint of the tangency appears

next to the point of contact. Next, by analogy, select the following two elements: ellipse and the

second circle. We finish input - there is a new constraint. Again, as in the first case, the circle moved to

the nearest point of contact.

Create a Tangent constraint between two circles. We act by analogy: choose the circle with the help of

, complete the input  or <Ctrl + Enter>. The third constraint has been created. In the "Model

Elements" window, you can see the created constraints.

By changing the initial position of the elements, you can define the sides of the tangency. For

example, it is possible that the tangency of all three lines between them will be at a single point.

Segment Tangent to Arc at Given Point

Let an arc and a segment be given. It is necessary to make the segment tangent to the arc at the point

of the beginning of the arc. 

To begin with, we will create a Coincidence constraint so that the starting point of the arc is always on

a segment. To do this, select a segment and a point with the help of . The constraint should be

selected. We finish input of constraint objects. The elements will move so that the starting point of the

arc lies on the straight line on which the segment lies. 

Now create a tangency. Select the type of constraint Tangent, then with the help of  choose a segment

and an arc. Finish entering constraint objects using  or <Ctrl + Enter>. The segment moves, the

arc is rebuilt (the length is reduced). 

Now, with all editing or parameterization options, the segment (or the line on which the segment lies)

will be tangent to the arc, at the point of the beginning of the arc.

Fix and Full Fixation

This type of constraint fixes the selected element. You can select both a line and a point. Fixation and

full fixation does the same for a point. The constraint Fix for a sketch line fixes its position, angle and
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curvature. In this case, the length of the sketch line can be changed. Full Fixation constraint

completely fixes the geometry of the sketch line, overlaying the fix automatically on its characteristic

points. If a line or point is fixed, then when creating constraints or editing a parametric sketch, the

selected line or point will be fixed. 

Icon Ribbon

Draw > Constraints > Fix

Keyboard Textual Menu

<F>

 Full fixation is available in the contextual menu of 2D elements.

Example

Full fixation is a quick way to fully define a sketch.

When creating parametric models, it is important to fully define the sketch. Otherwise, when the

control parameters are changed, the under defined lines will be rebuild randomly. Restriction Full

fixation makes it possible to fix those parts of the sketch that should remain unchanged in the

parametric model.

Suppose we have a rectangle whose height is specified by the parameter “a”, while the length of the

rectangle and the position of its upper side in the drawing must remain unchanged. We can call the

context menu for the line of the upper side of the rectangle with the help of  and select the

constraint Full fixation. Considering other constraints (which can be created automatically when

constructing a rectangle) and the driving dimension, the sketch will be completely defined. This is

shown by a green background under the driving dimension and color of the Coincidence constraint

points.  

Fixing Lines When Creating Match Constraints.
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If you create a constraint Coincidence between the extreme points of the segments and segments of

the polygon, then it can move as segments, as well as segments that are included into the polygon.

One of the options for applying the constraint Fix is the prohibition of moving selected elements

when there is uncertainty, which of the selected elements in the pair should move. 

In the tape, select Fix constraint. Using , we consecutive select all segments of the polygon, we

complete the entry of constraint objects using  or <Ctrl + Enter>. Five constraints will be created,

which can be seen in the drawing by the icons that appear or in the “Model Elements” window. Then

you can already create match constraints. Now only free segments have moved.

 

Horizontal and Vertical

These two constraint can be applied to lines or axes of an ellipse.

Icon Ribbon

Draw > Constraints > Horizontal

Keyboard Textual Menu

<H>

Icon Ribbon

Draw > Constraints > Vertical

Keyboard Textual Menu

<V>

If you apply the constraint Horizontality, then the segment (the axis of an ellipse) will take the

horizontal position and will save it when you edit a sketch. Horizontal implies parallelism to axis OX. 

If you apply the Verticality constraint, the segment (the ellipse axis) will take the vertical position and

will save it when editing the sketch. Verticality implies parallel to OY axis. 

Example

Horizontality and Verticality of Segments and Axis of the Ellipse

Let us be given three segments and three ellipses. We create Horizontality constraint for two

segments and an ellipse, and Verticality constraint for one segment and two ellipses.

Select Horizontality constraint in the Ribbon. With the help of  choose two segments and an ellipse. In

the selection process, the segments become horizontal (and can change the length), and when

choosing an ellipse, two points are indicated that indicate its axis (the one that was specified first).

The ellipse axis also becomes horizontal, while the ellipse can change the geometry. We finish input of

constraint objects using  or <Ctrl + Enter>. Three constraints will be created, which can be seen in

the drawing by the appeared icons or in the “Model Elements” window. 
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Choose a verticality constraint. With the help of  choose two ellipses and a segment. In the process of

selecting the axis of the ellipses become vertical (the axis of the ellipses are denoted by two nodes),

the segment also becomes vertical and can change the length. We finish input of constraint objects

using  or <Ctrl + Enter>. Three constraints will be created, which can be seen in the drawing by

the corresponding icons or in the “Model Elements” window.

When editing lines, segments can change length, ellipses can change dimensions of axes, all elements

can change position in the drawing, but the angle of the elements will remain the same: segments and

axes of ellipses will remain horizontal and vertical, respectively.

Horizontal and Vertical Alignment

Constraints allow you to align two points of two different lines horizontally or vertically. In other

words, set the same coordinate along the OY axis or, respectively, OX for two points of different lines.

If you select the Horizontal alignment constraint, then two points will have the same coordinate along

the OY axis. If we select the Vertical alignment constraint, then two points will have the same

coordinate along the OX axis.

You can select several second objects. Then the coordinates along the OX axis or the OY axis

(depending on the chosen constraint) will be interdependent for several points. As in the previous

cases, a separate constraint will be created for each pair of elements.
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Icon Ribbon

Draw > Constraints > Horizontal Alignment

Keyboard Textual Menu

<D>

Icon Ribbon

Draw > Constraints > Vertical Alignment

Keyboard Textual Menu

<G>

Example

Alignment of Arc End Points and Spline Horizontally and Vertically

Let us be given an arc and spline. Let us make it so that the starting points of the lines will be aligned

horizontally, and the ending will be aligned vertically.

We select Horizontal alignment in the Ribbon, then with the help of  we select the starting point of

the arc and the starting point of the spline - one of the points is moved in such a way so that it is on

the same horizontal line with the second. Finishing objects input. The following constraint is created: In

the drawing, the corresponding icons appear next to the points that are aligned. The points can be at

any distance from each other, but now they will always remain on the same horizontal line.

Next, select Vertical alignment in the Ribbon, and then use  to select the end point of the arc and the

end point of the spline. One of the points is moved in such a way as to be on the same vertical line as

the second. Finish objects input. In the drawing, a constraint icon appeared next to the dots. Points can

be at any distance from each other, but now always on the same vertical.
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Symmetric

The constraint allows you to rearrange one line (or point) of the sketch so that its positioning in the

drawing (or plane) and its curvature are a symmetrical reflection of the positioning and curvature of

the other line (or point) of the sketch relative to the segment. In other words, if you select two lines of

the sketch, and then a line, then the two lines of the sketch will be symmetrically distant, inclined or

bent relative to the line, while the symmetry of the lines will be interdependent. Moving any of the

lines, changing its curvature, as well as moving and rotating the segment that defines the line of

symmetry, will lead to a corresponding rebuilding of another line, or segment defining the axis of

symmetry. 

Icon Ribbon

Draw > Constraints > Symmetry

Keyboard Textual Menu

<S>

Symmetrically displays the position, angle and curvature of the sketch line. The length of the line

is determined by the characteristic points. For feature points, you can also set Symmetry

constraint.

In this case, symmetry can be assigned only to identical constructions: an ellipse is symmetric to an

ellipse, a segment to a segment, a point to a point, a spline to a spline.  

You can make an arc and a circle symmetrical. In this case, the curvature of the arc and the circle and

the position of their centers will be displayed symmetrically.

In order for splines to be symmetric - they should have the same number of characteristic points,

the same type of parameterization, they should not have special properties of the derivative at a

point, and they should be splines of the same type.

A Symmetric constraint can be created automatically by running the Copy with Symmetry command.

To do this, when executing the Copy with Symmetry command, select the Create copies with

constraints mode in the automenu.
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<Ctrl+F> Create copies with constraints

Example

Two Arcs Symmetry

Let us be given two arcs and a vertical segment. We select Symmetry constraint in the Ribbon and,

with the help of , we first select two arcs and then a segment that will define the axis of symmetry. We

finish the entry of constraint objects with the help of  or <Ctrl + Enter>.

As you can see the constraint created, the corresponding icons appeared, the radius of the circles and

the position of their centers became symmetrical with respect to the segment, but the lengths of the

arcs and the position of characteristic points bounding the arcs are not the same. 

Create two more Symmetry constraints: for each pair of characteristic points of arcs. In the mode of

selection of objects of constraints, we choose the characteristic points of the arcs nearest to the

segment and then the segment itself to determine the axis of symmetry using . When the creation of

the constraint is finished, one can see that the near end points of the arcs have become symmetrical

with respect to the segment. 

Similarly for points farthest from the segment. Now both the bounding points of the arcs and the arcs

themselves are symmetric with respect to the segment. Any movement of the segment will affect the

position of the arcs and their characteristic points. Editing the position of characteristic points of one

arc will affect the position of points of another. The radii of the arcs are also interconnected.

Equal Radius

The constraint allows you to equate the radii of arcs and circles. You can make the radii of the two

lines equal, or you can specify one first object and several second when creating a constraint. In this

case, as many constraints will be created as many second objects were specified. In this case, the

interrelations of objects in terms of editing will be equivalent: changing each line changes everything

else.  
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Icon Ribbon

Draw > Constraints > Equal Radius

Keyboard Textual Menu

<R>

Example

Equality of Radii of Circle and Two Arcs

Let a circle and two arcs of arbitrary radii be given. Equate their radii to each other using the Equal

Radius constraint. In the Ribbon, select the constraint, then select a circle and two arcs using : One

first object and two second are selected. We finish creating the constraint. In the "Model Elements"

window, you can see that two constraints have been created. There are icons on the drawing: two

icons for the circle and one for the arc, which illustrates the pairing of the created constraints.

Circle and arcs in the process of creating a constraint will change the radius. The radius to which the

others are equated in this case is determined randomly, since no additional constraints are specified.

Further, when editing, the defining radius will be the radius of the arc or circle that is edited. 

Middle

One option for setting the constraint is to create it by three points, or by two segments and a point.

The points can be any characteristic points of the lines of arcs, splines, circles, ellipses, segments.

Icon Ribbon

Draw > Constraints > Middle

Keyboard Textual Menu

<M>

When defining symmetry constraints on three points, we define the following interrelations. The first

given point P1 and the second given point P2 define a segment through which the straight line passes

through the normal to the segment. A third point P3 will lie on this line. All the constructions in the

figure are an explanation of the principle of setting Middle constraint at three points. When creating a

constraint, these constructions are not shown.
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Another option for setting a constraint is by two segments and a point.

The first given segment L1 and the second given segment L2 determine the direction of the straight

lines, which form an angle when crossing. If we draw a bisector from the corner, then the point P3

must always lie on it. It can be explained otherwise. If perpendiculars are dropped from point P3 to

segments L1 and L2, then the resulting segments will be equal. The second explanation is also true in

the case when the segments are parallel. All additional constructions in the figure are an explanation

of the principle of setting Middle constraint over two segments and a point. When creating a

constraint, these constructions are not shown.

 

Examples

Two Lines Perpendicular to each other with Intersection in the Middle.

Let two arbitrary segments be given. Let's make so that their point of intersection is in the middle for

each of them. First, we fix the length of the segments by the constraint Fixed length. Next, in the

ribbon, select the constraint Middle and with the help of  select the two extreme points of the first

segment and the point of the middle of the second. 

We finish the entry of constraint objects with the help of  or <Ctrl + Enter>. The second segment

is moved so that the point of its middle lies on the perpendicular from the middle of the first

segment. Next to the midpoint of the second segment, an icon appears on the symmetry constraint.

Similarly, we create the second symmetry constraint: with the help of  we choose two extreme points

of the second segment and a point of the middle of the first segment, then we finish creating the

constraint. The first segment is moved so that the point of its middle lies on the straight line normal to

the second segment, and passing through the center of the second segment. Next to the midpoint of

the first segment, an icon appears on the symmetry constraint. 

Now it is necessary to make the segments perpendicular. To do this, we use Perpendicularity

constraint. The segments moved in such a way that they became perpendicular to each other, and due

to two Midpoint constraints the intersection point divides each of the segments in half. 

The Axis sets the Midpoint between the Two Segments. 
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Let three segments be given. One of the segments is an axis and is made of the appropriate type of

graphic line. We position the segments vertically using Verticality constraint (select the constraint and

with the help of  and specify three segments). Then we make them of equal length using the Equal

length constraint. Let us make the segments at the same height with the help of the Horizontal

alignment constraint (choose the lower points of the segments with the help of ). 

Then we select the constraint Symmetry in the Ribbon, with the help of  we specify two segments and

a point on the segment made by the axial line. Finish input with  or <Ctrl + Enter>. An icon of the

middle appears next to the point on the axial line segment.

When editing, the segments, due to constraints, will always remain the same length, at the same

height, always vertical, and the segment of the axis will always be in the middle.

Fixed Length

The constraint can be applied to segments and arcs. Allows to keep the length of the segment or arc

when editing a parametric sketch.

It is possible to select several lines, while in the mode of selecting objects of constraints. Number of

created separate constraints of fixed length will be equal to number of the specified lines.
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Icon Ribbon

Draw > Constraints > Fixed Length

Keyboard Textual Menu

<L>

Example

Arc Length Fixation

An arc is created by two points and a radius. Fix its length by Fixed length constraint. We select this

constraint in the Ribbon, with the help of  we select an arc, we create a constraint using  or <Ctrl

+ Enter>. Next to the arc, an icon appeared indicating a fixed-length constraint.

To make it easier to edit the radius and position of the arc, we fix the starting point of the arc. To do

this, select the Fix constraint and specify the point. Now edit the arc. With the help of  choose an

arc, then a point . Now the end point of the arc follows the cursor. The length of the arc cannot

change, the starting point remains fixed. Only the radius of the arc and its rotation relative to the first

point changes.

Fixed Angle

The constraint can be applied to lines and ellipses. The constraint fixes the angle of a segment or the

angle of the ellipse axis relative to the OXY coordinate system. The angle of the segment or axis of the

ellipse at the time of application of the constraint is fixed. If the angle needs to be changed - it is

necessary to remove the constraint, change the angle and fix it again. In the mode of selecting objects

of constraint, you can specify multiple lines. Then upon completion of the input, number of constraints

equal to the chosen lines will be created. 

Icon Ribbon

Draw > Constraints > Fixed Angle

Keyboard Textual Menu

<A>

Example

Segment Angle Fixation

A segment is given. Fix its angle relative to the coordinate system of the drawing. To do this, select

Fixed angle constraint in the Ribbon and specify segment using . When the creation of the

constraint  is complete, an icon appears next to the segment. Before we try to edit a segment, we fix

its bottom point — the effect of the constraints will be more obvious. To do this, in the Ribbon, select

the Fix constraint and specify the segment point.
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Now we will try to change the geometry of the segment by moving the free top point. With the help

of  choose a segment, then the top point . Now the segment point follows the cursor. Even if we move

the cursor to the right or left - the point will only move along the straight line on which the segment

lies. Restricting the angle fixation does not allow the segment to change the angle. 

Equal Length

This constraint determines the equality of the lengths between the two lines. The constraint can be

applied to all lines: segment, circle, arc, ellipse, and spline. You can create consecutive pairs of equal

lengths: a segment - a circle, a circle - an arc. You can specify several second objects in the constraint

creation mode - then several pairs of constraints will be created with the line of the first object. 

For objects connected by the constraint Equal length with an ellipse or spline, editing and

parameterization will be available only through driving dimensions, and for an ellipse or spline,

editing is possible both by point and control dimensions.  

Icon Ribbon

Draw > Constraints > Equal Length

Keyboard Textual Menu

<E>

Example

Equality of Arc Segment Length and Circle

Let an arbitrary segment, an arc, and a circle be given. Using the Equal Length constraint, we equate

the lengths of the lines to each other. To do this, select the constraint in the Ribbon, then select the

circle, segment and arc with the help of  and complete the creation of the constraint using  or

<Ctrl + Enter>. Two constraints were created. Since we chose the circle first, it was the first object, the

segment and the arc were the second. Accordingly, two constraints have been created: circle -

segment and circle - arc. 
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The order of interrelations for these lines is irrelevant. Changing the length of any of the three lines

will change the other two. 

For convenience of editing lines, we fix the center of the circle and the point of the beginning of the

segment. Changing the radius of a circle affects the length of the segment and the radius of the arc.

Changing the length of the segment changes the radius of the circle and the radius of the arc. Both in

the first and in the second case the lengths of the lines remain equal.

Equality of Spline and Segment Lengths

Let arbitrary spline and segment be given. Set the equality of the lengths between the spline and the

segment. To do this, select Equal length constraint in the Ribbon, then select the segment and spline

with the help of . We finish input of constraint objects. The length of the segment has changed.

Equal lengths icons appeared alongside the line and spline. 

Let us try to edit the spline. With the help of  choose a spline, then a point on the spline  - the spline

point manipulators appear, by pressing  again - we start editing the point position.  Now the spline

point follows the cursor. The spline is dynamically rebuilt, changing the length of the segment. The

length of the segment is changed due to the constraint of equality of lengths. Now try to change the

length of the segment. With the help of  choose a segment, then a point on the segment .

Moving the cursor does not affect the length of the segment. To change the length of the spline

according to the change in the length of the segment - you need to create a driving dimension. The

principle of creating a driving dimension is described in the subsection “Driving Dimensions”. After

creating a driving dimension on a segment, change the dimension value. The line will change length.

The segment will change its length, the spline will also change length according to it. 

Driving Dimension

In order to fully define the drawing, you should create dimensional constraints in addition to the

geometric constraints. The driving dimension is responsible for the formation of geometry, therefore,

as it changes, the geometry of the line, on which the dimension is created, changes.
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To create a driving dimension, you need to use the standard Dimension (<D>) command, but before

that, enable the Driving Dimension constraints mode.

Icon Ribbon

Draw > Constraints > Driving Dimensions

Keyboard Textual Menu

If the dimension is set in the Driving dimension mode, then when creating it, you will be prompted to

enter a dimension value. To do this, the Edit dimension value on creation option should be active in

the dimension parameters.

Each dimension can be set driving after it has been delivered. To do this, press  and call the context

menu and put the appropriate flag. If the dimension in the drawing is not needed, but is needed only

for the parameterization and constraints of the degrees of freedom of the lines, then you can specify it

as auxiliary — then the dimension is highlighted in blue and is not printed. 

Through the context menu, you can also go to edit the value of the driving dimension - the string "Set

value". In addition, you can click on the dimension  itself in the area of its value to go to the editing of

the dimension nominal.

In the dimension value field, you can specify a variable or expression. 

If the dimension was not created as driving, but the user changed its value, then the dimension

automatically becomes driving. For this, Set "Driving" parameter when editing option is enabled. The

fact that dimension has become driving is easy to understand by its background, since unlike normal

dimensions, the values of the driving dimensions are highlighted in the background. The background

color shows the different states of dimension and geometry as a whole.

· Yellow background - the drawing is not defined and has degrees of freedom

· Green background - the drawing is defined, there are no degrees of freedom. When drawing

creation is finished, it is recommended that the system is defined.

· Red background - the drawing is over defined, i.e. there are dimensions or constraints

duplicating or conflicting each other. The other reason is that there is an error in setting the

value of the driving dimension, when the entered value cannot be provided due to other

constraint.

Dimensions can be created automatically when creating a sketch.

If the sketch mode (<SK>) in the bindings panel is on, click on the icon , then dimensions will be

created automatically. If you enable the input of driving dimensions  simultaneously with the

automatic creation of dimensions, then all the created dimensions will be driving.

You can customize the type of automatically created dimensions in the Options > Constraints and

dimensions > Create Dimensions Automatically group of system options. It is convenient to call the

section “Constraints and dimensions” through the Ribbon, using icon  Constraints and Dimensions

Settings. 

Example

Undefined, Defined and Over Defined Drawings

A defined drawing is a drawing with no degrees of freedom and no conflicting dimensions and

constraints. In general, when constructing a sketch, you should strive to ensure that the drawing is

defined. It is possible to understand that a drawing is defined if when Show under defined lines
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option is enabled there are no lines highlighted, the number of degrees of freedom in the constraint

property menu will be zero, and the background dimensions (if any dimension is created) will be

green.

The drawing is shown on the figure. There are no constraints and driving dimensions, i.e. a drawing is a

collection of unrelated lines. With the help of constraints and driving dimensions we will make the

drawing parametric and fully defined. 

The drawing has 20 degrees of freedom. The number of degrees of freedom of the drawing is

displayed in the properties window of the constraints. Let's make a Tangent constraint between all

segments, tangent to a circle and an arc.

The number of degrees of freedom decreased to 16. Next, connect all the end points of the successive

lines of the drawing to each other by the Coincidence constraint. For segments tangent to a circle, the

coincidence will be between the end points of the segments and the circle line, but not between the

points. After the creation of new constraints, the number of degrees of freedom was reduced to 8. 

Next, we assign the constraints Verticality and Horizontality to vertical and horizontal segments,

respectively: number of degrees of freedom is 6.

The constraints set the interrelations of the sketch lines and the characteristic position of the lines.

Specific dimensions of the drawing will be set using driving dimensions. In the Ribbon, with the help

of , press the icon  and call the command for dimensions creation <D>. Set the dimension of the

diameter of the circle and the radius of rounding: the number of degrees of freedom has become 4.

The background color of dimension value is yellow - which, like the presence of degrees of freedom,

indicates that the drawing has not yet been defined.

Next, we put the linear driving dimension, which sets the position of the circle, and the angular, which

sets the slope of the segment. The number of degrees of freedom has decreased to 2, and the

background of dimensions values is still yellow.

Use the option Show Under Defined lines: all drawing lines are highlighted. This means that for all the

lines of the drawing 2 degrees of freedom are available - moving vertically and horizontally. The

sketch itself is already defined by constraints and dimensions so that it cannot change its geometry,

but relative to the origin of coordinates, its position is not specified. The position of the sketch can be

determined either by specifying two linear dimensions from the origin of coordinates, or by fixing any

point. Fix a point using Fix constraint. 
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After creating a fixation constraint, the background under the driving dimensions became green, and

the number of degrees of freedom became zero. This means that the drawing is defined.  

If we fix one more point (in general, if we create one more constraint) or put another driving

dimension, then the drawing will be over defined. The background under the dimensions will turn red

and messages will appear that the constraints are recalculated with errors, since they will begin to

duplicate and conflict each other.

Polygon Constrain

This constraint is automatically created if the polygon is constructed by Polygon sketch command

(<SK> > <Shift + R>). This constraint is indicated by the  icon . Due to this constraint, when editing

and parameterization its lines and characteristic points, a polygon behaves as a single whole,

preserving the equality of sides and angles.

Example

Driving Dimension of the Polygon with Polygon Constraint

Construct a polygon in the automatic mode of creating constraints. Call the Sketch command (<SK>),

turn on the Infer Constraints (<Ctrl + F2>) mode, select the Polygon command (<Shift + R>). In the

properties of the polygon command, specify the number of sides equal to 5. Using cursor, we change

the radius of the inscribed (or circumscribed) circle, with the help of  we specify the position of the

characteristic point defining the polygon. As the point is selected, Polygon constraint is created. The

constraint icon appears near the central point, and the constraint can be seen in the “Model Elements”

window.
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Using the Fix constraint, we fix the position of the center point of the polygon, and set the driving

dimension to any dimension of the polygon.

Changing the value of the driving dimension, you can see that despite the fact that it only sets the

distance between the two extreme points of the polygon segments, the geometry of the polygon

changes completely, maintaining the equality of the sides and angles.

Offset

This constraint is automatically created if you construct an offset curve (Offset Curve <SK> > <Ctrl +

J>). This constraint is indicated by the  icon . Due to this constraint, the offset curve, consisting of

segments and arcs, behaves like a single line during parameterization and editing. The offset curve

can be constructed for source lines with constraints and for lines without constraints.

Example

Tangency of Offset Curve and Fixed Segment

A sequence of segments and arcs is constructed in the mode of continuous input of lines. Call the

Sketch command (<SK>), turn on the Infer Constraints (<Ctrl + F2>) mode, select the Offset Curve

command (Ctrl + J>). With the help of  choose a sequence of lines, and with the help of  choose the

position of the offset curve. As soon as the position of the offset curve was determined, the Offset

constraint was automatically created.  
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Add a horizontal segment to the drawing and fix it with a constraint Full Fix. Also add a full fixation to

all lines of the original sequence. Then, using the Tangent constraint, we define a constraint between

the segment and the arc of the offset curve.

The offset curve moved as a single line, maintaining an equal distance from the original sequence of

lines. The arc of the offset curve became tangent to the segment.

Linear Array

This constraint is automatically created for a linear array (Linear array <XL>). This constraint is

indicated by the  icon . Due to the constraint, the drawing lines created by the array, during

parameterization and editing, retain the relations that was set by the linear array: equal pitch and

alignment on a single line. To create this constraint, the copy mode option of the automenu of an

array command should be specified as Create copies with constraints.

<Ctrl+F> Create copies with constraints
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Example

Constraints and Driving Dimensions on the Linear Array Elements with Linear Array Constraint

Suppose we are given a rectangle (built with constraints and with a fixed point), on the left side of

which there is a circle. Using the Linear array command, copy 5 circles inside the rectangle. We check

that the Infer Constraints mode is enabled in the sketch, then through the context menu, by clicking 

on the circle, we call the Linear array command. Check that the Create copies with constraints mode is

active.

Specify the number of copies to 5, choose the starting point of the array, direction and step (for more

information on creating arrays, see the section “Moving and Copying Drawing Elements. Arrays. Use of

Clipboard" in subsection "Linear array"). As soon as the array was built, a Linear array constraint was

automatically created. A constraint icon has appeared on the drawing .

Fix the length of the left side of the rectangle, and position the horizontal of the array in the middle of

the rectangle using the Middle constraints. And also change the array pitch by setting the driving

dimension.
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Choosing the constraint Middle with the help of  we specify the upper segment of the rectangle, then

the lower one, and then the center point of any circle, for example, the first one. After entering the

constraint objects and completing the command, all the elements of the array, according to the Linear

array constraint, were moved as a whole. 

To change the array pitch, you can put a driving dimension between any points of two circles. For

example, put the dimension between the centers of the third and fourth circles. By changing the

dimension value, the user also changes the step for all elements of the array, since all array elements

are bound by a Linear array constraint. 

Circular Array

This constraint is automatically created for a circular array (Circular array <XR>). This constraint is

indicated by the  icon . Due to the constraint, the lines in the array retain the interrelations during

parameterization and editing: equal angle between the elements of the array, equal radius from a

single point of the center of the array. To create this constraint, the copy mode option of the

automenu of an array command should be specified as Create copies with constraints.

<Ctrl+F> Create copies with constraints

Example

Circular Array with Constraint upon Editing

Let us be given a circle on the same axis of which a rectangle is constructed, the center of the

rectangle lies on the axis. All constructions are created in the Auto parameterization mode. Create a

circular array of a rectangle. We check that the Infer Constraints mode is turned on in the sketch,

select the area above the rectangle with pressed , then click  on the highlighted rectangle through the

context menu and call the Circular array command. Check that the Create copies with constraints

mode is active. Specify the number of copies equal to 4, choose the center point of the array and the
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angle. As soon as the array was created, a Circular array constraint was automatically created. A

constraint icon  has appeared on the drawing. 

We put several driving dimensions on the elements of the array and change their values. Due to the

Circular array constraint, all elements have changed, maintaining the equality of the geometric

dimensions.

Smoothness

This constraint is automatically created when the command of the spline smoothness is executed.

These constraints are indicated by icons  (G1 Continuity) or  (G2 Continuity), in accordance

with the name of the created smoothness. These constraints allow you to maintain smoothness

between a spline and another curve (including another spline) when editing a spline or a curve.

Example

Spline with smoothness constraints

In Infer Constrains mode, create an arc to the left of the spline, and another spline to the right of the

spline. Two Coincident constraints were automatically created. Let us create the smoothness of G1 for

the extreme left point of the spline, and the smoothness of G2 for the extreme right point. Two

constraints of G1 Continuity and G2 Continuity were created automatically. Now when editing sketch

lines, the conditions defined by smoothness will always be met. 



T-FLEX CAD 17 Help

512

Examples

A set of examples will help you better understand how to use graphic lines. Below you can find the

examples:

Topics in this section:

· Creating non-Parametric Drawing

· Creating Parametric Drawing with Construction Entities

Creating non-Parametric Drawing

We will use the same familiar drawing example of the plate with a conical hole. Let’s begin with

constructing the main view. Thereafter, we will create two projections, the “Left Side View” and the

“Plan View”, using object snapping mechanism.

 

In this case, all constructions are created using the command <SK> Sketch:
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Icon Ribbon

Draw > Sketch

Keyboard Textual Menu

<SK> Construct > Sketch

This command can be used to create both a sketch (non-parametric drawing) and a parametric

drawing: sketch with constraints. Creating a sketch with constraints will be discussed in the next

subsection.

When creating a sketch, object snaps are widely used. Bindings are managed using the "Bindings"

panel. The currently activated bindings correspond to pressed panel icons. It is possible to disable the

established binding, by clicking on the binding icon using .

You can disable all bindings by clicking the icon:

Clear all sketch Snaps

All bindings will be enabled after disabling the option. When creating our example, the following

bindings will be needed:

Line Midpoint

Graphics End Points

Horizontal/Vertical

Orthogonal

Point on Graphic Line

Horizontal/Vertical tangent

Activate these bindings by clicking  on the corresponding icons in the "Bindings" panel. If the

binding has already been enabled, then clicking on its icon will disable it. If the icon is on a blue

background - it is enabled, if on gray it is disabled. Object bindings can also be configured in the

<SO> Options command, the Bindings tab.

When constructing segments, arcs and circles of the sketch, the coordinates of points can be set by

simply clicking  in the drawing field. To accurately specify the coordinates of the nodes, you can

use the properties window.

After calling the command <SK> Sketch, the following two options are automatically set in the

automenu:
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<J> Continuous creation

<S> Line

The first icon allows drawing continuously, so that the end of a just created line becomes the start of

the new line. This mode will stay active until the user turns it off by pointing at the icon and clicking

. We recommend keeping this option on for speedy sketching. The other option sets the segment

input mode. A black triangle in the lower-right corner of the icon marks availability of more options.

To access these encapsulated options, press  and hold a bit longer, and a menu of options will

appear. 

Attention: the automenu may display any of the encapsulated option icons in the given position.

Usually this is the icon of the last used option among the encapsulated set. 

In the Sketch command, nested icons are used when grouping actions aimed at creating a certain

group of elements, for example: creation of segments, arcs, circles.

On the screen you will see the cursor in the form of a small square. Move the cursor to the bottom

right part of the intended main view, near the center of the drawing, and click . The first point of

the segment will be set, to which the dynamic “rubber thread” cursor will be attached, displaying the

position of the created segment. In this case, the coordinates of the first point of the created segment

will be recorded in the properties window.

When building, it is necessary to take into account that space will be required along the edges

of the drawing later on for dimensioning.

Move the cursor up. Note that in the properties window, the coordinates of the cursor and its offset

relative to the first point of the segment are tracked. We can use the parameters window to specify

the exact position of the end of the segment. You can set the location of the second point of the

segment in several ways: in Cartesian coordinates, indicating the absolute coordinates of the second

point of the segment (X, Y), in Cartesian coordinates, indicating the offset of the second point relative

to the first (dx, dy), in polar coordinates (L, A) or a combination of these methods.
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Define the second point of the segment, specifying its offset relative to the first point. Set the value of

the “dx” parameter to zero, and for the “dy” parameter set the value to 100. At the same time, the

absolute coordinates of the second point of the segment will be automatically entered in the “X” and

“Y” parameter fields and the flag next to these parameters will be checked. Selecting the flag will

prevent changing the corresponding coordinates when moving the cursor in the drawing field. The

specified location of the second point of the segment will be shown on the screen.

To finish entering the coordinates of the second point, press <Enter> or , in the drawing field. This

will create the first segment. Move the cursor to the left and set the length of the segment to 150. A

circle with a radius of 150 mm will appear. Along the circle the second point of the segment will

move, following the cursor. 

Find the position at which the perpendicular binding will appear. If the binding to the first segment

does not work, then first move the cursor to the first segment, thus marking the line to which you want

to look for bindings. Next, move the cursor to the left and find the position of the perpendicularity of

the two segments and press <Enter> or . 
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Next, move the cursor down and find the position at which the perpendicularity to the upper segment

will be enabled and horizontal alignment to the lower point of the right segment. If the bindings to

the segments are not found, then hover over the segments sequentially with the cursor. Once the

necessary position of the second point of the third segment has been found, press <Enter> or .

Move the cursor to the right, to the lowest point of the first line. The binding to the end points of the

graphic line will be activated. Press <Enter> or . After that, you are still in the sketch creation

command in continuous line input mode. The next step is to round the corner of the plate. To do this,

select the Fillet option.

 

<Shift+B> Fillet

This option is nested and may not be displayed in the automenu. It may be found in the group list (see

the description above). The option is always visible in the Ribbon.

After accessing the option, the parameters window will change its appearance. Now you can set the

required rounding radius. Set the radius value to 31 and make sure that the Trim Initial Lines flag is

enabled.

Now it remains to choose two segments using . At the intersection of the sections it is necessary to

construct a given round. In our case, this is the upper and rightmost segments of the plate. After

selecting the last segment, rounding will occur, and the excess parts of the segments will be

automatically cut off.
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Now we will draw the image of a conic hole on the main view. To do this, we construct two axial lines,

thereby determining the exact center of the circles. Set the option:

<S> Line

To create center lines, you should set the appropriate line type. In addition to the type of lines, you

should also specify the protrusion of lines at the beginning and at the end. Set the dash-dotted line

type in the properties menu or in the graphic line parameters by calling the dialog box with the

option:

<P> Set Graphic line Parameters

Move the cursor to the left segment of the image so that it binds to the middle of the segment. As

soon as the binding will be enabled, the corresponding tooltip and icon will appear. Clicking  to

determine the first point. Move the cursor along the perpendicular from the left segment to the right

segment, and stop it when the binding Point on Graphic line is triggered, as shown in the figure. Click

 to create a centerline. 

Since you work in the mode of continuous input of lines, then the next segment will be built from the

last point. You do not need further construction from this point, so click .

In the same way, build a vertical centerline starting at the bottom segment.
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Now create circles. First, set the main line type of the graphic line in the command parameters by

calling the dialog box using the <P> option, or in the properties menu. Also replace the line end type

with a regular one. Then select the option:

<O> Circle by center

This option is also nested and may not be displayed both in the Ribbon and in the automenu. It may

be found in the group list.

After calling this option, move the cursor to the intersection of the two center lines. One of the many

bindings at this point will appear, for example, as in this case, the middle of the vertical axis. Click .

A dynamically changeable circle appears on the screen.

    

In the properties window, set the value of the radius of the small circle of the conical hole to 25, and

press the <Enter> button. The circle is fixed on the screen. Without leaving the option of creating a

circle, build a circle with a radius of 35 mm. Thus, the construction of the main view of the detail can

be considered complete.

    

Now we will construct the left view. To do this, set the mode for creating segments using the option

. Move the cursor to the right side of the drawing and position it so that the horizontal link with

the point lying on the top segment of the main view is activated and click . 
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In the properties window, set the length to 35 and for the second point of the segment lying on the

circle, find the binding of horizontality. Press <Enter> or . A new segment will be fixed on the

screen, and from the last created point there will be a “rubber thread” of the next segment. Next,

move the cursor down vertically until the horizontal reference with points of the lower segment of the

main view appears on the screen. If the binding does not appear, move the cursor to the lower

segment and again find the positions with two bindings: verticality and horizontality. Click  and

move the cursor to the left to create the next segment.

 

Further, by analogy with the previous constructions, finish entering the rectangle.

The next step is to create the lines belonging to the conical hole in the left view. To do this, without

leaving the line creation option, click  to cancel segment creation from the last point. Next, move

the cursor to the larger circle so that the binding algorithm “remembers” it, and then move the cursor

to the right segment of the view to the left, and move it along this segment until the connection of the

horizontal tangent with the larger circle is established. Click .

Now move the cursor to the smaller circle and then to the left segment of the view on the left and set

it so that the reference is set by the horizontal tangent with the small circle. If another binding is

determined, do not move the cursor for a while and wait until the list of all possible bindings appears.

Use the mouse wheel or the cursor to select the necessary binding and click . Another option is to

fix the binding with the <Space> key while the cursor is still close to the smaller circle.
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Next, click , to cancel the input of consecutive segments. In the same way, build the bottom line of

the taper hole. Now, using the bindings already known to you, build the center line, do not forget to

set the dash-dotted line type in the image line parameters (<P> option) or in the properties window,

and also change the type of line ending - to the line with protrusion.

Let's switch to the top view. This view can be constructed in the same way as the left view, but for a

more complete overview of the possibilities of the sketch, we will create it differently. Set the option:

<Shift+P> Rectangle by two vertices

This option refers to the creating polygons group in the automenu and the group of rectangles in the

Ribbon. If the icon for this option is not displayed in the automenu or in the Ribbon, then it can be

called up using the corresponding icon for this group, which is marked with a black triangle (see

description above).

The first vertex of the rectangle should coincide with the left vertical segment of the main view. Set

the appropriate binding, click .

The second vertex must specify the thickness and length of the plate. Set the length by binding to the

points of the right vertical segment of the main view. As before, if the bindings to the necessary lines
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of the drawing are not found, then you need to move the cursor to the line so that the algorithm of

the bindings “remembers” it. You should set the plate thickness in the “dy” field of the properties

window, specifying the value -35.

Using the bindings of the vertical tangents to the circles, by analogy with the left view, we create the

lines of the conical hole in the top view. Before building segments, you need to change the line type

to dashed (line parameters <P>). For binding to a larger circle, it is convenient to use the snapping

using the <Space> key.

Create an axial line in the top view, to do this, replace the line type and the line end type (line

parameters <P>).

It now remains to apply the hatching to the left view. Call the <H> Create Hatching command:

<H> Create Hatching

Set the option:

<A> Automatic contour search mode

Then move the cursor to the upper part of the view on the left, and set it so that it is located in the

center of the area to be shaded. Click  and closed loop will be highlighted in color. Now move the

cursor to the bottom of this view, and in the same way select the contour that you want to shade. After

that click .

Next you should create dimensions on the drawing. Dimensions on the sketch are set in the same way

as in the parametric drawing, in this case, instead of construction lines, you can select the graphic lines.

This possibility was already described in the main method for creating drawings.
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This completes the creation of non-parametric drawing. Further modification of its elements will not

change the entire drawing. Each view in this case will have to be changed separately. Applying levels

of visibility, using layers, disabling design elements, etc., work as usual.

Creating Parametric Drawing with Constrains

Suppose we need to create a drawing:

Moreover, it is necessary to make the drawing in such a way that it is controlled by the dimensions:

changing the values of the dimensions should lead to a change in the entire drawing.

Call the «Sketch» command. In order to make the example more descriptive, disable all bindings.

Check that automatic creation of constraints is turned on.

Icon / Keyboard Filter toolbar

  <Ctrl+F2> Automatic creation of constraints

Let's start by creating the main plate appearance. In the <SK> Sketch command, select the

construction of a rectangle along two vertices.
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<Shift+P> Rectangle on two vertices

In an arbitrary place in the drawing, we create arbitrary sizes of rectangles: with the help  we

indicate two points. 8 constraints were automatically created: 4 Coincident constraints - at the

intersection points of the line segments (the vertices of the rectangle), 2 Vertical constraints for

vertical lines and 2 Horizontal constraints - for horizontal lines.

The list of restrictions can be seen in the "Model Elements" window.

Next, let's create a fillet. Rounding will be performed using the option:

<Shift+B> Rounding

You can specify an arbitrary radius of the fillet, check box Trim Initial Lines option must be checked.

As in the previous example, with the help , we indicate two segments: the upper horizontal and the

right vertical.

Automatically created 2 constraints Tangent at points of tangency of an arc and lines, and 2

constraints Coincident at points of tangency of lines and an arc. The coincidence point at the

intersection of the continuation of the segments can be left or deleted. This point would make sense if
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you did not cut off the original curves, in this example it defines the intersection of the lines outside

the drawing boundaries. Next, we will create circles of arbitrary radius at an arbitrary place in the

drawing: one with a smaller radius than the second.

<O> Circle center and radius

Let's create two more rectangles - one will define the left view, the other the top view. The principle of

constructing rectangles is similar to that discussed earlier. The sizes and positions of the rectangles are

arbitrary. As with the first rectangle, each rectangle has 8 constraints.

Let's set the parameterization of the already created constructions. We go to the «Constraints»

command.

Keyboard Ribbon

<SC> Draw > Constraints

Icon Textual Menu

Draw > Constraints

The filter toolbar panel will display the bindings available for constraints. Let's include some of them

that touch the lines of the image.

In this case, snaps are needed to select specific drawing elements (graphic lines and points) when

creating constraints.

First, let's create a line relationship between different views of the drawing. To do this, we need to

make sure that the horizontal lines of one kind always coincide with the horizontal lines of another,

the same for vertical lines. This relationship can be set using the «Collinearity» constraint.

Icon / Keyboard Ribbon

    <Q> Constraints  > Collinearity

We select, with the , a pair of drawing lines in different views that should coincide, and then press

 or <Ctrl+Enter>. It is worth noting that the constraints provide a fully variable parameterization

and the order in which lines are selected does not affect the dependence of one line on another: the

lines are equally interconnected.
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When you create Collinearity constraints, the selected lines are moved so that they are on the same

line. When you move the lines, other relationships are preserved. So, for example, the coincidence of

the extreme points of the rectangle segments is preserved due to the Coincident constraints, and due

to the Vertical and Horizontal constraints, the parallelism and perpendicularity of the corresponding

sides of the rectangles are also preserved.

To define the relationship of views, you need to create 4 Collinear constraints.

The number and type of restrictions can be viewed in the "Model Elements" window. When you select

constraints in the "Model Elements" window, they will be highlighted in the drawing.

The next step is to position the circles. To do this, we will use the "Middle" constraint.

Icon / Keyboard Ribbon

  <M> Constraints  > Middle

This restriction allows you to specify a point in the middle between two points or two segments (or

lines). In our case, it is more convenient to set the center point of the circle as the middle between two

segments: one constraint is between two vertical segments, and the second is between two horizontal

main view.

Selecting the Middle constraint, specify the first vertical segment, then the second, and then the center

point of the smaller circle. Thanks to object snaps , the center point of the circle will be found

when you hover over the center of the circle. Finish entering constraint objects  or <Ctrl+Enter>.

By analogy, create a constraint between the horizontal lines and the center point of the circle.
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As a result, the two Middle restraints will define the position of the circle in the center of the plate. By

analogy, you can determine the position of the second, larger circle, or you can simplify the definition

of relationships and use the "Concentric" constraint.

Icon / Keyboard Ribbon

  <N> Limitations > Concentric

This constraint moves the center points so that they coincide. To create a constraint, you need to

specify two circles with  and finish entering constraint objects  or <Ctrl+Enter>.

As a result, two constraints, Middle and one Concentric, define the position of the circles in the

drawing.

The next step is to create the tapered hole lines in the left view and define their position. The extreme

points of the line segments representing the hole must always coincide with the vertical segments that

indicate the contour of the slab. This relationship will be provided by the Coincident constraint. This

constraint can be created automatically if, when constructing segments, their extreme points are

snapped to vertical segments. In order for the snapping of the point to the image line to work during

construction, enable the corresponding snapping on the snapping panel. By calling the command

<SK> Sketch, activate the snapping.

The Automatic creation of constraints mode was enabled earlier. Let's create two arbitrary segments,

the extreme points of which lie on the vertical segments of the slab contour. To construct line, select

the option:

<S> Line

Hover the cursor over the first vertical segment, the snapping is triggered, with the help we indicate

the first point of the segment, then move the cursor to the second vertical segment and indicate the

second point of the segment. If the Continuous creation mode was enabled, then press, to cancel the

construction of the next segment from the last point. By analogy, we construct the second segment.

The vertical position of the end points of the tapered hole segments is not critical. The main thing is

that due to snapping, 4 Coincident constraints are automatically created - for each of the two points

of the tapered hole segments. We will define the required position of the end points of the tapered

hole segments later.
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The number and type of restrictions can be viewed in the "Model Elements" window. When you select

constraints in the "Model Elements" window, they will be highlighted in the drawing.

Let's put the axis on the main view. The principle of constructing the axes in general is similar to the

just considered construction of segments of a tapered hole in the left view. For the vertical axis, it is

necessary that the extreme points of the segment lie on the horizontal segments of the slab contour,

for the horizontal - on the vertical ones. The vertical axis must be vertical, the horizontal axis must be

horizontal. As we have already seen, the Coincident constraint is created automatically when the Point

on Graphic Line snapping is triggered. If the Horizontal / Vertical snap  is triggered when creating

a line, the Vertical and Horizontal constraints will be created automatically. Turn on the necessary

snapping on the snapping panel after calling the Sketch command.

Horizontal / Vertical

Before creating line segments, change the line type and end type of the graphic line in the parameters

of the graphic line <P> or in the properties window.

Let's start with the vertical axis. Hover the cursor over the upper horizontal segment and by pressing

 define the first point, then move the cursor down so that the "rubber thread" is vertical and

snapping  works, bring the cursor to the lower horizontal segment and by pressing define the

second point. As in the previous case, due to the snap trigger, 2 Coincident constraints were created,

and due to the snap trigger , the Vertical constraint was created. The horizontal position of the

axis is not important, for precise positioning of the axis line in the center of the main view, you can use

the Middle constraint or the Coincident constraint (between the axis line and the center of the circle).
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If the construction was carried out in the Continuous creation mode, then click  to cancel the

construction of the next segment from the last point.

Now let's place the axis line in the center of the view. We will do this using the "Coincident" constraint.

Select the Coincident constraint.

Icon / Keyboard Ribbon

   <C> Constraints > Coincident

This constraint can be created between two points, or between a point and a line. Create a constraint

between the axis line and the center point of the circle in the main view. To do this, after selecting the

constraint, we indicate the axis line , and then the center point . We finish creating the

constraint:  or <Ctrl+Enter>. The center point of the circle will be determined by snapping .

This snapping has already been enabled earlier on the snapping panel when calling the Constraints

command.

As a result, the axis line is defined by 3 Coincident constraints (one of them was created manually to

coincide with the center point of the circle) and 1 Vertical constraint.

Let's create a horizontal axis by analogy.
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All relationships between graphic lines in the main view are defined.

Now let's define the position of the tapered hole lines in the left view. It is necessary that each

extreme point of the segments depicting a tapered hole in the left view should be on the same

horizontal line with the corresponding intersection point of the circles with the vertical center line of

the main view. Create points at the intersection of the circles with the vertical axis. Call the Sketch

command and select the option to draw a point.

Keyboard Ribbon

<SK> > <Shift+P> Drawing > Sketch > Point

Icon Textual Menu

Drawing > Sketch > Point

At the intersection of the vertical axis with the circles, we put a point with . Due to the snapping

 and the mode , 2 Coincident constraints are automatically created for the constructed points.

One constraint is between a point and a circle, the other between a point and an axis.
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The next step is to define, using constraints, the relationship between each point of intersection of the

circles with the centerline and the corresponding extreme point of the segments representing the

tapered hole. The points must be in pairs on the same horizontal line.

To do this, you can use the Horizontal Alignment constraint.

Icon / Keyboard Ribbon

  <D> Constraints > Horizontal Alignment

Having chosen the considered constraint, we indicate the upper point of intersection of the large

circle with the vertical axis, and in the left view we select the intersection point of the upper segment

of the conical hole with the right vertical segment of the slab contour. We finish creating the

constraint:  or <Ctrl+Enter>.

By analogy, we create constraints for all remaining pairs of points.
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It is worth noting that when creating constraints, the extreme points of the segments may move, or the

radius of the circles may change. This is due to the very principle of variational parametrization: all

objects of constraints are equally dependent on each other. If there are no additional restrictions and

both objects have degrees of freedom, then either of them can move.

The presence of the degrees of freedom of the sketch lines can be viewed in the properties window

when calling the Constraint command. The number of degrees of freedom is specified for the entire

drawing. If you set the Show Under Defined Lines checkbox, then lines with degrees of freedom will

be highlighted in the selected color. The degree of freedom relative to the origin of the drawing is

also taken into account.

The next step is to draw the dotted lines representing the tapered hole in the top view. The

construction principle will be similar to the construction principle for the lines in the left view.

· Let's construct two arbitrarily spaced segments, the extreme points of which lie on the

horizontal segments of the slab contour. Due to snapping  and mode , 4 constraints

will be created Coincident between points and horizontal segments of the slab contour.
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· Create points at the intersections of the circles with the horizontal axis of the main view. Due

to the snapping  and the mode , 8 Coincident constraints will be created. 2 constraints

for each point: between a point and a horizontal axis, and between a point and a circle.

· Using the "Vertical Alignment" constraint, set the relationship of points in the main view and in

the top view.

Let's draw the line segments representing the conical hole in the top view. Having called the Sketch

command, set in the parameters of the image line <P>, or in the properties window, the line type is

dashed, and the line end type is normal. Selecting the <S> Line option, place the cursor on the upper

line of the slab contour and by pressing define the first point of the segment. Next, point to the

bottom line, click - define the second point. By analogy, we construct the second segment. If the

continuous input mode is on, you must press before drawing the second line segment.

Thanks to snapping  and mode , 4 Coincident constraints are automatically created - for each

point of two lines.

Next, draw points at the intersection of the horizontal axis and circles <Shift + P> Point.

Set, using the Vertical Alignment constraint, the relationship between the points at the intersection of

the circles with the horizontal axis and the extreme points of the segments representing the tapered

hole in the top view.

Icon / Keyboard Ribbon

  <G> Constraints > Vertical Alignment

The principle of work with the constraint is completely similar to the example described above for the

constraint Horizontal Alignment.
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When creating constraints, the circles changed their radii and the lines remained in place. This

situation, of course, contradicts the logic of the drawing, but does not contradict the mathematical

model that we have created. Currently, the drawing model only establishes the relationship between

the lines, but does not set specific values or limit values. There are special constraints (Fixed Length,

Fixed Angle, Fix) and driving dimensions to specify the dimensions of the drawing. We will consider

driving dimensions below.

When working with constraints, it is possible that the created relationships make the construction

illogical. This is not an error in the sequence of constraint creation - constraints are completely

variable and do not create any hierarchical sequence of relationships. Even if at some point the

drawing took on an illogical form, you need to continue to specify the restrictions - gradually

the drawing will take the required form. If, after creating constraints, the drawing takes a form

that is inconvenient for further editing, you need to fix those elements for which movement in

the process of creating constraints is undesirable. For this, there are anchor lines and dots

constraints. In the future, unnecessary restrictions can be removed.

In this example, you can return the drawing to a logical view by editing the size of the circles. So that

the constraints do not interfere with the snapping of the cursor to the drawing elements, the

constraints can be hidden. On the "View" panel, click the icon .

Hover the cursor over the smaller circle, select it with , press it again  - go to its editing. The

required radius of the circle is set by pressing .
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Let's edit the second circle by changing the position of the point in the top view. Hover the cursor over

a point, use  to select it, press it again  - go to its editing. Set the necessary point position by

pressing . Note that the line on which the point is located also moves. This is because both a line

defines a point and a point defines a line. Their coincidence is interconnected.

Let's turn back the display of restriction icons in the drawing. To do this, click the icon  on the

"View" panel.

The slab thickness is shown in two views: top view and left view. So far, there is no connection between

these dimensions. To make the thickness of the slab the same in the two views, create an "Equal

Length" constraint.

Icon / Keyboard Ribbon

 <E> Constraints  > Equal Length

We select the first segment by pressing , then the second . We finish creating the constraint:

 or <Ctrl+Enter>.
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Let's plot the axes in the left and top view. We call the command <SK> Sketch and the option for

constructing the segment <S>. Change the line type as we did before.

The principle of creating axes in the left and top views is completely similar to the principle of

creating axes in the main view.

Hover the cursor over the contour line, snapping  is triggered, by pressing  we set the first

point. Then on another line of the contour - the second point , and so that the Horizontal/Vertical

snapping works. Thanks to the mode , the Coincident constraints and the Horizontal or Vertical

constraints (depending on the view) will be created.

As a result, centerlines will be created, which will only need to be correctly positioned. This can be

done with various restrictions. The easiest way to use the Collinearity constraint is to create it between

the centerlines in the main view and in the left and top views. Select the Collinearity constraint ,

use  to indicate the axis in the main view, then in the left view . We finish creating the

constraint:  or <Ctrl+Enter>. Then similarly for the top view.
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This completes the creation of restrictions. All the relationships between the lines are defined.

This drawing is completely parametric, and all relationships are equal: you can change any line of the

drawing.

A drawing can be fully defined by placing driving dimensions on it.

Icon / Keyboard Ribbon

   <D>
Constraints > Driving Dimensions; 

Appearance > Dimension

To create driving dimensions, you need to make the icon active in the ribbon. The icon is in the

"Restrictions" group. Now all the dimensions that we create in the drawing will be control. To create

dimensions, you need to use the standard design command <D> "Dimension".

If the dimension is set in Driving dimensions mode, then automatically, when creating it, you will be

prompted to enter the dimension value.
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That the size of the manager is easy to understand from its background; unlike regular dimensions,

driving dimension values ??are highlighted in the background. The background color indicates the

various states of size and geometry in general.

· Yellow background - the drawing is not defined and has degrees of freedom

· Green background - the drawing is defined, there are no degrees of freedom. When the

drawing is finished, it is recommended that the system be defined.

· Red background - the drawing has been redefined, i.e. there are sizes or limits that overlap or

contradict each other. Or there is an error in setting the driving dimension value, when the

entered value cannot be provided due to other restrictions.

You can also adjust the distance between views with driving dimensions.
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To prevent the size from being printed, you need to set it as Auxiliary. This option is available in the

context menu. Click  on the dimension, in the context menu select the Auxiliary option with .

The size will change color to blue.

Now drawing lines cannot be changed by simple editing of the sketch: all keypoints are somehow

dependent on driving dimensions. But the background color under the dimensions is yellow. This

means there are degrees of freedom. This is due to the fact that the drawing is not defined relative to

the origin. You can determine the position of the graphic lines by creating dimensions from the origin,

or you can fix any point in the drawing. To do this, we will use the Fix constraint.

Icon / Keyboard Ribbon

   <F> Constraints  > Fix

Select, using  any point in the drawing and complete the entry of constraint objects:  or

<Ctrl+Enter>.
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The dimension background turns green. This means that the drawing has no degrees of freedom and

is fully defined. 

You can verify this in the properties window of the Constraint command.

If the dimensions of the drawing need to be changed, then it is enough to click  in the area where

the value of the dimension is displayed and enter a new value.

Let's apply hatching (<H> Hatch) and change the dimensions in such a way that the drawing

completely repeats the dimensions of the drawing shown at the beginning of the example. To hide all

auxiliary elements - you need to click the icon  on the "View" panel, to hide the constraints - the

icon .
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It should be noted that the proposed sequence of actions is not the only correct or the most rational

one. This is primarily an example that aims to briefly show the various constraints and how they can be

applied. With variational parameterization, there are many (if not infinitely many) options for

sketching. The user himself can determine what constraints and sizes need to be created

automatically, for this in the ribbon in the "Constraints" group you need to click the icon , try

different combinations of constraints to create optimal relationships. The criterion for the optimal

solution is simple: the fewer restrictions and dimensions are needed in order to fully define the

drawing, the better.

Creating Parametric Drawing with Construction Entities

The following diagram shows a drawing to be created. It is a plate with a through hole of conical

shape. The drawing will be defined parametric so that any modifications will automatically reflect on

all projections.

Let’s begin with the main (elevation) view of the plate. First, create the necessary “thin” construction

lines, and then draw the graphic lines on top. Next, create the other two views using the construction

lines of the main view. This creates a dependency between the views so that the two views

automatically adjust to the main view modifications. Finally, apply text and dimensions.

As was mentioned, any command can be called by a number of ways. It can be typed on the keyboard,

selected from the textual menu, or picked on a toolbar.

Let’s begin with the command Construct Line. To invoke the command, use:
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Icon Ribbon

Draw > Construct > Line

Keyboard Textual Menu

<L> Construct > Line 

Pick the icon  at the top of the automenu. A crosshair appears that follows cursor dynamically. The

current coordinates of the crosshair crossing point are displayed in the status bar. There are several

ways to define the crossing point. One is to simply place the cursor near the center of the drawing

window and press . To define the crossing point more precisely, specify its coordinates in the

property window. The coordinates can also be specified via a parameter dialog invoked by typing

<P> key or picking the icon  in the automenu.

As a result, two crossing construction lines will be created. Besides, a node is created at the

intersection point. These lines make the basis of the view being created. The line parameters represent

the absolute coordinates. The view can be moved around on the drawing by moving the base lines.

Do not use more than two base lines on the main (independent) view, and more than one base

line on the views defined by projections. This will insure freedom in placing the drawings.

A T-FLEX CAD command stays active up until it is quit or another command is called. Quitting the

crosshair mode (as by pressing  once) cancels the crosshair rubberbanding, but the line creation

command stays active. After canceling the crosshair mode, move the cursor close to the vertical line.

The line will get highlighted, and a pop-up help will appear next to cursor displaying the name of the

highlighted entity.  This is object snapping in action. This behavior relieves the user from typing on

keyboard or using the automenu buttons.

The object snapping is on by default when starting the application. To set or unset this mode

manually, use the button  on the “View” toolbar.

Pressing  now starts rubberbanding of a line that follows the cursor while staying parallel to the

selected one. We are now creating a line parallel to a vertical line. Such a relationship between the

two construction lines, established at the creation time, is an example of an important feature of T-

FLEX CAD system. This defines behavior of a set of construction entities under parametric

modifications.
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Place the new line at the left of the highlighted vertical line by pressing . The exact value of the

distance can be specified in the property window or parameter dialog box. The newly created line will

become the left-hand side of the part.

Pressing  once cancels the parallel line creation mode, yet the line creation command stays active.

(Otherwise, call it again.) Next, move the cursor toward the horizontal line and press . The line is

selected as a reference for a parallel line to be created. Move the cursor up, specify an exact value of

the distance, if necessary, using the property window, and press  fixing the top side of the part. 

The next step is to round a corner of the plate with a fillet. For this purpose, let’s use the command

Construct Circle. Call the command via

Icon Ribbon

Draw > Construct > Circle

Keyboard Textual Menu

<C> Construct > Circle

To draw the fillet at the upper-right corner of the plate, construct a circle tangent to the top and the

right-hand-side lines. Move the cursor to the top line and press  or <L>. This starts rubberbanding

of a circle whose radius adjusts as the circle follows the cursor while the line tangency stays intact. This

means a circle is being constructed that is tangent to the top line. Any future modifications of the top

line location will not break the circle tangency condition.

Next, move the cursor to the right-hand-side line and again press  or <L>. Now, the circle

becomes “tied” to the two construction lines and keeps the tangencies while being rubberbanded.

Pressing  fixes the current circle radius. The exact value of the radius can be specified in the

property window.
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If the resulting construction does not match the illustration, use Undo Changes command,

Icon Ribbon

Keyboard Textual Menu

<UN>,

<Ctrl><Z>,

<Alt><BackSpace>

Edit > Undo

Each call to this command brings the system one step back. If this command was called mistakenly, its

action can be reversed with the command Redo Changes,

Icon Ribbon

Keyboard Textual Menu

<RED>,

<Ctrl><BackSpace>
Edit > Redo

This command restores the action that was mistakenly undone. 

One can remove all construction lines and start creating a drawing from the beginning with the

command  Delete Unused Construction:

Icon Ribbon

Edit > Additional > Purge

Keyboard Textual Menu

<PU> Edit > Purge

This command will delete all construction entities and allow to start drawing anew. A specific

construction entity can be deleted using command Edit Construction: 
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Icon Ribbon

Draw > Additional > 2D Construction

Keyboard Textual Menu

<EC> Edit > 2D Construction

Once the command is called, select the entity and delete it by pressing <Delete> key on the keyboard

or by picking the icon  in the automenu. 

Now, draw the graphic lines on top of the completed construction portion of the drawing. To do so,

let’s create graphic lines by calling Create Graphic Line. Call the command via

Icon Ribbon

Draw > Draw > Graphic Line

Keyboard Textual Menu

<G> Draw > Graphic Line

Note that the previous command is automatically terminated when calling another command via the

toolbar icon button or the textual menu (no need to cancel the previous one explicitly).

Start drawing solid lines from the upper-left corner of the plate. The graphic lines snap automatically

to a closest intersection of the construction lines. Simply move cursor to an intersection and press .

The line will be rubberbanded after the cursor. Just keep selecting nodes or construction line

intersections.

It is not recommended to select multiple (more than two) line intersections neither by pressing

<Enter> nor by right click. In this case, we recommend creating nodes at such intersections first.

The graphics can then be applied using the <N> key. When using the <Enter> key in “free

drawing” mode, a “loose” node will be created that is not constrained to any construction line.

Following these tips insures correct parametric function of the drawing under modifications.

Move cursor to the tangency point between the top line and the circle, and press . What you see

on screen now should be similar to the illustration at right. Note that T-FLEX system automatically

adds nodes to the end points of the graphic lines, unless already created. 
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Now let’s draw a graphic line along the circle to construct an arc between the two tangency points. To

do so, move the cursor to the circle and press <C> key. The circle will then get highlighted. The

direction of arc creation depends on the position of the cursor when selecting the circle. To change

the arc direction, press the <Tab> key.

Place the cursor just above and to the left of the second tangency point as shown.

Then press , and the graphic arc will be created in the clockwise (CW) direction, spanning to the

second tangency point. The result should look like on the diagram.

Continue drawing. Select with  the lower-right corner of the plate, then the lower-left one, and

finish the construction in the upper-left corner where the drawing started. To complete the command

press .

The drawing should look as shown here.

If applying graphic lines did not come out as necessary, edit the graphics using the command Edit

Graphic Line. Call as follows,
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Icon Ribbon

-

Keyboard Textual Menu

<EG> Edit > Draw > Graphics

Move the cursor to one of the lines to be edited, and press . This selects the line. It can then be

deleted by pressing <Delete> key or picking the icon  in the automenu. Repeat for each line to be

edited. If a whole area is to be edited, use box selection. To select by box, press  where one of the

box corners should be, hold and drag to the necessary location of the opposite corner, then release

the button. As you drag the cursor, it rubberbands a rectangle of the selection box. The elements will

be selected that are fully within the box. All these elements can be deleted at once.

To apply graphic lines again, call the command Create Graphic Line. To redraw the screen at any

moment use the <F7> key, in case not all lines are displayed properly after editing. 

Once the necessary image is obtained, proceed to the next step of drawing creation. The drawing can

be saved preliminary with the help of Save Model command:

Icon Ribbon

Keyboard Textual Menu

<SA> File > Save

Congratulations! You have accomplished your first drawing in T-FLEX CAD. Now let us briefly describe

the system editing capabilities.

The current drawing uses five construction entities that define the shape and size of the part. These are

the left-hand side, the right-hand side, the top, the bottom and the fillet radius. To modify

construction entities call the command Edit Construction:

Icon Ribbon

Draw > Additional > 2D Construction

Keyboard Textual Menu

<EC> Edit > 2D Construction

Move the cursor to the left-hand-side vertical line and press . The line gets highlighted. As you

move the cursor left to right, the line will move along. Specify the new position of the line by pressing

. The width of the plate will change. Note that modifying locations of construction entities causes

instant update of their respective “snapped” graphic lines. If you try to move the right-hand side of the

plate then the whole plate will move. This is because the left-hand side was created as a dependent of

the right-hand one, and the dependency stays as the right-hand side is modified. However, the left-

hand side can move independently of the right. Try such manipulations with other construction
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entities, including the circle. As the construction entities move the size and shape of the plate will be

changing while maintaining the dependencies defined at the construction time.

After testing modification capabilities of the system please bring the drawing back into an

approximately original configuration as shown on a diagram above. Let’s proceed with the next

element of the drawing, which is the conical hole in the middle of the plate.

First, let’s define the center of the circle to be constructed. To do so, let’s do auxiliary construction to

define the center point of the plate. T-FLEX CAD provides a handy command to create a line in the

middle of two others. For two parallel lines, this command creates a parallel line in between at equal

distances to the two. For intersecting ones, the resulting line passes through the intersection at equal

angles to the two original lines. Thus, the new line appears as the symmetry line for the two.

Call the command Construct Line and choose the icon  in the automenu. Move the cursor to the

right-hand side of the plate and select the vertical line by . A parallel line appears rubberbanding

after the cursor. Move the cursor to the left-hand side of the plate without fixing the rubberbanded

line. Now, select the left-hand-side vertical line with . This creates a new vertical line on the

drawing that is the symmetry line for the two selected ones.

Follow same way to create a horizontal line as the symmetry line for the top and bottom sides of the

plate. The intersection point of the two new lines will be the center of the hole to be constructed.

Next, call the circle creation command, move cursor to the intersection of the symmetry lines, and

press . This starts rubberbanding of a circle with the fixed center, with the radius adjusting to the

cursor position. 

The circle center snaps to the node created automatically at the intersection of the symmetry lines. Fix

the circle with . Just like line-to-line distances, the circle radius (diameter) can be defined

approximately by mouse operation, and exactly in the property window. Note that after pressing 

the command Construct Circle stays active.

The second circle of the conical hole can be constructed as concentric to the first one. To do so, pick

the icon  in the automenu or type <O>. Then select the existing circle with . The new circle

starts rubberbanding after the cursor. Place the cursor so that the rubberbanded circle is slightly

bigger than the original one, and fix with . The exact radius difference can be managed via the

property window.
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Proceed with the command Create Graphic Line, move cursor to the bigger of the two circles, and

press  or <C>. The circle gets drawn in solid. Then, move the cursor to the smaller circle, and again

press  or <C>. Now both circles are drawn solid. From this point, we can proceed with the two

other views of the plate.

The two other views are not required for constructing a parametric drawing in T-FLEX CAD. In

this example, creating the side and the plan views simply help demonstrating additional

advantages of parametric modeling using T-FLEX CAD system.

Since the straight lines are considered infinite, one can see that the other views (side and plan) are

already partially created. To finalize the drawing, we will need to establish additional dependencies

between the construction lines. These additional steps are described next.

Activate the line creation command and move the cursor to the construction line defining the right-

hand side of the plate. Select it with . This highlights the vertical construction line and starts

rubberbanding of a new line parallel to the selected one. This line will be the right-hand side of the

plate side view. Fix it at a necessary location by pressing . As before, the exact distance from the

selected line can be specified in the property window. 

The new line is created relative to the right-hand side of the plate on the main view. Therefore, when

the right-hand side of the plate is moved, the new line will follow, staying at the same distance. To

place the new line at a different distance, use the command for editing construction lines. After that,

moving the right-hand side of the plate will again preserve the new distance. The dependencies

between construction entities stay valid until redefined in the construction line editing command.

The next step is creating the line of the left-hand-side edge of the part on the side view. After

completing one line, a new line rubberbanding began automatically.

Note that the currently rubberbanded second line is also a dependent of the plate right-hand-side line

as the latter is still highlighted. This is not our intention; therefore, press  to start line creation

anew. Select the last created line – the one marking the right-hand side of the side view - by clicking
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 on it. Rubberband the new line up to the approximate location, and fix with , or enter exact

value in the property window. 

We recommend using specifically the right-hand side of the part main view as the base line, and

construct all the rest vertical lines with respect to it. In this way, the line-to-line distances will be

positive which is preferable in some situations.

Now let’s proceed with constructing the projection of the conical hole. First, let’s create horizontal

lines tangent to the top and bottom of the inner and outer circles of the hole. These lines will be used

as guides for the side view of the hole.

Press  once to restart line creation, move the cursor to the horizontal symmetry line, and select it

by pressing  or typing <L>. The line gets highlighted. Rubberband the new line by moving cursor

to the outer circle and type <C>. The line is created parallel to the horizontal symmetry line and

tangent to the circle.

Repeat the same sequence of actions three more times: for the top tangency with the inner circle, and

the two bottom tangencies.

Now we have the necessary guides for applying graphics on the side view. 
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Call Create Graphic Line command and apply solid lines between the four corners of the plate side

view. Simply move the cursor from corner to corner clicking  on each corner node, and then quit

with .

Next, apply the two lines representing the conical hole. The view is now almost complete, with only

the hatch yet to be created.

The hatch is created by Create Hatch command. Use

Icon Ribbon

Draw > Draw > Hatch

Keyboard Textual Menu

<H> Construct > Hatch

Set the following option, unless on by default,

<A> Automatic Contour search mode

Then move the cursor to the top portion of the side view, place within the area to be hatched, and

press . The top contour gets highlighted. Next, type <P> to invoke the hatch area parameters

dialog. Specify the type and scale factor of the hatch. Pressing  in the automenu completes

hatching of the selected area.
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Repeat the same actions to hatch the bottom portion of the plate.

It is also possible to create a single hatch consisting of two contours, instead of creating two separate

hatches. To do so, one could select the second contour right after the first one, and then press <End>

key or pick  icon in the automenu.

Once the hatch is created, proceed with the plan view. Call the line creation command “Construct

Line”. Select the bottom line of the main view in order to create dependency of the plan view on the

main view. Rubberband the new line to a location below the main view and fix with . Then quit

next parallel line creation with .

Let’s try creating the plan view in such a way that modifications of other views propagated on the plan

view via the established dependencies. The simplest way to create a dependency in projective

drawing is creating a slanted line at 45-degree angle to the side lines of the side and plan view. The

rest of auxiliary construction is done with respect to this slanted line.
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Let’s again use the symmetry line creation functionality, this time with a slanted symmetry line in mind.

Since the lines of the side and the plan views are orthogonal, the resulting symmetry line will pass at

the intended 45-degree angle.

Call the option . Point at the right-hand-side line of the side view and select with  or <L>. The

line will get highlighted. Next, select the bottom line of the plan view by same means. A new line will

be created passing through the intersection of the two selected lines at 45 degree to each.

Let’s create all necessary nodes at intersections while within the line creation command. The relevant

intersection points are those on the right-hand-side line of the side view and the newly created

slanted line. To create a node, place the cursor at an intersection and press the <Space> bar.

Another way of creating nodes is using command Construct Node via:

Icon Ribbon

Draw > Construct > Node

Keyboard Textual Menu

<N> Construct > Node 

You should still be within the command Construct Line. Point the cursor at and select the bottom line

of the plan view. This way we can create a line parallel to the bottom-side one. Now, move the cursor
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to the newly created node and type <N>. This creates a line parallel to the selected one and passing

through the specified node. Thus, the top and the side view become parametrically related.

To witness this, call the construction line editing command Edit Construction. Try changing location of

the left-hand-side line of the side view. To do so, select it, move and fix in the new position. Note now

that the corresponding line on the plan view moves accordingly.

Construction of the conical hole on the plan view follows the same steps as on the side view. Select a

vertical line while in the construction line creation command, and create four parallel lines tangent to

the two circles.

Now one can draw all graphic lines on the plan view. Use the command Create Graphic Line to draw

the perimeter of the plan view.
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Next step is to apply the two dashed lines corresponding to the conical hole. Set the “HIDDEN” line

type in the system toolbar.

Then create the two dashed lines representing the conical hole.

Now, let’s create centerlines. Call Create Axis command:

Icon Ribbon

Draw > Draw > Axis

Keyboard Textual Menu

<АХ> Draw > Axis

Set the automenu option:

<I> Create Axis of two Graphics lines
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  Use  to select the left and then the right-hand side of the elevation view. Push the  automenu

button. This creates a centerline on the elevation view. Similarly, create a horizontal centerline on the

elevation view and those on the side and plan views.

One could notice that all construction lines created so far were infinite. For convenience, an option is

provided in the command Edit Construction for trimming construction lines at outermost nodes. This

works as follows,

1. Call Edit Construction command.

2. Selecting one particular line and typing <T> or pushing  trims this selected line only.

3. Using option  trims all lines.

4. If you want to revert to the infinite line setting, call the command  Set Document Parameters:

Icon Ribbon

Edit > Document > Document Parameters

Keyboard Textual Menu

<ST> Customize > Document Parameters

Go to the parameter View > Construction Lines > Length and set it to “Default infinite”. Alternatively,

enter the command Edit Construction, select necessary lines, type <P> and specify an appropriate

setting. 
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The diagram shows a drawing with construction lines trimmed. It appears less crowded, although all

necessary construction entities are present. By default, construction lines are not output to the printer

or plotter, regardless of their length.

Next, let’s create the necessary dimensions on the drawing as follows:

1. First, let’s create linear dimensions. Call the command Create Dimension:

Icon Ribbon

Draw > Title Block > Dimension

Keyboard Textual Menu

<D> Construct > Dimension

One can select any pair of construction lines or graphic lines to create a linear or angular dimension.

Select the two outermost lines on the main view by . This starts rubberbanding of a dimension

following the cursor motion. To change any dimension parameter, type <P> or push the  button

in the automenu. The dimension parameters dialog box will appear on screen. Specify the necessary

parameters, close the dialog, and fix dimension placement with . To change the size of the

dimension string font, use the command Set Document Parameters, the Font tab. The font

parameters can be specified on this tab for the elements that did not have such parameters set

originally. 

2. Repeat the steps of the item 1 for the rest of the linear dimensions.

3. Diameter and radius dimension creation is also straightforward. While in Create Dimension

command, move the cursor to a circle to be dimensioned, and type <C> or click . The circle gets

selected, and a dimension begins rubberbanding after the cursor. Switch between the radius and

diameter dimension types by typing <R> and <D> or picking  and  buttons of the automenu

as appropriate. Typing <M> loops through the possible witness/leader line configurations for the

entity to be dimensioned. The <Tab> key handles the direction of the dimension leader line jog. Point

the cursor at the necessary location and press . The newly created dimension will be displayed on

the screen. Repeat this procedure to dimension all circles.
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After finishing construction of all major elements, one can hide all construction entities using the

command Set Levels:

Icon Ribbon

Edit > Document > Levels

Keyboard Textual Menu

<SH> Customize > Levels

This command controls visibility of various elements. An element visibility depends on the “level” at

which it is residing.

After calling the command, a dialog box appears on screen that allows setting a range of visible levels

for each element type of the model.
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Think of levels as transparent films with images drawn on them. The complete drawing consists of all

of them overlapped. The system permits making one or more levels invisible, displaying only intended

ones. A drawing may consist from up to 255 levels enumerated from -126 to 127.

All elements in T-FLEX CAD are automatically created on the level “0”. One can re-assign any element

to another level at any time. In our example, we did not change levels of any element; therefore, all

created elements fell in the level “0”.

As appears on the diagram above, all elements are visible by default whose level is in the range from

0 to 127. Setting the low limit of the visible range to 1 for construction lines and nodes hides the

construction lines and nodes, because they reside on the level 0 which is not within the new range. 

A simpler way to hide construction lines and nodes is to use a dedicated command. This command

hides or shows all construction entities in the current window. It is preferable in the situations when

hiding construction should not affect the document data, rather, the current window only.
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It is thus possible to open the same document in several windows, and have construction entities

displayed in some windows, and hidden in others.

Call the command via

Icon Ribbon

-

Keyboard Textual Menu

<Ctrl><Shift><C> View > Hide Construction

5. Let’s make a line of text containing the name of the drawing using command Create Text. Call the

command via

Icon Ribbon

Draw > Title Block > Text

Keyboard Textual Menu

<TE> Construct > Text

In the automenu of the command, turn on the option:

<D> Create string text

A text can be “snapped” to any construction entity on the drawing in order to have it move together

with the drawing elements being modified. 

Move cursor to the intersection of the vertical centerline and the top line on the main view. Type <N>

in order to snap the text to the node at the intersection. Move the cursor to the text placement point

and press . The text editor window appears on screen. Type a line of text “Sample Plate Drawing”

and push [OK] button.

Should the text not be placed as intended, this can be corrected easily. Quit the text creation

command. Point and click  at the text. This automatically starts the editing command Edit Text.

The selected text starts moving after the cursor. Locate it as necessary and click .
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To explicitly call the text editing command, use

Icon Ribbon

-

Keyboard Textual Menu

<ET> Edit > Draw > Text

In this case, select the text to be edited after launching the command.

There is another way of creating a text, which is typing it directly in the drawing area. To do so,

enter the “Create Text” command and set the option <Т> - “Create paragraph text” (icon ).

Move the cursor to the intended location of the text and press left click. A rectangle starts

rubberbanding on screen that defines the text box. Define the intended area and click , then

push the  icon. A blinking cursor will appear in the box. Make sure of the correct input locale

and enter the intended text. Then push the  icon or <F5> key.

The drawing is now finished. One can try moving construction lines using construction editing

command. When editing, fix line new placement by either using  or specifying exact line location

in the property window or parameters dialog (the latter accessible via the  pick). Note that the

whole drawing, including dimensions, adequately responds to modifications. Changing diameters of

the conical hole instantly reflects on the two other views. Hatches also adjust to their defining

contours. Now one can easily witness the powerful capabilities brought in by the parametric

technology.
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From now, we will assign variables and expressions to the various drawing elements. Select the left-

hand-side line on the main view by clicking .

The line will get highlighted, along with the one it is dependent on by construction. Line editing

command will automatically activate as well. The two parameters are displayed in the property

window. The first one is the original distance, and the second is the current value according to the

cursor position.

Since the line was originally created as parallel to the left-hand side of the plate, the displayed

distance is the distance  between  the right  and  the  left-hand side of the plate.  Instead of a specific

value, one  can  input a variable. Type a variable name “w” instead of the value and press <Enter> or

[OK].

A new dialog window will appear requesting a confirmation for the new variable to be created.

Please note that the variable naming is case-sensitive. A variable “w” is not the same as “W”.

The created variable «w» and the value assigned for this variable can be seen in the window

“Variables” located, by default, under the properties window. Point with a cursor at the number in the

column “Expression”, press  to enter the edit mode and specify the value for the variable, for

example, «170». The line will move to a different location corresponding to the new value of the plate

width.

The same operations can be carried out in the dialog window of the command Edit Variables:

Icon Ribbon

Title Block > Additional > Variables

Keyboard Textual Menu

<V> Parameters > Variables

Similarly, define a variable “H” as the distance from the base line to the top side of the main view.

Select the line on the drawing by clicking  and enter the variable name in the property window.

Now there will be already two variables in the window “Variables”, and you can, by modifying their

values, observe the change in the drawing.
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Try making an expression. In the window “Variables” place the cursor in the field “Expression” of the

variable «H» and press  to enter the edit mode. Specify the expression «w/2» instead of the

numerical value. This means that the value of “H” will be equal to the half of “w”. From now on,

changing just the value of “w” will automatically reflect on the value of “H”. 

Next, let’s assign an “R” variable to the radius of the circle defining the fillet at the upper-right corner

of the plate. Select the circle on the drawing by . In the property window specify the radius as “R”

variable. After confirming its creation, in the window “Variables” set the variable to the following

expression: w < 100 ? 0 : 6

This expression means that “R” equals 0 when “w” is less than 100, and equals 6 otherwise.

Let’s briefly explain the syntax of the expression. Its members are described as follows.

< - is the “less than” sign

? - means “then”, “in such a case”

: - means “else”, “otherwise”

The complete expression is written as

R = w < 100 ? 0 : 6

The value of “R” equals 0, if “w” < 100, and equals 6 for any other value of “w”. Therefore, there are

only two possible values of “R” - either “0” or “6”.

Check this on your drawing. Try setting “w” values greater or less than 100, and watch what’s

happening. Note that when the radius of the fillet equals 0, then the radial dimension automatically

disappears. The system does it for the user.

Therefore, one can create a variety of relations between variables, including quite complex ones, using

just a few basic terms. You will get to know all capabilities of the variables functionality in later

chapters.

Moving, Copying and Creating Arrays of Drawing Elements

T-FLEX CAD provides two main mechanisms for creating new 2D elements based on existing ones.

The first mechanism relies on moving, copying and array creation commands. This group of

commands unites all functions related to translating, scaling, using symmetry and rotating arbitrary 2D

elements, as well as creating various types of associative and independent copies, including linear and

circular arrays. Moving/copying of elements can be done within the current page of a T-FLEX CAD

document or from one page to another one.

The second mechanism uses copying via the clipboard that is a somewhat extended functionality in T-

FLEX CAD as compared with the standard Windows clipboard management. This mechanism only

supports non-associative (independent) copies. However, it supports copying between different

documents within the same T-FLEX CAD environment, as well as exchange with other applications.

Any T-FLEX CAD 2D elements can be handled by either of the moving/copying mechanisms, except

those specifically mentioned in the respective sections (for example, multi-page text and BOMs

cannot be copied or moved).

Moving, Copying and Array Creation Commands

A family of commands is provided in T-FLEX CAD for moving, copying and array creation. These

commands are used for transforming existing drawing elements and making various types of copies,

including multiple (arrays). All commands have similar interface and underlying mechanism that allow

easy switching from one command to another while keeping the same set of selected objects. These

commands also interact with object snapping described in the chapter “Sketch. Creating a Non-

parametric Drawing”. Upon calling any of the commands, the toolbar is displayed for object snapping

management.

The commands are divided into three large groups by their purposes:
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· The commands for moving (for modifying the existing elements – Transition, Transition and

Rotate, Transition and Scale, Transition with symmetry, Transition with translation and

rotation); The general options of the Transfer command are described in the corresponding

section;

· The commands for creating copies (Create Copy, Copy and Rotate, Copy and Scale, Create

Symmetry, Copy with translation and rotation); General options for copy commands are

described in the corresponding section;

· Array creation commands (Create Linear Array, Create Circular Array, Array by Curve, Array by

Table and Parametric Array.

Since the interface of all the commands is identical, the further description will be as general as

possible, covering all moving, copying and array creation commands. 

Calling the Commands

Upon calling any moving, copying or array creation command, the first step will always be selecting

the objects for moving or copying. The following options will be provided in the automenu:

<End> Finish element selection

<M> Add elements 

<M> Remove elements 

<I> Select Other Element

<Esc> Exit from editing of selected Elements list

Any T-FLEX CAD 2D elements are available for selection. Elements can be selected by box  and/or

using  under the active option . Selection can be canceled in the same way with the active option

. To speed up the process, you can use the transparent mode of switching between adding and

removing elements: pressing the <Ctrl> inverts the current mode. This means, if the current active

option was , pressing <Ctrl> +  will be removing the elements from the selected set, and vice

versa, with the active option  pressing <Ctrl> +  will result in adding the picked elements to

the set. To complete the selection, use the option .

Elements selection parameters are duplicated in the command properties window. You can change

the selection mode in the window.

 

You can delete the selected element using the  icon or delete all the elements using the  icon.
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After selecting the objects for translation/copying, the system will enable the automenu of the called

command.

You may also call the commands from the context menu after selection of one or several 2D elements

of a drawing. In this case, the automenu of the selected command will appear. Elements, for which the

automenu was called, are automatically selected as objects for transformation.

Topics in this section:

· Common Options of the Moving, Copying and Creating Arrays of Drawing Elements

· Common Options of Moving Drawing Elements

· Moving, Copying and Array Creation Commands for Drawing Elements

· Arrays of Drawing Elements

· Transformations in Translation and Copy Commands for Drawing Elements 

Common Options of Moving, Copying and Creating Arrays of Drawing Elements

For working convenience, all moving, copying and array creation commands have similar sets of

automenu options.

Such options include the options for switching between the commands, the attachment point

selection options and the options that define the action upon the completion of the current

transformation.

Options for switching commands 

The automenus of all moving, copying and array creation commands include the options, whose

composition defines the current command. These options are used for quick switching between the

commands while keeping the selected set of objects. 

The moving, copying and array creation commands differ primarily in the type of the transformation

and its mode. The transformation mode is either moving (modification of the selected elements) or

copying (creation of new elements based on the selected). The type of transformation defines the kind

of change between the original position and the target position. This can be a translation, rotation,

scaling, translation with rotation, creation of a linear or circular array. Thus, for example, the

combination of the “Move” mode and “Translate” transformation makes the command Move, while

the “Copy” mode in combination with the same transformation makes the command Create Copy

with translation. Note that the array creating transformations always make copies.

The kind of transformation is defined by the first automenu option that contains the enclosed list:

Transition:

<TM> Move with transition

<TT> Move with rotation
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<TA> Move with scale

<TS> Move with symmetry

<TP> Move with transition and rotation

Copy:

<XM> Copy with transition

<XT> Copy with rotation

<XE> Copy with scale

<XA> Copy with symmetry

<XS> Copy with transition and rotation

Arrays:

<XL> Linear array

<XR> Circle array

<XV> Array by curve

<XD> Array by table

Defining base points of transformation 

When defining a transformation, you need to specify two special points - origin and target. These

points define the transformation direction and parameter. Depending on the kind of transformation,

either both or just one point is required.

Origin point is the point that marks the original position of the objects to be transformed. This would

be the start point of a translation, the center of a rotation, the center of scaling or the start point of a

linear array.

The origin point of a transformation can either be defined as an arbitrary point, or be selected as one

of the characteristic points of the outlining rectangle. The outlining rectangle is a rectangular area that

covers the extents of the set of objects selected for the transformation. Characteristic points of the

outlining rectangle are its center, corners and the side midpoints. 

The way of defining the origin point of a transformation is selected from the following pull-down list

under the option :

<Ctrl+0> Left Top
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<Ctrl+1> Center Top

<Ctrl+2> Right Top

<Ctrl+3> Left Center

<Ctrl+4> Center

<Ctrl+5> Right Center

<Ctrl+6> Left Bottom

<Ctrl+7> Center Bottom

<Ctrl+8> Right Bottom

<Ctrl+9> Free attachment mode (arbitrary point selection)

 The default setting is the free attachment mode . In this case, the origin point is defined by

specifying the coordinates in the property window or by clicking  in the 2D window, or else by

selecting an existing 2D node. To select a node, you can use the option:

<N> Select Node

If the free attachment mode was selected, defining the origin point will be the first step of

moving/copying. 

Target point is the point defining the target position of the objects after the transformation. This can

be the end point of a translation, the end point of a linear array (defining its length and step), or the

center of the circular array. The target point of the transformation is always defined by specifying its

position by mouse clicking , in the property window, or by selecting a 2D node (the option ).

Option for selecting action after the current transformation 

You can select a necessary action upon completing the transformation from the enclosed list of the

option :
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<Alt+X> Exit Command automatically when finished

<Alt+O> Repeat Command for selected elements

<Alt+N>
Repeat Command for created elements (available

for copying only)

<Alt+A>
Repeat Command for selected and created

elements (available for copying only)

<Alt+S> Select new elements when finished

The selected option defines the system action upon completing the original transformation:  - the

system automatically exits the move/copy command. , ,   - upon the completion of the

first transformation, the command instantly activates the mode of defining a new transformation. This

will be indicated by a new set of objects for transformation, rubberbanding with the pointer, and the

respective prompts displayed in the status bar (such as, "Set destination point for Move"). Depending

on the selected option, the new set of objects for moving/copying will include either the original

objects of the first transformation, or the objects created as a result of the first transformation, or else

all of the above.  - upon the completion of the first transformation, the command switches to the

mode of selecting objects (see the section "Calling the command from menu").

Common Options of Moving Drawing Elements

The moving commands include the translation Transition, Transition and Rotate, Transition and Scale,

Transition with symmetry, Transition with translation and rotation.

Options for selecting moving mode

When executing any moving command (translation, rotation, scaling or symmetry), you can set various

modes of executing these transformations. The mode selection  is done in all cases by one of the

automenu options in the list:

<O> Change dependent elements

<G> Change related elements

<F> Change selected elements

Change dependent elements. The selected elements are moved together with their parents and

immediate dependents only.
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Change related elements. The selected elements are moved together with all objects related via

parents or dependents.

Change selected elements. Only the selected elements are moved, separated from parents and

dependents.

In complex cases, when it is impossible to break a relation between the element and its parents

and/or dependents, the following exceptions from this rule are possible:

· If the selected object can't be separated from a parent, a copy of the parent is created, that

moves together with the selected object. The original parent element is left unchanged;

· If the selected object cannot be separated from a dependent, then the object is moved, while

its copy is created in the original position to which the dependent is attached;

· If the selected objects have a common parent construction entity that cannot be moved (such

as a node or a construction line), and the parent does not have any other dependents that

cannot be moved, then the parent is moved along.

Dynamic model regeneration mode 

When defining various types of moving in the modes Change dependent elements and Change

related elements, you can turn on the dynamic model regeneration mode to view the modifications of

the elements related or attached to the selected ones (the selected elements themselves are always

updated dynamically). To turn on this mode, use the option .
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Options for handling variables 

If the original position of the selected elements (or the elements used for defining the selected ones)

was driven by variables, use the options  and  when moving the elements. These options

cannot be used together. When one is engaged, the other becomes inaccessible. 

If none of these options is active, then after selecting the new position for the elements being

transformed, a message is displayed on the screen, prompting the user for modifying the value of the

respective variable. Pressing the [Ok] button completes the transformation with updating the variable.

Pressing [Cancel] aborts the transformation. In the case when several variables are affected, the

prompts will be displayed subsequently for each of the variables. Checking the item "For all variables"

in one of the prompt windows confirms adjustment of all the rest of the variables without querying.

With the option  turned on, the values of the respective variables are adjusted without querying.

The option  replaces all the variables used for defining the coordinates of the transformed

elements by their respective values. The variables themselves are not deleted from the model. The

variables related to other element parameters are not affected by moving.

Moving in transparent mode

If in the command waiting mode one or more elements of the drawing are selected using the window

or the <Shift>+ , <Ctrl>+  keys, then the transfer can be performed without calling the

command. To do this, move the cursor to one of the highlighted nodes or the element image - the

cursor will change to  (when pointing to a node) and to  (when pointing to a line). This means

that the system is ready to change the position of the selected elements. Next, there are two options:

· Press  and release without moving the cursor. Then move the cursor to the copy point and

press  again or the <Enter> key. This method is useful when moving from one page to

another.

· Press  and move the cursor without releasing the mouse button. The move will occur when

the key is released or the <Enter> key is pressed.

After the first press , the system enters the transformation command and, if necessary, you can

change the transformation method or type in the automenu.

Moving, Copying and Array Creation Commands for Drawing Elements

This section covers all the commands that allow creating copies of the selected objects. Those are the

commands for creating copies (Create Copy, Copy and Rotate, Copy and Scale, Create Symmetry); and

Copy with translation and rotation) as well as the array creation commands Create Linear Array, Create

Circular Array, Array by Curve, Array by Table and Parametric Array.

When executing any copying command, one can use various copying modes. The mode selection 

 is done in all cases by one or the automenu options in the list:

<O> Explode Copy

<G> Explode Copy keeping relations

<F> Create Associative Copy
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<J> Create Copy on Associated Constructions

<Ctrl+F> Create Copy with Constraints

Explode Copy

The created copy is automatically broken up into the separate unattached objects. The copied

construction elements become stand-alone objects, regardless of the ways of their parent element

creation. All variables that were driving the parameters of the original elements are replaced by

constants in the new elements. 

For successful copying of the detailing elements (dimensions, leader notes, roughness symbols,

tolerances, etc.) in the modes “Create Associative Copy” and “Explode Copy”, make sure that the set of

the objects to be copied includes the elements and their parents as well. Otherwise, the copy will not

be created. To avoid this, let the system automatically append the selection with the required parent

elements by including those in the set of objects to be copied. This mode is turned on by the

additional automenu option:

<K> Auto selection of required parents

Explode Copy keeping relations

The created copy operation is automatically destroyed. The elements created by this operation

become independent from the original parent elements. However, the internal relations are

maintained between the resulting objects similar to those that existed between the original elements.

The relations with variables are maintained if the variable values are not affected. Otherwise, the

variables are replaced by constants.

If a copied object has a parent that was not among the set of the objects to be copied, then upon

destroying the copy operation, a copy of the parent element will be created that will move together

with the selected object. To prohibit this, turn on the additional option:

<Alt><T> Copy only selected elements

With this option turned on, the system tries to separate the objects being copied from their parents

that were not included in the set of the objects to copy (similar to the mode “Change selected

elements” in the moving commands).

Create Associative Copy

The option is enabled by default. An associative copy is created, which elements preserves link with

the initial parent elements. The copy elements will change according to the initial elements changes. 

An additional option Create node at point is available for associative copies creation. When the

option is enabled, a 2D node is created. The base point of the created copy is binded to the node. 

<T> Create Node at point

When the option is enabled, the base point will not move, and the other copy elements will change

associatively, according to the initial elements changes If you move the base point, the copy will be

translated with the point. 



Drawing Creation

571

When you use the associative copies creation option, the options for copies and arrays creation will be

available in the Model elements window.

The command parameters will be available in the context menu of each copy and array.

Two options for copies creation will be available in the context menu: Explode Copy and Explode

Copy keeping relations.

Create Copy on Associated Constructions

For selected construction elements, the associated copies are created. Copies of the drawing elements

are detached from the original parent elements and snapped to the copies of the construction

elements. If this mode is used while creating rectangular or circular arrays, the drawing elements will

be created only at the moment of array creation. Increasing the number of elements in the array does

not lead to appearance of new graphics lines and other drawing elements.

Create Copy with Constraints 

The option is available only for copy with symmetry, copy with translation, copy with rotation,

linear and circlular arrays. A special constraint will be created for array or symmetry when you

execute commands: 

 Symmetric

For copy with symmetry.

 Linear Array

For copy with translation and linear array.

 Circular Array

For copy with rotation and circular array.

Topics in this section:

· Copying Between Pages with Different Scales

· Edit Copy or Array of Drawing Elements

Copying Between Pages with Different Scales

The dialog of parameters of the already created 2D copy (by translation, rotation, scaling – except

symmetry) contains two additional flags: “Correction for a scale of model” and “Compensate scales

of pages”. These flags are taken into account when copying between pages is performed.

The “Correction for a scale of model” flag is available only for translations created automatically

upon construction of taken out elements.

Description of this flag can be found in the “Drawing views. Taken out elements” chapter.

The “Compensate scales of pages” flag allows us to achieve the correct ratio between the dimensions

of the elements on the original page and the resulting page of copying when the scales of these

pages are different. When this flag is enabled, to obtain the scale of the copy, the scales of both

pages are taken into consideration:
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Resulting scale of

the copy
=

Given scale of the copy* Scale of target page of copying

Scale of original page of copying

By default, this flag is enabled.

Edit Copy or Array of Drawing Elements

All elements obtained by moving or non-associative copying can be edited as normal construction or

graphic elements. 

The associative copies created using the copying commands are edited by the command Edit Copy

Operations. The command can be called by one of the following means:

Icon Ribbon

-

Keyboard Textual Menu

<EY> Edit > Draw > Copy

Upon calling the command, select the copies to be edited. To select one copy, you can use .

Multiple selection can be done by box selection or selection by <Shift> + , <Ctrl> +  or by the

automenu option:

<*> Select All Elements

When the copies are selected, both the selected and the original elements are highlighted, as well is

the transformation vector (or the attachment point in the cases of scaling, rotating or creating a

circular array).

Upon multiple selection of copies or arrays, the option is available in the automenu:

<Del> Delete selected Element(s)

Selection of a single copy or array makes the following options available in the automenu:

<Enter> Finish Editing

<P> Set selected Element(s) Parameters

<O> Explode Copy

<G> Explode Copy keeping relations

<H>
Select Clipping Hatch (available only for translated, rotated and scaled

copies)

<K>
Cancel selection of clipping Hatch (available only for copies clipped by a

hatch)
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<S> Edit copied elements list

<I> Select Other Element

<Del> Delete selected Element(s)

When selecting a copy (an array), the property window displays the dialog for editing the copy

parameters, similar to that used at the time of the copy creation. It allows modifying the copy

parameters. You can use the parameters dialog box for this purpose as well, called using the option

.

The two options -  and  - are provided for breaking up copies, that is, for converting those

into a set of independent elements. The copy (array) itself as a T-FLEX CAD element is deleted at this

moment. The result of applying these options corresponds with the respective modes of the copy

(array) creation. To delete a copy altogether, you can use the option .

The option  is provided for editing the list of the original elements of the copy (array). In this

mode, you can add the new elements to the list of the objects to be copied and delete some of the

elements from the list of selected.

The option  is accessible for copies created by the commands Create Copy, Copy and Rotate, Copy

and Scale, Copy with Translation and Rotation. It allows clipping the image of the copy by a hatch. To

do this, upon calling the option, select the necessary hatch by clicking .

If the clipping hatch is used for this purpose only, we recommend setting its flag "Invisible". The

diagram shows a copy image before and after selecting an invisible hatch for clipping. In addition to

the described capabilities, the attachment points can be redefined for the selected copy (array).

To do this, select one of the transformation vector ends or an attachment point by clicking  it (in

the cases of scaling, rotating and the circular array). After that, specify the new attachment point(s). At

this moment, the following options will be available in the automenu:

<T> Create Node at point

<N> Select Node

After defining the new attachment point, the element being edited will be drawn according to the

applied changes.

The commands for editing a copy or an array, or their elements, are also accessible via the context

menu. Simply select one of the elements of a copy/array and right click . In the coming up context
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menu, the editing commands will be provided for the selected element, as well as for the whole copy

or the array. 

You can change the properties of the selected element of a copy/array (the default properties are

copied from the parent element). You can also delete the selected element of a copy/array (without

deleting the copy itself). In this case, the copy/array itself maintains the information about the deleted

element, so that it can be restored in the future.

In the context menu of graphic lines obtained by copying, the  “Shorten/extend” command is also

available. This command allows us to modify the length of the visible part of the line. This function is

described in more detail below.

The editing commands for the copy/array itself are grouped in the context menu into a submenu,

named according to the copy type (such as, "Move Copy", as shown on the diagram). An additional

command is provided among the copy/array editing commands, "Restore deleted elements",

specifically for restoring all deleted elements of the copy.

Changing length of visible part of a line obtained by copying

The “Shorten/extend” command, which is available in the context menu of graphic lines obtained by

copying, allows us to modify the length of the visible part of the line. It is possible both to shorten and

extend the line of the copy. However, the function of extension is only available for segments and arcs.

The part of the line that is to be changed is indicated by 2D nodes. At first when you work with the

command it is required to indicate the part of the line which must be modified, then – the node which

defines the new end point of the line. For closed lines it is necessary to indicate two nodes and the

part of the line which must remain. The 2D nodes, which are being used, can be located on the line

itself or at some distance away from it. In the latter case the end point of the line is defined as a point

on the line that is the closest to the selected node.
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The context menu for the line modified with the help of the “Shorten/extend” command contains the

 “Reset” command. It allows us to quickly restore the original appearance of the line-copy.

Removing original objects of copy/array

When deleting an original element of the copy/array, two variants of the system's response are

possible depending on the option selected in the dialog of the command of deletion.

If the “Delete selected and dependent elements” option is chosen, the element that is being removed

is simply excluded from the set of original elements of the copy/array. As a result, the view of the

copy/array will change: the elements obtained by copying of the element that has been deleted will

disappear.

                           

When the “Delete only selected elements by changing the way of specifying the dependent

elements” option is selected, the element that is being removed is also excluded from the original set

of the copy/array. But, in addition, instead of copies that have been disappeared, identical externally

free objects are created. This means that the result of copying visually does not change.
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Particulars of handling variable arrays 

When modifying the number of copies in a linear or circular array, adding or deleting copies occurs in

the position immediately before the last copy in the array. This feature helps, for instance, keeping the

dimensions between the outer elements of the array throughout modifications to the number of

copies in the array. The dimensions set on "inner" copies of the array may disappear as the total

number of copies is reduced. The same is true for any 2D constructions: the elements attached to the

outer copies of an array will always maintain the correct position, regardless of the changes to the

array.

                     

            

When creating a hatch based on an array elements, hold on to the following technique: before

creating the hatch, set the maximum necessary number of copies in the array. The hatch should be

defined using the automatic contour search mode. In this case, the hatch will behave correctly in the

future and will not "break" under any modifications to the number of copies in the array (within the

initially defined range).

In the three-dimensional modeling mode, a 2D array placed on a workplane can be used for creating

a 3D profile. The profile can be created based either on the graphic lines directly, or on the hatch

constructed by those graphic lines. When using an array with a variable number of elements, use of an

intermediate hatch (based on the lines of the array) for the profile creation makes sense only in the

case when you know the maximum number of copies in the array. In all other cases, the 3D profile

should be created based on the graphic lines of the array. In the course of future construction, keep in

mind that indexing of geometrical items within the resulting 3D element (such as edges, vertices, etc.)

will be changing, as you modify the number of copies in the array that defines this 3D element.
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Arrays of Drawing Elements

To simplify the process of creating a series of similar drawing elements, you can use the array

commands. All there are 4 types of arrays.

· Linear array

· Circular array

· Array by curve

· Array by table

There is also an option for parameterization input values for linear and circular arrays.

Linear Array of Drawing Elements

Call the command Linear Array.

Icon Ribbon

Draw > Additional > Linear Array

Assembly > Assembly > Array > Linear Array

Keyboard Textual Menu

<XL> Draw > Array > Linear Array

You should specify two points for the linear array creation: start and end. You may use the available

bindings to specify the points. The points specify a guide vector for an array and its step, length and

number of copies according to the array specifying type. The copies will be placed along the guide

vector of the array.

After setting the first point, dynamically moving elements of the array are displayed on the screen.

Their number depends on the default number of copies in the properties window. To complete the

creation of an array,  you should specify the position of the end point.

The starting point of the array is determined automatically if the automatic determination of the

starting point is set on the basis of one of the characteristic points of the enclosing rectangle.

The array can be two-dimensional, i.e. consisting of several "i" rows. The “Rows” group defines the

properties of an array in the direction perpendicular to the guide vector. The number of copies in the

direction perpendicular to the specified vector (i.e., the number of rows), and their parameters (step or

total length) can be set in the array parameters in the properties window.

The “Columns” "j" group defines the parameters of the columns of linear arrays (copies located along

the directing vector).
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For both the “Columns” group and the “Rows” group, it is necessary to choose one of the ways to

specify copies of the linear array: “Number of copies and step”, “Length and step” or “Number of

copies and length”.

Depending on the chosen way, the distance between the points that are specified when creating the

array, can determine, respectively: step (the number of copies is only a numeric value); optional step

or length; the total length of the array (the number of copies is also specified only by a numeric

value). 

The values of the step and the total length of the array can be set by numerical values in the

properties window (the Step and Length parameters). To do this, set the flag next to the necessary

parameter. The specified points will then determine only the direction of the array. 

The number of copies is always specified by a numeric value using the Copies parameter. The initial

elements are included to the copies number.

The availability of the Copies, Step and Length parameters is determined by the selected way of an

array specifying.

The Rows parameter group defines similar parameters for the rows of a linear array. 
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Circular Array of Drawing Elements

Call the command Circular Array.

Icon Ribbon

Draw > Additional > Circular Array

Assembly > Assembly > Array > Circular Array

Keyboard Textual Menu

<XR> Draw > Array > Circular Array

To create a circular array, after selecting the copy objects, specify the center point of the array. To

specify the point, you can use the available bindings. After selecting of the copied objects, before

specifying the center of the array, dynamically moved elements of the array are displayed on the

screen. The number of elements and the angle covered by them are determined by the default values.

You can change array parameters in the properties window. 

In the properties window, you can also select the method for specifying a circular array: Copies and

Total Angle, Total Angle and Step or Number and Step.

Depending on the chosen method, some parameters may not be available (calculated automatically):

Copies. The option sets the total number of copies of the array, taking into account the initial

elements.

Step. The option sets the angle between copies of an array. 

Total angle. This parameter allows you to specify the angle within which the array elements will be

located. 
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Array of Drawing Elements by Curve

Call the command Array by Curve.

Icon Ribbon

Draw > Additional > Array by Curve

Assembly > Assembly > Array > Array by Curve

Keyboard Textual Menu

<XV> Draw > Array > Array by Curve

Array by Curve allows you to place copies of graphic lines along the selected path with the ability to

control the orientation of copies.

To create an array along a curve, after selecting the copy objects, specify the curve, and then the

starting point of the copied elements. The starting point of the first copy will coincide with the first

point of the curve. The starting points of the subsequent copies of the array will lie on the selected

curve. You can use the available bindings to set the starting point. After selecting the copied objects

and curve, dynamically moved elements of the array are displayed on the screen. The position of the

cursor determines the starting point. Unlike other arrays, in the Array by Curve command, initial

elements are not included in the number of copies. The first copy is moved so that the starting point

coincides with the first point of the curve, while the original elements do not move.  

In the command properties window, you can specify the way to set the parameters of the array and

the orientation of the array elements relative to the curve. An array is defined by the following

parameters: Number of Copies, Step, Total Length.

Number of Copies. Sets the total number of copies of the array without regard to the initial elements.

Step. Sets the length of the curve between the starting points of the array copies. 

Length. This parameter allows you to set the length of the array along the curve.

There are more ways for specifying in the Array by Curve command than for other arrays. This is due

to the fact that the length of the array may be set by a long curve. Two ways appear, where you should

set only one parameter: Number of Copies or Step, and the length of the array will be equal to the

length of the curve.

Number of Copies and Step. The length is calculated by the expression L=(N-1)*S, where N is the

number of copies, S is the step. If the length of the array L is greater than the length of the curve, then

copies that go beyond the curve are arranged in a straight line. A straight line is created tangential to

a curve from its last point.

Length and Step. Copies of the array are located at a given length of the array L with the step S. The

number of copies is determined by the expression N=L/S+1. The value of N is rounded down to a

whole number. If the given length of the array L is greater than the length of the curve, then the array

will continue along a straight line.
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Number of Copies and Length. The step with this method of specifying an array will be determined

by the expression S=L/(N-1). If the given length of the array L is greater than the length of the curve,

then the array will continue along a straight line.

Number of Copies. The length of the array L is equal to the length of the curve. The step is determined

by the expression S =L/(N-1).

Step. The length of the array L is equal to the length of the curve. The number of copies is determined

by the expression N=L/S+1. The value of N is rounded down to a whole number.  

Array copies may be differently oriented relative to the curve.

Constant. For all copies of the array, the orientation of the initial copy objects is preserved.

By Tangent. The angle of the copies rotation corresponds to the angle of rotation of the tangent to

the curve that is created at the starting point of the corresponding copy.

By Chord. The angle of rotation of the copies corresponds to the angle of rotation of the chord,

drawn from the previous starting point of the copy to the starting point of the copy, the angle of

rotation of which it determines.
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Array of Drawing Elements by Table

Call the command Array by Table.

Icon Ribbon

Draw > Additional > Array by Table

Assembly > Assembly > Array > Array by Table

Keyboard Textual Menu

<XD> Draw > Array > Array by Table

This command is used for creating 2D arrays Array by table. Use this command to use values from the

database as array parameters.

There are 4 parameters for setting an array by table:

· X-coordinate

· Y-Coordinate

· Corner

· Scale 

Prerequisite is to set either the X-coordinate or the Y-coordinate.

The Add variable button allows you to use the value of any model variable as the value of a database

column.

Parametric Array of Drawing Elements

For linear and circular arrays: Linear Array, Circular Array, the option to control copy

parameterization is available: Change value of variable.

The variable takes the value either in accordance with the copy number (the By number of copy

mode), or in accordance with the distance from the beginning of the trajectory or in accordance with

the angle value (the By length mode for linear arrays, the By angle mode for circular arrays).

To create a parametric array, you should enter a variable to the Change value of variable field. For a

variable in the variables editor (for more details, see the “Variables” section), you should specify

expressions that will determine the nature of its changes according to the selected option (By number

of copy, By length/By angle).

Example

It is necessary to create an array of rectangles, where the height of the rectangle will be increased by

15 mm for each subsequent copy.

Construct a rectangle. The height of the rectangle will be determined by the variable H. In the

variables editor for the variable H, write the expression: H=50+N*15, where N is a changeable variable

of the array.
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Create a linear array in which, in the option Change value of variable, you should specify the variable

N and choose the option of changing By number of copy.

As a result, the next array will be obtained.

Transformations in Translation and Copy Commands for Drawing Elements

While working with the transition and copy commands, user can perform a number of additional

transformations. For example, you can rotate objects, move or copy with scaling of the source

element, symmetric transformation, and rotate. For more details about all the additional conversions

can be found in the appropriate sections.

Topics in this section:

· Translation of Drawing Elements
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· Rotation of Drawing Elements

· Scaling of Drawing Elements

· Symmetry of Drawing Elements

· Translation and Rotation of Drawing Elements

Translation of Drawing Elements

Call the command Transition.

Icon Ribbon

Draw > Additional > Move with Translation

Sheet Metal > Additional > Move with Translation

Keyboard Textual menu

<TM> Edit > Move > Move with Translation

Call the command Copy.

Icon Ribbon

Draw > Additional > Copy with Translation

Assembly > Assembly > Copy with Translation

Sheet Metal > Additional > Copy with Translation

Keyboard Textual menu

<XM> Draw > Copy > Copy with Translation

To define translation or copying with translation, specify the start point (the origin point of the

transformation) and the end point (the target point of the transformation). 

When defining points' coordinates, a coordinate along one of the axes can be fixed by enabling a

checkbox located to the left side of the coordinate value input box. Then moving the mouse in the 2D

window will only affect a coordinate whose checkbox is disabled.

Following options appear in the automenu upon defining a base point:

<U> Move along X axis

<V> Move along Y axis

These options are active by default. Deactivating them disables the ability to move a target point

along a corresponding axis using the mouse and enables a checkbox of a corresponding target point's

coordinate in command's parameters window. It allows to easily define horizontal or vertical

translation.

If using the mode of automatic origin point location based on characteristic points of the outlining

rectangle, you shouldn't define the start point. The transformation is performed by carrying the start

point over the end point.

Additionally, you can change the scale and the rotation angle of the translated image in the

parameters window. The Scale Elements Font checkbox controls font scaling of the drawing elements

added to the copy set. When the checkbox is enabled, font size of all copied elements is  scaled
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according to the assigned scale factor. When the checkbox is disabled, font size remains unchanged.

The checkbox does not affect font size of the text being copied – it is always scaled.

The sequence of actions and the result of the Move with Translation command. 

The sequence of actions and the result of the Copy with Translation command.
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Rotation of Drawing Elements

Call the command Rotation.

Icon Ribbon

Draw > Additional > Move with Rotation

Sheet Metal > Additional >  Move with Rotation

Keyboard Textual menu

<TT> Edit > Move > Move with Rotation

Call the command Copy.

Icon Ribbon

Draw > Additional > Copy with Rotation

Assembly > Assembly > Copy with Rotation

Sheet Metal > Additional > Copy with Rotation

Keyboard Textual menu

<XT> Draw > Copy > Copy with Rotation

When defining a rotation, three points are specified in a general case: the center of rotation (the

attachment point), the start point and the end point. 

When defining points' coordinates, a coordinate along one of the axes can be fixed by enabling a

checkbox located to the left side of the coordinate value input box. Then moving the mouse in the 2D

window will only affect a coordinate whose checkbox is disabled.

Rotation is done about the specified center. The rotation angle is defined as the angle between the

vectors constructed from the rotation center to the start and end points.

The value of the rotation angle can be specified numerically or by a variable in the parameters

window.

When using the mode of the origin point automatic definition based on characteristic points of the

outlining rectangle, the rotation center is defined automatically.

The sequence of actions and the result of the Move with translation command.
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Scaling of Drawing Elements

Call the command Scale.

Icon Ribbon

Draw > Additional > Move with Scale

Sheet Metal > Additional > Move with Scale

Keyboard Textual menu

<TA> Edit > Move > Move with Scale

Call the command Copy.

Icon Ribbon

Draw > Additional > Copy with Scale

Assembly > Assembly > Copy with Scale

Sheet Metal > Additional > Copy with Scale

Keyboard Textual menu

<XA> Draw > Copy > Copy with Scale

When scaling and image, you need to specify the three points, just as in the case of rotation: the

center of scaling, the start point of scaling and the end point of scaling.

When defining points' coordinates, a coordinate along one of the axes can be fixed by enabling a

checkbox located to the left side of the coordinate value input box. Then moving the mouse in the 2D

window will only affect a coordinate whose checkbox is disabled.

The center of scaling is determined automatically in the case of using the mode of automatic

definition of the origin point based on the characteristic points of the outlining rectangle.

The scaling factor is computed as the ratio of the distances between the center and the end point and

between the center and the start point.

The scaling factor can also be defined numerically or by a variable in the parameters window.

The Scale elements font checkbox controls font scaling of the drawing elements (in the same way as

described for Translation).
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The sequence of actions and the result of the Copy with Scale command.

Symmetry of Drawing Elements

Call the command Symmetry.

Icon Ribbon

Draw > Additional > Move with Symmetry

Sheet Metal > Additional > Move with Symmetry

Keyboard Textual menu

<TS> Edit > Move >Move with Symmetry

Call the command Copy.
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Icon Ribbon

Draw > Additional > Copy with Symmetry

Assembly > Assembly > Copy with Symmetry

Sheet Metal > Additional > Copy with Symmetry

Keyboard Textual menu

<XS> Draw > Copy > Copy with Symmetry

To define symmetry, specify just the symmetry axis to mirror the selected object about. The axis can

be defined by either selecting an existing straight line or segment using the option , or by defining

two points for the symmetry axis to pass through. Existing 2D nodes can be used as the points.

When defining points' coordinates, a coordinate along one of the axes can be fixed by enabling a

checkbox located to the left side of the coordinate value input box. Then moving the mouse in the 2D

window will only affect a coordinate whose checkbox is disabled.

The sequence of actions and the result of the Move with symmetry command.

Following automenu options help to speed up definition of horizontal/vertical symmetry axes:

<U> Move along X axis

<V> Move along Y axis

Both options are active by default. This means, an arbitrary axis can be defined (you need to specify

two arbitrary points or an arbitrary straight line/segment). Deactivating one of the options turns on

the mode of creating a horizontal/vertical axis. The remaining active option defines the axis type: 

 - horizontal,  - vertical. In this case, simply select one point for the symmetry axis to pass through.
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When mirroring text, you can enable the Symmetrical Text checkbox in the parameters window. When

the checkbox is disabled, only the text position is affected by the symmetry. When checkbox is

enabled, the text contents are also mirrored symmetrically.

When you select the Create copies with constraints option, the Symmetry constraint will be created

automatically.

<Ctrl+F> Create Copy with Constraints

Translation and Rotation of Drawing Elements

Call the command Transition and Rotation.

Icon Ribbon

Draw > Additional > Move with Translation and Rotation

Sheet Metal > Additional > Move with Translation and Rotation

Keyboard Textual menu

<TS> Edit > Move > Move with Translation and Rotation

Call the command Copy.

Icon Ribbon

Draw > Additional > Copy with Translation and Rotation

Assembly > Assembly > Copy with Translation and Rotation

Sheet Metal > Additional > Copy with Translation and Rotation

Keyboard Textual menu

<XS> Draw > Copy > Copy with Translation and Rotation

For creation of translations with rotation or of analogous copying it is required to specify:

· initial point (this is an initial point of transformation and the first point of the initial direction

vector);

· initial direction vector (the end point of a vector is specified);

· end point (this is a target point of transformation and the first point of the final direction

vector);

· final direction vector (the end point of a vector is specified).

If the mode of automatic determination of the initial point on the basis of one of the characteristic

point of the encompassing rectangle is enabled, the initial point is not specified. 
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When defining points' coordinates, a coordinate along one of the axes can be fixed by enabling a

checkbox located to the left side of the coordinate value input box. Then moving the mouse in the 2D

window will only affect a coordinate whose checkbox is disabled.

Transformation is carried out by translating the initial point to the end point (target) and rotating with

respect to the end point at an angle between the initial and final direction vectors. In the parameters

window you can specify the magnitude of angle of additional rotation (it is added to the angle

specified by the vectors).

In addition, in the parameters window it is possible to change the scale of the image being translated.

The Scale font size of detailing elements checkbox controls the font scaling of detailing elements that

are included into the set of copied objects.

The sequence of actions and the result of the Copy with Translation and Rotation command.
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Copy with Clipboard

The command Copy - places the selected object on the clipboard:

Icon Ribbon

Edit > Edit > Copy

Database > Edit > Paste

Keyboard Textual Menu

<XC> Edit > Copy

The command Paste:

Icon Ribbon

Edit > Edit > Paste

Database > Edit > Paste

Keyboard Textual Menu

<XP> Edit > Paste

The clipboard allows you to use existing drawing elements to copy them between several documents

of one T-FLEX CAD application or another place in the current document. This mechanism allows you

to create only non-associative copies.

To place an object on the clipboard, you must point to it with the mouse cursor and press the right

mouse button. The  Copy to clipboard,  Copy with insertion point command will appear in

the context menu.  Paste from clipboard and  Paste special commands become available

only if there is any item in the clipboard.

The standard keyboard shortcuts work for copy commands via the clipboard: <Ctrl> <C>, <Ctrl>

<V>, <Ctrl> <Ins>, <Shift> <Ins>.

The types of items available for selection determine the settings of the Selector command. If you need

to change the selection of an item, you can use the Other context menu item containing a list of

available items.

Using multiple selections, you can copy/paste or move a group of items. You can select a group of

drawing elements in one of the following ways:

· using the window (when you move the mouse with the left button pressed, a rectangular area

of ??the drawing is selected, after which all the elements inside it that are available for selection

will be highlighted);

· when you click the left mouse button and the <Shift> key, the element closest to the cursor is

highlighted and added to the list of selected ones. Pressing the left mouse button and the

<Ctrl> key allows you to exclude an item from the selected list.

After multiple selection of elements, you can call the above commands in one of the ways.

· From the context menu (press  and select a command).

· In transparent mode, i.e. without explicit command invocation. In standby mode, press  to

execute the move.
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· From the Edit - Copy with point text menu, Paste <Ctrl><V> (<Shift> <Ins>), Translation >

Move > Rotate> Scaling > Symmetry.

If snapping to the grid is enabled, then the moved (inserted) elements will be snapped to the grid.

When moving beyond horizontal or vertical lines, they also snap to the grid.

Element moving

Moving elements is possible within a single document. When an element is moved, the position of the

parent elements (based on which the moved element was created) and the descendant elements

(which were created based on the moved element) changes. Moving can be of one of the following

types: moving, rotation, scaling, symmetry. Each type corresponds to a separate command in the Edit

> Move text menu. The work of these commands is described in more detail in the Moving, Copying

and Creating Arrays of Drawing Elements section.

To move elements from one page to another, it is convenient to use the following sequence of

actions:

· select elements,

· press the left mouse button and release without moving the cursor,

· go to the necessary page and press the left mouse button or the <Enter> key.

You can cancel the move by pressing the right mouse button or the <Esc> key.

The way an element is bound determines its position relative to the fixing point. The active binding

method is indicated by one of the icons (to change the binding method, click the left mouse button

on the icon image and hold it for a while - a list of options will appear in which you can select the

necessary method).

<Ctrl+0> Left Top

<Ctrl+1> Center Top

<Ctrl+2> Right Top

<Ctrl+3> Left Center

<Ctrl+4> Center

<Ctrl+5> Right Center

<Ctrl+6> Left Bottom

<Ctrl+7> Center Bottom

<Ctrl+8> Right Bottom

<Ctrl+9> Free attachment mode

Copy/Paste Element

Selecting elements and calling the  Copy command is done using one of the methods described

above. Then the  Paste command is called anywhere in the current document or in another

document. After that, an image of the copied elements will appear on the screen, which can be placed

in the necessary position when pressed. 
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To snap the copied objects during the subsequent insertion into the T-FLEX CAD document, it will be

possible to use the characteristic points of the copy object (center, upper left corner, upper right

corner, etc.).

The elements are copied along with the necessary building elements. If copying is done to another

document, then the connection with variables is broken (variables are replaced with constants). Note

that when copying, data is placed in the clipboard not only in the internal T-FLEX format, but also their

image in the Enhanced Metafile (EMF) format, which allows you to insert the image of selected

elements into other Windows applications, for example, Word.

If only one Text type element was selected for copying, then text data in the following formats is also

entered into the clipboard:

· T-FLEX Paragraph Text (except the string text), 

· RTF (except the string text), 

· Unformatted text.

This supports data exchange both within the same T-FLEX CAD application and across several

different applications. 

The  Copy with Insertion Point command allows you to write to the clipboard the selected

elements and the point that will be used to bind them when pasting from the clipboard.

Upon calling the command, the elements being pasted will be rubberbanding with the pointer. The

attachment point for the elements being pasted is defined by clicking  or by using the option 

.

The following options are provided in the automenu:

<N> Select Node

<E>
Use Variables when names are coincident (only when pasting in another T-

FLEX CAD document)

<Alt><T> Copy only selected elements

<U> Move along X axis (only when pasting in the same T-FLEX CAD document)

<V> Move along Y axis (only when pasting in the same T-FLEX CAD document)

(Selection of the attachment point)

(Selection of the action after pasting)

<Esc> Exit command

The options  and  are used for blocking pointer movement in the directions of the respective

coordinate axes. To specify the exact position of the copied elements or the offset with respect to the

original object, use the command property window. This option is available only when pasting the

copied elements in the same T-FLEX CAD document.

The group of options for selecting the attachment point allows specifying the point to which the

pasted object should be attached. The characteristic points of the object are available for selection. If

the objects were placed on the clipboard by using the command Copy with Insertion Point, then an

additional attachment point can be defined in the command being discussed (the option ).
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When using the clipboard copying mechanism, the system forces copying of the parent elements of

the objects being copied (in the cases, when the former were not explicitly included in the set of the

copied elements). This feature is similar to that used in the copying mode Explode Copy keeping

relations. In the current case, you can also prohibit this system behavior by using the option . With

this option activated, the elements, whose parents were not included in the set of elements to be

copied, will be converted into independent objects.

The copied elements can have relations with variables (except for the variables describing the position

of these elements). To replace the respective parameters of the elements being copied by the

variables defined in the target T-FLEX CAD document (the document where the elements are copied

to), use the option . This option is only available when pasting the copied elements in another T-FLEX

CAD document within the same active application. If the option  is turned on, the names of the

variables are compared in the target document versus those in the copied objects. If the names

coincide, then the copied elements take on the relations with the respective variables of the current

document. The variables, for which no match is found, are replaced by their values. If this option is

turned off, the relations with all variables are broken, the variables being replaced by constants.

The group of options  is used for the same purpose as in the moving, copying and array creation

commands. Those define the action that will be automatically performed upon completion of pasting

the clipboard contents. The following choices are provided:

 - the system exits the command after pasting the clipboard contents;

 - repeated pasting mode - upon pasting the first instance, the copied object starts

rubberbanding with the pointer. The system waits for the user inputting the attachment point for the

next copy. Upon selecting a second point, another copy is pasted, and so on. The copy creation can be

interrupted by right clicking  or pressing ;

 - the copying command Copy with Insertion Point is automatically executed over the pasted

object;

 - is similar to the previous choice; however, before calling the copying command, the system

turns on the mode of editing the list of selected elements.

The command is exited using the option (<Esc>).

When inserting an image, the Picture creation command is automatically launched.

When inserting text from the clipboard into a T-FLEX document, the internal data format is used.

The program scans through the clipboard, searching for the appropriate format among the clipboard

data. The data will be pasted in the first appropriate format found. The order of the format search is

as follows:

1. Internal T-FLEX CAD format (used only when copying within one T-FLEX CAD application)

2. T-FLEX Paragraph Text

3. RTF

4. Unformatted text 

5. EMF

6. BMP (bitmap image)

If a textual format is used, then a Paragraph text element is automatically created, and then its

editing command is launched, Edit Text.

When inserting objects from AutoCAD into a T-FLEX CAD document via the clipboard, the Import

command parameters dialog appears first. This dialog is used for specifying the general import
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parameters of an AutoCAD document. Then Paste command will start for setting location parameters

of the elements being inserted - position, angle of rotation, scale factor.

Copying the properties of an element via the clipboard

The Copy Properties command is available in the context menu for any 2D element. When this

command is called, the parameters of the selected element are copied to the internal clipboard. After

that, the Paste Properties from Clipboard commands will be available in the context menu when

selecting any other 2D elements. When it is called, the parameters copied to the clipboard are applied

to the selected elements.

Topics in this section:

· Copy with Insertion Point

· Paste Special

Copy with Insertion Point

Calling the command:

Icon Ribbon

Edit > Edit > Copy with Point

Keyboard Textual Menu

<XI> Edit > Copy with Point

This command allows you to copy the selected elements to the clipboard with the coordinates of the

point that will be used as the fixing point for subsequent insertion from the clipboard. The command

call is also available from the context menu for the selected item (set of items). 

If the command is called from the text menu, then the first necessary action will be the selection of

elements. The following icons will appear in the automenu:

<End> Finish element selection

<M> Add elements

<M> Remove elements

<I> Select Other Element

<Esc> Exit from editing of selected Elements list

To select one element, it is enough to point at it with the mouse cursor, click , and then complete

the selection with an option . To specify a set of elements, a window selection or sequential

indication of the necessary objects is used by pressing the <Shift>+  keys. To exclude one of the

items from the selected list, use the <Ctrl>+  keys. You need to confirm the selection using the

option .  

If the command was called from the context menu, then the selection of items to copy is not required

and you can immediately specify the insertion point.
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To specify a point in the automenu, the following options are available:

<N> Select Node

<A> Set absolute coordinates

<Esc> Cancel selection

You can use an existing node or an arbitrary drawing point as the fixing point. If the object snapping

mode is enabled ( ), then it is enough to move the cursor to the necessary point (if you point to a

node, it will light up) and click . Object snapping when selecting a point works the same way as in

the Sketch command. Options  or  is convenient to use when working without object

snapping. 

If you select the option, the exact values of the point coordinates can be set in a separate Position

window after clicking in the drawing field. 

The result of this command is to write the selected elements and points to the clipboard. When the

Paste from Clipboard command is called, this point will be the fixing point of the copied elements.

Paste Special

Calling the command:

Icon Ribbon

Edit > Edit > Paste Special…

Keyboard Textual Menu

<XZ> Edit > Paste Special…

This command allows the user to manually select a format for the clipboard contents to be pasted.

The command dialog displays the list of formats present in the clipboard at the time of calling the

command. Depending on what format the user selects, the system goes into the T-FLEX CAD object

pasting mode, or pasting pictures in the EMF or BMP format, plain text or formatted text (RTF).

Local Coordinate System

By default, all drawing elements will be created in the page coordinate system (CS). To create drawing

elements in a user coordinate system, you should create a user CS using the LCS command:
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Icon Ribbon

Draw > Style > LCS

Keyboard Textual Menu

<FV> + <L> Construct > Fixing Vector > LCS

The created CS is defined by two nodes that define its OX axis. The first selected node will be the

center of the CS. The second node will determine the direction of the OX axis. The OY axis is

perpendicular to the OX axis. You may edit nodes to change the CS position: translation in the drawing

plane and rotation.

All bindings that are available for construction and graphic lines are available during CS creation. If

you selected characteristic points of graphic line during the CS creation, free nodes will be

automatically created in the same position.

A dialog for the CS creation will appear after two nodes selection.

You should specify Level, Color (their description is given above) and Name for the CS.

The created CS is not an active CS that defines coordinates of the created drawing elements. You

should select it before constructions creation to make the CS active.

You can select a CS in the list of a drawing coordinate systems. The list can be found in the Ribbon in

the Style group near the icon for a user CS creation. All coordinate systems for the current page and

workplane are displayed in the list.
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The active CS is shown in the Ribbon. On the page or workplane it will be displayed with thick lines.

You can call a user CS creation in the bottom of the list. 

The selected CS will determine coordinates of the created constructions. The selected CS determines

constructions only on the current page or workplane like the default CS. The created CS will not be

available on other pages or workplanes.

User CS is not displayed in the hidden construction lines mode, is not printed and is not exported to

third-party formats.

Changes of a user CS location will cause position changes for all constructions created according

to this CS. 

Selection of 2D Elements

Any 2D element can be selected by 2D view, taking into account the filter toolbar or in the Model

Elements window.

When object snapping is enabled, when creating drawing elements, an icon appears next to the

mouse cursor when it points to an existing drawing element, reflecting the type of this element (node,

straight line, circle, intersection, etc.). At the same time, the selected element is highlighted on the

screen. In addition, if the Show Tooltips flag is set in the Set System Options command (Snap tab),

then the name of the element type and its identifier will appear on the screen.
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The described features simplify the selection of a drawing element for snapping the created elements.

This means that there is no need to use the automenu or keyboard in most cases. All elements of the

construction and graphics in the creation and editing commands are highlighted when the cursor is

brought up only when it makes sense. For example, when constructing a spline, only nodes and points

will be highlighted when selected, since the spline is based on a set of nodes (or points, if it is a Sketch

command spline), all other elements will not be highlighted when the cursor is brought in, since it

does not make sense when constructing a spline. When editing, dynamic highlighting of elements is

carried out after selecting the edited element.

When creating/editing, the system automatically finds the allowed snaps and offers them to the user

(highlighting the type of snapping next to the cursor). In addition, the system tracks the coincidence of

two object snaps, for example vertical - horizontal, perpendicular - horizontal, etc.

To temporarily disable the object snapping inside the command, you can use the <Ctrl> key. While

the key is pressed, the snaps do not work.

Enabling and disabling snaps that are active when building a drawing is carried out on a special

toolbar at the top of the drawing. The toolbar automatically appears as soon as the mode of drawing

graphic lines or graphic lines is selected.

For graphic lines:

For construction lines:

For the graphic lines created in the Sketch command, the designation of the snapping icons looks as

follows:

<Alt+I> Point on Graphic Line
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<Alt+D> Point on Construction (is not enabled by default)

<Alt+P> Construction Intersection

<Alt+R> Coordinate System Origin 

<Alt+M> Line Midpoint

<Alt+B> Graphic End Points

<Alt+C> Circle/Arc Center

<Alt+A> Arc Angle 90, 180, 270 degrees 

<Alt+V> Horizontal/vertical tangent 

<Alt+H> Horizontal/Vertical

<Alt+O> Orthogonal

<Alt+S> Graphics Continuation

<Alt+T> Tangent to Graphic Line 

<Alt+N> Snap to 3D Elements (not active for the drawing). 

By clicking  on the icon , you can disable and enable all object bindings. Each individual

binding can be turned on and off by clicking  on the corresponding icon. 

Often bindings interfere with each other: It's hard to find the right one among the automatically

offered binding variants. Then you can temporarily set only one, the necessary binding. To do this,

there is an icon  on the bindings toolbar that displays a list of all the bindings from which you

need to select the one you need. After you select the temporal binding, all other bindings will be

inactive, until creation is finished using . After the construction is completed, all the bindings that

are active in the bindings toolbar are available again. You can select a temporary binding using hot

keys. To set multiple time bindings, use the List button in the context menu. After clicking the button,

the context menu is replaced by a dialog window in which several time snaps can be enabled at once.
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If several object snapping options are found at a given point, the system allows the user to select the

necessary snapping (or a combination of two snaps). To do this, after placing the cursor at the

necessary point, do not move it for a while. Then a tooltip will appear next to the cursor, which will

indicate the total number of object snapping found by the system. Using the mouse wheel, you can

sort through these snaps. Clicking will select the snap that will be used to create or edit the current 2D

element.

The object snapping proposed by the system can be fixed using the <Space> key.

When the drawing is complex enough and there are many constructions, in order to activate the

binding to those constructions that you need, you should move the cursor to the element (or

several elements) in relation to which you want to create binding in the sketch command mode.

If the required binding is active on the bindings toolbar, then an accurate dashed line will be

drawn from the element. Next, we put a characteristic point with help of .
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Examples

Circle in the center of a rectangle

Suppose we are given a rectangle and need to create a circle in its center.

You need to make sure that the middle of the graphic line  and the perpendicular  bindings are

active. Call the Circle by the center and radius option and move the cursor to the middle of the upper

side of the rectangle. The binding to the center of the graphic line is activated. You move the cursor

down, and the perpendicular binding icon appears. The dashed line is dynamically erased from the

point of the middle perpendicular to the upper rectangle side. The binding is "remembered". Now we

move the cursor to the middle of the left side of the rectangle. The binding to the middle of the

graphic line is activated. You should move the cursor to the right. When the cursor is in the area close

to the center - the first binding is automatically aligned from the middle of the upper side along the

normal downward. The intersection of two perpendiculars from the middle of the sides is the center of

the rectangle. Click  to specify the point of the center of the circle. Next, enter the radius of the circle.

Quarter of a circle

Let us create a quarter of the circle, as shown in the figure. First, you need to make sure that the

bindings to the end points of the graphic line , the binding to the center of the circle  and the

binding when creating arcs to the angles of 90, 180 and 270 degrees  are active.

Select the Arc by two points and radius option. We specify the first point arbitrarily by using the  in

the drawing field. Next, enter the angle of 45° in the properties window: this means that the second

point of the arc will be built on a line passing through the first point, at an angle of 45° with respect to

the horizontal. We press , thereby setting the second point of the arc.

A dynamically changing arc appears under the cursor. The cursor position determines the radius of the

arc. Moving the cursor, we find the binding to the arc by 90 °: the dashed lines that limit a quarter of a

circle appear. Click  to complete the arc. You should switch to the construction of the segment <S>. If

Continuous line input has been enabled, the first point of the segment will already be at the extreme
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point of the arc. If the continuous input mode was not enabled, then we move the cursor to the edge

of the arc, so that the binding to the end points of the line is activated. Press  to enter the first point of

the segment. The second point of the segment appears under the cursor. The line is dynamically

rebuilt according to the position of the cursor. If you can not find the binding to the center of the arc,

you must point the cursor to the arc. The algorithm for finding bindings should "understand" that we

want to create binding to the arc. You should move the cursor to the center of the arc. Once the cursor

is near the center, the binding is activated. The center point will be highlighted with a square marker

and a binding to center icon will appear. Press  to enter the second point of the segment. Depending

on whether the continuous input mode is enabled or not, the first point of the next segment will be

already defined or it should be set independently. After specifying the first point of the segment, we

move the cursor down, toward the other extreme point of the arc. The binding to the end points of the

graphic line is activated again, we click , the contour is built. Next, you need to create a hatch.

Select All command

Calling the command:

Icon Ribbon

Draw > Additional > Select All

Workplane > Additional > Select All

Keyboard Textual Menu

<ESA>,

<Ctrl>+<A>
Edit > Select All

The command can also be called from the contextual menu invoked by clicking  on an empty

space in the 3D scene in the command standby mode.

The command selects all object in the 2D scene, which comply with active filters on the Filter Toolbar

or in the Selector command's dialog and are located in the active page of the current document.

Selected objects are highlighted in various colors depending on a type of a particular object.

Grid

Calling the command:

Icon Ribbon

Edit > Document > Grid

Keyboard Textual Menu

<QG> Customize > Grid

When creating a drawing, it is sometimes helpful to use a grid of dots. In this way, snapping will occur

to the grid dots while creating various drawing elements. The precision with which you create drawing

elements can be controlled by specifying the appropriate grid step. 
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The following required parameters are defined in the Grid Properties dialog box:

· Visible. Sets the display mode of the grid. The grid color is defined in the system options (the

Set System Options command). 

· Snap to grid. Sets the element snapping to grid mode.  

· Drawn last. Defines the order of drawing the grid on screen. 

· Step X. Defines the grid step along the X-axis of the drawing. 

· Step Y. Defines the grid step along the Y-axis of the drawing. 

· Offset X. Defines the grid shift along the X-axis of the drawing with respect to the origin (0,0). 

· Offset Y. Defines the grid shift along the Y-axis of the drawing with respect to the origin (0,0).

The grid options are saved with the drawing. 

The grid management commands are accessible via the View toolbar:

<Alt><F6> Grid

<Ctrl><G> Grid Snap On

Enlarge Grid Step (doubles)

Reduce Grid Step (halves)

If the grid snap is turned on then the grid knots serve as the snapping nodes for the drawing elements.

Drawing Detailing

In the T-FLEX CAD system, drawings can be designed using a large list of built-in functions that meet

all the standards of the ISO and ANSI.

Topics in this section:

· Drawing Views

· Dimension

· Auxiliary Lines and Dimensions

· Text
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· Hatch

· Roughness

· GD&T Formlimits

· Section View

· Leader Notes

· Snapping Dimensions and Leader Notes to Drawing Views

· Axes Creation

· Drawing Title Block

· Technical Requirements

· Variation Table

· Pictures

· Redraw

· Font Parameters of Drawing Detailing Elements

Drawing Views

Drawing views are created using the command “Create Drawing View”:

Icon Ribbon

Draw > Draw > Drawing View

Sheet Metal > Draw > Drawing View

Keyboard Textual Menu

<SD> Draw > Drawing View

This chapter describes an auxiliary element of T-FLEX CAD system – the drawing view. Additional

views, detail views, local section views and sections – all these instances are supported by Drawing

View. This functionality handles situations when elaboration to the images on the main views is

required. This can be an additional view, and, in particular, a scaled view. The functionality allows

collecting together on one page elements from different pages, inserting an image (or a portion

thereof) from one page into another page in various scales, even create a simple assembly from parts

contained in the same document.

Main concepts

A drawing view is an element of T-FLEX CAD that allows displaying contents of one page (or a portion

thereof) on another page, scaled to the necessary factor. It is a rectangular area of specified size used

for displaying the contents of another page. 

The page displayed within a drawing view can either be selected from the list of existing pages in the

document or additionally created for the drawing view. The newly created page is assigned the type

"Auxiliary". A drawing view can be nested, that is placed within another drawing view.

Location of the drawing view box on the main page can be specified by either direct selection of the

fixing point and the view rotation angle or with the help of the fixing vector located on the view page.

The main purpose of a drawing view is to display on one page drawing elements of different scales.

For example, one can create a drawing of some object on one page and then create drawing views of

this object on other pages that will display portions of this drawing to various scales. 

Besides, drawing views can be used simply for collecting the contents from different pages. This may

be used for adding to the main drawing some additional, local views and sections created on other

document pages in different scales. This capability is the most common way of using drawing views in
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T-FLEX CAD. Note that the images on the detail views can be copied from other pages of the current

document when the drawing view is created (see section “Creating Detail View”), and enhanced with

captions of the view notations (see section “Creating Detail View with Caption”).

          

 Detail View  Detail View with Caption

The image displayed on a drawing view can be created or edited either on the original page of the

drawing view elements, or directly in the view area of the main page by activating the view.

Limits are shown on the drawing for drawing view and detail view. The limits are not printed. If you

want to change color of the limits use the option Limits of inactive drawing view on the Color tab in

the Set system options command. You can specify colors of the other drawing view elements on the

tab.

Types of drawing views

After invoking this command, the following options will appear in the auto menu:

<О> New Drawing View

<V> New Detailed View

<С> New Detailed View with Caption

<S> Create drawing view by contour

These options define different modes of creating drawing views.

These command operation modes can be also specified in the properties window (parameter “Type”

in the group “Basic parameters”). The command's properties window and the auto menu work

synchronously.
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Breaks of Drawing Views

The following automenu option is available, when creating and editing drawing views:

<B> Add or edit Broken View

Breaks of drawing views are handled in the same way as breaks of 2D projections. The detailed

information can be found in the Breaks of Projections and Drawing Views section.

Topics in this section:

· Manipulators of Drawing View

· Create Drawing View

· Create Detail View by Elements

· Create Detail View with Caption

· Create Detail View by Contour

· Scale of Drawing View

· Specifics of Detail Views

· Parameters of Drawing View

· Contextual Menu of Drawing View

· Activate Drawing View or 2D Projection

· Edit Drawing View

· Managing Elements of Drawing View

Manipulators of Drawing View

For defining location, rotation angle and dimensions of the drawing view, a special type of the cursor

in the form of the dynamically movable rectangle with markers is used. Markers can be used for

modifying location, rotation angle, the scale and the size of the view, location of the fixing vector or

fixing point.



Drawing Creation

609

Move View Area

Scale

Movement of Whole Picture

Rotate

The markers are used as follows: a marker is activated simply by pointing the cursor and clicking .

Then the marker can be moved to the necessary position. The second click  fixes the new position

of the view. Alternatively, the marker can be “dragged” by moving the cursor with the mouse button

 held down. In this latter case, the placement of the view in the new position occurs on releasing

the mouse button.

As the placement or parameters of the view are modified, the original state stays in display. 

To change the view box size, the square-shape markers are used, located in the corners and at side

midpoints of the view box.

The  marker provides for modifying the view scale, that is the scale factor of the page display in the

view box. The exact value of the scale can be entered in the view parameters dialog box.

The marker  allows changing the view rotation angle about the fixing point. (In the case the view

was based on an existing page and a fixing vector, this will be the rotation angle of the fixing vector.) 

The exact value of the rotation angle can be entered in the view parameters dialog box.

For moving the view image relative to the page, on which it is located, the marker  or the marker of

the fixing point of the view (in the form of the filled square) can be used.

Location of the fixing point of the view is shown with the marker in the form of the unfilled square.

When  creating the drawing view on the basis of the existing page with the help of the fixing vector,

the location of the given marker coincides with the origin of the fixing vector.

For modifying the fixing point of the view, point at the marker for fixing the view while holding the

button <Shift>. After that, to select the fixing point, you can pick (by pressing ) one of the

characteristic points of the view box (corners of the view box and the midpoints of its sides). You can

also specify the fixing point of the view arbitrarily by using <Ctrl>+ .

It is also possible to change the location of the fixing point of the view with the help of the

option  of the auto menu for the command of creating/editing the drawing view.

For moving the drawing view area (that is, the drawing view box relative to the page displayed in the

view), the marker  is used.
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Originally, the boundaries of the box coincide with the boundaries of the displayed page.

Shifting the view with respect to its page makes sense only when a portion of the page is

supposed to be displayed on the view. In this case, the “Clip Image” flag is usually checked in the

parameters dialog box, and the view box manually reduced to the necessary size.

Create Drawing View

After entering into the command “Create Drawing View” the option  becomes active by default.

This option allows the user to create a simple drawing view. The created view can display the contents

of already existing page of the current document as well as of the new page, automatically created by

the system for the given drawing view.

After activating the option the cursor starts moving a box with markers for moving the view area,

rotating and scaling the view. Meanwhile, the status bar displays the help message “Select Drawing

View type or set new Drawing View placement”. The drawing view can be placed on the current page

by specifying a point on the drawing (a 2D node or an arbitrary point). 

To fix the view at a node, one can use the following automenu option:

<N> Set relation with Node

The location of the created view (coordinates X and Y of the fixing point) can be also specified in the

command's properties window (in the group “Basic parameters”).

By default, the snap of the drawing view is carried out at the center of the view box. It is possible to

select another fixing point of the view with the help of the option:

 Fixing Point of View

After specifying the view location, the user can define more accurately the location, the size and the

scale of the view by using the markers around the view box (the use of markers is described in section

“Editing drawing views” in more detail).

It is possible to specify parameters of the created drawing view in the command's properties window.

Create New Page. A new page (“Auxiliary” type) will be created along with a new drawing view. The

parameters “Width” and “Height” define the page size. These also define the initial size of the

drawing view box. The parameter “Scale” defines the scale factor of the view page. These settings are

entered as the “Paper size” group of parameters and “Scale” parameter of the newly created drawing

page on the tab “Paper” of the Set Document Parameters command.
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The created page will not contain any constructions. The user is supposed to create the

necessary contents on this page himself. The editing techniques of drawing views and their

contents are described in the section “Editing drawing views”.

Use Existing Page. Allows selecting any existing page in the document (except the current one) from

the list. This parameter is inaccessible for one-page documents. The size of the drawing view box is

automatically set in accordance with the size of the selected page.

Fixing Vector. Setting this parameter allows the user to select and use the fixing vector existing on the

selected page for snapping the created drawing view. The parameter is accessible only when the flag

“Use Existing Page” is set and when a fixing vector exists on the current page. Note that, when using

the fixing vector, it is necessary to specify two fixing points of the drawing view.

Fixing Vector can be used for placing a drawing view, just like a 2D fragment. This also allows

controlling the current page layers visibility as the page is displayed on a view. Use of fixing

vectors is described in details in the chapter “Assembly Drawing”.

The group of parameters “Parameters” combines auxiliary parameters of the drawing view:

Scale. Defines the scale factor of the drawing view, which is the scale of transformation of the view

page as it appears on the main page.

Rotation Angle. This parameter is inaccessible when using a fixing vector.

Clip Image. When set, the page in the view is clipped to the extents of the actual image contained on

the page.

Scale Lines. When set, the thickness of the graphic lines on the drawing view will be affected by the

“Scale” parameter.

To complete view creation, use the option . As a result, a rectangular area of the drawing view

will be created, with the contents of the specified page or its portion displayed within.
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Create Detail View by Elements

The option  allows the user to automatically create the detail views on the basis of the drawing

view. As a result of its use, the drawing view containing automatically created copy of the selected

elements of the drawing will be created. In addition, the image on the drawing view page will be

automatically augmented with the view caption.

When using this option, the following will be created: 

1. A new drawing view (based on a new “Auxiliary”-type page). The drawing view parameters are set

“by default”;

2. A translated copy (as in the command “Drawing > Copy > With translation”) for associative

copying of the selected elements onto the drawing view page with specified parameters (scale and

rotation angle);

3. The caption for the detail view.

As a result, a rectangular area of the drawing view is created on the main page with copies of selected

elements displayed within. The size of the drawing view, as well as the size of its respective page, is

defined automatically by the system based on the size of the copied entities. If necessary, the size of

the drawing view and its page can be modified manually.

For creating the detail view, it is necessary to do the following:

1. Select the elements to be copied from the original drawing;

2. Select the fixing node for the copied elements;

3. Define location of the detail view (that is, the location of the drawing view containing the detail

view).

After invoking the option  the options for selecting the copied elements will appear in the auto

menu:

<M> Select Mode

<M> Deselect Mode

<I> Select Other Element

When the option is turned on  all elements selected on the drawing are added to the list of the

copied elements. For quick selection of several elements, you can use the selection with the window.
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When the option is turned off  the selected on the drawing elements will be removed from the list

of the copied elements. For quick selection, you can use the selection with the window here as well.

Complete the selection of the elements, which will be copied onto the detail view, by pressing .

After selecting the copied elements, the system will prompt the user to specify the fixing point of

these elements (it will serve as the initial point of the copy to be created). The option for selecting a

2D node will appear in the auto menu:

<N> Set relation with Node

After choosing the fixing node, the dynamic image of the created detail view attached to the cursor

will appear on the screen. The location of the detail view on the drawing has to be selected next. After

snapping the view, its location and size can be adjusted with the help of the markers for editing the

drawing view.

To make the caption of the detail view change its location according to the modifications of the

drawing, it is recommended to fix the drawing view to the 2D node.

Before completing the detail view creation, the dialog for specifying parameters of the created view

will remain available in the command's properties window. In this dialog you can specify the precise

values for the fixing point of the view, and also the following parameters:

Copy Scale. This scale determines the scale with which the selected elements of the drawing will be

copied.

The group of parameters “Image” defines parameters of the drawing view being created (these

parameters can be also specified directly in the drawing's window with the help of the markers on the

view image):

Scale. The drawing scale of the drawing view, that is the scale with which the drawing view page is

shown in the view area;

Rotation Angle. Angle of rotation of the drawing view.

Group of parameters “Text” allows specifying parameters of the view caption:

Letter (Text):. In this field the lettered caption for the created view is shown (selected by the system

automatically). If necessary, you can choose another caption.

Auto Increment. When this flag is set, for each new detail view the “available” letter is automatically

selected. It is shown in the field of the parameter “Letter (Text)”. When this flag is turned off, the

automatic selection of the lettered caption does not occur.

First Line. The text in the first line of the view caption. This parameter supports the special format. To

insert the lettered view caption (the value of the parameter “Letter (Text)”) into the line, the group of

symbols “<Letter>” is used. To insert the copy scale caption (“1:1”, “1:2” ...) – the group of symbols

“<Scale>”. By default, the string “<Letter> (<Scale>)” is set for this parameter.

Underline. When this flag is set, the text in the first line of the view caption will be underlined.

Second Line. This parameter defines the text of the second line of the view caption.

Clip Image. When this parameter is set, the view image will be cropped by the drawing view borders.

Scale Line Width. If this parameter is set, the width of the graphic lines of the detail view will be

scaled according to the specified drawing scale of the view.
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To complete view creation, use the option . For the view constructed, the caption will be

automatically created. The obtained view can be edited and augmented, if required.

Create Detail View with Caption

The command for creating detail view with caption can be called in one of the following ways:

Icon Ribbon

Draw > Draw > Detailed View

Sheet Metal > Draw > Detailed View

Keyboard Textual Menu

It is also available as option in the  Drawing View command:

<C> New Detail View with Caption

Creating the detail view with the caption with caption is an extension of the case of creating a basic

detail view (the option ). The  Detailed View command creates the detail views clipped by

the specified contour and with automatic creation of the caption for the detail view on the given

drawing.

As a result of its use, the caption for the detail view is created on the drawing. The image of the detail

view itself is automatically clipped by selected contour (circle, oval or rectangle) and augmented by

the view caption. The obtained image can be edited later by using the standard tools of the T-FLEX

CAD.
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When creating the detail view with the caption, the following will occur:

1. Creating the new drawing view (on the basis of a new page of the type “Auxiliary”). The values of

the parameters of the drawing view are set “by default”;

2. Creating a copy with translation for associated copying of the selected elements onto the drawing

view page with the specified scale and rotation angle. Clipping the image to be copied by the

automatically created hatch of the specified form;

3. Creating detailing elements for the detail view (view caption, caption of the detail view).

After calling the  Detailed View command it is necessary to do the following:

1. Select the fixing node for the elements which will be copied;

2. Specify the center of the selection area for the detail view;

3. Specify the form and size of the selection area for the detail view;

4. Specify the location of the leader line jog for the detail view caption;

5. Specify the location of the detail view (that is, the location of the drawing view with the detail

view).

Note that in the described sequence of steps, there is no step for selecting the original elements to be

copied. When creating the detail view with the caption, the collection of the copied elements is

determined by the view selection area – all 2D elements at least partially contained in the specified

area will be copied.

For selecting the fixing node, in the auto menu of the command the following option will be available:

<N> Set relation with Node

The fixing node will determine the initial location of the fixing point for the created view. If, upon

specifying the fixing node, the user selects an arbitrary point on the drawing (with the help of ),

then at this point the free node, which will be selected as the fixing node, will be automatically

created.

After specifying the fixing node, the system will ask to specify the center of the selection area. This can

be done by picking an arbitrary point in the drawing's window (with the help of ) or by specifying

exact coordinates in the command's properties window.

The center of the selection area can be also defined by selecting a 2D node or offset of the center

point from the fixing node (selected at the previous step). For selecting the 2D node the following

option is used:
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<N> Set relation with Node

For specifying the offset of the center of the selection area from the fixing node, the following option

is used:

<A> Set Relative Position

After selecting the center of the selection area, the form and dimensions of the area need to be

specified.

The form of the area is specified in the command's properties window: circle, rectangle, oval.

The dimensions of the area can be specified either in the properties window or directly in the

drawing's window (the dynamic image of the area's bounding frame will follow the cursor, pressing

 will fix the frame location).

  

After specifying the view selection area, the location of the leader line jog for the view caption has to

be defined. Dynamic image of the leader line jog will follow the cursor. Pressing  in the drawing's

area will fix the jog location. The jog location can be also specified in the command's properties

window (by specifying the coordinates of the starting point of the jog in the group “Basic parameters”

of the properties window).

For changing orientation of the jog for the view caption, the following auto menu option can be used:

<Z> Change leader line jog orientation

After specifying the jog location, the dynamic image of the created detail view, attached to the cursor,

will appear on the screen. The location of the view on the drawing has to be specified next.

To make the caption of the detail view change its location according to the modifications of the

drawing, it is recommended to snap the copied element to the 2D node. 

After snapping the view, its location and size can be adjusted with the help of the markers for editing

the drawing view. Finish adjusting of view's location and size using the  option .

The last step of the detail view creation is the view outline creation. The system allows to define the

outline after pressing .
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A dotted line appears around the selected area for the detail view. The line is divided into segments.

A click into a segment enables/disables the display of the selected segment.

The following options are available:

<S> Show all segments of detail view outline

<H> Hide all segments of detail view outline

<I> Invert visibility of detail view outline segments

You can specify parameters for the outlines using the option .

For the constructed view, the caption will be automatically created. The obtained image can be edited

and augmented, if required.
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Create Detail View by Contour

To create a drawing view by contour you should create a contour in advance. Both the construction

lines and graphic lines can be used for the contour creation.

Use the following option to create a drawing view:

<S> Create detail view by contour

You should select a contour after the option activation.

Then you should select a fixing point and specify the position of detail view on the drawing.

Then you should edit outline.
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To finish a detail view creation select the option .

Scale of Drawing View

Particulars of drawing views scaling 

The "Drawing view" element and based on it detail views are created using various T-FLEX CAD

instruments (the view page, the drawing view mechanism, the copy functionality). Each of these

instruments has its own settings, including the scale:

1. Drawing view page scale (defined under the command Set Document Parameters); 

2. Drawing view scale which is the scaling factor of the drawing view page display on the detail view

(defined in the drawing view properties dialog box – "Image > Scale");

3. The Scale of the copying the view elements (available in the properties window of the drawing view

when using the options  and ).

All these scales are superimposed in the image of the drawing view on the host drawing page.

When creating a drawing view using the options of the command "Create Drawing View", the user

defines only two of these scales (for example, the scale of the drawing view and the page scale when

using the option , or the scale of the view image and the copying scale when working with the

options  and ). The missing scale is assigned to default value. The user can manually modify

the values of all types of scale (see next section), however, in this case, the user needs to clearly

understand the mechanism of the scale array.
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For example, consider the drawing view of a shaft on a diagram in the beginning of this chapter. This

drawing view of the shaft in axonometric projection was performed with the page scale equal to 1

and the drawing view  scale equal to 0.5 (1:2). As a result, the image of the view on the main drawing

page has the cumulative scale equal to 0.5. By changing the drawing view page scale to 2 (2:1), we will

get the axonometric projection of the shaft on the main page to the 1:1 scale. Should we change the

view page scale to 4 (4:1), the cumulative scale becomes equal to 2 (2:1).

The detail view (View A) in this example was created using the option . The copying scale and,

therefore, the drawing view page scale is equal to 4 (4:1). Meanwhile, the drawing view scale is equal

to 1. As a result, the cumulative scale of the detail view image is equal to 4.
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Scaling of Copied Elements

A context menu appears on right clicking  over the lines on the view created by copying (in the

activated drawing view area on the main page or on the view page), with the following commands

under the "Move Copy" group:

· "Edit Copy" - calls the editing command "Edit Copy";

· "Delete copy" – deletes all elements of the copy; 

· "Copy Parameters" – allows defining the scale and rotation angle of the translation; 

· "Explode Copy" - breaks association of the moved elements with the original elements. The

copied elements become independent objects, regardless of their parents creation history;

· "Explode Array" - breaks association of the moved elements with the original elements;

however, relations are preserved between the objects of the copy analogous to the relations

between the original objects; 

· "Restore deleted elements" – allows restoring deleted elements of the copy.

"Parameters" - opens dialog of transformation parameters where you can change scale and angle of

rotation.

Two extra options appear at this stage:



T-FLEX CAD 17 Help

622

Model scale correction (enabled by default). This option is available only for “move” transformations

 automatically created for the detail view. When this option is enabled, the assigned scale value is

replaced by the calculated scale as follows:

The resulting scale =
Assigned scale 

Scale of original page

Thus, the scale of original page is considered in the movement result. This allows you to obtain correct

image of detail view when scaling is used on the original page.

Consider page scales. This flag can be used for the drawing views created with the option , when scale

of the original page and view page differ from 1:1 and do not match. When this flag is enabled the

resulting view scale will take into account the scale of both pages:

Resulting scale =
Assigned scale* Scale of drawing view page

Scale of original page

Setting this parameter allows you to achieve the correct correspondence of element sizes between the

original drawing page and drawing view.

Specifics of Detail Views

The image created by the  and  options may need modifications or additions, for example,

add chamfers, rounds, clipping line, or place dimensions). One shall keep in mind that these options

create graphics based on the "Copy with translation" functionality, therefore, it is subject to all rules

and limitations imposed on direct use of this command. Thus, only graphic lines, hatches, 2D

fragments and projections are copied. The snapping nodes of the copied lines can't be modified. The

copied elements can only be deleted, hidden by the command "Hide/Show Elements", or their

parameters modified (for example, lower the level). Besides, these can be used for snapping the

construction lines (see the chapter "Lines") for new element creation. Therefore, if editing a view

involves modifying existing graphic lines, two ways of handling are possible:

1. Break association of the copies with the original elements using the command "Explode Copy" of

the context menu. As associations are broken, free nodes are created, thus turning the graphics on the

view into a sketch suitable for modifications. One should keep in mind that further modifications of

the original elements of the drawing will not propagate on the drawing view graphics, thus breaking

its parametric behavior.

2. Create new graphic lines based on the copies. To do this, first create construction entities snapped

to the copy entities. Then, hide the entities of the copy if necessary. Instead of the hidden lines, create

new ones by snapping to the newly created construction entities. 
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Parameters of Drawing View

Contextual Menu of Drawing View

In addition to commands standard for all T-FLEX CAD elements, the contextual menu of drawing view

contains following specific commands:

 Activate Drawing View

Upon calling the command, all elements on the current page, except for the elements of the drawing
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view, are grayed out. The boundaries of the drawing view and the drawing view page become

highlighted.  Any 2D objects created on a drawing in this mode will belong to the active view.

Activate in new window

This mode differs from the previous in that a new window is opened for editing that contains the

graphics of the selected drawing view.

The detailed information on views activation is available in the Activate Drawing View or 2D

Projection section.

View Page Parameters

Brings on the screen the dialog box of the Document Parameters command for a page of a selected

drawing view.

 Edit Breaks

The detailed information on this command is available in the Breaks of 2D Projections and Drawing

Views section.

 Explode Drawing View

As a result of exploding, the drawing view is deleted, while all its content (nodes, graphic lines, etc.)

are transferred directly to the drawing page. If the drawing view image contains dimensions, then

after exploding the view, the scale of the dimensions is modified in such a way that dimension’s value

remains unchanged. The system asks the question when exploding a view: "Unite in group objects

resulted from drawing view exploding?". Depending on the answer, objects are either grouped or

transferred individually. Name of the group corresponds to the name of exploded view. A second

question is also asked on whether to delete view's page or not. When exploding the drawing view,

whose contents is clipped by hatch (for example, when the drawing view was created as Detailed

Drawing View with Caption), the following rules apply: 

· lines clipped by hatch (for example, lines of associate copy) are replaced by standard

graphic lines shortened according to the clippings on the view;

· fragments clipped by hatch are copied into the resulting set of elements together with the

clipping hatch;

· hatches, clipped on the original view, disappear after exploding the view.

 Update Drawing View

Updates only the selected view in a similar way as the Update command for other types of elements.

Automatically Update View Border

This checkbox gets enabled automatically, upon creating a view, if you don't use the view size

manipulators (blue frame). 

· For detail views:

If the checkbox is enabled, then the view boundaries (non-printable dashed frame) are

automatically re-sized upon update depending on changes in view content size. Size of view

content may change due to modifying the view contour or scale. If the checkbox is disabled,

Then the boundaries size doesn't change, regardless of content size.

· For generic drawing views:

If the checkbox is enabled, then the view boundaries coincide with the paper size specified in

view page parameters.
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In order to re-size view boundaries manually,  Edit the view and use the view size manipulators.

This action disables the checkbox of automatic update. If the checkbox is disabled, then the view

boundaries keep the configuration defined via manipulators.

Keep in mind, that using view size manipulators during creation of a view changes the paper

size, while using such manipulators during  editing  doesn't affect the paper size.

Apply Breaks in Active View

The detailed information on this option is available in the Breaks of 2D Projections and Drawing Views

section.

Following options are additionally available for detailed views:

· Synchronize Page Parameters

When this checkbox is enabled (by default), parameters of view's page are synchronized with

parameters of document's page, which contains this view. So changing view's page parameters

changes document's page parameters and vice versa. On the first synchronization parameters

of document's page are applied to view's page.

· Automatically Update Position of View Designation

If this checkbox is enabled, then the view designation gets automatically placed above the

center of the view content. If this checkbox is disabled, then the view designation keeps its

position in the local coordinate system of the view. The checkbox is enabled by default, but it

gets automatically disabled upon manual repositioning of the view designation.

·  Crop View

Outline can be edited in the same way as when creating a view.

Activate Drawing View or 2D Projection

Activate a view

The command can be called in one of the following ways:

Icon Ribbon

Draw > Draw > Activate...

Sheet Metal > Draw > Activate...

Keyboard Textual Menu

Calling the command invokes the dialog, where you can see the list of all drawing views (including

details with caption and 2D projections of 3D model) belonging to the current drawing page. Select

the desired view in the list and click OK. The selected view will be activated.
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There alternative ways of activating a drawing view. Move the mouse cursor over a drawing view, so

that view boundaries and view content are highlighted in light magenta. When doing so for details or

2D projections, avoid moving the cursor over view content (including the hidden part of detail

outline). Next, either double-click  (the view gets activated immediately), or single click  to

invoke the contextual menu and then select the  Activate (the view gets activated in the current

document window) or  Activate in New Window command in said menu (the view gets activated

in new document window).

Deactivate a view

An active view can be deactivated in one of the following ways:

· Double click  outside view boundaries; 

· Single click  anywhere within the 2D window to invoke the contextual menu and then

select the  Close command in said menu.

· Call the  Activate... command from the ribbon.

When calling the  Activate... command within an active view, the dialog appears, similar to

the list of view. However this time the list only contains a single item - <Main View>. Select

this item and click OK. The view will be deactivated.
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Nested views

Detail views by elements and by contour are nested within a parent view. Moreover, creating a basic

drawing view, while another view is active, makes the new view nested within the active one. If the

parent view is inactive, then boundaries of its nested views are not displayed, and an attempt to select

particular elements belonging to nested views selects the parent view. In order to select a nested view,

you have to activate its parent view first. Upon activating the parent view, its nested views can be

activated using the same methods as for activating non-nested views. If the parent view is inactive,

then the list of views invoked by the  Activate... command doesn't contain its nested views. If the

active view contains nested views, then such views are displayed within the list of views invoked by the

 Activate... command in addition to the <Main View> item. Deactivating a nested view using any

of the aforementioned methods activates its parent view. In order to deactivate views of all nesting

levels at once, click  anywhere within the 2D window to invoke the contextual menu and select the

 Close All Drawing Views command in said menu.
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Working with active view

When a view is active, its boundaries are highlighted in light magenta and all drawing elements not

belonging to the active view are displayed in dull colors. Any 2D elements created in a drawing within

this mode belong to the active view.

Edit Drawing View

Editing of a drawing view is done by the command "Edit Drawing View". The command is called as:

Icon Ribbon

Keyboard Textual Menu

<ESD> Edit > Draw > Drawing View

Upon calling the command, an option appears:

<R> Select All Elements

<*> Select element from list

<Esc> Exit command

Once all drawing views are selected by the option , they are highlighted, and additional options

appear in the automenu:

<Del> Delete selected Element(s)

<Esc> Exit command

Upon selecting a particular drawing view by clicking it , another option appears in the automenu:
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<P> Set entity parameters

Fixing point of view

<I> Select Other Element

<B> Add or edit breaks

The option  allows the user to modify the fixing point of the drawing view being edited.

The option  brings up the "Drawing View Parameters" dialog box: 

Page. Displays the name of the auxiliary page corresponding to the selected drawing view. 

The parameter "Scale" defines the scale factor of this page. 

Clip Image, Scale Lines, Drawing Scale, Rotation Angle. These parameters affect the display of the

drawing view area on the original page. 

Layer, level, Priority. Define the values of the respective system-wide parameters. 

The selected view is highlighted as a box with markers along the perimeter. The markers control

position, rotation angle, scale, view size and the position of the fixing vector or fixing node.

Working with the markers is carried out in the same way as when creating the drawing view (or the

drawing view of the element).

The following option completes drawing view editing:

<Esc> Finish Page View editing

The  option enables the mode of creating/editing breaks on the view.

The command of editing the breaks of the drawing view can also be invoked without the use of the

menu it is possible to specify if the diagram of breaks must be shown on the page (“Show”), and also

to select the drawing view whose breaks have to be shown and edited (if there are several views

displaying the given page).

Managing Elements of Drawing View

Following Breaks and Clipping Contour options are available in the contextual menu of active

drawing view's elements:

· Don't draw

This option works in the same way as described for 2D projection elements.

· Don't clip

This option works in the same way as described for 2D projection elements.
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· Don't consider when calculating break lines

This option's usage is described below.

Don't consider when calculating break lines

Click  on active drawing view's element:

Select Breaks and Clipping Contour > Projection_# > Don't consider when calculating break lines in

the appeared contextual menu:

Break line doesn't reach the selected element anymore:
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Dimension

T-FLEX CAD supports all types of dimensions, recommended by the standards ISO, ANSI and

AR_ANSI. 

T-FLEX CAD dimensions are tied to straight construction and graphic lines and nodes, except for the

radius and diameter dimensions, whose position is defined by the circle they dimension.

Applying dimensions

To apply a dimension, use the command "Create dimension":

Icon Ribbon

3D Model > Additional > Dimension

Draw > Appearance > Dimension

Assembly > Additional > Dimension

Measure > Measure > Dimension

Analysis > Additional > Dimension

Sheet Metal > Additional > Dimension

Surfaces > Additional > Dimension

Weld > Additional > Dimension

Routing > Additional > Dimension

Primitives > Additional > Dimension

Support Geometry > Additional > Dimension

Workplane > Appearance > Dimension

Keyboard Textual Menu

<D> Draw > Dimension

The user then gets access to the following options:

<P> Set Dimension parameters
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<Alt+P> Copy Properties from Existing Element

<N> Select Node 

<L> Select Line 

<C> Select Circle 

<Y> Create radial Dimension with stepped line

<A> Create Arc dimensions

<Q> Create Dimensions by one Image Line

<F> Angular Dimensions by Four Nodes

<T> Linear Dimensions by Three Nodes

<O> Set Cone Dimension

<B> Create Dimensions from one baseline

<Ctrl+B> Create Dimension Chain

<S> Create ordinate dimension

<E> Leader Dimension

<X> Dimensions from Axis

<Ctrl+C> Dimension between two circles

<F4> Edit Dimension

<Esc> Exit command

Upon calling the dimension creation command, one can click  near any construction or graphic

line. The line will be highlighted. Alternatively, point the mouse at a line and type <L>. In addition,

one can select a node (the key <N>) or a circle (the key <C>). 

Depending on what was selected at this step, different options are provided for further construction.

Linear dimensions: 

· Between two parallel lines or between a straight line and a node

· Between two nodes

· by three nodes

· Arc Length Dimension

· from one baseline

· Dimension chains

· Ordinate dimensions (Level Markers)

· Dimensioning a Circle
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· between two circles

· between the Line and It's Equidistant Curve

Angular dimensions: 

· The angular size for the four nodes

Dimension of graphic lines: 

· by Graphiс Line or Arc

· by cone

· Leader Dimension

· from axis

Control dimensions

· Control dimensions when working with restrictions

Dimensions may also be created in 3D scene (see the 3D Annotations section).

When creating dimensions of any type there are several options that define general principles of

command's operation.

«Alternative dimension» section

Special about defining parameters for dimensions on circles

The "Style" allows manipulating the display of the little cross at the center of the circle being

dimensioned, (the parameter "Cross in center"). This is required by some standards. Otherwise, the

parameters for circles correspond with the parameters for linear dimensions.

When you create dimension on the circle the Arc Symbol option appears. 

Special about defining parameters of orditate dimensions

Ordinate dimension parameters are mainly same as those of linear dimensions. Described below are

the existing differences.

The ordinate dimensions do not have the parameters to define tolerances and deviation limits.

In the Style section there are only the parameters, whose status is relevant to an ordinate dimension.

Besides, there are the following additional parameters:

Leader Line. Controls the leader extension creation between the dimension and the attachment node.

Show “plus”. Controls the display of the “+” sign in dimensions with positive offset from the base

dimension.
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Just as for angular dimensions, there is no alternative scale for ordinate dimensions, nor any other

parameters related to an alternative dimension.

Working with the dimension parameters dialog

You can also define dimension parameters in the parameters dialog called by the automenu option:

<P> Set Dimension Parameters

The parameters located on the tabs of this dialog duplicate the parameters in the properties window.

Besides that, the parameters dialog has a number of additional settings. First of all, that's the system-

wise parameters: level, layer, priority and color. The parameters dialog also has an additional tab that

contains the font settings. This tab is standard for various system elements (dimensions, annotation

leaders, roughness symbols, GD&T formlimits). It allows defining all necessary font settings used to

display the dimension value string. If the value of some of the parameters on the tab is set as

"Default", then it will be taken from the "Font" tab of the Set Document Parameters command dialog.

Parameters for new dimensions (default parameters)

The default parameters that will be applied to all newly created dimensions can be defined in a

number of ways.

First of all, those can be defined within the parameters dialog (the option ). To do this, call the dialog

before creating a dimension. The parameters defined for the new dimensions will be copied to the

parameters set of each created dimension.

You can also save the parameters defined when creating (or editing) a dimension, as the default

parameters, by clicking the button  in the command's properties window.

Note, that the tab "Dimensions" of the command Set Document Parameters defines only those of the

described parameters, that have the default option. As a rule, all dimensions should appear

consistently. Therefore, a good strategy is defining their appearance in the command Set Document

Parameters, while using the default settings for the parameters of a particular dimension. This allows

instantly changing appearance of all dimensions, if necessary.

Besides the described parameters, the command Set Document Parameters defines two more

parameters. "Tolerance Grade" defines the threshold precision, up to which the dimension values

are displayed on the drawing. This means, for dimensions, whose tolerance grade is less or equal

to the specified, only the nominal values will be displayed.

The "Symbols" provides for defining codes of the selected special font, corresponding to the symbols

diameter, degree, and "±" sign. This can be helpful when exporting files, and when using fonts that use

different codes for these symbols.

Copying parameters from existing dimensions 

Parameters of the dimension being created can be quickly copied from an already existing dimension.

To do this, use the option:

<Alt+P> Copy Properties from Existing Element

This option is available in the command automenu prior to creating the dimension or during the

creation process (before selecting the dimension placement on the drawing).

After calling the option, simply pick the dimension whose parameters are to be transferred on the new

dimension. The parameters will be copied that are common for both the selected dimension and the

dimension being created.

To make the copied parameter values assigned to all newly created dimensions, before selecting the

source dimension activate an additional option:
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<S> Set Properties as Default

With the option active, the copied parameters will be saved as default parameters.

This option simplifies creation of dimensions with identical parameters. However, it does not

allow to copy specific parameters or parameters from an object of a different type. In such

cases, more convenient could be using the general mechanism of editing element parameters in

the property window.

Setting link of dimension with another dimension

For any type of dimension you create, it is possible to link it with the other already existing dimension

by means of the following automenu option:

<Shift+D> Select linked dimension

After calling this option, you must specify the dimension which parameters will be used for the

dimension being created.

When setting such link, parameters of "linked" dimension, for example, the nominal value, other

display options, will be taken from the original dimension. List of "linked" parameters can be

controlled in the properties dialog by selecting corresponding values for the nominal mode - “Auto”,

“Manually”, “Manually+Corrections”, “From selected dimension”. If you do not want to display the

content of "Before", "After" and "Under" strings of the linked dimension, it is necessary to remove the

flag to "Project string ...". The flag appears when you put the mouse cursor over a field of the

corresponding parameter.

To break the link between the dimensions you can use option:

<Shift+K> Break link with dimension

Option is available only for the linked dimensions.

This functionality can be used, for example, to display dimensions on a simplified view with the same

nominal values and other parameters as on the original accurate view.
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Dimensions Alignment

The options group Dimensions Alignment is available in the context menu when you select several

dimensions. The options allow associating the selected dimensions to move them together on the

drawing. 

The Group option creates group of dimensions. When you move one of the dimensions, the rest

dimensions also move, maintaining its position, retaining their original position relative to each other.

The Delete Alignment option appears for grouped dimensions. The option cancels the alignment of

all dimensions in the group.

The In Line option aligns all dimensions in one line. The option allows you to quickly build a chain of

dimensions.

The Adjust with offset option allows you to align the dimensions vertically in accordance with the

specified spacing.

The spacing between dimensions is specified in the Set Document Parameters on the Dimensions tab

using Alignment spacing parameter. The parameter specifies the spacing for newly created groups of

dimensions and does not affect spaces of the already created groups.

When you create a new dimension above or under another dimension, a snap in accordance with

a predetermined alignment spacing is active. 

The following options are available in the context menu for each of the dimensions in the group:

The same options are in the automenu of the Edit command for the dimension.

Move with others. The selected dimension is moved with the other dimensions in the group. The

option is enabled by default.



Drawing Creation

637

Move relative to others. After activation of this option, the selected dimension can be moved relative

to other dimensions in the group. After that, the dimension will move with other dimensions again, but

the new position will be preserved.

Exclude from alignment. The selected dimension is excluded from the alignment.

Change Direction. Changes the position of the dimensions relative to the selected dimension. If the

remaining dimensions in the group are located above the selected dimension, then they will be

located below after activation of the option and vice versa.

Working with dimensions in the 3D window

When using the 3D version of the system, you can create dimensions, just as well as leader notes and

roughness symbols, in the 3D window, on the faces of the 3D model. This allows you to create fully

functional three-dimensional drawings.

The parameters of such dimensions are automatically passed to the dimensions created in the 2D

window on the respective lines of a 2D projection of a given model. 

3D dimensions can serve as driving ("control") dimensions for 3D operations or construction elements.

That means, when a dimension's nominal value is modified, the respective parameters of the

operation or 3D construction element adjust to the change automatically.

You can also use the dimensions corresponding to the driving ones that are created on 2D projections,

in order to modify the values of operation parameters. The system will match such pairs of dimensions

automatically.

By default, parts of 3D dimensions as well as other 3D annotation elements hidden behind non-

transparent elements of a 3D model are not displayed. If necessary, you can enable the Display

annotations over 3D model option (Options > 3D > 3D).
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The detailed description of creating 3D dimensions and dimensions on projections is provided

in the chapters "3D Annotations" and "2D Projections. Creating Drawings from 3D Models".

Topics in this section:

· Dimension Between Two Straight Lines or Between Line and Node

· Dimension Between Two Nodes

· Linear Dimension by Three Nodes

· Creating Arc Length Dimension

· Creating Dimension Chain

· Creating Dimensions from One Baseline

· Creating Ordinate Dimensions (Level Markers)

· Dimensioning a Circle

· Dimension Between Circles and Object

· Dimension between the Line and It's Equidistant Curve

· Angular Dimension by Four Nodes

· Dimension by Graphic Line or Arc

· Creating Dimension by Cone

· Drawing Leader Dimension

· Creating Dimensions from Axis

· Options of Creating Dimensions

· Dimension Parameters

· Edit Dimensions

Dimension Between Two Straight Lines or Between Line and Node

If the first selected element was a line, proceed with defining the second dimension reference

element. To construct a linear dimension, the second element can be another line parallel to the first

one, or a node. To construct an angular dimension, select another line positioned at an angle to the

first line. 

Upon drawing dimension between two lines, the system itself finds the nearest nodes lying on these

lines and ties the origins of the extension lines to them. While doing it, however, there is always a

possibility to reassign the nodes to which the dimension will be tied.

The following set of icons will be available in the automenu:
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<L> Select Line

<N> Select Node

<Esc> Cancel selection

Obviously, the second dimension reference element can be selected using the common T-FLEX

technique. One can click  or type <L>, while pointing the mouse at a construction line. One can

select a node using the option . This creates a dimension between the line and the node.

Once the second dimension reference element was selected, regardless of the selection technique, a

dimension will start rubberbanding on the screen following the pointer movement. The start point and

the end point of the dimension line will be marked by numbers: “1” – the start point of the dimension

line, “2” – the end point of the dimension line.

You may use special floating toolbar with options - icons and markers that allow changing dimension

position, arrows style and dimension text.

You can enter text Before, After and Under on the toolbars that appear after clicking on one of the 

icons. Drop-down lists  includes standard texts Before, After and Under. Context menu appears,

when you press right mouse button in the text field.

You can apply Before and After text insertion by pressing <Enter>. You can cancel text insertion using

<Esc>.

You can select sign for the dimension value from the drop-down list after clicking  icon.
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You can set parameters for the  arrows in the special toolbar that appears after clicking  icon under

the arrow.

Option  allows to clear background. Option  enables/disables the same arrows for the

dimension.

You can move toolbars. Place cursor on  icon and move cursor, holding  button. 

Dynamic toolbar with Place leader , Center dimension text , Dimension with jog 

options appears under the dimension, when you place cursor on it.

To specify dimension location and to align it according to another dimension you can use the special

control marker.

If dimension is on a jog, you can specify the jog length using special control marker.
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Options Hide jog  and Remove jog  are available for the dimension with jog.

Option Remove leader  is available for dimension on leader.

The new options that appear in the automenu, hint of further possible actions. This relates to either the

linear or the angular dimension (in the case when the two selected lines intersect).

The available options after specifying the dimension references are:

<P> Set Dimension parameters

<Alt+P> Copy Properties from Existing Element

<Shift+D> Select Linked Dimension

<Z> Change leader line jog orientation

<Z> Change Dimension Orientation (for angular dimension)

<Spacebar> Place Dimension in absolute coordinates

<T> Tie Dimension to Node

<J> Center Dimension Text

<D> Change Sign

<M> Change Dimension Type

<K> Break relations (available if dimension is tied to the node)

<Esc> Cancel selection

After selecting two lines to be dimensioned, one can click , while pointing the mouse at the

necessary position of the dimension. Before clicking, one can define parameters of the given

dimension by calling the option , as well as specify position of strokes of the dimension entity.

This can be done primarily with the options <Spacebar> and <T>. Presented below are several

examples of dimensions that can be created between two lines or a line and a node. Parameter

definition is described below, after the description of other dimension types.
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Let’s review the process of tying the dimension witness lines using the options  <Spacebar> and

 <T>. This process is optional and necessary only when the dimension entity strokes must be

strictly tied to the construction elements in the drawing.

Example of option Tie Dimension to Node  usage:

Let's create a dimension by two lines and press <T> once. The dimension will be fixed in the position

next to the node. After that we move cursor up and create a leader line extension. 

The Center Dimension Text  option should be disabled.

If we press <T> one more time, the leader will be tied to the nearest node.

Example of option Place Dimension in absolute coordinates  usage:

When you type <Spacebar> for the first time the dimension will be fixed at the specified distance

from the object. If you move cursor up, create a leader line extension and press <Spacebar> again, a

leader jog will be created.

If the Center Dimension Text  option is enabled, the second spacebar pressing will create a

leader line extension.
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The third subsequent use of the option <Spacebar> causes creation of the leader jog attached to the

center of the leader line.

The fourth subsequent use of <Spacebar> will switch dimension into “invisible leader” mode. There

will be no leader lines but text will remain and will behave like if it is located on a leader. This mode

allows locating text in arbitrary place.

The fifth subsequent use of <Spacebar> reverts the dimension to the original state.

Note, that use of options <Spacebar> and <T> is recommended, when you want to strictly define the

dimension position through parametric modifications of the drawing. When modifying positions of

the nodes to which the dimension strokes are tied, the dimension position will be changing

accordingly. 

To break a tie to a node, use the option . If you click on the marker that indicates node to which

the dimension is tied, the relation will be broken automatically and the option will not appear.

The option  allows explicitly assigning the tying nodes for dimension strokes created on the

construction lines (by default, the system selects the node on the selected line nearest to the

dimension position). Suppose, the lower witness line in the first drawing is tied to the default node.

Let's specify another tying node using the option <N>. The modified dimension is shown on the right

hand side diagram.
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With the option  turned on, the dimension text will be centered between the witness lines.

Without the option, the dimension text is positioned wherever the mouse click occurred.

The option  allows quickly changing the dimension prefix symbol ("R", "Ж", "M", "•", "o"), without

calling the dimension parameters dialog box.

When creating a dimension with a jog, the option  (<Z>) will help changing the shape and

position of the jog.  

Pressing  (<Z>) results in a change of a quarter in which the dimension is drawn. In this case, the

mouse should be pointing to the quarter where the dimension should be placed.

Dimension Between Two Nodes

Creating a dimension between two nodes is mostly similar to creating a dimension between two lines.

The exception is multiple possibilities for the witness line positions. These possibilities are shown on

the diagram below.  

To select nodes, use the option:
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<N> Select Node

If two nodes to be dimensioned are connected by a graphic line, the option  is used. Upon calling

the option, select the necessary segment, and its end nodes will be automatically selected for

dimension creation.

  

To toggle through the various types of dimensions between two nodes, the option <M> is provided in

the automenu:

<M> Change Dimension Type

This option toggles the various dimension types. Besides, the necessary dimension type can be

selected from the pull-down list. The parameters of the dimension being created can be defined using

the option:

<P> Set Dimension parameters

Linear Dimension by Three Nodes

Linear dimension by three nodes represents itself a variation of the linear dimension between a line (a

segment) and a point. This means that the dimension will be drawn between the line defined by first

two nodes (end points of the segment of the line) and the third node selected.

For drawing dimension by three points, the following option is used:

<T> Linear Dimension by Three Nodes

After choosing this option in the automenu, the option for picking the nodes appears:
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<N> Select Node

Tooltips in the status bar indicate the node selection order. After specifying all nodes, it is necessary to

indicate the location of the dimension being created with the help of . While doing it, the

following options are available in the automenu:

<Alt+P> Copy Properties from Existing Element

<Shift+D> Select Linked Dimension

<D> Change Sign

<Spacebar> Place Dimension in absolute coordinates

<T> Tie Dimension to Node

<Z> Change leader line jog orientation

<J> Center Dimension Text

<K> Break relations (available if dimension is tied to the node)

<Esc> Cancel selection

The use of these options was described above in the section “Dimensions Between Two Straight Lines

or Between a Line and a Node”.

Creating Arc Length Dimension

To dimension the length of a circular arc, use the option . The following items become available

in the automenu after selecting the option:

<N> Select Node

<Esc> Cancel selection

Dimensioning a whole arc starts with selecting an appropriate graphic entity. 

In the case of dimensioning a portion of an arc or circle between two nodes, subsequently do the

following:

1. Select the start node of the arc being dimensioned.

2. Select the end node of the arc being dimensioned. 

3. Select the arc or circle passing through these nodes. An additional option is provided in the

automenu:

<С> Select Circle

After selecting the arc by any means, the automenu provides the options:
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<P> Set Dimension parameters

<Alt+P> Copy Properties from Existing Element

<Shift+D> Select Linked Dimension

<Z> Change leader line jog orientation

<Spacebar> Place Dimension in the absolute coordinates

<J> Center Dimension Text

<T> Tie Dimension to Node

<K>
Break relations

(available if dimension is tied to the node)

<H> Radial Dimension Lines

<H> Parallel Dimension Lines

<Esc> Cancel selection

As in the case of creating a dimension between two lines, the option <Spacebar> allows specifying

the positions of dimension strokes. The option  is used for tying the dimension to a node, while

the option  - for breaking the tie. To set parameters of the dimension being created, use the

option . 

The option  allows flipping the orientation of the dimension leader line jog.

With the option  turned on, the dimension text will be centered between the witness lines. With

the centering off, the dimension text is position wherever the mouse click occurred.

Additionally, one can choose between the types of the dimension witness lines (parallel or radial) by

using the options  / . To complete a dimension creation, click its position by . If the

dimension is already tied to a node, clicking  simply confirms its creation.
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Creating Dimension Chain

The option  allows creating dimension chains for a group of parallel lines, as well as appending

dimensions to already existing chains. Upon selecting the option, the following icons become

available in the automenu:

<D> Select Dimensions in Chain

 <L> Select Line

<N> Select Node

<Bkspace> Cancel last element selection

<Esc> Cancel selection

To create a new dimension chain, select subsequently the construction lines, the graphic lines or the

nodes to be dimensioned. Complete the entity sequence selection by pushing the option:

<E> End Dimension Chain input

After that, the following options will appear in the automenu:

<P> Set Dimension parameters

<Alt+P> Copy Properties from Existing Element

<T> Tie Dimension to Node

<K> Break relations (available if dimension is tied to the node)

<Esc> Cancel selection

The option  help tying dimension position to a node, while the option  breaks this tie. To

define parameters of a dimension being created, use the option .

To complete a dimension chain creation, specify its position by clicking . If the chain was tied to a

node, then clicking  simply confirms the creation. Note that each dimension in the chain

referencing a pair of lines, is a separate entity and can have its own parameters.    
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To add more dimensions to an existing chain of dimensions, upon calling the option  select one

of the dimensions in the chain to be appended. By doing so, you define the base for the dimensions to

be created. The further steps will be similar to the previous case. The chains can have gaps. Should this

be the case, select a line or node as the first entity of the chain continuation that is not referenced by

the last existing dimension in the chain.

Creating Dimensions from One Baseline

The option  serves for creating dimensions from one base. The creation procedure for this dimension

type is mostly similar to the previous case (creating a chain of dimensions from the common base),

except the number of additional features.

               

The following items are available in the automenu after selection of lines and nodes for the dimension

creation and pressing :

<P> Set Dimension’s Parameters

<Alt+P> Copy Properties from Existing Element

<Z> Hide Axis Origin

<S> Sign of Dimensions’ Orientation

<Space> Location Autocorrection Mode

<M> Change Dimension’s Type

<L> Value next to Leader

<L> Value on Leader

<L> Value on Leader inside Lines

<T> Tie Dimension to Node

<K> Break relations (available if dimension is tied to the node)

<Esc> Cancel Selection

The  option allows us to display/hide zero tick mark for given dimension chain. When option 

is enabled, dimensions are drawn with the negative values of their values. This option works only

dimensions that were created from top to bottom or from right to left.

Option / /  is toggled cyclically and allows to choose variant of placement for

dimensional size: nominal near jog/nominal at jog/nominal at jog inside lines.

Dimensions from one base can be of two types:  normal and ordinate. The dimension type can be

modified either at the time of creation or at editing. This is done by the option:



T-FLEX CAD 17 Help

650

<М> Change Dimension type

In the case of ordinate dimensions, only the witness lines are drawn, while the leader lines are not.

Normal dimension Ordinate dimension

<Space> Location Autocorrection Mode

This option helps avoiding overlapping text of the dimensions from one base when those are placed

near to each other. A jog is introduced in the dimensions that "creep" on the predecessors.

Autocorrection is off   Autocorrection is on

Creating Ordinate Dimensions (Level Markers)

To create a construction dimension, use the option . Upon calling the option, the following icons

become available in the automenu:

<D> Select ordinate dimension

<L> Select Line

<N> Select Node

<Esc> Cancel selection

Creating a series of dimensions from the same base starts with selecting the base ("zero") dimension.

To do this, upon calling the option  simply select a horizontal construction or graphic line, or a node.

As a result, a dimension starts rubberbanding on the screen, following the pointer. 
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Meanwhile, the following options become available in the automenu:

<P> Set Dimension parameters

<Alt+P> Copy Properties from Existing Element

<Shift+D> Select Linked Dimension

<Z> Change leader line jog orientation

<T> Tie Dimension to Node

<K>
Break relations

(available if dimension is tied to the node)

<Esc> Cancel selection

As in the case of a normal dimension creation, the option  flips the orientation of the dimension

leader jog. The option  allows defining the positions of the dimension strokes by tying them to

drawing nodes. In the letter case, use of the option <T> for the first time defines horizontal

positioning, that is, the position of the vertical stroke of the dimension jog. The second use of the

option <T> defines the dimension height, that is, the level of the horizontal stroke of the jog. To undo

a tie, use the option . The dimension creation can be completed by pointing the mouse at the

necessary position and clicking .

The thus created dimension becomes the base dimension. Meanwhile, the option of creating ordinate

dimensions stays active, with the automenu providing the options for a line  and node 

selection. By selecting next horizontal line or node, you begin creation of another dimension relative

to the base. It's creation steps are same as the described above. To complete creation of a series of

base dimensions, return from the option  into the main command menu. On a subsequent call for the

option, selecting a horizontal line or a node will create a new base, with the subsequently created

dimensions referencing the new base.
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To create dimensions relative to an existing base, upon calling the option, select the necessary base

dimension, or a dimension referencing the base. All dimensions created thereafter will be referencing

that base.

Dimensioning a Circle

When dimensioning a circle, there is only one reference, which is the circle being dimension.  After

calling the command "Create dimension", point the mouse at the necessary circle and click  or

<C>. The circle will be highlighted, and a radius or diameter dimension will start rubberbanding with

the pointer. 

The following set of options will become available in the automenu:
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<P> Set Dimension parameters

<Alt+P> Copy Properties from Existing Element

<Shift+D> Select Linked Dimension

<Z> Change leader line jog orientation

<Spacebar> Place Dimension in absolute coordinates

<T> Tie Dimension to Node

<D> Change Dimension Symbol

<M> Dimensional Dimension

<M> Radial Dimension

<Esc> Cancel selection

The type of the dimension being created is chosen in the drop-down list of the option Change

Dimension Symbol. The following types are available , , , , . 

The type of the dimension may be selected from the drop-down list  Change Dimension Type

, , . The list differ for the radial dimension  and includes the following options: ,

, .

Once the necessary settings are defined, the created dimension will appear on the drawing. Follows

are some types of dimensions on a circle supported by the system.

Creating radial dimension with jog on leader line

For circles of a large radius, a radial dimension can be created with a jog on the leader line. To do this,

use the option  of the command top-level automenu. Upon calling the option, select the circle to be

dimensioned. As a result, the select a circle will be highlighted and a dimension will start

rubberbanding following the pointer. As the pointer moves, the end of the leader line and the whole

dimension position will be adjusting accordingly. Meanwhile, the following options are available in

the automenu:
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<P> Set Dimension parameters

<Alt+P> Copy Properties from Existing Element

<Shift+D> Select Linked Dimension

<K> Break relations (available if dimension is tied to the node)

<Esc> Cancel selection 

To create the dimension, move the pointer to position the dimension as necessary, and click . In

this case, the default size and position of the dimension jog are set.

If necessary, the size and position of dimension components can be arbitrarily modified, including

tying nodes. 

Use special markers for this purpose. Upon selecting the circle, a fixation marker appears. You need to

select a node to which the dimension will be tied.

After the dimension position selection, you may change the dimension leader jog position. Select the

special marker on the dimension leader jog, press  and move the cursor. The dimension leader jog will

follow the cursor along the dimension line.

The additional option  turns on the mode of continuous radius dimension creation at a common fixing

point. This mode can be used for creating radius dimensions, originating at the same point, on several

concentric circles. With the option on, upon completing one dimension creation (the one on the first

circle), the system waits for dimensioning another circle.

If the fixing point of the first circle dimension was tied to a 2D node, then the dimensions on all

following circles are tied to this node automatically. However, if the first dimension was fixed

arbitrarily, then a free node is created at that point, with all the rest of the dimensions tied to it.

Dimension Between Circles and Object

The  command enables users to display linear dimensions at the drawing between a circle and

another object: a segment, a node, a point on the line, another circle.

After calling the command, select the circle and one of the objects given above or in the reverse

order: the sequence of selection only influences the numbering of dimension sides.

The following options are available in automenu:

<P> Set Dimension parameters

<Alt+P> Copy Properties from Existing Element

<Shift+D> Select Linked Dimension

<Z> Change leader line jog orientation

<Space> Place Dimension in absolute coordinates

<J> Center Dimension Text
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<D> Change Sign (change prefix)

<T> Tie Dimension to Node

<Esc> Cancel selection

There are three dimension types for non-coaxial circles dimensions:

·  The distance from the center of the circle

·  The distance from the nearest point of the circle (circles)

·  The distance from the farthest point of the circle (circles)

Use  option to change the dimension types.

The radii difference is measured for coaxial circles. To control the dimension position you can use a

special marker at a bigger circle.

Dimension between the Line and It's Equidistant Curve

You can display the distance between the equidistant curve and the initial line for the displacement

line. To do it, select the initial and displacement lines in the dimension command without selecting

special options.

A special marker enables you to move the dimension to the necessary position along the curves.
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Angular Dimension by Four Nodes

Placing a dimension by four nodes represents itself basically a variation of the angular dimension

between two segments (lines). The lines between which the dimension will be drawn are defined by

the end nodes.

For drawing the dimension by four nodes the following option is used:

<F> Angular Dimensions by 4 Points

After choosing this option in the automenu, the option for selecting the nodes appears:

<N> Select Node

Tooltips in the status bar show the order in which nodes are selected. The dimension will be tied to

the first nodes of both lines.

After specifying all nodes, it is necessary to indicate location of the created dimension with the help of

. While doing it, the following options will be available in the automenu:

<P> Set dimension Parameters

<Alt+P> Copy Properties from Existing Element

<Z> Change leader line jog orientation

<Shift+D> Select Linked Dimension

<Spacebar> Place Dimension in absolute coordinates

<T> Tie Dimension to Node

<J> Center Dimension Text

<K>
Break relations

(available if dimension is tied to the node)

<Esc> Cancel selection

The use of these options has been described above.

Dimension by Graphiс Line or Arc

To dimension a single graphic entity (a line segment or an arc), you do not have to call the option
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 or . You can simply select a line segment or an arc by clicking . Then, while still holding

down the left mouse button, slightly move the pointer. The command will then automatically assume

the mode of creating a line segment length or an arc dimension.

Creating Dimension by Cone

A dimension by cone  is created based on two non-parallel graphic lines. The selected lines are

considered silhouette edges of a cone (cone projection). In this case, the dimension measures the

distance between the ends of the selected lines, in the direction orthogonal to the cone axis. Thus, one

can dimension a cone base on a projection view without creating additional nodes at the line ends.

To create a dimension by cone, use the option . After selecting the option, the following items are

available in the automenu:

<L> Select line

<Esc> Cancel selection

The dimension creation starts with subsequent selection of two non-parallel graphic lines.  Once the

lines are selected, the following options appear in the automenu:

<P> Set Dimension parameters

<Alt+P> Copy Properties from Existing Element

<Shift+D> Select Linked Dimension

<Z> Change leader line jog orientation

<Spacebar> Place Dimension in the absolute coordinates

<J> Center Dimension Text

<D> Change Dimension Sign

<M> Change Dimension type

<T> Tie Dimension to Node

<K>
Break relations

(available if dimension is tied to the node)

<Esc> Cancel selection

Line ends selection for attaching a dimension is done automatically by the system. However, if

necessary, this can be modified using the option <M> ( ) that helps quickly toggle through all

possible pairs of line ends.
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As in the case of creating a dimension between two lines, the option <Spacebar> allows specifying

the positions of strokes of a dimension. The option  is used for tying a dimension to a node, while

the option  – for breaking such a tie. The option  serves for specifying dimension parameters. 

The option  allows flipping the dimension leader jog orientation, and the option  – quickly

changing the dimension prefix (the default symbol is "D"). Centering dimension text is set by the

option .

Drawing Leader Dimension

For drawing dimension similar to one shown on the picture on the right, the option  is used.

After calling this option, it is necessary to indicate the fixing point (2D node) for tying the dimension.

After specifying the fixing point, it is necessary to specify location of the leader of the dimension.

Dimension parameters are specified manually in the dialog of the command's properties or with the

help of the option .

In addition, the following options are available in the automenu:

<P> Set Dimension parameters

<Alt+P> Copy Properties from Existing Element

<Shift+D> Select Linked Dimension

<Z> Change leader line jog orientation

<D> Change Sign

<T> Tie Dimension to Node

<Ctrl+T> Link String to Node

<Esc> Cancel selection

Leader dimension can display the selected element length or that of several elements. Select a draft

line or image line in the leader dimension command. To add lines to be measured use Select objects

to measure, option, then highlight the necessary lines.
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Creating Dimensions from Axis

Diameter dimensions, which are created from the axis, look like standard linear dimensions with

diameter sign and doubled nominal values set in their parameters. There is no arrow near axis; it is

replaced with the outline with length half of the font size.

The  option is used for creation of such dimensions. After activation, you should define axis for

the dimension creation. The following option is used for this purpose:

<L> Select Line

Straight construction or graphic line can be chosen as axis. 

When axis was selected, you should define object for creation of the dimension. It can be a

construction line, a graphic line or a 2D node. The following items become available in automenu:

<L> Select Line

<N> Select Node

After defining axis and object  used for creation of dimension, it is necessary to set its location.

Parameters of dimension can be set manually in the dialog box of the command properties or with

the help of option 

The following options are available in automenu:

<P> Set Dimension parameters

<Alt+P> Copy Properties from Existing Element

<Shift+D> Select Linked Dimension

<Z> Change leader line jog orientation

<Space> Place Dimension in absolute coordinates

<J> Center Dimension Text

<D> Change Sign (change prefix)

<T> Tie Dimension to Node
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<K>
Break relations

(available if dimension is tied to the node)

<Esc> Cancel selection

Options of Creating Dimensions

When creating and editing dimensions, the Options tab of the  Parameters tool window contains

following checkboxes:

Show dialog for each created dimension. 

Enabling this checkbox makes the dimension's  parameters dialog automatically appear upon

placing a dimension on a drawing.

This allows us to work as with the previous versions of T-FLEX CAD – first specify location of a

dimension on the drawing and then specify its parameters.

Automatic alignment

If this checkbox is enabled (by default), then the system automatically places a value and arrows

outside for small dimensions

Show toolbar with options

If this checkbox is enabled (by default), then manipulators are displayed upon hovering the cursor

over a dimension

Create driving dimensions

Enabling this checkbox makes dimension a driving one.

See more in the Driving Dimension section.
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Edit driving dimension value on creation

If this checkbox is enabled along with the Create driving dimensions, then you will be forced to type

in a value upon placing a dimension on a drawing.

See more in the Driving Dimension section.

Snap within projection view

Defines, whether a dimension will belong to a particular drawing view or to a whole drawing page.

More information on this option is available in the Snapping Dimensions and Leader Notes to

Drawing Views section.

Dimension Parameters

The section contains only one auxiliary parameter– "Show Dialog for each Created Dimension". If this

parameter is enabled, then the dimension parameters dialog will automatically appear after defining

the dimension position in the dimension creation command (the option ).

This mode allows working in the same way as in previous versions of T-FLEX CAD – by specifying the

dimension position in the drawing first, and then defining its parameters.

Automatic alignment. If the option is enabled, the system automatically places the dimension number

and the arrows outside when the dimension size is reduced to certain values.

Show toolbar with options. If the option is enabled, additional markers and options for will appear

near dimension when you put cursor on it.

Dimension parameters are defined in the command's properties window before finishing dimension

creation (or editing).

Dimension parameters are arranged by several sections in the properties window according to the

parameter type. Depending on the type of the created dimension (angular, linear, radius, ordinate, arc

length), the sets of parameters in the sections may vary.

Topics in this section:

· General Tab

· Style Tab

· Tolerance Tab

· Alternative Parameters Tab

General Tab

Value. This group parameters determine, how the nominal dimension value will be defined. You can

select the following choices from the drop-down list: 
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· Auto. The dimension value is calculated automatically based on drawing elements on which it

is created. This allows a dimension to automatically change its value upon any modification to

the drawing. The field on the right-hand side for the manual dimension value input is

inaccessible. 

· Manual. The dimension value is defined by the user manually in the input field at the right of

the drop-down list. Regardless of drawing modifications, such dimension value will stay

unchanged. This option is used when you need to introduce a dimension value in the drawing,

that does not match the calculated dimension value.

· Manual with Corrections. The dimension value is specified manually by a user similar to the

previous case. However, on the drawing the dimension value for the given dimension will be

shown taking into consideration the specified scale and corrections (see below).

· By Source Lines. This option is available for 2D dimensions, drawn on the elements of any

associative copy. Upon selection of this option, the dimension value is determined by the

original elements of the copy (if for such dimension the case “Auto” is selected, then the value

of the dimension is evaluated on the basis of those elements of the copy to which the

dimension is tied to). 

The option “By Source Lines” can be used, for example, for dimensioning on the lines of the

associative copies (including the drawing views) without taking into account the scale of the copy.

· None. The dimension value string does not show on the dimension.

· From lines. This option is available for dimensions created manually on the 2D projection lines

(or their associative copies) corresponding to the thread (special 3D operation created with

the help of the command “Create Thread”). Also, this option is available for 3D dimensions

drawn on the threaded surfaces of the 3D model.  When selecting this option, the text

displayed on the dimension originates from the thread parameters (that is, the thread notation

is displayed instead of the dimension value string).

From 3D parent. This option is available only for dimensions created manually on the 2D projection

lines (or their associative copies) and on condition that 3D dimensions are drawn on the

corresponding to those lines faces, edges and vertexes of the original 3D model. Upon selection of

this option, the text and parameters of the dimension will be inherited from the parameters of the 3D

dimension.

The inaccessible for editing field found below the group “Value” is informative. It shows how the

dimension has been created and how its value and parameters have been determined:

· “On Drawing ” – standard 2D dimension drawn by nodes or by lines of a 2D drawing. The

value of the dimension is evaluated by the geometry of the drawing or specified manually;
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· “On Copy: On Drawing” – dimension is drawn on the elements of the associative copy of the

nodes and the lines of a 2D drawing. Similar text string also appears if the dimension is drawn

on the elements of the associative copy of the 2D projection lines, and for this dimension the

field “Value” has an arbitrary value except “By Source Lines” (that is, the value of the

dimension is determined either by the elements of the copy itself or specified manually);

· “On Copy: On Projection” – dimension is drawn on the elements of the associative copy of the

2D projection lines and for this dimension the field “Value” has the value “By Source Lines”. In

this case, the value of the dimension is evaluated by original objects of the copy, i.e. by the 2D

projection lines;

· “On Projection” – dimension is drawn on the 2D projection lines. If on the faces of a 3D model

corresponding to given projection lines there is a 3D dimension, and for the 2D dimension the

field “Value” has the value “From 3D parent”, then “(*3D)” is added to the information string;

· “On Operation” – this text string appears for 3D dimensions drawn on the vertexes, edges and

faces of a 3D model (see the chapter “3D Annotations” of the manual on 3D modeling)

· “Projected” – this string appears for 2D dimensions created via the command of auto-

dimensioning of 2D projections (see the chapter “3D Annotations” of the manual on 3D

modeling).

Correction. This parameter defines the correction amount that will always be added to a dimension

value. It is available only if the options “Auto” or “Manual with Correction” were chosen for specifying

dimension value.

Please note that in the case when a scale is defined, the correction is added to the already scaled

dimension value. 

The info field at the end of the "Value" group indicates the position of the dimension placement: "On

drawing" (for the dimensions created on common construction or graphic elements), "On

projection" (for dimensions on 2D projections), "On operation" (for 3D dimensions).

The "Scale" group serves to define the value of the scale factor. The scale factor provides control over

the dimension value. For example, suppose, some portion of a drawing was performed to a different

scale. Since the units are the same throughout the drawing, you shall specify a scale factor for the

dimensions in the said portion of the drawing. Then the dimension value will be displayed according

to the specified scale (that is, multiplied by the specified scale factor). The value of the scale is not

taken into account if the parameter “Value” was set the value “Manual”.

You can select the necessary option from the drop-down list:

Default. The dimension value will be affected by the settings made on the "Dimensions" tab of the

Set Document Parameters command dialog.

None. The dimension doesn't have a scale factor. 
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Inches/Millimeters, Millimeters/Inches. These are the standard scale factors introduced for the user

convenience. When selecting one of those items, the appropriate scale factor is set automatically to

make the conversion to other units.

Custom. This option is used when it is necessary to set an arbitrary scale factor. The factor value is

entered in the input field to the right of the drop-down list. For example, the case shown on the figure

at the right has the scale factor equal to "5" for both dimensions (the top dimension also having the

correction of "100").

«Strings» section

This section of the properties window collects the parameters that serve to define the text that shall

be placed before, after or under the dimension value string.  

Those strings can be defined manually, or substituted by numerical or text variables. Besides that, one

can use all capabilities of text line formatting described in the "Text" chapter.

To insert a variable into one of the dimension strings, you need to enter its name in the respective

string, surrounded in braces. For example, if you need to make the "A" variable value appear in the

dimension text on the drawing, enter {A} in the respective dimension string. 

For example, in the string "Before" enter the necessary text: width {A} mm  

Note that the variable "A" is entered in braces. Suppose, its value is equal to 100. Set the parameter

"Dimension text" (described above) to the value "No parameters". As a result, the dimension on the

drawing will appear as shown on the diagram at the right.

 

For complete information on use of the variables, refer to the chapter "Variables". 

Besides, special symbols can be entered in the text strings via <Alt><F9>. To do this, click inside a text

string input box and press <Alt><F9>. Then, select the necessary symbol and hit <Enter>.



Drawing Creation

665

Special symbols are various conventional textual and drawing notations. The symbols are

represented by the textual font used in the parameter dialog box. On selecting a special symbol

from the dialog box, it will be entered in the parameter string input box as a double percent

character (%%) followed by the symbol code. However, upon placing the cursor into the

parameter string which contains special symbols, a popup tooltip with a real image of the line

contents will appear on the screen. On the drawing the special symbols will be also displayed

precisely. 

Note that the special symbols can be used as part of any parameter, which is a textual string, for

various system elements.

String parameters of the dimension may be set using other parameters of the same dimension. You

need to use $(VALUE) record, where VALUE – name of the parameter (as it is called in the Measure

operation)

Style Tab

Sign. For a linear dimension, this parameter defines a special symbol to be displayed before the

dimension value. This is necessary to create, for example, a radius, diameter or thread dimension. 

              

This parameter is not available for the circular arc length dimension.

Type. This parameter is required if you need to have a linear dimension without extension (witness)

lines (this is often used when creating dimensions from a centerline). This parameter can also be used
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to create one-sided dimensions (used for dimensioning on cut views or for dimensions on large-size

parts).

Strings offset. This parameter defines the distance by which the dimension value string and the string

beneath the dimension will be separated from the dimension line or from the leader jog (by default =

0).

Lines offset. This parameter defines the offset of extension (witness) lines of a dimension from the

object when creating dimensions per the ANSI and AR_ANSI standards. Whenever this parameter is

not defined, the offset amount will depend on the size of the dimension line arrows.

The next diagrams correspond to the values of this parameter equal to "0" and "5".

   

Box. You can choose one of the following options from the drop-down list. 

· No. The dimension text will be displayed without box.

· Square. The dimension text is outlined by square box.

· Rounded. The dimension text is outlined by rounded box.

You can outline only selected part of the dimension text using %%R.

Outside Arrows. When this flag is set, the dimension arrows are always drawn outside of the extension

(witness) lines. When the flag is disabled (the default), the arrows position is determined automatically

depending on the distance between the extension lines of the dimension. If arrows don't fit inside,

then those will be automatically switched to outside.

Show when zero value. When this parameter is enabled, dimension will be displayed on the drawing

even when its value is zero.

The "Clear Background" group provides controls for the dimension display mode in which drawing

portions are erased around the dimension strokes:

Under Arrows. Turning on this item erases the drawing portions under and around the leader lines

and leader arrows (at the distance equal to the thickness of the main continuous line).

Under Lines. Turning on this item erases the drawing portions under and around the witness lines (at

the distance equal to the thickness of the main continuous line). In the case of the radial dimensions,

the background is also erased under the cross marking the circle center.

«Arrows» section

In this section you define the type and size of arrows on either end of a dimension line. The value in

square brackets means the arrow size will be per the value defined on the Lines > Arrow (End) Size

tab of the Set Document Parameters command dialog.

Button  toggles start and end arrow head parameters.
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«Units» section

Standard. This parameter allows selecting the dimension display standard: ANSI, AR_ANSI, ISO or

Default. When the “Default” value is used, the dimension standard is copied from the parameter value

in Dimensions > Standard of the Set Document Parameters command. 

    

Minimum Digits. This parameter determines the minimum number of decimal digits displayed in a

dimension. For example, if the value “3” is specified, then the dimension 28.5 will be displayed as

28.500. If the “Default” is set, then the value is taken from the “Dimensions” tab of the Set Document

Parameters command.

Units. This defines the units in which the dimension value is displayed. Mostly, this item is important

for inch dimensions. When the “Default” value is used, the dimension is displayed in the units defined

in the Set Document Parameters command.

Precision. Sets the rounding accuracy of dimension values. The accuracy "0.01" means the dimension

values will be rounded to the second decimal digit. For example, if there is a dimension 28.4482, and

the accuracy is 0.01, then the value 28.45 will be displayed in the drawing. If this item is set to Default,

then its setting is defined on the «Dimensions» tab of the Set Document Parameters command

dialog.
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Tolerance Tab

This section of the properties window defines the tolerance zones and deviation limits.

The "Text" parameter, which is coming first in the section, defines what parameters will be displayed

together with the dimension nominal value:

Nominal. Only the dimension value is displayed

Limits (ANSI standard). The dimension value is composed of the two main values, each being the sum

of the dimension value and the corresponding deviation limit.

Nominal + Deviations. The deviation limits are displayed next to the dimension value.

Nominal + Tolerance. The tolerance notation will be displayed next to the dimension value.

All parameters. In this case, both the tolerance notation and the deviation limits are displayed.

No parameters. In this case, the dimension text is not displayed. This is convenient when the user

intends to enter one's own text instead of the dimension value.
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Deviations can be defined manually or calculated automatically based on the specified tolerance

zone. Automatic deviations calculation is used by default. The change from the manual setting to the

automatic is done by toggling the "Deviations" flag (when the flag is off, the deviations are calculated

automatically, when it is on – those are defined manually).

When using the automatic mode of calculating tolerances, you just need to specify the tolerance zone.

Please note that the values of the calculated deviations depend on the measurement units defined in

the Set Document Parameters command menu. Automatic calculation of deviations works only for

the millimeters or inches settings.

When the dimension value is modified, the deviations populated from tolerances will be adjusted

automatically.

A variable can be entered in place of a deviation value just like in any other numerical field.

Various standards set the different requirements to the font size used to display value deviation limits

in the drawing. Two choices are provided: reduced-height, which is half the font size, and full-height.

To choose the necessary one, use the "Font" parameter. 

Fit parameters are defined similar to tolerance parameters.

Special about defining angular dimension parameters

Linear and angular dimension parameters are mainly same. Described below are the existing

differences.

The set of tolerance parameters for angular dimensions is different from the respective parameters of

other dimensions.

 

Since angular dimension tolerance calculation depends on the length, the parameter "Length" is

provided for angular dimensions. When calculating deviations automatically, the following formula of

defining the tolerance zone is used: +AT8, AT8 or -AТ8, where 8 is the tolerance grade, while a signed

AT defines the tolerance type.

    

The deviations are calculated in degrees, minutes and seconds, respectively. The angular dimensions

use special units for displaying the dimension value.



T-FLEX CAD 17 Help

670

For angular dimensions you cannot specify an alternative scale, nor any other parameters related to an

alternative dimension.

When you create angular dimensions, the Text along the line option appears. If the option is enabled,

the text on the angular dimension will not be drawn along the arc, but along the tangent to it.

Alternative Parameters Tab

Show. This parameter determines the presence or absence of an alternative dimension in the drawing.

When the parameter is set to "Default", then its setting is defined on the "Alternative dimensions" tab

of the Set Document Parameters command dialog.

Separator. This parameter sets the appearance of separators that are used in the drawing to separate

the alternative and the main dimension values:

· Default. In this case, the separator assumes the type defined in the command Set Document

Parameters.

· None. The alternative dimension text will not be separated.

· [Brackets]. The alternative dimension text will appear in brackets.

· {Braces}. The alternative dimension text will appear in braces.

· (Parentheses). The alternative dimension text will appear in braces.

Position. This parameter defines the mode of displaying the alternative dimension value in the

drawing at a relative location of the main dimension value. According to the choice made, the

alternative dimension value will appear in the drawing "After", "Before", "Under" or "Above" the main

dimension value string. If the parameter is defined as "Default", then its value is assumed from the

"Alternative dimensions" setting of the command Set Document Parameters.

Scale. This parameter defines the scale factor of an alternative dimension (which is fully analogous to

the scale factor of the main dimension value).

Why are «Alternative scale» and «Scale factor», respectively? Suppose, dimension values need to be

created in two measurement systems at the same time, inches and metric. For this purpose, a special

expression is introduced in the system - #DIM#. If this expression is used in any of the dimension lines

(strings), then a dimension value will appear instead of it in the drawing, which will be multiplied by

the alternative scale factor.

To follow the example on the right, set the «Alternative scale» to «Millimeters/Inches» and enter the

following text in the «Text > After» field: [#DIM#%%119].

Correction. Parameter defines correction of the alternative dimension value compared to the

calculated value. Correction is calculated similarly to the nominal value: displayed value = calculated

value*scale factor + correction.



Drawing Creation

671

The "Text" group of parameters allows defining the text that will be displayed before or after the

dimension value of an alternative dimension. Such strings can be entered manually or substituted by

numerical or text variables. You can familiarize yourself with this capability in detail by reading the

description of the counterpart parameter in the "String" section. If no parameter values are set in this

group, then those are taken from the "Alternative dimensions" tab of the Set Document Parameters

command.

The "Tolerance" group of parameters allows defining tolerance zones (ranges) and value deviation

limits of alternative dimensions:

Text. This parameter defines the included members of the dimension value string of an alternative

dimension (the dimension value only, the dimension value with tolerance, etc.). A value can be

selected from the list. The "Default" setting means the appearance of an alternative dimension will be

determined by the "Text" parameter setting in the "Tolerance" section.

The tolerance zone is defined by the same-name parameter. The value deviation limits can be either

defined manually (in the respective input fields) or calculated automatically. The method of defining

deviations is controlled by the "Set Tolerance" parameter:

· Auto-Scale. The deviation limit values are calculated by the tolerance zone of the main

dimension (while accounting for the measurement units of the alternative dimension –

millimeters or inches). The definition of the tolerance zone value of an alternative dimension

does not affect the calculation of its value deviation limits.

· Auto-ANSI. Deviations are calculated by the defined tolerance zone of an alternative

dimension per the ANSI standard.

· Auto-ISO. Deviations are calculated by the defined tolerance zone of an alternative dimension

per the ISO standard.

· Manually. The deviation values are defined by the user. Variables can be used instead of

deviation values.

· When using the automatic modes of calculating deviations (Auto-Scale, Auto-ANSI or Auto-

ISO), you just need to define the tolerance zone. The deviations will be calculated

automatically.

Accuracy. Defines the rounding precision of the dimension values of the alternative linear dimensions.

For example, the accuracy 0.01 means the dimension values will be rounded to the second decimal

digit. Accuracy 0 means no rounding. If set to "Default", the accuracy assumes the settings from the

"Alternative dimensions" tab of the Set Document Parameters command.

Units. Defines the way of displaying the dimension values of alternative linear dimensions. This item is

primarily used when working in inches. Just as in the previous case, the "Default" setting means the

dimension will be displayed in the units defined on the "Alternative dimensions" tab of the Set

Document Parameters command.

Minimum Digits. This parameter determines the minimum number of decimal digits that is displayed

for the alternative dimension value (similar to the "Minimum Digits" parameter of the main dimension
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value). If "Default" is set, then the value is taken from the "Alternative dimensions" tab of the Set

Document Parameters command.

Edit Dimensions

Dimension editing is done via the command "Edit Dimension":

Icon Ribbon

Draw > Title Block > Dimension

Keyboard Textual Menu

<ED> Edit > Draw > Dimension

Upon calling the command, the following options become available:

<*> Select All Elements

<Esc> Exit command

Select a dimension for editing by pointing and clicking the mouse . That highlights the dimension.

This dimension parameters will be displayed in the properties window. Meanwhile, the automenu

offers the following options:

<P> Set selected Element(s) parameters

<Alt+P> Copy Properties from Existing Element

<O> Create Name for Selected Element

<Shift+D> Select Linked Dimension

<Shift+K> Break Link with Dimension

<Z> Change leader line jog orientation

<Z> Change Dimension orientation (for angular dimension)

<Spacebar> Place Dimension in the absolute coordinates

<J> Center Dimension Text

<D> Change Dimension Symbol

<T> Tie Dimension to Node

<Ctrl+T> Link String to Node

<W> Move dimension
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<M> Change Dimension type

<M> Change Dimension type

<M> Change Dimension type

<H> Change Dimension Symbol

<H> Change Dimension Symbol

<K> Break relations

<D> Change Dimension Type

<I> SelectSelect Other Element

<Del> Delete selected Element(s)

<Esc> Cancel selection

Availability of some of the above options in the automenu depends on the ways of creation and

the type of the selected dimension.

The selected dimension can be moved, tied to other drawing elements or have its parameters

modified, with respect to the original settings. To do this, select the appropriate option in the

automenu. 

The option   allows you to modify orientation of the leader extension of the dimension text.

  

The option  changes orientation of angular dimension (i.e., the quarter of an angle on which the

dimension is drawn).

The option  sets the mode of centering the dimension text. When pushed, the dimension text will be

automatically centered between the witness lines.

The option  helps quickly changing the dimension value prefix ("R", "Æ", "M"," ", "o"), without

calling the dimension parameters dialog box. The option  serves for changing the reference

elements (lines, nodes) of the dimension being edited. The fixing position of the dimension created

using the option , can be changed by selecting two nodes.
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Sometimes, it is necessary to change the witness line attachment point. To do this, select the

dimension at the point of the intended origin node of the witness line, and pick the option .

       

If a wrong dimension was selected, alter the selection using the option . The option  or / ,

depending on dimension type, allows changing its type without altering its references.

      

Note that if the dimension was tied to a node using the option , then to modify its fixing condition,

first use the option .

Option  is used to assign a name to the selected dimension. The name is unique and allows you to

uniquely identify this dimension.

A selected dimension can be deleted using the option . Deleting chain dimensions or dimensions

from one base can be done separately for each dimension. Deleting the parent dimension (which is

the dimension between the first two lines) causes deletion of the whole dimension group. The same

rule is used for ordinate dimensions, created on one base: any dimension in the series, except the base

one, is deleted as a separate entity; when deleting the base dimension, all dependent dimensions are

also deleted.

As in the case of other elements, multiple selection is done by the option , or using box selection

or clicking  while holding down the <Shift> key (for adding to the list of selected) or <Ctrl> (for

excluding from the list of selected).

For editing parameters of a group of selected dimensions, use the option:

<P> Set selected Element(s) parameter

First, select the set of parameters to be modified, in the dialog box that comes up on the screen. The

standard dimension parameter dialog box will follow, allowing to define new parameter values. To

define color, later, level and priority, one can also use the system toolbar. The option  helps copying

parameters from another existing dimension.

Remember, that a number of dimension settings are defined by default, which can be changed in the

command Set Document Parameters.

One can also enter the dimension editing command directly from the command "Create dimension",

using the option: <F4>  Edit Dimension

The third way of selecting a dimension for editing is available, when the system is in the command-

waiting mode. Move the pointer over the dimension to be modified, and click . As a result, editing

of the selected dimension begins. Besides, one can select the dimension and right click . The
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coming up context menu provides the commands for editing, deleting and modifying properties of

the selected dimension.

Auxiliary Lines and Dimensions

Dimensions and graphic lines on a drawing can be made auxiliary. Enable the Auxiliary line or

Auxiliary dimension checkbox in command's parameters window, when creating a corresponding

element, or click   on an existing element an enable the Auxiliary checkbox in the contextual

menu.

Auxiliary elements are non-printable. They're displayed in blue color regardless of the color set in

element's parameters.

The  Hide Constructions command hides auxiliary elements.

By default, auxiliary lines are displayed using the line type set in their parameters. However, you can

enable the option of displaying all auxiliary lines as dashed regardless of the line type set in their

parameters (Document Parameters > Page > Lines > Lines > Draw auxiliary lines dashed). 

Drawing line and dimension (left),

Auxiliary line and dimension, when the Draw auxiliary lines dashed option is disabled (center),

Auxiliary line and dimension, when the Draw auxiliary lines dashed option is enabled (right).

2D projection lines resulting from 3D model can also be made auxiliary. Such lines are displayed in

violet color.

When creating a 2D projection, the Lines tab of command's parameters window contains the Create

Auxiliary Lines checkbox. Enabling this checkbox makes auxiliary all lines of the projection.



T-FLEX CAD 17 Help

676

2D projection of a prism with two auxiliary edges, when the Draw auxiliary lines dashed option is

enabled (left) and disabled (right).

Text

The command for creating texts can be called in one of the following ways:

Icon Ribbon

Draw > Appearance > Text

Assembly > Additional > Text

Workplane > Appearance > Text

Sheet Metal > Appearance > Text

Keyboard Textual Menu

<TE> Draw > Text

It can be used for creating texts on a drawing or on an active workplane.

Upon calling the command, you should select a type of text to be created. Following types can be

selected in the automenu:
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<M> Multiline Text 

Boundaries of text area are not fixed and depend on size of text content. Font and

Paragraph parameters can be customized individually for different parts of the same

text. Inputting the content can be performed directly on a drawing/WP or in the text

editor.

<R> Paragraph Text 

Boundaries of text area are fixed. If content doesn't fit, user can expand boundaries

manually or enable automatic expansion with customizable parameters. Font and

Paragraph parameters can be customized individually for different parts of the same

text. Inputting the content can be performed directly on a drawing/WP or in the text

editor.

<B> Table

Tabular representation of information. Table can be created as separate object or

inserted into other multine text or paragraph text. Boundaries of table area are not fixed

and depend on size of content, if table is created as separate object. Font and

Paragraph parameters can be customized individually for different parts of text in the

same table. Inputting the content can be performed directly on a drawing/WP or in the

text editor.

<D> String Text 

Unlike other types of text, string text can be oriented along a construction line or a circle.

Boundaries of text area are not fixed and depend on size of text content. Font and

Paragraph parameters are defined for the whole text only. Inputting the content is

performed in parameters dialog. This type of text has limited elements insertion

capabilities, compared to other types.

Apart from aforementioned options, upon calling the text creation command, automenu contains

options described in the Position and Orientation of Text section and following options common for

most 2D elements creation commands:

<P> Set Text Parameters

<Alt+P> Copy Properties from Existing Element

<F4> Edit Text

<Esc> Exit

The sequence of actions required to create a text of a particular type can be found in section

describing such type.
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Topics in this section:

· Multiline Text

· Paragraph Text

· Table

· String Text

· Position and Orientation of Text

· Contextual Menu of Text Content

· Text Editor

· Display Options of Text Content Editing 

· Inserting Elements into Text

· Font Parameters of Text

· Paragraph Parameters of Text

· Check Spelling

· Parameters Dialog of Text

· Edit Text

Multiline Text

Multiline text can be created using the following automenu option within the Text command:

<M> Create Multiline Text

Multiline text may contain any number of lines and any number of characters within the line. When

inputting the text content, press <Enter> to add a new paragraph or <Shift>+<Enter> to adding a

new line.

Multiline text always lays within a single bounding rectangle. Size of a rectangle is not fixed. It

expands or shrinks depending on the size of text content. When adding the content to a current line,

the rectangle expands horizontally, when adding new lines - vertically. The direction of expansion or

shrinkage depends on the selected position of text in relation to its anchor point. 

The content of multiline text can be inputted directly on a drawing page/active WP or in the text

editor.

Font parameters may be defined individually for each character. Paragraph parameters may be

defined individually for each paragraph.

Creating a multiline text

Upon selecting a multiline text option in the automenu of the Text command, you need to define an

anchor point in one of the ways described in the Position and Orientation of Text section. 

Upon defining an anchor point, the creation of text gets finished and the system switches to the text

content editing mode. A bounding rectangle with text cursor appear on a drawing page/active WP.

The you may additionally move or rotate the text using manipulators, customize the text position in

relation to its anchor point and start inputting the text content. For the most part, the text content is

inputted using the keyboard. Optionally, you may insert various elements into text using the automenu

or the contextual menu of text content.

When editing content of a multiline text, following options are available in the automenu:

<Ctrl>+<Enter

>
Finish input

<Ctrl>+<X> Cut
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<Ctrl>+<C> Copy

<Ctrl>+<V> Paste

Inserting elements into text

Inserting symbols into text

<F9> Format Font

<F10> Format Paragraph

 Position of text in relation to its anchor point

<F11> Edit in separate window

<Ctrl>+<F11> Check Spelling

<Esc> Cancel

As you finished inputting the content and customizing the parameters of the current text, press ,

<Ctrl>+<Enter> or . In result, editing of the current text gets finished and the system proceeds to

creating a next text. 

If after creating a text you finish its editing without inputting any content, then the system asks the

question:

Answering No deletes the empty text object.

Answering Yes keeps the empty text object. You can edit it later.

If you edit an already created empty text and leave it empty again, the question doesn't appear.

Paragraph Text

Paragraph text can be created using the following automenu option within the Text command:

<R> Create paragraph text

Paragraph text lays within one or several bounding rectangles. Size of rectangles is fixed. Different

rectangles of a single text may be placed on different pages.

If text content doesn't fit the current line within bounding rectangle's width, it gets wrapped to the

next line automatically. You may add a new line manually by pressing <Shift>+<Enter>, or add a new

paragraph by pressing <Enter>. Sometimes the content can not be wrapped to the next line, e.g.
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when width of a character or inserted element (picture, 2D fragment, formlimit, roughness) exceeds

the width of the bounding rectangle. In such cases, depending on the fit settings, it's either the width

of the rectangle is automatically increased, or the content that didn't fit is ignored.

If inputted lines do not fit the height of the current bounding rectangle, they get wrapped to the next

one. If there's no next rectangle, then, depending on the fit settings, it's either the height of the current

rectangle is automatically increased, a new rectangle is automatically added, a font size is

automatically reduced, or the content that didn't fit is ignored.

When ignoring a content that didn't fit a width of a rectangle, the ignored part is still displayed

on a drawing/WP and remains printable.

When ignoring a content that didn't fit a height of a rectangle, the ignored part is not displayed

on a drawing/WP outside the text content editing mode and becomes non-printable.

If deleting some of the text content leaves a bounding rectangle (except the first one) empty, then,

depending on the fit settings, such empty rectangle might be either kept or automatically deleted.

Automatic deletion of a rectangle may be combined with automatic deletion of a corresponding

page.

The content of paragraph text can be inputted directly on a drawing page/active WP or in the text

editor.

Font parameters may be defined individually for each character. Paragraph parameters may be

defined individually for each paragraph.

Creating a paragraph text

Upon selecting a paragraph text option in the automenu of the Text command, you need to define a

first anchor point in one of the ways described in the Position and Orientation of Text section. Upon

defining a first anchor point, a preview of a first bounding rectangle appears. One of rectangle's

angles coincides with the first anchor point, the opposite angle follows the cursor. Next you need to

define a second anchor point. Upon defining a second anchor point, the second angle of the first

bounding rectangle coincides with it, and the preview of a third point (i.e. first angle of the second

bounding rectangle) starts following the cursor. Thus, you can defined multiple bounding rectangles

for the same text. However, a single rectangle is enough to create a text. Defining anchor points and,

therefore, bounding rectangles goes on until you click  within the boundaries of any of the created

rectangles. Then the creation of text get finished and the system switches to text content editing

mode.

Creating the paragraph text with two bounding rectangles by pointing anchor points' positions with

the mouse is shown on the figure below:
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Upon switching to the text content editing mode, the appearance of bounding rectangles changes.

They become bigger due to additional offsets intended to ease the content editing. Manipulators for

moving  and rotating  the text appear at top corners of rectangles. Square manipulators  for

changing rectangle's size appear at key points (start, middle and end) of each edge. In order to re-size

a rectangle, move the cursor over one of its  manipulators. The cursor's appearance will change to 

, ,  or  depending on the resizing direction controlled by the selected manipulator. Then click

and hold , while moving the cursor. Preview of rectangle's new size will start following the cursor.

The preview consists of two contours - big dashed and small continuous. Continuous contour

represents the real size of the rectangle based on its anchor points. Dashed contour represents the

one, that will get displayed within the text content editing mode, and is bigger due to additional

offsets intended to ease the content editing. Establish the necessary size of the rectangle and release

 to confirm resizing.

Next you can start inputting the text content. For the most part, the text content is inputted using the

keyboard. Optionally, you may insert various elements into text using the automenu or the contextual
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menu of text content. Throughout inputting the content, dialog windows described in the Fit Settings

of Paragraph Text may appear.

When editing content of a paragraph text, following options are available in the automenu:

<Ctrl>+<Enter

>
Finish input

<Ctrl>+<X> Cut

<Ctrl>+<C> Copy

<Ctrl>+<V> Paste

Inserting elements into text

Inserting symbols into text

<F9> Format Font

<F10> Format Paragraph

<Ctrl>+<F5> Change paragraph size parameters

<F11> Edit in separate window

<Ctrl>+<F11> Check Spelling

<Esc> Cancel

As you finished inputting the content and customizing the parameters of the current text, press ,

<Ctrl>+<Enter> or . In result, editing of the current text gets finished and the system proceeds to

creating a next text. 

If after creating a text you finish its editing without inputting any content, then the system asks the

question:

Answering No deletes the empty text object.

Answering Yes keeps the empty text object. You can edit it later.

If you edit an already created empty text and leave it empty again, the question doesn't appear.



Drawing Creation

683

Fit Settings of Paragraph Text

When editing the content of paragraph text, you can call the Fit settings dialog using the following

automenu option:

<Ctrl>+<F5> Change paragraph size parameters

The dialog contains following tabs:

· Width

Sets the action to be applied by the system, in case when text content doesn't fit in width of a

bounding rectangle.

· Height

Sets the action to be applied by the system, in case when text content doesn't fit in height of a

bounding rectangle.

· Delete

Sets the action to be applied by the system, in case when deleting text content leaves a

bounding rectangle empty.

· Additional

Allows duplicating headers of tables inserted into paragraph text.

The Ask action is selected by default in the Width, Height and Delete tabs. As a result, when the

corresponding event occurs, a dialog will appear on the screen in which the user will be asked to

choose a further action:
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The set of actions available for selection in these dialogs is similar to the sets of actions available in

the corresponding tabs of the Fit settings dialog. 

Additionally, there's the Don't ask this question again group in the bottom part of the dialog

containing following checkboxes:

· for this text

If this checkbox is enabled, then the action selected above will always be automatically

applied to this text in the future. This flag takes precedence over the following.

· in this session

If this checkbox is enabled, then the action selected above will always be automatically

applied to this text in the current T-FLEX CAD session. In following sessions the Ask action will

be applied.
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Width

This tab sets the action to be applied by the system, in case when text content doesn't fit in width of a

bounding rectangle:

· Ask

The system asks user to choose a further action.

· Ignore

Size of a rectangle remains unchanged. A content, that didn't fit, is still displayed on a

drawing/WP and remains printable.

· Enlarge Width of  Rectangle

Width of a rectangle is increased automatically, so that all text content fits. Upon selecting this

action, the dropdown list appears in the bottom part of the dialog, where you can select a

direction of extending a rectangle - to the right or to the left.
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Height 

This tab sets the action to be applied by the system, in case when text content doesn't fit in height of a

bounding rectangle:

· Ask

The system asks user to choose a further action.

· Ignore

Size of a rectangle remains unchanged. A content, that didn't fit, is not displayed on a

drawing/WP outside the text content editing mode and becomes non-printable.

· Fit text

Font size shrinks, so that all text content fits a rectangle.

· Create rectangle on current page

A new rectangle is created automatically on a current page. Upon selecting this action, the

Rectangle Coordinates input boxes appear in the bottom part of the dialog. Coordinates are

set either in system of a page, or in system of a drawing view, depending on what the text

belongs to. 

1 - Left, 2 - Right, 3 - Top, 4 - Bottom.
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· Create new page with rectangle

A new rectangle is created automatically on a new page of the same type as the current page.

Coordinates of a new rectangle are set in the same way as described above.

· Create new rectangle on next page

A new rectangle is created automatically on a next page. If there's no next page, it will be

created automatically. Coordinates of a new rectangle are set in the same way as described

above.

Regardless of the type of the page containing the initial rectangle, when adding a new

rectangle, only pages of the following types are taken into account :  Normal,  Text, 

 Bill of Materials.

· Enlarge height of last rectangle

Height of a rectangle is increased automatically, so that all text content fits. Upon selecting

this action, the dropdown list appears in the bottom part of the dialog, where you can select a

direction of extending a rectangle - downwards or upwards.

· Create rectangle with offset

A new rectangle is created automatically on the current page. A new rectangle is positioned

by defining offsets of one of the angles of a new rectangle in relation to one of the angles of

the initial rectangle (Bottom Left, Top Left, Top Right, Bottom Right).

Following parameters are available:

o Snap to initial rectangle

An angle of the initial rectangle, which will define a position of a new one.

o Snap new rectangle

An angle of a new rectangle, which is positioned in relation to an angle of the initial

rectangle defined above.

o Horizontal offset and Vertical offset

Offset of a new rectangle from the initial one.

o Width and Height

By default, dimensions of a new rectangle are equal to dimensions of the initial rectangle.

So, dimension values are displayed in these input boxes but can not be edited. In order to

type in custom value, enable the checkbox located to the left side of a corresponding

parameter's name.
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The result of creating a new rectangle with parameters shown on the previous image

1 - Top Right angle of the initial rectangle

2 - Top Left angle of the new rectangle

3 - Horizontal offset of the new rectangle from the initial one (40 mm)

4 - Vertical offset of the new rectangle from the initial one (-10 mm)

5 - Width of the new rectangle is defined by the width of the initial one (100 mm)

6 - Height of the new rectangle is defined by the custom value (40 mm)

Delete

This tab sets the action to be applied by the system, in case when deleting text content leaves a

bounding rectangle empty.

· Ask

The system asks user to choose a further action.

· Keep

Empty rectangle is kept.

· Delete only rectangles

Empty rectangle is deleted.

· Delete pages

The whole page containing the empty rectangle is deleted.

Attention! It doesn't matter if there's any other content on a page along with the empty

rectangle. The page gets deleted anyway..
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Additional

If there's a table inserted into text, then enabling the Duplicate Table Header in Subsequent

Rectangles checkbox adds table's header to the top of each bounding rectangle, except the first one.

The header is the number of rows of the table from its beginning, specified in the Number of Header

Lines input box.  

This option only works for tables inserted at the beginning of the text. When inserting multiple

tables into the same text, the header of the first table is displayed for all rectangles
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Table

Calling the command:

Icon Ribbon

Draw > Appearance > Table

Workplane > Appearance > Table

Sheet Metal > Appearance > Table

Keyboard Textual Menu

- -

The Table command runs the Text command with the following option applied:

<B> Create Table

It is not possible to switch to options for creating other types of text in this case.

In addition, the table can be inserted into paragraph text or multiline text using the following

command:

Icon Ribbon

Text > Table > Insert Table

Table Creation

When creating a separate table, you first need to set its anchor point using one of the methods

described in the Position and Orientation of Text section.

When inserting a table into the text, its position depends on the position of the text cursor at the

moment of calling the Insert Table command. 

Next, the Insert Table dialog will appear:

In the dialog box, set the required Number of Columns and the Number of Rows, as well as the

Column Width (you can set the individual width for each column later in the table parameters or using

the mouse). If you disable the Column Width checkbox, the system will set the minimum possible

column width.

You can also create a table based on a prototype. To do this, select a Prototype in the drop-down list.

As a result, the Number of Columns, Number of Rows and Column Width input boxes will become

inactive, and a preview of the selected prototype will appear at the bottom of the dialog. In addition

to the standard prototypes supplied with the system, you can create custom prototypes. To do this,
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create a 2D fragment containing one table and save it to the folder ...\T-FLEX Parametric CAD

xx\Program\Template (administrator rights may be required). As a result, the saved prototype will be

available in the drop-down list when inserting tables.

After confirming the set parameters, the created table will be drawn on the page, and the system will

switch to the mode of editing its contents.

You can move and rotate the table using manipulators, as described in the Position and Orientation of

Text section. It also describes the options of the text's position in relation to its anchor point.

The cell sizes can be changed using the mouse or using the table parameters dialog. To change the

size of the cells using the mouse, to move the cursor over the border you want to move. The cursor

changes appearance  to  (for vertical borders) or  (for horizontal borders). Click and hold 

while moving the mouse. The border will follow the cursor. Move the border to the necessary position

and release . The left vertical and upper horizontal borders of the table cannot be moved.

Changing cell sizes using the properties dialog is described in the Table Properties section.

To fill in a cell, place the cursor over it and click . A text cursor will appear in the cell in the form of

a blinking vertical line, corresponding in height to the height of the text line. After that, you can enter

the text of the cell from the keyboard or insert an element into the cell. The position of the text cursor

corresponds to the position of the inputted character/inserted element. Also, the text cursor can be

moved around the table using the arrows on the keyboard.

Symbols and elements in cells, as well as entire cells, can be selected by moving the mouse while

holding down , or by pressing the arrows on the keyboard while holding down the <Shift> key.

You can also select the entire table using the keyboard shortcut <Ctrl>+<A> or the Select All

command in the context menu of the text content.
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The contents of the table can be created by copying through the clipboard the contents of a

previously filled T-FLEX CAD table, or a table from Word or Excel. And vice versa: the T-FLEX

CAD table can be copied to Word or Excel.

When editing the table contents, the following options are available in the automenu:

<Ctrl>+<Enter

>
Finish input

<Ctrl>+<X> Cut

<Ctrl>+<C> Copy

<Ctrl>+<V> Paste

Inserting elements into text

Inserting symbols into text

<F9> Format Font

<F10> Format Paragraph

Position of text in relation to its anchor point

<F11> Edit in a separate window

<Ctrl>+<F11> Check Spelling

<Esc> Cancel

Also, when editing tables, you can use the contextual menu of the text content and the commands

available on the Text ribbon tab.

After all the necessary content is inputted and all the required parameters are set, press ,

<Ctrl>+<Enter> or . As a result, editing of the current table will be completed and the system will

proceed to creating the next one.

Topics in this section:

· Commands for Working with Tables

· Table Properties

Commands for Working with Tables

When editing tables following commands are available in the Text tab of the ribbon, as well as on the

Table toolbar in the Text Editor, :
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Select Table

Icon Ribbon

Text > Table > Select Table

Selects all cells of the table.

Table Properties

Icon Ribbon

Text > Table > Table Properties

Calls the table properties dialog.

Split Cells

Icon Ribbon

Text > Edit > Split Cells

Opens a dialog, where you should specify the Number of Columns and the Number of Rows into

which the selected cells will be split after clicking OK.

Merge Cells

Icon Ribbon

Text > Edit > Merge Cells

Merges the selected cells into one.

Split Table

Icon Ribbon

Text > Edit > Split Table

This option is available if the table is inserted into a multiline text or paragraph text. Splits the current

table into two separate tables along the upper border of the current cell. When multiple cells are

selected, the command is not available.
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Insert Row Before

Icon Ribbon

Text > Rows > Insert Row Before

Inserts an empty row before the current row.

Insert Row After

Icon Ribbon

Text > Rows > Insert Row After

Inserts an empty row after the current row.

Insert Rows

Icon Ribbon

Text > Rows > Insert Rows

Opens a dialog, where you should specify the Rows Number that, after clicking OK, will be inserted

Before Current Row or After Current Row, depending on the value selected in the Insert field.

Delete Rows

Icon Ribbon

Text > Rows > Delete Rows

Deletes the rows that the selected cells belong to.

Insert Column Before

Icon Ribbon

Text > Columns > Insert Column Before

Inserts an empty column at the left of the current column.
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Insert Column After

Icon Ribbon

Text > Columns > Insert Column After

Inserts an empty column at the right of the current column.

Insert Columns

Icon Ribbon

Text > Columns > Insert Columns

Opens a dialog in which you should specify the Columns Number that, after clicking OK, will be

inserted Before Current Column or After Current Colum, depending on the value selected in the

Insert field.

Delete Columns

Icon Ribbon

Text > Columns >Delete Columns

Deletes the columns that the selected cells belong to.

Database

Icon Ribbon

Text > Database > Database

Allows you to insert into table the contents of any of the databases available in the current document

(both internal and added by reference to an external file). After calling the option, the Database

dialog box appears on the screen. In the upper part of the window there is the Name drop-down list,

in which you can select any of the databases available in the current document.

Then a list of columns of the selected database appears in the Columns field on the left. The data type

in the column ( integer, real, text) is indicated by an icon to the left of the field name. The 

 <Empty Column> and  <Row Number>  are also available. To display the values of a database

column in the table, select the column in the left list using  and move it to the right list using the

[>>] button.  The  <Empty Column> and  <Row Number> are not moved to the right list, but
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are copied to it, so you can add them to the table several times. The column can be removed from the

right list using the [<<] button.

The number of selected database columns cannot exceed the number of table columns. The order of

the columns in the right list corresponds to the order of the columns to be filled in the table (the

contents of the database column top in the list, is entered in the leftmost column of the table, etc.). To

change the order of the columns in the right list, use the Up and Down buttons located to the right of

the list. 

The order in which the database contents are displayed in the table rows can be changed by sorting

the database by one of the columns. To do this, select the  column in the right list and set the

necessary sorting method in the Sort field (None,  Ascending,  Descending order).

The table is filled vertically from top to bottom, starting from the row containing the cell active at the

time of the command call. The lines above will remain blank. If the database contains more rows than

are available in the table, new rows will be added automatically. 

The table is filled horizontally from right to left, always starting from the leftmost column, regardless

of which cell was active at the time the command was called.

After clicking OK, the table will be filled with the corresponding values from the database.

The contents of the table associated with the database are updated automatically during

regeneration.

Update from Database

Icon Ribbon

Text > Database > Update from Database

It is used to update the contents of the table, if the contents of the linked database have been

changed.

Table Properties

The command can be called when creating a table after the cells are located in the drawing or WP, as

well as when editing previously created tables:
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Icon Ribbon

Text > Table > Table Properties

Keyboard Textual Menu

- -

The command is also available in the text input context menu if the input focus is in one of the table

cells.

Opens a dialog box containing the following tabs:

· Table

· Row

· Cell

· Borders

The parameters on the Table tab always apply to the entire table as a whole. The parameters on the

other tabs of the dialog refer to the cells currently selected, or to the cell in which the input focus is

set.

The text parameters in the table cells are defined in the text parameters dialog (for the entire table as

a whole) or in the Font Parameters of Text and paragraph parameters dialogs (for the selected part of

the text).

Table

Align

Sets the alignment of the table in relation to a bounding rectangle.

· Horizontal

Left, Center, Right.  This parameter can be useful when inserting a table into paragraph text or

multiline text. When inserting a table as a separate object, the bounding rectangle is

automatically adjusted to the size of the table, so changing this parameter has no effect.
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· Left offset

Available with left alignment. Sets the value of the margin from  left border of a bounding

rectangle.

Cell Interval

Distance between adjacent table cells.

· Horizontal

· Vertical

Default Cell Fields

The offset of the cell content from cell border.

· Horizontal

· Vertical

Disable text input outside of Table

If this checkbox is disabled, then it is possible to enter multiline text within table's bounding rectangle

outside of table cells.
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Row

Size

· Height

Sets the height value of the row containing the selected cells. If the checkbox is disabled ,

then the default height is used for the selected row. If multiple lines are selected, then the

checkbox is in the intermediate state . When the checkbox is enabled , the entered height

value will be applied to all selected rows.

· Mode

Specifies how to apply the entered line height value if it is less than the font height.

o Minimum - the height value that minimally accommodates the current font is applied;

o Exact - the entered value is applied regardless of whether the font will fit in such a height;

o Multiple - a multiple of the entered value is applied, minimally accommodating the current

font.

Parameters 

· Allow wrap

Allows you to transfer lines containing selected cells from one rectangle of text to another,

and therefore from one page to another (in the case of creating a table or using a ready-made

table in a paragraph text).
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Cell

Size

· Width

Sets the width value of the selected cells.

Text Alignment and Direction

· Vertical justification

Sets the alignment mode of the cell contents relative to its height.

o Top

o Center

o Bottom

· Direction

Defines the method of filling the cell.

o Normal

o From Bottom to Top

o From Top to Bottom

o Upside Down
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Fields

Controls the application of the margins of the contents of the current cell from its borders. If the

checkbox is disabled , then the default margin values are used for the selected cells. If the checkbox

is in the intermediate state , then different margin values are used for the selected cells. When the

checkbox is enabled , the entered margin values will be applied to all selected cells.

· Horizontal

· Vertical

Fill

Controls the application of cell fill. If the checkbox is disabled , then the fill is not applied (the cell is

transparent). If the checkbox is in the intermediate state , then different fill colors are used for the

selected cells. When the checkbox is enabled , a fill with the selected color will be applied to all

selected cells.

· Color

Sets the fill color of the current cell. The color is selected from the drop-down list, or from the

catalog, similar to the one described in the Color section.
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Borders

This tab is used to set the color and thickness of the cell border lines.

There is a symbolical image of a table on the left side of the tab. The image represents the upper,

lower, left and right borders of the selected set of cells, as well as the borders between the cells.

Regardless of the actual number of borders between cells in the selected set, in the image, all vertical

borders between cells are represented by the single vertical line, and all horizontal borders are

represented by the single horizontal line. Callouts connect the borders on the image to the controls

located on the right side of the tab. The same sets of controls are available for each border type,
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grouped in one row. Thus, the following correspondences are established between the boundaries of

the selected set of cells and the controls (from top to bottom):

· first row - upper border of a set of cells;

· second row - horizontal borders between cells in a set;

· third row - the lower border of a set of cells;

· fourth row - the right border of a set of cells;

· fifth row - vertical borders between cells in a set;

· sixth raw - the left border of the set of cells.

The following controls are available for each border type:

1 - Enables/disables this type of borders.

2 - Resets the color to the default value.

3 - Color selection from the drop-down menu

4 - Color selection from catalog.

5 -The thickness of the lines. If the value is set to [Default], the thickness is taken from the

Document Parameters (Document Parameters > Page > Lines > Lines > Thick Lines).

6 - Double line. Instead of a solid line of a given thickness, a double line of the same total

thickness is used. The thickness of each of the components of the double line is equal to 1/3 of

the total thickness.

String Text

String text can be created using the following automenu option within the Text command:

<D> Create string text

String text may contain any number of lines and any number of characters within the line. When

inputting the text content, press <Enter> or <Shift>+<Enter> for adding a line.

String text always lays within a single bounding rectangle. Size of a rectangle is not fixed. It expands

or shrinks depending on the size of text content. When adding the content to a current line, the

rectangle expands horizontally, when adding new lines - vertically. The direction of expansion or

shrinkage depends on the selected position of text in relation to its anchor point. 

Text content is inputted in the Contents tab of the text parameters dialog or in the crippled version of

the text editor. Elements insertion capabilities are limited compared to other types of text.

The font parameters dialog and paragraph parameters dialog are not available for string text,

therefore such parameters can not be customized individually for different parts of the same text. Font
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parameters and line spacing can be customized for the whole text at once using the Font tab of the

text parameters dialog. 

Unlike other types of text, string text can be split line by line into several texts using the editing

command.

Creating a string text

Upon selecting a string text option in the automenu of the Text command, you need to define an

anchor point in one of the ways described in the Position and Orientation of Text section. Upon

defining an anchor point, the creation of text gets finished and the system switches to editing the

created text. However, the usual mode of editing the text content in the view window is not available

for string text.

By default, upon defining an anchor point, the Contents tab of the text parameters dialog gets

opened. You can type in the text content there. Unlike other types of text, when inputting the content

of a string text, there are no automenu options and no contextual menu of text content available. If

you need to insert some elements into text, use the regular contextual menu. The text input box in the

Contents tab is essentially the same as any other input box, which you may encounter in other T-FLEX

CAD windows. Therefore it has the standard set of commands available in the contextual menu. More

information can be found in the Contextual Menus of Input Boxes section.

Optionally, before defining an anchor point, you can open the text parameters dialog and disable the

Force Parameter dialog box for each new text created checkbox. In such case, upon defining an

anchor point, the text editor gets opened instead of the Contents tab. However this version of editor

lacks most its capabilities. Clicking  in the text input box of such editor invokes the same

contextual menu as in the Contents tab. Compared to the Contents tab, the only additional

capabilities of said editor are the  Load and  Save buttons, that allow importing/exporting text

content using .txt files.
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Upon clicking ОК, the editing of the current text gets finished and the system proceeds to creating the

next text. If text has no content, an empty text object is not created.

See Also:

· Position and Orientation of Text

· Parameters Dialog of Text

· Contextual Menus of Input Boxes

Position and Orientation of Text

Upon selecting a type of text to be created, you need to define its anchor point. For  multiline

text,  paragraph text and  table an icon indicating the selected type gets displayed near the

cursor. For string text a preview of its bounding rectangle starts following the cursor. Size of the
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bounding rectangle preview depends on the font size. The cross on the preview indicates the anchor

point. Position of the rectangle in relation to the anchor point depends on the justification parameters

set in the text parameters dialog.

Preview of the string text with various justification parameters

Position of a multiline text, table and string text on a drawing page or on an active workplane is

defined by a single anchor point.

Position of a paragraph text's bounding rectangle is defined by two anchor points that form its

opposite angles. A single paragraph text may have multiple bounding rectangles, and therefore

multiple anchor points.

Anchor points could be defined in the following ways

· pointing an arbitrary position with the mouse;

· typing in coordinates;

· selecting a 2D node.

If a drawing view is active, when creating a text, then said text belongs to said view and an anchor

point is defined in view's coordinate system. If there's no drawing view active, when creating a text,

then said text belongs to the whole drawing page and an anchor point is defined in page's coordinate

system.

When defining an anchor point, a string text can be attache to a construction line (straight or circle).

Position of text in relation to its anchor point can be customized for all types of text.

A text is placed horizontally by default. However, you can set a rotation angle using the parameters

dialog prior to text creation. Further a multiline text, paragraph text and table can be moved or

rotated using manipulators, while a string text can be moved by mouse or rotated using the

parameters dialog. 

 

Defining an anchor point by pointing an arbitrary position with the mouse

Upon selecting a type of text to be created, move the cursor over the necessary position on a drawing

or WP and then click  or press <Enter>. This is the easiest way of defining an anchor point, but it

lacks the precision.

Defining an anchor point by typing in coordinates

Upon selecting a type of text to be created, use the following automenu option:

<A> Set absolute coordinates 

Then click  on a drawing or an active workplane. The Location dialog appears, where you can see

X and Y coordinates of a clicked point. Edit coordinate values as required and press OK or <Enter>.

An anchor point will be defined by said coordinates.
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When editing a string text, its anchor point's coordinates can be changed using the parameters

dialog.

Using a 2D node as an anchor point

Following objects can be selected as an anchor point

· an existing 2D node;

· joint of graphic lines belonging to a 2D projection;

· intersection of construction lines (a 2D node will be created automatically at the selected

point);

· joint or intersection of graphic lines belonging to a 2D fragment (a 2D node will be created

automatically at the selected point).

Upon selecting a type of text to be created, click  the necessary object. The selected object

becomes an anchor point of a text, so, upon further changes in object's position, the position of text

will change accordingly. 

Alternatively, you can use the following automenu option:

<N> Set relation with Node

Upon activating the option, click  anywhere on the drawing or active WP. The system will

automatically detect the nearest existing 2D node or joint/intersection of graphic lines belonging to a

2D fragment and use it as an anchor point.

Regardless of the way of selecting a node, following actions happen upon selection:

· In case of creating a multiline text or table, the system automatically creates a text at the at

the selected node and switches to text content editing mode. 

· In case of creating a paragraph text, the system switches to defining the next anchor point.

· In case of creating a string text, the system switches to defining horizontal and vertical offsets

between the anchor point and the selected node. The preview of bounding rectangle

continues following the cursor. An auxiliary line connects the selected node to the cross-

shaped preview of the anchor point. Click  at the necessary location to define offsets. As

offsets are defined, the system switches to text content inputting.
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Offsets can be later edited using the text parameters dialog.

Orienting text along a construction line

String text can be oriented along a construction line (straight or circle) using following automenu

options:

<L> Set relation with Line

<C> Place Text around Circle

Graphic lines as well as construction lines other than straight and circles could not be used for

orienting a text.

Upon activating one of the aforementioned options, move the cursor over a line of suitable type. The

line gets highlighted in green. Click  to select the line. Next you need to define an anchor point in

one of the ways described above. The selected line only affects text orientation without affecting its

position. 

Text characters are placed normal to the selected line. The system automatically applies one of the

two possible solutions. If the applied solution is not acceptable (the text is upside down), then you

need to call the text parameters dialog and perform one of the following actions in the Style tab: 

· Change the Rotation angle, in case of orienting the text along a straight line;

· Change the Vertical Justification to an opposite in case of orienting the text along a circle.

Position of text in relation to its anchor point

Before defining an anchor point for any type of text, you can call text parameters dialog using the

following automenu option:
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<P> Set Text Parameters

Among other parameters in the Style tab of the dialog there's the Justification group of parameters.

This group contains drop-down list, where you can select Horizontal and Vertical positioning of the

text in relation to its anchor point. The figures below show the examples of positioning the string text.

For multiline text or table the combination of parameters selected in this dialog enables the

corresponding automenu option. For paragraph text this parameters have no effect.

· Horizontal 

Left Center Right Left&Center Right&Center

The figure represents combinations of various horizontal justification options 

with the Upper Limit vertical justification 

· Vertical 

Lower Limit Lower Base Center Upper Base Upper Limit

The figure represents combinations of various vertical justification options 

with the Center horizontal justification 

After creating the text, these options remain accessible in the parameters dialog for the string text

only.



T-FLEX CAD 17 Help

710

When editing the content of multiline text or table, an automenu option indicates the applied method

of positioning the text in relation to its anchor point. You can switch to another option in one of the

following ways:

· Click and hold  a currently displayed option, until the drop-down menu appears. Then

select the necessary option in the drop-down menu. 

· Click  a currently displayed option once in order to switch to the next available option.

Following options are available:

Left Top

Center Top

Right Top

Left Center

Center

Right Center

Left Bottom

Center Bottom

Right Bottom

Rotating a text using its parameters dialog

Before defining an anchor point for any type of text, you can call text parameters dialog using the

following automenu option:

<P> Set Text Parameters

Among other parameters in the Style tab of the dialog there's the Rotation angle. It's an angle at

which text is rotated about a horizontal axis. Measured in degrees. Positive values correspond to

counterclockwise rotation, negative - clockwise. In cases where text is oriented along a construction

line, such line will be used as rotation axis instead of horizontal.

After creating the text, this option remain accessible in the parameters dialog for the string text only.

Moving and rotating a text using manipulators

When editing the content of any text excluding the string text, if the text is not attached to a node,

following manipulators are displayed at upper angles of a bounding rectangle:

 - move;

 - rotate around an anchor point.
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Move the cursor over the necessary manipulator. As the cursor changes appearance to  or , click

and hold , while moving the cursor. The text will move or rotate following the cursor. Establish the

necessary position of the text and release .

 

Moving a string text

In order to move a string text, first move the cursor over it. As the pink frame and the square anchor

point marker appear, you can start moving the text in one of the following ways:

1. Click  within the frame or at the anchor marker. The blue contour of text's bounding

rectangle will start following the cursor. Establish the necessary position of the text and click

 again. The text will move to the selected position.

2. Click and hold  within the frame or at the anchor marker and start moving the mouse

without releasing . The text will start following the cursor.  Establish the necessary

position of the text and release . Moving the text in such way launches the Move with

Translation mode of the 2D elements transformation command. Therefore, you can use any

options available in said mode or switch to another transformation mode. In order to

customize the transformation command' parameters, move the cursor outside the active view

window and release . From now on you won't need to hold  anymore - the text will

follow the cursor until you click  in a view window again.

Additionally you can edit anchor point's coordinates in the string text parameters dialog.
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Contextual Menu of Text Content

When editing the contents of any text types other than string, pressing  within the bounding

rectangle brings up the following contextual menu:

The set of commands available in the menu depends on which element of the text content is selected

when the menu is called, as well as on the presence of elements of a certain type in the current text. To

call the command, hover the cursor over it and click . For some commands, the following ways of

calling from the keyboard are additionally available:

· Hotkeys or key combinations

If a hotkey or key combination is available for the command, it is displayed on the right side

of the menu bar. Calling commands in this way is also possible outside of this menu.

· Quick selection keys

If any letter of the command name in the menu is underlined, then you can call this command

by pressing the appropriate key. This method of calling works only when the menu is displayed

on the screen. Different language versions use different shortcut keys. In some cases, different

commands may have the same quick selection key. E.g. on the image above you can see that

the <P> key is used for three commands at once: Paragraph, Paste and Parameters. In this

case, pressing a key does not trigger a command, but only highlights its line in the menu.

Repeated keystrokes will sequentially switch the highlighting between these three commands.

After the necessary command is highlighted, you need to press <Enter> to call it.

The following items may be available in the menu:

Font... <F9>

Opens the font parameters dialog for the selected content. If no content is selected, the

parameters are applied to the current position of the text cursor.

Paragraph... <F10>

Opens the paragraph parameters dialog for the selected content. If no content is selected, the

parameters are applied to the current position of the text cursor.

Cut <Ctrl>+<X>
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Cuts the selected content to the clipboard. If the content is not selected, then the command is

unavailable.

Copy <Ctrl>+<C>

Copies the selected content to the clipboard. If the content is not selected, then the command is

unavailable.

Paste <Ctrl>+<V>

Pastes the content of clipboard into text. If the clipboard is empty or contains unacceptable type

of data, then the command is unavailable.

Delete <Del>

Deletes the selected content. If the content is not selected, then the command is unavailable.

- Select All <Ctrl>+<A>

Selects the entire contents of the current text

- Insert

This item contains a drop-down menu in which the following commands are available:

Text <F6>

See the Inserting Text from Dictionary section.

Hyperlink <Alt>+<F6>

See the Inserting Hyperlinks into Text section. Allows you to insert links to web pages, local

files, macros, 2D and 3D elements, as well as pages of the current document.

Variable... <F8>

See the Inserting Variables and Expressions into Text section. Allows you to insert the value

of a text or real variable into the text. Using this command, you can either select one of the

variables existing in the current document, or create a new one.

Product Composition Position Number... <Alt>+<F7>

See the Inserting Position Numbers into Text section. Allows you to insert an entry position

from the product composition, if there is one in the current document.

Position Number (T-FLEX DOCs)... <Alt>+<F8>

See the Inserting Position Numbers into Text section. This command is only available in the

T-FLEX DOCs integration mode. Allows you to insert the position of the entry of the DOCs

product structure into the text.

BOM Position Number... <Alt>+<F10>

See the Inserting Position Numbers into Text section. Allows you to insert into the text the

position of a record from a BOM created in the format of previous versions of T-FLEX CAD,

if there is such a BoM in the current document.

Technical Requirements <Alt>+<F11>

See the Inserting Technical Requirements into Text section. Allows you to insert the

technical requirements of the document into the text if they are available in the current

document.

Index <Alt>+<F12>

See the Inserting Indexes, Fractions and Radicals into Text section. Allows you to insert a

pair of indexes (upper and lower) into the text with the default font scale.

Index...
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See the Inserting Indexes, Fractions and Radicals into Text section. Allows you to insert a

pair of indexes (upper and lower) into the text and adjust the font scale in a special dialog

box.

Fraction <Ctrl>+<F12>

See the Inserting Indexes, Fractions and Radicals into Text section. Allows you to insert a

fraction with the default font scale into the text.

Fraction...

See the Inserting Indexes, Fractions and Radicals into Text section. Allows you to insert a

fraction into the text and adjust the font scale in a special dialog box.

Radical

See the Inserting Indexes, Fractions and Radicals into Text section. Allows you to insert a

radical with the default font scale into the text.

Radical...

See the Inserting Indexes, Fractions and Radicals into Text section. Allows you to insert a

radical into the text and adjust the font scale in a special dialog box.

Roughness... <Ctrl>+<F8>

See the Inserting Roughness, Formlimits, Fragments and Pictures into Text section. Allows

you to insert a roughness symbol into the text.

GD&T... <Ctrl>+<F9>

See the Inserting Roughness, Formlimits, Fragments and Pictures into Text section. Allows

you to insert GD&T Formlimits into the text.

Fragment... <Ctrl>+<F10>

See the Inserting Roughness, Formlimits, Fragments and Pictures into Text section. Allows

you to insert a 2D fragment into the text.

Picture... <Ctrl>+<F7>

See the Inserting Roughness, Formlimits, Fragments and Pictures into Text section. Allows

you to insert a picture into the text. 

- Show

This item contains a drop-down menu in which the following commands are available:

Variable names

See the Display Options of Text Content Editing section. If this option is active (the icon is

highlighted ), then when editing the text content, their names are displayed instead of

the values of variables inserted into the text. Values are always displayed outside of the text

content editing mode, regardless of the state of this option.

Non-printing Chars

See the Display Options of Text Content Editing section. If this option is active (the icon is

highlighted ), then when editing the text content, non-printable characters are displayed,

which facilitate the visual perception of text formatting. These characters are not displayed

outside of the text content editing mode, regardless of the status of this option.

- Symbol

This item contains a drop-down menu in which the following commands are available:

Diameter

Inserts a symbol .
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Degree

Inserts a symbol °.

Plus Minus

Inserts a symbol ±.

Special...

 Allows you to insert a character from the basic set.

Other...

 Allows you to insert a character from the full set.

Check Spelling <Ctrl>+<F11>

See the Check Spelling section.

Table Properties...

Calls the table properties dialog. The command is available if the text cursor is located in one of

the table cells.

Parameters...

Calls the dialog of the parameters of the element inserted into the text (roughness, tolerance, 2D

fragment, picture). Calls the expression constructor for the variable.

Variables

Calls the external variables editor of the fragment inserted into the text.

Size and Position...

See the Inserting Roughness, Formlimits, Fragments and Pictures into Text section. Opens a

dialog where you can adjust the size and position of the inserted element relative to the text

font.

Edit Hyperlink

Calls the command to edit the hyperlink inserted into the text.

Open Hyperlink

Navigates through the hyperlink inserted into the text.

Copy Hyperlink

Copies the hyperlink inserted into the text to the clipboard.

Delete Hyperlink

Deletes the hyperlink inserted into the text.

Text Editor

The text editor is designed for entering and editing the content of multi-line texts. When working in a

text editor, all cursor movement keys and text string editing functions are available. When editing text,

you have the opportunity to operate both individual lines of text and entire blocks of lines.
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Cursor movement keys and line editing functions:

<Home> Move the cursor to the beginning of the line.

<End> Move the cursor to the end of the line.

<Right> Move the cursor a position to the right.

<Left> Move the cursor a position to the right.

<Ctrl>+<Right> Move the cursor on the word to the right.

<Ctrl>+<Left> Move the cursor to the word to the left.

<BackSpace> Delete the character in front of the cursor.

<Delete> Delete the character along with the cursor position.

<Insert> Turn on/Turn off the insert mode.

Available options when working with string text in a text editor:

<Ctrl>+<W> File export.

<Ctrl>+<R> File import (.txt format).

<Alt>+<F4> Exit the text editor.

Editing functions:

<Ctrl>+<X> Cut the marked block of text.

<Ctrl>+<C> Copy the marked text block.

<Ctrl>+<V> Insert the marked block of text.
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<Del> Delete. 

<Ctrl>+<A> Select the entire text.

Available options when working with the paragraph text editor:

All available options for working with the editor are divided into separate groups (File, Edit, View,

Insert, Format).

To call the required option, click  on the necessary group and select the necessary option. You can

also use the keyboard shortcut listed in the options list.

The File option group allows you to:

work with external format files

· T-Flex Paragraph Text -  *.TFT

· Rich Text  Format        -  *.RTF

· Text  Document           -  *.TXT

<Ctrl>+<N> Open a new file

<Ctrl>+<O> Open an existing file

<Ctrl>+<S> Save text to file

· finish working in the editor

· with text saved;

· without saving the text.

The Edit option group allows you to:

<Ctrl>+<X> Cut the marked block of text.

<Ctrl>+<C> Copy the marked text block.

<Ctrl>+<V> Insert the marked block of text.

<Del> Delete. 

<Ctrl>+<A> Select the entire text.

The View option group allows you to:

· set the panel display flag (standard, formatting);

· set the status bar display flag;

· set the scale of the text image;

· set the flag for displaying non-printable characters;

· set the flag for displaying variable names or their values;

· set the double buffering flag.

The Insert option group allows you to use the features described in the Text section.

The Format options group allows you to:

· set font;

· format a paragraph;

· set the width of the edit field;

· set the units of measurement.

Keyboard shortcuts in a text editor:

<F5> Finish the input (except for the variable editing mode).

<F6> Dictionary.
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<F8> Expression constructor. Link to the variable of the current drawing (only in variable

editing mode).

<F9> Font (except for the variable editing mode).

<F10> Paragraph.

<F11> Edit in a separate window (only from the T-FLEX window; except for the variable

editing mode). Finish typing (only in the window editor).

<F12> Insert a table (except for the variable editing mode).

<Ctrl-F2> Non-printable symbols.

<Ctrl-F3> Variable names (except for the variable editing mode). Buttons for selecting values

from the list (only in variable editing mode).

<Ctrl-F5> Rectangle parameters (only from the T-FLEX window and only for paragraph text;

except for the variable editing mode). The anchor point of the rectangle (only from the T-FLEX

window and only for multiline text; except for the variable editing mode).

<Ctrl-F8> Insert a roughness (except for the variable editing mode).

<Ctrl-F9> Insert tolerance (except for variable editing mode).

<Ctrl-F10> Insert a fragment (except for the variable editing mode).

<Ctrl-F11> Insert an index (except for the variable editing mode).

<Ctrl-F12> Insert a fraction (except for the variable editing mode).

<Alt-F2> Insert the diameter symbol (except for the variable editing mode).

<Alt-F3> Insert the degree symbol (except for the variable editing mode).

<Alt-F4> Insert a plus-minus symbol (except for the variable editing mode).

<Alt-F5> The symbol table (except for the variable editing mode).

<Alt-F8> The Table toolbar (only from the T-FLEX window; except for the variable editing mode).

<Alt-F9> Insert a special character (except for the variable editing mode).

<Ctrl-B> Bold font (except for variable editing mode).

<Ctrl-I> Italics font (except for variable editing mode).

<Ctrl-U> Underlined font (except for variable editing mode).

<Ctrl-L> Left alignment (except for variable editing mode).

<Ctrl-T> Center alignment (except for variable editing mode).

<Ctrl-H> Right alignment (except for variable editing mode).

<Ctrl-J> Width alignment (except for variable editing mode).

<Ctrl-M> Numbering (except for the variable editing mode).

<Ctrl-A> Select all.

<Ctrl-X> Cut.

<Ctrl-C> Copy.

<Ctrl-V> Paste.

<Shift-Delete> Cut.

<Shift-Insert> Paste.

<Ctrl-Insert> Copy.

<Shift-Ctrl-Пробел> An unbroken space (except for the variable editing mode).

<Shift-Ctrl-'-'> An unbroken hyphen (except for the variable editing mode).

<Shift-Enter> Line feed.

<Esc> Cancel the input (except for the variable editing mode). Cancel changing variable

values (only in variable editing mode).

<Enter> Confirm changes to variable values (only in variable editing mode).

<Tab>, <Shift-Tab> Moving through the cells of the table (except for the variable editing mode).

Moving through variables (only in variable editing mode).

<Ctrl-Tab> Tab entry in the table (except for the variable editing mode).

<Ctrl-N> New text (only in the window editor).
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<Ctrl-O> New text (only in the window editor).

<Ctrl-S> Save (only in the window editor).

<Ctrl> Rotation of the rectangle without binding (15 degrees) (only from the T-FLEX window;

except for the variable editing mode).

Display Options of Text Content Editing

When editing the content of text of any type except the string one, following auxiliary elements can

be displayed:

 Non-printable characters;

 Variable names.

Non-printable characters

Non-printable characters facilitate the visual perception of text formatting by designating spaces,

tabs, paragraphs, line wraps, etc. They are not printed. Non-printable characters are displayed only in

the text content editing mode in a 2D or 3D window, or in the text editor.

Within the text content editing mode the following command enables the non-printable characters

display:

Icon Ribbon

Text > Font > Show Unprintable Symbols

Keyboard Textual Menu

<Ctrl>+<F2>

This command is also available in the contextual menu of text content (Show   Non-printing

Chars)

Within the text editor this command is available in the Standard toolbar and in the drop-down menu

(View >  Non-printing Chars). 

When characters are displayed, the command's icon gets highlighted . In order to disable the

characters display, call the command again.

Variable names

When there's an expression inserted into text, an expression value is always displayed in text outside

the text content editing. When editing the text content, you may switch between displaying a value or
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a body of expression. In order to display a body of expression with variable names, mathematical

operations and functions, use the following command within the text content editing mode:

Icon Ribbon

Text > Font > Show Variable Names

Keyboard Textual Menu

<Ctrl>+<F3>

This command is also available in the contextual menu of text content (Show   Variable Names)

Within the text editor this command is available in the Standard toolbar and in the drop-down menu

(View >  Variable Names). 

When variable names display is enabled, the command's icon gets highlighted  and expressions are

shown in curly braces. In order to disable the variable names display, call the command again.

a=5; b=3

Inserting Elements into Text

When editing the text content, you can insert data from the clipboard or various special elements into

text. The position of the inserted element in the text is determined by the position of the text cursor at

the time of calling the insert command.

When editing the contents of string text, the input box contextual menu commands and keyboard

shortcuts specified in this menu are used for insertion. The insertion possibilities are limited in

comparison with other types of text.

For other types of text, the way elements are inserted depends on the content editing method used.

When editing the text content in a 2D or 3D view window, the automenu, the contextual menu of the

text content and the keyboard shortcuts shown there are used for insertion.

When editing the text content in the editor, the drop-down menu and the editor toolbars are used for

insertion. The editor does not specify keyboard shortcuts, but you can use most of the combinations

used in 2D and 3D view windows. The contextual menu of the text content in the editor has limited

functionality and allows you to insert only data from the clipboard.

To work with the clipboard in a 2D or 3D view window, the following automenu commands are used:

<Ctrl>+<X> Cut

<Ctrl>+<C> Copy
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<Ctrl>+<V> Paste

These commands are also available in the contextual menu of the text content.

When editing the contents of string text in the parameters dialog, these commands are available in

the input box contextual menu.

When editing the text content in the editor, these commands are available in the Standard toolbar, as

well as in the Edit section of the drop-down menu.

Insertion from the clipboard is not possible if the clipboard contains unacceptable type of data.

The commands for inserting various elements are described separately. It is possible to insert

following elements:

· Hyperlink

· Text from dictionary

· Special symbol

· Expression

· Position Number

· Technical requirements of the document

· Index

· Fraction

· Radical

· Roughness

· Geometric dimensioning and tolerancing (GD&T) formlimits

· 2D fragment

· Picture

Inserting Hyperlinks into Text

When editing the text content in a 2D or 3D view window, a hyperlink can be inserted using the

contextual menu command: Insert   Hyperlink <Alt>+<F6>. The command parameters are

displayed in the Parameters  service window.

When editing the text content in the editor, this command is available on the Standard toolbar, as

well as in the Insert > Hyperlink drop-down menu. The command parameters are displayed in a

separate dialog box.

The set of available command parameters is the same in both cases, the difference is only in the form

of the display.

 

After calling the command, you need to select the type of hyperlink. The following types are available:

 URL

 File
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 Objects 

 Dimension

 Page

 Macro

Next, you should set the necessary link parameters. The set of available link parameters depends on its

type. After the parameters are set, you should confirm the creation of the link using the automenu

option  <Ctrl>+<Enter> (when working in a 2D or 3D view window), or by clicking OK (when

working in the editor).

Text of the link

When creating links of all types except the  Dimension, the Text input box is available in the link

parameters. The link will be displayed in the drawing in the form of text typed into this input box.

Depending on the selected reference element, the system automatically suggest some text, but you

can enter any text from the keyboard instead of the automatically entered one.

If you select a part of the text before calling the link creation command, the selected text

automatically becomes the link text.

When displaying the drawing in electronic form, the text of the link is always displayed in blue and

highlighted with an underline (except for the text content editing mode in a 2D window).

When printing, as well as when editing the text content in a 2D or 3D window, the color and the

presence of an underline are determined by the font parameters.

When editing a previously created link, the Text field in is missing from its parameters. However, the

link text can be edited in the same way as regular text directly in a 2D window or in a text editor.

Working with created links

To follow the created link outside the text content editing mode, just click  on the link text.

To follow the created link in the text editor, press +<Ctrl> on the link text.

To follow the created link in the text content editing mode in a 2D or 3D window, use the command

 Open Hyperlink in the contextual menu.

To edit a previously created link in a 2D window, you need to switch to the mode of editing the

content of link's parent text object and use the command  Edit Hyperlink in the contextual menu.

To edit a previously created link in the text editor, click  on the link text and use the Parameters...

command in the contextual menu.

URL

A link to any network resource. Clicking on the link opens the resource in the default browser.
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When creating a hyperlink of this type, two input boxes are available:

· Address - the network address of the resource.

· Text.

File

Link to any local file. Clicking on the link opens a file in the program used by the operating system by

default to open files of this type, or opens the system application selection window.

When creating a hyperlink of this type, two input boxes are available:

· File - the local address of the file. The Open  button is available in the right side of the

input box, which invokes the drop-down list:

All files opened in the current session are available in the drop-down list (except those that

have not yet been saved to disk), as well as two commands:

o  Select 

Allows you to select a file on disk in the standard Windows Explorer window.
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By default, when selecting a file, only T-FLEX CAD documents (*.grs, *grb) are displayed.

However, you can create a link to any type of file. To display other file types, select the

necessary type or the All files (*.*) option in the drop-down list. Working with the Explorer

window is carried out in the same way as described in the Open Model section.

o  Select embedded...

Allows you to select a file from the list of internal (embedded) documents, if there are any

in the current document.
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· Text

Objects 

Link to any 2D or 3D element or set of elements. 

A text containing a link can be located:

· In a drawing view (including 2D projections)

Following such link is possible only when this view is activated.

· On a workplane/surface

Following such link is possible only in the mode of drawing on this WP or from a page of this

WP in a 2D window.

· On a drawing page outside drawing views

Following such link is possible only when none of the drawing views located on the same page

is active.

Reference elements can be located:

· In the 3D scene

When selecting a first element in the 3D scene, subsequent elements can only be selected in

the 3D scene.

· On a same workplane/surface

When selecting a first element on a WP, the selection of subsequent elements is possible only

on the same WP.

· On a same drawing page outside of drawing views

When selecting the first element on a drawing page outside of drawing views, the selection of

subsequent elements is possible only on the same page outside of drawing views.

· In a same drawing view (including 2D projections)

When selecting the first element in a drawing view, the selection of subsequent elements is

possible only in the same view.

If you are creating a link on a page that contains several drawing views/projections, and the text

containing the link does not belong to any of them, then you should keep in mind that:
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· Selecting a first reference element on a projection located on the same page as the link text

will make it impossible to select subsequent elements. To select a set of elements in such

cases, switch to the page of the corresponding projection before selecting the first element.

· To select individual reference elements in drawing views that are not projections, switch to the

page of the corresponding view before selecting the first element. If you try to select an

element in the view without switching to its page, the entire view will be selected as a

reference element.

If you are creating a link on a page that contains several drawing views/projections, and the text

containing the link belongs to one of them, then you should keep in mind that:

· Creating links to elements that do not belong to any of the drawing views/projections is not

possible in this case.

· To select reference elements in another drawing view/projection, switch to the page of this

view/projection before selecting the first element. Otherwise, elements of other

views/projections will not be available for selection.

Following a link centers the camera in a 2D or 3D window (depending on where the reference

elements are located) so that all the reference objects are visible.

At the same time, if the view window suitable for displaying corresponding type of reference elements

is not open at the time of following a link, than a new view window will be automatically opened in a

new document window.

If the reference elements are located on another page of the drawing relative to the link itself, the

view will automatically switch to this page.

If the reference elements are located in the drawing view/projection, then a separate page of this

view/projection will be opened, even if the link itself belongs to the same view/projection.

When creating a hyperlink of this type, two input boxes are available:

· Objects - the list of reference elements. After activating this list, you can select the necessary

objects in a 2D or 3D window using . When selecting, pay attention to the active filters on

the filter toolbar. Using the buttons located to the right of the list, you can Expand ,

Collapse , or Clear  the list, or Delete Element from the List . Items in the list can be

selected using .

· Text

Dimension

A link to any of the dimensions available in the current document (in a drawing or in a 3D scene).

Following a link centers the camera on the selected dimension in the same way as objects link. Unlike

an objects link, dimension's nominal value, tolerance, deviations, or any of the possible combinations

of the listed parameters can be displayed as link text.
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When creating a hyperlink of this type, the following controls are available:

· Dimension input box 

Activating this box enables the dimensions selection filter on the filter toolbar, after which you can

select the necessary dimension in a 2D or 3D window. The name of the selected dimension, its ID

and the icon symbolizing the type of dimension are displayed in this box. Selecting the next

dimension cancels the selection of the previous one.

· Nominal, Tolerance, Deviations checkboxes

The parameters of the selected dimensions corresponding to the enabled checkboxes will be

displayed as the link text. In future, the link text is automatically updated when the selected

parameters are changed. To create a link, you must enable at least one of the checkboxes.

Page

Link to a page of the current document. Following a link opens the specified page, positioning the

camera in such a way as to fit the specified area of the page.

When creating a hyperlink of this type, the following controls are available:

· Page drop-down list

It is used to select a reference page. All pages of the current document belonging to the following

types are available in the list:  Normal,  Text,  Bill of Materials.

· input boxes for the X and Y coordinates of the First and Second corners

The first and second corners are used to set the area that determines the position of the camera

when following the link.

· Text input box.

Macro

A link to any of the macros available in the current document. Clicking on the link triggers the macro.
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When creating a hyperlink of this type, two input boxes are available:

· Macro

Displays the name of the selected macro. To select a macro, use the [...] button located on the right

side of the input box. This button opens a macro selection dialog similar to the one described in the

Debugging, Compiling and Running Macros section.

·  Text

Inserting Text from Dictionary

When creating drawings, you often need to add the same text several times on the same drawing or

repeat from a drawing to a drawing (such as, for example, technical requirements). T-FLEX CAD makes

a provision for this case by including in the installation a standard dictionary with a set of technical

requirements. The dictionary is based on file of *.xml format, represented by the file C:

\Users\User\AppData\Local\Top Systems\T-FLEX CAD 3D xx\Eng\TFDict.xml. The user can create

custom dictionaries or modify this standard dictionary by manually adding or deleting elements. To

create a new dictionary file, make a copy of the standard dictionary and save it under a different

name, and then modify as necessary. 

When editing the text content in a 2D or 3D view window, text insertion from the T-FLEX CAD

dictionary is performed using the following automenu command:

<F6> Insert text from Dictionary

This command is also available in the contextual menu of the text content:  Text... <F6>.

When editing the contents of lowercase text in the parameters dialog, this command is available in

the context menu of the input box.

When editing the text content in the editor, this command is available on the Standard toolbar, as

well as in the drop-down menu (Insert > Text...).

After calling the command, the dictionary window opens:
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1 - Main menu

2 - Toolbar (Main toolbar)

3 - Dictionary sections tree

4 - List of entries of the selected section

5 - The content panel (content of the selected entry)

6 - Status bar

The tree structure of the sections of the current dictionary is displayed in the left part of the window. In

the upper right part of the dictionary window, a list of entries of the selected section is displayed in

tabular form. For each entry in the list, the Name and Contents are displayed. The Contents is the text

that is directly inserted into the drawing. The Name is usually a short version of the contents and

serves to identify entries in the dictionary. In the list of entries, the Contents is displayed as a single

string. The newline characters are shown in the form of the code \n. In the lower right part of the

dictionary window, the Contents of the selected entry is displayed in the form in which it is inserted

into the drawing. 

To search for the necessary entry, you can use the search bar located on the right side of the toolbar.

Enter your search query and click . The result depends on which part of the window is active at the

time the search is launched. The active part of the window can be determined by the color of the

highlighting of the selected element. If the sections tree is active, then the search is performed in the

tree through headers. If the list of section entries is active, the search is performed through the

contents of these entries. If the contents of the record is active, then the search is not performed. As a

result of the search, the first found result is selected in the corresponding window. By pressing the 

 button sequentially, you can switch between the results.

You can insert the content of the record into the text in the following ways:
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· By double-clicking  its row in the list of entries. 

· By clicking the  Insert into editor button in the toolbar.

In both cases, the pasted text is also copied to the clipboard. In addition, the text of the entry selected

in the list can be copied to the clipboard by clicking the  Copy  button in the toolbar.

Configuring the Dictionary Window interface

By default, after the content of the entry is inserted into the text, the dictionary window automatically

closes. If you activate the Keep Visible  option on the toolbar, the dictionary window will not be

closed automatically. An open dictionary window does block working with other T-FLEX CAD windows

and commands. Additionally, you can activate the Always on Top  option on the toolbar, which

fixes the dictionary window above all other windows. The Keep Visible  and Always on Top 

commands are also available in the View section of the main menu. There you can also turn on/off the

display of the Status bar and Toolbar. In addition, you can turn on/off the display of the Main Menu

and the Main Toolbar in their contextual menus. You can close the dictionary window using the

standard button  in the upper right corner of the window or using the Exit command in the File

section of the main menu.

Editing the content of an entry

The content of the record can be stored as formatted or unformatted text. The formatted text is

displayed in the dictionary and inserted into the drawing with customizable font and paragraph

parameters. In addition, various elements can be inserted into it in the same way as it is done for the

text in the drawing. The unformatted text is inserted with the parameters that are set for the current

position of the text cursor in the drawing, and is displayed in the dictionary in the same font as the

elements of the T-FLEX CAD interface.

Unformatted text can be edited directly on the content panel in the dictionary window.

The formatted text is edited in the text editor. To open the editor for the selected entry, click 

 on the content panel or use the Edit Formatted Text  button on the toolbar

Unformatted text can be converted to formatted text by clicking the Insert Formatted Text  button

on the toolbar.

Formatted text can be converted to unformatted by clicking the Delete Formatted Text  button on

the toolbar.

Editing a dictionary

To work with dictionary files, use the following commands available in the File section of the main

menu:

·  Open

Opens another dictionary file, closing the current one. This command is also available in the

toolbar.

· Add from...

Adds the contents of another dictionary to the current dictionary.

· Save as...

Saves the current dictionary under a different name.

· Close

Closes the current dictionary, leaving an empty dictionary window open.

To work with sections and entries of the current dictionary, use the following commands available in

the toolbar:
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·  Add

Adds a new section to the current level of the dictionary tree or a new entry to the current

section. The result (adding a section or entry) depends on which part of the dictionary window

is active at the time the command is called. This command is also available in the context

menu of sections in the tree (Create > Folder - creates a section, Create > Text - creates an

entry). In addition, you can create an entry from the context menu of the empty part of the list

of entries (Create).

·  Delete

Deletes a section highlighted in the tree or an entry highlighted in the list, depending on which

part of the dictionary window is active at the time the command is called. This command is

also available in the contextual menu of the elements of the dictionary tree and the list of

records.

·  Rename

· Renames the section highlighted in the tree or the entry highlighted in the list, depending on

which part of the dictionary window is active at the time the command is called. This

command is also available in the contextual menu of the elements of the dictionary tree and

the list of records.

·  Sort

Sorts by name entries in the list or sections at the current level of the tree. This command is

also available in the contextual menu of the blank part of the list of entries. In addition, you

can sort the entries in the list by Name or Content by clicking  on the column header in the

list.

·  Move Up and  Move Down

Moves the selected entry up/down the list or the selected section along the current level of the

tree. These commands are also available in the contextual menus of entries in the list (Move

Up, Move Down). In addition, you can move records and sections by dragging them with the

mouse while clamped .

·  Paste

Replaces the contents of the selected record with the contents of the clipboard, if there is a

suitable data type.

Working with external databases

The following commands are available on the toolbar of the dictionary window:

 Add reference database

This command is also available in the contextual menu of the dictionary tree (Create > Reference

Database). Includes the contents of an external database (*.accdb) into the dictionary. After calling the

command, a file selection window appears on the screen, allowing you specify the required database.

Note that adding a section with the selected database occurs at the current level of the dictionary

structure. After creating the database section, you can rename it (by default, the path and name of the

database file are used as the section name) or move it to another level. Unlike other dictionary

sections, the contents of the linked database cannot be edited and converted to formatted text. The

next step is to set the database parameters (when adding a base this dialog appears automatically).

 Edit database parameters

The dialog window is shown in below:
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The left side of the dialog window contains the list of all fields of the selected table in the database

(the table is selected in the Table drop-down list). In the right side of the dialog window the user

places the fields to be used in the dictionary. To add a field, select it in the left pane and press the

[>>] button. To remove a field select in the right list and press the [<<] button. The Add All and

Delete All buttons do this with all elements of the field list. The selected database fields will be

placed in the dictionary window in the order they were in the right side of the dialog. To modify a

field position, select it in the right side of the dialog and move within the list using the Up and Down

buttons. The SQL statement input box is provided for specifying the selection condition for the fields

and records in the database.

Inserting Special Symbols into Text

When editing text content, you can insert a special symbol into it in the following ways:

· using dedicated commands for inserting particular characters;

· from basic character map;

· from the full character map. 

Dedicated commands for inserting particular symbols

When editing text content in a 2D or 3D view window, the following commands are available in the

automenu:

<Alt>+<F2> Insert Diameter

<Alt>+<F3> Insert Degree

<Alt+<F4> Insert Plus-Minus

<Alt>+<F9> Insert Special

Non-breaking Space

Non-breaking Hyphen

Line Break

In addition, some of these commands are available in the context menu:

Symbol  Diameter;
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Symbol  Degree;

Symbol  Plus Minus.

When editing the text content in the editor, all of the aforementioned commands are available in the

Standard toolbar, as well as in the Insert section of the drop-down menu.

Regardless of which font is set for the current position of the text cursor, these commands insert

characters using the font set for the characters in the document parameters (Document Parameters >

Page > Symbols > Characters > Font). The default font is T-FLEX Symbol Type A. If you change the

font in the document settings, the font of previously inserted characters will also change. On the same

tab of the document parameters dialog, you can change the code of the characters inserted by the

commands for inserting diameter, degree and plus-minus. This may be required when using a font,

where codes for these characters differ from codes in the default font.

Basic Character Map

When editing the text content in a 2D or 3D view window, the following command is available in the

automenu:

<Alt>+<F9> Insert Special

It is also available in the contextual menu: Symbol   Special....

When editing the contents of string text in the parameters dialog, this command is available in the

contextual menu of the input field (Insert symbol... <Alt>+<F9>).

When editing the text content in the editor, this command is available on the Standard toolbar, as

well as in the drop-down menu (Insert > Special...).

Calling the command invokes the Insert Symbol dialog window:

The left part of the window contains the basic set of special symbols of the font set for the symbols in

the document parameters (Document Parameters > Page > Symbols > Characters > Font). The

default font is T-FLEX Symbol Type A. If you change the font in the document settings, the font of

previously inserted characters will also change.
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Select the necessary symbol by clicking  it. An enlarged image of the selected symbol and its Code

will be shown in the upper right part of the window. Just below is the Ignore font angle checkbox.

When this checkbox is enabled, the inserted symbol will always be displayed without an italic tilt, even

if you apply an italic style in the font settings. After the necessary symbol is selected, click Insert. The

dialog will close and the selected symbol will appear in the text.

Full Character Map

When editing the text content in a 2D or 3D view window, the following command is available in the

automenu:

<Alt>+<F5> Open Character Map

It is also available in the contextual menu: Symbol   Other...

When editing the text content in the editor, this command is available on the Standard toolbar, as

well as in the drop-down menu (Insert > Other...).

Calling the command invokes the Character Map window:

Select the font name In the Font drop-down list. The table will show all the characters of this font. Use

the scroll bar to move through the table.

Point  to the symbol in the table and click the Select button. The specified symbol will appear in

the Characters to copy input box, and the symbol code and its name (if the font contains symbol

names) will be displayed in the bottom line of the window. Thus, you can select the required number

of characters, and then click the Copy button (all characters in the field Characters to copy will be

written to the clipboard). After that, the table window can be closed or left open. An open symbol

table window does not block working with other windows and T-FLEX CAD commands. Next, in a 2D

window or text editor, use the cursor to indicate the position in the text where you want to place the
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contents of the clipboard, and use the Paste  command (<Ctrl>+<V>) to paste the selected

characters into the text.

When the Advanced view checkbox is enabled, the following controls appear at the bottom of the

Character Map window:

· A drop-down list in which you can select a Character set displayed in the table.

· The Go to Unicode field, which allows you to search for a character by its code. Place the

cursor in this field, click , enter the code from the keyboard and press <Enter>. The

corresponding symbol will be the first in the table, and all preceding symbols will be

unavailable. To return to the normal view of the table, enter the code 0 and press <Enter>.

· The Group By drop-down list. Select the grouping principle. The Group By window will

appear next to the character map window with a list of available groups. Only the symbols of

the selected group will be displayed in the character map window.
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· The Search for input box. Allows you to search for characters by name (if the font contains

symbol names). Enter a search query and click the Search button located to the right of this

field. The table will show the search results.

Inserting Variables and Expressions into Text

You can insert an expression into the text. An expression can consist of a single variable, or use

multiple variables and/or constants in various mathematical functions. As a result, the value of the

expression will always be displayed outside of the text content editing mode. In the text content

editing mode (except string text), you can switch between displaying the value of the expression, and

displaying the body of the expression with the names of variables and the designations of the

functions used. To switch the display, use the  Variable Names command.

There are the following ways to insert expressions into text:

· Using the Expression Constructor

This method is available for all types of text.

· By typing in an expression body from the keyboard without calling additional commands

This method is only available for string text.

The values of variables inserted into the text (except string text) can be edited directly in the text in

the drawing.

Inserting using the Expression Constructor

When editing the text content in a 2D or 3D view window, variables and expressions are inserted into

the text using the automenu:

<F8> Insert Variable

Additionally, this command is available in the contextual menu (Insert   Variable... <F8>).

When editing the contents of string text in the parameters dialog, this command is available in

contextual menu of the input box (Expression Constructor... <F8>).

When editing the text content in the editor, this command is available in the Standard toolbar, as well

as in the drop-down menu (Insert > Variable...).

After calling the command, the  Expression Constructor dialog window opens. Enter the required

expression and click OK. If only existing variables are used in the expression, then the insertion will be

completed. If new variables are used in the expression, then, after clicking OK in the constructor, the

Variable value windows will open sequentially for each of the new variables. After setting the values

of all variables, the insertion will be completed.



Drawing Creation

737

In addition to the features that are standard for the expression constructor when inserting a variable

into text (except for string text), additional controls are available in the constructor that allow you to

configure the ability to edit a variable in the text after insertion:

· Editable as field;

· Value List;

· Highlight when edited.

In addition, the Precision parameter is available at the bottom of the constructor, which determines

the number of decimal places displayed in the text (for real expressions).

To call the expression constructor for an expression already inserted into the text, use the 

 Parameters... command in the contextual menu.

Editing values of variables in the text

Editing variables in the text is not available for string text.

If, when inserting an expression consisting of a single variable into the text, the Editable as field

checkbox is enabled, then later it will be possible to edit the value of this variable directly in the text

using the  Edit Variables command. This command can be called outside of the text content

editing mode in two ways:

· by clicking  on the text and selecting  Edit Variables in the contextual menu;

· just by clicking  on the value of the variable if transparent editing of 2D elements is

enabled.
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Enabling the  Editable as field checkbox and then calling the Edit Variables command is also

possible for expressions consisting of several variables, but the values of the variables will not be

edited.

If a list of values has been created for a variable, then this list can also be used in the  Edit

Variables command. To select a value from the list, a button  is displayed next to the variable. The

size of the button is determined by the font size of the text.

The position of the button  relative to the value of the variable is determined by the option selected

in the Value List drop-down list, when inserting the variable:

· Right of text

 

· Left of text border

· Right of text border

 

· None

If there is some other content after the variable in the text, then the Right of text option is used

instead of the options Left of text border and Right of text border.

If the selected option assumes the presence of the button , then, upon launching the  Edit

Variables command, you can enable/disable the display of the button  by activating/deactivating

the automenu option:
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<Ctrl>+<F3> Show "Select from List" buttons 

This option is also available in the contextual menu called by pressing  on the button .

If you enable the Highlight when edited checkbox, when inserting an expression into the text, then the

expression will be highlighted upon launching the  Edit Variables command. The highlighting color

can be selected to the right of this checkbox. Color selection is carried out in the same way as

described in the Color section.

The  Edit Variables command provides automenu options for working with the clipboard:

<Ctrl>+<X> Cut selected text

<Ctrl>+<C> Copy selected text to clipboard

<Ctrl>+<V> Paste text from clipboard

These options are also available in the contextual menu called by clicking  on the value of the

variable or on the button .

When pasting text from the clipboard, the system keeps track of the correspondence between the

buffer content types and the current variable, i.e. it is not possible to insert textual information into the

field of a numeric variable.

Additionally, following options are available for inserting text from a dictionary, indexes, fractions,

symbols and spell check:
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<F6> Insert text from Dictionary

<Alt>+<F12> Insert Index

<Ctrl>+<F12

>
Insert Fraction

<Alt>+<F2> Insert Diameter

<Alt>+<F3> Insert Degree

<Alt>+<F4> Insert Plus-Minus

<Alt>+<F9> Insert Special

<Alt>+<F5> Open Character Map

<Ctrl>+<F11

>
Check Spell

These options are also available in the contextual menu called by clicking  on the value of the

variable or on the button . In addition, inserting a radical is available in the same menu: Insert  

Radical.

These options are intended to work with text variables. Using these options, when editing real

variables, can lead to incorrect results.

The options mentioned above are used in the same way as in the text content editing mode.

The display of non-printable characters can be enabled/disabled using the option:

<Ctrl>+<F2> Non-printing symbols

This option is also available in the contextual menu called by clicking  on the button .

You can quit the command using the following options:

<Ctrl>+<Enter

>
Confirm change of variables

<Esc> Undo variable change

These options are also available in the contextual menu called by clicking  on the button .

Inserting expressions into string text by typing in the expression body from the keyboard without

invoking additional commands

When entering string text content, you can enter expressions by enclosing them in curly brackets. As a

result, the value of the entered expression will be displayed in the drawing instead of the contents of

curly brackets. If the expressions use names of non-existent variables, then after clicking OK in the text

parameters dialog, the Variable Value windows will be opened sequentially for each of the new

variables. After setting the values of all variables, the insertion will be completed and the system will

calculate the value of the expression.
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For example, if you create text with the following content:

Cylinder diameter - {D} millimeters

and assign the value 10 to the variable D, then the text in the drawing will look as follows:

Cylinder diameter - 10 millimeters

When entering expressions in the contents of string text, the same rules, operations and functions are

used as in the variable editor.

If the expressions entered in the current line of text do not use non-existent variables, then their values

are calculated immediately after entering. At the same time, the content of the current line is

displayed above the text content input field, taking into account the value of the expression. To

display the contents of another line, move the text cursor to it.

See also:

· Parametrization

· Expression Constructor

Inserting Position Numbers into Text

The following commands are available to insert the position number into the text:

· Position number from T-FLEX CAD Product Composition

It is used to work with a modern mechanism of creating the product composition.

· Position number from T-FLEX DOCs

It is used to work with the T-FLEX DOCs product structure in integration mode.

· BOM position number

It is used to work with the old mechanism of creating bill of materials.

When the display of variable names is enabled, the position number is displayed as {pos.1} where 1 is

the value of the number.

The inserted number retains an associative relationship with the selected record. If the position

number in the product composition has changed, then in order to automatically update the

corresponding number in the text, you need to call the  Full Regeneration command. In order to

update a record from the T-FLEX CAD product composition, the Product Composition checkbox must
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be enabled in the regeneration command's dialog. In order to update records from T-FLEX DOCs and

old BoM, the Reports/Bills of Materials checkbox must be enabled.

Position number from T-FLEX CAD Product Composition

When editing the text content in a 2D or 3D view window, the item number from the product

composition is inserted into the text using the auto menu:

<Alt>+<F7> Insert position number from product composition

In addition, this command is available in the contextual menu (Insert   Product Composition

Position Number... <Alt>+<F7>).

When editing the text content in the editor, this command is not available.

After calling the command, you need to select  the line of the necessary entry in the  Product

Composition tool window. If this window is closed, when the command is called, it will be opened

automatically. After selecting the necessary line, its position number will appear in the text.

Position number from T-FLEX DOCs

This command works only in the T-FLEX DOCs integration mode, if the product structure of the

current document is saved in DOCs.

When editing the text content in a 2D or 3D view window, the position number from T-FLEX DOCs is

inserted into the text using the automenu:

<Alt>+<F8> Insert position number from product composition (T-FLEX DOCs)

In addition, this command is available in the contextual menu (Insert   Product Number (T-FLEX

DOCs) <Alt>+<F8>). 

When editing the text content in the editor, this command is not available.

After calling the command, you need to select  the line of the necessary entry in the  T-FLEX

DOCs Product Structure service window. If this window is closed, when the command is called, it will

be opened automatically. After selecting the necessary line, its position number will appear in the text.

BOM position number

When editing the text content in a 2D or 3D view window, the item number from the BOM is inserted

into the text using the automenu:

<Alt>+<F10> Insert position number from BOM

In addition, this command is available in the contextual menu (Insert   BOM Position Number

<Alt>+<F10>).

When editing the text content in the editor, this command is available on the Standard toolbar, as

well as in the drop-down menu (Insert > BOM Position Number).

Calling the command invokes the Select BOM Record window:
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The name of the BOM is displayed in quotes in the title bar of the window. If there are multiple

specifications in a document, the first one in the list is used.

Select  the line of the necessary entry in the selection window. The position number of the selected

entry will be inserted into the text. The behavior of the window after selecting the entry depends on

the state of the  Keep Visible option.

In the record selection window, the View drop-down menu is available, which allows you to turn

off/on the display of the Status Bar and Toolbar in this window. The following options of the record

selection window are available on the toolbar, as well as in the View menu:

·  Zoom In

Zooms in the camera. Only available in the toolbar.

·  Zoom Out

Zooms out the camera. Only available in the toolbar.

· Select scale from the list (200%, 150%, 100%, 75%, 50%, 25%). Only available in the menu.

·  Zoom

Opens a dialog where you can enter an arbitrary scale value.

·  Show Unprintable Symbols

·  Show Variable Name
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·  Merge Records

Similar to the Merge Records checkbox in the old BOM parameters dialog.

·  Save Link to BOM for Position Number

·  Keep Visible

If the option is enabled (by default), then after selecting a record, the selection window

remains on the screen. Otherwise, after selecting an entry, the selection window is

automatically closed.

See also:

· Product Composition (modern mechanism)

· Working with BOM on Prototypes (old mechanism)

Inserting Techincal Requirements into Text

If the technical requirements of the document have been created for the current document, then their

contents can be inserted into text.

When editing text content in a 2D or 3D view window, technical requirements are inserted into the

text using the automenu:

<Alt>+<F11> Inserting technical requirements of the document

In addition, this command is available in the contextual menu (Insert   Technical Requirements

<Alt>+<F11>). 

When editing the text content in the editor, this command is available on the Standard toolbar, as

well as in the drop-down menu (Insert > Technical Requirements).

The inserted text does not retain an associative connection with the technical requirements of

the document, i.e. in the future, when the technical requirements of the document change, the

text is not updated.

See also:

· Technical Requirements

Inserting Indexes, Fractions and Radicals into Text

The insertion of indexes, fractions and radicals into the text (except for string text) is carried out

according to the same principle. The insert command adds a template of the appropriate type to the

text. The template consists of three cells. 

In the text content editing mode, the contours of the template cells are indicated by dashed lines. The

figure below shows the index, fraction and radical inserted into regular text and describes the contents

of each cell.
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The first line is empty templates;

The second line is filled templates

A, B, C, D - regular text

1 - text before the index;

2 - top index;

3 - bottom index;

4 - text after the index;

5 - text before the fraction (integral part);

6 - numerator;

7 - denominator;

8 - text after the fraction;

9 - text before the radical;

10 - root degree;

11 - root expression;

12 - the text after the radical.

Cell outlines are not displayed outside of the text content editing mode.
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The text cursor can be moved between cells using the arrows on the keyboard or set to the necessary

cell by clicking  on it. The contents of the cells are entered using the keyboard or using the

contextual menu. You can insert indexes/fractions/radicals into the cells of other

indexes/fractions/radicals.

Font Parameters can be set individually for individual characters in each cell in the same way as for

regular text. The size of the content in the cells before and after the index/fraction/radical, as well as

in the cell of the root expression, is equal to the font size. The size of the content in the cells of the

upper and lower indexes, numerator, denominator and root degree is equal to the product of the font

size and scale.

For all types of text, except string, there are two ways of insertion:

· with default scale;

· with custom scale.

For string text, you can only insert fractions using a separate command described in the section

Contextual Menus of Input Boxes.

Insert with default scale

When editing the text content in a 2D or 3D view window, insertion with default scale is performed

using the following contextual menu commands:

· Insert   Index <Alt>+<F12>;

· Insert   Fraction <Ctrl>+<F12>;

· Insert   Radical;.

Commands for inserting indexes and fractions are also available in the automenu:

<Alt>+<F12> Insert Index

<Ctrl>+<F12

>
Insert Fraction

When editing the text content in the editor, commands for inserting indexes, fractions and radicals

with a default scale are available on the Standard toolbar, as well as in the Insert section of the drop-

down menu.

After calling the command, the template is immediately inserted into the text. The default scale can

be adjusted when inserting with custom scale.

Insert with custom scale

When editing the text content in a 2D or 3D view window, insertion with custom scale is performed

using the following contextual menu commands:

· Insert   Index;
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· Insert   Fraction;

· Insert   Radical.

Commands for inserting indexes and fractions are also available in the automenu:

Insert Index...

Insert Fraction...

When editing the text content in the editor, commands for inserting indexes, fractions and radicals

with custom scale are available in the Insert section of the drop-down menu.

After calling any of the listed commands, the Expression Parameters dialog box appears, in which you

can set the Font Scale. After clicking OK, a template with the specified scale will be inserted into the

text.

If the Use as Default checkbox is enabled, then after clicking OK, the entered scale value becomes the

default scale. Despite the same appearance of this dialog for indexes, fractions and radicals, they have

separate default scales.

Inserting Roughness, Formlimits, Fragments and Pictures into Text

Among other things, you can insert into the text:

· roughness, 

· GD&T formlimits,

· 2D fragment,

· picture.

Insert roughness or GD&T symbols

When editing the text content in a 2D or 3D view window, the symbols are inserted into the text using

the automenu:

<Ctrl>+<F8> Insert Roughness

<Ctrl>+<F9> Insert GDT Formlimit

In addition, these commands are available in the contextual menu (Insert   Roughness...

<Ctrl>+<F8>, Insert   GD&T... <Ctrl>+<F9>).

When editing the text content in the editor, these commands are available in the Standard toolbar, as

well as in the drop-down menu (Insert > Roughness..., Insert > Tolerance ...).

After calling one of the listed commands, a dialog of roughness or GD&T formlimit parameters

appears on the screen. In the dialog, you should set the necessary symbol parameters and click OK,

after which the symbol will be inserted into the text.
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Detailed information about roughness symbols is available in the Roughness section.

Detailed information about GD&T formlimits symbols is available in the GD&T Formlimits

section.

The created symbol can be edited by clicking  on the symbol in the text content editing mode

(both in the 2D window and in the editor) and selecting one of the following items in the context

menu that appears:

·  Parameters...

Calls the roughness or GD&T formlimit parameters dialog.

· Size and Position...

Calls the Object Parameters dialog.

Insert 2D fragment into text

When editing the text content in a 2D or 3D view window, fragments are inserted into the text using

the automenu:

<Ctrl>+<F10

>
Insert Fragment 

In addition, this command is available in the contextual menu (Insert   Fragment... <Ctrl>+<F10>).

When editing the text content in the editor, this command is available in the Standard toolbar, as well

as in the drop-down menu (Insert > Fragment...).

Calling the command invokes the standard Windows Explorer window for selecting a file. Working

with the Explorer window is carried out in the same way as described in the Open Model section.

As a fragment, you can select T-FLEX CAD Model File (*.grs, *.grb) or T-FLEX CAD Remark File

(*.grn). If you try to use a file of a different format, the fragment will not be inserted.
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Select the necessary file and click Open. If there are no external variables in the selected file, then the

fragment insertion will be completed. Otherwise, the external variables of the fragment dialog will

open. Set the required variable values and click OK to finish inserting the fragment.

As a result, an image of the first page of the fragment drawing will appear in the text. If the first page

of the fragment drawing is empty, then the image in the text will also be empty. Upon adding an

image to the first page of a fragment, the system will suggest to update the links in the document in

which the fragment is inserted. After updating the links, the image in the text will be updated.

The inserted fragment can be edited by clicking  on it in the text content editing mode (both in

the 2D window and in the editor) and selecting one of the following items in the contextual menu:

·  Parameters...

Calls the fragment parameters.

·  Variables...

Calls the external variables of the fragment dialog

· Size and Position...

Calls the Object Parameters dialog.

Insert picture in text

When editing the text content in a 2D or 3D view window, pictures are inserted into the text using the

automenu:

<Ctrl>+<F7> Insert Picture

In addition, this command is available in the contextual menu (Insert   Picture... <Ctrl>+<F7>).

When editing the text content in the editor, this command is available in the Standard toolbar, as well

as in the drop-down menu (Insert > Picture...).

Calling the command invokes the standard Windows Explorer window for selecting a file. Working

with the Explorer window is carried out in the same way as described in the Open Model section.
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As a picture, you can choose image files of various formats, as well as T-FLEX CAD documents.

Unlike inserting a fragment, when using a T-FLEX CAD document as an image, you cannot set the

values of external variables. However, it allows to choose the page displayed in the text.

Select the necessary file and click Open. As a result, the image of the first page of the selected file will

appear in the text. To select a different page, use the picture parameters dialog (see below).

You can also copy an image from the text in *.rtf format to the clipboard and then  Paste

<Ctrl>+<V> from the buffer into the T-FLEX CAD text (except string text).

The inserted picture can be edited by clicking  on it in the text content editing mode (both in the

2D window and in the editor) and selecting one of the following items in the contextual menu:

·  Parameters...

Calls the picture parameters dialog.

· Size and Position...

Calls the Object Parameters dialog.

Size and Position

In the text content editing mode (both in the editor and in 2D or 3D view windows), the contextual

menu of roughness symbols, GD&T formlimits symbols, fragments and pictures inserted into the text

contains the Size and Position... item, which opens a dialog of the following type:
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In the dialog, you can set the following parameters of the object inserted into the text:

· Scale

This group of parameters contains the scale Value input box and a drop-down list, in which

you can select, Relative to what the entered Value is applied to. By default, objects are

inserted into text with a scale of "1" relative to the Font Size. As a result, the height of the

inserted object is equal to the height defined in the text font parameters. If necessary, you can

set the scale relative to the size of the object. For pictures and fragments, the size of the object

is the size of the inserted picture in the source file. For symbols, the object size is the font size

set in the roughness or tolerance parameters dialog.

· Color

By default, images and fragments are inserted into the text with the same colors as in the

source file, and the symbols are inserted with the color set on the General tab in the roughness

or GD&T formlimit parameters dialog. If necessary, you can choose a different color in the

Size and Position... dialog. The color selection is performed in the same way as described in

the Color section. To apply the selected color, enable the Color checkbox. For a fragment, the

selected color is applied to all lines at once, even if they initially have different colors. Using

this parameter is not recommended for the image, because it leads to the replacement of the

image with a frame of the selected color.

· Vertical offset

The distance from the current line of text to the lower border of the inserted object.

See also:

· Roughness

· GD&T Formlimits

· Inserting Fragments into a Drawing

· Pictures

Font Parameters of Text

Initially, text creation command uses default font parameters, which are defined in the document

parameters dialog (Document Parameters > Page > Font). Next, user can customize font parameters

either for the whole created text using the text parameters dialog, or individually for selected part of

the text in the content editing mode.

Font parameters for selected part of text are customized using the font parameters dialog or special

commands. If nothing is selected, then font parameters are set for the current position of text cursor.

Commands for font parameters customization

Following commands are available at the Text tab of the ribbon within the text content editing mode

and at the Format toolbar in the text editor:



T-FLEX CAD 17 Help

752

Bold Font:

Icon Ribbon

Text > Font > Bold Font

Keyboard Textual Menu

<Ctrl>+<B>

The result of applying this command is shown on the picture below.

Italic Font:

Icon Ribbon

Text > Font > Italic Font

Keyboard Textual Menu

<Ctrl>+<I>

The result of applying this command is shown on the picture below.

Underline Font:

Icon Ribbon

Тext > Font > Underline Font

Keyboard Textual Menu

<Ctrl>+<U>

The result of applying this command is shown on the picture below.

Box:

Icon Ribbon

Text > Font > Box

Keyboard Textual Menu

The result of applying this command is shown on the picture below:
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Default Color:

Icon Ribbon

Text > Font > Default Color

Keyboard Textual Menu

The command is enabled by default , which indicates that the selected part of text uses the font

color set in the text parameters dialog. If you set different color specifically for the selected part of

text using the font parameters dialog, then the command gets disabled. Enable the command

manually, if you want to restore the link between color of the selected part of text and color set in the

text parameters dialog.

Moreover, following controls are available at the Text tab of the ribbon within the text content editing

mode:

Font type input box

Displays name of the font applied to selected part of text. You can select another font in the drop-

down menu invoked by clicking the  button located at the right side of the box. Alternatively, you can

activate the input box by clicking  within its boundaries and type in the exact name of the font. If

there is such font available in the system, it will be applied. If the name of the font is shown in the

square brackets, then the font of the selected part of text depends on parameters of the whole text.



T-FLEX CAD 17 Help

754

Font size input box

Displays size of the font applied to selected part of text. In order to change the size, click  within

input box's boundaries and type in the new size value or use buttons  located at the right side of the

box. If the size is shown in the square brackets, then it depends on parameters of the whole text.

Font parameters dialog

Within the text content editing mode the dialog can be called using the following automenu

command:

<F9> Format Font

Moreover, it can be called from the contextual menu (  Font... <F9>).

Within the text editor it can be called from the Format toolbar, from the contextual menu and from

the drop-down menu (Format >  Font...).

The dialog contains following controls: 

Name

This input box displays name of the font applied to selected part of text. You can select another font

in the drop-down menu invoked by clicking the  button located at the right side of the box.



Drawing Creation

755

Alternatively, you can activate the input box by clicking  within its boundaries and type in the exact

name of the font. If there is such font available in the system, it will be applied. If the name of the font

is shown in the square brackets, then the font of the selected part of text depends on parameters of

the whole text.

Size

Capital letters' vertical dimension in absolute units (by default it's either millimeters, or inches

depending on the standard of the current document). In order to change the size, click  within

input box's boundaries and type in the new size value or use buttons  located at the right side of the

box. If there is the [Default] text shown instead of value, then it depends on parameters of the whole

text.

Style

One of the following styles can be selected in the drop-down list:

· Regular

· Bold

Same as applying the  Bold Font command.

· Italic

Same as applying the  Italic Font command.

· Bold Italic

Same as applying the  Bold Font and  Italic Font commands simultaneously.

· [Style in square brackets]

In addition to the styles listed above, there's always one of the styles in the list shown in the

square brackets ([Regular] by default). Selecting such style links the style of the selected part

of text to the parameters of the whole text.

Italic by Default and Bold by Default

If the Italic by Default checkbox is enabled, then the selected part of text uses italic font, as long as

there is italic or bold italic font set in the parameters of the whole text. If the checkbox is disabled,

then the selected part of text uses style selected in the list above. The Bold by Default checkbox works

in the similar way. To see how it works let's take a look at the following example. Bold Italic is set in

the parameters of the whole text, Regular is set in font parameters of the selected part, Bold by

Default checkbox is enabled. In result, the selected part is shown in Bold. Then we switch from Bold

Italic to Italic in the parameters of the whole text. In result, the selected part is shown in Regular.

Underline

Following options are available in the drop-down list: None – no underline, Single – single underline

(same as applying the  Underline Font command).

Character Spacing 

Additional space between adjacent characters in a line. Defined in portions of font size (height).

Stretch

Ratio of characters width scaling. If there is the [Default] text shown instead of value, then it depends

on parameters of the whole text. The value should always be above zero.

Color

Allows to select font color from the drop-down list or from the catalog. The selection is performed in

the same way as described in the Color section. Enabling the Default checkbox links the color of the

selected part of text to the parameters of the whole text.

Vertical offset

A vertical offset from the bottom line of the string measured in absolute units (by default it's either

millimeters, or inches depending on the standard of the current document). Positive value means

offset up, negative - down.
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Clear Background

When this checkbox is enabled, the drawing elements behind the selected part of text are not

displayed. 

Box

Enabling this checkbox is the same as applying the  Box command. 

Strikeout

Enabling this checkbox strikes out the selected part of text.

Paragraph Parameters of Text

Initially, text creation command uses default paragraph parameters. Next, user can customize

paragraph parameters either for the whole created text using the text parameters dialog, or

individually for selected part of the text in the content editing mode.

Font parameters for selected part of text are customized using the paragraph parameters dialog or

special commands. If nothing is selected, then font parameters are set for the current position of text

cursor.

When inputting the text content, new paragraphs are added by pressing <Enter>. In order to wrap a

textual string to the new line without creating a new paragraph, press <Shift>+<Enter>.

Commands for paragraph parameters customization

Following commands are available at the Text tab of the ribbon within the text content editing mode

and at the Format toolbar in the text editor:

Left Text Alignment:

Icon Ribbon

Text > Font > Left Text Alignment

Keyboard Textual Menu

<Ctrl>+<L>

Aligns text with the left edge of bounding rectangle or table cell.

Center Text Alignment:

Icon Ribbon

Text > Font > Center Text Alignment

Keyboard Textual Menu

<Ctrl>+<T>

Aligns text with the center of bounding rectangle or table cell.

Right Text Alignment:
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Icon Ribbon

Text > Font > Right Text Alignment

Keyboard Textual Menu

<Ctrl>+<H>

Aligns text with the right edge of bounding rectangle or table cell.

Text Justification:

Icon Ribbon

Text > Font > Text Justification

Keyboard Textual Menu

<Ctrl>+<J>

Aligns text with both vertical edges of bounding rectangle or table cell by increasing spacing between

words.

Text Numbering:

Icon Ribbon

Text > Font > Text Numbering

Keyboard Textual Menu

<Ctrl>+<M>

Enables numbering of paragraphs. Numbering parameters may be customized using the paragraph

parameters dialog. If   Non-printable characters are enabled, then identifiers of each numbered

paragraph are displayed. Identifier may differ from actual number of the paragraph.

Paragraph parameters dialog

Within the text content editing mode the dialog can be called using the following automenu

command:

<F10> Format Paragraph

Moreover, it can be called from the contextual menu (  Paragraph... <F10>).

Within the text editor it can be called from the Format toolbar, from the contextual menu and from

the drop-down menu (Format >  Paragraph...).
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Following groups of parameters are available in the dialog: 

Justification 

Contains following controls intended for text's horizontal alignment customization:

· Horizontal

One of the following options can be selected in the drop-down list:  Left,  Center, 

 Right,  Justify. Applying this options has the same effect as using the ribbon commands

described above.

· Fit to one line

Enable this checkbox, when you need to fit the whole paragraph in one line. In this case, the

font characters are first scaled by the width to the minimum ratio defined in the Reduce

extension input box. If that's not enough, then the font height is reduced. 

· Reduce extension 

Minimal scale ratio applied upon enabling the Fit to one line checkbox.

Since bounding rectangle of multiline text expands automatically upon increasing the size of its

content, then enabling the Fit to one line checkbox for multiline text has no effect.

Tabs

Contains following input boxes intended for customizing the effect of pressing <Tab>:

· Size

The distance of textual cursor's movement upon pressing <Tab> in absolute length values (by

default it's either millimeters, or inches depending on the standard of the current document).

· List

Type in several numbers separated by commas. Numbers are automatically sorted in

ascending order. They define distance between left edge of bounding rectangle and textual

cursor's position. E.g.: if the List contains 20,40,50, then upon pressing <Tab> for the first time,

the cursor will be placed at 20 units distance from the left edge, upon pressing <Tab> for the

second time - at 40 units distance, third time - 50 units. Thereafter, the tabulations use the

distance specified in the Size input box.

Offset
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Contains following controls intended for customizing the distance between edges of bounding

rectangle and text content:

1 - Left, 2 - Right, 3 - First.

Keep in mind, that within the text content editing mode the appearance of bounding rectangle

doesn't represent its actual dimensions. The rectangle looks bigger than it is, due to additional

offsets displayed for more convenient content editing.

Interval

Contains following controls intended for customizing the distance between lines of text: 

· Before 

The distance between the bottom of previous paragraph's last line and the top of current

paragraph's first line. 

· After 

The distance between the bottom of current paragraph's last line and the top of next

paragraph's first line. 

· Between 

The distance between bottoms of current paragraph's lines. Following options are available in

the drop-down list:

o Auto 

The distance is set automatically depending on a max height of line's content. 

o Minimum 

The minimal distance value is typed in below the drop-down list. If the line's content doesn't

fit such distance, the distance is increased automatically. 

o Exactly 

The exact distance value is typed in below the drop-down list. Such distance is applied

regardless of line's content size. If indexes, fractions or radicals don't fit, then their size is

reduced automatically. If other types of content don't fit, then the part, that didn't fit, is

omitted.

o Factor 

The distance is defined as a font height multiplied by a ratio typed in below the drop-down

list.

Numbering

Enabling this checkbox enables the automatic numbering of paragraphs in the same way as the 

 Text Numbering command. Next there's the switch with two possible states:
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· Start

Numbering of selected paragraphs starts from the number typed into the Start from input

box.

· Continue

Numbering of selected paragraphs either continues the numbering of previous paragraph (if

possible), or starts from 1.

The symbol to be added after the paragraph's number can be typed into the Add input box or

selected from the list .

Numbering font is defined separately from font of the rest of the text. The Format... button invokes

the numbering font parameters dialog. Such dialog contains the same set of parameters as the regular

font parameters dialog. 

Check Spelling

T-FLEX CAD allows checking the spelling of any texts in a drawing, on an active workplane and in

input boxes. Checking is carried out by tools of Microsoft Office.

To check the spelling the following command should be called:

Icon Ribbon

Tools > Tools >Check Spelling

Keyboard Textual Menu

<Ctrl>+<F11> Tools > Check Spelling

After calling this command it is necessary to indicate  a single text or multiple texts, which needs to

be checked, on the current drawing page or on the active workplane. All available texts can be quickly

selected using the following automenu option:

<*> Select all Elements

The command may also be called:

· from contextual menus of input boxes in various system windows

(results in checking the content of the current input box only);

· from contextual menu of text content or from the automenu in the text content editing mode

(results in checking either the part of text selected at the moment of calling the command, or

the whole current text);

· from the Edit section of the drop-down menu and from the Standard toolbar in the text editor

(results in checking either the part of text selected at the moment of calling the command, or

the whole current text).

Depending on the way of calling, the command's interface is displayed either in the  Parameters

tool window, or in the special dialog window. The set of available controls is the same anyway.
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Words not found in the dictionary get marked by the red underline in the text. Such words are

sequentially displayed one by one in the Unknown Word input box. Next word is displayed upon

selecting the action to be applied to the current one.

if the command's interface is displayed in the  Parameters tool window, then you can manually

switch between unknown words by clicking  them directly on a drawing or active WP.

The Replace By list contains words similar to the unknown one found in the dictionary. Words in this

list may be selected using . If there's no suitable word in the list, you can manually edit the content

of the Unknown Word input box. Result of editing gets added to the Replace By list.

Following buttons can be used:

· Skip

Skips the current instance of the current unknown word. Doesn't affect other instances of the

same word. Upon calling the Check Spelling command next time, instance previously skipped

will get marked as unknown again.

· Skip All

Skips all instances of the current unknown word in all texts within the current T-FLEX CAD

session. Upon calling the Check Spelling command next time in the current session, such word

won't be marked as unknown. Upon calling the Check Spelling command in the next session,

all instances of such word will get marked as unknown again.

· Replace

Replaces the current instance of the current unknown word by the word selected in the

Replace By list.

· Replace All

Replaces all instances of the current unknown word in the text subjected to checking by the

word selected in the Replace By list.

· Add

Adds the current unknown word to the dictionary.

· Delete

Deletes the current instance of the current unknown word.

· Options...

Invokes the Spelling Check Options dialog.
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If command's interface is displayed in the  Parameters tool window, then you can exit the

command either with confirming ( ) or without confirming (  or ) changes.

If command's interface is displayed in the special dialog window, then you can only exit with

confirming changes. It is performed either automatically upon selecting an action to be applied to the

last unknown word, or manually using the Close button.

Parameters Dialog of Text

Parameters dialog of text may have different layouts depending on type of text and depending on

whether the dialog is called before or after text creation.

Parameters dialog of a new text

Parameters dialog  can be called for a new text prior to its creation using the following automenu

option within the Text and Table commands:

<P> Set Text Parameters

The dialog's layout is common for all types of text. It contains following tabs:

· Style; 

· Font.
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Style tab in parameters dialog of a new text

The tab contains following parameters:

· Justification group of parameters

See the Position and Orientation of Text section.

· Rotation angle

Angle at which text is rotated about a horizontal axis. Measured in degrees. Positive values

correspond to counterclockwise rotation, negative - clockwise. In cases where text is oriented

along a construction line, such line will be used as rotation axis instead of horizontal.

· Level, Layer, Priority, Color

Standard parameters available for most T-FLEX CAD elements.

· Force Parameters dialog box for each new text created

This checkbox only affects string texts. If checkbox is enabled, then the Contents tab of text's

parameters dialog is opened automatically upon defining an attachment point. Otherwise, the

crippled version of the text editor is opened.

Parameters dialog of an already created text

The parameters dialog  can be called for an already created text outside the text content editing

mode in one of the following ways:

· double-clicking   a contour of text's bounding rectangle in 2D or 3D window; 

· double-clicking   anywhere within string text's bounding rectangle in 2D or 3D

window; 

· double-clicking   a text in the  Model Elements tool window;

· right clicking  the text in 2D or 3D window or in the  Model Elements tool window and

then selecting  the  Parameters... item in the contextual menu;
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· clicking the  the  icon in the dynamic toolbar displayed upon selecting a text in 2D or

3D window;

· using the automenu of the Edit Text command.

The dialog has common layout for multiline text, paragraph text and table. It contains following tabs:

· Style; 

· Font.

The layout of dialog for string text differs by the set of parameters in the Style tab and by the

presence of the Contents tab.

Style tab in parameters dialog of an already created multiline text, paragraph text and table

The tab contains following parameters:

· Level, Layer, Priority, Color

Standard parameters available for most T-FLEX CAD elements.

· Symmetric

Enabling this checkbox mirrors the text horizontally.

· Correct Length of Italic Text

Enabling this checkbox forces the system to take into account the slope of the italic text when

placing elements of fractions, indexes, and when formatting a paragraph in Fit to one line

mode.

By default, this option is disabled for texts created in T-FLEX CAD version 11 and later, and

enabled for newly created texts.
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Style tab in parameters dialog of an already created string text

The tab contains following parameters:

· Coordinates group of parameters

Input boxes for X and Y coordinates of text anchor point. If the text is attached to to 2D node,

then offsets from said node are displayed instead of absolute coordinates.

· Justification group of parameters

See the Position and Orientation of Text section.

· Rotation angle

Angle at which text is rotated about a horizontal axis. Measured in degrees. Positive values

correspond to counterclockwise rotation, negative - clockwise. In cases where text is oriented

along a construction line, such line will be used as rotation axis instead of horizontal.

· Symmetric

Enabling this checkbox mirrors the text horizontally.

· Level, Layer, Priority, Color

Standard parameters available for most T-FLEX CAD elements.

See Also:

· Default Parameters

· Defining Element Parameters

· Copying Parameters of 2D Elements
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Edit Text

To edit a paragraph text, use the command "Edit Text":

Icon Ribbon

Keyboard Textual Menu

<ET> Edit > Draw > Text

Selection of several paragraph text, just like multiple selection of other system elements, can be done

by box or using the options  (selects all text) and  (selection from the list of the named elements).

When selected, all rectangular areas of the specified paragraph text are highlighted.

Upon multiple text selection, the following options become available:

<P> Set selected Element(s) parameters

<Del> Delete selected Element(s)

<Esc> Cancel selection

Upon selecting a single element, the following options are available:

<E> Edit selected Text

<P> Set selected Element(s) parameters

<D> Add Rectangle

<Y> Create Name for selected Element

<N> Set relation with Node

<I> Select Other Element

<Del> Delete selected Element(s)

<Esc> Cancel selection

Text contents editing mode

To begin editing, click  inside the rectangular area or select the option .

There is yet another way to select a text for editing. When the system is in the command waiting

mode, point the mouse to the text to be edited and right click . In the coming up context menu,

select the item "Edit text". 
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Besides that, if the parameter "'Transparent' Text editing" is set among the drawing settings (the

command Set Document Parameters, the tab "Preferences"), then you can start the text editing mode

by clicking the text  (the pointer in this case turns into a textual cursor).

Modifying parameters of selected elements 

To modify parameters of selected text, use the option .  If the whole paragraph text was selected, then

after calling the option a dialog box appears with general parameters of the paragraph text: 

Level, layer, priority, color – the standard parameters for all T-FLEX CAD elements. 

Symmetric. This parameter defines "mirror" text mode. 

Account for italic font while formatting. Enabling this parameter allows us to take into consideration

the text in italic when placing the elements of fractions, indices and also when formatting the

paragraph in the “fit into one line” mode.

By default this parameter is disabled for texts created in T-FLEX CAD of versions 11 and lower, and

enabled for the newly created texts.

Account for italic font while formatting. Enabling this parameter allows us to take into consideration

the text in italic when placing the elements of fractions, indices and also when formatting the

paragraph in the “fit into one line” mode.

By default this parameter is disabled for texts created in T-FLEX CAD of versions 11 and lower, and

enabled for the newly created texts. 

The "Font" tab contains several standard parameters.

Vertical Justification - sets the vertical text justification inside the selected rectangle. Three

justification options are available –Top, Center, and Bottom. 

Rotation angle – allows rotating the rectangular area by an arbitrary angle, in degrees. In  the  case  of

 selecting  several elements,  upon  calling the option  <P>,  the  dialog  box  appears  for 

selecting  the parameters to be edited. The checkmarked parameters will be available for editing in

the general text parameters dialog box that follows.

Editing string text

To edit a text, start the command "Edit Text":

Upon calling the command, the following options become available in the automenu:

<*> Select All Elements

<R> Select element from list (for named elements only)
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<Esc> Exit command

Selection, editing the position and attachment, and modifying text parameters are similar to editing

other system elements.

Selection of several text, as well as multiple selection of other system elements, can be done by box or

by using the options  (selection of all text) and  (selection from the list of the named elements).

Besides that, the string text allow subsequent selection of elements by using  with the <Shift> key

depressed. Use of  in combination with the depressed key <Ctrl> excludes the text from the list of

selected for editing.

If the selected text is attached to some construction element, this element will be highlighted.

After selecting several text, the following options become available:

<P> Set selected Element(s) parameters

<Alt+P> Copy Properties from Existing Element

<N> Set relation with Node

<K> Break (kill) relations

<J> Merge Text

<Del> Delete selected Element(s)

<Esc> Cancel selection

Upon selecting a specific element, the following options are available:

<E> Edit selected Text

<P> Set selected Element(s) parameters

<Alt+P> Copy Properties from Existing Element

<Y> Create Name for selected Element

<N> Set relation with Node

<L> Set relation with Line

<C> Place Text around Circle

<K> Break (kill) relations

<I> Select Other Element

<X> Explode Text
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<D> Duplicate Text

<Del> Delete selected Element(s)

<Esc> Cancel selection

The option  is used for editing the selected text contents. When the option is called, the text

editor window appears on the screen.

To attach the selected text to a node, line or circle, the same options , ,  are used as

when creating a text. To break and attachment, use the option .

The option  allows breaking a text containing several lines into a number of separate elements. In this

case, each line of the original text will be converted into a separate “String Text” element.

The option  allows creating a copy of the selected text.

Modification of text parameters is bound to the option .. The parameters dialog box appears in the

screen. Besides accessing the text parameters and its contents, you can define the text position in the

absolute coordinates or by an offset from the attachment node, if the text was attached to a node. 
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When calling the option while several elements are selected, you will have to first specify the

parameters to be modified in the dialog box "Change Parameters". By default, all parameters of the

selected elements are subject to editing. Upon specifying the parameters to edit, this standard text

parameters dialog box appears.

Hatch

The command for creating hatches and fills can be called in one of the following ways:

Icon Ribbon

Draw > Draw > Hatch

Sheet Metal > Draw > Hatch

Workplane > Draw > Hatch

Keyboard Textual Menu

<H> Draw > Hatch

Hatches are used, besides the primary purpose, as a means of various manipulations: as contours for

hidden line removal, as profiles and as base data for creating three-dimensional models (in T-FLEX

CAD 3D only).

The hatch or fill area may consist of a single or multiple contours. The left diagram shows a single-

contour hatch, and the right one – a three-contour hatch.

             

Since the contour lines are "tied" to construction elements, modifications of the latter result in

appropriate adjustment of the boundaries of hatch contours.



Drawing Creation

771

    

Various hatch attributes provide control over the contour filling pattern, ranging from standard to

special technical ones to even various artistic types. Fills provide filling of the profile area with the

specified color.

Custom hatch types can be defined if not found among the standard ones provided by T-FLEX CAD.

See details in the chapter "Creating Custom Lines and Hatches".

Applying hatches

The following options are available to the user:

<Ctrl><F

>
Free mode

<Ctrl><F

>
Manual mode

<P> Set selected Element(s) Parameters

<Alt+P> Copy Properties from Existing Element

<R> Preview

<X> Automatic Contour search parameters

<A> Automatic Contour search mode

<A> Manual Contour input mode

<F4> Execute Edit Hatch command

<N> Select Node (in Manual Contour input mode)

<C> Create full Circle Contour (in Manual Contour input mode)

<E> Create full Ellipse Contour (in Manual Contour input mode)

<S> Create full Spline or Polyline Contour (in Manual Contour input mode)

<Esc> Exit command

Filling pattern parameters

With this area filling method, the hatch type is defined by a description stored in a file of a special

format. The descriptor file of the standard T-FLEX CAD hatches is stored in the "PROGRAM" folder

under the name "TCAD.PAT". The name of the standard hatch pattern file is defined in the command

"Customize > Options…". 
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The same format is used for the hatch pattern descriptor file as in AutoCAD system. If some type

of hatching is not available, it can be created by the user or copied from AutoCAD system.

In the cases when standard hatches do not suit the user, then user-defined hatch types can be created.

Special format files "*.grb" are used for the user-defined hatch descriptors. These files are located in

the …/Program/HatchPatterns folder. More on this is in the chapter "Creating user lines and hatches".

The additional parameters of filling by pattern include: 

Type. Defines the filling pattern. The type is selected from a list containing standard and user-defined

hatch types.

Size. Defines the scale factor of the pattern hatch. With a very small scale factor the hatch may appear

as a solid fill.

Angle. Defines the slant angle of the hatch.

Line thickness. Defines line thickness, used when drawing a hatch by pattern.

Hatch Result Preview

There is an option to view the result of hatching without confirming the operation’s creation in the

command:

<R> Preview mode

When this option is enabled, in case of presence of a closed contour or contours, the hatch

being created is immediately displayed on the screen with the same parameters as defined in

the command.

Defining hatch contour  

The hatch contour can be defined in two modes, the automatic contour search mode and the manual

contour input mode.

Automatic Hatch Contour Search Mode

To activate this mode, press the  icon in the automenu or type <A> on the keyboard. This mode

works only with the graphic line contours. To find a hatch contour, position the pointer at a point lying

inside the anticipated hatch contour, and click . The found contour will be highlighted. If

automatic contour search lasts longer than three seconds, a window is displayed with the [Cancel]

button.

Successful definition of a hatch contour requires the graphic lines to form "tight" contour (with

no gaps). 
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The result of the automatic tracing is affected by the parameters set for this mode. The automatic

search parameters are defined in a dialog called by the option . In this dialog window, first of all

specify the types of the graphic lines to be considered in the automatic search for the hatch contour.  

The threshold value of the gaps between graphic lines is determined by the parameter "Gap". If the

graphic lines pass at the distance, which is less than or equal to that defined by the given parameter,

then the system will assume that they have an intersection point and may therefore include them in

the hatch contour.

The "Search:" parameter allows defining more specific requirements to the result of tracing a hatch

contour. If this parameter has the "External contour" value, then the system will search for the largest

closed contour. The internal contours are ignored in this case. When using the "Internal Contours"

value, the system finds the minimal contour which still contains the position of the pointer while

searching. The internal contours processing depends in this case on the state of the additional flag

"Search for Islands (Holes)". If this flag is set, then be found internal contours are included in the

resulting hatch contour (so that the identified islands are not filled with a hatch). When the flag is

cleared, the internal contours are ignored.

Scanning for hatch contours may take a while on very crowded drawings. Search can be restricted per

the “Only on Visible Part of Page” flag. In this case, only the entities will be processed whose outline

boxes overlap with a portion of the drawing display on the screen. An outline box is the least

horizontally oriented rectangle that fully covers the entity. Examples of outline boxes and contour

processing situations are shown on the following diagrams.
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“Scan Fragment Lines” flag will add lines of 2D fragments for scanning the hatch contour. This flag is

set off by default meaning that lines of the fragments will not be considered when searching the

closed contours.

Several contours can be selected subsequently. Should there be common graphic lines between

different contours, the contours get automatically joined along these lines.

Manual hatch contour input mode

When manually defining a hatch contour, object snapping is active. Moving the cursor over a drawing

element modifies the cursor appearance accordingly and pre-highlights the element. The object

snapping can be turned off by pressing on the  icon on the “View” toolbar. In complicated

situations, when snapping to the right element is difficult, the elements can be selected by typing

commands on the keyboard as described below.

If you would like to use already created construction entities as a contour, make sure to be in the

constrained drawing mode rather than in free drawing. See that the icon  appears in the

automenu.

The first step in the manual definition of a hatch contour is selection of the start point. One can select

an appropriate 2D node, or create one by clicking at an intersection of construction lines. Next, define

the contour sequentially. 

The following options become available after selecting a node:

<Ctrl><F> Manual mode

<Ctrl><F> Free Mode

<End> Close Contour

<Tab> Change arc direction (available when making contour along a circle)

<Space> Select Graphic line (available after selecting a node)

<N> Select Node

<L> Select Line

<C> Select Circle
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<E> Select Ellipse

<S> Select Spline

<A> Select contour automatically

<BackSpace> Delete last Contour segment

<Esc> Cancel selection

The simplest way of defining a hatch contour is using the <Space> bar that will let you traverse the

contour by following graphic lines. Note that this way can only be used when the hatch contour

follows graphic lines. In the case of multiple choices, the cursor should point at the necessary graphic

line when pressing the <Space> bar.

        

For faster selection, use the <A> option that automatically searches for the next contour line until the

contour is closed or a dubious situation is encountered (such as branching lines).

The system can be set up for selecting only construction lines when defining a hatch contour in

snapping mode, and not graphic lines. This option can be set in the system customization dialog box

under "Customize > Options…", the "Snap" tab.

A contour can be defined using the same actions as in graphic line creation. That's defining

subsequently the lines of the contour, each having the start and end nodes and is constrained to

construction entities – a line, a circle, an ellipse or a spline. To define the start or end of a line of the

contour, select existing nodes (the <N> key) or create new ones (the <Enter> key or ) at two-line

intersections.

As in graphic entity creation, to define an arc one needs first select a start node on the arc, and then

select the circle by typing <C>. Otherwise, the contour will gain the segment between the two nodes

instead of the arc. 
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When creating a contour along an arc, the arc direction can be flipped by the option .

To create a full circle contour, point at the circle and type <N>. Similarly, ellipses, splines, 2D paths

and functions can be included in a contour.

       

In complex cases, when several nodes coincide, the end nodes of the contour lines can be specified by

selecting two construction lines whose intersection yields the necessary node. This is done in object

snapping mode via the options <L>, <C>, <E>, <S>, for lines, circles, ellipses and splines respectively.

       

In dubious cases, when several construction lines intersect in one point, all necessary nodes can better

be created in advance by using the command "Construct Node". The contour then can be defined

using the option <N>.

To cancel the last contour line input use the <BackSpace> key.

If the end node of a contour line coincides with the start node then the contour automatically closes,

as indicated by a changed color of contour lines display on the screen. 

The contour can also be closed using the option:

<Home> Close Contour

This closes the contour with a straight line from the current node to the contour start.

If the hatch contains several contours then the next contour can be input after closing the current one.

To complete hatching, upon defining the contours use the following option:

<End> Finish input (creates hatching)

The hatch area then gets filled according to the defined hatch parameters.
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To confirm the hatch user can also apply the dynamic toolbar.

   

In case if the user wants to refuse the usage of this capability in the given mode, it can be disabled by

using the "Do not use in current command" command found in the context menu invoked for the

given toolbar.

To cancel an action of a contour segment input or the whole contour definition, right-click  or

press <Esc> key. Upon clicking  the "Right button action" dialog box pops up. You can select the

command to execute in this dialog: 

Cancel element creation. This cancels hatch contour input. 

Cancel last element selection. This cancels the input of the last segment of the hatch contour, bringing

the contour definition one step back.

Finish element creation. This command closes the contour automatically with a straight line.

The dialog box won't be displayed again if the option "Don't show this dialog in future" was set. The

right mouse button click will in this case execute the command checked in the dialog box last time it

was used.

Topics in this section:

· Custom Hatches

· Hatches Parameters

· Edit Hatch

Custom Hatches

T-FLEX CAD allows creating custom hatch types along with custom graphic line types. To add a

custom hatch type to the system, place the file with a hatch pattern in the folder …

\Program\HatchPatterns. Upon restarting T-FLEX CAD, the new type will appear in the list of hatches
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by pattern. To remove a custom hatch type, simply delete its pattern file from …

\Program\HatchPatterns and restart T-FLEX CAD.

Creating Hatch Template

A pattern file is a T-FLEX CAD drawing complying with certain rules. It must contain the image of the

hatch pattern composed of nodes, graphic lines, text and hatches, as well as construction elements.

The start point of the hatch is defined by a special node named Center. This node is mandatory in the

hatch pattern. 

To make a given pattern repeat multiple times when filling the hatch contour, additional named

nodes must be defined in the pattern that would define the direction and step of the pattern

repetition. The node defining the first hatch direction must be named «StepX»; the node defining the

second direction – «StepY». The direction-defining nodes are optional. In the case either of them is

not defined, the pattern will be drawn just once in the respective direction.

Working with Custom Hatches

When using a custom hatch type in a document, the hatch pattern is saved with that document.

Relation with the source file is lost at this point. Therefore, when porting a document file to a

computer without the given hatch type, the image does not get lost.

When porting a document containing custom hatch types to a computer with existing hatch type

pattern under the same name, the hatch image stays unchanged in the form of the image saved in the

document. To update a hatch image, you would need to redefine its type over again. To make an

update, all you need is to bring up the parameters dialog box for one of the hatches and confirm the

existing value. New hatches of the same type that will be created in this document will take on the

current pattern.

Examples of Creating Simple Hatches

To create a custom hatch pattern, let's open a new document (the command Create New Model). 

In the opened document, create the image of a hatch pattern as shown on the figure. Make sure to put

an additional node on the drawing, named Center, which must be present on a hatch pattern.

The drawing created in this way can already be identified by the system as a custom hatch template.

All that needs to be done is saving the file in the folder …\Program\HatchPatterns (for example, under

the name Custom hatch sample.grb) and restart T-FLEX CAD. 

However, since no direction nodes are defined in the pattern, an actual hatch created from this pattern

will contain just a single instance of the hatch.

   

To make the sample defined in the hatch pattern repeat in one direction, you would need to create

the respective named node in the pattern, as, for example, StepX. The position and step of the node

will define the step and repetition direction of the pattern sample.
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Two named nodes – StepX and StepY - would allow defining repetition of the pattern sample in both

directions. By varying the position of the direction nodes with respect to the Center node, one can

obtain various hatch appearances all based on the same pattern.

            

Example of Creating «Woody» Hatch 

The custom hatch creation mechanism allows creating even more complex hatches, for example, a

woody hatch. To create this type of a hatch, a pattern was created as shown on the figure. An

appropriately arranged placement of direction nodes yields a hatch imitating wood texture.

    

Automatic Contour Search Mode

To activate this mode, press the  icon in the automenu or type <A> on the keyboard. This mode

works only with the graphic line contours. To find a hatch contour, position the pointer at a point lying

inside the anticipated hatch contour, and click . The found contour will be highlighted. If

automatic contour search lasts longer than three seconds, a window is displayed with the [Cancel]

button.

Successful definition of a hatch contour requires the graphic lines to form “tight” contour (with no

gaps).

The result of the automatic tracing is affected by the parameters set for this mode. The automatic

search parameters are defined in a dialog called by the option . In this dialog window, first of all

specify the types of the graphic lines to be considered in the automatic search for the hatch contour. 
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The threshold value of the gaps between graphic lines is determined by the parameter “Gap”. If the

graphic lines pass at the distance, which is less than or equal to that defined by the given parameter,

then the system will assume that they have an intersection point and may therefore include them in

the hatch contour.

The Search: parameter allows defining more specific requirements to the result of tracing a hatch

contour. If this parameter has the External contour value, then the system will search for the largest

closed contour. The internal contours are ignored in this case. When using the Internal Contours value,

the system finds the minimal contour which still contains the position of the pointer while searching.

The internal contours processing depends in this case on the state of the additional flag Search for

Islands (Holes). If this flag is set, then be found internal contours are included in the resulting hatch

contour (so that the identified islands are not filled with a hatch). When the flag is cleared, the internal

contours are ignored.

Scanning for hatch contours may take a while on very crowded drawings. Search can be restricted per

the Only on Visible Part of Page flag. In this case, only the entities will be processed whose outline

boxes overlap with a portion of the drawing display on the screen. An outline box is the least

horizontally oriented rectangle that fully covers the entity. Examples of outline boxes and contour

processing situations are shown on the following diagrams.

          

Scan Fragment Lines flag will add lines of 2D fragments for scanning the hatch contour. This flag is

set off by default meaning that lines of the fragments will not be considered when searching the

closed contours.

Several contours can be selected subsequently. Should there be common graphic lines between

different contours, the contours get automatically joined along these lines.

Hatches Parameters

Common parameters for all types of filling 

Filling method. This item defines the way of filling the contour. The parameters for each of the ways

are described below. 

· Hatch
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· Solid Fill

· Pattern

· Invisible

Use for hidden line removal. In this case, the contour will be used for removing hidden lines. Any

elements with lower priority will be hidden behind the hatch. This is true for assemblies as well. 

Profile. With this parameter set, the hatch will be used as a profile for generating a profile file in the

command "Write Profile". This is necessary for displaying geometrical information about the contour

of a part for further processing.

Level. This is an integer in the range from -126 to 127. The level defines whether the hatch will be

displayed upon a redraw.

Priority. This is an integer in the range from -126 to 127. The priority defines the order of drawing

graphic elements on the screen (the greater the priority, the "more prominent" is the element).

Layer. Defines the name of the current layer.

Color. The hatch color can be selected from a table or by number (0-256).

Topics in this section:

· Hatch

· Solid Fill

· Pattern

· Invisible

Hatch

To define hatch parameters, call the option <P>. This will bring a dialog box on the screen, named

"Area Parameters". Some of the hatch parameters can be defined on the system toolbar (see the topic

"Defining hatch parameters on the system toolbar").

Note that defining parameters prior to inputting the hatch contour makes the settings default for all

future hatch creations. To set parameters for one particular hatch, do so in the middle of the hatch

creation.

A hatch can be filled with solid lines with any slant angle in one or two directions.

Angle. The slant angle in degrees with respect to the X-axis.

Step. The distance between hatch lines.

Second hatch. With this attribute set, hatching is done in two directions.

Line thickness. Defines the hatching line thickness.
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Circular. With this flag on, hatching is done in concentric circles with specified parameters (step, color,

line thickness, etc.). In the case attachment point is not selected, the position of the center is defined

by the system automatically. Otherwise, the center is placed in the attachment point.

Solid Fill

A fill type is defined by the “Blend Colors” options. 

You can make the following choices in the drop-down list: 

No. Filling is done with solid color. This hatch does not have additional parameters, besides the

common ones for all filling methods.

Linear. This fill uses a linear color transition. The scale displayed in the parameters dialog shows the

fill palette. By default, a scale of gray is used for the color transition (from white through tones of gray

to black).
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The scale palette can be modified by defining arbitrary colors in arbitrary quantities.

To define a new color, double-click  anywhere on the scale. A standard Windows dialog for

defining color will appear. After selecting a color and closing this window, the specified color will

appear on the scale. A color position on the hatch transition scale is indicated with a triangular marker

below the scale. Using the marker, you can set the new position of the color on the scale. To do this,

point to the necessary marker, depress  and, while holding the button down, drag the marker to

the necessary position.

To delete a color from the transition scale, drag its marker out of the scale. To modify one of the

transition scale colors, double-click  on the respective color marker.

You can also use the context menu accessible by right clicking  on the scale image in order to set

up the color transition scale.
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A color scale setting can be saved into an external file “*.col” in order to quickly load it in the future.

An additional parameter “Angle” defines the fill rotation angle.

Circular. This is a fill with a circular color transition. Its parameters are similar to those of a fill with the

linear color transition, except for the fill angle (it is not defined for a circular hatch).

You can define the center of a fill with a circular transition. To do this, when editing such a field, define

its start point. For details, refer to the section “Editing Hatches and Fills”, the topic “Defining the

Hatch Start Point”.

Pattern

The outline is filled in with a hatching pattern that matches one of the samples supported by the

system. 

Type. Set by selecting from the menu.

There are two types of hatching patterns in T-FLEX CAD: 
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1. the hatching Structure can be described in the TCAD.PAT file (by default, this file contains a set of

different hatches, including those that meet the requirements of GOST). The file format is the same as

similar autocad system description files. Therefore, if you lack any types, you can either create them

yourself, or directly take them from the AutoCAD system, if it is installed on your computer. File name

.PAT is set in the "Levels" command, Files tab.

2. Patterns can be created based on an image that is in a GRB file. The files used as hatching samples

must be located in the Program\HatchPatterns folder. In addition, the nodes that define the starting

point of the sample and the hatching direction must be named in a special way. The starting node is

named "Center", the node that defines the first direction of the hatch, has the name "StepX", which is

the second track, "StepY". Nodes that specify directions are optional. If they are not specified, the

sample in this direction is drawn only once. If a new hatching pattern file is added to the

HatchPatterns folder, it will only appear in the list after the system is restarted.

Size. Defines the scale factor for hatching the sample. Below you can see an example of the same

hatching with different values for the "Size" parameter. If the scale factor is set too small, the hatching

may look like a solid fill.

Angle. Sets the hatching angle.

Thickness. Sets the thickness of the lines used when drawing the hatching pattern.

Invisible line. This is used so that in the future, when building a complex drawing from parts, you can

hide those lines in the drawing of the part (fragment) that should logically not be visible in the

Assembly drawing. Any elements that have a lower priority will be hidden by the hatching that you set

in this command for the drawing fragment that is participating in the Assembly drawing.
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Level. 

Layer. 

Priority.

Color. Defines the hatching color, you can select it from the menu.

Invisible

With this hatch type set, the hatch will not have its own graphical representation on the drawing. This

may be necessary if the hatch is used solely for hidden line removal, or for creating a 3D profile or a

3D model.

"Outline" tab

The hatch contour can additionally be outlined with lines. This is handy when the hatch contour is

defined based on construction lines and nodes, in the absence of graphic lines. The hatch outline lines

are set up in the same way as common graphic lines.

Defining hatch parameters on the system toolbar

When creating and editing a hatch, some of the parameters can be defined directly in the system

toolbar, without using the <P> option:

Color box . Indicates the line color of the hatch being created or edited.

Fill method box . Defines the hatch contour filling method.

"Use for hidden line removal" icon . 

Depending on the fill method setting, the system toolbar may have additional fields:

Hatch: 

Hatch slant angle input box .

Hatch line step input box .

By pattern:

Hatch slant angle input box .

Hatch scale factor input box . Defines the scale factor of the hatch.

Pattern type input box .

Edit Hatch

To modify hatches or fills, use the command "Edit Hatch".

Icon Ribbon

Draw > Title Block > Text

Keyboard Textual Menu

<EH> Edit > Draw > Hatch

Select a hatch or a fill by clicking . One can also use element selection from list, if the element was

named. Upon selecting a hatch or fill, the following actions can be performed:

Modifying hatch or fill parameters

This is done via the option <P> that lets modifying hatch (fill) parameters (see parameter description

above). One can change the hatch type, for example, from pattern to solid fill. This will fill the contour

per the settings for new fill creation.



Drawing Creation

787

As in hatch creation, some of the parameters are accessible from the system toolbar upon hatch

selection.

Deleting the whole hatch or fill 

To do this, press the <Del> key (the icon  in the automenu). 

In the case when a hatch is referenced by the 3D model, its direct deletion is impossible. The user will

have to delete all dependent elements referencing the hatch, which may not be desirable. In such

cases, it may be possible to edit the hatch contour. This opportunity is described below.

As in the case of any other model elements, multiple selection of hatches is supported for

simultaneous deletion or modifying their parameters.

Adding a contour to a hatch or fill

This is done similar to hatch (fill) contour initial input. Suppose, given a hatch, we'd like to make a hole

within. To do this, select the hatch and turn on the contour addition mode (the icon  or <M> key).

Then, using the option <C>, input the additional contour – a full circle, and press <End>. The result

will be a hatch with a "cut" hole.

    

Redefining hatch contour

Select the hatch whose contour is to be redefined, and use the option

<К> Redefine Hatch Contours

To input a new hatch contour, using manual or automatic contour input mode. The edited hatch will

assume the new shape upon confirming the input with the  option.

Defining the hatch start point

A start point can be defined for a hatch (either the regular or by pattern or for a fill with a circular

color transition). The start point defines the location from which hatching begins. 

The start node can be defined by the option:

<O> Select Starting Node of Hatch

Upon calling the option, simply click the necessary node with .

To reject the start node input, use the option: 

<T> Cancel selection of starting Node of Hatch

Displaying the contour point numbers of a hatch

To toggle the display of the contour point numbers of a hatch, use the option:

<Q> Show/Hide contour point numbers

With the option turned on, the points in the all hatch contours are enumerated based on their position

in the contours and the contours direction. Points, belonging to the different contours, are enumerated

independently. The point numbers are displayed next to the respective nodes. When several



T-FLEX CAD 17 Help

788

subsequent points of a contour coincide, their numbers are displayed next to each other, separated by

commas.

Editing a particular contour 

Note: only manually defined hatch contours can be edited.

First, select the hatch that includes the necessary contour. Then, turn on the contour editing option

using the option:

<М> Contour edit mode

Now, select the necessary contour. The selected contour can be deleted or edited. To delete it, press

the <Del> key. When picking a contour, the segment of the contour nearest to the cursor gets

automatically selected. Now, the necessary modifications can be done with the help of the automenu.

The following options become available upon selecting a contour segment:

<I> Switch to “Insert Point” mode

<Q> Show/Hide contour point numbers

<Del> Delete selected Contour

<R> Change Contour direction

<F> Move Contour starting point forward

<B> Move Contour starting point backward

<N> Select Node

<L> Straighten Contour Segment

<C> Select Circle

<E> Select Ellipse

<S> Select Spline

<Tab>
Change arc direction (available when editing an

arc segment of a contour)

<A> Link Arc or Circle to Node 
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<K> Break Link with Node 

<Esc> Cancel selection

Note: the options  and  only are available for editing the contours defined

automatically with the option , constructed on top of 2D projections or as a copy of an

existing hatch.

When editing a contour, the following actions are supported: node deletion, node addition and

redefinition of the type of lines connecting the nodes. Besides, one can change the contour direction,

move the start point back and forth, link arc segments of a contour to nodes.

Flipping contour direction to the opposite

The contour direction is an important hatch property when creating 3D elements. This parameter is

inherited by the 3D profiles created based on hatches. For example, the 3D operation "Loft" matches

profiles by the start points of the respective contours and requires matching of contour directions as

well.

To change the direction of a 3D profile constructed based on a hatch, you need to change the hatch

contour direction.

The contour direction is shown by the arrow displayed upon selecting the contour. This arrow also

indicates the start point of the contour.

The following steps are to be done in order to change a hatch contour direction:

· Call the command "Edit Hatch";

· Select a hatch for editing;

· Turn on the contour editing mode (the icon  or <M> key);

· Select the contour (point the graphic cursor at and click );

· Flip the contour direction (the icon  or <R> key);

· Confirm changes by the  icon or <End> key.

Moving around contour start 

The contour start is the first node selected during the manual hatch contour input.

If the contour is defined automatically or without node selection (as by a full circle), the start point is

defined automatically.

The start point placement and contour direction (see above) can only be changed for the contours

defined manually.

To move the contour start point, do the following steps:

· Call the command "Edit Hatch";

· Select a hatch for editing;

· Turn on the contour editing mode (the icon  or <M> key);

· Select the contour (point at it with the graphic cursor and click );

· Move the start point forward (the icon  or <F> key) or backward (the icon  or <B>

key);
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· Confirm changes by the  icon or the <End> key.

Editing a particular segment in contour 

To edit a contour segment, do the following steps:

· while in contour editing mode, select the necessary contour segment;

· select the construction element defining the new contour segment: line, circle, ellipse or spline

(use the appropriate option for element selection). The end nodes of the contour segment

must be snapped to the selected construction element;

· confirm changes by the  or <End> key. 

Let's review an example illustrating a particular contour segment editing. The diagram shows the

original hatch constructed along construction lines using the "Outline" option. Here, a straight-line

segment is to be replaced by a spline. To do so, call the command "Edit Hatch" and select the hatch. 

Then, turn on the contour editing mode using the option:

<M> Contour edit mode

Select the hatch contour. The following diagram shows the situation after the hatch selection. The

contour is highlighted, and the nodes are marked by little boxes. Move the cursor over the necessary

segment of the contour and click the left mouse button. The selected contour segment also gets

highlighted, and the nodes marked by larger boxes. This state is shown on the center diagram. Move

the cursor over the spline constructed through the nodes of the contour being edited, and select it as a

contour segment by typing <S>.

    

Similarly, one can replace a contour segment by an arc or ellipse, if the respective circle or

ellipse is constructed based on the marked nodes. Simply use the appropriate option: <C> or

<E>. If the new contour segment was not constructed based on the marked nodes yet passes

through them then the contour segment editing should be done via the option "Switch to 'Insert

Point' mode" (the icon  or <I> key). This option functionality is described below.

The edited segment will then assume the necessary shape. The system is still in the mode of modifying

the selected contour segment. If the manipulations with this segment are over, complete the contour

segment modification mode. To do so, press the  icon in the automenu.
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The option <Space> is not available for editing the contour. Therefore, it is impossible to snap a

contour line to a graphic line. If a contour segment is to be replaced by a graphic line while

editing, as, for instance, a wave line, then you need to construct a spline based on the wave line.

The intended hatch contour segment can then straightforwardly be replaced by the spline.

Linking arc contour segment to helper node

If the edited contour segment is an arc then the option for linking to a helper node  becomes

available in the automenu. This node will be defining the choice of an arc constructed on top of the

circle to be used for the hatch contour. As the drawing gets modified, the hatch contour will pass by

the arc nearest to the linking node.

Let's review an example where a construction line position is modified with respect to a reference line

driven by a variable "K". Both circles here are linked to a node on the drawing in order to ensure

correct position. The left diagram shows the hatch contour in the original configuration (K=1). Let's

link the arc segment of the hatch contour on top of the outer circle to the marked node. To do this, do

the following steps once in "Edit Hatch" command:

· Call the hatch contour editing option

;

· Select the arc;

· Call the option ;

· Select the linking node.

The right diagram shows the modified drawing with the "К" equal to (-1). The contour segment on top

of the upper circle was linked to the marked node and adjusted correctly. The contour segment on top

of the second circle was not linked to the node, which resulted in an incorrect configuration.

           

To clear or redefine the linking node, use the option .

Deleting a node on a contour 

To delete a node on a contour, do the following steps:

· Call the command "Edit Hatch";

· Select a hatch for editing;

· Turn on the contour editing mode (the icon  or <M> key);

· Select the contour segment the node is snapped to (point at with the graphic cursor and click

);

· Select the node (point at with the graphic cursor and click );
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· Delete the node (the icon  or <Del> key); 

· Confirm changes (the icon  or the <End> key). The resulting new hatch contour passes

through two adjacent nodes.

             

Modifying a contour node position

To modify a contour node position, do the following steps:

· Call the command "Edit Hatch";

· Select a hatch for editing;

· Turn on the contour editing mode (the icon

 or <M> key);

· Select the contour segment of the node (point at with the graphic cursor and click );

· Select the node (point at with the graphic cursor and click );

· Move the node to the necessary position (the contour rubberbands after the cursor as the

node is being dragged);

· Fix the node (click  over an intersection point or type <N> key for an existing node); 

· Confirm changes (the icon   or the <End> key). As a result of moving, the node point will

be connected with the neighbor nodes by straight line segments belonging to the contour

(regardless of the former adjacent segment entity types).

         

Creation of additional nodes on a contour 

To create additional nodes on a contour, do the following steps:

Call the command "EH: Edit Hatch";

· Select a hatch for editing;

· Turn on the contour editing mode(the icon

 or <M> key);

· Select the contour segment to split by new node(s) (point at with the graphic cursor and click

); 
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· Turn on the point insertion mode (the icon  or the <I> key), and click on a contour

segment. The segment becomes split in two, with the new node between them. The node and

the segments rubberband with the cursor, the solid line segment connecting to the previous

node and the dashed line one to the next. The order of the nodes after the insertion will be

determined by the system automatically, depending on the hatch contour direction. Do not

click on a segment near a vertex, as, instead of adding a node, this will start moving the

existing node;

· Close the contour between the newly created node and the successive one.

· Contour input is complete once the closing node is selected, or the icon  or the <End>

key is pressed.

· The system returns to the mode "Contour selected for editing". One can do other

modifications, and then confirm all changes.

· Confirm changes (the icon  or the <End> key).

Let us illustrate the above with a specific example. Suppose, a hatch contour needs to be edited that

was originally constructed along construction lines using the "Outline" option. The original and target

configurations are shown on the diagrams.

      

To get the result, begin with calling the command "Edit Hatch". Next, select the hatch and turn on the

contour editing mode. Select the hatch contour to be modified. Now, to get the result, perform

manipulations shown on the following diagrams 1 – 8.

       

        

Upon selecting the closing node (see diagram 8) the contour automatically closes, and the point

insertion mode exits. What is left is to press the  icon or the <End> key, and the contour editing

task is completed. 

One comment to the described procedure: as the contour segment to be modified is selected (see

diagram 5), the system will define the previous and the next nodes in the sequence, depending on the

hatch contour direction. These will be identified by the dashed and solid rubberbanded lines. In this

particular example, the hatch contour direction is clock-wise.
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Copying Parameters from Existing Hatches

The values of parameters of the hatch being created can be quickly copied from an already existing

hatch. To do so, use the option:

<Alt+P> Copy Properties from Existing Element

This option is available in the automenu of the command before creation of the hatch has

started or during the process of its creation.

After the option is invoked, it is sufficient to indicate the hatch whose parameters' values must be

transferred to the hatch being created.

To assign the copied values of parameters to all new hatches, enable the additional option before

selection of the original hatch:

<S> Set Properties as Default

When this option is enabled, the copied parameters will be stored as default parameters.

This option simplifies creation of hatches with identical parameters. However, it does not allow

us to copy individual parameters or parameters from an object of another type. In such cases, it

is more convenient to use the general mechanism of editing parameters of the elements in the

properties window.

Roughness

The command for creating roughness symbols can be called in one of the following ways:

Icon Ribbon

3D Model > Additional > Roughness

Draw > Appearance > Roughness

Assembly > Additional > Roughness

Sheet Metal > Additional > Roughness

Surfaces > Additional > Roughness

Weld > Additional > Roughness

Routing > Additional > Roughness

Primitives > Additional > Roughness

Workplane > Appearance > Roughness

Keyboard Textual Menu

<RO> Draw > Roughness

Roughness symbols creation is similar in its nature to creating leader notes and tolerances. First, you

define the position and attachment of the roughness, and then specify its parameters. The size of a

roughness element is related to the font size defined either in the parameters of the specific element,

or in the Font tab of the Document Parameters dialog.

Roughness symbol can be attached to:

· construction lines;

· 2D Nodes;



Drawing Creation

795

· graphic lines;

· joints of graphic lines (a 2D node is created automatically upon selecting a joint)

· 3D paths, faces, edges and vertices of 3D model (see the 3D Annotations section).

Creating Roughness Notation

The following options will become available to you in the command:

<Enter> Place a roughness symbol at the pointer position.

<Alt+P> Copy Properties from Existing Element

<P> Set Roughness Symbol Parameters

<N> Set relation with Node

<L> Set relation with Line

<C> Set relation with Circle

<D> Set relation with Dimension

<R> Set Relation with Leader Note

<E> Set relation with Ellipse

<S> Set relation with Spline

<Space> Change Roughness Attach type

<Z>
Change leader line jog orientation (available only

with selection of the previous option)

<K>
Break (kill) relations (available upon selecting

attachment element)

<F4> Execute Edit Roughness Symbol command

<Esc> Exit command

The roughness can be instantly placed in the absolute coordinates at the pointer position by clicking

. An exact value of coordinates can be defined in the command's properties window (the section

“Coordinates”).

The way of attaching the created roughness is determined by the status of the option . This option

contains a drop down list with the following choices:

<Alt><N> Roughness without leader jog

<Alt><L> Roughness with leader jog
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<Alt><T> Attach to the sign point

To attach a roughness symbol to a construction or graphic line (ellipse, spline, path or function), use

the respective option <L> (<E>, <S>). The graphic pointer must be over the necessary line when using

the option. The intended construction entity must have at least one node on it. In this way, the

roughness being created is attached to the entity and the nearest node on this construction entity. A

leader line will be created by default from the node to the roughness symbol (you can cancel the

leader line creation in the command's properties window).

                

With the object snapping engaged, to select an attachment element you just need to move the

pointer over the necessary element. As the element pre-highlights and the pointer changes its shape,

indicating snapping to the element, click . In complicated configurations, you can use the element

selection options for precise element selection.

Upon selecting the construction or graphic entity (ellipse, spline, path or function), a roughness symbol

starts rubberbanding with the pointer. To complete the creation, point the mouse to the necessary

position of the roughness symbol (the distance from the node to which the roughness being created is

attached) and click .

A precise position of the roughness on a construction or graphic line can be defined in the command's

properties window.

For attaching to a node, select the necessary node by pressing the key <N>.

           

When selecting a node, the roughness can be created in two modes: with an offset from the node and

without an offset. By default, the mode of snapping to the node without an offset is used. This is

indicated by the enabled option  in the command automenu. In this case, you just need to point at a

node and click . To set the mode of snapping to a node with an offset, disable the option . In this

case, after selecting the snap node you will need to specify an offset relative to the node for the

roughness. This can be done by  in the drawing window or by entering the exact offset value in the

command's properties window.

A roughness symbol can be attached to a circle (the option <C>).

The dimension is selected by the key <D>.
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A roughness can also be attached to graphic lines. As the pointer approaches a graphic line, the entity

is pre-highlighted due to the object snapping. If the roughness symbol is placed beyond the graphic

line limits, then by default a leader is created along the graphic line extension up to the roughness

symbol (the leader creation can be disabled in the roughness parameters). 

To undo element selection (line, node, circle or dimension), and, thus, to cancel the attachment

relation, use the option . 

To cancel the last action (for example, to cancel the leader start attachment), use the <Esc> key or

right click .

Roughness parameters are defined in the command's properties window prior to specifying the

roughness position on the drawing. Besides that, you can enter the exact position of the roughness

snap point in the properties window. Option  will take parameters of roughness symbol from

already existing roughness element. See chapter "Dimensions" for more details on this option.

Topics in this section:

· Unspecified Roughness

· Roughness Parameters

· Edit Roughness

Unspecified Roughness

Icon Ribbon

Title Block > Unspecified Roughness > New

Keyboard Textual Menu

Title Block > Unspecified Roughness > Insert

Calling this command invokes the roughness parameters dialog window. Once the parameters are

defined, the roughness symbol will appear on the drawing.
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Icon Ribbon

Title Block > Unspecified Roughness > Edit

Keyboard Textual Menu

Title Block > Unspecified Roughness > Properties

This command serves to edit roughness properties.

Position of the unspecified roughness symbol is defined by the special hidden Roughness

element created inside the title block document.

Roughness Parameters

Roughness Parameters Dialog

You can also define roughness parameters using the parameters dialog accessible by the automenu

option:

<P> Set Roughness Symbol Parameters

The parameters available on the tabs of that dialog duplicate the parameters in the properties

window. Besides that, the parameters dialog contains several additional parameters. First of all, those

are the system-wide parameters: level, layer, priority, color. There is also an additional tab in the

dialog that contains font parameters. There you can define the required font parameters to display the

roughness text.

Defining Default Parameters

The default parameters that will be applied to all newly created roughness symbols can be defined in

various ways.

First of all, those can be defined using the parameters dialog (the option ). To do that, call this dialog

before creating a roughness. The parameters defined in it will be copied over to the parameters of

each newly created roughness symbol.

Besides that, you can save parameters defined for any roughness being created (or edited) as the

default, by clicking the button  in the command's properties window.

Topics in this section:

· General Tab

· Style Tab

General Tab

Roughness Parameters

The first section – “Coordinates” – provides the fields to enter the exact coordinates of the roughness

snap point. The current coordinates are dynamically tracked as the cursor moves in the drawing

window.

The other sections of the properties window – “Height Parameter”, “Step Parameter”, “Relative Basic

Length” – may contain various sets of parameters, depending on the “Type” field value selections in

each section:

Height Parameter. The possible parameter combinations are – “Basic Length” and: 

Ra,         Ra, max, min          Ra, min         Ra, nom 

Rz,         Rz, max, min          Rz, min         Rz, nom 
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Rmax,    Rmax, max, min     Rmax, min    Rmax, nom 

Step Parameter. The possible parameter combinations are – “Basic Length” and: 

S,           S, max, min             S, min           S, nom 

Sm,        Sm, max, min          Sm, min        Sm, nom 

Relative Basic Length. The possible parameter combinations are: 

tp,          tp, max, min           tp, min           tp, nom 

Note that the set of values that you can select can be either in the metric or in the inch notation. This is

controlled by the parameter “Units” in the command “Set Document Parameters”.  Remember that

you can use variables (surrounded in braces) in any parameter field.

Besides, each parameter combo box provides the pre-defined list of values. The user can customize

this list, modifying and appending it as necessary. To edit the list, right click  over the dialog

combo box, and select the command “Edit Value List” in the context menu. For detailed information,

refer to the chapter “Main Concepts of System Operation”, the topic “Context menu for dialog input

boxes”.

Style Tab

In the “Style” section there are the following roughness parameters:

Symbol. The type of the roughness symbol notation can be selected from the set (see the diagram on

the right). 

Direction. Is defined by a symbol of icon or special font, invoked by the key combination <Alt><F9>. 
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Before Symbol, After Symbol. These parameters allow defining additional strings of text to be

displayed before and after the roughness symbol, respectively.

Instruction. This parameter defines the string that will be put above the jog.

Unset Roughness Symbol. Creates the notation of unset roughness . To define the

symbol inside the parentheses, set the flag “Symbol in parentheses”. 

Leader Line. This parameter sets the mode of creating the leader line when attaching the roughness to

a line or a graphic entity. 

Old Drawing Style. This flag is reserved for switching between old and new roughness notation

standards when applicable. 

In the “Arrow” section you can define the type and size of the leader arrow. The parameters

represented by textual strings allow use of variables (the variables must be surrounded in braces). 

The section “Option” contains only one auxiliary parameter– “Show Dialog for each Created

Element”. If this parameter is enabled, then the roughness parameters dialog will automatically

appear after defining the roughness position in the roughness creation command (the option ).

This mode allows working in the same way as in previous versions of T-FLEX CAD – by specifying the

roughness position in the drawing first, and then defining its parameters.

Various samples of the roughness notation symbol are shown below:
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Edit Rougness

The command "Edit Roughness Symbol" allows changing the attachment, position and the parameter

values of a roughness symbol (alternatively, use the option <F4> in the command "Create Roughness

Symbol"):

Icon Ribbon

Draw > Title Block > Roughness Symbol

Keyboard Textual Menu

<ERO> Edit > Draw > Roughness Symbol

Upon calling the command, the following icons are available in the automenu:

<*> Select All Elements

<Esc> Exit command

A roughness symbol notation can be selected by pointing at with the mouse and clicking , or by

multiple selections. As in the case of other drawing elements, multiple selections are done by the

option . Using  together with the depressed key <Shift> adds an element to the list of

selected, while with the key <Ctrl> - excludes from the selected list.  

For multiple selections, you can use the options:

<P> Set Roughness Symbol Parameters

<Alt>+<P> Copy Properties from Existing Element

<Del> Delete selected Element(s)

<Esc> Cancel selection

When selecting a single element, the properties window displays parameters of the selected element.

The following icons become available in the automenu:

<К>
Break (kill) relations (available when the selected roughness is attached to

a node, construction or graphic entity)

<H>
Change leader / roughness position (available when selecting a roughness

symbol with a leader)

<Z>
Change leader line jog orientation (available only when selecting a

roughness symbol with a leader)

<T> Set relation with Node

<Space> Change Roughness Attach type
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<I> Select Other Element

Once selected, the roughness symbol starts rubberbanding on the screen, following the pointer. The

option  allows selecting which point of the roughness notation to rubberband - the arrow tip or the

leader jog. Clicking  fixes the roughness symbol in the new position.

To change the attachment type, first you need to cancel the original attachment by using the option

 (<K>). After that, the options will be provided in the automenu for selecting new attachment

elements: <N>, <L>, <C>, <S>, <D>. If the position of the selected roughness symbol was defined in

the absolute coordinates, then you do not need to use the first option <K>.

Node, that roughness's on lines, dimensions and circles can assume two opposite positions.

The option <P> allows modifying parameters of the several selected roughness symbols. Modifying

parameters in the case of selecting a single element is similar to defining the roughness parameters.

However, if you selected multiple roughness's for editing and run Edit command, then you need to

determine first, which parameters to modify, in the "Change parameters" dialog box. By default, all

parameters of the selected elements are subject to editing. Upon selecting parameters for editing and

pressing [OK], you will access the standard dialog box for defining roughness parameters. Option 

takes parameters of roughness symbol from existing roughness symbol. To delete a roughness symbol,

select it, and then press the <Del> key.

See Also:

· Element Editing Commands
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GD&T Formlimits and Datum

The GD&T Formlimits command can be called in one of the following ways:

Icon Ribbon

3D Model > Additional > GD&T Formlimits

Draw > Appearance > GD&T Formlimits

Assembly > Additional > GD&T Formlimits

Sheet Metal > Appearance > GD&T Formlimits

Surfaces > Additional > GD&T Formlimits

Weld > Additional > GD&T Formlimits

Routing > Additional > GD&T Formlimits

Primitives > Additional > GD&T Formlimits

Workplane > Appearance > GD&T Formlimits

Keyboard Textual Menu

<FO> Draw > GD&T Formlimits

The command creates geometric dimensioning and tolerancing feature control frames.

Feature control frames can be attached to:

· construction lines;

· 2D Nodes;

· graphic lines;

· joints of graphic lines (a 2D node is created automatically upon selecting a joint)

· 3D paths, faces, edges and vertices of 3D model (see the 3D Annotations section).

The GD&T Formlimits command is closely related to the Datum command. In order to switch from

creating a feature control frame to creating a datum use the following automenu option:

<O> Create leader or datum with leader

You can switch between the GD&T Formlimits and Datum at any stage of working with the

corresponding command.

A formlimit or base symbol can be displayed with or without the leader line and contain any number

of extension lines.
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The size of the GD&T symbols is dependent on the font size specified among the parameters of a

particular element or system-wide in the Font tab of the Document Parameters dialog.

Command's automenu contains following options:

<P> Set GD&T formlimit parameters

<Alt+P> Copy properties from existing element

<N> Select node

<L> Set relation with line

<D> Set relation with dimension

/ / <U> Orthogonal Fixing/Fixing to point/Angle Fixing

<Del> Delete arrow

<F4> Execute Edit GD&T formlimit command

<Esc> Exit command

Creating tolerance with extension line

To create tolerance with extension, the user has to specify location of the tolerance on the drawing,

shape of the extension, and also tolerance’s parameters.

In general case the tolerance location is determined by sequential indication of two snapping points–

snapping point of the extension’s arrow and snapping point of the tolerance itself. Dynamic image of

the tolerance on the screen shows which snapping point the user must specify at the current moment.
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Location of both points can be specified in absolute coordinates and also via snapping to the

elements of the drawing.

Dynamic view when the first snapping point is

specified (snapping point of extension’s

arrow)

Dynamic view when the second snapping point is

specified (snapping point of tolerance symbol)

The first snapping point defines location of the extension’s arrow. Snapping in absolute coordinates is

carried out by pressing . Snapping point is created at the current location of the cursor.

  Location of the second point can be defined relative to the first snapping point of the tolerance (with

respect to the arrow) or in absolute coordinates. To select the mode, use the option:

<F> Tie to Arrow

When this option is enabled, location of the leader is specified with respect to the arrow of the leader

note, when this option is disabled – in absolute coordinates.

To snap the tolerance to drawing’s elements it is possible to use object snapping and the following

options of the automenu:

<N> Select node

<L> Set relation with line

<D> Set relation with dimension

Object snapping can be used for snapping the tolerance symbol to such elements as construction line

 (line), graphic line (segment), 2D node, graphic lines that belong to 2D projections or 2D fragments,

to points of confluence of graphic lines that belong to 2D projections or 2D fragments (a 2D node is

created when selecting a point). It is also possible to read the value of the dimension for automatic

calculation of the tolerance. With the approach of the cursor, the elements accessible for snapping will

be highlighted. Both the extension line and the tolerance itself can be snapped to drawing’s elements.

To snap to a 2D node or to a point of object snapping, it is sufficient to indicate the necessary

node/point and press . Location of the specified snapping point will be fixed.

By default, the snapping of a tolerance is carried out to the node itself, without a shift.
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To specify a shift, it is necessary after specifying location of all snapping points to return to editing of

the necessary point. After the point is selected it will start to follow the cursor. While doing so, the

node will be highlighted and the rubber-band line will extend from it to the cursor. Pressing 

defines the tolerance shift with respect to the selected node. In the properties window it is possible to

specify the exact values of the shifts along the X-axis and Y-axis.

           

When snapping to the construction line or graphic line, it is necessary first to indicate the snapping

line itself with the help of . The tolerance’s image will start moving after the cursor along the

selected line. Second click of  will fix location of the extension’s arrow or of the tolerance itself (in

case of snapping the tolerance itself to the graphic line).

When snapping to the graphic line, the tolerance symbol can be situated beyond the graphic line

bounds – on its continuation

           

In case of snapping the tolerance’s arrow to the line, it is possible to control location of the arrow with

respect to the snapping line. To do so, the following option of the command’s automenu can be used:
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/ / <U> Orthogonal Fixing/Fixing to point/Angle Fixing

The  option allows us to keep the extension line of the tolerance perpendicular to the selected

snapping line. If the tolerance was created with the use of the  option, then while being translated

along the line it will be translated “as a whole” (without change in angles). The  option allows us

to retain the angle of the extension line with respect to the selected snapping line.

By default the “Tie perpendicularly” option is activated automatically. Note that in this case after

selection of the snapping line it is sufficient to click  only once to specify location of the arrow and

of the tolerance itself. That is, the second click of  immediately determines location of two

snapping points of the tolerance.

To cancel snap to the line or node, use the option (available upon selection of the corresponding

snapping point of the tolerance):

<K> Break (kill) relations

To snap tolerance to a dimension, it is necessary to specify the necessary dimension, with the help of

object snapping or with the  option in the automenu. After selection of the dimension with the

help of , the tolerance is tied to the dimension line. The tolerance’s image will move after the

cursor along the dimension line. Additional click of  will fix the image of the tolerance in the

necessary location. The tolerance’s parameters in this case are calculated automatically on the basis of

parameters of the dimension. Figures below show examples of snapping tolerance with extension to

the dimension:

 

There is also a possibility to link the tolerance’s parameters with the dimension’s value, without fixing

location of the tolerance to the dimension itself. In the command’s automenu the following option is

available:

<M> Select linked dimension

The tolerance tied with the dimension with the help of the  option can be positioned on the

drawing in an arbitrary way, however, its parameters retain connection with parameters of the

indicated dimension. When changing the dimension’s value, the tolerance’s parameters will change

automatically.

To break connection between tolerance’s parameters and the dimension’s value, use the option: 
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<Ctrl+M> Break link with dimension

To cancel the snap of the tolerance location to dimension, the  option is used (available when

selecting the corresponding snapping point of the tolerance).

Markers for controlling the snap of tolerance’s elements. Creation of extension line with bends.

After initial snapping of the tolerance, location of its snapping points can be modified. Also it is

possible to change the shape of the extension line by creating any number of bends on it. To control

the snap of tolerance’s points, and also for specifying bends on its extension line, the special markers

are used.

At the beginning of tolerance creation, there are only two markers – they designate its major snapping

points and are highlighted with blue color. After location of both points has been specified, on the

image of tolerance’s arrow one more marker appears, highlighted with green color. This is a point in

which it is possible to create a bend.

To correct location of any snapping point, it is sufficient to move the cursor closer to the marker of the

necessary point (it will be highlighted with orange color) and select it with . The point will start

moving after the cursor. In this way, for example, it is possible to specify the shift when snapping the

tolerance’s point to the node.

To create a bend, it is required to move the cursor closer to the green marker (it will also be

highlighted with orange color) and select it with the help of . The arrow will split into two sectors,

flexure point – arrow bend point – will start moving after the cursor. The second click of  will fix

location of the arrow bend point.

                          

After creation of the first bend point, new green markers will appear on the created arrow segments. If

necessary, it is possible to create next bend on any of these segments. When arrow creation is finished,

it is possible either to start creation of the next arrow or complete tolerance creation with the help of

the  option.
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The following option controls the snap of each bend point with respect to the preceding point of the

arrow:

<F> Attach to arrow

When this option is enabled, location of the bend is specified with respect to the previous

characteristic point of the arrow, when this option is disabled – in absolute coordinates. 

To remove the bend point, it is required to select it and use the following option:

<Del> Delete point

Creation of additional extension lines (arrows) for tolerance

After location of the main arrow and the tolerance’s image itself has been specified, additional option

appears in the automenu:

<Space> Add arrow

When this option is invoked, the image of the new arrow-extension appears next to the cursor.

Location of arrow of the additional extension line can also be specified in absolute coordinates or by

using the snap to the lines and nodes of the drawing. With the help of markers it is possible to

generate bends on the arrow. In the properties window the user can specify individual parameters of

the arrow that are different from the specified parameters of the main arrow of the tolerance.

The end of the additional arrow can be snapped to any characteristic point of the tolerance’s

rectangle . (2D nodes can be created in those points if the option “Create Nodes on GD&T

Symbol” is active, as defined in the command “Customize|Options…”, the tab [Snap]). The

characteristic point nearest to the pointer is automatically selected when picking the GD&T symbol.

You can reject creation of the new arrow by using the following option:
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<Del> Delete arrow

The list of created arrows for the tolerance is displayed in the properties window. 

The + and - buttons to the right of the arrow list can also be used for creation and deletion of the

tolerance’s arrows.

Automatic completion of tolerance creation

By default, after specifying location of two main tolerance’s points (location of the arrow and of the

tolerance’s rectangle) the command remains in the mode of editing the created element. This allows

us to add to the tolerance the required number of additional arrows, create bends on the arrows,

specify and edit parameters at any moment of tolerance creation. After creation of the tolerance is

finalized, its creation needs to be completed explicitly with the help of the  option or analogous

button in the command’s properties window.

It is also possible to use another work algorithm. In the command’s properties window, in the

“Options” section, there is a flag “Create automatically”. When this flag is enabled, the tolerance

creation will automatically be completed right after specifying the snapping point of the tolerance’s

rectangle.

Note that in this case it is required either to specify parameters of the element being created before

the snap of the tolerance’s rectangle, or to additionally enable the “Show parameters dialog for each

element” flag. Then after specification of the tolerance’s location the tolerance’s parameters dialog

will appear on the screen. This approach allows us to work the same way as in previous versions of T-

FLEX CAD – first indicate location of the element on the drawing, then specify its parameters.



Drawing Creation

811

Creating tolerance without extension line

 To create a tolerance without extension line, it is sufficient, at any moment of tolerance creation, to

delete the extension line with the help of the option: 

<Del> Delete arrow

The arrow will be removed, and the dynamic cursor will appear as a rectangle of the tolerance without

extension line. It is more convenient to remove the arrow at the beginning of tolerance right away. If it

is done at a later stage, for example, after snapping a tolerance, then it will be required to specify

again location of the tolerance on the drawing.

To remove arrows-extensions, it is also possible to use the command’s properties window. To remove

an extension line, it is sufficient to select the arrow from the list in the “Arrows” section (by default, it is

assumed that there is only one arrow) and press the  button.

 Location of the tolerance without extension line can be specified by the same rules as in general case.

The only difference is that for positioning of the tolerance without extension line it is required to

indicate location of only one snapping point – snapping point of the tolerance’s rectangle itself.

Symbol for the tolerance without extension line can be snapped to another tolerance already existing

on the drawing with the help of the option:

<T> Select tolerance’s symbol

After this option is invoked it is required to indicate the tolerance’s symbol. The newly created GD&T

symbol will be positioned below the selected one. If both symbols contain the same type of tolerance

or refer to the same base, then the tolerance type cells or base cells of both GD&T symbols are

merged. Thus you can merge any number of symbols. 

As the pointer approaches characteristic points on the GD&T symbol box, object snapping activates,

allowing creating a 2D node at such a point and making an attachment to it. In this way, one can

attach the new GD&T symbol to a characteristic point of another GD&T symbol . In this case, a

2D node will be created on the selected GD&T symbol. Respectively, you can select an attachment

point on the GD&T symbol being created (see “GD&T Symbol parameters”).
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Note that completion of the creation of tolerance without extension line will occur automatically right

after specifying the snapping point. Pressing  is not required in this case.

«Options» section

This section contains the following tolerance’s parameters:

Show parameters dialog for each element. If this parameter is enabled, then in the tolerance creation

command after specifying location of the tolerance on the drawing, the parameters dialog window

will automatically appear on the screen (the  option).

This mode allows us to work in the same way as in the previous versions of T-FLEX CAD – first specify

the tolerance location on the drawing, and then specify the tolerance’s parameter.

Create automatically. When this parameter is enabled, the tolerance creation will automatically be

completed right after specification of the snapping point of the tolerance’s rectangle (without

pressing ). This parameter is active only if the tolerance with extension line is created.

Topics in this section:

· GD&T Formlimits Parameters

· Edit Formlimits
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Datum

The command can be called in one of the following ways:

Icon Ribbon

3D Model > Additional > Datum

Draw > Appearance > Datum

Assembly > Additional > Datum

Sheet Metal > Appearance > Datum

Routing > Additional > Datum

Workplane > Appearance > Datum

Keyboard Textual Menu

The command creates geometric dimensioning and tolerancing datum feature symbols. Such symbols

mark physical features of a part, which are used as tolerancing reference.

The Datum command is closely related to the GD&T Formlimits command. In order to switch from

creating a feature control frame to creating a datum use the following automenu option:

<O> Create leader or GD&T Formlimit with leader

You can switch between the GD&T Formlimits and Datum at any stage of working with the

corresponding command.

Creating a datum feature symbol

Upon launching the command, the preview of the data feature symbol starts following the cursor.

The creation and editing techniques for datum feature symbols are similar to the ones described for

feature control frames. Arrow of datum feature symbol has a different ending tip.

Similar to the feature control frame, at any moment of datum feature symbol creation it is possible to

specify the symbol’s parameters in the command’s parameters window. The command’s parameters

window contains all main parameters of the symbol. To make the work more convenient, the window

is divided into several sections. Some of the sections – Coordinates, Arrows, Arrow, Options are the

same as similar sections of the GD&T Formlimits command's parameters window.

The Style section contains the set of parameters specific for datum feature symbol: 
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· Base

Datum name (capital letter). You can use a text variable as a datum name.

· Auto

This checkbox is enabled by default upon launching the command. As a result, the first letter in

the alphabet, which is not used by other views, gets assigned as a datum name. In future, upon

deleting a datum feature symbol, names of all datums, that are below the name of the deleted

one in alphabetical order, will be automatically reassigned, in order to ensure the continuous

numbering. If you disable the Auto checkbox upon creating or editing a datum feature symbol,

the its datum name will remain the same independently of other datums names.

· Placement. 

Defines placement of the frame in relation to the anchor point. There are eight different

placement options available the drop down list.

· Leader 

This checkbox only affects the creation of a symbol without arrow. It it's enabled, the extension

line is created between the linked node/line and the datum feature symbol.

GD&T Formlimits Parameters

As in other cases, the window for drawing tolerance parameters is divided into tabs, each of which

contains parameters of a certain type.

· Style Tab.

· Font Tab.

Default. Setting this parameter means that the newly created tolerance symbols will have the current

settings.

Style Tab

Tolerance’s parameters

The dialog in the command’s properties window contains all main parameters of the tolerance. To

make the work with this dialog more convenient the dialog is divided into several sections.

«Coordinates» Section

The first section “Coordinates” contains the fields for accurate specification of the coordinates of

snapping points of the tolerance. The current coordinates are dynamically determined when the cursor

moves inside the drawing’s window.

Depending on the tolerance snapping method various types of coordinates can be displayed in this

section. For example, if snapping of both points is free, the absolute coordinates of both snapping

points are shown in the properties window. When snapping the rectangle of tolerance/datum to the
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extension’s arrow, for the second point the shifts dx and dy with respect to the first point will be

specified, etc.

«Tolerance» Section»

The “Tolerance” section contains the main parameters of the tolerance.

From the drop down list select the necessary type of the tolerance:

Specification. This parameter determines how the value of the tolerance will be obtained. You can

enter it manually or it can automatically be calculated depending on the dimension’s value and

precision.

Expression. Can be one of the following choices:

- not defined;

R - if a circular or cylindrical GD&T symbol is defined by the radius;

D - if defined by the diameter;

Sphere R - if a spherical GD&T symbol is defined by the radius;

Sphere D - if a spherical GD&T symbol is defined by the diameter;

T - if the diametrical expression is used for GD&T symbols of Symmetry, Axis crossing,

Profile form and Surface form, as well as the positional GD&T symbols (in the case when

the positional GD&T symbol is bounded by two parallel lines or planes);

T/2 - if the radial expression is used for the same GD&T symbols as above

Dimension. Value of the dimension upon which the value of the tolerance depends. If, when setting

the tolerance, you tied it with the dimension, then the nominal value of the dimension will

automatically be inserted into the parameter’s field. The value of the dimension affects the tolerance’s

value in automatic calculation. 



T-FLEX CAD 17 Help

816

Precision. Takes integer values in the range from 3 to 16, inclusive. This parameter makes sense only

when using the automatic tolerance calculation.

Value. This is the value of the tolerance, either input manually or calculated automatically. A

predefined list of values is supplied for the manual parameter definition.

«Datum» Section

Datum 1, Datum 2 and Datum 3. These are the names of datums that can be used in the GD&T

symbol, defined as textual strings. Text variables can be used as datum names just like in the case of

any other text string parameters.

«Arrows», «Arrow», «Text on arrow», «Symbol on Arrow» Sections 

Next two sections of the properties window – “Arrows” and “Arrow” – should be considered together.

Together they allow us to specify parameters of the tolerance’s extension lines.

The “Arrows” section contains the list of all created arrows-extensions of the tolerance. The buttons to

the right of the list allow us to create/remove the arrows. By selecting one of the arrows in the list with

the help of , in the next sections of the properties window it is possible to specify parameters of

the given arrow.

The “Arrow” section contains the following parameters of the selected arrow:

Drop down list for selection of the arrow type at the beginning of the extension line. This list

coincides with the list of arrow ends used in the commands for construction of dimensions, graphic

lines and leader notes.

Field for specifying the arrow tip size at the beginning of the extension line. If the “From

document” value is selected, it will be calculated based on the given parameter «Arrows (end) size»

in the command “Set Document Parameters” (the «Line» tab).

Line thickness. Specifies thickness of arrow lines. In case when the value of this parameter is set to

«From document», it will be evaluated based on the given parameter «Other lines» in the command

“Set Document Parameters” (the «Lines» tab).

Clear under arrow. When this parameter is enabled, the drawing’s image under the tolerance’s arrow

is removed.

Clear under line. This parameter allows us to remove the drawing’s image under the tolerance’s arrow

line.

Draw extension line. This parameter controls drawing of the extension line for extension of the

tolerance, from the snapping point up to the arrow.
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Clear under extension line. When this parameter is enabled, the drawing’s image under the extension

line is removed.

«View» section 

Text after. This parameter allows entering an arbitrary text string that you want to be displayed after

the tolerance value. You can enter, for instance, conditions for dependencies, unevenness, etc. Use the

key combination <Alt+F9> for this purpose. 

Show dimension’s value. It can take the values “No” and “Yes”. If this parameter has the value “Yes”,

then the dimension’s value will be placed after the tolerance’s value. If necessary, in this line use the

variables by embracing them into curly brackets.

0.01/10

Extension line. This parameter is active only upon creation of the tolerance without extension line. It

controls the drawing of the extension line from the snapping node/line up to the tolerance.

«Placement» section

Placement. Defines the box positioning with respect to the attachment node. Eight different

positioning options are provided in the pulldown menu.

Rotate 90. Can be set or unset. If set, the GD&T symbol will be rotated by 90 degrees.
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Edit Formlimits

To edit GD&T/datum  symbol parameters, position, attachment or to set or break the relation

between a GD&T/ base and a drawing dimension, use the command "Edit GD&T Symbol":

Icon Ribbon

Draw > GD&T Formlimits

Keyboard Textual Menu

<EFO> Edit > Draw > GD&T Formlimits

Upon calling the command, the following icons are available in the automenu:

<*> Select All Elements

<Esc> Exit command

You can select a GD&T/ base symbol by pointing it with the mouse and clicking , or by using

multiple selections. As in the case of other drawing elements, the multiple selections are done by the

option . Using  together with the pressed key <Shift> adds an element to the list of selected

ones, while with the pressed key <Ctrl> - removes from the list of selected elements.

For multiple selections, you can use the options:

<P> GD&T Formlimit Parameters

<Alt+P> Copy properties from the existing element

<Del> Remove selected elements

<Esc> Cancel selection

When selecting one element, the following icons become available in the automenu:

<P> GD&T Formlimit Parameters 

<Alt+P> Copy properties from the existing element

<M> Select linked dimension



Drawing Creation

819

<Ctrl+M> Break tie with dimension (only upon selection of the element tied with the

dimension)

<Space> Add arrow

<Del> Delete arrow

<I> Select Other Element

<Del> Remove selected elements

<Esc> Cancel selection

To change location and snapping of the tolerance/base, it is necessary, after element selection,

indicate the marker of the necessary snapping point with the help of . The selected point will start

dynamically follow the cursor (according to the snapping method selected for the point). At the same

time the additional options will appear in the automenu: 

<T> Link to node 

<K> Break (kill) relations 

<F> Snap to arrow (available only upon selection of the second snapping point of the note)

/ / <U> Orthogonal Fixing/Fixing to point/Angle Fixing

<L> Set relation with line

<N> Select node

<D> Set relation with dimension

Pressing  will fix the new location of the snapping point of the tolerance. It is possible to change

location of any bend point exactly in the same way. It is also possible to cancel snapping of the point

with the help of the  option, snap tolerance to a node or line, specify/cancel relation with

dimension.

To remove one of the arrow-extensions of the tolerance, it is possible to use the  option. If the

tolerance/base being edited has only one extension, then this option is available in the automenu

right after selection of the element being edited. In case if the tolerance/base with several extension

lines, the  option will become available after selection of the necessary extension line. The

extension line can be selected in the command’s properties window (the “Arrows” section) or, for

example, by specifying its starting point in the drawing’s window. To remove the extension line, it is

also possible to use the  button next to the list of arrow-extensions of the tolerance/base in the

command’s properties window.

The option  allows modifying the parameters of the selected GD&T symbol notations. Modifying

the parameters in the case of a single selected element is similar to original defining of the GD&T

symbol parameters. 

In the case of multiple selections, calling the option <P> brings up the dialog box "GD&T Formlimit

Parameters". All parameters of the selected elements are subject to editing. 
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The option <D> allows setting the relation between the selected GD&T symbol and the necessary

drawing dimension. To delete the selected GD&T symbol, press the key <Del>. To select and modify

parameters of a group of GD&T symbols, use the same techniques as for other elements.

Cutting Line, View Arrow, View Label

The command can be called in one of the following ways

Icon Ribbon

Draw > Appearance > Section

Sheet Metal > Appearance > Section

Workplane > Appearance > Section

Keyboard Textual Menu

<SE> Draw > Section

This command creates cutting lines, view arrows and view labels. Cutting lines and view arrows placed

on 2D projections of 3D model can be used for creating projections of a corresponding type (see

Section Cut and Section View, Arrow View).
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Upon calling the command, you need to activate one of the following automenu options, in order to

select a type of an element to be created:

<S> Create two point Section

<D> Create multiple point section

<R> Create Arrow View

<V> Create View

The two point section option is active by default.

Callouts and labels of circular detail views are created automatically, when you create a view using the

Detail View with Caption command.

Callouts of arbitrary-shaped detail view can be drawn manually, using graphic lines

Upon selecting a type of element to be created, its preview starts following the cursor. Then you have

to define anchor points using one of the methods described in the Snapping of Cutting Lines, View

Arrows and View Labels section. Number of anchor points depends on the type of element and its

desired configuration. Upon defining all necessary points, the system switches to creation of a next

element.

At any stage of creating an element you can customize its parameters using either the  parameters

tool window, which is displayed automatically, or the  parameters dialog, which can be invoked by

activating the following automenu option: 

<P> Set Section Line Parameters 

In addition to options described above, the automenu of the Section command contains options

specific for particular type of element. Such options are described in sections describing

corresponding element types. Moreover, there's the option of selecting a 2D node. It is described in
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the Snapping section. And finally, there are following options, which are common for most 2D

elements creation commands:

<Alt>+<P> Copy Properties from Existing Element

<F4> Execute Edit Command

<Esc> Exit command

Topics in this section:

· Snapping Cutting Lines, View Arrows and View Labels

· Cutting Line

· View Arrow

· View Label

· Edit Cutting Line, View Arrow or View Label

Snapping Cutting Lines, View Arrows and View Labels

Upon selecting a type of element to be create, the preview starts following the cursor. Next, you have

to define anchor points. Number of points depends on the type of element and its desired

configuration., but methods of defining points are the same anyway. There are following methods of

defining anchor points:

· Move the mouse cursor over an arbitrary location in the drawing and click  or press

<Enter>.

The point will be snapped to the position of the cursor in the moment of clicking/pressing.

Then the system will switch either to defining a next point or to creating a next element. When

pointing a location you can use object snapping and snap anchor points to:

o 2D nodes;

o starting, middle and ending points of graphic lines; 

o intersections of construction lines (when selecting an intersection, a 2D node is created there

automatically).

When snapping anchor points to such elements, an associative link gets created between the

resulting and selected elements, i.e. the position of resulting element will change in future

upon changes in position of selected element.  

· Type in the X and Y Coordinates in the parameters window.

Initially, the Coordinates tab of the parameters window displays coordinates of the mouse

cursor. If a drawing view or 2D projection of 3D model is active, the coordinates are measured

in its coordinate system; otherwise - in current page's coordinates system. If you move the

cursor over one of the coordinates input boxes and click , you can type in values using the

keyboard. Upon typing in a value, the checkbox located to the left of the coordinate input box

gets enabled automatically. In result, the preview gets fixed along the corresponding axis. So,

the preview then can be moved only along a particular vertical or horizontal line. Such line is

indicated by blue dashes.
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Next, you can either type in the second coordinate in the same manner, or place the preview in

desired location by moving the mouse cursor and click  or press <Enter>. If the second

coordinate is defined by moving the mouse, then the system automatically switches to defining

a next anchor point or to creating a next element. If the second coordinate is typed in from the

keyboard, the preview gets fixed along both axes, which is indicated by the second dashed

blue line.

Finally, you have to confirm the coordinates by clicking  or pressing <Enter> anywhere in

the drawing. In result, the system will move on to defining a next anchor point or to creating a

next element. 

· Activate the following automenu option:

<N> Select Attachment Node

Upon activating this option, a click  in the drawing window snaps the current anchor point

to a nearest existing 2D node. In this case, an associative link gets created between the created

object and the selected 2D node, same as if you select a node using object snapping.

Upon defining all necessary points, the system automatically switches to creation of a next object.
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Cutting Line

Two-point section

A cutting line of two-point section can be created using the following automenu option of the

Section command:

<S> Create two point Section

This option is active by default, upon calling the command.

After activating the option, you have to define three points, using one of the methods described in the

Snapping section. First and second points define the position of the cutting line, the third one defines

offset from two others to the arrows of the cutting line. One of the arrows is located at the intersection

of the cutting line and a normal to the cutting line from the third point; another arrow is located

symmetrically to the first one. Positions of arrows represent the actual endpoints of the cutting line.

Fist and second points are indicated by square blue markers connected by the thin dashed line.

After defining the third point, the creation of the current cutting line ends, and the system starts

creation of another one.
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The view direction in relation to the cutting line can be switched to opposite, using the following

automenu option:

<Z> Change View Direction

Multiple-point section

The cutting line of multiple-point section can be created using the following automenu option of the

Section command:

<D> Create multiple point section

This option works in the same way as the single point section. The only difference is that for multiple-

point section you can define unlimited number of anchor points. Points are defined, using one of the

methods described in the Snapping section.  Upon defining one point, the command starts defining of

another one, and so on. After defining the desired number of points, you need to confirm the input,

using the following option:

<Ctrl>+<Enter>

,

<End>

Finish input

The cutting line is constructed as a polyline connecting points in the order of their creation. 

Instead of defining particular points, you can use an existing 2D path as a cutting line. Path can be

selected using the following option:
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<T> Select 2D path

Next, you have to set offset from endpoints of the cutting line to the arrows. It is done by defining

another point in the same way, as described for the one-point section.

After defining the last point, the creation of the current cutting line ends, and the system starts

creation of another one.

The view direction in relation to the cutting line can be switched to opposite, using the following

automenu option:

<Z> Change View Direction

Using a cutting line for creating a section cut or section view

If a 2D projection or drawing view is active at the moment of creating a cutting line, the line belongs

to such projection/view. If no projections/views are active, but the first anchor point of the cutting line

lays within projection's boundaries, then such line also belongs to the projection. Cutting lines

belonging to 2D projections of 3D models can be used for creating section views and section cuts,

using the Section View command.

Topics in this section:

· Parameters of Cutting Line

Parameters of Cutting Line

Parameters of a view label can be customized either in the  Parameters tool window or in the 

 Parameters dialog

 Parameters window

Following tabs are displayed in the parameters window, during creation of a cutting line: 

· Coordinates;

· General;
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· Dimensions.

Общие

The tab contains following parameters:

Text group:

· Text

Main text (view name), which is displayed at the outer sides of cutting line's the arrow.

· Auto

This checkbox is enabled by default, upon calling the command. As a result, the first letter in

the alphabet, which is not used by other views, gets assigned as a cutting line's text. If all

letters are used, then a subscript index number gets added to the letter (A
1
, B

1
, ... Z

1
, A

2
, B

2
 and

so on). In future, upon deleting a view, names of all views, that are below the name of the

deleted one in alphabetical order, will be automatically reassigned, in order to ensure the

continuous numbering. If you disable this checkbox upon creating or editing a cutting line, its

text will remain the same independently of names of other views.

· Additional

This parameter have two input boxes, where you can type in additional texts for each arrow.

The additional text is displayed near the main text in the same line.

· Zone and Sheet

A number of a zone and/or number of a sheet, where a linked view label is located, can be

added to the text of a cutting line. This option takes effect, only after creating a linked view

label. When creating a linked view label (manually or by using the cutting line for generating a

section view/cut), then the label automatically gets the same Zone and Sheet option as the

cutting line. In such case, manual change of the option for the cutting line invokes a dialog,

where the system asks, if the same option should be applied to the linked label, and vice versa.
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The detailed information on zones and their customization is available in the Zones. Document

Parameters section.

· Zone and Sheet Position

A number of a zone/sheet can be displayed By First Arrow or By Second Arrow.

Text Offset group:

· From arrow

Distance between arrow and nearest symbol of the text measured normal to arrow.

· Along arrow

Distance between cutting line and center of text measured along arrow. 

Standard

The section line can be drawn in accordance with either DIN/ISO or ANSI standards. The difference is

shown below. If the value of this parameters is set to From document, then the applied standard

depends on document parameters (Document Parameters > Page > Dimensions > Dimensions >

Standard). 

ЕСКД ANSI
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Show Dashed Line

This checkbox affects only the ANSI standard cutting lines. The effect is shown below.

Dimensions

The tab contains following parameters:

Lines group: 

1 - Length.

2 - Line Width.  If a value is displayed in the square brackets, then it is defined by document

parameters (Document Parameters > Page > Lines > Lines > Thick Lines).

3 - Offset on Start.

4 - Offset on End.

5 - Dash Length. For DIN/ISO lines defines length of dashes at line jogs. For ANSI lines defines

length of all dashes except starting and ending ones.

Arrows group:
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1 - Length.

2 - Size. If a value is displayed in the square brackets, then it is defined by document parameters

(Document Parameters > Page > Lines > Line Style > Arrow (End) Size).

3 - Line Width. If a value is displayed in the square brackets, then it is defined by document

parameters (Document Parameters > Page > Lines > Lines > Other Lines).

4 - Type. Type of the arrow tip can be selected in the drop-down list.

 Parameters dialog

The parameters dialog of a cutting line can be invoked in one of the following ways:

· double clicking   a cutting line in a view window or in the  Model Elements window;

· from the contextual menu, that appears upon clicking  a cutting line in a view window or in

the  Model Elements window;

· from the dynamic toolbar, that appears upon selecting a cutting line in a view window;

· from the automenu of the Section View and Edit Section commands.
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The parameters dialog of a cutting line label contains following tabs:

· Common

This tab contains same parameters, as the General tab of the parameters tool window

described above. Additionally, Level, Priority, Layer and Color can be customized in the

bottom of the tab.



T-FLEX CAD 17 Help

832

· Dimensions

This tab contains same parameters, as the eponymous tab of the parameters tool window

described above

· Font

This tab contains the same parameters, as the similar tab in parameters dialogs of other

detailing elements.

See Also:

· Default Parameters

· Defining Element Parameters

· Copying Parameters of 2D Elements

· Contextual Menus of Input Boxes

View Arrow

A view arrow can be created using the following automenu option of the Section command:

<R> Create Arrow View

Horizontal and vertical arrows

Upon activating this option, you have to define a single anchor point, using one of the methods

described in the Snapping section. 

defining a single anchor point allows you to create ether horizontal or vertical arrows. You can quickly

rotate an arrow by 90 degree, using the following automenu option:

<Z> Change View Direction

Upon defining an anchor point, the creation of the current arrow ends, and the system starts creation

of another one.

Arrows at arbitrary angles with typing in the angle value

An arrow at an arbitrary angle can be created in the same way, as horizontal and vertical arrows. For

this you need to type a value into the Angle input box in the parameters window or in the parameters

dialog. The angle is measured counterclockwise. Zero value corresponds to the horizontal right

direction of an arrow. 
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Arrows at arbitrary angles with defining the angle value by points

In order to define angle of arrow, using points, you have to activate the following automenu option: 

<B> Set First Attachment Point

Next, you have to define a point, using one of the methods described in the Snapping section. The first

point defines arrow's position. Upon defining the first point, following option gets activated

automatically:

<E> Set Second Attachment Point

Upon activation of this option, the preview of an arrow stops following cursor. Instead, it starts

rotating around the first point always pointing the cursor. A blue dashed line connects the cursor to

the arrow tip. Set the desired direction and click . The creation of the current arrow will be finished,

and the system will start creation of another one.

Position of text in relation to arrow

The position of text in relation to the arrow's line can be switched to opposite, using the following

option:

<Н> Change Text Placement

Using a view arrow for creating an arrow view

If a 2D projection or drawing view is active at the moment of creating a view arrow, the arrow belongs

to such projection/view. If no projections/views are active, but the first anchor point of the arrow lays

within projection's boundaries, then such arrow also belongs to the projection. Arrows belonging to

2D projections of 3D models can be used for creating arrow views, using the Arrow View command.

Topics in this section:

· Parameters of View Arrow

Parameters of View Arrow

Parameters of a view arrow can be customized either in the  Parameters tool window or in the 

 Parameters dialog

 Parameters window

Following tabs are displayed in the parameters window, during creation of a view arrow: 

· Coordinates;
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· Style.

Style

The tab contains following parameters:

Text group:

· Text

Text (view name), which is displayed near the arrow.

· Automatic

This checkbox is enabled by default, upon calling the command. As a result, the first letter in

the alphabet, which is not used by other views, gets assigned as an arrow's text. If all letters are

used, then a subscript index number gets added to the letter (A
1
, B

1
, ... Z

1
, A

2
, B

2
 and so on). In

future, upon deleting a view, names of all views, that are below the name of the deleted one in

alphabetical order, will be automatically reassigned, in order to ensure the continuous

numbering. If you disable this checkbox upon creating or editing a view arrow, its text will

remain the same independently of names of other views.

· Zone and Sheet

A number of a zone and/or number of a sheet, where a linked view label is located, can be

added to the text of an arrow. This option takes effect, only after creating a linked view label.

When creating a linked view label (manually or by using a view arrow for generating an arrow

view projection), then the label automatically gets the same Zone and Sheet option as the

view arrow. In such case, manual change of the option for the arrow invokes a dialog, where

the system asks, if the same option should be applied to the linked label, and vice versa.
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The detailed information on zones and their customization is available in the Zones. Document

Parameters section.

· Offset

Distance between the first anchor point and the center of the text measured parallel to the

arrow.

· Along Arrow

Distance between the first anchor point and the center of the text measured normally to the

arrow.

Arrow group:

1 - Length.

2 - Size. If a value is displayed in the square brackets, then it is defined by document parameters

(Document Parameters > Page > Lines > Line Style > Arrow (End) Size).

3 - Line Width. If a value is displayed in the square brackets, then it is defined by document

parameters (Document Parameters > Page > Lines > Lines > Other Lines).

4 - Type. Type of the arrow tip can be selected in the drop-down list.
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5 - Angle. Angle of the arrow. Measured counterclockwise. Zero value corresponds to the

horizontal right direction of an arrow.

 Parameters dialog

The parameters dialog of a view arrow can be invoked in one of the following ways:

· double clicking   an arrow in a view window or in the  Model Elements window;

· from the contextual menu, that appears upon clicking  an arrow in a view window or in the

 Model Elements window;

· from the dynamic toolbar, that appears upon selecting an arrow in a view window;

· from the automenu of the Section View and Edit Section commands.

The parameters dialog of a view arrow contains following tabs:

· Style

This tab contains same parameters, as the eponymous tab of the parameters tool window

described above. Additionally, there are X and Y Coordinates of the first anchor point.

Moreover, Level, Priority, Layer and Color can be customized in the bottom of the tab.

· Font

This tab contains the same parameters, as the similar tab in parameters dialogs of other

detailing elements.

See Also:

· Default Parameters

· Defining Element Parameters

· Copying Parameters of 2D Elements

· Contextual Menus of Input Boxes
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View Label

Labels of circular detail views, section view and cuts created by existing cutting lines, as well as labels

of arrow views created by existing view arrows, are generated automatically upon view creation. For

other types of views labels can be created manually using the following automenu option of the

Section command:

<V> Create View

Upon activating this option you have to define a single anchor point, using one of the methods

described in the Snapping section.

After defining an anchor point, the creation of the current label ends, and the system starts creation of

another one.

Label text can be defined in one of the following ways:

· Type the text into the input boxes in the parameters window or in the parameters dialog.

· Select an existing cutting line or view arrow, using the following automenu option:

<C> Select Section Type

Upon activating this option, select  a desired object. Main text of the current label (Text

over Line) will be the same as the text of the selected object. This action creates an associative

link, i.e. the text of the current lable will be automatically updated upon future changes in the

text of the selected object and vice versa. 

Topics in this section:

· Parameters of View Label

Parameters of View Label

Parameters of a view label can be customized either in the  Parameters tool window or in the 

 Parameters dialog

 Parameters window

Following tabs are displayed in the parameters window, during creation of a view label: 

· Coordinates;

· Style.
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Style

The tab contains following parameters:

Text over Line:

· Text

Main text of a label.

· Offset

Vertical distance between an anchor point and a bottom of main text.

· Auto

This checkbox is enabled by default, upon calling the command. As a result, the first letter in

the alphabet, which is not used by other views, gets assigned as a label's main text. If all letters

are used, then a subscript index number gets added to the letter (A
1
, B

1
, ... Z

1
, A

2
, B

2
 and so on).

In future, upon deleting a view, names of all views, that are below the name of the deleted one

in alphabetical order, will be automatically reassigned, in order to ensure the continuous

numbering. If you disable this checkbox upon creating or editing a view label, its main text will

remain the same independently of names of other views.

· Zone and Sheet

A number of a zone and/or number of a sheet, where a linked view arrow, cutting line or detail

circle is located, can be added to the main text of a label. If a text of a label is defined by

selecting a linked element, then the label automatically gets the same Zone and Sheet option

as the linked element. In such case, manual change of the option for the label invokes a dialog,

where the system asks, if the same option should be applied to the linked element, and vice

versa.

The detailed information on zones and their customization is available in the Zones. Document

Parameters section.
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Text under Line.

· Text

The additional text, which is located under the main one.

· Offset

· Vertical distance between an anchor point and a top of additional text.

Underline Text

Enabling this checkbox draws a horizontal line between the main and additional texts through the

anchor point. Length of the line is equal to the width of the main text.

Line Width  

Thickness of the underline. If a value is displayed in the square brackets, then it is defined by

document parameters (Document Parameters > Page > Lines > Lines > Other Lines).

 Parameters dialog

The parameters dialog of a view label can be invoked in one of the following ways:

· double clicking   a label in a view window or in the  Model Elements window;

· from the contextual menu, that appears upon clicking  a label in a view window or in the

 Model Elements window;

· from the dynamic toolbar, that appears upon selecting a label in a view window;

· from the automenu of the Section View and Edit Section commands.
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The parameters dialog of a view label contains following tabs:

· Style

This tab contains same parameters, as the eponymous tab of the parameters tool window

described above. Additionally, there are X and Y Coordinates of the anchor point. Moreover,

Level, Priority, Layer and Color can be customized in the bottom of the tab.

· Font

This tab contains the same parameters, as the similar tab in parameters dialogs of other

detailing elements.

See Also:

· Default Parameters

· Defining Element Parameters

· Copying Parameters of 2D Elements

· Contextual Menus of Input Boxes

Edit Cutting Line, View Arrow or View Label

The command can be called in one of the following ways:

Icon Ribbon

Keyboard Textual Menu

<ESE> Edit > Draw > Section

The command edits cutting lines, view arrows and view labels, including those created automatically.

Following options are available in the automenu, upon calling the command:
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<*> Select All Elements

<Esc> Exit command

Next, you can select  an element to be edited. You can use a rectangular frame for selecting

multiple elements, or use the automenu option for selecting all. Upon selecting multiple element,

following option additionally appears in the automenu: 

<Del> Delete Selected Element(s)

Upon selecting a single element, following options are available in the automenu, regardless of a type

of selected element:

<Ctrl>+<Enter> Finish Editing

<P> Parameters

<Alt>+<P> Copy Properties from Existing Element

<N> Select Attachment Node

<I> Select Other Element

<Del> Delete entity

<Esc> Exit command

Additionally, there are options that appear upon selecting element of a particular type: 

1. Cutting line.

<C> Select Point

This option gets activated automatically, upon selecting a cutting line. While it's active, you can select

anchor points represented by square blue markers. Click  a marker to select a point. Selected pint

starts following the cursor. Set the new position of the point by moving the cursor and click  again

to confirm repositioning. As long as point follows the cursor, the  Delete entity option can be

used for deleting such point. Next, you can select another point and reposition it in the same manner.

Following option is an alternative to selecting existing points:

<L> Add Point

While it's active, it is impossible to select existing points. Instead, clicking  anywhere in a drawing

window creates a new point under the cursor. The system automatically detects two nearest points of
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the current cutting line an adds a created point to the line between these two. A marker of a new

point follows the cursor. Set the desired position and click  to confirm it. 

<Z> Change View Direction

This option switches a view direction in relation to the cutting line to an opposite one in the same way

as, when you create a cutting line.

2. View arrow.

<Z> Change View Direction

<H> Change Text Placement

These options work in the same way, as when creating a view arrow.

View arrow or view label selected for editing follows the mouse cursor. Clicking   fixes the new

position of a label/arrow and finishes editing. If a view arrow is defined by two anchor points, then

only the first one gets re-defined during editing. The arrow remains pointing the second anchor point

from the new position.

See Also:

· Transparent Editing

· Multiple 2D Elements Editing 

· Defining Element Parameters

· Copying Parameters of 2D Elements

Leader Notes

The command for creating leader notes can be called in one of the following ways:
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Icon Ribbon

3D Model > Additional > Leader Note

Draw > Appearance > Leader Note

Assembly > Additional > Leader Note

Sheet Metal > Appearance > Leader Note

Surfaces > Additional > Leader Note

Weld > Additional > Leader Note

Routing > Additional > Leader Note

Primitives > Additional > Leader Note

Keyboard Textual Menu

<IN> Draw > Leader Note

Leader notes are used for creating various drawing elements like BoM positions balloons,

designations of brand marks, part codes, etc. Also, leader notes can be created in 3D window either

on active workplane, or not. Usually, a leader note is composed of two parts: the arrow (leader) and

the shoulder (note). If necessary, it is possible to create leader notes that contain several arrows.

Arrows might be straight or have jogs.

When creating a leader note in 2D window or in the draw on workplane mode, following steps are

performed upon calling the Leader Note command:

1. Setting the necessary configuration of options, which define the way of command's

operation;

2. Defining a shape and position of a main arrow;

3. Defining an orientation, text and other parameters of a main shoulder;

4. Adding additional shoulders and defining their parameters;

5. Adding additional arrows;

6. Defining parameters of each arrow;

7. Finishing input .

The only mandatory steps are defining a starting node and an ending node of a main arrow. If the

Create Automatically option is disabled, then finishing input is also mandatory. Other steps are

optional.

When defining positions of arrow's nodes, command's automenu contains specific set of options

described in the Shape and Position of Leader Note's Arrow section plus following options, which are

common for most 2D elements creation commands:
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<P> Set Leader Note Parameters

<Alt>+<P> Copy Properties from Existing Element

<Esc> Exit command

After defining a position of main arrow's ending node the leader note' creation command essentially

switches to the editing mode, which have the same set of automenu options as the leader note's

editing command has upon selecting a single leader note. During editing of arrow's nodes and adding

additional nodes using manipulators both sets of options are available simultaneously. 

Creating a leader note in 3D scene without drawing on a workplane has some specifics, but for the

most part is similar to the way of operation described above.

Special commands are available for creating assembly drawing's balloons, bend notes and weld

symbols.

Main Components of Leader Note
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A - text of the main shoulder

B - text of the additional shoulder

C - text below shoulders

D - text above the main arrow

E - text below the main arrow

1 - corners of shoulders

2 - jog of the main arrow

3 - symbol on the main arrow

4 - witness line of the main arrow

5 - additional arrow

Leader Note's Manipulators

Manipulators can be used for quick editing of leader notes in 2D or 3D window. Click  on a

manipulator to perform a corresponding action:

1 -
Change the position of the main arrow's starting node

2 -
Change the position of the main arrow's additional node

3 -
Change the position of main arrow's ending node, 

which defines the position of the shoulder's start

4 -
Change the position of the additional arrow's starting node 
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5 -
Change the position of the additional arrow's ending node 

and convert this node into transitional (jog)

6 -  
Add a transitional node (jog) to an arrow

7 -
Change the appearance and and size of arrow's starting node

8 -
Add a symbol on arrow

9 -
Change the position of the symbol on arrow

10 -
Add a text above the arrow'

11 -
Add a text below the arrow'

12 -  
Change the position of texts above and below the arrow

13 -
Add an additional shoulder

14 -
Switch the way positioning additional shoulders in relation to the main shoulder 

(Add shoulders above  or below  )

15 -
Add a text below shoulders

When some of the shoulder doesn't have a text, a manipulator  for adding a text is available.

Manipulators for adding additional shoulders , their texts  and switching position  

become available only after defining a text of the main shoulder.

Manipulators are displayed not only within leader note's creation and editing commands, but also in

the command standby mode upon hovering the cursor over a leader note. Thus, you can call the

leader note's editing command by simply clicking  a manipulator, even if the transparent editing

of 2D elements is disabled. Manipulators    become orange  upon hovering the cursor over

them.

Upon clicking  a manipulator for adding a text, it gets replaced by the text input box

. You can confirm  or cancel  input using buttons located in right side of the

input box. Input can also be canceled using the <Esc>.

Keep in mind, that pressing <Esc> exits the command, if the input focus is outside the

aforementioned text input box.

Input of the main shoulder's text can be confirmed using <Enter>. When inputting a text below

shoulders, <Enter> adds a new row. When inputting texts of additional shoulders as well as texts

above and below an arrow, <Enter> has no effect.

Keep in mind, that confirming the input of main shoulder's text using either  or <Enter> exits

the command.
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Automatic Finishing of Leader Note’s Creation

By default, after defining positions of main arrow's starting and ending points the command remains

in the mode of editing the created leader note. This allows us to add to the leader note the necessary

number of additional arrows, create jogs on the arrows, specify and edit leader note’s parameters.

After finalizing the leader note's appearance, it is required to explicitly confirm its creation by clicking

the  button in the command’s parameters window or pressing <Enter>.

It is also possible to use another work algorithm. In the Options tab of the command’s parameters

window you can find the Create automatically checkbox. When this checkbox is enabled, creation of

the leader note will automatically be completed right after positioning the ending point of the main

arrow (which also defines the position of the main shoulder).

Note that in this case it is required either to specify parameters of the leader note being created

before positioning of the ending node or additionally enable the Show parameters dialog for each

element checkbox. In the latter case, after positioning the ending point, the leader note’s parameters

dialog will appear on the screen. This allows us to work as with the previous versions of T-FLEX CAD –

first specify location of an element on the drawing and then specify its parameters.

Creating Leader Notes in 3D scene without drawing on a workplane

Creating 3D leader notes for the most part is the same as creating 2D leader notes. However, there are

some specific requirement described below.

3D leader note can only have a single arrow. Adding additional arrows is not available.

A starting node of an arrow should be linked to some element of a model, so you have to select  a

node, face, edge or vertex in the 3D scene. Linking point on a face or edge is defined by a position of

the cursor at the moment of selection. 

An ending node of an arrow can not be linked to a particular element, but it is always placed on a

plane, which passes through a linking point of a starting node and is parallel to one the model's

planes (to Front plane by default). Thus, a text of a leader note lays in the same plane. You can select

another plane using the following automenu option:

<Т> Select Plane

An angle between shoulder and arrow in the selected plane changes automatically depending on the

camera position, ensuring the readability of a text.

Leader notes in 3D have same manipulators as in 2D.
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By default, parts of leader notes as well as other 3D annotation elements hidden behind non-

transparent elements of a 3D model are not displayed. If necessary, you can enable the Display

annotations over 3D model option (Options > 3D > 3D).

Commands for Creating Assembly Drawing's Balloons, Bend Notes and Weld Symbols.

You can use the basic Leader Note command for creating assembly drawing's balloons (see Linking

Leader Note to Product Composition), bend notes, weld symbols and leader notes referring to

technical requirements if necessary. However, it is more convenient to use special command, which

provide extended capabilities:

·  Callouts

·  Bend Note

·  Weld Symbol

·  Leaders by Drawing Notes

These commands use the basic Leader Note command for actual creation of designations, so they

have similar basic principles and user interface, but additionally provide the ability to create multiple

notes at once, automatic detection of bend lines and weld type, creating associative links between

technical requirements' records and leader note, as well as compliance with specific standards.

Default parameters of basic leader notes, assembly drawing's balloons, bend notes and weld

symbols are handled independently of each other.

Topics in this section:

· Shape and Position of Leader Note's Arrow

· Main Shoulder of Leader Note

· Linking Leader Note to Product Composition

· Additional Shoulders of Leader Note

· Additional Arrows of Leader Note

· Parameters of Leader Note's Arrows

· Options of Creating Leader Notes

· Parameters Dialog of Leader Note
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· Edit Leader Notes

Shape and Position of Leader Note's Arrow

Upon calling the Leader Note command, it is mandatory to define positions of two nodes (starting

and ending) of the main arrow. Position of the ending node also defines a position of the main

shoulder. 

When creating a leader note on a drawing or in the draw on workplane mode, nodes' positions might

be either free or linked to some existing elements. A created link might be deleted if necessary.

When creating a leader node in the 3D view window without drawing on a workplane, the starting

node of the arrow should always be linked to some element of a model. Such linking can not be

deleted. See more in Creating Leader Notes in 3D scene without drawing on a workplane.

Free Positioning of Leader Note's Arrow Nodes

At first, the manipulator  of arrow's starting node and the preview of the leader note are attached to

the cursor. Absolute coordinates of the node are displayed in the Coordinates tab of command's

parameters window. They are dynamically tracked as the cursor moves in the drawing window.

Enabling a checkbox located near the X or Y coordinate's name fixes such coordinate, so it stops

depend on cursor's position. Checkboxes are enabled automatically, when you type in coordinates

using keyboard. Fixing of coordinates is indicated by a dashed blue line on a drawing: vertical for X

coordinate, horizontal for Y.

Coordinates can be inputted:

· Using the cursor

Simply place the cursor in the necessary position and click .

· Using the keyboard

Type in the X coordinate, then either press <Tab> or click  the Y coordinate's input box,

then type in the Y coordinate and click  at any position within the 2D or 3D window

(depending on which window you're working in).

· Using the combination of aforementioned methods

Type in one of the coordinates first, then define the second one using the cursor.

After positioning the starting node, its manipulator disappears and the manipulator  of the ending

node gets attached to the cursor. By default, the ending node is positioned in relation to the starting

one. Therefore, the relative coordinates dx and dy are used instead of absolute X and Y.
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For positioning the ending node in absolute coordinates you need to disable the following automenu

option: 

<F> Attach to Arrow

If the ending node is positioned in relative coordinates, then the ending node follows the starting one,

when editing the starting node's position. If the ending node is positioned in absolute coordinates,

then editing the starting node's position doesn't affect the ending node.

Initial shape of the leader note The result of repositioning the starting node

Attaching to arrow is disabled Attaching to arrow is enabled

Regardless of the type of used coordinates, they're inputted in the same way as described above.

After positioning the ending node, the arrow configuration no longer depends on the cursor

movement and all manipulators of arrow's nodes are displayed as well as the main shoulder's text

input box  (see Main Shoulder of Leader Note). If you cancel  the text input, then

manipulators  for adding text of the main shoulder and below shoulders also appear.

Note that, after positioning the ending node of the arrow, the input focus is automatically

shifted to the main shoulder's text input box. If you confirm the text input using <Enter> or ,

it will finish the leader note's creation.

Usage of manipulators for changing the appearance and and size of arrow's starting node , adding

a symbol on arrow , adding text above and below arrow , is described in the Parameters of

Leader Note's Arrows section.

The green circle manipulator  allows adding an transitional node to the arrow. Positioning of

transitional nodes is performed in the same way as positioning of the ending node either in absolute
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or relative coordinates. After adding a transitional node, new manipulators  for adding more

transitional nodes appear on each segment of the arrow. Thus, you can can create arrows with

multiple jogs

Each node of the created arrow can be repositioned. To do so, click  the manipulator  of a

necessary node. The node will start following the cursor, so you can input its coordinates in the same

way as they were initially defined. 

If you want to delete a transitional node, click  its manipulator  and then use the following

automenu option:

<Del> Delete point

Linking Leader Note's Arrow Nodes to Drawing’s Elements

Any of arrow's nodes can be linked:

· to 2D node or intersection/connection point of construction or graphic lines (selecting an

intersection point automatically creates a 2D node, selecting a connection point links the

arrow to endpoint of one of the connected lines);

· to construction or graphic line;

· to elements of a 3D model.

Linking Leader Note's Arrow Nodes to 2D Nodes

When positioning an arrow's node, activate the following automenu option in order to link it to a 2D

node:

<N> Select Node

Then move the cursor over a necessary 2D node and click .

First node of an arrow can be link without activating this option. Simply move the cursor over a

2D node (with active 2D nodes snapping filter on the filter toolbar) and click  - link will be

created anyway. However, when positioning other nodes of an arrow, activating the option is

mandatory for establishing a link.

If you activate the option and click  a blank area of a drawing without pointing directly to

the 2D node, the system will detect a nearest existing 2D node automatically.
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In result, arrow's node coordinates will always coincide with the selected 2D node's coordinates, upon

further changes in the latter. Additionally you can apply an offset from the selected 2D node. To do

so, return to editing arrow's node by clicking its manipulator . The arrow's node starts following the

cursor. Link between the arrow's node and the 2D node is indicated by the dashed line. The

Coordinates tab of the command's parameters window contains offsets dx and dy from the linked 2D

node. Then you can input required offsets in one of the ways described above.

Use the following automenu option for deleting offsets and snapping the arrow's node directly to the

2D node again:
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<F> Link to Node

Linking Leader Note's Arrow Nodes to Construction and Graphic Lines

Linking to a construction line is only possible, if at least one 2D node lays on such line. 

Move the cursor over a construction or graphic line, when positioning an arrow's node, in order to link

it. The line gets highlighted in red (graphic) or green (construction). Then click  the line. In result,

the arrow's node starts moving along the selected line as you move the cursor. Place the node in

necessary position and click  to finish positioning.

As you move the node along the selected line, the Coordinates tab of the command's parameters

window contains the Offset parameter, which defines the position of the node on the selected line.

The offset on curves (circle, arc ellipse, spline) is measured in relative units ranging from 0 to 1,

where 0 - start of the curve, 1 - end of the curve. Start and end of closed curve are the same

point.

The offset for straight lines is measured in absolute units from the starting or ending point of the

line, depending on which point is closer to the current position of the node. 
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You can type in the offset value using the keyboard for precise positioning. Typing in the value

enables the checkbox located to the left side of the Offset input box. In result, the node stops

following the cursor. Dashed blue lines indicate fixing of the offset. Click  anywhere on the

drawing to confirm the positioning.

Alternatively, you can use the following automenu option:

<L> Set relation with Line

Click  anywhere on the drawing after activating the option, and the system will automatically

detect the nearest construction line. 

Linking to a construction line is only possible, if at least one 2D node lays on such line. 

This option isn't mandatory for establishing a link, unlike the similar option for linking to a 2D node.

The leader note has following modes of handling the angle between the arrow and first node's linking

line:

<U> Fixing to Point

<U> Angle Fixing



Drawing Creation

855

<U> Orthogonal Fixing

Sequentially click the corresponding automenu option or press <U> to switch between modes.

Fixing to point  preserves the position of the second node of the arrow in relation to the first

node upon further repositioning of the first node. 

Angle Fixing  preserves the angle between the arrow and the linking line upon further

repositioning of the first node.

Orthogonal Fixing  keeps the arrow normal to the linking line upon further repositioning of the

first or second node.

Regardless of which node is being currently edited, these modes are applied to the angle of the

arrow's starting segment, i.e. the segment between the first and second node. Second node

might be ending or transitional.

Switching modes has no effect if first node has no linking, first or second node is linked to a 2D

node, or second node is linked to a line.

Initial configuration Results of repositioning starting nodes

Delete Linking 

Linking of an arrow's node to a 2D node, construction line or graphic line can be cancelled using the

following automenu option:
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<K> Break relations

See Also:

· Parameters of Leader Note's Arrows

· Additional Arrows of Leader Note

Main Shoulder of Leader Note

A position of leader note's main shoulder is defined by a position of a main arrow's ending point (see

Shape and Position of Leader Note's Arrow). By default, a shoulder is created horizontally to the right

side from ending point. You can sequentially rotate shoulder by 90 degree around arrow's ending

point using the following automenu option:

<Z> Change leader line jog orientation

Thus, the four variants of shoulder orientation are possible:

The Leader tab of the command's parameters window allows to define following parameters of the

main shoulder: 

Text 

This is the text on the leader note's shoulder. 

When defining this and other text parameters of a leader note, you can use variables by entering

them in curly brackets (braces).

The text may also be defined using manipulator:
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Text Under 

This is the text under all shoulders. It may also be defined using manipulator: 

Corner

Defines the type of the shoulder. There are standard and custom types of shoulders 

Thickness

Defines the thickness shoulder's lines. If the parameter value is shown in square brackets, then it is

defined by Document Parameters (Document Parameters > Page > Lines > Lines > Other Lines). 

Size

It defines the length of the shoulder. If the Auto value is used, it will automatically adjust to the length

of the text. 

Standard

Defines the leader style standard. There are two standards for leaders - ANSI or BS/DIN/ISO. If this

parameter is set to Default, then leader notes will follow the standard specified in Document

Parameters (Document Parameters > Page > Detailing elements > Leader Notes > Standard) 
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Clear background under leader

When this checkbox is enabled, the drawing elements behind the shoulder are not displayed. 

Clear background under corner

When this checkbox is enabled, the drawing elements behind the corner are not displayed.

Increment by 1

This parameter is only available until you initially place the ending point of a main arrow. It serves to

quickly define BoM items. A number should appear on the shoulder instead of text – a BoM item

position number. When the next leader note is created, the former current number is automatically

incremented by one. It should be noted that, when using this approach, the number that appears on

the leader will not be actually linked to the BoM position number.  

If you want to establish a link between position number and leader note's text, so that it will

update accordingly upon further changes, please refer to the Linking Leader Note to Product

Composition section.

The special Callouts command is available for creating balloons on assembly drawing.

Fit text to borders

This checkbox can be enabled for circular shoulders  (balloons). When it is disabled (by default),

the balloon automatically stretches to fit a long text. When it is enabled, the balloon's size always

remains default, and a font of a long text gets automatically narrowed in order to fit the balloon.

Custom Leader Note's Shoulders

T-FLEX CAD allows a user to make his own types of leader note's shoulders. Custom shoulders are

created as standard parametric fragments and saved in the folder …\T-FLEX Parametric CAD

17\Libraries\System\Leader Symbols (Leader Symbols library). 
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Files located in this folder are added as icons to the Corner list in the leader note command's

parameters window and in leader note's parameters dialogs. Upon creating the leader note, location

of the fragment-leader image is determined by the fixing vector which must exist in the fragment

model. 

For controlling parameters of the custom leader note, the dialog of the fragment variables or the

custom dialog (if it was created in the fragment) will be used. To call the dialog of the fragment

variables (or the custom dialog), use the special button  which appears in leader note's parameters

or call the Annotation Properties… command in the contextual menu of a leader note that uses a

custom shoulder.

See also:

· Linking Leader Note to Product Composition

· Additional Shoulders of Leader Note

· Contextual Menus of Input Boxes

Linking Leader Note to Product Composition

This section describes linking leader notes to product composition using the basic Leader Note

command. Alternatively, you can use special commands for creating assembly drawing's

balloons, bend notes and weld symbols.

Use the following automenu option to establish a link between leader note's text and product

composition item's position number:

<W> Link to Product Composition

Activating this option invokes the  Product Composition tool window, if it isn't already displayed.

Then you need to select a shoulder, whose text will be linked to the position number. Selection of a

shoulder is performed in the list of the Multiple Jogs tab of the command's parameters window. The
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top row of the list is the main shoulder of the leader note, other rows - additional shoulders. If a text

of a shoulder is empty, then a corresponding row of the list is also empty, but still selectable. Click 

a row to select it. Then click a necessary item in the  Product Composition window. In result, the

position number of the selected item becomes the text of the selected shoulder. If text of a shoulder is

linked to the product composition, then it is shown in curly brackets in leader note's parameters.

T-FLEX DOCs Product Structure positions

When working in the T-FLEX DOCs integration mode, contextual menus of elements in the  Product

Structure DOCs tool window contain the  Insert Callout command. It can be used for creating a

Leader Note with a position of selected DOCs product structure item used as the main shoulder's text.

Rest of leader note's parameters are defined in the same way as when using the basic Leader Note

command.

Additional Shoulders of Leader Note

The Multiple Jogs tab of the command's parameters window contains the list of all shoulders of the

current leader note:

The top row of the list represents the main shoulder, others - additional shoulders. The rows contains

texts of corresponding shoulders. If a shoulder has no text, then a corresponding row of the list is
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blank. Regardless of text presence, any row in the list can be selected using . Double-clicking 

 a row allows to edit a text of a corresponding shoulder.

Right side of the list contains following buttons:

·  New <Ins>

Add new additional shoulder to the bottom of the list. Additional shoulders may also be

added by double-clicking  the blank space of the list.

Another way of adding a shoulder is using the manipulator:

·  Delete <Del>

Deletes a selected shoulder. The main shoulder (top row of the list) cannot be deleted.

·  Move up <Alt>+<Up> and  Move Down <Alt>+<Down>

Move a selected shoulder up or down the list, thus changing their order on a drawing.

Shoulders are shown on drawing in accordance with their order in the list. 

Following parameters are available below the list of shoulders:

Strings Height

Defines the distance between shoulders. When the Auto setting is used, the distance is set

automatically depending on the font size.

Align jogs length

When this checkbox is enabled (by default), multiple shoulders are drawn with the same length,

otherwise each shoulder has individual length, which depends on a length of its text.

Append Upwards

By default, this checkbox is disabled, so shoulders are placed top-down on the drawing or in the 3D

window, i.e. the main shoulder is located at the top and the order of shoulders is the same as in the list

of the parameters window. Enabling this checkbox switches shoulders placement to bottom-up, i.e.

the main shoulder is located at the bottom and the order of shoulders is opposite to their order in the

list of the parameters window. Moreover, the order of shoulders placement can be switched using

manipulators:
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Additional Arrows of Leader Note

A single leader note may have multiple arrows. The list of arrows of the current leader note is show in

the Arrows tab of the command's parameters window.

Arrows can be selected in the list using . Parameters of a selected arrow are displayed in the

Arrow, Arrow Text and Symbol on Arrow tabs of the command's parameters window.

The arrow created first is considered the main arrow, others - additional. The ending node of the main

arrow defines the position of leader note's shoulder.

Additional arrow may be added using the [+] button, which is located in the right side of the arrows

list, or using the following automenu option:

<Space> Add Arrow

In result, the preview of the new arrow starts following the cursor. Shape and position of additional

arrows are defined in the same ways as shape and position of the main arrow, with a single additional

condition:

The position of a new additional arrow's ending node should coincide with a position of one the

nodes of previously created arrows. Placing the ending node of a new additional arrow in an

arbitrary position converts this node into a transitional one. Adding transitional nodes goes on

until the last node finally coincides with one of the nodes of previously created arrows.
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Additional arrows have same manipulators as the main one.

You can delete an additional arrow using the following automenu option:

<Shift>+<D> Delete Arrow

The option is available, while you are creating or editing additional arrow's nodes.

Another way of deleting an additional arrow is to select  it in the arrows list and use the [-] button

located in right side of the list. This button is always available.

The main arrow cannot be deleted.

See also:

· Shape and Position of Leader Note's Arrows

· Parameters of Leader Note's Arrows

Parameters of Leader Note's Arrows

Arrow, Arrow Text and Symbol on Arrow tabs of the Leader Note command's parameters window

allow to define parameters of an arrow, which is currently selected in the list of arrows.

Arrow

The tab contains following parameters:
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Drop-down list for selecting the appearance of arrow's starting node

It is located at the top of the tab. This list mostly coincides with the list of arrows used in dimension

and graphic line commands. However, for leader notes the list is appended with two special arrow

types:  and . For these arrow types two input boxes are available for specifying the length and

height, instead of the single arrow size input box described below. By varying those parameter values,

you can get leader notes with a rectangle- or oval-shape tip of arbitrary size and aspect ratio.

Arrow's starting node size input box

It is located to the right side of the aforementioned drop-down list. If the value is shown in square

brackets, then it is defined by Document Parameters (Document Parameters > Page > Lines > Line

Style > Arrow (End) Size).

Size and appearance of the starting node may also be defined using manipulator:

Draw Leader

This checkbox controls drawing of the witness line between the linking object an the arrow's starting

node.
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1 - Draw Leader checkbox is enabled

2 - Draw Leader checkbox is disabled

Linking line is highlighted in red

Line Width

Defines the thickness of arrow lines. If the value is shown in square brackets, then it is defined by

Document Parameters (Document Parameters > Page > Lines > Lines > Other Lines).

Clear Background under Arrow

When this checkbox is enabled, the drawing elements behind the arrow's starting node are not

displayed. 

Clear Background under Line

When this checkbox is enabled, the drawing elements behind the arrow's line are not displayed. 

Clear Background under Leader

When this checkbox is enabled, the drawing elements behind the witness line are not displayed. 

Arrow Text

The section contains input boxes for text displayed above and below the arrow:

Alternatively, these texts can be defined using using manipulators:



T-FLEX CAD 17 Help

866

Moreover, after typing in the text, its position can be adjusted using the manipulator . Upon clicking

 the manipulator, the text starts following the cursor along the arrow's line. Move the text to the

necessary location and click  to confirm the repositioning.

Symbol on arrow

The tab contains parameters of the symbol on the selected arrow.

Symbol

Defines the type of the symbol, is displayed across the arrow's line. Normally it is used to indicate

various drawing notes. 

A symbol may also be selected using manipulator:
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Clear Background

When this checkbox is enabled, the drawing elements behind the symbol on arrow are not displayed. 

Line Width

Defines the thickness of the symbol on arrow. If the value is shown in square brackets, then it is

defined by Document Parameters (Document Parameters > Page > Lines > Lines > Other Lines).

Moreover, after adding the symbol on arrow, its position can be adjusted using the manipulator .

Upon clicking  the manipulator, the symbol starts following the cursor along the arrow's line. Move

the symbol to the necessary location and click  to confirm the repositioning.

See also:

· Shape and Position of Leader Note's Arrow

· Additional Arrows of Leader Note

Options of Creating Leader Notes

The Options tab is located in the bottom part of the Leader Note command's parameters window. It

contains following checkboxes:
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Show Dialog for Each Element

If you enable this checkbox, then the leader note's parameters dialog  will appear automatically

after defining the position of main arrow's ending node.

More information on this option is available in the Automatic Finishing of Leader Note's

Creation section.

Create automatically

If you enable this checkbox, then the creation of a leader note will automatically be finished right after

defining the position of main arrow's ending node.

More information on this option is available in the Automatic Finishing of Leader Note's

Creation section.

Snap within Projection View

Defines, whether a leader note will belong to a particular drawing view or to a whole drawing page.

More information on this option is available in the Snapping Dimensions and Leader Notes to

Drawing Views section.

Parameters Dialog of Leader Note

The parameters dialog  of a leader note can be invoked in one of the following ways:

· by double-clicking  a leader note in 2D or 3D view window or in  Model Elements

window;

· from the contextual menu, invoked by clicking  a leader note in 2D or 3D view window or

in  Model Elements window;

· from the dynamic toolbar, displayed upon selecting a leader note in 2D or 3D view window;

· from the automenu of the Leader Note and Edit Leader Note commands.
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The parameters dialog contains following tabs:

· Common

Contains same parameters as the Leader tab of the Leader Note command's parameters

window. Additionally allows to customize Level, Priority, Layer and Color.

· Multiple Jogs

Contains same parameters as the Multiple Jogs tab of the Leader Note command's

parameters window. 

· Arrows

Contains same parameters as the Arrows, Arrow, Arrow Text and Symbol on Arrow tabs of

the Leader Note command's parameters window. 

· Font

See the Font Parameters of Drawing Detailing Elements section.

See Also:

· Default Parameters

· Defining Element Parameters

· Copying Parameters of 2D Elements
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Edit Leader Note

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual Menu

<EI> Edit > Draw > Leader Note

The command allows to edit Leader Notes. 

Upon calling the command, following automenu options are available:

<*> Select All Elements

<Esc> Exit command

You can select a single leader note using  or multiple leader notes.  <Shift> +  adds an

element to selection, <Ctrl>+  deletes an element from selection.  

Upon selecting multiple leader notes, following automenu options become available:

<P> Set Leader Note Parameters

<Alt>+<P> Copy Properties from Existing Element

<Del> Delete Selected Element(s)

<Esc> Cancel selection

See the Multiple 2D Elements Editing section.

Upon selecting a single leader note, following automenu options become available:

<P> Set Leader Note Parameters

<Alt>+<P> Copy Properties from Existing Element

<W> Link to Product Composition

<Space> Add Arrow

<Z> Change leader line jog orientation

<I> Select Other Element

<Del> Delete Selected Element(s)
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<Esc> Exit command

Editing a single leader note using the editing command is performed in the same way as defining

parameters of the Leader Note command. Position and linking of each node of leader note's arrows

are defined individually using manipulators and specific automenu options available only upon

clicking a manipulator (see the Shape and position of Leader Note's Arrow section).

See Also:

· Transparent Editing

· Multiple 2D Elements Editing 

· Defining Element Parameters

· Copying Parameters of 2D Elements

Snapping Dimensions and Leader Notes to Drawing Views

The Snap within Projection View checkbox is available in the Options tab of Dimension and Leader

Note commands' parameters windows.

The checkbox is enabled by default, so a drawing view gets activated upon selecting a first reference

element.

In result, Dimensions and Leader Notes are created within a single projection and selecting reference

elements on other projections is impossible.

If the checkbox is disabled, then a drawing view doesn't get activated upon selecting a first reference

element, so you can select a second reference element on another projection.
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In result, created Dimensions and Leader Notes belong to the whole drawing page, not to a particular

projection.

This option can be also disabled by holding <Shift> while selecting a first reference element.

Keep in mind, that values of dimensions created without snapping on projections with breaks do

not take "broken" part of the model into account.

When dimension values do not represent actual dimensions of a model due to disabled snapping, info

messages are displayed in the Diagnostics window:

Axes Creation

Calling the command:

Icon Ribbon

Draw > Draw > Axis

Sheet Metal > Draw > Axis

Workplane > Draw > Axis

Keyboard Textual Menu

<AX> Draw > Axis

The command is provided for drawing axis designations (axis designations are graphic lines).

The following options are available when working with the command:
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<Enter> Set the position of the label fixing point at the cursor position

<Ctrl+Enter

>
Finish input

<P> Set graphic line parameters

<1> Create Axis of two Graphics lines

<2> Create two Axes of Circle or Ellipse

<3> Create Horizontal Axis

<4> Create Vertical Axis

<5> Axis with angle by Node

<6> Radial Axis by Node

<7> Tangent Axis by Node

<8> Axis by Circle and Radial Axis

<9> Axis by Arc and Radial Axis

<Z> Change Arc Direction

<Esc> Deselect items/Exit command

After calling the command, the CENTER 2 type of the graphic image is automatically set, which is used

for drawing axis. You can change the line type in the graphic line parameters, the dialog box of which

is called using the option . In doing so, you will set the type of line used by this command in the

current drawing.

To apply the designation of the axes, you should select the graphic line.

The option  (<1>) allows creating an axis line between two graphic lines. You can select two

straight segments or two arcs of equal radii as the source graphic lines. The selection is done by .

Selected elements are highlighted.

If the object snapping is engaged in the current session, then the axis being created appears as soon

as you select the second segment or arc. It the object snapping is turned off, then the axis is displayed

only upon confirming the selection. Confirm the selection of elements for creating the axis by the

option .

The axis is bounded by the projections of the end points of the selected graphic lines on the axis line.
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It is possible to extend the axis on one or both sides. To do this, you need to select additionally one or

two graphic lines. The axis will then be extended up to the projection point on the axis of the selected

graphic line end point. If two graphic lines are 

selected as the additional lines, then the axis creation is completed automatically, without the

confirmation by the option .

The option  (<2>) allows simultaneously creating two axes for a circle, ellipse or an arc. To do

this, just select the graphic entity - the circle, ellipse or arc. The selected elements are highlighted, and

the pair of axes is instantly displayed (if the object snapping is turned on). The limits of the axes are

defined by the radii of the selected elements. The axes are created automatically upon the selection,

without the confirmation.

      

The options  (<3>) and  (<4>) allow creating, respectively, the horizontal and vertical axes

for circles and circular arcs. In the case of ellipses or elliptical arcs, the major axis is created instead of

the horizontal one, and the minor – instead of the vertical.

When one of the options is selected, the object snapping mode is automatically set, so only lines of

the appropriate type are available for selection.

or  

When using the following options, it is first required to specify a 2D node and then the graphic line of

the circle, ellipse or arc:
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The  option allows us to draw two perpendicular lines of the axis of the circle (the arc of the

circle, ellipse), one of which goes through the given center. 

The  option allows us to create the radial (straight) axis of the circle (arc of the circle, ellipse)

passing through the given center.

Radial Axis by Node  Axis with angle by Node

The  option creates the tangent axis of the circle (arc of the circle, ellipse), i.e., the straight axis

perpendicular to the radius that goes through the given center.

The  option allows us to draw the axis on a whole circle and the radial (straight) axis, going

through the given center, for the circle or ellipse.

Tangent Axis by Node Axis by Circle and Radial Axis

To create axes with the use of the , ,  and  options, it is first required to specify the

center node and then the graphic line of the circle, ellipse or arc. After the selection, the axial lines are

created automatically without the need to confirm.

   

It is important to note that after creation of the axes, the command will remain in the mode of axes

creation with the same center node. To create one more axis (or a couple of axes), it is sufficient to

select the next graphic line of the circle, ellipse or arc. To return to the stage of selection of the center

node, it is sufficient to press  or use the  option in the automenu of the command.  

One more option  of the automenu of the command allows us to create inclined axes through the

center for two circles (ellipses) with an arc of the size of these circles (ellipses):
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<9> Axis along arc and radial axis

To create the axes with the help of this option, it is first required to select the center node. Then it is

required to specify two graphic lines – of the circle or ellipse. When the cursor of the mouse is over

the second graphic line, the view of the future axis along the arc will appear on the screen in a

dynamic mode. At this moment the direction of the arc can be modified with the help of the option

.

To finish creation of axes, press  in the window of properties or in the automenu of the command.

    

The second graphic line does not have to be specified; instead a 2D node can be selected. In this case

 is created an inclined axis with an arc of the size of one of the circles or an inclined axis with an arc up

to the node.

On the size of a hole  Axis along the arc up to the hole

Editing axes

Since the created axes maintain associative relationship with their reference elements, their

modifications occur together with the reference elements. Axes can be deleted, or their parameters

changed, or their name defined, by using the context menu coming up upon right clicking  over an

axis, or by the command Edit Graphic Line.

Drawing Title Block

The drawing title block module is an application that is launched automatically upon launching the T-

FLEX CAD. If necessary it can be launched manually from the Applications command. 
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Adding Title Block to Drawing Page

Icon Ribbon

Title Block > Title Block > New 

Keyboard Textual Menu

Title Block > Title Block > Insert

To create a title block, this command is intended.

After calling the command, you need to select the type of the title block from the list. 

You can add to this list yourself by creating the title block necessary for drawing design, and adding

them to the list using the Options command. After selecting the type, a window will appear on the

screen to fill in the title block. This window is a dialog for editing the values of the external variables

of the fragment and by default displays the dialog created in the document of the main label using

the control elements.

The Variables list flag displays this window as an external variable editor.  
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It should be noted that the format fields Drawing Number and Title display the values of hidden

variables, which are also associated with the data for the specification of the current document.

Therefore, when entering data into these formatting fields, the corresponding data for the

specification is automatically filled in.

Editing Contents of Title Block 

To edit the contents of the title block fields, use the command:

Icon Ribbon

Title Block > Title Block > Edit

Keyboard Textual Menu

- Title Block > Title Block > Edit

Changing Type of Title Block

To re-select a type of a title block, use the command:

Icon Ribbon

Title Block > Title Block > Change Type

Keyboard Textual Menu

- Title Block > Title Block > Change Type

Move Title Block

To modify the title block's position, use the command:

Icon Ribbon

Title Block > Title Block > Move > Move Title Block

Keyboard Textual Menu

- Title Block > Title Block > Move

The command allows you to change the position of the title block (after the call, a dynamically

moving image of the title block appears on the screen). Point the cursor at the necessary point in the

2D window and click  - the title block will be moved to the new position. 

You can change the title block type and move the title block by selecting the respective item in the

context menu, which appears on right-clicking  the title block fragment. 

The title block can also be filled directly in the drawing. To do that, place the text cursor in the title

block field, which needs to be filled, and click . A blinking cursor will appear in the selected field,

indicating the readiness to input text, and a button with an arrow will appear next to the selected

field, serving to select a value from the list. Initially, the list is empty (except for the fields in the "Date"

column). If you need to fill in the list in order to have list values available in the future, then in the

selected field enter the necessary text, and then select the Add to List item in the context menu. 
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Since the title block is a drawing fragment, there is another way to apply it - by using the command

Create Fragment. If you want to use one of the standard title blocks, then when selecting the fragment

file, specify the required document in the System\Titleblk library. After that, the dialog described

above for editing the external variables of the fragment will appear.

Note that when inserting several title blocks into the current document (for example, for drawings

located on different pages), the data from all title blocks will be bound to the same variables of the

current document. As a result, the contents of the fields Drawing Number and Title of all title blocks

will be same. As you edit fields in one title block, the text will be changing in all the rest of them. To

disable this mode, you need to cancel the established relation with the hidden drawing variables, and

then define the new field value. To do this, you need, regardless of the variable editing technique, call

the context menu for the respective field. In the menu, clear the check in the Insert Variable item. After

that, you can edit the text value in the current field. To relate this field with a new variable, call the

same command again and define the name of the new variable in the upcoming Insert Variable

window.

When editing the title block using the dialog for editing fragment external variables, you have another

alternative. If you enable the Variables List flag in this dialog, then, instead of a dialog with interface

control elements you'll see the standard list of the format frame fragment external variables. Find the

$Drawing_Number and $TITLE variables in it (the fields Drawing number and Title), and replace their

values with constants.

In some cases, you may need to suppress automatic binding of title blocks variables with the

variables of the current drawing. This may be needed, for example, when frequently creating

documents containing several different drawings. In such a case, it is more convenient to edit the

title blocks document itself, to have the automatic variable bindings suppressed on inserting it

into the current document. To do this, open the format frame document, go into the variables

editor and delete the contents of the Assembly Variable Name parameter from the above-listed

variables.

Title Block Fitting

The commands below serve to define the size of the format of the drawing, and therefore the title

block.
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Icon Ribbon

Title Block > Title Block > Move > Standard

Keyboard Textual Menu

Title Block > Fit Title Block Size > Standard

The command picks the format of the closest standard size.

Icon Ribbon

Title Block > Title Block > Move > By Drawing Limits

Keyboard Textual Menu

Title Block > Fit Title Block Size > By Drawing Limits

In this case, the format size and position are adjusted so that they fit all graphic lines and drawing

detailing elements existing on a current page. Automatically calculated width and height of the

format are put into Document Parameters (Document Parameters > Page > Paper > Paper Size >

Format > Custom).

Icon Ribbon

Title Block > Title Block > Move > By Current Window

Keyboard Textual Menu

Title Block > Fit Title Block Size > By Current Window

In this case, the format size and position are defined by the current size of the 2D window.

Automatically calculated width and height of the format are put into Document Parameters

(Document Parameters > Page > Paper > Paper Size > Format > Custom).

Updating Title Block

See the Update Layout Elements section.

Title Block Parameters

Icon Ribbon

Title Block > Options> Options

Keyboard Textual Menu

Title Block > Options

After calling this command, a dialog window appears on the screen with two tabs.

Title Blocks
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This tab contains the list of title block types used for layouts. You can edit this list using the buttons

Edit, Add, Delete. The first two buttons call the same dialog window, only in the first case it is used for

an existing type, and in the second - for a new one.

These two buttons call the dialog, where you have to specify:

· Title

The title block name, which will be entered in the list of title block types. 

· File name 

The name to the title block file.

Title Block Parameters

Sets the values of the fields of the title block. If the Set as Default flag is set, these values will be

substituted by default in the corresponding fields of the title block of the drawing.

If you have changed the type of the title block of the drawing, the system will offer to transfer the text

of the technical requirements in accordance with the changed size or position of the title block.
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Technical Requirements

There is a difference between technical requirements of a whole document and technical

requirements on a drawing page.

Technical requirements of a document can be created and edited using the  Drawing Notes

command. Such requirements are not bound to any particular drawing page. They refer to the whole

document. For instance, you can create them at first in a document which only has a 3D model and use

them on a drawing page later. Creating and editing technical requirements of a document is

performed in a text editor.

Technical requirements of a document can be inserted into the regular text. 

Technical requirements on a drawing page can be created using the  New command and edited

using the  Edit command. Such requirements are bound to a particular drawing page. If their

content doesn't fit a single page it can be wrapped to subsequent pages. 

At first, upon creating requirements on a page, the text of the document's requirements are

automatically inserted into them (if document's requirements exist in this document). Then you can

manually edit or delete the automatically inserted text. Editing the text on a drawing page doesn't

affect the content of document's requirements. Requirements on a page may be deleted in the same

way as the regular text.

Both document's requirements and requirements on a drawing page can be used for  creating

leader notes.

Creating Technical Requirements on a Drawing Page

Icon Ribbon

Title Block > Technical Requirements > New

Keyboard Textual Menu

Title Block > Drawing Notes > Insert

Upon calling this command, a bounding rectangle is displayed on a drawing page, in which you can

enter the requirements' text. If there are  document's technical requirements in the current

document, then their text is automatically inserted into the rectangle.

The inserted text doesn't have associative link to document's requirements, so editing the

document's requirements in future does not affect the requirements on a page and vice versa.

The technical requirements on a drawing page are a paragraph text, so they can be edited in the same

way as any regular paragraph text. The detailed information on working with texts can be found in the

Text chapter.

Position and dimensions of requirements' bounding rectangle on a drawing page are defined by

a title block's template. the text is created in such way, so that its position and dimensions are

automatically adjusted upon changing position and dimensions of a title block.

Creating technical requirements on a drawing page is not possible and the corresponding command

is not available until you create a title block. 
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Editing Technical Requirements on a Drawing Page

Icon Ribbon

Title Block > Technical Requirements > Edit

Keyboard Textual Menu

Title Block > Drawing Notes > Edit

Calling the command launches the text contents editing mode for technical requirements already 

 created on a drawing page. Editing is performed in the same way as editing of a regular paragraph

text. The command is not available, if there are no technical requirements on the current page. 

If Transparent text editing is enabled (Document Parameters > Page > View > Text), then the

command is launched automatically upon clicking  within the text's bounding rectangle.

The text of requirements may also be edited using regular text editing commands.

Creating/Editing Technical Requirements of a Document

Icon Ribbon

Title Block > Technical Requirements > Drawing Notes

Keyboard Textual Menu

Title Block > Drawing Notes > Technical Requirements...

When invoking this command, the text editor window appears, where you can input text of

document's technical requirements. Working with requirements' text is performed in the same way as

working with regular text. 
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Leader Notes by Technical Requirements

Icon Ribbon

Title Block > Technical Requirements > Leaders by Drawing Notes

Keyboard Textual Menu

Title Block > Drawing Notes > Leaders by Drawing Notes

The command allows convenient creation and viewing of leader notes linked to a particular technical

requirements' record.

Upon calling the command, you can select one of the following modes in the top of the parameters

window:

 Create;

 Highlighting.

Select the necessary set of technical requirements (requirements of the whole document or a

particular drawing page) in the drop-down list below.

The table next to it contains records of the selected set. The first column # contains record's index

number, the Text column - record's text. Records can be selected in the tables using .

In the  Create mode selecting a record launches the leader note command with custom

parameters, where main shoulder's text contains index number of a selected record. In leader note's

parameters the number is displayed in curly braces. The rest of the leader note's creation process is

the same as described for the Leader Note command. As creation of a note is finished, the system
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returns to the Leaders by Drawing Notes command, so you can sequentially create multiple leader

notes for multiple records. Records, that already have at least a single corresponding leader note, are

highlighted in the table. Create all necessary notes and finish the command by clicking  or using

one of the buttons in the parameters window's header. There's a link between a technical requirements

record and its corresponding leader note. Therefore, if an index number of a record has changed due

to adding or removing other records, you can update corresponding leader notes automatically by

calling the  Regenerate command.

In the  Highlighting mode selecting a record in the table highlights all its linked leader notes in 2D

and 3D windows.

See Also:

· Text

· Drawing Title Block

· Pages

· Leader Notes

Variation Table

Call the command:

Icon Ribbon

Title Block > Variations Table > New

Keyboard Textual menu

Title Block > Variations Table > Create

To fill in the variation table, you must first create part/Assembly variation. Variation are created in the

Configurations and Variations command. 

After activating the command, the execution table window will appear. In the left part of the window,

there are columns of external variables created in the model, as well as columns for the letter and

ordinal number of the table row. All these columns can be included in the table. To do this, select a

variable and move it to the right side of the window using Drag'n'drop.

In the right part, there is a window for the variation table. This shows the columns that will be included

in the variation table in the drawing.
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You can change the order of columns in the table. To do this, just move the column header in the

necessary direction. Two red arrows will indicate between which columns it will be located. In the

same way, you can place a column moved from the right side of the window using Drag'n'drop in the

right place.

You can also change the order of rows in the table. To do this, select a row and move it to the

necessary position.

In the upper part of the window, there are options for working with the execution table.

 Insert Row. This option adds an empty row to the end of the table. 

 Update sequence numbers. This option updates the row numbers in the corresponding n/n

column. This option is used if the rows in the table were moved and their numbering was broken. 
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 Reset. When using this option, all changes made are canceled, and the table returns to its original

appearance.

 Delete row. Deletes the selected row from the table.

After clicking OK, a table is added to the drawing. If necessary, you can move it using the marker in the

upper-left corner.

Then you can work with the created table as with normal text. 

To launch the variation table editor, you can use the command:

Icon Ribbon

Title Block > Variations Table > Edit Contents

Keyboard Textual menu

- Title Block > Variations Table > Edit

This command causes editing of the text containing the variation table.

To add a new column or make other changes to the table use the command:

Icon Ribbon

Title Block > Variations Table > Change

Keyboard Textual menu

- Title Block > Variations Table > Variations Table...

This opens the variation table window.
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All changes made to the variation table in the drawing will be rejected after clicking OK,

because the table will be updated. In this regard, we recommend making all important changes

in the variation table window.

To finish creating the table, click  in the auto-menu. If you exit editing mode using the  undo

command option, the table will not be created.

Redraw

Call the command:

Icon Ribbon

Keyboard Textual menu

<RD>, <F7> View > Redraw

In order for the system to redraw the entire drawing in accordance with the set priorities, you must use

the <F7> key corresponding to the Redraw command.

The Redraw command lets you update the image in the current window. To stop the image

redrawing process, press the <Esc> key or the right mouse button.

Pictures

Calling the command:

Icon Ribbon

Draw > Appearance > Picture

Assembly > Assembly > Picture

Sheet Metal > Appearance > Picture

Workplane > Appearance > Picture

Keyboard Textual Menu

<IP> Draw > Picture

You can add to a T-FLEX drawing vector or bitmap images stored in files using different graphic

formats:
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T-FLEX CAD Metafiles are graphic images of T-FLEX drawings, they do not require parametric

regeneration and are quickly displayable on the screen. Those are stored on disk with the

extension *.bmf. Metafiles can be generated in the command Export or produced by an

animation (the command Animate Model).

Such images can be inserted using various scale, rotated various angles and snapped to nodes, which

helps parametrically define their position on the drawing. Unlike fragments, pictures themselves are

not parametric, do not use variables or special fixing elements.

Transparent font color can be set for bitmap pictures.

Connection with Source File. Links Mechanism

Pictures, just like fragments and databases, use the links mechanism that allows managing relations of

objects with their source files. A picture is related with an object by a "link" that indicates the source of

external data. 

Recall that the object of a link can be external (external file) or internal (a picture copied from internal

file and saved inside the main document, fragment document etc.). Links management is done in the

Assembly Structure window.

Links to files are used for 2D and 3D fragments and pictures. The command Update links

updates all links to files.

By default an inserted picture uses an "external link" to the source file. By changing the link to

embedded in the Assembly Structure window, you can save the picture directly in the drawing file

(without relation to the source file).

Internal document-picture can be generated automatically right after inserting the picture. In this case

a created picture will be at once connected with two links: a link to an external document (source file)

and to an internal document. Such picture will function as an internal one, keeping the image of the

source document in the form that the image had at the moment of insertion, but updating an internal

image from the source file in case of need will still be possible.

Pictures on the basis of files “*.grb” are always generated as internal ones with the preserved

connection with the source file.

Methods of fixing on drawings

The position of a picture on the drawing can be defined by the following methods:

By two corner fixing points. The graphic image of a picture is bounded by a box. By defining two

opposite corners of this box on the drawing, you can change the position and size of the picture's
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image on a drawing. The original aspect ratio of the picture is not preserved in this way. The picture is

fit in the specified box.

   

The corner points of the picture can be snapped to nodes on the drawing. This will allow parametric

control over the position and size of the picture's image. Additionally, one can specify an angle of the

picture's rotation about its center. 

By one point, rotation angle and scale. In this case, just one reference point is used for fixing. As in

the previous method, the fixing point can be related to a node on a drawing.

Creating picture

After calling this command, the options for creating the picture will appear in the automenu, and the

command's properties dialog box — in the properties window.

Choosing source file and fixing method

First of all, it is necessary to choose the source file of the picture being created. This can be done with

the help of the button  in the command's properties window or with the help of automenu option:

<M> Select file

Files can be selected either from the T-FLEX CAD library or just from any folder on the disk.

A picture name can be variable. For this, you shall use a text variable as the picture name.

The drop-down list of the <M> option contains a list of previous files. 
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If there were no previous files, the drop-down list will not be active.

If the current document (in which the picture is generated) contains internal pictures, the symbol

manifesting the existence of the drop down list will appear next to the icon of the option <M>.

Another method for selection of the picture source can be picked from the drop down list:

<E> Select Embedded Document

The name of the selected/internal document will be shown in the command's properties window (to

the left of the button ).

If the picture is inserted from a library, then the name of the library is entered in the corner

brackets, for example, “<Schemes>Graph node”. If the library name in the corner brackets is

omitted, the picture is taken from the same library as that in which the drawing is located.

Grey (not accessible for editing) field, located a little below is informational and shows the absolute

path to the file from which the picture is taken.

Upon picture insertion, as a file with bitmap image, a page being inserted from the source document

can be selected in the command's properties window (parameter Displayed Page).

The fixing method for the inserted picture (by two points or by one point, angle and a scale) is

selected in the dialog box of the properties window (parameter Fixing Mode).
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Fixing picture by two points

After choosing the fixing method (parameter Fixing Mode > By 2 Points in the command's dialog

box) it is necessary to successively indicate location of two fixing points of the generated picture. This

can be done with the help of  in the drawing's window or by indicating the exact values of the

coordinates in the command's properties window.

Upon defining fixing points, it is possible to select nodes of the drawing with the help of the option:

<N> Set relation with Node

When the second fix point has been defined, the creation of the picture is automatically completed.

After defining location of the first fixing point, it is possible to finish creating the picture by pressing

 (in the automenu or in the properties window). In this case, location of the second fixing point

will be determined by the system automatically (on the basis of the initial size of the inserted picture).
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Fixing picture by point, angle and scale

Upon inserting picture by one point, angle and scale, the fixing point is defined first. Note that in the

command's properties window location of the fixing point can be selected with respect to the box of

the picture (parameter Fixing Point).

Location of the fixing point can be assigned directly in the drawing's window with the help of  or

by prescribing exact values of the coordinates in the command's dialog box. With the help of the

option  it is possible to fix picture to a node.

Additionally, in the command properties window, you can select the way the image is positioned

relative to the fixing point.

Fixing Point indicates which one of the characteristic points of the picture rectangle will be combined

with the given fixing point. Selection of another characteristic point from the drop-down list of this

parameter allows you to change the final location of the image on the drawing. The same can be

done with automenu option:

Fixing point

After indicating the fixing point, the picture's contour takes the position in accordance with the

parameters (angle of rotation and a scale), prescribed in the command's parameters dialog box (be

default, angle of rotation is set to be equal to 0, and scale is 1). At this point it is possible to finish
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creation the picture by pressing , but it is also possible to preliminarily change the scale, angle

and even location of the picture with the help of special markers, located at the corners of the

picture’s box. Note that upon fixing by a point, angle and scale, rendering the picture can be

completed only by pressing 

 

Scale and angle of rotation of the picture can be also prescribed in the dialog box of the properties

window (parameters Scale and Rotation Angle).

Creating Internal Picture with Preserved Connection with Source File

To create an internal picture, right upon its insertion it is necessary to turn on the flag Create Internal

Document under the group Options found in the command's properties window.

Setting Transparent Color

Prescribing transparent color is possible only for bitmap pictures. Transparent color can be set in two

ways: with the help of a special list of colors in the command's properties dialog box (this list

becomes available only upon activating the flag Transparent Backgroun”) or directly in the drawing's

window with the help of the following option of the automenu:

<T> Select Transparent Background Color

This option lets a user select color directly from the screen by pointing at the necessary region of the

drawing.

Repeated Picture Insertion

For repeated picture rendering it is convenient to use the following options of the automenu:
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<R> Repeat Last Picture Insertion

<F> Select Picture to Insert Copy

The option  enables to repeat multiple insertion of the last picture created in the given document.

By default, parameters of the new picture will be assigned the same values as those of the last

inserted picture.

The option  enables to repeat insertion of any of the previously inserted pictures many times.

After calling this option it is necessary to point at the source picture with the help of .

Picture Editing

Picture editing can be done by using automenu option:

<F4> Call Edit Picture command 

Topics in this section:

· Pictures Parameters

· Edit Picture

Pictures Paramaters

Name. Sets the file name for the applied picture.

Layer. Level. Priority. Set the system parameters for the applied picture.

The other parameters are similar to the parameters described in the Pictures section.

Edit Picture

Calling the command:

Icon Ribbon

-

Keyboard Textual Menu

<EP> Edit > Construct > Picture

The Edit Picture command allows you to edit pictures.

Upon calling the command, the following options become available in the automenu:
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<*> Select all elements

<R> Select element from list

<Esc> Exit command

To select a picture, point to its image and click . Selection of several pictures can be carried out

via a window or with the help of the key combination left <Shift>+  (adding elements to a list of

chosen ones) or left <Ctrl>+  (removing an element from the list). After selecting one or more

pictures, the following icons become available:

<P> Set Picture Parameters

<I> Select Other Element

- Picture Fixing Point

<Del> Delete selected element(s)

<Esc> Cancel selection

Editing Single Picture

If a single picture is selected, it becomes outlined. The appropriate characteristic points and markers

will be highlighted with the outline, depending on the fixing mode.

Editing Picture Inserted by Two Fixing Points

If the picture was put on the drawing using two fixing points, then the points defining the picture

position on the drawing will be highlighted. By modifying the fixing point positions, you can change

the picture location and size. Moreover, at the upper left corner of the picture there will be a picture

movement marker, with the help of which a movement of a whole picture can be performed.

To modify the picture size, move the mouse to the necessary fixing point and click . The picture's

outline will start rubberband. One of the corners of the outline will be "tied" to the pointer, while the

other stay still. Next, move the pointer to the necessary position and click . After that, the picture

will redraw per its new sizes. If the selected fixing point was fixed to a node, this fixing will be broken

after the move.

Upon movement of the fixing point, the following option will be available in the automenu:
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<N> Set Relation with Node

To move the picture with the help of the movement marker, it is necessary to bring the cursor to the

pointer, press , drag the cursor to the necessary location and press  again. If the fixing points

were initially fixed to nodes, then, upon moving the picture, their relations with those nodes will be

broken.

The picture’s rotation angle can also be defined in the two-fixing-points mode in the properties

window. 

Editing Picture Inserted by One Fixing Point, Angle and Scale

In case when selected picture was put on the drawing with the help of one fixing point, angle and

scale, the fixing point as well as the markers for setting picture's movement, scale and angle of

rotation will be highlighted. The markers enable to change position, angle of rotation and size of the

image directly on the drawing.

The location of the fixing point will be determined by the value of the parameter Fixing Point in the

command's properties window (or using  command). If this parameter is modified, another fixing

point will be highlighted on the drawing (corresponding to the selected value of the parameter).

Detailed description of working with markers was provided in the chapter Drawing Views.

The exact numerical values of the rotation angle and picture scale can be defined in the picture's

parameters dialog box (the option ). The same dialog allows modifying the picture's fixing method.
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If multiple pictures are selected, you can modify their parameters (level, layer, priority). You can also

delete the selected pictures from the drawing.

Editing Several Pictures

If multiple pictures are selected, you can modify their parameters (level, layer, priority). You can also

delete the selected pictures from the drawing.

Updating Internal Pictures

If upon creating a picture in the command's dialog box the flag Create Internal Document was turned

on, then such picture will be connected with two links: the first link will refer to the external source file

of the picture, the second one – to, created upon insertion, the internal (i.e. stored inside the current

document) copy of the file. Upon recalculations, an internal copy of the source file will be used for

updating the picture. This means that picture will preserve the form which the source document had at

the moment of creating a picture.

For updating the picture from the external file, it is necessary to select a necessary picture in the

command waiting mode and call the context menu with the help of . For the internal picture,

which maintained connection with the external source file, the command Update File Data will be

accessible from the context menu.

Font Parameters of Drawing Detailing Elements

The font parameters are a tab in the  parameters dialog of many of the elements of the document.

In it, you can set the necessary parameters of a font used for displaying a text of an element. The set

of available parameters depends on a format of a selected font -  .shx or TrueType.

If the value of any parameter is set by default (in square brackets) or is not set, it will be taken from

document parameters (Document Parameters > Page > Font).
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The parameters available for all fonts are:

Name. The system supports a wide range of fonts, some of which are .shx fonts and some of which

are TrueType fonts. You can add your own fonts of the specified format to the system at any time.

Select the font name from the list.
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Size. You can set any font size that is greater than 0. this Parameter sets the vertical size of the font's

uppercase letters.

Line Spacing. Sets the distance between two adjacent lines of multi-line text. The row spacing is set in

relative units. To get the absolute value of the row interval, multiply the value of this parameter by the

font height.

Character Spacing. Sets the distance between characters of a font. The parameter value is also

relative. To obtain absolute values it is necessary to multiply the value of this parameter on the height

of the font.

Stretch. Sets the zoom level for the width of the font character. You can specify any extension except

the value 0.

Clear Background. This parameter is used for displaying the text in a rectangle with the background

color of the drawing. The use of background cleanup is convenient to display the text on top of the

hatches, fills, etc.

If you have selected the TrueType font, one of its parameters will be the Style.

Following styles are available: Regular, Bold, Italic, Italic Bold.

If you have selected the .shx font, you can set the following parameters: 

Oblique Angle. Sets the font angle in degrees. You can set any angle, excluding 0, 180, 360 and so on.

The normal angle (straight font) is 90 degrees. This parameter has a higher priority than the Style

parameter. The value of the angle can be set via a variable.

Line Width. Sets the thickness of contour lines.

Fill. Note that not all fonts can be filled in. In order for the font to be considered filled, you must have

a file in the system directory T-FLEX with the .chd extension  and the name that matches the name of

the .shx font. The file may be empty. In this case, each font character will be filled in.

After setting the font type and its parameters, the result is visible in the preview window.
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2D Assembly Drawings

Any drawing can be inserted in other drawings in T-FLEX system. For example, you can insert the

drawing of the title block template into a part drawing, or, say, a drawing of a bolt into an assembly. 

A T-FLEX CAD drawing is called fragment when inserted into another document. The drawing

obtained by using fragments will be referred to as assembly drawing. The assembly drawing keeps

only a reference to the original fragment file. Modifications in the fragment file propagate on the

respective component in the assembly drawing.

Creation of drawings using fragments brings significant benefits in various cases. Firstly, this simplifies

the process of creating complicated drawings, since you can create portions of such drawing first, and

then join those. The design workflow of separate fragments can be completely independent, or,

alternatively, be conducted in the assembly context, using the associative relations between the

fragments and the assembly. Separating the assembly drawing into fragments corresponding to

separate parts makes the assembly drawing fully represent the actual assembled mechanism. This

approach also provides maximum automation to creating bills of materials of the assembly drawing,

and delivers the complete set of detail drawings. Secondly, the use of assembly drawing supports

reverse propagation of parametric modifications to any of the assembly parameters from the

assembly to its contributing parts. This feature instantly yields a full set of part drawings satisfying

those modified parameters. Thirdly, fragments can serve for representing frequently used drawing

elements. Standard library elements can also be handy as fragments. For example, the title block

template drawing can be added to a part drawing. You could also create special detailing elements to

add to drawings.

Effective use of fragments in T-FLEX assembly drawings relies on the following fragment

characteristics:

As any T-FLEX CAD elements, fragments can be attached to various elements of the assembly drawing,

including other fragments. This allows coordinating fragment position modifications with other

drawing elements relocations.

Since fragments are parametric drawings, they dimensions upon assembling are calculated according

to the desired parameters of the assembly drawing. Note that the same fragment file can be used in

the assembly document multiple times with different parameter values. This feature is especially

beneficial when using libraries of standard elements.

Once assembled, fragments often overlap each other and the image of the assembly itself. T-FLEX

CAD allows setting up automatic hidden line removal upon fragment overlapping.
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You can do selective insertion of only necessary elements from the fragment drawing into the

assembly drawing. This capability allows using fully furnished part drawings in assemblies. Fragments

can be variable, meaning that one or another fragment would be inserted in the assembly drawing,

depending on certain conditions. This capability allows creating assembly  drawings  and  modeling 

products  in various configurations, when different parts are put in the same assembly, depending on

the configuration.

  

Assembly drawings do not directly incorporate all fragment data. They only keep the necessary

images and references to fragment drawings. This helps achieving most compact representation of

the drawings in the memory and on the hard disk. Besides, if the same drawing file is inserted in

different assemblies, then its modifications will propagate on all documents that use it.

Topics in this section:

· Specifics of Handling Assembly Drawings

· Bottom-up Design

· Create LCS of Drawing

· Inserting Fragments into a Drawing

· Top-down Design

· Editing Fragments

· Composition Document. Embedded Fragments

· Examples of Working with Drawings

Specifics of Handling Assembly Drawings

Assembly drawing creation techniques

Before starting with creation of an assembly drawing, think through its composition. Try to define

requirements to its parametric layout: what specifically will be subject to modifications in the future,

what parts will make up the drawing, what is the expected hierarchy of fragments. The conclusions

made at this preliminary analysis stage will define the preferable technique of the assembly model

and fragment creation. Assembly design techniques differ in the ways of creating fragment files:
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·  "Bottom-up" development. This technique implies creating part drawings first, to be inserted

in the assembly, in a conventional way in separate T-FLEX CAD documents. Assembly drawing

creation in this case implies subsequent assembling of the necessary fragments. In the course

of development, one has to accomplish the task of attaching part images within the assembly

drawing.

·  "Top-down" development. This technique implies that the part drawings originate from the

assembly drawing. This means, the fragments are created in the assembly context. In this case,

development start from creating the assembly drawing. Already created parts of the assembly

drawing, including graphic lines and nodes belonging to fragments, can be used for creating

new fragments. This approach simplifies creation of associative relations between the

assembly fragments and the process of their attachment. The created fragments are saved into

separate documents for further refinement and/or use in other assemblies.

The described techniques can be combined. For example, a fragment created and inserted in an

assembly according to the "Bottom-up" approach, can later be edited in the assembly context. Vice

versa, a fragment created in the assembly context, can later be used for creating other assemblies

within the "Bottom-up" framework. 

Ways of Attaching the Fragment Image to the Assembly Drawing

For placing the fragment image at a desired place in the assembly drawing, in the system T-FLEX CAD

there are several different methods utilizing various tools depending on the problem being solved:

1. Inserting the fragment with the help of fixing vector. The fixing vector represents itself a special

construction entity which serves as a two-dimensional coordinate system. When inserting the

fragment into the assembly drawing, a user specifies location of the fixing vector, and the fragment

image, connected to the fixing vector, is transferred along with that. The fixing vector is defined in

advance in the fragment document (for more detailed description see the chapter Bottom-Up

Design).

 

2. Inserting the fragment by fixing points. The fixing point represents itself an intersection of the

horizontal and vertical construction lines the coordinates of which are specified by a pair of

variables with special names x1…x9 and y1…y9. Accordingly, the number of fixing points can vary

from 1 to 9. The entire parametric drawing of the fragment is constructed on the basis of the base

construction lines determining the fixing points. When inserting such fragment, a user indicates a
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new location, and the parametric drawing of the fragment gets reconstructed depending on the

new location of the base construction lines. This method is used when the fragment image (linear

dimensions, shape, topology, etc.) has to be modified depending on the placement in the assembly

drawing when position of the base fixing points is changed. For more detailed description see the

chapter «Bottom-Up Design».

3. Associative/Non-associative fixing to elements of the assembly drawing. While designing by

«Top-down» approach, upon creating a fragment in the assembly context drawing, a user can

perform associative and non-associative fixing of the elements of the fragment to the elements of

the assembly drawing (for more detailed description see the chapter «Top-Down Design»).

          

4. Without fixing (inserting «as it is», in absolute coordinates). When the fixing vector and the fixing

points are absent while working with the «Bottom-Up» approach, and also, when all snaps are

turned off while working with the «Top-Down» approach, the system puts the image of the

drawing on the page of the assembly drawing without any changes. Each line or node of the

fragment gets the same coordinates in the assembly drawing as the coordinates it had in the

fragment document.

5. Use of special functions of variables. In some cases when inserting the fragment in absolute

coordinates, the functions of the T-FLEX CAD variables can be used. For example, it is used for

making the title block. In the parametric drawing of the title block the special functions that read

the coordinates of the page borders of the assembly drawing are utilized. Then the coordinates are

passed via the variables to the corresponding construction lines. Thus, the title block automatically

takes the desired size in accordance with the specified page size of the assembly drawing.
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Use of fragment variables

When inserting a fragment, one can define the values of the variables that define the fragment

drawing. For this, the desired variables must be marked as external when creating the drawing of the

future fragment. For example, to be able to define a circle radius of a fragment when inserting it in

other drawings, assign an external variable (say, "R") to the circle radius when creating the respective

construction circle. After that, any time when inserting this fragment into other drawings, the system

will ask for the value of the variable "R", and then adjust the fragment image according to the input

value.

The external fragment variables play an important role by relating the fragment parameters with

those of the assembly drawing. For example, consider a drawing representing a shaft, whose diameter

is assigned the variable "Diameter". Suppose, we need to mount a ball bearing on the shaft. A

variable "d" was created in the ball bearing drawing that is responsible for the value of the ball

bearing inner diameter. The variable "d" is marked as external. All the rest of the ball bearing

parameters are interrelated in such a way that they are driven by the value "d". 

Now, as the bearing is inserted in the shaft drawing, the two variables can be related. After the above

steps, modifications to the shaft diameter, that is, to the variable "Diameter" of the assembly drawing,

will be automatically propagate as changes to the variable "d" in the fragment, leading to the desired

adjustment of its image.

An assembly variable name can be set same as an external variable name of the fragment (for details

refer to the chapter Variables). When inserting a fragment in the current assembly drawing, if a same-

name variable is found in the fragment as an assembly variable, the latter will be automatically

assigned the respective external fragment variable.
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For automatic specification of connections between the values of the fragment variables and the

variables of other fragments in the assembly, the mechanism of connectors can be used (see

below for details).

When working with a large number of external variables of a fragment, it is convenient to use

configurations. 

Configuration – is a named, stored in the document, collection of values of external variables for

the fragments of the document and 3D geometry corresponding to these values. In the 2D

document, only the values of external variables are stored in the configuration. The work with

configurations will be described in more detail in the chapter Configurations.

If in the document of a 2D fragment, configurations are created, then, when inserting and editing the

fragment, the user can select one of the fragment’s configurations. The values stored in the selected

configuration will be automatically assigned to all external variables of the fragment.

The name of the used configuration can be specified as a variable. If the value of this variable

changes, the system will select the corresponding configuration of the model and automatically

modify the values of the fragment’s variables.

Visibility management of fragment drawing elements

A part drawing may contain an image that should not be included in the assembly drawing.

Alternatively, we may need to use one or another portion of the same part drawing, depending on

circumstances. (For instance, in one case we need to show the top view, while in the other – the front

view.) Visibility of the fragment drawing elements inserted in the assembly can be controlled using

layers or visibility levels. Two approaches are possible when using layers. 

The first one is using a layer's own attributes (Hidden when model is used as a Fragment, Visible only

when model is used as a Fragment). This way does not allow defining several configurations of the

fragment image based on the same drawing. Nevertheless, it allows hiding/showing the elements of
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the fragment part drawing that are definitely necessary in the part drawing, yet must be hidden in the

assembly (or vice versa). This can be, for example, the part dimensions, the title block, etc. 

The second approach is more flexible, and can be used when positioning the fragment by a fixing

vector. The fixing vector parameters can relate the vector with selected layers (see chapter Fixing

Vectors). Thus, a number of part configurations (such as part views) can be obtained from the same

drawing by creating several fixing vectors with different types of relation with the layers in the

drawing.

Control over the visibility of the fragment drawing elements is done by using visibility levels in a way

common across all drawing elements. This approach may require use of external fragment variables.

Such external variables can be created in the fragment drawing, and then carried over to the assembly,

in order to control the visibility levels of the fragment drawing. The visibility levels of the fragment

drawing elements will obey the external variable settings both while editing in the assembly context

and in detailing (in the exported assembly fragment instance).

Hidden line removal in assembly drawing

One of the important advantages of T-FLEX fragments is the hidden line removal mechanism when

building an assembly from fragments. This allows, on one hand, creating a complete drawing of the

desired part, while, on the other hand, "hide" the drawing lines that fall behind the image of other

parts of the assembly drawing. 

       

The area in the drawing subject to hidden line removal is defined using a hatch. To remove hidden

lines, you can use an existing hatch or create an additional invisible one (using the fill method

Invisible). In the hatch parameters, set the flag Use for hidden line removal. In this case, the invisible

hatch will be hiding behind the objects with lower priority. Control over the visibility of a covered up

element is done by setting an appropriate priority in its properties. If a fragment is supposed to cover

assembly lines, then the fragment priority should be set higher than that of the assembly elements,

which the fragment should cover.  If the assembly lines should cover the fragment lines, then one

would have to create a hatch in the assembly drawing itself, and then set its priority higher than the

priority of the respective fragment.
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Let's review hidden line removal on the example of a shaft drawing and a ball bearing fragment. We

need to create a hatch in the shaft drawing for hidden line removal. Upon inserting the fragment in

the assembly, the ball bearing fragment image will be overlapping the shaft image. For the shaft

image to cover the lines of the ball bearing, we need to set the priority of the ball bearing fragment

lower than the priority of the hatch contour on the shaft. This can be done by the immediately at the

time of inserting the fragment, or later, when editing it.

Upon modifying the fragment priority, refresh the image by calling the command Update Model

Windows (by pressing   <F7>). As a result, the image will appear as shown on the lower right diagram.

Snapping the fragment elements

Even though the lines and other elements of a fragment are not part of the assembly drawing that

includes it, those can be used as references for creating various elements of the assembly drawing.

Ordinary lines of the fragment image (arcs and circles) can be used at the time when the object

snapping is turned on. In this way, one can create new construction lines on top of the fragment

graphic lines or dimension those, or attach any other detailing elements.
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Besides the graphic lines, one can use the fragment nodes as references. To engage use of fragment

nodes, you need to activate certain settings. The flag Fragment Nodes must be set in the command

Set System Options on the tab Snap > Priority. This setting allows creating assembly drawing

elements that rely on the named fragment nodes or end points of graphic lines. In this way, the new

nodes based on fragment nodes are created in the transparent mode.

If the image of the fragment is crowded with various elements, working in transparent mode may

become somewhat difficult. In this case, you can turn off the discussed setting and work in the mode

of forcing creation of necessary nodes based on a fragment: 

1. The command Construct Node allows creating only the nodes that will later be actually used in the

assembly constructions (a detailed description is provided in the respective chapter).

2. Named fragment nodes can be created automatically when inserting the fragment, provided that

the flag Create Named Nodes Automatically is set in the system settings (the command Set System

Options, the tab Fragments).

Assembly BOM creation

Creation of bill of materials is one of the important steps in handling assembly models. Detailed

description of handling BOMs is provided in chapter Product Structure, Reports, Bills of Materials.

For automatic filling of BOM records, you need to make sure, that the parts (fragments) of the

assembly document contain sets of the relevant data. BOM data can be defined in the fragment part

document in Product composition window at any stage of creation. You can specify the way of using

the inserted elements (other fragments) and their data contribution in the product structure of

assembly. This allows including in the product composition the data about inserted fragments or

append data from product composition belonging to a fragment document. Defining an appropriate

mode simplifies building bills of materials of multi-layer assemblies. 

To obtain the BOM of the assembly document, you need to do the following steps:

1. Enter the BOM data in the product composition window in the fragment document.

2. In the assembly document, define the way of including the fragment in product composition, either

in the fragment parameters or in the command Include in Product Structure (Tools > Report/Bill of

Materials > Elements).

3. Using the command Create Report/Bill of Materials, generate the assembly BOM.

Detailing drawings based on fragments 

When building an assembly, the fragment drawings may be modified according to the assembly

parameters via modifications of the fragment external parameters or the whole drawing when using

associative attachments. In this case, the fragment drawing files are not changed. However, if

necessary, one can automatically create separate documents with the drawings of the fragment parts

adjusted to the assembly parameters. We will refer to such drawings as detail drawings. One can

create detail drawings for the whole set of parts making up the assembly drawing. Once created, a

detail drawing does not maintain any relation with the source assembly drawing.

To get a detail drawing, use the option  in the command Edit Fragment or the command Open

Part in the fragment context menu.

Upon calling the command, a new document window will be opened, with a copy of the fragment

drawing loaded in it, with the external parameter values and associative relations inherited from the

assembly. The new drawing will be named "Part" with a subsequent number, for example, "Part 1". This

drawing will be treated by the system is a new document, with the system asking to define the name

to save the drawing as upon an attempt to close the window.
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Usually, detail drawings are used for printing out hard copies of the detail drawings that can be

different from the original fragment drawing due to, for instance, modifications of the assembly

variables. In such case, you don't even have to save a copy of the detail drawing into a file. This is

convenient in the case when a parametric fragment used in the assembly has a corresponding fully

furnished drawing. In such a case, upon creating the detail, the user instantly gets a complete set of

new documentation for the desired part.

Exploding fragments

An inserted fragment can be exploded. By this operation, the fragment is removed, while instead the

copies of all fragment elements are created in the assembly drawing that were deemed visible at the

time of assembling. 

The system can explode selected fragments in two ways, creating drawing elements with or without

construction entities. In the first case, all parametric relations are preserved between the former

fragment elements by carrying over all necessary construction lines for maintaining parametric

relations of the former fragment drawing. In the second case, the fragment is transformed to a set of

graphic lines attached to free nodes.

A fragment that contains nested fragments is exploded into the graphic elements and fragments that

it contains. After using the exploding option, the obtained elements can be treated as usual, according

to the type.

If some elements in the assembly drawing were attached to fragment elements (dimensions,

construction lines, etc.), then, upon exploding, those will be re-attached to the elements created by the

fragment explosion (nodes, construction and graphic lines). 

Use of connectors

When creating assembly documents, it is often necessary to relate parameters (variables) of the

inserted elements with the parameters of the elements to which the attachment is made. Examples

are: setting a ball bearing on a shaft, attaching a cap to a ball bearing, a shaft key to its slot, a nut to a

bolt, insertion of a screw or being into a hole, etc. When inserting such elements, the user is required

not only to define the main dimension parameters (diameter, length, etc.), but also precisely position

the elements being inserted with respect to the target element (selection of the attachment point and

direction). One of the ways of solving this task is using "Measuring" mechanism. This mechanism,
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however, often requires large amount of auxiliary preparations. Connector mechanism helps

significantly simplify the procedure of assembling elements and minimize the number of actions

required from the user.

This mechanism is based on the concept of a "connector" which is a construction element serving as a

reference for attaching other elements. In fact, a connector is a counterpart of a fixing vector or a

target LCS for attaching 3D fragments. Its main difference from a fixing vector is that a connector

serves for providing attachment reference to other model elements. Consider, for instance, use of a

fixing vector for inserting a bearing image into an assembly drawing. Suppose, the image of the

bearing should be attached to an axle. In this case, the connector should be attached to the axle

image (fragment).

Besides the geometrical positioning (the origin position and the axes directions), a connector may

keep additional information necessary for "snapping" to it other elements. This information is kept in

the connector in the form of named values that can be constants or variables. The names of these

values are used for specifying the values of the respective external variables of the fragments being

snapped to the connector. For example, a connector placed on the axis of a hole, can have such

parameters as the hole depth and the diameter. When inserting a pin in this hole, its diameter can be

automatically defined by the value D kept in the connector. To achieve this, the external variable

defining the in diameter should also be named "D".

There are a number of considerations when using a connector for snapping a fragment:

· A connector is a construction entity and may not be displayed in the main drawing, while it has

to be selected when snapping a fragment to it. 

· A connector may be located outside the viewable area of the drawing.

· Sometimes, it is convenient to use a connector for placing an element elsewhere. For example,

when attaching a cap to a ball bearing, it is convenient to select the outer lines of the ball

bearing. Meanwhile, the intended connector is lying on the ball bearing axis.

A concept of  "associated elements" is introduced for dealing with such questions and for overall

convenience. The list of such elements is stored in the connector. Associated elements are necessary

for in-depth utilization of the object snapping mechanism when snapping to a connector. As the

pointer approaches one of the image lines associated with the connector, the connector is

automatically activated (highlighted in the screen), and the external variables of the fragment receive
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the values from the connector. The 2D fragment is automatically calculated with the new variable

values and is snapped to the attachment point with the appropriate orientation.

All libraries of the standard T-FLEX CAD elements are already equipped with connectors and

ready for their use. The required named values for linking with the connectors have been set in

advance for the driving external variables.

Composition document. Nested fragments

T-FLEX CAD has a mechanism that allows you to control the way of storing links to other documents

(fragments, pictures, external databases, etc.). A T-FLEX CAD document can store links to external files

(external link "), or data from external files can be saved directly inside a T-FLEX CAD composition

(assembly) document file (internal link"). The same mechanism allows you to quickly transfer the

assembly model to another place in the file system, pack the assembly model into one file with the

possibility of subsequent unpacking.

To manage links in the system, use the File > Assembly… command group. Working with the

commands of this group is described in the chapter “Composition Document. Embedded Fragments".
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Icon Ribbon

Assembly > Component Links > Update Links

Keyboard Textual Menu

<UL> File > Assembly > Update Links

Icon Ribbon

Assembly > Component Links > Update Assembly

Keyboard Textual Menu

<UA> File > Assembly > Update Assembly

Icon Ribbon

Assembly > Component Links > Move Assembly

Keyboard Textual Menu

<AM> File > Assembly > Move Assembly

Update Links command reloads the data of the first-level external files included in the composition

document.

Update Assembly command launches a converter that recalculates and saves all fragment files

included in the assembly.

Move Assembly command to move an assembly document to another location in the file system or to

pack an assembly into one file. When performing a transfer, you can specify its method (attachment,

substitution), and also the path of the document to which the assembly will be transferred is

transferred.

List of commands for designing assemblies

Commands for inserting and editing fragments:
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Icon Ribbon

Draw - Fragment

Keyboard Textual Menu

<FR> Draw > Fragment

Icon Ribbon

Parameters > Tools > Configurations and variations

Keyboard Textual Menu

<EFR> Edit > Draw > Fragment

The first Fragment command is the main command for inserting fragments and creating new

fragments in the context of an assembly.

The second command Fragment is a command for editing fragments. Used to change binding

parameters, set properties, edit fragment variables, etc.

"Top-down" commands:

Keyboard Textual Menu Icon

<FM> File > Fragment > Create 3D Fragment

<FX> File > Fragment > Extract Fragment Drawing

<FF> File > Fragment > Apply

<FQ> File > Fragment > Cancel

<FG> File > Fragment > Refresh Files

The Create 3D Fragment command is a command for creating a new fragment in the context of an

assembly.

The Extract Fragment Drawing command is a command for creating a new fragment based on the

elements of the assembly drawing. Transfers the selected elements to the slice file.

The Apply command is a command to end the fragment editing mode in the context of an assembly

while saving the fragment.

The Cancel command is a command for ending the fragment editing mode in the context of an

assembly with the option of saving the fragment or refusing to save it.

The Refresh Files command is a command to update the data from the assembly used as the basis for

creating slices in a top-down fashion.

Setting up the document of a fragment is carried out by the command Document parameters, the

Fragment 2D tab. These settings will be applied in the assembly drawing when using the current

document as a fragment. On the Fragments tab, the Dynamic fragment editing mode can be set,

which is used when creating and editing a fragment. When this mode is enabled, editing variables or

fragment binding automatically leads to redrawing of the elements associated with the fragment. In
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this case, the preliminary image of the applied fragment is displayed in the same quality as the final

result. Dynamic mode enhances the visibility of the editing process. It can be useful when editing, for

example, diagrams, plans, etc.

System settings for working with fragments are called by the Options command, the Fragments tab:

Commands for changing a fragment, available in the context menu when a fragment is selected :

The command to launch the Document Converter application:

Keyboard Textual Menu Icon

<AC> File > Document Converter

This command allows you to carry out automatic or forced full recalculation, diagnostics and saving

the entire assembly together with the fragment files included in it. Documents created in previous

versions of T-FLEX CAD are brought into conformity with the format of the current, newer version. At

the end of the work, a report is generated that can be used to diagnose and find errors in the structure

of the assembly model. The converter is also used to transfer documents to the T-FLEX DOCs system.

For details on working with the application, see the Converter section.
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Bottom-up Design

When using the "Bottom-up" approach, the assembly model design starts from creation of separate

assembly elements – fragments. A fragment drawing is originally created as a standalone T-FLEX CAD

document. In the process of creation, it is necessary to follow the certain rules that will allow in future

to "snap" the fragment to the elements of the assembly drawing.

A special mechanism is provided in T-FLEX CAD for correct positioning of the fragment drawings in

the assembly - Fixing points or vectors. Such elements should be created in a fragment drawing in

advance, before inserting it into an assembly drawing. 

When inserting a fragment, you need to specify the position of the reference elements in the assembly

drawing, which will define the fragment position, orientation and size. The fragment image will be

built according to the specified fixing points or vectors. If no attachment elements are created in the

fragment drawing, such fragment will be attached to the coordinate system of the assembly drawing

page according to its initial coordinates in this page. The position of such fragment can be modified

only by editing. To get associated relations between the fragments and the assembly drawing,

attached fragments to the nodes of the assembly drawing (including the nodes of other fragments).

Ways of attaching fragments

When designing assemblies by «Top-down» approach, two ways of positioning the fragment on the

drawing are primarily used in the T-FLEX CAD system:

·  Defining fixing vector. In this way, first create the drawing, and then define the necessary

number of fixing vectors. Each fixing vector defines the origin and the positive direction of the

X-axis of one local coordinate system in the drawing. An arbitrary number of fixing vectors can

be defined within a fragment drawing. The fixing vector defines the fragment position and

orientation one the assembly drawing and controls elements visibility.

·  Defining fixing points using variables. In this way, the drawing is created first, following

certain rules. The base vertical and horizontal lines are assigned the parameters with the

reserved variable names. Upon assembling, the system will identify the intersection point of

such lines as a fragment fixing point. Multiple fixing points are allowed. All the rest of

fragment constructions are done with respect to the base lines defining the fixing points. The

fixing points can define the position, orientation and size of the fragment within the assembly

drawing.

The main difference between the fixing vector and fixing point approaches is in the sequence of

creation steps of the fragment drawing. When using fixing vectors, you need to create the drawing

first, and then specify the fixing vectors. When using the fixing points, one has to create fixing points

first, and then build the drawing of the part based on the fixing points.

There are also differences in the uses of fixing vectors and points. Fragments with fixing vectors are

created as follows: first, the image of the fragment is formed, taking into account the visibility layers.

Next, the complete image is moved to the specified point and rotated by the specified angle without

distortions. Fragments with fixing points are created differently: upon specifying the fixing points, all

construction elements dependent on those points are rebuilt first, and then the image of the fragment

is obtained.

This difference in forming the fragment image on the assembly drawing leads to differences that can

be illustrated by the following example. Let's create identical fragments with different fixing

provisions. Insert these fragments into a drawing, rotated by the same angle. The fragment that uses a

fixing vector, exposes a change in the hatch angle, nonstandard dimension placement (with the

automatic dimension text orienting functionality disabled), and a changed angle of a text. The

fragment that uses fixing points shows the hatch angle preserved, the dimension "10" rotated per the

standard, and the text angle maintained as well.
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The mentioned differences shall not be considered shortcomings; rather, those are features that can

be exploited in certain design situations.

Fixing vector. Connector

Fixing vector and connector are auxiliary elements of the model that are used when binding

fragments. They are construction elements, they are permanently displayed on the screen and can be

suppressed together with other construction elements using the "Suppress / show construction

elements" command. A context menu works for them, from which you can call commands for deleting,

editing and changing properties.

In order to use the finished drawing as a fragment, you need to create a snap vector. In order to create

conditions for quick "connection" of other fragments, you need to create a connector. The connector

does not have to be created in the fragment drawing. It can also be created in an assembly drawing.

Fixing vectors and connectors have different purposes, but are created in the same command.

Fixing points

Fixing point is created as the intersection of vertical and horizontal lines, the parameters of which are

specified by variables with reserved names.

For the vertical line, variables with the name are used: x1, x2, x3, x4, x5, x6, x7, x8, x9.

For the horizontal line: y1, y2, y3, y4, y5, y6, y7, y8, y9.

The number at X and Y corresponds to the fixing point number and must be the same for the vertical

and horizontal lines that define one fixing point. There can be up to nine fixing points in a drawing.

When using the method of snapping a fragment using fixing points, it is necessary to determine the

necessary fixing points before creating a drawing. All subsequent elements of the drawing must be

created relative to the straight lines that define these points. For example, if we want to use a circle as

a fragment, which we could then place in various places in other drawings, we must first create

horizontal and vertical lines, and then a circle with a center at the point of their intersection.
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Create fixing point

Fixing points can be created automatically using the Line command option . After calling the

option, move the cursor to the required position and press <F> or use the automenu icon . When

creating a point using the option , a number will be located next to the cursor, which shows the

serial number of the fixing point being created.

As a result, two intersecting construction lines will appear on the screen. Also, two external variables

x1 (x2, x3, ...) and y1 (y2, y3, ...) will be created. The parameters of the horizontal and vertical

construction lines will be set using these variables. This will create a drawing anchor point. When

placing this fragment on the assembly drawing, you will be prompted to enter the anchor point.

If necessary, you can set the anchor point manually. To do this, it is enough to independently create

intersecting vertical and horizontal lines and assign them as parameters the names of the reserved

variables x1 (x2, x3, ...) and y1 (y2, y3, ...), respectively. In this case, the variables must be marked as

external.

In the following description, the phrase Create the first (second, ...) fixing point means that you must

follow all the steps described above to create an fixing point.

Let's consider the most commonly used methods of creating fixing points for fragments and local

coordinate systems of a drawing.

Fragment with one fixing point without the possibility of rotation

Create a fixing point. Then draw all construction lines relative to the vertical and horizontal

construction lines that define the fixing point. Do not use other lines of the "vertical" and "horizontal"

types when drawing the drawing, but use the "parallel" and "angled" types. If you follow these rules,

you will get a drawing, the center of the local coordinate system of which will always be at the fixing

point, and its axes will coincide with the X-axis and Y-axis of the drawing into which this fragment is

inserted.

Fragment with one fixing point with the ability to rotate

Create an fixing point. Draw a construction line through the fixing point at an angle to the horizontal

line. Specify the slope angle of the line with a variable, for example, "al". When creating a variable,

mark it as external and set a value other than 0 (if the value is "0", the straight line will coincide with

the horizontal line in the drawing, which will complicate further construction). The variable "al" will be

an external variable in the drawing. When inserting this drawing as a fragment, the system will ask for

the value of the "al" variable. A construction line passing through a node at an angle to a horizontal

line defines the X-axis of the new local coordinate system of this drawing. To create the Y axis, you

need to draw a construction line passing through the node and perpendicular to the construction line,

which is drawn at an angle to the horizontal line. An angled line and a line perpendicular to it define a

new local drawing coordinate system. All subsequent constructions must be carried out relative to

these lines. The result is a parametric fragment with one fixing point and a variable "al", which will

determine the angle of inclination of the fragment coordinate system relative to the assembly

drawing coordinate system.
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For the convenience of constructing a relatively new coordinate system, it is recommended to perform

the following actions. Set the vertical and horizontal lines through the fixing point to "-1" for the level.

The straight lines will disappear from the screen, because the visibility level interval from 0 to 127 is

set for construction lines in the Set Levels command, and these lines have a level of -1 and do not fall

into the interval. After that, call the Document Parameters command, go to the View tab and set the

Element Selection parameter to Visible Only. Thus, a mode is set for the drawing in which system

elements that are invisible in the drawing will not be selected.

Fragment with two fixing points with the ability to rotate

The specified fragment can be created in two different ways: the first way - when the second fixing

point sets the rotation of the fragment and changes the size of the fragment, the second way - when

the second fixing point will only set the rotation of the fragment, and its size will not change.

First way:

Create two fixing points of the future fragment. After that, you need to build construction line 1,

passing through two nodes - fixing points. This line will define the X-axis of the new local coordinate

system of this drawing. To create the Y-axis of a local coordinate system, you need to draw

construction line 2, passing through a node and perpendicular to construction line 1. A line drawn

through two nodes and a line perpendicular to it define the new local coordinate system of the

drawing. All subsequent constructions must be carried out relative to the lines defining the new

coordinate system of the drawing. Create line 3 parallel to line 2 and going through the node that

defines the second fixing point. Then draw lines 4 and 5, parallel lines 1. After that, you can create the

necessary graphic lines.

The result is a parametric drawing with two fixing points, the location of which will determine the

location of the fragment coordinate system relative to the assembly drawing coordinate system. In

addition, the second fixing point will also determine the size of the rectangle.
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Second way:

All constructions in the second method are completely repeated, except for the creation of line 3,

which is drawn parallel to line 2, but is not attached to the node of the second fixing point.

When inserting such a fragment into an assembly, its size will be constant; only the rotation angle of

the fragment will depend on the second fixing point.

Since the T-FLEX system always considers the variables x1, y1, x2, y2, etc. as fixing point

definitions, variables with these names cannot be used to set other drawing parameters.

Create LCS of Drawing

The following description is key for creating parametric drawings in the T-FLEX CAD system and

creating custom libraries of parametric elements.

You can create parametric drawings in the T-FLEX CAD system. Any system drawing can be inserted

into another drawing. The drawing you insert is called a fragment.

In the T-FLEX CAD system, there are two ways to create local drawing coordinate systems.

The first method is to set the Fixing vector. In this method, you need to build a drawing, and then set

the fixing vector. There can be several fixing vectors.

Any drawing of the T-FLEX CAD system can have several fixing vectors in addition to the geometric

parameters.

The fixing vector defines the positive x-axis direction of the local drawing coordinate system. The

fixing vector is used to bind a drawing when you insert it into another drawing as a fragment. There

can be an unlimited number of fixing vectors. The fixing vector defines how the drawing is bound and

the orientation of the drawing when it is inserted as a fragment into another drawing.
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The 2D connector is a construction element that is intended for binding other elements to it. It is used

for linking other model elements to it. In addition to the geometric position (the position of the origin

of the coordinate system and the direction of the axes), the connector can store other (dimensional or

non-dimensional) information necessary to "connect" other elements to it. This information is stored

as named values, which can be either constants or variables. The names of these values are used to set

the values of the corresponding external variables of the fragments that are connected to them.

The second method is to set fixing points using variables. In this method, the drawing is built

according to certain rules. For vertical and horizontal lines, reserved variable names are set as

parameters. In the future, the T-FLEX CAD system defines the intersection point of such lines as the

fixing point of the fragment. There can be several fixing points.

Topics in this section:

· Fixing Vector

· 2D Connector

· Fixing Point

Fixing Vector

Calling the command:

Icon Ribbon

Draw > Insert > Fixing Vector

Assembly > Assembly > Fixing Vector

Workplane > Insert > Fixing Vector

Keyboard Textual Menu

<FV> Construct > Fixing Vector

The Fixing Vector command allows you to specify two types of construction elements - the fixing

vector and the connector. The fixing vector is used when drawing a drawing as a fragment into an

assembly to determine its position and orientation. The connector is used to automate the binding of

fragments in an assembly drawing.     

Upon calling the command, the following options appear in the automenu:

<Enter> Select a node to define the first point of the fixing vector

<Ctrl+Enter> Create a fixing vector defined by a single point

<F> Create Fixing Vector

<L> Create LCS

<C> Create Connector

<A> Set Snap Elements

<N> Select Node

<F4> Execute Edit Fixing Vector Command



T-FLEX CAD 17 Help

922

<Esc> Exit command

Fixing vector creation

The  option is enabled by default, i.e. when nodes are selected, a fixing vector will be created. It

can be set by one or two nodes. The node is selected by pressing <Enter> (with object binding

enabled, existing nodes will be automatically highlighted when the mouse cursor is hovered over).

After selecting the first node, the  (<End>) option will appear in the auto menu. If you use this

option, a binding vector will be created that coincides with the positive direction of the X axis of the

drawing.

To select the second node, press <Enter>.

After that, the fixing vector parameters window will appear on the screen.

After clicking OK, the fixing vector will be displayed in the drawing. You can control the visibility of the

fixing vector using the value of the Level parameter or the Hide/Show construction command. In the

context menu for binding vectors that have linked layers, there is a command to Apply layer visibility.

When it is called, the visibility or invisibility of layers is set according to how they will be displayed

when inserting this document into another document as a fragment using this fixing vector.

The  option (<N>) is used to select existing nodes when object binding is disabled.

General information

There are two types of fixing vectors: a fixing vector, defined by two points, and a fixing vector,

defined by one point. One-point fixing is used for quick snapping of parts, the image of which is

indifferent to the rotation angle, or does not require rotation.
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When you create a fixing vector in its parameters, you can specify the drawing layers that will be

displayed in the assembly. In this way, you can, for example, insert different views of the same part

into an assembly.

If there is a 3D model in the document, then it is possible to establish a connection of the fixing vector

with a specific workplane. This allows you to use 2D fragments in 3D assemblies to determine the

position of the 3D firagment in space relative to the end position of the fixing vector and the selected

workplane. This method of creating an assembly model is called Layout. More detailed information

about it can be found in the Creating assembly 3D models section. This link allows you to insert a 3D

fragment automatically when drawing a 2D fragment. To do this, the Create 3D fragments of a

fragment checkbox must be set in the options of the Fragment command.

Fixing vector specified by two points

When inserting a fragment with such an fixing vector, the position of the first point (the beginning of

the vector) will determine the position of the fragment on the assembly drawing, and the position of

the second point (the end of the vector) will determine the rotation of the fragment. To create this

vector, you must sequentially select two nodes with . After selecting the second node, a dialog box

will appear on the screen. In the dialog, you can add a comment to the fixing vector. According to this

comment, the fixing vector will be selected when inserting a fragment into an assembly drawing. 

This fixing vector is used by default if the Use only first point option is not selected.

Fixing vector specified by one point

To create such a fixing vector, select a node in the drawing with  and press <End> or  in the

automenu. A dialog box will appear on the screen, the same as for the above-described fixing vector,

in which you need to set the Use only first point parameter.

When inserting a fragment, only one point will be requested, and it will not be possible to set a

rotation for such a fragment. If the Use only first point option is not selected, a fixing vector with two

points will be created. The direction of such a fixing vector will coincide with the X-axis of the

fragment drawing.
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Fixing vector parameters

Name. You can set a comment to the fixing vector by which you will distinguish it from others when

inserting and editing this drawing as a fragment.

Use as default Fixing Vector for Fragment insertion. Defines the fixing vector that will be offered by

default when inserting a fragment into an assembly drawing. Only one main fixing vector can be

defined in the fragment drawing, although there can be many fixing vectors.

Use only first point (for fixing vectors defined by a single point). When the flag is set, the first point

of the fixing vector is used as the fixing point.

The Link to Layers group is used to define the display of drawing layers when drawing it as a

fragment. 

It is possible to choose one of three modes for displaying drawing layers when applying it as a

fragment:

· Draw all.

· Draw only marked.

· Draw all except marked.

These parameters affect the display of only 2D elements of the fragment. They do not affect the

visibility of 3D fragments located on the corresponding layers.

Layer list. This field contains a list of all layers present in the drawing. Here you can mark those of

them that will be displayed when drawing a document as a fragment using this fixing vector.

In the figure below, the reference vector and drawing elements that need to be transferred to the

assembly drawing are marked with color. These elements have been assigned a new layer. It is this

layer that needs to be marked in the fixing vector parameters.

Now, when applying this drawing as a fragment, only the marked layer will be displayed in the

assembly drawing, and, therefore, those elements that lie on this layer.
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In the context menu for fixing vectors with linked layers, there is the Apply Layer Visibility

command. When it is called, the visibility or invisibility of the layers is set in accordance with

how they will be displayed when inserting this document as a fragment using this fixing vector.

Link to Workplane. This parameter is relevant only for the 3D version of the system. Serves to define

the workplane with which the given fixing vector will be linked. This opportunity is used when creating

layouts (see the Create 3D Fragment command).

View orientation. The orientation of the view is used when creating layouts (2D fragment on the

workplane on a 3D fragment). It allows you to select the condition under which the schematic image

will be added to the assembly plane.

1. Assembly workplane

2. Position of the fixing vector

3. 3D fragment workplane

There are three possible options:

· Parallel to workplane;

· Axial symmetry;

· Arbitrary orientation.
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Parallel to workplane - after adding the model to the assembly, its schematic image will be created

only if the workplane of the assembly is parallel to the workplane in the fragment file with which the

vector is associated.

Axial symmetry - Used for models of the body of rotation type. After adding the model to the

assembly, its schematic image can be created on any assembly workplane that is parallel to the

straight line on which the anchor vector lies.

Arbitrary orientation - It is used for bodies with central symmetry or having the same conditional

graphical representation of several types. After adding the model to the assembly, its schematic

image can be created on any plane.

Level. Color. These parameters determine the visibility level of the element and the color of its display

in the drawing.

2D Connector

Calling the command:

Icon Ribbon

Draw > Insert > Connector

Assembly > Assembly > Connector

Workplane > Insert > Connector

Keyboard Textual Menu

<FV> Construct > Fixing Vector

The connector is used to automate the binding of fragments in an assembly drawing.

In this command, you can also create a fixing vector. The description of creating a fixing vector

is given in the Fixing Vector section.

Upon calling the command, the following options appear in the automenu:

<Enter> Select a node to define the first point of the fixing vector

<Ctrl+Enter> Create a fixing vector defined by a single point

<F> Create Fixing Vector (described in the Fixing Vector section)

<L> Create LCS

<C> Create Connector

<A> Set Snap Elements

<N> Select Node (intended only for working with the fixing vector)

<F4> Execute Edit Fixing Vector Command

<Esc> Exit command

A connector is a construction element intended to snap 2D fragments to it. In addition to the

geometric position (the position of the origin of the coordinate system and the direction of the axes)



2D Assembly Drawings

927

the connector can also store a set of variables with certain values. If a connector is selected when

applying a fragment to an assembly, that the selected fragment fixing vector is combined with the

connector vector of the assembly. In addition, the values of the connector variables of the same name

are automatically assigned to the external variables of the fragment. If there are no variables with the

same names in the connector, then the external variables of the fragment will have the value specified

in the fragment document.

Connector creation

Connector can be created either by calling the appropriate command from the Ribbon, or after calling

the Fixing Vector command, by activating the automenu option:

<C> Create Connector

Then the system goes into the mode of specifying nodes. A connector can be specified by one or two

nodes. If you need to specify only one node, then you need to use the icon  after selecting the

first node and specifying the necessary parameters.

If the connector is defined by one node, then its image in the drawing will be a point. In this case, it

will be possible to geometrically snap to it only fragments by the snap vector specified by one point

(only the origin of coordinates, no direction). For more convenient binding to such a connector, it is

recommended to associate several drawing elements with it (see below).

If a connector is defined by two nodes, then when a fragment with a two-point fixing vector is

connected to it, the fragment is positioned automatically by combining both vectors.

After specifying the nodes, a dialog automatically appears for specifying the named values

(Connector Values tab) and common properties (Common tab) of the connector.

On the Common tab, you can set for the connector the main properties of the auxiliary drawing object

- name, level, layer, color. Also on this tab, in a special field, information about the number of

connections to this connector is displayed (if the connector properties dialog is open directly in the

assembly drawing).

  

Initially, the new connector has no values. By the time of creation, the user, as a rule, already knows

what he is creating this connector for and what parameters of the connected fragments he will control.

For example, if we create a connector on the axis of the shaft, then we will connect fragments of parts
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that are mounted on the shaft to it. This means that we need to transfer the value of the shaft axis

diameter to the connected fragment (bearing).

To create a new connector value, click the Add button. A window is displayed in which the name of

the value and the expression for it are specified. 

The name of the connector value is used later at the moment of binding another fragment to this

connector. The name of the external variable of the fragment may not coincide with the value of the

connector. 

It is recommended to set semantic names for named connector values, adhering to the same

naming rules in all drawings. This will simplify the establishment of connections between the

values of the connector and the external variables of the fragments attached to it. For example,

the seemingly complex names used in the standard T-FLEX CAD libraries such as

DiameterOuterMetricThread, ThreadPitchMetric, LengthInnerMetricThread,

LengthInnerInchThread are actually compiled according to the rules common to all libraries

and show exactly what information this connector value conveys.

The following names of 2D connectors are accepted in the T-FLEX CAD system:

· DiameterOuterMetricThread - Nominal diameter of the outer metric thread  

· DiameterOuterMetric - Diameter of the outer cylinder in millimeters  

· DiameterInnerMetricThread - Nominal diameter of the inner metric thread  

· DiameterInnerMetric - Diameter of the inner cylinder in millimeters  

· DiameterOuterInchThread - Nominal diameter of the outer inch thread  

· DiameterOuterInch - Diameter of the outer cylinder in inches  

· DiameterInnerInchThread - Nominal diameter of the inner inch thread  

· DiameterInnerInch - Diameter of the inner cylinder in inches
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At the moment of binding, the system uses a special parameter of the external variable of the

Connector Values ??fragment (see the details in the Variable Creation section). If a name is found in the

list of values ??of the connector of an external variable that matches the value stored in the connector to

which the fragment is attached, then the value for the external variable will be automatically read

from the connector. The connection to the connector will be retained. Also, when binding to a

connector, it is possible to manually directly bind any external variable of a fragment with one of the

values ??of the connector (see Setting the values ??of external variables of a fragment).

The Expression field can contain a number (or quoted text for a text variable), an expression, or the

name of a variable in the current document. In our example, we need to transfer to other fragments

the value of the diameter, for which a certain variable is responsible in the shaft model (for example,

'D'). When creating a named value for a connector, you can specify the name ‘Diameter’, in the

expression field, put the variable ‘D’. When creating a bearing model for the variable responsible for

the bore diameter, you need to set in the properties for it a new value of the connector named

‘Diameter’.

Setting associated elements for a connector

To define the graphic lines associated with the connector, use the option:

<A> Set snap elements

After selecting the option, the system enters the mode for selecting drawing lines that will activate the

connector when you hover over them. To attach elements to the connector, select them with the

mouse in the drawing window. The selected elements are added to the list of associated elements in

the properties window.

Insertion rules

For a connector, so-called "insertion rules" can be additionally defined. These are additional

transformations of movement or rotation relative to the coordinate axes of the connector, which the

system will automatically prompt the user to perform when the fragment is attached to this connector.

For example, when tying a nut to a bolt connector, in practice it is always necessary to specify

additional movement of the nut along the bolt axis. Therefore, when designing a bolt model, you

need to specify in the insertion rules for its connector to move along the X-axis of the connector.

Topics in this section:

· 2D Connector Usage

2D Connector Usage

Upon attaching the fragment (for example, a nut) to the connector of another fragment (for example,

a bolt) the values of the variables can be obtained automatically. For successful automatic connection

of the variables with the connector, the following conditions must be met:



T-FLEX CAD 17 Help

930

1. In the connector the named values have to be specified. These named values will subsequently

serve as a link between the variables of the fragment having a connector (bolt) and the variables of

another fragment (nut) which will be attached to the given connector in the assembly.

 

2. For corresponding variable of the fragment the list of names for the values or at least one name of

such sort must be specified for linking with the connector. The name of the value for the variable

has to be specified in advance in the variables editor in the fragment file by modifying the

properties of the variable. The name of the connector value specified for the variable must

coincide with the name of the value specified in the connector. Only in this case the automatic

connection is possible.
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3. Upon inserting the fragment, the connector must be chosen. The variables of the new fragment 

automatically take the values straightway after the connector selection. The image of the fragment

takes the form in accordance with the values of the variables.

The connection between the fragment variables and connector values can be determined manually. To

do it, resort to the list of the fragment variables in the command of creating and editing the fragment.

If the user-defined dialog is used for controlling the variables, switch to the list of the variables (List of

Variables flag). The manual setup of the connection between the variable and the connector value is

needed in case the fragment is attached to the connector but for its variable the connector value

name is not designed or that name does not coincide with the value in the connector. In this case,

clicking in the field Connector Values will show the list of the connector values and upon selecting

one of the values, the connection will be established. The field will be marked by a special symbol.
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Fixing Point

A fixing point is created as an intersection of a vertical and horizontal lines, whose parameters are

defined by variables with reserved names.

The variables reserved for the vertical lines are:

x1, x2, x3, x4, x5, x6, x7, x8, x9.  

Those for the horizontal lines are:

 y1, y2, y3, y4, y5, y6, y7, y8, y9.  

The numeric postfix of X and Y corresponds to the number of the fixing point and must match

between the vertical and horizontal lines that define one fixing point. Up to nine fixing points are

supported in a drawing.

Usually there are one or two fixing points on a fragment.

Vertical and horizontal plot lines define the fixing point of the drawing because they do not depend

on other construction lines. If you build all subsequent construction lines relative to the lines defining

the fixing points, you thereby create local coordinate systems of the drawing.

Fixing point creation

Create a new drawing using the 2D Drawing command. Enter the Line command. 

Select the <X> option, which corresponds to the  icon in the auto menu, to create a horizontal

and vertical line of construction. 

Move the cursor to the desired position and press <1> (<2>, <3>, ...) or use the icon in the automenu

. Two intersecting lines of construction will appear on the screen. As a result, two external

variables x1 (x2, x3, ...) and y1 (y2, y3, ...) will be created. The parameters of the horizontal and

vertical construction line will be set using these variables.

You have created a new drawing fixing point. When applying this drawing as a fragment to other

drawings, the T-FLEX CAD system will request the input of the fixing point. This is the easiest way to

create an fixing point.

Another method describes the possibility of creating a fixing point using the construction line options

menu.

Create a new drawing using the 2D Drawing command. Enter the Line command. Select the <X>

option, which corresponds to the  icon in the automenu. Move the cursor of the intersecting lines

to a certain place and press <P>. A menu will appear on the screen to set the parameters of the

construction lines.
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In the X coordinate parameter, enter x1 (or x2,.... depending on the fixing point number) instead of a

real constant. Press <Tab>. A menu will appear on the screen to set the value of the variable x1. You

can enter a new variable value. Press <Tab> and use <Space> to set the External parameter (this

parameter can also be set if you move the cursor to the square next to this parameter and press ).

Press <Enter>. The window will disappear and you will return to the previous window to enter the next

parameter of the construction lines. 

In the Y coordinate parameter, enter y1 (or y2,.... depending on the fixing point number) instead of a

real constant. Press <Tab>. A menu will appear on the screen to set the value of the variable y1. You

can enter a new variable value. Press <Tab> and use <Space> to set the External parameter (this

parameter can also be set if you move the cursor to the square next to this parameter and press ).

Press <Enter>. The window will disappear and you will return to the previous window to enter the next

parameter of the construction lines. 

Press <Enter>. The window will disappear and two intersecting lines of construction will appear on

the screen. You have created a new drawing fixing point. When applying this drawing as a fragment to

other drawings, the T-FLEX CAD system will request the input of the fixing point.

You can also create an anchor point using the Edit Constructions command. If you have vertical and

horizontal construction lines built in the drawing and you did not set their parameters using variables

when building them, then call the Edit Constructions command. Move the cursor to the vertical line

and click . The line will stand out. Click <P>. A menu will appear on the screen to change the

parameters of the construction line. 

In the X Coordinate parameter, instead of a constant, type x1 (or x2,.... depending on the fixing point

number) and press <Enter>. A menu will appear on the screen to set the value of the variable x1. You

can enter a new variable value. Press <Tab> and use <Space> to set the External parameter (this

parameter can also be set if you move the cursor to the square next to this parameter and press ).

Press <Enter>.  

Move the cursor to the horizontal line and click . A menu will appear on the screen to change the

parameters of the construction line. 

In the Y Coordinate parameter, instead of a constant, type y1 (or y2,.... depending on the anchor point

number) and press <Enter>. A menu will appear on the screen to set the value of the variable y1. You

can enter a new variable value. Press <Enter>. You created the anchor point in a different way. You

can use either of these methods, they both lead to the same result.

In the following description, the phrase Create the first (second, ...) fixing point will mean that you

need to perform all the steps described above to create the fixing point.

Consider the most commonly used ways to create fixing points of fragments and coordinate systems

of the drawing. All the methods described below for creating fragment coordinate systems are given

for the case when you create a new drawing (after calling the 2D Drawing command).

A non-rotatable fragment with a single fixing point

Create an anchor point. Call the Line command. Create a construction line passing through the node at

an angle to a straight line. To do this, move the cursor to the node located at the intersection of the

vertical and horizontal lines and press <N>. The node will be highlighted and a line passing through

the selected node will appear on the screen, which will dynamically change its position depending on

the cursor movement. Move the cursor to the horizontal line and press <L>. The line will stand out.

Press <P> and set the line parameter: the angle of inclination of the straight line to the horizontal line.

In the Angle parameter, set the variable al instead of the specific angle value. Press <Enter>. A menu

will appear on the screen to set the value of the variable "al". You can change the default value for a

variable (do not set the value to 0). Press <Tab> and use <Space> to set the External parameter (this
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parameter can also be set if you move the cursor to the square next to this parameter and press ).

Press <Enter>.You have created an external drawing variable. When you insert this drawing on another

as a fragment, the value of the variable al will be requested by the system. By creating a construction

line passing through the node at an angle to the horizontal line, you have created the X-axis of the

new local coordinate system of this drawing. To create the Y-axis of a new local coordinate system,

you need to build a construction line passing through the node and perpendicular to the construction

line built at an angle to the horizontal line. To do this, call the Line command. Move the cursor to the

node located at the intersection of the vertical and horizontal lines and press <N>. The node will be

highlighted and a line passing through the selected node will appear on the screen, which will

dynamically change its position depending on the cursor movement. Move the cursor to the line

drawn at an angle and press <L>. The line will stand out. Press <O>. A construction line perpendicular

to the line at an angle will be created. A line constructed at an angle and a line perpendicular to it

define a new local coordinate system of the drawing. 

All subsequent constructions must be carried out relative to the lines defining the new coordinate

system of the drawing. Adhering to this rule, you will get as a result a parametric fragment with one

fixing point and the variable al, which will determine the angle of inclination of the coordinate system

of this drawing relative to the coordinate system of the drawing on which you will insert this drawing

as a fragment.

For the convenience of constructing a relatively new coordinate system, it is recommended to do the

following. Call the Edit Constructions command. Move the cursor to the horizontal line and click .

The line will stand out. Move the cursor to the vertical line and press <Shift>+ . As a result, both

lines of construction should stand out. Click <P>. A menu will appear on the screen, with parameters

that you can change for a group of construction lines. Set the Level parameter. Press <Enter>. A menu

for setting parameter values will appear on the screen. Set the value of the Level parameter to -1 and

press <Enter>. The horizontal and vertical lines will disappear on the screen. This happened because

the visibility levels range from 0 to 127 is set for the construction lines in the Level command, and

these lines have a -1 level and do not fall into the interval. For more information about element levels,

see Layers. Levels. Priorities. Call the Variables command and set the value of the al variable to 0. Click

OK. On the screen, the line at an angle and perpendicular to it will be located horizontally and

vertically. Now it will be more convenient for you to create an image of your drawing.

Inserting Fragments into a Drawing

Calling the command:

Icon Ribbon

Draw > Insert > Fragment

Assembly > Assembly > Fragment

Workplane > Insert > Fragment

Keyboard Textual Menu

<FR> Draw > Fragment

There are several ways of inserting a fragment into an assembly drawing:

1. By using the command Create Fragment. 

2. Within the Library Explorer or library window.

3. By creating a fragment directly in the assembly context.
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The following description relates to the first two techniques of inserting a fragment into a drawing.

The third technique is described in the dedicated section «Top-Down» Design.

To insert a fragment into an assembly drawing, call the command Create Fragment:

The following options will appear in the automenu:

<O> Select File

<C> Create new Fragment in Assembly Context

<G> Mark out Fragment

<P> Set Fragment parameters

<R>
Repeat previous Fragment (accessible upon a repeated call to the

command

<F> Select Fragment to create its copy

<V> Associative Copy of Fragment

<F4> Execute Edit Fragment command

<Esc> Exit command

The controls for customizing parameters of the fragment will appear in the properties window. They

are put into several sections, their number and structure depend on the fragment creation approach.

The sections of the properties window allow selecting the file of the fragment being inserted, a way of

attaching the fragment, specifying external variables of the fragment, etc.

Before selecting the fragment file the dialog in the properties window contains only three

sections: Basic parameters, Fragment parameters, Options. The values of the parameters,

defined in the properties window before file selection, are automatically stored as default values

for all subsequently inserted fragments.

The first step when inserting the fragment is the selection of the file of a fragment. The dialog window

for selecting a file can be called with the help of the option  in the section Basic parameters of

the command's properties window. 

If you need to re-insert one of the fragments already available in the assembly drawing, it is

more convenient to use the options ,  and  (working with them will be described

below in the Repetitive fragment insertion).

In the window for file selection it is necessary to indicate the document file of the fragment. After

selecting the file, a dynamic image of the inserted fragment attached to the cursor will appear in the

drawing window. The contents of the automenu will be changed. The new state of the automenu will

depend on the fragment attachment approach specified in the properties window: by fixing points or

by fixing vector.

The fragment attachment approach is specified in the section Insert Fragment, with the help of the

parameter Fixing. In case the fragment is attached by the fixing vector, the required fixing vector can
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be chosen from the drop down list of this parameter. The required page of the fragment document

can be selected here as well (in case of multi-page document).

In the section Fragment parameters of the command dialog it is possible to specify various settings

for fragment insertion. A detailed description of these parameters is presented in the section

Fragment parameters.

The values of the fragment external variables are specified in the section Variables of the properties

window. This section is present in the dialog of the command's properties window if the fragment

being inserted has external variables.

In the section Preview of the command dialog the inserted fragment is dynamically displayed in

accordance with the specified values of the external variables, fixing elements (fixing points and fixing

vectors) are indicated. 

When defining fragment insertion parameters, you need to specify the placement points of the fixing

vector or fixing point in the drawing area. The coordinates of the specified points are shown in the

section Coordinates of the command's properties window.

After attaching the fragment on the current drawing, it is necessary to finish creating the fragment by

pressing  in the automenu or in the command's properties window. Before that a series of

additional operations can be performed with the help of the options appearing in the automenu of

the command at this stage of the fragment insertion:

<Ctrl+Enter> Finish input

<K> Input Fragment insertion points

<P> Set Fragment Parameters

<Y> Create Name for selected Element

<Ctrl+O> Open Fragment in Context of Assembly

<O> Open Part

<D> Automatic Explode

<S> Explode with Constructions

<F4> Open Fragment file for editing

<C> Select Clipping Hatch

<V> Inner Fragment Variables

<Z> Change Fixing Vector

<I> Select Other Element

<Esc> Deselect all elements

The option  starts the mode of respecifying the fixing point of the fragment.
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The option  allows assigning the name for the inserted fragment. The fragment name can be

used, for example, for search, for automatic creation of nodes of the fragment in the assembly, for

obtaining the values of the fragment variables in the assembly drawing with the help of the function

get:

get("Fragment name","Variable name"),
where Fragment name – the name that was specified for the fragment, and Variable name - the

name of the variable from the fragment drawing the value of which has to be obtained in the

assembly drawing.

To explode the fragment automatically the options  and  are used (see the section Exploding

Fragments). The options  and  allow opening the file of the inserted fragment straightway for

editing, after its creation has been finished automatically.

If necessary, for example, for fast insertion of several fragments in a row, it is possible, by setting on

the flag Auto Create in the section Options of the command's properties window, to turn on the mode

of finishing fragment insertion automatically after specifying its fixing points. In this case, the

fragment insertion will be finished automatically right away after specifying all fragment fixing points

or its fixing vector.

Detailed description of all steps of inserting a fragment (selecting the fragment file, defining

external variable values and placement, attachment of the fragment to the assembly drawing)

can be found in the respective topics of this section.

For a description of the Open Part  option, see the Specifics of working with assembly drawings

section.

Option  Inner Fragment Variables allows you to view and, if necessary, change the values of the

external variables of the nested fragment. After calling the option, you need to select one of the

nested fragments of the edited fragment, after which a window will appear in which its external

variables will be displayed.

Option   Change Fixing Vector sequentially switches the fragment vectors according to their list.

Option  Select Clipping Hatch you to trim the part of the fragment that does not intersect with

the hatching.

Selecting fragment file 

For specifying the fragment file the standard window for file selection is used. It appears after using

the option .

The source of choice can be both the structure of your folders and the installed T-FLEX CAD libraries.

Switching between these two sources is done using the drop-down list in the upper left corner of the

window to select a file.

The drop-down list of the  option displays a list of previous files.
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When you are in the fragment insertion command, it is also possible to indicate the library element in

the service window Library Explorer.

Selecting fragment from library

If a library element is used as a fragment, it can be assembled directly in the Library Explorer window

or in the auxiliary library window, bypassing a direct call to the command Create Fragment. In this

approach, you can use the context menu commands or the Drag&Drop mechanism. To use the latter,

select a fragment in the Library Explorer or library window by pressing  on the fragment and drag

it into the drawing area, while holding the left mouse button down. This will automatically activate the

command Create Fragment. You can get the same result by right-clicking  over a fragment in the

Library Explorer or library window, and then selecting the context menu item Insert.

Defining fragment external variables

If external variables exist in a drawing, you will be asked to define the values when inserting this

drawing as a fragment into assemblies. When attaching to the connector, necessary values can be

specified automatically.

Let's review defining fragment external variables in the example of a ball bearing drawing that we will

be inserting into a shaft drawing. An external variable "d" is created in the ball bearing drawing that

drives its inner diameter.

After choosing the name of the fragment-bearing, in the command's properties window the tab

Variables will appear which allows specifying the values for the fragment external variables. The

standard list of variables or user-defined dialog with the control elements can be used for specifying

the values.

If the fragment drawing has text fields with an external variable inserted into them (for example,

title block), then the values of such variables can be changed directly on the assembly drawing.

Let's consider first defining the fragment external variables using the list of variables. In this way,

variables may be assigned data of three types:  

1) Constant (a number in the case of a real variable, or a string in the case of a text variable); 

2) An assembly variable; 

3) None (the variable entry left blank).

Type 1: Assigning constant value

Let's set a particular value of the ball bearing diameter, for example, "30".
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In this case, as the shaft diameter varies, the inner diameter of the ball bearing will not change. To

modify the value of the ball bearing external variable, you will have to edit the fragment.

Fragment external variables can be pre-defined with default values when offered for defining.

The default values are copied from the respective variables in the original fragment drawing file,

if the flag Substitute Variable values is set in the command Set System Options on the tab

Fragments.

Type 2: Assigning assembly variable

Instead of a fixed value of the ball bearing external variable, let's type in the name Diameter of an

existing assembly variable. If a user puts in the name of a non-existing variable, the system will

prompt a user to create a new variable. Suppose, at the insertion time, the variable Diameter equals

"20".
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 Let's modify the variable Diameter to "40". In this case, the ball bearing image will adjust

automatically.

If a fragment external variable was named after an assembly variable, and such assembly

variable actually exists in the current assembly drawing, the latter value will be automatically

assigned to the fragment variable (see the chapter Variables).

Type 3: Undefined value

You can skip defining the external variable altogether, leaving the entry blank. 

In this case the value read from the fragment file will be put into. To change now the ball bearing

diameter, it is necessary to download its file as a separate drawing, specify the desired diameter value

in that file, and after saving the file return to the assembly drawing. This scheme is used in practice
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rarely, when it is required to modify the assembly drawing by changing the values of the variables in

the fragment file.

 For filling in unspecified values of the variables automatically, in the System options a special

parameter Substitute variable values is turned on by default. In this case, upon inserting the

fragment, all variables automatically get constant value read from the fragment.» is turned on

by default. In this case, upon inserting the fragment, all variables automatically get constant

value read from the fragment.

Working with user-defined dialog

User-defined dialog with control elements represents itself a more visual tool for working with

external variables of the fragment. The set of different control elements allows specifying the values

for the variables with the help of various toggles, buttons and also by entering the values from the

keyboard or working with the list of values. There are two regimes in which the dialog fields for the

value entry can operate. Either the value of the variables or the expressions themselves can be

displayed in the fields of the dialog. In the latter case, the values of the expressions are shown to the

right of the entry field. The second regime works in case the parameter Show expressions has been

set on in the properties of the entry field. Details of creating user-defined dialogs are described in the

chapter Control Elements.

In any case, a user can write both values and expressions into the entry fields. After finishing the data

entry (when the focus of input is shifted to another field), the fragment external variable which is

related to the given entry field will be set equal to the expression.

To define a relation between a fragment external variable and an assembly variable, you can use the

context menu commands.

You can call the context menu command Insert Variable or, instead, simply press <F8>. The standard

Insert Variable dialog box will be displayed in the screen. Upon selecting an assembly variable, its

value will be assigned to the fragment external variable. A checkmark before the respective command

of the context menu will be indicating that the current fragment variable has a relation with an

assembly variable. Direct editing of the dialog entries will be modifying the respective assembly

variable values. To cancel such a relation, call the same context menu command again. 
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To cancel such a relation, call the same context menu command again. When the connection

with the variable is established, it is possible to continue working with the drop-down lists of the

values. While doing it, the assembly variable connected to the given fragment variable will be

assigned the new value from the drop down list.

Using configuration

For specifying the values of the fragment’s external variables, it is also possible to use configurations

created in the document of the fragment.
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When configurations exist in the fragment’s document, the parameter Configuration is available in the

fragment’s parameters dialog. Its drop-down list contains the names of the configurations created in

the fragment’s document. When selecting a configuration, all fragment’s external variables are

automatically assigned the values stored in the selected configuration. 

In addition to the names of fragment’s configurations, the list of the parameter Configuration

contains additional items:

Without configurations – this option is used to prevent the use of configuration;

Variable… – allows specifying the name of the used configuration with help of the variable. After

selecting this item in the list, the window for specifying the variable’s name will pop up on the screen.

The variable’s name can be specified either manually (in curly brackets) or with the help of the context

menu command Insert Variable… F8.
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Defining fragment placement in the assembly drawing

When specifying location of the fixing vector or fixing points, the nodes of the assembly drawing can

be picked for carrying out fragment attachment to the elements of the assembly drawing. When

changing location of the specified nodes of the assembly drawing, the fragment placement will be

modified as well.

If necessary, the fragment can be inserted by specifying the absolute coordinates for the fixing vector

and points. This becomes possible upon clicking at the desired place of the drawing in the absence of

object snap. The object snap can be turned off via the toolbar View or by pressing the key <Ctrl> at

the time of the click. In this case, with the help of the section Coordinates in the fragment properties

window the adjustment of the coordinates of the fragment insertion can be performed.

Fragment placement using fixing vectors

When inserting a fragment by the fixing vector, the system asks to define the vector fixing points.

If the fixing vector was defined in the fragment drawing by a single point, then you need to specify

only one point in the assembly drawing to place the fragment. Once that is done, the image of the

fragment will be placed in this point. The fragment image cannot be rotated in this case. If the fixing

vector was defined by two points in the fragment drawing, then the fragment can be placed in several

ways. 
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The first way implies specifying two points, the first defining the location of the fragment image, and

the second - rotation of the fragment image about the first point.

<M> Fixing using two points

When proceeding in this way and snapping the vector start to one node and the vector end to

another, modifying the position of the first node will change the location of the fragment image,

while the second one - the orientation.

            

The second approach differs from the first one as follows. The first point still defines the location of

the fragment image, while the second point, instead of maintaining the rotation, sets just once the

rotation angle of the fragment image with respect to the X-axis of the assembly drawing. The angle of

rotation for the fixing vector can be specified as a variable.

This way is handled by the option that appears upon defining the first point:

<M> Fixing using one point and angle

With this type of placement, modifications in the position of the first placement node will cause

change in the fragment location only, not affecting the rotation angle of the fragment image.
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Before confirming the fragment insertion or in the fragment editing command, already inserted points

of the fixing vector can be easily changed. For modifying location of the desired point, bring a cursor

to this point. The cursor will take the form corresponding to the point number (1 or 2). Next by

pressing  select the point, and the system will be ready for modifying the point location. Choose

the new position and press .

The fragment being inserted can have several fixing vectors. For selecting the desired vector, the

section Insert Fragment in the properties window should be used. In the drop down list Page it is

possible to select the desired page of the fragment document (if the fragment contains several

pages), and then for the selected page the fixing vector is picked in the drop down list Fixing.

The section Preview of the properties window can be also used for changing the fixing vector. Here,

on the preliminary image of the fragment, the active fixing vector is highlighted with a red color, the

rest are blue. The fixing vector can be selected by clicking in the preview window.
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Attaching to connector

When inserting a fragment with a fixing vector, turn on the mode of snapping to connectors. This

mode is activated by the automenu option:

<C> Mode of snapping to Connectors

The option appears in the automenu immediately after selecting a fragment file, if the system

determines that the current fragment is placed using a fixing vector. In this mode, as the pointer

approaches a connector or a graphic line referenced by the connector, the variables of the fragment

being inserted automatically assume the values from the same-name connector variables. This reflects

on the changing shape of the fragment. At the same time, the updated fragment automatically snaps

to the connector. 

When attaching to the connector the system may require specifying additional transformations

(see below).

If you need to define the values of other variables, this can be done in a conventional way (see above).
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Additional transformations

When attaching the fragment with the help of the fixing vector, sometimes it is required to make the

fragment location more precise – move or turn the fragment with respect to the axes of the fixing

vector, i.e. define additional transformations. Transition to specifying additional transformation can be

carried out straightway after specifying the points of the fixing vector. While doing it, a special

dragger in the form of the coordinate system will appear on the fragment image. If the cursor is

brought to the elements of the dragger (the coordinate axes and the arc between the axes), it will be

taking the form in accordance with the offered transformation – ,  rotation or , 

translation along one of the axes. When specifying the rotation, one of the dragger axes is also

selected (namely the nearest one) for possibility of defining exact direction to the selected point on

the drawing.
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If at this moment  is pressed, the fragment will start moving following the cursor. For fixing the

current transformation, it is necessary to select the object on the drawing or specify the numeric value

of the transformation. Selection of the object of the drawing will create its associative link with the

transformation. This means that upon changing the object location, the transformation will be

automatically adjusted as well. The numeric value for the transformation is specified in the properties

window or by clicking  at the free space of the drawing without selecting the object.

It is possible to define an unlimited number of transformations successively. All specified

transformations are put into the properties window. The transformations of similar type (for example,

several translations along the same axis) are automatically summed up.

When attaching the fragment to the connectors, the requirement of defining additional

transformations can be brought into the fragment file already at the connector creation stage. In this

case right away after the connector selection (when attaching another fragment) and reading the

values of the variables, the system will automatically turn to specifying the required additional

transformation. This approach is frequently used in the libraries of the standard elements since it is not

always possible to automatically determine the location of the future fragment. For example, when

putting a nut on a bolt, it is almost always necessary to place this nut on the surface being fastened,

the attachment to which is specified by a user while defining additional transformations.

Fragment placement using fixing points

If the fragment drawing contains external variables “x1”, “y1”, “x2”, “y2”, etc., then upon inserting the

fragment into the assembly drawing you will have to specify as many placement points as you have

pairs “x” and “y” with the respective numbers in the fragment drawing.

For example, suppose we want to locate the image of the transistor, the drawing of which has three

fixing points. Each point specifies location of one transistor contact. When inserting the fragment on

the assembly drawing, the system will successively prompt a user to specify location of each point.
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When specifying the fragment fixing points, the current fixing point number will be drawn next to the

cursor.

The dynamic image following the cursor helps to evaluate the appearance of the future fragment. If

necessary (in case of complicated for dynamic imaging fragments) the dynamic image can be

switched off with the help of the option:

<W> Dynamic Preview

          

There are two possibilities for specifying locations of the fixing points: attach the fixing point in

absolute coordinates (independent of the assembly drawing) or snap to the node on the assembly

drawing. Attachment in absolute coordinates is carried out by pressing  while the object snaps are

turned off or by pressing simultaneously the key <Ctrl>. Snapping to a node is done via  with

simultaneous node selection or with the help of the option <N>. 

Repetitive fragment insertion

Several options are provided in the fragment creation command Create Fragment for repetitive

insertion or duplicating fragments. Use of these options speeds up insertion of identical fragments. 

Multiple insertions of the last created fragment are supported by the option:

<R> Repeat previous Fragment

The option allows you to select the fragment that needs to be duplicated in the drawing:

<F> Select Fragment to create its copy

The option allows you to select a fragment that needs to be duplicated in the drawing, while

maintaining an associative relationship:
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<V> Associative Copy of Fragment

Unlike a regular copy, an associative copy of a fragment will react to a change in the value of

external variables of the source fragment.

Upon calling one of those options, the system asks you to specify just the placement of the fragment

in the drawing. In this case, the external variables will have the same values as the fragment being

duplicated. 

Adding Projections and Schematic Drawings of Models to Assembly Drawing 

This option allows us to add projections or schematic drawings of models onto a plane.

<W> Project 3D fragments onto a workplane 

After the command is activated, the automenu appears.

<W> Select workplane for specifying projection direction

<F> Select 3D fragment

<A> Select all 3D fragments in scene

<Esc> Exit from the command

Using the command:

1. Select a plane onto which the model will be projected . The selected plane will be displayed in

the operation’s properties in the Workplane field;

2. Select one or several models for projection  or ;

3. Select projection type or schematic view.

The source for the 2D fragment being created can be selected in the list in the Snap field: 
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1. Model

2. Raster Projection

3. Vector Projection/Vector for "Top View"

4. Vector for "Scheme"

· Vector Projection - a projection of the selected model is created based on the lines of its image;

· Raster Projection - a projection of the selected model is created in the form of a 2D fragment;

· Vector for "Top View" - the schematic image "Top View" created earlier in the fragment is added

to the workplane (see the Using 2D-fragment as «projection» for 3D fragment section);

· Vector for "Scheme" - the schematic image "Scheme" created earlier in the fragment is added to

the workplane (see the Using 2D-fragment as «projection» for 3D fragment section).

Using 2D-fragment as «projection» for 3D fragment

This method allows us to create, on the drawing, instead of projection of a 3D fragment, a 2D image

prepared in advance in the fragment’s file (the term “the schematic view” is used below).

This can be a simplified image or a drawing of the workpiece. In most cases the assembly’s drawing

created in this way will be recalculated faster than the drawing obtained by projection of the

assembly.

This method can be conveniently used when creating layouts of industrial shops, creating electric

circuits and in other cases that require schematic display of 3D elements on the drawings.

Furthermore, schematic view can contain conditional graphical views which can not be foreseen on

projections (for example, direction of door opening).

Preparing simplified image in fragment’s file 
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To get started, open or create a 3D model of the fragment. In this example, the pipeline element is

selected.

On the Top View workplane, create a "Top View" drawing of this element.

It is important that the overall dimensions of the drawing and the 3D model are the same. If the

model is parametric, then the created image should also be rebuilt when the parameters change. 

In this case, it is convenient to use the Project Elements command and create the necessary drawing

based on auxiliary lines.

If you do not make the model parametric and the length of the pipe in the drawing, for

example, will be less than that of the 3D fragment, during assembly it will not be connected to

other pipeline elements. 

You can create several different drawings of a part on the same or on different workplanes, and then

select any of them when creating an assembly drawing.

Next, you need to create another schematic drawing "Scheme", but before that you need to assign a

certain layer to the "Top View" drawing.

Use the Layers command from the Edit ribbon tab to create a new Top View layer.
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Next, select the graphic lines of the drawing image and select the Top View layer in the options

window.

Now the selected graphic lines will be associated only with it.

Next, on top of the previous drawing "Top View", create a schematic drawing "Scheme" using a

different color of the graphic lines.
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Independently assign a layer for the graphic lines of the schematic drawing "Scheme" in the

same way as described above.

You can control the visibility of graphic lines by enabling the Invisible option for a specific layer.

The next step is to create a fixing vector using the Fixing Vector command in the Workplane ribbon

tab. Specify the beginning and end of the vector in the drawing.
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The fixing vector is used to create a connection between the 3D model and the drawing. 

In the window that appears, specify the name of the vector Vector for "Top View". In the Link to

Layers field, select Draw only marked, so that when applied, only the drawing located on the selected

layer is displayed as a fragment. From the list of layers, select the Top View layer. 

In the Link to Workplane field, select the workplane to which the fixing vector will be associated. In

the View orientation field, select the axial symmetry option.

Repeat the same sequence of actions for the second drawing, specifying a different layer.

For more information about creating fixing vectors, see Bottom-up Design.

As a result, we have two schemes to insert into the assembly drawing.

Save the fragment file.
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Creating a schematic image of a 3D fragment in an assembly

Create a new assembly file and insert the previously created 3D pipe fragment into it.

Next, you need to go to the 2D page of the Top workplane.

In order for the pages of the workplanes to be displayed in the 2D window, you need to call the Pages

command in the Edit ribbon tab.

The command call is available only when the 2D window is active. 

In the window that opens, set the Workplane flag.

Now workplanes tabs will be displayed at the bottom of the 2D window.

Go to the workplane Top page.

Call the Fragment command in the Assembly ribbon tab.

Activate the automenu option:

<W> Project 3D fragments to workplane

Select the Top workplane on which the image will be created and the body for which it will be

created. 

It is possible to select several bodies at once manually or all the bodies in the scene using the option:
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<A> Select all 3D fragments in Scene

For the current 3D fragment in the list in the Binding field, you can select the source for the 2D

fragment being created:

· Vector Projection - a projection of the selected model is created based on the lines of its image;

· Raster Projection - a projection of the selected model is created in the form of a 2D fragment;

· Vector for "Top View" - the schematic image "Top View" created earlier in the fragment is added

to the workplane;

· Vector for "Scheme" - the schematic image "Scheme" created earlier in the fragment is added to

the workplane.

Select the Vector for "Scheme" and click Finish input. A new schematic image "Scheme" will appear

on the Top workplane.

If Vector for "Top View" was selected, the schematic image would look like this:

In this example, this image is the same as the Vector Projection.

If Raster Projection was selected, the schematic image would look like this:
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When moving a 3D fragment, such a 2D fragment will change its position.

Fragment parameters

The section Basic Parameters contains data about the fragment file. The text of the link to the

fragment file is written in the editable field. The link can be full or relative. The second line displays

the full path on the hard disk where the recorded link works. The relative reference can be written

manually or automatically in the following form:

· ..\..\folder\file_name.grb – in this case, the record is made relative to the file of the assembly

drawing. The symbol ..\ denotes going along the folders by one level up with respect the

assembly file.

· <library>file_name.grb – in this case, the reference uses the drawings library connected to T-

FLEX CAD.

It is recommended to use the relative references which operate in a more flexible way and are not tied

to a specific place on the hard disk. It allows a user, for example, to move the assembly with all

documents contained in it from one place to another without any losses.

The section Insert Fragment allows a user to select the desired page of the document being inserted

as a fragment (parameter Page). This parameter is not available if there is only one page in the

fragment. Also, in the drop down list Fixing found in this section, the attachment approach is

specified: either by fixing points or by fixing vector.

The section Fragment Parameters contains different parameters of the fragment insertion:
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Scale. Defines the scale of the fragment being inserted. This is used only when inserting fragments by

fixing vectors. 

Rotation Angle. Defines the angle of the fragment rotation. This is used only when inserting fragments

by fixing vectors. 

Scale line thickness. This parameter specifies whether to apply the assigned scale to the fragment

lines thickness. This is used only when inserting fragments by fixing vectors. 

Symmetry About Fixing Vector. When set, the fragment image will be mirrored about the fixing

vector. This is used only when inserting fragments by fixing vectors.

Ignore text symmetry. This parameter is important when using the “Symmetry about vector” flag.

When this parameter is enabled, texts on the fragment are not subjected to symmetric reflection with

respect to the fixing vector (when the fragment itself is symmetric).

Always regenerate 3D model. With this flag set, the 3D model of the fragment will be automatically

regenerated upon changes to the 2D fragment parameters. 

Constant Fragment (Symbol). Setting this parameter makes the inserted fragment saved in the

assembly document as a picture. This allows speeding up the work with the assembly since now there

is no necessity to resort to external files. The fragment file is not read when opening the assembly.

Owing to that, the fragment can be displayed in the assembly even in case its source file is absent.

However, since this is a picture, other elements of the drawing cannot be fixed to it. Also, it is not

possible to modify variables of such fragment from the variables editor of the assembly drawing

(when the connection between the assembly variable and the fragment variable exists). Modifying

variables is possible only upon editing such fragment on condition that the source file exists on the

hard disk at the indicated reference.

Use Status of. As any T-FLEX drawing, the fragment has its own drawing settings defined in the

commands Set Document Parameters and Set Levels. Those include the line thickness, the font size,

levels, etc. One of the two status settings can be selected for the fragment being inserted into the

current drawing:

· Fragment. In this case, the fragment will be inserted with the settings defined in the fragment

drawing.

· Current Document. The inserted fragment will adjust to the settings of the current document.

This choice is used when the assembly drawing is required to maintain a uniform style. Besides,

by changing the ranges of visibility levels you can "turn on" or "turn off" certain portions of the

fragment drawing when it is used in an assembly. For instance, one can remove "extra"

drawings or dimension symbols.

Include in Product Composition. 

This parameter manages incorporation of fragment data into the bill of materials of the current

drawing. It can take the following values:

· Don’t Include - the fragment is not entered in the BOM table. 

· Without Embedded Elements - the fragment is entered in the BOM table. If the fragment is an

assembly itself, then only the fragment proprietary data is entered into the BOM. The

information about the nested elements (lower-level fragments) is not included.

· With Embedded Elements - the fragment is entered into the BOM together with the nested

elements.

· Embedded Elements Only - only the nested elements are entered into the BOM.

If incorporation of fragment data was not defined upon creating a fragment or if it is necessary to

associate a fragment with particular Product Composition, you can call the parameters window after

the fragment was inserted.

In this case, the name of the aforementioned parameter will change to as Include in new Product

Composition and, therefore, this parameter will take effect only on the newly created product

structure in the current document.
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Additionally, a graphic button Include in Product Composition... will be provided for displaying the

window with the list of product compositions existing in the current document, and the settings of the

fragment contribution to each of them.

By activating the Assign Product Composition option, one of the structures of the workpiece which

are present in the fragment’s file can be selected. 

The way of including the given fragment into the assembly’s structure can also be specified using

Include in Product Composition command

The section Variables allows a user to specify the values for the fragment external variables. 

This section is present in the command's properties window only if the fragment being inserted

has external variables.

Both the list of variables and the user-defined dialog of the fragment parameters (if it has been

created in the document of the fragment being inserted) can be used for specifying external fragment
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variables. The choice of the desired way to work with the variables is made with the help of the flag

List of variables.

The section Coordinates can be used for specifying precise coordinate values for the points of the

fixing vector or the fragment fixing points if these points are not being fixed to the elements of the

drawing. 

The structure of the controls in the section Coordinates changes depending on the situation.

Section Preview. In this section of the properties window the diminished image of the fragment on

the selected page is shown. The fixing vectors are also shown in this window if they exist. The desired

fixing vector can be selected in this window by pointing at it. The selected fixing vector is shown with

red color. The rest of the vectors are blue.

Section Options contains the following parameters:

· Auto create 3D fragment. (Available only for 3D version). In case this flag is set on, right away

after inserting the new 2D fragment the corresponding 3D fragment is automatically created

with attachment by default (without using the coordinate system).

· Auto create. When turning on this flag, the process of inserting the fragment will be finished

automatically straightway after specifying the fixing points or the points of the fixing vector of

the fragment.

· Create internal fragment. This parameter allows a user to create an internal fragment, the

contents of which are stored in the assembly drawing, but not in the external file.
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· Explode. As a result of exploding, the drawing view is deleted, while all its content (nodes,

graphic lines, etc.) are transferred directly to the drawing page. The operation of the parameter

is similar to the Explode Drawing View command in the context menu of the drawing view.

· No. Elements are not transferred.

· Without Constructions. Only the nodes and graphic lines are transferred.

· With Constructions. All construction elements  are transferred.

· Group. When a fragment is exploded, all its elements will be automatically combined into a

group.

· Do not remove hidden lines. When this parameter is activated, the invisible lines of the

fragment will not be deleted.

Priority. Defines the priority of the fragment in the assembly drawing. This is used for changing the

order of drawing fragments within the current document and for the fragment hidden line removal.

Priority is represented by an integer, positive or negative. Fragments with lower priority will be drawn

in the screen prior to the fragments with higher priority. The priority of the current (assembly) drawing

is equal to "0" by default.

Level. Sets the fragment level.

Layer. Sets the fragment layer.

The button Options. Provides a shortcut to defining the system parameters for handling fragments.

The parameters in this dialog are the same as those on the tab Fragments of the command Set

System Options. 

Top-down Design

When using the "Top-down" design approach, separate parts-fragments are created directly within

the assembly drawing window while working with the assembly. There are two approaches to creating

a fragment when using the "Top-down" method - fragment extraction and working in the assembly

context. In the first case, a fragment can be created by extracting into a separate file the necessary

elements of the assembly drawing. The second case allows creating a new part drawing with the

provision for referencing existing elements of the assembly drawing. 

The fragments created in this way can be attached to the elements of the assembly itself or other

existing fragments. This helps excluding or significantly reducing use of external variables and

simplifies handling of an assembly. Meanwhile, some values of the original model parameters can be

obtained directly from the assembly context. This approach significantly simplifies relating elements

with each other and provides parametric relation between those. If dimensions or position of one of

the parts is modified, then all related model elements will adjust automatically.

Working in the assembly context simplifies in certain cases the design process of the assembly

module. This also facilitates development of the complete documentation suite of such a module,

including detail drawings of all contributing fragment parts. Upon modifications to any assembly

document, either the assembly drawing itself or one of its fragments, the changes propagate to all

documents of the assembly (automatically or by the user request). As a result, modifications to one

part cause update of the full suite of new documentation for the assembly, including the assembly

drawing itself and detail drawings of all contributing part fragments.

The "Top-down" design approach may not be suitable in all cases of designing assemblies. The

method has certain shortcomings that limit its use:

· More complicated organization, compared with the approach "from part to assembly";

· Lesser robustness to topology changes. For example, once an assembly line is referenced by an

introduced fragment, it can no longer be deleted, otherwise the fragment associative

reference will be lost;
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· This approach is less convenient in terms of reusing fragments in other assemblies, since

modifying a fragment may be complicated without the availability of references to the

original assembly;

· Upon an attempt to extract a fragment, if it is impossible to "detach" an element from the

assembly drawing, additional copies of the necessary elements are created in order to

preserve parametric relations in the assembly drawing;

Somewhat higher computational resources are required.

· The icons for handling the "Top-down" approach can be found:

· In the textual Menu File > Fragment > ...";

· In the automenu of the command Create Fragment:

<C> Create Fragment in Assembly 

<G> Mark out Fragment

Managing fragments in assembly context

When using the option , the first step will be specifying the name of the fragment being created,

using the "Save As" dialog box. After that, all construction elements of the assembly will be hidden in

the drawing window, and the graphic elements drawn in halftone. While in this mode, all newly

created construction and graphic elements will belong to the new fragment. As you create drawing

elements, you can use one of the following modes of snapping to assembly elements:

·  Associative snapping. In this case, the fragment elements can be snapped to the graphic lines

and nodes of the assembly. (By assembly nodes, we mean the joint points of the graphic lines

and the attachment points of the detailing elements.) This ensures two-way relation between

the assembly and the fragment file. In other words, changes in the assembly drawing can be

propagated, upon the user request, into the fragment file, and, vice versa, modifications in the

fragment file cause the assembly document update. As the pointer approaches assembly

nodes in this mode, those are highlighted and marked by the tooltip "Assembly Node", while

the graphic elements – "Assembly Image".

·  Non-associative snapping . In this mode, snapping to assembly drawing elements is also

available. However, in this case, snapping is done to the current "snapshot" of the assembly.

The future modifications of the assembly lines won't affect the fragment image.

·  No snapping (both of the above modes should be undone). This mode is none different from

conventional drafting. The assembly drawing displayed on the screen does not interact with

the fragment elements in any ways.

The icons of the snapping modes can be found in the context menu and also in the textual menu

“Customize > Snap > ...”.

It should be noted that the inclusion of any of the binding icons is possible only when the system

object binding is enabled (View Toolbar > Object Snap).

The following diagrams show fragment creation in the assembly context, using associative snapping.

In this mode, the assembly construction elements are hidden, while its graphic lines are shown in the

halftone. When creating fragment construction lines, snapping to assembly elements is engaged. The

graphic elements of the fragment drawing are created last.
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Upon finishing working with the fragment, the system returns to the normal mode of working with the

assembly drawing. If the created fragment was saved, its image will appear in the assembly. To finish

working with a fragment, use the options in the context menu:

Keyboard       Textual Menu Icon

<FF>
File > Fragment > Save Fragment and Return to

Assembly

<FQ> File > Fragment > Close Fragment

Extracting Fragment from Assembly Drawing

The option  serves for creating a new fragment by moving or copying into a separate file already

existing elements of the assembly drawing. Upon the call, the following options appear in the

automenu:

<Ctrl+Enter> Finish Fragment Creation

<M> Select Mode

<M> Deselect Mode

<F> Assign Fixing Vector

<V> Select Variables for Copying into Fragment

<D> Delete or hide selected elements after creating Fragment

<Esc> Exit command

Fragment extraction is the action opposite to that of the option Explode Fragment. To create a

fragment, the user just needs to select a set of graphic elements (lines, dimensions, hatches, etc.) of

the assembly drawing to be carried over into the separate fragment. When creating a fragment,
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besides the graphic elements picked in the assembly drawing, their respective construction elements

are also created.

The option  allows picking the assembly drawing elements, adding those to the contents of the

fragment. (The selected elements are highlighted.) 

The option  excludes elements from the selected set.

The option  toggles between the modes:

· If the icon is in the pushed state, then, after creating the fragment, the elements included in the

fragment are deleted from the assembly drawing. Exception is the parent elements of other

elements. In this case, the system will not delete the element. Instead, it will make it hidden

(invisible) by assigning a special attribute; 

· If the icon is not pushed, then the fragment contents are formed by the copies of the selected

elements.

Creation of a fixing vector (the option ) is optional. However, if you need to make a provision for

modifying the attachment of the fragment being created or placing its duplicate at other locations,

then you should perform this step. A fixing vector can be created in one of the ways described above.

The option  brings up the dialog box for selecting variables existing in the assembly drawing, to

be copied to the fragment. The list in the left-hand side pane contains all plain variables. Variables

defined by an expression cannot be copied into a fragment. The variables can be carried from the left

to the right pane and back using the graphic buttons [>], [<]. The buttons [>>], and [<<] allow

carrying over the whole list. All fragment variables that originated from the assembly drawing are

automatically deemed "external".

The fragment creation can be completed using the icons: 
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<End> Finish Fragment Creation

<Esc> Exit command (without saving the fragment)

Calling the option  brings up the dialog box for defining the fragment filename. If variables to be

copied to the fragment were not defined in the course of the fragment creation  (as they would have

been by the option ), the dialog for selecting variables will appear prior to the filename defining

dialog. The diagrams on the right hand side show the fragment extraction. The first step is selecting

the elements to include in the new fragment.

 

After that, a fixing vector is created. Next, the necessary variables are selected, and the filename is

defined. As a result, the selected lines are placed in the assembly drawing by the 2D fragment

possessing the set of the specified parameters. 

Whenever possible, we recommend creating all elements directly in the new fragment, rather

than carrying those over from the assembly drawing. This approach enhances productivity.

Editing Fragments

Calling the command:

Icon Ribbon

-

Keyboard Textual Menu

<EFR> Edit > Draw > Fragment

As for any other T-FLEX element, the common selection and editing rules apply to a fragment. That

means, selection of the necessary fragment for editing is done by clicking , while the option <P>

or  is used for changing its parameters, etc. 

To select multiple fragments, one can use the key combination <Shift>+  (for adding elements to

the selected list), <Ctrl>+  (excluding an element from the list) or the box selection.

To select a fragment by name, use the option:
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<S> Select Fragment from List

This option can be helpful when the fragment with the known name is hard to find in the drawing.

Besides, the option may be very helpful for editing the reference paths of several similar fragments

simultaneously. A dialog box will appear in the screen, where you can select the desired fragment. 

By default, the fragments appear in the list in the order of their insertion into the assembly drawing.

The flag Sort by Name alters the order of fragments in the list. The graphic buttons Change allows

changing the filename, the reference paths or both, of the selected element (or a group of elements)

in the list. 

The fragments which because of some reasons lost connection with the external file are marked with

the question sign.

Selecting the option Change Name allows modifying the filename only, without changing the path. 

Selecting the option Change Path modifies the path to the fragment without changing its name. 

Selecting the option Change Name and Path modifies both the Name and the path of the fragment

file.

We recommend using relative paths to the assembly or library rather than full paths, when

inserting fragments. Using relative paths simplifies porting assembly drawings to different file

systems.

In some cases, the system may automatically record the relative path to a reference with respect to the

assembly file. Depending on the relative location of the fragment and the assembly file, the relative
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path to the reference may appear differently. The following table shows examples of relative path

formats for fragment references:

Assembly location Fragment location Fragment reference path

C:\Assembly.grb C:\Drawings\Parts\Part3.grb Drawings\Parts\Part3.grb

C:\Drawings\Assembly_1\Assembly.grb C:\Part2.grb ..\..\Part2.grb

C:\Drawings\Assembly_1\Assembly.grb C:\Drawings\Assembly_1\Part1.grb Part1.grb

Any Library "Bolts", file  "Bolt_1.grb" <Bolts>Bolt_1.grb

Follows are the rules that are accepted for the fragment reference relative path formats:

1. If the assembly is located at a higher level in the file tree, than the fragment, then the reference will

be always relative to the assembly file. In this way, the portion of the full path to the reference,

identical with that of the assembly file path, is removed, resulting in the relative path to the reference.

2. If the assembly is located deeper in the file tree, then the fragment, yet in the same tree branch of

the file system, then T-FLEX CAD system will be able to create the relative path for the reference. In

this way, to step up one level in the file tree, the system will use the notation "..\" in the beginning of

the reference path. However, if the reference requires switching to another branch of the file tree, the

user will have to specify the reference path manually, as the system won't be able to do this

automatically.

3. If the assembly file and the fragment file are in the same folder, then the reference name will consist

of just the fragment file name.

4. If the fragment file was inserted from an opened library, then the reference relative path will contain

the library name, in brackets, and the fragment file name.

Upon selecting a fragment, it will be marked by an outlining rectangle. All fixing points or the fixing

vector of the fragment will be highlighted.

External variables manipulators of 2D fragment

For additional convenience, the system allows modifying the fragment's external variables dynamically

by the mouse, using specially provided manipulators (draggers). By default, manipulators appear

automatically, as you start editing a fragment, which contains construction lines and 2D nodes that are

defined by external variables. Manipulators of lines look like continuous blue lines, manipulators of

nodes look like brown squares. Color of nodes' manipulators can be changed in system options

(Options > Color > 2D Draggers > Highlighting). Manipulator gets thickened upon hovering the

mouse cursor over it. An icon near the cursor indicates type of a manipulator. Upon clicking  a

manipulator, corresponding line or node starts following the cursor. Move the line or node into a new

position and click  again to confirm the new configuration of a fragment. The manipulators can be

disabled for a particular fragment in its document parameters (Document Parameters > Document >

2D Fragment > 2D Fragment > Enable draggers on edit).



T-FLEX CAD 17 Help

970

Variables Editing for Several Fragments

The system allows the simultaneous modification of the variables with the same name for several

fragments at once. For modifying the fragment variables it is necessary to perform the following

actions:

· select fragments on the drawing;

· invoke the context menu by pressing the right mouse button and choose the command

Variables;

· introduce modifications in the dialog which appears.

Upon calling the command of the context menu Variables, the dialog with the list of variables of the

selected fragments appears. This list may include either all variables of all fragments or only common

variables (i.e., the variables with coinciding names). Control is carried out with a toggle Show

variables at the bottom of the dialog.

The common variables in different fragments can have different values. In this case, for such variables

opposite their value there will be a special control element – a flag which when being switched on will

let a user change the value. Modification of the value for the common variable will be applied to all

selected fragments.

Using Clipboard for Fragment Variables

When selecting a specific fragment with , the commands for copying variables from one fragment

to another will be found in the context menu. The command Copy variables to clipboard copies
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values and expressions for the variables into the internal clipboard. The command Insert variables

from clipboard replaces the values of the variables having the same name for the selected fragment

with the values from the clipboard.

Editing Fragment in Assembly Context

The Open in Context option for editing in the assembly context is available in the context menu of the

selected fragment and in the automenu of the command Edit Fragment.

Upon calling the option, all elements of the assembly drawing other than those belonging to the

fragment are drawn in halftone, and the fragment elements become editable. As in the assembly-

context fragment creation, the user can create and/or edit the fragment drawing. With the associative

or non-associative snapping to assembly elements turned on, you can use nodes and lines of the

assembly drawing as references. The commands for modifying the snap types and exiting the mode of

work in the assembly context can be found in the context menu.

Updating Fragments Files

The options Refresh Fragment File and Refresh All Fragments Files  are provided for updating the

fragment document per the changes in the assembly when working by “Top-down” approach or in the

assembly context. To update a single fragment, you can use the respective option in the automenu of

the command Edit Fragment or the command Update, accessible in the context menu. To update all

fragments per the changes in the assembly drawing, use the option Refresh All Fragments Files in the

textual menu item File > Fragment > Refresh Files.

See Also:

· External Variables
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Composition Document. Embedded Fragments

A T-FLEX CAD document can refer to other files: T-FLEX CAD documents (fragments), graphic files

(pictures), database files, etc. Working with such a composite document can cause a number of

difficulties, for example, if it is necessary to transfer it to another computer.

To facilitate the work with composite documents, a mechanism for working with links has been

developed in T-FLEX CAD. A link is a T-FLEX CAD object containing the path to an external file (the

link object). 

The link is used when creating fragments, images and other T-FLEX CAD elements to specify the

source of external data. The same link can be used by several elements, for example, several

fragments based on the same file will access the same link.

The mechanism of working with links allows you to control the way link objects are stored. T-FLEX

CAD allows you to store the reference object both outside the T-FLEX CAD document as a regular

external file ("external link"), and directly inside the composite document file ("internal link"). Internal

link storage increases the size of a composite T-FLEX CAD document, but allows you to work with it as

a single file. Working with links is carried out using the commands located in the Assembly Structure

window.

The mechanism of working with links allows you to solve the problem of transferring large assembly

documents. When using it, there is no need to search for all fragment files that may be in different

folders, on different disks, in libraries, etc. It is enough to "pack" the assembly model into one file with

the possibility of subsequent unpacking and transfer it to another location in the file system or in the

document management system storage (for example, T-FLEX DOCs).

Managing Links

To manage links in a assembly document, a group of commands is used in the Assembly >

Component Links ribbon tab.

The Update Links command allows you to reload the data of all external files included in a assembly

document:

Icon Ribbon

Assembly > Component Links > Update Links

Keyboard Textual Menu

<UL> File > Assembly > Update Links

Update Assembly

The Update Assembly command starts the converter, which recalculates and saves all files of

fragments included in the assembly.
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Icon Ribbon

Assembly > Component Links > Update Assembly

Keyboard Textual Menu

<UA> File > Assembly > Update Assembly

Icon Ribbon

Assembly > Component Links > Move Assembly

Keyboard Textual Menu

<AM> File > Assembly > Move Assembly

Examples of Working with Drawings

For a better understanding of how to create 2D drawings, you can see examples of working with

drawings below. These drawings can be found in the library of examples by searching.

Topics in this section:

· Assembly Drawing Levels. Variable Levels

· Complex Assembly Engineering Drawings

· Variables Connection. Key Variables

· Variable Fragments

· Using Databases

· Drawing up Assemblies

Assembly Drawing Levels. Variable Levels

How to make it so that the complete drawing of a part with all its projections, dimensions and other

design elements could be used in an assembly drawing as a fragment? After all, we do not need most

of the drawing. To do this, use the drawing levels. Set using the Levels command, they can be different

in the assembly drawing and the drawing-part. Due to this, you can "hide" unnecessary elements of

the drawing.

Consider any of the detailing drawings used as fragments in our assembly, for example, a body

drawing:



T-FLEX CAD 17 Help

974

On the assembly drawing, only one view of the three is used, there are no dimensions, roughness, etc.

This is achieved by using different levels at which different elements of the detail drawing are located,

and by setting the range of levels for these elements in the assembly drawing. For example, the

display lines of the view that are to be displayed in an assembly drawing have a level of 2. All other

display lines of the body drawing have a level of 0.

You can set the assembly drawing in the Levels command to the following range for the "visibility" of

graphic lines:

This means that only those graphic lines with a level in the range from 2 to 127 will be drawn in this

drawing.
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If in the parameters of a fragment (in our case, the body) on the assembly drawing you did not forget

to indicate that it will be drawn with the From Drawing status, then this range for drawing graphic

lines will be correct for the fragment as well. As a result, all graphic lines in the fragment with a level

below 2 will not be drawn in the assembly drawing. Thus, you can get rid of the image of two

unnecessary projections on the assembly drawing.

Likewise, setting the hatch level in the view required for the assembly drawing equal to 1, and in the

assembly drawing, setting the visibility range for the hatches from 1 to 127, we will see only one hatch

on the body fragment in the assembly. All other hatches remained at the 0 level and were not drawn

in the assembly drawing. Similarly, by setting the level values ??for those elements that should be drawn

on the assembly, and by setting the level ranges in the Levels command, you can control the "visibility"

of various parts of the fragment drawings.

Take a look at the detailed view of the body. In this drawing, in turn, fragments are used, for example,

a fragment of the title block (format). On the assembly drawing, this fragment should not be drawn.

Fragments, like any other elements of the drawing, also have a level. By default, the level value is 0. In

the assembly drawing, in the Levels command, set the drawing range of the fragments from 1 to 127,

and the title block fragment used on the body fragment will remain invisible.

When setting the level range for the fragments, do not forget to change the levels of all those

fragments that must be present in the assembly drawing from a value of 0 to 1, otherwise they will

also become invisible.

Variables can be used as levels of individual elements of drawings. We recommend that you use this

opportunity if you need to ensure the "appearance" or vice versa "removal" of any parts of the

drawing, depending on the specified conditions.

Since our assembly drawing provides for the ability to change the design to process an additional

hole in the part, this implies a partial change in the detail drawings.

For example, another hole should be added to the body drawing:

 

At the stage of creating a detail drawing, this had to be foreseen, using variables as levels. For more

information about variables as a value for the visibility level, see the chapter Variables.

In this drawing, the variable "ur" is responsible for the level of the lines of the additional hole. The

value of this variable changes depending on the fulfillment of the condition generated in the variable

editor:

ur = lr-5 > 100 ? 2 : -1

Since the variable "lr" is external, and its value is passed to the fragment from the assembly

drawing, when the design of the assembly drawing is changed, the new value "lr" is passed to the

fragment. When the condition is met, the drawing of the body is drawn in a different version,

since the variable "ur" is used as the level of the graphic lines of the hole.
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Changing the outline of the hatching is organized similarly. In fact, there are two hatching contours:

with one and with two holes. Each of them has its own variable responsible for the visibility level.

According to the condition (we remind you that you form all these conditions yourself), only one

hatching is "visible" at each moment of time:

ur = lr-5 > 100 ? 2 : -1
ur1 = lr-5 > 100 ? -1 : -1

Variables can also be used as a visibility level in an assembly drawing. For example, instead of the

variable fragments described earlier, it would be possible to put both fragments on the drawing

and, using a variable in their visibility level, draw the necessary fragment on the assembly

drawing depending on the value of this variable.

Complex Assembly Engineering Drawings

Correct structure of the drawing. Linking fragments. Priorities

Before starting to create an assembly drawing, it is necessary to think over its structure. The main thing

is to determine the requirements for its parametric capabilities: what exactly do you want to modify

later, which parts, in your opinion, will make up the drawing, what kind of hierarchy of fragments is

assumed.

An important role is played by the system of communication of fragments among themselves. Firstly,

it is carried out by the correct selection of the fixing points of the fragments. It is necessary to

determine how the nodes in the current drawing will be created, to which the fragments will be

"attached". Nodes can be created based on the construction lines, or from other fragments.

As a rule, the fragments overlap each other in the assembly drawing. To realize this possibility, it is

necessary to use the mechanism of removing invisible lines. Each fragment will need to be given an

appropriate priority.

Let's consider one of the examples of an assembly drawing:
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This is an assembly drawing of a device (conductor) designed to fix a part in a certain position for

drilling holes in it. In the upper right corner there is a drawing of the workpiece, which is made directly

on the assembly drawing. The assembly is assembled from ten fragments tied both to each other and

to auxiliary construction lines. Some of the fragments are original parts, some are standard, for

example, a folding bolt (item 4). 

The creation of such an assembly drawing begins with the creation of detailed detailed drawings of

the parts of which it consists. But don't rush to create them. You can get beautifully designed,

parametric drawings of parts, from which it will not be easy to assemble an assembly drawing as a

result. 

First, think over the design of the assembly, from which fragment you will begin to assemble the

drawing, which parts will be attached later, where the fixing points of the fragments should be

located. The fact is that the creation of any of the fragments begins with the creation of basic vertical

and horizontal lines. They determine the fixing points of the fragment. 

The parameters of the conductor assembly drawing we are creating will be determined based on the

drawing of the part being processed. Let's create a drawing of this part and create variables

responsible for the parameters being changed:



T-FLEX CAD 17 Help

978

Take the drawing of the Conductor (see the Assembly Drawing Levels. Variable Levels section) as the

basis of the assembly drawing. In the assembly drawing, the part is located in the upper right corner.

Since the dimensions of the conductor depend on the dimensions of the part, the variable parts will

subsequently determine the dimensions of the assembly drawing of the conductor.

In the assembly drawing, the first (basic) fragment, as in the real design, is the drawing of the body.

Let's create a detailed drawing of the body (item 1).

For this part, the location of other structural elements does not affect the position of its fixing point,

since the body is the first fragment.
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In the assembly drawing, the body is always positioned horizontally, so one point is enough to bind it.

Let's construct intersecting vertical and horizontal lines to bind the first fragment and a node at the

intersection of these lines. Let's apply a fragment by tying it to this node:

The next part - the lid (item 3) - should be tied to the body. To do this, having previously created a

node with a name in the detailing drawing of the body, we will create a node from a fragment in the

assembly drawing.

In cases where the point of articulation of the graphic lines belonging to the fragment can be used as

the fixing point, creating nodes from the fragment is optional. When specifying such a point as a

binding node, the system itself will create a node based on the fragment lines. When applying a

fragment of the lid, you can use any of these methods.

The fixing point of the lid fragment is accordingly created at the intersection of two straight lines:

 

When creating the lid drawing, all other constructions were carried out relative to these basic lines. 

Let's put a fragment of the lid on our assembly drawing, tying it to a node created from a fragment of

the body:

For binding subsequent fragments -bushings (items 7 and 8) and the locking screw (item 6) in the

drawing-fragment of the lid, you need to create nodes with names.
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This is necessary for further creation of nodes from the fragment in the assembly drawing:

 

We will bind fragments of bushings and screws to these nodes.

Since the bushings are in our body standard parts (bushing item 7 according to GOST 18432-73,

bushings item 8 according to GOST 18433-73), then it is not required to create a complete detailed

drawing for them. It is enough to have a drawing of the kind that is displayed on the assembly

drawing. Perhaps these details are already contained in the standard parts library created by you (or

someone else). In this case, you can use them instead of creating them again.

If you use library bushings as fragments, then pay attention to the fact that such drawings have two

fixing points. It is for this purpose that the lid are provided in the drawing-fragment, and two nodes

from the fragment are created in the assembly drawing to bind the bushings and the screw.

Similarly, we will apply a fragment of the hinge bolt (item 9) to the drawing, binding it to the nodes

from the fragment of the lid.

So far, to create our assembly, we have been using nodes from fragments. But it is possible, and

sometimes it is necessary to use additional constructions to bind fragments.

Now we need to place a fragment of the fork on the assembly drawing (item 2), and place the second

hinge bolt in it (item 9).But the mutual arrangement of these parts contradicts: on the one hand, the

second hinge bolt should be located on the same axis with the first, and on the other hand, its location

is affected by the hole in the fork. Let's consider one of the solutions.
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We will draw a horizontal line through the nodes to which the fragment of the first hinge bolt is

bound.

From the fragment of the body, we will create another node to bind the fork fragment to it. We will

draw a vertical line through this node and build a node at the intersection of the horizontal and

vertical lines. We will also draw a straight line through the node that we previously built to bind one of

the bushings. 

At the intersection of the straight lines, we will create nodes:

Use the received nodes to snap the fork fragment to them. But to do this, you need to create a fork

drawing as follows:

This drawing has three fixing points. As a result, it "stretches" when applied between three nodes:



T-FLEX CAD 17 Help

982

By creating nodes with names in the capture fragment and "developing" them in the assembly

drawing, you can bind a second hinge bolt to them. As a result, using only additional constructions

and nodes from the fragment, we achieved the result required in this case - alignment of the hinge

bolts.

Further assembly is performed in the same way: somewhere nodes from the fragment are used,

somewhere additional constructions are used to obtain binding nodes.

Pay attention to the sequence of drawing fragments, how they overlap each other. This can be

adjusted using fragment priorities.

For example, this is what an assembly drawing will look like if all fragments have the same priority (by

default it is zero).

The result obtained bears little resemblance to the correct picture. To correct the situation, we will

prioritize some fragments. The fork fragment (item 2) should overlap the body. To do this, in editing

fragments, select the fork and enter its parameters. Set the priority for this fragment to 2. Do the same

for the flip bolt fragment (item 4), but set the priority for it higher than for the fork, since the bolt

should be drawn from above:
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As a result, the assembly drawing will look completely different.

Recall that prioritization will give the necessary result only if contours are created in the fragments to

remove hidden lines (see the Inserting Fragments into a Drawings command).

Please note that for the convenience of working with complex assembly drawings, certain techniques

are used: key variables and variable fragments, as well as variable levels.

Variables Connection. Key Variables

With the help of key variables, you can control the size of the assembly.

For the assembly drawing of the conductor, it is important to provide for the possibility of changing

the dimensions depending on the change in the dimensions of the workpiece. In the assembly

drawing, we have already provided the variables responsible for the dimensions of the part. Now

these values need to be transferred to fragments in order to recalculate the latter. Let's go through the

process of assembling the conductor again, but at the same time let's see how it is possible to

establish a connection between the assembly drawing and fragments.

As you remember, the first fragment applied is a fragment of the body.

When creating the body drawing, external variables were provided that affect the dimensions of the

drawing as a whole. At the moment of drawing the fragment, the values of these variables are

requested:
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What happens if you leave the value field empty, or write specific values in it, you can find out in the

Inserting Fragments into a Drawing command. In the line opposite the fragment variable "d", which is

responsible for the diameter of the hole, we write the following expression:

Remember that in the assembly drawing there is a variable "d0", which is responsible for the diameter

of the processed hole of the part.

The expression "d0+6" in the fragment Value column means that the fragment in the assembly

drawing is drawn with the value "d" equal to the value "d0" from the assembly drawing plus 6.
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Next to the variable "L" of the fragment, we will write another expression:

"L" is an assembly drawing variable responsible for the length of the workpiece. Similarly, the required

dependencies are formed for the remaining variables of the fragment:

Once again, we draw your attention to the fact that the Name field contains the names of the

fragment variables, and the formulas in the Value field contain the names of the assembly drawing

variables. The Value field is your workspace. In this field you can create any arithmetic expressions, use

functions, create logical expressions in the same way as you would do it in the Variable Editor. For

example, to get the value "d" for drawing a fragment, you can create such an expression:

This means: if the part being processed has a length greater than 80, then draw a fragment with a hole

diameter equal to "d0+6", in all other cases - with a diameter of "d0+10". 

You can also create another auxiliary variable, for example, "dp", to implement such a dependency in

the Variable Editor of the assembly drawing. For this variable, we will set the required condition, that

is, the expression "LD>80?do+6:do+10". After that, in the Value field of the fragment, we can use the

"dp" variable:

The result will not change from this. Note that we first created a new variable "dp" in the assembly

drawing, and then specified its name in the value of the variables of the applied fragment. If you try to
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do the opposite, that is, specify a variable that does not exist in the assembly drawing in the Value

field of the fragment variables, the system will issue an error message:

You should form all these dependencies yourself, based on constructive, calculated, or any other

considerations. 

When applying the remaining fragments, the values of their external variables are also requested.

Expressions containing assembly drawing variables or expressions in which they are used are created

for them in the same way. With these values, a fragment of the bar is drawn on the assembly drawing.

When changing the values of the variables of the assembly drawing "d0", "L" and others used in

forming the values of the external variable fragments, the values of these external variables will

change, and the fragments will be redrawn with the changed dimensions. 

In order to make it convenient to work with the finished assembly drawing, it is recommended to

select several key variables that determine all other parameters of the drawing. You need to create

comments for them so that it is convenient to work with variables in the External Variables command.

You will use this command to set the values of variables and get a new version of the drawing.

For our drawing of the conductor, the variables responsible for the dimensions of the workpiece are

decisive. They will be the key ones for the entire assembly:
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If the values of variables are a pre-known set of possible numbers or lines of text, it is convenient to

set lists of possible values using the appropriate option in the Variables command. After that, when

setting values in the External Variables command, you can simply select the necessary item from the

list.

Let's assume that our conductor is designed for processing parts whose length varies according to a

certain series: 70, 80, 90, 100 and 110 mm. In this case, it is convenient to form a list to set the length

value:

Variable Fragments

If different fragments can be used as some part of the drawing, depending on the conditions, then you

can use the mechanism of variable fragments. To do this, use a text variable as the fragment name.

Let's go back to the assembly drawing of the conductor. Let's assume that if the length of the

processed part exceeds a certain value, the execution of the part changes:
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To process a part with two holes, a slightly different device will be required:

It is not necessary to create another assembly drawing for this. It is possible to provide for the

possibility of changing the design in the existing one. This is what variable fragments serve for. In our

case, three more fragments are added for the new version - bushings for drilling the second hole and

a locking screw. When applying these fragments to the drawing, instead of a specific fragment name,

you need to specify a text variable in which this name will be stored:
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When requesting the value of the variable "$Name_1", specify the name of the fragment to be

applied.

After that, further drawing of the fragment will go the usual way: first you need to set the values of the

external variables of the sleeve fragment, then its fixing points.

The line appears in the assembly drawing variable editor:

$Name_1 = "Bushing" = Bushing

In this line, you can form any condition, which is required in our case:

$Name_1 = L>100?"Bushing_2":"" = Bushing_2

If the variable "L", which is responsible for the length of the workpiece, exceeds the value of 100 mm,

draw a fragment with the name "Bushing" in the drawing, otherwise the fragment name is missing, so

nothing will be drawn in the drawing.

$Name_1 = L>100?"Bushing_2":"" = Bushing_2
$Name_2 = L>100?"Bushing":"" = Bushing
$Name_3 = L>100?"Screw":"" = Screw

Similarly, we will create variables to store the names of fragments of another bushing and screw. In

the variable editor, we will create conditions for drawing them.

In this case, variable fragments were used to add fragments to the assembly drawing. It is also

possible to use them to replace part of the assembly drawing with another. Suppose that in our
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drawing, under certain conditions, the guide bushing should be replaced with a bushing of a different

design:

            

In this case, you should also specify a text variable, for example, "$Name_2", instead of a specific

name at the time of applying the sleeve fragment. As the value of this variable, specify the name of

one of the fragments, and in the variable editor form a condition, when executed or not executed, this

or that fragment will be displayed:

$Name_2 = L>100 && H<30 ? "Bushing 2":"Bushing 4" = Bushing_2

For example, if the variable "L", which is responsible for the length of the workpiece, exceeds the value

of 100 mm and if the height of this part (variable "H") is less than 30 mm, draw the fragment "Bushing

2" on the assembly drawing, otherwise the fragment "Bushing 4".

To avoid misunderstandings, the variable fragments should be similar, that is, have the same

number of fixing points. If you use a variable relationship when drawing such fragments, then the

variable names in both fragments should match. The semantic load of variables should also be

the same (if in one of the variable fragments the variable "d" is responsible for the outer

diameter, then in the second the same variable should be responsible for a similar parameter). If

you need to use nodes from a variable fragment, then in the second fragment you must create

the same number of nodes with the same names.

From all of the above, we can conclude that despite the convenience of using variable fragments, you

should work very carefully.

Using Databases

When the possible values of the parameters of the drawings-fragments or assembly drawing can be

organized in the form of a table in which, depending on one or more key fields of the table, other

parameters can be determined, it is convenient to use databases. The database can be internal or

external. Internal databases provide a high speed of selection of values. External - the ability to access

from different drawings to the same database plus compatibility with the generally recognized

database storage standard - dbf. For more information about how to access databases, see the

manual for the Databases, Variables, Creating Libraries of Parametric Elements commands.

In our example, there are several standard parts. These are bushings, fixing screw, folding bolt. Using

the example of the latter, we will consider some features of working with databases in assembly

drawings.

In the assembly drawing, there are variables "D" and "L" calculated based on the overall dimensions of

the assembly. These variables are responsible, respectively, for the diameter and length of our bolt.

The values of these variables should be transferred to the bolt fragment during its application to the

drawing:
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The fragment itself contains a database from which, based on the values "D" and "L", the remaining

parameters of the bolt will be selected, with which it will be drawn in the drawing.

A slightly more complicated option is when changing, for example, the diameter of the bolt will entail

the need to change the diameter of the hole for the head of this bolt in another fragment.

After all, the value of this parameter will be obtained from the database in the drawing of the bolt

itself, and not in the assembly drawing, and it is impossible to transfer it to another fragment. 

In this case, it is better to use an external database. Then in the Variable Editor of the assembly

drawing itself, using the functions of selecting values from an external database, we can get the value

of the diameter of the bolt head depending on the diameter of the bolt thread. The database is used

the same to obtain the values of the parameters of the bolt itself, and to obtain the diameter of the

head of this bolt in the assembly drawing. The last value can be passed to a fragment in which there is

such a hole, having previously provided an external variable for this in the fragment.

The same result can be achieved by accessing the same external database in the second fragment, in

which you want to get the value of the diameter of the bolt head. Then in this fragment it is necessary

to provide an external variable to which the bolt diameter value will be transferred from the assembly

drawing. In accordance with the passed parameter, the required value will be selected from the

database.

Drawing up Assemblies

It is better to think about how you will apply dimensions, roughness, tolerances of shape and location

of surfaces and other elements of the design of drawings before creating a drawing. After all, in order

for these elements to be parametrically connected to the drawing, construction lines and nodes to

which they are "attached" are necessary. 

For example, if you want all the callout lines with part numbers to be located on one straight line, it is

best to create a construction line - a straight line, and when placing labels, "bind" them to it.
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In order for the callout line to always point to the desired part, use the binding to the node. 

The same applies to texts and sizes.

It is important to think about how nodes and construction lines for binding design elements will be

created in the drawing. Firstly, they can be created directly on the assembly drawing, and then, using S

bindings and external variables, include fragments accordingly. Alternatively, you can use nodes from

fragments or points of articulation of graphic lines belonging to a fragment, both for direct

"binding" of design elements, and for creating other construction elements that will determine the

position of design elements.
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3D Elements Management

To work with 3D elements, additional functionality is used, which you can read about below.

Topics in this section:

· Selection of 3D Elements

· Common Parameters of 3D Elements

· Transformations of 3D Elements

· Name Customization for 3D Elements

· Model Regeneration

Selection of 3D Elements

General principles of 3D Elements selection

Any 3D element can be selected in a 3D view window (considering filters), in the  3D model tree or

in the  Model elements window. To select an element in the 3D scene hover the mouse cursor over

it. The system will suggest for selection an element under the cursor and pre-highlight such element in

red color. Keeping the cursor in this position a bit invokes a tip with a name of highlighted element

and an icon representing its type. A number of all elements, which are located behind the current

cursor position and fulfill active filters, is shown in brackets in an end of a tip preceded by the "+" sign

(an element nearest to the camera is selected by default). Holding the cursor in the same position a

little longer invokes a list of such elements. You can switch between elements in the list by scrolling

. When desired element is highlighted click  to confirm selection. 
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You can also select elements by clicking . It invokes a contextual menu, which contains various

commands applicable to the selected element.

While the preliminary highlighting of elements that are about to be selected is red, upon confirming

the selection it changes to another color depending on a type of selected element and context of

selection.
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By default, you can only select the visible 3D elements in the 3D window. Keep in mind that some

elements are visible in the 3D window only if the Show in 3D view checkbox is enabled in their

parameters (e.g.: workplanes, 3D sections). The level parameter also affects  the visibility of elements.

The  Levels command defines intervals of visibility for each type of elements. Elements are not

displayed in the 3D scene if their level values are outside of visibility interval. Moreover, elements can

be  Hidden or  Suppressed.

You can allow the selection of invisible elements if necessary via changing the value of the Element

Selection parameter (Document Parameters > 3D > View > Selection).

Elements may be also selected by name or ID using the  Find command.

Multiple elements can be selected either by subsequently selecting the one by one while holding

<Shift>, or via the selector frame. Click  a selected element while holding <Ctrl>, if you need to

exclude an element from selection.

Using filters of element's type

Elements can be selected in the 3D scene only if they fulfill the active set of element's type filters.

Filters are displayed either in the filter toolbar or in the system toolbar. Active filters are highlighted in

blue color. Click a filter's icon to activate or deactivate it. Following filters are available in the

command standby mode:

·  <Ctrl+Alt+W> Select Workplanes;

·  <Ctrl+Alt+Z> Select 3D Nodes;

·  <Ctrl+Alt+L> Select LCS;

·  <Ctrl+Alt+R> Select 3D Profiles/3D Paths;

·  <Ctrl+Alt+X> Select Operations;

·  <Ctrl+Alt+Q> Select Faces;

·  <Ctrl+Alt+E> Select Edges;

·  <Ctrl+Alt+K> Select Loops;

·  <Ctrl+Alt+V> Select Vertices;

·  <Ctrl+Alt+M> Select Other Elements;

·  <Ctrl+Alt+J> Select operations by created faces;

·  <Ctrl+Alt+U> Select embedded subassemblies by bodies.

If all filters are active, geometric entities (faces, edges, loops) are usually suggested for selection upon

hovering the cursor over a body.

When 3D modeling commands are launched, the set of available filters changes depending on active

input boxes in command's parameters window and active automenu options. In this case, some of the

filters mentioned above might be unavailable and some of the following additional options might be

available, such as:

·  Worksurface;

·  Select an array;

·  Select 3D Fragments;

·  <Ctrl+Alt+R> Select 3D Profiles (unlike the similar option mentioned above, this option

doesn't include 3D Paths selection);

·  <Ctrl+Alt+H> Select 3D Paths.
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Beside 3D elements selection filters mentioned above, 2D elements selection filters may also be

available if an active command supports creating 3D elements based on 2D elements (e.g.: 3D Profile

by 2D Elements).

Selecting Operations by Geometric Entities

By default, contextual menus of geometric entities contain drop-down sub-menus for the last

operation in the body's tree. The name of the string in the contextual menu corresponds to the name

of the last operation for which the sub-menu is formed. For example, the figure below shows that

when the contextual menu for the face formed by the operation Rotation_1 is called, the contextual

menu contains the name of the last operation in the tree of the body - Blend_1.

A drop-down sub-menu called from the contextual menu of a geometric entity fully coincides with a

contextual menu called directly for the same operation.
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The set of available filters on the Filter Toolbar or System Toolbar contains the  <Ctrl + Alt + J>

Select operations by created faces option, which allows you to select earlier operations in the model

history by geometric entities. If you enable this option, names of those operations that directly created

the selected geometric entity will appear in the entities' contextual menus. 

Let's make this option active and call the contextual menu for the cylindrical face once again. It can be

seen from the figure below that, when the option  is active, the contextual menu does not indicate

the name of the last operation in the body's tree (Blend_1), but instead contains the name of the

operation that formed this face, i.e. - Rotation_1.  

To select the operation itself by clicking  the geometric entity formed by it, you can use the 

 <Ctrl + Alt + J> Select operations by created faces option in conjunction with the  <Ctrl + Alt +

X> Select Operations filter. 
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If the system finds several operations for a given entity, the list of possible selections appear near the

cursor..

Selecting elements within a command

Command for creation of operations and 3D constructions usually require to select various elements

existing in the 3D scene. E.g.: the Extrusion command requires to select an extrusion contour and

allows to optionally select a vector or two points defining a direction of extrusion, objects defining

extrusion boundaries, a point or a plane for calculating a length of extrusion and a body for an

automatic Boolean operation. The selection can be performed after activation of corresponding

automenu options or input boxes of the command's parameters window. It activates a suitable set of

element's type filters and geometric type filters. Other than that, the selection is performed in the

same way as in the command standby mode.

Within a command 3D elements created by 2D elements can be selected by selecting a parent 2D

element. E.g.: if you need to use a 3D Node constructed by two projections as an origin within the LCS

creation command, it is enough to click one of the parent 2D nodes, so the child 3D node will be

selected in result.

When selecting elements in some commands, you can use the following automenu option:

<I> Select Other Element

If the first 3D element was selected by the parent 2D element, then using this option will cause

subsequent selection of all 3D elements of an editable type based on 2D elements. If an element was
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selected in the 3D window, then the selection will loop through all similar 3D elements laying on the

selection ray. The selection ray is directed perpendicular to the screen plane and goes through the

point of the cursor position at the selection instant. Only those elements will be selectable which are

located close enough to the point of the cursor. 

Unlike the command standby mode, you can not call an element's contextual menu by clicking

 on an element in the 3D window. Instead of invoking a contextual menu, it cancels the last

action. However, you can still call the contextual menu in the model tree and model elements

window.

Filter of Selection by Geometric Type

Creating most operations requires to select existing elements of a particular type (points, planes,

surfaces etc.), direction vectors, tangency conditions etc. 

Activating an input box in command's parameters window or an automenu option activates filters of

geometric type in addition to element's type filters. Such filters are also shown either in the filter

toolbar or in the system toolbar and allow to define the type of selected element more precisely. 

Each geometric type has its own drop-down list containing possible methods of defining the type.

Geometric types filters automatically fit the context of selection. E.g.: when selecting an axis of

rotation within the Rotation command,the  Axis geometric type is automatically activated with its

full list of methods.

Click the triangle  near the filter's icon to expand its drop-down list of methods.

Next, when defining a rotation range within the same command, the  Point geometric type is

activated with its full list of methods.
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In some cases several geometric types can be available at the same time. E.g.: when creating a 3D

Node in Coordinates, following geometric types are available each with its own list of methods: 

 Point,  Wire,  Geometric surface,  Surface,  Solid.

All available for the current context geometric type filters are active by default with all their methods.

If you need to narrow the possible selection options, you can either deactivate the whole type with all

its methods by clicking  a type's icon, or deactivate a particular method by clicking directly on a

methods icon. E.g.: if you need to select an edge's midpoint, enable the  edges elements' type filter

and the  Edge Midpoint method within the  Point geometric type.
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Common Parameters of 3D Elements

As well as 3D elements, each 3D element has it's own set of parameters. Some of such parameters are

common for all object in the system, some are applicable to 3D elements only, some others are

exclusive to specific type objects. Common parameters of 3D elements will be described in this

chapter. Chapters describing particular types of elements will contain the description of type-specific

parameters only.

3D elements' parameters dialog can be invoked in following ways:

· by double-clicking  an element in the 3D scene or in the model tree;

· from the contextual menu invoked by clicking  an element in the 3D scene or in the model

tree;

· from the automenu of 3D elements creation commands.

Parameters displayed upon invoking a dialog from a command's automenu are applied to result of

this operation.

There are following types of 3D elements' parameters dialog:

· parameters of operations and bodies 3D elements' parameters dialog;

· parameters of geometric entities (vertices, edges, loops, faces);

· parameters of 3D constructions (3D profiles, 3D nodes, workplanes etc.).

Array's parameters dialog layout depends on the type of initial element.

Set as default

Parameters dialog for operations, bodies and 3D constructions contains the Set as default checkbox. It

is located in the bottom part of the dialog to the left side of OK and Cancel buttons.

Enabling this checkbox applies parameters of the selected element as default parameters of all new

objects of the same type.

Bodies and operations parameters dialog  

It may contain following tabs:

· Common

· Operation (or similar)

· Transformations

· Mate Transformations

· Characteristics

The Common tab of bodies and operations parameters dialog

Each 3D operation's parameters dialog contains the similar tab - Common. It contains non-specific

parameters of an operation and parameters of a body formed or modified by this operation. Body

parameters are common for all operations belonging to this body's tree. If you invoke a parameters

dialog for a body itself, a parameters of a last operation in this body's tree are displayed. 

If you invoke an array's parameters dialog from the Operations > Arrays folder in the model tree,

displayed body's parameters (except name) are applied to all bodies created by this array. In this case

Body Name input box contains a random value, which isn't applied to anything.
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Operation group in the Common tab of bodies and operations parameters dialog

Operation Name

3D operations as well as other 3D elements have a unique name. User can type name manually. In this

case the system checks if typed name is unique. If typed name is already assigned to another element

in this document, the changes are not applied. If user didn't input a custom name, the system

generates name automatically. More information about automatically generated names can be found

in the Names Customization for 3D Elements chapter.

Suppress

This option can be used for excluding a particular operation from the 3D model generation.

Suppressed operation isn't displayed in the 3D scene. It might be useful when working on complex

assemblies. Suppress the element that you're not interested in at the moment so that they don't block

the view. Enabling the Suppress checkbox excludes an operation from the model generation and sets

the "1" value in the corresponding input box. Disabling the checkbox includes an operation into the

model generation and sets the "0" value in the corresponding input box. Value may also be typed

manually or defined by a real variable for controlling the suppression via Parametrization. An

operation is suppressed if a variable's value isn't zero. Any whole values apart from zero are replaced

by "1". Fractional values are not allowed.

Keep in mind, that suppression of a parent operation leads to errors upon regenerating its child

operations.

Body group in the Common tab of bodies and operations parameters dialog

Body Name. It's a name of body formed or modified by the selected operation. Body name works in

the same way as described for operation name above.

Level. This parameter is described in the Levels chapter.

Layer. This parameter is described in the  Layers chapter.

Quality 
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You can adjust the quality of displaying the particular body in the 3D window. The drop-down

contains options similar to described in the Image Quality chapter. The additional From fragment

option is available for 3D fragments. It uses the quality parameters from the fragment's document

parameters.

If you want to use one of the system presets as a template for customizing user-defined parameters,

select a preset in the drop-down and click the  button located to the right side of the drop-down.

The Mesh Quality dialog will appear with parameters of a selected preset. Enable the User Settings

checkbox to edit them.

Transparency. If you want to make a body transparent, enable this checkbox and use the slider or the

input box for adjusting the transparency level. 

Wireframe. Enabling this checkbox applies the Wireframe view style to this body independently of the

style selected for the whole window.

Hide. This option allows to disable displaying of a body without excluding it from the model

generation.

Material group in the Common tab of bodies and operations parameters dialog

Bodies created by most of 3D modeling operations have parameters of this group assigned

individually.
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Color and Material are assigned by default upon creating a body. They couldn't be deleted, but could

be edited. That's why the corresponding checkboxes are enabled and inactive.

Coating is not assigned by default.

Bodies created from other bodies by such operations as Copy, 3D Symmetry, Array and Divide inherit

such parameters from the source body. 3D Fragments inherit such parameters from the fragment's

document. In these cases the input box of an inherited parameter is inactive and contains either

[Source operation] or [From fragment] value, while the corresponding checkbox is disabled. Enable

the checkbox to define a parameter manually.

Color - this is a color of a body in all view styles except Render. Color here can be selected in the

same way as described in the Color chapter. 

Material 

This parameter defines the main material of a body. It is used for mass-inertia parameters calculation

and engineering analysis. It is also used visualization of a body in the 3D scene in the Render style, if

no coating is assigned.

The input box contains a name of a currently assigned material. If you need to assign another material

click the  Select Material button in the right side of the input box. A drop-down window appears. It

is a simplified version of the Materials service window. Two tabs are available there: Document

(contains the list of materials used in the current document) and Libraries (contains available material

libraries). The search box is available in the upper part of the window. Type a search query and click

the  Find Material button. The list of materials will be filtered according to the query. 

Name is the only column in the materials list by default. Columns containing the material's physical

characteristics could be enabled using the  Selection of columns button located to the right side

of the search box.
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Select the desired material in the list using . The drop-down window will disappear and the

selected material will be assigned to a body.

Coating

This is an additional material used for visualization only. Even if the coating is applied, mass-inertia

parameters calculation and engineering analysis still use the main material. Enable the corresponding

checkbox to apply coating. Coating material selection is performed in the same way as described for

the main material.

If Material and Coating are not inherited, they are previewed in the right area of the dialog. Preview

uses ball or cube sample with cutout. Click  on the preview to switch between ball and cube. 

Clicking the  button located to the right side of the corresponding input box invokes the Material

Properties dialog.

Material and Coating may also be defined using a string variable. Detailed information about

working with materials can be found in the Materials chapter.

Operation tab of bodies and operations parameters dialog

The content of the Operation tab depends on the type of the operation. Complex operations have

large number of parameters divided into several tabs instead of a single Operation tab. Some

operations have a tab similar to the Operations tab but under a different name.
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These tabs of the parameters dialog have the same functionality as the Parameters window has when

the operation being created. Detailed descriptions are available in chapters describing particular

operations.
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Transformations tab of bodies and operations parameters dialog

This tab contains information about element's transformations. 

There are several ways of assigning transformations: 

· upon creating primitives;

· upon inserting a fragment into an assembly;

· using the Transformations command;

· directly in the Transformations tab of the element's parameters dialog. 
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All transformations created in any possible way are displayed in the Transformations tab of the

parameters dialog.

The main disadvantage of assigning transformations directly in the parameters dialog is that it doesn't

allow to use reference elements (axis, vector, point, LCS). A symmetry also can not be applied. As for

the rest, the functionality of the Transformations tab of the parameters dialog is similar to the

functionality of the Parameters window, described for the Transformations command, except the

absence of Mate Transformations which are displayed in the separate tab.

Modern layout of the Transformations tab

The legacy layout of the Transformations tab may be displayed when editing files created in old

versions of the T-FLEX CAD. If you want to switch to a new layout for a particular element, apply the

Transformations command to such element without adding any new transformations
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Legacy layout of the Transformations tab

Mate Transformations tab of bodies and operations parameters dialog

This tab contains information about mate transformations applied to element.

The tab works in the same way as the eponymous tab of the Parameters window, described for the

Transformations command.

Characteristics tab of bodies and operations parameters dialog

This tab contains mass-inertia characteristics of bodies. They can be used in following cases:

· in the Mass Properties command;

· in the Measure command;

· when receiving the mass using the corresponding functions in the variables editor;
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· when forming a BoM or other reports;

· in Express Analysis studies;

· in T-FLEX Analysis and T-FLEX Dynamics modules.  

By default, values are calculated automatically depending on the body's geometry and its material's

physical properties. 

You can type in custom values if necessary. The mass should be typed into the Value: input box, center

of mass coordinates should be typed into X:, Y; Z: input boxes. Values can also be defined using

variables and expressions. 

The corresponding Manually: checkbox should be enabled for applying typed in values. Enabling the

checkbox applies the custom value of the corresponding characteristic and sets the "1" value in the

adjacent input box. Disabling the checkbox discards the custom characteristic value and sets the "0"

value in the adjacent input box. Values in this input box might also be typed in using the keyboard or

defined by a real variable for controlling the custom characteristics application via Parametrization.

Any non-zero value enables the checkbox.

This mechanics can be used when the exact model of a product is not created yet, but its mass-inertia

characteristics are already defined by technical requirements or manufacturer's data.

Geometric entities parameters dialog

Geometric entities are vertices, edges, loops and faces belonging to bodies, 3D profiles and 3D paths.

A Name of an element can be customized in vertex, edge and loop parameters dialogs.
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Face parameters dialog also allows to customize Color and Transparency.

The result of changing these parameters is only visible in the  Shading view style

3D constructions parameters dialog

3D constructions parameters dialog may contain Common (or General), Transformations and Mate

Transformations tabs, as well as some special tabs depending on a construction type.

Transformations and Mate Transformations tabs are similar to described above for bodies and

operations..

The Common tab always contain following parameters: 

· Level. This parameter is described in the Levels chapter.

· Layer. This parameter is described in the  Layers chapter.

· Color. This parameter is described in the Color chapter

· Name. Works in the same way as the Operation Name.

For workplanes the Common tab is replaced by the Workplane tab, which still contains the

aforementioned parameters.

Additionally, the Common tab may contain some other parameters depending on the construction

type. Information about such parameters as well as content of the rest of the tabs in the 3D

constructions parameters dialog can be found in chapters describing a particular 3D construction

type. 
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See also:

· Defining Element Parameters

· Copying Parameters of 2D Elements

· Default Parameters
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Transformations of 3D Elements

The command can be called in one of the following ways:

Icon Ribbon

3D Model > Additional > Transformations

Assembly > Additional > Transformations

Sheet Metal > Additional > Transformations

Surfaces > Additional > Transformations

Weld > Additional > Transformations

Routing > Additional > Transformations

Primitives > Additional > Transformations

Support Geometry > Additional > Transformations

Keyboard Textual Menu

<3EG> Tools > Transformations

The command can also be called from the contextual menu for a selected operation in the command

standby mode:
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The command serves for translating, rotating, scaling and mirroring operations and 3D constructions.

Transformation parameters are recorded in the parameters of 3D elements. Moreover, parameters of

operation (or the element of 3D construction) can contain simultaneously several transformations that

are executed successively one after another. It is also possible to form a group of objects and create

common transformations for them. 

Apart from using this command transformations can also be applied in other ways:

· Upon Primitives creation;

· Upon inserting 3D Fragment into an assembly;

· Directly in the Transformations tab of the object Parameters dialog.

Beside main transformations there are special Mate Transformations.

Transformations are most commonly used for positioning fragments in assemblies. However you can

also use transformations on objects inside a single part.

Upon calling the Transformations command the Parameters window contain two tabs - Objects and

Transformations. Upon selecting an object of transformation three more tabs become available: Main

Transformations, Scaling (if applicable to selected object) and Mate Transformations (if there are

mate transformations applied to selected object).

Upon calling the command and selecting an object, all transformations previously applied (in any

way) to this object are displayed in the Parameters window.

Selecting objects for transformation

Upon calling the command it's necessary to select element to be transformed. Selection can be done

in 3D scene or in 3D Model tree using one of following automenu options:
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<1> Select objects for transformation

<2> Select objects for individual transformation

Selected objects are added to the list in the Objects tab of the Parameters window.

A button allowing to  Delete selected row is located to the right side of the list.

Both selection modes allow to select several objects. However the command works in different ways.

In the individual transformation mode  it is possible to switch between objects in the list by

clicking  on the desired row of the list. Selected row is highlighted in green color. All information

in other tabs of the Parameters window is applicable to the selected row of the list only. Automenu

options are also applicable to the selected row of the list only. Objects added to the list are

highlighted in green color in the 3D scene, if their row is selected in the list, or in blue color, if their

row is not selected.  

In the group transformation mode  the Parameters window contains only two tabs: Objects and

Main transformations. Information in the Main transformations tab as well as automenu options are

applicable to all objects forming a group. Detailed information about this mode's specifics can be

found in the Group Transformations of 3D Elements chapter.

Selecting an object in the list or in the 3D scene by clicking  after selecting objects for group

transformation will switch the command into individual transformation mode. It can be easily

detected by disappearance of orange objects highlighting and different set of tabs in the

Parameters window.

Source and target local coordinate systems (LCSes) of transformation

When transforming 3D Fragments source and target LCSes are available. Source LCS is attached to

transformed fragment. Target LCS is defined independently of transformed fragment. 

At first, transformation command aligns source LCS to target LCS. Then user can define

Transformations in relation to new position and orientation of source LCS.

Selected Source LCS and Target LCS are displayed in the corresponding fields in the upper area of the

Main Transformations tab of the Parameters window.
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Transformations are divided into groups, which are displayed in the list in the lower area of the Main

Transformations tab of the Parameters window.

Content of the currently selected group is displayed in the Transformations tab of the Parameters

window.

When transforming operations and constructions, source LCS is the only available. In this case aligning

source LCS to an arbitrary selected existing LCS can be performed by creating a special kind of

transformation  -  Coordinate System and subsequently deleting automatically created elementary

transformations, instead of selecting a target LCS.

LCSes of operations LCSes of 3D fragments

Source LCS

Source LCS is displayed in the drop-down in the Main Transformations tab of the Parameters

window.

Content of the drop-down depends on the object of transformation

When transforming operations and constructions following options are available: 

· Global LCS of the document

· LCS in the Bound box center

Axes orientation in this case coincides with the Global LCS

· Fixing by LCS

Can be created using Select or Create Source LCS automenu option of the Transformations

command. 

When transforming 3D fragments following options are available: 

· Attachment by default 

(Global LCS), 

· One of the LCSes existing in the transformed fragment

Drop-down will contain all of the LCSes available in the transformed fragment

· Fixing by Fragment

Can be created using Select or Create Source LCS automenu option of the Transformations

command. .

Source LCS of operations Source LCS of 3D fragments

LCS for Fixing by LCS or Fixing by Fragment options can be defined using the following automenu

option:
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<S> Select or Create Source LCS

Selecting this option switches the system into LCS defining mode. 

Target LCS

Target LCS is displayed in the Main Transformations tab of the Parameters window when

transforming 3D fragments.

If a target LCS was selected during insertion of a fragment into an assembly, it will be selected while

using the Transformations command as well.

If a target LCS was not selected during insertion of a fragment into an assembly, the Target LCS field

will contain <None> value.

Selecting target LCS can be performed using the following automenu option:

<F> Select Target LCS

Clearing the target LCS selection can be performed using the following automenu option:

<T> Re-create Target LCS

Groups of Transformations

The list of Groups of Transformations is displayed below the source and target LCS fields in the Main

Transformations tab of the Parameters window. A group can be selected in the list by clicking .

The Transformations tab contains list of transformations belonging to the selected group only. If one

of transformations belonging to the group contains link to an existing geometrical element, a name of

a linked element is displayed in the Parents column of the groups list. Multiple parents' names are

separated by the comma.

Following buttons are available to the right side of the groups list:

·  Add transformation group (adds an empty group to the end of the list);

·  Delete transformation group (deletes currently selected group);

·  Delete all groups of transformations;

·  Up (moves currently selected group one row up in the list);

·  Down (moves currently selected group one row down in the list);
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Transformations are applied in the order of their positions in the list (from top to bottom). Using

  buttons changes the order of transformations application. Notice that changing the said

order changes the result.

·  Replace with a single non-associative transformation

Merges all groups of transformations into a single one and replaces all of their content by a

single special non-editable type of transformation-  Transformation.

The Suppress checkbox and its corresponding input field are located below the list of transformation

groups. This checkbox is applied individually to a transformation group which is currently selected in

the list. Enabling the checkbox excludes a selected group from the calculation of a 3D element's

position and sets the "1" value in the corresponding input field. Disabling the checkbox includes a

selected group into the calculation of a 3D element's position and sets the "0" value in the input field.

You can input said values manually using the keyboard or define them by a custom variable. Latter

allows you to control the suppression via Parametrization.  A transformation will not be suppressed if

a value of a variable is not equal to zero. Any positive values are replaced by "1", any negative values

are replaced by zero.

Created groups of transformations are also shown in the 3D model tree in the form of Transformation

object. Transformation command can be called by selecting Edit option in the context menu for the

said object.

Transformations

Transformations tab of the Parameters window contains the list of transformations belonging to the

selected group. A transformation can be selected in the list by clicking . Following buttons are

available to the right side of the list:

· Add

·  Delete

·  Up

·  Down

Transformations are applied in the order of their positions in the list (from top to bottom). Using

  buttons changes the order of transformations application. Notice that changing the said

order changes the result.
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Transformations might be added or edited using:

· manipulators;

· the  Add button;

· some options in the automenu;

· contextual menu invoked by clicking  in any area of the Transformations tab.

Contextual menu invoked by clicking  on any transformation in the list, allows to create a

translation along or a rotation around one of the Source LCS axes, or to delete a selected

transformation. Contextual menu invoked by clicking in any other area of the Transformations tab,

or by clicking  on the  button, contains the same set of options apart from missing the Delete

option. A new transformation with zero value appears in the list upon adding a transformation by

using a contextual menu.

A numerical value input field is displayed below the transformations list, when selecting a

transformation which requires a value.

A button allowing to  Re-select geometric fixing and a name of a linked geometrical element

appear below the transformations list when selecting a transformation which uses links to a reference

geometry. Clicking this button enables filters for selecting objects of a suitable type on the Filter

Toolbar. Then you can select a desired object in the 3D scene. Transformation recalculates in

accordance to the newly selected reference geometry.

Children of the transformed objects can’t be selected. This prevents recursion in the model.

During manipulators usage for defining a transformation, which uses a numerical value, the Filter

Toolbar (or the system toolbar if enabled) contains an input field for setting said value. A parameter's

name and a checkbox are displayed to the left side of an input field. A checkbox is automatically

enabled when inputing a value via the keyboard. Enabling a checkbox prevents changing of value by

moving a mouse. Disable the checkbox again if you want to define value by moving a mouse. You can

use a variable or a formula as a value.
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The list may contain following types of transformation:

·  Coordinate System

·  Transformation

· Translation along axis (a value is displayed instead of a name)

· Move to Point by Axis

· Move to Curve by Axis

· Move to Surface by Axis

· Direct Axis to Point

· Set Axis

· Set Axis Direction

·  Rotation around axis (a value is displayed instead of a name)

· Turn Axis around Axis to Point

· Translation along axis

· Rotation around axis

· Mirror plane

·  Set Plane

· Cyclic Axis Change

Scaling is not displayed in the transformations list since it's shown in a separate tab. 

Mate Transformations

When using the Transformations command, the Mate Transformations tab may appear in the lower

part of the Parameters window. It contains the list of mate transformations groups if such

transformations are applied to the selected object. This tab is not displayed if there are no mate

transformations. Mate transformations are only shown as a group without individual transformations

breakdown.

Mate transformations are always applied before main transformations. 
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The list of mate transformation groups works in the same way as the list of main transformation

groups. The main difference is that less buttons are available to the right side of the list:

·  Delete transformation group (deletes currently selected group);

·  Delete all groups of transformations;

·  Up (moves currently selected group one row up in the list);

·  Down (moves currently selected group one row down in the list);

This type of transformations is created automatically when deleting mates, if Keep position of mated

elements checkbox is enabled in the Delete Elements dialog.

Transformation usage example

To create transformations it is possible to use geometric links. The Transformations command works

with the following nodes: vertices, edges, faces, 3D paths, profiles, 3D nodes and LCS.

For example, lets change the location of the chair (1) by aligning it with desk (2) in the existing 3D

layout.

First, invoke the Transformations command. Next, select the chair (1) for transformation. After that on

the manipulator select the X-axis along which the translation will be carried out. Next, with the help of

the cursor on select the midpoint of the desk's (2) edge to which the X-coordinate of the chair being

moved will be linked. When pressing  the chair (1) will move to a new location.
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In the Transformations tab a new recording will appear.

Let's finish input .

From now on changing the desk's position will make the chair change its position in accordance with a

new location of the desk's edge midpoint.

Adaptive 3D fragments transformation specifics

If you need to transform an adaptive 3D fragment you should enable the option Don’t use

transformation for geometric parameters in the contextual menu invoked by clicking  on an

adaptive fragment in the 3D model tree.

It is recommended to use the option if the geometry of the adaptive fragment does not depend on

the adaptive parameters, but changes on their bases. 

Topics in this section:

· Defining Source LCS for Transformations of 3D Elements

· Types of Transformations of 3D Elements

· LCS Manipulators for Transformations of 3D Elements
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· Scaling when applying Transformations to 3D Elements

· Group Transformations of 3D Elements

Defining Source LCS for Transformations of 3D Elements

You can enter the defining source LCS mode from the Transformations command using the following

automenu option:

<S> Select or Create Source LCS 

3D scene in this mode contains transformed element and coordinate system existing in the model

only. 

You can either select an existing LCS by moving the mouse cursor over it and clicking , or define a

new LCS using following automenu options:

<1> Select 3D Node or vertex as LCS origin

<2> Select point that defines direction of X axis

<3> Select point that defines direction of Y axis

Activating these options enables filters for selecting elements, which can define a point, on the Filters

Toolbar.

Besides, activation of   and  options also enables filters for selecting elements, which can

define a direction.

When selecting elements, pay attention to active filters..

An LCS defined using options mentioned above or selected from the existing ones can be edited

using manipulators and following options:

<A> Rotate LCS around X axis by 90°

<O> Rotate LCS around Y axis by 90°

<Z> Rotate LCS around Z axis by 90°

<8> Change LCS axes orientation

The Parameters window in the defining source LCS mode contains the Transformations tab only,

which displays all transformations applied to LCS.  



3D Elements Management

1025

The Transformations tab, as well as manipulators work in this mode in the same way as in the default

Transformations command mode. The only difference is that here transformations are applied to a

source LCS of a 3D element and not to an element itself.

The following automenu option allows to reset the source LCS defining mode to its initial state:

<C> Reset Target LCS

The following automenu option allows to exit the source LCS defining mode and return to the

Transformations command without applying LCS changes:

<X> Exit command

The following automenu option allows to exit the source LCS defining mode and return to the

Transformations command with applying LCS changes:

<Ctrl+Enter> Finish input

Types of Transformations of 3D Elements

Following types of transformations are available:

· selecting existing LCS;

· non-associative transformation;

· translation along LCS axis:
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o by user-defined arbitrary value;

o to point;

o to curve;

o to surface;

· rotation around LCS axis:

o by user-defined arbitrary value;

o by 90 degrees;

o by directing axis to point;

· rotation around LCS origin:

o parallel to direction;

o by directing axis to point;

o cyclic;

· aligning LCS axis to arbitrary vector;

· aligning LCS plane to arbitrary surface;

· translation along arbitrary axis;

· rotation around arbitrary axis;

· mirroring;

· scaling.

Coordinate System

This type of transformation is not available for 3D fragments. Select Target LCS instead.

When transforming operations and constructions an LCS can be selected using the following

automenu option:

<L> Select LCS for current transformation

Click  on the automenu option, then click again on an existing LCS. A dialog will pop-up:

Upon selecting Yes, an object retains its current position and all transformations belonging to the

selected group of transformations are replaced by elementary translations and rotations in relation to

selected LCS' axes, in such way that result coincides with a current position of an object. 

Upon selecting No, all transformations belonging to the selected group of transformations are

deleted, so a position of an object changes.

In any case, the  Coordinate System appears in the first row of the transformations list for the

current group. 

Position of this transformation in the list of transformations can be changed using   buttons

which have the following effect:

· All transformations above the  Coordinate System in the current group are calculated using

the source LCS of the element.
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· All transformations below the  Coordinate System in the current group are calculated in the

selected LCS

· All transformations in other groups are calculated independently of this transformation (in the

source LCS of the element or in the  Coordinate System selected in the same way for

another group)

Selected LCS is highlighted in green color in the 3D scene..

This type of transformation is non-editable but you can select another LCS again in the same way.

This transformation can be deleted by selecting it in the list and clicking the  Delete button, or

using the following automenu option:

<C> Cancel coordinate system for current transformation

Upon deleting the  Coordinate System using  button, all transformations of the current group

will remain unchanged, but values previously calculated in the selected LCS will now use the source

LCS, so the position of the element will change.

Upon deleting the  Coordinate System using automenu option a dialog will pop-up again:

Upon selecting Yes, an object retains its current position and all transformations belonging to the

selected group of transformations (no matter of their positions in the list relative to the 

 Coordinate System) are replaced by elementary translations and rotations in relation to the source

LCS, in such way that result coincides with a current position of an object. 

Upon selecting No, all transformations belonging to the selected group of transformations (no matter

of their positions in the list relative to the  Coordinate System) are deleted, so a position of an

object changes.

Non-associative transformation

Created using the  Replace with a single non-associative transformation option. Represents a

position of an element at the moment of applying the option. Can not be edited but can be

repositioned in the list of transformations using   buttons, which affect a final position of an 3D

element.

Translation along LCS axis

A translation along one of the LCS axes can be created using the contextual menu or axes

manipulators.

For using manipulators move mouse cursor over a desired axis manipulator arrow. An arrow becomes

highlighted and the cursor's symbol changes to ,  or  depending on the axis. If you hold the

cursor in this position a little longer, a textual tip pops-up. Upon moving cursor over an axis there are

two ways of using the manipulator:
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1. Drag and drop

Press and hold , then move the cursor without releasing . Manipulator will follow the

cursor along the axis. Endpoint of translation will be defined upon releasing . Linking

transformation to reference geometry is not available in this mode.

2. Point and click

Click  once and release. Manipulator will follow the cursor along the axis. Endpoint of

translation will be defined upon second click . Linking transformation to reference

geometry is available in this mode.

In both cases a ruler is shown along axis while moving a manipulator. Ruler graduation pitch depends

on the scale of the view. Manipulator's movement step also depends on the scale of the view and is

always rounded to single unit of a certain order of magnitude (hundred, ten, one, tenth etc.). You can

define custom step manually in manipulator settings. Zero value is highlighted by a yellow mark on a

ruler. Current translation value is highlighted by a blue mark on a ruler. Ruler is only displayed near the

current value, while yellow zero mark is always displayed. You can input a translation value using the

keyboard while moving a manipulator.

Upon defining a translation without linking it to reference geometry, a new transformation is added to

the transformations list looking like this:

 123 mm 

where  - an icon representing a selected axis, 123 - translation value, mm - unit of measurement.

Such transformation can be edited by entering a new value into the input field. 

When using Point and click the Filters toolbar contains filters for selecting geometrical elements

defining a point. Moving the mouse cursor over an element, which fulfills active filters, highlights such

object (in red) and a point defined by it (in yellow). Manipulator snaps to a normal projection of a

highlighted point onto a manipulator's axis. Holding the cursor in this position invokes a tip with a

name of highlighted geometrical element and an icon representing its type. Holding the cursor a little

longer invokes a list of all elements, which are located behind the current cursor position and fulfill

active filters (an element nearest to the camera is selected by default). You can switch between

elements in the list by scrolling . When desired element is highlighted click  to confirm

selection. A new transformation will be added to the transformations list looking like this:

Move to Point by Axis

where  - an icon representing a selected axis.

Such transformation can be edited by re-selecting the fixing.

Links to reference geometry are saved upon applying transformations, so if reference point changes

position, object of transformation changes its position accordingly.
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You can apply translations along two axes at once using a plane manipulator or along three axes at

once using the origin manipulator

Such manipulators work in a similar way to axes manipulators. The cursor's symbol changes to 

when placed over the origin manipulator, or to ,  ,  depending on the plane when placed

over plane manipulator. A ruler is not shown when moving these manipulators. However the step of

manipulator's movement is defined in the same way as for axes manipulators. 

When using reference points:

· a plane manipulator snaps the LCS origin to a normal projection of a highlighted point onto

the manipulator's plane;

· the origin manipulator fully aligns the LCS origin to a highlighted point.

Upon using these manipulators, two or three transformations at once are added to the list of

transformations:

 123 mm 

 123 mm 

 123 mm 

(without using a reference point) or

 Move to Point by Axis 

 Move to Point by Axis 

 Move to Point by Axis

(when using a reference point).

You can also apply three Move to Point by Axis transformations at once using the following

automenu option:

<N> Select point

The result is identical to using the origin manipulator with selecting reference point.
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Move to Point by Axis transformation can also be applied using the Move to Point option of

the axes and planes manipulators' contextual menu. Selecting a point this way is similar to using

manipulators in Point and click mode. However it's impossible to set arbitrary values of translation

and a manipulator does not follow the cursor. 

Upon adding a new translation without reference along an LCS axis, the system checks if there

are any other translations without reference along the same axis in the transformations list. If

there are no such translations, a new translation being added. If there are such translations, result

depends on a presence of transformations, which change axes direction: 

· If there is a transformation, which changes axes direction, and it's positioned in the list

between an existing translation and the end of the list, then a new translation being added.

· If there are no transformations, which change axes direction and are positioned in the list

between an existing translation and the end of the list, then a new translation is not being

added. Instead an existing translation being edited by adding a new value to the old one.

Upon adding a moving to point by axis, the system checks presence of transformations, which

change axes direction, in the same way. But instead of adding values, a reference point is

replaced for the existing translation. In this case, if there's a translation without reference along

the same axis below the moving by point in the list, such translation without reference is being

deleted. 

Move to Curve by Axis transformation can be applied using Move to Curve option of the

axis manipulator's contextual menu. Selecting this option enables filters for selecting curves on the

Filter Toolbar. Then you need to select a curve in the 3D scene.

If a selected curve intersects an axis, then a manipulator repositions to a point of intersection. 

If a selected curve does not intersect an axis and is not parallel to an axis, then a manipulator

repositions to a normal projection of a selected curve's nearest point onto an axis .

If a selected curve is parallel to an axis, then a transformation is not added and the system throws an

error in the  Diagnostics window:

Cannot find nearest point on Surface or Curve

Despite an error a transformation is still added to the transformations list. Error will be displayed until

you delete or edit a faulty transformation. 

A new transformation is always created upon using this option, no matter if there are other

translations along the same axis.

Such transformations can be edited by re-selecting the fixing.

Move to Surface by Axis transformation can be applied using Move to Surface option of the

axis manipulator's contextual menu. Using this option enables filters for selecting surfaces on the Filter

Toolbar. Then you need to select a surface in the 3D scene.

If a selected surface intersects an axis, then a manipulator repositions to a point of intersection. 

If a selected surface does not intersect an axis and is not parallel to an axis, then a manipulator

repositions to a normal projection of a selected surface's nearest point onto an axis .

If a selected surface is parallel to an axis, then a transformation is not added and the system throws an

error in the  Diagnostics window:

Cannot find nearest point on Surface or Curve

Despite an error a transformation is still added to the transformations list. Error will be displayed until

you delete or edit a faulty transformation. 
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A new transformation is always created upon using this option, no matter if there are other

translations along the same axis.

Such transformations can be edited by re-selecting the fixing.

 Rotation around LCS axis

Rotation along an LCS axis can be applied using one of following ways:

· via the contextual menu;

· via automenu options;

· via rotation manipulators;

· via the Direct axis to point with rotation around axis option in the axis manipulator's

contextual menu.

For using manipulators move the mouse cursor over the desired rotation manipulator. An arrow

becomes highlighted and the cursor's symbol changes to ,  or  depending on the axis. If

you hold the cursor in this position a little longer, a textual tip pops-up. There are two modes of using

rotation manipulators: Drag and drop and Point and click, both are similar to the described in the

translation along axis chapter. However, linking a transformation to reference geometry is not

available in both modes.

A protractor is shown around an axis while moving a manipulator. Protractor graduation pitch as well

as manipulator's movement step are always constant. You can define custom step manually in

manipulator settings. Zero and current rotation values are marked on a protractor in the same way as

described in the translation along axis chapter. You can also input a value using the keyboard while

moving a manipulator.

Upon defining a translation without linking it to reference geometry, a new transformation is added to

the transformations list looking like this:

 123° 

where  - an icon representing a selected axis, 123 - rotation value, ° - unit of measurement.

Such transformation can be edited by entering a new value into the input field. 

Rotation by 90° around an LCS axis can be quickly added using one of following automenu options:
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<A> Rotate LCS around X axis by 90°

<O> Rotate LCS around Y axis by 90°

<Z> Rotate LCS around Z axis by 90°

Upon adding a new rotation around an LCS axis, the system checks if there are any other

rotations around the same axis in the transformations list. If there are no such rotations, a new

rotation being added. If there are such rotations, result depends on a presence of other

transformations, which change axes direction: 

· If there is a transformation, which changes axes direction, and it's positioned in the list

between an existing rotation and the end of the list, then a new rotation being added (even if

such transformation did not change the direction of a new rotation's axis).

· If there are no transformations, which change axes direction and are positioned in the list

between an existing rotation and the end of the list, then a new rotation is not being added.

Instead an existing rotation being edited by adding a new value to the old one.

You can Turn Axis around Axis to Point using the Direct axis to point with rotation around axis

option in the axis manipulator's contextual menu.

Selecting this option enables filters for selecting points on the Filter Toolbar. Then you need to select

a point in the 3D scene. Upon selecting a point, a new transformation is added to the transformations

list looking like this:

Turn Axis around Axis to Point

A new transformation is always created upon using this option, no matter what other

transformations are present in the list.

Such transformations can be edited by re-selecting the point.

Initial condition Result of applying the Direct axis X to point

with rotation around Z axis option 

Rotation around LCS origin

When applying rotation around LCS axis, two axes change orientation, while the third one does not

change. When applying rotation around LCS origin, all three axes change orientation. Rotation around

LCS origin can be applied using one of following options in the axis manipulator's contextual menu:
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· Rotate Parallel to Direction

· Direct Axis to Point

Using the Rotate Parallel to Direction option enables filters for selecting directions on the Filter

Toolbar. Upon selecting a direction, a new transformation is added to the transformations list looking

like this:

Set Axis Direction

Using the Direct Axis to Point option enables filters for selecting points on the Filter Toolbar. Upon

selecting a point, a new transformation is added to the transformations list looking like this:

Direct Axis to Point

Initial condition Result of applying the Direct Axis to Point option 

to the X axis 

A new transformation is always created upon applying rotation around an LCS origin, no matter

what other transformations are present in the list.

Such transformations can be edited by re-selecting the fixing.

Cyclic Axis Change can be applied using the origin manipulator's contextual menu or the following

automenu option:

<8> Change LCS axes orientation

Upon applying this option, the X axis inherits the orientation from the Y axis, the Y axis - from the Z

axis, the Z axis - from the X axis.  A new transformation is added to the transformations list looking

like this:

 Cyclic Axis Change

where  can be replaced by any other random icon.

This transformation can not be edited but can be repositioned in the list of transformations using 

 buttons, which affect a final position of an 3D element.

It is not possible to create more than two transformations of this type in a row. Applying the

cyclic axis change for the third time simply deletes two previous changes, due to the fact that a

result of the third change is identical to an initial LCS orientation.
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Aligning LCS axis to arbitrary vector

Can be applied using the Combine Axis option in the axis manipulator's contextual menu. Using this

option enables filters for selecting axes on the Filter Toolbar. Then you need to select an axis in the

3D scene. A new transformation is added to the transformations list looking like this:

Set Axis

where  - an icon representing a transformed axis.

A new transformation is always created upon using this option, no matter what other

transformations are present in the list.

Such transformations can be edited by re-selecting the axis.

Aligning LCS plane to arbitrary surface

Can be applied using the Fully Combine option in the plane manipulator's contextual menu. Using this

option enables filters for selecting planes on the Filter Toolbar. Then you need to select a plane in the

3D scene. Upon combining planes, origins are also combined. A new transformation is added to the

transformations list looking like this:

 Set Plane

Applying this option deletes all other transformations belonging to the same group of

transformations.

Such transformations can be edited by re-selecting the surface.

Translation along arbitrary axis

Can be applied using the following automenu option:

<B> Move along arbitrary axis

Using this option enables filters for selecting axes on the Filter Toolbar. Then you need to select an

axis in the 3D scene.

Upon selecting an axis, a manipulator appears in the 3D scene allowing you to define a translation. It

works in the similar way as translation along LCS axis manipulators in the point and click mode. The

only difference is that here you can't link translation to a reference point. Manipulator's movement

step is also defined by the camera scale or manipulator's settings. You can also input a value using the

keyboard while moving a manipulator.
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Upon defining a translation distance, a new transformation is added to the transformations list

looking like this:

Translation along 123 axis

where 123 - translation distance value. Units of measurement depend on the Length units set in the

Document Parameters. 

A new transformation is always created upon using this option, no matter what other

transformations are present in the list.

Such transformations can be edited by re-selecting the axis or entering a new value into the input

field.

Rotation around arbitrary axis

Can be applied using the following automenu option:

<Y> Rotate around arbitrary axis

Using this option enables filters for selecting axes on the Filter Toolbar. Then you need to select an

axis in the 3D scene.

Upon selecting an axis, a manipulator appears in the 3D scene allowing you to define a rotation. It

works in the similar way as rotation around LCS axis manipulators in the point and click mode.

Manipulator's movement step is also defined by manipulator's settings. You can also input a value

using the keyboard while moving a manipulator.
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Upon defining a required rotation angle, a new transformation is added to the transformations list

looking like this:

Rotation around 123 axis

where 123 - rotation angle measured in degrees.

A new transformation is always created upon using this option, no matter what other

transformations are present in the list.

Such transformations can be edited by re-selecting the axis or entering a new value into the input

field.

Mirroring

Can be applied using the following automenu option:

<P> Select mirror plane

Using this option enables filters for selecting planes on the Filter Toolbar. Then you need to select a

plane in the 3D scene.

Upon selecting a plane a new transformation is added to the transformations list looking like this:

Mirror plane

A new transformation is always created upon using this option, no matter what other

transformations are present in the list.

Such transformations can be edited by re-selecting the plane.

LCS Manipulators for Transformations of 3D Elements

This chapter describers types, contextual menus and settings of 3D Elements Transformation LCS

manipulators.

Usage of these manipulators for applying transformations is described in the Types of

Transformations of 3D Elements chapter.

Scaling manipulators and their usage are described in the Scaling when applying Transformations to

3D Elements chapter. 

Types of LCS Manipulators

Upon selecting an object of transformation, its source LCS manipulators appear in the 3D scene.

Position and orientation of manipulators depend on applied transformations.
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0 - origin manipulator

X - X axis manipulator

Y - Y axis manipulator

Z - Z axis manipulator

rX - manipulator of rotation around X axis

rY - manipulator of rotation around Y axis

rZ - manipulator of rotation around Z axis

XY - XY plane manipulator

XZ - XZ plane manipulator

YZ - YZ plane manipulator

Axis manipulators look like arrows: X - red, Y - green, Z - blue.

Plane manipulators look like planes of a same color as a normal axis.

The origin manipulator looks like a turquoise ball located in the axis manipulators' point of

intersection.

Manipulators of rotation look like arcs locate to both sides of an axis normal to an axis of rotation.

One of the arcs define positive rotation angles, another one - negative angles. Positive angles are

counted clockwise, negative - counterclockwise when looking along the rotation axis. Rotation

manipulators have same colors as their corresponding axes of rotation.
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Х axis coincides with the view direction 

1 - manipulator of positive rotation angles around X

axis

2 - manipulator of positive rotation angles around X

axis

Contextual menus of LCS manipulators

Clicking  on a manipulator invokes its contextual menu. Set of options available in the contextual

menu depends on the type of manipulator. However, two common options are always available:

· Rotate to

Applies such view orientation, so the X axis is pointed horizontally to the right, Y - vertically up,

Z - opposite of the view direction.

· Settings...

Invokes the common manipulator settings dialog.

Contextual menu of the rotation manipulator contains common options only.

Contextual menu of the origin manipulator beside common option also contains the Cyclic Axis

Change option, which works in the similar way as the automenu option.
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Contextual menu of the plane manipulator beside common option also contains following options:

· Move to Point

· Fully Combine

Contextual menu of the axis manipulator beside common option also contains following options:

· Move to Point

· Rotate Parallel to Direction

· Combine Axis

· Direct Axis to Point

· Direct axis to point with rotation around axis

· Move to Curve

· Move to Surface

Manipulator settings

Manipulator settings dialog is common for all types of manipulators. Here you can define custom

manipulator's movement step when applying Move (translation) and Rotate transformations, by

typing the value into the input field to the right side of the corresponding checkbox. Move step is

measured in the Length units set in the Document Parameters. Rotate step is measured in degrees.

Enable the corresponding checkbox and click ОК to apply a custom step value. If the checkbox is

disabled, then a custom value will be saved in system parameters upon clicking ОК, but will not be

applied to manipulator's movement.
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Scaling when applying Transformations to 3D Elements

Scaling can be applied by typing scale values into input fields in the Scaling tab of the Parameters

window or by using manipulators of scaling.

Manipulators of scaling are invoked by the following automenu option:

<М> Scaling

Activating this option enables display of a bounding box around the selected object in the 3D scene.

Ball-shaped manipulators are located on three of the bounding box's vertices. Colors of manipulators

coincide with colors of corresponding LCS axes.

To define scaling along one of the axes move the mouse cursor over a desired manipulator.

Manipulator will get highlighted and the cursor symbol will change to ,  or  depending on

the axis. If you hold the cursor in this position a little longer, a textual tip pops-up. Upon moving

cursor over a manipulator there are two ways of operation:

1. Drag and drop

Press and hold , then move the cursor without releasing . Manipulator will follow the

cursor along the axis. Final value of the scaling coefficient will be defined upon releasing .

2. Point and click

Click  once and release. Manipulator will follow the cursor along the axis. Final value of

the scaling coefficient will be defined upon second click . 

Linking scale to reference geometry is not available in both modes. You can also input a scaling

coefficient value using the keyboard while moving a manipulator.

Keep in mind that scaling is applied along current orientation of object's LCS axes. Edges of

bounding box may be non-parallel to LCS axes 
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Several consequent scalings are automatically summed up.

The Scaling tab of the Parameters window contains the Uniform scale checkbox. If this checkbox is

enabled (by default), then a single S: input field is displayed. Scaling coefficient value from this field is

applied simultaneously along all three axes. Disabling the checkbox replaces aforementioned field by

three separate fields X:, Y: and Z: allowing to specify the scaling coefficient individually for each axis.

Scaling can be reset to the S:1 value using the following automenu option:

<J> Remove scaling

Scaling cannot be suppressed.

Group Transformations of 3D Elements

In the Transformation command it is possible to create transformations for several objects

simultaneously. 

Only objects independent from each other can participate in such group transformation (not to be

confused with groups of transformations). Objects are considered independent if they do not have

parents/children relationships to each other.

Group transformation mode differs from default transformation mode in sets of available automenu

options and tabs of the Parameters window. System switches to this mode automatically if there are

objects selected for group transformation.
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Selecting objects for Group transformations 

Can be done using the following automenu option: 

<1> Select objects for transformation

Selected objects are added to the list in the Objects tab of the Parameters window. Object selected

first becomes the main object, other objects become dependent.

Even in the  selecting objects for individual transformation mode it is possible to select objects

for group transformation by using following hotkeys: 

·  - selecting new main object, disbanding all existing groups;

· +<Shift> - including a dependent object to a group;

· +<Ctrl> - including a dependent object to a group, if selected object is not a member of

a group; excluding selected object from the group if it's already a member.

Hotkeys work both in the list objects and in the 3D scene. Excluding a main object from the group

leads to automatic assigning of a new main object. Auto-assigning selects the group member highest

ranking in the list as a new main object. 

Main object's LCS is used for applying group transformations. Main object is highlighted in green

both in the 3D scene and in the list of object. All other dependent members of the group are

highlighted in orange. Object selected for transformation but not included into group are highlighted

in blue in the 3D scene, but are not highlighted in the list.

 

Applying group transformations

Main Transformations, Scaling and Mate Transformations tabs of the Parameters window are not

displayed in the group transformation mode. The Transformations tab contains the list of

transformations to be applied to each member of the group upon selecting the following automenu

option
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<Еnter> Apply group transformation of objects

Applied transformations are added to a lowest group of transformations for each object. 

The list of transformations can be cleared without applying by using the following automenu option:

<U> Remove group transformation of objects

The system stays in the group transformation mode after using any of the two aforementioned

options. You can switch to individual transformation mode by clicking  on any of the objects in the

list or a new object in the 3D scene.

All transformations in the list are automatically applied  upon changing or disbanding the

group of objects.

Group transformations LCS

All transformations in the group transformation mode are previewed in the main object's LCS. By

default this LCS is common for all members of the group and the following automenu option is active:

<G> Set transformation of selected objects in common CS

While this option is active, dependent (orange) objects move in the same LCS as a main object.

Applying  group transformations to the main objects is performed in the same manner as it's

displayed in the transformations list. Applying group transformation to dependent objects leads to

recalculating them into each object's LCS in such manner, so that objects retain position and

orientation defined in the group transformation mode.

When  the transformation of selected objects in common CS is deactivated, group

transformations are still represented in the list in relation to the main object's LCS. However,

application of the same transformation values to dependent objects is performed in each object's

individual LCS. This results in objects moving in different directions if they have different orientations

of LCSes. 

Defining group transformations

Can be done in the similar way as defining individual transformations using contextual menu, LCS

manipulators and automenu options. The detailed information can be found in the Types of

Transformations of 3D Elements chapter.  Mirroring and  Scaling are not available in this

mode. The unique automenu option is available in this mode: 

<S> Set Positions of Source and target Coordinate Systems

When using this option, it is necessary to consequently select two existing coordinate systems in the

3D scene. Then transformations are calculated in such way, so that difference between final position of

main object's LCS and second selection is equal to difference between initial position of main object's

LCS and first selection.
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Initial position of the main object's LCS in relation

to the first selected LCS

Final position of the main object's LCS in relation to

the second selected LCS

Unlike individual transformations mode, the group transformation mode allows only elementary

translations and rotations in relation to the source LCS axes. Options in the automenu and in context

menus of manipulators are still available, but result of their application is being converted to

elementary translations and rotations.

Group transformations are most efficiently used in when creating exploded views. Detailed

information on this topic can be found in the Exploded View Scenario chapter.

Name Customization for 3D Elements

The T-FLEX CAD allows you to configure names of 3D elements and 3D operations. Default names

are stored in a special configuration file called OperNames.ini, located in the Program folder (by

default C:/Program Files/T-FLEX CAD 17/Program). Each row in the OperNames.ini looks like this:

OperationName = "Name of Operation"

Where OperationName - non-customizable internal identifier of operation, Name of Operation -

name assigned by default to elements created by this operation.

The name of the 3D element displayed in CAD interface is formed as follows: Name of

Operation_# (the number # is a number equal to the number of elements of this type existing in

the model at the time of its creation).

For example: 3D node_1, Extrusion_0, and so on. 

If necessary, you can change the contents of this file by entering your own default names for 3D

elements.

For example, in order to get Revolve_# instead of Rotation_# you need to edit opernames.ini file

and change the Rotation = "Rotation" row to Rotation = "Revolve".
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You can change name for already created element in the General Parameters.

Upon creating operations or performing measurements it is possible to select elements by name.

It can be done by typing the name of the desired element into fields for selecting geometrical

inputs in the parameters window of an active operation. You can also search elements by names

in the command standby mode using the Find command or search toolbars. Named elements

retain their names when new operations are created based on them.

Model Regeneration

Topics in this section:

· Regenerate modified elements

· Full Regeneration

· Managing Regeneration of a Particular Element

Regenerate modified elements

The command can be called in one of the following ways:

Icon Ribbon

Parameters > Tools > Regenerate

Keyboard Textual Menu

<3G>, <Alt+F7> Tools > Regenerate

The command can also be called from the View Toolbar or from the dynamic toolbar, invoked by

clicking  on empty space in the 3D scene in the standby mode.

Dynamic toolbar in the 3D window
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Dynamic toolbar in the 2D window

Upon calling the command the system automatically analyzes what objects were modified since the

last regeneration, and recalculates these objects and their children only. Compared to the Full

Regeneration it creates less load on the system since most of the elements are usually not

regenerated.

Full Regeneration

The command can be called in one of the following ways:

Icon Ribbon

Parameters > Tools > Regenerate > Full Regeneration

Keyboard Textual Menu

<3RG>,

<Shift+F7>
Tools > Full Regeneration

The command can also be called from the View Toolbar 

This command can regenerate each element, unlike the Regenerate command, which regenerates only

changed elements. 

The following window pops-up after calling the command:

If the Drawing 2D Projections checkbox is enabled, pressing OK will will update only changed 3D

elements (similar to Regenerate command) and all projections which don't have Update: Manually

parameter.
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Drawing projections which have Update: Manually parameter are not updated on full

regeneration, no matter which checkboxes are enabled or disabled here. Use the Update

selected element command for updating such projections.

If the 3D Elements checkbox is enabled, all 3D objects and their dependent projections are

regenerated. 

If both Drawing 2D Projections and 3D Elements checkboxes are enabled, the full regeneration is

performed. If both checkboxes are disabled, the optimal regeneration is performed (Regenerate

command).

The Links checkbox allows to update files used in the current document (fragments, images, data

bases). You can choose to update Changed Only links (similar to Automatic Link Update) or All links

(similar to Update links). 

The Product Composition checkbox allows to update all product compositions created in the

document. 

The Reports/Bills of Materials checkbox updates all reports and bills of materials created in the

document.

The Select All checkbox enables/disables all of the aforementioned checkboxes. 

Enabling Show this dialog only with the pressed Shift key will make this window pop-up upon further

calls to the command only when holding <Shift>.

If current document is opened from the T-FLEX DOCs in the integration mode then the Full

Regeneration window contains additional checkboxes allowing you to update T-FLEX DOCs files in

Working Folder and Synchronize with DOCs data defined by integration rules.
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Managing Regeneration of a Particular Element

Update selected element

Upon selecting some elements, the Update selected element command might be available in the

context menu and in some cases in the dynamic toolbar. Beside selected element it also updates all its

children.

Do not update geometry when recalculating

The Do not update geometry when recalculating option is available in the contextual menu of 3D

elements. If it's enabled, the element can only be updated using the Update selected element

command.
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3D Constructs. Support Geometry.

This chapter contains a description of the work of the 3D construction elements and elements of the

wire geometry. Auxiliary elements are used for setting the shape of the future body, orientation in

space, determining directions, vectors, axes, trajectories, etc. Each element has a separate create and

edit command. After running the command, an additional set of icons appears in the auto menu for

calling options. Some of the options in this set are shared by all elements.

Common Information about 3D Construction Entities

3D node is one of the basic construction entities used for representing a point in the three-

dimensional space. There are several ways of creating 3D nodes. A 3D node can be specified, for

instance, as a characteristic point on a body, referencing a vertex, an edge, or a face. It also can be

located by using absolute coordinates or offsets from other 3D nodes. 3D nodes can also be specified

using the nodes from the two-dimensional drawing, and workplanes. In this way, the 3D node will be

defined by selecting one node on a workplane, or two nodes on two different workplanes that are

related by having a common projection.12

3D profile is a construction entity used for defining a patch on a surface. A 3D profile is one of the

basic entities because it is used as an original reference for many operations. A 3D profile may be

defined by an open or closed contour. A closed contour defines a fixed area on the surface that can

be used as a base for various operations creating solid bodies. An open profile can be used as a base

for creating sheet bodies only as it consists of wire geometry. There are many ways of creating a 3D

profile. Thus, it can be drawn on a workplane, or get anew by a variety of modifications to an existing

profile, and so on. One 3D profile may contain several contours of the same type. An example of a

multi-contour profile is a text entity. A 3D profile can be obtained from hatches and graphic lines

(when drawn on the active workplane).

3D Path is a bounded three-dimensional curve with a defined traversal direction. The 3D paths are

used in the operations "Sweep", "Pipe", "Loft". A 3D path can be defined by a hatch, 2D paths, as a

chain of a body edges, as a curve passing through a sequence of 3D nodes, by modifying existing 3D

paths, etc. A 3D path can be closed.

Route is a 3D path consisting of straight line segments smoothly connected by arcs. This command is

mainly used for modeling pipes. A large variety of options and controls provided by this command

help quickly and easily solving this sort of task.

Workplane is an entity that helps defining the required data for 3D operations, and, first of all,

creating 3D profiles. A 3D model cannot be built without creating a workplane. Workplanes can be

specified in 2D or 3D window based on various references, such as the 2D drawing views, projections

of entities in a 3D model, or the 3D entities themselves, including other workplanes.

Worksurface serves similar functional purposes as the workplanes, providing a non-planar geometrical

basis for further design. A worksurface can be a cylinder, a sphere, or a torus.

3D Section is an entity that, generally, results from extruding a planar curve or polyline through all

geometry in the direction normal to the plane of the curve. In some cases, a 3D section consists of one

or several planes. In this case, it can be used for creating two-dimensional cuts.  A 3D section may be

included in visualization of the objects of a 3D scene, and can be used in "cut" operations.

Local Coordinate System is an entity for referencing three-dimensional objects in space. It is used for

inserting 3D fragments and other elements, copying, exploding of assemblies, etc. This entity is

defined by the origin point and the axis directions. Objects snap to a coordinate system by making the

object and the target coordinate systems coincide

3D connector – is a special type of local coordinate systems which allows a user, apart from

performing the functions of snapping, to automatically tie external variables for jointed parametric
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elements of the 3D assembly models. This significantly simplifies positioning of parts and parameters

assignment when designing the assemblies.

Construction array is a special composite construction element. A construction array is a particularly

organized set of copies of an arbitrary construction element, except for sections, light sources and

cameras. The copies contributing to such an array can be used as conventional construction elements.

Construction arrays are created and edited using any of the 3D array creation operations.

Using Active Workplane

Calling the command:

Icon Ribbon

3D Model > Construct > Draw on Workplane

Sheet Metal > Construct > Draw on Workplane

Surfaces > Construct > Draw on Workplane

Weld > Construct > Draw on Workplane

Primitives > Construct > Draw on Workplane

Support Geometry > Worksurfaces > Draw on Workplane

Keyboard Textual Menu

<3W> -

The mode of drawing on the active workplane is intended for placing 2D elements on a plane in the

three-dimensional space and their further use in creation of the 3D model.

You can select the workplane as active in the 3D Model window or in the 3D model tree. Workplanes

used to work in this mode must be located on separate pages of the drawing. Drawing on workplanes

that do not meet this requirement is performed in the 2D view window, and then, using 3D

commands, the necessary 3D elements are created. Any flat face can also be used as a workplane. A

workplane will be created based on the selected face, along with the page to contain all elements

belonging to the workplane.

You can switch to the mode of operation on the active workplane in one of the following ways.

1. Call the Draw on Workplane command from the ribbon or from the contextual menu invoked by

clicking  on an empty space in the 3D scene in command standby mode. Then select a desired

workplane or flat face in 3D scene, in model tree or in the list of workplanes existing in this document

(the list is displayed in the Parameters window). 

2. Point the mouse to a workplane or a flat face and click . The selected workplane gets

highlighted. At this moment, you can start creating elements, using 2D drawing commands. Activating

a 2D command activates the selected workplane. 

3. Point the mouse to a workplane or a flat face and click . Then call the Draw on Workplane

command from the ribbon. 

4. Point the mouse to a workplane and click . The selected plane gets highlighted. In the coming

up context menu, select the Draw On Workplane command. 

5. Point the mouse to a flat face and click . The selected face gets highlighted. In the coming up

context menu, select the Draw On Face command.
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The Turn workplane on activation parameter of the Options  command (3D tab) sets the rotation of

the 3D scene to the position corresponding to the view of the active workplane. When you exit the

active workplane mode, the 3D scene returns to its previous position. 

 - End Drawing On Active Workplane

 - Project Elements On Active Workplane

 - Move Cutting Plane To Active Workplane

 - Select Profile

 - Rotate Active Workplane Orthogonal To View Direction

 - Cancel Drawing On Active Workplane

Managing View in Draw on on Active Workplane Mode

You can quickly open a 2D window with an active workplane using the Open 2D Window command

.

Option  is available only when working in the 3D window. Upon selecting this option, the icons

appear in the automenu for selecting 3D model elements (operations, faces, edges) that you need to

project on the active workplane. Upon finishing the selection, confirm the projection creation with the

icon . 

While working in the active workplane mode, you can use any construction and 2D element creation

commands. If the workplane was created on a body face, then the face projection on this workplane

will be automatically created on the drawing page linked to this workplane. While working with 2D

drafting commands, you can snap construction and graphic elements to the lines of the projection and

their joint points. 

The Profile  command contains a list of 3D profiles drawn from the image lines of this plane. If

you select one of the profiles from this list, the image lines that form it are automatically shown on the

screen, and the color of the selected profile is set for the newly created lines.

If you need to use 3D elements, use the Rotate Scene  command on the View toolbar, which

allows you to rotate a 3D scene or select existing elements of a 3D model. Also, selection of 3D

elements is possible with the Alt key pressed.

When exiting the workplane, the system automatically creates a 3D Profile using the following

elements: 

· hatch outline;
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· graphic lines created by the Sketch and Graphic Line commands;

· TrueType text.

If graphic lines of different colors are found on the workplane, the system, when exiting the drawing

mode on the plane, will prompt the user to create several 3D profiles - according to the number of

colors used. Each of the created profiles will include lines of one specific color.

To create several 3D contours at once on the same workplane, you can use graphic lines of

different colors or hatching (for more details, see the 3D Profile section).

Working in the active workplane mode, you can call commands for creating 3D operations. In this

case, the system will complete drawing on the workplane and, if the operation requires the selection

of a 3D profile, it will highlight the profile created on it automatically.

Project Elements

The Project Elements command becomes available in the workplane.

Icon Ribbon

Workplane > Modes > Project Elements

The command allows projecting 3D scene elements onto the active workplane: Nodes, Patches,

Profiles, Vertices, Edges, Faces, the intersection with the active workplane of these elements,  surfaces

outlying. Lines or points obtained when projecting can be used to create 3D elements, or to position

other lines based on which 3D elements will be created. In the latter case, the line obtained when

projecting should be made Auxiliary.

All created projection lines and points are associatively rearranged as the projected 3D

elements change. 

You need to start drawing on any workplane or on a face (when drawing on a face, a workplane is

created automatically) in order for the command of projecting elements to become available in the

Ribbon. In other words, you should make an existing or new workplane active.

In the mode of drawing on the active workplane, the group “Modes” appears in the Ribbon. The

Project Elements command is available in the group.

The Project Elements command has three basic ways to create projected lines and points based on

3D elements. Each option for creating projection lines and points has its own icon in the dialog.
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Projection to Workplane

Intersections with Workplane

Projection of Elements Outline to Workplane

To complete the command and construction lines according to the specified parameters, you need to

press the automenu command  or <Ctrl + Enter>.

Often when working with the command, it is convenient to change the view on the active workplane.

To freely rotate the 3D scene in the active workplane mode, click the  Rotate Scene icon. The icon

is located on the right on the View Toolbar by default. If the scene rotation mode is active, the created

constructions on the workplane will be inaccessible for editing properties. To turn off the Rotate

Scene mode, click the icon again. If any command for creation of 2D elements was selected, the

Rotate Scene mode will automatically turn off. 

In the mode of drawing on the active workplane, other view control commands are available (which

are also on the View Toolbar): 

 Rotate Normal to Selected Element and View Point. Usage of these commands helps to see the

orientation of the projected element.

In the Ribbon, three more view control icons are available  in the Modes group.

The first icon  orients the direction of view along the normal to the active workplane.

The second icon  makes a cut of the 3D model along the active workplane.

Pressing the icon  again restores the initial display of the 3D model. 
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The third icon  centers the view on the profile that is created on the active workplane. When you

click the icon, a list of all profiles that have been created on the active workplane appears. The view

will be centered on the selected profile.

Topics in this section:

· Projection to Workplane

· Intersections with Workplane

· Projection of Elements Outline to Workplane

· Combining Projection Methods

· Automatic Creation of Projection Lines and Points

Projection to Workplane

You can project a Face, Edge, Vertex, Profile, Patch, 3D Node on the plane while in the mode of

drawing on the active workplane. To do this, call the Project Elements command in the Ribbon and

select the Projection to Workplane option (active by default).

The filters toolbar displays a list of all possible 3D elements for projecting in this way  by default.

You should select the projection option in the command parameters (in this case, the first one). The

active workplane and elements are automatically selected. The list of selected items can be

completely cleared using the icon , or cancel selection of any element using  .

The following two options are also available: Create Auxiliary Lines and Project Direction. In the first

option is enabled, all lines created using projecting will be auxiliary.
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If the second option is disabled, then the projection is performed along the normal to the workplane.

If the option is enabled, then it is necessary to specify the direction of projecting the element on the

workplane. The direction may specified by an edge, a normal to a face or an axis of a cylindrical

surface.

For example, you can project the edges of the nozzle flange in the direction of its axis. Then in the

Project Direction option field you need to select a cylindrical face: the axis of the cylindrical face will

set the direction of projection.

As a result, projection lines will be created on the active workplane. In this case, the auxiliary lines are

created as the appropriate option was enabled. 
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Normal projection (without using

Project Direction option)

Projection by Direction (using the Project

Direction option)

Intersections with Workplane

Using this option of the Project Elements command, elements that are formed when the active

workplane intersects edges, edges, profiles, paths or other workplanes and work surfaces can be

projected on the active workplane. The specified list of elements corresponds to the filter option.

When the active workplane intersects edges, profiles, or other workplanes and work surfaces, they are

projected as lines. When the active workplane intersects edges or paths, they are projected as points.

For example, you can get the line of intersection of the nozzle faces with the workplane passing

through the body of the nozzle. To do this, you need to make the workplane active, select the Project

Elements command in the Ribbon and specify the Intersections with Workplane option. Next you

need to select the faces of the nozzle. If you select the outer faces - the outer contour of the nozzle

section by the workplane is created.

If you select both outer and inner faces, the complete contour of the nozzle section by the workplane

is created.

Several selected faces are specified twice in the list of elements, as it can be seen from the example.

For example, "Face_28".
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The intersection of the element "Face_28" with the workplane forms two edges, and, therefore, you

can create two projection lines.

If you need to project only one intersection line, you can disable the All Components option. Then

only the intersection that is closer to the cursor at the moment of selecting the face will be projected.

Another way is to remove an extra element from the list using the icon .

If you select the edges of the intersection of the nozzle faces then the result of the command will be

points projections.

As can be seen from the example, two selected edges create projections of four points, since each

edge has two intersections with the active workplane. If you need only one intersection point of
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several, then you need to act by analogy with the previous example: Do not use the All Components

option or remove items from the list using . 

Projection of Elements Outline to Workplane

With this option,  you can project an outline of a body along the normal on the active workplane. Only

 faces are available in the filter of this option.

For example, you can project the outline of the inclined cylindrical face of the nozzle on the horizontal

workplane. To do this, you need to make the workplane active, select the Project Elements command

in the Ribbon and specify the Projection of Elements Outline to Workplane option. 

In this case, the active workplane can either intersect or not intersect the face. In any case, a complete

line of the outline projected onto the face along the normal will be constructed.

If you need only one specific element of the projection of the outline, then you can disable the All

Components option. In this case, only the element that was closest to the cursor at the moment of the

face selection will be selected.
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You can remove all excess elements using  icon.

Not only the outer contours of the faces dimensions are projected, but also the inner lines of the

outlines of the faces, which the face itself does not obscure. This is well illustrated by an example of a

projection of an outline on a cylindrical face of a nozzle flange. The red lines correspond to the

outline of the face on the upper edge, the green lines correspond to the outline of the face on the

lower edge. Turquoise lines correspond to the outline of a cylindrical surface. 

The colors of the lines have been changed specifically to clarify the principle of projection - such color

gradation is not an option of the command.

Combining Projection Methods

Variants of projection can be combined to obtain the necessary constructions on the workplane. For

example, you can obtain a profile that will be part of the outline of the face of an inclined nozzle. The

nozzle is located under the workplane that intersects the specified face. To do this, you need to

activate a workplane that intersects the inclined cylindrical face of the nozzle.
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Select the Project Elements command in the Ribbon and specify the Projection of Elements Outline to

Workplane option. Select the nozzle face. The options All Components and Create Auxiliary Lines

are active.

Create projection lines using the specified parameters  or <Ctrl + Enter>. 

Next, select the Intersections with Workplane option in the Project Elements command and select the

nozzle face again. The All Components and Create Auxiliary Lines options should be active.

Create a projection line using the specified parameters  or <Ctrl + Enter>. 
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Next, in the automatic hatching creation mode , we hatch the area as shown in the figure. This

area will correspond to the projection of the face outline, which is under the active workplane. 

On the created hatching, you can create a profile for further work.

Automatic Creation of Projection Lines and Points

In some cases, it is convenient to automatically create projections of 3D scene elements on the active

workplane. 

Automatic Creation of Projection Lines

When you select the Draw on Face command, projection lines of face contours are created on an

automatically created workplane.

The lines are always auxiliary by default.
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Automatically created projection lines of a face contour have all the properties of projection lines:

they are associatively rebuilt when the face is changed, they can be made basic, they can be used to

create profiles and other 3D elements. Constraints can be created between projection lines and other

lines.  Automatically created projection lines can be deleted. If necessary, they can be re-created using

the Project Elements command and its Projection to Workplane option.

Automatic Creation of Projection Points

When creating sketch lines and construction lines, the  Snap to 3D Elements icon is available in the

bindings toolbar. With the active icon, you can bind to the projections of points of 3D elements. The

centers of the edges (circles) and the midpoints and extreme points of the edges (segments and arcs)

are projected. The points are projected along the normal to the active workplane, on which a 2D point

is automatically created. On the workplane, 2D points created on the basis of the projections of 3D

elements are indicated by a red triangular icon . 

Bindings of sketch lines and construction lines to such points is preserved without creating constraints.

The projected points are associatively rebuilt when the 3D model is changed.

If you need to perform more complex binding of constructions to 3D elements, you need to apply the

Project Elements command and use constraints.
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Workplane

Calling the command:

Icon Ribbon

3D Model > Construct > Workplane

Draw > 3D Model > Workplane

Assembly > Construct > Workplane

Sheet Metal > Construct > Workplane

Surface > Construct > Workplane

Weld > Construct > Workplane

Primitives > Construct > Workplane

Keyboard Textual Menu

<3W> Construct > Workplane 

The command is intended for constructing workplanes, which are the initial elements for creating

auxiliary 3D elements.

In addition, workplanes are used as construction elements in many 3D operations. For example, they

can be used to set the cutting plane of the body in the Cut operation or the position of the cutting

plane when creating a section. The normal to the working plane can be determined by the direction of

extrusion or the axis of rotation, etc.

The system provides mechanisms that make it possible to speed up the creation of workplanes and

drawing on them: creating workplanes in transparent mode, creating planes parallel to existing work

planes using special manipulators, drawing directly in the 3D scene in the active workplane mode.

Available types of workplanes creation:
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<L> Based on LCS

<1> Offset Workplane

<3> Through Flat Edge or Points

<7> Orthogonal to Path

<E> Between Two Planes

<S> Standard Workplane

<8> Tangent to Surface at Point

<J> Based on 2D Projection

<9> Parallel to Screen

<2> In Coordinates

A distinction should be made between workplanes created in 2D and in a 3D window. The position of

the workplanes in three-dimensional space is determined either by the world coordinate system

(standard workplanes), or by the elements of the 3D model. When created in the 2D view window, the

workplane is snapped to the elements of the 2D drawing. Each working plane specified in the 3D

window is assigned a separate drawing page, and the working plane specified in the 2D window

occupies a certain area on the current drawing page. If more than one workplane is located on one

page, then these workplanes cannot be used to work in the active workplane mode.

Note that although the boundaries for the workplanes are indicated in the 3D view window, they are

used only for displaying the workplanes. In reality, the workplanes are infinite.

The outer boundaries of the workplane in the 3D window are drawn with a solid line, and the inner

lines - with a thin dashed line. The size of the visual boundaries of all workplanes created without

reference to 2D constructions can be changed using the size manipulators that appear when you click

on the required workplane.

When you change the visual boundaries of the workplane, the boundaries of the 2D page

created for this workplane will also change.

If you move the cursor to the lines of the plane, it will be highlighted. By pressing , the plane can

be selected for any actions, and by pressing  - call the context menu for it.

You can also select a workplane in the 3D model tree, in the Workplanes folder, or in the part of the

tree that illustrates the history of the creation of any 3D element based on the workplane.

Let's say that you want to create a 3D profile on the workplane Top View, which will serve as the basis

for creating a 3D body.

To do this, press  on the Top View workplane in the 3D window or model tree. In the context menu

that appears, select the Draw on Workplane item.
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Settings for displaying workplanes in a 3D scene

The appearance of workplanes in a 3D scene is controlled by a set of parameters in the system

options, document parameters and parameters of the workplane itself.

First of all, you can control the transparency of the workplanes (from full transparency to full opacity).

The parameter that controls the degree of transparency of an individual workplane is available in the

dialog of parameters of this plane (see the section Workplane Parameters).

In the corner of the rectangle representing the workplane, the name of this plane or its type is usually

indicated. You can show or hide them using the Workplanes/Display Options type parameter in the

dialog of the Document Parameters, 3D tab. The font used to display the name of the workplane is

specified in the System Options, 3D tab.

The size of the workplane font can be set using the Workplane Font on the 3D tab in the dialog of the

Document Parameters. The higher the value of this parameter, the larger the font of the inscription will

be.

The coordinate system of the given workplane can be displayed within the rectangle of the workplane.

Controls the visibility of the coordinate system by the Show coordinate system parameter in the

parameters dialog of this workplane (see the section Workplane Parameters).
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By default, the workplane coordinate system is not displayed.

In the System Options, on the 3D tab, you can also specify the desired number of internal lines on the

image of the wor plane (Workplanes\Number of grid lines parameter). Here you can also set the

method for selecting workplanes - only along the lines of the outer rectangle or along all lines of the

workplane image (Workplanes\Select by all grid lines parameter).

After changing the Number of grid lines or Select by all grid lines parameters, you need to

perform a full regeneration.

If it is necessary to provide access in the assembly model to the workplanes created in fragments, then

the External checkbox must be enabled in the workplane parameters dialog in the fragment

document.
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Manipulators of Workplanes

For convenience of work with workplanes in T-FLEX CAD, special manipulators can be used.

When selecting a workplane in the 3D scene outside the command, on the workplane's image the

special manipulators will appear in the form of a rectangle. 

Small manipulators in the form of spheres located at the mid-sides of the workplane's rectangle allow

us to quickly modify the visible boundaries of the workplane. 
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When the cursor is moved to such a manipulator, the size of the manipulator is slightly increased.

Working with the manipulator can be carried out in two ways. First, it is possible to point at the

manipulator and press . The selected boundary of the plane will start moving after the cursor.

Pressing  for the second time will fix the new location of the boundary of the workplane. The

second way – by pointing at the manipulator, press  and without releasing the pressed mouse

button, move the selected boundary of the plane to the desired location. In this case, to fix the new

size of the workplane, it is sufficient to release the pressed mouse button. 

In both cases, when the manipulator is activated, in the system toolbar appear the additional elements

for exact specification of the new location of the boundary of the plane being edited.

The large manipulator, which appears at that place where the cursor was at the moment of workplane

selection, allows us to quickly move the plane and also create new workplanes. The given manipulator

practically consists of two manipulators: sphere at the center  – manipulator of translation  – serves

for the translation of the selected plane parallel to its original location; and the cones – manipulators

of copying – allow us to create new planes parallel to the selected one.
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After the plane translation manipulator is activated, the rectangle of the plane starts dynamically

moving after the cursor. A ruler that measures the distance of translation is displayed near the

manipulator. After pressing  for the second time (or after releasing the pressed mouse button) the

workplane is fixed at the specified location. As in the case of modifying the boundaries of the plane,

the exact value of the translation can be specified in the system toolbar or filter toolbar.

 
           

Working with the manipulator of copying is carried out in a similar way. The only difference is that as

a result of this operation not the original plane but its copy is moved to the specified location. In this

way any number of parallel planes can be created.
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Workplane Size and Position

Aside from using manipulators described above, size and position of workplane's rectangle in the 3D

scene can be customized using the  Change Size and Position command. It is available in

workplane's contextual menu. Upon calling the command, the view becomes normal to the workplane

and red square manipulators appear on rectangle's edges. Set the desired configuration by dragging

manipulators.

In addition to standard options for exiting the command with or without confirming changes, there

are following options available in the automenu of the  Change Size and Position command:

<W> Draw On Workplane

This option activates the mode of drawing on active workplane.

<P> Set page size

This option invokes the dialog, where you can set X and Y global coordinates of bottom left (1st

corner) and top right (2nd corner) vertices of the workplane's rectangle.
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Alternatively, you can change size and position of workplane's rectangle using the document

parameters dialog (Document Parameters > Page > Paper > Origin).

In order to access workplane parameters, use the filter and drop-down list located at the top of

the document parameters dialog.

Working with Workplanes using Rulers of 3D window

When working in the 3D window with the enabled rulers, there are additional capabilities for quick

translation and copying of workplanes.

Visibility of rulers in the 3D window can be controlled with the help of Rulers command from

the View ribbon tab, Window group. 

The rulers in the 3D window allow us to quickly estimate the sizes and distances in the 3D scene.

Coordinates shown on the rulers constitute the coordinates on the imaginary plane parallel to

the plane of the screen.

In case when the workplane is orthogonal to the plane of the current 3D view and positioned in it

vertically or horizontally, the special marker on the ruler (  or ) will show the location of such a

workplane.

The marker of the workplane is closely linked with the workplane itself. When the cursor is moved to

the sign of the marker, the color of the marker is changed to red. Moreover, the workplane itself is

highlighted. Pressing  on the sign of the marker invokes the context menu for the plane that

corresponds to the given marker.
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When the marker is selected using  , the mode of moving/copying of the workplane is activated. 

The translation of the selected plane is carried out if, after selection of the marker with the help of 

, the user moves the cursor without releasing the pressed mouse button. To fix the new location of the

workplane, it is sufficient to release the mouse button. The exact value of the translation can be

specified in the system toolbar or filter toolbar.

Creation of the new workplane – copying – takes place if, after selection of the marker with the help

of , the pressed mouse button is released. Pressing  for the second time in this case will fix the

location of already the new workplane – copy of the original plane.

By using the <Shift> and <Ctrl> keys, it is possible to select several markers at once. Translation and

copying in the case of multiple selection are carried out similarly to the selection of one marker. In the

context menu the additional commands will be available:

· Distance (available only upon selection of two markers) – this command is used for quick

modification of the distance between the workplanes. When invoking the command, the

Distance window appears in which it is necessary to indicate the required value of the

distance. After pressing OK, the system will displace the corresponding workplanes in such a

way that the distance between them becomes equal to the specified value;

· Equal Distance (available only upon selection of three or more markers) – this command

displaces the planes, which are connected with the selected markers, in such a way that the

distance between all adjacent planes becomes the same;

· Array – create an array of planes (only upon selection of two markers of planes).
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In the context menu of the ruler of the 3D window two additional commands are available –

Associative mode and Mark dimensions.

The Associative mode checkbox controls the mode of creation of workplanes with the help of tick

marks on the rulers. When this checkbox is enabled, the new workplane's position is defined relative to

the original workplane. When the checkbox is disabled, position of the new plane will be fixed in

absolute coordinates without snapping to the original workplane.

The Mark dimensions checkbox controls the display of distances between the planes. When this

checkbox is enabled, the distances of the selected workplanes between each other (if several of them

were selected) and the distances to the first and last workplanes along the given axis are shown on the

ruler as dimensions.

Grid of Workplanes

In T-FLEX CAD there is one more auxiliary tool for working with the workplanes – grid of workplanes.

The grid of workplanes – is a set of lines of intersections of all workplanes of the model. Intersections

are shown with the gray lines. Visibility of the grid is controlled with the Hide Workplanes Grid

command of the View toolbar. By default, the grid is not displayed.

The nodes of the grid of workplanes can be used for snapping, once they are selected as geometric

points in different 3D operations. In this case 3D nodes will automatically be created at the nodes of

the grid.
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Topics in this section:

· Main Concepts of Workplane

· Workplane based on LCS

· Offset Workplane

· Workplane through Flat Edge or Points

· Workplane Orthogonal to Path

· Workplane between Two Planes

· Standard Workplane

· Workplane tangent to Surface at Point

· Workplane based on 2D Projection

· Workplane Parallel to Screen

· Workplane in Coordinates

· Workplane Parameters

· Workplane Coordinate System

· Edit Workplane

Main Concepts of Workplane

A workplane is a plane oriented in space with which 2D and 3D elements of a 3D model are

associated. Depending on the type of workplane and the method of its construction, it is created in

the 2D or 3D view window.

When creating a workplane in a 3D window, its position in space is determined either by the world

coordinate system (standard workplanes), or by the elements of the 3D model. In this case, the

workplane is assigned to a separate page of the drawing.

When created in the 2D view window, the workplane snaps to the elements of the 2D drawing and

occupies an area on the current drawing page. That is, it is possible to arrange several workplanes on

one drawing page.

Using the active workplane mode, you can create 2D elements belonging to the selected workplane in

the 3D window.
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In order for the workplanes to be visually displayed/not displayed in the 3D window, it is necessary to

set/disable the Show in 3D view parameter in the parameters of each workplane when creating or

editing.

Creating Workplanes in the 3D View Window

1. Standard workplanes correspond to the six standard views used in drawing. The standard

workplanes are Front View, Back View, Top View, Bottom View, Left View, and Right View.

2. Workplanes based on solid elements (faces, vertices, edges) or 3D elements (3D nodes, 3D paths).

Using the corresponding options of the Workplane command, you can define the position of the

workplane in space using the above 3D elements.

There is a special way to create a workplane based on a body face. Point at the face with the mouse

cursor (the selected face will be highlighted) and press . In the menu that appears, select Draw on

Face. The system will automatically create a workplane based on the corresponding face. When you

select a face on which workplanes have already been created, the Draw on Workplane item will be

available from the menu, containing a list of workplanes based on this face.

3. Workplanes created from another workplane.

By selecting an existing workplane, you can position the new workplane relative to the original, either

by specifying an offset, or create a copy of it by specifying the source and target coordinate systems.

Workplane offset is determined by snapping to 3D elements or in workplane parameters. Thus, by

setting the offset, you can get a workplane parallel to the original one:

· with a given offset value;

· passing through a 3D point;

· tangent to the surface.
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Creating Workplanes in the 2D View Window

1. Standard workplanes correspond to the six standard views used in drawing. The standard wor

planes are Front View, Back View, Top View, Bottom View, Left View, and Right View.

2. Additional workplanes correspond to the arrow views used in drawing (view A-A, view E-E rotated).

Additional workplanes can only be drawn when at least one workplane is specified. When constructing

additional workplanes, only rectilinear views along the arrows are used, that is, without bends.

3. Workplanes based on 2D projection are defined based on the viewing direction in which the 2D

projection was specified. This method is very intuitive, as it allows you to use the elements of the 3D

model to define the position of the workplane. For example, you can create a 2D projection of any

face of a 3D model and define the workplane through this projection. Then you can continue 2D

construction using the face projection as the base. Thus, you can, for example, create a new 3D profile

that will be used to create a new 3D object. This 3D object will lie directly on the face that was used in

the 2D projection.

4.Workplanes based on 3D coordinate system are defined based on the position of one of the three

main planes of the local coordinate system. This method is interesting in that it quite effectively allows

you to position the workplane at any necessary point and at any angle. 

Active workplane mode

To switch to the active wor plane mode, call the context menu by pressing the right mouse button and

select the Draw on Workplane item. Then select the necessary workplane from the list of all model

workplanes. Or point with the mouse cursor to the workplane (it will be highlighted) and in the context

menu also select the corresponding menu item.

The current workplane becomes active.

Working in the active workplane mode, you can use any commands for creating 2D elements (see

Using Active Workplane). 

Object selection

At the stage of selecting objects on the basis of which the workplane will be created, an advanced

filter for selecting the type of geometry is available.
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The rest of the filters define the set of element types allowed for selection (for example, face, 3D

Profile, 3D Path, etc.).

Reverse sketch drawing side

During the creation of the workplane, yellow manipulators appear at its edges, which indicate the

drawing side of the sketch. Clicking on the manipulator reverses the direction.

Workplane based on LCS

The command can be called in one of the following ways:

Icon Ribbon
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Support Geometry > Worksurfaces > Workplane based on LCS

Keyboard Textual Menu

<3KSL>

It is also available as option in the Workplane command:

<L> Based on LCS

This command allows you to create a workplane based on the LCS.

Workplanes in a 3D coordinate system are useful when the workplane has a complex orientation angle

in space.

In this case, the orientation angle is determined in accordance with the orientation of one of the main

planes of the 3D coordinate system - XY, XZ, YZ, YX, ZX, ZY.
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In addition to selecting the appropriate plane in the parameters window, you can select it or by

hovering the mouse over the necessary plane...

... or by selecting it from the dropdown list:

Additional Parameters are described in the corresponding section.
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Sequence of creation 

1. Create the required coordinate system using the LCS command.

2. Call the command Workplane based on LCS. 

3. Select the created LCS.

4. Select Type in the dropdown list if necessary.

5. Customize additional parameters if necessary.

3. Confirm the creation of the workplane.

Offset Workplane

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > Worksurfaces > Offset Workplane

Keyboard Textual Menu

<3KSO>

It is also available as option in the Workplane command:

<1> Offset Workplane

This command allows you to create a workplane relative to an object, the geometry of which allows

the system to define the original plane and offset it by a specified value.

After selecting a 3D element, a new workplane appears in the 3D scene.

The initial position of the created workplane coincides with the position of the geometric plane

defined by the parent 3D element. An exception is the case of creating a workplane relative to

another work plane - then a small initial offset is set by default.
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The final position of the created workplane can be defined using an offset value or using a point.

Defining position of offset workplane using offset value

Offset value can be typed into the Offset: input box in the command parameters window.

If necessary, you can change the direction of the workplane offset using the  Reverse button.

The offset value can also be set directly in the 3D scene using the manipulator in the same way as

defining a translation along an LCS axis in the Transformations command.
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Defining position of offset workplane using point

In addition to the Offset: field there's also the Tangent: field in the command parameters window.

Activation of this field enables filters for selecting points, faces and planes on the Filter toolbar.

Upon selecting a point, an offset workplane is created through selected point parallel to the source

plane.

Upon selecting a plane, an offset workplane is created through selected workplane's LCS origin

parallel to the source plane.

Upon selecting a face (doesn't matter if it's flat or not) two turquoise ball manipulators appear in 3D

window. One manipulator represents the nearest point of a selected face in relation to the source

plane. Another one represents the furthest point of a selected face in relation to the source plane. You

can switch between these points using the   Change Workplane Position button in the command

parameters window or by clicking  the desired manipulator in the 3D scene. An offset workplane is

created through selected point parallel to the source plane.
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1 - Source Plane

2 - "Tangent" face

3 - Nearest point of "tangent" face

4 - Furthest point of "tangent" face

Additional Parameters

Additional Parameters tab of the offset workplane command parameters window contains the

Project Selected Face to Workplane checkbox. If it's enabled a face selected as the Source Plane will

be automatically projected onto created workplane. The rest of options on the Additional Parameters

tab are common for all types of workplane. These option are described in the Workplane Parameters

section.
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Sequence of creation 

1. Call the command.

2. Select source plane.

3. Select tangent (optional).

4. Set the offset (optional).

5. Set the workplane coordinate system (optional).

6. Customize additional parameters if necessary.

7. Confirm the creation of the workplane.

Workplane through Flat Edge or Points

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > Worksurfaces > Workplane through Flat Edge or Points

Keyboard Textual Menu

<3KSF>

It is also available as option in the Workplane command:

<3> Through Flat Edge or Points

This command allows you to create a workplane by points or a flat edge. You can select vertices,

edges, 3D nodes, LCS, etc. as points.

Based on the selected 3D point, you can create the following types of workplanes:

· through a 3D point and a flat edge;

· through two 3D points;

· through two 3D points and in the specified direction (or through two points at an angle to the

specified direction);

· through two 3D points at an angle to a plane;
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· through three 3D points.

· through a 3D point and tangent to a cylindrical or conical surface.

· through two 3D points and tangent to a conical, cylindrical or spherical surface.

The command includes two modes of workplane creation - By Points, By Tangent.

By Points Mode

To create Workplane going through a 3D point and a flat edge, select a 3D point (Points option)

and redefine the position of the workplane in space by specifying an object (Position option), the

geometry of which can define a straight line (the X axis on the WP will be directed along the selected

straight line, the Y axis is perpendicular to it and passes through the origin of the coordinate system)

or by setting two more 3D points defining the direction of the X and Y axes.

To create Workplane going through two 3D points, you need to select two 3D points (Points option).

The workplane is created as going through the axis defined by the selected 3D points. The workplane

position in the space is set arbitrarily by the system. If necessary, the workplane position can be

modified by rotating it at the specified angle relative to the original position. The angle is defined in

the command's properties window or directly in the 3D window using manipulator.
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To create Workplane going through two 3D points in the specified direction,  you need to select two

3D points (Points option) and a 3D element defining a direction (Position option). The direction can

be defined with a flat edge or 3D path, a normal to a surface, an axis of a cylindrical or conical

surface, etc.

If necessary, it is possible to define an additional rotation angle of the workplane relative to a

specified direction (in the properties window or in the 3D window using manipulator).

To create Workplane going through two 3D points at an angle to a plane, you need to select two 3D

points (Points option) and a plane (Position option). To define a plane, you can select another

workplane, a flat (planar) face, a planar edge, an LCS, etc. As in the previous cases, the angle is defined

in the properties window or in the 3D window using manipulator.
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If you set a position on a face, then the created workplane will take the shape of that face.

To create Workplane going through three 3D points, you need select three 3D points (Points

option). The X-axis of the created workplane coordinate system will be directed from the first selected

point to the second one, and the Y-axis will be perpendicular to it.

By Tangent Mode

Turquoise ball-shaped manipulators are displayed in this mode. They represent possible variants of

tangency. Select the desired variant by clicking  its manipulator. Tangent surface is highlighted in

blue in the 3D scene.

To create Workplane going through a 3D point and tangent to a conical or cylindrical surface, you

need to select 3D point (Points option) the desired surface (Tangent option). From the two tangency

possibilities, the one will be selected that is closer to the cursor position at the instant of selecting the

surface.
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1 - Selected point

2 - Selected tangency variant manipulator

3 - Alternative tangency variant manipulator

To create Workplane going through two 3D points tangent to a surface (conical, cylindrical or

spherical), you need to select two 3D points (Points option) and a surface (Tangent option). By

default the X-axis of the created workplane coordinate system will be directed from the first selected

point to the second one.

1 и 2 - Selected points
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3 - Selected tangency variant manipulator

4 - Alternative tangency variant manipulator

When selecting a conical or cylindrical tangency surface, the construction result will be defined

similarly to that of a workplane by a single 3D point with a tangency to a surface. The second

point definition could merely help define the tangency configuration.

To create Workplane going through an axis tangent to a surface (conical, cylindrical or spherical)

you need to select an axis (Points option) and a surface (Tangent option). By default the X-axis of the

created workplane coordinate system will coincide with direction of selected axis..

1 - Selected axis

2 - Selected tangency variant manipulator

3 - Alternative tangency variant manipulator

Additional Parameters are described in the corresponding section.

Sequence of creation 

1. Call the command Workplane through Flat Edge or Points.

2. Select type By Points or By Tangent.

3. Specify points.

4. Specify position/tangent (optional)

5. Set the workplane coordinate system (optional).

6. Customize additional parameters if necessary.

7. Confirm the creation of the workplane.
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Workplane Orthogonal to Path

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > Worksurfaces > Workplane Orthogonal to Path

Keyboard Textual Menu

<3KSP>

It is also available as option in the Workplane command:

<7> Orthogonal to Path

This command allows you to create a workplane orthogonal to the selected path.

After you select the path, the system will create a workplane at the selected point on the path. The

position of this point is determined by the Offset coordinate.

One of the two possible principles of the Offset coordinate calculation can be selected in the

Coordinates Type dropdown list:

· By Offset. For this type, the units of length must be considered.

· Parametric. For this type, the value has a unitless form (fraction of the length) from 0 to 1.
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The system also provides the ability to select the Base point of the Offset coordinate:

· Start. In this case, the base point is the start point of the original object.

· Middle. In this case, the base point is the middle point of the original object.

· End. In this case, the base point is the end point of the original object.

The offset can be set both using the command parameters window and using the manipulator in

the 3D scene.

It is possible to select a reference Point. 

If a reference point lies geometrically on the path, such point becomes a base point.

If a reference point does not geometrically lie on the path, then the nearest point of the path in

relation to the reference point becomes a base point.
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You can also set the Normal Direction of the generated workplane.

Additional Parameters are described in the corresponding section.

Sequence of creation 

1. Call the command Workplane Orthogonal to Path.

2. Select an edge or path that the workplane will be perpendicular to.

3. Specify a 3D point through which the workplane will pass (optional).

4. Set the coordinate type, base point and offset (optional).

5. Set the workplane coordinate system (optional).

6. Customize additional parameters if necessary.

7. Confirm the creation of the workplane.
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Workplane between Two Planes

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > Worksurfaces > Workplane between two planes

Keyboard Textual Menu

<3KSS>

It is also available as option in the Workplane command:

<E> Between Two Planes

This command allows you to create a workplane between two planes or faces.

The result depends on whether selected planes/faces are parallel to each other and on the Factor

value. Default Factor is 0.5. Factor value can be changed in the command parameters window or in

the 3D scene using the manipulator.

Parallel planes 

If original planes are parallel, resulting plane is also parallel to them. Distance between first original

plane and resulting plane is equal to distance between original planes multiplied by Factor. Positive

values are applied in direction from first original plane to second; negative - in reverse. Factor's sign

can be changed using the  Reverse button.

Therefore:

If Factor value is equal to zero, resulting plane coincides with first original plane.

If Factor value is equal to one, resulting plane coincides with second original plane.

If Factor value lies between zero and one, resulting plane splits distance between original planes in

proportion corresponding to factor.

If Factor value is less than zero, resulting plane lies by the same side of both original planes. Distance

between resulting plane and nearest (first) original plane is equal to distance between original planes

multiplied by Factor's absolute value.

If Factor value is higher than one, resulting plane lies by the same side of both original planes.

Distance between resulting plane and nearest (second) original plane is equal to distance between

original planes multiplied by difference between Factor and one.

After selecting two parallel planes it is becomes possible to select Point.

Selecting a point affects position of resulting plane in the following way. A plane parallel to original

planes is created through selected point and then being offset using distance between original planes

multiplied by Factor. 
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Non-parallel planes

If original planes are not parallel, angle between first original plane and resulting plane is equal to

angle between original planes multiplied by Factor.

By default positive values are applied in direction of the shortest turn from first original plane to

second; negative - in reverse. Directions of positive and negative values can be swapped using the 

 Reverse button. Unlike parallel planes mode, using the Reverse button doesn't affect Factor's sign.

Additional Parameters are described in the corresponding section.

Sequence of creation 

1. Call the command Workplane between Two Planes.

2. Select first plane.

3. Select second plane.

4. Select point (optional).

5. Set the factor (optional).

6. Set the workplane coordinate system (optional).

7. Customize additional parameters if necessary.

8. Confirm the creation of the workplane.

Workplane Tangent to Surface at Point

The command can be called in one of the following ways:

Icon Ribbon
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Support Geometry > Worksurfaces > Workplane Tangent to Surface at Point

Keyboard Textual Menu

<3KST>

It is also available as option in the Workplane command:

<8> Tangent to Surface at Point

This command allows you to create a workplane tangent to the selected surface at point.

The first step in creating a workplane in this way is to select a surface. Then you need to specify a 3D

point, the projection of which to the selected surface will set the position of the tangency point of the

created workplane (projection occurs at the smallest distance to it). When selecting a closed surface,

you can use one of two projections: to the near side or to the far side of a surface. In this case

projections are represented by two turquoise balls manipulators. Select the desired projection by

clicking  its manipulator.  

1 - Surface

2 - Point

3 - Selected projection of the point

4 - Alternative projection of the point
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Additional Parameters are described in the corresponding section.

Sequence of creation 

1. Call the command Workplane Tangent to Surface at Point.

2. Select a face that the workplane will be tangent to.

3. Select the 3D point, the projection of which will determine the position of the tangency point.

4. Set the workplane coordinate system (optional).

5. Customize additional parameters if necessary.

6. Confirm the creation of the workplane.

Standard Workplane

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > Worksurfaces > Standard Workplane

Keyboard Textual Menu

<3DS>

It is also available as option in the Workplane command:

<S> Standard Workplane

This command allows you to create a standard workplane or a set of workplanes from a 2D drawing

or in a 3D window. Using the buttons in the parameters window, you can switch between the

corresponding modes for creating standard workplanes. The required mode must be set before

selecting a specific view of standard workplane.

Creating standard workplane in 3D window

To create a standard workplane, you need to select its view - Front, Back, Top, Bottom, Left, Right,

Front and Top, Front and Left, or Three Standard Views.

After selecting a view, a preview of the created workplane will automatically appear in the 3D scene. 
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By default the position of the workplane is determined by the global coordinate system. Alternatively

you can change position using Link with 3D Node. Then the workplane's origin coincides with selected

node.

Confirm the workplane creation by clicking the  button.

Editing standard workplane in 3D window

Click  on an existing workplane and select the Edit option in the contextual menu.

The Parameters window will contain options for establishing a projection link between the selected

workplane and other elements of the model.

The system will offer to select a 2D node (Fixing point option) belonging to the image located on the

new workplane, which will be the origin point of this view. Fixing point selected in 2D window is the

projection of 3D node selected in 3D window for the Link with 3D Node option. If Link with 3D node

is not defined, the fixing point is the projection of the global coordinate system origin. After selecting

a 2D node as a fixing point, the system will automatically select the same node as the First Corner of

the border.



3D Constructs. Support Geometry.

1099

If this is not necessary, then you can reset the selection of the first corner of the border:
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If necessary, you can change or define the Link with 3D Node option.
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You can also redefine the boundaries of the new standard workplane by selecting two 2D nodes

(First/Second Corner options). By default, the boundaries of the workplane are determined by the 2D

node selected in the first step and the closest corner point of the drawing boundaries (Front View -

top left, Bottom View - bottom left, Left View - top right).

If only the 2D node defining the first corner of the border is selected, you can change the

direction of the border of the workplane using the  Switch Workplane Borders button. When

the button is pressed, the border will change its direction clockwise from the node.

Workplane boundaries can be used to select a workplane when constructing 3D elements and to

determine whether 2D elements belong to a specific workplane.
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Press  to confirm the creation of a new standard workplane. If the 3D node is not selected, the

system will consider the 2D node selected at the first step as the projection of the origin point (0, 0, 0).

ANSI or ISO standard selected in the System Options 3D tab only affects the set of workplanes.

Creating workplane from a 2D drawing

To create a standard work plane, you need to select its view - Front, Back, Top, Bottom, Left, Right,

Front and Top or Front and Left.

For 2D drawing, you can create either one standard workplane view or two views at the same time

(front and top or front and left).

If one workplane is created in the 2D drawing window, and there are no other workplanes on the

current drawing page, then the workplane will occupy the entire working area of the drawing and the

system will offer to establish a projection link between the new standard workplane and the already

created workplanes, i.e. select a Fixing Point, set Link with 3D Node and select the First and Second

Corners of the border in the same way as for editing a ready-made workplane (see Editing standard

workplane in 3D window).
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If two workplanes are created in the 2D view window, the system will offer to select a 2D node as the

Origin of workplane's LCS.

In this case, the result will look like this:
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As you can see above, when you create two workplanes in the 2D window, they will be located

on the same drawing page. In this case, they cannot be used in active workplane mode.

Additional Parameters are described in the corresponding section.

Sequence of creation 

1. Call the command Standard Workplane.

2. Select the view in which you will create the workplane - Standard WP on 2D drawing or Standard

WP in 3D window.

3. If you have selected the mode of creating WP in 3D window, then you need to select the desired

views and, optionally, Link with 3D Node.

    If you have selected the mode of creating WP on 2D drawing, then you need to select the desired

views, define the fixing point and, optionally, Link with 3D Node and Corners of the border

4. Customize additional parameters if necessary.

5. Confirm the creation of the workplane.

Workplane based on 2D Projection

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > Worksurfaces > Workplane based on 2D Projection

Keyboard Textual Menu
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<3KSJ>

It is also available as option in the Workplane command:

<J> Based on 2D Projection

This command allows you to create a workplane based on an existing 2D projection.

When creating a 2D projection, the projection plane is selected. When creating a workplane based on

a 2D projection, its position in space is set by the projection plane of the selected surface (face,

section, etc.)

The general scheme for creating work planes from a 2D projection is as follows. 

First, the required 2D projection is created using the 2D Projection command. You can project the

entire body, or a face, or other features.

Then, in the command for creating workplanes, the created 2D projection is simply selected.
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When using a 2D projection workplane, the elements (3D profiles, 3D paths, 3D nodes) defined on the

basis of this workplane will be positioned in accordance with the position of the elements that were

projected. It should be noted that the position of the workplane relative to the body will depend on

how the 2D projection was set. If the projection direction was specified from a face, then the

workplane will lie on this face. If the projection direction was specified by a section, then the

workplane will be located in the plane of this section.

You can customize First and Second Corner of the border in the same way as described for Standard

Workplane.

Additional Parameters are described in the corresponding section.

Sequence of creation 

1. Create a 2D Projection from which the workplane will be created.

2. Call the command Workplane based on 2D Projection.

3. Select 2D Projection.

4. Set First and Second Corner of the border of the new workplane (optional).

5. Customize additional parameters if necessary.

6. Confirm the creation of the workplane.

Workplane Parallel to Screen

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > Worksurfaces > Workplane Parallel to Screen

Keyboard Textual Menu

<3KSV>

It is also available as option in the Workplane command:
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<9> Parallel to Screen

This command allows you to create a workplane parallel to the current view point.

While the command is running, you can change the viewpoint at any time by clicking the Rebuild

button.

By default workplane is created through the global coordinate system origin. You can select another

Point instead.

It is also possible to define an Offset from selected point or from global CS origin. Offset's direction

can be switched using the  Reverse button.

No matter if a point is selected or not in the General Parameters of command, by default the

workplane's LCS origin is located in the projection of global LCS origin onto this workplane. Axes are

oriented by the screen (X - horizontally right, Y - vertically up). You can customize the workplane

coordinate system if necessary.

Additional Parameters are described in the corresponding section.

Sequence of creation 

1. Call the command Workplane Parallel to Screen.

2. Set the desired viewpoint and click the Rebuild button (optional).

3. Specify point and offset (optional).

4. Set the workplane coordinate system (optional).

5. Customize additional parameters if necessary.

6. Confirm the creation of the workplane.

Workplane in Coordinates

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > Worksurfaces > Workplane in Coordinates

Keyboard Textual Menu

<3KSM>

It is also available as option in the Workplane command:
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<2> In Coordinates

This command allows you to create a workplane in X, Y, Z coordinates.

Upon calling the command, LCS manipulators appear in the 3D scene and following options appear in

the automenu:

<A> Rotate LCS around X axis by 90°

<O> Rotate LCS around Y axis by 90°

<Z> Rotate LCS around Z axis by 90°

<8> Change LCS axes orientation

Use manipulators and automenu options in the same way as described for the Transformations

command.

You can also type coordinates into X:, Y:, Z: input boxes on the General Parameters tab of the

command parameters window.

Additional Parameters are described in the corresponding section.

Sequence of creation 

1. Call the command Workplane in Coordinates.

2. Specify coordinates.

3. Set the workplane coordinate system (optional).

Keep in mind, that workplane CS origin in this command doesn't coincide with projection of

selected Origin Point. It is offset from projection by coordinates set in General Parameters.

4. Customize additional parameters if necessary.

5. Confirm the creation of the workplane.

Workplane Parameters

Additional Parameters of workplane

When creating workplanes, the Parameters window always contain the Additional Parameters tab. It

contains same parameters for all workplane types with a few exceptions. Parameters common for all

workplane types are described below. Workplane type specific parameters are described in sections

describing the particular type.

Name. You can type in a custom name for a workplane or leave default name unchanged. Detailed

information about default names can be found in the Names Customization for 3D Elements chapter.

Scale. Defines scaling of elements created when drawing on this workplane. E.g.: "5" value means

scale 1:5; "0.5" value means scale 2:1.

External. Enabling this checkbox allows displaying of a workplane in assemblies when inserting the

current file as a fragment.

Show in 3D View. This checkbox controls the display of the workplane in the 3D view.

Show 2D Annotations on 3D View. Enabling this checkbox makes drawing annotation (detailing)

elements (dimensions, symbols, texts etc.) that were drawn on that workplane visible in the 3D window

outside drawing on workplane mode. So you can edit them without entering the drawing on

workplane mode.
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Show all 2D elements in 3D view. When the checkbox is enabled, all hatches, graphic lines and other

elements of the 2D drawing are displayed in the 3D scene. 

Show intersection lines with workplanes. When the checkbox is enabled, not only workplane

boundaries but also intersection lines with the other model workplanes will be shown.

Intersection lines can be used as a reference for creating graphic lines.

Three checkboxes mentioned above are also available in workplane's contextual menu.

Show Coordinate System. This checkbox controls the display of the workplane's own coordinate

system on its rectangle in the 3D scene. By default, this checkbox is disabled, i.e., the coordinate

system is not displayed.
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Do not delete in "Purge" command. When the checkbox is enabled the workplane will not be

deleted, even if it is not used for the operations creation.

Transparency. This parameter allows a user to control the transparency level for the workplane's

rectangle in the 3D window.

Name Font Size. Size of font in which name of workplane is displayed in left upper corner of its

rectangle in 2D and 3D windows.

Existing workplane parameters dialog

Parameters in Transformations and Mate Transformations tabs as well as some of parameters in the

Workplane tab and Set as default checkbox work in the same way for all 3D construction types.

Detailed information about such parameters can be found in the General Parameters of 3D Elements

section. 

The Workplane tab of the parameters dialog also contains same parameters as the Additional

Parameters tab of the command Parameters window when creating a new workplane. Such

parameters are described above.

The Type dropdown list is present in parameters dialog for all types of workplanes. However it can be

edited for standard workplane and workplane based on LCS. There you can change orientation of

workplane in relation to custom or global CS. E.g.: change Left view to Right view or XY to XZ. 

Parameters dialog for some types of workplanes may also contain type-specific parameters:

· Offset by Normal

Available for offset workplane. Represents Offset from Source Plane.

· Angle

Available for workplane through flat edge or points if it uses an angle.

· Factor

Available for workplane between two planes.
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Workplane Coordinate System

For many types of workplanes, the definition of a workplane coordinate system is available.

Two types of CS are available in the Workplane Coordinate System tab of the Parameters window:

Custom CS

Global CS

Global CS

Using this option makes workplane LCS origin position and axes orientation depend on the projection

of global CS onto such workplane.

For workplane parallel to screen axes orientation coincide with screen CS  (X - horizontally right,

Y - vertically up).

The rest of controls in the Workplane Coordinate System tab become inactive upon selecting global

CS.

Custom CS

This option allows you to specify 3D points, the projections of which on the created workplane will

determine the position and orientation of the axes of the workplane coordinate system.

Using the Origin Point option, a 3D point is selected, the projection of which onto the workplane will

be the new origin point.

The option Point that Defines X Direction allows you to select a 3D point, the projection of which

onto the workplane will set the direction of the X axis of its system.
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Reverse the workplane

In addition to LCS controls the Workplane Coordinate System tab of the Parameters window also

contains the  Reverse button. It switches a normal direction of a workplane to an opposite one.

Edit Workplane

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3EW> Edit > Construct > Workplane

This command is used for editing Workplane.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity
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<X> Exit command

<M> Transformation

In addition to selection options mentioned above (select all, select by name) it is possible to select a

workplane for editing using mouse in 2D or 3D window (if Show in 3D view checkbox is enabled in

the workplane parameters).

Upon selecting an element, you can delete it, edit its parameters using the <P> option, select other

nearest element, edit or change definition. Editing and changing definition open the Workplane

command. The difference between them is that changing the definition resets command parameters

to defaults.

Worksurface

Calling the command:

Icon Ribbon

3D Model > Construct > Worksurface

Draw > 3D Model > Worksurface

Assembly > Construct > Worksurface

Sheet Metal > Construct > Worksurface

Surface > Construct > Worksurface

Weld > Construct > Worksurface

Primitives > Construct > Worksurface

Support Geometry > Worksurfaces > Worksurface

Keyboard Textual Menu

<3SU> Construct > Worksurface

Worksurfaces are auxiliary 3D elements that represent geometrical surfaces of certain type. A cylinder,

sphere or torus can be used as such surfaces. The functional purpose of worksurfaces is similar to that

of workplanes. Generally, those are intended for carrying 2D objects over to the 3D space. Each

worksurface is always related with a parametric region on a page of a 2D drawing. Auxiliary 3D

elements, such as 3D nodes, 3D profiles and 3D paths, can be created based on a flat 2D image

located on this page. Those elements will be placed on the respective worksurface – a cylinder, sphere

or torus. 

The main purpose of worksurfaces is creation of auxiliary objects (3D profiles, 3D paths, 3D nodes) for

creating parts whose surfaces are curved in two directions: turbine blades, boat propellers, ship hulls,

aircraft fuselages.
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Topics in this section:

· Main Concepts of Worksurface

· Parametric Region

· Methods of Creating Worksurfaces

· Worksurface Parameters

· Edit Worksurface

· Example of Worksurface Creation

Main Concepts of Worksurface

Worksurfaces are defined parametrically in the special coordinate systems:

· cylindrical;

· spherical;

· toroidal (ring-shaped).

The parametric coordinates are always counted with respect to an orthogonal (Cartesian) coordinate

system. (The meaning and the range of the coordinates depend on the surface type.) The particular

Cartesian system can be either the world coordinate system, or a specifically selected local coordinate

system (LCS). 

The position of a point in the cylindrical coordinates is defined by three parameters: the radius of the

cylinder, the shift along the cylinder axis (Z-axis) and the angle (or the arc length) between X-axis and

the radius-vector of the point projection onto the X-Y plane.

The position of a point in the spherical coordinates is defined by three parameters: the radius of the

sphere, the angle between X-axis and the radius-vector of the point projection onto the X-Y plane,

and the angle between the point radius vector and Z-axis.

The position of a point in the toroidal coordinates is defined by four parameters: the two defining

radii of the torus, the angle between X-axis and the point projection on the X-Y plane and the angle

between the point radius vector and Z-axis direction.
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The parameters defining the radius of the cylinder, that of the sphere or the two torus radii are called

fixed, as those are the same for all points belonging to one surface. This is a constant characteristic of

the given surface. The cylinder and the sphere have one fixed parameter – the radius, while the torus –

two (the two torus radii). 

Therefore, the position of a point belonging to a surface of any type is actually defined in a special

coordinate system by two orthogonal parameters – the coordinates (U and V). Due to this fact, a

mapping can be established between any of the special coordinate systems and a rectangular region

on a plane (a parametric 2D region). This 2D region represents an "unfolding" of the surface onto the

plane (according to the rules of mapping the UV-coordinates into the Cartesian coordinates for the

selected type of surface), playing the same role as the image of the workplane on a page of a 2D

drawing. Besides, the 2D region defines the range of the UV-coordinates.

Introducing a parametric 2D region allows working with a surface as if with a common workplane.
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Spherical coordinates

Graphic  Illustration Parametric 2D region Profile in 3D 

U – angle from X-axis (0-2p) V – angle from Z-

axis (0-p) R – radius of the sphere

Cylindrical coordinates

Graphic  Illustration Parametric 2D region Profile in 3D 

U – angle from X-axis (0-2p) or arc length
counted from X-axis (0-2pR) 
V - Z-coordinate (-Ґ,+Ґ) 
R – radius of the cylinder

Toroidal coordinates

Graphic  Illustration Parametric 2D region Profile in 3D 

  

U – angle from X-axis (0-2p) V – angle from

the vector R in the plane ZOR (-p,+p) R – torus

major radius, r – torus minor radius

Data required for creating a worksurface 
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When creating a worksurface of any type, you need to define:

· The parametric 2D region (a rectangular region in the 2D drawing) – the unfolding onto a

plane of the surface being created;

· The fixed parameter value for this surface (the radius of the sphere or cylinder, or the two

torus radii);

· The original Cartesian coordinate system (the world coordinate system or an arbitrary LCS),

with respect to which the parametric surface coordinates are defined.

Worksurface Representation in 3D View

It is possible to control the visibility of the working surface by the special flag “Show in 3D View”

available in parameters dialog box when creating/editing a worksurface. By default this flag is turned

on, that is to display the worksurface in 3D view. When flag is turned off the worksurface will be not

shown in 3D view.

Parametric Region

The parametric 2D region of a worksurface is defined on one of 2D pages of the current document.

The size and position of the parametric region in the drawing units is defined either by the system

automatically or by the user (by specifying two 2D nodes as the diagonal corners of the region). The

size of this region in the parametric coordinates is always constant, depending on the type of the

surface being created (entered as the "ranges" in the table above). The region extents along the Х-axis

are mapped onto the allowed range of the parameter U, along the Y-axis – onto V (the reverse

configuration is also supported). 

In the cases when the position and size of the parametric region are defined by the user (by selecting

two 2D nodes), the direction of the worksurface axes is determined by the nodes selection order and

position. The diagrams below show the configurations of the UV-axes directions with respect to the

order of node selection. 

          

When the parametric 2D region of the worksurface is defined automatically, the axes are always

directed as shown on the right-hand-side figure.

In spherical and toroidal coordinate systems, both parameter axes represent angular coordinate

values. The exception is the cylindrical coordinate system. Since a cylinder can be "unwrapped" onto a
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plane without distortions, linear units can be used as cylindrical coordinates. The V-axis units are

always linear, while the units of the U-axis can be either angular (the angle between the radius vector

and X-axis) or linear (U being the linear distance as measured along the cylinder unfolding). 

When using linear units along the U-axis of the cylindrical coordinates, the second 2D node defines

only the axes orientation. The size of the parametric region along the U-axis in this case is equal to

2pR, where R is the cylinder radius. The diagram below shows the way of defining the parametric

region for a cylindrical surface, when linear units are used in both axes. 

When using angular units along the U-axis in cylindrical coordinates, both nodes are used. The linear

distance between the two nodes along the U-axis is considered equal to the angular value of 2p. The

linear coordinates in this direction will be converted into the angular ones based on this constant.

The choice of units along the U-axis – linear or angular – depends on a particular task. If the 2D

construction to be carried over on a cylindrical worksurface is described in linear units, then it may be

more convenient to use linear units along the both axes of the cylindrical coordinates. In this case, the

2D construction will be carried over to the 3D space preserving all relations between the construction

elements. Use of angular units in such a situation will cause distortions in the transition from 2D to 3D.

As in illustration, consider a simple example of creating a 3D profile on a cylindrical worksurface using

a 2D hatch of square shape. One can easily see that the profile shape is far from square when using

the angular units along the U-axis. Meanwhile, when using the linear units, the 3D profile matches the

shape of the hatch. 
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Use of the angular units along the U-axis of the cylindrical coordinate system makes sense only in the

cases when the original 2D constructions are described using angular values. For instance, in the

following example, the original 2D data for creating a model of a heat exchanger are defined in the

angular values on the surface of a cylinder. Use of angular units helps easily getting the desired result

(provided that the boundaries of the parametric region of the worksurface were defined correctly). 

To be comfortable when working with angular units, use the following rule. The distance

between the 2D nodes along the U-axis must be set so that the total width of the parametric

region along the U-axis (that is, the respective distance between the nodes defining its

boundary) is a multiple of 360 (in degrees), or 2p (when using radians). 

When working with worksurfaces of any type, keep in mind the following. Any of the worksurfaces are

periodic in one or both UV-parameters. Therefore, a parametric surface has cycles in the direction in

which it is periodic. The diagram below shows periodicity of a parametric 2D region for spherical and

toroidal surfaces. 
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In the case of a cylindrical surface, the parametric 2D region cycles only along the U-axis. 

The Fixed Parameter and the Cartesian Coordinate System of the Worksurface

A fixed parameter value (two parameters – in the torus case) is defined with a numerical value. When

creating a worksurface by an existing geometrical surface, the fixed parameter value is determined by

the specified offset along the radius of the source geometrical surface.

The position of the worksurface in space is defined by selecting a Cartesian coordinate system. The

parametric coordinates will be counted with respect to the system. An arbitrary LCS can be selected as

such a system. If no local coordinate system is specified, the world coordinates are used.
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When constructing a worksurface by an existing geometrical surface, the coordinate system of the

source geometrical surface is used as the Cartesian coordinate system.

Methods of Creating Worksurfaces

There are three methods to create a worksurface:

1. Creating a worksurface by an existing geometrical surface of the respective type (a surface

underlying a face, 3D profile, another worksurface). This method was used in the aboveDescribed

examples.

2. Creating an arbitrary worksurface (that is, without being based on existing geometrical surfaces in

the 3D model) in the 3D window. 

3. Creating an arbitrary worksurface based on 2D constructions (in the 2D window).

Worksurface based on existing geometrical surface

Worksurface creation by an existing geometrical surface is performed in the 3D window. To define the

source data, select a 3D object related to the intended geometrical surface. As a result, a worksurface

is created that coincides with the source geometrical surface.

        

Additionally, you can specify an offset amount (two offsets for a torus), which defines the difference

between the source and target surface radii. In this case, a worksurface will be created as an

equidistant (offset) to the source geometrical surface.
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The source geometrical surface coordinate system is used as the Cartesian coordinate system for the

created worksurface. The coordinate system position for the worksurface being created can be

adjusted by selecting an additional 3D point. The point will determine the worksurface coordinate

system origin (that is, the X-axis direction of the Cartesian coordinate system). Two 3D points are

defined for a spherical worksurface – first determining the X-axis direction, and the second adjusting

the Z direction (and, therefore, the Y-axis).

               

A separate 2D page of the “Workplane” type is automatically created for a constructed worksurface.

The page's format frame size is determined automatically by the size of the 3D object that was used

to define the source geometrical surface. The parametric 2D region of the worksurface is also created

automatically. Its size is equal to the size of the page format frame.

The created worksurface is by default displayed in the 3D window.

Arbitrary Worksurface

An arbitrary worksurface is also created in the 3D window. To create a worksurface by this method,

you need to specify the type and the radius (two radii for a torus) of the surface being created. 

Additionally, you can specify an LCS, relative to which the parametric coordinates of the worksurface

will be counted.
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As in the previous method, a separate 2D page of the “Workplane” type is automatically created for

such worksurface. The dimensions of the page format frame and the parametric 2D region

worksurface are automatically determined by the system.

Worksurfaces of this type are also displayed in the 3D window by default.

Worksurface based on 2D constructions (in 2D window)

Creation of a worksurface of this type is done in the 2D window, on an already existing drawing page

of any type. To create the surface, you need to define the boundaries (two diagonal corners) of its

parametric 2D region. The region boundaries are defined using two 2D nodes. The position and the

order of selecting the 2D nodes determine the direction of parametric axes of the worksurface.

Besides that, the radius is to be defined (two radii for a torus) of the surface being created.

Additionally, you can specify an LCS, relative to which the parametric coordinates of the worksurface

will be counted.

A worksurface of this type can be created on a 2D page that is already related with other worksurfaces

or planes. In this case, the boundaries of the parametric 2D region are used by the system to

automatically match the 2D elements found on this page, with the respective worksurface/plane

(when creating 3D elements – 3D profiles, 3D paths).

If several worksurfaces/planes are related to a 2D drawing page, those cannot be activated.

Rules of creating worksurfaces

Upon calling the command, the following options are available in the automenu: 

<S> Select Face

<1> Spherical coordinate system

<2> Cylindrical coordinate system

<3> Ring-shaped coordinate system

The first option –  – serves to construct a worksurface by an existing geometrical surface. 

The other three options – ,  and  – are used to construct either an arbitrary worksurface in

the 3D window or a worksurface based on 2D constructions (in the 2D window). How a worksurface

will be created depends on where the command call originated – from the 3D window or from the 2D

window.

These options are also available as separate commands:
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Icon Ribbon

Support Geometry > Worksurfaces > Spherical Surface

Keyboard Textual Menu

<3SV>

Icon Ribbon

Support Geometry > Worksurfaces > Cylindrical Surface

Keyboard Textual Menu

<3SB>

Icon Ribbon

Support Geometry > Worksurfaces > Toroidal Surface

Keyboard Textual Menu

<3SN>

Creating worksurface by an existing geometrical surface

To create a worksurface by an existing geometrical surface, use the option . It is turned On by

default. With the option enabled, select a 3D object in the 3D window or in the model tree, suitable to

define a surface of the cylindrical, spherical or toroidal type. This could be a face of the respective

type, a 3D profile, or an existing worksurface.

After selecting the source 3D object, the system will automatically determine what-type worksurface

will be created. The command's properties window will have the dialog to define parameters of the

given worksurface. Depending on the type of the created worksurface, you can define the values of

one or two offsets in the properties window. The offsets determine the difference between the radius

of the source geometrical surface and the radius of the worksurface being created.

Original direction of worksurface coordinate axes corresponds to direction of the parent surface.

Reverse Direction flag in the Properties dialog box will reverse direction of both axes.
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Additionally, the option is available in the automenu to select a 3D point defining the worksurface

coordinate origin:

<1> Select starting point

<2> Select Pole point

<D> Cancel selection of points setting surface orientation

Creating an arbitrary worksurface (in the 3D window)

To create a worksurface of this type, you must call the command Construct Worksurface from the 3D

window. After entering the command, you need to specify the type of the surface being created, by

selecting the desired automenu option ( ,  and ). 

After selecting the surface type, the command will go into the mode of creating the worksurface of

the selected type. Define the radius of the surface being created in the command's properties window

(two radii for a torus). The surface creation can be completed right after defining the radius (radii), by

clicking  (in the automenu or in the command's properties window).

To define an LCS, relative to which the parametric coordinates of the worksurface will be counted, use

the option:

<L> Select target LCS

The option to cancel a local coordinate system selection is:
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<D> Eliminate target LCS

The system will automatically define the parametric 2D region of the worksurface being created (on a

separate drawing page of the Workplane type). If necessary, you can manually define the boundaries

of the parametric 2D region of the worksurface being created, using the nodes on the same or another

2D page. To do that, use the same options as when creating a worksurface based on 2D constructions.

Creating an arbitrary worksurface based on 2D constructions (in the 2D window)

To create a worksurface of this type, you need to call the Construct Worksurface command from the

2D window. Upon entering the command, just like in the previous case, you need to specify the type of

the surface being created (the option ,  and ). 

After that, you need to define the parametric 2D region of the worksurface being created. If there are

no worksurfaces or planes on the current 2D page, then the system will select the region boundaries

automatically according to the page format frame size. If, on the other hand, the current drawing

page is already related with worksurfaces or planes, or if you are not satisfied with the system choice,

define the boundaries of the parametric 2D region by selecting two 2D nodes with the options:

<N> Select Node as origin of parametric region

<N> Select Node as second border of parametric region

The start and end points should not coincide. Otherwise, it will be impossible to determine the

orientation of the U and V axes.

By default, the range along the Х-axis of the parametric region is mapped onto the range of U

parameter, the Y-axis – onto V. This can be changed by the option:

<3> Shift coordinate axes

The fixed parameter value of the worksurface being created (the surface radius) is defined in the

command's properties window.

If the worksurface is to be created relative to a local coordinate system, then you need to use the

option:

<L> Select target LCS

To cancel a local coordinate system selection, use the option:

<D> Eliminate target LCS

The visible boundaries of a worksurface on the drawing are by default aligned with the defined

boundaries of the parametric 2D region. The visible boundaries can be modified with the options:

<B> Define Workplane borders

<Tab> Switch Workplane borders
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<K> Eliminate borders

These options work in the same way as those provided for common workplanes.

By default, a created worksurface of this type will not be displayed in the 3D scene. To make it appear

in the 3D window, enable the Show on 3D View flag in the command's properties window.

You can finalize worksurface creation by clicking  (in the automenu or in the command's

properties window).

Worksurface Parameters

System-wide parameters

Layer. Sets the name of the layer that the plane belongs to.

Color. Sets the color of the work plane. Use this color to draw a rectangle that marks the visual

boundaries of the work plane.

Level. Sets the visibility level value.

Parameters common to 3D elements

Name. For special work surfaces, depending on their type, the following names are created by default:

Sphere_0, Cylinder_1, Tor_0, and so on..

Special parameter

Radius. Value of a fixed parameter. This value can be taken as the radius of the selected circle, or set

to a specific value. If a circle is selected, the value of the radius of this circle is displayed in the field

and it is not editable.

Units. It can take two values: Angular and Linear.

Type. Sets the type of coordinate system:

· Spherical.

· Cylindrical.

· Toroidal.

Radius of the torus (used for a toroidal system). Sets the value of the second fixed parameter (small

radius). This value can be taken as the radius of the selected circle, or set to a specific value. If a circle

is selected, the value of the radius of this circle is displayed in the field and it is not editable.

Show in 3D view. This flag allows you to control the display mode of the created surface in the 3D

view window.

Вefault. This set of parameters will be set for subsequent surfaces to be created.

Edit Worksurface

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3ESU> Edit > Construct > Worksurface

This command is used for editing Worksurface.

Available option:
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<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the "3D node" command.

If you select multiple items, you can delete them. Note that the <Shift>  combination can be used

for multiple selection (the <Ctrl>  combination cancels the selection).

You can also call this edit command using one of the following methods:

· When the system is in standby mode, move the cursor to the 3D element in the 3D window

and click the right mouse button. Next, select Edit from the menu that appears, and then the

3D element editing command will be called. 

· When the system is in command standby mode, you can select an item in the operations tree

in the 3D model Structure window and right-click. Next, select Edit from the menu that

appears, and then the 3D element editing command will be called.

Example of Worksurface Creation

Example 1

To understand how worksurfaces are created and used, let's review a brief example. Suppose, we need

to wrap a text on a cylindrical body face. 

To create a worksurface, call the Worksurface command and select cylindrical face of the source body

in the 3D window.
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The command's properties window displays the parameters of the surface being created. Those do

not need to be changed. 

The Offset parameter defines the difference between the source face radius and that of the surface

being created. The required “0” value is already set by default. 

The Units parameter defines, what units will be applied along the U-axis. The default setting Linear

should also be left unchanged.

To create the worksurface, just click . As a result, a cylindrical worksurface will be created, which

coincides in the radius and position in the space with the source face, or, rather, with its geometrical

surface.

By now the worksurface is created. Now we need to create the 3D profile-text on it. To do that, select

the created surface and call its context menu by right-clicking . In the menu select the command

Draw On Workplane. A separate window will open with the 2D drawing page, corresponding to the

selected worksurface. 
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A box will be marking the parametric 2D region of a worksurface on the page. Let's create the

required text on the 2D page. Finish drawing on the active worksurface. Upon leaving the mode of

drawing on the active worksurface, a 3D Profile will be automatically created based on the 2D text.

What is left is to extrude the 3D profile to the required height and perform a Boolean addition of the

resulting text and the source cylinder.

Example 2

Let's see another example. In it, we need to apply a text on a cylindrical-shape plate while maintaining

a specified offset distance from the plate borders. 
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In this example, two worksurfaces will be used. We will construct the first one by the cylindrical face of

the source body. On it, let's create the 3D profile of the plate contour. We will construct the second

worksurface by the outer face of the plate. The 3D profile-text will be created on the latter

worksurface.

The difference of this example from the previous one is that in this case we need to know how

precisely the worksurfaces and their source faces are positioned relative to each other. Otherwise, it

will be impossible to precisely position the plate on the cylindrical body, and the text – on the plate.

To precisely position the worksurface, one can use an additional 3D point. The surface coordinate

origin will be placed at that point. Let's create a 3D node on the face of the source body where the

lower-left corner of the plate shall be positioned. 

Next, as in the previous example, you need to call the Worksurface command and create a surface

based on a cylindrical face.

The parameters of the created worksurface, set by default, will not be changed again. But before

confirming the creation of the surface, we will include the option in the auto menu:
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<1> Select starting point

Using this option, we will select the 3D node created earlier. 

The surface coordinate origin will be positioned where the node projects (maps) on the surface. After

selecting the 3D node, the worksurface creation can be finalized by clicking . After that we will

select the worksurface and call from its context menu the command Draw On Workplane. As in the

previous example, after calling the command, a separate window will open with the 2D drawing page

corresponding to the selected worksurface. A box on the page will be marking the parametric 2D

region of the worksurface. The worksurface coordinate origin (the lower-left corner of the box)

corresponds to the 3D node that defines the lower-left corner position of the would-be plate.

By accepting the lower-left corner of the box as the base point, let's create the necessary 2D

constructions to create the plate contour. To create a 3D profile, you need to apply a contour in any

convenient way.
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Finish working in the mode of drawing on the active worksurface. Upon exiting the mode of drawing

on the worksurface, the plate's 3D profile will be automatically created. The plate body is created by 

extruding the resulting 3D profile.

 

To create text on the plate, we will construct a second worksurface. The construction will be similar to

the previous cases. To define the surface coordinate origin, select one of the vertices (the lower-left

one) of the plate's upper face.
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After creating the second worksurface, we will go into the mode of drawing on it (the command Draw

On Workplane in the surface's context menu). On the worksurface page, mark the plate boundaries.

After that, apply 2D text at the desired position on the plate.

Next, the 3D profile on the worksurface is created based on the 2D text. The profile is extruded, and a

Boolean addition with the plate body is performed. In the described example, we relied on a 3D point

selection as the worksurface origin to precisely position the 3D profile contour on the worksurface.

The same goal could be achieved using a different method.  Working in the mode of drawing on the

active worksurface (the command Draw On Workplane in the context menu) is mostly analogous to

working in the respective mode on a workplane. The only difference is that one can draw on a

workplane both in 2D window and directly in the 3D window. For a worksurface, only the mode of

drawing in the 2D window is available. Besides that, all other functions of this mode are supported for

a worksurface, including the capability of projecting (mapping) a 3D point on the active

plane/surface.
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In our example, one could have skipped selecting additional 3D nodes as the origin for worksurfaces,

but rather have them mapped in the drawing-on-surface mode. After that, it is possible to create all

underlying construction for the 3D profile contours based on the created 2D nodes-the projections.

Local Coordinate System

Calling the command:

Icon Ribbon

3D Model > Construct> LCS

Assembly > Construct > LCS

Sheet Metal > Construct > LCS

Surfaces > Construct > LCS

Weld > Construct > LCS

Routing > Construct > LCS

Primitives > Construct > LCS

Support geometry > LCS > LCS

Keyboard Textual Menu

<3O> Construct > LCS

A local coordinate system (LCS) is an auxiliary 3D construction element, that allows positioning 3D

objects in the space. LCS's are widely used in 3D modeling, for example, for building 3D assemblies,

copying 3D bodies, defining transformations, etc.
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The size of an LCS's image is controlled in the command Set Document Parameters, on the tab 3D >

View, by the parameter Size > LCS.

On the basis of the LCS it is possible to create special 3D construction elements of the T-FLEX CAD —

3D connectors. 3D connectors are used for attaching fragments when creating 3D assemblies. They

represent themselves the LCS of a special type which are able (besides performing the function of

attaching the fragments) to pass the values of the variables of one 3D fragment into another

fragment. The use of the 3D connectors significantly simplifies positioning of the parts and matching

of the fragment parameters when designing the assemblies.

The image of the 3D connector in the 3D window is analogous to the image of the standard LCS, but

the axes are marked with “volume” arrows.

LCS 3D Connector

Topics in this section:

· Main Concepts of LCS

· Visibility of LCS in Assembly

· Create LCS

· Additional LCS

· 3D Connector

· LCS Parameters

· Edit LCS
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Main Concepts of LCS

Steps of creating LCS

Generally, an LCS creation includes the following steps:

1. Selecting LCS origin. A local coordinate system is created in the selected origin point with the same

axis orientation as the global coordinate system.

2. Selecting X-axis direction. X-axis of the LCS resulting from the previous step, is reoriented in the

specified direction.

3. Selecting Y-axis direction. Y-axis of the LCS resulting from the previous step, is reoriented in the

specified direction.

4. Selecting surface for additional reorientation. The LCS resulting from the previous step, is

reoriented in such a way, that its X-axis becomes pointing at the nearest point on the specified

surface.

5. Selecting tangency surface. The LCS resulting from the previous step, is reoriented to achieve

tangency with the specified face/surface.

6. Selecting required LCS transformations. The LCS resulting from the previous step, is rotated about

its axes.

Some steps can be skipped. The only required action is selecting the origin of the LCS.

7. Specifying additional non-geometrical characteristics of the LCS (associated elements, visibility in

the assembly, etc.).

Some of the steps can be skipped. The only mandatory action is to select the origin of the LCS

coordinates.

Defining the origin of the LCS

The origin of LCS is defined by a 3D point. An LCS is created in the specified 3D point with the axes

orientation (X', Y', Z' on the diagram) coinciding with the orientation of the axes of the global

coordinate system. 

Defining X-axis direction of LCS

To define X-axis direction of the LCS being created, specify either the direction vector itself or its 3D

end point (the first point of the vector is the 3D point defining the origin of the LCS). As a result, the

coordinate system is reoriented in such a way, that the X-axis assumes the desired position. 
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The rotation axis is defined as follows: a plane is constructed through the two positions of the X-

axis –the old (resulting from the previous step) and the new (defined at the current step). The

normal to this plane, passing through the origin of an LCS, is exactly the rotation axis.

Defining Y-axis direction of LCS

The Y-axis direction is defined, as in the case of the X-axis, either the direction vector itself, or by its

3D end point (the first point of the vector is the 3D point defining the origin of the LCS).

The step is performed only upon the condition of completing the previous one, which is the

selection of the X-axis direction. You cannot define the Y-axis direction without specifying the X-

axis direction.

The vector of the Y-axis direction does not define the Y-axis direction, rather, the position of the plane

XY, in which this axis must be located. The plane will pass through the X-axis of the LCS and the

specified vector of the Y-axis direction. As a result, the X-axis of the LCS maintains its position, and the

Y-axis is located in the specified plane at the angle of 900 to the X-axis. The direction of the Z-axis is

defined automatically based on the X and Y axes.
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Reorienting X-axis of the LCS towards the nearest point on the selected surface

Reorienting the X-axis of the LCS towards the nearest point on surface is used in the case, when it is

impossible to achieve the desired position of the LCS by selecting vector of the X-axis direction. 

Upon selecting the reorientation surface, the LCS being created is reoriented in such a way, that its X-

axis is directed towards the point of the selected surface nearest to the origin of the LCS.

The reorientation surface can be represented by a worksurface or plane. You can also select a face, flat

edge or a simple body (a body, all whose faces lie on one surface). In this case, the reorientation

surface is represented by the geometrical surface underlying the selected element.

Reorienting an LCS is done similar to rotating an LCS at the time of defining the original X-axis

direction.

Snapping LCS to tangency point on surface

Snapping LCS to tangency point on a face allows adjusting the position of the origin of the LCS being

created. 

The new position of the origin of the LCS is defined as follows: an auxiliary plane is constructed

parallel to the plane YZ LCS and tangent to the selected surface. If there are several such planes, the

nearest to the origin of the LCS is selected. The intersection point of the auxiliary plane and X-axis will

become the new origin of the LCS.
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The tangency surface is defined in the same way as the reorientation surface. To do this, you can select

a worksurface or plane, face, flat edge or a simple body. However, limitations are applied in this case: 

·  If a plane is used as the tangency surface (a workplane, and underlying plane of a flat face or

flat edge), it must be perpendicular to the X-axis of the LCS;

·  If the tangency surface is defined by a cylindrical face – the axis of the cylinder must be

perpendicular to the X-axis of the LCS.

Modifying axes orientation of LCS

To modify axes orientation of an LCS, you need to use stepwise rotation of the LCS about any of its

axes. In one pass, the LCS is reoriented by 900 about the selected axis. Additionally, a provision is

made for cyclical rotation of the axes of an LCS.

If both ways of modifying axes orientation of an LCS are combined together (rotation about one axis

and cyclical rotation), then the specified rotations about the specifics axes are performed first, and the

cyclical rotation follows.

Visibility of LCS in Assembly

In addition to the geometric parameters that determine the position and orientation of the axes of the

local coordinate system, a number of additional characteristics can be set for the LCS, which are

necessary when using this LCS to bind 3D fragments in an assembly.

LCS visibility in the assembly

Four visibility modes can be specified in the assembly drawing for the LCS being created in the 3D

fragment document (set in the External parameter, in the properties of the LCS):

· Invisible in assembly. This mode is set on by default. The LCS created in the fragment

document, will be not accessible in the assembly document. The LCS of the fragment will be

visible neither in the 3D window, nor in the LCS list of the assembly model;

· Visible in assembly on one level. This LCS will be visible in the assembly model and available

for snapping to it under condition that the fragment containing this LCS is a fragment of the

first nesting level. The location of such coordinate system is determined by the location of the

3D fragment. This LCS can be used for attaching other 3D fragments, and also for creating any

construction elements and operations of the assembly model;

· Visible in assembly on all levels. The LCS will be visible in the assembly document and

accessible for snapping to it for any nesting level of the fragment in the assembly;

· Externally invisible in assembly, but available for snapping to it. This mode is used most

frequently for 3D connectors operation. In this mode, by default, the LCS of the fragment is not

displayed in the 3D window of the assembly model. However, upon bringing the cursor to the

LCS (or to its associated elements) the LCS will be “shown” in the assembly model and it will
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be possible to select it for snapping. Such LCS is also displayed in the list of the local

coordinate systems of the assembly (with gray color, as invisible).

The connection of the External parameter can be restored from the properties of the LCS for the

part and assembly.

Visibility of Fragment’s LCS in Assembly

The following types of LCS can be visible in the model tree of an assembly: On one level, On all levels,

Connector.

Limitations:

· Connector and On all levels external LCS are invisible in the model tree until any other

element is not snapped to it. You can disable the option Hide connectors in the context menu

of the model tree to show the LCS.

· LCS will be hidden in the model tree if the option Hide coordinate systems in model tree is

enabled in the fragment parameters.

LCS for Attaching 3D Fragment

Location of the 3D fragment in the assembly gets fixed by combining two coordinate systems: source

one – belonging to the fragment, and target one – located in the assembly model. The LCS created in

the fragment document and assembly document are usually used as the source and target coordinate

systems.

However, not all LCS created in the 3D fragment document can serve as a fragment source coordinate

system. The only LCS that can be selected as the source coordinate system are the LCS marked as used

for fragment attachment. This parameter is specified in the LCS properties when creating and editing

the LCS.

Degrees of Freedom

For the LCS which will be used as the source coordinate system upon 3D fragment attachment, it is

possible to specify additional conditions in the form of allowed degrees of freedom. They define

behavior of the 3D fragment with respect to the fixing LCS. When inserting a 3D fragment, the

conditions with degrees of freedom are copied from the LCS parameters to the 3D fragment

parameters and subsequently are taken into account when calculating the set of mates of the

designed 3D assembly model.

There are 6 degrees of freedom of the fragment – 3 translations and 3 rotations with respect to the

LCS axes.

For each degree of freedom of the LCS, allowable bounds on the fragment displacement can be

specified.
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Associated Elements

For the LCS it is possible to specify associated, i.e., connected with the LCS elements (vertices, faces,

edges, etc.). It will allow a user later on to perform snapping to the given LCS by indicating not the

LCS itself, but the elements connected with the LCS. For example, if for the “external” LCS created in

the fragment of the bolt, faces and edges of the bolt are specified as associated elements, then in the

assembly when attaching a nut to this bolt, it will be sufficient to point at any face or edge of the bolt

with the cursor – the LCS connected with these elements will be highlighted and selected as a result.

   

3D Fragment Insertion Rules upon Snapping to Given LCS

For LCS which is going to be used as the target LCS upon 3D fragment attachment, so-called

“insertion rules” can be specified. They imply the necessity of specifying additional transformations

upon insertion of the fragment with snapping to the given LCS.

For example, when a nut is snapped to the bolt LCS, it is usually necessary to specify additional

translation of the nut along the bolt axis. That is why when designing a bolt model, in the insertion

rules for the bolt LCS, it is possible to indicate the necessity of translation along the X-axis.

Create LCS

When creating an LCS, the properties window and the command automenu are used together. 

To select a geometrical element defining some property of the LCS (the origin, X and Y axis direction,

the reorientation surface, etc.) you can simply focus in the respective input box of the properties

window. In this case, the option for defining the given parameter activates automatically in the

automenu. The opposite is also true: upon activating one of the automenu options, the input focus in

the command's properties window automatically switches to the input box of the LCS parameter,

corresponding to that option. For each option, you can configure filters for selecting geometric

elements in the filter toolbar.

Specifying Geometric Characteristics of LCS

Note that geometry elements, defining various LCS parameters (the origin, X and Y axis direction, the

reorientation surface, etc.) can be selected in arbitrary order. Those, however, will be applied in the

order described earlier in this chapter.
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Geometric characteristics, as well as other parameters, can be copied from another LCS using the

following automenu option:

New options have been added to command's automenu:

<С> Format by Pattern

Select an existing LCS, upon activating this option. All parameters of the selected LCS, except

connector values and origin position, will be applied to the current LCS.

To select a 3D point defining the origin of the LCS, focus in the input box Origin of the properties

window. The following automenu option will become active: 

<1> Select 3D Node or vertex as LCS origin

Once the 3D point of the coordinate system origin is selected, the image of the LCS being created is

displayed in the 3D window. As the rest of the characteristics are specified, the direction of the LCS

axes can be modified. To define the X-axis direction, use the entry X axis direction of the properties

window and the automenu option: 

<1> Select point that sets direction of X axis  

The Y-axis direction of the LCS is defined in the Y axis direction entry of the properties window and

the automenu option: 

<3> Select point that sets direction of Y axis 

The surface, whose nearest point defines the reorientation of the X-axis of the LCS, is specified in the

input box Rotate to Surface. The respective automenu option is:

<4> Rotate LCS to be orthogonal to Face

To select the tangency surface, use the Move to Surface entry of the properties window and the

automenu option:

<5> Offset LCS to be tangent to Face

The selected geometry elements (3D node, vertex, edge, etc.) are specified in the respective entries of

the properties window. To reject an element, focus in this entry and press the button Delete. Moreover,

by pressing  or <Esc> it is possible to successively cancel selection of all elements.

To modify axes orientation of an LCS, use the following options:
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<A> Rotate LCS around X axis by 90°

<O> Rotate LCS around Y axis by 90°

<Z> Rotate LCS around Z axis by 90°

The cyclical reassignment of the axes of an LCS is done by the option:

<Tab> Change LCS axes orientation

Several LCS in row with the same orientation can be quickly created using the following option:

<К> Save given orientation

Upon activating this option, all rotations applied to the current LCS via , , , and 

options will be automatically applied to the next LCS created after the current one.

Keep in mind, that this option doesn't affect rotations resulting from aligning axes to selected

elements. 

Once the desired LCS is built, confirm its creation by  (in the properties window or in the

command automenu). To reject creation of the given LCS, use the automenu option:

<F>  Reset target LCS

Before confirming the LCS creation with the help of  in the command's properties window, the

LCS characteristics (see below) necessary for snapping 3D fragments can be specified.

Choosing LCS Visibility Mode in Assembly

When inserting the current document into an assembly as a 3D fragment, the drop down list of the

parameter “External” in the group Coordinate System Parameters of the command's properties

window is used for selecting LCS visibility mode:

· Hide in Assembly. LCS will be always invisible in assembly;

· One Level. LCS will be visible in assembly on one level;

· All Levels. LCS will be visible in assembly on all levels;

· Connector. LCS will be invisible in assembly but available for snapping to it (this option is

usually used for 3D connectors).

· Select Type. This option is used for 3D connectors with pre-created parameters. The LCS will

be invisible in the assembly, but available for binding to it.
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LCS as Source Coordinate System of 3D Fragment. Specifying Degrees of Freedom

To utilize the LCS being created as the source LCS of the fragment (upon inserting the current

document into an assembly as a 3D fragment), it is necessary to set on the flag Use for Fragment

Insertion found in the command's properties window, in the group Coordinate System Parameters. By

default, this flag is turned on.

When the flag Use for Fragment Insertion is on, in the group Degrees of Freedom it is possible to

additionally indicate degrees of freedom of the 3D fragment when given LCS is used as the source

fixing LCS.

There are 6 degrees of freedom for a fragment – 3 translations and 3 rotations with respect to LCS

axes. By default, all degrees of freedom are forbidden – the switched off flags found next to the

strings of all degrees of freedom manifest about that.

For enabling any of the degrees of freedom, it is necessary to set on the flag to the left of the

corresponding string. In this case, the fragment can move along the given axis of the LCS (or rotate

around the given axis of the LCS) with no restrictions.

For specifying start and/or end limits of permissible motion by allowed degrees of freedom, it is

necessary to set on flags before the fields from and/or to and specify desired value in the opened

entry field. 

Note that for rotation around the LCS axes, two (start and end) limits of motion have to be specified

at the same time. For translation along the axis, the limits can be specified independently (for

example, only start, or only end limit).
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Selection of Associated Elements

For specifying associated elements, the command's property window (group Associated Elements)

and automenu can be used.

To specify associated elements with the help of the automenu, it is necessary to turn on the option:

<E> Select Associated Elements

This option allows a user to select the associated elements for the LCS just by picking them in 3D

window. The drop down list of the option contains filters for choosing the elements. The selected 3D

elements are put into the list “Associated Elements”.

The option  can be enabled just by putting the cursor over the string of the list containing “…”.

For removing selected elements, the buttons to the right of the list are used. The button  allows a

user to remove one element – selected in the list at the moment of pressing the button. When

pressing the button , all selected associated elements of the LCS are removed at once.

Specifying 3D Fragment Insertion Rules upon Attaching to Given LCS

Additional transformations of translation/rotation, which the system automatically prompts a user to

carry out when the fragment is attached to given LCS, can be specified in the group Insertion Rules

found in the command's properties window.

To create a new rule, press the button . Upon pressing this button, a drop down menu appears in

which a desired type of transformation needs to be chosen. The selected transformation is added to

the list.
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For removing one of the specified transformations, choose it in the list and press the button .

Pressing the button  will lead to deletion of all transformations at once.

Special LCS

Special coordinate systems as well as workplanes are intended for setting three-dimensional

elements and their correct location in space. As surfaces that can be used to define a special

coordinate systems are supported by the cylinder, the sphere and the torus. This method of defining

geometry is often used when building complex surfaces, such as when designing propellers. The

essence of the method is that a flat image, for example, a hatching profile, is located on a cylinder,

sphere, or torus by means of transformation. To bind special coordinate systems in space, the local

coordinate system is used.

Special coordinate systems are defined within a parametric area that represents the "sweep" of a

surface onto a plane. The parametric area is defined in u and v coordinates. The range of coordinate

changes and the meaning attached to the coordinates depend on the type of surface used to set the

special coordinate system.
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Spherical coordinate system

Cylindrical coordinate system

Toroidal coordinate system
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R-radius of a cylinder, sphere, or large radius of a torus 

r - small radius of the torus

Parametric regions of spherical and toroidal coordinate systems have restrictions from the bottom

and top. Cylindrical vertical coordinate systems are not restricted. In addition, cylindrical coordinate

systems can be set in either angular or linear units.

3D Connector

The 3D connector is a LCS, which is assigned named values. Named values contain information

(variable values) that the 3D connector must pass to the 3D fragments connected to it. For example,

among the bolt fragments included in the library of the standard T-FLEX CAD elements, 3D fragments

containing data about the current diameter of the bolt were created. Upon snapping the fragment-nut

(from the same library) to such 3D connector, the nut diameter will be automatically replaced with the

value taken from the 3D connector.

The image of the 3D connector differs from that of the standard LCS by the form of the axes arrows.

Specifying position and direction of the 3D connectors axes is performed in the same way as upon

creating the standard LCS.

The 3D connector has several image options in the 3D window. The image depends on the type of 3D

connector:

· By default, it looks like a 3D connector, the role of the axes depends on the context of use.

· Type A - there is one selected direction, the orientation of the other axes is not fundamental

(typical for single wire connections, etc.).

· Type B - there are two dedicated directions. (typical for AC socket–plug type connections (i.e.

polarity reversal is acceptable), etc.).
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· Type C - all three directions have values. (typical for cable connections with a key ... (cable

connector), etc.)

Detailed information on the use of types A, B and C connectors can be obtained in the Routing

section.

Working with 3D connectors

When connecting a 3D fragment (for example, a washer) to the 3D connector of another 3D fragment

(for example, to a bolt), the diameter of the washer will be automatically assigned a value read from

the 3D connector. For successful automatic connection of variables with the 3D connector, certain

conditions must be met:

1. The 3D connector should be assigned named values (see Specifying named values for 3D

Connector below). The names of these values will later be the link between the variables of the 3D

fragment having a 3D connector (bolt) and the variables of the connected 3D fragment (washer).

2. For the corresponding variable of the 3D fragment, a named value corresponding to the value of

the mating 3D connector must be set (see Specifying value names for connection with the 3D

Connector below). You need to set the name of the 3D connector value for the variable in advance

in the 3D fragment file in the variable editor by changing its parameters.

3. When inserting a 3D fragment, you need to select a 3D connector. At the time of connecting, the

system looks for a match between the name of the value of the 3D connector (item 1) of the source

fragment (bolt) and the named value of the 3D connector of one of the external variables (item 2)

of the connected 3D fragment (washer). If a match is found, the value of the variable transferred

through the 3D connector is assigned to the external variable. The connection with the 3D

connector will be saved. If necessary, you can disconnect from the 3D connector (see Disconnecting

from the 3D connector)

See a specific example of working with 3D connectors in the 3D Connectors Usage section in the

Creating 3D Assembly Models chapter.

Specifying named values for 3D Connector

Named connector values are set in the LCS parameters dialog.  The input becomes available after

selecting the Connector type of LCS (Connector Values section).

In the list placed in this section of the parameters window, the names of named connector values, their

expressions and current values are indicated. To fill in the list of named values, use the buttons located

above the list.
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To add a new named value to the list, the button  is used. After pressing this button, the dialog

window Connector Value will appear, in which the name of the named value being created and

expression assigned to it have to be specified. Both constant values as well as the variables of the

current document can be used in the expression. After pressing OK the specified named value will

appear in the list.

It is recommended to specify “meaningful” names for the named 3D connector values sticking to

the same name creation rules in all 3D models. This will simplify the setup of the connection

between the connector values and external variables of the fragments snapped to it. For

example, at first sight complicated names like DiameterOuterMetricThread, ThreadPitchMetric,

LengthInnerMetricThread, LengthInnerInchThread used in the standard T-FLEX CAD libraries,

are actually made up according to the common to all libraries rules and exactly show what

information is transferred by the given 3D connector value.

The following names of 3D connectors are accepted in the T-FLEX CAD system:

· DiameterOuterMetricThread - Nominal diameter of the outer metric thread  

· DiameterOuterMetric - Diameter of the outer cylinder in millimeters  

· DiameterInnerMetricThread - Nominal diameter of the inner metric thread  

· DiameterInnerMetric - Diameter of the inner cylinder in millimeters  

· DiameterOuterInchThread - Nominal diameter of the outer inch thread  

· DiameterOuterInch - Diameter of the outer cylinder in inches  

· DiameterInnerInchThread - Nominal diameter of the inner inch thread  

· DiameterInnerInch - Diameter of the inner cylinder in inches

Pressing the button  removes the named value selected in the list at the moment of pressing the

button.

By pressing the button , it is possible to rename already created named 3D connector value or the

expression specified for connector value.

The button  allows a user to copy all named 3D connector values and their expressions to the

clipboard. The button  adds the lines located in the clipboard of the system to the list of the

named values (if in the list there are no named values with the same names). Copying the named
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values via clipboard works in the framework of the same instance of T-FLEX CAD application. Thus, it

is possible to copy the named values from one document to another.

Specifying value names for connection with the 3D Connector

The value name of the mating 3D connector for the variable is set in the file of the connected 3D

fragment in the variable editor by changing the variable parameters (see the details in the Variable

Creation section).

 

Disconnecting from the 3D connector

The connection with the 3D connector is maintained until it is disconnected. This means that if the

values of the source 3D fragment (bolt diameter) change, then the values of the connected 3D

fragment (washer diameter) will also be changed. 

Information about the relevance of the connection can be viewed in the variables dialog of the

connected 3D fragment. The dialog can be opened by calling the Variables option from the context

menu of the model tree for the connected 3D fragment, or in the 3D Fragment insertion

command(Variables tab).

If a variable dialog has not been created for the connected fragment, a list of variables of the

connected 3D fragment will be opened, where the connection with the 3D connector is also

displayed (see below).
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To disconnect from the 3D connector, you should manually change the value of the associated

external variable of the connected 3D fragment. In this case, a window appears with confirmation of

disconnection.

You can also disconnect from the 3D connector by switching to the list of variables (the Variables List

checkbox).

The connection with the 3D connector is displayed with a special symbol . To break the connection,

press the  on the symbol and disable the option From the connector.
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After clicking, the symbol will turn gray and the connection will be broken. To restore the connection,

you need to click on the 3D connector symbol again and select the desired named value.

Specifying associated elements for the 3D connector

To set the elements associated with the 3D connector, use the option:

<E> Select Associated Elements

After selecting the option, the system enters the mode to select the elements that will activate the 3D

connector when the cursor hovers over them. To attach elements to the 3D connector, you need to

select them using the cursor in the 3D window. The selected items fall into the list of associated items

in the options window.
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A selection of 3D nodes, operations, faces, edges, cycles and vertices is available.

Insertion rules

For a connector, so-called "insertion rules" can be additionally defined. These are additional

transformations of movement or rotation relative to the coordinate axes of the 3D connector, which

the system will automatically prompt the user to perform when the fragment is attached to this 3D

connector. For example, when tying a nut to a bolt 3D connector, in practice it is always necessary to

specify additional movement of the nut along the bolt axis. Therefore, when designing a bolt model,

you need to specify in the insertion rules for its 3D connector to move along the X-axis of the 3D

connector.

LCS Parameters

Parameters of an LCS are defined in the dialog box invoked by the option:

<P> Set entity parameters

Some parameters of this dialog are common across all 3D elements. Their detailed description is

provided in the chapter General parameters of 3D elements. 

Other parameters of the given dialog duplicate parameters of the LCS properties window already

described above. Thus, only those LCS parameters which were not mentioned in the previous section

of this chapter will be described in this section.

You can define the following parameters of an LCS on the tab General:

· Comment. This parameter allows specifying a text string – the description of the given LCS.

The comment helps selecting a coordinate system from the list of those available for

positioning, when applying a 3D fragment.
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· Use One Color. This flag is responsible for the LCS viewing colors. When it is turned off, the

LCS axes are drawn with different colors. Each axis color (red, green, or blue) corresponds to

the color of the global axis. When the flag is turned on, the LCS is drawn with one color (Color

parameter).  

Display of LCS by

one color

Display of LCS by

different colors

· Use as Source CS. Allows you to use this LCS as the source.

· External. Adjusts visibility in the assembly (see Visibility of LCS in Assembly).

· Level. The value of the visibility level.

· Layer. The name of the layer that the coordinate system belongs to.

· Color. The color with which the LCS is drawn in the 3D window.

· Name. By default, the following names are generated ("LCS_1", "LCS_2", etc.).

· Set as default. The selected option means that the specified general parameters will be used

for all subsequent operations.

On the tab Exploded View, you can specify the transformations that will be applied to 3D fragments

attached to the given LCS in the exploding mode (the command Tools > Exploded View).
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Edit LCS

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3EO> Edit > Construct > LCS

This command is used for editing LCS.

Available option:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters
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<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the "3D node" command.

If you select multiple items, you can delete them. Note that the <Shift>  combination can be used

for multiple selection (the <Ctrl>  combination cancels the selection).

3D Node

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Node

Draw > 3D Model > 3D Node

Assembly > Construct > 3D Node

Sheet Metal > Construct > 3D Node

Surfaces > Construct > 3D Node

Weld > Construct > 3D Node

Routing > Construct > 3D Node

Primitives > Construct > 3D Node

Workplane > 3D Model > 3D Node

Keyboard Textual Menu

<3N> Construct > 3D Node

The following methods for creating 3D nodes are available:

<A> In Coordinates

<P> On Path

<S> On Surface
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<M> In Center of Mass

<R> By Shortest Distance

<Q> On Intersection of Elements

<K> On Intersection of Three Planes

<O> By Faces and Offsets

<J> By Two Projections

In general, the process of creating a 3D node using any of the above methods includes the following

steps:

· Select how to create a 3D node. Each method has a separate option in the automenu or on the

Type tab in the command parameters window.

· Specify the source objects and set the required parameters.

· Apply the operation using the automenu icon  or in the command parameters window.

You can also confirm the command by double-clicking  on an empty space in the 3D

scene.

If you select a particular model object immediately after running the command, the system will

automatically select a method for creating a 3D node in accordance with the following rules:

· When you select 2D nodes, the By Two Projections method is activated;

· When selecting 3D nodes, vertices, and LCS, the In Coordinates method is used;

· When selecting edges, 3D paths, and 3D profiles, use the On Path method;

· When selecting faces, workplanes, and surfaces, use the On Surfaces method;

· When selecting solids, use the In Center of Mass method.

Switching from any method of creating a 3D node to a method In coordinates enables you to convert

the created 3D node to absolute coordinates.

Topics in this section:

· 3D Node in Coordinates

· 3D Node on Path

· 3D Node on Surface

· 3D Node in Center of Mass
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· 3D Node by Shortest Distance

· 3D Node on Intersection of Elements

· 3D Node on Intersection of Three Planes

· 3D Node by Faces and Offsets

· 3D Node by Two Projections

· Creating 3D Node without calling command

· 3D Node Parameters

· Edit 3D Node

3D Node in Coordinates

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > 3D Node > 3D Node in Coordinates

Keyboard Textual Menu

<3KNC> -

It is also available as option in the 3D Node command:

<A> In Coordinates

The command allows creating a 3D node by specifying absolute or relative coordinates.

Absolute coordinates are calculated from the constant zero of the global coordinate system; relative

coordinates are calculated from a given geometric point. In both cases, axes directions can be defined

using manipulator.

By default, upon launching the command, the Coordinates tab of the parameters window contains

three input boxes X, Y and Z, where you can type in absolute coordinates.

In the meantime, there are several geometric type filters are active in the Filter Toolbar. Upon

selecting a  point, the command switches to defining relative coordinates. X, Y and Z input boxes
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of the Coordinates tab can now be used for inputting coordinates in relation to the selected point.

Additional non-editable X abs, Y abs and Z abs boxes appear in the right side of the tab. They

indicate node's absolute coordinates. You can switch some of the X, Y and Z input boxes into the

absolute coordinates defining mode individually by clicking  buttons in the right side of the box. 

Regardless of coordinates type (absolute or relative), in addition to the Coordinates tab there are the

Transformation tab in the parameters window (similar to the one used in the Transformations of 3D

Elements command) and LCS manipulators in the 3D scene.  Upon typing in values in the Coordinates

tab, corresponding transformations are automatically added to the Transformations tab. Moreover,

you can add or edit transformations manually using control elements of the transformations tab or

manipulators. For the most part working with transformations is performed in the same way as

described for the Transformations of 3D Elements command. The main difference is the absence of

transformations-specific automenu options, which makes impossible creation of some transformation

types (  Cyclic Axis Change, Translation along axis, Rotation around axis, Mirror plane).

Points and coordinate systems for Move to Curve by Axis and   Coordinate System

transformation types can be selected without using the automenu.

Keep in mind, that selecting objects other then points and coordinate systems launches

commands for creating other types of 3D Node.

3D Node on Path

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > 3D Node > 3D Node on Path

Keyboard Textual Menu

<3KNP> -

It is also available as option in the 3D Node command:
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<P> On Path

This method involves creating a 3D node on elements of wire geometry. These elements include

edges of 3D profiles, faces, solids, and 3D paths. A 3D node can either belong to the selected object

or be located at some distance from it. In this case, the node offset from the source object set in a

cylindrical coordinate system in which the coordinate U determines the position of the node on the

source object relative to a reference point, the V coordinate is a polar angle, and the coordinate R is

the polar radius, determining the node offset from the original object. Coordinates can also be

controlled using draggers in the 3D scene.

1-manipulator for changing the coordinate U; 2-manipulator for changing the polar radius R; 3-manipulator for

changing the polar angle of rotation V

The U coordinate has two types of values:

· By Offset. For this type, the length dimension is important;

· Parametric. For this type, the value is dimensionless (a fraction of the length) from 0 to 1.

The system also provides the ability to select the reference point of the U coordinate:

· Start. In this case, the reference point is the starting point of the source object;

1 – Base Point; 2 – Created 3D Node

· Middle. In this case, the reference point is the middle point of the source object;

1 – Base Point; 2 – Created 3D Node

· End. In this case, the reference point is the end point of the source object;
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1 – Base Point; 2 – Created 3D Node

· Point. In this case, the reference point is the projection of the selected point on the source

object.

1 – Base Point; 2 – Created 3D Node

After selecting this method for creating a 3D node, you must specify the source wire geometry object

in the 3D scene (using ) or in the model tree.

After selecting the source object, the Coordinates tab of the parameters window displays the input

fields for coordinate values that support the selection of measurement units, as well as the

Coordinates Type and Base Point parameters that define the type of U coordinate values and the

position of the reference point, respectively. To determine the position of the reference point of the U

coordinate using an arbitrary point, just select it in the 3D scene (using ) or in the model tree.

When changing the position of the reference point, the value of the U coordinate of the created

3D node is recalculated – the position of the 3D node in space is saved.

 

Changes to the position of the 3D node are displayed in the list of transformations on the

corresponding tab of the parameters window.
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3D Node on Surface

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > 3D Node > 3D Node on Surface

Keyboard Textual Menu

<3KNS> -

It is also available as option in the 3D Node command:

<S> On Surface

This method enables you to create a 3D node on different surfaces: closed and open faces of solid

and sheet bodies, 3D profiles, working planes, and surfaces. The position of the 3D node on the

surface is determined by the coordinates U, V. In this case, the resulting 3D node can either belong to

the original surface or be located at some distance from it. The offset of the node from the original

surface is given by the N coordinate. Coordinates can also be controlled using draggers in the 3D

scene.

1 – dragger for changing the V coordinate; 2 – dragger for changing the U coordinate; 3 – dragger for changing

the N coordinate

There are two types of coordinate values:

· By Offset. For this type, the length dimension is important;

· Parametric. For this type, the value is dimensionless (a fraction of the length) from 0 to 1.

After selecting this method for creating a 3D node, you must specify the source surface in the 3D

scene (using ) or in the model tree.

After selecting the source surface on the Coordinates tab of the parameter window, the input fields

for coordinate values and the Coordinates Type parameter are activated.
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3D Node in Center of Mass

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > 3D Node > 3D Node in Center of Mass

Keyboard Textual Menu

<3KNM> -

It is also available as option in the 3D Node command:

<M>  In Center of Mass

This method involves creating a 3D node in the center of mass of a given 3D profile, edge, solid or a

set of bodies obtained as a result of various operations. When determining the mass of each body, the

characteristics of its material are taken into account.
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After activating this method of creating a 3D node, you must select the source body or a set of bodies.

The selection is performed in the 3D scene (using ) or in the model tree.

All the selected objects are displayed as a list on the In Center of Mass tab of the parameters window.

The list is managed using the following buttons: Expend , Collapse , Delete Element from the

List  , Clear . The current absolute coordinates of the 3D node being created (in the global

coordinate system) are displayed on the Coordinates tab of the parameters window.

3D Node by Shortest Distance

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > 3D Node > 3D Node by Shortest Distance

Keyboard Textual Menu

<3KNR> -

It is also available as option in the 3D Node command:
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<R> By Shortest Distance

This method involves creating a 3D node as follows:

The system analyzes a set of selected elements in order to find a pair with the minimum distance

among them and builds a 3D node at this distance.

By default, the created 3D node lies on one of the elements of the found pair. If necessary, you can

move it in the direction of the second object of the pair by setting the offset value in a dimensionless

form (in fractions of length) from 0 to 1.

After activating this method for creating a 3D node, you must select the original set of elements. The

selection is performed in the 3D scene (using ) or in the model tree.

All the selected items are displayed as a list on the By Shortest Distance tab of the parameters

window. The offset of the 3D node from the first element of the pair is set by the Ratio parameter.
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The current absolute coordinates of the 3D node being created (in the global coordinate system) are

displayed on the Coordinates tab of the parameters window.-

3D Node on Intersection of Elements

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > 3D Node > 3D Node on Intersection of Elements

Keyboard Textual Menu

<3KNI> -

It is also available as option in the 3D Node command:

<Q> On Intersection of Elements

This method enables you to build a 3D node at the intersection of two 3D elements. The permissibility

of selecting certain 3D elements is determined by the possibility of getting an intersection between

them as a point. To avoid situations where the intersection of the specified elements is not a point,
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only objects that are characteristic of the Axis and Wire geometry type can be selected as the first

element. Objects that are characteristic of the Axis, Wire, Surface, Sheet, Solid geometry type can be

selected as the second element.

If multiple intersections occur when selecting elements, the point closest to the cursor click is selected

by default. If necessary, you can select a different intersection.

After activating this method, you must select the source elements. The selection is performed in the

3D scene (using ) or in the model tree.

The selected objects are displayed in the corresponding fields on the On Intersection of Elements tab

in the parameters window. Cancel the selected object and re-select it using the Clear  button . An

icon indicating the geometric type of the selected object is displayed next to the field of the source

elements.

The Intersection Point parameter enables you to select the desired intersection if there are several of

them, changing the sequence number of the resulting point. In addition, the selection of the

intersection point can be performed directly in the 3D scene by specifying the necessary point-

dragger.

The current absolute coordinates of the 3D node being created (in the global coordinate system) are

displayed on the Coordinates tab of the parameters window.

3D Node on Intersection of Three Planes

The command can be called in one of the following ways:

Icon Ribbon
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Support Geometry > 3D Node > 3D Node on Intersection of 3 Planes

Keyboard Textual Menu

<3KNT> -

It is also available as option in the 3D Node command:

<K> On Intersection of Three Planes

This method enables you to build a 3D node at the intersection of three planes. The system enables

you to select any 3D object that can define a plane in space – a flat edge, a flat 3D path, a face, a

cycle, a working plane, a LCS, etc. When selecting 3D objects, pay attention to the state of the element

selection filters.

After activating this method, you must select the original set of elements. The selection is performed

in the 3D scene (using ) or in the model tree.

The selected objects are displayed in the corresponding fields on the On Intersection of Three Planes

tab in the parameters window. Canceling of the object selection and its re-selection is performed

using the Clear  button. The current absolute coordinates of the 3D node being created (in the

global coordinate system) are displayed on the Coordinates tab of the Parameters window.

3D Node by Faces and Offsets

The command can be called in one of the following ways:

Icon Ribbon
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Support Geometry > 3D Node > 3D Node by Faces and Offsets

Keyboard Textual Menu

<3KNO> -

It is also available as option in the 3D Node command:

<O> By Faces and Offsets

Creating a 3D node by faces and offsets from a solid is a special case of creating a node on a face. In

this mode, first specify the base face for the node to be placed on. The required node position on this

face is defined using two additional faces of the same body, adjacent to the base face (having a

common edge), and their offsets. To create the node, offsets are constructed from the additional faces

at the specified distances. The node is defined as the intersection point of the base face and the

offsets.

All three faces can have the underlying surface of any type (a plane, torus, sphere, cone, spline

surface). Alternatively, the additional faces can be selected by selecting the edges that join the faces

with the base face.

In this mode, 3D node construction is done as follows:

· The offsets from the additional faces are constructed. The offset distances are defined by the

values entered for those faces. In the case of a positive distance, the offset is constructed

inside the body, negative - outside.

· An intersection of the base face and the offsets of the additional faces are calculated. The

resulting intersection will be the point of the 3D node creation.

In simple cases, the face surfaces can be extended beyond the bounds (both the base and the

offsets). For a plane and cone, this extension is unlimited, while for a torus or a sphere it is

closed. This allows, for example, creating a node beyond the bounds of the base face, yet lying

on its underlying surface (when the offset distance is negative). This also allows constructing 3D

nodes in the situations when the offsets from the additional side faces do not intersect with the

base face.
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After activating this method, you must select the original surface on which the 3D node will lie, as well

as additional faces. Instead of additional faces, you can select the edges of the source surface that

define them. The selection is performed in the 3D scene (using ) or in the model tree.

The selected objects are displayed in the corresponding fields on the By Faces and Offsets tab in the

parameters window. Cancel the selected object and re-select it using the Clear  button . The X and

Y input fields are used to specify equidistant offsets to the side faces that determine the position of

the 3D node being created. When you select the Reverse option, the offset direction of the

equidistant changes: the position of the node on the base surface will correspond to negative offset

values. If the flag is disabled, positive offsets are directed inside the body, i.e. the node is created on

the surface. 

3D Node by Two Projections

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > 3D Node > 3D Node by 2 Projections

Keyboard Textual Menu

<3KNJ> -

It is also available as option in the 3D Node command:

<J> By Two Projections

This method involves creating a 3D node based on its 2D projections – 2D nodes that lie on

workplanes (surfaces).
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There are two ways for creating a 3D node:

· Based on a single projection;

· Based on two projections.

After activating this method, the fields for setting source objects appear in the parameters window. 

The current absolute coordinates of the 3D node being created (in the global coordinate system) are

displayed on the Coordinates tab of the parameters window.-

3D Node by One Projection

To create a 3D node, you must specify a 2D node on the work plane (surface) or in the Model

Elements window. The selected 2D node is displayed in the First Element field on the By Two

Projections tab of the Parameters window. The Clear  button enables you to cancel a node

selection and to select another node.

 By default, the system attempts to automatically determine the work plane (surface) that the selected

2D node belongs to. The found workplane (surface) is displayed in the Worksurface field in the

parameters window. You can cancel the workplane selection and re-select it using the Clear 

button.

3D Node by Two Projections

To create a 3D node, select the 2D node of the first projection, then set the Second Projection flag

and select the 2D node of the second projection. The specified 2D nodes are displayed in the

corresponding fields of the parameters window. You can cancel the selection of the nodes and re-

select them using the Clear   button.

Similar to the previous version of creating a 3D node (based on a single projection), the system tries

to automatically determine the working planes (surfaces) that belong to the selected 2D nodes. The
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found planes (surfaces) are displayed in the corresponding fields of the parameters window. You can

cancel the selection of the workplanes and re-select it using the Clear  button.

In this case, creating a 3D node may cause erroneous situations. The 3D node is created at the

intersection of the perpendiculars to the workplanes that pass through the selected 2D nodes. If the

perpendiculars do not intersect, the message "Projections do not form a 3D point" appears in the

diagnostic window.

Creating 3D Node without calling command

Construct 3D Nodes by Grid of Workplanes

When creating/editing 3D operations, in situations where you need to select a 3D point, you can

transparently build a 3D node on a grid of working planes (without using command Construct 3D

Node). When the grid display is enabled, you can select points in the grid nodes of workplanes, as

well as points where paths and workplanes intersect, in all the operations where you want to select a

geometric point. In this case, a 3D node is automatically created in the grid nodes.

Construct 3D Node in the Mode of Measuring Elements

In the model element measurement mode, you can create a 3D node based on the measurement

results. It is available for the following properties of the measured elements:

· for properties: StartX, StartY, StartZ, EndX, EndY, EndZ – a 3D node is created on the path, at

the beginning or end of the path, respectively;

· for properties: LocationX, LocationY, LocationZ – a 3D node is created on the surface at the

starting point of the surface;

· for the Xmass, Ymass, and Zmass properties, a 3D node is created in the center of mass;

· for the Distance property, a 3D node is created on the first point of the segment that

represents the minimum distance between the selected elements (the first point of the

segment belongs to the first selected element).

If you select one of the above properties, an additional option appears in the auto menu:

<N> 3D Node

This option creates a 3D node.



3D Constructs. Support Geometry.

1175

3D Node Parameters

Common Tab

The 3D node parameters include: layer, level, color, and item name. The meaning of the first three

parameters is similar to the meaning of these parameters in two-dimensional design. The name is

unique, and it reflects by default the sequential number of the operation performed (for example, "3D

node_0"). At the time of creation, the element name is not displayed in the parameters window. You

can view and edit the created name in the Edit 3D node command.

If the External parameter is set, the 3D node is also available in the Assembly model. Nodes lifted

from the fragment have special names (Link to node_01). You can use them to link profiles or set

operation operands. The position of such nodes is completely determined by the position of the

model associated with them. Only parameters can be edited. You can also set an external parameter

for these nodes, which allows them to be used in next-level Assembly models.

Geometry Tab

Depending on the selected method for creating a 3D node this tab will contain a different set of

parameters:

Coordinates. The x, Y, and Z fields specify the values of the node's offsets relative to the source point

(vertex, 3D node, start of the local coordinate system, center of an elliptical edge, center of a sphere,

or torus). The X, Y, and Z fields are also used to set the coordinates of a node created in absolute

coordinates.

The following group of parameters is available when creating a node based on an edge, 3D profile, or

3D path:

Parameter. The distance is set in relative units (i.e. the parameter value is between 0 and 1). If the

middle of the source element is used as the reference point, the parameter value can change in the

range from -0.5 to 0.5.

Offset. The distance is set in model units. If an offset value greater than the length of the parent

element is set, the node is built at its endpoint, and the actual distance from the starting point to the

3D node along the parent element is displayed in the additional Used field.
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Transformation Tab

Default. The selected option means that the specified General parameters will be used for all

subsequent elements.

Edit 3D Node

Calling the command:

Icon Ribbon

-

Keyboard Textual menu

<3EN> Edit > Construct > 3D Nodes

This command is used for editing 3D nodes.

Available option:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the "3D node" command.

If you select multiple items, you can delete them. Note that the <Shift>  combination can be used

for multiple selection (the <Ctrl>  combination cancels the selection).
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3D Path

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path

Draw > 3D Model > 3D Path

Assembly > Construct > 3D Path

Sheet Metal > Construct > 3D Path

Surfaces > Construct > 3D Path

Weld > Construct > 3D Path

Routing > Construct > 3D Path

Primitives > Construct > 3D Path

Workplane > 3D Model > 3D Path

Keyboard Textual Menu

<3PA> Construction > 3D Path

3D path is used as an auxiliary 3D element in many system 3D operations. It represents a spatial curve

that may consist of segments of different types.

Any 3D path has direction, and, therefore, the start and end points. The direction of the 3D path will

affect the result of using it in various operations.

A 3D path can be open or closed. The start and end points of a closed path coincide.

You can create a new 3D path or edit existing paths.

Following options are available upon calling the command:

<Ctrl>+<Enter> Finish input

<P> Set entity parameters

<I> Select Other Element

<X> Exit command

<F5> Preview Operation Result

<H> By 2D Elements

<S> Spline based on 3D Nodes

<T> Compound 3D Path

<Q> By Two Projections

<J> Projection on Face or on Body
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<M> Create Copy

<B> Intersection of Elements

<A> Parametric Change of 3D Node Position

<O> Outline

Offset Curve

<L> Spiral Path

<K> Split Path

<X> Axis

<C> Transition Path

<I> Isoparametric Curve

<W> Conic Curve

<N> 3D Path by Function

To create a 3D path in any of the ways listed above, you need to perform following steps:

· Select the method of creating a 3D path. 

Each method has its separate option within the command's automenu. Upon selecting one or

another option, the automenu provides additional options corresponding to the given method

of creating a 3D path. Some methods of creating a 3D path can be automatically activated by

the system if you select the source object of a certain type in the 3D scene or in the 3D model

tree right after entering the command. For example, selecting a 3D node activates the mode

of creating a 3D path by a 3D points; upon selecting a 3D path – the mode of creating a 3D

path copy; selecting a 2D path on the active workplane sets the mode of creating a 3D path by

2D paths.

· Select the source objects for creating a path and the required parameters (if necessary);

· Confirm the creation by  in the automenu or in the command's properties window.

Topics in this section:

· 3D Path by 2D Elements

· Spline based on 3D Nodes

· Compound 3D Path

· 3D Path by Two Projections

· 3D Path as Projection on Face or on Body

· Copy 3D Path

· 3D Path on Intersection of Elements

· Parametric Change of 3D Node Position

· Outline

· 3D Offset Curve
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· Helix 3D Path

· Split 3D Path

· 3D Axis

· Transition 3D Path

· Isoparametric Curve

· Conic Curve

· 3D Path by Function

· Modification of 3D Path

· 3D Path Parameters

· Edit 3D Path

3D Path by 2D Elements

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path > By 2D Elements

Sheet Metal > Construct > 3D Path > By 2D Elements

Surfaces > Construct > 3D Path > By 2D Elements

Weld > Construct > 3D Path > By 2D Elements

Routing > Construct > 3D Path > By 2D Elements

Primitives > Construct > 3D Path > By 2D Elements

Support Geometry > 3D Path > 3D Path by 2D Elements

Keyboard Textual Menu

<3KPE> Construction > 3D Path > By 2D Elements

It is also available as option in the 3D Path command:

<H> By 2D Elements

2D elements on the basis of which 3D paths can be created include hatching, construction elements

(2D paths, circles, ellipses, splines, offset curves and functions), as well as graphic and sketch lines

located on pages associated with workplanes or worksurfaces. When using 2D elements lying on the

workplane page, the resulting 3D path will be flat. A 3D path created based on 2D elements lying on

the worksurface will repeat the shape of the surface used.

You can select 2D elements basing on which a 3D path is to be built with the following automenu

option:
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<H> Select Source Elements

Creating a 3D path using open construction elements, graphic and sketch lines involves their

sequential connection: based on each next selected object, another section of the created path is built;

all the obtained sections are combined into one 3D path.

When using hatches, closed construction elements, graphic lines or a sketch as the source, the resulting

path is built along the contour of the selected object. In this case, let 3D always be closed.

The objects selected are shown in corresponding fields in the command properties window. To

control the list of the objects selected as the second element, Expend  , Collapse   , Delete

Element from the List  , Clear  buttons are used.

To cancel selection of an object as a work surface Clear  button is used. 

By default, the system aims to automatically determine the worksurface to which the selected 2D

elements belong. The found worksurface is displayed in the corresponding field in the parameters

window. If the automatic selection turned out to be incorrect or it is necessary to select another

worksurface to which the resulting path should belong, use the following automenu option:

<W> Select Work Surface

Additional snap

By default, a 3D path created based on 2D elements belonging to the current worksurface will

coincide with it in space. However, the system provides for the possibility of changing the position of

the 3D path. This is achieved by using an additional binding to the 3D node through which the surface

of the profile being created will pass. In addition, it is allowed to clarify the position of the 3D path in

space by specifying a 2D node (on the current worksurface) that should be aligned with the selected

3D node.
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Changing the position of the 3D path is carried out after activating the Additional Snap parameter,

followed by selecting a 3D node in the 3D scene or model tree and, if necessary, specifying a 2D node

on the active worksurface. Cancellation and re-selection of nodes is carried out using the Clear 

 button .

Spline based on 3D Nodes

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path > Spline based on 3D Nodes

Sheet Metal > Construct > 3D Path > Spline based on 3D Nodes

Surfaces > Construct > 3D Path > Spline based on 3D Nodes

Weld > Construct > 3D Path > Spline based on 3D Nodes

Routing > Construct > 3D Path > Spline based on 3D Nodes

Primitives > Construct > 3D Path > Spline based on 3D Nodes

Support Geometry > 3D Path > Spline based on 3D Nodes

Keyboard Textual Menu

<3KPS> Construction > 3D Path > Spline based on 3D Nodes

It is also available as option in the 3D Path command:
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<S> Spline based on 3D Nodes

The 3D path in the form of a spline is built on the basis of the original (control) 3D points. Any

geometric points of the model can be used as initial (control) points - 3D nodes, vertices,

characteristic points of edges, faces, bodies.

There are three types of 3D splines:

· 3D polyline;

· 3D spline through nodes;

· 3D spline by polyline.

Any type of 3D spline can be open or closed (periodic). In the case of a periodic spline, the last

selected geometric point is automatically connected to the first one.

At least three control points are required to construct a closed spline of any type.

1 – closed 3D polyline; 2 – closed 3D spline by points; 3 – closed 3D spline along a polyline

3D polyline

3D polyline is a spatial curve made of straight segments connecting the points of the source set. A

polyline can be either open or closed (when a closed polyline is created, the first 3D point of the

source set is used twice – for defining the start and the end of the path); 

1 – source geometrical points; 2 – 3D polyline

By default, a polyline is a special case of a 3D spline of the first degree.

3D spline through nodes

3D spline through nodes is a spline passing through all control points (nodes). In this case, the control

points (nodes) are the selected geometric points of the model.
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1 – source geometrical points; 2 – 3D spline through nodes

The main parameter of this type of spline is its Degree – the degree of the polynomials of the

piecewise continuous function by which it is described. The maximum allowable value of the degree is

one less than the control points (nodes) of the spline. For splines with more than four control points

(nodes), third degree polynomials are used by default.

Shape of 3D spline through nodes, depending on its degree: 1 - spline of the second degree; 2 - spline of the third

degree; 3 - spline of the fourth degree

Also, the features of this type of spline include the ability to set its direction at each control point

(node). The direction is determined by a special object - a tangent. Thus, the resulting spline will touch

the specified direction at the current point (node).

1 – current point; 2 - tangent that defines the direction of the spline at the current point; 3 - vector of the direction

of the spline at the current point

The control point (node) of the spline does not have to belong to the guiding object.

At the control points (nodes) of the spline, it is allowed to determine the nature of the conjugation by

the nodes in contact with other curves. The following options are provided:
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1 – source curve for the mating; 2 - mating point; 3 - 3D spline through the nodes

· Continuity G0 - assumes a coincidence in the space of mating curves at the current point (node).

Mating of 3D spline with an source curve with continuity G0: 1 – initial curve for mating; 2 - resulting 3D spline

through nodes; 3 - curvature plot

· Continuity G1 - assumes that the tangent directions of the mating curves coincide at the current

point (node).

Mating of 3D spline with the source curve with continuity G1: 1 – source curve for mating; 2 - resulting 3D spline

through nodes; 3 - curvature plot

· Continuity G2 - assumes the coincidence of the tangent directions of the mating curves and the

equality of their curvature at the current point (node).
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Mating of 3D spline with an source curve with continuity G2: 1 – source curve for mating; 2 - resulting 3D spline

through nodes; 3 - curvature plot

· Continuity G3 - assumes the coincidence of the tangent directions of the mating curves, the equality

of their curvature, as well as the preservation of the smoothness of the curvature at the current point.

Mating of 3D spline with an source curve with continuity G3: 1 – source curve for mating; 2 - resulting 3D spline

through nodes; 3 - curvature plot

With continuity G1 G2 G3, it is allowed to set the value of the Tangent magnitude - a coefficient that

scales the value of the length of the tangent vector. By default, the value is [1]. The convenience of

controlling the tangent module is achieved by using a special manipulator - an arrow - in a 3D scene.

Tangent magnitude = 1
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Tangent magnitude = 2

1 –  source curve for mating; 2 - resulting 3D spline through the nodes; 3 - manipulator for controlling tangent

magnitude

The direction of contact of the spline at the point of interface with another curve can be changed to

the opposite.

3D spline by polyline

3D spline by polyline (a NURBS – non-uniform rational B-spline) – an arbitrary-degree spline by a

control polyline. The selected geometric points of the model are used to construct a control polyline.

The spline itself does not pass through them (except for the first and last points in the case of an open

(open) spline).
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1 – source geometric points; 2 - control polyline; 3 - 3D polyline spline

In addition to the Degree, one of the main characteristics of this type of spline is the Weight - the

weight coefficient of the control point. The greater the weight of the point, the closer the curve passes

to it. By default, the weight for all control points is [1].

1 - control vertex; 2 - 3D spline with weight [1] at the control point; 3 - 3D spline with weight [2] at the control point;

4 - 3D spline with weight [3] at the control point

Another parameter of this type of spline that affects its geometry is the type of parametrization that

determines the intervals between the mathematical nodes of the spline. The following types are

provided:

· By Chord – the placement of mathematical nodes is proportional to the distances between

each connected pair of control points.

· Uniform – mathematical nodes are placed at an equal distance from each other regardless of

the distance between the control points. Since the shape of the curve does not adapt to the

lengths of the segments of the control polyline, folds and loops can be obtained on small

segments.

· Centripetal – the placement of mathematical nodes is proportional to the square root of the

distance between each connected pair of control points.

· Manually. This type of parametrization assumes an independent determination of the position

of mathematical nodes. For convenience, special manipulators are designed in the 3D scene.
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Shape of the spline depends on the type of parametrization: 1 - by chrord; 2 - uniform; 3 - centripetal; 4 - manually;

5 - manipulators for controlling the parametrization nodes.

Any control point of the 3D path can be shifted relative to the source position. To do this, it must

belong to a spatial curve. Thus, the offset of the control point is carried out along this curve.

If the source geometric point does not belong to the curve, then the projection of the geometric

point on this curve will be used as the control point of the spline.

Any wire object of the model can be selected as a curve. The offset of the control point relative to the

beginning of the selected curve can be controlled by the parameters window, as well as directly in the

3D scene by using a special manipulator in the form of a sphere.

1 – source control point; 2 - curve for the offset of the source control point; 3 - offset manipulator

For a 3D path as a spline through nodes, the selected curve by default is also its tangent (a reference

to the tangent) at the current control point.

Creating 3D path as 3D spline by 3D points

Creating a 3D spline usually begins with specifying a set of 3D points on which the spline will be

constructed. To select 3D points, use the option:

<M> Add 3D Point to Spline

All selected 3D points are sequentially entered into the corresponding list of control points of the

spline in the parameters window. For each control point, depending on the type of spline, the

specified additional parameters are displayed. The list is managed using the Expand , Collapse ,

Delete Element from the List , Clear  buttons.
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The type of the resulting 3D spline is selected using the corresponding icons in the parameters

window:

Through Nodes

By Polyline

Closed Spline Through Nodes

Closed Spline By Polyline

Polyline

Closed Polyline

The degree of the 3D spline is set in the corresponding field in the parameters window.

The object defining the direction of the 3D spline through the nodes at the current control point is set

using the following automenu option:

<T> Select Tangent

The selection is made in the 3D scene (using ) or in the model tree. At the same time, it is

important to pay attention to the state of the element selection filters.

The selected object is displayed in the Tangent field of the parameters window. Cancel and re-select

using the Clear  button.
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The curve along which the current control point should be shifted is selected using the following

automenu option:

<C> Select Curve

The object specified as the displacement curve is displayed in the Curve field of the parameters

window. The value of the reference point offset is set in model units in the adjacent field.
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The icons     are designed to determine the type of mating of the 3D spline

with the source curve at the current control point. The tangent magnitue is controlled using a

manipulator in the form of an arrow in a 3D scene or by changing the value in the parameters window.

The touch direction is changed using the icon .

The value of the weight coefficient of the current control vertex of the spline along the polyline is set

after its selection in the special Weight field.

 

The choice of the type of parametrization of the spline along the polyline is carried out on a special

tab of the parameters window. This tab also displays the number and intervals of mathematical nodes

of the spline. In Manual mode, the intervals between nodes can be changed – using special

manipulators in triangles in a 3D scene or in a special field in the parameters window.
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Compound 3D Path

The command can be called in one of the following ways:

Icon Ribbon

3D Model > Construct > 3D Path > By Two Projections

Sheet Metal > Construct > 3D Path > By Two Projections

Surfaces > Construct > 3D Path > By Two Projections

Weld > Construct > 3D Path > By Two Projections

Routing > Construct > 3D Path > By Two Projections

Primitives > Construct > 3D Path > By Two Projections

Support Geometry > 3D Path > 3D Path by 2 Projections

Keyboard Textual Menu

<3KPO> Construction > 3D Path > By Two Projections

It is also available as option in the 3D Path command:

<T> Compound 3D Path

This method allows you to create a 3D path by combining various elements of wire geometry. Such

elements include the edges of 3D paths, sheet and solid bodies, and directly 3D paths. The source

elements should not be closed. The direction of the resulting path is determined by the direction of

the first selected element.

In general, a 3D path is formed by a simply connected sequence of elements, while the direction of

the resulting path is determined by the direction of the first element of this sequence; the direction of

the remaining elements is determined automatically.



3D Constructs. Support Geometry.

1193

If unrelated elements are used in the formation of a 3D path (i.e. elements that do not have common

vertices), the system provides three modes of linking them:

· Auto Joining Mode . In this mode, the beginning of an unrelated element is connected

to the end of the previous section by a straight segment.

1, 2 - source elements in the order of selection; 3 - resulting 3D path

· Move . In this mode, the beginning of an unrelated element is connected to the

beginning of the previous sequence by the parallel transfer method.
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1, 2 - source elements in the order of selection; 3 - resulting 3D path

· Auto . In this mode, the system analyzes a set of selected elements for the formation of

a simply connected sequence, regardless of their order. Otherwise, the elements in the order of

their selection, taking into account the original direction, are connected by the parallel transfer

method.

1, 2, 3, 4 – source elements in the order of selection; 5 - resulting 3D path when selecting the first three elements; 6

- resulting 3D path when selecting all elements

In the Auto Joining and Move modes, the direction of unrelated elements is determined by the cursor

position when they are selected in a 3D scene: the edge of the element to which the cursor is closer at

the time of selection is the end. If necessary, the direction of unrelated elements can be reversed.
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All selected items are entered in the list. The order in which the sections of the 3D path are connected

corresponds to their position in the list. By moving the required item through the list, the connection

order changes.

In the Auto Joining mode, the Find Transition Sequence function is available, designed to

automatically search for a sequence with a minimum set of edges between selected edges of the

same body.

1 – source edges of the body; 2 - resulting 3D path along the found sequence

Creating compound 3D path

The joining mode is selected using the corresponding icons in the command parameters window.

The elements are selected in the 3D scene (using ) or in the 3D model tree when the option is

enabled:

<T> Select Element

The sequence of smoothly coupled elements is selected when the corresponding option is enabled in

the selector settings.
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After enabling this option, it is enough to specify any element included in the required sequence. The

remaining elements will be selected automatically.

All selected items are displayed in the corresponding list in the command parameters window. To

manage the list, use the Expand , Collapse , Delete Element from the List , Clear  buttons.

The selected item is moved through the list using the buttons Move Up , Move down .

The Reverse direction flag is used to reverse the direction of the current unrelated element.

The Find Transition Sequence function is activated in the Auto Joining Mode.

 

3D Path by Two Projections

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path > By Two Projections

Sheet Metal > Construct > 3D Path > By Two Projections

Surfaces > Construct > 3D Path > By Two Projections

Weld > Construct > 3D Path > By Two Projections

Routing > Construct > 3D Path > By Two Projections

Primitives > Construct > 3D Path > By Two Projections

Support Geometry > 3D Path > 3D Path by 2 Projections
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Keyboard Textual Menu

<3KPJ> Construction > 3D Path > By Two Projections

It is also available as option in the 3D Path command:

<Q> By Two Projections

This method allows you to create a 3D path based on two projections located in non-parallel planes.

Image lines, 2D paths and 3D paths, as well as 3D profiles and edges can be used as projections. A 3D

path is constructed at the intersection of two imaginary surfaces formed by moving projections in

specified directions.

This example is located in the Examples library, the 3D Modeling/Paths/3D Path by two 2D

Paths.GRB.

Upon calling the command following options appear in the automenu:

<F> Select first projection (2D Path)

<S> Select second projection (2D Path)

These options allow you to select objects as projections of the created path.

Each projection can include several objects.

By default, the system seeks to automatically find objects that determine the direction of projection in

such a way that the resulting path is orthogonal to the planes in which the projections lie. If necessary,

it is allowed to explicitly specify objects (plane, face, profile) that determine the direction of

projection. In this case, the selection is made in the 3D scene (using ) or in the 3D model tree when

the option is enabled:

<W> Select Other Workplane

All selected items are displayed in the corresponding list in the command parameters window. To

manage the list, use the Expand , Collapse , Delete Element from the List , Clear  buttons.
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3D Path as Projection on Face or on Body

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path > Projection on Face or on Body

Sheet Metal > Construct > 3D Path > Projection on Face or on Body

Surfaces > Construct > 3D Path > Projection on Face or on Body

Weld > Construct > 3D Path > Projection on Face or on Body

Routing > Construct > 3D Path > Projection on Face or on Body

Primitives > Construct > 3D Path > Projection on Face or on Body

Support Geometry > 3D Path > 3D Path as Projection on Face or on Body

Keyboard Textual Menu

<3KPF> Construction > 3D Path > Projection on Face or on Body

It is also available as option in the 3D Path command:

<J> Projection on Face or on Body

This method involves creating a 3D path as a projection of an existing 3D path on a face or a set of

adjacent faces of a sheet or solid. In this case, the source path may be non-planar, and its projection

does not necessarily have to fit entirely on the selected faces. The projection vector is set either by a

single 3D object capable of determining the direction (a straight 3D path, edge, LCS, working plane,

etc.), or by using two geometric points (3D nodes, vertices, etc.). If a body is selected, a 3D path is

projected onto each of its faces. The resulting elements (the results of projecting a 3D path onto the

selected faces or body) are combined into one 3D path. Elements that cannot be joined are discarded.
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1 – source 3D path; 2 - the source body (face); 3 - objects defining the projection vector; 4 projection of the source

path

If the projection vector is not specified, then the projection is built along the normal to the selected

face, and if a set of faces is selected – along the normal to the nearest face.

1 – source 3D path; 2 - projection of the source path along the normal to the face; 3 - projection of the source path

in a given direction (along the normal to the plane)

<В> Select operation on which 3D path will be mapped

<F> Select face that will be used for 3D Path projection

The face or operation body are selected in the 3D scene by . An operation body can also be

selected in the 3D model tree by picking the intended operation in it.

The source 3D path is selected by the option:

<T> Select 3D Path for projecting onto face

The projection vector can be defined by two 3D points with the help of the options:

<M> Select first 3D point of projection direction vector

<S> Select second 3D point of projection direction vector

The projecting vector can be defined by a single object using the option:
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<L> Select projection direction

To undo a specified direction, use the option:

<K> Cancel selection of projection direction

Copy 3D Path

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path > Copy

Sheet Metal > Construct > 3D Path > Copy

Surfaces > Construct > 3D Path > Copy

Weld > Construct > 3D Path > Copy

Routing > Construct > 3D Path > Copy

Primitives > Construct > 3D Path > Copy

Support Geometry > 3D Path > Copy 3D Path

Keyboard Textual Menu

<3KPC> Construction > 3D Path > Copy

It is also available as option in the 3D Path command:

<M> Create Copy

This method involves creating a 3D path as a copy of an existing path or its separate section.

By default, if the source and target coordinate systems are not specified, the new path coincides in

space with the source 3D path. When specifying the source and target coordinate systems, copying is

carried out by transferring the source coordinate system together with the associated 3D source path

to the position occupied by the target coordinate system.

1 – source 3D path; 2 - source coordinate system; 3 - target coordinate system; 4 - resulting 3D path

The process of creating a copy of only a separate section of the source 3D path involves specifying the

initial and final boundaries of copying, specified as two geometric points. If the points do not belong
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to the source path, then their projections on the source path, lying at the minimum distance, are used

as the boundary of the copied section.

1 – source 3D path; 2 - source coordinate system; 3 - objects defining the boundaries of copying; 4 - target

coordinate system; 4 - resulting 3D path

If one of the copy boundaries is not specified, then the corresponding end of the source path is used

instead.

1 – source 3D path; 2 - source coordinate system; 3 - object defining the source copy boundary; 4 - the target

coordinate system; 4 - resulting 3D path

Creation of a path copy begins with selecting the source 3D path. A 3D path is selected either directly

in the 3D scene or in the 3D model tree. For this, use the automenu option:

<T> Select 3D Path

To select the source and the target coordinate systems, the following options are provided:

<1> Select source LCS

<2> Select target LCS

If the source or target coordinate system doesn't exist, it can be quickly created using the following

options:
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<F> Select Point for creating source LCS

<W> Select Point for creating target LCS

As a result, LCS will be automatically created with the vertices at the specified 3D points and the same

orientation of the axes as that of the global coordinate system.

To cancel a selection of the source or target coordinate system, you can use the option:

<Y> Cancel LCS selection

The copying limits are defined by the following options:

<S> Set starting copying limit

<E> Set ending copying limit

<D> Clear copying limits

3D Path on Intersection of Elements

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path > Intersection of Elements

Sheet Metal > Construct > 3D Path > Intersection of Elements

Surfaces > Construct > 3D Path > Intersection of Elements

Weld > Construct > 3D Path > Intersection of Elements

Routing > Construct > 3D Path > Intersection of Elements

Primitives > Construct > 3D Path > Intersection of Elements

Support Geometry > 3D Path > 3D Path on Intersection of Elements

Keyboard Textual Menu

<3KPG> Construction > 3D Path > Intersection of Elements

It is also available as option in the 3D Path command:

<B> Intersection of Elements

This way enables users to create 3D path at the intersections of elements. Sheet objects (work plates,

work surfaces, faces and sheet bodies) as well as solid bodies can be used as intersection elements.

The first element can only be set by one object, the second one – by a set of objects.

In case there are several sections formed in the intersection, you can determine the ones by which 3D

paths will be built. 
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Open-loop sections are formed as a result of several objects intersection. If a solid body is used as

one of the intersecting elements, the obtained adjacent sections are automatically combined into one.

If several solid bodies intersect, the resulting contours formed by adjacent sections will be closed.

When creating a 3D path at element intersection with the use of sheet objects, sometimes it is

necessary to consider one of the intersection elements without taking into account its limiting

contours, both external and internal (i.e. the sheet object is considered an infinite surface). It enables

users to create a 3D path only limited with the second element contours. 

Taking into account limiting contours Without taking into account limiting contours

Upon calling the command, options for choosing objects as intersecting elements appear in the

automenu:

<A> To choose the first element

<S> To choose the second element

The following automenu option cancels selection of all the elements:

<F> To cancel selection of all the elements

The selected elements are shown in the corresponding fields in the command properties window. To

control the list of the objects selected as the second element, Expand  , Collapse   , Delete

Element from the List  , Clear  buttons are used.

Set the flag Use as Surface to use a sheet object selected as the first element without taking into

account its contours. 
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Resulting sections obtained after elements intersection are shown in Result field. The flag set indicates

creating a 3D path at this section after confirming the command. You can set on and off all the flags

at the same time using Select All   , Clear  buttons.

Extend 3D Path parameter enables users to expand the resulting section up to the first element

boundaries.

In case the first element is used as a surface, the resulting sections will possess an infinite length

when enabling this parameter.

Join Adjacent Segments parameter is used for combining resulting adjacent segments when several

sheet objects intersect.

Parametric Change of 3D Node Position

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path > Parametric Change of 3D Node Position

Sheet Metal > Construct > 3D Path > Parametric Change of 3D Node Position

Surfaces > Construct > 3D Path > Parametric Change of 3D Node Position

Weld > Construct > 3D Path > Parametric Change of 3D Node Position

Routing > Construct > 3D Path > Parametric Change of 3D Node Position

Primitives > Construct > 3D Path > Parametric Change of 3D Node Position

Support Geometry > 3D Path > Parametric Change of 3D Node Position

Keyboard Textual Menu

<3KPP> Construction > 3D Path > Parametric Change of 3D Node Position

It is also available as option in the 3D Path command:
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<A> Parametric Change of 3D Node Position

The way of creating a 3D path by parametric variation of a 3D point is used for creating trajectories of

complex geometry.

A spatial curve of the path results from "sweeping" a 3D point along an arbitrary or specifically

defined spatial trajectory. "Sweeping" of the point is realized by multiple copying of the source 3D

point. The resulting set of points is joined by a spline, and a 3D path is built. The resulting 3D path can

be closed.

When constructing such path, a general mechanism is used that provides the final result based

on parametric copying of the source element. This mechanism is used in the By Parameters

operation – when creating a body based on "sweeping" (copying) a profile. It is also used in the

Parametric Array operation, where the result of the operation is a set of parametrically varying

copies of the source object.

This algorithm is described in most details in the By Parameters chapter. The current chapter provides

only a brief description and some examples of using this mechanism.

To create a 3D path by a parametrically varying point, you need to define the law, according to which

the copies of the source 3D point will be constructed. 

A so-called current copy's coordinate system is calculated for each copy of the point. Copying the 3D

point is done in the direction from the source coordinate system to the calculated target coordinate

system of the current copy. The user can select one of the local coordinate systems available in the

model as the source coordinates. If no local coordinate system is selected, then the source coordinate

system will be either the global coordinate system or the coordinate system of the first copy,

depending on the method of calculating the current copy's coordinate system.

The current copy's coordinate system (that is, its origin and axes orientation) can be defined by one of

two methods:

· Free copy orientation. The laws of modifying the coordinate system parameters of the current

copy of the 3D point are described by expressions. 

· Copy orientation by 3D curves or surfaces. To define the spatial position of the current copy's

coordinate system, existing 3D curves or surfaces of other bodies are used. By directing the

copy's coordinate system, the user controls the position of each copy of the 3D point.

Directing the copy's coordinate system is done via the operation parameters. There are parameters of

two types - driven parameters and driving parameters.

Driven parameters are the parameters whose values are calculated automatically in the process of

creating a copy of the point. You can assign independent variables to read the values of such a

parameter. 

Driving parameters are the entries with the dependencies defined by the user. The entries of the

driving variables allow entering arbitrary expressions that can include any system variable. For

example, by including a variable representing the ID number of the 3D point's copy in such an

expression will make the value of this parameter dependent on the copy number.

Some operation parameters can be sometimes driving, and sometimes driven. The leading parameter

Copy number is always driven. It necessarily requires an independent variable that would be assigned

the current value of the copy number while calculating the operation. The copy number automatically

changes during the calculation from 1 up to the specified amount with increment of 1.

Calculation is done in the following order: first, the copy number is incremented, then the driving

parameters are calculated, after which the rest of driven parameters are calculated (if any), and, finally,

copying is done. All copies of the 3D point obtained in this way are united in one spline.
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Upon calling the command following actions become available:

<R> Select 3D Node

<1> Select Curve defining position of coordinate system 

<2> Select 3D Curve defining X direction of coordinate system 

<3> Select 3D Curve defining Y direction of coordinate system

<4> Select Surface defining X direction of coordinate system

<5> Select Surface defining Y direction of coordinate system

<6> Select source LCS

<7> Cancel selection of elements defining coordinate system

As was mentioned earlier, one can distinguish two ways of creating a path by parametric variation of a

3D point. Let's review examples of each of them.

Free copy orientation method

When creating a path by this method, all that is required is selecting a 3D node, specifying the number

of copies and assigning an independent variable to the Copy number parameter. By using the

variable assuming the value of the current copy number, one can create certain dependencies in the

driving the variable entries, as well as in 2D or 3D constructions, that, in turn, define the position of the

source 3D point.

Example 1

Let's review the use of a parametric path on the example of creating a model of a cam. This example

can be found in the Examples library, the folder 3D Modeling/Paths/Cam.grb. The source data is

represented by a graph defining the cam surface.
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A parametric segment is constructed between the nodes 1 and 2. Its position is defined by the value of

the variable "a" in the range from 0 to 1, inclusive. As the variable "a" changes, the line will move from

point 1 to point 2. The resulting line will cost the axis of the graph and the graph curve. A segment can

be constructed between these points. Its length will be equal to the current value of the function

represented by the graph. The read value of the segment length is stored in the variable "L" (by means

of the function get).

To construct a 3D Path repeating the contour of the cam surface, one needs to create such a 3D node

that will change its spatial position according to the law defined by the graph as the variable changes

that is assigned to be the copy counter. Such a node can be conveniently created by adding a few

additional 2D constructions based on already available data.

To get the cam of the desired size, the axis of the graph needs to be "wrapped" onto a circle of the

specified radius. In the given example, the constructed circle has the radius of 50 mm. A new line

needs to be created through the circle center at an angle to the horizontal. The variable "a1" shall be

assigned to the parameter defining the slant angle of this line.

The node 3 is constructed at the intersection of the circle and the slanted line. The node 4 is

constructed at the distance "L" from the node 3 along the slanted line. A 3D node is constructed based

on the 2D node 4. For that purpose, a "Front view" workplane was created on an existing page.

Now, we need to relate all variables in such a way that the 3D node would rebuild according to the

copy counter changes. This can be achieved by introducing the following expressions instead of fixed

values of some variables, that will maintain the dependency from the copy number:
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Since the values of the Copy number parameter always start from one, sometimes a (–1)

adjustment is necessary in the expressions employing the Copy number variable.

At this point, the parametric 3D path can be constructed. We need to define two parameters in the

parameters dialog: enter the number of copies and assign the variable to act as the copy counter. In

the given example, the "Copy number" parameter is assigned the variable "s".

     

The first copy of the 3D node will coincide in its position with the 101-th. As a result, a closed 3D path

will be created. Its geometry will correspond to the cam shape. Next, to create the cam body, extrude

the path in the normal direction by 50 units and create a solid body based on the obtained sheet

surface using Sew operation. Finally, one can make a cylindrical hole along the cam's axis (by

extruding a circle with automatic subtraction from the main body).
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Method of orienting copy by paths or surfaces

The method of orienting a copy by paths or surfaces is convenient when other means fail that would

define the law of varying copy parameters by expressions. In such cases, it could be convenient to use

various 3D curves or surfaces for defining the position and orientation of the current copy's coordinate

system.

Example 2

As an example of using a parametric 3D path with orientation of the copy by paths or surfaces, let's

consider building a 3D path defining the outer border of a "waves" surface. On the figure, it is

denoted as 3D path 2.  To construct such a path, we need:

· the source 3D node whose position will be changing depending on the number of the copy

being created in the process of building the path; 

· a 3D path defining the position of the coordinate system origin for each copy;

· a surface, defining the orientation of the X-axis of each copy's coordinate system.

The path being created shall repeat the shape of the outer border of the source sheet body. Therefore,

to define the origins of the copies' coordinate systems, we would need to use a 3D path built on the

edges of the source sheet body – the 3D path 1.

An auxiliary workplane is constructed in order to get the source 3D node, which is perpendicular to the

3D path 1 and is passing through one of the vertices of the source sheet body. The necessary 2D

constructions are created on the workplane. The sought 3D node is created based on a 2D node on

the workplane – the Node 2. Node 2 was constructed as follows: first, the Node 1 was created on the

workplane with the coordinates (0,0) (corresponding to the vertex of the source sheet body through

which the workplane passes). A horizontal line is drawn through this node. A vertical line is drawn at

the distance "y" from Node 1,  perpendicular to the horizontal line. Node 2 lies on this line at the

distance "L" from the lines intersection point. The value of the "L" variable is defined in such a way as

to vary with the changes in the copy counter of the 3D path. Therefore, as the 3D path creation

progresses, the position of the 2D Node 2 changes by the sinusoidal law with the current copy

number, and so does the based on it 3D node.
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To define orientation of the X-axis of the copies' coordinate systems with the progress of the

parametric path creation, we need to specify the source sheet body itself. If no surface is selected,

then the axis orientation will be defined based on the curvature vector of the 3D path 1, whose

direction may change abruptly. The following needs to be defined in the path parameters dialog: the

number of copies (the variable "q"), the copy counter variable (in the given example, this is the

variable "n") and the driving parameter "Parameter along path". Once 3D path 2 is created, the based

on it "waves" surface can be created by Loft operation. 
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This example is located in the library Examples, the folder 3D Modeling/Path/Parametric path

with copies orientation by path and surface.grb.

Outline

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path > Outline

Sheet Metal > Construct > 3D Path > Outline

Surfaces > Construct > 3D Path > Outline

Weld > Construct > 3D Path > Outline

Routing > Construct > 3D Path > Outline

Primitives > Construct > 3D Path > Outline

Support Geometry > 3D Path > Outline

Keyboard Textual Menu

<3KCO> Construction > 3D Path > Outline

It is also available as option in the 3D Path command:

<O> Outline

Creating a 3D path as an outline edge can be found useful for defining the separation line when

designing diecast molds. 

Construction of a body's outline edge can be schematically described as follows: imagine that spatial

lines are drawn parallel to the viewing direction through each point on the body's surface. The points

on the body surface in which such a line just touches the body (without intersecting it) are the

candidate points for an outline edge.

To create a 3D path, the source body and the viewing direction are specified. The system analyzes the

surface of the body, searching for points satisfying the outline edge definition. The resulting set of

points is united in one curve –  the 3D path.
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If it is impossible to join all found points into one curve, the system returns a set of separate outline

edge segments. The user is offered to select the segment that will be used for building the resulting

3D path. One can select multiple outline edge segments simultaneously. In this case, multiple 3D path

will be created rather than a single one, according to the number of selected segments.

Viewing direction is defined by normal to upper face System-identified outline edge segments are shown

as yellow and blue lines.

A situation as possible when the vector of the viewing direction is parallel to some of the body's faces.

In this case, all points of such face satisfy the definition of the outline edge, that is, the system finds an

outline "surface" instead of an edge. This situation is resolved by the system by constructing the

outline edge through the first points encountered on such face. As a result, most often, the outline

edge is constructed along one of the side edges of such a face. A better shape of the outline edge will

be obtained by applying the "vertical" face processing. In this mode, the system draws the outline

edge straight across the face.

Constructing outline edge without "vertical"

face processing

Constructing outline edge with "vertical" face

processing

 The mode of processing Vertical faces is turned on in the command’s properties window.

The mode of processing Vertical” faces is turned on in the command’s properties window.

The body whose outline edge will be constructed is selected by the option:
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<1> Select Solid Body

The viewing direction is defined either by two 3D points or by one 3D element suitable for defining a

vector:

<2> Select First point of Direction

<3> Select Second point of Direction

<4> Select direction

After specifying the source body and the viewing direction, the image of the created outline edge will

be shown in the 3D scene. 

In the case when the system cannot create a single outline edge, the 3D scene will show one of the

identified outline edge segments. To create a 3D path based on it, simply confirm the path creation

by .

The full list of found outline edge segments is displayed in the command’s properties window. To

create a 3D path based on another outline edge segment, it is possible to select the desired segment

in the properties window or use the additional option:

<Tab> Change Outline

This option allows us to loop through the outline edge segments found by the system (when pressing

this option the next segment of the outline edge is displayed on the screen). The segment selected in

the list is displayed with a light blue color in 3D scene.

To create a 3D path by several segments of the outline edge, it is necessary to find all desired

segments in the list and checkmark them, and then confirm the path creation with the help of .  

3D Offset Curve

This way of creating a 3D path allows creating 3D curves of the following types:

1. 3D path as an offset from a flat 3D path

2. 3D path as an offset from a 3D curve on a surface

3. 3D path as a 3D offset from a 3D path.

All the methods of creating the 3D path as an offset from another 3D path are united in the automenu

under the option:

Construct 3D Path as offset to existing 3D Path

The drop-down list of this option contains three choices of creating a 3D path as an offset.
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Offset Curve to Planar 3D Path

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > 3D Path > Offset Curve to Planar 3D Path

Keyboard Textual Menu

<3KCF>

It is also available as option in the 3D Path command:

<F> Offset Curve to Planar 3D Path 

To create a path - an offset to a planar 3D path, select the source path and specify the shift with

respect to the source 3D path. The shift can be defined in two ways:

By specifying a 3D node through which the offset should pass. The node must lie in the plane of the

source path. By a numerical value of the shift of the offset path from the source path. The figure

presents an example of creating an offset path with the shift defined by a 3D node. 

Creating this kind of a path is similar to creating a 3D profile as an offset to another planar 3D

profile (see the chapter "3D profiles").

The gaps introduced between the segments of the offset path can be processed in three ways:

Natural – the curves making up the source path are continued. Straight lines are continued straight,

arcs are rounded up.

Round – a fillet is created between the end points of the neighboring segments of the path being

created.

Extend – straight lines are added to the hanging points that are tangent to the path segments at the

gaps.
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Natural Round Extend

When creating an offset to a path of the complex shape, self intersection loops may occur in the

contour of the new path. An additional loop trimming mode helps removing those automatically.

               

The first step in creating the 3D path is selecting the source planar 3D path by the option:

<T> Select planar 3D Path

After that, one has to specify the required shift by a 3D node or numerical value. The 3D node is

selected by the option:

<N> Select 3D Vertex in the plane of selected path

To reject a selected node, you can use the option:

<K> Cancel Node selection

The numerical value of the shift is specified in the command's properties window. Here, other offset

parameters are defined as well. The option of processing gaps introduced by creating the offset path

is defined by the parameter "Gap Type". The mode of deleting loops turns on upon setting the flag

"Remove loops".

Offset Curve to 3D Curve on Surface

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > 3D Path > Offset Curve to 3D Curve on Surface

Keyboard Textual Menu
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<3KCS>

It is also available as option in the 3D Path command:

<U> Offset Curve to 3D Curve on Surface

To create a 3D path as an offset to a 3D curve on a surface, select the source curve – a 3D path. The

offset will be constructed by shifting the points of the original curve by the specified distance along

the surface of the face on which the source curve lies. The source 3D path must necessarily lie on a

face of a body – either solid or sheet.

  

The face on which the selected 3D path lies is defined by the system automatically. Whenever

possible, the user is offered to change the system selection (for example, if the 3D path was created

on an edge dividing two faces of a body).

Shifting the offset from the source curve can be defined by a numerical value or by a tabulated

function. The table definition of the shift distance allows creating an offset with variable shift from the

source curve. The shift table determines the position of control points on the source path and their

respective shift values.
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The accuracy of constructing the resulting 3D path is defined either by the number of points, through

which the path is created, or by the offset tolerance. When using offset tolerance, the path is

constructed in such a way that the resulting curve-to-chord distance for any given pair of sequential

points does not exceed the specified accuracy value. The more use the number of points set for the

offset or the higher use the specified accuracy, the more precisely the offset path will be constructed.

Upon calling the command, select the source 3D path by the option:

<Z> Select path on surface

The offset of an equidistant and its construction accuracy are defined in the properties window or in

the path parameters dialog (the option ). To define an offset by a numerical value, set “Offset

Type” to “Constant” and enter the desired value in the “Offset” field. To use a tabulated offset

function, set the “Offset Type” parameter to the value “Function”. The [Offset Table] button appears in

the dialog that brings up the window to define the table of offsets.

   

The "Offsets" dialog allows creating or editing the table of shifts. To add a new row, set the cursor on

one of the existing rows in the table and click [Add]. The "Offset" dialog will appear on the screen. In

it, specify the position of the new control point (the parameter "Length") and the amount of its offset

(the parameter "Offset").  

The "Offset" dialog is also used for editing an existing row in the table (by clicking the button [Edit]). 

The button [Delete] allows deleting the selected row from the table of shifts. 

The table of offsets can be also defined using a plot (graph). To do this, use the button [Graph]. Upon

clicking this button, the window to edit a plot appears. Details about working with plots are described

in the chapter “Graphs”.
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To define the accuracy of constructing the resulting path, decide on the parameter to use for this

purpose – "Number of Points" or "Tolerance" – and enter the value of the chosen parameter in the

field at the right. The face on which the offset is being created can be replaced by the option:

<Tab> Select other adjacent Face

 

The "Offset Direction" switch in the offset properties dialog can be used for the same purpose. 

3D Offset Curve to 3D Path

The command can be called in one of the following ways:

Icon Ribbon

Support Geometry > 3D Path > 3D Offset Curve to 3D Path

Keyboard Textual Menu

<3KCP>

It is also available as option in the 3D Path command:

<D> 3D Offset Curve to 3D Path

To create a 3D path as a 3D offset, all you need is just to select the source 3D path (of any shape), the

offset distance and offsetting direction. The offsetting direction will define the direction of offsetting

each point of the source path. A 3D spline will then be constructed, uniting all such points created by

offsetting.

A 3D path created as a 3D offset can be used, for example, in CAM processing for creating tool

movement trajectories accounting for the tool radius correction; also, in diecast mold design for

creating the separation surface (using the outline edge and an offset to it).

There are two ways of defining the offset direction:

· Direction vector. A single direction vector is defined for the whole offset – by two 3D points, a

straight edge, a normal to a flat face or workplane.

To yield the offset, each point of the source 3D path is shifted by the specified distance along the

vector defined as the cross product of the tangent to the path at the given point and the specified

offset direction vector. That means, a point being offset is shifted in the direction perpendicular to

both the direction vector and the tangent to the source path.
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· Direction from body. This way of creating a 3D offset implies creation of a 3D Path as a

"continuation" of a sheet body surface (tangentially). The offsetting direction is defined by the

operation body, whose surface needs to be extended. The source 3D path must lie on the

same body. 

We recommend using a sheet body that lies in one surface, while the source path – a 3D path

constructed along the bounding edges of this sheet body. Use of other configurations of the

source data leads to an undetermined result of the offset creation.

To make the offset, each point of the source 3D path is shifted by the specified distance along the

vector defined as the cross product of the path tangent and the normal to the guiding surface at this

point.

An additional provision of offset with rotation can be used together with any method of creating an

offset. In this mode, the offset vector calculated for each point of the source path is additionally

rotated about the path tangent at that point by the specified angle. The 3D offset with rotation can be

useful, for example, in CAM operations – for constructing a guide path defining the tool inclination

angle.

The first step in creating the 3D offset curve is selection of the source 3D path by the option:

<A> Select 3D Path
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After that, you need to define the offsetting direction. 

To define the direction by the direction vector, the following options are used:

<B> Select first Point of Direction

<C> Select second Point of Direction

<D> Select straight Direction

The first two options (  and ) allow defining the direction vector by two 3D points. The option

 serves to select a 3D object suitable for defining the direction vector at once.

To define the offset direction from a body, use the option:

<G> Select Solid Body

The offset amount is specified in the command properties window or in the path parameters dialog

(the option ).

The shift of the offset is specified in the "Distance" parameter. Here, the offset with rotation mode can

also be turned on (if necessary). For this, simply enter the desired value of the rotation angle in the

field of the "Angle" parameter (the default value is set to "0").

Helix 3D Path

Calling the command:

Icon Ribbon

3D Model > Construct > Split Path

Draw > 3D Model > Split Path

Assembly > Construct > Split Path

Sheet Metal > Construct > Split Path

Surfaces > Construct > Split Path

Weld > Construct > Split Path

Primitives > Construct > Split Path

Support Geometry > 3D Path > Split Path

Keyboard Textual Menu

<3PH> Construct > Helix 3D Path

It is also available as option in the 3D Path command:
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<L> Spiral Path

A helix path is a special type of 3D path that allows you to obtain a conical, cylindrical, flat or

parametric screw curve around the selected axis.

Helix 3D Path types

Following types are available:

Along Axis

By Face

Flat

Information about creating 3D paths of each type can be found in corresponding sub-chapters.

Helix 3D Path along Axis

The 3D path of this type can be created using the following option within the Helix 3D Path

command:
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Along Axis

Creation of a Helix Path along Axis

Following steps should be done:

· Choose axis type.

· Define an axis.

· Define a start point and/or a start angle (optional).

· Set length, pitch, number of coils and direction of coiling (optional).

· Set radii or diameters (optional).

· Confirm the operation .

Parameters of operation are described below.

Main concepts of this type of path are available in a separate section.

Axis, Stat Point, Start Angle

Following Axis Types are available:

·  Two Points

·  Path

·  Axis

·  Point and Direction
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Depending on the selected axis type, some of the following input boxes appear: First Point, Second

Point, Path, Axis, Direction. Activating the desired input box allows to select in the 3D scene a

corresponding object defining a helix axis.

By default a helix is constructed from start to end of an axis along the whole axis (or directional

vector) length. However, it can be changed by specifying additional parameters.

The  Reverse button is available for all axis types. It allows to switch helix direction along axis. For

all axis types except Path this button switches between constructing a helix from start to end of an

axis and in reverse; the start itself is not changed in this cases. For  Path this button not only

switches a direction, but also switches a start of a helix between start and end points of an axis.

Start Point allows to manually define starting position of a helix. If start point lays in helix's starting

plane (a plane normal to axis, passing through its first point), then helix's start lays on a line normal to

helix's axis going through start point. If start point doesn't lay in helix's starting plane, the result

depends on the  For Angle Reference Only option. If  option is disabled (by default), then

helix's starting plane is shifted to the start point and after that helix's start is defined in a way

described above. If  option is enabled, then start point is projected to the starting plane. If start

point is not selected, then the system automatically selects an arbitrary starting point.

If start radius or diameter is disabled, then radius/diameter of a helix is defined by the start point.

Start Angle - an angle of a helix start's rotation around a helix's axis. If Start Point is selected, angle is

laid off from said point, otherwise - from an arbitrary starting point automatically selected by the

system.

Accuracy - object are being approximated or considered coinciding within this tolerance.

Length, Pitch, Coils, Direction of Coiling

Following combinations of parameters are available in the Parameters group:

·  Length and Coils (default)

·  Length and Pitch

·  Pitch and Coils

Only two of three parameters (Length, Pitch and Coils) are available depending on the selected

combination. Third parameter is calculated automatically from values of two others. For  and 

 options the Length is defined by axis length by default. Enable the checkbox located to the left side

of the Length input box for applying a custom length value. All of the three parameters should have

values higher than zero.

When using the  option, the pitch can be defined either by a constant value or by a graph

depending on helix's length along axis. To use a graph click the  Create Graph button, which is

located to the right side of parameter's input box. Detailed information is available in the Using

Graphs in 3D Operations section.

Function value on the pitch's graph defines the number of coils for the corresponding length from the

helix's start. 

Function on the pitch graph should be always increasing, otherwise the operation will throw an

error.
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The default spline graph contains almost horizontal starting and ending sections, where function value

changes very slowly. This leads to creation of a helix with starting and ending sections almost parallel

to the axis. 

Change spline's tangency parameters so, that function value change more rapidly, if you want to get

rid of helix sections parallel to axis. The helix shown below is the same helix as the one shown above;

the only difference is the X_tan value for the first point of the graph.

The Direction of Coiling parameter as well as the  Reverse Direction of Coiling button switch

direction of helix between clockwise and counterclockwise. The button is not pressed by default and

the value is equal to zero. Pressing the button switches the value to one. Values can be also typed in

manually or defined using variables. Only positive whole numbers are allowed. Values higher than one

are considered same as one.
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Radius/Diameter

The Distance group of parameters allows to define change of helix diameter/radius upon changing of

coil number. First you need to choose one of following distance calculation options:

·  Radius

·  Diameter

Either Start and End radius or Start and End Diameter input boxes become available depending on

the selected option. Enable a checkbox located to the left side of a corresponding input box to apply

a parameter. If Start Radius/Diameter is disabled, it is necessary to select a Start Point, so that helix's

radius/diameter will be defined by a start point's position. Then you will still be able to define the End

Radius/Diameter if necessary.

If neither Start radius/diameter nor Start Point are defined, the operation throws an error.

By default, radius/diameter changes linearly from starting to ending value along the helix's axis.

Alternatively, Radius/Diameter of a helix can be defined by a graph depending on helix's length

along axis. This can be done by enabling only the Start Radius/Diameter checkbox and clicking the 

 Create Graph button, which is located to the right side of parameter's input box. Detailed information

is available in the Using Graphs in 3D Operations section.

Start and end of a graph may expand beyond a helix's length. The only limitation is that a graph

should be defined along the whole helix's length, otherwise the operation will throw an error.

On Polyline graph only two points are allowed - starting and ending. Otherwise the operation

will throw an error

Main Concepts of Helix 3D Path along Axis

Axis of helix 3D path along axis

The screw curve is built around the axis of the helix. Axis can be either straight or curved.
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Straight axis can be defined by two 3D points: the start and end. 3D points can be defined by 3D

nodes, as well as by any 3D object that can determine a point in space. The vector defining the axis of

the helix will be directed from the first point to the second (respectively, the beginning and the end

will be determined). The shape of the curve is determined by the parameters of the helix 3D path.

1 - First point of axis

2 - Second point of axis

3 - Axis 

4 - Screw curve

Curved axis can be defined by 3D paths, 3D profiles, loops, edges. Multiple selection is also

acceptable if selected object form a tangency continuous contour. Contour could be either open or

closed.  

Selecting a closed axis yields a closed 3D path by default.

There are limitations applied to constructing a closed helix 3D path. Radius/diameter should

have the same value in the end and in the start of the screw curve. X_tan parameter values in the

starting and ending points of the pitch graph should be higher than zero.
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Closed helix 3D path constructed using a pitch graph

Manually apply the desired length, if you need to create an open path by a closed axis. Limitations

mentioned above are not applicable to open paths created by closed axes.
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Main parameters of helix 3D path along axis

The appearance of the resulting helix 3D path resulting from this operation is determined by the

following parameters:

· Radius/diameter

A cylindrical helix (i.e. the one with constant radius/diameter along the whole length) is

created by default. It is possible to set different values for starting and ending

radius/diameter. Then it will change linearly from start to end value along the helix length.

Another option is to use graph of dependency between radius and length.

· Start angle and start point

Define the initial point of screw curve (see below).

· Direction of coiling

The clockwise direction (when looking along the helix's axis) is applied by default. It can be

switched to counterclockwise if necessary.

· Pitch, length and number of coils

The helix can be defined using one of the following parameters combination: Length and

Coils, Length and Pitch, Pitch and Coils. 

The third parameter is calculated automatically from the values of two others. By default, an
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axis's length is used as a helix's length. It can be changed to a custom value if necessary. 

When using the Length and Pitch combination, the pitch can be defined either by a constant

value or by a graph in dependency to length.

Length of screw curve is defined by distance between 3D

nodes that define axis (additionally,  pitch is defined)

Length of  screw curve is defined by pitch value and

number of coils (n = 4)

Initial Point of Screw Curve of Helix 3D Path along axis

By default, the initial point of the screw curve is chosen arbitrarily by the system. It can be changed by

setting the desired position using an additional 3D point - the start point. Additionally, you can

specify the numerical value of the start angle of the screw curve's initial point rotation.

1 - Axis

2 - Default initial point of screw curve 

When you specify the start point, the initial point of the screw curve will move along the specified

initial radius to the plane passing through the selected point and the axis of the helix 3D path.
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1 - Selected start point

2 - Plane passing through axis and start point

3 - Initial point of screw curve

When simultaneously setting the start point and the numerical value of the start angle, the angle is

measured from the plane, passing through helix's axis and the start point.

Initial point of screw curve is defined by numerical value

of start angle (30°) without selecting start point

Initial point of screw curve is defined by start point and

numerical value of start angle (30°)

Using start point for defining radius/diameter

Selecting a start point and disabling the start radius/diameter's checkbox links screw curve's

radius/diameter to the start point's position.
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Radius/diameter of screw curve is defined by start point

Helix 3D Path by Face

The 3D path of this type can be created using the following option within the Helix 3D Path

command:

By Face

Creating Helix 3D Path by Face

Following steps should be done:

· Select face.

· Define a start point and/or a start angle (optional).

· Set number of coils and direction of coiling (optional).

· Confirm the operation .

A curvilinear face of any rotational body can be selected as a Face. Face defines length and diameters

of a helix.

Additionally you can select custom Start Point of a helix. If selected point doesn't lay on selected face,

its projection will be used as a start.

The  Change Direction button switches direction of a helix along face's axis in relation to start

point. 
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Start Angle - the angle of helix start's rotation around face's axis.

Accuracy - object are being approximated or considered coinciding within this tolerance.

Number of Coils may also be changed. The value should be higher than zero.

The Direction of Coiling parameter as well as the  Reverse Direction of Coiling button switch

direction of helix between clockwise and counterclockwise. The button is not pressed by default and

the value is equal to zero. Pressing the button switches the value to one. Values can be also typed in

manually or defined using variables. Only positive whole numbers are allowed. Values higher than one

are considered same as one.

Flat Helix 3D Path

The 3D path of this type can be created using the following option within the Helix 3D Path

command:

Flat

Creating Flat Helix 3D Path

Following steps should be done:

· Choose axis type.

· Define an axis.

· Define a start point and/or a start angle (optional).

· Set pitch, coils and direction of coiling (optional).

· Set radii or diameters (optional).

· Confirm the operation .

Axis, Start Point, Start Angle

Axis of a flat helix 3D path defines normal direction and position of a helix's support plane. 

Following Axis Types are available:
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·  Two points

First Point defines plane's position, Second Point - normal direction.

·  Axis

Helix's support plane is located in the axis's starting point. 

· Point and Direction

First Point defines plane's position, Direction - normal direction.

Depending on the selected axis type, some of the following input boxes appear: First Point, Second

Point, Axis, Direction. Activating the desired input box allows to select in the 3D scene a

corresponding object defining a helix axis.

Start Point allows to manually define starting position of a helix. If start point lays in helix's support

plane, then helix's start lays on a line normal to helix's axis going through start point. If start point

doesn't lay in helix's support plane, the result depends on the  For Angle Reference Only option. If

 option is disabled (by default), then helix's support plane is shifted to the start point and after that

helix's start is defined in a way described above. If  option is enabled, then start point is projected

to the support plane. If start point is not selected, then the system automatically selects an arbitrary

starting point.

Start Angle - an angle of a helix start's rotation around helix's axis. If Start Point is selected, angle is

laid off from said point, otherwise - from an arbitrary starting point automatically selected by the

system.

Accuracy - object are being approximated or considered coinciding within this tolerance.

Pitch, Coils, Direction of Coiling

Pitch and number of Coils may be specified in the Parameters group. Both parameters should have

value higher than zero. 

The Direction of Coiling parameter as well as the  Reverse Direction of Coiling button switch

direction of helix between clockwise and counterclockwise. The button is not pressed by default and

the value is equal to zero. Pressing the button switches the value to one. Values can be also typed in

manually or defined using variables. Only positive whole numbers are allowed. Values higher than one

are considered same as one.

Radius/diameter

The Distance group of parameters allows to define change of helix diameter/radius upon changing of

coil number. First you need to choose one of following distance calculation options:

·  Radius

·  Diameter

Either Start and End radius or Start and End Diameter input boxes become available depending on

the selected option. Enable a checkbox located to the left side of a corresponding input box to apply

a parameter.

Applying Start and End diameter/radius simultaneously makes Pitch input box non-editable, because

in this case pitch is calculated automatically depending on diameters/radii and number of coils.
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Diameter/radius of a helix can be defined by a graph depending on the number of a particular coil.

This can be done by enabling only the Start diameter/radius checkbox and clicking the  Create

Graph button, which is located to the right side of parameter's input box. Detailed information is

available in the Using Graphs in 3D Operations section.

When using a graph for the flat path, keep in mind that function must be always increasing.

Otherwise the operation will throw an error.

Starting point of a graph may not coincide with one, ending point may not coincide with total

number of coils. Anyway, the system considers a start of a graph as a first coil and an end of a

graph as a last coil.

Split 3D Path

Calling the command:

Icon Ribbon

3D Model > Construct > Split Path

Draw > 3D Model > Split Path

Assembly > Construct > Split Path

Sheet Metal > Construct > Split Path

Surfaces > Construct > Split Path

Weld > Construct > Split Path

Primitives > Construct > Split Path

Support Geometry > 3D Path > Split Path

Keyboard Textual Menu

<3KPD> Construction > 3D Path > Split Path

It is also available as option in the 3D Path command:
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<K> Split Path

This way enables users to create 3D paths by means of splitting the existing one into parts using other

model objects. The initial 3D path can be either closed or open-loop. 3D points belonging to the

initial 3D path or linear objects, sheet bodies and solid bodies crossing the initial 3D path can be used

as splitting objects. Several splitting objects for the path to be split are also possible.

As a result of the operation copies of the initial 3D path are generated which correspond to the

segments between the objects used for splitting.

You can choose the 3D path to be split at the 3D scene or from the model tree when the following

option is enabled:

<G> Select 3D Path

Splitting objects are selected in the same way as the 3D path to be split when the following option is

enabled:

<S> Select splitting object

You can cancel selection of all the elements with the help of the following option:

<F> Cancel selection

The objects selected are shown in corresponding fields in the command properties window. To

control the list of the objects selected as the second element, Expand  , Collapse  , Delete

Element from the List  , Clear  buttons are used.

The segments obtained after splitting the selected 3D path are shown in Results of Splitting field. The

flag set indicates creating a 3D path at this section after confirming the command. You can set on and

off all the flags at the same time using Select All , Clear  buttons.
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3D Axis

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Axis

Draw > 3D Model > 3D Axis

Assembly > Construct > 3D Axis

Sheet Metal > Construct > 3D Axis

Surfaces > Construct > 3D Axis

Weld > Construct > 3D Axis

Primitives > Construct > 3D Axis

Support Geometry > 3D Path > 3D Axis

Keyboard Textual Menu

<3PX> Construct > 3D Axis

It is also available as option in the 3D Path command:

<X> Axis

The command creates 3D axes on the basis of rotation surfaces and edges. Axes created in such a way

preserves associative links with the initial elements.
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General Information and Opportunities

This command allows you to create straight axes on the basis of surfaces of rotation (cylindrical,

conical, toroidal), as well as circular edges. As additional elements for specifying the dimensions of

the created axis, you can select any other model elements.

The 3D axis object may be used in the following ways:

· You can use it as a rotation axis or direction element when creating various operations

(extrusion, rotation, array, etc.);

· You can use it as an object for setting 3D dimensions (between axes, from axis to plane, edge,

etc.).

Any 3D path or track can be converted into a 3D axis object using the Convert to Axis command of

the context menu or enabling the corresponding parameter in the parameters dialog box.

3D axis is automatically created based on the center graphic lines or sketch lines of work planes and

projections.
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Also, the 3D axis can be used as an object to project. See the 2D Projections.

3D Axis Creation

You can select the element for a 3D axis creation using the automenu:

<M> Main element

This option becomes active immediately upon entering the command. It contains a list of 3D element

selection filters. The elements can be used as the basis for a 3D axis creation. You should pay attention

to the active filters when selecting elements. For more information about working with these filters,

see the chapter “Basic 3D Terms and Concepts of Modeling with T FLEX CAD”.

To select the main element you should point the cursor to the required object. The object will be

highlighted and the hint with the element name will appear. You should press  to select an

element.

The selection of the main item is canceled by clicking the Clear  button in the corresponding list in

the properties window or by clicking .

Perpendiculars dropped from the extreme points of the selected element on the axis are used as limits

of the 3D axis. If you select a round edge as a main element, a 3D axis of zero length will be created.

The 3D axis will be extended from the both sides according to the Overhang parameter value.
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To extend a 3D axis from one or both sides, you should select additional elements. The elements will

define the length of the axis. Use the following option for this purpose:

<G> Additional Elements

The selected elements will be automatically added to the corresponding list in the properties window.

Use the following buttons to edit the elements list: Collapse , Delete Element from the List ,

Clear .

In this case, the perpendiculars dropped from the extreme points of the additional elements to the

axis will be used as limits. 

In this case, the perpendiculars will be the limits of the 3D axis, dropped from the extreme points of

the additional elements on the axis, taking into account the value of the Departure parameter. The

Overhang parameter is also considered.

By default the Overhang parameter units are millimeters. You can change units by clicking on the

corresponding units icon.
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Transition 3D Path

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path > Transition Path

Surfaces > Construct > 3D Path > Transition Path

Sheet Metal > Construct > 3D Path > Transition Path

Weld > Construct > 3D Path > Transition Path

Routing > Construct > 3D Path > Transition Path

Primitives > Construct > 3D Path > Transition Path

Support Geometry > 3D Path > Transition Path

Keyboard Textual Menu

<3KCB> Construction > 3D Path > Transition Path

It is also available as option in the 3D Path command:

<C> Transition Path

This method is used to connect two elements with wire geometry in a transitional 3D way with the

ability to control the interface parameters and the boundaries of the extreme points. Elements with

wire geometry include all linear objects - edges, 3D paths, cycles, and some types of 3D profiles. Such

elements can be either closed or open.
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1 – source elements of wire geometry; 2 - resulting 3D paths

The first step in creating a transition 3D path is determining the resulting curve shape: Spline  or

Rounding . It is set with the help of corresponding icons in the properties window. By default

the system sets the curve shape as spline.

You can select the initial wire objects between which the bridge is to be built at the 3D scene or from

the 3D model tree when the following options are enabled:

<Q> Select Start

<E> Select End

The initial objects end points joined with the 3D path are selected in the same way as the objects,

using the corresponding automenu options:

<W> Select Start Geometry

<R> Select End Geometry

All the selected objects are shown in the corresponding fields in the command properties window. To

cancel selection of an object Clear  button is used.

Moving the transition 3D path limits along the initial objects can be set in three ways:

· As a value in mm or other units of measurement;

· As a percentage of the initial object length;

· By Point, belonging to the initial object.

For a spline type of curve the kind of joining at the transition interface between the initial object and

the resulting 3D path is determined by continuity condition:

· By Point G0 continuity is points coincidence in space; 

· By Tangent G1 continuity is geometrical continuity in the first derivative;

· By Curvature G2 continuity is geometrical continuity in the second derivative; 

· By Flow G3 continuity is geometrical continuity in the third derivative.

For G1, G2 and G3 continuity conditions it is allowed to set Tangent magnitude value – it is a

coefficient scaling derivative value in the given direction. By default this value is equal to [1].
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Initially the transition curve is built so that it forms a direct touch with the initial object. You can

change the touching direction to the opposite one by clicking .

When creating a transitional 3D path of a spline shape, it is allowed to assign supporting surfaces

(surfaces on which the resulting curve should lie). The selection is made using the following automenu

option:

<T> Select Supporting Geometry

All selected surfaces are displayed in the corresponding list of the command parameters window.

You can control Indent and Tangent magnitude parameters at the 3D scene by means of draggers of

the same name. You can disable displaying them in the Options tab of the properties window.

Initial objects conjugation with a rounding type of curve is determined by Radius parameter. By default

its value is set in millimeters, but it is allowed to change units of measurement.
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Sew option is used to join the resulting transition curve and initial objects into one 3D path.

It is also available as option in the 3D Path command:

<C> Transition Path

This way is used for joining two elements having a wire geometry using a transition 3D path with the

ability to control joining parameters and end points limits. All linear objects – edges, 3D paths, cycles,

some kinds of 3D profiles – belong to wire geometry elements. Such elements can be either closed or

open-loop.

The first step in creating a transition 3D path is determining the resulting curve shape: Spline or

Rounding. It is set with the help of corresponding icons in the properties window.

By default the system sets the curve shape as spline.

You can select the initial wire objects between which the bridge is to be built at the 3D scene or from

the 3D model tree when the following options are enabled:

<Q> Select Start

<E> Select End

The initial objects end points joined with the 3D path are selected in the same way as the objects,

using the corresponding automenu options:

<W> Select Start Geometry

<R> Select End Geometry
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All the selected objects are shown in the corresponding fields in the command properties window. To

cancel selection of an object Clear  button is used.

Moving the transition 3D path limits along the initial objects can be set in three ways:

· As a value in mm or other units of measurement;

· As a percentage of the initial object length;

· By Point, belonging to the initial object.

For a spline type of curve the kind of joining at the transition interface between the initial object and

the resulting 3D path is determined by continuity condition:

· By Point G0 continuity is points coincidence in space; 

· By Tangent G1 continuity is geometrical continuity in the first derivative;

· By Curvature G2 continuity is geometrical continuity in the second derivative; 

· By Flow G3 continuity is geometrical continuity in the third derivative.

For G1, G2 and G3 continuity conditions it is allowed to set Tangent magnitude value – it is a

coefficient scaling derivative value in the given direction. By default this value is equal to [1].

Initially the transition curve is built so that it forms a direct touch with the initial object. You can

change the touching direction to the opposite one by clicking .

You can control Indent and Tangent magnitude parameters at the 3D scene by means of draggers of

the same name. You can disable displaying them in the Options tab of the properties window.
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Initial objects conjugation with a rounding type of curve is determined by Radius parameter. By

default its value is set in millimeters, but it is allowed to change units of measurement.

Sew option is used to join the resulting transition curve and initial objects into one 3D path.

Isoparametric Curve

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path > Isoparametric Curve

Surfaces > Construct > 3D Path > Isoparametric Curve

Sheet Metal > Construct > 3D Path > Isoparametric Curve

Weld > Construct > 3D Path > Isoparametric Curve

Routing > Construct > 3D Path > Isoparametric Curve

Primitives > Construct > 3D Path > Isoparametric Curve

Support Geometry > 3D Path > Isoparametric Curve

Keyboard Textual Menu

<3KCU> Construction > 3D Path > Isoparametric Curve

It is also available as option in the 3D Path command:

<I> Isoparametric Curve

This method is designed to generate isoparametric curves (isocurves) on a selected surface (including

imported ones). Isoparametric curves should be understood as curves representing the skeleton of any

surface. Thus, the generated isoparametric curves can be used as a reference to the selected surface.

This method involves several options for the position of the isocurves:

· Uniform. In this case, the specified number of isoparametric curves is located uniformly over

the entire surface in the specified directions.
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· Through Points. In this case, the position of the isocurves is determined by parametric points.

The points are determined by the values of the parameters U and V. In addition, any geometric

points of the model can be used as parametric points – 3D nodes, vertices, edge centers.

If the geometric points of the model are used as parametric points that determine the position

of isocurves, the latter do not necessarily belong to the selected surface.

· Between Points. In this case, the specified number of isoparametric curves is located evenly

between two parametric points. 

After activating this command, you need to select the surface on which you want to get curves. The

selection is made in the 3D scene (using ) or in the 3D model tree when the option is enabled:
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<S> Select Surface

The selected object is displayed in the Face field in the parameters window. The selected object is

canceled using the Clear  button.

The next step in generating isocurves is to determine their direction: in the direction of U, V or UV. To

do this, the corresponding buttons are provided in the parameters window.

U

V

UV

The choice of the location of the isocurves is also carried out in the parameters window using the

corresponding buttons. Depending on the selected option, the necessary parameters and automenu

options are activated.

Uniform

Through Points

Between Points

If the position of the isocurves is uniform, it is necessary to specify their number.

With the Through Points variant of the position of the isocurves, the parametric point is set when the

automenu option is enabled:

<B> Select Point

The parametric point is set by clicking the cursor anywhere on the selected surface, followed by

changing the parameters U and V. The convenience of managing the parameters U, V is achieved by

using manipulators in a 3D scene, the display of which can be disabled on the Options tab if

necessary. The values of the point movements along the U, V axes are displayed in the corresponding

fields of the parameters window.
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The geometric point of the model is selected as a parametric point in the 3D scene (using ) or in

the 3D model tree.

If the geometric points of the model are used as parametric points that determine the position

of isocurves, the latter do not necessarily belong to the selected surface.

<N> Add Point

With this variant of the arrangement of isocrives, it is allowed to add an unlimited number of

parametric points.

All the specified points are displayed with the values of the parameters U, V in the corresponding list

in the parameters window. The list of points is controlled using the Expand , Collapse , Delete

Element from the list , Clear  buttons. The Delete Geometric Binding  button is designed to

remove the binding of a parametric point to a geometric one.
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In the Between points variant of the isocurves position, it is necessary to specify two parametric points

between which curves will be generated, as well as the required number of curves.

By default, the resulting set of generated isoparametric curves is created as separate 3D paths. If

necessary, it is allowed not to divide the set of isocrives into separate 3D paths. To do this, uncheck

the Split flag in the Options tab in the command parameters window.

Conic Curve

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path > Conic Curve

Surfaces > Construct > 3D Path > Conic Curve

Sheet Metal > Construct > 3D Path > Conic Curve

Weld > Construct > 3D Path > Conic Curve

Routing > Construct > 3D Path > Conic Curve

Primitives > Construct > 3D Path > Conic Curve

Support Geometry > 3D Path > Conic Curve

Keyboard Textual Menu

<3KCC> Construction > 3D Path > Conic Curve

It is also available as option in the 3D Path command:

<W> Conic Curve

Conic curves are curves of conic sections, i.e. obtained as a result of the intersection of a straight

circular cone with planes that do not pass through its vertex.

Depending on the position of the secant plane, the following types of conical curves are distinguished:

· If the secant plane cuts off all the forming cones at the points of one of its cavities, then as a

result, the intersection line is a closed curve - an ellipse. A circle is a special case of an ellipse

when the secant plane is perpendicular to the axis of the cone.

· If the secant plane is parallel to one of the tangent planes of the cone, then as a result, the

intersection line is an open, infinite curve - a parabola lying entirely on one cavity of the cone.
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· If the secant plane intersects both cavities of the cone, then as a result, the intersection line is a

hyperbola – two identical open parts extending to infinity (branches of the hyperbola), each of

which lies on its own cavity of the cone.

Five geometric conditions are sufficient to form any type of conical curve. These conditions can be:

· Extreme points of a conical curve;

· Inner points of a conical curve;

· Guides of a conical curve at its extreme points;

· The vertex is the intersection point of the guides of the conical curve;

· Engineering discriminant is a coefficient that characterizes the degree of convexity of a conical

curve. Is equal to the ratio of the part of the median bounded by the curve (h) to the length of

the entire median (H) of the triangle formed by the vertex and the extreme points of the curve.

1 – extreme points; 2 - inner point; 3 - guides; 4 - vertex

Thus, the value of the engineering discriminant varies from 0 to 1. With a value greater than 0.5, the

resulting curve has the shape of a hyperbola; with a value equal to 0.5, it has the shape of an ellipse;

with a value less than 0.5, it has the shape of a parabola.
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       Discriminant = 0.25         Discriminant = 0.5        Discriminant = 0.75

Depending on the combination of geometric conditions, the system provides six modes for

constructing a conical curve:

By 5 Points

By 2 Points, 2 Guides and Discriminant

By 3 Points and 2 Guides

By 2 Points, Vertex and Discriminant

By 3 Points and Vertex

By 4 Points and Guide

For each characteristic point of a conical curve, it is allowed to specify an additional curve along which

the point can be offset. The offset is set relative to the nearest end of the specified curve in the

parameters window. The convenience of displacement control is achieved by using a manipulator in

the form of a point in a 3D scene.
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1 - characteristic point of the conical curve; 2 - offset curve; 3 - offset manipulator

The resulting conical curve lies in a plane determined by the system automatically. If necessary, it is

allowed to explicitly specify the plane to which the curve should belong. In this case, all objects that

do not belong to the specified plane are projected onto it, and the curve is formed based on their

projections.

1 – source objects that do not lie in the target plane; 2 - target plane; 3 - projections of the source objects on the

target plane; 4 - resulting curve.

The conic curve construction mode is selected in the parameters window. Depending on the selected

mode, the set of source data and the composition of the window changes.

To select the geometric points of the model as characteristic points (initial, internal, final) of the

conical curve, use the following option:

<O> Select Conic Curve Points

Objects are selected in the 3D scene (using ) or in the 3D model tree.

All selected points are displayed as a list in the parameters window in the appropriate sequence. The

list of points is controlled using the Expand , Collapse , Delete Element from the list , Clear

 buttons.
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To replace an object used as one of the characteristic points of a conical curve, select it from the list,

and then specify a new geometric object.

Specifying a curve to offset the current characteristic point along it is carried out in a 3D scene or a

model tree using the following automenu option:

<C> Select Curve

The selected object is displayed in the Curve field in the parameters window. Cancel and re-select by

clicking the Clear  button. The offset value is set in model units in an adjacent field or using a

manipulator in a 3D scene.

 

If the selected point of the conical curve belongs to a specific wire object (edge, 3D path, etc.),

then the latter is automatically selected as an offset curve.

The conic curve guide is set after selecting the extreme point in the list of points and using the

following automenu option:

<T> Select Guides of Conic Curve

The object is selected in the 3D scene (using ) or in the 3D model tree.

The selected object is displayed in the Guides field in the parameters window. Cancel and re-select by

clicking the Clear  button.
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To set a geometric point as the vertex of a conical curve, a special automenu option is provided:

<V> Select Vertex of Conic Curve

The object is selected in the 3D scene (using ) or in the 3D model tree.

The selected object is displayed in the Vertex field of the parameters window. Cancel and re-select by

clicking the Clear  button.

 

To control the engineering discriminant, a special slider is provided in the parameters window that

allows you to change the value from [0] to [1] in increments of [0.01]. If necessary, you can enter the

value manually.
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Specifying the target plane to which the conic curve should belong is done using the following

automenu option:

<L> Select Conic Curve Plane

The selected plane is displayed in the corresponding field of the parameters window. Cancel and re-

select by clicking the Clear  button.

The offset manipulators of the characteristic points of the conical curve along the curves in the 3D

scene are displayed using the Use Manipulators option.

The Sew option is designed to combine a conical curve with the offset curves of the extreme points

into one 3D path.

3D Path by Function

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Path by Function

Assembly > Construct > 3D Path by Function

Sheet Metal > Construct > 3D Path by Function

Surfaces > Construct > 3D Path by Function

Weld > Construct > 3D Path by Function

Primitives > Construct > 3D Path by Function

Support Geometry > 3D Path > 3D Path by Function

Keyboard Textual Menu
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<3PL> Construction > 3D Path by Functions

It is also available as option in the 3D Path command:

<N> 3D Path by Function

This command allows you to create a 3D path using a function in a given coordinate system.

There are 3 types of coordinate systems available - Cartesian, Cylindrical, Spherical. Each coordinate

system has its own set of parameters. So, for example, for a Cartesian coordinate system it is proposed

to specify formulas for X, Y, Z, for cylindrical with respect to ρ , φ , Z, and for spherical with respect to ρ ,

θ, φ .

For all types of coordinate systems, it is possible to select, create and delete a type of function.

For each type of coordinate system, it is possible to set the interval, accuracy and select the origin of

the 3D path. You can also close the 3D path using the Periodic option.

Modification of 3D Path

The path modification command can be called from the Ribbon in the 3D path list: Change 3D Path

Length and Smooth 3D Path. 



3D Constructs. Support Geometry.

1257

You can also call the Modify command from the path context menu.

Smooth 3D Path allows you to round all sharp edges on the path, and Change 3D Path Length allows

you to set the law of lengthening the path from its extreme points or change the total length of the

path to a specified value. You can change the length symmetrically on both sides or specify an

invariable side.

You can select only one smoothing modification and one length change modification for each path.

Modification options can be added using the icon .

When you call the modification command again, the parameters of the previous modification will

already be set for the path in the dialog. You can change the modification parameters, or you can

delete one of the two modification options  or both modification options at once. 
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3D Path Parameters

General Tab

· Name. The name is used to identify and search for an item. For 3D paths, the following names

are created by default: 3D path_1, 3D path_2, and so on. You can change the name when

editing the 3D path.

· Level.

· Quality. A number (from 0 to 1) that specifies the quality of the visualization. The higher the

value, the better the image, but it increases the amount of memory used and takes longer to

calculate. The value corresponding to the [Standard] setting is set in the document Parameters

command. 

· Layer.

· Color. Sets the color of the three-dimensional object to create. When rendering in color mode,

you don't use Tonal paint with materials.

· External. If the model is used as a 3D fragment, the 3D paths that have this parameter set are

available in the Assembly model. The position of this path is determined by the position of the

associated model. The 3D paths raised from the 3D fragment have special names (Reference

to 3D path_01). You can also set this parameter for them and use them in next-level Assembly

models.

· Reverse direction. When the flag is set, the path direction is reversed.

Transformation Tab

· Offset. A set of parameters that defines the path offset relative to the global coordinate

system.

· Angle. A set of parameters that defines the values of the rotation angles of the path around

the axes of the global coordinate system and the sequence of their execution.

· Scale. Sets the zoom level of the path.
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Turn angles are set counterclockwise when viewed from the direction of the axis arrow. If the offset

and turns are set simultaneously, the turns are performed first, followed by the offset.

Tab by 3D nodes

Type of polyline.

· Polyline. A section of the path enclosed between two selected 3D nodes will be displayed as a

set of segments.

· Spline. The path section enclosed between the two selected 3D nodes will be displayed as a

spline. 

Type. 

· Open. When building this type of spline, it is built from the start to the end point. 

· Closed. If you select this option, the first and last sections of the path will close after you

confirm the 3D path setting.

Offset tab (for equidistant 3D paths).

· Value.  Sets the equidistant offset. If the offset value is positive, the original contour increases;

if it is negative, it decreases.

· Processing gaps. Defines how to handle gaps.

· Continue (continuation of the equidistant line according to the lines forming the original

contour).

· Round (creates a rounded corner between the endpoints of two adjacent segments).

· Extend (straight lines continue from the break points, parallel to the tangent lines of the

contour at the break point).

Rounding Radii tab

Total radius of the rounding. Radius applied automatically to all new sections of the pipeline path.

Minimum length of the path. It is used for checking and warning the user about incorrect input of

pipeline nodes.

Rounding radii table at points shows the nominal and received radii for all 3D nodes of the pipeline

path.

Default. The selected option means that the specified General parameters will be used for all

subsequent operations.

Transformation Tab

Default. The selected option means that the specified General parameters will be used for all

subsequent elements.

Options Tab (only in the system window)

Enable Manipulator. This option allows you to display the visibility of the manipulator during the

creation of a 3D node. When drawing on WP/faces/surfaces, the manipulator is disabled by default.

Edit 3D Path

Calling the command:

Icon Ribbon

-

Keyboard Textual menu

<3EPA> Edit > Construct > 3D Path

This command is used for editing 3D Path.
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Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the "3D node" command.

If you select multiple items, you can delete them. Note that the <Shift>  combination can be used

for multiple selection (the <Ctrl>  combination cancels the selection).

Route

The route is a special type of a 3D path, that is composed of straight segments. The adjacent straight

segments are connected by arcs of a specified radius. This type of a 3D path is mostly intended for

defining a spatial trajectory used for creating pipelines.

Topics in this section:

· Main Concepts of Route

· Create Route

· Edit Route

Main Concepts of Route

Sections of the route

The system allows you to create a route consisting of several sections constructed by various methods:

· by specified points;

· using the geometry of already existing objects (elements of wire geometry, elements of

bodies).

When constructing the route by specified points for each new point in the scene, the LCS manipulator

appears. The manipulator allows you to set its position in absolute coordinates or relative to the
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selected binding (3D node, vertex, etc.). By default, the direction of the axes of the manipulator

coincides with the direction of the axes of the global coordinate system.

Manipulator provides for the following transformations:

· translation along the axis (X, Y, Z). To enable translation, move the cursor closer to the axis

arrow.

· translation in the plane (XY, XZ, YZ). To enable translation, move the cursor closer to the image

of the plane.

· translation by three axes. To enable translation, move the cursor closer to the sphere at the

center of the manipulator.

· rotation about the axis (X, Y, Z). To enable rotation move cursor closer to the arc (the color of

the arc corresponds to the color of the axis around which the rotation will be carried out).

Manipulator can work in one of the two modes:

· numeric specification of the transformation value. To work in this mode move the cursor of the

mouse closer to the manipulator (it will be highlighted and the tip will appear on the screen)

and translate the mouse with the pressed left button. Precise value of the transformation can

be specified on the system toolbar.

· transformation is prescribed by snapping to the existing object of the model (for example,

translation up to a 3D node). To work in this mode move the cursor of the mouse closer to the

manipulator and click . After that the object snapping will be working upon translation of

the cursor. In this way it is possible to specify the translation up to a point, edge midpoint, etc.

 

Any change in the location of the manipulator is reflected in the auxiliary window Transformations.

For each point of the path a separate list of transformations is saved. Translations along the axes are

summed up. Transformations with the use of object snapping are recorded as a separate line.

Transformation selected in the list can be deleted. The object snapping can be redefined by indicating

a new object in 3D scene.
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The order of transformations can be changed by moving transformation up and down along the list

with the help of buttons with arrows. However, it is important to take into account the fact that an

arbitrary change of the order might lead to the incorrect result.

There is the possibility of multiple editing of points. The selection of the required points is carried out

in the corresponding list in the properties window. After this translation of the manipulator will affect

the position of all selected points.

For a section of the route built at specified points, a type can be specified, which determines the

method of its construction:

· Spline through points;

· Spline by Polygon;

· Polyline.

Spline through points

It is a spline that passes through all given points. The minimum degree of such a spline (the degree of

the polynomials by which it is described) is 3.

The adjustment of the spline in terms of the behavior between adjacent specified points is determined

by the maximum deviation of its shape from the chord between these points.
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All default points are spline interpolation points. In the case when the exact passage through the point

is not required, but rather only the approximate one, it is necessary to remove the Interpolation Point

flag from it and set the maximum deviation value.

The deviation of the curve at all points of approximation is the same throughout the route.

At each interpolation point, it is allowed to change the smoothness parameters of the curve, setting

the direction and values of the first derivatives of the polynomials (Tangent parameter) of the spline. 

The value of the Tangent parameter is specified by the Tangent to curve at 3D Node arrow. 

The direction of the tangent is specified by two manipulators in the form of arcs Tangency Direction.
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For intermediate spline interpolation points, the system automatically selects the direction and

calculates the optimal values of the first derivative, while observing the condition for preserving the

smoothness of the curvature (the smoothness of the third derivative of the spline polynomials).

However, it is allowed to set different values. It should be remembered that in this case the condition

of preservation of tangency (smoothness of the first derivative of polynomials) is violated;

accordingly, the curvature at such points will tend to zero.

Spline by Polygon

Represents a spline that passes along a controlled polyline, providing the condition for continuity of

curvature. A polyline is a set of specified points connected in series by chords. The spline itself does

not pass through the points (except for the start and end points). By default, the system builds a spline

of the 2 degree. If necessary, you can change the degree of the spline, but the maximum allowable

value of the degree of the spline should be one less than the number of specified points.

The main parameter of the given points is the Weight of the curve function. The greater the weight of

the function at a point, the closer the curve goes to it.
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Polyline

It is a spatial polyline consisting of straight line segments, sequentially connecting a set of specified

points. This is a special case of a spline by broken line of the 1st degree.

For a polyline, a rounding can be specified with a total value for the entire section or separately for

each given point.

The rounding dragger is available for any given point of the section except the start and end points.

Moving the dragger changes the value of the rounding radius at the selected point.

Segments Based on Geometry of Existing Objects

The construction of sections of the route based on the geometry of existing objects involves the use of

the following types of elements:

· Based on paths/edges;
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· Based on surfaces/faces.

When building a route based on paths or edges, the created section will coincide with them

completely. You can change the position of the section, its starting and ending points using the

following draggers (the numerical values of the draggers can be set in the properties window).

· Location. Specifies the shift from the ends of the selected object.

· Offset. Specifies the shift of the segment of the path from the selected object.

· Starting angle. Specifies the angle of rotation around the selected edge/path. Located at the

start point of the path section.

· Twist angle. Specifies the angle of rotation of the end point with respect to the start point of

the path section.
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When creating a route by a set of edges (paths), it is necessary to add a separate section for each of

them.

When creating a route based on faces or surfaces, the starting point of the section is created on the

surface of the object at the point of the mouse click. After that, after adding a new point, you can

move it using the manipulator or by setting the coordinates U, V in the properties window.

The created curve can be moved along the normal to the surface, and an equidistant to the section

lying on the surface is created.  It is allowed numerical values in the properties window.
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Despite the difference in construction methods, the areas can be mated with each other, forming a

single spatial 3D path. In addition, it is allowed to combine several 3D paths into one, as well as break

the existing one into smaller ones.

When mating several sections of different types in one route and when several routes join, a transition

zone is constructed between sections in the form of an additional curve which is connecting them.

Moreover, the smoothness of the first derivative of polynomials is ensured by the equality of the

values of the parameters Tangency on Start, Tangency on End of the points being connected. In

addition, the system allows you to automatically provide the smoothness of all transition zones,

selecting the optimal values of the above parameters for all mating sections by the Create smooth

path parameter.
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If a newly created route starts at the extreme point of an already existing route, then the system allows

them to be smoothly mated, while at the same time allowing you to change the direction of tangency

using the Reverse outer tangent parameter.

When combining the selected section with the following, both of them should be of the same type.

The resulting curve will inherit the parameters of the first section.

The section is divided into two sections by the selected point, the route is divided into several routs -

by the selected section. 

The system allows you to change the direction of the created sections to the opposite. 

Using context menu in work with the manipulator

When selecting the manipulators the following commands will become available in the context menu:

· for translation along the axis
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· for translation in the plane

· for translation along three axes

· for rotation around the axis

The option of the Settings menu defines the step with which the distance and the angle change upon

translations and rotations of the manipulator.

Additional features

For convenience and clarity of work with the command, the system offers a number of options.

· Pipe Diameter. The option allows to dynamically display a preview of the route in the 3D

scene by setting the curve thickness (increases convenience when working with a large number

of 3D paths in the scene).
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· Mark points with curvature less than. Displays diagnostics in the 3D scene about points of the

3D path in which the radius of curvature is less than the specified one.

· Mark breaks. Displays diagnostics in the 3D scene about the points in which the direction of a

curve changes in such a way that zero curvature and an infinitely large radius appear.

· Check self-intersections. Displays diagnostics in the 3D scene about the self-intersection

points of the 3D path.

Create Route

Calling the command:

Icon Ribbon

3D Model > Construct > Route

Assembly > Construct > Route

Sheet Metal > Construct > Route

Surfaces > Construct > Route

Weld > Construct > Route

Routing > Construct > Route

Primitives > Construct > Route

Support Geometry > 3D Path > Route

Keyboard Textual Menu

<3PP> Construction > Route

The same command is invoked from the pipeline creation command with the help of the option of the

automenu:

<B> Create/edit route

The Type parameter allows you to assign a routing group to which this route will belong. This allows

you to eliminate errors when creating pipelines, when there are several communication groups in the

assembly at once.
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Creating and editing points

After invoking Route command the first section with the start point is automatically created. This point

becomes active. A point is considered active when it is highlighted in the list of points in the

properties window. A manipulator of the active point appears in the 3d window.

By default the following option is active in the automenu:

<F> Select a point

This option allows you to bind route points to geometric 3D points of the model (3D nodes, vertices,

etc.). In this case, the parent geometric object will be displayed in the list of points next to the point

name in parentheses.

Deleting a point binding to a geometric object is implemented using the following automenu option:

<L> Delete linking of Point

After deleting the link, location of the point is stored in absolute coordinates

The system offers two modes of adding points, the choice between which is done by the auto-menu

buttons:

<H> Add Note at the end of Path

<J> Add Note at the beginning of Path

In the case of adding points before the active point, new points are added to the beginning of the

section.

Change the location of the active point by using the manipulator in the 3d window. The absolute

coordinates are shown in the properties window. For points of the section by surface fields the U, V, N

coordinates are filled in. For points of the section by edge the U, V, R coordinates are filled in.

Coordinate values can be changed manually.
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When creating or editing a point it is often more convenient to specify the values of the shifts but not

their absolute coordinates. For input of this data the group of parameters Offset is used. When

creating the new point its location initially coincides with the point created just now. By specifying the

value of the shift, we translate the active point with respect to the previous one. If the shifts are

specified upon the editing of the point, then the result will be its translation relative to its current

location.

If the Offset flag is set for a point, then it is not recommended to bind this point to a geometric

object. The point should be free from geometric binding.

Segment points can be specified in the coordinates of an arbitrary LCS. To select\cancel LCS in

automenu use options:

<C> Select LCS

<V> Cancel LCS selection

After selecting a coordinate system, it will be used for the current point and all points that are created

after the current one. LCS deselection transfers the coordinates of the current point to the global

coordinate system. Section of the path can contain any combination of coordinates definition.

 A new point creation is performed using the automenu option:

<Enter> Finish point Editing and create new Point

The new point is initially located in the same coordinates as the point created just now.

To delete the active point, you need to use the automenu option:
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<Del> Delete Point from Path

In the properties window next to the list of points there are the buttons, which also allow us to add the

points before  or after  the active point, delete the active point , delete link of points ,

split section into two at the active point , and import points from external file*.txt and *.csv .

Depending on the selected curve type, the corresponding point parameters are activated.

Parameters of points are set in the corresponding tab of the properties window depending on the

selected type of the section of the path.

The Rounding parameter allows you to specify the rounding radius of a Polyline type area at a

selected point.

The Tangent parameter sets the same value of the first derivative of the polynomials of the curve

before and after the selected point. To set different values, disable the Symmetric flag:

The Reverse outer tangent parameter is used to change the direction of one route when smoothly

mating with another.

The Tolerance parameter is used for the Spline through points segment type. To set the maximum

deviation of a curve from a point, it is necessary to disable the Interpolation Point flag (the other

parameters of the point will not be available):

The Weight parameter determines the degree of influence of the selected point on the segment of

the Spline by Polyline type.

Creating and Editing Sections

The list of sections of the route is displayed in the corresponding tab of the properties window. To

add a new section, use the Add...  and Add to End  buttons. To delete the current section use

the Delete  button. 

When deleting a section from the middle of the list, the previous and the following section are

connected by a transition zone.

The Merge with Next  button allows you to combine two sections of the same type into one.
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The division of the area is carried out at the selected point using the Split  button.

Sections can be moved using the Move Up  and Move Down  buttons.

The parameters Tangency on Start and Tangency on End allow you to provide a smooth conjugation

between the transition curve and the mating sections.  The option Create smooth path provides

automatic smoothing of all transition zones between sections. The option is located in the Options

tab of the properties window.

The Reverse Curve Direction parameter allows you to change the direction of the section to the

opposite. This is useful when adding new sections to provide the same direction of the curve in all

sections of the route.

For a section of the route built on specified points, the type that determines how to build it is selected

in the drop-down list on the Sections tab in the properties window.

The parameters of the curve section, depending on its type, are set in the corresponding tab of the

properties window.

The Spline Degree parameter is used for the Spline through points and Spline by Polyline section

types.

The Radius of Rounding parameter sets the total rounding value for all points of the section of the

Polyline type.

The Offset parameter sets the value of the movement of the section created by the path/edge and the

surface/face, along the normal from the object.

The Straighten by Chord parameter allows setting the value of the maximum deviation of the curve

shape from the chord between the interpolation points in the corresponding field for a Spline

through points type.
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To create a section based on paths or edges, use the option:

<E> Create segment by path/edge

After activating the option, you should specify an object of one of the types:

The selected object will set the trajectory of the created section. The positioning of its starting and

ending point is performed with the help of manipulators or by setting the coordinates U, V in the

properties window. The R field duplicates the value of the Offset parameter.

To create a section based on faces or surfaces, use the option:

<S> Create segment by surface/face

After activating the option, you should specify an object of one of the types:
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The start point of the section is created at the place of the mouse click. After that, having added the

new point, it can be translated with the help of the manipulator or by specifying coordinates U, V in

the properties window. Coordinate N duplicates values of Offset parameter.

Edit Route

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3EPP> Edit > Construct > Route

To combine the created route with the existing one, use the option:

<M> Merge two paths

After activating the option, you should specify the target route to combine with. If the routes do not

have common points, a transitional curve will be created between them.

To divide the route into two, use the option:

<D> Split Path

The separation of the route is performed from the current section. After separating the path, the

transition zone between the sections is deleted, and the system proceeds to editing of the newly

created route.
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The construction of the route, smoothly mated at the point with the existing one, is performed by

setting the Tangency on Start flag and selecting the direction of tangency using the Reverse outer

tangent parameter

Available option for editing Route:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation

3D Profile

Calling the command:

Icon Ribbon

3D Model > Construct > 3D Profile

Draw > 3D Model > 3D Profile

Assembly > Construct > 3D Profile

Sheet Metal > Construct > 3D Profile

Surfaces > Construct > 3D Profile

Weld > Construct > 3D Profile

Primitives > Construct > 3D Profile

Workplane > 3D Model > 3D Profile

Keyboard Textual Menu

<3PR> Construction > 3D Profile

This command includes following types of 3D profiles:
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<H> 3D Profile by 2D Elements

<L> 3D Profile by 3D Elements

<J> 3D Profile Projection to Face

<S> Unfold Surfaces

3D profile is one of the most important elements in T-FLEX CAD. 3D profile is a contour oriented in

the 3D space in accordance with orientation of elements used for defining profile. 

Profile geometry types

3D profiles are based on contours. Contour is a sequence of main elements (graphic lines, hatches,

texts, edges, loops, 3D paths) where each subsequent element starts at an endpoint of a previous

element. Contour is closed if endpoint of last element coincides with starting point of first element.

Contour is flat if all its elements lay in the same plane, otherwise contour is spatial. Therefore, 3D

profiles are classified as:

· flat and spatial;

· closed and open;

· single-contoured and multi-contoured.

Sweeping a profile by any means in the space is the base operation for a body creation.

Profile geometry type defines a type of object created on its base by default. Using an open contour

in extrusion yields a surface, using closed contour yields a solid body.

Creating a 3D profile from a parametric 2D contour located on a workplane page allows propagating

parametric properties of two-dimensional drawings into the realm of solid modeling.

Closed multi-contoured profiles

Following configurations of closed multi-contoured profiles and resulting bodies are possible:

· Intersecting contours 

Upon attempt to create a profile based on such contours, the system displays a message:

"Contours contain self-intersections or bifurcations. Thickness definition is required for

proper result. Would you like to edit properties of thickness for this profile?". In case of

negative answer a profile is not created. In case of positive answer the 3D profile parameters

dialog is invoked, where you should define a value and a type of thickening.
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· Non-intersecting non-nested contours

A single solid body consisting of several non-connected parts is created by default upon

extruding or rotating such profile. You can divide such body if necessary.

· Non-intersecting nested contours

The outer (first) contour defines boundaries of a resulting solid body. The second contour,

which is enclosed by the first one, defines boundaries of a hole. The contour enclosed by the

second one defines other boundaries of a solid body and so on. Several contours on the same

nesting level result in several holes or several solids. Even if several solids are present, the

result is considered a single body, which can be manually divided if necessary.
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Open multi-contoured profiles

Following configurations of open multi-contoured profiles and resulting bodies are possible:

· Intersecting or bifurcated contours

Upon attempt to create a profile based on such contours, the system displays a message:

"Contours contain self-intersections or bifurcations. Thickness definition is required for

proper result. Would you like to edit properties of thickness for this profile?". In case of

negative answer a profile is not created. In case of positive answer the 3D profile parameters

dialog is invoked, where you should define a value and a type of thickening.

 

· Non-intersecting non-bifurcated contours

A single body consisting of several non-connected surfaces is created by default upon

extruding or rotating such contour. You can divide such body if necessary.
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Topics in this section:

· 3D Profile by 2D Elements

· 3D Profile by 3D Elements

· 3D Profile Projection

· 3D Profile by Surface Unfolding

· Thickening Flat 3D Profiles

· 3D Profile Parameters

· Edit 3D Profile

3D Profile by 2D Elements

The command can be called in one of the following ways:

Icon Ribbon

3D Model > Construct > 3D Profile by 2D Elements

Sheet Metal > Construct > 3D Profile by 2D Elements

Surfaces > Construct > 3D Profile by 2D Elements

Weld > Construct > 3D Profile by 2D Elements

Primitives > Construct > 3D Profile by 2D Elements

Support Geometry > 3D Profile > 3D Profile by 2D Elements

Keyboard Textual Menu

<3KRF> Construct > 3D Profile > 3D Profile by 2D Elements

It is also available as option in the 3D Profile command:

<H> 3D Profile by 2D Elements

3D profiles based on 2D elements are widely used in all stages of 3D modeling. Profiles can be based

on graphic and sketch lines, hatches of any type, and texts written in TrueType fonts (such fonts are

indicated by the  icon). 2D elements for 3D profile creation may lay on workplanes or worksurfaces.

Elements laying on a workplane produce a flat profile. Elements laying on a worksurface produce a

spatial profile following the shape of a worksurface.
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Text written in TrueType font ( ) is considered a union of closed contours, where each contour

is a separate character. Thus, the resulting 3D profile is a multi-contoured. Elements of a text

that cannot be transformed into the profile contour lines are ignored. For example, if a

roughness symbol was inserted in a text, then only letters and numbers in the roughness notation

will be used for generating the contour lines, while the strokes of the roughness symbol itself will

be ignored.

3D profile creation modes

Following ways of creating 3D profile by 2D elements are available:

·  by elements;

·  by color;

· automatic.

It is also possible to set an additional snap.

Creating 3D profile by elements

In this mode 3D profile is created from manually selected 2D elements of the same type belonging to

the same workplane or worksurface.

The mode is activated using the By Elements button located in the top of the Parameters window.

Then you need to select Source Elements. Elements can be selected either on an active workplane

(worksurface) or in the Model Elements window.
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The list of selected Source Elements is displayed in the Parameters window. You can Expand ,

Collapse , Clear  the list or Delete Element from the List  using buttons located on the right

side.

By default the system tries to auto-detect a worksurface which supports selected 2D elements. The

Worksurface is displayed in the eponymous field of the Parameters window and can be Cleared 

 and re-selected manually.

Creating 3D profile by color

In this mode 3D profile is created by automatically selected 2D elements of the same color belonging

to the same workplane (worksurface).

This mode is applicable to graphic lines only.

The mode is activated using the By Color button located in the top of the Parameters window. Then

you need to select a workplane (worksurface) using the  in the 3D scene or in the model tree. The

selected Worksurface is displayed in the eponymous field of the Parameters window and can be

Cleared  and re-selected. Upon selecting a worksurface, it is necessary to Select Color of elements

to be used for profile creation. Color can be selected from the drop-down list which opens upon

clicking the color sample icon and contains all colors used on this worksurface. You can also type in

RGB components values manually separating them by a comma.
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Automatic 3D profiles creation

This mode doesn't require to use the 3D Profile creation command. 3D profile is created automatically

upon exiting the active workplane mode if at least one suitable 2D element is drawn on such

workplane (worksurface). The principle of automatic 3D profiles creation depends on type of elements

drawn on workplane:

· If only graphic lines are present on an active workplane, the system automatically uses them

for profiles creation. When lines are drawn in multiple colors, the system asks if it should

create separate profile for each color of graphic lines. Upon negative answer a single profile

is created from all lines of the active workplane regardless of their color. Upon positive answer

several profiles are created and a color of each profile corresponds to a color of lines used for

its creation.
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If new lines are added to workplane after profiles creation, the system automatically adds such

lines to existing profiles. You can see which color of lines was used for a particular profile in the

3D profile parameters dialog. 

Color can be manually reselected or even cleared by disabling the Select Color checkbox. Upon

clearing the color, the profile is regenerated using all graphic lines existing on this workplane

(worksurface). Thickness should be applied if lines are intersecting or bifurcated.

· If hatches or texts are present on the active workplane, the system only uses them for 3D

profiles creation ignoring graphic lines. Each hatch and each texts is considered a separate

profile.
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Additional snap

By default a 3D profile based on 2D elements lays on a same workplane as those elements. However

you can manually select a 3D Node, so that profile will lay in a plane passing through such node and

parallel to the plane of 2D elements. Additionally you can change a position of a profile by selecting

a 2D Node on a plane of 2D source elements. The point of the profile corresponding to the selected

2D Node will coincide with the selected 3D Node.
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Additional Snap is not applied

The 3D Node is selected 

The 3D Node on the arbitrary plane and the 2D Node on the plane of

source elements are selected

2D Node can also be selected on an arbitrary plane. In that case the distance between projection of

source 2D elements onto profile's plane and resulting 3D profile itself is equal to the the distance

between 3D node and projection of 2D node onto profile's plane.
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Black circle - source 2D element

Blue circle - resulting 3D profile

3D - 3D node

2D - 2D node 

Selected 2D and 3D Nodes are displayed in eponymous fields of the Parameters window and can be

Cleared  and re-selected.

See also:

· Thickening Flat 3D Profiles
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3D Profile by 3D Elements

The command can be called in one of the following ways:

Icon Ribbon

3D Model > Construct > 3D Profile by 3D Elements

Sheet Metal > Construct > 3D Profile by 3D Elements

Surfaces > Construct > 3D Profile by 3D Elements

Weld > Construct > 3D Profile by 3D Elements

Primitives > Construct > 3D Profile by 3D Elements

Support Geometry > 3D Profile > 3D Profile by 3D Elements

Keyboard Textual Menu

<3KRV> Construct > 3D Profile > 3D Profile by 3D Elements

It is also available as option in the 3D Profile command:

<L> 3D Profile by 3D Elements

This type of 3D profile is based on existing 3D elements of a model. Geometry of a profile is fully

defined by selected 3D elements as changes upon changing such elements. Profiles of this type can be

flat or spatial.

3D Profile creation modes

Depending on source 3D elements there are different modes of 3D profile creation. Following

elements can be used as source:

·  existing 3D profile;

·  faces of solid body or surface;

·  closed sequence of edges;

·  loops;

·  closed 3D path.

Source 3D elements are selected using  in the 3D scene, model elements window or model tree.

Pay attention to active filters on the Filter Toolbar, when selecting elements. Selected elements are

added to the Source Elements list in the Parameters window. You can Expand , Collapse , Clear

  the list or Delete Element from the List  using buttons located on the right side.
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 3D Profile by an existing 3D Profile

Using an existing 3D profile as a source element results in creating a 3D profile equidistant to the

source one. Source profile can be single- or multi-contoured.

Source 3D Profile can only be flat, when creating an equidistant profile.

Offset of an equidistant profile can be defined in two ways: 

· By a numerical value of the offset distance between source profile and equidistant profile.

Setting a zero offset value results in creating a copy of the source profile.

· By defining a point for the equidistant profile to pass through. If selected node doesn't belong

to plane of source profile, it is projected onto such plane and projection is used for creating

an equidistant profile.

1 – source profile

2 – point

3 – resulting equidistant 3D profile

When creating an offset, three ways of handling gaps between the offset lines are possible:

· Round – rounds are constructed between the ends of the neighboring lines of the resulting contour.

· Extend – the gaps are closed by straight lines tangent to the offset lines at their ends.

· Natural – the curves that make the original contour are continued naturally. Straight lines are

continued straight, arcs - round.
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Round Extend Natural

If the source profile contains inner loops, their handling will be defined separately, regardless of the

offset distance sign. One of the two options can be chosen:

· Enlarge – offsets to inner contours are constructed by expanding the original contours.

· Decrease – offsets to inner contours are constructed by shrinking the original contours.

Enlarge Decrease

To create an equidistant profile you need to select a source profile first.

Offset is set in the Value input box, with the option to switch units of measurement. Point defining an

offset can be selected using  in the 3D scene, model elements window or model tree upon

activating the Element input box. When point is selected, the resulting offset value is displayed in the

Value input box, but it becomes non-editable. Clear  the point selection using the button located

in the right side of the Element input box, if you want to be able to type value again. The way of

handling gaps and inner loops can be selected in Gap Type and Internal Contours lists.

 3D Profile by faces of solid body or surface

When using a face (or set of faces) of solid or surface as a source element, the resulting 3D profile

represents a segment of face's base surface bounded by loops (closed sequences of edges) limiting

the base face. The resulting profile in this case always coincides with source elements. All faces in the

selected set should belong to the same body and faces should be adjacent to each other.
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1 - source face; 2 - resulting 3D profile

Source face (or set of faces) should be selected to create a 3D profile in this mode.

 3D Profile by loops

The resulting 3D profile in this mode represents a segment of loop's parent face's base surface. The

difference between this mode and the previous one is that here the resulting profile won't have inner

contours regardless of presence of holes in the source loop's parent face.

 

1 - source loop; 2 - resulting 3D profile

In cases where source loop is a boundary of two periodical base surfaces, it is possible to switch

between base surfaces.

1 - source loop; 2, 3 - resulting 3D profiles depending on the selected base surface

Source loop should be selected to create a 3D profile in this mode.

Switching between base surfaces limited by the same loop is performed using the Select Another

Region checkbox.
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 3D profile by closed sequence of edges

This mode of 3D profile creation uses closed sequence of edges belonging to various elements of the

model. You can also select a sequence of edges belonging to the same object, but the result in such

case will be identical to 3D profile by loops. Geometry of a profile is fully defined by selected edges

and their parents.

1 - source sequence of edges; 2 - resulting 3D profile

 3D Profile by closed 3D Path

This mode allows to create 3 profile based on a single closed 3D path. The path itself can be based on

edges of several object (faces of solids and surfaces, 3D profiles) and other 3D paths.

1 - source 3D path (closed); 2 - resulting 3D profile

3D Profile Projection

The command can be called in one of the following ways:

Icon Ribbon
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3D Model > Construct > 3D Profile Projection

Sheet Metal > Construct > 3D Profile Projection

Surfaces > Construct > 3D Profile Projection

Weld > Construct > 3D Profile Projection

Primitives > Construct > 3D Profile Projection

Support Geometry > 3D Profile > 3D Profile Projection

Keyboard Textual Menu

<3KRJ> Construct > 3D Profile > 3D Profile Projection

It is also available as option in the 3D Profile command:

<J> 3D profile Projection to Face

This command allows creating a new profile by transferring the original flat profile to a face or set of

faces in the body.  

Upon calling the command you need to select one of the two available modes:

·  Project 3D Profile to Face (or set of faces)

·  Wrap 3D Profile on Set of Faces

The set of available parameters depends on the selected mode.

1 – source 3D profile 

2 – projected 3D profile

3 – wrapped 3D profile

 Projecting 3D Profile

In this mode a source 3D profile is projected onto a face or a set of adjoining faces of a solid or

surface body. Upon selecting a face, it is not required for the final projection to fully fit such face

(though in some cases abrupt projections can not be generated), but it is required to avoid breaks in

projection. Upon selecting a body, it is required for the final projection to fully fit faces of such body
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and it is also required to avoid breaks in projection. The projecting direction is defined either by a

single object capable for defining a direction (straight 3D path, edge, LCS, workplane etc.) or by two

geometrical points (3D nodes, vertices etc.).

 

1 – source 3D profile

2 – source face or body

3 – points defining the projecting direction 

4 – projected 3D profile

If elements defining the projecting direction are not selected, the direction can be either normal to

the selected face (or nearest face of the selected body) or normal to the source 3D profile.

1 – source 3D profile

2 – 3D profile projected using direction normal to source profile

3 – 3D profile projected using direction normal to face

This mode can be activated using the  Project 3D Profile to Face button in the Parameters

window. Then you need to subsequently select a source 3D profile (displayed in the Planar Profile

input box), and a face or a body defining the set of faces for projecting (displayed in the Body or
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Face input box). Objects can be selected using  in the 3D scene, model elements window or model

tree.

Object defining a projecting direction can be selected upon activating the Direction or Point input

box. Upon selecting a point the additional Second Point input box appears.

You can Clear  the selection of any object using the button located in the right side of the

corresponding input box.

By default, the system automatically enables the Reverse Direction checkbox if selected projecting

direction is opposite to direction from source profile to face. However you can enable or disable it

manually if necessary. If elements defining the projecting direction are not selected, you can select

direction either  To Profile or  To Face in the Perpendicular drop-down list.

 Wrapping 3D Profile

This mode allows creating a new profile by wrapping the original profile on a face or set of faces in

the body.  A point is selected in the profile plane to be coincided to a point in the face. After

coinciding points by changing the profile's position, the profile is wrapped around the face, as if a

paper label on the bottle. 3D nodes are used as points on profile, any objects capable of defining a

point are used as points on face. The initial 3D profile should be flat.

The profile transformation is performed without rips or shrinkages of its surface – areas of the original

and the resulting profiles are equal. This condition poses restrictions on the used faces or sets of faces.

The faces allowed for wrapping profile are those that can be created by simple extruding.

However, those don't have to be produced by the extrusion operation per se. For example, a

cylinder is allowed, since it can be created by simple extruding, even if it was actually created by

the rotation. On the other hand, a cone, sphere or torus is not allowed, since it cannot be created

by the simple extrusion.

A plane orthogonal to all used faces is constructed through the selected 3D node on the face. If the

selected faces were constructed by an extrusion, then this plane would have been orthogonal to the

extrusion direction. The profile will be wrapped along the intersection line between this plane and the

selected faces. At this point, two possibilities exist for defining the direction of the profile wrapping

along the intersection line. The profile can be laid on either side of the reference point (see the

diagram).
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1 – source 3D profile

2 – first point on profile

3 – first point on face 

4 – virtual plane orthogonal to selected faces

5 – virtual intersection line between faces and plane

6 – two possible directions of wrapping

The plane orthogonal to the selected faces, the intersection line between the plane and the

faces and the direction vector of wrapping the profile are not displayed in the scene. Those are

shown in the diagrams for illustration purpose only.

To fully define the direction of wrapping the profile, it is necessary to select the second point on the

used faces. The selected node will define which out of the two possibilities should be used as the

direction of wrapping the profile.
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1 – second point on face defining the direction of wrapping

2 – direction of wrapping

3 – resulting profile

If the set of faces is defined in such a way, that the first point belongs to a side face, then the

wrapping direction is determined automatically – towards the adjoining faces. This is the case

when you do not have to select the second point on the face.

1 - automatically detected direction of wrapping

2 - resulting profile

The vector that defines the profile orientation on the face (set of faces) can be defined in two ways: by

using the second point on the profile plane, or without it. This vector is not displayed in the scene, and

is shown in the diagrams for clarity.

When using the second point, the start and the end of the new vector will be defined by the first and

second points on the profile plane. 
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1 - second point on profile

2 - direction normal to source profile

3 - profile-orienting vector

4 - direction normal to face

5 - wrapping direction

In the cases, when the second point on the profile plane is not selected, the direction is determined by

the following algorithm:

· The wrapping direction vector beginning at the first point on the surface is projected onto the

profile plane. This gives the direction of the new vector for profile orientation.

· The start of the profile-orienting vector is placed in the first point on the profile plane.

1 - direction normal to source profile

2 - wrapping direction

3 - direction normal to face

4 - profile-orienting vector

The arrows that are drawn from the first point on the profile and on the face show the normal

directions to the profile plane and to the surface. When wrapping the profile, the profile plane is

reoriented to have its normal coincide with the normal to the surface in the first selected point. The

normal direction of the profile plane can be flipped to the opposite. This allows turning the wrapped

profile 180° about the wrapping direction axis.
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1 - direction normal to source profile plane

2 - direction normal to face

This mode is activated using the   Wrap 3D Profile on Set of Faces button in the Parameters

window. Then you have to subsequently select Planar Profile, First Point on Profile, Faces for the

profile to be wrapped on, First Point on Face and Second Point on Face.

Additionally you can select Second Point on Profile if necessary.

Objects can be selected using  in the 3D scene, model elements window or model tree. Selected

objects are displayed in corresponding input boxes of the Parameters window.

You can Clear  the selection of any object using the button located in the right side of the

corresponding input box.

3D Profile by Surface Unfolding

The command can be called in one of the following ways:

Icon Ribbon
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3D Model > Construct > 3D Profile by Unfolding

Sheet Metal > Construct > 3D Profile by Unfolding

Surfaces > Construct > 3D Profile by Unfolding

Weld > Construct > 3D Profile by Unfolding

Primitives > Construct > 3D Profile by Unfolding

Support Geometry > 3D Profile > 3D Profile by Unfolding

Keyboard Textual Menu

<3KRS> Construct > 3D Profile > 3D Profile by Unfolding

It is also available as option in the 3D Profile command:

<S> Unfold Surfaces

This command allows to create a flat 3D profile by unfolding a face or set of faces using either

analytical or iterative method of unfolding. The resulting profile lays in a plane tangent to the initial

face. Profile passes through the tangency point. Tangency point should be selected on the initial face. 

Upon calling the command it is necessary to select an initial face (or set of faces). Faces can be

selected using  in the 3D scene or in the model tree, when the following automenu option is

active:

<O> Select Surfaces

Selected faces are displayed in the Elements for unfolding list in the Parameters window. You can

Expand , Collapse , Clear  the list or Delete Element from the List  using buttons located

on the right side.

The next step of constructing a 3D profile is the selection of unfolding method. Following options are

available in the Algorithm drop-down list:

· Auto

First, the system tries to apply the analytical method of unfolding. If it turns out to be

impossible, the iterative method is applied.

· Iterative

Iterative method includes approximation of initial surface's mesh.

The set of available parameters depends on the selected algorithm. 

Tangency point of initial face and resulting profile can be selected using  in the 3D scene or in the

model tree, when the following automenu option is active:

<A> Select 3D node as tangency point of profile and source face

The selected point is displayed in the Anchor point input box in the Parameters window and can be

Cleared  using the button in the right side of the input box.
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Automatic selection of unfolding algorithm

The analytical method of an unfolding construction is used for developable surfaces. Developable

surfaces are the ruled surfaces that can be unfolded so that all their points are combined with the

plane without any damage to the surface (gaps or folds). Such surfaces can be either closed (periodic)

or unclosed.

1 – initial face 

2 – anchor point 

3 – resulting 3D profile (unfolding of the initial face)

The point of tangency of profile and face can be set by any 3D object that can define the point (for

example, a 3D node or a vertex of the body). The specified point must lie on the initial face.
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If the selected face is closed (periodic), the point of tangency of the profile and the face is used to

specify the split line of the unfolding. The splitting is performed along a straight generatrix line

passing through this point.

1 – initial face 

2 – tangency (anchor) point 

3 – resulting 3D profile (unfolding of the initial face)

When unfolding a closed cylindrical or conical surface, it is possible to select other objects defining

the split line. 

In case of building a 3D profile as an unfolding of a closed cylindrical surface, the unfolding split line

can pass:

· Along a generatrix passing through a tangency (anchor) point;

· Along a generatrix passing through an additional 3D point;

· Along a 3D path, which must lie on the same geometric surface as the initial face (for

example, you can create an arbitrary 3D path and project it onto the face or build a path in a

cylindrical coordinate system with the same position and radius as the unfolding face) and its

ends must lie on the outer edges of the face.

An additional object defining the split line can be selected in the 3D scene or in the model tree upon

selecting an initial closed cylindrical face an activating the following automenu option:

<S> Select Split Line

Selected object is displayed in the Splitting element input box in the Parameters window and can be

Cleared  using the button in the right side of the input box.



3D Constructs. Support Geometry.

1305

  

1 - initial closed cylindrical face

2 - tangency (anchor) point

3 - resulting 3D profile (unfolding of the initial face)

4 - additional object defining the split line

In the case of building a 3D profile as an unfolding of a closed conical surface, the unfolding split line

can pass:

· Along a generatrix passing through a tangency (anchor) point;

· Along a generatrix passing through an additional 3D point.

An additional point defining the split line can be selected in the 3D scene or in the model tree upon

selecting an initial closed conical face an activating the following automenu option:

<S> Select 3D node to define split line

Selected object is displayed in the Splitting element input box in the Parameters window and can be

Cleared  using the button in the right side of the input box.
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1 - initial closed conical face

2 - tangency (anchor) point

3 - resulting 3D profile (unfolding of the initial face)

4 - additional point defining the split line

Unfolding Set of Faces using the Automatic Algorithm 

When unfolding a set of faces, such faces should have common edges.

If there is at least one non-developable surface in the set of faces, then the system uses an

iterative algorithm for constructing an unfolding, which gives an approximate result.

When creating a profile, several solutions may occur. By default, the system automatically chooses an

optimal solution. In order to obtain a specific variant of the profile construction, you can additionally

select “inseparable” edges, which are used as unfolding lines. When specifying edges, you should set

connections between all faces in the set. Otherwise, the face, which isn't connected by an “inseparable”

edge to any other face in the set, will be ignored during profile creation.
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1 - initial set of faces

2 - tangency (anchor) point

3 - resulting 3D profile (unfolding of the initial set of faces)

4 - set of inseparable edges

If you want to select inseparable edges, you need to enable the Cut by edges checkbox first. Then

edges can be selected using  in the 3D scene upon activation of the following automenu option:

<E> Select inseparably linked edges

Selected Inseparably linked edges are displayed in the eponymous list in the Parameters window.

You can Expand , Collapse , Clear  the list or Delete Element from the List  using buttons

located on the right side.
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By default, edges separating faces of the set are deleted on the resulting 3D profile. Enable the Keep

Internal Edges checkbox if you want to keep them.

Internal edges are kept Internal edges are deleted

Iterative Algorithm of Unfolding

The iterative method is used for non-developable surfaces. Non-developable surfaces include non-linear

surfaces and those ruled surfaces that cannot be turned into a plane without damaging the surface.

First, the system replaces the original surface by segments of developable surface in such way that the

result is approximately resembles the original surface. Then each of those segments is unfolded and

unfoldings of segments form a resulting 3D profile. For applying this method the surface must be

unclosed. The resulting profile may significantly differ from the original surface due to approximation.
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1 - initial face

2 - tangency (anchor) point

3 - resulting 3D profile (unfolding of the initial face)

When using the iterative algorithm, vertices of the initial face are only allowed as the tangency

(anchor) point.

To define the orientation of the resulting profile in the plane of tangency, it is possible to specify an

additional 3D point defining the direction of projection. The resulting vector (5) formed by the anchor

(tangency) point (1) and the projection of the additional point (3) will coincide with the vector (4)

formed by the anchor (tangency) point and the additional point itself (2).

  

The additional point can be selected in the 3D scene or in the model tree using the following

automenu option:
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<D> Select Point to Define Profile Orientation

Selected point is displayed in the Point that defines direction input box in the Parameters window

and can be Cleared  using the button in the right side of the input box.

You can also set a plane in parallel to which the resulting profile will be located.

The plane can be selected in the 3D scene or in the model tree using the following automenu option:

<P> Select Plane to Define Unfolding Direction

Selected point is displayed in the Plane that defines orientation input box in the Parameters window

and can be Cleared  using the button in the right side of the input box.

The accuracy of the resulting profile's contour can be adjusted using following parameters:

· Spline Interpolation Accuracy - the coefficient in range from 0.000001 to 1.

· Smooth Edges Angle - the max allowed angle (in degrees) between edges to consider them

smoothly connected; it is used upon automatic smoothing of the initial result.

The accuracy of initial face approximation can be adjusted using following Mesh Parameters:

· Edge Tolerance - max distance between edges of the initial face and edges of approximated

faces.

· Face Tolerance - max distance between the initial face and approximated faces.

· Angle Tolerance - max angle (in degrees) between edges of the initial face and edges of

approximated faces. The angle is measured a sum of angles between edges of approximated

faces and lines tangent to the initial edge at its ending and starting points. Also the same

parameter defines the max angle between between the initial face and approximated faces.

· Maximal Edge Length - max length of the approximated edge. If value is set to zero, this

parameter is ignored upon approximation.
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Unfolding Set of Faces using the Iterative Algorithm

Iterative algorithm can also be used for unfolding set of faces. However, the set should not form a

closed contour, because this algorithm doesn't support cutting by edges. The Keep Internal Edges

checkbox is still available.

Internal edges are kept Internal edges are deleted
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Thickening Flat 3D Profiles

Any flat profile representation can be changed by applying a Thickness.

Upon applying a thickness, the contour lines of the profile are offset. The new, thickened, contour is

constructed based on these lines. The contour geometry change can be seen by the solid body

resulting from it. 

   

When creating a 3D profile based on intersecting or bifurcating 2D elements, the use of this mode

may become the only possible way of constructing the profile. If thickness was not defined by the user,

the system asks to apply it upon confirming the creation of such profile.

Thickness types

In theory, the way of constructing offset lines is defined by the thickness type. Following types are

available in the Thickness drop-down list:

·  No

Thickness is not applied.
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·  Outside

 Inside

Offset lines are constructed on one side of the original contour lines. Offset Value can be set in

the eponymous input box. For closed contours, the direction of offsetting in relation to

original lines is defined by the selected mode (outside or inside the original contour); the

offsetting direction for open contours is automatically selected by the system.

·  Symmetric

Offset lines are constructed on both sides of the original contour lines at distances equal to

the offset Value.

·  Symmetric - Total Width

Offset lines are constructed on both sides of the original contour lines at distances equal to

half of the offset Value.

·  Different

· Offset lines are constructed on both sides of the original contour lines at different distances.

Offset Value is applied outside, Second Value - inside.

In real life, however, the shape of offset lines is determined, besides the thickening type, by the shape

of the original contour. It depends on the presence in the original contour of self-intersections or forks

(bifurcations), as well as closed areas. For example, a contour with self-intersections or forks in most

cases can't be thickened on two sides by different offset distances. Use of Outward or Inward options

is not allowed for such contours either. The result of applying to it the Double sided option will also

depend on the presence of closed areas in the contour. If there aren't such areas in the original profile

contour, using this option will result in the same shape as the Symmetric option, that is, the same

offset distance will be maintained on either side of the original contour lines (the second offset

distance being ignored). If the contour with self-intersections or forks contains closed areas, then the

inward offsets (the ones created in closed loops) use one of the distances, while the outward ones (all

the rest) use the other offset distance.

Closed Area Handling

If 3D profile contains closed contours, one of following options can be applied to them:

· Close area - closed contours remain the same after applying the thickness.

· Thickness -  closed contours are replaced by equidistant contours.
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Gap Handling

When creating an offset, three ways of handling gaps between the offset lines are possible:

· Round – rounds are constructed between the ends of the neighboring lines of the resulting

contour.

· By Line – the gaps are closed by straight lines tangent to the offset lines at their ends.

· By Curve – the curves that make the original contour are continued by the same law. Straight

lines are continued straight, arcs - round.

Ends handling

When thickening an open contour, the offsets from the hanging ends of lines can be joined in one of

following ways:

· Round – ends of offset lines are joined by circular arcs.

· By line – ends of offset lines are joined by straight lines.

3D Profile Parameters

As any other model element, each 3D profile has a set of parameters. When creating a new profile

parameter values can be defined by calling the parameters dialog using the option:

<P> Set entity parameters

The parameters dialog for an existing profile can be invoked by double click  on a profile or

by selecting the  Parameters command in the contextual menu.

3D profile parameters dialog contains following tabs:

· Common

This tab is described below.

· 3D Profile

This tab has the same functionality as the Parameters window has, when the 3D profile being

created, and depends on the type of profile. Detailed descriptions are available in sections

describing particular 3D profile types (by 2D elements, by 3D elements, projection, by surface

unfolding) an in the Thickening Flat 3D Profiles section.
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· Transformations

Contains information about transformations applied to the profile. This tab has the same

functionality as the Parameters window described for the Transformations command, except

that it doesn't allow to apply symmetry and snap transformations to reference elements and

doesn't contain information about Mate Transformations (it can be found in the separate tab

of the dialog).

· Mate Transformations

Contains information about mate transformations applied to the profile. This tab has the same

functionality as the eponymous tab of the Parameters window described for the

Transformations command.

Common Parameters of 3D Profile

Name

Each element of a model have a unique name. User can type name manually. In this case the system

checks if typed name is unique. If typed name is already assigned to another element in this

document, the changes are not applied. If user didn't input a custom name, the system generates

name automatically. More information about automatically generated names can be found in the

Names Customization for 3D Elements chapter.

Color

The color of profile's representation in the 3D scene. Color can be selected in the same way as

described in the Color chapter.

Level

This parameter is described in the Levels chapter.
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Layer

This parameter is described in the  Layers chapter.

Suppress

This option can be used for excluding a profile from the 3D model generation. Suppressed profile isn't

displayed in the 3D scene. Enabling the Suppress checkbox excludes a profile from the model

generation and sets the "1" value in the corresponding input box. Disabling the checkbox includes a

profile into the model generation and sets the "0" value in the corresponding input box. Value may

also be typed manually or defined by a real variable for controlling the suppression via

Parametrization. A profile is suppressed if a variable's value isn't zero. Any whole values apart from

zero are replaced by "1". Fractional values are not allowed.

Keep in mind, that suppression of a parent element leads to errors upon regenerating its child

elements.

External 

Two options are available in the drop-down list: Hide in Assembly and One Level. If the model is used

as a 3D fragment, then profiles with One Level option applied are accessible in the assembly. The

position of such profile is fully determined by the position of its 3D fragment. The parameters dialog

of a 3D profile belonging to a 3D fragment in an assembly contains only one tab - Common. A name

of a 3D fragment is added to a name of a profile as a prefix. The One level option can also be

applied to profiles in assemblies, that will allow using such profiles in assemblies of higher level.

View as Wireframe 

This checkbox controls the way of rendering the profile in the 3D scene. If it is disabled (by default),

closed contours of a profile are filled in semi-transparent color. If it's enabled, only lines are displayed.

Convert to Spline 

This parameter allows converting each contour of a profile into a single spline. The checkbox is

disabled by default, so the conversion is not applied. Enabling the checkbox turns each contour of a

profile into a single segment, with the intermediate vertices being removed. The approximation

accuracy is controlled by the parameter in range from 0.0 (Rough) to 1.0 (Precise) using the slider or

the input box. In certain cases, such 3D profiles are more suitable then those based on polylines (for

instance, in the Loft operation).

This parameter does not affect combined profiles, whose several faces have adjoining edges (for

example, if the profile is created from a set of adjoining faces).

Transparency

This parameter sets the degree of transparency of the profile contours filling in the 3D window. Lines

of a contour are always non-transparent regardless of this parameter. The checkbox is enabled by

default and the transparency value can be set in range from 0 (opaque profile) to 1 (fully transparent

profile) using the slider or the input box. Disabling the checkbox makes profile fully opaque

regardless of parameter's value.

Quality

Defines the quality of profile's representation in the 3D scene. Can be customized in the same way as

described in the Common Parameters of 3D Elements section.
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Edit 3D Profile

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3EPR> Edit > Construct > 3D Profile

This command is used for editing "3D Profile".

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation

In addition to selection options mentioned above (select all, select by name) it is possible to select

elements using mouse.

Upon selecting an element, you can delete it, edit its parameters using the <P> option, select other

nearest element, edit or change definition. Editing and changing definition open the 3D Profile

command. The difference between them is that changing the definition resets command parameters

to defaults (including type of profile).

3D Section

Calling the command:

Icon Ribbon

3D Model > Construct > Section

Draw > 3D Model > Section
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Assembly > Construct > Section

Sheet Metal > Construct > Section

Surfaces > Construct > Section

Weld > Construct > Section

Primitives > Construct > Section

Workplane > 3D Model > Section

Keyboard Textual Menu

<3SE> Construct > Section

The 3D section is an auxiliary 3D construction element in T-FLEX CAD. It is used as a secant object

when creating 2D projections (for obtaining local area views and sections) in the Cut operation. 

The 3D section can be used when viewing objects of the 3D scene, helping quickly examine the inner

model structure without changing it.

The section is displayed in the 3D scene by dotted lines indicating the boundaries of the 3D section.

The arrows on the image of a 3D section indicate the view direction. The view direction of the 3D

section defines the part of the model that would remain as a result of applying the section to a 2D

projection, a model in the 3D scene or when cutting by section.

Main methods to create 3D sections

A 3D section can be defined by one of the following methods:

· With an octant (trihedral angle);

· With a planar angle (dihedral angle);

· On the basis of a plane;

· With a parallelepiped

As a result of extrusion of the specified curve in a certain direction. The initial curve can be specified:

· based on a 3D view;

· based on 2D constructions on the workplane;

· based on a 2D projection.
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Selection of Objects of the Section

When creating a section, it is possible to specify a set of objects of the section. The Bodies, operations,

welded joints can be selected as such objects of the section. The selected set of objects can be used in

one of the three modes:

· section is applied only to the selected  objects;

· section is applied to all elements of the model except the selected ones;

· section is applied to all elements of the model (the specified set of objects is removed).

Applying section to 3D model

A 3D section can be used for viewing a 3D model. This helps quickly examine the inner structure of the

model and evaluate the shape of the model of the setting with this 3D section.  

When viewing a model with the help of 3D section, the body is "slashed" by the 3D section into two

parts. The 3D scene displays only the portion have the disappointed up by the view direction arrows of

the 3D section. In this way, no actual separation is performed, the model itself is left unchanged, what

is changed is just the way of its rendering in the 3D scene.

In order for the section to be applied to the model immediately after its creation, it is necessary to

activate the Apply Section option during the creation of the section.

To apply a section to the model, call the Apply Section command on the View toolbar:
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The drop-down list will list all sections present in the document. If you select the required section from

the list, the selected section will be applied to the model.

There is another way of calling this command. In the command waiting mode, right click  in the 3D

view window. In the coming up context menu, select the Apply Section command. As a result, the

described dialog box will appear.

A section can also be applied to the model from the context menu of the particular 3D section.

The Apply Section command is not available for complex 3D sections created by extrusion a

given curve (based on a 3D view, constructions on a workplane or a 2D projection). If such a

section consists of several segments, it cannot be applied to a 3D model.

Quick 3D Section Edit

In the automenu, there are buttons for quickly rotating the system around the X/Y/Z axis by 90

degrees.

To create sections by plane angle, octant and parallelepiped, it is possible to change the direction of

the section using manipulators or a special button in the automenu.
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Topics in this section:

· 3D Section Type

· Creating 3D Section

· 3D Section Parameters

· Edit 3D Section

3D Section Types

3D section based on a plane

When creating a 3D section of the given type, the location of the secant plane is specified with the

help of the special manipulator. It constitutes the LCS to which the “draft” of the secant plane is

attached. The location of the secant plane can be specified and controlled with the help of the

manipulator and commands of its context menu. Position of the secant plane can be snapped to

points of 3D model.

The secant plane can also be specified by simply indicating the 3D object that defines the required

geometric plane (planar face, planar edge, workplane, etc.). 

The view direction of the 3D section is set by the system arbitrarily, and the user can change it, if

necessary.

The boundaries of the 3D section in the 3D window are purely imaginary and are used solely to

display the section in the 3D scene. The model is slashed by such section throughout the entire range

of the section plane. Direction of the sight of the 3D section is determined by the system arbitrarily

but the user has always a possibility to modify it.

3D section by octant and planar angle

To create a 3D section with an octant and a planar angle, it is sufficient to indicate the location of the

secant trihedral or dihedral angle in the space. To specify the location of the section, use the special

manipulator in the form of the LCS to which the view of the secant angle is attached. Position of the

secant angle can be snapped to points of the 3D model and also to LCS.

The created 3D section is displayed in the 3D scene in the form of a dashed rectangle coinciding with

the X-Y plane of the manipulator of the section. The boundaries of the rectangular section are
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imaginary and only used to display the section in the 3D scene. The direction of the sight is parallel to

the Z-axis of the manipulator of the section and has an opposite direction. 

3D section based on a parallelepiped

To create a 3D section with a parallelepiped it is sufficient to indicate dimensions and location of the

secant parallelepiped. Note that when applying the section of the given type everything that is

situated outside the parallelepiped will be cut off.

To specify location of the section, the special LCS manipulators are used to which two opposite

vertices of the parallelepiped are snapped. Location of the secant parallelepiped can be snapped to

points of the 3D model, and also to LCS.

Created 3D section is displayed in 3D scene as a dotted parallelepiped.

3D section as a result of extrusion of specified curve

3D section can also be specified as a list body obtained as a result of extrusion of the specified curve

(line of the section) in a certain direction. To do so, it is possible to use one of the three variants of

creation of 3D section:

· based on 3D view;

· based on 2D constructions on a workplane;

· based on 2D projection.

These approaches differ in the way of defining the source curve of a 3D section and the direction of its

extrusion. The view direction of a 3D section is arbitrarily defined by the system, regardless of the

creation technique, however, the user can always flip it.

The boundaries of such 3D sections are imaginary only in the direction of extrusion of the initial curve.

The extents of the section in the other direction are precisely determined by the boundaries of the

source curve. Therefore, when creating a 3D section, make sure that the base curve fully intersects the

3D model. Otherwise, only a portion of the model will be selected that is intersected by the base curve

of the 3D section.

The 3D sections, created based on 2D projection and 2D constructions on a workplane, by

default are not displayed in the 3D scene. To make such section appear in the 3D window, set

the flag Show in 3D View in the section parameters.

3D Section Based on 3D View

The curve that guides creation of a 3D section is specified by a set of 3D points (3D nodes or body

vertices). The selected 3D points are joined by straight segments. The 3D section is constructed by

extruding the resulting polyline in the normal direction to the screen (at the time of selecting the first

point).

Before creating a 3D section, you need to a pointing and the 3D scene to make it perpendicular

to the desired direction of the section creation. This can be done, for example, by using the

command Set 3D View Parameters, selecting the desired view position with its help. Or, if the 3D

section is to be made perpendicular to some face or flat edge of the model, you can use the

command Rotate Normal to Selected Element.

A section, created based on 3D view, is displayed only in the 3D window.

3D Section Based on 2D constructions on a Workplane

The base curve of a 3D section is defined by 2D elements lying on workplane:

· a set of 2D nodes (two and more nodes);

· a 2D path;

· a view notation (2D section), created by the command Section View.
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The resulting flat curve as extruded perpendicular to the workplane, that is referenced by the source

2D elements.

In this type of section, it is possible to display several sections in a 3D scene at the same time.

When using 2D nodes, the curve is created as a polyline (the specified nodes are connected by straight

segments). The 3D section will be composed of planar segments in this case. 

If a 2D path is selected, the base curve of a 3D section will exactly follow the path shape. The 2D path

can be of arbitrary shape. Therefore, 2D paths allow creating 3D sections, containing segments of

selected circle or spline surfaces.

The 3D sections, created based on 2D nodes and 2D paths, are displayed in the 2D view window by a

dotted line with the arrows at the ends, indicating the view direction of the section.

A view notation is commonly used, when the 3D section is created based on existing 2D drawing. The

base curve of the 3D section will repeat the shape of the 2D section, created in the command Section

View. Such 3D section is not displayed in the 2D window. You can find out about its presence in the

drawing from the 3D model tree or from the context menu for the 2D section.

There are two additional options for this method of creating a section in an automenu.

<O> One-sided section

<D> Switch direction of one-sided section

When the One-sided section option is activated, the part of the model that is below (or above) the

Workplane onto which the element(s) was selected, the specifying section will not be cut off. The

option Switch direction of one-sided section changes the part of the model that is not cut off: either

under the Workplane or above it. 
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Without options One-sided section
One-sided section and Switch

direction of one-sided section

Creation of 3D section based on 2D projection

This way of the section creation is almost exactly identical to creating the section based on workplane.

The section is constructed perpendicular to the direction of projecting the source 2D projection. The

base curve of a 3D section is defined by 2D elements one the projection: a set of 2D nodes, 2D path,

view notation.

Such 3D section can be created automatically in the 2D projection creation command when

constructing a local view or section based on a 2D view notation.

Creating 3D Section

3D sections can be graphical and geometric. Both types divide the body according to the selected

section type in the parameters window, however, the geometric section additionally draws outline

lines, i.e. the lines of intersection of the section and the dissected body.
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Graphical section Geometrical section

The graphical section allows you to load the system less when working with large assemblies.

By default, the system offers to create a graphical section, i.e. the option to display a geometric

section is disabled.

If necessary, the user can apply a geometric section to sections with an octant, a flat two-sided angle

and based on a plane.

The types of sections based on a 3D view, 2D constructions on the workplane and based on a 2D

projection can only be created as geometric, and it is possible to create several sections at the same

time.

Upon calling the command, the automenu will offer both the general system options and the options

for selecting a method of creating the 3D section:

Create Section by Plane

Create Section by Plane Angle

Create Section by Octant

Construct Section by Parallelepiped

Construct Section using 2D Constrations
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Construct Section using 2D Projection

Construct Section using 3D View

Creating a 3D section based on a plane

After selecting the option , the following two options will appear in the automenu:

<B> Select Bodies for Section

<F> Select LCS

<Tab> Switch view direction

<L> Select Plane

<X> Rotate LCS around X by 90°

<Y> Rotate LCS around Y by 90°

The blue plane  –  a «workpiece» of the secant plane, and the special manipulator in the form of the

LCS for controlling the location of the plane appear in the 3D scene. With the help of the manipulator

and commands of its context menu, it is possible to specify and control the location of the secant

plane.

To fix the secant plane to an already existing 3D element (a face, a plane, etc.), it is possible to use the

 option. The filter toolbar contains filters for selecting 3D objects that define the plane. It is also

possible to fix the plane to different 3D points when moving the dragger by using double pressing of

the mouse.

The option  toggles the view direction of the 3D section being created. Once the plane and the

view direction of the section are selected, confirm the section creation by clicking  in the

properties window or in the automenu.
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Creation of 3D Section by Octant/Planar Angle

After selection of the  or  options, in the 3D scene a preliminary image of the secant angle

with the manipulator in the form of the LCS at the base appears. Location of the secant angle is

defined by translation/rotation of the manipulator.

The manipulator constitutes a view of the coordinate system. The coordinate axes are connected with

each other by colored arcs and rectangular “areas”, the center of the manipulator is marked with a

sphere. Different parts of the manipulator are the active elements intended for specification of the

following transformations:

· the axes of the manipulator are intended for specification of translations along individual

axes;

· rectangular “areas” connecting axes of the manipulator in a pairwise manner are intended for

translations across the XY, XZ or YZ planes;

· arcs of the manipulator are intended for specifying rotations;

· the center of the manipulator is used for an arbitrary translation (without fixing to axes).

When pointing at the coordinate axis, the user can proceed to specifying a translation along the

selected axis. When pointing at the arc, the system prompts the user to specify a rotation in the

corresponding plane. In the latter case, in addition to that, the axis of the manipulator closest to the

cursor is selected so that the user could specify the rotation by directing the selected axis at the

specific element of the model. When clicking the center of the manipulator, the manipulator itself and

the secant angle that is linked to it start to dynamically move following the cursor.

To specify a transformation with the help of the manipulator, the user must choose the active element

of the manipulator by pressing . Next, without releasing the pressed button, the user can move the

cursor. Transformation will be specified when the mouse button is released. It is also possible, after

selection of the manipulator, release the mouse button, move the cursor and select a new element

(specify a location in the space), to fix the transformation, by clicking  again. 

To snap the secant angle to LCS the following option of the automenu is used: 

<F> Select coordinate system

After invoking the option it is required to indicate the desired LCS.
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The context menus of the elements of the manipulator offer additional capabilities of defining

orientation of the secant angle. For example, with their help it is possible to direct the selected axis of

the manipulator at a 3D point or translate the axis up to the specified surface. The option that is

common to all menus – Settings – invokes the dialog for specifying the step of the translation of the

manipulator.

 

After specifying the required location of the secant angle in the space, it is required to confirm its

creation with the help of  in the properties window or in the automenu.

Creation of 3D Section with Parallelepiped

After selection of the  option, will appear a preview image of the secant parallelepiped with

two LCS manipulators laying in opposite vertices. To specify the required location and size of the

parallelepiped it is required to translate/rotate the manipulators. 

 

To specify the initial coordinate system, one of the vertices of the parallelepiped can be snapped to

LCS with the help of the option:

<F> Select coordinate system

The manipulator of the vertex will be superposed with the selected LCS. 
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The parameters window displays Transformations applied to one of the manipulators in relation to

the global coordinate system. You can use following automenu options, in order to switch between

display of coordinates for start and end manipulators:

<E> Edit start position

<G> Edit end position

As you use manipulators, the system automatically activates the option corresponding to active

manipulator. 

Section's start and end manipulators are handled in the same way, as described in the LCS

Manipulators for Transformations of 3D Elements section. The Transformations tab is handled in

the same way, as described in the Transformations of 3D Elements section. The difference is, that

for section you get less transformation types available and less options in manipulators'

contextual menus.

Creation of sections based on 2D constructions on a workplane

A section can be constructed in this way either in the 2D window (on the page of the 2D drawing

related to the workplane), or in the 3D window on the activated workplane.

Upon activating this mode by the option , select 2D elements defining the source curve for the

section. This can be done by the following automenu options:

<N> Select Next Section Node

<C> Select 2D Path

<M> Create 2D Section for creating 3D Section

The workplane used as the base for the 3D section construction, is automatically selected by the

system. In the cases, when another workplane can be selected (for example, if several workplanes are

located on the given 2D page), the automenu will provide the option for changing the workplane:

<W> Select Other Workplane

To flip the view direction of the section, as in the previous case, use the option:

<Tab> Switch view direction

Upon selecting the source curve, the workplane and view direction of the section, confirm its creation

by the option  in the properties window or in the automenu.

Creation of section based on 2D projection

Creation of a 3D section in this way is done by the option . Creating such section is exactly

identical to the previous method (creating a 3D section based on workplane).



T-FLEX CAD 17 Help

1330

The 3D section based on 2D projection can be created by the system automatically (without calling

the Section command) within the command of creating the 2D projection when constructing a local

area view or section based on a 2D view notation.

Creating section based on 3D view

Upon selecting the option , the automenu will provide the additional options for selecting 3D

points, the source curve of the section being created, and for switching the view direction of the

section.

3D points can be selected by the following options:

<N> Select 3D node

<V> Select Vertex

You can select as many 3D points as necessary using these options. If some point was minced when

specifying the points, cancel the selection and define the points anew. To cancel the selection of a set

of points, use the option:

<K> Eliminate all Section Nodes

To flip the section view direction, offered by the system, use the option:

<Tab> Switch view direction

Upon selecting 3D points and view direction of the section, confirm its creation by the option  in

the properties window or in the automenu.

Selection of Objects of Section

The set of objects of a section is specified with the help of the properties window.

The list of objects can be specified both directly when entering the Section command (before

selection of the section creation method), and during the stage of creation of the 3D section of

any type. In the former case, the specified set of objects is automatically applied to all sections

that are created during the current session of work with the command. In the latter case, the

specified set of objects acts only for the specific section.

Place the cursor into the “…” line and press . The command automatically transfers to the mode of

selection of objects of the section. In the automenu the following option will become active:

<B> Select Bodies for Section

The drop-down menu of this option contains the list of filters of the objects being selected

(Body/operation/welded joint).

Objects can be selected in the 3D window or in the tree of the 3D model.
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The way of interpreting the specified set of objects is set up with the help of the following buttons:

All Elements

Selected Elements

All Excluding Selected

Transparent editing of sections

3D sections along the plane, angular and octant sections can be edited directly in the command

standby mode, without calling the section editing command. To do this, it is enough to select a

section in the 3D window using . A manipulator will appear in the 3D scene, allowing you to

quickly change the position and orientation of the section.

3D Section Parameters

Defining parameters of a section is done by the parameters dialog (the option ).

Show on 3D View. Defines the display of the section plane in the 3D view. 

Color of sectioned surfaces:

Section Color. This color is used for drawing the section  in the  2D and 3D windows. Additionally, this

color is used for painting surfaces resulting from cutting the model.

Body Color. When this flag is turned on, then the surface generated as a result of applying the section

will be displayed in the same color, as the model. When the flag is cleared, color is used specified in

this dialog. 

Body Material. Section is displayed using the material of the body according to material’s texture,

color and other characteristics.
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System-wide parameters:

· Level.

· Layer.

· Color. This color is used to draw the cross section in 2D and 3D windows,as well as to paint the

surface obtained when the model is clipped when the rendering mode is set to Render or

Shade.

· Name. For cross sections, the following names are generated by default: cross Section_1, cross

Section_2, and so on..

If the Set as default flag is set,the specified parameters will be set when the command is called again.

Edit 3D Section

Call the command:

Icon Ribbon

Keyboard Textual menu

<3ES> Edit > Construct > Section

This command is used for editing Section.

Available option:

<Esc> Cancel selection

<A> Select All Elements
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<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation

After calling the command, you can select the section using the mouse. The selection is possible in a

2D window, or in a 3D window, provided that the Show in 3D view flag is set in the 3D section

parameters.

It should be noted that if it is necessary to reassign nodes or change the choice of the workplane, first

you need to cancel all nodes that define this section using the option  (<K>).

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the "3D node" command.

If you select multiple items, you can delete them. Note that the <Shift>  combination can be used

for multiple selection (the <Ctrl>  combination cancels the selection).
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Solid Body

This chapter provides list of operations for solid 3D modeling in the T-FLEX CAD system as well as

common options available during creation of such operation, and gives a short description. Along

with solid 3D modeling many operations listed here may be used for surface modeling. Basic

operations require selection of auxiliary 3D construction entities used for setting the shape of future

bodies and surfaces. Other operations use existing solid bodies and surfaces for creating more precise

shape.

Common options for solid 3D modeling operations

When you create most of the solid 3D modeling operations, there are following checkboxes available

in the Options tab of the Parameters window (availability of certain checkboxes depends on a

particular operation):

Blue and red arrows Manipulators

Blue edges Wire-frame preview

69 and 85 Labels of key dimensions

Yellow surfaces Dynamic preview

Use Manipulators

Enables manipulators in 3D scene. Also enables wire-frame operation results preview, which

automatically updates upon changing parameters of operation. Set of available manipulators as well

as availability of wire-frame preview depends on a particular operation.

Show Labels

Enables labels of key dimensions in 3D scene. An icon depicting a dimension type is shown on left

side of a dimension value. Set of dimensions available for using as labels depends on a particular

operation.

Dynamic preview

Enables operation results preview in form of yellow surfaces which automatically update upon

changing parameters of operation. 
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Create Driving Dimensions

Allows to create Driving Dimensions in 3D scene along with the current operation creation. Not all

dimensions defined in operation Parameters may be used as driving dimensions. Set of dimensions

available for using as driving depends on a particular operation.

Simplify Geometry

For some operations General Parameters or Additional Parameters tabs of the Parameters window

have the Simplify Geometry checkbox. Enabling this checkbox will allow the automatic simplification

of the resulting geometry. Spline-based surfaces will be replaced by analytic surfaces (segments of

cylinder, sphere or torus) where possible.

Main Operations

Extrusion

Extrusion operation yields a body or surface formed by straight propagation of a contour along a

specified direction. Extrusion can be performed along not only the extrusion vector, but along normal

direction to the contour in either or both directions as well.  Thus, it provides a means of thickening an

arbitrary face, even a non-planar one. Extrusion can also be limited from face to face, from surface to

surface or through the whole volume of the selected body.



T-FLEX CAD 17 Help

1336

Rotation

Rotation operation yields a body or surface formed by revolving a contour around an axis located in

space for a given angle. The original contour can be located in an arbitrary orientation relative to the

axis and lay in arbitrary plane, but it should not intersect the axis.

Blend

Edge blend is an operation for creating transitions between two or more adjoining faces belonging to

one solid body or surface. Face Blend is an operation for creating transition surface between two sets

of smoothly meeting faces.  Three-Face Blend is an operation for creating transition surface between

two sets of smoothly meeting faces, where resulting surface will be tangent to the third set of faces.

Boolean

Boolean operation creates a new body based on two or more existing bodies. As a result of the

operation, a new body is created that is a combination of the source bodies.

Loft

Loft is an operation for creating new bodies and surfaces of complex geometrical shapes. The

resulting spline faces are constructed on the wire guides in one or two directions and according to the

specified boundary conditions. The base elements for spline definition can be practically any entities

of the three geometrical types: "point", "wire" and "sheet". Depending on the base element type, the

result will be either a solid body or a set of surfaces.
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Operations for geometry creation by moving a contour along defined path

Sweep is an operation that creates bodies or surfaces whose geometry is defined by an arbitrary-

shape profile propagated along a spatial curve. The operation provides controls over scaling of the

profile and its twisting with respect to the trajectory axis as it moves along.

         

Pipeline is an operation for creating of pipelines along defined routing and pipeline connection

elements according do selected standard.

By Parameters operation extends the capabilities of the Sweep operation. The base profile is defined

in such a way that its geometry and orientation are driven by a variable. The driving variable can

assume values within the specified range. Final body or surface is created as a result of recomputing

the geometric shape and orientation of the profile across the whole range of the variable values..
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Copy

Copy is an operation for creating copies of existing operations, bodies, 3D construction entities and

even sets of faces. 

3D Symmetry

3D Symmetry is an operation for symmetrically reflecting selected 3D objects in relation to a given

plane. 

Array

Array set of operations includes wide variety of operations for creating multiple copies of existing 3D

objects with different types of copies placement.

Advanced Operations

Hole

Hole is an operation for creating standard apertures. It relies on a provided parametric library of holes

satisfying current standards. The command supports creation of patterns of holes, holes through

multiple bodies, and threaded holes. When a threaded hole is created on a face, a cosmetic thread is

displayed.
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Shell

Shell is an operation for creating shells on the basis of solid bodies. A shell is a hollow thin-sided solid

body with the sides of a certain thickness. When creating shells some faces of the initial solid body can

be deleted.

Offset Body

Offset Body is an operation for creating an equidistant non-hollow body whose faces are displaced

relative to the initial solid body faces along the normal direction at a set value.

Rib

Rib is an operation for creating ribs of the solid body on the basis of one or several 3D profiles.

Execution of this operation results in a solid body obtained via a Boolean operation of a union of the

rib being created with the source body.

Cut

Cut is an operation for creating a body or surface by cutting some portions off the original

body/surface, or getting two new bodies/surfaces by splitting the original body/surface into two parts.



T-FLEX CAD 17 Help

1340

Thread

Thread is an operation for creating cosmetic threads on cylindrical and conic faces of 3D model. A

cosmetic thread is a texture applied to the selected face which depicts the pitch, direction and

boundaries of the thread but doesn't provide it's actual geometrical representation. 

Spiral

Spiral is an operation for creating spiral-like bodies or surfaces by moving an arbitrary-shape profile

along a spiral curve. This operation may be used for modeling actual geometry of a thread. However,

in most cases, when only cosmetic representation of a thread is needed, the Thread operation is

recommended for use instead, as it creates less load on hardware. 

Spring

Spring is an operation for creating spring-shape bodies by moving a round profile along a spiral

curve. It differs from the Spiral operation in the capability of forming closed and ground ends of the

spring. 

Taper

Face Taper is an operation for tapering one or several selected faces at a specified angle, with

automatic correction of the adjacent faces. Body Taper is an operation for creating two-sided tapers

on faces of a body relative to a specified taper direction and a parting body. 

Apply Material

Apply Material is an operation for applying a certain material on one or several model's faces. The

applied material will be maintained through the future model modifications despite changes in the

face’s geometry.



Solid Body

1341

Simplify

Simplify is an operation for deleting extra edges or vertices from the specified operation body, as well

as for simplifying the geometrical base of faces and edges.

Divide

Divide is an operation for dividing operations into separate bodies, that unite several bodies (solid

and sheet bodies alike). Thus, for example, the result of creating Linear or Circular array or a Boolean

operation will be divided by this operation into geometrically separate components. 

Fragments Insertion set of operations

Insert 3D Fragment, Adaptive Fragment, External Model and 3D Picture operations allow variety of

ways to insert bodies of other 3D models into active 3D model.

Special Operations

Primitives

Primitives set of operations allows to create basic geometric bodies: Box, Cylinder, Cone, Sphere,

Torus, Prism and Pyramid without additional construction elements creation. 

Surfaces

Surfaces set of operations includes wide variety of operations for working with surfaces and faces of

bodies.

Sheet Metal

Sheet Metal set of operations includes wide variety of operations for creating bent and stamped sheet

metal elements.

Deformation

Deformation set of operations includes wide variety of operations allowing free-form body or surface

shape editing.

Topics in this section:

· Primitives

· Extrusion

· Rotation

· Blending Edges

· Blending Faces

· Three-Face Blend

· Boolean Operation

· Loft

· Sweep

· By Parameters

· Hole

· Thread

· Spring

· Spiral

· Shell

· Offset Body

· Copy
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· Symmetry

· Cut by Section

· Face Taper

· Body Taper

· Rib

· Deformation

Primitives

Calling the command:

Icon Ribbon

3D Model > Special > Primitives

Keyboard Textual Menu

- Operation > Primitives

There is also an additional Ribbon tab for primitives:

Primitive type selection:

<3PB> Box

<3PY> Cylinder

<3PO> Cone

<3PS> Sphere

<3PT> Torus

<3PZ> Prism

<3PV> Pyramid

The command can also be called from the dynamic toolbar, invoked by clicking  on empty space

in the 3D scene in the standby mode.
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Main Concepts and Capabilities

Commands united in the Primitives set allow to create basic geometric bodies: Box, Cylinder, Cone,

Sphere, Torus, Prism and Pyramid without additional construction elements creation. 

When you select a command from the list the corresponding body appears in the 3D scene.

You can specify location and general dimensions for primitives and apply Boolean operation for them

immediately. This allows you to quickly create models based on primitives.

Translation and rotation manipulators and manipulators for geometric parameters specifying are

available for the bodies.
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Scaling Translation along axis Rotation around axis Translation in plane

Manipulators are color-coded depending on the axis they relate to: Х - red, Y - green, Z - blue.

All transformations performed using translation and rotation manipulators are displayed in the

Parameters window in the Transformations section.

Special manipulators are used to change diameters of rotation bodies.

Same manipulators are available in the transparent editing mode, when the chosen operation is

available for editing by means of the manipulators at once.

Topics in this section:

· Automenu Options for Primitives

· Parameters Window for Primitives

· Additional Features for Primitives

Automenu Options for Primitives

Following options become available in the automenu after selecting any kind of primitives creation

operation:

<S> Select or Create Source LCS

<T> Select or Create Target LCS

<Y> Symmetry

<U> Thin Wall
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<A> Rotate LCS around X axis by 90°

<O> Rotate LCS around Y axis by 90°

<Z> Rotate LCS around Z axis by 90°

<8> Change LCS axes orientation

<9> Move

<Ctrl+T> Select Target Body for Boolean

<Ctrl+B> Boolean operation mode

Coordinate Systems

Commands  for creating Source LCS and Target LCS are available in the automenu for each

primitive type.

Source LCS is associated with the primitive and allows you to set its position in the scene. Source LCS

can be coincided with Target LCS, which already exists in the scene. Their axes and origin will be

coincided. 

Options         for rotating LCS around its axes are also available.

More information about LCS transformation and manipulators for translation and rotation can

be found in Assigning Transformations to 3D Entities chapter.

All LCS transformations applied this way are shown in the Transformations tab of the Parameters

window
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Symmetry

Symmetry  option exists in automenu for all commands from Primitives set, except Pyramid

command. A single body that consists of two symmetric about XY plane parts is created and Source

LCS of the primitive is moved to the center of the body after this option activation. Additional

symmetry operations are not created in this case.  The option is active for Sphere and Torus by

default. If you deactivate this option for Sphere or Torus, primitives creation operation yields lower

half of the primitive only (cut-off by XY plane).

Activation/deactivation of this option is equal to enabling/disabling Symmetry checkbox in the

Parameters window.

 

Thin Wall
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Thin Wall  option is available for all commands of the Primitives set. If this option is activated,

operation yields a solid body, if deactivated - a surface. Activating this option for Box, Cylinder, Cone,

Prism and Pyramid (regardless of Symmetry option condition) or for Sphere and Torus (with

Symmetry option deactivated) leads to excluding faces parallel to XY plane of the primitive's LCS

(Bottom and Top). Extended capabilities for Thin Wall customization (ability to set Thickness and

include Top and Bottom) are available in the Parameters window.  

 

Move

You can change way of primitive translation in the scene using Move  option. If the option is

activated, the primitive follows the cursor. If the option is deactivated, you need to use manipulators

for primitive translation. All LCS transformations applied both ways are shown in the Transformations

tab of the Parameters window

Using created body in Boolean operation

Options for Boolean operation creation are available in lower part of the automenu.



T-FLEX CAD 17 Help

1348

More information about Boolean operations can be found in Boolean operation chapter.

See also:

· Preview of Operation Result 

Parameters Window for Primitives

Unique set of parameters is displayed in the General Parameters tab of the Parameters window for

each operation from the Primitives group. 

When you change primitive dimensions using 3D manipulators in the scene, corresponding

parameters are also changed in Parameters window. Value of changed dimension is displayed in the

top of the window upon manipulator movement.

Shared Parameters are also displayed in other tabs of the Parameters window regardless of selected

primitive type.

Box

You can set Length, Width and Height values for the box: 

When the Cube checkbox is enabled only Length value can be changed. It defines value of all cube

dimensions.
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Cylinder

You can set Diameter and Height values for the cylinder.

 

Cone

You can set Diameter 1, Height, Angle and Diameter 2 values for the cone. Diameter 1 is a cone apex

diameter. Diameter 2 is a cone base diameter. Height, Angle and Diameter 2 values depends on each

other, so user can only define manually any two of this values, while the third value will be calculated

automatically.
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Sphere

You can set Diameter value for the sphere.

 

Torus

You can set two diameter values for the torus.

Diameter 1 is a revolution diameter. Diameter 2 is a section diameter

 

Prism

You can set Diameter of inscribed or circumscribed circle, Height and number of Sides for the prism.

Internal checkbox defines placement of the circle in relation to the base polygon. Enabling checkbox

makes the the circle inscribed into the base polygon, disabling checkbox makes the circle

circumscribed around the base polygon.
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Pyramid

You can set diameters of base and apex inscribed or circumscribed circles, Height and number of

Sides for the pyramid. Diameter - diameter of the base circle. Diameter 2 - diameter of the apex

circle. 

Internal checkbox defines placement of the circles in relation to the base and apex polygons.

Enabling checkbox makes the circles inscribed into the polygons, disabling checkbox makes the circles

circumscribed around the polygon.
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Shared Parameters

Symmetry

There is a Symmetry checkbox available for all primitives creation operations in the General

Parameters tab of the Parameters window. A single body that consists of two symmetric about XY

plane parts is created and Source LCS of the primitive is moved to the center of the body after

enabling this checkbox. Additional symmetry operations are not created in this case. The checkbox is

enabled for Sphere and Torus by default. If you disable this checkbox for Sphere or Torus, primitives

creation operation yields lower half of the primitive only (cut-off by XY plane).

Enabling/disabling of this checkbox is equal to activation/deactivation of the Symmetry option in the

Automenu.
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Thin Wall

There is a Thin Wall checkbox available for all primitives creation operations in the Thin Wall tab of

the Parameters window.

Enabling Thin Wall checkbox activates drop-down menu for selecting Thickness application direction.

Selecting No in the drop-down menu leads to creation of a zero-thickness surface. Selecting Outward,

Inward or Symmetric activates the thickness Value field and the operation yields a solid body with a

thickness applied to selected direction. 

You can exclude faces parallel to the XY plane of the primitive's LCS for Box, Cylinder, Cone, Prism

and Pyramid (regardless of Symmetry checkbox condition) or for Sphere and Torus (with Symmetry

checkbox disabled). Including/excluding such bottom and top faces into/from the result of the

operation can be done by enabling/disabling Bottom and Top checkboxes respectively. Bottom and

Top thickness values can be set independently of other primitive's elements thickness.
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Transformations

Transformations tab of the Parameters window show all the transformations applied to primitive's

LCS by using automenu options, manipulators, and Move/Rotate operation. You can also create new

transformations using buttons in the right side of the tab.

More information about LCS transformation and manipulators for translation and rotation can

be found in Assigning Transformations to 3D Entities chapter.

See also:

· Common options for solid 3D modeling operations

· Common Parameters of 3D Elements

Additional Features for Primitives

Link Dimensions to Existing Geometry

There is possibility to link primitives’ dimensions to the existing geometry. 

For this purpose use you need to  on the corresponding manipulator of the parameter and to

select a point on the existing geometry using .

A primitive will transform according to the changes in the linked body.

Primitive's dimension linked to existing geometry becomes unavailable for manual editing in the

General Parameters tab of the Parameters window. You can break a link using special option. The

option appears near the linked parameter.
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Extrusion

Calling the command:

Icon Ribbon

3D Model > Create > Extrusion

Sheet metal > Advanced > Extrusion

Workplane > 3D Model > Extrusion

Surfaces > Advanced > Extrusion

Keyboard Textual Menu

<3X> Operation > Extrusion

The command can also be called from the dynamic toolbar or contextual menu for selected contour

in the standby mode.
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Extrusion operation creates solids by sweeping the shape-defining element (the extrusion contour)

along the straight line. Extrusion is a most popular operation across solid modeling systems.

By default extrusion is performed in the normal direction to the base contour surface. Optionally you

can select an arbitrary vector as a direction of extrusion.

The command's interface is shown below:
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The extrusion contour can be made of wire geometry objects (either flat or 3D), as well as faces and

edges belonging to solids and surfaces. You can also select multiple objects of the same type. The

result of extruding is a surface or a solid body, depending on the selected contour and thin wall

parameters.

The extrusion boundaries and direction can be defined by various means, including usage of existing

model elements as a reference. Association with reference object stays active after an operation

creation, so extrusion will be recalculated automatically according to reference objects' geometry

changes. Additional parameters of operation allow to taper faces and blend edges of resulting body.

Topics in this section:

· Main Concepts of Extrusion

· Boundaries of Extrusion

· Additional Options for Extrusion

· Create Extrusion

· Edit Extrusion

Main Concepts of Extrusion

This sub-chapter describes basic principles of extrusion geometry creation. The detailed description of

operation creation interface can be found in Creating and Additional Features sub-chapters.

Extrusion contour

The extrusion contour can be made of wire geometry objects (both flat and 3D), as well as faces and

edges belonging to solids and surfaces. You can also select multiple objects of the same type. By

default operation yields a surface or a solid body, depending on the selected contour:

· a single closed 3D profile or a single face yields a solid body; 
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· multiple closed 3D profiles or multiple faces yield a single solid body which visually consists

of multiple parts;

· a rib yields a surface, no matter if rib closed or not;

· a single open contour yields a surface; 

· multiple open contours yield a surface, even if the combination of selected objects looks like a

closed contour. 

However, you can create surfaces from contours that yield solids and vice versa, using Thin Wall

parameters.

             

Extrusion direction

The trajectory of sweeping the contour for extrusion is defined by the extrusion direction. By default

extrusion direction is set as the normal to the original contour surface. Optionally you can select an

arbitrary vector as a direction.

In either case, there are first and second directions of sweeping the contour. The First Direction

coincides with the normal direction or the extrusion vector. The Second Direction is opposite to the

first one. Two-sided extrusion is also supported, in which the contour is swept in both directions. By

default, the system creates extrusion in the first direction.
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1 First direction of extrusion

2 Second direction of extrusion

3 Length of extrusion in first direction

4 Length of extrusion in second direction

5 Preview of the first direction extrusion result

6 Preview of the second direction extrusion result

7 Extrusion contour

Extruding in normal direction

Extruding along the normal is the system default when selected contour allows to calculate normal

direction. Each point on the contour is swept along a separate line defined by the normal direction to

the contour surface at the point. In this case, extrusion can be described as an offset from the original

contour defined by the specified length of the extrusion.

In real life, flat contours are extruded most often, with the same normal direction at all points of the

contour. For practical purposes, one can think of the flat contour in this case being translated parallel

to its original position along one common line defined by the single normal to the contour plane.

Therefore, extrusion normal to the flat contour can be viewed as a special case of extruding along an

arbitrary vector.
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 Extrusion of a non-flat contour

 

 Extrusion of a flat contour

Extruding along an arbitrary vector

When the extrusion direction can't be defined by the normal (for example, if a non-flat wire contour

was selected) or extrusion is desired in a specific direction, then its definition may include an arbitrary

direction vector.

The vector of the extrusion direction can be defined in two ways:

1) By specifying a pair of 3D points (the vector start and end);

2) By selecting some element of the 3D model suitable for defining a vector in the desired direction

(regardless of the length). 

Two 3D points define the start and end of the extrusion direction vector. 3D points can be defined by

3D nodes and vertices. One can also select other elements defining the desired point. For example,

one can select an edge – in this case, the edge midpoint will be used as the 3D point. Selecting a

coordinate system defines the point at the origin. Selection of a face, which is part of a sphere or torus

– yields the point at the center of the sphere/torus, and so on.
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1 Extrusion direction vector (not displayed in the 3D scene)

2 Start point

3 End point

4 Extrusion contour

5 Extrusion result

In the latter approach, the selected 3D object defines the vector of extrusion direction. The suitable

kinds of objects are flat curved edges, workplanes, flat faces, arbitrary-shaped surfaces (the direction

is determined as the normal to the selected element), straight edges (the vector coincides with the

selected edge), coordinate systems (the direction is one of the axes), faces/surfaces that are part of a

cylinder or a torus (the direction of the vector is the direction of the face/surface axis). It is possible to

select vector using single point only (if it lays on some surface). In this case a normal direction to

surface at selected point is used as a vector.

1 The axis of the cylindrical face defines direction of the extrusion vector

2 Extrusion contour

3 Extrusion result

Defining extrusion length

The length of an extrusion can be specified in one of the three ways: 

1) By the length of the defining vector of the extrusion direction;

2) By an arbitrary numerical value, measured from the original contour position;

3) By extrusion bounds;

4) By an offset from bounds.

Defining extrusion length by length of direction vector

The extrusion length can be derived from the length of the defining vector of the extrusion direction in

the cases when the direction is defined by two 3D points or a straight edge. The length of the

extrusion vector in this case is defined by the distance between the specified points or the length of
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the selected edge. Extruding is performed from the original contour position in forward direction by

the length equal to the vector length. The length of extruding in the reverse direction, if necessary, can

be defined by an arbitrary number or set equal to the length of extruding in the forward direction.

Defining extrusion length by numerical value

Regardless of the ways of defining extrusion direction, the extrusion length in the forward direction

(from the original contour position) can be defined by an arbitrary numerical value. The extrusion

length in the reverse direction, if necessary, is defined by an arbitrary numerical value or is set equal to

the length of extruding in the forward direction.

Defining extrusion length by extrusion boundaries

When specifying the extrusion length using boundaries, the extrusion is performed from one boundary

to another.

More information about extrusion boundaries can be found in Boundaries chapter.

Defining extrusion length as an offset from a boundary

For some of the boundary types it's possible to define an offset in forward or reverse direction from

the object selected as boundary.
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Extrusion to surface without offset Extrusion to surface with a reverse

offset 

Extrusion to surface with a forward

offset 

Boundaries of Extrusion

This sub-chapter describes basic principles of assigning extrusion boundaries. The detailed description

of operation creation interface can be found in Creating sub-chapter.

 

Extrusion boundaries can be assigned using following bounding contidions:

· Automatically

· No

· Symmetric by Total Length

· Symmetric

· Through All

· Through All by Direction

· By Value

· To Surface

· To Face

· To Body

· To Sheet

· Offset

· To Nearest Face
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· From Base

· To Point

Automatically

Automatically is the default way of assigning extrusion boundaries. CAD automatically assigns

extrusion parameters based on selected inputs (contour and direction). This option allows to associate

extrusion Length with length of the selected Direction vector if applicable.

No

No condition is available for Second Direction only, when First Direction is defined by Automatically,

 By Value or From Base conditions. This condition disables the extrusion in Second Direction.

Symmetric by Total Length

Symmetric by Total Length condition makes the extrusion contour equidistant to both ends of the

extrusion body. Length parameter value in this case defines the overall length of the whole body. 

Red arrow First direction of extrusion

Red polygon Extrusion contour

100 value Length of extrusion in the First

Direction (half of the overall length of

extrusion set in the Length field of

Parameters window)

Symmetric

Symmetric condition is available for Second Direction only, when First Direction is defined by

Automatically or By Value condition. Unlike Symmetric by Total Length in this case overall length of

the whole body will be twice higher than Length parameter value.

Through All

Through All is one of the ways to define extrusion boundaries using an existing solid body. This

condition defines boundaries in both directions at once. It requires using extrusion body in a Boolean

operation. Dynamic preview shows an infinite body of extrusion in both directions but size of the

operation result is defined by size of the selected existing body. This body is used as the first operand

of a Boolean operation. It is useful for creating holes in bodies for instance.
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Blue Extrusion contour

Yellow Extrusion body

Gray Target Body for Boolean operation

Through All by Direction

Through All by Direction also shows an infinite body of extrusion on the dynamic preview, but it's

infinite only in First Direction.

This condition is very similar to the previous one. The difference is using the First Direction of

extrusion only. So the resulting body is limited by the extrusion contour on one end and by the body

selected as a boundary on another end. This condition also requires using extrusion body in a Boolean

operation.

Blue Extrusion contour
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Yellow Extrusion body

Grey Target Body for Boolean operation

By Value

Using by Value condition requires setting the Length of extrusion. Using positive length in the First

Direction and negative length in the Second Direction allows to create an offset from the extrusion

contour. When using opposite sign values for first and second direction length, keep in mind, that their

absolute values can not be the same.

Green rectangle Extrusion contour

100 value Extrusion Length in the First Direction

-50 value Extrusion Length in the Second Direction

To Surface

Using To Surface condition allows to select Worksurface, Workplane, generic surface or face as an

extrusion boundary. You can also select a flat edge or 3D Profile – in this case a base surface of

selected geometry used as a boundary. 

Extrusion is limited by the whole surface. Selected boundary surface can be extended automatically if

it doesn't fully overlap with extrusion contour.  Some complex surfaces, such as an underlying surface

of a body face defined by a spline, like those created in the Loft operation, can't be extended. In this

case, the surface limits coincide with the limits of its defining object. If selected surface doesn't fully

overlap with extrusion contour and can not be extended, extrusion will not be created.
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1 - Face, selected as an extrusion boundary

2 - Extrusion contour

Extrusion result

Additionally you can set an Offset from the selected surface. Positive offset value defines offset from

outer side of the selected surface. Not all types of boundary objects allow setting an offset.

Boundary surface highlighted in green. 

Extrusion with no offset. 

Boundary surface highlighted in green. 

Extrusion with 40 mm offset. 

To Face

Using To Face condition limits the extrusion body by the selected face.  If selected face doesn't fully

overlap with extrusion contour, adjoining faces are used for bounding as well. Unlike To Surface

condition selected face can not be extended. If it's impossible to fully overlap the extrusion contour by

the selected face alone or in combination with other face of the same body, extrusion will not be

created. You can select faces belonging not only to solid bodies but to surfaces and 3D profiles as

well.
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1 - Boundary face

2 - Extrusion contour

Extrusion result

To Body

Using To Body condition limits the extrusion by faces of the selected body. It works in the same way

as To Face condition. If several intersections between a boundary body and an extrusion body are

possible, operation uses solution nearest to the mouse cursor when clicking the body for selection. 

Red polygon - Extrusion contour

Blue body - Boundary body

Yellow body - Extrusion body

Bounding by body is a more robust technique then bounding by a specific face, because different

faces may act as the extrusion bounds upon changes in topology of the selected object. (The face

selected as a bound at the time of extrusion creation may later shift or disappear altogether.)
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To Sheet

Using To Sheet condition allows to select surface, face or 3D profile as a boundary. Unlike other

conditions a surface consisting of several faces can be selected as a whole. If several intersections

between a boundary surface and an extrusion body are possible, operation uses solution nearest to

the mouse cursor when clicking the surface for selection. Unlike To Surface condition the selected

boundary will not be extended when it doesn't fully overlap with the extrusion contour. 

Offset

Unlike By Value when using Offset condition First and Second Direction vectors have the same

direction. So if you want to achieve the same result as in the illustration to the By Value condition, you

need to set positive Offset values in both directions. Second Direction offset should always be lower

than First Direction offset. 
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To Nearest Face

To Nearest Face condition is a special case of To Body condition. This condition always uses the first

intersection between extrusion body and boundary body in selected direction. Keep in mind following

rules when using this condition:

1) The specified extrusion boundaries (at least one of which is the To Nearest Face) must lay in

opposite directions from the original contour. An exception from this rule is the case when the

second extrusion boundary is defined using Offset condition.

2) The boundary body must lay in the First Direction, when it defines the first boundary, and in

the Second Direction, when defining the second boundary.

Extrusion contour highlighted in blue, boundary body

for both directions highlighted in gray.

Operation result

From Base

From Base condition allows to set the extrusion Length in the First Direction not from contour but

from base when extruding a flat contour. A point or a plane parallel to the contour plane can be used

as a base. In this case the Length value defines distance between base and end of the extrusion body.
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Length 0 mm Length 300 mm Length -150 mm

To Point

You can use a point as an extrusion boundary in first or second direction when extruding a flat

contour. Point can be defined by 3D node, vertex, edge midpoint or other 3D objects.

1 - Extrusion contour

2 - Boundary point

Additional Options for Extrusion

Creating tapers 

Tapers can be applied automatically on the side faces while creating an extrusion. All side faces of the

body being created are slanted from the original position by the specified angle. If you want to apply

a taper, enable Taper checkbox under corresponding Length or Offset value (depending on the

selected boundaries) in the General Parameters tab of the Parameters window. Taper angle value can

be set in the field on the right side of this flag.
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The direction of tapering depends on the specified angle and body type. If the resulting extrusion is a

solid body then positive angle values correspond to tapering toward the inside of the body. For the

opposite result, specify a negative tapering angle.

No taper Positive taper Negative taper

When creating a surface, the choice of taper direction is left out to the system. If the system choice is

different from the desired, simply change the angle sign.

The taper angle can be defined either separately for each extrusion direction (if the extrusion length

was defined by a numerical value or direction vector length), or once for the whole extrusion (if the

extrusion length was defined by specifying bounds).
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Uniform taper for the whole extrusion Separate tapers for each direction

Creating thin walls

Thin Wall parameters can be set in the eponymous tab of the Parameters window.

Enabling Thin Wall checkbox activates drop-down menu for selecting Thickness application direction.

This checkbox can only be enabled when extruding flat contours.

There are following thickness application directions available:

· No

· Outward

· Inward

· Symmetric

· Double sided

Selecting No in the drop-down menu leads to creation of a zero-thickness surface. 
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Extrusion contour

Extrusion result with Thin Wall checkbox

enabled and No thickness application

direction selected

Selecting Outward, Inward or Symmetric activates the thickness Value 1 field and the operation yields

a solid body with a thickness applied to selected direction. The resulting body is similar to Shell

operation result.

Selecting Double sided activates thickness Value 1 and Value 2 fields, giving the ability to specify

different values for outward and inward thickness. Value 1 - outward, Value 2 - inward.

Outward Inward Symmetric Double sided

The new faces in the thin-wall body are created by extruding an offset contour of the original one. The

shape of the faces depends on the choice of handling the gaps when creating an offset contour.

Following choices for gap handling become available in the Gap drop-down menu after selecting the

thickness application direction:

Round – The free ends of the neighboring offset curves are connected by fillets.

By line – The offset curves of the original contour are extended at their free ends by tangent straight

line segments.

By curve – The offset curves of the original contour are prolonged until intersect. 
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Round By line By curve

Creating Bottom and Top 

Faces parallel to the contour plane are excluded from the result of Thin Wall extrusion by default. You

can include them manually by enabling corresponding checkboxes. Enabling Bottom checkbox

includes face on the end of the second direction of extrusion. Enabling Top checkbox includes face on

the end of the first direction of extrusion. Bottom and Top thickness values can be set independently

of other extrusion's elements thickness.

This feature is not available when boundaries are specified for the extrusion or when using open

contour.

Thin Wall with Top and Bottom

disabled

Thin Wall with Top and Bottom

disabled (section view)
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Thin Wall with Top and Bottom

enabled

Thin Wall with Top and Bottom

enabled (section view)

Creating blends

Blend Parameters can be set in the eponymous tab of the Parameters window.

Enabling Fillet checkbox activates blending of extrusion side edges. Side edges can only be blended

by a round fillet. Fillet Radius can be set in the corresponding field. You can also add blending of the

top and bottom faces if the operation yields a solid body. Enabling Target Blend checkbox activates

blending on the first direction ending face. Enabling Source Blend checkbox activates blending on the

second direction ending face. You can choose between Chamfer and Round (fillet) types of target

and source blend in the drop-down menu. Chamfer size or Round fillet radius can be set in the field

on the right side of the drop-down.

Source Blend and Target Blend checkboxes are not available for the Thin Wall with No thickness.

Enabling Source Blend and Target Blend checkboxes for the Thin Wall with some thickness blends

both inner and outer contour edges of the corresponding face. Operation can not be completed if

source or target blend size exceeds half of the overall (inward plus outward) thickness of the Thin

Wall.
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Target Blend (Chamfer type)

enabled for the Thin Wall with

defined thickness 

Source Blend (Round type)

enabled 

Fillet enabled for the Thin Wall

with No thickness

Using created body in Boolean operation

Options for Boolean operation creation are available in lower part of the automenu.

More information about Boolean operations can be found in Boolean operation chapter.

Create Extrusion

Creating an extrusion operation

The Automenu and the Parameters window are used together in the command. These work together

and enhance each other. The state of the automenu depends on the current step in defining the

operation and on the purpose and type of the objects being selected.

Following steps should be done to create an operation:

1. Call the Extrusion command.

2. Set Common parameters of operation  (non-mandatory action)

3. Select the extrusion contour

4. Define the extrusion direction (non-mandatory action if using normal direction).

5. Define the extrusion boundaries (non-mandatory action).

6. Set Length or Offset values (non-mandatory action in some cases).

7. Set Taper, Thin Wall, Blend, Boolean operation parameters (non-mandatory actions).

8. Use Preview of the operation result  (non-mandatory action).

9. Finish input .

Following options become available in the automenu after calling the extrusion command:
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<W> Draw Profile

<R> Select Contour

<H> Cancel contour selection

<D> Select Direction

<F> Select starting Point of Extrusion

<S> Select ending Point of Extrusion

<K> Reset Direction selection

<T> Select 1st limit of extrusion

<B> Select 2nd limit of extrusion

<U> Reset Bounds selection

<N> Select Starting Point of Extrusion 

<L> Select Plane setting starting position of Extrusion

<O> Cancel selection of Extrusion Base 

<Ctrl+T> Select Target Body for Boolean

<Ctrl+B> Boolean operation mode

Selecting the extrusion contour

When creating the extrusion operation, it is necessary to define the extrusion contour. Upon calling the

command, the following option automatically activates in the automenu:

<R> Select contour

This option's activation enables filters  for selecting 3D elements allowed as an extrusion contour (3D

profiles, operations, faces, edges, loops and 3D paths) on the Filter Toolbar. When selecting elements,

pay attention to active filters.

To define the extrusion contour, move the cursor over the desired element in the 3D window. The

pointed at element will be pre-highlighted, and the cursor gain a tooltip with the element name. Click

 to select.

3D profiles based on hatches can be selected by picking the original hatch in the 2D window.

The Contour filed in the General Parameters tab of the Parameters window activates in conjunction

with the activation of the Select contour option in the Automenu. Upon selecting a contour this field

will contain a name of a selected element and an icon depicting a type of a selected element. Upon

multiple contours selection only number of elements is shown as well as an icon depicting multiple

elements. Right side of the Contour contains buttons allowing you to  Clear the selection and 
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 Expand list of selected elements.  Clear button is also available in other fields for geometrical

elements selection.

Clicking the  Expand button changes the Contour field layout. Left side of the field will contain the

list of all selected contours. The  Expand button on the right side of the field will be replaced by the

  Collapse button which allows you to switch to previous layout. The  Delete Element from the

List button also appears allowing you to delete the selected (highlighted in blue in the list) contour.

Click  on an element in the list if you need to select it.

You can also call the new profile creation command using the following automenu option:

<W> Draw Profile

Upon finishing the new profile creation it will be selected as an extrusion contour automatically. 

Keep in mind that all extrusion parameters defined before the new profile creation will be reset

to default. 

Upon selecting an extrusion contour the following option will be available in the automenu:

<H> Cancel contour selection

Elements selected as an extrusion contour are highlighted in red in the 3D scene throughout defining

an operation parameters.

Calling the command with automatic contour selection

A slick way of handling an extrusion is calling the command with automatic selection of an extrusion

contour. 

Enter the Draw on workplane mode and draw an extrusion contour.

Then, without leaving the active workplane mode, call the Extrusion command. The system will then

automatically create a 3D profile based on the Continuous type graphic lines or a hatch, and will

select it as an extrusion contour. If you'll draw on the same workplane again, automatic contour

selection will work for newly created contours only (new color).  

Defining the extrusion direction

Upon selecting a sheet or flat wire contour, the system automatically offers to create an extrusion in

the direction normal to contour plane. This is indicated by the preview of the resulting body, displayed
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on the 3D scene. There is no need in this case for defining the extrusion direction. The user can alter

the kind of extrusion simply by defining a different extrusion direction by specifying a direction vector.

If a preview is not displayed in the 3D scene, extrusion in the normal direction can't be created from

this contour.

The following automenu option allows to define an extrusion direction vector by a 3D model element:

<D> Select Direction

This option allows to select a 3D element suitable for defining an extrusion direction vector. This

option's activation enables filters  for selecting 3D elements allowed as an extrusion direction on the

Filter Toolbar. When selecting elements, pay attention to active filters. Selected element will be

shown in the Direction field in the General Parameters tab of the Parameters window.

The following automenu options allows to define an extrusion direction vector by two 3D points

(activate sequentially):

<F> Select starting Point of Extrusion

<S> Select ending Point of Extrusion

This option's activation enables filters  for selecting 3D elements allowed as an extrusion direction on

the Filter Toolbar. When selecting elements, pay attention to active filters. A 3D point can be defined

by selecting a 3D node, a vertex on a body, profile or path. Besides, selecting an edge yields the edge

midpoint as the 3D point (for straight edges) or the center (for edges that are full circles, arcs or

ellipses). Selecting a face that is part of a sphere or torus yields the sphere/torus center as the point. A

coordinate system selection yields the origin as the 3D point. If you define an extrusion direction by

two points, the Direction field in the General Parameters tab of the Parameters window will be

replaced by two new fields: First Point and Second Point. 

You can also reverse the direction vector by clicking the  Reverse Direction button located on the

right side of the Length or Offset fields (depending on the selected bounding condition) in the

General Parameters tab of the Parameters window.

The last option for the direction defining in the automenu cancels the vector selection:
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<K> Reset Direction selection

Elements selected for defining an extrusion direction are highlighted in yellow in the 3D scene

throughout defining an operation parameters.

You can also define the extrusion direction using manipulators.

Defining the extrusion boundaries

The extrusion bounding condition can be selected in the General Parameters tab of the Parameters

window. This tab contains two groups of parameters - First Direction and Second Direction. Each

group contains the drop-down where you can choose a bounding condition for the respective

direction.

The names of the parameter groups (First Direction and Second Direction) for specifying

boundaries are essentially arbitrary. The boundaries positions are generally not related to the

extrusion directions. The exception here is the bounding condition To Nearest Face that is

defined for a particular extrusion direction.

 

Automenu options for selecting boundaries are activated depending on the selected bounding

condition.
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Automatically, Symmetric and Symmetric by Total Length conditions do not require boundaries

selection, so you can move on to defining a Length. Through All and Through All by Direction

conditions do not require either boundaries or length, but do require defining a Boolean operation

parameters.

Selecting boundaries using From Base condition uses unique interface.

Selecting the bounding condition activates one of the following options in the automenu (depending

on whether the first or second direction being bounded):

<T> Select 1st limit of extrusion

<B> Select 2nd limit of extrusion

These options are used for selecting 3D elements as boundaries. This options' activation enables filters

  for selecting 3D elements allowed as a boundary on the Filter Toolbar. When selecting elements, pay

attention to active filters. Availability of certain filters depends on the selected bounding condition.

The last option in this automenu group cancels the selection. Depending on the state of the

command, one of the following options available:

<U> Discard 1st extrusion limit

<U> Discard 2nd extrusion limit

<U> Reset Bounds selection

The option  is available while defining the first boundary (under the active option ). The

option  is available while defining the second boundary (under the active option ). In other

states of the command (for example, under the option of contour or direction selection), the option

 is displayed allowing to cancel both boundaries selection at once.

Elements selected as extrusion boundaries are highlighted in green in the 3D scene throughout

defining an operation parameters.

Some types of boundaries can also be selected using manipulators.

Defining the base

Following options are available in the automenu for selecting a base:

<N> Select Starting Point of Extrusion

<L> Select Plane setting starting position of Extrusion

This options' activation enables filters  for selecting 3D elements allowed as a base on the Filter

Toolbar. When selecting elements, pay attention to active filters. 

First option is activated automatically upon selecting From Base bounding condition. You can switch

to second option by clicking  on it if necessary. Both options can also be activated by clicking 
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on them without selecting a bounding condition. In this case From Base condition will be selected

automatically upon selection of a base in 3D scene. 

You can cancel base selection using following automenu option:

<O> Cancel selection of Extrusion Base

Defining the extrusion length or offset

The extrusion Length value can be set in the General Parameters tab of the Parameters window.

Defining a Length value depends on the selected bounding condition. For some bounding conditions

Length values should be set separately for each direction (First and Second), other require Length

value for the First Direction only. Some bounding conditions use Offset value instead of Length.

You can also set Length or Offset values using manipulators.

Defining extrusion length by direction vector length or by numerical value

The default bounding condition for extruding in the First Direction is Automatically. It allows the

system to automatically choose a means of defining the extrusion length in the first direction

(depending on the way of defining the extrusion direction). 

When defining the extrusion direction by a vector, the system tries to define the extrusion length in the

first direction by the vector length. This is possible only when the vector is defined by two 3D points or

a straight edge. Value displayed in the Length field reflects the vector length value. To override this

mode, you can force the extrusion length input mode (in the first direction) by a numerical value. To

do this, simply enter the new value into the Length field or change length using manipulators.

When defining the direction vector by other means (for example, by axis of a cylindrical face or

normal to a surface), as well as in the case using direction normal to contour plane, the extrusion

length can't be defined by the length of the direction vector. In this case Length value will be set to

default (10 mm), which you change manually.

By default, extruding is not performed in the second direction. No bounding condition applied in this

case. The input boxes of the extrusion length and taper in the second direction are inaccessible.

To perform extruding in the second direction, select another bounding condition from the drop-

down. 

Extrusion Manipulators

To specify the length and also the direction of the extrusion, it is possible to use the special arrow-

shaped manipulators in the 3D scene. Red arrow represents First Direction of extrusion, blue arrow -

Second Direction. If you don't see manipulators make sure that they are enabled. Under some

bounding conditions manipulators are displayed only after boundary selection. Under Through All
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and Through All by Direction conditions manipulators are not available. Under Symmetric and

Symmetric by Total Length conditions manipulators are only available for first direction.

Context Menu of the Extrusion Manipulators

Clicking  on the tip (cone) of the manipulator arrow invokes the context menu, where you can

choose some of the bounding condition for selected direction::

· To Point;

· To Surface;

· To Face;

· To Sheet;

· To Solid (equal to To Body);

or open the Manipulator Settings window.

Clicking  one of the bounding conditions in the context menu sets the corresponding condition in

the Parameters window's drop-down for selected direction and activates boundary selection mode.

Clicking  on the axis of the manipulator arrow or on the ball of the end point manipulator

invokes short context menu where the only option available is to open the Manipulator Settings.

 

Extrusion Manipulators Settings

There are two checkboxes in the Manipulator Settings window:

· Enabling the Step checkbox overrides the default step value by the custom value which you

can set in the field on the right side of the flag. Step is responsible for the manipulator

position change increment upon dragging it while holding the 
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· Enabling Show Manipulator of end points checkbox enables ball-shaped manipulators near

tips of arrows. It is disabled by default.

Manipulator position change increment depends on a view scale in the 3D scene window.

Zooming in or out at some point will lead to 10 times change of the increment. Increment is

measured in units, which are set in the right part of the Length or Offset field.   

Extrusion Manipulators usage

Clicking   on the tip (cone) of the manipulator arrow makes cone move along the extrusion

direction vector in accordance with the cursor movement until  is clicked for the second time. 

Second  click:

· on a 3D point of an existing geometry selects this point as an extrusion boundary and

automatically selects To Point bounding condition for this direction of extrusion;

· on any other location of the 3D scene (if Offset bounding condition was not selected) selects

By Value bounding condition for this direction of extrusion and sets Length value

corresponding to the current position of the cone;

· on any other location of the 3D scene (if Offset bounding condition was selected) sets Offset

value corresponding to the current position of the cone;

Dragging the mouse while holding  on the tip (cone) of the manipulator arrow leads to Length

value change (or Offset value if Offset bounding condition was selected) in accordance with the cursor

movement. Setting length using this method automatically selects By Value bounding condition for

this direction of extrusion. It is not necessary to click directly on the manipulator cone. Move the cursor

over the end face (parallel to the extrusion contour) of the wire-frame preview of the operation result.

An icon  (for First Direction) or  (for Second Direction) will appear near the cursor. As long as

icon is displayed dragging the mouse while holding  works in the same way as when you do it

directly on the manipulator cone. These icons might be unavailable in some cases.

.

Clicking  on the shaft of the manipulator arrow activates mode for selecting an extrusion

direction vector. Move the cursor over a desired object. The appearance of the manipulator will

change - it shows the preview of an extrusion in this direction. If you are satisfied with a result, click

 on an object to select it as an extrusion direction. 

Clicking  on the ball of the end point manipulator activates mode for selecting a starting or

ending point of the extrusion direction vector. move cursor over the desired point.  The appearance of

the manipulator will change - it shows the preview of an extrusion in this direction. If you are satisfied

with a result, click  on a point and it will be selected as a starting or ending point (depending on

which ball manipulator you are using) of an extrusion direction vector. Second point can be selected

in the same way. You don't have to select both points using the manipulators. Each point can be

selected using different methods.

See also:

· Creating tapers

· Creating thin walls 

· Creating blends

· Using created body in Boolean operation 
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· Common options for solid 3D modeling operations

· Preview of Operation Result 

· Common Parameters of 3D Elements

Edit Extrusion

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual menu

<3EX> Edit > Operations > Extrusion

This command is used for editing Extrusion.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Extrusion command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).
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Rotation

Calling the command:

Icon Ribbon

3D Model > Create > Rotation

Workplane > 3D Model > Rotation

Keyboard Textual Menu

<3RO> Operation > Rotation 

The command can also be called from the dynamic toolbar or contextual menu for selected contour

in the standby mode.

Rotation operation creates solids by rotation of shape-defining element (rotation contour) about an

arbitrary axis by full circle (360°) or by an arbitrary sector. 
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The rotation contour can be made of wire geometry objects (either flat or 3D), as well as faces and

edges belonging to solids and surfaces. You can also select multiple objects of the same type. The

result of extruding is a surface or a solid body, depending on the selected contour and thin wall

parameters. Rotation axis and sector can be defined by various means, including usage of existing

model elements as a reference. Association with reference object stays active after an operation

creation, so rotation will be recalculated automatically according to reference objects' geometry

changes. Additional parameters of operation also allow to blend edges of resulting body.

The command's interface is shown below:

Topics in this section:

· Automenu Options for Rotation

· Parameters Window for Rotation

· Edit Rotation

Automenu Options for Rotation

Following steps should be done to create an operation:

1. Call the Rotation command.

2. Set Common parameters of operation  (non-mandatory action)

3. Select the rotation contour

4. Select the rotation axis

5. Set angle of rotation and start angle or starting and ending points of rotation (non-

mandatory action);

6. Set thin wall, blend, Boolean operation parameters (non-mandatory action);

7. Use Preview of the operation result  (non-mandatory action).

8. Finish input .

Following options become available in the automenu after calling the extrusion command:
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<W> Draw Profile

<R> Select Contour

<H> Cancel contour selection

<A> Select axis of rotation

<F> Select first point of Axis

<S> Select second point of Axis

<1> Select starting point of Rotation

<2> Select ending point of Rotation

<K> Cancel selection of points for Rotation

<Ctrl+T> Select target Body for Boolean

<Ctrl+B> Boolean operation mode

Contour and trajectory of rotation 

It is necessary to select a rotation contour. Upon calling the command following option is activated in

the automenu:

<R> Select Contour

This option's activation enables filters  for selecting 3D elements allowed as an extrusion contour (3D

profiles, operations, faces, edges, loops and 3D paths) on the Filter Toolbar. When selecting elements,

pay attention to active filters.

To define the extrusion contour, move the cursor over the desired element in the 3D window. The

pointed at element will be pre-highlighted, and the cursor gain a tooltip with the element name. Click

 to select.

3D profiles based on hatches can be selected by picking the original hatch in the 2D window.

Selected contour is shown in the Contour field in the General Parameters tab of the Parameters

window.

Rotation contour can lay in arbitrary position related to rotation axis, but axis should not intersect the

contour's base surface. Flat contour should not be perpendicular to rotation axis.

Rotation contour can be composed of set of 3D profiles, faces, edges, 3D paths or other objects, but

all selected objects should belong to the same type - either wire or surface-based (including closed

3D profiles).

Trajectory of rotation is defined by circle passing through geometrical center of rotation contour.

Center point of trajectory circle is defined by the normal projection of rotation contour's geometrical

center onto rotation axis. Operation will not be created if plane of rotation contour is tangent to

rotation trajectory or close to being tangent.
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You can also call the new profile creation command using the following automenu option:

<W> Draw Profile

Upon finishing the new profile creation it will be selected as a rotation contour automatically. 

Keep in mind that all rotation parameters defined before the new profile creation will be reset

to default. 

Upon selecting a rotation contour the following option will be available in the automenu:

<H> Cancel contour selection

Elements selected as a rotation contour are highlighted in green in the 3D scene throughout defining

an operation parameters.

Calling the command with automatic contour selection

A slick way of handling a rotation is calling the command with automatic selection of a contour and

axis of rotation. 

Enter the Draw on workplane mode and draw a contour and an axis.

Then, without leaving the active workplane mode, call the Rotation command. The system will then

automatically create a 3D profile based on the Continuous type graphic lines or a hatch, and will

select it as a rotation contour. When a single dash-dot line is present on a workplane, such line will be

selected as a rotation axis. If you'll draw on the same workplane again, automatic contour selection

will work for newly created contours only (new color).  

Axis of rotation

Following automenu options can be used to specify rotation axis:

<A> Select axis of rotation

<F> Select first point of Axis

<S> Select second point of Axis

If   option is active, a rotation axis can be defined by any object suitable to defining a straight line

geometry (including one of the rotation contour's edges). This option's activation enables filters  for

selecting 3D elements allowed as an axis on the Filter Toolbar. When selecting elements, pay

attention to active filters.
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Results of rotation of the same contour around different axes. Axes

are highlighted in yellow.

Axis of rotation can be defined by two 3D points (using   options). This option's activation

enables filters  for selecting 3D elements allowed as points on the Filter Toolbar. When selecting

elements, pay attention to active filters. 

It is possible to define rotation axis using single point only (if it lays on some surface). In this case a

normal direction to surface at selected point is used as an axis.

Elements selected for defining a rotation axis are shown either in Axis or First point and Second point

 fields in the General Parameters tab of the Parameters window.

Elements selected for defining an axis are highlighted in yellow in the 3D scene throughout defining

an operation parameters.

Direction of rotation

By default rotation is performed clockwise related to looking in the rotation axis' direction. Axis'

direction coincides to direction of the selected object. When defining an axis using two points,

direction goes from first point to second. You can reverse the direction of rotation using  Switch

rotation direction button in the General Parameters tab of the Parameters window.

Angle of rotation and start angle

By default rotation is performed by full circle (360°). You can set a custom sector of rotation using one

(or combination) of the following methods:

· Setting values in Angle and Start Angle fields in the General Parameters tab of the

Parameters window.

· Selecting Starting and Ending points of rotation using automenu;

· Using manipulators. 
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Starting and ending points of rotation

Following automenu options can be used to specify starting and ending points of rotation:

<1> Select starting point of Rotation

<2> Select ending point of Rotation

<K> Cancel selection of points for Rotation

Selecting a Starting point defines the initial position of the rotation contour. If only starting point is

selected, a rotation is performed using Angle value set in the eponymous field in the General

Parameters tab of the Parameters window. Start Angle field becomes inactive and displays value

defined by a starting point's position.

Selecting an Ending point defines final position of the rotation contour. Angle field also becomes

inactive and displays value defined by difference between ending and starting points' positions.

Selecting an ending point without selecting a starting point does NOT affect the operation result.

Starting and ending points are highlighted in yellow in the 3D scene throughout defining an operation

parameters.

Rotation manipulators

Angle and Start Angle values can be set using manipulators. Manipulators look like red arrow and

turquoise ball. 

Arrow's shaft represents a rotation trajectory, turquoise ball - starting point, arrowhead - ending

point. 

Dragging the mouse while holding  on the red arrow (no matter shaft of arrowhead) changes

position of rotation ending point in accordance with the cursor movement. Angle value in the General

Parameters tab of the Parameters window changes accordingly.

A single click on the red arrow (no matter shaft of arrowhead) activates mode for selecting

rotation ending point. In this mode position of the rotation ending point changes in accordance with

the cursor movement until  is clicked for the second time. However, if you hover the cursor over an

existing point in the 3D scene, position of a rotation ending point will be snapped to a said point.

Second click  confirms the point selection. Selected point will be displayed in the Second Point

field of the Rotation Range group in the General Parameters tab of the Parameters window and an

associative link is created. So from now on if position of selected existing point change, the result of

rotation is recalculated accordingly. Angle value in the General Parameters tab of the Parameters

window changes in accordance with the selected point's position.

Dragging the mouse while holding  on the turquoise ball changes position of rotation starting

point in accordance with the cursor movement. Start Angle value in the General Parameters tab of

the Parameters window changes accordingly. 

Unlike using automenu options, selecting an ending point using manipulator without selecting a

starting point DOES affect the operation result.
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A single click on the turquoise ball activates mode for selecting rotation starting point. In this

mode position of the rotation starting point changes in accordance with the cursor movement until

 is clicked for the second time. However, if you hover the cursor over an existing point in the 3D

scene, position of a rotation starting point will be snapped to a said point. Second click  confirms

the point selection. Selected point will NOT be displayed in the Parameters window and an

associative link is NOT created. So if position of selected existing point will change in future, the result

of rotation won't change. Start Angle value in the General Parameters tab of the Parameters window

will be set in accordance with the selected point's position at the moment of confirming the selection.

Using created body in Boolean operation

Options for Boolean operation creation are available in lower part of the automenu.

More information about Boolean operations can be found in Boolean operation chapter.

See also:

· Preview of Operation Result 

Parameters Window for Rotation

General Parameters

The Contour field in the General Parameters tab of the Parameters window activates in conjunction

with the activation of the Select Contour option in the Automenu. Upon selecting a contour this field



T-FLEX CAD 17 Help

1394

will contain a name of a selected element and an icon depicting a type of a selected element. Upon

multiple contours selection only number of elements is shown as well as an icon depicting multiple

elements. Right side of the Contour contains buttons allowing you to  Clear the selection and 

 Expand list of selected elements.  Clear button is also available in other fields for geometrical

elements selection.

Clicking the  Expand button changes the Contour field layout. Left side of the field will contain the

list of all selected contours. The  Expand button on the right side of the field will be replaced by the

  Collapse button which allows you to switch to previous layout. The  Delete Element from the

List button also appears allowing you to delete the selected (highlighted in blue in the list) contour.

Click  on an element in the list if you need to select it.

Axis. 

A name of an element selected as an axis of rotation and an icon depicting a type of element are

displayed in this field. 

When defining an axis by two points, this field is replaced by First point and Second Point fields (not

to be confused with eponymous fields in the Rotation Range group).

Angle. 

Value of a rotation angle (360° by default). If starting and ending points of rotation are selected, this

field becomes inactive and displays a value defined by difference between ending and starting points'

positions. 

 Switch rotation direction button is located near the Angle field. Clicking this button reverses

direction of rotation.

Start Angle. 

Defines the initial point of the rotation contour's transition relative to its actual position. When starting

point of rotation is selected, this field becomes inactive and displays a value defined by a starting

point's position. 
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Rotation Range group of parameters contains two fields: First point (displays starting point of

rotation) and Second point (displays ending point of rotation).

Thin Wall

Enabling the Thin Wall checkbox activates the toolbar for selecting Thickness application direction

Following directions are available:

No

Outside

Inside

Symmetric

Various

Selected option is highlighted in blue and has a black outline. 

Selecting No leads to creation of a zero-thickness surface. 

Selecting Outward, Inward or Symmetric activates the thickness Value 1 field and the operation yields

a solid body with a thickness applied to selected direction. 

Selecting Various activates thickness Value 1 and Value 2 fields, giving the ability to specify different

values for outward and inward thickness. Value 1 - outward, Value 2 - inward.

The new faces in the thin-wall body are created by rotating an offset contour of the original one. The

shape of the faces depends on the choice of handling the gaps when creating an offset contour.
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Following choices for gap handling become available on the Gaps toolbar after selecting the

thickness application direction:

By Line

By Curve

Round

Selected option is highlighted in blue and has a black outline. 

Round – The free ends of the neighboring offset curves are connected by fillets.

By Line – The offset curves of the original contour are extended at their free ends by tangent straight

line segments.

By Curve – The offset curves of the original contour are prolonged until intersect. 

Blend Parameters

Enabling Fillet checkbox activates blending of rotation side edges. Side edges can only be blended by

a round fillet. Fillet Radius can be set in the corresponding field. 

You can also add blending of the top and bottom faces if the operation yields a solid body. Enabling

Target Blend checkbox activates blending on the rotation ending face. Enabling Source Blend

checkbox activates blending on rotation starting face. You can choose between  Chamfer and 

 Round (fillet) types of target and source blend. Selected option is highlighted in blue and has a black

outline. Chamfer size or Round fillet radius can be set in the field to the right side of blend type

selection. Source blend and target blend are available only if rotation angle is less than 360°. 

Source Blend and Target Blend checkboxes are not available for the Thin Wall with No thickness.

Enabling Source Blend and Target Blend checkboxes for the Thin Wall with some thickness blends

both inner and outer contour edges of the corresponding face. Operation can not be completed if

source or target blend size exceeds half of the overall (inward plus outward) thickness of the Thin

Wall.

See also:

· Common options for solid 3D modeling operations

· Common Parameters of 3D Elements

· Preview of Operation Result 
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Edit Rotation

Calling the command:

Icon Ribbon

-

Keyboard Textual Menu

<3ER> Edit > Operations > Rotation

This command is used for editing Rotation.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Rotation command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).
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Edge Blend

Calling the command:

Icon Ribbon

3D Model > Operations > Blend > Edge Blend

Sheet Metal > Advanced > Blend > Edge Blend

Surfaces > Advanced > Blend > Edge Blend

Primitives > Advanced > Blend > Edge Blend

Keyboard Textual Menu

<3DE> Operation > Blend > Edge Blend 

The command can also be called from the dynamic toolbar or contextual menu for selected face,

edge, vertex or operation in the standby mode.

The edge blending operation makes transition between two or more adjoining surfaces belonging to

same body (solid or surface).

There are several types of blend:

· chamfer (offset; length-angle; offset along faces);
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· rounding;

· variable-radius rounding (circular, elliptical).

As the result of the operation, the edge where two faces meet is replaced by an additional surface

(the blend surface) providing the required transition from one face to the other. Vertices can also be

blended.

In the edge blending operation there is a special diagnostics mode available which allows a user to

promptly estimate possibility and causes of error appearance.

Blended faces and edges do not have to be flat, they may have different shapes (see examples

below).

Topics in this section:

· Main Concepts of Edge Blend

· Main Concepts of Vertex Blend

· Create Edge Blend

· Create Vertex Blend

· Boundary of Edge Blend

· Trimming of Edge Blend

· Manipulators of Edge Blend

· Special Options of Edge Blend

· Overflow Processing of Edge Blend

· Diagnostics of Edge Blend

· Edit Edge Blend

Main Concepts of Edge Blend

This sub-chapter describes basic principles of geometry creation. The detailed description of

operation creation interface can be found in other sub-chapters.
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Subjects of the edge blending operation are edges of a body (solid or surface). Additionally, some

vertices may be selected on the involved edges in order to specify particulars of the intended shape.

The set of the automenu options allows selection of various objects, besides the edges, such as loops,

faces, vertices and operations. This helps selecting certain common combinations of edges. Thus, for

instance, by selecting a vertex, we select all the edges meeting at that vertex. Selecting a loop by the

definition means selection of the sequence of edges making this loop. Selecting a face results in

selection of all its surrounding edges (single or multiple loops). Selecting a solid automatically makes

selected all its edges appropriate for blending.

It is very important to understand how the information is maintained about the original

elements subjected to blending. These original elements selected for blending are remembered

in the model history. Thus, in case a face was selected, a reference to this face is recorded in the

model tree. In this case, the set of edges to blend is built anew at each regeneration. This way of

selecting brings the advantage of having a quite robust operation. If topology of the selected

object changes (for example, the number of edges changes), the operation will be correctly

regenerated with the new set of edges of the involved object. Otherwise, if a specific edge were

selected that would later disappear, then the system would output an error.

Each selected edge has a direction indicated by an arrow. Other blend-defining conditions depend on

this direction. The arrow tail defines the edge start. According to an agreement, the surface on the

right-hand side of the edge, as looked in the arrow direction, is conventionally called the first blend

surface, and the one on the left-hand side – the second.
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Types of blend

Constant-radius rounding

Rounding is the most commonly used type of blending. A surface is created along the selected edge,

providing a smooth transition from one face to the other. A condition holds that any normal cross

section of this surface with respect to the edge is an arc of the specified radius. 

To easily realize how the rounding surface is generated, imagine a ball of the specified radius rolling

along the selected edge, touching the faces adjacent to the edge. The trace of the ball represents the

blend surface for the given edge. The surface may be defined in a single or multiple passes,

particularly, if different edges are rounded with different radii. Complex spline surfaces may be

constructed to join multiple edge blends.

The operation may add or remove material, depending on whether the angle between the faces of the

blending edge is convex or concave.

The rolling ball must be touching at least one of the adjacent faces. Otherwise, rounding will fail and

the system will output an error.

Variable-radius rounding  

This type of rounding creates a surface of a variable radius. A list of critical points is defined. A certain

value of the rounding radius can be set at each of these points. Each point position is defined as

percentage of the total edge length. Initially, this list contains two points at 0% and 100% of the edge

length. 
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If several edges are selected, then the point positions are defined as percentage of the total chain

length for all consequently adjoined edges. The edge joints are not required to be smooth. A single

direction is used for the whole chain of edges. It is defined by the direction of the first edge in the

chain.

When defining this type of blending along a closed loop of edges, always make sure that the

start and end point radii are equal.

The change in the rounding radius between points can be Linear or Smooth. In the Linear case, the

change in the radius is described with a broken line (the radius changes linearly from one point to

another). In the Smooth case – the change in the radius is specified by a curve having a horizontal

tangent at the start and end points.

Linear change of radius Smooth change of radius

A special mode is provided for processing certain cases, that allows specifying own variable rounding

parameters for each individual edge. When processing a smooth chain of edges in this mode, make

sure the radii are equal at the meeting ends of the adjacent edges. 

Variable-elliptical rounding 

This type of rounding allows creation of advanced blend surfaces. Size and shape of the blend surface

is defined by the offsets from the first and the second faces (as conventionally denoted), and by the

convexity coefficient (Rho) value.
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Depending on the convexity coefficient (Rho) value  all resulting surfaces are divided in three groups:

· 0 < K < 0.5

Blend surface cross section have elliptical shape.

· K = 0.5 

· Blend surface cross section have parabolic shape.

· 0.5 < K < 1

· Blend surface cross section have hyperbolic shape.

0 < K < 0.5
 Ellipse

K = 0.5 

Parabola
0.5 < K < 1 

Hyperbola

The shape of the surface can be defined at any point on the edge or on the chain of edges. The list is

managed in the same way as in the case of the circular variable-radius rounding. The change in the

rounding radius between points can be also Linear or Smooth as in the circular variable-radius

rounding.

The offsets from the faces define the boundaries of the blend surface. The algorithm for constructing a

blending surface with a variable elliptical radius is illustrated in the following figures:
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1. An offset surface is constructed at the distance Offset 1 from the second face. 

2. Another offset surface is constructed at the distance Offset 2 from the first face. 

3. The intersection line between the two offsets is projected on the original faces in normal direction,

thus defining the boundaries of the blend surface.

In the special case of blending two flat orthogonal faces, this means the distance from the blended

edge to the side boundary of the blend surface is equal to the value of the offset.

Chamfer by offsets 

A chamfer can be constructed along a selected set of edges. A chamfer can be defined by two offsets

from the adjacent faces. The algorithm for constructing a chamfer by offsets is similar to rounding

algorithm with variable elliptical radius and is illustrated in the following figures:
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Chamfer by length and angle

The chamfer can be specified by length and angle. The algorithm for constructing a chamfer by length

and angle is illustrated in the following figures:
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For a given angle, the second length value is calculated as the product of the first and the tangent of

the angle. Further calculations are performed as in the algorithm for constructing a chamfer by two

offsets.

Chamfer by offsets along faces

A chamfer can be specified with two offsets along adjacent faces. The algorithm for constructing a

chamfer by offset along the faces is illustrated in the following figures:
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From the point of intersection of the faces, offset values are measured along each face, and a

blending surface is created using the points at the ends of the offset.

When the angle between the surfaces is 90 degrees, the results obtained with the offset chamfer

and the offset chamfer along the faces are identical. Differences appear only with an arbitrary

value of the angle between the surfaces.

Main Concepts of Vertex Blend

This sub-chapter describes basic principles of geometry creation. The detailed description of

operation creation interface can be found in other sub-chapters.

Automatic vertex blending

A single operation can be used for blending all edges meeting at one vertex. The edges can be of

either the convex or the concave type. Simultaneous blending of all edges meeting at one vertex

automatically involves blending of vertex itself.
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A shape of blending geometry at a vertex can be changed by choosing a different Edge Processing

Order: Default (the order of smoothing edges is determined by the system independently), Concave

blends first, Convex blends first, On edges of minority convexity first, On edges of majority

convexity first. Please note: in order to control a shape of blending at a vertex, it is necessary to select

this vertex in addition to the edges when creating blending.

This option is not available for chamfers.

Red edge - convex,

Green edges - concave,

Green square - blended vertex
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Convex blends first Concave blends first

To avoid the vertex blending, do the edge blending by two blending operations, first blending any

two edges meeting at a vertex, and then the third edge, by disabling the Propagate option. The result

in this case will look as shown here:

First blend Second blend

Sometimes it is impossible to blend all edges at once, and the system outputs an error. In this case, try

creating the intended blends by steps.

The above implies that proper handling of the operation leads to successful blending of practically

any edges of any model.

It is recommended to use as few operations as possible when blending several edges of one

solid. Prefer blending a set of edges by one operation, rather than by a number of operations

one edge at a time. With this approach, the model regeneration is much faster, and the blending

algorithm most likely performs best.

Blending two of three edges meeting at a vertex 

When blending a pair of edges of the same convexity, two blend surfaces are constructed – one per

edge. The vertex is not blended in this case; rather, new edges are created at intersections of blend

surfaces. 

However, when blending a pair of edges of opposite convexity, the vertex where the edges meet is

automatically blended.
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Blending a pair of edges of the opposite convexity is impossible for chamfers.

Blending a pair of edges of the same

convexity

Blending a pair of edges of the opposite

convexity

Processing of vertices joining edges of different convexity 

Consider the special case when three edges of different convexity meet at a vertex. 

When blending two edges of the same convexity, you could use the option of also blending their

common vertex. This would require selecting the vertex as well. 

This option is not available for chamfers.

The results are shown below:

Rounding with an offset from vertex

When rounding a group of edges meeting at a vertex, you can specify an offset from this vertex. The

following figures demonstrate how this offsetting affects the shape of the resulting blend:
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You can see that the offset defines a zone of smooth transition from one blend surface into the other.

The specified radius of rounding is not guaranteed in the transitional zone. The transitional zone can

be created with or without special transitional faces - collar faces.

Blend with collar faces Blend without collar faces

The Offset parameter can be specified at any edge's start and end. However, offsetting can be done

only for a set of three or more edges meeting at a vertex. Some of the meeting edges may be

directed away and some towards the vertex. That said, make sure the offsets are defined on the vertex

side for all edges. If an edge connects two vertices, each subject to offsetting, then the offsets are to

be defined for both the edge start and end.

In some cases, T-FLEX CAD system allows automatic synchronization of the Offset parameters for the

edges with opposite direction. This happens, for instance, when selecting a group of edges by clicking

a vertex. (Detailed description of the steps for defining offsets can be found in other sub-chapters). 

Special dynamic manipulators are provided for marking offsets on the edges while defining the

operation parameters. Their presence and location help easily realize the offset parameters and

modify, if necessary, by the mouse.

Create Edge Blend

Following steps should be done to create an edge blend operation:

1. Select edges for blending.

2. Select Blend Type and define parameters depending on the selected type:

· Constant-radius rounding

· Variable-radius rounding
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· Variable-elliptical rounding

· Chamfer by offsets

· Chamfer by length and angle

· Chamfer by offsets along faces

3. Define Vertex Blend, Boundary Saving, Trimming, Special Options and Overflow Processing if

necessary.

4. Use Preview of Operation Result or Preview of Solid Changes if necessary.

5. If blend can not be created using specified parameters use Diagnostics and change parameters.

6. Finish input .

Selecting edges for blending 

After starting the operation, the element input field is active, allowing you to select all elements

suitable for creating the operation.

Upon calling the command the Edges tab on the General Parameters tab of the Parameters window

becomes active as well as the corresponding automenu option:

<E> Select Faces, Edges, Vertices

This automenu option and the Edges tab are linked together: activation of the tab activates the

automenu option and vice versa. This mode enables filters  for selecting 3D elements allowed for

defining edges  on the Filter Toolbar. Then you can select object in the 3D scene by moving mouse

cursor over it and clicking . When selecting elements, pay attention to active filters.  

Edges tab contain the list of elements.

Upon selecting an operation all edges of the corresponding body are added to the list. The body itself

isn't added to the list.

Upon selecting a vertex all edges meeting at this vertex are added to the list. The vertex itself isn't

added to the list.

Using vertex for selecting edges is the only way to automatically enable offsets.

Upon selecting a face it is added to the list and blend parameters are applied to all edges of such

face. Remember that selected face will always be considered the first blend surface.
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Upon selecting a loop it is added to the list and blend parameters are applied to all edges in a loop.

Remember that face framed by a selected loop will always be considered the first blend surface.

The way of selecting edges for blending (directly or using loops and faces) affects operation

regeneration upon further changes of initial geometry.

Edges and loops added to the list are highlighted in green in the 3D scene, faces are highlighted in

blue, current selection is highlighted in red.

Buttons allowing to   Collapse the list,  Delete Element from the List or  Clear the list are

located to the right side of the list. Click  on element in the list to select it. Selected element will

be highlighted in the list. 

List is represented in a tabular format.

The first column Element contains an element type icon (edge, face or loop), a name of an element

and a name of a parent body.

The second column Radius contains one or two numerical values. Depending on the selected blend

type such values may represent radii, offset 1 and offset 2 or length. Values could not be edited

directly from the list. Use corresponding fields below the list instead. If Common Properties checkbox

is enabled for selected element, value in Radius column are displayed in square brackets. Disabling

the checkbox removes brackets.

The third column Leave Selected contains the checkbox which applies blend to this particular element.

It's enabled by default. Disabling such checkbox will exclude corresponding element from the blend.

However excluded element will remain in the list after operation creation.

The smooth edge chain selection mode can be activated using the following automenu option:

<S> Smooth edge chain selection mode

A smooth chain is a set of edges making an open or closed continuous smooth curve (with a

tangent continuity (G1)).

When using this mode, all edges that can make a smooth chain together with the selected edge are

added to the list automatically.

Propagating blend on tangent edges. 
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The Propagate checkbox is available for all types of blend. This functionality searches for a smooth

continuation of the currently blended edge. A smooth chain may exist originally or form as new edges

are created on the blend boundary. In the case of successfully defining a smooth chain the system

attempts to propagate the blend along the whole chain.

The automenu option  described above has a similar purpose. However, when selecting an edge

with automenu option, all elements of the identified chain are included in the list. When using the

Propagate checkbox, the list may not contain all edges of the blended chain, rather, could be just one

edge. 

This is important in view of possible topology changes of the model when the smooth chain

contents may change. It's enough to select just a single most stable edge of the whole chain to

be blended. 

If the Common Properties checkbox is disabled for selected edge, the Propagate checkbox is applied

to such edge only. Otherwise Propagate checkbox is applied to all edges with Common Properties

enabled.

Defining operation parameters.

The operation parameters can be defined at any step of creating the operation. The operation

parameters can be defined in the Parameters window or using manipulators. 

The Parameters window of the Edge Blend operation consists of three sections: General Parameters,

Overflow Processing, Options. General Parameters tab itself contains four tabs: Edges, Vertices,

Boundary and Trimming. Edges tab may contain different controls depending on selected blend

type.

We recommend to begin defining parameters after selecting the elements for blending. As mentioned

above, the selected edges, faces, and loops are displayed in the list on the Edges tab. Blending

parameters can be defined for a particular object by selecting it in the list. Originally, blend properties

are set same for all elements. This is represented by enabled Common Properties checkbox. Disabling

this checkbox allows to define individual blending parameters for each element in the list.

The blend type can be selected from the general parameters. 
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Depending on the blend type, the appropriate controls appear for defining parameters attributed to

this type. 

Defining a constant-radius rounding

Main concepts of constant-radius rounding can be found in the corresponding sub-chapter.

1. Select edges for rounding. It is convenient to do this first. However, if necessary, objects can be

selected at any step of defining the operation.

2. Set the type of blend to Rounding (by default when starting an operation) in the general

parameters.

3. Set the Radius of the rounding in the Parameters window or using manipulators. 

Initially a single value of the radius is set for all edges processed by one operation. Changing Radius

for a single edge results in all the rest instantly adjusting by the same amount. To define individual

properties of some edge, select it in the list and disable the Common Properties checkbox. Then, an

individual value of the radius can be entered in the Radius field. The radius-controlling manipulators

on this edge will become independent from the rest as well.

4. Finish input .
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Defining a variable-radius rounding

Main concepts of constant-radius rounding can be found in the corresponding sub-chapter.

1. Select edges for rounding. 

2. Select the type Variable (circular) in the general parameters. 

The necessary controls will appear for defining the rest of parameters. 

3. Next, the set of intermediate points needs to be defined, and radii specified in each point. 

Note: initially, the system tries to compose one chain (not necessarily smooth) of all selected edges. If

this is impossible, then several chains will be composed. Within each edge chain, the set of points is

distributed along the full length of the chain.  

The system can automatically compose the chains from the edges with Common Properties checkbox

enabled only. If the Common Properties checkbox is disabled for some edge then the whole set of

points will be distributed along this edge only, and stay strictly specific to this edge. 
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If several edges that make a smooth chain are processed simultaneously, with the Common

Properties checkbox disabled, make sure the radii on each side of the edge joints are equal.

The list of points for defining the radii is located in the lower part of the Edges tab. The list is

represented in a tabular format.

First column Position contains a name of a point.

Second column Position (%) contains point's position on an edge expressed as a percentage of an

edge's length.

Third column Radius contains value of a blend radius at this point.

Radius and Position (%) values can not be edited directly in the list.

 Add after,  Delete Element from the List and   Graph buttons are located on the right side

of the list.

Initially two points exist in the list – Start and End, at 0% and 100% of the edge (chain) length

respectively. These points are always present, and their positions are not modifiable.

To add a new intermediate point, press the  button. A new manipulator will appear on the edge

controlling the new point position and the blending radius at this point.

The current position of the selected point is displayed in the Position (%) field below the list of points.

Default position of a newly added point is between the point selected add the moment of adding and

the next one in the list.

Blend radius at the selected point is displayed in the Radius field below the list of edges.

To adjust the radius and position values without using manipulators, select point in the list and enter

values in the aforementioned fields.

Point selected in the list (except Start and End) may be deleted using  button. 
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Position of the points may be specified via a graph. Use  button. This button will open the graph

editing. window. The range of definition by X is 0-100 corresponding to the percentage from the

length. The value area is limited with positive numbers only.

4. Specify the type of the radius change – Linear, Smooth, or a special option – Auto;

The type of the radius change is selected from the Interpolation drop-down. The option Auto is set by

default. In this case:

· if only start and end points are specified for the current rounding, the radius change will be

calculated by the linear algorithm;

· otherwise (when intermediate points are specified) a smooth algorithm of the radius change is

applied.

5. Finish input .

Defining a variable-elliptical rounding

Main concepts of variable-elliptical rounding can be found in the corresponding sub-chapter.

1. Select edges for rounding. 

2. Select the type Variable (ellipse) in the general parameters. 

The necessary controls will appear for defining the rest of parameters.

3. Next, the set of intermediate points needs to be defined, along with the offsets and convexity

coefficient (Rho) values at each point.

Variable-elliptical rounding is based on special points, just like the previous, variable-radius,

rounding. The point defining techniques are similar to those described for the variable-radius

circular rounding. The difference of this blend type is in the ways of defining the shape of

rounding.

In this way of blending, two offsets are defined at each point defining boundaries of the blend at the

given cross section, and the convexity coefficient (Rho) value of the cross section curve. 

Offset 1 and Offset 2 for selected point may be specified in eponymous fields located below the list

of edges or using manipulators. Offsets are also displayed in eponymous columns of the points list.

Convexity group of controls is located below Offset 1 and Offset 2 fields. There you can specify

convexity coefficient (Rho) using slider or enter the value from keyboard.
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In general, without use of manipulators, the following procedure is recommended for defining the

blend surface parameters at the points: 

· Select the required edge in the list.

· Add required number of intermediate points; define their position on the edge or chain of

edges.

· Go through the points of each edge, defining the offsets and convexity coefficient (Rho)

values.

4. Specify the type of the radius change – Linear, Smooth, Auto (in the same way as for creating

variable-radius circular rounding);

5. Finish input .

Defining a chamfer

Main concepts of chamfers can be found in the corresponding sub-chapters:

· chamfer by offsets

· chamfer by length and angle

· chamfer by offsets along faces

1. Select edges for chamfering.

2. Select the blend type Chamfer (Offsets), Chamfer (Length-Angle) and Chamfer (Offset along

Faces).
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The necessary controls will appear for defining the rest of parameters.

3. Define chamfer parameters. The set of parameters is different for various chamfer types. The easiest

way to roughly set up parameters values is using manipulators. Exact values can be entered in the

Parameters window. Offset 1, Offset 2, Length and Angle values could be entered using keyboard in

the corresponding fields located below the list of edges.

 



Solid Body

1421

The edge direction determines which face correspond to which offset (or length and angle). The edge

direction can be flipped using the Reverse checkbox. This checkbox works individually for each edge

and does not depend on the Common Properties checkbox.

When defining chamfer by length and angle, the second marker of the manipulator will be driving the

Angle parameter. A special checkbox can be enabled against the Angle field that will block angle

modification using manipulator. When this checkbox is enabled, both markers of the manipulator

drive the Length while keeping the angle fixed.

4. Confirm the operation by .

See also:

· Common options for solid 3D modeling operations

· Common Parameters of 3D Elements

· Preview of Operation Result 

Create Vertex Blend

Vertex is blended automatically when blending all edges which meet at this vertex. Additionally you

can specify Y-Shape, Offsets, Vertex Chamfer or Edge Processing Order parameters if necessary. 

When rounding two edges of a same convexity, meeting at a vertex with a third non-blended edge of

an opposite convexity, such vertex is not rounded automatically. However, you can set rounding of

such vertex manually. For this you have to select a vertex. Rounding will be applied to selected vertex

using radii specified for the adjusting edges.

This option is available only for constant-radius and variable-radius rounding.

For constant-radius rounding this option works only if adjusting edges are rounded using equal

radius values.
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For variable-radius rounding this option works if both of following conditions are met: 

· parameters are specified individually for each edge (Common Properties checkbox is

disabled);

· equal radius values are set for adjusting edges' ends.

Selecting a vertex for blending

To select a vertex go to the Vertices tab of the General Parameters tab of the Parameters window, or

use the following automenu option:

<Z> Allow vertex selection without edge selection

.

This automenu option and the Vertices tab are linked together: activation of the tab activates the

automenu option and vice versa. This mode enables filter  for selecting points on the Filter Toolbar.

Then you can select a vertex in the 3D scene by moving mouse cursor over it and clicking .

Selected vertex will be displayed in the list. Vertices added to the list are highlighted in green in the

3D scene, current selection is highlighted in red.

Buttons allowing to   Collapse the list,  Delete Element from the List or  Clear the list are

located to the right side of the list. Click  on element in the list to select it. Selected element will

be highlighted in the list. 

Each row of the list contain an element type icon (vertex), a name of an element and a name of a

parent body.

Vertex blend options checkboxes are located below the list.

The Common Properties checkbox (enabled by default) applies same condition of Y-Shape, Use

Collar Faces and Chamfer checkboxes as well as selected Edge Processing Order to all elements in

the list. Disabling Common Properties for selected element allows to define its parameters

independently.

Y-shape 

When two edges of opposite convexity are tangent at a vertex where three or more faces meet, a

special option is available for blending the vertex - Y-shape. Blend surfaces created using this option

are lesser curved in the transitional zone around the vertex, then surfaces created by default.
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Blended edges are highlighted in

green, vertex selected for Y-shape

definition is highlighted in red

Operation result with Y-Shape

disabled

Operation result with Y-Shape

enabled

This option is available only for constant-radius and variable-radius rounding.

Following steps should be done to create an Y-Shape rounding:

1. Select edges for rounding. 

2. Select the vertex for Y-Shape blending.

3. In the list on the Vertices tab, click the vertex and enable the Y-Shape checkbox for it.

If Y-Shape blend can't be constructed in the given vertex, the system will apply default way of

blending, ignoring the Y-Shape checkbox.

 

4. Depending on the selected blend type specify the blending radius for edges using

manipulators or in the Parameters window. 

5. Finish input .

Defining a rounding with an offset from a vertex

Main concepts of rounding with an offset from a vertex can be found in the corresponding sub-

chapter.

This option is available only for constant-radius and variable-radius rounding.
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Following steps should be done to create a rounding with an offset from vertex:

1. Select edges for rounding by clicking on a vertex in the mode  of selecting faces, edges

and vertices. Zero-value offsets from the selected vertex are automatically set when selecting

edges using this way. This is indicated by appearing of offset manipulators. Selected edges

will be put in the list on the Edges tab in the Parameters window. The vertex itself won't be

put in the list. 

2. Specify offset values. This can be done using offset manipulators or by entering values into the

Start and End fields of the Offset group located below the edges list.

Common Properties are enabled for all

selected edges

Common Properties are disabled for the

vertical edge

Initially, the Common Properties checkbox is enabled for all edges. This allows entering equal

offsets for all selected edges. Modifying one offset causes all the rest edges assume the same

value. This is indicated by the synchronous movement of offset manipulators. 

To define different values of the offsets, disable the Common Properties checkbox. This does

not have to be done for all edges at once. Individual properties can be set only for some

particular edges by disabling Common Properties checkbox only for them. For the rest, the

common properties will still be used.
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The offset values are displayed in the Start or End fields of the Parameters window -

depending on which point of an edge is used as a base for offset. Exact values can be typed in

these fields using keyboard. Checkboxes activating the Offset at the start or at the end of an

edge are located to the left side of the Start and End fields. When selecting edges by clicking

a vertex, the system automatically enables necessary checkboxes for the edges meeting at

such vertex. This is done depending on edge direction. Some edges have a Start offset, others

- End offset, so that all of them have offsets from the vertex where they meet.

If necessary, you can manually define enable desired offset using these checkboxes.

Meanwhile, manipulators can be used for visual control of offset parameters.

3. Depending on the selected blend type specify the blending radius for edges using

manipulators or in the Parameters window. 

4. By default blending with offsets uses collar faces. If it is necessary to disable collar faces, you

need to additionally select the vertex itself. Collar faces are not used on the selected vertices

by default. You can Use Collar Faces on selected vertex by enabling the eponymous

checkbox. 
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5. Finish input .

Defining a vertex chamfer

For a vertex at which three or more edges meet it is possible to create a chamfer without chamfering

adjacent edges. It cuts body by polygon created using points defined by Offset values for the adjacent

edges. In some complex cases the resulting chamfer surface will be curved.

Vertex chamfer can not be created when edges of opposite convexity meet at this vertex or

when one of the edges splits tangent faces.

Following steps should be done to create a vertex chamfer:

1. Click  on a vertex in the mode  of selecting faces, edges and vertices. All edges

meeting at this vertex will be added to the list on the Edges tab of the Parameters window.

The vertex itself won't be put in the list. Zero-value offsets from the selected vertex are

automatically set when selecting edges using this way. This is indicated by appearing of offset

manipulators.

Select edges meeting at a single vertex only. Creating chamfers on a multiple vertices in a single

operation is impossible. 

2.  Specify offset values. 

This can be done in the same way as for rounding using offset manipulators or in the

Parameters window.

3. Select vertex and enable Chamfer checkbox for it.

 It is impossible to select a vertex before setting offset values, because, when offsets are equal to

zero, manipulators overlap the vertex

 Select a single vertex only - the one where selected edges meet. Creating chamfers on a

multiple vertices in a single operation is impossible. 
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4. Finish input .

Defining edge processing order when blending vertices

This special processing is only applicable for constant-radius rounding. 

Main concepts of edge processing order can be found in the corresponding sub-chapter.

Following steps should be done to define an edge processing order:

1. Select edges for rounding.

2. Depending on the selected blend type specify the blending radius for edges using

manipulators or in the Parameters window. 

3. Select vertex where you want to specify edge processing order

4. For the selected vertex the Edge Processing Order field becomes active. From the drop-

down list it is possible to select one of the following options: Default, Concave blends first,

Convex blends first, On edges of minority convexity first, On edges of majority convexity

first.
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5. Finish input .

See also:

· Common options for solid 3D modeling operations

· Common Parameters of 3D Elements

· Preview of Operation Result 

Saving Boundary of Edge Blend

Main Concepts of Edge Blend Boundaries

When the blending is created, it is possible to specify the edges of the body which must remain intact

upon blending. As a result, the blend surface will be bounded by these edges. 

Blended edge is highlighted in

green, saved boundary edge is

highlighted in red

Blend result without saving

boundary

Blend result with saving

boundary

In some particular cases saved boundary is selected automatically. Automatically selected boundary is

NOT displayed in the list of boundaries in the Parameters window. You can override automatic

boundary selection by selecting the desired boundary manually.
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Blended edge is highlighted in green,

manually selected saved boundary is

highlighted in red

Blend result with 

automatically saved boundary

Blend result with 

manually saved boundary

Some edges can not be used as saved boundaries. They can still be added to the list of boundaries in

the Parameters window, but enabling the Save checkbox for them do not affect the blend result. 

Edge highlighted in red can not be saved, 

as it lays on the straight line 

intersecting the blended (highlighted in green) edge

Selecting saved edges (boundaries) 

To select a boundary go to the Boundary tab of the General Parameters tab of the Parameters

window, or use the following automenu option:

<L> Select Saved Edges
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This automenu option and the Boundary tab are linked together: activation of the tab activates the

automenu option and vice versa. This mode enables filter  for selecting edges on the Filter Toolbar.

Then you can select an edge in the 3D scene by moving mouse cursor over it and clicking .

Selected edge will be displayed in the list. Edges added to the list are highlighted in green in the 3D

scene, current selection is highlighted in red.

Buttons allowing to   Collapse the list,  Delete Element from the List or  Clear the list are

located to the right side of the list. Click  on element in the list to select it. Selected element will

be highlighted in the list. 

Each row of the list contain an element type icon (edge), a name of an element and a name of a

parent body.

The Save checkbox is located below the list. It works individually for each selected edge. Enabling this

checkbox will force system to try and save selected edge. If saving is impossible, the checkbox

condition will be ignored.

Trimming of Edge Blend

Main Concepts of Trimming

It is possible to trim the blend surface by an arbitrary faces, plane or surface. It might be useful in

some complex cases.
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Blended edge is highlighted in green,

trimming face - blue

Blend result without trimming Blend result with trimming

Trimming has priority over saving boundaries.

Blended edge is highlighted in green,

saved boundary edge - red, trimming

faces - blue

Blend result without trimming Blend result with trimming 

(no matter if saving boundary is

enabled or not)

Selecting trimming geometry

To select trimming geometry go to the Trimming tab of the General Parameters tab of the

Parameters window, or use the following automenu option:

<T> Select Trimming Surfaces
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This automenu option and the Trimming tab are linked together: activation of the tab activates the

automenu option and vice versa. This mode enables filters  for selecting objects allowed as trimming

geometry on the Filter Toolbar. Then you can select an object in the 3D scene by moving mouse

cursor over it and clicking . When selecting elements, pay attention to active filters.

Selected object will be displayed in the list. Objects added to the list are highlighted in blue or green

(depending on the object type) in the 3D scene, current selection is highlighted in red.

Buttons allowing to   Collapse the list,  Delete Element from the List or  Clear the list are

located to the right side of the list. Click  on element in the list to select it. Selected element will

be highlighted in the list. 

Each row of the list contain an element type icon, a name of an element and a name of a parent body.

The Reverse Direction checkbox is located below the list. It works individually for each selected

object. Enabling this checkbox changes the location of resulting blend surface in relation to the

trimming object

Manipulators of Edge Blend

Manipulators are helper graphic widgets for dynamically defining main numerical parameters of the

blend. Manipulators appear automatically once the objects for blending have been selected. Their

quantity, look and size depend on the type of blend, the kind of selected objects and the type and

values of the parameters modified by them. 

Manipulators are displayed in various colors. By default, the active manipulator (the one being

currently dragged using mouse) is drawn red, all the rest (inactive) are yellow.
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1 - Active manipulator

2 - Inactive manipulator

Using manipulators for blending of many edges at once may cause delays in system responses,

especially on low-performance computers. To speed up the system in such cases, manipulators

can be turned off. This is controlled by the respective checkbox in the Options tab of the

Parameters window.

Offset manipulators are always displayed individually for each vertex. Other kinds of manipulators

could be either individual for each edge or common for a whole edge chain. 

Constant-radius rounding manipulators

Radius manipulators have a shape of a blend surface's cross-section (arc) with two square markers at

endpoints.

On straight edge a single manipulator appears at the midpoint. On curved open edges two

manipulators split blend surface in equal length sections. On curved closed edges either two or four

manipulators might appear in different cases.

Moving the mouse cursor over any of a manipulator's endpoint markers leads to a radius icon

appearing near the cursor. Dragging the mouse while holding , when the radius icon is present,

leads to blend Radius value change in accordance with the cursor movement. Depending on the

Common Properties checkbox condition, Radius changes either for all edges at once (which affects

the appearance of their manipulators) or for the corresponding edge only. Both endpoint markers of a

single manipulator work in the same way - it doesn't matter which one to use.
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Variable-radius rounding manipulators

Radius manipulators have a shape of a blend surface's cross-section (arc) with two square markers at

endpoints.

Quantity of manipulators for each edge (or edge chain) depends on the quantity of radius change

critical points. By default at least two points are created - start and end. On open edges an individual

manipulator appears for each point. Start and end points of closed edges have a common

manipulator, due to necessity of having equal radii at such points (otherwise blend could not be

created) 

Moving the mouse cursor over any of a manipulator's endpoint markers leads to radius icon

appearing near the cursor. Dragging the mouse while holding , when radius icon is present, leads

to blend Radius value change in accordance with the cursor movement. Depending on the Common

Properties checkbox condition, Radius changes either for all edges at once (which affects the

appearance of their manipulators) or for the corresponding edge only. Both endpoint markers of a

single manipulator work in the same way - it doesn't matter which one to use.

On intermediate points besides from radius manipulators, point position manipulators appear. They

look like an unfilled contour (  - active,  - inactive) and are located a bit aside a corresponding

radius manipulators. Sometimes point position manipulator might appear relatively far from

corresponding radius manipulator.

Moving the mouse cursor over a point position manipulator leads to a point position icon 

 appearing near the cursor. Dragging the mouse while holding , when point position icon is

present, leads to Position (%) of the corresponding point change in accordance with the cursor

movement. Depending on the Common Properties checkbox condition, Position (%) changes either

for all edges at once (which affects the position of their manipulators) or for the corresponding edge

only.

Variable-elliptical rounding manipulators

Offset from face manipulators have a shape of a blend surface's cross-section with two square markers

at endpoints. Shape of cross-section depends on blend parameters.
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Quantity of manipulators for each edge (or edge chain) depends on the quantity of critical points. By

default at least two points are created - start and end. On open edges an individual manipulator

appears for each point. Start and end points of closed edges have a common manipulator, due to

necessity of having equal offsets at such points (otherwise blend could not be created) 

Each of two manipulator's endpoint markers represents its own offset value (Offset 1 or Offset 2).

Moving the mouse cursor over an endpoint marker leads to a radius icon  appearing near the

cursor. Dragging the mouse while holding , when radius icon is present, leads to a corresponding

Offset value change in accordance with the cursor movement. Depending on the Common Properties

checkbox condition, Offset changes either for all edges at once (which affects the appearance of their

manipulators) or for the corresponding edge only.

On intermediate points besides from offset from face manipulators, point position manipulators

appear. They look like an unfilled contour (  - active,  - inactive) and are located a bit aside a

corresponding offset from face manipulators. Sometimes point position manipulator might appear

relatively far from corresponding offset from face manipulator.

Moving the mouse cursor over a point position manipulator leads to a point position icon 

 appearing near the cursor. Dragging the mouse while holding , when point position icon is

present, leads to Position (%) of the corresponding point change in accordance with the cursor

movement. Depending on the Common Properties checkbox condition, Position (%) changes either

for all edges at once (which affects the position of their manipulators) or for the corresponding edge

only.

Chamfer manipulators

Chamfer manipulators have a shape of a blend surface's cross-section (straight line segment) with two

square markers at endpoints.

On straight edge a single manipulator appears at the midpoint. On curved open edges two

manipulators split blend surface in equal length sections. On curved closed edges either two or four

manipulators might appear in different cases.

In chamfer by offsets and chamfer by offsets along faces modes each of two manipulator's endpoint

markers represents its own offset value (Offset 1 or Offset 2). 



Solid Body

1437

Moving the mouse cursor over any of a manipulator's endpoint markers leads to a radius icon

appearing near the cursor. Dragging the mouse while holding , when radius icon is present, leads

to a corresponding Offset value change in accordance with the cursor movement. Depending on the

Common Properties checkbox condition, Offset changes either for all edges at once (which affects the

appearance of their manipulators) or for the corresponding edge only.

In chamfer by length and angle mode manipulator's way of operation depends on the condition of

the checkbox which is located to the left side of the Angle field on the Edges tab of the Parameters

window. If checkbox is enabled (by default) both endpoint markers represent Length value, while

Angle does not depend on the manipulators usage. Disabling the checkbox makes one of the

endpoint markers represent Length and other represent Angle. As to the rest manipulators in chamfer

by length and angle mode are used in a similar way as in other types of chamfer modes. 

Offset from point manipulators

Offset from point manipulators have a shape of a triangle. They appear on edges with offset (Start or

End) checkboxes enabled. When zero offset values are set for all edges meeting at a given vertex,

manipulators will overlap at vertex.

Moving the mouse cursor over an offset manipulator leads to a vertex icon  appearing near the

cursor. Dragging the mouse while holding , when radius icon is present, leads to a corresponding

Offset value change in accordance with the cursor movement. Depending on the Common Properties

checkbox condition, Offset changes either for all edges at once (which affects the position of their

manipulators) or for the corresponding edge only.
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Special Options of Edge Blend

Delete elements 

In the cases when blend surface completely overlaps other topological entities, two ways of

processing the operation are possible depending on condition of the Delete Elements checkbox. This

checkbox is located in the bottom part of the General Parameters tab in the Parameters window

(independently of Edges, Vertices, Boundary and Trimming tabs). 

If the checkbox is disabled, the system retains all overlapped elements, while trimming or extending

blend surface if necessary.

If the checkbox is enabled, the system deletes all overlapped elements, leaving the blend surface

only. 

Blend surface 

does not fully overlap blind holes

In result Delete Elements option doesn't

delete anything
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Blend surface fully overlaps blind holes, 

but does not fully overlap protrusion 

In result Delete Elements deletes holes

but does not delete protrusion 

Blend surface fully overlaps both blind

holes and protrusion

In result Delete Elements 

deletes both holes and protrusion
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Blend surface fully overlaps both ends 

of through hole 

In result Delete Elements deletes hole

Blend surface fully overlaps only one end 

of through hole 

In result Delete Elements should be disabled to

create a blend. Otherwise the system will throw an

error

Specifying the order of blend creation when blend surfaces overlap on several edges

When blend surfaces overlap on several edges of different convexity, it is possible to achieve the

desired shape of these surfaces by changing the order of blend creation. The order of blend is

determined by the selected priority of the edges processing. By default convex edges are processed

first, concave edges - last.

You can change the priority be enabling Apply Concave Blend First checkbox on the Edges tab of the

General Parameters tab in the Parameters window.
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+

Blended edges 

are highlighted in green

Blend result if

Apply Concave Blend First
checkbox is disabled

Blend result if

Apply Concave Blend First
checkbox is enabled

Curvature-continuous
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Curvature-continuous checkbox is available in the bottom part of the General Parameters tab in the

Parameters window (independently of Edges, Vertices, Boundary and Trimming tabs) for all types of

rounding. Enabling this checkbox implements curvature continuity (G2) between resulting blend

surface and adjusting faces. 

Using this option distorts Radius (for constant-radius and variable-radius rounding) or Offset 1,

Offset 2 and Convexity coefficient (Rho) (for variable-elliptical rounding).

Affect of Curvature-continuous checkbox on different types of rounding:

1 и 2 - Cross-section shape of a blend surface in starting point of the edge

3 и 4 - Cross-section shape of a blend surface in ending point of the edge

1 и 3 - Curvature-continuous checkbox disabled

2 и 4 - Curvature-continuous checkbox enabled
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Constant-radius rounding

Variable-radius rounding

Variable-elliptical rounding, Convexity = 0.6
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Variable-elliptical rounding, Convexity = 0.1

3D fragment supplement mode

<Num0>   3D fragment supplement mode

This option becomes available in the automenu when creating a blend on a fragment in assembly.

Overflow Processing of Edge Blend

In real situations, an overflow may quite often occur between the rounding surface and some elements

of the solid geometry that are not the adjacent faces of the rounded edge. In such cases, the system

may use special options for processing such overflows. These options are controlled in the Overflow

Processing tab in the Parameters window.

This tab contains overflow processing options checkboxes and Inside Tight Corners processing drop-

down

All checkboxes are enabled by default. In this case the system tries to apply all possible options in the

order of their interface layout. So Process Smooth Overflow goes first, then Retain Cliff Edges along

with its Process Cliff End  sub-option, and finally Notch.

You can disable or enable necessary options by using checkboxes.

In case where all checkboxes are disabled an blend surfaces overflow other edges or faces, blend

operation could not be created.
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Process Smooth Overflow

This option is applicable when blend surface overflows an existing rounding of the processed body.

Blend surface is deformed in the transition zone in order to provide tangency to the rounding surface.

In following examples it is necessary to enable either Process Smooth Overflow 

or Retain Cliff Edges to create a blend. If both options are enabled, Process Smooth Overflow being

applied. 

Other overflow processing options are not applicable in these cases.

Blended edges are

highlighted in green
Process Smooth Overflow is applied

independently of other checkboxes'

conditions

Retain Cliff Edges is applied 

if Process Smooth Overflow is disabled

Process Smooth Overflow option is applicable both to Roundings and Chamfers.

In following examples it is necessary to enable Process Smooth Overflow. 
Other overflow processing options are not applicable in these cases.
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Blended edges are highlighted in green Chamfer result

Retain Cliff Edges 

Retains a sharp edge when the rounding surface "creeps" over it. Blend surface is formed by rolling a

ball which is tangent to one of the initial faces and supported by a retained edge.

In the following example it is necessary to enable Retain Cliff Edges. 

Other overflow processing options are not applicable in this case.
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Blended edges are highlighted in green Rounding result

In the following example it is necessary to enable Retain Cliff Edges. Process Smooth Overflow option is

applicable but non-mandatory. Other overflow processing options are not applicable in this case.

Blended edge is highlighted in green Process Smooth Overflow 

is disabled

Retain Cliff Edges is enabled

Both Process Smooth Overflow
and Retain Cliff Edges 

are enabled

Retain Cliff Edges option is not applicable to chamfers. 

Upon enabling Retain Cliff Edges option you can additionally enable/disable Process Cliff End sub-

option, which processes the case, where only ending part of blend surface overflows a sharp edge.
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Blended edge is highlighted in green.

None of the Overflow Processing

options are mandatory in this case

Process Cliff End is disabled Process Cliff End is enabled

Process Cliff End sub-option is not applicable to chamfers 

Notch 

Rounding is constructed in such a way that the element affected by the overflow is ignored. The

rounding surface is not deformed in this case, and the surfaces of the notched element are trimmed or

extended to the rounding.

In following examples it is necessary to enable either Notch or Retain Cliff Edges. If both options are enabled,

only Retain Cliff Edges is applied. Other overflow processing options are not applicable in these cases.

Blended edges are

highlighted in green

Retain Cliff Edges is applied independently

of other checkboxes' conditions

Notch is applied only if Retain Cliff Edges

is disabled

Notch option is applicable both to Roundings and Chamfers.

In following examples it is necessary to enable Notch. Other overflow processing options

are not applicable in these cases.
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Blended edges are highlighted in green Chamfer result

In some case when Notch option is mandatory for creating a blend it might be applied automatically

and independently of Overflow Processing checkboxes condition.

Inside Tight Corners

Some portions of model subjected to blending might be represented by surfaces with so small

curvature radius that the blending ball of the specified radius cannot roll through while maintaining

contact with sidewalls. In such a case, the system can use special processing for providing blending

with the specified radius in the curved zone:

· Tight blends – in this case, the system will process curved zones using the fastest algorithm.

The algorithm assumes that surfaces in these zones are created solely by blends of constant

radius. If a type of an original surface is different and a blend cannot be created, an error is

output.

· Tight faces – the system processes curved zones, assuming, that a zone of small curvature

radius fully extends through some face of a sidewall.

· Tight partial – this is the most complex, but also versatile, algorithm. It allows processing

cases, when a zone of small curvature radius covers a portion of a sidewall of a blend. In this

case, a blend surface is additionally subdivided in order to provide correct processing.

Disabling unnecessary complex options allows to lower a time required for model regeneration.

Here are the examples of using different inside tight corners processing options:
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Unprocessed original Tight blends processing

Unprocessed original Tight faces processing

Unprocessed original Tight partial processing

Diagnostics of Edge Blend

The special diagnostics mode in the edge blending operation allows a user to determine the

possibility and causes of the error appearance while creating the blend.

The absence of errors in the diagnostics mode is the necessary but not the sufficient condition 

for successful blend creation. The absence of errors in the diagnostics mode does not guarantee

the successful completion of the operation creation.

If diagnostics mode do not detect any errors, but blend still can not be created, try noticing

messages in the Diagnostics window.

The following option of the automenu is used for entry into the diagnostics mode:
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<D> Diagnostics

This option is available for selection right after selecting the objects for blending.

In the preview mode and in the mode of viewing the changes made by the operation the option

for starting the diagnostics mode is also available if, in these modes, the problems arise upon

the model regeneration.

When entering into the diagnostics mode, the system automatically analyzes specified objects and

blend parameters. The objects, the blending of which may cause problems, are highlighted in green in

the 3D scene. If a problem of an object is caused by another object the latter is highlighted in yellow.

Callouts connect highlighted objects to labels. Each label contains short description of a problem for

connected object. Upon moving mouse cursor over a label it changes appearance from the default

arrow to . In this mode you can drag and drop labels for better view.

In the diagnostics mode all fields of the Parameters window are locked and selection of objects

in 3D scene is impossible.

Edit Edge Blend

Calling the command:

Icon Ribbon

-

Keyboard Textual Menu

<3EDE> Edit > Operations > Blend > Edge Blend

This command is used for editing Edge Blend.

Available options:

<Esc> Cancel selection
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<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Face Blend

Calling the command:

Icon Ribbon

3D Model > Operations > Blend > Face Blend

Sheet Metal > Advanced > Blend > Face Blend

Surfaces > Advanced > Blend > Face Blend

Primitives > Advanced > Blend > Face Blend

Keyboard Textual Menu

<3DF> Operation > Blend > Face Blend 

The face blending operation lets create a blend surface between one set of smoothly meeting faces to

another. The sets of the blended faces are not required to have common edges (intersect). Blending

can be done over solid bodies, as well as sheet bodies. The command has numerous options for

controlling the shape of the blend surface, defining trimming conditions, bounds, etc. Do not consider

this operation as an alternative to the edge blending operation. These two approaches have their

advantages and limitations, well complementing each other.
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Topics in this section:

· Main Concepts of Face Blend

· Special Capabilities of Face Blend

· Create Face Blend

· Face Blend Parameters

· Overflow Settings of Face Blend

· Edit Face Blend

Main Concepts of Face Blend

The two sets of faces for blending are conventionally called the right and the left wall. In most general

case, these can be arbitrarily positioned in space and have arbitrary geometry of the surface. The

system constructs the blend surface between the right and the left wall in several steps. 
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                  Step 1                                                        Step 2                                           Step 3

· First, the set of planes is computed for holding the blend cross sections. The position of each

plane depends on the existence and the shape of the auxiliary direction guide, as well as on

the computational algorithm of a particular blend type. One can specify various blending

effects by manipulating the orientation of the cross section planes. 

· Next, two points are defined on each plane that will be the bounds of the future blend surface.

One point belongs to the right wall, the other – to the left. These will be referred to as the

points of contact of the blend surface. The sets of the points of contact on the right and left

walls make the two lines of contact. The position of the points in each cross section depends

on the shape and mutual situation of the walls, as well as on the computational algorithm of

the particular blending mode. 

· Finally, the system computes each cross section of the blend surface spanning the two points

of computed in the previous step. The shape of the blend cross section depends on the

positions of the points of contact and on the selected geometrical algorithm.

· The final result may also be affected by a number of additional functions and boundary

conditions.

Direction Guide

The direction guide defines positions of the blend cross-section planes. 3D paths can be used as

guides. The direction guide is used for constructing most types of blends. Often, when all parameters

appear to be defined yet the confirmation button is inaccessible, most probably the direction guide is

needed. 

If the guide is too short for constructing the whole blend surface, the system extends the guide by

straight segments tangent to the 3D path at the ends. If the guide is longer than required, the system

will attempt automatically define the necessary portion if the 3D path.

Sometimes, the operation can be created without use of a guide, as in the case of simple rolling ball

blending.

Blend Types

There are two types of blends. Each type involves its own algorithm of constructing cross section

planes for computing the blend surface.

Rolling ball blend

In this type of blending, the cross section planes are made orthogonal to the right and left walls. This

blend type does not require a guide in the "Constant radius" and "Constant width" modes. 

In the "Constant radius" mode, a notional ball of the specified radius defines the points of contact as

it touches the right and left walls. This ball "rolls" all the way along the right and left wall and leaves

two lines of contact. The cross section planes pass through the points of contact and the center of this

notional ball at a given instant.

Rolling ball blend is the only type supporting the "Constant width" mode. In this case, the system

automatically positions the cross section planes for best fit to the requirements of the specified blend

mode. The guide is not required in this case either.
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The "Variable radius" mode always requires using a guide. A current point on the guide is used to

define the nearest points on the blended surfaces. Normals to the right and left wall surfaces are

constructed at these points. The cross section plane passes through the current point on the guide. The

plane normal is computed as a cross product of the two surface normals from the above. In the

special case of flat wall surfaces, true to say that the cross section plane passes through the current

point on the guide and is oriented orthogonal to either wall.

Disc blend 

A plane is constructed orthogonal to the guide through each point on the guide. A current blend

surface section is computed in each such plane.

                      

Rolling ball blend                                                                                            Disc blend

Isoparametric blend 

This is an advanced type of blend. Isoparametric blend is a special type provided for turbine design. It

is used to make a blend between a turbine blade and a base.  The isoparametric blend is best for this

kind of parts.

The isoparametric blending is similar to the disc type. However, the blend cross-section planes are

oriented along the isoparametric lines of the blade surface in this case. Because of this, the blade

surface ought to be necessarily the first set of faces (the left wall).

The direction guide must lie on the left wall (the one that defines the isolines). A dependency is

established between the points on the guide and the blade surface. Then the specified cross-section

blend surface is constructed tangent to the current isoline.

                

            Rolling ball blend                                                                 Isoparametric blend

The diagram on the left-hand side shows a rolling-ball blend with self-intersection zones. The right-

hand side diagram demonstrates an isoparametric blend with no flaws. 

Blend Modes

Blend modes define the ways of computing the blend surface bounds in the current cross section. Only

the bounding points (points of contact) are computed in the cross sections of the blend surface. What

will be constructed in between the bounding points depends on the chosen shape of the blend

surface.
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Constant radius 

In this mode, the blend surface is constructed of the constant shape across the extent of the blend. The

term "radius" in the mode name is just a convention. In fact, variations of this type include, besides the

conic-shape roundings, chamfers and surfaces of smooth curvature (see below "Shapes of blend

surfaces"). This depends on the specified blending shape. With the conic shape of the cross section

selected, a surface is constructed with each cross section being a circular arc of a specified radius.

Variable radius

This blending mode supports blend surfaces with the shape parameters varying across the extent of

the blend. All cross section parameters are controlled via special auxiliary points distributed along the

blend surface. The points of contact are computed in the variable-radius mode based on two ranges

defined for each such auxiliary point. The same approach is used for computing the points of contact

by the ranges, as in the command "Blend Edge". The same chapter (see the topic "Variable-radius

elliptical rounding") describes and illustrates the approach in details. The following is different in

variable-radius blending by the "Blend Face-Face" operation from the variable-radius elliptical

rounding by "Blend Edge". First, it is the way of constructing the cross section planes. Second, it is

availability of other cross section shapes (besides the conic one).

Constant width

In this blending mode, the blend cross sections are constructed based on the constant chordal width

condition. These are the chords connecting the points of contact in cross sections. This type of

blending is especially desirable when the angle between the blended faces varies across the extent of

the blend. In this case, one may want to specify approximate amount of cross section additional

material to be maintained along the blend.
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"Constant width" mode only works with "rolling ball" type blend.

            

In this blending mode, the parameters of the shape are the chordal width and the ratio of the ranges

for the bounding points of the blend surface. A ratio of ranges other than 1 makes a blend with a

constant chordal width and asymmetrical cross section.

In constant width mode, the system automatically determines the shape of a conic cross section.

Shapes of blend surfaces

Three different shapes of blend surfaces are supported.



T-FLEX CAD 17 Help

1458

Conic 

Conic is one of the shapes found in sections of a cone by a plane. These are a circle, an ellipse, a

parabola and a hyperbola. In the constant radius mode, if "conic" shape is selected then the blend

cross sections are arcs of the specified radius. In the variable-radius mode, the shape of a cross section

is dependent on the "skew" parameter representing the rho value of a conic. Different values of this

parameter yield an ellipse, a parabola and a hyperbola.

Chamfer

The chamfer-type blend cross section is defined as follows. The points of contact, computed in each

cross section, are connected by a straight line. Chamfer is supported for all blend types and blending

modes.

Continuous curvature shape

This way of blending provides continuity of the surface curvature where the blend surface meets the

walls. In other words, the blend surface has the same curvature at the points of contact as the

respective wall.

In "Constant radius" and "Constant width" blending modes the shape of the surface depends on a

single "Softness" parameter controlling the smoothness of the transition from one wall to the other.
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The value of the softness greater than zero is allowed, with the maximum unlimited. With the softness

values approaching 0, the blend cross section becomes closer to a chamfer. However, if a true chamfer

is required then the "Chamfer" setting for the blend shape is recommended instead.

The "Variable radius" mode provides two parameters for controlling the blends with continuous-

curvature cross sections – "Offset" and "Depth". 

 

These two parameters together define the deepest point on the current blend cross section – the

"Depth point". The "Offset" defines the position of the "depth point" between the two contact points.

The parameter varies from 0 to 1, exclusive. The depth point approaches the left wall, as the offset

approaches zero and the right wall with the offset approaching one. The "Depth" defines the position

of the "depth point" between the chord connecting the two points of contact, and the intersection of

the wall tangents. The parameter varies between 0 and 1, exclusive. With values near 0, the "depth

point" approaches the chord between the points of contact, while with values approaching 1 – the

intersection of the right and left wall tangencies.
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Boundary conditions

Tangency to faces

In the cases when a blend surface overflows beyond the blended faces (of the right or left wall) then

the system can adjust the blend surface to keep edges overflown by the blend surface. This results in

shifting the line of contact of the blend surface in the area of the edge overflow to actually make it

coincide with the edge. The blend surface adjustment is done while maintaining the tangency

condition at the wall surface in the points of contact. 

If the blend surface can't be fit within the extent of the walls, two types of constraints can be specified

- "One-face tangent" or "Two-face tangent".

The boundary condition is defined by selecting an edge or a set of edges belonging to one or another

wall, called "holdline". 

If one face tangency is elected then the opposing line of contact of the blend surface is not disturbed.

It will satisfy the defining rule of the shape of the surface (as, for instance, the radius). If two-face

tangency is elected then the opposing line is distorted symmetrically. 

Inverted tangency to faces 

The boundary condition is defined by an edge or a set of edges belonging to one of the walls (the

holdline). With too small radius values, when the blend surface can't be constructed, the system shifts

the line of contact to the holdline. The blend surface is tangent to the faces of the wall along the line

of contact. If the back tangency to one face is elected, then the opposing line of contact of the blend

is not disturbed. It will satisfy the defining rule of the surface shape (as, for instance, the radius). If

inverted tangency to two walls is elected then the opposing boundary is distorted symmetrically. Thus,

the blend surface is no longer defined by the radius. Rather, it is deformed by the boundary conditions

wherever imposed.

Cliffedge

This is the "sharp edge" overflow, when tangency is not maintained at the bounding edge. 
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The edge overflown by the blend surface is left unchanged. The blend surface is constructed without

distortions in such a way that the cross section spans between the wall and the line of contact of one

side and the cliffedge on the other side, without altering the guiding rule of the cross section shape.

To understand this, consider a simple example of a spherical blend with a constant radius. Imagine a

ball of the given radius rolling on one wall, keeping contact with the sharp edge on the other wall. 

With this constraint, tangency is not provided for the blend surface along the cliffedge, however, the

shape of the sections is not distorted and is constructed by the specified rule across the blend surface.

Special Capabilities of Face Blend

Notch 

Sometimes, the walls to be blended may include topology insertions (Notches) that cross the line of

contact of the blend surface. A special option "Notch" helps identify such insertions and let blending

extend in the affected area trimming the blend surface with the faces adjacent to the wall. Without

this option, the blending would stop before the affected area, where the line of contact is crossed.
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Tangent propagation 

This blend option allows extending the blend surface on the adjacent faces smoothly connected to the

selected walls. This simplifies the operation definition by letting select just one face per a wall. The

system will attempt propagating the blend surface on all adjacent faces as far as possible.

   

Propagate option can't be used for disc and isoparametric blend types.

Propagate option is applicable when defining boundary conditions (see details below). This allows

specifying just one edge for defining boundary conditions if all bounding edges connect in a smooth

chain.
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Trimming with planes 

Flat faces and workplanes can be used for limiting the blended area. One limit plane divides the blend

surface into two parts leaving just one part in the scene. Total of two limit planes can be defined. The

two planes will surround from the two sides the central portion of the.

It is important to keep in mind that by dividing the blend surface the limit plane is not trimming it. The

blend surface is divided along a cross section plane at the point of intersection between the limit

plane and the blend spine. 

Blend end trimming 

When creating a face-face blend, there is a choice of trimming options for the end boundaries of the

blend surface. The geometry of the walls themselves is not disturbed by trimming the blend surface.

Total of four trimming options are available:

· No trimming. When trimming is off, the blend surface is extended beyond the ends of either

wall. 

· Short trimming. The blend surface is trimmed by the end boundaries of the shorter wall. 

· Long trimming. The blend surface is trimmed by the end boundaries of the longer wall. 

· Faces to wall trimming. The blend surface is trimmed by the end boundaries of both walls.

Meanwhile, the side edge of the blend surface is constructed such as to provide tangency with

both side edges of the trimming walls.

First three options can be used for blending sheet bodies only.
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Wall trimming 

In addition to blend surface trimming, the walls can be trimmed as well along the line of contact. 

Selecting the resulting topology  

The face-face blend operation can be stored in the model structure in several topological variations.

The choice of a topological solution is combined with the wall-trimming interface (the previous

topic). Total of four solutions are available:

· "Separate body" means neither wall will be trimmed and the blend surface will stay as a

standalone sheet body. The objects selected for the walls to blend will remain in the model

structure in the original state. The blend operation will be represented by a separate sheet

body – the blend surface.
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· "Trimmed on both walls" trims both walls along the line of contact without attaching the

blend to any wall. This solution has a practical meaning only for sheet bodies. 

The model structure will reflect the face-face blend operation alone at the top level. The operations

whose faces were selected as walls will be written in the model history one level deeper. Meanwhile,

the blend operation will be represented by three sheet bodies. This means that if, for instance, the

operation Divide Solid is applied to the blend then three separate sheet bodies will be created, the

two trimmed walls and one blend surface.

· "Attach to the left wall" trims both walls and attaches the blend surface to the walls. If

blending was done between two different sheet bodies then these bodies are united into one

by the blend. The operation used as the left wall will further be used as the reference in the

model structure.

· "Create body" trims both walls, adds the blend to the walls and creates a solid body if

possible. This solution can only be used together with the "Faces to wall" trimming option.

This option is similar to the previous. The specific of this option is the system attempting to

create a solid body. This is done if a check is satisfied for the resulting geometry to form a

closed volume.

Solution using an adjusting point 

In some cases, several blend surfaces can be constructed for the same set of walls. One can accept

them all. However, a particular solution can be specified. The system accepts the solution nearest to a

selected node.

Processing curved zones (Inside tight)

The algorithm's for processing curved zones allow creating blend's in the areas where the value of the

curvature radius of the sidewalls is less than the blend radius. This option is available only for rolling

ball blending by a conical section of a constant radius. This functionality is described in more details

in the chapter "Edge blend".

Create Face Blend

The property window and the automenu are used for handling the command and defining necessary

components. These work simultaneously and enhance each other. The state of the automenu depends
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on the operation defining stage and on the purpose and type of the objects being selected. The

object selection modes can be manipulated via either the automenu or the property window.

To create the operation, follow the following steps:

1. Select first set of faces (the left wall)

2. Select second set of faces (the right wall)

3. Specify blend type (if necessary)

4. Select the spine (if necessary, depending on the blend type)

5. Specify blending mode (if necessary)

6. Specify the shape of the blend cross section (if necessary)

7. Specify geometrical parameters of the blend cross section 

8. Specify boundary conditions and overflow processing (optional)

9. Confirm operation creation

Using draggers and decorators

As the face-face blend operation is being defined, the parameters can be specified and various

objects selected in the 3D window with the help of auxiliary elements. These elements help quickly

review and modify the configuration of the operation being created. Their quantity, shape and size

depend on the defined properties of the operation, on the purpose of the selected objects and on the

type and values of the parameters controlled thereby. The elements that control parameters

dynamically are called "Draggers". The elements that merely display some or other operation

properties are called "Decorators".

Draggers are displayed in various colors. By default, the active dragger (the one driven by the mouse

at the moment) is drawn red, all the rest - yellow. Decorators are drawn blue by default.

Draggers are used for quick reviewing of the result and correcting it, therefore, the shape follows the

actual blend surface with limited accuracy. Dragger does not make an account of all details of the

cross section in the case of the surfaces with continuous curvature and is not responding to such

settings as "Convexity", "Softness", etc.

Using draggers with numerous active objects on a low-performance computer may cause delays

in the system response. To speed up workflow in this situation, the draggers may be turned off.

The off switch for the draggers is located in the "Options" section of the property window.

The following topics review all types of manipulators and decorators for each flavor of face-face

blend.

Selecting a set of faces

Normally, the operation is defined beginning with selecting the sets of faces between which the blend

will be constructed. The left and right-wall sets are formed when one of the following automenu

options is active:

<L> Select left-wall face

<R> Select right-wall face

Switching between the options is done by pressing an icon button in the automenu. Turning on an

option automatically activates the respective tab on the property window. The list of selected faces of

the right or left wall is displayed in the provided pane under the tab tag. Switching between the tabs

of the property window also activates the appropriate options for face selection.
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Face selection is done using the mouse in the 3D view window.

The selected faces of the left wall are highlighted in green by default, the right ones - yellow. Settings

of the highlighting colors are done in the system customization dialog box. The current face

highlighting color is reflected in a color box on the tab tag for each set.

A decorator is drawn in the middle of each face, shaped as an arrow, marking the side of the face

adjacent to the blend surface. In a general case, two walls make four quadrants, each being suitable

for constructing a blend surface. The blend is created in the quadrant pointed at by both arrows.

For solid bodies, the direction of an arrow is determined automatically. For sheet bodies, the direction

of faces has to be controlled manually by the user. For flipping the system default direction, set or

clear the "Reverse" flag.

To exclude a face from a wall set, simply select it in the list in the property window on the respective

tab and press [Delete] button.

Blending mode selection

A blending mode can be defined (modified) at any step into the operation setup. The name of the

mode is selected in the pull-down menu in the property window. Three modes are available:

"Constant radius", "Variable radius" and "Constant width".

"Constant radius" mode settings

In the "Constant radius" mode, the user needs to additionally specify the  "radius" of the blend

surface. The "radius" input box appears in the property window right after selecting this mode. By

default, the system sets the radius equal to 10 units.

This field is synchronized with the draggers. Depending on the selection of the blend surface shape,

the dragger is drawn as an arc or as a line segment (only for chamfer creation). The number of

manipulators depends on the number of faces in the right and left wall sets. All manipulators update

simultaneously and relate to the same parameter, the "radius".

"Variable radius" mode settings

The "Variable radius" mode brings more additional controls in different parts of the property window.

 At the bottom of the property window there are standard controls for manipulating intermediate

points for variable-radius blend. The special item "Positions" manipulates the list of auxiliary points.
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The points "Start" and "End" are always included. Other points are named as they are created. Adding

and deleting points is done using the buttons [Add] and [Delete]. A point position is specified in a

special input box by percentage of the total length of the blend surface.

 

The "Variable radius" mode requires setting two offsets for each auxiliary point. Initially, the system

sets the second offset equal to the first one, as indicated by the checked box before the second offset

in the property window. With this setting, the two offsets change simultaneously. If the setting is

cleared, an individual value can be defined for the second offset. 

Positions of the auxiliary points and their offset values can be defined by draggers (see the diagram

below). 

"Constant width" mode settings

The "Constant width" mode requires two numerical parameters – "Width" and "Ratio". By default, the

system presets the width of 10 units and the ratio equal to (-1). These fields  are synchronized  with 

the  respective dragger. Depending on  the blend shape selection, the dragger is drawn as an arc or as

a line segment (for chamfers only). The number of draggers depends on the number of faces in the

right and left walls.

Blend type selection

The type of the blend operation can be selected from the pull-down list in the property window. One

can select any of the three choices: "Rolling Ball", "Disc", "Isoparametric". The system sets the rolling

ball type by default.
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Spine selection

To turn on the spine selection mode, activate the following automenu option, 

<S> Select 3D path as guide curve

1Selection of a 3D path is done in the 3D window or in the model tree by the mouse. The name of the

selected 3D path is displayed in the property window. 

Only one 3D path can be used as a guide. If, say, by a mistake, a wrong path was selected, another one

can be selected right away. Selection of a new 3D path cancels the previous, and the last selected path

will be used as a guide.

To reject a 3D path selection, use the automenu option:

<W> Cancel Selection of 3D Path as a guide curve

Defining the shape of cross section

The shape of the cross section can be selected from the pull-down list in the property window. The list

contains three choices: "Conic", "Chamfer" and "Continuous curvature". By default the conic cross

section shape is defined. Depending on the blending mode and the selected shape of the cross

section, additional controls may appear or hide in the property window for controlling the cross

section shape and its geometrical parameters.

Conic cross section settings

When using the "Constant radius" blending mode, no additional settings are requires. In this mode,

defining a conic shape makes the blend cross sections become arcs.

An additional "Rho" parameter is defined in the "Variable radius" mode for conic cross sections. The

parameter value is defined separately for each characteristic point of the variable blend. By default,

the value of 0.5 is assigned to this parameter. In this case, the cross section is a parabola. With smaller

values the cross section becomes an ellipse, with greater ones – a hyperbola. This parameter may not

be 0 or less and 1 or more.

In the "Constant width" mode the shape of the conic section depends on the definitions of the mode

itself, in particular, on the "Offset" parameter. If the offset ratio is defined equal to 1, then the blend

cross section will become a circular arc, otherwise it will be a parabola.
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Chamfer settings

No additional settings are required for this shape of the cross section in any blending mode. The

points of contact, computed for each cross section according to the chosen mode, are connected by a

straight line.

Continuous-curvature cross section settings

The continuous-curvature cross section can only be realized under the rolling-ball blend type.

Therefore, selecting this shape for the cross section automatically switches the system into the rolling-

ball blend type.

In the "Constant radius" and "Constant width" modes, the shape of the cross section is controlled by

the single parameter "Softness". The softness value must always be greater than zero The system

default for this parameter is 1.

In the "Variable radius" mode, the shape of the continuous-curvature cross section depends on two

parameters – "Offset" and "Depth". Both parameters vary in the range from 0 to 1, exclusive. The

default value is 0.5. The values of the parameters are defined separately for each characteristic point

of the variable blend.

Defining boundary conditions

All types of boundary conditions are defined along the specially selected edges.

Turning on this option automatically activates the "Constraint" tab of the property window. The

provided pane under the tag displays the list of selected edges. Switching to this tab of the property

window from any other mode activates the edge selection mode as well. The type of boundary

conditions can be selected from the pull-down list. Five choices are available: "tangent", "conic",

"inverted tangent", "inverted conic" and "cliff". The default offered by the system is "tangent". Each

constraining  edge  requires  individual setting of  the  boundary  condition type, in a certain order.

First, you need to select a constraining edge in the complete list of edges, and then define (if

required) the boundary condition type using the pull-down list.

To remove an edge from the list of constraining edges, press [Delete] button in the property window

on the "Constraint" tab.
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One should keep in mind that constraints can work only in connection with compatible

geometrical parameters of the blend surface that are defined by the blending mode and cross

section shape.

Thus, if the cross section parameters prevent the blend surface from reaching a holdline then the

tangency condition on one or both walls is impossible. Vise versa, if an "inverted tangent"

constraint is imposed, then the appropriate "radius" of the blend surface is such that the blend is

not reaching the holdline or the wall itself in the zone of the constraint validity.

It follows from the above that often draggers stop working on a blend surface constrained to certain

boundary conditions. For example, when creating an "inverted tangent" blend surface that does not

reach the walls initially, the draggers are not displayed. Vise versa, when creating a "tangent to walls"

blend surface that does not fit amid the walls then the dragger reflects the largest arc fitting amid the

walls.

Mode group

Mode group of options has been reworked. Old options have been replaced with Radius, Offset, and

Width values:

Radius mode is designed to create a symmetrical blend with a constant or variable radius. A variable

value is indicated by using graphs. 

In the Offset mode, you can control the offset of the two directions separately. 

Width mode allows you to create a rounding with a constant width. The setting of the Ratio option is

available. 

If the ratio is 1, the rounding is symmetrical:
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If the ratio less or greater than 1 - the rounding is asymmetrical: 

A group of Form options has also been reworked. As before, three types of shapes are available:

Conical, Chamfer and Continuous Curvature.

There are two possibilities for constructing a conical section. 

The first is with the Rho option turned off: 

In this case, a circle will be drawn if the rounding is symmetrical, and if the rounding is asymmetrical -

an ellipse. 

The second possibility of creating a conical section is with the Rho option enabled. In this case, you

will be able to set the value manually, or set the graph. The Rho value can be set from 0 to 1.
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In the case of a graph, you will need to specify a guide.

For the Continuous Curvature form, it became possible to select Type. Two types are available -

Softness and Depth. Softness works similarly to the previous version of T-FLEX. 

For the Depth type, it is possible to set the Offset and Depth values. For both options, you can set

both a constant value and a value using the graph.
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Overflow settings

Notch. Tangent propagation

Attributes are provided in the property window for turning on notch handling and tangent

propagation. These parameters are accessible for use with all types of blend.

Creating a "wire-face" blend

To create a "wire-face" blend you must specify:

· set of faces of solid/sheet body as a left or right wall of the blend. The second wall is not

defined;

· set of smoothly conjugate edges of the wire body (3D profile, 3D path) as a boundary

condition;

· radius of the blend;

· option for the final result topology (only the "Separate body" or "In left wall").

All other parameters of the operation in this mode are not used.

As in the general case, for selecting faces it is necessary to either activate one of the tabs "Left/Right"

in the parameters window, or use one of the automenu options:

<L> Select left-wall face

<R> Select right-wall face

Option for the final result topology is determined by the "Result" drop-down list  in the parameters

window. For this mode of blend, you can use only two options: "Separate body" and "In left wall".

Option "In left wall" can only be set if the original set of faces belongs to a sheet body. In this case,

the resulting body is attached to the original sheet body, regardless of which wall has been set in

operation - the left or right.
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Face Blend Parameters

General Tab

Name. The following names are generated for the blend operation by default: Blend_0, Blend_1, and

so on.

Then the General parameters of the operation are set.

Edge Tab 

· Type. Sets the type of smoothing surface. This parameter can take the following values: 

· Rounding (the section of the smoothing surface is a circle).             

· Variable (circular) (the cross section of the smoothing surface is a circle of variable radius).

· Variable (elliptical) (the cross section of the smoothing surface is an ellipse).

· Chamfer (offset).

· Chamfer (length-angle). Note that this type of smoothing only makes sense if the neighboring

faces form a right angle.

· Radius. Sets the value of the rounding radius. It is important that the radius value specifies the

inscribed circle, otherwise the system will return an error message.

· Offset on the first face (for the Chamfer smoothing type). The first is the face that is located to

the right of the edge, if you look in the direction of the arrow that indicates the edge.

· Offset on the second face (for the Chamfer smoothing type). The second is the face that is

located to the left of the edge, if you look in the direction of the arrow that indicates the edge.

· Length (for the Chamfer smoothing type (length-angle)). Sets the distance deferred along the

first edge face. That is, on the face that is located to the right of the edge, if you look in the

direction of the arrow that indicates the edge.

· Angle (for the Chamfer smoothing type (length-angle)). Sets the angle of the smoothing

surface.

· If the smoothing type is set to Variable (circular), a list of points is available, each of which can

be set to a specific value for the blend radius. By default, the list contains two points - the

start and end points of the edge.  If you need to enter a new point, use the Add button. Edit

and Delete buttons allow you to pass blend parameters for the selected point in the list or

delete it.

For the Variable (elliptical) smoothing type, new points with parameters are set in the same way as the

previous smoothing type.

In this case, you can set the following values for the edge point: 

Length. Specifies the percentage value of the point. You can set the value using the slider or enter it

manually in the parameter field.

Radius 1. The value of the radius that is deferred along the first edge face. The first is the face that is

located to the right of the edge, if you look in the direction of the arrow that indicates the edge.

Radius 2. The value of the radius that is deferred along the second edge face. Accordingly, the second

face is located to the left of the edge, if you look in the direction of the arrow indicating the edge.

Bulge.  Defines the cross-section type of the smoothing surface. The bulge values are divided into

three groups: 

· the first group of values is in the range from 0 to 0.5, not including the extreme values. For

values of this convexity group, the cross section of the smoothing surface is defined by an

ellipse.

· the second group includes the value 0.5. With this convexity value, the cross section of the

smoothing surface is defined by a parabola.
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· the third group of values is in the range from 0.5 to 1, not including the extreme values. For

values of this convexity group, the cross section of the smoothing surface is defined by a

hyperbola.

The convexity values for all edge points must belong to the same group.

Topology: Specifies how to handle intersections of the smoothing surface with other surfaces. It can

take the following values: 

Delete. The system handles the intersection of the smoothing surface with the surfaces that the

selected elements belong to.

Save in the region. The system handles the intersection of the smoothing surface with all the surfaces

of the model.

A group of Offset parameters forms the edge rounding surfaces in the vertex area. These parameters

are relevant if all three edges that converge at the same vertex are selected on the model. To set the

margin, it is advisable to select edges of the same convexity, otherwise an error may occur.

Start, End. When these parameters are enabled, fields become available where you can set the

numerical value of the offset of the edge smoothing surface from the specified vertex at the

beginning or end of the edge. You can only use the indentation parameters present on this tab if all

the edges of the vertex are selected for smoothing. If three edges that converge at the same vertex

are selected for smoothing, then all three edges at that vertex must have the same position: either the

beginning or the end. Otherwise, use the same parameters on the List tab to set margins for each edge

separately. For example, if you select three edges that converge at the same vertex (edges 1 and 2 end

at the selected vertex, and edge 3 has a beginning at this vertex), then set the offset value for edges 1

and 2 in the End parameter, and for edge 3 in the Start parameter. The offset value must exceed the

value of the smoothing radius. The figure shows smoothing without margins and with the specified

margins (in this case, the margins are equal for all edges).

Overflow Processing tab

This group of flags defines algorithms for processing overlaps of the smoothing surface with the

surfaces of the body. If the flags are set in several types of overlaps, the system will create an overlap

when building the smoothing surface, which it was able to create when iterating through the specified

types of overlaps.   

· Process Smooth Overflow. The smoothing surface is created tangent to the interface surface.

Flags of Different convexity and One convexity define the algorithm for creating a smoothing

surface.

· Retain Cliff Edges. The smoothing surface is created in such a way that it converges on the

sharp edges of the body that belong to the interface surface. Flags of Different convexity and

One convexity define the algorithm for creating a smoothing surface.

· Notch(Yes\No). If the Yes option is set, the smoothing surface is trimmed by the surfaces that

the body faces belong to.

List Tab 

Displays a list of selected edges and vertexes. The order of items in the list is determined by the order

in which they are selected. You can define your own set of parameters for each element. To do this,
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select an item from the list, disable the General properties flag for It, and then use the [Properties]

button to set the necessary parameters for the item.

Transformation Tab

If the default flag is set,the specified parameters will be set when the command is called again.

Overflow Settings of Face Blend

Limit plane setup 

Upon activating the option, workplanes and flat faces will become selectable in the 3D window. Select

either in the 3D window or on the model tree using the mouse.

When selecting a limit plane, its decorator is displayed in blue color. The decorator is a rectangle

drawn on the limit plane. The size of the rectangle is computed according to the sizes of the right and

left walls. Normal arrows are drawn in the corners of the rectangle, pointing toward the side of the

blend surface to keep.

   

After selecting first or second limit plane, the property window displays the "Reverse" checkbox

instead of the previous "Not selected" status, for flipping the "keep" side as indicated by the arrows.

If only one limit plane is to be used then define only the "First" plane. Both the "First" and

"Second" limit planes should be defined only when two limit planes are to be used

simultaneously.

End trimming options

The end trimming options for the blend surface can be selected from the pull-down list in the

property window. Four choices are available: "Faces to wall", "No trimming", "Long trimming", "Short

trimming". By default, the "Faces to wall" option is set.
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Defining topology of the resulting geometry 

A choice of the resulting topology is selected from the pull-down list in the property window. Four

options are available: "Separate body without trimming", "Trimmed on both walls and attach",

"Trim, attach and create body" and "Separate body trimmed on both walls". The system default is

"Trimmed on both walls and attach".

Adjusting solution by a node 

If a blend operation results in several sets of blend surfaces, a 3D node can be selected to define the

blend set to keep.  Selection of the 3D node is done by activating the following automenu option:

<E> Select 3D Node, that defines only one nearest surface as result

Upon selection, the name of the node is entered in the blend operation property window. Next, the

user needs to explicitly specify whether to use the solution by the 3D node, or use all obtained

solutions. The type of the solution is selected in the pull-down list, containing just two items: "All" and

"Use adjusting point". This switch helps quickly alter the solution type without giving up the selection

of the adjusting 3D node.

Edit Face Blend

Calling the command:

Icon Ribbon

-

Keyboard Textual Menu

<3EDF> Edit > Operations > Blend > Face Blend

This command is used for editing Face Blend.

Available options:
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<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Three-Face Blend

Calling the command:

Icon Ribbon

3D Model> Operations > Blend > Three Face

Sheet Metal > Advanced > Blend > Face Blend

Surfaces > Advanced > Blend > Face Blend

Primitives > Advanced > Blend > Face Blend

Keyboard Textual Menu

<3DT> Operation > Blend > Three Face 

The three-face blending operation creates a blend surface from one set of smoothly connected faces

to another such set. The blend surface will be constructed tangent to yet another, third set. A typical

situation addressed by this operation is creation of a smooth transitional surface between two

opposite faces and along the narrow strip of the side surface of thin-wall parts. The sets of faces for

blending are not required to share common edges (intersect).

Topics in this section:

· Main Concepts of Three-Face Blend
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· Create Three-Face Blend

· Edit Three-Face Blend

Main Concepts of Three-Face Blend

General operation concepts 

Three sets of faces make the basis of the Three-face blend operation. These are called right, left and

center walls. The sets of faces of the left and right walls should have between themselves smooth

mates, a set of faces of the middle wall can be mated at a small angle (not more than 5 °). The walls

themselves are not required to connect smoothly with each other. All sets of faces can belong either

to the same solid body or to one, two or three surface bodies. Three-face blends can’t be created

between walls belonging to different solid bodies or mixed surface and solid bodies.

Blending Form

There are two types of blending of three faces: spherical and disk.

For a spherical type, the blending surface is formed by moving an imaginary sphere inscribed

between the walls along the entire length of the walls, forming a smooth tangential conjunction at the

points of contact with them. The cross-sectional shape of the blending surface is calculated as a

spline.

For disc type, the blending surface is formed on the basis of a set of cross-sectional planes and a

guide. Planes are built perpendicular to the guide and contain three points of contact where the

blending surface touches the walls. The cross-sectional shape of the blending surface in the plane is

always calculated as a circular arc that fits in such a way as to ensure a tangency to each wall.

Original configuration: 1 - Left Wall, 2 - Center Wall,

 3 - Right Wall, 4 - Guide Spine

Resulting blend

The guide spine is always represented by a 3D path. The spine may not have sharp corners. If the spine

is too short for defining all cross sections, it is extended by straight segments tangent at the ends. If

the length of the guide is redundant, then the system tries to choose the part of the 3D path it needs.



Solid Body

1481

  

The figures show blend surface geometry dependency on the guide spine

If the left and center walls are adjoining then their common edge (the set of edges) may be

used as the guide spine. In this case, selection of the guide spine is optional.

In the case of the use of disk-type construction of the blending surface, when the edge between the

left and middle walls has a complex shape, to ensure a successful result between the faces, it is

necessary to create a new guide of a simpler shape in comparison with the edge, which approximately

repeats its shape. Let's consider two typical examples.

Example 1. It is required to create a blending of the side part of the fan blade with the use of disk

construction type. In this case, the system may not use the edge between the left and center walls due

to the following reason. The edge has a too small radius in the circled area. The blend cross sections

would intersect each other if constructed normal to the edge. An additional spine (a 3D path) helps

creating a blend in this case that approximately repeats the shape of the edge yet avoids the

mentioned traps.

      

Example 2. In this example, the left and right walls are cone fragments. The part gets wider in the

middle. At the first glance, the edge radius is not too small. However, due to the widening part and

edge curving in the opposite direction, the system considerably increases the radius of the blend

surface that again results in self-intersections. Using a flat spine of the shown shape helps easily create

the blend surface.
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Adjacent Smoothing

The mode of selecting consecutively paired faces allows the system to automatically select a

connected sequence of smoothly adjoined faces of the required wall when specifying one of the faces

included in this sequence.

If the adjacent faces of the middle wall are conjugated at an angle, the system allows you to set the

angle at which these faces will participate in blending.
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Result

When blending three faces of a solid body, the result will always be in the form of a solid body. 

When blending three edges of the surface body, or three surface bodies, the system allows to

determine the type of the resulting blending:

· No Trim. The blending surface does not join the walls; walls are removed. The result is a

surface body.

· Trim Both. The left and right walls are cut off at the points of contact with the blending; the

blending surface does not join the walls. The result is individual surface bodies.

· Trim and Sew. The left and right walls are cut off at the points of contact with the blending

surface; blending surface joins the walls. The result is one surface body.

· Create Solid. The left and right walls are cut off at the points of contact with the blending

surface; blending surface joins the walls and forms a closed space. The result is a solid body.

· Auto. The system independently selects the optimal blending result.
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The Initial Set of

Surfaces

No Trim Trim Both Trim and Sew Create Solid

The system also provides the ability to create a blending in the form of a separate body, while

maintaining the topology of the original bodies.

The Initial Set of Surfaces Result Original solid body Result

Sometimes situations arise when several blending surfaces may exist for a selected set of walls. You

can leave them all or specify one specific solution. The system selects the solution closest to the

selected 3D point. The 3D point can be a 3D node, a vertex or a middle of an edge.

Source body All solutions 3D node solution

Trim Blending Surface

Using flat edges or work planes, you can set a restriction of the blending zone. One bounding plane

divides the blending surface into two parts, leaving one of them in the scene. In total, no more than

two bounding planes can be specified. Two planes can limit the central part of the blending surface

from two sides.
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The orientation of the blending boundary depends on the bounding plane and the chosen method of

the blending shape. When the Trimming parameter is set, the blending boundary passes along the

boundaries of the bounding plane. Otherwise, the blending boundary passes perpendicular to the

direction of the blending surface through a point formed in one of the following ways:

· The intersection of the bounding plane and the top blending (for spherical shape blending);

· The intersection of the bounding plane and the given guide (for the disk shape blending).

Trimming by walls (Ends processing)

When creating blending faces, you can choose how to trim the edges of the blending surface. The

geometry of the walls themselves when cutting the blending surface is not broken. Total

There are four ways to trim:

· No Trim. In this case, the blending surface is extended beyond the boundaries of all walls.

· By Both Walls. The blending surface is cut along the borders of the left and right walls. In this

case, the side edge of the blending surface is formed in such a way as to ensure contact with

the side edges of the trimming walls.

· By Short. The blending surface is trimmed along the least distant wall edges.

· By Long. The blending surface is cut along the most distant edges of the walls.
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The Initial Set of

Surfaces

No Trim By Both Walls By Short By Long

Additionally, the system makes it possible not to take into account the middle wall when creating a

blending surface. For example, the option may be useful when creating a body with trimming along

the wall in the By Short mode or By Long.

The Initial Set of Surfaces By short, taking into account the

middle wall

By short, without taking into account

the middle wall

The Initial Set of Surfaces By long, taking into account the

middle wall

By long, without taking into account the

middle wall

The methods of trimming No Trim, By Short, By Long can be used only if the end result is

obtained in the form of a surface body.

Create Three-Face Blend

Blending can be performed over solid bodies as well as surface bodies. This operation can be

considered as a special case of the face-face blend, separated into a dedicated command. Since the

three-face blend shares many concepts with the face-face blend, first refer to the Blending faces

section for details on certain terms and concepts.
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Operation defining steps

The parameters window and the automenu are used for handling the command and defining

necessary components. These work simultaneously and enhance each other. The object selection

modes can be manipulated via either the automenu or the parameters window. 

To create the operation, follow the following steps:

· Select first set of faces (the left wall)

· Select second set of faces (the center wall)

· Select third set of faces (the right wall)

· Set blending type (if necessary)

· Select a guide (if necessary, depending on the type of blending)

· Set result parameters (if necessary)

· Select trim elements (if necessary)

· Set the trim parameters by the walls (if necessary)

· Confirm operation creation

Selecting a set of faces

Normally, the operation definition begins with selecting the sets of faces between which the blend will

be constructed. The left and right-wall sets are formed when one of the following automenu options is

active:

<L> Select left-wall face

<C> Select center face

<R> Select right-wall face

Switching between the options is done by pressing an icon button in the automenu.

Turning on an option automatically activates the respective tab on the parameters window. The list of

selected faces of the right or left wall is displayed in the provided pane under the tab tag. Switching

between the tabs of the parameters window also activates the appropriate options for face selection.

Face selection is done using the mouse in the 3D view window. The current face highlighting color is

indicated by the colored box on the tab tag for each set.

To automatically select a linked sequence of smoothly conjugate faces, you need to enable the

option:

<S> Smooth face chain selection mode

After enabling this option, it is enough to specify any face of the required wall that is included into the

required sequence. The remaining faces will be added automatically. 
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You can deselect all items at once using the option:

<K> Cancel selection

A decorator is drawn in the middle of each face, shaped as an arrow, marking the side of the face

adjacent to the blend surface. The blend is created on the side pointed at by all three arrows.

    

Control over the arrow directions is done via the Orientation drop-down list right of the face list pane

on each tab in the parameters window. Selection is made in the pull-down list. For solid bodies, the

direction of an arrow is determined automatically. In this case, the Auto option is set for all faces. For

surface bodies, the direction of faces has to be controlled manually by the user.

 

To change the system default arrow direction, select one of the other two available orientation

settings, Normal or Reverse.

To exclude a face from the wall set, simply select it in the list in the parameters window on the

respective tab and press Delete button.

To ensure the participation of adjacent edges of the middle wall conjugated at an angle in the

blending creation, it is necessary to set the flag in the Propagate field in the corresponding tab of the

parameters window and set the maximum conjugation angle of these faces.

Choice of Blending Form

The selection of the type of blending is carried out using the corresponding icons in the parameters

window. By default, the system sets the spherical type of blending.

Spine Selection

To turn on the spine selection mode, activate the following automenu option.

<W> Select guide spine

Selection of a 3D path is done in the 3D window or in the model tree by the mouse. The name of the

selected 3D path is displayed in the Guide Spine box of the parameters window.
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Setting Result Parameters

Multiple Solution

The selection of an auxiliary point to refine the result in the case of the formation of several blending

surfaces is performed after the Multiple Solution checkbox is enabled in the parameters window.

To do this, activate the corresponding field and select the desired 3D point in the 3D window. The

selection of the auxiliary point is canceled using the button .

Select Type of Walls Trimming

The selection of the type of wall trimming is carried out using the corresponding buttons in the

parameters window. By default, the system sets the type to Auto.

To create a blending surface in the form of a separate body, you should enable the Single body

checkbox in the parameters window.

Selection of Trim Elements

To select the elements that limit the blending zone, it is necessary to use the Trimming tab in the

parameters window. Then determine the mode of selecting items: topological (faces, cycles, edges) or

geometric (planes, surfaces, straight lines).

Elements are selected using the mouse in the 3D window after activating the Element field.

The direction of the resulting blending surface is determined by the value of the Orientation drop-

down list.

To delete a bounding element, simply select it in the list of the parameters window and click the

Delete button.

The Trimming checkbox allows you to determine the position of the blending boundary relative to the

guide.
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Trimming by Walls

The way to trim the edges of the blending surface is selected from the drop-down list of the

Trimming by Walls option in the parameters window. By default, the system sets the By Both Walls

trimming method.

In order for the middle wall not to be taken into account when creating the blending surface, it is

necessary to enable the Ignore Middle Wall checkbox.

Edit Three-Face Blend

Calling the command:

Icon Ribbon

-

Keyboard Textual Menu

<3EDT> Edit > Operations > Blend > Three-Face Blend

This command is used for editing Three-Face Blend.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name
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<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Boolean Operation

Calling the command:

Icon Ribbon

3D Model > Operations > Boolean

Sheet Metal > Advanced > Boolean

Surfaces > Advanced > Boolean

Primitives > Advanced > Boolean

Keyboard Textual Menu

<3B> Operation > Boolean 

Boolean operation creates a new body based on two or more existing bodies. As a result of the

operation, a new body is created that is a combination of the source bodies.
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Creating Boolean operation

The automenu and the property window are used together in the command. These work together and

enhance each other. The state of the automenu depends on the step of defining the operation and on

the purpose and type of the objects being selected.

The following steps are to be done to create the operation:

1. Select Boolean operands.

2. Select the type of the Boolean operation.

3. Specify operands' pieces for creating a selective Boolean operation (optional).

4. Define element matches (optional).

5. Define additional parameters (if necessary).

6. Define blending parameters (optional). 

7. Confirm operation creation.

Topics in this section:

· Main Concepts of Boolean Operation

· General Parameters of Boolean Operation

· Additional Parameters of Boolean Operation

· Results of Boolean Operations

· Setting Element Matches in Boolean Operation

· Boolean Operation Features

· Common Parameters of Boolean Operation

· Edit Boolean Operation

· Delete Boolean Operation

Main Concepts of Boolean Operation

Types of Boolean

There are three types of Boolean operations: 

· Addition . This operation results in a body which is the union of all pieces of the bodies

participating in the operation.
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·  Subtraction . This operation subtracts one body from another body.

·  Intersection . This operation results in the body which is the intersection of the

participating bodies, being their common part.

Boolean operands

The bodies combined in a Boolean are called operands of the Boolean operation. Operands of a

Boolean are the target and the tool. The bodies that are worked on are called Target of a Boolean.

The bodies used for the manipulations are called Tool. Different result is obtained, depending on

which of the body was the target and which was the tool.

 

1. Target body

2. Tool body
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1. Target body

2. Tool body

A Boolean can also be defined on a set of bodies, some of which are selected as the target and other

as the tool. In such an operation, all targets are united in one body, and all tools are united in another

one. Then, a Boolean is performed on these bodies. This results in a single multiple-connected body.

1. Target bodies

2. Tool bodies

3. Result of Boolean Subtraction on target and tool sets (multiple-connected body)

Global and local Boolean operations

If sheet or solid bodies are selected as operands, we will call such instances of the Boolean operation

Global. When creating such a Boolean operation, the system automatically determines which faces of

the bodies are involved in the operation, and finds their intersections. If a Boolean involves

geometrically complex bodies or the large number of operands, then the search for all intersections

may noticeably delay the command execution. 

Besides the Global Boolean operation, T-FLEX also introduces the Local Boolean operation. Unlike the

Global Boolean operation whose operands are always bodies, the Local Boolean operation allows

selecting faces, besides the body operands. The operand faces can be selected with the help of the

tab Faces in the operation's parameters. In some cases, use of the Local Boolean operation saves

considerable time on the model regeneration, as compared with the Global Boolean operation, since

the intersections will be searched only among the specified faces when processing the operation. For

example, to make a hole in a rather complicated body, you can specify the faces to be intersected in

the operation parameters if you know in advance that just few faces will be intersected.
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You need to be careful when selecting faces for the Local Boolean operation. An invalid body

may result from incorrect selection of faces.

 

Blue color - faces of target body, yellow color - faces of tool body

Selecting specific faces for the operands of a Local Boolean operation with the option Cut by Faces of

Target Bodies turned on, allows creating bodies like those shown on the diagram below. In this case,

the intersection lines between the operands' boundaries will be determined first, and then closed

loops will be formed along these intersection lines and the boundaries of the target operands' faces,

in order to create a Boolean operation.



T-FLEX CAD 17 Help

1496

1. Target body faces

2. Tool body faces

3. Result of local Boolean operation Subtraction

In some cases, the option Use Neighbor Faces can be conveniently used for the target or the tool. All

you need is select one face of an operand, and the system will automatically define the neighboring

faces in such a way, that the intersection lines between the operand faces form closed loops. In this

case, changes in the number of faces making a closed loop due to operand modifications, will not

invalidate the result of the Boolean operation.
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1. Target body faces

2. Neighbor faces defined by the system

3. Selected face of tool body

4. Closed cycle from edges of intersection of faces of bodies

Selective Boolean operations

When intersected, operand faces create common edges. Those edges divide the bodies of the

operands into pieces. There are inner pieces (shared by the operands) and outer pieces of operands.

When creating a Boolean operation, you can specify the outer pieces of the operands that will be left

in the resulting body, or, on the contrary, excluded from it. A piece of an operand is defined by

topology elements, such as vertices, edges are faces. To select a piece of an operand, you need to

specify one of such elements in the operation parameters on the tab Selections. The diagram below

shows an example of using a selective Boolean Addition operation, whose execution results in a body

containing only selected pieces of the tool.
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1. Target body

2. Tool body

3. Edges defining parts of the tool body to be left in the resulting body

4. Only the selected parts of the tool body are left in the resulting body

In some cases, the selected topology element does not explicitly defines the desired piece. For

example, as shown on the diagram below, the selected face belongs to several outer pieces of the

tool. To uniquely determined the desired piece, one needs to create a 3D node on this face, and then

select this 3D node by the option Select point that indicates operand region. In this case, you do not

have to select the face.
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1. 3D node defining part of the operand

2. The edge of the operand, which does not uniquely determine the necessary part

3. In the resulting body, the part of the operand defined by the 3D node is excluded

Missing operands

When creating a Boolean operation, you can turn on the option Allow missing operand. This

technique is often used in parametric models, when one of the model's elements needs to be

excluded in some instances. As shown on the diagram below, a nut can be in two instances: with and

without grooving. To realize both instances in one model, one can suppress the tool, while

maintaining the rest of the consequent operations based on the Boolean (in the example, this is the

cosmetic thread on the face of the Boolean operation).

If this option is turned off, then an error will be output when recreating this Boolean operation with

the operand suppressed.
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1. Target body

2. Tool body

3. Result of Subtraction operation 

4. Result of applying cosmetic thread on a face of the Boolean (Instance 1)

5. Result of suppressing the tool body (Instance 2)

General Parameters of Boolean Operation

Selecting Boolean type

The operation type is selected in the General Parameters tab:

<+> Addition

<-> Subtraction

<*> Intersection

When the Boolean operation is called first time in a session, the Boolean operation type Addition is

automatically set in the automenu. On subsequent calls to the Boolean, the default button will be the

type used in the previously called Boolean.

Selecting operands of the global Boolean operation

To select operands of a global Boolean operation, use the following option:

<1> Select Boolean operands 

At this point, the options become available in the automenu:

<F> Select 1st body

<S> Select 2nd body

As one of these options is activated, the input focus switches to the respective pane of selecting

targets or tools in the property window. Vice versa, as you switch the focus between the selected

operands panes in the property window, the respective options activate in the automenu. Target and

tool bodies can be selected either directly in the 3D scene or in the 3D model tree. Target bodies are

highlighted green in the scene, tools – yellow. An operand selected in the property window is

highlighted blue in the scene. To delete any operand from the list, select it in the Parameters window,

and then press the buttons Delete Element from the List or Clear. Once the Boolean operation is

created, the operand bodies will be removed from the scene, with only the resulting body left.
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Selecting operands for the local Boolean operation

To enter the mode of selecting faces for creating a local Boolean operation, one can use the

automenu option:

<3> Select local faces 

Alternatively, to activate this mode, you can switch to the Faces tab in the Parameters window.

At that time, the following options become available in the automenu:

<F> Select local faces for first Operands

<S> Select local faces for second Operands

Once the operands are selected, you can proceed with selecting bodies' faces for creating a local

Boolean operation. You can do this in the scene by the mentioned automenu options or by focusing

on the pane of the Faces tab. When creating a Boolean operation, you can skip selecting operands

and directly proceed to the mode of selecting faces. In this case, the bodies, whose faces are selected,

will be automatically added as operands on the respective tab in the operation parameters.

Highlighting of the target and tool faces is analogous to that of the bodies-operands. To remove a

face, select it in the list on the Faces tab, and then press the buttons Delete Element from the List or

Clear. In some cases, you may need to turn on the option Cut by Faces of Target Bodies to insure the

correct operation result.

When creating a local Boolean operation, you can engage faces adjacent to the selected face. To do

this, select the respective entry in the combo box of the Use Neighbor Faces parameter.

Selecting parts of operands 

To create a selective Boolean operation, use the following option:
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<2> Select parts of operands 

Alternatively, to activate this mode, you can switch to the Regions tab in the Parameters window. In

this case, the following options become available in the automenu:

<S> Select element that indicates part of operand

<H> Select point that indicates part of operand

With these options, you can select the elements defining the operands' pieces. The names of the

selected elements will be added to the list on the Regions tab in the Parameters window.  On the

same tab, you can select the action for the selected pieces of the operands: leave those in the

resulting body, or exclude. The selected action will work on all selected pieces of the operands.

Setting element matches

To define element matches, use the option:

<4> Select matches

Alternatively, to activate this mode, you can switch to the Matches tab in the Parameters window.

Then, the following options become available in the automenu:
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<F> Select first match Element

<S> Select second match Element

Use these options to select pairs of elements for defining matches. The names of the selected

elements are displayed on the Matches tab in the Parameters window. Each pair of elements can be

assigned the exact or approximate ("tolerant") matching option. The type of match is selected from

the Type combo box on this tab.  

Note that the set of match types in this combo box can vary, depending on the particular

combination of element topologies in a pair (see the table in the section Setting Element

Matches in Boolean Operation). 

The matching tolerance can be specified on this tab.

Preview of Boolean Operations Results

To preview the result of a Boolean operation and also the changes introduced by a Boolean operation

it is required to use the preview option in the automenu or a similar button in the parameters window:

<F5> Preview result of operation

<Ctrl+F5> Preview changes introduced by operation

Additional Parameters of Boolean Operation

Extension of Edges

If one sheet does not fully intersect the other one, the Boolean won't work. To fix the situation, an

option is provided among the Boolean operation parameters for extending edges of the target or the

tool up to the next edge or the body boundary. In this case, the intersection line between these two

bodies will be extended tangentially up to the selected edge or to the boundary of one of the

operands.
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1. Target body

2. Tool body

3. Intersection line extended tangentially on the tool body

4 Result of Boolean Addition between sheet bodies, the options Operands Treatment > Target, Tool >

By Normal and Extension of Edges > Target Bodies > To Nearest Edge are enabled

Operands Treatment

The Boolean operation can perceive the faces of sheet bodies as faces of a solid body, conditionally

adding volume to them in the selected direction. The operand interpretation option allows you to

choose how the surface will be perceived by the command and in which direction the volume will be

completed on the surface faces.

There are three options for interpreting a sheet body:

· as a sheet body

· behind direction of normal

· by direction of normal

Depending on how it is determined by the system, different results of the Boolean operation will be

generated. You can define sheet bodies by selecting the appropriate values ??in the drop-down lists of

operand treatment.

See the results of the Boolean operation with operand treatment in the Results of Boolean

Operation section.

Blend New Edges

Another capability of Boolean operations is blending new edges. By new edges, we mean the edges

created as a result of intersecting faces of the operands. As the operands' geometry changes, the

system will automatically track the increasing or decreasing number of new edges and create

blending. You can select the type of blending in the command: round or chamfer, and specify the

blending radius. 
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1. Target body

2. Tool body

3. Result of Boolean operation Subtraction with creation of chamfer on new edges

Use Pattern Copying

If a 3D array is used as one of the operands, you can significantly reduce the time of executing the

Boolean operation by turning on the parameter Use Pattern Copying.

Allow Missing Operand

By turning on the Allow Missing Operand parameter in the Boolean being created, you will be able to

suppress one of the operands in the future, and still keep the result of the Boolean operation. 

Create Body

If as a result of creating a Boolean operation both a solid and a sheet body can be formed, then the

required type can be selected using the Create Body option in the additional operation parameters. If

set to Default, the command will create the priority type of the resulting body.

Source bodies Boolean "Subtraction" operation result
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1. Target body with treatment behind normal

2. Tool body with treatment by normal

3. Result is selected - Body

As noted earlier, this option is advisory in nature. If it is impossible to form the selected type of the

resulting body, the value of this parameter will be ignored.

Material of newly created faces

To determine the material to which the result of the Boolean operation is applied, the combination of

parameters is used. In addition to material parameters found on the General tab and common for all

operations (the Source, Main, Covering parameters), the material assignment parameter for the new

faces, which are created as a result of applying Boolean operation, is also taken into account.

This parameter can take one of the three values:

· Material of target body. In this case the main material or the material of the covering (if it is

specified) will be assigned for the new faces according to the parameters of the first operand.

If there are several first operands and they are with different materials, then on the new faces

the material of that operand which participated in formation of these faces will be saved;

 

1. Target body

2. Tool body

3. Result of Boolean operation Addition

· Material of tool body. With this value, the material of the faces of the tool body, which

participated in the formation of new faces, will be transferred to these new faces. This can be
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the main material, the cover material if specified, and even the material of the material setting

operation. For example, as a result of the Boolean operation Subtraction between the target

body with the material steel and the tool body with the material black plastic, black plastic

material will be imposed on the created faces of the resulting body. If there are several tool

bodies and they have different materials, then the material of the operand that participated in

the formation of these faces will be stored on the new faces.

 

1. Target body - steel

2. Tool body - black plastic

3. Result of Boolean operation Subtraction

· Main material of target body.  The action of this parameter is analogous to the first

parameter Material of target body, except the case when the material of the covering is

specified. In this case the material of the covering is not used on the new faces. For example, if

in a part with the main material Steel and with covering Copper we create a hole with the help

of the Boolean operation, the hole inside will appear as steel in accordance with the main

material.

Results of Boolean Operation

Operands can be either solids or sheet bodies. By selecting various combinations of operands and

using different options, you can get a variety of results of a Boolean operation.

Note that in certain cases, inadmissible combinations of operand types in a Boolean will not

produce a valid result.

Below, we review common operand combinations and results of the respective Boolean operations.

"Addition" operation

The following are the results of the Boolean Addition per different operand type combinations:
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Target Tool Result

Solid Solid Solid

Sheet  (with specifying

direction of normal)
Solid Solid

Solid
Sheet  (with specifying

direction of normal)
Solid

Sheet  (with specifying

direction of normal)

Sheet  (with specifying

direction of normal)

Sheet

(with corners)

Sheet Sheet
Sheet 

(sewn)

Solid + Solid

If both the target and the tool are solid, then the operation results in a single body uniting all parts of

the bodies subjected to the operation.

1. Target body

2. Tool body

3. Result of Boolean Addition on solid bodies

Sheet + Solid

The operation results in a sheet, which is "stamping" of the sheet with a portion of the solid body.

Depending on the specified direction of the normal, either the lower or upper part is "stamped"

through. The normal direction is selected in the Operands Treatment field.

Note that the sheet must fully intersect with the solid.
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1. Sheet target body, option Operands Treatment > Target > By Normal is enabled

2. Sheet target body, option Operands Treatment > Target > Behind Normal is enabled

3. Solid tool body

4. Result of Boolean operation Subtraction between sheet and solid bodies with By Normal option

enabled

5. Result of Boolean operation Subtraction between sheet and solid bodies with Behind Normal option

enabled

Solid + Sheet

If a solid is selected as the target, while a sheet - as the tool, then the default result of the Boolean

Addition will be a solid. The faces of the sheet body will create an additional volume for the solid.

In this case, the direction of the normal should be indicated for the sheet body.

Note that this type of the Boolean operation requires, that the sheet body formed a closed

volume when united with the solid. Otherwise, the operation cannot create a valid result. 

When selecting a sheet body, pay attention to the normal vectors direction. An invalid result can be

produced due to certain normal directions. In this case, you should select a different normal direction

in the Operands Treatment field.
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1. Solid target body

2. Sheet tool body

3. Correct normal direction (option Operands Treatment > Tool > Behind Normal is enabled)

4. Wrong normal direction (option Operands Treatment > Tool > By Normal is enabled)

5. Result of Boolean operation Addition between solid and sheet body in the correct normal direction

Sheet + Sheet

Adding two sheet bodies results in a sheet. For successful operation creation, the faces of the sheet

bodies must either have a common edge or coincide within some region. This functionality is similar

to the Sew operation. The difference is in that the Boolean Addition does not eliminate gaps between

the bodies, while the Sew attempts to create a new continuous surface.

1. Target body - sheet body

2. Tool body - sheet body

3. Result of Boolean Addition of sheet bodies



Solid Body

1511

 "Subtraction"operation

Following are the results of the Boolean Subtraction for different operand type combinations:

Target Tool Result

Solid Solid Solid 

Sheet Solid Sheet

Solid
Sheet  (with specifying

direction of normal)
Solid 

Sheet  (with specifying

direction of normal)

Sheet  (with specifying

direction of normal)
Sheet (with corners)

Solid - Solid

The result of the Boolean Subtraction of one solid from another one will be the target body with the

removed tool portion of the volume.

1. Target body

2. Tool body

3. Result of Boolean solid-solid Subtraction

When creating the Boolean Subtraction, the system guards from a situation in which the target

body would have portions with zero-thickness walls. This would break the model topology.

1. Target body

2. Tool body

3. Tangent contact of operands would break topology as a result of the Boolean

Sheet - Solid

When a solid is subtracted from a sheet, an opening is created in the sheet body, repeating the shape

of the solid tool.
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1. Sheet target body

2. Solid tool body

3. Result of Boolean Subtraction of sold body from sheet body

Solid - Sheet (with specifying direction of normal)

Subtracting a sheet body from a solid leaves a part of the solid body cut off by the sheet. In this case,

the direction of the normal should be specified for the sheet body. Depending on the specified

direction, either the upper or the lower portion of the solid remains. This type of the Boolean is

analogous to the Cut operation.

Result of Subtraction operation of sheet body from solid body. Option Behind Normal is enabled for

sheet body

Result of Subtraction operation of sheet body from solid body. Option By Normal is enabled for sheet

body

"Intersection"operation

The results of the Boolean Intersection operation on various combinations of the operand types are:

Target Tool Result

Solid Solid Solid 

Sheet Solid Sheet
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Sheet  (with specifying

direction of normal)
Solid Solid 

Solid
Sheet  (with specifying

direction of normal)
Solid 

Sheet  (with specifying

direction of normal)

Sheet  (with specifying

direction of normal)
Sheet (with corners)

Solid  Solid

The result of intersection of two bodies is the body that is the common part of all operands.

1. Target body

2. Tool body

3. Overlapping two operands

4. Result of Boolean Intersection of solids

Sheet (with specifying direction of normal)  Sheet (with specifying direction of normal)

If sheet bodies coincide within some region, then their common portion is left as a result of the

Boolean Intersection.
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1. Target body

2. Tool body

3. Result of the Boolean Intersection between the tool and target sheet bodies

3. Result of the Boolean Intersection between the target and tool sheet bodies

Sheet  Solid

If a sheet is selected as the target while a solid as the tool, then the Boolean Intersection operation

will result in creation of a sheet which is the common part of the two operands.

1. Sheet target body

2. Solid tool body

3. Result of the Boolean Intersection of sheet and solid bodies

Boolean operations on sheet bodies (with specifying directions of normals)

One indication to using Boolean operations on sheet bodies is creation of corners. To do this, the

sheet bodies in the command should intersect and the normal directions should be specified for them.

Depending on the normal directions of the sheet surfaces and the type of the used Boolean operation,

different sheet bodies are produced as a result.  Note that the normal directions are preserved on the

resulting body.
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1. Target body

2. Tool body

3. Result of Boolean Addition, the option Operands Treatment > Target, Tool > Behind Normal is

enabled

4. Result of Boolean Subtraction, the option Operands Treatment > Target, Tool > Behind Normal is

enabled

5. Result of Boolean Intersection, the option Operands Treatment > Target, Tool > Behind Normal is

enabled

Setting Element Matches in Boolean Operation

Using this feature, you can fine-tune the Boolean operation in cases where the main algorithm

incorrectly detects tangent cases or lacks accuracy, since the accuracy of the entire Boolean operation

algorithm may be higher than the accuracy of processing the interaction of specific surfaces. To do

this, you can manually specify the type of contact and the correspondence of the operands, which

allows you to speed up the process of converting a Boolean operation in complex situations.

The command has provisions for four types of matches:

· Exact match – the boundaries of topological elements coincide within the specified tolerance.

Source bodies Boolean "Addition" operation result
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1. Face of target body

2. Face of tool body

· Contained – the boundary of the second element lies fully within the extents of the first

element's boundary. 
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Source bodies Boolean "Addition" operation result

1. Face of target body

2. Faces of tool bodies

· Overlap – the boundary of one element partially coincides with the boundary of the other

element.

Source bodies Boolean "Addition" operation result

1. Edges of target body

2. Face of tool body

· Imprinted – the boundaries of the imprinted topological elements coincide.

Source bodies
Boolean "Intersection" operation

result
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1. Edges of target body

2. Edges of tool body

The table below presents the description of match types for operands of various topology:

Matching:

Exact

Matching:

Contained

Matching:

Overlap

Matching:

Imprinted

Contact

type:

Vertex

Vertex

— — —

Projections of

operands vertices

coincide

Contact

type:

Edge

Edge

Edge curves

coincide within

specified tolerance.

Respective vertices

of edges coincide

within specified

tolerance.

Edge curves coincide

within specified

tolerance. Extents of

the second edge are

fully within the first

edge

—

Imprinted

operands edges

coincide

Contact

type:

Face

Edge

—

Edge curve lies on the

surface of the face

within specified

tolerance. Edge lies

fully within the extents

of a face

Edge curve lies on

surface of the face

within specified

tolerance. Edge

may intersect the

face boundary

(edges)

—

Contact

type:

Face

Face

Surfaces of faces

coincide within

specified tolerance.

Each edge of first

face has matching

edge on second

face. Inexact

Surfaces of faces

coincide within

specified tolerance.

Second face is fully

contained within first

face. No edge of

second face intersects

boundaries of first

Surfaces of faces

coincide within

specified tolerance.

Boundary of one

face may intersect

boundary of the

other face. Edges of

—
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coincidence of

edges is allowed

face. Edges may

coincide

the faces may

coincide

A match can be exact or approximate. An exact match implies that the operands have only the

described contacts and no more overlaps or intersections. If the inexact ("tolerant") matching is set,

the system will be searching for other intersections of operands, besides the specified contacts. This

type of processing takes more time, compared to the exact matching; however, in some cases this is

the only possible way of creating a Boolean operation.

Boolean Operation Features

Boolean operation representation in "3D Model" window

Upon creation, a Boolean operation is put in the Boolean folder in the 3D Model window. An icon is

displayed before each Boolean operation, denoting the operation type (  Addition,  Subtraction, 

 Intersection).  Booleans appear in a special way in the 3D model tree. When expanding the Body's

structure, the Boolean appears as an icon before the tool body. The diagram shows "Boolean_1": an

addition of the target "Box_3" and the tool "Box_1".

Upon right clicking  the icon before a tool operand in the model tree, the Boolean operation

context menu appears. Alternatively, the Boolean context menu can be accessed as the context menu

of the tool body in the model tree.
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Creating Boolean operation in the 3D model tree

You can create a Boolean in the 3D model tree without explicitly calling the creation command.

Select a body in the 3D model tree, and then Drag&Drop it to another body by dragging the mouse

with the left button depressed. This would automatically create the Boolean Addition. By additionally

holding down the <Ctrl>  key, the Boolean Subtraction will be created. If, instead of <Ctrl>, you hold

the <Shift>  key, the Boolean Intersection will be created. The dragged body is the tool, and the

body, to which the other is dragged, is the target.

Automatic Boolean creation combined with creating other operations

Numerous 3D modeling operations of T-FLEX CAD allow automatic creation of a Boolean. The body

being created in those operations is always the tool of the Boolean. The target is selected among all

existing bodies of the 3D model.

To use created body in Boolean operation:

1. Activate Boolean operation by  on the following automenu option:
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<Ctrl+B> Boolean operation Mode: Smart Mode

Automenu option will be highlighted in blue upon activation. 

2. Change operation mode if necessary by  + hold on the Boolean operation Mode automenu

option and selecting desired mode from the drop-down:

<Ctrl+'+'> Addition

<Ctrl+'-'> Subtraction

<Ctrl+’*’> Intersection

<Ctrl+I> Smart Mode

Smart Mode way of operation

· Subtraction applied when Extrusion body and Target body intersect each other.

· Subtraction applied when Extrusion body lays fully within the Target body.

· Addition applied when Extrusion body touches (but do not intersect) Target body.

· No Boolean operation applied when Target body lays within Extrusion body or when there is

an error in bodies penetration type calculation or when none of the aforementioned

conditions are valid.

3. Select Target Body if necessary using following automenu option:

<Ctrl+T> Select Target Body for Boolean

Body selected as a Target is highlighted in yellow in the 3D scene. 

Select Target Body option becomes available upon defining minimum data required for tool body

creation.

If there's only one body in scene, it's selected as a Target Body automatically. New body created in the

3D modeling operation is always used as a second operand of the Boolean operation.

When user confirms operation creation, first the 3D modeling operation body being created, then the

Boolean operation.

Dynamic preview as well as wire-frame preview of the operation result do not display result of a

Boolean operation. Use Preview of Operation Result  if you want to see the result of

Boolean before operation creation. If selected Boolean does not yield a result, only 3D

modeling operation result is displayed on preview. 

Boolean operations on 3D fragments

Use of 3D fragments as operands is a unique feature of T-FLEX CAD. This significantly expands

capabilities of creating parametric 3D models and assemblies. At the time of inserting a 3D fragment

into an assembly, there is a provision of creating a Boolean with the assembly's bodies. For details on
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capabilities of using a 3D fragment as an operand, refer to the chapter Creating Boolean Operation

Based on 3D Fragment, and the chapter Set Document Parameters, the section 3D.

When you insert a 3D fragment with option for automatic Boolean operation creation, the preview

displays not only the inserted fragment, but also the result of the Boolean operation.

3D Fragment Supplement

<Num0> 3D Fragment Supplement

The option automatically becomes available in the command automenu when selecting fragments in

an assembly.

Applying thread by Boolean operation 

If a cosmetic thread is applied on a face of one of the operands, and this face is in contact with the

faces of the other operand, then it is possible to automatically create a cosmetic thread on the face of

the resulting body. For example, as shown on the diagram below, a body with a cosmetic thread on its

face is subtracted from a base body. In this case, a cosmetic thread is automatically created on the

newly created face of the resulting body.

Note that the thread on the face of the tool operand must be Inner in order for the thread in the

hole of the resulting body to be created Inner as well.

1. Target body

2. Tool body with inner thread

3. Cosmetic thread created on the face of the resulting body

4. Result of Boolean Subtraction

Common Parameters of Boolean Operation

The general parameters of the operation are called using the command:

<P> Set entity Parameters

Common Tab

Sets general operation parameters (see General Parameters).   

General Parameters tab

See the description of the parameters in the General Parameters of Boolean Operation section.

Additional Parameters tab
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See the description of the parameters in the Additional Boolean Operation Parameters section.

Transformations Tab

This tab allows you to perform the necessary transformations for the lofted surface (see

Transformations of 3D Elements).

Mate Transformations Tab

On this tab, you can delete transformations of mates created after creating a boolean operation.

Characteristics Tab

This tab appears only after creating an operation. Created to set the mass and center of mass of the

created body.

Common properties

Set as Default. When this option is activated, the selected set of parameters will be set for subsequent

Boolean operations to be created.

Edit Boolean Operation

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3EB> Edit > Operations > Boolean Operation

This command is used for editing Boolean Operation.

Available options:
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<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Boolean command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Delete Boolean Operation

If a Boolean is at the top level of the tree, then, upon its deletion, the operand bodies of this Boolean

operation will be left in the model. However, if a Boolean operation already has dependents, then the

Delete Elements dialog box will be launched upon its deletion. 
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If you select the option Exclude selected elements from model tree in this dialog box, then another

dialog will be launched, Select Operation to Reassign Child Operation, that offers selecting one of

the Boolean's operands on which all dependents of the Boolean would be transferred.

Loft

Calling the command:
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Icon Ribbon

3D Model > Operations > Loft

Surfaces > Advanced > Loft

Keyboard Textual Menu

<3SL> Operation > Loft 

This operation creates solid bodies of complicated shapes. Almost any model elements based on one

of three types of geometry can be used as the base for the Loft operation: point, wire, surface.

Depending on the type of geometry of the original elements, the result can be obtained both as a

solid body and as a set of surfaces. The spline resulting surfaces are generated based on a specified

set of sections and guides, taking into account the selected boundary conditions and match points.

Among the operation settings, there is an optimization module that allows you to create simple

analytical surfaces where possible.

Loft operation defining steps 

The property window and the automenu are used for handling the command and defining necessary

components. These work simultaneously and enhance each other. The state of the automenu depends

on the operation defining stage and on the purpose and type of the objects being selected. The

object selection modes can be manipulated via either the automenu or the property window.

The surface of the operation is computed based on the element skeleton and specified boundary

conditions. The skeleton elements are sections and guides.

To create the operation, follow the following steps:

1. Define sections.

2. Define guides (optional).

3. Define match points (optional).

4. Define boundary conditions (optional).

5. Confirm operation creation.

Topics in this section:

· Main Concepts of Loft

· Sections of Loft

· Guides of Loft

· Match Point of Loft

· Boundary Conditions of Loft

· Additional Parameters of Loft

· Thin Wall in Loft

· Blend Parameters of Loft

· Loft Parameters

· Edit Loft

Main Concepts of Loft

Sections

Sections define the surface shape along the first direction. To create a simplest instance of the

operation, at least two sections need to be selected.

A section can be represented by either a sheet or a wire object. A wire object may be either closed-

loop or open. One section can be composed from several pieces that can be freely added and

removed during the operation setup. The set of objects making one section must have same-type
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geometry. For example, one section can be composed of a set of paths and edges, or, alternatively, of

a set of adjoining faces.

The section has such a property as the contour bypass direction. When specifying an operation on the

selected section, an arrow is drawn in the direction of the bypass.

The direction of the contour bypass is used when calculating the surface; it must be the same for all

selected sections. In most cases, the system can independently determine the direction of the sections

to achieve a successful result. But if necessary, it can be changed by the user for each individual

section.

 

1. Contour bypass direction

2. Sections

The contours of all sections used for creating the resulting surface must be of the same type – either

open or closed. Exception is the case of a "clamped tube" body. In that case, most sections are

defined by closed-loop sections, while the first or last section is defined by an open "wire". In order to

successfully create such a body, follow precisely the set of conditions listed below.

   

1. Matching starting points

2. Additional matching points

Multi-contour profiles can be used as sections, if they have same topology. For example, these can be

similar profiles or copies of the same multi-contour profile. In this case, no other parameters may be

specified (guides, matches, boundary conditions). When you select such a body in the Matching tab,

you must additionally specify the Inner and Outer start points, some of which are the start points.
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1. Inner starting point

2. Outer starting point

Sections can be planar or non-planar. For non-planar closed sections, variants of all boundary

conditions are available.

     

1. Non-planar sections (3D Profiles)

A point can be used as the first and last section. In this case, the surface will collapse in the selected

end points.

1. First section (3D Node)

2. Last sections (3D Node)

A detailed description of the selection of sections is described in the Section chapter.

Match point

The match points help defining the direction of the surface propagation between the characteristic

points of different sections. Always there is at least one match between the points in the sections.

Originally, it is set between the start points of the sections. New sequences of match points can be

added by the user manually. Any sequence of match points, including the start points, can be edited.
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The preview of the operation in the 3D window displays each set of match points connected by

straight blue lines as soon as the elements get selected. 

Each set of matching points includes one point from each section, except for the end sections defined

by a single point The match points can be defined by 3D nodes, section vertices or the points defined

on a section edge by the Position parameter. 

 

 

1. Sequence of matching starting points

If the end sections are open with the rest closed (as in the clamped tube body type), then the

following conditions must be met when defining the match points:

1. At least two sequences of match points must be defined passing through the start and end of the

first and last open wire. 

2. The closed profiles should not have "free" vertices, that is, the vertices not used as match points in

any sequence. 

3. All match point sequences must meet at the start or end of the first and last open wires. 

A detailed description of the selection of match points is described in the Match Point chapter.

Guides

Guides are similar to sections and are used for defining the shape of the resulting surface in the

second direction. As opposed to sections, the guides can be made of wire geometry only. If a sheet

object is selected, its perimeter will be used instead. All objects must have continuous first derivative,

that is, the "wire" should not have any sharp corners. Another condition is the requirement for a guide

to intersect with all sections, including the ones defined by a single point. One guide can be

composed of several smoothly connected linear objects. 
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1. Guides (3D Nodes)

Guides can be closed or open. Closed guides are used for creating closed bodies.

A detailed description of the selection of guides is described in the Guides chapter.

Boundary conditions

Boundary conditions impose additional constraints on the shape of the resulting surface. 

Different boundary conditions can be specified for different components of an operation. They are set

in order to provide a more accurate surface, including the formation of smooth transitions.

For ordinary sections, you can set 4 boundary conditions - By Normal, By Tangent, By Geometry and

By Vectors.

Ordinary sections are all sections except section-points.

For a section-point, as well as for match points, only one boundary condition is available - By Vectors.

For guides, only two boundary conditions are available - By Geometry and By Vectors.

A more detailed description of the boundary conditions is described in the Boundary Conditions

chapter.

General information

For each tab, you can customize the display of columns. For example, for sections, you can enable or

disable the display of sections, the number of vertices, or reverse buttons.

In the operation parameters dialog called by the option , you can specify the general parameters

of the operation.

You can change the contour bypass direction of sections/guides/matches either by disabling the

Autoreverse option (see details in the corresponding section) ...
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... or by pressing  on the corresponding manipulator-arrow of contour bypass direction. In this

case, the system will offer to first disable the Autoreverse option:

To edit a lofted body, use the corresponding command.

Sections of Loft

The operation is always defined beginning with selecting the sections. For successful operation

creation, at least two sections are required. Any system object may be used as a section that contains

wire or surface geometry. 

General information when defining sections

The elements selected as sections are highlighted in green by default. The active section is

highlighted in red. Active considered the section that is being currently manipulated. For example,
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working on a section composition makes it active. Settings of the highlighting colors are done in the

system options dialog box. 

When you select each section, a starting point is assigned, highlighted in blue. The set of starting

points forms the first match sequence. When working with closed sections, the starting point is

assigned at the vertex of the section contour closest to the cursor. When using open sections, the

starting point is assigned at the closest end of the wire. If the variant of section synchronization

proposed by the system is not suitable, then the starting sequence can be changed or new matches

can be added.

1. First section (Active)

2. Second section

3. First section bypass direction

4. Second section bypass direction

5. Start match

6. Section matching starting points

In each section, an arrow is drawn from the starting point, showing the direction of the contour

direction. To successfully create an operation, it is necessary to achieve the same direction in all

sections. You can change the contour bypass direction using the Reverse option.

When using closed or open contours, the system tries to establish the synchronization of the

bypass directions using Autoreverse. If you want to use the Reverse option, you must first

disable the Autoreverse option.

Switching the option for open contour moves the starting point to the opposite end of the contour.

After starting the operation, the Sections tab is automatically activated and the user will be prompted

to select sections.
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One 3D profile (single/multi-contour, closed/open, planar/non-planar), one 3D path (closed/open),

one face, one point or set of edges can be selected, which must form one continuous contour.

1. Open 3D Path

2. Closed 3D Profile

3. Set of Edges

4. Closed Multi-Contour 3D Profile

5. Non-planar 3D Profile

6. 3D Node

7. Closed 3D Profile

All available selection filters are displayed in the filter toolbar.

On the left side of the filter toolbar, a selection of advanced filters is available, such as Edge

Midpoint, Center of curve/edge, Profile bounds, etc.

The following automenu option is active by default:

<S> Automatic contour search

While it's active, the system automatically decides whether selected element should be included into

one of existing sections or a new section should be added. If selected non-closed element touches

one of the existing non-closed sections, such element is included into such section; otherwise a new

section is added.

Upon disabling the  option, each selected element will be added to the end of the section list as

a new section. Sections can be moved up and down the list using the corresponding buttons of the

properties dialog.

The first and last sections cannot be moved in the list if they are points.

To remove any object from the list, after selecting an object in the list, press the Delete Section.
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All selected objects go to the Composition field. This field displays a list of the names of the selected

elements for each specific section. To replenish the composition of the section, you need to expand

the drop-down list of the Composition field, after which you can start selecting additional objects.

The number of elements in the Composition field is displayed opposite the selected section.

A section can only be composed of objects containing geometry of the same type.

For sections, there are special manipulators at the original vertices, when you hover over which,

additional information about the parameter and length from the starting point, as well as the entire

length of the section, is displayed.
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Р(i) – vertex parameter. The range is [0, 1].

L(i) – length in document units

i – vertex indices (starting at 1).

The length and parameter are measured from the starting point.

L – the entire length of the section.

Rounding to 5 decimal places.

Pi = Li / L;

Defining boundary conditions for sections is described in the Boundary Condition section. 

Guides of Loft

The guides are side elements of the operation skeleton. 

Without Guide With Guide

General information when defining guides

Elements that are selected as guides are highlighted in yellow by default. The active guide is

highlighted in red.
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1. First guide (Active)

2. Second guide

A guide becomes active when you select it from the guide list. Color settings are made in the system

options.

An arrow is drawn at the end of each guide to show the contour bypass direction. For the successful

creation of the operation, it is necessary to achieve the direction from the first section to the last. For

open guides, the direction is set automatically. You can change the bypass direction of a closed

contour using the Reverse option.

When using closed or open contours, the system tries to establish the synchronization of the

bypass directions using Autoreverse. If you want to use the Reverse option, you must first

disable the Autoreverse option.

Switching the option for open contour moves the starting point to the opposite end of the contour.

Defining guides is much the same as defining sections. To switch to the guides setting mode, go to

the Guides tab of the properties dialog.

One 3D profile (closed/open), one 3D path (closed/open), a face (a set of faces), an edge (a set of

edges) or a loop can be selected as a guide.

All available selection filters are displayed in the filter toolbar.

The guide must necessarily have intersections with all sections, including sections specified by a

point.

The following automenu option is active by default:
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<S> Automatic contour search

While it's active, the system automatically decides whether selected element should be included into

one of existing guides or a new guide should be added. If selected non-closed element touches one

of the existing non-closed guides, such element is included into such guide; otherwise a new guide is

added.

Upon disabling the  option, each selected element will be added to the end of the guides list as a

new guide.

Trajectory

In the Loft operation, you can select the trajectories along which the sections will move. The

trajectories selection field is located on the Guides tab.

The selection of the trajectories allows the use of wire geometry, which will determine the shape of

the result along all vertices of the sections. This functionality is similar to the Sweep operation, but has

a number of peculiarities, for example, specifying several sections with a different number of vertices

or match points.
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1. Section with 4 vertices

2. Section with 6 vertices

3. 3D Path used as a guide

4. 3D Path used as a trajectory

If necessary, you can add both guides and trajectories at the same time. If a trajectory is selected and

at least one guide is selected, the Use path as guide option will become active.

With guide only / With guide

and trajectory

With trajectory only / With guide and

trajectory with enabled option

 "Use trajectory as guide"
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1. Guide

2. Trajectory

For the trajectory, the option to change direction is available. It allows you to move the starting point

of the trajectory direction in the opposite direction.

1. First section

2. Second section

The option to reverse the trajectory direction is available only when the Autoreverse option for guides

is disabled.

Trimming

Guides and trajectories can be automatically trimmed if they are longer than the section boundaries. If

such guides have been selected, the system will offer to enable the Trim - By End Sections option,

which will allow using only that part of the guide that is located between the first and last sections.
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The option is created for working with solid and surface bodies. If the Periodic Body option is

enabled, trimming will not work.

Defining boundary conditions for guides is described in the Boundary Condition section. 

Match Point of Loft

Once the sections are defined, the system needs to relate them with each other. One needs to define

how to configure the surface. This is what match points are for. 

Automatically created

starting match points

Adjusted starting match

points

Matching points for

sections with different

number of vertices

One match sequence is automatically created from the start points once the sections are defined. In

complicated cases, however, this may not be enough. 
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1. First section

2. Second section

3. Start match

4. Body with an "extra" edge

5. Additional match

The sections are divided into sectors by the match points. Some of the generatrices of the surface

being created pass exactly through the match points. The space between the sectors is divided into an

equal number of elements for the primary generatrices to pass through. Should there be at least one

vertex within a sector between any two match points on a section, the system subdivides the

respective matching sectors in all sections in the same proportion. This is done to achieve an equal

number of sectors in all sections. This may lead to creation of additional, sometimes undesired, edges

and faces.
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Therefore, an optimum solution is to define match points in the vertices of the sections. This way of

defining the match points should be favored whenever possible. To switch to match point defining

mode, go to the Matches tab of the operation property window. This tab hosts two related panes with

the lists of sequences and the respective match points. Each sequence contains one point per a

section, except for the single-point sections. The points are ordered from the start to the end section.

The contents of the sequence can be viewed in the second pane.

General information when defining match points

Items that are selected as match points are highlighted in dark blue by default, and match start points

are highlighted in blue. The active match point is highlighted in red.
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1. Start match

2. Start match point

3. Match

4. Match point

5. Match (Active)

6. Match point (Active)

To define a new sequence, place the cursor on a free line in the Match field. The system will then be

ready to set points.

The first section is automatically highlighted in red (by default) - it becomes active. After selecting a

point on the first section, the second is highlighted - and so on, until points on all sections are

selected. Object snapping works - you can snap a point to the top of the section or to a 3D node on

the section.

If snapping to vertices and nodes is not required, then you can create a point on the edge of the

section. To select a point, point the cursor on the required edge and press .

Objects are selected in accordance with the current filter settings.

In this case, for the selected point, it will be possible to set the position on the edge.

The position of a point on an edge relative to the origin is determined by the U coordinate.The U

coordinate implies two types of values:

· By Offset. For this type, the units of length must be considered.

· Parametric. For this type, the value has a unitless form (fraction of the length) from 0 to 1.

The system also provides the ability to select the base point of the U coordinate:

· Start. In this case, the base point is the starting point of the edge;

· Middle. In this case, the base point is the middle point of the edge;

· End. In this case, the base point is the end point of the edge;

The position of a point on an edge is set either manually using the Position field, or using a

manipulator on a selected edge.

The direction of the edge coincides with the contour bypass direction.

It is not allowed to cross sequences of match points with each other.

To edit an object - a sequence or a point - you just need to select it in the properties dialog, after

which you can redefine it by selecting a new object in the 3D window. So, to edit an entire sequence

(for example, a starting one), select the Start Points object in the Matches field, and then, in turn,

indicate the required points on each section. Highlighting and object snapping works like the first

time you set the sequence. To edit one point in the sequence, you must first select this point in the list

of section-to-point relationships, then select another object in the 3D scene. When editing a point, the

corresponding section is highlighted.

After editing the selected object, the system proceeds to change the next object in the list (point or

sequence) or offers to set a new sequence if the edited object was the last in the list.

To remove any object from any field, select it and click the Delete Element button.

Auto-alignment

For successful automatic creation of the body, you need the same number of vertices on all sections. If

the number of vertices is different, you can either manually set the match points, or use the auto-align

match points option.

There are three types of auto-align match points - By Current Vertices, By Length, and Uniformly.

The first type automatically aligns the match points to the vertices of the sections.
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Sections with 6 and 3 Vertices
Auto-Alignment

"By Current Vertices"

The second type automatically aligns the section match points so that spacing between adjacent

edges has the same ratio to total length.

Sections with 6 and 3 Vertices Auto-Alignment "By Length"

The third type aligns the match points of sections if at least one guide or one additional match is

selected. If there are no guides and no matches, then the mode will work similarly to the previous

type.
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Auto-Alignment "By Length" Auto-Alignment "Uniformly"

1. First section

2. Second section

3. Guide

The above is an example where the guide (or match line) does not intersect other connection lines. If

the guide intersects the connection lines, then the By Length type will not be able to handle such a

case, and the result of the Uniformly type will be as follows:

The guide splits the sections into two intervals. The first point of the upper section has a general

parameter equal to 0.3, and in the interval 1 (at the same point) its local parameter is 0.6. Accordingly,

the interval point 1 is imprinted on the other section.

Synchronization

In the case when circles or ellipses with only one starting point act as sections, the option to

synchronize the starting points may be useful. There are two types of synchronization - By Minimum

Distance and By Minimum Twist.

The first type automatically sets the position of the match start points, ensuring the minimum distance

between sections.
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Auto-Alignment "By Length"

without Synchronization

Auto-Alignment "By Length"

without Synchronization

"By Minimum Distance"

1. Match points and bypass directions

The second type automatically sets the position of the match start points, ensuring the minimum twist.

This option works only for closed and planar sections.

Auto-Alignment "By Length" without

Synchronization

"By Minimum Distance"

Auto-Alignment "By Length" without

Synchronization "By Minimum Twist"

1. Match points and bypass directions

Defining boundary conditions for match points is described in the Boundary Conditions section.

Boundary Conditions of Loft

Different boundary conditions can be specified for different sections/guides/match points. They are

set in order to provide a more accurate surface, including the formation of smooth transitions. As it

was said in main concepts, there are 4 boundary conditions in total - By Normal, By Tangent, By

Geometry and By Vectors. For ordinary (planar/non-planar) sections, all boundary conditions are

available.

For a section-point, as well as for match points, only one boundary condition is available - By Vectors,

and for guides only two boundary conditions are available - By Geometry and By Vectors.

Basically, the principle of operation of boundary conditions for guides and match points does not

differ from the principle of operation of boundary conditions for sections, therefore, below will be a

description of creating boundary conditions for sections. Some of the distinguishing features of the

boundary conditions for guides and match points are shown at the bottom of the page.
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Boundary condition is not selected

If the boundary condition is not selected, then the surface is created along the vertices of the sections

without additional smooth transitions.

1. First section

2. Second section

Boundary condition "By Normal"

If the boundary condition By Normal is selected, then the surface is created taking into account the

normal vector of the selected section. A prerequisite is the presence of a normal for the selected

section. 

Without boundary condition
Boundary condition "By Normal" for both

sections

1. Section normals

The sequence of actions for defining the boundary condition By Normal is as follows:

1. Select the required section in the general list of sections.

2. Select the boundary condition By Normal.

3. Select the type of length of the normal vector, and set its value.

4. Reverse the direction of the normal vector (optional).

Items 3 and 4 are described below in the Additional parameters of boundary conditions section.

Boundary condition "By Tangent"

If the boundary condition By Tangent is selected, then the surface is created either taking into account

the vectors directed along the tangent, or taking into account the normal.

Without boundary condition Boundary condition "By Tangent", type 
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"By Vectors" for both sections

1. Vectors directed along the tangent

2. Section normals

The sequence of actions for defining the boundary condition By Tangent is as follows:

1. Select the required section in the general list of sections.

2. Select the boundary condition By Tangent.

3. Select the type of boundary condition - By Vectors or By Normal.

By Vectors type allows you to create a surface using planar or non-planar sections, taking into account

vectors directed along the tangent.

Top View

Boundary condition "By Tangent",

type  "By Vectors" for first section in

an arbitrary view

1. First section

2. Second section

3. Vectors directed along the tangent

By Normal type allows you to create a surface only by planar sections, taking into account the normal.

The direction depends on the position of the next section.

Top View

Boundary condition "By Tangent",

type  "By Normal" for first section

in an arbitrary view
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1. First section

2. Second section

3. Normal

A prerequisite is the presence of a normal for the selected section. 

To obtain the "classic" boundary condition By Tangent, it is recommended to use the type By

Vectors.

4. Select the type of length of the normal vector, and set its value.

5. Reverse the direction of the vector (optional).

Items 4 and 5 are described below in the Additional parameters of boundary conditions section.

Boundary condition "By Geometry"

If the boundary condition By geometry is selected, then the surface is created taking into account the

tangency to the selected face or a set of faces. If there are multiple faces adjacent to a framing

element, it is not necessary to select all of them.

Without boundary condition
Boundary condition 

"By Geometry" for both sections

1. Tangency vectors

You should remember about the need to comply with some restrictions:

· The processed element (section, guide or their segment) must lie entirely on the selected face;

· The selected face must end on the element being processed;

· You cannot set a face for a framing element (element segment) in one direction if it intersects with a

framing element in the other direction. This means that if guides are specified in the operation, then

this boundary condition is not applicable for the entire section. In some exceptional cases, when



Solid Body

1551

using open sections, the system allows you to use this boundary condition in the presence of one

guide.

The sequence of actions for defining the boundary condition By Geometry is as follows:

1. Select the required section in the general list of sections.

2. Select the boundary condition By Tangent.

3. Select a face or set of faces that will define the boundary condition in the section.

 The section to be processed must coincide with the face of the body. The contact of the future

surface will be provided to the adjacent faces of the body.

4. Select continuity type G1 or G2 (optional).

G1 connects profiled curved surfaces with tangential continuity to boundary surfaces. G2

connects profiled curved surfaces with curvature continuity to the boundary conditions.

G1 for both sections G2 for both sections

1. Face that "touches" the top section

2. Face that "touches" the bottom section

5. Activate the account of the scale factor and set its value (optional).

6. Reverse the direction of the vector (optional).

Items 5 and 6 are described below in the Additional parameters of boundary conditions section.

Boundary condition "By Vectors" for planar and non-planar sections

If the boundary condition By Vectors is selected for a planar or non-planar section, then the surface is

created taking into account the tangent vectors emerging from the selected points. You can select

vertices, 3D nodes, or points as points anywhere on any edge of the section. A prerequisite is that the

point belongs to the selected section. You can select an unlimited number of points from which

tangent vectors will be created.

Without boundary condition
Boundary condition

"By Vectors" for section
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1. First open section

2. Second open section

3. Guide

The sequence of actions for defining the boundary condition By Vectors for planar and non-planar

sections is as follows:

1. Select the required planar/non-planar section in the general list of sections.

2. Select the boundary condition By Vectors.

3. Select the first point of vector 1.

If an arbitrary point on the edge is selected as the first point of the vector, an additional dialog will

appear in the operation parameters, where it will be possible to set the coordinates type of point, the

base point and set the position of the point on the edge.

The position of a point on an edge relative to the origin is determined by the U coordinate.The U

coordinate implies two types of values:

· By Offset. For this type, the units of length must be considered.

· Parametric. For this type, the value has a unitless form (fraction of the length) from 0 to 1.

The system also provides the ability to select the base point of the U coordinate:

· Start. In this case, the base point is the starting point of the edge;

· Middle. In this case, the base point is the middle point of the edge;

· End. In this case, the base point is the end point of the edge;

The position of a point on an edge is set either manually using the Position field, or using a

manipulator on a selected edge.
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If a 3D node or a vertex is selected as a point, then an additional dialog on point location does not

appear.

4. Select the type of length of the vector, and set its value.

5. Select the type of vector definition, and set the appropriate parameters.

6. Reverse the direction of the vector (optional).

7. Activate the option For All Vertices (optional).

This option is used when it is necessary to set the current parameters of the selected vector for

all free vertices. Free vertices are all vertices of the section, except for the vertices of intersection

with the guides and except for the correspondence points, which have a boundary condition.

When this option is activated, it will no longer be possible to select additional vectors.

Items 4 and 6 are described below in the Additional parameters of boundary conditions section.

Item 5 is described below in the Vector defining types section.

Boundary condition "By Vectors" for section-points

If the boundary condition By Vectors for the section-point is selected, then the surface is created

taking into account the tangent vector outgoing from the section-point.

Without boundary condition
Boundary condition

"By Vectors" for section-point

1. Section-point

The sequence of actions for defining the boundary condition By Vectors for section-points is as

follows:

1. Select the required section-point in the general list of sections.

2. Select the boundary condition By Vectors.

3. Select the type of condition for specifying the vector.

There are 2 types of vector specification conditions - By Normal and By Tangent.

By Normal provides smooth ending for the created surface, limiting it to a tangent plane with a

specified normal at the section-point. The normal is determined by the type of its vector definition -

by spherical or cartesian coordinates, by two points, or by direction.
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1. Planar section

2. Section-point

3. Normal

By Tangent produces a more general ending which may or may not be smooth, constraining the

surface by limiting it with a vector of derivatives in a section-point. The vector is determined by the

type of its definition - by spherical or cartesian coordinates, by two points, or by direction.

1. Planar section

2. Section-point

3. Vector with a given scale factor

4. Select the type of length of the vector, and set its value.

5. Select the type of vector definition, and set the appropriate parameters.

6. Reverse the direction of the vector (optional).

Items 4 and 6 are described below in the Additional parameters of boundary conditions section.

Item 5 is described below in the Vector defining types section.

Vector defining types

For boundary condition By Vectors, it is possible to specify 4 types of specifying the direction of the

vector - In Cartesian Coordinates, In Spherical Coordinates, By Two Points, By Direction.

If the type Cartesian Coordinates is selected, then it becomes possible to specify the coordinates X, Y,

Z, and also select the LCS for the vector. If LCS is not selected, then the vector is created in the global

coordinate system.

Without boundary condition
Vector specified in Cartesian

coordinates
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1. First Point

If the Spherical Coordinates type is selected, then it becomes possible to set the polar and azimuthal

angles, as well as to select the LCS for the vector. If the LCS is not selected, then the vector is created

in the global coordinate system.

Without boundary condition
Vector specified in Spherical

coordinates

1. First Point

2. Polar angle 35°

3. Azimuthal angle 25°

If the By Two Points type is selected, then it becomes possible to specify the second (end) point of the

vector, which determines its direction. Any point in the 3D scene can be selected as the second point.

The starting point belonging to the selected section is used as the first point. 



T-FLEX CAD 17 Help

1556

Without boundary condition Vector specified by two points

1. First Point

2. Second Point

If the By Direction type is selected, it becomes possible to select an object, the direction of which

must coincide with the direction of the vector. As such an object, you can select any object in the 3D

scene that has a direction. The direction is taken from the object itself, along the normal to the

object's plane, or along the axis of rotation of the surface of rotation.

Without boundary condition        
Vector specified along the edge

of another body

1. First Point

Designation of vectors in a 3D scene

For the boundary condition By Vectors, vectors outgoing from the selected points are marked as

follows - green arrows for sections, yellow for guides, blue for matches.
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The size of such arrows is 2 times smaller than the size of the arrows indicating the contour bypass

direction. Clicking on such a manipulator activates it and the system will go to editing the vector for

the corresponding element.

Additional parameters of boundary conditions

For each boundary condition, you can set a certain type of length of its vector or normal, or change

the direction of the vector.

There are 2 types of vector length - Length and Scale Factor. These 2 types determine the degree of

influence of the boundary condition on the curvature of the future surface. If the first type is selected,

the user manually sets the length of the direction vector.

The value is set in absolute model units, so the required number depends on the model size.

With large model sizes, you need to set large numerical values to achieve the same effect.
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If the second type is selected, the user manually sets the scale factor by which the modulus of the

derivative in the given direction will be multiplied.

In addition, the user can change the direction of the vector at any time using the corresponding button

.

Directional vector of top

section

Reversed directional vector

of top section

Boundary conditions for guides

The principle of operation of boundary conditions for guides is similar to sections, but for guides

there are fewer boundary conditions available - By Geometry and By Vectors.
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The boundary condition By geometry for a guide is quite specific and is used in most cases when

open 3D profiles connected by a guide are selected as sections:

Without boundary condition
Boundary condition

"By Geometry" for guide

1. First open section

2. Second open section

3. Third open section

4. Guide

5. Face defining surface geometry

Otherwise, the principle of operation of this boundary condition does not differ from a similar

boundary condition for sections.

The boundary condition By Vectors for a guide works in the same way as the boundary condition for

sections.

Without boundary condition
Boundary condition

"By Vectors" for guide

1. Guide

2. Start points of vectors 1 and 2

3. Second point of vector 2 specifying

the direction

4. Vector 1

5. Vector 2

Boundary conditions for match points

For match points, only one boundary condition is available - By Vectors. It works similarly to the By

Vectors boundary condition for sections. The only difference is that match points are used instead of

first points.
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Without boundary condition
Boundary condition

"By Vectors" for both sections

1. Match point of first section

2. Match point of second section

Additional Parameters of Loft

Trim Option

If guides (trajectory) are selected that are longer than the boundaries of the sections, the system will

offer to enable the Trim - Guides by End Sections option, which will allow using only that part of the

guide that is located between the first and last sections.

Without Trim With Trim - Guides by End Sections

1. Guide

2. Open section

Similarly, you can trim sections using the Trim - Sections by End Guides guides option. To trim

sections, you need at least 2 guides or 1 guide and a trajectory, with the Use trajectory as guide

option enabled. Section trimming is possible only for open sections.
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Without Trim With Trim - Sections by End Guides

1. Guide

2. Open section

If necessary, you can trim both guides and sections at the same time as described above. To do this,

use the Trim - Sections and Guides option.

Without Trim With Trim - Sections and Guides

1. Guide

2. Open section

These options are created to work with solids and sheet bodies. If the Periodic option is enabled,

trimming will not work.

Periodic Option

Used to create closed bodies or surfaces. When this parameter is set, the last section is closed with the

first. This parameter can be set if no points are specified as the first and last section, and also if special

conditions are not specified for the first and last sections.

Non-Periodic Body

1. First section

2. Second section

3. Third section

Periodic Body
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When using guides and setting the Periodic option, the guides must be closed.

1. Start match

2. Guide

3. First section (3D Path)

4. Second section (3D Path)

5. Third section (3D Path)

Linear Option

If the flag is set, then linear bodies are created, if it is cleared, then smooth bodies are created. A

linear body is the result of connecting a pair of sections by generatrices-straight lines.

Smooth Body       Linear Body

Split Parameter

This parameter determines how the new faces should split the resulting body. There are 3 options -

Minimum, Columns, Grid.

The columns are produced by dividing the body along the sections direction at each profile vertex.
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The grid is produced by dividing the body into columns and then dividing along the body according

to the position of the sections.

Derived Quantities Parameter

When using boundary conditions, where the value of the derivative is specified through a scale factor,

the system first determines the “Default” value of the derivative on the selected section. The scale

factor value is then multiplied by the calculated value of the “Default” derivative. With these options,

you can choose different behavior for the computed value of the “Default” derivative. It is

recommended to use the Smooth Variation along Body option.

Optimization Parameters

The Tolerance parameter specifies the maximum allowed gap between profiles and guides. Thus, for

example, setting rough (large) tolerance in some cases allows handling a situation when the sections

and guides do not intersect, but pass near each other. The tolerance defines the distance between

them that the system can ignore by assuming that the guides and sections do intersect. Besides, the

tolerance affects the minimum size of a profile edge that is defined as ten times the tolerance value.

Consequently, the same limit is used as the minimum distance between two distinct match points on a

profile, as well as between start points of boundary conditions defining vectors. The lower tolerance

limit is 10-8. However, keep in mind that a too small tolerance may slow down the system operation.

The system default tolerance is 10-5. 

The Simplify Geometry flag is used for simplifying the geometry and topology of the resulting

surface. With this flag on, analytical surfaces are created instead of splines whenever possible, such as

a torus, a cylinder, a sphere and a plane.

Using the created loft in a Boolean

To create a Boolean operation, do the following:

1. Turn on the Boolean creation mode by the automenu option

<Ctrl+B> Select original body for Boolean operation

A Boolean is created when the icon is pushed.

2. Select the type of the operation from the pull-down list under the above option:
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<Ctrl+'+'> Addition

<Ctrl+'-'> Subtraction

<Ctrl+’*’> Intersection

<Ctrl+’I’> Smart mode

Operating principles of the Smart mode

· If the body being created and the existed selected body have intersection of volumes - the

type of Boolean operations: subtraction.

· If the body being created lies entirely within the selected body - the type of Boolean

operations: subtraction.

· If the body being created touches and selected body touch each other - the type of Boolean

operations: addition.

· If conditions set out above are not met, or a selected body lies inside the created, or error

occurred determining the type of penetration, then, Boolean type is not defined - the

Boolean operation will not be created.

3. Select the target body for the Boolean (optional in some cases), using the automenu option

<Ctrl+T> Select Target Body for Boolean

If only one body exists in the scene, it is selected automatically. The new body created by the extrusion

operation becomes the tool body of the Boolean.

Upon confirming operation creation, first the body is created by the loft operation, and then the

specified type Boolean is performed.

Thin Wall in Loft

This option allows you to get a body with zero or specified thickness. It is possible to set the direction

of the thickness - Outside, Inside, Symmetrically or Different.

Solid Body
Thin-Walled Body with

Zero Thickness

Solid Body with Specified

Thickness

Using the Trim - By End Sections option, you can trim the created surface along the extreme sections.
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Selected sections must be planar.

Blend Parameters of Loft

If the resulting body is solid then it can be applied blend and chamfer options. Blending and chamfer

creation can be done on the source and target surfaces independently. 

Source blend. Setting this attribute defines the mode of edge blending on the original surface, that is

the surface on the side of the start section. Blending is done in the way of Round or Chamfer. The

parameter of the blend is defined in the next box. 

Target blend. Setting this attribute defines the mode of edge blending on the target surface, that is

the surface on the side of the end section. Blending is done in the way of Round or Chamfer. The

parameter of the blend is defined in the next box.
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Loft Parameters

The general parameters of the operation are called using the command:

<P> Set entity Parameters

Common Tab

Sets general operation parameters (see General Parameters).   

Operation Tab

Completely duplicates the General Parameters tab in the operation parameters window.

Blend Parameters Tab

Completely duplicates the Blend Parameters tab in the operation parameters window.

Transformations Tab

This tab allows you to perform the necessary transformations for the lofted surface (see

Transformations of 3D Elements).

Mate Transformations Tab

On this tab, you can delete transformations of mates created after creating a lofted surface.

Characteristics Tab

This tab appears only after creating an operation. Created to set the mass and center of mass of the

created body.

Common properties

Set as Default. When this option is activated, the selected set of parameters will be set for subsequent

Loft operations to be created.
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Edit Loft

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3ESL> Edit > Operations > Loft

This command is used for editing Loft.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Loft command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).
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Sweep

Calling the command:

Icon Ribbon

3D Model > Operations > Sweep

Surfaces > Advanced > Sweep

Keyboard Textual Menu

<3SW> Operation > Sweep

Sweep operation allows creating a solid body by sweeping a contour along a spatial path. This

operation belongs to the family of so-called "kinematic" operations, as it results in creating a body

swept by the original contour as the latter is moved along a guiding path. Depending on the type of

original contour geometry (the contour can have wire or sheet body geometry), the operation will

yield a sheet or solid body. As the contour is being swept along the path, its orientation, twisting and

scaling can be controlled. During the movement of the contour along the trajectory, it is possible to

control the laws of its orientation (correction of the initial position of the contour), torsion and scaling.

It is possible to select correction points with a filter that filters out points that do not belong to the

selected profile. The size of the body along the trajectory can now be adjusted by manipulators.

Steps of operation creation

The general algorithm of the operation creation is as follows: 

1. Select the type of the setting object

1. Select an option of contour orientation.

2. Select a contour.

3. Select elements defining the path.

4. Define correction of the contour original position (optional).

5. Defined additional guiding paths or a surface (optional).

6. Define general operation parameters (optional).

7. Confirm operation creation.
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Topics in this section:

· Contour of Sweep

· Trajectory of Sweep

· Correction of Contour Location in Sweep

· Contour Twist in Sweep

· Contour Scaling in Sweep

· Sweep Creation by Guides

· Methods for Calculating Auxiliary Vectors by Guides in Sweep

· Using the Created Sweep in a Boolean

· Sweeping Body by Trajectory

· Sweep Parameters

· Edit Sweep

· Additional Features of Sweep

Contour of Sweep

Any object with wire or sheet body geometry can be used as the original contour. A multi-contour 3D

profile can be used as well. Sweeping a contour means placing its multiple instances along the

selected path. A contour instance will be referred to as an intermediate section. To define an

intermediate section, the system calculates orientation of the coordinate system of that intermediate

section. The original coordinate system is calculated as the reference for the original contour

orientation. A contour instance creation is done by transforming the original contour to the calculated

coordinate system of a given intermediate section. 

  

The original coordinate system is calculated at the start of the path. Two of its axes are set

perpendicular to the path, and one is tangent to the path at the start point. The original contour

position is fixed with respect to the original coordinate system. The contour sweeping is done by

placing the original coordinate system together with the contour in other points of the path, in which

the coordinate systems are defined for the intermediate sections.
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Contour selection

The first option that turns on automatically is the contour selection.

The option contains a set of selector filters helping selection of the desired objects. There is a pull-

down list behind the icon that appears after prolonged pressing . A contour can be defined by any

object with sheet or wire geometry, such as a 3D profile, 3D path, edge, face, surface, etc.

Control over contour orientation

Different geometry can be created, depending on the position of the intermediate sections with

respect to the path. One of the three types of the contour orientation can be specified when creating

the operation:

Perpendicular to the trajectory

Parallel to the original profile

By guides

We recommend defining the contour orientation first, since that will determine the set of options

offered by the system in the following steps. 

Option selection is done in the property window of the operation, in the provided combo box with a

pull-down list. The pull-down list contains all three possible ways of orienting the contour – Profile is

perpendicular to path, Profile is parallel to source profile, By guides. The first and, apparently, the

most often used setting is the system default. Therefore, if the contour is to be oriented perpendicular

to the path, the contour orientation option selection can be skipped.

When using non-planar trajectory, condition of perpendicularity is not sufficient for obtaining a

desired result due to twist of the profile around the trajectory. In these cases it is possible to

additionally define fixing direction. Specifying fixing direction can change the method of

constructing coordinate systems of intermediate sections. The variant of a change depends on the
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selected method of interpretation of the fixing direction: fixing by path and direction, fixing of

rotation.

Perpendicular to the trajectory

The X-Y plane of the intermediate section coordinate system is always oriented perpendicular to the

trajectory. The tangency vector at the point of the section creation defines the Z-axis of the local

coordinate system.

This mode is primarily for flat contours. When defining the operation, the plane of a flat contour is

always oriented perpendicular to the guiding path in each intermediate point. When using non-flat

contours, the system automatically calculates some "mean normal" that is used for orienting the

contour. 

In case of non-planar contour the system automatically calculates some “mean normal” that is used

for orienting the contour. We recommend using additional correction of the original contour position

(see  section “Correction of Contour Original Position”) in order to get a predictable result.

Parallel to the original profile

The coordinate axes of each intermediate section are oriented parallel to the axes of the original

coordinate system. Sweeping in this way results in the parallel translation of the original contour.

By guides

The operation is created by sweeping a contour along the trajectory while orienting the contour

towards the points on the additional guides. At the same time, one of the guides also defines the
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contour scaling law. In this way, the guides are required to be smooth (no corners). This is a special

way of creating the operation that will be discussed in a separate topic (Sweep Creation by Guides). In

some particular cases faces can be used for defining only orientation (direction) of the intermediate

sections.

Trajectory of Sweep

 You can define different elements as trajectory, e.g. 3D profile, 3D path, edge, face, surface, etc.

Selecting trajectory

After defining the contour, the system automatically activates the option for the trajectory path

selection.

Once a trajectory is selected, the operation confirmation icon  becomes accessible. The specified

data is already enough to create the operation. The selected contour will be swept from its current

position along the trajectory Perpendicular to the trajectory or Parallel to the source contour.

Reverse direction

In cases where the original elements of the trajectory have an incorrect direction and it is not possible

to flip them (for example, an edge of a body), then you must use the Reverse direction  option.

Tolerance

This parameter sets the tolerance for the surface being created – deviation of the resulting surface

from the exact solution. The units are meters.
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Correction of Contour Location in Sweep

The original contour position can be additionally corrected by selecting one or three additional 3D

points.

The correction points can be 3D nodes, vertices, LCS, etc.

Fixing points

One point defines the contour snapping to the start of the path. Contour orientation in this case

depends on the selected orientation method. If the option Profile is perpendicular to path is set, the

plane of the flat profile is reoriented orthogonal to the path at the start point. When using non-flat

contours, the system automatically calculates some "mean normal" that is used for orienting the

contour "plane". If the option Profile is parallel to source profile is set, the contour is moved to the

start point of the trajectory path by parallel translation.

Additional point end Point that defines rotation

In some cases, one point may not be enough for correcting the original contour position since it does

not fix the contour rotation about its normal. One can select two additional points in order to specify

additional contour rotation about the normal. The second selected point, together with the first one,

will determine the original orientation vector (similar to a 2D fragment fixing vector). 
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The third selected point, together with the start of the trajectory, will define the target orientation

vector. The projection of this vector on the plane of the contour will determine the angle of

additional rotation of the contour. If a non-flat contour is used, the plane of the contour is

determined by the calculated mean normal.

When using non-flat contours, even three-point contour positioning does not guarantee the

expected result. In such a case, we recommend setting up the desired contour orientation before

starting the operation "Sweep". For example, one can create the contour in the desired position

from the beginning or, if that is not feasible, use coordinate system-based copying.
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Contour Twist in Sweep

One can define additional contour twist along the sweeping trajectory path.

The rotation angle of the intermediate sections can be defined by table or by using additional

geometry – a guide path or surface. This approach allows quite different ways of calculating the

contour rotation angle.

When using a table for defining twist, rotation by the specified angle of each intermediate section is

done about the Z-axis of the calculated coordinate system. The table appears as a set of trajectory

points, whose position is defined in percent of the trajectory length, with a fixed value of rotation

angle entered against each point. When setting up the table of rotation angles, one can use special

draggers. This functionality is convenient, for example, for creating sweeps with the surface twisted as

a spiral.

The choice of a path or surface is determined by the specifics of a particular task. For example, if the

contour is expected to trace a specified curve throughout sweeping, use a guiding path. 
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Alternatively, if one needs to create an auxiliary surface touching another surface, staying tangential to

that other one, then a surface can be selected for the swept contour orientation. In this way, the

tangency condition will be maintained between any intermediate section and the surface.

When creating bodies using contour twisting (defined by a guide or surface), make sure of the

correct original position of the contour. Thus, in the first example the contour must be originally

directed towards the start point of the additional guide. In the second example, the contour

shall make tangential transition to the adjacent surface in the original position.

The system uses an additional guide or surface for calculating auxiliary vectors defining a rotation

angle for each intermediate section. The rotation angle is calculated as the angle between the

directions of the auxiliary vector at the start point of the trajectory and at the current point, for each

intermediate section. If the calculated auxiliary vector does not lie in the X-Y plane of the coordinate

system of an intermediate section, its projection on that plane will be used.

When a surface is used for calculating the auxiliary vector, its direction is calculated in a general case

as follows. A point is identified on the surface that is nearest to the origin of the coordinate system of

an intermediate section. The sought direction is a tangency direction constructed at this point.

Therefore, best results are achieved when the used surface is closest to the trajectory. In this case, the

trajectory can be defined by using, for example, edges of the surface.

If a guide is used for calculating rotation angles of intermediate sections, you can select one of the

four methods for calculating the auxiliary vector. The methods for calculating auxiliary vectors by

additional guides are described in a separate topic (see below).
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Defining contour twist

Contour twist can be defined by a table or by using auxiliary geometry. Let's review all approaches.

Twist definition by table

Twist is defined with the help of the controls on the tab Twist of the property window.

To enter new contour twist parameters, press the button . The first time you push it, two special

entries are created, Start and End. Subsequent pushes add new intermediate points along the

trajectory. Numerical data for each defining point is entered in the property window. Each point

position is defined in percent of the trajectory length. The section rotation angle is entered in the

Twist box, in degrees. To delete a defining point, select it, and then press the button .

Position of the intermediate points may be specified with the help of a graph. Use  button in the

properties dialog for this purpose. This button will open the graph editing window. The range of

definition by X is 0-100 corresponding to the percentage from the length. The value area is not

limited. See more details on operations with graphs in chapter Graphs.

To facilitate definition of twist parameters, auxiliary elements are displayed in the scene – draggers

and decorations.

A decoration is an image of an intermediate section for each defining point, together with an arrow

specifying the direction and the rotation angle. Arrows are positioned along a spiral, showing the full

rotation angle. This is convenient when the rotation angle exceeds 360 degrees. Decorations of an

inactive point are drawn in the yellow color, while the decorations of the point being currently

manipulated – in the red.
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The dragger is a pair of blue segments indicating the zero angle and the current angle. There are two

handles at the ends of one dragger segment. Dragging those by the mouse with the depressed

bottom  modifies the value of the rotation angle and the point position on the path. As the

pointer approaches a dragger handle, it assumes a specific shape.

Use of auxiliary geometry for defining twist

Any object with wire geometry can be used as a guide.



Solid Body

1579

After selecting a guide, the dialog in the parameters window is automatically switched to the display

of the pull-down list from which the method of calculation of rotation vector can be selected.

You can choose from four options:

· By Minimal distance

· Perpendicular to path

· By parameter

· By offset.

For more information on the Axes Direction, see Methods for Calculating Auxiliary Vectors by Guides.

The surface can be defined by a face, a sheet 3D profile or a surface operation. When using auxiliary

geometry, draggers and decorations are not available.

Contour Scaling in Sweep

Scale Law

Contour scaling can be defined by a table or by using auxiliary geometry. Let's review all approaches.

When sweeping the contour, one can define an additional law for scaling the contour with respect to

the origin point of a section coordinate system or any other point in the space, related with the

section coordinate system and moving together with it. The scale factor can be specified in a table or

by using an additional guide.

Scale by Table

The table appears as a set of trajectory points, with a fixed value of the scale factor entered against

each point. Scaling is defined with the help of the controls on the tab Scale of the property window.

The way of defining parameters is the same as that of defining the twist by table. When defining the

scaling law by table, draggers and decorations are also displayed in the scene.
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In the rest of the points along the trajectory path, the value of the scale factor is interpolated by the

system automatically.

The scale law as well as the twist law can be defined with a graph. Use  button in the properties

dialog for this purpose. The range of definition by X is 0-100 corresponding to the percentage from

the length. The function values must be positive only. See more details on operations with graphs in

chapter Graphs.

Additionally, the property window has a pulldown list for adjusting parameters of scaling with respect

to the attachment point.

Scaling guide and scaling point

Any object with wire geometry can be used as a guide. The system can be tuned for selecting a certain

type of objects by using the pulldown list behind the option. The selected object will be highlighted in

green (by default). Once the guide is selected, a combo box in the property window becomes

available for selecting a scale vector defining option.

You can select any objects suitable for defining a 3D point.

Once the reference point is selected, a combo box becomes accessible in the property window for

selecting an option of scaling with respect to the point. You can choose from the three items – Retain

size, Retain distance, Change size and distance.

When using an additional scaling guide, the scale factor of an intermediate section is calculated as a

ratio of the vector length in the current point of the trajectory to that in the first section. The methods

for calculating auxiliary vectors by additional guides are described in a separate topic (see below).
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The scaling point, together with the scaling method, allows additional control over the shape of the

body.

When using a scaling reference point, the way of scaling the contour with respect to that point can be

one of the following:

· Retain Size. Scale the distance from the origin on the trajectory to the reference point, keep

the contour snapped to the reference point, but don't scale the contour;
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· Retain distance. Scale the contour only; don't change the distance between the reference

point in the trajectory;

· Change size and distance. Scale both the contour and the distance to the reference point.
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Sweep Creation by Guides

Creating a body by guides requires a contour, a trajectory and at least one additional guide. The first

additional guide is used for calculating the first auxiliary vector for each intermediate section. The

intermediate points for defining auxiliary vectors on the trajectory and additional guides are always

calculated "by parameter". This vector is simultaneously used for scaling an intermediate section and

for orienting it (by calculating the direction of one of the axes of the intermediate section coordinate

system). The direction of the second axis of the intermediate section coordinate system can be

calculated automatically (as the cross product of the calculated auxiliary vector and the tangent to the

trajectory at the origin point of the intermediate section coordinate system). 

To define an intermediate section orientation other then offered by the system, one could use a

second additional guide. That will help the system calculate the second auxiliary vector for each

intermediate section. The two auxiliary vectors will define the X-Y plane of the intermediate section

coordinate system. The Y-axis of the intermediate section coordinate system will be oriented in the

direction closest to that of the second auxiliary vector.

The approach to solid body creation by using an additional guide or guides serves certain specific

goals, such as closing a gap between two curves by a surface obtained by sweeping a specified

contour. Creating this kind of bodies assumes that the original contour will rest at one of its ends on

the start point of the trajectory path, and at the other end - on the start point of the additional guide.

In theory, some kind of a result can be obtained by using various orientations of the original contour,

however, the result will be rather hard to predict.

If, for example, the original wire contour rests at its ends on the start points of the trajectory and an

additional guide, the resulting surface connecting the trajectory and the additional guide will follow

the shape of the original contour.

Faces can be used instead of the first and second additional guides. Orientation of the intermediate

sections will be defined by auxiliary vectors calculated as perpendiculars to surfaces at points nearest

to trajectory points. In practice surfaces adjacent to trajectory are mostly used. The use of surfaces for

defining contour twist is applicable when the first two methods of contour orientation (Perpendicular

to the trajectory and Parallel to the original profile) cannot be employed. The following example

demonstrates sweep operation when the contour-segment is oriented perpendicular to the auxiliary

surface in every point of the trajectory.
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Sweep definition by guides

The difference of the By guides approach from Perpendicular to path and Parallel to source contour

is that you select a single guide for defining both twisting and scaling. In this way, you can't select the

method of vector calculation or the scaling point. Instead, you define the correction of the original

profile orientation by one or three points. The correction makes the system work in the same way as

under the option Perpendicular to path.

Methods for Calculating Auxiliary Vectors by Guides in Sweep

Auxiliary vectors are used by the system for orienting coordinate axes of an intermediate section

(rotating the section) or for calculating the scale factor for an intermediate section. When using an

additional guide, the auxiliary vector calculation is done as follows. The auxiliary vector of each

intermediate section starts on the trajectory – at the origin of the coordinate system of the

intermediate section. The end point of an auxiliary vector, that defines its direction, is located on the

additional guide. Calculation of such end point for defining auxiliary vector can be done by one of the

four methods. 

By minimum distance. The end point of the vector will be the point on the guide nearest to the vector

start on the trajectory.
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Perpendicular to the path. A plane is constructed through the start point perpendicular to the

trajectory. This plane must intersect the guide. The end point is defined as the intersection of the plane

and the guide. If no intersection is found between the plane and the guide for some point on the

trajectory, an error in operation regeneration is output. Follows are examples of using options

Perpendicular to the path and By minimum distance:

By parameter. Position of any point on a curve can be defined by a parameter – a value defining the

point position in percent of the curve length (0 – at the start of the curve, 1 – at the end of the curve).

The point on the guide is defined by the same parameter value as the vector start point on the

trajectory. This method of calculating an auxiliary vector is least demanding on the orientation and

length of the guides.
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This option is automatically used when orienting sections By guides. The user can also turn it on

manually when defining the scaling or twisting law, for example, in situations, when the additional

guide is shorter than the trajectory, or other methods are inadmissible. Here is an example of using

the option By parameter:

By offset. First, the length of the trajectory portion is calculated from the start of the curve to the

auxiliary vector start. The vector end is then found by the same length on the guide from the origin. In

this method, the length of the additional guide must be greater than or equal to the length of the

trajectory. This option can be used when, for example, only a portion of the additional guide shall be

used that is equal to the total length of the trajectory. Follows is an example of using the option By

offset:
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Operation created by the option By offset:

Using the Created Sweep in a Boolean

To create a Boolean operation, do the following:

1. Turn on the Boolean creation mode by the automenu option

<Ctrl+B> Select original body for Boolean operation

A Boolean is created when the icon is pushed.

2. Select the type of the operation from the pull-down list under the above option:

<Ctrl+'+'> Addition
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<Ctrl+'-'> Subtraction

<Ctrl+’*’> Intersection

<Ctrl+I> Smart mode

Operating principles of the Smart mode:

· If the body being created and the existed selected body have intersection of volumes - the

type of Boolean operations: subtraction.

· If the body being created lies entirely within the selected body - the type of Boolean

operations: subtraction.

· If the body being created touches and selected body touch each other - the type of Boolean

operations: addition.

· If conditions set out above are not met, or a selected body lies inside the created, or error

occurred determining the type of penetration, then, Boolean type is not defined - the

Boolean operation will not be created.

3. Select the target body for the Boolean (optional in some cases), using the automenu option:

<Ctrl+T> Select Target Body for Boolean

If only one body exists in the scene, it is selected automatically. The new body created by the extrusion

operation becomes the tool body of the Boolean.

Upon confirming operation creation, first the body is created by the sweep operation, and then the

specified type Boolean is performed.

Sweeping Body by Trajectory

There is a possibility to use solid body as the source object, which is moving along selected trajectory

in the Sweep operation. 

To do this, you need activate the option:
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Solid

The body spins around the predetermined axis during movement. The resulting “trace” model left by

the swept body can be used in further, for example, in Boolean operation.

Thus, it is possible to simulate trace that leaves a milling cutter when machining.

The general algorithm of the operation creation is as follows: 

· Select forming body

· Select trajectory

· Select axis direction of forming body

· Select fixing point of axis

· Select fixing direction, point for starting position and used faces of the body (optional).

Forming body

You may select only solid body as a forming body. You can’t select a sheet metal body or a faceted

model.

It does not matter where the forming body is located with respect to the trajectory.

The operation will not be created if overall sizes of the forming body are too large in compare

with the trajectory. It can lead to self-intersections and inability of the operation creation.

After the body selection, you need to select a trajectory, along which the body will move.

Trajectory

You can select a planar path or 3D path as a trajectory. 

The trajectory may be closed. You should specify a starting position point on closed vertex to create

the operation.

The trajectory should lie in a plane orthogonal to the forming body axis, unless a fixing direction

controlling the orientation of the forming body is supplied.

Accuracy sets the tolerance to the created surface - the deviation of the resulting surface from the

exact solution. Measured in meters.



T-FLEX CAD 17 Help

1590

Axis of forming body

The body will spin while moving along the trajectory. So that you need to select an axis direction.

You should specify an axis fixing point, after selection of the axis.

Fixing point

The fixing point will determine axis location according to the trajectory. The fixing point lies on the

trajectory when the body moves along it. If the forming body should be at some distance from the

trajectory, you should disable the Align fixing point of the body rotation with trajectory starting

point flag.

Fixing direction

Fixing direction controls the orientation of the forming body according to the trajectory.
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You can also define fixing direction by two points.

The fixing direction should not have to be in the same direction as the forming body rotation axis.

If the fixing direction is not the same as the direction of forming body axis, you should additionally

specify a starting position point.

A 3D trajectory should match the following requirement: all curves of the trajectory should be analytic

curves, a C2 non-rational b-curves or a helical curves created by a Parasolid function.

Fixing direction should not coincide at any point with the tangent to the trajectory.

Trim trajectory

Trim trajectory is used when the original path object cannot be changed, but the path itself needs to

be shortened. The size of the trimmed parts is set from the beginning or end of the path.

Used faces

Тo specify a point for starting position of the forming body use option Used face. Location of the

point on the trajectory affects the overall shape of the resulting body.

Only selected faces will be used for the operation. If Reverse flag  is set, the selected faces will not

be used for the operation.

The resulting body can be used for Boolean operation. 

More information about Boolean operations can be found in Boolean operation chapter.
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Sweep Parameters

Common tab sets the General parameters of the operation.

General Parameters Tab

Counter orientation. This parameter can take the following values: 

· Perpendicular to trajectory (the profile will be oriented perpendicular to the path along its

entire length).

· Parallel to the original counter (the profile will be oriented relative to the path, parallel to the

original profile).

· Simplify the geometry.  This flag allows you to form analytical geometry of surfaces (for

example, planes) in some cases where splines were formed earlier. This makes it possible to

build working planes on the obtained faces, take the projection direction from them, and so

on.

The next group of parameters is only available when the profile is positioned Perpendicular to

trajectory.

· Twist specifies the angle of rotation of the profile between its target position and the original

one.

· Use the angle table. When this flag is set, the graphic table of angles button appears, which

opens the table window. By default, the table records the values of the torsion angles at the

beginning and end of the path equal to zero. Using the Delete, Edit, and Add buttons, you can

change the table contents and create a list of angle values at specified path points.

· Scale. This parameter sets the scale of the source contour at the end point of the path.

· Use the scale table. Setting this flag allows you to set the contour scale using the scale table,

similar to using the angle table.

· The original plane. This parameter sets the mode for smoothing the edges of the surface

formed at the starting point of the path. Smoothing is performed using the Round or Chamfer

method. The smoothing size is set in the Radius parameter.

· The target plane. This parameter sets the mode for smoothing the edges of the surface

formed by the source contour at the end point of the path. Smoothing is performed using the

Round or Chamfer method. The smoothing size is set in the Radius parameter.

· Set as default. The selected option means that the specified General parameters will be used

for all subsequent operations.

Edit Sweep

Calling the command:

Icon Ribbon

-

Keyboard Textual menu

<3ESW> Edit > Operations > Sweep

This command is used for editing Sweep.

Available options:

<Esc> Cancel selection
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<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Sweep command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Additional Features of Sweep

Accuracy

The parameter sets the accuracy to the created surface – the deviation of the resulting surface from

the exact solution. Measured in meters.

Trim trajectory

This function is used in cases where you cannot change the original path object, but you need to

shorten the path itself.
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Source body (left), body with trimmed start and end of trajectory (right)

The size of the trimmed parts is specified in arbitrary units from the start or end of the trajectory.

1. End of trajectory

2. Trajectory

3. Guide

4. Contour

Fixing direction

Fixing directions allows you to adjust the contour in space during the "movement" along the

trajectory.

Faces, 3D paths, 3D profiles, etc. can act as a fixing direction. You can also specify a pair of points that

form a direction vector.

Vector fixing the direction should not coincide with the tangent to the trajectory at any point of

the trajectory.
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Fixing by path and direction: tangent to the trajectory at each point of the trajectory is projected

onto the plane perpendicular to the fixing direction. The coordinate system of the intermediate

section is constructed from obtained projection of the tangent to the trajectory and fixing direction.

Fixing of rotation: the coordinate system of the intermediate section is constructed by the tangent to

the trajectory at the given point of the trajectory and by the cross product of the fixing direction

vector and the tangent.

Source operation without using fixing direction

Fix by Path and Direction Fix Twist

Simplify geometry

This setting allows you to create analytical surfaces (planes, cylinders, spheres and tori) where

possible. When this option is disabled, an exact spline surface is always created. Modeling with

analytical surfaces is more efficient - the model takes up less memory, algorithms for working with

such surfaces are processed faster.

Check Self-intersections

This parameter allows the user to correct certain cases of self-intersections occurring upon operation

creation
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Start Point on Trajectory

The parameter is intended for cases of using a closed trajectory, when the start point is not clearly

defined. When the flag is enabled, the start point (from which the body will be created along the

trajectory) is automatically selected as the point on the trajectory closest to the contour.

1. Contour

2. Trajectory

3. Source start point

4. Start point on trajectory

Thin Wall

An additional mode for creating a thin-walled feature allows you to change the extrusion result. The

result is a body similar to the one created using the Shell operation. This mode is available only when

extruding planar contours.

When setting the thickness, there are several options in the drop-down list:
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No

Outside

Inside

Symmetric

Various

No – the extrusion result remains unchanged (it is used to obtain a sheet body based on a sheet

contour; for a wire contour, the result is the same as the extrusion result without turning on the thin-

walled element mode);

Source profile Sheet body

With giving the required thickness to the side walls in various ways (inside, outside, symmetrically, with

different wall thicknesses inside and outside the original face), a thin-walled solid body is created

from a sheet body by adding thickness to the walls.
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Outside Inside Symmetric Various

New faces in a thin-walled body are formed by extruding a contour equidistant from the original

extrusion contour. The shape of the faces depends on the way gaps are processed when creating an

equidistant contour:

By Line

By Curve

Round

By Curve – a continuation of the curves forming the source contour is created.

By Line – straight lines are created from the break points, tangent to the contour lines at the break

points.

Round – rounding is created between the end points of neighboring segments of the created contour.

Blend parameters

The options in this tab allows you to round the faces of the resulting body.
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Source operation without face blending

Body with face blending

Green highlights the blended edges at the start, red at the end, and blue are the side edges.

For initial and final faces, it is possible to select a blending profile:

Round

Chamfer

Options

The Use Manipulators flag allows you to activate manipulators in the 3D scene for dynamic control of

body parameters.
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Parametric Sweep

Calling the command:

Icon Ribbon

3D Model > Operations > Parametric Sweep

Keyboard Textual menu

<3SA> Operation > Parametric Sweep

The following icons become available in the automenu:

<R> Select Contour

<F> Cancel contour selection

<1> Select Curve defining position of coordinate system

<2> Select Curve defining X direction of coordinate system

<3> Select Curve defining Y direction of coordinate system

<4> Select Surface defining X direction of coordinate system

<5> Select Surface defining Y direction of coordinate system

<6> Select source LCS

<7> Cancel selection of elements defining coordinate system

Depending on the way of defining the coordinate system of the current instance, some parameters

may appear as driving or driven. In this case, there are two main approaches to creating a body with

parametrically varying profile:

· The approach of free instance orientation

· The approach of orienting instances by paths or surfaces

In each case, different automenu options are used, and a different sequence of steps is involved for

defining the necessary elements and operation properties. Follows are the descriptions of each

approach presented separately. 

Topics in this section:

· Main Concepts of Parametric Sweep

· Free Instance Orientation in Parametric Sweep

· Orienting Instances by Paths or Surfaces in Parametric Sweep

· Edit Parametric Sweep

Main Concepts of Parametric Sweep

A parametric sweep is a variation of a common sweep. This operation is used for creating bodies with

complex surface geometry. The resulting body is obtained by "sweeping" a profile along an arbitrary
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or specially defined spatial trajectory. In this case, the system allows defining the variation of the

profile parameters as a function of its position.

"Sweeping" of the profile is realized by multiplicating the original profile. The thus created set of

profiles shapes up the resulting body. The body can be closed. Depending on the profile geometry

type (sheet or wire), the resulting body may be a solid or a sheet.

The driving parameter of the operation is the profile instance number ("copy number"). Numbering of

profile instances ("copies") starts from 1 and is automatically incremented by 1 per an instance as the

operation creation progresses.

The so-called current instance coordinate system is computed for each instance of the profile. Each

instance of the original profile is carried over from the original coordinate system to the computed

coordinate system of the current instance. The user can select one of the model's local coordinate

systems as the original coordinate system. If no local coordinate system is selected, then the global

coordinate system is used as the original coordinate system.

The origin and orientation of the coordinate axes of the current instance can be done in two ways.

One can specify the rules of varying the coordinate system parameters by an expression. The other

way implies the use of a 3D Path or another body surface for positioning the coordinate system of the

current instance in space. Each way will be described in details below. The user controls the position

and orientation of each profile instance by manipulating the respective coordinate system.

The operation parameters dialog box provides controls over the coordinate system parameters of an

instance. The two main types of the operation parameters are - driven parameters and driving

parameters.

Driven parameters – are those whose values are computed automatically as the operation creation

progresses. Independent variables can be used for reading the values of such parameters. 

Independent are those system variables that are assigned a specific value, rather than an

expression. Those do not depend on other system variables. On the contrary, some of the

parameters of 2D or 3D constructions may depend on such variables, as well as other driven, or

dependent, variables. 

A name of an independent variable used with driven parameters is always selected from the list

of already existing independent variables in the system.

The parameter Number of Copy is always driven. Always use an independent variable to read this

parameter for getting the current copy number as the operation creation progresses.

How to use driven parameters?

You can enter the name of an independent model variable in a driven parameter value box to

establish a relation between the parameters of positioning an instance in the space and the

parameters defining the shape of that profile instance. After computing the position of the coordinate

system of the current profile instance, the independent variables assigned to the driven parameters

are updated with the respective current values. If an assigned independent variable is somehow

involved in defining the profile geometry, then, at each instance creation, the values of the driven
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parameters will be passed through that variable on to the related model parameters. Thus, the shape

of the profile will be recalculated depending on the values of the driven parameters.

The variable that reads the current copy number can be bound to record numbers in a database.

Driving parameters are the fields whose values are defined by the user. An arbitrary expression can be

entered in the input box of a driving parameter. Such an expression can include any system variable.

For example, you can include the variable that represents the copy number. In this case, you will get a

dependency of the parameter on the copy number via that specified expression.

The computations on the way of the operation creation are performed in the following order: the

instance counter (copy number) is incremented; the driving parameters are computed; the driven

parameters (if any) are computed; the original profile is recalculated with the current values of the

variables; the thus obtained instance is positioned. 

In the operation parameters dialog called by the option , you can set general operation

parameters.

Free Instance Orientation in Parametric Sweep

Free instance orientation approach

To create a parametric sweep, simply select a 3D profile, specify the number of instances and assign

an independent variable to the parameter Copy Number. Using the variable that follows the instances

enumeration, one can create certain dependencies for the driving parameters, as well as for 2D or 3D

constructions, which, in turn, define the shape and position of the 3D profile.

One can select the 3D Profile by using the respective option in the automenu:

<R> Select Contour

The number of copies of the profile can be assigned in the Common tab in the operation parameters

window.

Besides the Number of Copies parameter, this tab also contains an accessible option Closed.

With this option on, the body being created from the set of the sections (the set of the instances

of the original profile), will be smoothly closed, as if the first section was selected twice.

After setting the number of copies, you can go to the Parameters tab.
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This tab has two types of parameters, grouped under the names Driving Variables and Driven

Variables.

When creating the operation following this approach, the only driven parameter is the copy number,

while the driving are the parameters responsible for positioning the current profile instance in space.

For convenience, four groups of driving parameters are defined: 

- Position on Path

- X axis direction

- Y axis direction

- Z axis direction

For each group of control parameters, input of the X,Y,Z coordinates of the point determining the

position of the origin of the coordinate system of the current copy is available.

The rest of parameters define the three vectors used for orienting the coordinate system of the current

instance. 

You can explicitly describe the position of the current instance coordinate system as a function of the

copy number. To do this, define the required dependency in the group of driving parameters (by

entering the names of existing variables that directly or indirectly depend on the copy number).

Each vector defining the direction of a coordinate system axis of an instance is defined by two

points. The first point coordinates are <0,0,0>. The coordinates of second points of the direction

vectors for the current instance's coordinate system axes are defined by the parameters X, Y, Z

from the respective group of driving parameters.

In the case when the vectors defined by the user are not orthogonal or do not make a right-oriented

coordinate system, the system refines the definition automatically. Axes definition is done in the order:

X, Y, Z. The X-axis direction is left unchanged, the Y-axis is rotated to yield the 90° angle in the XY

plane, and then the Z-axis is defined.

In the case when only two vectors are defined (for example, the X and Z-axes), then the order of

defining vectors changes, and the third vector (of the Y-axis) is defined last.

Each profile instance is obtained by carrying a copy of the original profile from the global coordinate

system to the computed at the given step coordinate system of the current instance.

Additionally, one can select a local coordinate system by using the automenu option:
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<6> Select source LCS

In this case, the selected coordinate system will be used instead of the global one when carrying over

the copies of the original profile.

When creating a parametric sweep following the described approach, the system computes the

position and orientation of the current instance of the profile in the following order:

1. The variable reading the copy number is incremented. 

2. The absolute coordinates are computed of the origin of the current instance coordinate system. The

computation is based on the expressions entered in the driving parameters fields. 

3. The coordinates of the vectors are computed, defining the directions of the current instance's

coordinate system axes.

4. The coordinate system of the current instance is created in the computed point of the origin,

oriented according to the computed direction vectors.

5. If the geometry of the 3D profile depends in some way on the variable that reads the current copy

number, then the profile will be recalculated with the current variable value.  

6. The original profile's copy is carried over from the original coordinate system to the obtained

coordinate system of the current instance. If the original coordinate system was not specifically

selected, then the global coordinate system is used as the original when carrying over a copy of the

profile. 
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After calculating all instances of the original profile, the result is united in one solid or sheet body

using spline surfaces.

Example 1

As a first example, let's create a rather simple model.

 

 Let's skip the details of creating the auxiliary 2D and 3D construction elements. Instead, let's briefly

review the technique itself. This model can be created by sweeping a 3D profile in the space that is

indirectly tied to several guides. Let's use four guides in the 2D view, two of which will define the

elevation view, and the other two - the left side view. Three guides are straight lines, and one is a

spline.
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The horizontal construction line is drawn. The position of this line is defined by the expression 

"H-1". Therefore, it depends on the variable "H".

Since the Number of Copy parameter values sequence begins from one, sometimes a correction

(–1) is required in the expressions where the variable Number of Copy is entered. In this

example, the first instance of the profile should be located at the base, that this at the

coordinate Y=0.

Four 2D nodes are constructed at the intersections of the horizontal line and the guides. These nodes

can drive the length and width of the profile if attached to vertical lines. A 3D node is created based

on one of the 2D nodes in order to fix the profile plane. The grooves on the sides of the profile are

constructed in such a way to always divide its side in four equal parts. The grooves radius linearly

depends on the length of the profile.

We will need two workplanes – the elevation view and the plan view. The first one is needed for

constructing the 3D node, the second - for the profile. The coordinate system origin is located at the

model base level (see the diagrams). A straight line is constructed from the origin at the angle of 45°

to the horizontal. This line is necessary for establishing the projective relation between the guides on

the left side view and the profile hatch on the plan view.

All constructions are interlocked so that varying the variable "H" causes the following chain of

modifications: the horizontal line changes its position, that affects the position of the 2D nodes

referencing the line. The next link in the chain is modification of the profile hatch geometry and

repositioning of the 3D node, to which the 3D profile plane is snapped. Consequently, the 3D profile

itself will move in the space.

Among the operation parameters, the variable "H" should be assigned the copy number. Specify the

number of copies in the Common tab, corresponding to the type of the model, amended as

(150+1=151).

It is not necessary to describe the rule for adjusting the instance's coordinate system, since the original

profile adjusts its position due to a direct dependency on the copy number. As a result, each instance's

coordinate system coincides with the global coordinate system, and, therefore, the current copy
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coincides with the original profile in the position and geometrical parameters. What matters is how

the original profile moves with variations of the variable "H", that is, with respect to the copy number.

The described approach is convenient for using two-dimensional drawing data for constructing a

complex model.

Example 2

The second example demonstrates the approach to the model creation, when the exact rule is defined

for the profile movement. The original data for creating this operation are: a 3D profile; a local

coordinate system constructed in the center point of the profile and oriented with respect to the

profile as shown in the diagram (the Z-axis lies in the profile plane and is directed towards the

groove); several independent variables. 

 

The expressions should be entered in the operation parameters fields, as shown in the following

diagrams:
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The expressions define the helical trajectory with changing radius. The radius is varied by the cosine

function.

The number of copies (profile instances) is equal to 360 due to the following reason: the 360-degree

period is used in the expressions of trigonometrical functions.

The diagram shows that the Z-axis of the original profile coordinate system should always be directed

towards the center of the spiral (with the groove towards the center), the X-axis – in the opposite

direction to the Z-axis of the global coordinate system. The expressions describing these rules are

entered in the respective fields of the driving parameters. The Y-axis is defined automatically. 

Orienting Instances by Paths or Surfaces in Parametric Sweep

Since it is not always possible to describe the rules of the profile instance's parameter modifications

by expressions exactly, it is sometimes convenient to use 3D paths or surfaces from other bodies for

defining the position and orientation of the current instance's coordinate system.

The origin of the current profile instance's coordinate system is snapped to a 3D path. The position of

the origin on the paths can be controlled in two ways.
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The X- and Y-axes can be oriented using other 3D paths or surfaces from other bodies. 

Selection of a 3D path for snapping the coordinate system origin of the instances is done by the

option:

<1> Select Curve defining position of coordinate system

Selection of elements for defining the orientation of the X and Y-axes is done by the following

automenu options (the Z-axis is defined automatically):

<1> Select Curve defining position of coordinate system

<2> Select Curve defining X direction of coordinate system

<3> Select Curve defining Y direction of coordinate system

<4> Select Surface defining X direction of coordinate system

<5> Select Surface defining Y direction of coordinate system

When creating the operation using 3D paths, the operation dialog tabs Common and Parameters are

somewhat different from the described above:

Accessible in this tab are various options for controlling the axes directions. Which group is accessible

depends on how many paths were selected altogether: one (for defining the instance's coordinate

system origin only) or two (for defining the instance's coordinate system origin and orientation of the

X and/or Y-axes).

The Axis Direction drop-down list:

· By curvature. The X-axis coincides with the direction of the path's curvature vector. If the 3D

path is a straight line, then the axis is oriented along the X-axis of the global coordinate

system.

· By minimal twist. The X-axis is directed so to provide smooth rotation from the curvature

vector direction at the path start to the curvature vector direction at the path end.

The Z-axis is always directed along the tangent to the path at the point of the coordinate system

origin of the current instance. The Y-axis direction, if not defined, is determined automatically based

on the X- and Z-axes.
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· By minimal distance (between the paths at the origin). A vector is constructed from the

instance's coordinate system origin on the first path towards the nearest point on the second

path. 

· Orthogonal (to the path). A plane is constructed orthogonal to the first path tangent direction

in the coordinate system origin. The axis direction is defined by the intersection point between

the plane and the second path. If such point can't be constructed, an error message is output.

· By parameter/By offset. An expression entered in one of these boxes is evaluated to define

the point on the second path that determines the axis direction. If a face is selected for

defining the axis direction, then, in the general case, a point is identified on the face that this

nearest to the coordinate system origin located on the path. The normal to the face's surface in

this point determines the axis direction. The result will be best when the coordinate system

origin lies in the surface. Therefore, use of a face for orienting the axes of the profile instance is

recommended in the cases, when the first 3D Path lies on that face.
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The thus constructed X- and Y-axes may not be orthogonal (if those are parallel, the system will

output an error message). In this case, the Y-axis will be additionally reoriented to become orthogonal

to the X-axis in the plane defined by the two axes. The Z-axis will be determined automatically.

If a path or face is specified for the X-axis and not for the Y-axis, then the Z-axis will be directed

tangent to the path defining the position of the coordinates origin, while the Y-axis will be

determined automatically. If the X and Z-axes are not orthogonal, then the X-axis is additionally

reoriented in the way described above.

Let's consider the Parameters tab:

As shown in the diagram, the group of driven parameters now includes not only the parameter

Number of Copy, but also the groups Position in Path, X axis direction, Y axis direction and Z axis

direction. There are now additional parameters Parameter on Path and Offset by Path. 

The group of driven parameters Position on Path allows reading the absolute coordinates of the

current instance's coordinate system origin. The driven parameters from the groups X/Y/Z axis

direction provide the coordinates of the instance's coordinate system axes. You can use the

information about the position and orientation of the current profile instance in the space for defining

relations with other model parameters.
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The group of driving parameters includes Parameter on Path and Offset by Path. Parameter on

Path and Offset by Path serve the same purpose – to define the point position on a path by

various means. Therefore, you can't simultaneously define both the Parameter on Path, and

Offset by Path. Parameter on Path varies in the range from 0 (at the start of the path) to 1 (at the

end of the path); Offset by Path is measured in the model units and is equal to the length of the

portion of the path from the start to the desired point.

Once you defined the Parameter on Path driving parameter, you can assign the driven

parameter to the Offset by Path only, and vice versa.

Example 3

Let's review a parametric sweep creation using 3D paths on an example of the model of a drill bit's

cutting tip. 

Create a new document using the template with workplanes. The next step is creation of the 3D

profile. For this purpose, activate the workplane Top View and draw a contour as shown in the

diagram.  For convenience, try to construct the profile in such a way, that its center is located at the

global coordinate system origin. In this case, you do not have to construct the local coordinate system

for tying instances of the profile to the 3D path during the operation creation.

Next, we need to create two 3D paths for positioning the profile in the space when creating the

parametric sweep. The path defining the profile position is a straight line coinciding with the axis of

the bit. It can be created by two 3D nodes constructed on the axis of the bit. The length of this path

defines the length of the cutting portion of the bit. The other path defines the profile orientation in

space and is represented by a spiral line. The second path can be easily constructed using a cylindrical

worksurface.
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In the valuable editor, create an independent variable for storing the value of the copy number. In this

example, the created variable was named s.

After calling the operation creation command, select the 3D profile, the 3D path defining the profile

position and the 3D path defining the direction of the X-axis. On the Common tab of the operation

parameters dialog, define the number of copies equal to 101 (with the correction) and select the

option By minimal distance for the two paths.

On the Parameters tab, select the variable s to assign the copy number. This is the only necessary

driven parameter in this example.

Enter the expression in the driving parameter Parameter on Path input box, that will define the profile

position along the path depending on the copy number. Remember that the Parameter on Path

varies in the range from 0 to 1. 

Edit Parametric Sweep

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3ESA> Edit > Operations > Parametric Sweep

This command is used for editing Parametric Sweep.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.
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<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Sweep command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Copy

Calling the command:

Icon Ribbon

3D Model > Operations > Copy

Assembly > Assembly > Copy

Sheet Metal > Advanced > Copy

Surfaces > Advanced > Copy

Primitives > Advanced > Copy

Keyboard Textual menu

<3CP> Operation > Copy 

3D copy – operation of the T-FLEX CAD system which allows a user to copy existing operations,

Bodies, 3D construction elements and even collections of faces.

Parameters of copying are determined by specifying two LCS: source coordinate system of copying

and target one. The transformation is performed by moving the source coordinate system along with

connected with it objects to the location occupied by the target coordinate system.

The operation of creating 3D copy allows a user upon copying to symmetrically reflect selected

elements with respect to one of the planes of the target coordinate system.

When creating 3D copy of operations, it is possible to automatically combine the created copy with

the source operation, and also, use the move mode (when the source bodies are removed upon

copying).

Limitations of Copy Operation

When creating and editing copy operations the following limitations exist:

· If at least one of the source objects of 3D copy was used for creating the body (including 3D

weldment), then the mode Move will be locked;
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· If at least one of the objects-results of the operation was used for defining any other object of

the T-FLEX CAD model, then upon editing 3D copy, the option of modifying the collection of

the source objects will be locked as well as the option of turning on/off the mode of copying

with union (for 3D copy of operations);

These limitations are relevant to the 3D copies of all types except the copy of faces.

Moreover, when copying the workplanes or LCS, the additional transformation of symmetry cannot be

applied to the created copies.

Copy creation

To perform the copy operation, do the following steps:

1. Select the source objects of copy; 

2. Select the source coordinate system;

3. Select the target coordinate system;

4. Specify parameters of copy;

5. Finish the operation creation;

Topics in this section:

· Main Concepts of 3D Copy

· Types of 3D Copies

· Create 3D Copy

· Edit 3D Copy

Main Concepts of Copy

Objects of Copy

The collection of copied objects of a single operation can contain several elements of the same type

(only operations, only Bodies, only faces, etc.). Depending on the type of the 3D copy (i.e. on the type

of the selected objects of copy), parameters and capabilities of the operation will be changing (see

Types of Copies section).

Source and target coordinate systems

Any existing LCS can be selected as the source and the target coordinate systems. If the required LCS

(source or target) is not found in the 3D model, it can be created when defining the 3D copy. To do

this, just select a 3D point as the origin for the LCS being created. A new 3D element – LCS will be

created at this point. The axes of the newly created LCS will be directed along the axes of the world

coordinates.

General Principles of Copying

The position the copy being created  is defined in a general case by carrying the source coordinate

system over the target one.
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1. Source object of copy - operation

2. Source coordinate system

3. Target coordinate system

4. Copy

The copy being created can be additionally subjected to symmetry (mirroring) about one of the

principal planes of the target coordinate system. 

1. Source object of copy - operation

2. Source coordinate system

3. Target coordinate system

4. Copy with additional mirroring about the plane XY of the target coordinate system

When creating a copy with additional mirroring, one can specify just the source LCS. In this case, the

system assumes that the source and the target LCS coincide.



Solid Body

1617

1. Source object of copy - operation

2. Source coordinate system

3. Copy with additional mirroring about the plane YZ

4. Global coordinate system

The additional mirroring of the copy produces the result similar to that of the 3D Symmetry operation.

Such copies can be used, for example, for creating symmetrical parts. You create the half-part first,

then do copy with mirroring, and, finally, the Boolean addition of the two halves.

When creating a 3D copy, you can refuse the new body creation. In this case, the operation results in

moving the source body.

Types of Copies

Copy of Operations

3D copy of operations allows a user to copy existing operations of the model. As a result of creating

the copy operation, new Bodies appear – copies of the source operations. 

In the structure of the model the result of 3D copy of operations is shown in the following way: if for

creating the copy only one operation was selected, then the last operation of the created Body-copy

will be the 3D copy operation itself. On the other hand, if the 3D copy was created for several objects

simultaneously, then the references to the copy operation will serve as the basic operations of the new

Bodies.

Optional mode of copying with union automatically combines the created copy with the body of the

source operation. If the collection of the objects of copy contains more than one operation, then each

created copy is combined with the corresponding to it source operation.

1. Source coordinate system

2. Target coordinate system
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3. Source body

1. Source coordinate system

2. Target coordinate system

3. Copying without union

1. Source coordinate system

2. Target coordinate system

3. Copying with union

3D copy of operations can work in the move mode. In this case, the body of the source operation is

removed, and only created copy remains in the 3D scene and in the tree of the 3D model.

1. Source coordinate system

2. Target coordinate system

3. Source body
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1. Source coordinate system

2. Target coordinate system

3. 3D copy in moving mode (source body removed)

Copy of Bodies

3D copy of Bodies is created in the same way as the copy of operations. But while the 3D copy of

operations copies only results of specific operations, the copy of Bodies copies the whole Body

obtained by using the selected operation. If this Body is modified in the future, the 3D copy will be

regenerated, accounting for new operations included in the Body history (similar to arrays of Bodies).

Copy of 3D fragments

Copy of 3D fragments is created in the same way as the copy of Bodies.

The operation gets into the model tree in the form of an item, inside which all the elements of the

copy are fully functional fragments. This allows you to apply, for example, transformations, exploded

view scenario, and other operations to selected elements of copies.

Copy of 3D Construction

The copy operation allows a user to create copies of any 3D construction elements.

In the tree of the 3D model, the created operation is put into the special folder 3D Construction >

Clones. The elements-copies, obtained as a result of using this operation, are also put into the

corresponding folders of the tree. For example, when creating the copy of a 3D profile, the resulting

profile-copy will be put into the folder 3D Construction > 3D Profiles.

When copying workplanes and LCS, the additional transformation of symmetry can not be applied to

the created copies.
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The tree of the 3D model before and after creating 3D copy of construction elements

Copy of Faces

Copy of faces allows a user to add to the bodies present in the 3D model the holes and raised

portions which duplicate already exiting structural elements.

3D copy of faces is always created on the basis of a single body of the model: all faces being copied

have to belong to the same body. The outcome of creating the copy operation – collection of faces-

copies – is also included into the source body.

1. Source coordinate system

2. Target coordinate system

3. Result of creating 3D copy of faces

The collection of faces selected for creating 3D copy can be arbitrary, but it has to fully describe the

geometry of the copied structural element of the part. Faces-copies have to lie within the bounds of

the source body and intersect with its other faces in the same way as the faces of the original

collection.
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1. Source coordinate system

2. Target coordinate system

3. Intersection of the copy with the faces of the source body is different than that of the source set (a 3D

copy will not be created)

4. Intersection of the copy with the faces of the source body is the same as that of the source set (the 3D

copy will be created successfully)

5. Result of creating 3D copy of faces

When creating the copy with the symmetry, one more additional condition is imposed on the source

collection of faces: all edges bounding the collection of faces being copied have to be belong to the

same “base” (not included into the list of copied faces) face of the body.

Specifying the initial collection of faces is carried out in the same way as in the arrays of faces by:

· Selection of closed sequence of edges bounding the desired collection of faces.

· Direct selection of all desired faces;

· Selection of the operation that created the desired collection of faces.

The outcome of creating the face copy operation can be also affected by the following additional

modes:

· Copy to one Face. Use of this mode considerably reduces the copy regeneration time;

· Extend Faces (used only in combination with the Copy to one Face mode). The system will be

automatically extending or trimming the copied faces in order to insure their correct

connection to the body;

· Check Intersection with other Faces (used to avoid body self-intersections).

A detailed description of the copy types is given in the Optional Parameters of Array of 3D Elements

section.
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Create Copy

Selection of Copy Type

The type of the operation being created is selected in the command's parameters window with the

help of drop down list: Copy of Operations, Copy of Construction, Copy of Bodies, Copy of Faces and

Copy of Fragments.

Depending on the type of copy selected in the list, the set of options in the command's automenu and

the set of parameters in the parameters window will be changing.

Selection of Source Objects of Copy

For selection of the source objects of copy, one of the following options will be available in the

automenu (depending on the type of operation selected):

<N> Select source 3D operation 

<N> Select source 3D operation

<N> Select Construction

<N> Select Faces to Copy or their boundary Edges or Loops

Selection of Source Objects for Copying 3D Operations, Bodies, 3D Fragments, 3D Construction

The objects can be selected directly in the 3D scene or in the model tree. The selected objects will be

put into the list of the copy source objects in the operation parameters window.

To select a 3D Body, you can pick any of the operations contributing to this Body (again, either in the

3D scene, if that is possible, or in the 3D model tree). The Last operation of the given Body will be

automatically put in the list of the selected objects.
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Note that after selection of the first object (operation, construction element), the option / /

 will be automatically turned off, and the system will move to specifying the source coordinate

system. For selecting several objects of copy, a user has to independently reactivate the option for

selection of the objects of copy in the command's automenu or place the cursor in the row "…" in the

list of the selected objects (in the command's parameters window).

To deselect any of the previously selected objects, specify it in the list and click Delete Element from

the List or clear all items using the Clear button.

Note that once the first object to be copied is selected, the entry defining the copy type

becomes inaccessible. To change the copy type, you need to remove all 3D objects from the list

of the copy source objects. Only after that, you will be able to select another copy type.

Selecting source collection of faces for copy of faces

Selection of the source collection for copying faces is done in the same way as selection of the source

faces for the array of faces (see the chapter Arrays).

The option  allows you to set the selection method in the filter toolbar: selection of the faces

themselves, selection of the edges bounding the faces, selection of the operation (the same filters are

duplicated in the system toolbar).

Copy of faces can be applied only to source body, otherwise it will result in error.

When specifying the collection of faces with the help of bounding edges, an additional flag

Alternative Face Selection shows which of the two collections of faces defined by the specified

collection of edges will be chosen as the source object of copy. The flag has three states:

On by default . The system selects the collection of faces automatically (by the least area condition).

If the further manipulations with the 3D model will alter the balance of the areas, the system will

automatically switch to the other set of faces as the source object of the copy;

On /Off . Each of these two states will correspond to a specific collection of faces

(correspondence is determined by the system itself). With any further modifications of the model, the

collection of faces being copied does not change.

When creating the copy of faces, the option  remains active until a user independently activates

the option for selection of the source/target coordinate system.
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Selection of source coordinate system 

Selection of an existing LCS as a source coordinate system is done by using the option:

<S> Select source LCS

For automatic creation of an LCS, use the option:

<F> Select Point for creating Source LCS

This option allows selecting an arbitrary 3D element suitable for defining a 3D point that will be the

new LCS origin.

Selection of target coordinate system

Selection of the target coordinate system is done similar to selecting the source coordinates. An

existing LCS is selected by the option:

<T> Select target LCS

A new LCS can be created at a 3D point by using the option:

<W> Select Pont for creating Target LCS

To  refuse the selection of LCS, use the option:

<C> Cancel selection of target coordinate system

Specifying Parameters of Copy

The necessity of applying the symmetry transformation to the copies being created is specified in the

command's parameters window with the help of the flag Symmetry Using LCS Plane. The plane of the

target coordinate system, with respect to which the symmetry will be performed, is selected with the

help of the toggles: XY, XZ, YZ.

Additional flag Count Copies in product composition is used only when copying 3D fragments

included in the BOM. When checking this flag, the copies of the fragments will be also taken into

account in the product composition. When this flag is turned off, only the original fragment is

included in the product composition.
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Flag Separate to Solids is used when copying several operations at once. A separate Body-copy is

created for each of them.

When creating 3D copy of operations, the copy mode is selected with the help of a toggle Mode in

the group Options in the parameters window of the command: Move, Copy, Copy and Unite.

The optional parameters of the copy of faces are different from the parameters of other copies.

Copy to one Face. Set this flag to turn on the Copy to one Face mode.

Extend Faces. Turns on the mode of extending faces. This is always used together with the previous

flag.

Check Intersection with other Faces. This flag turns on the mode of checking for intersections of the

created array copies with the existing body faces.

Confirmation of copy creation

This action is possible when the option becomes available in the automenu:

<Y> Finish input

Option  (<F5>) allows you to view the result of the operation before confirming its creation.

Pressing the icon again returns the system to the state when the preview was called.

Copy Parameters

The general parameters of the operation are called using the command:

<P> Set entity Parameters

Common Tab

Here you can set General parameters for the operation. 

Operation Tab

Completely duplicates the General Parameters tab in the operation parameters window.

Transformations Tab

This tab allows you to perform the necessary transformations for the Copy (see Transformations of 3D

Elements).

Mate Transformations Tab

On this tab, you can delete transformations of mates created after creating a Copy.

Characteristics Tab

This tab appears only after creating an operation. Created to set the mass and center of mass of the

created body.
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Common properties

Set as Default. When this option is activated, the selected set of parameters will be set for subsequent

Copy operations to be created.

Edit Copy

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3EC> Edit > Operations > Copy

This command is used for editing Copy.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Copy command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).
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3D Symmetry

Calling the command:

Icon Ribbon

3D Model > Operations > Symmetry

Assembly > Assembly > Symmetry

Sheet Metal > Advanced > Symmetry

Surfaces > Advanced > Symmetry

Primitives > Advanced > Symmetry

Keyboard Textual menu

<3SY> Operation > Symmetry

3D symmetry – operation of the T-FLEX CAD system which allows a user to symmetrically reflect

selected 3D objects with respect to a given plane. 3D construction elements, operations, bodies, 3D

fragments, faces can be selected as source objects for creating the symmetry (objects of symmetry).

When creating the symmetry of operations, it is possible to automatically combine the created copy

with the source operation as well as use the move mode (when the source bodies are removed upon

copying).

Limitations of Symmetry Operation

When creating and editing symmetry operations, to avoid getting improper results, there are the

following limitations:

· If at least one of the source objects of symmetry was used for creating the body (including 3D

weldment), then the mode Move will be locked;

· If at least one of the objects-results of the operation was used for defining any other object of

the T-FLEX CAD model, then  upon editing the symmetry operation, the option of modifying

the collection of the source objects will be locked, as well as the option of toggling on/off the

mode of copying with union (for symmetry of operations);

These limitations are related to the symmetry of all types except the symmetry of faces.

Creation of Symmetry

For creating the operation of symmetry, these steps have to be followed:

1. Select the source objects of symmetry;

2. Select the plane of symmetry;

3. Select the parameters of symmetry (for example, the mode of symmetry);

4. Finish creation by pressing  in the automenu or in the command's parameters window.

Topics in this section:

· 3D Symmetry Types

· Create 3D Symmetry

· 3D Symmetry Parameters

· Edit 3D Symmetry
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3D Symmetry Types

Symmetry Types. General Information

The collection of copied objects of a single operation of symmetry can contain several elements of

necessarily the same time (only operations, only Bodies, only faces, etc.). The result of execution of the

operation and its parameters depend on the type of the initial data of symmetry.

Symmetry of Operations

Symmetry of operations allows a user to symmetrically copy the existing operations of the model. As

a result, new Bodies appear – symmetrical copies of the initial operations. 

In the structure of a 3D model, the result of symmetry of operations is shown in the following way: if

for creating the symmetry only one operation was selected, then the last operation of the created

Body-copy will be the symmetry operation itself. On the other hand, if the symmetry was created for

several operations simultaneously, then the references to the symmetry operation will serve as the

basic operations of new Bodies.

Optional mode of copying with union automatically combines the created copy with the body of the

source operation. If the collection of the symmetry objects contains more than one operation, then

each created symmetric copy is combined with the corresponding to it source operation. This mode

can be useful for designing the assemblies with large number of symmetric parts.

Source model

Copy without unite
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Copy with unite 

3D copy of operations can work in the move mode. In this case, the body of the source operation is

removed, and only created copy remains in the 3D scene and in the tree of the 3D model.

Move

Symmetry of Bodies

Symmetry of Bodes is created in the same way as the symmetry of operations. But while the symmetry

of operations copies only the results of specific operations, the symmetry of Bodies copies the whole

Body obtained by using the selected operation. Later when this Body is modified, the symmetry will

be regenerated taking into consideration new operations entered into the Body history.

Symmetry of 3D fragments

Symmetry of 3D fragments is created in the same way as the symmetry of Bodies.

The operation gets into the model tree in the form of an item, inside which all the elements of the

symmetry are fully functional fragments. This allows you to apply, for example, transformations,

exploded view scenario, and other operations to selected elements of symmetry.

Symmetry of 3D Construction

The symmetry operation allows a user to symmetrically copy any 3D construction elements except

workplanes and LCS. As in the previous case, in the framework of a single operation, several 3D

construction elements can be simultaneously subjected to the symmetry.

In the tree of the 3D model, the created operation is put into a special folder 3D Construction >

Symmetry. The elements-copies, obtained as a result of using this operation, are also put into the

corresponding folders of the tree. For example, when creating the symmetry of the 3D profile, the

resulting profile-copy will be put into the folder 3D Construction > 3D profiles.
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The tree of the 3D model before and after creating the 3D symmetry of construction elements

Symmetry of Faces

The symmetry of faces, as well as of the array of faces, and 3D copy of faces, allows a user to add to

the bodies present in the 3D model the holes and raised portions which duplicate already existing

structural elements.

All copied faces of a single symmetry operation have to belong to the same body. The outcome of

creating the symmetry operation – collection of faces-copies – is included into the source body as

well.

Source body and symmetry of faces result

The collection of faces selected for creating the symmetry has to fully describe the geometry of the

copied structural element of the part. Faces-copies have to lie within the bounds of the source body

and intersect with its other faces in the same way as the faces of the original collection.
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Symmetry of faces will not be created because symmetrical faces intersect the body differently compared

of the original collection of faces

Specifying the initial collection of faces is carried out in the same way as in the arrays of faces by:

· Selection of closed sequence of edges bounding the desired collection of faces.

· Direct selection of all desired faces;

· Selection of the operation that created the desired collection of faces.

In addition, one more additional condition is imposed on the source collection of faces of symmetry:

all edges bounding the collection of faces being copied have to belong to one “base” (not included

into the list of copied faces) face of the body.

The following additional modes can affect the outcome of the face symmetry operation:

· Copying to one face. The use of this mode significantly reduces the symmetry regeneration

time;

· Extend surfaces (is used only along with the mode Copying to one face). The system will

automatically extend or trim the faces being copied for assuring their proper insertion into the

body;

· Check intersection with other faces (is used to prevent creation of self-intersecting body).

More detailed description of these modes can be found in the chapter Arrays.

Create 3D Symmetry

Selection of Symmetry Type

The choice of the type of operation being created is performed in the parameters window in the

General Parameters tab. The following types are available: Symmetry of Operations, Symmetry of

Construction, Symmetry of Bodies, Symmetry of Faces, Symmetry of 3D fragments.

Depending on what type of the symmetry is selected from the list, the set of options in the command's

automenu and the set of parameters in the parameters window will be changing.
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Selection of Source Objects of Symmetry

For selection of the source objects of symmetry, one of the following options will be available

(depending on the type of symmetry selected) in the automenu:

<N> Select source 3D operation (for symmetry of operations)

<N> Select source 3D operation (for symmetry of Bodies)

<N> Select Construction

<N> Select Faces to Copy or their boundary Edges or Loops

Selection of Source Objects for Creation Symmetry of 3D Operations, 3D Fragments, Bodies, 3D

Construction

The objects can be selected directly in the 3D scene or in the tree of the 3D model. Selected objects

are put into the list of the source objects of symmetry in the operation's parameters window.

For selection of a 3D Body (also either in the 3D scene, if it is possible, or in the tree of the 3D model)

any operation taking part in the creation of the given Body can be chosen. The last operation of the

given Body will be automatically put into the list of the selected objects.

After selection of the first object (operation, construction element), the option / /  will be

automatically turned off and the system will move to specifying the symmetry plane. For selecting

several objects of symmetry, a user has to independently reactivate the option for selection of the

objects of copy in the command's automenu or place the cursor in the row … found in the list of the

objects of copy (in the command's parameters window).

After selection of the first object of copy, the entry for specifying the operation type will be

inaccessible for editing. To change the type of the copy, it is necessary to remove all 3D objects

already put into the list of the source objects. Only after that, another operation type can be

selected.

Selection of Source Objects for Faces Symmetry

Selection of the source collection for copying faces is done in the same way as selection of the source

faces for the array of faces (see the chapter Arrays).
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The option  allows you to set the selection method in the filter toolbar: selection of the faces

themselves, selection of the edges bounding the faces, selection of the operation (the same filters are

duplicated in the system toolbar).

Symmetry of faces can be applied only to source body, otherwise it will result in error.

Selection of operations, bounding edges or the faces themselves is done in the 3D window.

Operations can be also selected in the tree of the 3D model.

When specifying the collection of faces with the help of bounding edges, the flag “Alternative Face

Selection” shows which of the two collections of faces defined by the specified sequence of edges will

be selected as the source object of symmetry. The flag has three states:

Turned on by default . The system itself chooses the collection of faces (from the least area

condition). If during the process of subsequent manipulations with the 3D model, the balance of the

areas changes, the system will automatically change the original collection of faces;

Turned on /Turned off . Each of these two states will correspond to a specific collection of faces.

The collection of faces corresponding to a specific state of the flag is chosen by the system arbitrarily

after specifying the collection of faces. With any further modifications of the model, the collection of

faces being copied does not change.

When creating the symmetry of faces, the option  remains active until a user independently

activates the option for selection of the symmetry plane.

Note! To receive correct model, faces-copies have to lie within the bounds of the source body

and intersect with its other faces in the same way as the faces of the original collection.

Selection of Symmetry Plane

Symmetry plane is selected with the help of the following option of the automenu:

<S> Select reflection plane

When creating symmetry of 3D operations, Bodies, 3D construction elements, this option is turned on

automatically after selection of the first object of symmetry. If at that moment a user turns off this

option (for selecting several objects of symmetry), then after selecting all desired objects, a forced

activation of this option will be required.

When creating the symmetry of faces, the option  always requires independent activation by the

user.

The option  contains the drop-down list of filters for selecting 3D objects capable of defining the

plane. Selection is performed in the 3D window or in the window of the tree of the 3D model.

To cancel selection of the symmetry plane, the following option can be used:

<K> Cancel selection of reflection plane

Specifying Parameters for Symmetry of 3D Operations, Bodies and 3D Construction

The mode of symmetry is selected with the help of a toggle Mode in the group Symmetry in the

parameters window of the command: Move, Copy, Copy and Unite.

In some cases, the options Move and Copy and Unite may not be accessible (see description of

features of various types of symmetry).
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Additional flag Count Copies in product composition is used only when copying 3D fragments

included in the product structure. When checking this flag, the copies of the fragments will be also

taken into account in the product structure. When this flag is turned off, only the original fragment is

included in the product structure.

Flag Separate to Solids is used when copying several operations at once. A separate Body-copy is

created for each of them.

Specifying Parameters for Symmetry of Faces

Optional parameters of symmetry of faces differ from the parameters of symmetry of other types:

Copy on one Face. This flag is set on when the mode Copying to one face needs to be turned on.

Extend Faces. This flag turns on the mode of the same name. It is always used along with the previous

flag.

Check Intersection with other Faces. This flag allows a user to turn on the  mode of checking for

intersections of the created copies with already existing faces of the body.

Don’t check body boundaries. This flag allows to create symmetry of faces without checking self-

intersection and correctness of created geometry. It significantly increases performance. This option

should be used only if you are sure in the correctness of the resulting model.

3D Symmetry Parameters

The general parameters of the operation are called using the command:

<P> Set entity Parameters

Common Tab

Here you can set General parameters for the operation. 

Operation Tab

Completely duplicates the General Parameters tab in the operation parameters window.

Transformations Tab

This tab allows you to perform the necessary transformations for the 3D Symmery (see

Transformations of 3D Elements).

Mate Transformations Tab

On this tab, you can delete transformations of mates created after creating a 3D Symmery.
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Characteristics Tab

This tab appears only after creating an operation. Created to set the mass and center of mass of the

created body.

Common properties

Set as Default. When this option is activated, the selected set of parameters will be set for subsequent

3D Symmetry operations to be created.

Edit 3D Symmetry

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3ESY> Edit > Operations > Symmetry

This command is used for editing Symmetry.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Symmetry command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).
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Hole

Calling the command:

Icon Ribbon

3D Model > Advanced > Hole

Sheet Metal > Advanced > Hole

Surfaces > Advanced > Hole

Primitives > Advanced > Hole

Keyboard Textual menu

<3H> Operation > Hole

The operation Hole creates a set of holes. All holes in a set will be of the same type, size and depth. A

set may consist of one or more holes.

For each hole in a set, you specify an attachment point, in the body face where creating the hole. The

face hosting the attachment point is called base face of the hole.

Base faces of the holes in one set (that is, holes belonging to the same operation instance) can be

same or different, or even belong to different bodies. 

A set of holes on several bodies yields a single multi-body operation. To use each body

separately in the future, apply Divide operation after creating the holes.

Holes in one set can have different orientation. Hole orientation means orientation of the hole axis in

the space and the hole rotation angle about its axis.

The fixing point and orientation of any element in a set can be modified at the operation creation or

editing. Any hole can be deleted from a set.

In the model tree, opposite the created Hole operation, its parameters are displayed, for example,

Hole_5 [D20; H45].

Hole creation

To create a hole, do the following steps (the order of steps may vary):

1. Select the type and main geometrical parameters of the set of holes to be created;

2. Define attachment points for the holes;

3. Specify the desired hole depth;

4. Modify default axis orientation and rotation angles of the holes (optional);

5. Finish hole creation (use  in the automenu or in the property window).

Topics in this section:

· Hole Templates

· Selecting Type and Main Geometrical Parameters of Holes

· Hole Attachment Point

· Hole Orientation

· Hole Depth

· Holes Through Multiple Bodies

· Modify Hole Position and Orientation

· Holes Library Configuration

· User Holes Creation

· Edit Hole
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Hole Templates

Two mechanisms are used for holes creation: primitives or fragments (templates).

Primitives – a mechanism that creates a special operation to define the shape of the hole. No external

objects are used.

When using a template mechanism, hole creation is realized as an automated process of inserting a

special 3D fragment – a hole template. 

A template has a set of parameters that define the type and dimensions of a hole created with its

help.

Hole templates are stored in the parametric library Hole Features, among Utilities. If necessary, the

user can add custom elements to this library.

If inch units are set in the command Set Document Parameters, on the tab 3D, then the library

Hole Features Inch is used for creating holes.

The standard library includes hole templates of the following types:

·  Holes for check screws (Type 1, 2, 3);

·  Threaded;

·  Center hole (shape A, B, C, E, F, H, R, T).

To add custom holes to the library, create a template for the new hole type in a separate document,

following certain rules, and add it to the respective library (Hole Features for those using metric units,

Hole Features Inch - inches).

Нole type table part 1

Type  

Hole for fasteners Threaded hole

 

Through all
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Type  

Hole for fasteners Threaded hole

 

For given length
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-

Нole type table part 2

Square hole for fasteners Oblong hole for fasteners

Through all For given length Through all For given length

Нole type table part 3

Center hole

A B C E
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F H R T

Selecting Type and Main Geometrical Parameters of Holes

Select the type of the holes being created in the operation property window. The list of holes contains

all elements in the hole utility library (Hole Features or Hole Features Inch).

Type of a hole can be selected either from the quick access drop-down list or by clicking the

corresponding icon. If you select type from the list and it is not presented among icons below, the new

icon will replace the last right icon. 

Item Type in the drop-down list allows you to select element from custom libraries added to selection

list.

The content of the selection list is linked with the value of the Standard field and will update

accordingly.

You can select holes library using option:

<B> Library Configuration

A schematic chart of a hole of the selected type is provided in the lower portion of the parameters

window, with input boxes for all its geometrical parameters. To specify any dimension, just placed the

cursor in the respective input box in the chart and type in the desired value (or select one from the

list). Variables may be used as values. In this case the value of parameter will be assigned to the

nearest value from the appropriate list.

Hide Connectors. Flag allows hiding connectors of created holes.

Retain material. When active, body’s basic material will be applied to the created hole faces.

Otherwise, the coating material will be used.

Use Document Parameters. The option is used for holes created using the fragments mechanism. If

this option is enabled, the hole uses document parameters, for example, the units. If this option is

disabled, the hole will use parameters from the fragment.

Reach-through asymmetric hole (e.g. with one side chamfer) may be turned upside-down by its axis

direction with option Turn over. Often this flag is used for mold-base design. Note that this flag will

affect all holes from the set being created.
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The initially defined type and dimensions of holes can be modified at any time while creating or

editing holes (before the confirmation by pressing ).

Hole Attachment Point

To specify position of holes being created, specify an attachment point for each hole, one at a time.

One hole is associated with one point. The base face of each hole is defined by the system

automatically. By default, the axes of the holes are normal to the respective base faces.

After specifying an attachment point, the current hole is added to the Holes drop-down list on the

Position and Orientation tab.

Attachment points of the holes can be defined by one of the following 3D elements.

Face of a body. The specified face becomes the base face of the hole; the hole center will be

positioned in the location of the mouse click that selected the face. For the current hole, it will be

possible to adjust the U and V coordinates, as well as set the offset from the 1st or 2nd edge.

3D node which is either on the face of the body or outside of it.

· If the 3D node is on the face, this edge is chosen as the bearing one, the hole center coincides

with the given node.

· If the 3D node is outside of the face, it is necessary to choose a body (or several ones), then

the 3D node. The hole is built normal to the closest body face. If it is required to build the hole

otherwise, the direction should be given. If the system cannot calculate the hole depth, a

corresponding notice will be given.

Circular edge on one of the body faces. The face with the plane of the chosen circular edge will be

chosen as the bearing one; the hole center is associated with the circular edge circumference center.

The hole edge. The circular hole edge locates the center and the bearing edge of the hole at the

given length from the template.

1. 3D Node

2. Circular edge

3. Face
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To quickly define a set of holes, you can select an array of 3D nodes for the attachment points. Holes

will be automatically created at each 3D node of the array.

3D nodes - hole array elements

Changing the attachment point

The attachment point of any hole in a set can be modified by one of the following means:

1. Define a totally new attachment point (new base face or new attachment 3D element for the hole

center);

2. Modify the hole position on the current face (maintaining same base face) – by defining offsets of

the hole center from the two side edges of the base face. The hole center will be attached to the point

on the base face, defined by the specified offsets.

1. Source hole position

2. First edge

3. Second edge

4. Setting offsets from the first edge by U and from the second by V

5. New hole position

3. Create coaxial hole with automatic adjustment of the hole position on the base face (see the

Coaxial holes section).

Defining attachment points of holes

Hole attachment points can be defined upon activating the automenu option (the option is active by

default upon entering the command):
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<A> Enter Hole center

With the option active, simply select the desired face, 3D node or a circular edge on a face in the 3D

window. The parent body of the selected element is highlighted, and a wireframe preview of the hole

being created is displayed.

After defining the attachment point for the first hole, the option  stays active. This helps creating a

set of holes without additional actions. Just keep picking attachment points after selecting the first

one. As a result of defining a number of attachment points, a preview of a set of holes is displayed in

the 3D scene. The type and geometrical parameters of all elements are the same.

Creation of a set of holes from an array of 3D nodes is done with the option:

<M> Add Hole Array

Upon activating the option, specify the source array of nodes. You can select an array either in the 3D

model tree or directly in the 3D scene by clicking any array element with .

When you create a holes array, you need to set maximum number of the array elements. If this

rule is not met, offset or disappearance of new holes in array can occur after the holes number

increase.

Hole Orientation

By default, all new created holes are placed by the system in such a way, that the axis of each hole (X-

axis of the hole template coordinate system) is directed along the normal to the base face at the

attachment point. The orientation of the hole cross section is set by the system arbitrarily. (This is the

angle of the hole cross section rotation about the Y-axis of the hole coordinates.)

If necessary, you can modify orientation of each hole in a set separately. 

Orientation is specified by specifying the direction and rotation for each hole. The options become

available when you activate the Orientation checkbox on the Position and Orientation tab.
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A hole's orientation can be modified in one of the two ways:

By auxiliary LCS

A specified LCS is used for defining the direction of the axes of the coordinate system of the hole

(existing in its template). The hole is rotated in such a way that its coordinate system axes all get

aligned with the direction of the respective axes of the selected LCS;

Defining direction by LCS:

1. Original hole direction

2. LCS that defines the direction of the hole

3. Global coordinate system

4. Hole direction according to LCS

Defining rotation by LCS:
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It is also possible to orient all the holes of the set according to one LCS.

By 3D nodes

In this case, the hole's orientation and the angle of rotation about its axis are defined separately. You

can modify just one of these parameters, for example, only rotation of the hole about the axis, in

order to turn a non-round hole about its axis. In this case, the axis itself can be left unchanged (in the

system default position).

When using a 3D node for orienting the hole axis, the axis will be directed from the hole attachment

point to the 3D node. When specifying rotation of the hole by a 3D node, the Y-axis of the hole

coordinate system will be turned so as to point at the selected node.

Defining direction by 3D Node:

Defining rotation by 3D Node:
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Base face search

If necessary, in the Search Face Base drop-down list, you can explicitly specify in relation to which

base face the hole should be created.

There are 3 options available:

· Default

· Nearest

· First

If the Default option is selected, the hole can only be created based on 3D nodes belonging to the

selected face.

The Nearest and First options allow you to create a hole based on 3D nodes that do not belong

to the selected face.

The Nearest option allows you to select the nearest base face to the selected 3D node. To create a

hole on the nearest base face, you need to do the following:

1. Run the Hole command.

2. In the Search Face Base drop-down list, select the Nearest option.

3. Specify the 3D node on which you want to create a hole.

1. 3D nodes

2. Nearest base faces
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The First option is used to create a hole relative to the base face on which the first hole was created.

This option can only be used in the mode of adding additional holes. To create a hole in this way, you

need to do the following:

1. Run the Hole command.

2. Select the first node to create the first hole.

3. Without leaving the command, select the option First.

4. Specify the 3D node on which to create the next hole.

1. The first 3D node to create the first hole using the Nearest option

2. The second 3D node on which the second hole is created using the First option

Coaxial hole

Any hole can be created as coaxial (using the same axis) with an arbitrary cylindrical or conic face. A

hole can also be created coaxial with an existing round hole. 

The location of the base face should permit creating a coaxial hole. For example, when creating a hole

coaxial to another hole, the two holes may not be placed on the same face.

The axis directions of the new hole will coincide with that of the source face.

1. Original hole

2. Coaxial hole

Create Holes With Specifies Direction

Nodes for the holes are located on the boundary of two or more faces. It is required to create holes

on the nodes according to certain direction. Since the system cannot automatically determine the

direction, it selects the first appropriate solution. However, the user can independently set the

direction by performing the following sequence of actions.

In this example, we will build an array of holes using the nodes created on the edge of the body. The

nodes are already created.
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Step 1. Select the face for the hole. The face will define the direction for the hole. 

Step 2 – Select A: Enter hole center command and select one of the nodes for which holes should be

created. The system will construct holes according to the selected face.

Step 3 - Select the rest of the array.
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Hole Depth

Depth of a set of holes can be specified by a numerical value or calculated automatically, depending

on the current mode:

·  To next face. Holes are cut up to the intersection with the next face. 

·  Through all. Holes are cut throughout the selected body (a set of bodies).

·  For given length (depth). The depth of the holes is defined by a numerical value.

·  To specified face. Holes are cut up to the specified face (the selected face must intersect with

the holes being created).
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1. To next face

2. Through all

3. For given length (depth)

4.  To specified face

The holes for check screws and center holes of the shape A, B, C, E, R, T permit the option For

given length only.

If a hole axis is not perpendicular to the intersected faces of the body, or if faces intersected by a hole

are not flat, additional manipulations may be required to get a correct hole entry. In such a case, we

recommend using the mode of considering (handling) non-planar faces. In this mode, holes are

extended by an allowance amount at either side, and then trimmed by body faces.
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1. Non-flat faces handling is off

2. Non-flat faces handling is on

Defining hole depth

The desired mode of defining the hole depth is controlled by the following automenu options of the

command:

<E> To next face

<F> Through all

<J> For given length

<S> To specified face

For some types of holes, certain options may not be available.

Selecting the first two modes does not require any additional actions. The depth of the holes will be

determined by the system automatically.

When in the mode , the hole chart presents additional items for defining the hole depth.

In the last mode (the option ), you need to additionally select a face in the 3D scene, up to which

the holes will be cut. The selected face will be highlighted (by default - red).

The additional mode of handling non-flat faces is turned on by the flag Consider non-planar faces in

the lower portion of the operation parameters window. Setting the flag brings up an additional item

in the parameters window, Extend by, where the amount of allowance for the hole extension is to be

input.
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Holes Through Multiple Bodies

Holes can be cut through several solid bodies at once. Such sets of holes create multi-body

operations.

To use each model body separately in the future, use Divide operation after creating the holes.

1. A set of holes created through one body

2. A set of holes through multiple bodies

Creating holes through multiple bodies at same time

You can select additional bodies using the option:

<K> Select additional bodies

Bodies can be selected both in the model tree and directly in the 3D scene.

It is not recommended to select the parent operation of the already selected body as an

additional body in the model tree, because in this case a copy of this operation will be created.

The option allows you to cancel the selection of bodies:

<L> Cancel additional bodies selection

You can create coaxial holes in several bodies or fragments and such holes will not be united in one

resulting body. Use the Create coaxial holes  option for this purpose.
 

<H> Create coaxial holes
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A separate hole will be created for each of the bodies.

Parameterization is supported at the level of general variables. That is, if you set the hole sizes

through variables, then these variables will be saved for each of the holes.

Modify Hole Position and Orientation

Attachment points and orientation can be modified separately for each hole in a set being created.

The hole currently available for editing is highlighted in the 3D scene. The default highlighting color is

red. Other holes in the set are highlighted green.
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Normally, the last created hole is instantly made available for editing. A different hole in the set can

be selected by the option:

<D> Select Hole for edit

Upon activating this option, simply point the mouse at one of the created holes and click . The

selected hole will be highlighted.

The selected hole can be deleted by the option:

<X> Delete selected Hole

Modifying hole attachment point

To define a new attachment point from scratch, use the option:

<R> Change Hole position

After calling this option, you must specify a new anchor point for the hole being edited.

You can change the position of the hole on the current bearing face in the options.

You can change the parameters of an existing hole by selecting it in the model tree and calling the

 Variables command from the context menu.

In the operation parameters dialog called by the option , you can set general operation

parameters.

A special command is used to edit the created operation.

3D Fragment Supplement

<Num0> 3D Fragment Supplement

The option automatically becomes available in the command's automenu when selecting elements on

a fragment in an assembly.

Holes Library Configuration

Library Configuration  option displays structure of libraries that are used in the current operation.

The option allows to select fragments that will be added to the selection drop-down list. Also it

allows to add custom libraries that contain additional fragments. 
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Configurations window appears when you call the option with the tree that contain the following

configurations folders:

Configuration name. Corresponds to the current operation that we configure.

Standard. Defines subset of libraries that will be linked to this standard.

Library. Contains files of fragments that will be added to the selection list.

There are Favorites and Library elements groups inside each library.

All fragment files that exist in the selected library are displayed in its Library elements group. The

fragments that are included in the quick access drop-down list are displayed in the Favorites group.

New library. Add Library window appears when you call the option.

You need to select configuration, standard and the library that will be added. There are two standards

by default: metric and inch. To add a new standard you need to enter its name in the Standard field.

Drop-down list in the Library field includes all libraries, that are displayed in the Documents Menu

window.
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Delete element. Deletes selected configuration, standard or library.

Add/delete fragment as an element by default. Allows to select fragments that will be added to

the quick access drop-down list and in the Favorites group.

Export library configuration. Allows to export configurations in external *.xml file.

Import library configuration. Allows to import configurations from external *.xml file.

Save changes. Allows to save changes in the configurations.

User Holes Creation

The operation of creating a hole combines two actions - inserting a 3D fragment and subtracting it

from the body of the 3D model. In the Hole operation, these actions are performed automatically by

the system (it is enough to select the type of hole and specify the fixing point). This section describes a

technique for creating a 3D model that can be used as a 3D fragment-hole.

The hole fragment file is a parametric 3D model whose geometric parameters are associated with

special reserved variables that are processed by the program. The user's actions when creating a

library element will be considered by the example of creating a file with a centered hole with a metric

thread.

1. If the hole has different versions, it is convenient to use an internal database in which the

corresponding standard sizes are entered. In the example, an internal database b has been created,

in which the fields of the parameters of the future hole are filled in.
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2. A prerequisite is the creation of special variables that will be associated with the parameters of the

created element in the Hole command. These variables should be external. It is necessary to create

the following variables with the specified values in the new file:

· Is Through – this is the variable that defines the hole type (0 – blind, 1 – through). 

The 3D model of any hole fragment shall be created in such a way as to have the hole type (blind,

through) change depending on this variable value. The variable value will be determined by the state

of the option in the Hole command when inserting the hole. This external variable must necessarily be

present in the hole fragment.

· length – this is the variable responsible for the hole depth (when creating a fragment, this

variable value can be arbitrary). 

When applying a fragment, this variable value will be determined by the system (for a through hole)

or by the user in the fragment's external variables dialog (for a blind hole).

You do not have to create this variable (or make it external), if the hole being created can only be

blind and its depth cannot be arbitrary, but is rather determined by the standards. In such a case, the

depth is uniquely determined by other hole parameters (for example, the diameter, as found in the

holes for the positioning screw tips). When applying a hole without the length external variable, the

hole type selection options will be inaccessible in the Hole command automenu.

Other necessary variables can be created and named by the user as desired. For example, in the

described hole fragment, an additional external variable IsThrough is created. Depending on its value,

the hole length can be increased by the amount defined by another external variable, tempDistCurv.

This is necessary in the case when the hole is applied on a curved face (convex or concave) or is

directed at an angle to a flat face. When the IsThrough variable value is equal 0 – no length extension

is required, 1 – the length needs to be extended. A blind hole will be extended by this amount on one

side, a through one - on both sides.

3. Creating 3D hole profile

The 3D profile of the hole is created based on 2D constructions on the workplane. Since the hole can

be created on a curved face of the model (convex or concave) or directed at an angle to a flat face, it

is necessary to provide a protruding part of the hole. Using the tempDistCurv variable, the length of

this part is set at both ends of the hole. If the hole type is blind (variable IsThrough=0), then the hole

length is L=length. If the hole is through, then L=length+tempDistCurv.

If the hole is inserted on a curved face and additional ejection is required, then the length of this part

is set by the value of the tempDistCurv variable.
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4. A Rotation operation is created based on the 3D profile. When creating a hole it is also possible to

use the Extrusion command. An example is a square hole in the standard library. 

It is advisable to create only one operation in the hole fragment file. In the event that the hole has

several versions, then its shape should be changed using associative snaps of the construction lines.

          

5. When creating a hole, a fragment is inserted using a local coordinate system. It is necessary to

create a coordinate system in the hole model that will be used as the default source. The origin point

of the coordinate system should belong to the hole axis, and the X axis should be directed inside the

hole along its axis. The Use for Fragment Insertion flag should be set in the coordinate system

parameters.

6. Since the considered hole is threaded, there is a thread applied to the cylindrical face (the Thread

command). The cylindrical face diameter corresponds to the inner thread diameter. The thread

parameters (type, diameter, pitch, direction) are bound to variables. To make sure that the thread in

the hole appears correctly on a projection, the Thread operation parameters include the Side:Inner

property.

7. To manage hole parameters, a dialog of control elements is created.

Adding hole to library

In order for the fragment you created to be added to the general list of the Hole command, you need

to save it in the \T-FLEX Parametric CAD\Libraries\System\Hole Features\ folder (for metric

prototype) or \T-FLEX Parametric CAD\Libraries\System\Hole Features Inch\ folder (for the inch

prototype).

You can also create an icon file (*.ico) for your hole file with image sizes of 16x16 (for small icons) and

32x32 (for large icons). The icon file should be named the same as the fragment file (*.grb) and should

be in the same folder.
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Edit Hole

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3EH> Edit > Operations > Hole

This command is used for editing Hole.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Hole command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).
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Shell

Calling the command:

Icon Ribbon

3D Model > Advanced > Shell

Primitives > Advanced > Shell

Keyboard Textual menu

<3SH> Operation > Shell

Shell operation enables users to create shells on the basis of solid bodies. A shell is a hollow thin-

sided solid body with the sides of a certain thickness. When creating shells some faces of the initial

solid body can be deleted. 

   

The principle of the Shell operation is as follows: an equidistant surface is built at a given distance

from the initial solid body for every face. The distance can be set along the normal (outwards),

contrary to the normal (inwards) or both ways. The displacement value and direction are set for all the

faces at once, at the same time you can set special displacement parameters for each face. The

volume within the initial surfaces of the solid body and the equidistant ones makes the shell.

Shell Creation

To create a shell, do the following set of steps:

· Select the face or all the solid body to be deleted;

· Set the displacement value and direction;

· Select the faces with special conditions of setting wall thickness and direction (optional);

· Set additional parameters (optional);

· Finish creating the operation.

Selection of a Face or a Body to Remove

To create a solid shell with one or multiple face removal, use the option:

<R> Select Face to be removed

This option activates by default upon calling the command. It allows selecting a face or a set of faces

to be removed when creating the shell. The parent body of the first selected face to be removed is

also selected. The body is highlighted in this case and selected face is highlighted with color.

The faces selected for removal are added to the list in the provided pane in the property window on

the tab Removed. 

Placing cursor in the list pane in the property window activates the option for selecting faces to

remove.
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The thickness of other walls of the shell being created is defined in the input box Thickness of the

parameters window. The default value is 0.06. 

This means the walls of the faces left in the body will be 0.06 mm thick (the measurement units

depend on the document settings).

Enlargement of the shell wall may be performed inside, symmetric and outside according to the initial

body. The corresponding direction selection is performed by clicking the corresponding button in the

parameters window.

   

The wall thickness may have positive or negative value. If you specify negative value, a shell will be

performed in the opposite direction.

You can also set the value and direction with the help of a dragger in the 3D scene.

To create a shell without removing any faces, upon entering the command switch to the automenu

option:

<O> Select Solid

This option allows selecting a solid body to create a hollow body with the specified wall thickness.

   

Selection of Faces with Individually Defined Wall Thickness

In case it is necessary to set individual wall thickness for one or several faces, activate Different tab.

The selected faces get into a special list. The displacement value and direction for the special faces
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can be set with the help of draggers in the 3D scene or in the parameters window. The properties can

be set for several special faces at once at a multiple choice.

     

You can switch to selecting special faces with the help of the automenu option:

<T> Select Face with different wall thickness

The faces selected in this way get to the Different tab.

Including and Excluding Additional Faces

The created shell can be altered by adding new elements to it.

Add a new element to the outer side of the shell with the help of Boolean operation. Now transform

the added element into the shell.

To do it, call the Shell command and select the face to be deleted: the upper face of the element.

Then specify the faces to be added to the shell: activate the Additional tab and select the faces to be

added from the 3D scene, they are three side faces of the element and the bottom face. Specify that
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the additional faces are to be added in the drop-down list: Include faces. You can also set

displacement for the added faces in the parameters window, in the Thickness parameter field.

If only a part of the initial solid body is to be transformed into a shell, not the whole body, eliminate

the faces without displacement, within which the solid body remains without cavity.

To specify such faces, select them in Additional tab and select Exclude faces. In the given example

these are once again three side faces and the bottom face of the element, but here we specify that the

element should not be included in the shell. 

               

Editing is available for all the lists of the geometric objects selected: geometric objects can be

deleted selectively  or all the list can be deleted at once .  icon enables users to reduce the

list which optimizes the window size.

You can finish the command with body creation according to the parameters specified in the

following way:

<Ctrl+Enter> Finish input

To exit the command without creating the body:

<X> Exit command

Additional Operation Parameters

You can set additional operation parameters in the parameters window using the corresponding

options.
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Pierce Smooth Surface. The option allows to create a shell in the cases, when the removed face is

tangent to the non-planar faces. For example, it can be a rounding (radius chamfer). 

Keep Source Body. The option allows keeping source body and the resulting body in the scene. It may

be useful when you need to preserve two models. 

Blend Convex Edges. The option enables users to smooth convex edges obtained after adjacent faces

displacement when the displacement value is the same (displacement value defines the resulting shell

wall thickness). There is a limit for the option: smoothing is only performed at the radius equal to the

wall thickness.

Blending of convex edges when the faces are shifted

inward

Blending of convex edges when the faces are shifted

outward
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Processing the faces intersecting when extending. If the faces intersect when extending, there are

three ways to process this case. User can switch between corresponding icons to select an appropriate

variant for intersecting faces processing.

Auto

Extend Moved

Extend Fixed

An extended face is a face which is moved from the initial one called fixed.

1 – extended faces; 2 – fixed faces.

Auto. The system offers a processing variant without faces overlapping if possible. Otherwise it offers

any other possible variant.

Extend Moved. The faces moved overlap the fixed ones along all the face length.

Extend Fixed. The faces fixed overlap the moved ones along all the face length.

Auto - movable and fixed faces do

not overlap

Extend moved – moved faces

overlap fixed

Extend fixed – fixed faces overlap

moved

The Simplify Geometry option is available in the command.

Dynamic Preview

In the process of setting/editing shell parameters, the future result of the current operation is

dynamically displayed in the 3D window. To increase performance, you can disable the dynamic
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preview by disabling the Dynamic Preview checkbox in the Options section of the command

parameters window.

Manipulators Usage

Manipulators are special graphics elements, which are convenient to use to specify main numerical

parameters of a shell during dynamic preview. Manipulators appear after elements selection.

There are two Manipulators types for the operation:

· Manipulator for specifying general shell thickness appears upon a body or removed face

selection on the largest (not selected) face of the model;

· Manipulators for specifying thickness of different faces.

Manipulators may specify face offset both inward and outward. They are synchronized with the

parameters of the direction of the faces offset.

Using manipulators while working with a large number of objects on a computer of low

performance may cause a significant system slowdown. In this case, you can disable

manipulators using the Use Manipulators option in the Options section of the parameters

window. 

Troubleshooting

When creating Shell operation, the system may fail to calculate the result in some cases. A reason for

a failure could be particulars of the source body geometry. Let's review most typical situations:

1. Degenerate faces. When creating an offset, some faces may disappear. The system may handle

some of the cases. However, if there are too many such faces, or several adjacent faces disappear,

the system outputs an error.

2. Offset faces do not intersect. Upon creating offset faces, the system constructs intersection lines

between adjacent faces for generating the resulting body. In some cases, two adjacent offset faces

may not intersect. 

Topics in this section:

· Shell Parameters

· Edit Shell
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Shell Parameters

The general parameters of the operation are called using the command:

<P> Set entity Parameters

Common Tab

Sets general operation parameters (see General Parameters).   

Operation Tab

Completely duplicates the General Parameters tab in the operation parameters window.

Transformations Tab

This tab allows you to perform the necessary transformations for the shell (see Transformations of 3D

Elements).

Mate Transformations Tab

On this tab, you can delete transformations of mates created after creating a shell.

Characteristics Tab

This tab appears only after creating an operation. Created to set the mass and center of mass of the

created body.

Common properties

Set as Default. When this option is activated, the selected set of parameters will be set for subsequent

Shell operations to be created.

Edit Shell

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3ESH> Edit > Operations > Shell

This command is used for editing Shell.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.
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<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Offset Body

Calling the command:

Icon Ribbon

3D Model > Advanced > Offset Body

Primitives > Advanced > Offset Body

Keyboard Textual menu

<3CO> Operation > Offset Body

An offset body command enables users to create an equidistant not hollow body whose faces are

displaced relative to the initial solid body faces along the normal at a set value. This command is

helpful for creating workpieces with a machining stock or a part coating model with a given layer

thickness. The offset can be performed inwards or outwards from initial body faces. You can set the

same offset value and direction for all the faces or select the faces with special offset parameters. 

Part and workpiece for machining 

Setting the operation

Select the initial solid body. The body select mode is active automatically at calling the command.
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<O> Select Solid Body

The selected body is shown in the dialog in the corresponding field. The field can be edited: you can

cancel body selection with  and select another body. It is not allowed to select several bodies.

You should also select the offset direction in the dialog with the help of special icons.

Inside

Outside

Inside – moving from the body faces along the normal inwards. 

Outside – moving from the body faces along the normal outwards. 

Offset field – set the offset value. If no special faces are selected, the offset value is the same for all

the faces.

To select special faces, activate the automenu option:

<T> Select Face with different wall thickness

This automenu option becomes active automatically after you select the body. The faces selected in

this mode automatically get into the editable list.

You can set the offset direction and value for any element of the list. In case you choose Common

variant (set by default), the offset direction is the same as for all the faces which are not on the list. 

Any face can be deleted with the help of  or clear all the list of faces with .

You can control the offset value and direction by means of draggers at the 3D scene. When you select

a special face, a special dragger for it appears.

You can set the same offset parameters for several faces by selecting them in the list with the <Shift>

key pressed. If manipulators are used in a 3D scene, the manipulators of the faces selected in the list

will move coherently according to the movement of any of the manipulators.  

To finish the command with creating the surface according to the parameters set, do the following:

<Ctrl+Enter> Finish input

To exit the command without creating the surface, do the following:
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<Х> Exit command

Additional operation parameters

Keep Source Body. This option enables you to leave the initial body at the 3D scene along with the

result. This can be helpful when it is necessary to have both part models at the same time.

The Simplify Geometry option is available in the command.

Options

Dynamic preview. The option is standard for all the 3D Design commands. It enables a simplified

representation of the body being built which dynamically changes when the initial parameters change.

The option is enabled by default.

Use Manipulators. The option is standard for all the 3D Design commands and is enabled by default.

It enables auxiliary graphical objects – manipulators. There are two types of manipulators in this

operation: common offset manipulator and special faces manipulators.

Offset Body Parameters

The general parameters of the operation are called using the command:

<P> Set entity Parameters

Common Tab

Sets general operation parameters (see General Parameters).   

Operation Tab

Completely duplicates the General Parameters tab in the operation parameters window.

Transformations Tab

This tab allows you to perform the necessary transformations for the offset body (see Transformations

of 3D Elements).

Mate Transformations Tab

On this tab, you can delete transformations of mates created after creating a offset body.

Characteristics Tab

This tab appears only after creating an operation. Created to set the mass and center of mass of the

created body.

Common properties

Set as Default. When this option is activated, the selected set of parameters will be set for subsequent

Offset Body operations to be created.
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Rib

Calling the command:

Icon Ribbon

3D Model > Advanced > Rib

Keyboard Textual menu

<3ST> Operations > Rib

A rib is an element that is obtained by extension of a contour in the given direction until intersection

occurs with the faces of the initial body. 

Ribs can be created on the basis of closed as well as open contours. The result of execution of this

operation is a solid body obtained with a Boolean operation of union of created rib with the initial

body.

   

The user specifies direction of extension of the initial contour and its thickness. After selection of

several contours a grid of ribs can be created. In this case the thickness for several objects is specified

immediately for the entire grid.

Contour may consist of several parts. In this case one direction to solid body is specified for all parts

of the contour.
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It is not necessary to limit rib contour with solid body walls. In most cases system can automatically

determine the boundaries of the created edge. On the picture below the rib is limited with planes of

the solid body faces.

1. Solid body faces

2. Rib contour

Note that if borders can’t be automatically determined the construction of the rib will not be possible.

Creation of rib

To create the operation, it is required to execute the following sequence of actions:

1. Select the source body;

2. Select forming contour;

3. Select direction of extrusion of the rib;

4. Specify thickness of rib; 

5. Specify additional capabilities of the operation (not a necessary step);

6. Confirm creation of operation. 

Topics in this section:

· Create Rib

· Direction of Extension of Rib

· Additional Capabilities of Rib

· Edit Rib
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Create Rib

Selection of Source Body 

To create a rib it is firstly required to select the source body. After invoking this command the

following option will automatically be activated in the automenu:

<S> Select body

To select a body, you need to move the cursor to the necessary element in the 3D window. If there is

only one body, it is selected automatically. The selected element will be highlighted, the cursor will

have a hint with its name. To select, click . You can cancel the body selection by clicking .

Selection of contour

After selection of the source body the option of selection of the contour that defines the form of a rib

being created is activated.

<C> Select forming contour

As a contour we can select 3D profiles, faces, edges, paths, loops. If there is only one profile in the

scene, it will be selected automatically.

After the first contour has been selected this option remains active, and if necessary you can select

several contours.

When contour extends beyond the limits of the source body it is cut to the required size.

1. The original contour

2. The original body

3. Created rib

2. Contour of rib being created

The contour, if it is open, is extended to the intersection with the model, and the entire space between

the surfaces of the part and this contour will be filled with a material of a given thickness.

By using one contour we can specify two or more ribs.
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Entire contour. When flag is set, rib can be created outside of the body using the closed contour.

All of the selected contours are displayed in the Forming Contours tab in the command’s parameters

window.
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The button  removes the selected contour from the list.

Direction of Extension of Rib

Direction of Extension of Rib

Extension of a contour can be carried out in two directions:

· In the contour plane  

· Perpendicular to the contour plane

Direction of Extrusion of Rib

The contour can be extruded in two directions:

· In the contour plane (the rib surface is formed by the extension of the contour in the direction

of its plane).

· Perpendicular to the contour plane (the rib surface is formed by the extension of the contour

in the direction perpendicular to its plane).

 

To choose the method of contour’s extension it is required to use the General Parameters tab of the

command’s parameters window.

Direction of contour extension is displayed in the scene as arrow-manipulator.
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Contour Direction for a Straight Segment

If forming contour is specified by a straight segment, its positioning plane is determined

automatically by the following rule. If segment presents part of a profile, system will use plane of the

profile creation. If segment presents part of a path, positioning plane is defined by rotating the

segment in global coordinate system to the nearest plane the segment coincides.

 Contour extension direction is created according to the determined positioning plane.

To select contour extension direction manually, you need to use option:

<D> Select contour direction

Next you need to select an auxiliary element. If you select object that specifies plane – face,

workplane, etc., then the direction will be a normal to this plane. Alternatively, you can select object

that specifies direction – edge, coordinate axis, etc.

Specified contour extension direction will affect all selected contours defined by the straight

segments.

To cancel direction selection use option:

<K> Cancel direction selection

Direction to Solid 

In addition to contour extension direction, you can specify direction to solid. It determines which part

of the half-space, created by contour, will be transformed into the rib. 

Special manipulator is used to specify direction to solid. It indicates direction inside the rib body from

the point located on the contour. If contour is open, the point is located in the center of the contour

line. For closed contour, the point position is chosen arbitrarily. For convenience you can move this

point along the contour.

Direction to solid can be defined individually for each contour. To change direction you need to move

the manipulator, pulling one of its arcs.

The manipulator allows you to set the direction to solid manually. Thus, system does not need to

determine correct direction automatically.

After the operation creation, all space between the walls of the source body and the contour in

determined direction is converted into the solid rib of specified thickness.
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1. Point

2. Direction to solid body

3. Manipulator arcs

Thickness of rib

When forming a rib, new solid material is added in the direction perpendicular to contour extension

plane.

The value of thickness can be specified in appropriate field of the «Main Parameters» tab of the

command’s parameters window or by means of manipulator.

The direction of thickness adherence must also be specified for a rib:

· Forward direction. Direction coincides with the direction of the normal to the contour’s plane.

· Back direction. Direction is opposite to the direction of the normal to the contour’s plane.

· Symmetric. Thickness is added to the rib equally in both directions with respect to the plane

of the contour.
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Symmetric Forward direction Back direction

Direction of thickness adherence can be selected from the drop down list on the General Parameters

tab:

In case if the specified value of the thickness parameter becomes larger than the value of the

contour’s length, the corresponding field will be renamed to Height.

Additional Capabilities of Rib

Taper of Rib’s Faces. 

If it is required that the faces of the rib have a taper, the following actions must be executed:

1. Select direction of a taper by using the option:

<T> Set tapering direction 

When this option is enabled the geometric element is selected that specifies the direction of the

taper.

2. Enter the value of the taper angle.
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In the example the normal to the selected face serves as a geometric element that specifies the

direction of the tilt.

To cancel selection of tapering direction use option:

<R> Cancel taper direction

Blending ribs

To specify parameters of ribs blending it is required to use the Blend Parameters tab in the

command’s parameters window.

To smooth out the side faces of a rib on its ends it is required to enable the Edges flag and input the

required value of blend radius in the field next to the flag.
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To smooth out intersections of a rib with the source body it is required to enable the Intersections

flag and input the required value of blend radius in the field next to the flag.

Separate body

Allows to create a rib as a separate body.

The option, in particular, allows you to create welded structures using ribs.

This method may be used for example when modeling welded structure of flange and pipe.

In the Option section, you can set options for displaying auxiliary elements. 

Option Use Manipulator allows you to enable/disable the display of manipulators that specify the

direction to solid and rib thickness.

Option Show Labels allows you to enable/disable the display of the labels that output rib thickness.
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Edit Rib

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3EST> Edit > Operations > Rib

This command is used for editing Ribs.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).
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Cut

Calling the command:

Icon Ribbon

3D Model > Advanced > Cut

Sheet Metal > Advanced > Cut

Surfaces > Advanced > Cut

Keyboard Textual menu

<3CU> Operation > Cut

The cut operation allows cutting bodies (solid or surface) by surfaces. Surface bodies, Worksurfaces

and Workplanes, 3D sections, 3D profiles, faces and arrays of all mentioned elements can be used as

cutting surfaces. Depending on the selected command mode and parameters, operation may result in

deleting a part of an original body or splitting an original body into several parts with or without

creating new bodies. Following command modes are available:

Cut

Split

Split with Separation

Original body and cutting plane
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 Cutting result: 

part of original body is deleted

 Splitting result: 

original body is split into parts

 Splitting with Separation result: 

original body is split into two new bodies

Topics in this section:

· Create Cut

· Edit Cut
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Create Cut

Following steps should be done to create a cut:

1. Sect a command mode (  Cut,  Split,  Split with Separation);

2. Select an object of cutting (body);

3. Specify, whether the source object should be kept (optional);

4. Select cutting surfaces;

5. Define offsets from selected cutting surfaces (optional);

6. Reverse cutting direction (optional step available in the  Cut mode only);

7. Select the resulting parts to be kept (optional step available in  Split and  Split with

Separation modes only);

8. Confirm the operation creation .

General Parameters
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General Parameters in the  Cut mode General Parameters in 

 Split and  Split with Separation modes

Upper area of the General Parameters tab of the command parameters window contains buttons for

selecting one of the following command modes:

Cut

Split

Split with Separation

The Accuracy input box is located below. Just like in many other commands, object are being

approximated or considered coinciding within this tolerance. Additionally, the Accuracy affects the

Offset application. Offsets with absolute values lower than Accuracy are ignored.

Keep in mind that the Offset is measured in millimeters, while the Accuracy is measured in

meters.

The body to be cut can be selected in the 3D scene or in the model tree using the following automenu

option:

<B> Select 3D operation

The selected body is highlighted in green color in the 3D scene and shown in the Object input box of

the command parameters window. Selected object can be Cleared  and re-selected using the

button located in the right side of the input box. Multiple objects can not be selected. Solid and

surface body can be used as an object of cutting.

The original body is replaced by the result of cutting by default. Enable the Keep Source Object

checkbox, if need to keep the original body along with the result of the operation

Cutting surfaces can be selected in the 3D scene or in the model tree using the following automenu

option:

<C> Select intersecting Profile

Selected surfaces are highlighted in blue color in the 3D scene and are put into the Cutting Surfaces

list in the command parameters window. Upon selecting a row in the list, the corresponding surface is

highlighted in red color in the 3D scene. You can Expand , Collapse , Clear  the list or Delete

Element from the List  using buttons located on the right side. Upon selecting cutting surfaces, the

green highlighting of an object body in the 3D scene is replaced by the dark-yellow highlighting of a

cutting result.  Surface bodies, worksurfaces, 3D sections, 3D profiles, faces and arrays of all

mentioned elements can be used as cutting surfaces. The list of cutting surfaces contains following

columns:
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· Element 

Contains an icon of element type, a name of an element and a name of its parent operation. 

·  Reverse Direction

Contains the checkbox of the eponymous option in the  Cut mode. Contains a dash in other

modes.

· Offset

By default, an object body is split into parts by an intersection with a cutting surface. However,

you can cut the body not by the surfaces itself, but by the equidistant one. Equidistant surface

is offset from the selected cutting surface by the value typed into the Offset input box, which is

located below the list of cutting surfaces. This value is shown in the Offset column of the list. 

 

Cutting direction

The  Cut mode allows to delete a part of an original body, which lays by one side of a cutting

surface. By default, the part to be deleted is selected automatically. You can switch the part to be

deleted to an opposite one by enabling the  Reverse Direction option for a particular cutting

surface selected in the list. The checkbox of this option is available below the list of surfaces as well as

in the second column of the list. The input box for this option is also located below the list of cutting

surfaces. Enabled checkbox corresponds to the "1" value, disabled - to the "0" value. Values can be

also typed in manually or defined using variables. Only whole values are allowed. Any value non equal

to zero is counted as "1". This option can also be switched using the following automenu option:

<D> Switch view direction

Arrows, pointing to the part of the body to be kept, are shown in the 3D scene for each of the selected

cutting surfaces:

If a cutting surface is a workplane and an offset is defined for it, then arrows are shown on an

equidistant surface:
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Clicking  on an arrow reverses the cutting direction.

Result

 Result tab 

for the  Split mode

Result tab

for the  Split with Separation mode

In  Split and  Split with Separation modes the command parameters windows contains the

Result tab. If dynamic preview is enabled (by default), this tab contains the list of parts resulting from

splitting an original body. Parts are grouped in accordance with resulting bodies (The  Split mode

always results in a single body, the  Split with Separation mode results in a separate body for each

part). You can fold a section of the list containing part of a particular body by clicking the  button,

which is located to the left side of a body name. When folded, the button changes to . Click it again

to unfold a section.

Each part in the list has its own checkbox. All checkboxes are enabled by default. The Keep drop-down

list located above the list of parts contains following options:

· All (default)

All parts are kept upon confirming the operation creation. Selecting this option automatically

enables checkboxes for all parts.

· Selected

Parts with enabled checkboxes are kept upon confirming the operation creation. Parts with

disabled checkboxes are deleted.
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· All Excluding Selected

Parts with disabled checkboxes are kept upon confirming the operation creation. Parts with

enabled checkboxes are deleted.

The part, which is currently selected in the list, is highlighted in red color in the 3D scene (no matter if

it is subjected to deletion or not). The parts to be kept are highlighted in yellow, the parts to be

deleted are highlighted in white.

The Unite checkbox is available above the list of parts in the  Split mode, in case when some of the

part's checkboxes are not enabled. Enabling the Unite checkbox unites all part to be kept upon

confirming the operation creation.  In such case, the  Split result is similar to the  Cut result.

However, the  Split provides extended capabilities for selecting the parts to be kept (the  Cut

doesn't allow keeping parts, which are not geometrically connected).

See also:

· Preview of Operation Result 

· Common Parameters of 3D Elements

Edit Cut

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3EU> Edit > Operations > Cut by Section

This command is used for editing Cut.

Available options:

<Esc> Cancel selection
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<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Cut command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Thread

Calling the command:

Icon Ribbon

3D Model > Advanced > Thread

Keyboard Textual menu

<3AT> Operation > Thread

This operation allows you to create cosmetic threads on cylindrical and conical faces of a 3D model.

Such a thread is called cosmetic because when the command is launched, a texture is applied to the

selected face, depicting the thread, taking into account the specified boundaries and values ??of the

step and direction. Unlike a thread created using the Spiral operation, this operation does not create a

complex geometric surface and does not require a lot of time when creating and recalculating the

model. When creating 2D projections, the system automatically creates graphic lines corresponding to

the applied thread. When drawing up a drawing, dimensions attached to such graphic lines will

display a thread symbol. When creating drawings, this type of thread will also be displayed in

projections. In addition, the thread type is displayed in the model tree opposite the created Thread

operation, for example, Thread_5 [M14x1.5].

The parameters for standard threads are contained in the Treads.xml file, which is located in the

Program folder.
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The command is also available from the context menu when a cylindrical or conical face is selected

(Create > Thread). In this case, when the command is called, the bearing face is considered to be

already selected.

Topics in this section:

· Create Thread

· Thread Display on 2D Projections

· Thread Parameters

· Edit Thread

T-FLEX CAD supports creation of cosmetic threads on cylindrical and conic faces of a three-

dimensional model. A cosmetics thread is not the exact geometrical representation of an actual

thread that can be created in the command "Create Spiral". Nevertheless, it is quite suitable for most

of the tasks arising in thread modeling, while consuming much less computational resources.

A cosmetic thread is a texture applied to the selected face. The simulated image reflects the pitch,

direction and boundaries of the thread.

When creating drawings by projecting cosmetic threads, the standard thread notation is automatically

generated on the projections.
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Main concepts. Operation capabilities

Cosmetic threads are created based on a special database "Threads.mdb", located in the folder …

\Program. The database contains geometrical parameters of standardized threads according to the

engineering standards. If necessary, the database can be appended with custom threads. You can also

create nonstandard threads directly in T-FLEX CAD, without using the database.

When creating a cosmetic thread, you need to select the base face (cylindrical or conic), define the

thread type (standard) and side (outer or inner) and the main parameters. To define the thread

parameters, use either the property window or the standard parameters dialog box. All of the thread

parameter values can be defined using variables. Additionally, you can specify the thread offsets from

the ends of the base face or from an arbitrary 3D object. The position of the thread end can also be

defined relative to its start, by actually specifying the thread length.

The parameters of the standard thread – the pitch, the working profile height and the class – can

either be set by the system automatically or manually defined by the user.

In the Autoadjust mode, the system sets the thread parameters from the database, based on the

diameter of the base face. When the base diameter is modified, the thread parameters are adjusted

automatically.

In the manual mode, the user defines the thread parameters by numerical values or by using variables.

The entered values are checked against those in the thread database. If the input diameter or pitch is

not defined for the respective thread type, the value will be taken from the database nearest to the

specified one. In this case, the thread parameters will not adjust to the base face diameter

modifications. When creating a nonstandard thread (not existing in the thread database), all its

parameters are defined manually.

The combination of parameters and the thread behavior depends on its property – being an outer or

an inner thread. For an outer thread, the base face diameter is considered the outer diameter, while

for an inner thread it is the inner diameter. For the same base face diameter, the system-defined

parameters will be different for outer and inner threads. The thread side (outer or inner) is a

characteristic constant and can be defined in two ways. 

In the first way, the thread side is defined automatically at creation. Inner threads are created on

concave faces, while outer ones – on the convex faces. If the face later changes from convex to

concave or vice versa due to Boolean operations or other body modifications, the thread will
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disappear. The automatically defined thread side is suitable for most of threads. In the second way,

the thread side is explicitly defined by the user at creation, regardless of the current geometry of the

base face. This may be necessary, for example,when creating fragments of holes.

In the fragments, the thread is applied to the convex face, yet is marked as inner. Upon assembling the

fragment, performing a Boolean subtraction makes the base face of the thread concave. Thus, after

the Boolean operation the thread is carried over to the resulting inner cylindrical face of the hole.

When creating a 2D projection, the necessary graphic lines are created automatically to mark the

thread. The parameters of such graphic lines are defined separate from the rest.

Topics in this section:

· Create Thread

· Thread Display on 2D Projections

· Thread Parameters

· Edit Thread

Create Thread

To create an operation, you need to perform the following sequence of actions:

1. Specify the bearing face.

2. Set the thread parameters.

3. Set the boundaries of the beginning and end of the thread (optional).

4. Confirm the creation of the operation.

Specifying the bearing face

The option  (<F>) is active by default after calling the command. Cylindrical and conical faces are

available for selection. It is allowed to select several faces of the same type and diameter.

After selecting a face, a schematic image of the thread in the form of a spiral, the thread border is

displayed on its surface (by default, the thread is applied to the entire length of the face).
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The edge of the face, closer to which the mouse cursor was located at the time of selection, sets the

beginning of the thread (i.e. the direction of cutting is postponed from it).

Thread parameters

The operation parameters are displayed in the Parameters service window. You can also open the

parameters window using the automenu option  (<P>). The default thread parameters are

selected from a special file based on the diameter of the bearing face. With the same diameter of the

bearing face, the parameters selected by the system for external and internal threads will be different.

For an external thread, the diameter of the bearing face is considered the outer diameter, for an

internal thread – the inner one.

Defining thread offsets (boundaries)

By default, the thread is created along the entire length of the selected face. To set offsets, you can

use the automenu options and the Parameters window or manipulators, which are shown in yellow in

the figure. When you hover the cursor over the manipulator, its shape changes to  for the start

thread boundary or to  - for the end one. By moving the mouse with the left button pressed, you

can change the position of the thread boundaries. Numerical values of offsets will be displayed in the

Parameters window.

By default, the offsets are set relative to the start and end of the face. Using the automenu options,

you can change the type of indentation assignment.

For the start thread boundary, an option  is used, the drop - down list of which contains icons:
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<A> From face start

The offset of the start of the thread is calculated from the start boundary of the bearing face. The start

boundary is considered to be the edge closest to which the cursor was located when selecting the

face.

<S> From Element

The offset of the start of the thread will be calculated from the additionally selected 3D object. The

options for selecting objects of different types are described below.

For the end thread boundary, an option  is used, the drop - down list of which contains icons:

<D> From face end

The offset is set from the end edge of the bearing face.

<F> From thread start

The offset is set from the start thread boundary, i.e. the offset value determines the length of the

thread.

<G> From face start

<H> From Element

This option  allows you to set the offset from the start edge of the bearing face. When using the

option , the offset of the start of the thread will be calculated from the additionally selected 3D

object. The options for selecting objects of different types are described below.

If the type of the start or end of the thread is set Object, then additional icons become available in the

automenu:

<V> Select points

<L> Select lines

<U> Select planes

Each of these options uses filters to define the set of object types allowed for selection (see Selection

of 3D Elements). That is, those objects are available for selection, on the basis of which the system can

determine the geometry of a 3D point, straight line or plane.

For example, on a bolt, the thread is created after the chamfer is created, so the start boundary is set

from object. An end face or a 3D point belonging to this face can be selected as an object. You can

set the type of thread end to Thread start and set the offset to an exact value of the thread length.
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The automenu option  (<R>) cancels the selection of the bearing face and the objects that set the

offsets.

Completing the operation creation

To confirm the creation of the operation, use the option  (<Y>).

You can edit the operation either by calling the Parameters window again, or by using a special

command.

Thread Display on 2D Projections

By default, the thread-marking lines are automatically created on 2D projections of bodies with

threads. 

The line display is controlled via the projection parameters, the tab Lines. 



Solid Body

1697

When dimensioning the thread lines, the thread notations are applied automatically. To cancel this

mode (of creating a normal dimension), set parameter From lines to Auto. By default the value is set

to From lines for dimensioning the thread lines.

Hidden threads can be displayed on 2D projections by dashed lines, when the Hidden lines flag is

turned on. When creating a section or a local view, the thread is displayed in the usual way. In those

cases, thread notations can be applied automatically when dimensioning thread lines.
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If a small line thickness or a large scale is set for the projection, then you can use the Minimum

Thread Height projection parameter (Line tab, Threads flag) to display the actual size between the

projection line of the face and the line indicating the thread. By default, this size is limited to 0.025.

Sections of the threaded connections require setting of the Fill Element Outline flag in 2D Projection

parameters. When flag is set, lines of the section view will be constructed correctly. Otherwise

projection lines of bolts and holes will overlap each other due to interpenetration.

Thread Parameters

Common Tab

Sets General operation parameters.  

Name. The operation name is unique, and by default it reflects the sequence number of the operation

performed (Thread, etc.). at the time of creation, the operation name is not displayed in the

parameters window.

Operation Tab

Standard. The value of this field can be one of the names of the standard that exists in the Treads.xml

file, or a non-Standard thread. The parameter value is set by selecting from the list or entering a

numeric value in the field on the right. In this field, you can enter a numeric value or a variable that

specifies the ID of the standard in the file. If you select a non-standard thread all the parameters

including the string notation of the threads are manually set, the file in this case is not used. 

Side. This parameter defines the type of thread.
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· Current. The type of thread (external or internal) is determined automatically depending on the

type of face selected. If the carrier face type changes during further work with the model (for

example, after performing a Boolean operation), the thread will not be displayed because the

face type does not match. This value is set by default.

· External. The thread is considered external for any type of bearing face. The face diameter

specifies the outer diameter of the thread (if the AutoFill flag is set). 

· Internal. The thread is considered internal for any type of bearing face. The diameter of the

edge defines the inner diameter of the thread (if the flag is set autoadjast). For example, when

creating a thread on the outer face of a body that will be used as a 3D fragment to create a

hole, i.e. it will be automatically subtracted when inserted into the Assembly, you must use the

Internal value. 

Autoadjust. By default, this flag is set when creating an operation, i.e. the thread parameters are

selected from the database based on the diameter of the bearing face. The system selects the thread

diameter value closest to the face diameter value from the list of acceptable values for the selected

standard. If two values are found, the higher priority value is selected in accordance with GOST

requirements. Values that are not recommended in GOST are marked in brackets in the list. Then, from

a number of steps corresponding to the selected diameter, the most preferred step is selected (for

metric threads, this will be a large step, for other threads – recommended in GOST). The value

corresponding to a major step is highlighted in the list in bolder font. Automatic selection of thread

parameters will also be performed when changing the diameter of the bearing face during model

recalculation.

For non-standard threads, auto-selection is not available.

When auto-selection mode is disabled, you can set any parameter values or variable names in the

parameters dialog for standard threads. However, even in this case, the thread parameters are taken

from the database – they are selected closest to the values entered by the user. These parameters do

not change when the diameter of the bearing face changes.

Diameter. For non-standard threads, enter the value of the thread diameter in this field. When creating

one of the standard threads, the field displays the value selected from the database. If several nearest

values are found in the database, all of them will be included in the list. 

Pitch. The parameter contains the increment value of the created thread. For standard threads, the

system displays the preferred pitch by default. If necessary, you can select a different step from the list

provided by the system. In this case, automatic recalculation after changing the face diameter will not

select the most preferred step, as it should be by default, but the one closest to the one set manually.

Height. The value of the field displays the height of the working thread profile for this step. This

parameter is a reference parameter,Number of Threads. The parameter value specifies the number of

thread runs.

Side. If the flag is set, the thread being created will be left-sided (by default, the flag is unchecked). In

the field on the right, you can enter a numeric value or a variable that controls the flag state. A value

of 0 or less indicates that the flag is cleared, and any value greater than zero indicates that the flag is

set. When creating a left-hand thread, the corresponding symbols are added to the symbol string.

Class. This parameter contains a list of tolerances (accuracy classes) set in the database for the current

thread parameters.

Notation. This parameter contains a thread designation string. When you create a dimension on the

lines of the thread image that belong to the 2D projection, this designation is placed automatically.

When creating a standard thread, this parameter is a reference parameter, i.e. its value cannot be

edited.

Face diameter. This field displays the diameter value of the bearing face. This parameter is a reference

parameter, i.e. its value cannot be edited.

The next group of parameters specifies how to set the thread offset and its value.
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Start. Specifies the offset from the initial boundary of the thread. Can take one of the following values:

· Face start. The offset is deferred from the edge of the bearing face closest to which the cursor

was located at the time of selection (this edge is considered the beginning). This value is set

by default.

· From object. The indent is deferred from the point set by an optional 3D object (point,

straight line, or plane). The item type is selected using the corresponding auto-menu options. 

If the offset is set by a 3D point, it is deferred from the projection of the additional point on

the axis of the bearing surface. If the indent is set as a straight line, it is deferred from the

point on the axis that is located at the shortest distance between the axis and the selected

straight line. If the offset is set by a plane, it is deferred from the point where the axis

intersects with the selected plane. 

End. Specifies the offset from the end edges of the thread. It can take one of the following values: 

· Face end. The offset is deferred from the final border of the face.

· Thread start. The offset is deferred from the initial thread border.

· Face start. This type of indentation task is described above (the Start parameter group).

· From the object. This type of indentation task is described above (the Start parameter group).

The numeric value of the margin is set in the field On. By default, the indent is set in model units. If

necessary, you can select %from the list on the right. Then the offset value will be set as a percentage

of the length of the bearing face (if the offset is set from the beginning of the thread, the initial length

is the distance from the beginning of the thread to the end of the face).  

Set as default. The selected option means that the specified General parameters will be used for all

subsequent operations.

Edit Thread

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3EAT> Edit > Operations > Thread

This command is used for editing Thread.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command
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<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Thread command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Spring

Calling the command:

Icon Ribbon

3D Model > Advanced > Spring

Keyboard Textual menu

<3SP> Operation > Spring

The Spring operation creates a 3D body as a conic or cylindrical helix-shape spring with round profile.

The body is created by sweeping a circular profile along a helical curve defining the spring trajectory.

                          

Topics in this section:

· Main Concepts of Spring

· Create Spring

· Edit Spring

Main Concepts of Spring

Spring axis

The helical curve used for sweeping the circle profile is centered about the spring axis. The axis is

defined by two 3D points: the start point and the end point. 3D points can be defined by 3D nodes, as

well as by any 3D object suitable for defining a point in the space. The vector defining the spring axis

will be directed from the first point to the second one (those also defines the start and the end of the

spring, respectively). The shape of the curve is defined by the spring parameters. The swept profile will

be normal to the original curve.
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Spring main parameters

The shape of the body resulting from this operation is defined by the following parameters:

· The radius of the spring wire – defines the radius of the circular profile, whose sweeping

forms the body.

· Spring radii/diameters at the ends – the radii/diameters of the helical curve at the start and

end of the spring (mean start and end radii are equal in the case of a cylindrical spring). You

can select which Mode to use: Mean radius, mean diameter, inner diameter, outer diameter.

10 - inner diameter

12 - mean diameter

14 - outer diameter

· Spring coiling direction: Clockwise (right) or counterclockwise (left).

· The step (pitch), the number of coils and the free length of the spring.

The spring can be defined using any two of the three parameters: Pitch, Coils, Length. When

two parameters are already enabled, one of them will be automatically disabled upon

enabling a third one. By default, the free length of the spring is defined as the distance

between the 3D points defining its axis. In this way, it is sufficient to define just the pitch or just

the number of coils – the other parameter will be calculated by the system automatically. In

cases when both the pitch and the number of the spring coils are defined, the spring length

will be defined solely by those parameters.
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Initial position of spring profile

Initial position of the spring profile is set arbitrarily by the system. It can be modified by defining the

desired position with the help of an additional 3D point – profile starting location (profile start point)

– or by specifying the numerical value of the start angle (profile rotation angle) in relation to the

original position.

Once the start point of the profile is specified, it will snap to the plane passing through the selected

point and the spring axis.
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When both the start point and the numerical value of the rotation angle are specified, the latter is

measured from the profile position defined by the start point.

   

Compression and grinding of spring ends

If necessary, the end coils of the spring can be compressed (closed/squared) and ground. The diagram

below shows a spring with one coil compressed at the start, and one coil compressed and ground by

3/4 wire diameter at the end.
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Spring position with respect to start and end points

If the spring length is defined by the pitch and the number of coils, you can force the spring alignment

by the start or the end point.

Aligning by start point 

Aligning by end point 

Create Spring

The detailed information about geometrical meaning of undermentioned parameters is

available in the Main Concepts of Spring chapter.

Creating a spring

To create a spring, do the following steps:

1. Define spring axis.

2. Define spring main parameters (optional).

3. Select the start point for the spring profile starting location (optional).

4. Define parameters of compression and grinding of spring ends (optional).

5. Apply aligning with starting or ending point of an axis (optional).

6. Define parameters of a Boolean operation (optional).

7. Confirm operation creation .
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Spring axis definition

The start point of the spring axis is defined by the following automenu option:

<F> Select starting Point of Axis

The end point of the axis is selected option:

<S> Select ending Point of Axis

The options activate one after another. Selected objects are highlighted in the 3D scene. Once the

second point is selected, the following preview of the spring is displayed:

1 - Starting point of axis

2 - Ending point of axis

3 - Axis

4 - Helical curve

5 - Profile at start

6 - Profile at end

7 - Radius of profile

8 - Starting radius of helical curve

At this stage, you can already complete the spring operation by pressing  in the header of the

parameters window or in the automenu.

Spring operation parameters definition

Following parameters can be defined in the Parameters tab of the command parameters window:
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The Mode drop-down list contains following options of spring's helical curve diameter/radius

calculation:

· Mean radius;

· Mean diameter;

· Inner diameter;

· Outer diameter.

Depending on the selected option, Start and End input boxes could be used to define a

corresponding radius or diameter of a helical curve at the starting and ending points of an axis.

The cylindrical spring is created by default, so the End input box is inactive and the radius/diameter is

constant along the spring length. Enable the checkbox for the End parameter, if you need to define its

value. In this case, the radius/diameter varies linearly along the spring length from Start to End value. 

The diameter or radius of a spring's wire can be defined in the Wire input box. Type of parameter is

selected in the adjacent drop-down list.

Length, Pitch and Coils input boxes are located below the Wire. By default, only number of Coils can

be edited, while Length and Pitch are calculated automatically. If you need to defined any of these

parameters manually, enable the checkbox located to the left side of parameter's name. The system

disables one of the two enabled parameters automatically if you enable the third one. 

The Start Angle parameter defines an angle between wire profile's actual and default starting

positions or between actual starting position and a point that defines profile starting location.

Winding direction can be selected using the Direction of Coiling switch. Right-handed - clockwise,

Left-handed - counterclockwise.

Selection of the start point for spring profile position 

The start point of the spring profile can be specified using the following automenu option (the option

activates upon selecting the second axis point):

<B> Select 3D Node as profile starting location

To undo a 3D point selection, simply select another one using the same option, or cancel the selection

by the option:
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<K> Delete starting 3D Node

The profile will then revert to its original position. You can enter a numerical value of the angle

between profile's actual starting position and a point that defines profile starting location in the Start

Angle input box (the Parameters tab of the command parameters window).

Defining compression and grinding of spring ends 

Parameters for compression and grinding of end coils of the spring are defined in the Optional

Parameters tab of the command parameters window. To compress coils at the spring start, enable the

Compress checkbox in the Start group of parameters and type in the adjacent input box the desired

number of coils. Enabling the Ground checkbox in the Start group of parameters allows to define

depth of spring start grinding measured in portions of wire diameter. 

The compression and grinding parameters at the end of the spring are defined in a similar way using

checkboxes in the End group of parameters.

Spring alignment by start or end point

To align the spring by the start or end point, enable the Align with Starting 3D Node or the Align

with Ending 3D Node checkbox in the command parameters window. In the case of ambiguity (when

both flags are set), the system aligns the spring by the start point.

Using created body in Boolean operation

Options for Boolean operation creation are available in lower part of the automenu.

More information about Boolean operations can be found in the Automatic Boolean creation

combined with creating other operations chapter.

See also:

· Common options for solid 3D modeling operations

· Preview of Operation Result 

· Common Parameters of 3D Elements
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Edit Spring

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3ESP> Edit > Operations > Spring

This command is used for editing Spring.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Spring command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).
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Spiral

Calling the command:

Icon Ribbon

3D Model > Advanced > Spiral

Keyboard Textual menu

<3SR> Operation > Spiral

The Spiral operation creates a 3D body by sweeping an arbitrary 3D profile along a helical curve. The

profile can be oriented parallel to the spiral axis, perpendicular to the spiral axis or perpendicular to

the helical curve.

Helical curve can be constructed either along an axis (straight or curved) or in a plane. Helical curve is

constructed in a similar way as in Helix 3D Path along Axis and Flat Helix 3D Path commands.

Upon calling the command it is necessary to select the type of spiral to be created and then follow

instructions given for the selected type. Following types of spiral are available:

Along Axis

Flat

     

Topics in this section:

· Spiral along Axis

· Flat Spiral

· Edit Spiral

Spiral along Axis

Spirals of this type can be created using the following option in the Spiral command:
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Along Axis

Following steps should be done to create a spiral along axis:

1. Choose axis type

2. Define spiral axis.

3. Define start point and/or start angle (optional).

4. Select profile.

5. Select first and second fixing points.

6. Choose profile orientation (optional).

7. Define profile scale (optional).

8. Define length, pitch, number and direction of coils of a screw curve (optional).

9. Define radius or diameter of a spiral (optional).

10. Confirm the operation .

Command parameters are described below.

For more information refer to the Main concepts of spiral along axis chapter.

Axis, Start Point, Start Angle

Following Axis Types are available:
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·  Two Points

·  Path

·  Axis

·  Point and Direction

Depending on the selected axis type, some of the following input boxes appear: First Point, Second

Point, Path, Axis, Direction. Activating the desired input box allows to select in the 3D scene a

corresponding object defining a spiral axis.

By default a spiral is constructed from start to end of an axis along the whole axis (or directional

vector) length. However, it can be changed by specifying additional parameters.

The  Reverse button is available for all axis types. It allows to switch spiral's direction along axis.

For all axis types except Path this button switches between constructing a spiral from start to end

of an axis and in reverse; the start itself is not changed in this cases. For  Path this button not only

switches a direction, but also switches a start of a spiral between start and end points of an axis.

Start Point allows to manually define starting position of a spiral. If start point lays in axis's starting

plane (a plane normal to axis, passing through its first point), then spiral's start lays on a line normal to

spiral's axis going through start point. If start point doesn't lay in spiral's starting plane, the result

depends on the  For Angle Reference Only option. If  option is disabled (by default), then

spiral's starting plane is shifted to the start point and after that spiral's start is defined in a way

described above. If  option is enabled, then start point is projected to the starting plane. If start

point is not selected, then the system automatically selects an arbitrary starting point.

If start radius or diameter is disabled, then radius/diameter of a spiral is defined by the start point.

Start Angle - an angle of a spiral start's rotation around a spiral's axis. If Start Point is selected, angle

is laid off from said point, otherwise - from an arbitrary starting point automatically selected by the

system.

Accuracy - object are being approximated or considered coinciding within this tolerance.

Profile

One of the following profile orientations can be selected in the Profile group of parameters:

·  Parallel to Axis

The profile will remain parallel to axis along the whole spiral length.
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·  Perpendicular to Axis

The profile will remain perpendicular to axis along the whole spiral length.

·  Perpendicular to Path

The profile will remain perpendicular to screw curve along the whole spiral length.

Activate the Contour input box below to select objects defining a spiral profile in the 3D scene or in

the model tree. The  Reverse Profile button is located to the right side of the Contour input box. It

flips the profile by 180 degree about a fixing vector

Upon selecting a contour, it is necessary to select a First and Second Fixing Points defining a profile

fixing vector.

The input box for defining a Scale of a profile is located below fixing points input boxes. Scale can be

defined either by a constant value or by a graph depending on spiral's length along axis. To use a

graph click the  Create Graph button, which is located to the right side of parameter's input box.

Detailed information is available in the Using Graphs in 3D Operations section.

Screw curve parameters

A combination of parameters defining a spiral's screw curve can be selected in the Parameters group.

Following combinations are available:
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·  Length and Coils (default)

·  Length and Pitch

·  Pitch and Coils

Only two of three parameters (Length, Pitch and Coils) are available depending on the selected

combination. Third parameter is calculated automatically from values of two others. For  and 

 options the Length is defined by axis length by default. Enable the checkbox located to the left side

of the Length input box for applying a custom length value. All of the three parameters should have

values higher than zero.

When using the  option, the pitch can be defined either by a constant value or by a graph

depending on helix's length along axis. To use a graph click the  Create Graph button, which is

located to the right side of parameter's input box. Detailed information is available in the Using

Graphs in 3D Operations section.

Function value on the pitch's graph defines the number of coils for the corresponding length from the

spiral's start. 

Function on the pitch graph should be always increasing, otherwise the operation will throw an

error.

The default spline graph contains almost horizontal starting and ending sections, where function value

changes very slowly. This leads to creation of a spiral with starting and ending sections almost parallel

to the axis. 

Change spline's tangency parameters so, that function value change more rapidly, if you want to get

rid of spiral sections parallel to axis. The spiral shown below is the same spiral as the one shown

above; the only difference is the X_tan value for the first point of the graph.
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The Direction of Coiling parameter as well as the  Reverse Direction of Coiling button switch

direction of spiral between clockwise and counterclockwise. The button is not pressed by default and

the value is equal to zero. Pressing the button switches the value to one. Values can be also typed in

manually or defined using variables. Only positive whole numbers are allowed. Values higher than one

are considered same as one.

Radius/diameter

The Distance group of parameters allows to define change of spiral diameter/radius upon changing

of coil number. First you need to choose one of following distance calculation options:

·  Radius

·  Diameter

Either Start and End radius or Start and End Diameter input boxes become available depending on

the selected option. Enable a checkbox located to the left side of a corresponding input box to apply

a parameter. If Start Radius/Diameter is disabled, it is necessary to select a Start Point, so that spiral's

radius/diameter will be defined by a start point's position. Then you will still be able to define the End

Radius/Diameter if necessary.

If neither Start radius/diameter nor Start Point are defined, the operation throws an error.

By default, radius/diameter changes linearly from starting to ending value along the spiral's axis.

Alternatively, Radius/Diameter of a spiral can be defined by a graph depending on spiral's length

along axis. This can be done by enabling only the Start Radius/Diameter checkbox and clicking the 

 Create Graph button, which is located to the right side of parameter's input box. Detailed information

is available in the Using Graphs in 3D Operations section.

Start and end of a graph may expand beyond a spiral's length. The only limitation is that a graph

should be defined along the whole spiral's length, otherwise the operation will throw an error.
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On Polyline graph only two points are allowed - starting and ending. Otherwise the operation

will throw an error

See also:

· Main Concepts of Spiral along Axis

· Using created body in Boolean operation 

· Common options for solid 3D modeling operations

· Preview of Operation Result 

· Common Parameters of 3D Elements

Main Concepts of Spiral along Axis

Spiral axis

The helical curve used for sweeping the profile is centered about the spiral axis. Axis can be either

straight or curved.

Straight axis can be defined defined by two 3D points: the start point and the end point. 3D points can

be defined by 3D nodes, as well as by any 3D objects suitable for defining a point in the space. The

vector defining the spiral axis will be directed from the first point to the second one (this also defines

the start and the end of the spiral, respectively). Alternatively, straight axis can be defined by point

and direction or selected directly.



Solid Body

1717

1 - First point of axis

2 - Second point of axis

3 - Spiral axis

4 - Screw curve

5 - Spiral profile

Curved axis can be defined by 3D paths, 3D profiles, loops, edges. Multiple selection is also

acceptable if selected object form a tangency continuous contour. Contour could be either open or

closed.  

Selecting a closed axis yields a closed spiral by default.

There are limitations applied to constructing a closed spiral. Radius/diameter and profile scale

should have same values in the end and in the start of the screw curve. X_tan parameter values in

the starting and ending points of the pitch graph should be higher than zero.
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Closed spiral constructed using a pitch graph

Manually apply the desired length, if you need to create an open spiral by a closed axis. Limitations

mentioned above are not applicable to open spiral created by closed axes.

Spiral screw curve parameters

Screw curve of a spiral has following main parameters:

· Radius/diameter

A cylindrical spiral (i.e. the one with constant radius/diameter along the whole length) is

created by default. It is possible to set different values for starting and ending

radius/diameter. Then it will change linearly from start to end value along the helix length.

Another option is to use graph of dependency between radius and length.

· Start angle and start point

Define the initial point of screw curve (see below).

· Direction of coiling

The clockwise direction (when looking along the spiral's axis) is applied by default. It can be

switched to counterclockwise if necessary.

· Pitch, length and number of coils

The helix can be defined using one of the following parameters combination: Length and
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Coils, Length and Pitch, Pitch and Coils. 

The third parameter is calculated automatically from the values of two others. By default, an

axis's length is used as a spiral's length. It can be changed to a custom value if necessary. 

When using the Length and Pitch combination, the pitch can be defined either by a constant

value or by a graph in dependency to length.

Length of screw curve is defined by distance

between 3D nodes that define axis (additionally, 

pitch is defined)

Length of screw curve is defined by pitch value

and number of coils (n=4)

Initial point of spiral's screw curve

By default, the initial point of the screw curve is chosen arbitrarily by the system. It can be changed by

setting the desired position using an additional 3D point - the start point. Additionally, you can

specify the numerical value of the start angle of the screw curve's initial point rotation.

1 - Axis

2 - Default initial point of screw curve 

When you specify the start point, the initial point of the screw curve will move along the specified

initial radius to the plane that passes through the selected point and the axis of the spiral.
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1 - Selected start point

2 - Plane passing through axis and start point

3 - Initial point of screw curve

When simultaneously setting the start point and the numerical value of the start angle, the angle is

measured from the plane, passing through spiral's axis and the start point.

Initial point of screw curve is defined by numerical value

of start angle (30°) without selecting start point

Initial point of screw curve is defined by start point and

numerical value of start angle (30°)

Using start point for defining radius/diameter

Selecting a start point and disabling the start radius/diameter's checkbox links screw curve's

radius/diameter to the start point's position.
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Radius/diameter of screw curve is defined by start point

Spiral profile and its orientation in the space 

3D profile, 3D path, face, loop, edge or sequence of edges can be selected as a spiral profile.

Selecting a closed contour results in creating a solid, selecting an open contour results in creating a

surface.

Spiral based on closed profile Spiral based on open profile

The profile position in the space is defined by a fixing vector. The spiral fixing vector is defined by two

3D points fixing the profile. The profile fixing vector will be directed from the first 3D point to the

second one. If the profile is defined by 2D constructions, the profile fixing vector can be defined by

two 2D points in the profile plane.

Once the spiral is created, the first point of the profile fixing vector is snapped to the end point of the

radius vector at the spiral start. The direction of the fixing vector coincides with the radius vector.
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1 - Radius-vector

2 - Spiral profile

3 - Original profile

4 - First fixing point

5 - Second fixing point

6 - Profile fixing vector

After that, the profile is rotated about the fixing vector to achieve one of the following orientations:

perpendicular to the screw curve, perpendicular to the axis or parallel to the axis.
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Perpendicular to screw curve  Perpendicular to spiral axis Parallel to spiral axis

It is possible to flip the profile of the spiral about the radius vector by 180 degree.

        

Scaling of spiral profile

The selected profile is used in its original from by default. You can apply a Scale to it if necessary.

Scale can be defined by a constant value or by a graph in dependency to the spiral length. For

instance, using a scale graph allows to create a thread run-out representation. 

Scale value should be higher than zero, otherwise the operation will throw an error.



T-FLEX CAD 17 Help

1724

Flat Spiral

Spirals of this type can be created using the following option in the Spiral command:

Flat

Following steps should be done to create a flat spiral:

1. Choose axis type

2. Define spiral axis.

3. Define start point and/or start angle (optional).

4. Select profile.

5. Select first and second fixing points.

6. Choose profile orientation (optional).

7. Define profile scale (optional).

8. Define pitch, number and direction of coils of a screw curve (optional).

9. Define radius or diameter of a spiral (optional).

10. Confirm the operation .

Axis, Start Point, Start Angle

Axis of a flat helix 3D path defines normal direction and position of a helix's support plane. 

Following Axis Types are available:
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·  Two points

First Point defines plane's position, Second Point - normal direction.

·  Axis

Spiral's support plane is located in the axis's starting point. 

· Point and Direction

First Point defines plane's position, Direction - normal direction.

Depending on the selected axis type, some of the following input boxes appear: First Point, Second

Point, Axis, Direction. Activating the desired input box allows to select in the 3D scene a

corresponding object defining a spiral axis.

Start Point allows to manually define starting position of a spiral. If start point lays in axis's starting

plane (a plane normal to axis, passing through its first point), then spiral's start lays on a line normal to

spiral's axis going through start point. If start point doesn't lay in spiral's starting plane, the result

depends on the  For Angle Reference Only option. If  option is disabled (by default), then

spiral's starting plane is shifted to the start point and after that spiral's start is defined in a way

described above. If  option is enabled, then start point is projected to the starting plane. If start

point is not selected, then the system automatically selects an arbitrary starting point.

Start Angle - an angle of a spiral start's rotation around a spiral's axis. If Start Point is selected, angle

is laid off from said point, otherwise - from an arbitrary starting point automatically selected by the

system.

Accuracy - object are being approximated or considered coinciding within this tolerance.

Profile

One of the following profile orientations can be selected in the Profile group of parameters:

·  Parallel to Axis

The profile will remain parallel to axis along the whole spiral length.

·  Perpendicular to Axis

The profile will remain perpendicular to axis along the whole spiral length.

·  Perpendicular to Path

The profile will remain perpendicular to screw curve along the whole spiral length.
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Activate the Contour input box below to select objects defining a spiral profile in the 3D scene or in

the model tree. The  Reverse Profile button is located to the right side of the Contour input box. It

flips the profile by 180 degree about a fixing vector

Upon selecting a contour, it is necessary to select a First and Second Fixing Points defining a profile

fixing vector.

The input box for defining a Scale of a profile is located below fixing points input boxes.

Screw curve parameters

Pitch and number of Coils may be specified in the Parameters group. Both parameters should have

value higher than zero. 

The Direction of Coiling parameter as well as the  Reverse Direction of Coiling button switch

direction of a spiral between clockwise and counterclockwise. The button is not pressed by default

and the value is equal to zero. Pressing the button switches the value to one. Values can be also typed

in manually or defined using variables. Only positive whole numbers are allowed. Values higher than

one are considered same as one.

Radius/diameter

The Distance group of parameters allows to define change of spiral diameter/radius upon changing

of coil number. First you need to choose one of following distance calculation options:

·  Radius

·  Diameter

Either Start and End radius or Start and End Diameter input boxes become available depending on

the selected option. Enable a checkbox located to the left side of a corresponding input box to apply

a parameter.

Applying Start and End diameter/radius simultaneously makes Pitch input box non-editable, because

in this case pitch is calculated automatically depending on diameters/radii and number of coils.

See also:

· Using created body in Boolean operation 

· Common options for solid 3D modeling operations

· Preview of Operation Result 

· Common Parameters of 3D Elements
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Edit Spiral

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3ESR> Edit > Operations > Spiral

This command is used for editing Spiral.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Spiral command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).
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Face Taper

Calling the command:

Icon Ribbon

3D Model > Advanced > Taper > Face Taper

Keyboard Textual Menu

<3TA> Operation > Taper > Face Taper

This operation allows the user to taper one or several selected faces at a specified angle, with

automatic correction of the adjacent faces.

Face taper can be used, for example, for designing parts manufactured by casting method under

pressure. Addition of tapers to the part enables easy extraction of the part from the mold.

Methods of Creating Taper

The operation provides various methods of shaping up the tapered face:

· Standard;

· By offset;

· By curve;

· By surface.

The taper forming method is selected from the drop-down list of the Method parameter.

By offset taper formation method can be set automatically when the offset face selection option is

enabled.

By default, a standard method for creating tapers is used. It allows you to construct the tapered

surface exactly matching the shape of the original surface and a specified taper angle.

In several cases, the standard method does not allow you to create a required taper. In these cases it is

possible to use methods By curve and By surface. These types of taper match the shape of the

original tapered face in a less stringent manner which permits you to construct the taper in cases when

the standard method of taper creation does not work. Methods By curve and By surface differ by the

method of resolving ambiguity upon creating the tapered surface. In the first case, for constructing a

taper, a tangent to the curve of the fixed edge is utilized, in the second case – the normal to the

tapered surface. The tapers By curve and By surface are usually used for giving a part more aesthetic

shape.

In many cases the methods By curve and By surface give similar outcome. For example, in the

example on the figure below, the difference between these methods is noticeable only upon repeated

use of the taper operation.
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Creating Face Taper

After invoking the command for creating a taper (except a step taper and a taper by an offset) it is

required:

1. Indicate taper direction;

2. Specify a required number of pairs fixed line/tapered face; 

3. Specify taper angle (or a set of taper angles when tapering several faces);

4. Select method of tapering (if necessary);

5. If required, specify additional parameters (the way of filling the juncture between the tapered and

non-tapered faces; between the faces tapered at different angles);

6. Complete operation creation with the help of .

In the operation parameters dialog, called by the  option, you can set common parameters of 3D

elements.

Topics in this section:

· Direction, Fixed and Tapered Elements of Face Taper

· Value of Face Taper

· Processing of Junctures in Face Taper

· Step Tapering in Face Taper

· Edit Face Taper

· Additional Features of Face Taper

Direction, Fixed and Tapered Elements of Face Taper

Taper Direction

The direction, in which the taper (slant) angle of the faces is counted, is determined by a vector. This

vector can be defined in two ways.

· The first way requires selecting an object, whose geometry will determine the taper direction:

a normal to a face, a flat edge, etc.

· Alternatively, the vector can be defined by two 3D points. The second 3D point defines the

vector direction.
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When designing parts made by parts made by molding, it is necessary to specify the direction of the

taper along the direction of the mold separation.

Specifying taper direction

For specifying a taper direction by one 3D object, the following option is used:

<D> Select tapering direction

This option allows selecting objects in the scene, whose geometry is suitable for defining the taper

direction vector. Once an object is selected, its name appears in the parameters window.

For defining a taper direction by two 3D points, the following options are used:

<1> Select first point of tapering direction

<2> Select second point of tapering direction

The selected elements are also entered in the parameters window. The taper direction is marked by a

vector in the 3D scene.

To cancel the direction selection, use the option:

<X> Cancel direction selection

Fixed Edge/Fixed Taper Face

For each tapered face, it is required to specify a fixed edge or a face. 

A fixed edge defines a fixed taper line – a line, lying on a tapered face, which does not change its

position when creating a taper. Construction of a taper surface takes place with respect to a fixed line.

A fixed edge must belong to the same body as a tapered face.
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Instead of an edge, it is possible to indicate a fixed face. Intersection of the selected face with the

tapered face defines a fixed taper line.

Unlike the fixed edge, the fixed face can be selected on a different body. Once the fixed face is

selected, the command creates the plane based on that face, and projects it to the intersection with

the face to taper. The intersection line between this line and the face being tapered is the fixed line

about which the face tapering will occur.

A fixed face can be adjacent to the tapered face. In this case the common edge will be a fixed edge

with respect to which the face will be tapered.

Fixed edges and fixed faces are defined separately for each tapered face.

Instead of collection of fixed edges, it is possible to specify one workplane. It will define a fixed line

for all tapered faces of the current operation at once. A fixed line of each tapered face will be defined

as an intersection of selected workplane with the given face.
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Specifying Fixed Object and Tapered Face

After defining a taper direction, the command will prompt you to define a fixed line of the first

tapered face. The following automenu options are used for that:

<T> Select fixed Face

<E> Select fixed Edge

<W> Select Workplane

After selecting the respective element, it will be added to the list Fixed/Tapered of the command’s

parameters window.

Then the system will prompt you to select a tapered face. The following option will become active in

the automenu:

<F> Select faces to be tapered

Selected tapered face is also added to the list Fixed/Tapered next to the corresponding to it fixed

object.

A fixed line (edge, face, workplane) and a tapered face are specified in pairs. Each tapered face

must correspond to a fixed object, and vice versa.

Further action of the command depends on the type of the selected fixed object. If it was a fixed

edge, then the system will prompt you to select the next fixed edge. If it was a face or a workplane,

the system will wait for specification of one more tapered face. Selected earlier face/plane will be, by

default, considered as a fixed object for all subsequently selected tapered faces. To select another

fixed object, it is necessary to manually activate the corresponding option (  or ), select a

desired object (face or edge), and then specify a tapered face.
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Note that in the framework of a single operation, it is possible to specify only one workplane – it

will become a fixed object for all tapered faces.

For creating the taper of all faces adjacent to a single fixed edge, it is sufficient, after selection of the

fixed edge, turn on the following automenu option:

<A> Select all adjacent faces for tapering

All faces adjacent to a specified fixed face will be automatically selected as tapered.

To modify already selected fixed objects or tapered faces, it is necessary to select a desired pair in the

list Fixed /Tapered, turn on the option of selecting a desired object ( ,  or ) and select an

object again.

It is possible to delete a specified pair fixed object/tapered face by selecting them in a list, pressing

key <Del>.

It is also possible to cancel selection of the workplane with the help of the option:

<X> Cancel workplane selection

Value of Face Taper

Calculating taper angle

Taper angle of face can be evaluated according to the following algorithm:

· A normal to the face to taper is constructed at each point of the fixed edge.

· The taper direction vector is translated to that point.

· Based on those two vectors, a plane is constructed, in which the taper angle will be counted.

· Next, the vector is determined, that sets the zero taper angle.

The taper angle is counted from the formerly described vector in the plane. This angle defines the

resulting vector, through which the surface of the tapered face will be passing.
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Setting taper angle

The taper angle is defined by a numerical value in the operation parameters. It can be common across

the whole set of pairs of fixed objects and tapered faces, or be defined individually for each pair. By

default, the common angle is used.

If for a certain pair fixed object/tapered face, it is desired to define a value of the angle different from

the common, it is necessary to perform the following steps:

· In the parameters window, click the desired pair of the fixed and tapered objects.

· Clear the check mark on the option Common Angle.

· Specify the angle value for the selected pair.

The command provides draggers for easy setting of the face taper angles. By using the draggers, you

can dynamically modify the taper angle value.

In certain cases the draggers may not be displayed.

A dragger for defining face taper angles appears as two vectors connected by an arc. Both vectors

originate from the fixed object (a face or an edge). The direction of the first vector coincides with the

taper direction. The direction of the second vector defines the resulting position of the tapered face.

The taper angle is set by dragging the tip of the second vector.

A separate dragger is provided for each pair fixed object/tapered face in the 3D scene. If a common

angle is used for all pairs fixed object/tapered face, then you can modify the taper angle by any of the

draggers. If the “Common angle” option is turned off for any of the pairs, then the dragger position

will affect the angle of this pair only.
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To change the face taper direction, either enter a negative angle value or push the  button in the

face taper parameters dialog.

Creating Taper by Offset

For creating face taper by offset it is required:

1. Specify a taper direction;

2. Indicate a fixed taper line;

3. Indicate a tapered face or a collection of faces;

4. Select a face in the plane of which the offset will be created;

5. Specify the offset of the tapered face;

6. If necessary, define additional parameters (the method of filling the junctures between the tapered

and non-tapered faces, between faces tapered at different angles, etc.);

7. Complete operation creation with the help of .

Taper direction, fixed taper line and tapered face are specified in the same way as for the standard

taper. For specifying the face in the plane of which the offset will be created, it is necessary to turn on

the following automenu option:

<O> Select Face for creating taper by offset

The name of the selected face will be displayed in the command’s parameters window (the field

Offset face). The offset is specified as a numeric value of the parameter Offset.

When specifying the face for defining the offset, the parameter Method is automatically assigned to

the value Taper by offset.
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Processing of Junctures of Face Taper

Processing of Junctures between Tapered and Adjacent to Them Faces

When creating a taper, there is a possibility of creating a gap between the tapered and adjacent to

them non-tapered faces. To process these gaps, it is possible to use two methods:

· Creating auxiliary flat faces;

· Extending the surface of the non-tapered face.

The first way implies creation of an additional flat face for patching the gap at the connection. The

second way allows preserving transition between those faces. In this way, a portion of the tapered face

will be trimmed by the surface created by extending the adjacent face.

In some cases, creation of the additional face is the only possible way of closing the gap at the faces

connection. This exact case is shown on the right-hand diagram.

Processing of Junctures between Tapered Faces

When the adjacent faces are tapered at different angles, a gap can be created between them. For

correcting this situation, it is possible to use the following methods:

· Creating additional flat faces;

· Extending the surface of non-tapered face;

· Preserving smooth connection.
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Processing connection between faces

You can select a method for connecting the tapered face and its adjacent faces, using the parameter

“Faces Connection/Tapered and Non-tapered” in the parameters window.

Similarly, you can select a method for connecting the tapered faces.

Processing faces together

For combined processing of two adjacent faces, it is required to select one of them as a fixed face for

another, and turn on the flag Multiple in the dialog of the command’s properties. 

In the same way, it is possible to create a taper for three and more faces.

Step Tapering of Face Taper

For creating step tapering, the user specifies:

1. Taper direction;

2. Fixed face or workplane;

3. Tapered face;

4. A continuous sequence of edges, lying on the tapered face, whose geometry must be preserved

upon taper creation. All edges of the specified sequence must be non parallel to the taper

direction.

For adding the edge to the tapered face, the command Imprint Elements can be used.

As a result, the tapered face “turns around” relative to the fixed face/workplane. Along the line

generated by a specified sequence of edges, a “step” is formed. Additional faces forming the “step”,

can be created by two methods: perpendicular to the original face or at a specified taper angle.
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When creating a step tapering, it is possible to create a two-sided “step”.

A step tapering can be created simultaneously on several faces of the body.

Creating Step Tapering

For creating step tapering of faces it is necessary:

1. Specify taper direction; 

2. Specify a fixed taper line;

3. Specify a tapered face or a collection of faces;

4. Specify a sequence of edges on the tapered face; 

5. Specify taper angle (or a set of taper angles in case of selecting several tapered faces);

6. Specify the method of creating additional faces (by normal or with a taper);

7. Complete creation of operation with the help of .

Taper direction, fixed taper line and a tapered face are specified in the same way as for the standard

taper.

For specifying the edges of a step taper, it is necessary to turn on the option:
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<G> Step tapering

When activating this option, the command switches to the mode of selection of edges, with respect to

which the step taper will be formed.

Selected edges of the step taper will be added to the corresponding list of the command’s

parameters window. The user can remove selected edge by selecting it in the list and pressing the

button Delete.

The method of creating additional edges forming the “step” is selected with the help of the list Edges

of step taper. If the value Normal is chosen, the edges will be formed perpendicular to the original

face. For the value Tapered the faces will be formed at a specified taper angle.

Edit Face Taper

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3ETA> Edit > Operations > Face Taper

This command is used for editing Face Taper.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command
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<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the Face Taper command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Additional Features of Face Taper

Taper of Face Relative to Multiple Fixed Faces/Edges

The operation allows tapering the selected face relative to multiple fixed faces or edges. As a result of

such operation, the tapered face will be split into two parts. The edges of the resulting faces will have

the specified taper angle.

Tapering All Adjacent Faces

The mode of tapering all faces adjacent to the fixed one is provided for quick taper creation. In this

case, all you need is just to select the fixed face. The command will automatically determine all

adjacent faces for tapering. 



Solid Body

1741

Combined Processing of Adjacent Faces

The mode of combined processing of adjacent faces allows the user to create a simultaneous taper

for a pair of adjacent faces, when one of the tapered faces serves as a fixed face for another. In a

standard mode, an attempt to create such a taper will lead to an error. 

On the figure below an example is shown in which it is desired to simultaneously taper two faces:

“Face 1” and “Face 2”. For the face “Face 1”, the edge “Edge 1” is selected as a fixed edge. For the

“Face 2” a fixed line has to be defined by the face “Face 1” or the edge “Edge 2”. But both “Face 1”

and “Edge 2” will be modified upon taper creation. In this situation, the mode of combined

processing of faces can help. By turning it on and indicating “Face 1” as a fixed object for the face

“Face 2”, the user can obtain a correct taper of two faces at the same time.

            

Splitting Faces

This parameter is used in cases when it is necessary to create a taper of the curvilinear face. The

command splits the face into patches defining the position for which it is possible to create a taper

surface. The tapered patches will pass tangentially to the remaining curvilinear part of the face at a

specified angle to the taper direction.
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For creating the taper with face splitting, the user has to specify a

face which is to be split as a fixed face (a tapered face in this case is not specified) and activate the

flag Split Faces.

Note that the functionality of splitting faces remains in the command for compatibility with

earlier versions of T-FLEX CAD. The currently available Imprint Elements command provides

various ways of dividing a curvilinear face into pieces for further tapering.

Taper by offset

The method of specifying the taper “by offset” allows the user to determine the magnitude of a taper

not by an angle but by an offset of the tapered face with respect to the initial position.

The algorithm of creating the taper “by offset” method is as follows: 

· A fixed face or edge is mapped along the taper direction on the plane selected for defining

the face offset.

· A specified-distance offset from the mapped face or edge is constructed. In this case, the

taper parameter is the offset distance. 

· The resulting surface will be passing through the offset off the fixed edge’s mapped image.
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3D Fragment Supplement Mode

<Num0> 3D fragment supplement mode

The option automatically becomes available in the command's automenu when selecting elements on

a fragment in an assembly.

Body Taper

Calling the command:

Icon Ribbon

3D Model > Advanced > Taper > Body Taper

Keyboard Textual Menu

<3TB> Operation > Taper > Body Taper

Body taper operation allows the user to create two-sided tapers of faces of a body relative to a

specified taper direction and a parting body. A parting body divides the original body into two parts:

“top” and “bottom”, which are tapered with respect to each other. A sheet body is usually specified as

a parting body, but solid bodies can be used as well.

For “top” and “bottom” tapers, the operation enables specifying different taper angles. If necessary, it

is possible to specify only “top” or “bottom” angle, that is, create a one-sided taper of a body.

The use of body taper operation allows the user to significantly simplify the process of designing cast

parts and their molds. The parting body corresponds to the surface of separation, and the taper

direction - to the direction of the mold separation.
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Body taper creation

To create a body taper, do the following steps:

1. Select the source body.

2. Select the parting body.

3. Define the taper direction.

4. Select the top set of edges.

5. Select the bottom set of edges (required for the two-sided taper).

6. Define the top and bottom taper angles.

7. Define additional parameters of a taper (the method of creating a taper, the method of processing

connections between tapered faces, an corner connection, etc.);

8. Complete operation creation with the help of .

Topics in this section:

· Main Concepts of Body Taper

· Create Body Taper

· Additional Parameters of Body Taper

· Defining Additional Parameters of Body Taper

· Edit Body Taper

Main Concepts of Body Taper

For creating a body taper, first of all it is necessary to indicate a tapered body itself, a parting body,

the sets of “top” and “bottom” fixed edges of the tapered body, taper direction and angle.

Taper Direction

Taper direction is an oriented in space vector, relative to which the taper angles of the faces will be

measured.

Taper direction vector can be defined by two methods:

· by one 3D object whose geometry can define a vector;

· by two 3D points defining the start and end points of a vector.

Parting Body

A parting body is used for dividing the original body into two parts, each of which can be tapered

individually. When tapering faces at both sides from the parting body, a two-sided taper is created.

When tapering faces located at one side from the parting body, a one-sided taper is created.

Both sheet and solid bodies can be used as a parting body. In most cases, a sheet body is used as a

parting body. After executing the operation, a parting body is remained in the 3D scene.

The parting body may not have through holes. Additionally, the parting body must be large enough to

fully intersect the target body in the taper direction. 
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If a solid was selected as the parting body, then use of the “Body Taper” operation will result in one

body obtained by merging the tapered and the parting body.

The source body itself can be used as the parting body. On the figure below, an isoclinal line of the

faces of the original body was selected as the source edges for creating the taper. The original body

itself serves as the parting body.

      

Fixed Edges/Faces

For creating two-sided tapers of a body it is required to specify two sets of edges: “top” edges and

“bottom” edges.

The so-called “top” and “bottom” sets of base edges are respectively those located above and below

the "parting body", with respect to the taper direction. The edges define the faces for which a taper

needs to be created, and also define the fixed lines of these faces.
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It is possible to select only one set of fixed edges (“top” or “bottom”). In this case, a one-sided taper

will be created.

Instead of source edges, the user can specify the source faces themselves. For example, when creating

a body taper, it might be impossible to select base edges of the “top” and “bottom” sets. Those edges

might either not exist, or have the geometry that would not allow creating a body taper. In this case,

for creating a taper the user indicates the sets of source faces based on which the virtual edges for

constructing the body taper are defined. If, for example, a face was selected as “top”, then the

command will automatically find the uppermost point on this face with respect to the taper direction.

A virtual edge is defined at this point, passing tangentially to the edge of the selected face and

perpendicular to the taper direction vector.

Taper Angle

Taper angle is specified separately for the “top” and “bottom” set of edges, i.e. for the “top and

“bottom” faces. Within each set, all faces will have identical taper angle.

Create Body Taper

Selecting source body

The default mode of selecting the source body is activated automatically upon entering the Body

Taper operation:
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<S> Select source body 

This source body can be selected either in the scene or in the 3D model tree. After selecting the source

body, the parameters window will display the respective operation of the source body.

Selecting parting body

Upon selecting the source body, the system proceeds to the mode of selecting the parting body. To

enable selection of a solid or sheet as a parting body, the following options are provided in the

command automenu:

<A> Select parting body

<H> Select parting sheet body

When using one of those options for selecting the parting body, the selector is tuned up accordingly.

For example, in the sheet body selection mode, the following parting objects can be selected: a face,

a 3D profile, an operation-surface. Moreover, filters for choosing the objects can be also customized

with the help of the filter toolbar.

In the solid body selection mode, only objects with solid geometry can be selected for parting.

The name of the object used as the separating body is displayed in the Parameters window.

Defining taper direction

The next step in the operation creation is selecting an element defining the taper direction. This can

be done by the option:

<D> Set tapering direction

As common across other operations, the option for selecting the taper direction allows selection of

various 3D elements capable of defining a directional vector. The direction-defining object is

displayed in the parameters window.

To change the taper direction to the opposite, check the parameter “Reverse Direction”.

Alternatively, the taper direction can be defined by two 3D points. The following options are provided

for this purpose:

<1> Select first point of tapering direction
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<2> Select second point of tapering direction

Selected elements are displayed in the Parameters window.

To cancel the direction selection, use the option:

<K> Cancel direction selection

Selecting fixed edges

Selection of the set of edges is done directly in the 3D window. To create a one-sided taper, select

just the top set of edges. For the two-sided taper, additionally select the bottom set of edges. To do

this, use the following options:

<T> Select top edges

<B> Select bottom edges

Each selected edge will be added to the list of edges in the parameters window. Switching between

selecting the top and bottom sets of edges can be done either by the automenu options or by clicking

the respective tabs in the parameters window dialog. To remove an edge from the list, select it in the

list, and then press the [Delete] button or <Del> key.

Options  and  can be used in combination with the mode of selecting a sequence of

smoothly connected edges, which can be activated by the option:

<G> Smooth edge chain selection mode

Let us define a sequence of smoothly connected edges as a set of edges forming closed or non-

closed continuous curve which does not have sharp turns (the first derivative is continuous).

When using the given mode, all edges capable of making a smooth sequence with the chosen edge

are automatically picked.

To cancel selection of all edges, use the following option:
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<R> Cancel selection of all edges

Selecting non-fixed faces

The following options are provided for selecting bottom and top faces:

<U> Select top faces

<O> Select bottom faces

You can activate selection of top or bottom faces by clicking an empty line on the respective tabs of

the Top and Bottom Faces section in the parameters window. Selection of faces, just like edges, is

done in the 3D window. The selected faces will be added to the list of faces in the parameters

window. To remove a face from the list, select it in the list, and then press the Delete button or <Del>

key.

To cancel selection of all faces, use the option:

<Z> Cancel selection of all faces

Defining taper angles

The command allows defining taper angles for the top and bottom faces of the source body. The

angles can be defined by specifying values in the Parameters window.

To modify taper angle values, you can also use draggers. Once the edges are defined, with respect to

which the body taper will be constructed, the draggers appear in the 3D window for modifying the

angles. Those draggers work the same way as the draggers defining taper angles in the command

Face Taper.
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At this stage, the option becomes available in the automenu:

<Y> Finish input

In the operation parameters dialog, called by the  option, you can set common parameters of 3D

elements.

Additional Parameters of Body Taper

Corner Connection

As a result of performing a two-sided taper, along the line separating the tapered faces of the body, a

gap-step can be created due to non-uniform displacement of the “top” and “bottom” faces. It is

possible to avoid creation of this step by using the mode of corner connection. 

When creating an corner connection, the system automatically adjusts the displacements of the “top”

and “bottom” tapered faces in such a way that they have a common edge (on the parting body).

Correction of displacements is always carried out by adding material.

An corner connection can be created only upon constructing a two-sided taper with the sheet parting

body.
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Creating the corner connection can be performed by one of the following methods:

·  “From edge” – the material is added from the edge determining the given face. The

boundaries of the corrected face will include the source edge specified for this face (or a part

of the edge);

· “Tangent to face” – the material is added in such a way that the corrected surface becomes

tangent to the adjacent faces (where it is possible). Simultaneously, the original edges may be

deleted and replaced with the new edges created on the basis of the line of intersection of the

corrected face and adjacent face;
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· Combination of first two aforementioned methods – depending on the geometry of the

resulting body, the system itself selects the method of creating the corner connection for each

tapered face needing the correction. Priority is given to the method “From edge”. If, for some

face, this method cannot be used, another method “Tangent to face” is employed.

On the figure below, an example of creating an corner connection with the use of combination of two

methods is shown. The “top” set of taper edges is non-closed, and it is impossible to employ the

method “From edge” for the lateral cylindrical face. Thus, for creating a corner connection on the

lateral faces of the tapered body, the method “Tangent to face” was used. On the end faces, the

correction is carried out by the method “From edge”.

By default, in the mode of corner connection, the system adjusts the displacements of all tapered

faces. If necessary, it is possible to suppress the displacement correction for any of the tapered faces.
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Taper creation method

The following methods of creating the body taper exist in the command:

· Standard – allows constructing the taper surface exactly matching the form of the source

surface and a specified taper angle.

· By curve, By surface – matches the form of the source tapered faces in a less stringent

manner, which allows constructing the taper in cases when the standard taper construction

method does not work.

These algorithms are described in more detail in chapter Face Taper.

By default, the standard taper creation method is used in the operation. If necessary, it is possible to

apply another method of tapering to the entire tapered body as well as to each tapered face

individually.

Concave Edge Correction

In some cases while creating the taper with the corner connection, concave angles are created on the

body, which can interfere with successful creation of taper operation.

       

To avoid such a situation various methods of processing the concave angles exist in the operation:
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· No correction – created concave angles remain unchanged;

· Cylindrical surface – concave angles are “covered” with a surface of cylindrical type.

Simultaneously, in the plane of a parting body the projection of the concave angle is replaced

with the circular arc of specified radius.

· Mixed surface – the concave angles are “covered” with the surface of mixed type. In the plane

of a parting body, the projection of an angle is replaced with a circular arc of a given radius

and lines tangent to the surface of the tapered body.

       

Processing Connections of Tapered Faces

When creating a taper, the command provides options for selecting a method of processing

connections between tapered faces. Two processing methods are available:

· Extend surfaces – in this case, the adjacent tapered faces will be extended to achieve an

intersection.

· Create plane – in this method, a flat face will be created between two adjacent tapered faces.
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Edge Replacement

In some cases, keeping the shape of edges defined as fixed leads to creation of redundant faces on

the tapered body. To improve results of the operation, the user can allow replacement of certain

“fixed” edges. Use of edge replacement guards in some cases from creation of extra tapered faces.

The replacement edges are created in such away as to make a single slanted face.

Taper with Undercut

In some cases, creation of a taper requires not the addition but the removal of the material of a

tapered body. In this situation, it is necessary to use the option of creating an undercut. Otherwise,

creation of a taper will be impossible.
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Defining Additional Parameters of Body Taper

Selecting Method of taper creation

The method of creating a taper is determined by the value of the parameter Method. To change the

value of this parameter, a drop down list is used. The standard method is used by default.

For all selected fixed taper edges the flag Common method is set by default. This means that the

value of the parameter Method is unique for all selected fixed taper edges. When changing the value

of this parameter, the taper creation method is changed for all tapered faces.

To specify for some tapered face another tapering method (different from the one specified for the

rest of the body) it is required: from the list of edges to select the edge corresponding to the given

face, turn off the flag “Common method”, and with the help of parameter Method specify the

required taper method.

Creating corner connection

Parameter Miter controls creation of corner connection. By default, it is assigned the value No, which

signifies that the corner connection is not created. 

In order to create a corner connection, the user needs to select one of the following values: From

Edge, Tangent to Face, or Both from the drop down list. Difference between these three options was

described above.
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A corner connection can be created only upon constructing a two-sided taper with the sheet

parting body.

By default, the corner connection is created for all tapered faces of the body. To exclude any of the

faces from the corner connection, the user needs to select the edge corresponding to the given face

from the list, and, for the selected edge, take off the flag Miter.

  

Selecting Method of Correcting Concave Angles

Parameter Concave is responsible for correcting concave angles arising upon creation of a taper with

a corner connection. By default, this parameter is assigned the value No, which means that concave

angles remain intact.

For automatic correction of concave angles it is required to select another value from the drop down

list:

· Radius – a concave angle is covered with a surface of cylindrical type. In addition, the radius of

the surface must be specified in the parameter Radius;

· Mixed Surface – a concave angle is covered with a surface of mixed type. The radius of

cylindrical segment of the surface is specified with the help of the parameter Radius.

Controlling Edge Replacement

The flag Replace Edge controls the capability of replacing fixed edges upon creation of taper. By

default, replacement of all selected taper edges is suppressed (flag is turned off for all edges).

To permit replacement of any of the edges, the user should select it in the list of edges and set the

flag Replace Edge.
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Closing gaps between adjacent faces

The method of processing the connection between tapered faces is selected with the help of

parameter “Corner”.

Specifying Undercut

The mode of creating an undercut is activated with the help of the flag Undercut. By default, this flag

is turned off.

Keep source body

The operation of creating the body taper allows the user to keep the source body in the 3D scene. For

that, it is sufficient to set the flag Keep Source Body.
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Edit Body Taper

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3ETB> Edit > Operations > Face Taper

This command is used for editing Body Taper.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Deformation

The deformation operations allow a user to perform modification of solid and sheet bodies by various

means: skewing, bending, scaling/twisting etc.

When creating deformation operations, a function producing volume deformation of the given body

is formed in the model on the basis of parameters specified by the user. This function can be defined

over the entire volume of the given body or only its part. Applying this function in a continuous

manner deforms the entire volume of this body (or its part). Topology of the deformed part of the

body does not change. The number of faces, edges, vertices, etc. remains the same. If necessary, faces
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and edges of special type (planes, segments, cylinders, arcs of circles etc.) are automatically replaced

with spline surfaces and curves.

Commands of deformation can be applied to both solid and sheet bodies (surfaces).

Tolerance

Just like some other T-FLEX CAD commands for working with complex geometrical shapes, each

deformation command has the Tolerance parameter, which defines the tolerance of the deformation

function calculations. It is measured in meters.

Options in Deformation Operations

In the process of specifying/editing parameters of deformation, the future result of the current

operation is dynamically shown in the 3D window. For speeding up the work, the dynamic preview can

be turned off by disabling the Dynamic Preview checkbox in the command's parameters window.

An additional Mesh Density parameter controls accuracy of the mesh used for visualization of the

result of the deformation. The increase in the mesh density leads to slower regeneration of the bodies

in the scene but increases accuracy of the drawing.

Keep in mind, that sometimes the dynamic preview might display shape different from the

actual operation result. Use the Preview of the operation result  in such cases.

If you disable option Mark body, the body is no longer highlighted in the scene, which simplifies

visual perception of the deformed object.

Mark body enabled Mark body disabled

The Live update option allows to watch deformations of the body in real time. Deactivating the

option accelerates recalculation because solid body updating is not required.
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Live update enabled. Deformation

result is visible.

Live update enabled. Deformation result

is visible.

3D fragment supplement mode

<Num0> 3D fragment supplement mode

This option becomes available in the command's automenu, when deforming a 3D fragment.

Topics in this section:

· Skew

· Sculpt Deformation

· Scaling/Twisting

· Bending

· Deformation by Curve

· Deformation by Surface

· Edit Deformation

Skew

Calling the command:

Keyboard Ribbon

3D Model > Special > Deformation > Skew Deformation

Keyboard Textual Menu

<3DRS> Operation > Deformation > Skew Deformation 

In the skew deformation, the deformation function is specified by displacing the vertices of the

bounding box of the given body. The bounding box is calculated with respect to the axes of the

global coordinate system or additionally-specified LCS.

The offset of vertices of the bounding box can be realized along any axis of the coordinate system

(the axis with respect to which the bounding box is constructed), along the edges of the bounding

box, along the face diagonals of the bounding box. For specifying the offsets in the command, the

manipulators as well as the command's parameters window can be used.
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The magnitude of the vertex offset for a bounding box can be specified both in absolute units – units

of model and in relative units – in fractions of length (in percents) of the bounding box along the

respective axes. The relative coordinates can be used in cases when it is necessary to preserve

proportions of the deformed model no matter what changes in the source operations are made. For

example, the picture below shows how the deformed model will be modified when changing the

length of the source extrusion depending on in which units the offsets of the vertices of the bounding

box have been specified.

Initial deformation
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Deformation after changing the source body length, if offsets for points

were defined in absolute values

Deformation after changing the source body length, if offsets for points

were defined in relative values

The vertices of the bounding box can be snapped to the 3D points. In this case the offset does not

depend on modification of the deformed body or on what units of length have been chosen for

specifying the offsets.
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Initial body and 3D node

One of vertices of initial body is snapped to 3D node

Snapping is retained after increasing height of initial body

When attaching the vertex to a 3D point, the offsets of the vertex with respect to the selected 3D point

can be specified additionally.
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Creation of Skew Deformation

For specifying this deformation it is necessary:

1. Select a body to be deformed;

2. Define LCS for the bounding box calculation (optional step);

3. Define LCS for offsets calculation (optional step);

4. Select fixing points for bounding box's vertices (optional step);

5. Specify the required offsets of the vertices of the bounding box;

6. Complete the operation creation by pressing .

Selection of Deformed Body and LCS of Deformation

For selecting the deformed body, the following option of the automenu is used:

<O> Select Body to Deform

This option is turned on by default upon the entry into the command. The deformed body is selected

with the help of  in the 3D window or in the tree of the 3D model. The selected body is

highlighted, and the contour of the bounding box appears.

By default the bounding box is calculated with respect to the axes of the selected operation's

coordinate system. It is possible to switch between bounding box based on global LCS and based on

LCS of the selected operation using the following automenu options, which are grouped into a drop-

down list:

<1> LCS by global coordinate system

<2> LCS based on operation

Upon switching an LCS, the bounding box is automatically recalculated in accordance to the new axes

orientation.

Specifying Offsets for Nodes of Bounding Box of Deformation

After constructing the bounding box, in the 3D window a user can select the vertices of the box in any

order and specify their offsets (with respect to initial position). To specify vertices' offsets, the 3D

manipulators are used. 

   

By default, offsets are calculated in the same coordinate system as the bounding box. It is possible to

select another coordinate system for offsets calculation using the following automenu option:
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<L> Select source LCS

After choosing the LCS, offsets manipulators are reoriented in accordance to the selected LCS' axes.

LCS selection can be canceled using the following automenu option:

<C> Cancel LCS selection

The offsets of the vertices of the bounding box (with respect to their initial position) can be also

specified in the command's parameters window. After selecting the deformed body, the list of all

vertices of the bounding box will appear in the parameters window. Under the list, there will be input

boxes for input of the offset values (the Offset parameters group ). To specify the offsets, it is

sufficient to select the desired node-vertex from the list (it will be highlighted in the list and in the 3D

window), and specify the offset values along the axes X, Y, Z in the input boxes of the Offset group.

Units, in which the offsets of vertices are specified, are controlled by the status of the Relative Value,

% checkbox. By default this checkbox is disabled, and the specified offsets are absolute (i.e., are

measured in units of model). If the checkbox is enabled, the specified offsets will be recalculated in

relative units.

For fixing a vertex of the bounding box to a 3D point, select the desired vertex (in the 3D window or in

the list of vertices in the command parameters window) and turn on the following option of the

automenu:

<Z> Set Fixing to Point

After activating this option, 3D fixing point has to be selected. The drop down list of this option

contains filters for selecting various 3D objects capable of defining a 3D point.

For a vertex of the bounding box fixed to a 3D point, the offsets input boxes in the parameters

window will remain accessible. The offsets specified in these input boxes will determine the vertex

offset with respect to the 3D fixing point. The offsets with respect to a fixing point can be also

specified in the 3D window with the help of the manipulators.
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To cancel a fixing to a 3D point, select the desired vertex (in the 3D window or in the vertices list in

the dialog of the command) and invoke the following option of the automenu

<D> Cancel Fixing to Point

After invoking this option, the vertex is untied from the 3D point. Note that the offset of the given

vertex does not change at that. The vertex will remain in the position specified by the 3D point.

However, later, when modifying the original model or location of the 3D point, the offsets of the

given vertex of the bounding box will be recalculated as if they were specified by numeric values from

the beginning.

Scaling/Twisting

Calling the command:

Keyboard Ribbon

3D Model > Special > Deformation > Scale/Twist Deformation

Keyboard Textual Menu

<3DRT> Operation > Deformation > Scale/Twist Deformation 

Scale/Twist Deformation is always specified with respect to the coordinate system of deformation

(defined with the help of LCS). Twisting is performed only around the X-axis of the coordinate system

of deformation, scaling is possible along all axes.

The deformation function is determined on the basis of the parameters (angle of twist and

deformation scales) specified for several sections of the deformed body located along the X-axis of

the coordinate system of deformation. For different sections a user can specify different scales and

angles of twist along the axes of the coordinate system of deformation. For each section the scales

along different axes can be also different.

The value of any parameter (except section position) can be assigned to a variable.
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Deformation of the whole body Deformation of the part of the body

The deformation function is calculated over the specified domain of the deformation function along

the X-axis. The domain of the deformation function is defined by the start and end boundaries along

the X-axis. The domain of the deformation function can include into itself the entire deformed body,

only its part or extend beyond the boundaries of the body.

The computed function is applied to the part of the deformed body defined by the deformation area.

By default, the deformation area is constructed as the bounding box of the deformed body (in the

axes of the selected coordinate system of deformation). If necessary, the size of the deformation area



Solid Body

1769

can be modified by moving the faces of the deformation area bounding box. It is possible to specify

location of the faces by snapping to a 3D point.

Domain of the deformation function Deformation area Deformation result

Creation of Scale/Twist Deformation

After invoking this command, it is necessary to:

1. Select a body to be deformed;

2. Define the LCS of deformation (optionally);

3. Select the domain of the deformation function;

4. Select the deformation area (if necessary);

5. Define the location of the sections of deformation;

6. Specify parameters for the sections of deformation;

7. Complete the operation creation by pressing .

Selection of Deformed Body and LCS of Deformation

For selecting the deformed body, the following option of the automenu is used:

<O> Select Body to Deform

This option is turned on by default upon the entry into the command. The deformed body is selected

with the help of  in the 3D window or in the tree of the 3D model. The selected body is

highlighted.

When you select body for the operation, the system is creating LCS for the deformations

automatically. It is possible to switch between automatic creation of LCS based on global LCS and

based on LCS of the selected operation using the following automenu options, which are grouped

into a drop-down list:
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<1> LCS by global coordinate system

<2> LCS based on operation

Upon switching LCS, domain of the deformation function and bounding box of the deformation area

are automatically recalculated in accordance to the new axes orientation.

Instead of automatically created LCS you can select an LCS existing in the 3D scene using the option:

<L> Select Source LCS

It is recommended to create the LCS of deformation in such a way that its X-axis is directed

along the axis of the body since the twist of the body will be performed exactly around the X-

axis of the coordinate system.

Cancellation of the selected LCS can be done with the help of the option:

<C> Cancel LCS selection

Specifying Domain of Deformation Function and Deformation Area

The domain of the deformation function is specified in the command's parameters window (the

Deformation Area group of parameters ).

Start and End parameters define the distance from the origin of the LCS of deformation to the start

and end boundaries of the domain of the deformation function. The distances are measured along the

X-axis of the LCS in units of modal. The system puts the default values into these input boxes so that

the domain of the deformation function spans the entire deformed body. A user can narrow or expand

the deformation area by specifying other values in these input boxes.

When the Whole body checkbox is enabled, the domain of the deformation function is computed

automatically in accordance with the current deformation area.

The bounding box of the deformation area initially spans the entire body. For modifying the size of

the deformation area, as in the sculpt deformation, the following option of the automenu is used:

<D> Change Deformation Box

Modifying the deformation area is performed similarly to the sculpt deformation. To exit the mode of

modifying the size of the deformation area, in the automenu turn off the option .

Creating Sections of Deformation

After selecting the LCS, the 3D manipulators to control location and parameters of the sections of

deformation will appear on the screen. By default, only two sections are created: at the start and at the

end of the deformation area. These sections cannot be removed, their location cannot be modified.



Solid Body

1771

The Position list of all sections specified for the given deformation is displayed in the command's

parameters window. The list in the parameters window is synchronized with the sections' manipulators

in the 3D window. When selecting the manipulator of some section in the 3D window, the same

section is automatically selected in the list. And vice versa: the section selected in the Position list, will

automatically become active in the 3D window. Selected for editing (active) section is marked in the

3D window with color.

To add a new position click the left mouse button on the line that connects centers of two existing

positions.

The buttons  and  in the Position list allow a user to create new sections of deformation and

delete existing ones. The new section by default is placed after the section which is active at the

moment of pressing the button . The exception is the case when at the moment of pressing the

button , the active section is the end section – in this case the new section will be placed before

the end one.

Moving/Scaling along the X-axis is now performed with respect to the origin of the applied

coordinate system. Move/scale manipulator is available for both primary ellipses.

Local coordinate system manipulator can be hidden using the appropriate checkbox in the Options

tab.

Specifying Parameters of Sections

For specifying parameters of some section, first it is necessary to make it active by selecting it from

the sections list in the parameters window or directly in the 3D window. After that, the section

parameters can be specified in the Transformations section.

To specify the section parameters in the 3D window, the special manipulators of the active section are

used. Upon bringing the cursor, the manipulator is highlighted. For modifying any parameter of the

section connected with a certain manipulator, bring the cursor to the desired manipulator, press 

and without releasing the mouse button, move the cursor to the desired location of the manipulator.
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The manipulator of the scale also allows a user to simultaneously change the scales along the two

axes (Y and Z). To do it, bring the cursor to an arbitrary point of the active section, press  and

without releasing the pressed mouse button move the cursor to the desired location.

Bending

Calling the command:

Keyboard Ribbon

3D Model > Special > Deformation > Bend Deformation

Keyboard Textual Menu

<3DRB> Operation > Deformation > Bend Deformation 

Bend deformation allows us to bend a selected body with respect to the selected axis by a specified

angle. To create this deformation, a user has to specify the deformed body, the origin and the

direction of the bend axis, the angle and the bend radius. 

To specify the bend axis, the angle and the bend radius, it is possible to use the special multi-element

manipulator in the form of LCS with additional elements for specifying the angle and the bend radius.
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1 - Bend angle manipulator.

2 - Bend radius manipulator.

3 - Bend LCS manipulator. The X axis (red) is the axis of bend.

4 - Plane, that separates bent and non-bent parts of the body. It passes through

the axis of bend and defines the base for bend angle calculation.

5 - Plane that represents the end of the deformed area.

The angle and radius of bending can be specified both with the help of the manipulator and as the

numeric values in the command's parameters window. 

The bend radius defines the position of the “neutral” surface. For the source body, this is the

plane that turns into the cylinder on the bent body. The points lying on this surface do not

undergo the tension or compression deformation.

In this operation, it is possible to quickly change the part of the body being deformed, and also,

create two-sided bending (with respect to the dividing plane).

As in the sculpt deformation, in the bend deformation it is also possible to modify the size of the

deformation area (the size of the deformation area bounding box). By default, it spans the entire

body.
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The deformation area spans the entire body 

The deformation area spans only a part of the body

Creating Bend Deformation

After invoking the Bend Deformation command, follow these steps:

1. Select a body to be deformed;

2. Specify the LCS for deformation area calculation (if necessary);

3. Define an origin and a direction of a bend axis and a starting position of a bent area using the LCS

manipulator;

4. Select deformation area (if necessary);

5. Specify the bend radius and the bend angle;

6. Select the mode of creating deformation (deformation of the selected part of the body,

deformation of the opposite part or two-sided deformation);
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7. Complete the operation creation by pressing .

Selection of Deformed Body

To select the deformed body, the following option of the automenu is used:

<O> Select Body to Deform

This option is turned on by default upon the entry into the command. The deformed body is selected

with the help of  in the 3D window or in the tree of the 3D model. The selected body is

highlighted.

By default the bounding box of the deformation area is calculated with respect to the axes of the

selected operation's coordinate system. It is possible to switch between bounding box based on

global LCS and based on LCS of the selected operation using the following automenu options, which

are grouped into a drop-down list:

<1> LCS by global coordinate system

<2> LCS based on operation

Upon switching an LCS, the bounding box is automatically recalculated in accordance to the new axes

orientation.

Selection of Bend Axis and Body-Dividing Plane

After selection of the deformed body, the manipulator for specifying LCS of bending appears in 3D

scene. By default, the axes of the manipulator are oriented along the sides of the bounding box of the

deformation area. The axis of bending coincides with the X-axis of the manipulator. The plane that

separates the bent and unbent parts of the body is defined as the XY-plane of the manipulator.

The manipulator of the bending deformation can be operated in the same way as described for the

Transformations of 3D elements. By default, transformations applied to the manipulator are displayed

in the separate window. You can switch the window to the auto-hiding mode  or close it  using

buttons located in the right side of the window's header.

When the window is closed, transformations are displayed in the command's parameters window.
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Specifying Bend Angle and Radius

A user can specify the numeric parameters of bending deformation – bend angle and bend radius – in

different ways. The exact values of these parameters can be specified in the command's parameters

window (Radius and Angle parameters ). Or they can be defined by using the manipulators in the 3D

window.

To specify values of angle and radius using the manipulators, bring the cursor to the corresponding

manipulator, press  and without releasing the pressed mouse button, move the manipulator to the

desired location. It is also possible to press  after selection of the corresponding manipulator. In

this case, the manipulator will start follow dynamically the cursor. To fix the desired position of the

manipulator, it is required to press  again.

Commands for defining values of radius and angle by position of existing 3D points are available in

the contextual menu of the angle and radius manipulators. You can also call the manipulator settings

dialog similar to the one described in the Transformations of 3D Elements chapter.

 

You can switch the direction in which the bend angle is measured using the  button in the

command's parameters window .
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Selection of Bending Mode. 

The mode of creating deformation can be selected in the Mode drop-down list of the command's

parameters window. By default, the One Side option is selected, which means that the deformation

will be applied only to one part of the initial body (the part which is chosen by the system by default).

 If a user wants to apply the deformation to another part of the body, he should select the Opposite

Side option .

For creating two-sided deformation, that is bending of both parts of the body, the Symmetric option

should be used.

Modifying Size of Deformation Area

The bounding box of the deformation area initially spans the entire body. For modifying the size of

the deformation area, as in the sculpt deformation, the following option of the automenu is used:

<D> Change Deformation Box

Modifying the deformation area is carried out similarly to the sculpt deformation. To exit the mode of

modifying the size of the deformation area, in the automenu turn off the option .



T-FLEX CAD 17 Help

1778

Sculpt Deformation

Calling the command:

Keyboard Ribbon

3D Model > Special > Deformation > Sculpt Deformation

Keyboard Textual Menu

<3DRC> Operation > Deformation > Sculpt Deformation 

In the sculpt deformation, the deformation function is defined by displacing the nodes of the regular

mesh on one of the faces of the bounding box of the deformation area.

The bounding box can be built with respect to the axes of the global coordinate system or

additionally-specified LCS.

By default, the box of the deformation area spans the entire body. If necessary, its dimensions can be

modified, thus altering the deformation area.
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Deformation area spans the entire body Deformation area spans only part of the body

The regular mesh is automatically created on a face of the bounding box which is selected for

creating deformation. Dimensionality of the mesh is specified by the user. Any node of the mesh can

be displaced from its initial position by the user-specified value. Several nodes can be selected and

moved simultaneously.

As a result of displacing the nodes of the mesh, the flat face of the bounding box is transformed into a

space spline surface which forms the required transformation law of the body. The spline surface

being formed can be of two types: control polyhedron type (the nodes of the mesh are used for

constructing the control polyhedron of the surface) and interpolation type (going directly through the

nodes of the mesh).
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Deformation with creating the spline surface 

by control polyhedron

Deformation with creating the spline surface by

interpolation over mesh points

The sculpt deformation has three modes:

· One side – only the nodes located on the selected face of the bounding box are displaced;

· Both sides – the nodes located on the selected and the opposite faces of the bounding box

are displaced. The nodes on the face opposite to the selected one are displaced in the same

direction by the same distance;

· Symmetric – the nodes located on the selected and the opposite faces of the bounding box

are displaced. The nodes on the opposite face are displaced symmetrically with respect to the

symmetry plane of the box.

One side mode Both sides mode Symmetric mode

The value of the mesh points offsets from their initial position can be specified both in absolute units

– units of model and in relative units – in fraction of length (in percents) of the bounding box along

the respective axes. The relative coordinates can be used in cases when it is necessary to preserve

proportions of the deformed model no matter what changes in the source operations are made. The

picture below shows how the deformed model will be modified when changing the length of the

source extrusion depending on in which units the offsets of the mesh points have been specified.
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Initial deformation Deformation after changing the source

body length, if offsets for points were

defined in absolute values

Deformation after changing the source

body length, if offsets for points were

defined in relative values

A snap to 3D points can be also specified for the nodes of the mesh. In this case the offset is

determined by the location of the 3D snap point and does not depend on modification of the

deformed body or on units in which the offsets are specified.

Initial body and 3D point Deformation mesh node is

snapped to 3D point

Snapping is kept upon changing the height

of the initial body 

When fixing the node of the mesh to a 3D point, the node's offsets with respect to the selected 3D

point can be specified additionally.
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Creation of Sculpt Deformation

After invoking this command, a user has to:

1. Select a body to be deformed;

2. Define LCS of deformation (optional step);

3. Specify the boundaries of the deformation area (of the bounding box of the deformation area)

(optional step);

4. Define the deformed face of the bounding box;

5. Specify mesh parameters on the selected face (optional step);

6. Specify the mode of deformation: one-sided, symmetric or two-sided deformation (optional step);

7. Define the desired displacements for the nodes of the mesh;

8. Complete the operation creation by pressing .

Selection of Deformed Body and LCS of deformation

For selecting the deformed body, the following option of the automenu is used:

<O> Select Body to Deform

This option is turned on by default upon the entry into the command. The deformed body is selected

with the help of  in the 3D window or in the tree of the 3D model. The selected body is

highlighted, and the contour of the bounding box appears on the screen. 

When you select body for the operation, the system is creating LCS for the deformations

automatically. It is possible to switch between automatic creation of LCS based on global LCS and

based on LCS of the selected operation using the following automenu options, which are grouped

into a drop-down list:

<1> LCS by global coordinate system

<2> LCS based on operation

Upon switching LCS, bounding box of the deformation area is automatically recalculated in

accordance to the new axes orientation.

Instead of automatically created LCS you can select an LCS existing in the 3D scene using the option:

<L> Select Source LCS

After choosing the LCS, the bounding box will be automatically reconstructed in accordance with the

axes of the LCS.

Cancellation of the selected LCS can be done with the help of the option:

<C> Cancel LCS selection

Selection of Deformed Face and Deformation Mode

After specifying the bounding box, the user has to indicate the face which will be subject to

deformation. To do it, it is sufficient to bring the cursor to the desired face (it will be highlighted) and

press . The option of face selection will become active at this moment in the automenu:
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<T> Select Face 

The mesh will appear on the selected face (by default it is a 3x3 mesh). The mesh parameters can be

changed in the command's parameters window (Mesh Size parameters group ). The maximum

allowable size of the mesh – 20x20.

By default, the deformation is created in the one-sided mode, i.e. only the nodes of the selected face

of the bounding box are displaced. The mode can be also changed in the command's parameters

window with the help of the Mode parameter .

Modifying Size of Deformation Area

The bounding box of the deformation area initially spans the entire body. To modify the size of the

deformation area, the following option of the automenu is used:

<D> Change Deformation Box

After invoking this option, the command will turn to the mode of modifying the boundaries of the

deformation area. Highlighting of the deformed face and the mesh temporarily disappear from the

screen. The list of the faces of the deformation area bounding box appears in the command's

parameters window.

The offsets for the faces of the bounding box can be specified directly in the 3D window or in the

command's parameters window (with the help of the list of the faces).

For moving the face in the 3D window, it is sufficient to point at it with the help of  (the selected

face will be highlighted) and, without releasing the pressed mouse button, shift the face to the desired

position. When selecting the face in the 3D window, it will be automatically highlighted in the list of

faces in the parameters window. The offset specified for the face will be shown in the input box of the

Offset parameter .
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The position of the face of the bounding box can be also modified in the parameters window just by

selecting the face from the list (in the 3D window the selected face will be highlighted in color) and

by entering the desired offset into the input box of the Offset parameter .

To specify the offsets of the faces in relative units (relative to the initial size of the deformation area

bounding box, that is the size of the bounding box of the deformed body), enable the Relative Value,

% checkbox.

To fix a face to a 3D node, use the option:

<Z> Set Fixing to Point

After invoking this option, define a 3D point to which the selected face of the deformation area

bounding box should be fixed. Any 3D object capable of defining a point (3D node, the vertex of the

body, etc.) can be used for specifying this point.

A user can also specify the offsets for the face fixed to a 3D point – in this case these offsets will be

relative to the 3D point to which the face is fixed.

To cancel the snap of the face to a 3D point, use the option:

<H> Cancel Fixing to Point

After canceling the fixing, the face location does not change. However, the offsets of the face will be

subsequently recalculated with respect to the body's overall size and will not depend on the location

of the former fixing point for the given face.

For quick cancellation of all modifications of the deformation area, the following option can be used:

<W> Set Deformation Box by Body Size

This option cancels all specified offsets for the faces of the deformation area bounding box.

To exit the mode of modifying the size of the deformation area, in the automenu turn off the option

.

Specifying Offsets of Deformation Mesh Points

Offsets of the mesh points can be specified both in the dialog of the parameters window and directly

in the 3D window.

For specifying offsets in the 3D window, select successively the nodes (or group of nodes) and with the

help of the manipulator in the 3D window move them to the desired location.

For selecting one mesh point, it is sufficient to bring the cursor of the mouse to it and press . The

selected node will be highlighted, and the manipulator in the shape of the coordinate system will
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appear at the node. The offset of the node is specified by moving the manipulator along one or two

axes at once (the manipulator can be operated in the same way as described for the Transformations

of 3D elements).

There are several ways of selecting simultaneously several mesh points. For example, it is possible to

successively select the desired nodes while keeping the key <Ctrl> pressed. In this case, the

manipulator will be drawn at the last selected node of the group. When moving the manipulator, all

points of the group will be shifted in the same direction by the same distance.

All nodes lying on the same mesh line can be selected quickly just by pointing at this line with the help

of . While doing that, all nodes lying on the given mesh line will be selected, but the manipulator

will not appear. To activate the manipulator, point with the  at one of the selected nodes. If while

pressing the key <Ctrl>, a user successively defines two mesh lines, all nodes on the defined mesh

lines will be selected, etc.

When editing, you can quickly select a rectangular group of points with <Shift>.

In the Interpolation mode, you can add new grid line: hold <Alt> and select one of the existing

horizontal or vertical lines in the scene. The deforming principle will not be changed.

For specifying the offsets of the mesh points in the parameters window, a table in the Mesh Size

parameters group  is used. Each cell of this table corresponds to one mesh point. The symbol “0” is

displayed in the cell if the offset is not specified for the respective node. For the displaced nodes, the

specified offsets are shown in the format (X,Y,Z), where X – the node's offset along the X-axis, Y – the

offset along the Y-axis, Z – offset along the Z-axis.

To specify offset of any mesh point, in the table select the cell corresponding to the desired node.

While doing that, the parameters of the Offset group  will become accessible for editing below the

table. They will define the offsets along the X-axis, the Y-axis and the Z-axis. When modifying the

offset values, the node will be moving in the 3D window.

As with the work in the 3D window, it is possible to specify offsets at once for a group of nodes. For

selecting several nodes (that is, several cells in the table of nodes), use +<Ctrl>.

The units in which the offsets of the mesh points are specified are controlled by the status of the

Relative Value, % checkbox. By default it is disabled, and the specified values are absolute (i.е., are

measured in units of model). If the checkbox is enabled, the specified offsets will be recalculated in

relative units.
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To fix a mesh point to a 3D point, select the desired node (in the 3D window or in the nodes table in

the dialog of the command) and turn on the following option of the automenu:

<A> Set Fixing to Point

After activating this option, select a 3D point to which the current node of the mesh should be fixed.

The drop down list of this option contains the filters for selecting various 3D objects capable of

defining a 3D point. The selected object is displayed in the Object of Snap input box of the

parameters window.

For the mesh point fixed to a 3D point, it is possible to additionally specify the values of the node's

offsets relative to the selected 3D point (with the help of the manipulator in the 3D window or in the

parameters window).

To cancel a fixing of the mesh point to a 3D point, select the desired mesh point (in the 3D window or

in the nodes list in the dialog of the command) and invoke the following option of the automenu:

<B> Cancel Fixing to Point

After invoking this option, the current mesh point is untied from a 3D point. Note that the offset of the

given node does not change at that. The node will remain in the position specified by the 3D point.

However, later, when modifying the original model or location of the 3D point, the offsets of the

given node of the deformation mesh will be recalculated as if they were specified by numeric values

from the beginning.

The type of the formed spline surface (by control polyhedron or by mesh points) is determined by the

status of the Interpolation checkbox. When this checkbox is disabled, the spline surface is created by

the control polyhedron, and when the checkbox is enabled – the created spline surface will go through

the nodes of the mesh.



Solid Body

1787

Deformation by Curve

Calling the command:

Keyboard Ribbon

3D Model > Special > Deformation > Deformation by Curve

Keyboard Textual Menu

<3DRV> Operation > Deformation > Deformation by Curve

The law of the deformation by curve is determined by two space curves (source and target). The

source curve is identified with the deformed body in its initial state; the target curve – in the resulting

state. The space transformation law is constructed in such a way as to provide the transformation of

the source curve to the target one.

In general case, the source and the target curves can have arbitrary shapes. Most often, a line (for

example, one of the edges of the deformed body or a straight 3D path) is used as the source 3D

curve.

When constructing the deformation law, in each point of the two curves the auxiliary LCS1(s) and

LCS2(s) (s – the curve parameter) are calculated, whose pairwise superposition allows a user to define

more precisely the space orientation of the resulting body. The auxiliary LCS are computed by the

system in the following way: the tangent to the source/target curve at the current point is taken as the

X-axis, the normal to the auxiliary surface at the given point of the same curve is taken as the Y-axis,

the Z-axis is the vector product of the X and Y axes.

The auxiliary surfaces for the source and target curves can be constructed differently depending on the

selected algorithm of the deformation by curve:

· 3D Curve – 3D Curve;

· Curve – Spiral;

· Pair of Curves – Pair of Curves.

3D Curve – 3D Curve

When using this algorithm, a user specifies an auxiliary direction vector for each of the curves (source

and target). For this purpose, a user defines the LCS one of the axes of which will define the direction

vector.

The auxiliary surface for both curves (source and target) is formed by moving the direction vectors

along the corresponding curves by using the minimum twist method.

As an example of using this algorithm, consider one of the typical problems solved by this algorithm 

– wrapping the source body into a ring. The resulting body can be closed.
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3D Curve – Spiral

This algorithm is based on the assumption that the target curve resembles a “spiral”, that is, there is a

space axis around which this curve is “wound”. The use of this algorithm of the deformation by curve

allows a user to “wind” bodies around the axisymmetric curves in the most natural way.

In this algorithm, a user defines an additional direction vector for the source curve (by selecting LCS

and one of its axes). The auxiliary surface for the source curve is formed in the same way as in the

previous case by moving the given direction vector along the curve by using the minimum twist

method.

A user also defines the axis of the target curve by selecting the LCS and the desired axis. For the target

curve the auxiliary surface is formed as a set of vectors directed from each point of the curve at the

axis along the shortest distance.

   

Pair of 3D Curves – Pair of 3D Curves

In this algorithm, for each of the main curves (source and target) an additional 3D twist curve is

specified.

When calculating the transformation law, the auxiliary surfaces for the source and target curves are

formed as the set of vectors directed from each point of the source/target curve at the corresponding

to it point of the twist curve.
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Creating Deformation by Curve

The first step after invoking this command is the selection of the deformed body:

<O> Select Body to Deform

This option is turned on by default upon the entry into the command. The deformed body is selected

with the help of  in the 3D window or in the tree of the 3D model. The selected body is

highlighted.

After selecting the deformed body, the desired deformation algorithm has to be selected. To do it,

use the Type drop-down list in the command's parameters window.

Depending on the deformation algorithm selected, the following steps sequence will vary.

Creating 3D Curve – 3D Curve deformation

If in the Type list the user selects the value 3D Curve – 3D Curve, then in the automenu the following

option becomes active:

<O> Select Body to Deform

This option is turned on by default upon the entry into the command. The deformed body is selected

with the help of  in the 3D window or in the tree of the 3D model. The selected body is

highlighted.

After that, the system will prompt a user to select the source curve:

<T> Select Source Curve

The drop down list of this option contains the list of the 3D elements capable of defining a 3D curve.

The selected curve is marked in the 3D scene.

Cancellation of the source curve selection can be done with the help of the option:
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<H> Cancel Source Curve Selection

After selecting the source curve, a user needs to specify the LCS one of the axes of which will serve as

the direction vector for the source curve:

<L> Select Source LCS

In the command's parameters window, specify the axis of the LCS which will serve as the direction

vector for the source curve (Source direction parameter). One or two axes of the LCS can be

unavailable for the selection which means that the selection of the corresponding direction vector will

not be possible for the selected source and target curves. 

On the basis of the defined direction vector the system automatically computes the auxiliary surface

for the source curve and the auxiliary LCS at each point of the curve. For clearness, in the 3D window

the auxiliary LCS will be shown for the start point of the source curve.

The button  allows a user to change the direction of the obtained direction vector of the source

curve, and, therefore, the orientation of the auxiliary LCS.

To cancel the selection of the LCS, which specifies the direction vector of the source curve, the

following option is used:

<C> Cancel LCS selection

The target curve and its direction vector are defined similarly with the help of the following options:

<B> Select Target Curve

<D> Cancel Target Curve Selection

<M> Select Target LCS

<N> Cancel LCS selection

By changing axes which specify the direction vectors for both curves as well as the directions of these

axes, it is possible to find the desired choice of the transformation. For obtaining the desired result, it
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is also possible to use the  Reverse Target Curve button, which allows a user to change the

direction of the selected target curve.

Creating Curve – Spiral deformation

If in the Type list the user selects the Curve – Spiral value, then in the automenu the following option

becomes active:

<O> Select Body to Deform

The deformed body is selected with the help of  in the 3D window or in the tree of the 3D model.

After that, the system will prompt the user to select the source curve:

<T> Select Source Curve

Cancellation of the source curve selection can be done with the help of the option:

<H> Cancel Source Curve Selection

After selecting the source curve, a user needs to specify the LCS the axis of which will serve as the

direction vector for the source curve:

<L> Select Source LCS

In the command's parameters window, specify the axis of the selected LCS which will serve as the

direction vector for the source curve (Source Direction parameter). In the 3D window the auxiliary LCS

will be shown for the start point of the source curve.

The button  allows a user to change the direction of the obtained direction vector of the source

curve.

To cancel the selection of the LCS, which specifies the direction vector of the source curve, the

following option is used:

<C> Cancel LCS selection

The target curve and its axis are selected similarly with the help of the following options:

<B> Select Target Curve



T-FLEX CAD 17 Help

1792

<D> Cancel Target Curve Selection

<M> Select Target LCS

<N> Cancel LCS selection

As in the previous case, for obtaining the desired result, it is also possible to use the  Reverse

Target Curve button, which allows a user to change the direction of the selected target curve.

Creating Pair of Curves – Pair of Curves deformation 

When choosing the Pair of Curves – Pair of Curves option, the following option becomes active in the

automenu:

<O> Select Body to Deform

The deformed body is selected with the help of  in the 3D window or in the tree of the 3D model.

After that, the system will prompt the user to select the source curve:

<T> Select Source Curve

Cancellation of the source curve selection can be done with the help of the option:

<H> Cancel Source Curve Selection

After that, it is necessary to define the twist curve for the source curve of deformation:

<K> Select Source Twist Curve

This curve is selected in the 3D window or in the tree of the 3D model.

To cancel selection of the source twist curve, use the option:

<L> Cancel Source Twist Curve Selection

The target curve and its twist curve are selected similarly with the help of the following options:

<B> Select Target Curve

<D> Cancel Target Curve Selection

<M> Select Target Twist Curve

<N> Cancel Target Twist Curve Selection

In addition, in the command's parameters window the  Reverse Target Curve button is available,

which allows a user to change the direction of the selected target curve.



Solid Body

1793

Deformation by Surface

Calling the command:

Keyboard Ribbon

3D Model > Special > Deformation > Deformation by Surface

Keyboard Textual Menu

<3DRF> Operation > Deformation > Deformation by Surface

In the deformation by surface the deformation law is defined by two surfaces: the source and the

target one. The deformation function is constructed in such a way that the source surface is reflected

onto the target one.

In general case, the source and the target surfaces may not belong to the deformed body. In practice,

however, it is often convenient to choose one of the faces of the deformed body to be the source

surface. In this case, the deformation function is constructed in such a way as to provide the «bend» of

the deformed body onto the target surface.

   

A solid or a sheet body can be selected as the deformed body.

The source and the target surfaces can be specified by face, 3D profile or a sheet body. The sheet

body, specified as the source body, must consists of one face. For defining the target surface, the

polyhedral sheet body can be used, however, its faces must have a continuous joint on the tangent

plane.

For a source surface, it is not recommended to select surfaces with a complicated geometry, for

example, faces with a picture “pressed out” on them. When transforming such face to the target

one, the loss of the face geometry may occur. In such cases, as a source surface, it is better to

define, for example, the 3D profile drawn in the plane containing the boundaries of the

complicated face.

For defining the deformation function more precisely, base points are specified on the source and the

target surfaces. For each surface, three points lying on the surface are specified. The points can be

specified with the help of 3D nodes, vertices or other 3D objects capable of defining a 3D point. The

specified points are not supposed to lie on the same line. The order in which the points on the source

and the target surfaces are specified has to coincide.
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Two transformation methods are used when performing the deformation by surface:

· By parameters – transformation with superposition of the base points of the surfaces. With

that deformation method, the points on the source surface exactly go into the points on the

target surface. When using this method, the target surface cannot have more than one face;

· With minimal distortions – transformation with preserved geometric distances between points

of the source surface. This method gives minimal distortions, if the distances between the first

two points on the source and the resulting surfaces coincide. If the distances do not coincide,

the distances are recalculated with the corresponding similarity factor. The distances are

measured as the lengths of the normal sections.

The method “with minimal distortions” can be applied in cases when the target surface consists of a

collection of faces (sheet body). It provides the superposition without irregularities which are common

for the interior surface parameterization.

By parameters With minimal distortions

When creating the deformation by surface, the offset from the target surface can be specified. In this

case, upon forming the deformation function, the source surface will be transformed not to the target

surface, but to the equidistant to it surface with the specified offset.

Without offset With offset

As a result of the deformation, the resulting body may turn out to lie on either side of the target (or

equidistant to it) surface. The placement of the body can be quickly changed with the help of the

button in the command's parameters window.
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Creating Deformation by Surface

To create deformation by surface, it is necessary to:

1. Select deformed body;

2. Select the source surface of deformation;

3. Define the base points on the source surface;

4. Select the target surface of deformation;

5. Define the base points on the target surface;

6. Specify deformation method (By parameters or With minimal distortions);

7. Specify offset (if necessary);

8. Complete operation creation by pressing .

Selection of Deformed Body and Source Surface

After invoking the command, in the automenu the options for specifying necessary initial data will

appear. For selection of the deformed body, the following option is used:

<O> Select Body to Deform

This option is turned on by default upon the entry into the command. The deformed body is selected

with the help of  in the 3D window or in the tree of the 3D model. The selected body is

highlighted.

After that, the system will prompt the user to select the source surface of deformation:

<T> Select Source Surface

The drop down list of this option contains the list of 3D elements capable of defining the source

surface of deformation: face, sheet body, 3D profile. The selected surface will be marked in the 3D

scene.

Selection of Correspondence Points on Deformed Body and Source Surface

After selection of the source surface, the options for selecting three base points of the source surface

will be successively activated in the automenu:

<L> Select First Point on Source Surface
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<K> Select Second Point on Source Surface

<G> Select Third Point on Source Surface

The drop down lists of these options contain filters for selection of the 3D elements capable of

defining a 3D point.

For specifying the target surface, the following option of the automenu is used (it becomes active

automatically after specifying the base points of the source surface):

<M> Select Target Surface

This option also has a drop down list with the filters for selection of the different types of the 3D

elements capable of defining a surface.

After selection of the target surface, its base points need to be specified successively:

<R> Select First Point on Target Surface

<F> Select Second Point on Target Surface

<B> Select Third Point on Target Surface

Specifying Deformation Parameters

The deformation mode is selected in the Mode drop-down list in the command's parameters window.

The offset of the source surface with respect to the target one is specified with the help of the Offset

parameter. The placement of the deformed body with respect to the target surface can be changed

with the help of the button  found in the  command's parameters window (to the left of the Offset

parameter).
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Edit Deformation

Following commands can be used for editing deformation operations:

Icon Ribbon

-

Keyboard Textual menu

- Edit > Operations > Deformation > Skew Deformation

Icon Ribbon

-

Keyboard Textual menu

- Edit > Operations > Deformation > Scale/Twist

Icon Ribbon

-

Keyboard Textual menu

- Edit > Operations > Deformation > Bend Deformation

Icon Ribbon

-

Keyboard Textual menu

- Edit > Operations > Deformation > Sculpt Deformation

Icon Ribbon

-

Keyboard Textual menu

- Edit > Operations > Deformation > Deformation by Curve
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Icon Ribbon

-

Keyboard Textual menu

- Edit > Operations > Deformation > Deformation by Surface

Following automenu options are available in all of the commands mentioned above:

<Esc> Cancel selection

<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).



Surface

1799

Surface

A set of commands, united in a group called "Surfaces", is created to work with surfaces and faces of

bodies. Commands allow you to create new surfaces, add and modify faces.

Surfaces can be created not only using surface modeling commands, but also using solid modeling

operations.

Topics in this section:

· Bridge

· Transition Surface

· Ruled Surface

· Extend by Law

· Offset Surface

· Fill Hole

· Sew

· Imprint Elements

· Delete Faces

· Separate Faces

· Replace Faces

· Change Faces

· Transform Faces

· Extend Faces

Bridge

Calling the command:

Icon Ribbon

3D Model > Special > Surfaces > Bridge

Surfaces > Operations > Bridge

Keyboard Textual Menu

<BRI> Operations > Surfaces > Bridge

Bridge is an operation for joining two surfaces with a transition one being able to control the joining

parameters and end points boundaries. Sheet body surfaces or solid body faces can be used as initial

bodies. The result is a sheet body surface independent of the type of base elements.

Topics in this section:

· Main Concepts

· Operation Defining Steps

Main Concepts

Bridge Chains

The transition surface obtained as a result of the operation is determined by the initial chains

geometry. A chain is a surface or a solid body face with an edge selected to be the boundary with the

transition surface. One chain can be composed of several successively joined surfaces which can be

added or deleted while setting the operation. It is obligatory that the set of surfaces in one chain

belong to one and the same object or body.
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Every chain has start and end points. The transition surface alignment is determined by matching the

end points between the chains. If necessary you can change the order of matching the points so that

the transition surface alignment is changed too.

The system enables users to control the transition surface boundaries moving end points along the

initial chain edges. Shift values can be set as a percentage from the boundary edge length, in units of

measurement or be determined by the geometric point at the boundary. If necessary, end points shift

values can be synchronized. 

Shift value cannot exceed chain edge length.

Shift is not set Different values of initial shift Initial shift values are synchronized

Besides shifting it is also possible to set transition surface displacement along the normal to boundary

edges towards initial chains.
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Initial surfaces can be closed. When working with closed chains it is possible to open the contour and

define the circumvention direction.

Closed Open – Forward direction Open – Reverse direction

Boundary Conditions

The system enables users to control joining parameters at the border line between the set of initial

surfaces and the transition one, and defines continuity condition – G0, G1 and G2. It enables users to

obtain a more precise surface including the one with smooth transitions.

Continuity G0 means that the boundaries of the initial limiting surfaces set and that of the transition

one coincide in space.

Continuity G1 means that not only do the boundaries of the initial limiting surfaces set and that of the

transition one coincide in space, but also their directions (tangent lines).

Continuity G2 means that besides mentioned above, radii of curvature at surfaces boundary coincide

too.

Continuity G0 Continuity G1 Continuity G2

Tangent Magnitude value can be set for G1 and G2 continuity conditions – it is a coefficient that

scales the derivative value in the given direction.
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Tangent Magnitude 1,0 Tangent Magnitude 2,0

Flow Direction

Transition surface is formed by generating lines which join together the end points of both chains. To

obtain a more precise surface it is allowed to determine the direction of these lines relative to limiting

surfaces.

Auto Perpendicular Isoparametric

There are three variants available:

· Auto. In this case the generating lines direction is determined by the system automatically so

that an optimum result is achieved.

· Perpendicular. In this case the generating line vector is perpendicular to the vector of the

normal to the limiting surface and to the tangent to its edge one.



Surface

1803

· Isoparametric. In this case the generating line vector is the extension of the limiting surface

directrix vector.

In addition to direction it is allowed to specify the tangent line modulus at the end points for the

generating lines

In case of perpendicular and isoparametric joining in addition to tangent line modulus it is allowed to

set deviation angle vector of the generating line in the tangent plane from the initial position

determined by the joining method. The tangent plane is determined by the limiting surface edge

vector and the direction vector.

By default the transition surface is built so that it forms a direct contact with the initial chain as a

result. However it is allowed to change the contact direction to the opposite one if necessary.
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Forward tangent Reverse tangent

Additional Features

By default the result of the operation is a separate surface conjugate with initial sets of surfaces. If

necessary, the system allows sewing initial surfaces with the transition one to form a single sheet body.

Set of initial

surfaces

Result without

sewing

Result with sewing

Operation Defining Steps

The dialog of properties and automenu are used for working with the command and setting the

required parameters simultaneously. It is convenient to change the parameters in the dynamic mode

due to using special graphic objects in the 3D window – draggers and marks – which appear

automatically after selecting the elements. These objects enable users to quickly evaluate and change

the operation result. 

Follow these steps to create the operation:

· Select the edges of the first chain

· Select the edges of the second chain

· Select boundary faces of both chains

· Specify boundary conditions

· Specify flow direction

· Set indentation parameters

· Set result parameters

· Confirm operation creation
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Selection of chain edges

The operation setting starts with selecting the edges between which the transition surface is to be

built. The set of edges for the first or the second chain is formed when one of the following automenu

options is active:

<U> Add Edges to the First Chain

<V> Add Edges to the Second Chain

Press the automenu icon and switch between the options.

Select the edge from the 3D window using the mouse.

The selected edges of every chain are shown in the lists in the corresponding tabs of the properties

window. Switching between the lists in the properties window activates corresponding automenu

options. 

To delete the edge selected from the list, use Delete  button.

By default the following option is enabled:

<G> Smooth Edge Chain Selection Mode

In this case it is sufficient to specify any edge of the chain to automatically select all the sequence. If

you want to select the edges separately, disable the option.

A boundary face is automatically set for every edge, and the transition surface is built connected to it.

Select another boundary face for an edge in the 3D window, enabling the option:

<F> Select Boundary Face

Use Reverse direction parameter to change the transition surface orientation in the selected chain.

There is a mark  in the 3D window representing this parameter.

A special mark in the 3D window breaks the closed contour of the chain and determines the

circumvention direction. It has three states: Closed , Open – Forward direction  , Open –

Reverse direction .

Defining Boundary Conditions

Continuity parameter determines a continuity condition for every chain. A mark corresponding to this

parameter is used for working in the dynamic mode in the 3D window: G0 , G1 , G2 .
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Continuity conditions G1 and G2 suppose setting Tangent Magnitude parameter. A dragger looking

like a red arrow whose value is shown in the properties window is used in the 3D window for that

purpose. By default, the value is equal to 1.

Reverse direction parameter changes the contact direction of the transition surface and the initial

chain. This parameter is represented with the  mark in the 3D window.

Defining of Flow Direction

Flow direction of the initial chains with the transition one is determined by the corresponding

parameter in the properties window. By default the value is Auto.

To control tangent in the selected end point of the chain, use the following option

:

<E> Select Vertex for Tangent Direction Precise Definition

After you select the point, there appears a dragger in the 3D window that controls the generatrix

tangent module value in that point. To conjugate Perpendicular and Isoparametric surfaces there

appears an additional dragger of tangent deflection from the initial position angle.

Setting Indentation Parameters

Start and end shifts from the end points of both chains are set with the help of the draggers or by

entering the values in the properties window. The value can be set as a percentage from the boundary

edge length, in the units of measurement or can be defined by the geometric point within the edge.

The point is selected in the 3D window.

To synchronize shift values of the corresponding chain points it is necessary to enable  parameter for

the selected point of any chain.

The transition surface boundary indent from the chain limit in the direction of the boundary surface is

set by a dragger looking like a blue arrow in the 3D window showing Offset parameter.
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Setting Result Parameters

To sew the transition surface with the initial chains into one sheet body, use the Sew surfaces

parameter which can be found in the General parameters tab in the properties window.

Transition Surface

You can call the command in any of the following ways:

Icon Ribbon

3D Model > Special > Surfaces > Transition Surface

Surfaces > Operations > Transition Surface

Keyboard Textual Menu

<3Y> Operations > Surfaces > Transition Surface

Transition surface is as operation for creating surfaces with a given variant of generating profile

mathematical formulation. The position of the profiles in space is determined by the supporting curve:

a tangent line can be built in any point of the curve. It sets the normal of the plane which the

generating profile belongs to. Depending on the transition curve variant and the set parameters, the

generating profile can be a parabola, a hyperbola, an ellipse arc, a circumference arc, a circumference

or a segment.

A transition surface enables users to create joining surfaces with a given profile and a given shape of

the surface transition edges. In particular cases transition surfaces can have only one connecting edge

and two free edges or can be close-looped.

A transition surface enables users to create complex 3D surfaces with a strict mathematical definition

given by the user. Firstly it is helpful for the designers who work on aero- and hydrodynamically

complex parts.
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Topics in this section:

· General Information and Abilities

· Conic – Discriminant

· Conic – Path

· Conic – Tangent

· Conic - Four Points

· Circle – Tangent to Surface

· Circle – Radius

· Circle – Radius and Angle

· Circle – Three Points

· Line – Angle

· Line – Tangent

General Information and Abilities

 Conic – Discriminant. Builds a conic section surface with a smooth rounding shape between

two curves lying on the given surfaces. The generating profile can be a parabola, an ellipse or a

hyperbola. Discriminant parameter determines the degree of flatness for the surface obtained. It

varies from 0 to 1 (not included). If Discriminant is less than 0.5, the generating profiles are hyperbola,

if it is more than 0.5 – they are parabolas. If it is equal to 0.5, the generating profile is an ellipse arc.

Therefore, the more the Discriminant, the less is the flatness of the surface created.

 Conic – Path. Builds a conic section surface with a smooth rounding shape between two curves

lying on the given surfaces. The generating profile can be a parabola, an ellipse arc or a hyperbola.

The rounding shape of the surface is determined by the intermediate path every generating profile

has to pass. The position of every path point is limited with the triangle area as shown in the picture.
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1 – first face; 2 –first guide point; 3 – second face; 4 –second guide point; 5 – point in the middle path; 6 – the

surface obtained (surface generating profile); 7 – available region for the point in the middle path.

 Conic – Tangent. Builds a conic section surface with a smooth rounding shape between two

curves lying on the given surfaces. The generating profile can be a parabola, an ellipse or a hyperbola.

The surface rounding shape is determined by a reference surface set with two reference curves. The

reference surface is invisible for the user if the reference curves selected don’t belong to the surface

already built. The surface to be built must be tangent to the reference surface. At the same time the

reference surface must allow every generating profile to be tangent to it. Otherwise the surface

created will intersect the reference one without fulfilling the tangent condition.

1 – first face; 2 –first guide point; 3 – second face; 4 –second guide point; 5 – reference surface; 6 – first reference

curve point; 7 – second reference curve point; 8 – surface obtained (surface generating profile).

 Conic - 4 Points. It creates a conic section surface that smoothly touches a given surface along

the specified guide curve (First Guide), while the shape of the surface is determined by three other

guide curves.

 Circle – Tangent to Surface. Builds a surface tangent to the selected surface. The surface

generating profile is a circle arc with a given angle relative to the point of contact, the center of the

arc lying at the curve set. The arc angle can be constant along all the surface length or it can vary

which is set by a diagram.

 Circle – Radius. Builds a looped surface whose generating profiles are circles of a given radius.

The radius can be constant or variable. The centers of the circles are determined by the selected curve.
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 Circle – Radius and Angle. Builds a surface which passes through a curve and is tangent to the

surface the curve belongs to. The surface cross section is of circle arc shape with a set radius and

angle. The radius and angle can be constant along all the surface length or it can vary which is set by a

diagram.

 Circle – Three Points. Builds a surface which passes through three given curves. The surface

cross section is of circle arc shape which is built by three points belonging to each of the three set

curves. The curves can converge at one point.

 Line – Angle. Builds a surface whose generating profiles are segments. Every segment is at a set

angle to the selected surface. One end point of the segment lies at the surface, the other is at the

directing line set by the user. The angle can be either constant or variable. At a zero angle the surface

is built by the tangent line. The surface is limited by the initial directrix at one side and by the contact

with the plane at the other.

 Line – Tangent. Builds a surface whose generating profiles are segments. Every segment is

tangent to the surfaces set by the user at the end points.

Support Curve

A supporting curve is a fundamental element of any variant of creating a transition surface. A

supporting curve can be set by a 3D path, a route, an edge or several smoothly joint edges.

Generating profiles which set the geometry of the surface to be created lie in the planes built

perpendicular to the tangent lines whose direction is determined by the supporting curve. Generating

profiles and the planes where they lie are invisible for the user. The picture shows how the supporting

curve influences the generating profiles position (the profiles are shown symbolically as their real

frequency is much higher).

Supporting curve can be located in any part of the 3D scene. The supporting curve should be located

so as to avoid collisions of the end generating profiles, taking into account supporting curve curvature

and the distance from it to other determining elements. In case the supporting curve is a segment,

there will be no collision of the end generating profiles anyway, as they are parallel to each other.

Besides, the supporting curve limits should be taken into account: no surface is built beyond them. The

supporting curve can go beyond the limits of other determining elements.
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Surface bend direction

The contact (bend) direction of the conic transition surfaces (the first three variants of surfaces) is

determined by the position of the surfaces the directing curves belong to. The bending direction of

the surface to be created is the only one possible in this case. The bending direction is determined by

the tangent lines intersection point direction, the tangent lines being built to the surfaces in

generating profile planes. 

1 – the first surface; 2 – the second surface; 3 – the surface obtained (surface profile); 4 – tangent lines intersection

point.

Free limit control

For Circle – Tangent to Surface, Circle – Radius transition surface variants the surface ends don’t

depend on the geometric elements selected and are only determined by Angle parameter which can
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be constant or variable, set by the diagram. Variable values are set relative to the supporting curve

length.

Accuracy parameters

All the variants of surface design have three accuracy parameters: Approximation Accuracy,

Calculation Accuracy, Simplify Geometry.

Approximation Accuracy. Determines the partition accuracy for all the set curves: the supporting, the

axial, the directing ones etc. The parameter sets maximal distance from the chord built between two

adjacent partition points to the curve. The number of partition points determines the number of

generating profiles. By default, partition accuracy parameter equals 0,0001 m. 

Calculation Accuracy. Determines the approximation accuracy of generating profiles and the

accuracy of joining adjacent generating profiles with a surface. By default, calculation accuracy

parameter equals 0,00001 m. The given value allows us to obtain correct surfaces in most of the cases.

It is not recommended to change the parameter if there are no visible problems with the design.

Simplify Geometry. Determines the surface edges type: the surface edge can be a single curve (if the

flag is on) or a sequential set of edges (if the flag is off). By default the flag is on. The number of

edges is one less than that of the generating profiles. 

Use Guides. A directrix is a curve defining characteristic points of the generating profiles: a generating

profile passes every characteristic point of the directrix (see explicative schemes of “Transition surface

types” subsection). Besides, a directrix can set final surface shape between two adjacent generating

profiles. If the flag for this option is on, the directrix shape at the section between every two adjacent

profiles is used when building a joining surface (between the two points of the directrix which define
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generating profiles geometry). If the flag is off, the section between two characteristic points of the

directrix (profile setting points) is approximated by some function which can be of a shape different

from that of the directrix section discussed. It is obligatory that the approximation function passes the

directrix points which set the profiles.

By default the flag is on.

In case a conic section surface is built (the first four variants of creating a surface), the directing curves

shown as 2 and 4 at the schemes clearly set the shape between generating profiles, so it is not

recommended to switch off this option for these construction variants.

In case the directrix is set from one end only or if it is not explicitly set but is defined from the

construction, e.g. as in the fifth construction variant with circular profiles surface contact, switching the

flag off can ensure a better result for the user. In the case cited (and in similar cases) the directrix is set

at one side and is defined from the construction as a joining curve by circle contact points, it lies in the

given contact plane which can influence the surface symmetry and curvature. Therefore it is acceptable

to remove the flag and use directrix approximation at the sections between profiles instead of the

directrix.

Angle Tolerance. The parameter is only available for Line – Tangent variant. The parameter

determines the acceptable angle between the generating profile (segment) and tangent lines to the

selected surfaces at the ends of the segment. By default the value equals 1°. The minimal acceptable

value is 0,1°. It is not recommended to set angle tolerance less than 0,3° in terms of calculating

resources saving. 

Options

There is an additional feature enabled by default among the options: Dynamic preview. The option is

standard for all the 3D Design commands. It gives a simplified representation of the surface being

created which dynamically changes with initial parameters change.

Conic – Discriminant

To create a Conic – Discriminant surface do the following:

1. Select Support Curve. It can be a path, a route, an open profile, an edge or a sequence of

smoothly-joint edges. 

2. Select First Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges. The first guide must entirely belong to the first face. 

3. Select First Face. It can be set by a face, a surface or a sequence of smoothly-joint faces.

4. Select Second Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges. The second guide must entirely belong to the second face.

5. Select Second Face. It can be set by a face, a surface or a sequence of smoothly-joint faces.

6. Set Discriminant value in the range from 0,001 to 0,999. The value can be constant or variable, set

by the diagram. The abscissa axis of the diagram is the supporting curve length. 

7. Change or leave the default values for the parameters determining design accuracy.

8. Confirm the surface creation.
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1. Support curve

2-1. First edge from the set of smoothly conjugated edges of the first guide

2-2. Second edge from the set of smoothly conjugated edges of the first guide

3-1. First part of the set of smoothly conjugate faces of the first face

3-2. Second part of the set of smoothly conjugate faces of the first face

4-1. First edge from the set of smoothly conjugated edges of the second guide

4-2. Second edge from the set of smoothly conjugated edges of the second guide

5-1. First part of the set of smoothly conjugate faces of the second face

5-2. Second part of the set of smoothly conjugate faces of the second face

8. Resulting surface, the shape of which depends on the discriminant

Discriminant equals 0.3 Discriminant equals 0.5 Discriminant equals 0.7

Conic – Path

To create a Conic – Path surface do the following:

1. Select Support Curve. It can be a path, a route, an open profile, an edge or a sequence of

smoothly-joint edges. 
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2. Select First Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges. The first guide must entirely belong to the first face. 

3. Select First Face. It can be set by a face, a surface or a sequence of smoothly-joint faces.

4. Select Second Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges. The second guide must entirely belong to the second face.

5. Select Second Face. It can be set by a face, a surface or a sequence of smoothly-joint faces.

6. Select Middle Path. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges.

7. Change or leave the default values for the parameters determining design accuracy.

8. Confirm the surface creation.

1. Support curve

2-1. First edge from the set of smoothly conjugated edges of the first guide

2-2. Second edge from the set of smoothly conjugated edges of the first guide

3-1. First part of the set of smoothly conjugate faces of the first face

3-2. Second part of the set of smoothly conjugate faces of the first face

4-1. First edge from the set of smoothly conjugated edges of the second guide

4-2. Second edge from the set of smoothly conjugated edges of the second guide

5-1. First part of the set of smoothly conjugate faces of the second face

5-2. Second part of the set of smoothly conjugate faces of the second face

6. Middle path

8. Resulting surface

Conic – Tangent

To create a Conic – Tangent surface do the following:

1. Select Support Curve. It can be a path, a route, an open profile, an edge or a sequence of

smoothly-joint edges. 

2. Select First Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges. The first guide must entirely belong to the first face. 

3. Select First Face. It can be set by a face, a surface or a sequence of smoothly-joint faces.

4. Select Second Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges. The second guide must entirely belong to the second face.

5. Select Second Face. It can be set by a face, a surface or a sequence of smoothly-joint faces.
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6. Select First Reference Curve. It can be a path, a route, an open profile, an edge or a sequence of

smoothly-joint edges.

7. Select Second Reference Curve. It can be a path, a route, an open profile, an edge or a sequence of

smoothly-joint edges.

8. Change or leave the default values for the parameters determining design accuracy.

9. Confirm the surface creation.

1. Support curve

2-1. First edge from the set of smoothly conjugated edges of the first guide

2-2. Second edge from the set of smoothly conjugated edges of the first guide

3-1. First part of the set of smoothly conjugate faces of the first face

3-2. Second part of the set of smoothly conjugate faces of the first face

4-1. First edge from the set of smoothly conjugated edges of the second guide

4-2. Second edge from the set of smoothly conjugated edges of the second guide

5-1. First part of the set of smoothly conjugate faces of the second face

5-2. Second part of the set of smoothly conjugate faces of the second face

6. First reference curve

7. Second reference curve

9. Resulting surface

Conic - Four Points

Conic - 4 Points. It creates a conical section surface that smoothly touches a given surface along the

specified guide curve (First Guide), while the shape of the surface is determined by three other guide

curves.

To create a Conic – 4 Points surface do the following:

1. Select Support Curve. It can be a path, a route, an open profile, an edge or a sequence of

smoothly-joint edges. 

2. Select First Face. It can be set by a face, a surface or a sequence of smoothly-joint faces.

3. Select First Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges. The first guide must entirely belong to the first face. 

4. Select Second Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges. The second guide must entirely belong to the first face.
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5. Select Third Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges. The second guide must entirely belong to the first face.

6. Select Fourth Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges. The second guide must entirely belong to the first face.

7. Change or leave the default values for the parameters determining design accuracy.

8. Confirm the surface creation.

1. Support curve

2. First face

3. First guide

4. Second guide

5. Third guide

6. Fourth guide

8. Resulting surface

Circle – Tangent to Surface

To create a Circle – Tangent to Surface surface do the following:

1. Select Tangent Face. It can be set by a face, a surface or a sequence of smoothly-joint faces.

2. Select Axial Curve. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges.

3. Select Support Curve if necessary. It can be a path, a route, an open profile, an edge or a sequence

of smoothly-joint edges. In case the support curve is not selected, the axial curve sets the

orientation for generating profiles. 

4. Set Angle. The range for angle value is from 0° to 180°. The value can be constant or variable, set

by the diagram. In case you use the diagram, the range is from 0 to 179,99°. The diagram cannot

switch from the negative to the positive area or vice versa. The abscissa axis of the diagram is the

supporting curve length. The angle is settled symmetrically in both sides from the tangent point.

5. Change or leave the default values for the parameters determining design accuracy.

6. Confirm the surface creation.
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1. Tangent face

2. Axial curve

3. Support curve

4. Angle (ordinate axis) relative to the length of the support curve (abscissa axis)

6. Resulting surface

Circle – Radius

To create a Circle – Radius surface do the following:

1.  Select Axial Curve. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges.

2.  Select Support Curve if necessary. It can be a path, a route, an open profile, an edge or a sequence

of smoothly-joint edges. In case the support curve is not selected, the axial curve sets the

orientation for generating profiles. 

3.  Select Radius Curve if necessary. It can be a path, a route, an open profile, an edge or a sequence

of smoothly-joint edges.

4.  Set Radius in case radius curve is not set. The value can be constant or variable, set by the diagram.

The abscissa axis of the diagram is the supporting curve length. 

5.  Change or leave the default values for the parameters determining design accuracy.

6.  Confirm the surface creation.
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1-1. First edge from the set of smoothly conjugate edges of the axial curve

1-2. Second edge from the set of smoothly conjugate edges of the axial curve

4. Radius (ordinate axis) relative to the length of the support curve (abscissa axis)

6. Resulting surface

1-1. First edge from the set of smoothly conjugate edges of the axial curve

1-2. Second edge from the set of smoothly conjugate edges of the axial curve

2. Support curve

3. Radius curve

6. Resulting surface

Circle – Radius and Angle

To create a Circle – Radius and Angle surface do the following:

1. Select Support Curve. It can be a path, a route, an open profile, an edge or a sequence of

smoothly-joint edges. 

2. Select Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-joint

edges. It must entirely belong to the tangent face. 

3. Select Tangent Face. It can be set by a face, a surface or a sequence of smoothly-joint faces.

4. Set Radius. The value can be constant or variable, set by the diagram.

5. Set Angle. The range for angle value is from -360° to +360°. The value can be constant or variable,

set by the diagram. In case you use the diagram, the range is from -359,99° to 0 or from 0 to

+359,99°. The diagram cannot switch from the negative to the positive area or vice versa. The

abscissa axis of the diagram is the supporting curve length. 

6. If necessary, enable Reverse Direction. Whether the flag is on/off, the tangent direction switches to

the opposite. Combining angle parameters and reverse direction enables you to create a surface in

any of the quarters of the symbolic coordinate system set by the initial surface and the directing

curve.

7. Change or leave the default values for the parameters determining design accuracy.

8. Confirm the surface creation.
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1. Support curve

2. Guide

3. Tangent face

4. Radius (ordinate axis) relative to the length of the support curve (abscissa axis)

5. Angle (ordinate axis) relative to the length of the support curve (abscissa axis)

8. Resulting surface

6. Radius reverse derection

6. Angle reverse derection
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Circle – Three Points

To create a Circle – Three Points surface do the following:

1. Select Support Curve. It can be a path, a route, an open profile, an edge or a sequence of

smoothly-joint edges. 

2. Select First Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges.

3. Select Second Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges.

4. Select Internal Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges.

5. Change or leave the default values for the parameters determining design accuracy.

6. Confirm the surface creation.

1. Support curve

2. First guide

3. Second guide

4. Internal guide

6. Resulting surface

Line – Angle

To create a Line – Angle surface do the following:

1. Select Support Curve. It can be a path, a route, an open profile, an edge or a sequence of

smoothly-joint edges. 

2. Select First Guide. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges.

3. Select End Face. It can be set by a face, a surface or a sequence of smoothly-joint faces.

4. Set Angle. The range for angle value is from 0° to 180°. The value can be constant or variable, set

by the diagram. In case you use the diagram, the range is also from 0° to 180°. Switching the

diagram from the negative to the positive area or vice versa is available. If the value equals 0° or

180°, the surface is built tangent. The abscissa axis of the diagram is the supporting curve length.

5. Change or leave the default values for the parameters determining design accuracy.

6. Confirm the surface creation.
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1. Support curve

2. First guide

3. End face

4. Angle (ordinate axis) relative to the length of the support curve (abscissa axis)

6. Resulting surface

Line – Tangent

To create a Line – Tangent surface do the following:

1) Select Support Curve. It can be a path, a route, an open profile, an edge or a sequence of smoothly-

joint edges. 

2) Select First Face. It can be set by a face, a surface or a sequence of smoothly-joint faces.

3) Select Second Face. It can be set by a face, a surface or a sequence of smoothly-joint faces.

4) Change or leave the default values for the parameters determining design accuracy.

5) Confirm the surface creation.
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1. Support curve

2. First face

3. Second face

5. Resulting surface

Ruled Surface

Calling the command:

Icon Ribbon

3D Model > Special > Surfaces > Ruled Surface

Surfaces > Operations > Ruled Surface

Keyboard Textual Menu

<3Q> Operation > Surfaces > Ruled Surface

The command allows you to create surfaces using two selected sections. The forming line of the

created surfaces is a straight line. Edges/3D Profiles/3D Paths, as well as any geometric points, can be

selected as sections.

There is an opportunity to change the direction of the entire section. When you select the second

section, the first one will automatically reverse.

Sections can be smooth or with jogs.

There are two types of alignment - By arc length and By support curve.
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The essence of the By Arc Length type is the distribution of isoparametric curves, i.e. the intervals

between adjacent isoparametric curves are equally related to the total length.

There is possibility to create surfaces between closed contours, provided that both contours are

closed. In this case, fields will appear that allow you to set the start of the first and second sections.

It is necessary to choose points as the start of sections. Below is a model without indicating the start of

the section, i.e. the start of the second and first section is selected automatically.

If you select the 3D node located on the first section as the start of the second section, the result will

look like this: 
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The essence of the type By Support Curve is that in each cross section to the support curve, a straight

line will be displayed on the resulting surface. You can select a 3D Profile/3D Path/Set of edges as a

support curve.
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There is also possiblity to specify closed sections with jogs. 

Extend by Law

Calling the command:

Icon Ribbon

3D Model > Special > Surfaces > Extended by Law

Surfaces > Operations > Extended by Law

Keyboard Textual Menu

<3CW> Operations > Surfaces > Extended by Law

Extended by Law is an operation referring to modeling both surfaces and solid bodies. 
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The command is divided into two types – Line and Circle Arc. With the Line type, a surface passing

through a selected guide at a given angle to a selected face. The surface created can have either one

free edge whose geometry is specified by the user, in which case the surface is limited by the directrix,

or two free edges, in which case the guide lies within the surface being created. Thickness can be

added to the surface being created – then a solid body is built.

The command is useful for creating surfaces made of edges of a complex shape leaning against

curved surfaces e.g. when working with case bodies in aviation, space engineering and shipbuilding.

In solid body modeling the command enables users to efficiently create grooves obtained by milling.

With the Circle Arc type, the surface touches the specified face at the specified edge.

For such a surface, you can set the boundary conditions G1 and G2, as well as the direction and length.

Additional parameters

Accuracy. The parameter sets tolerance to the surface being created – the deviation of the surface

obtained from the accurate solution. It is measured in meters. By default, the accuracy parameter

equals 0,00001 m.

Simplify Geometry. The option deletes redundant edges. 
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Options

There is an additional ability enabled by default in the options: Dynamic preview. The option is

standard for all the 3-D Design commands. The option enables a simplified representation of the

surface being created which dynamically changes at changing of the initial parameters.

Topics in this section:

· Line Law

· Circle Arc Law

Line Law

Surface creation

To create a surface, choose two geometrical elements: Face and Guides.

Face. The initial face can belong to the surface (a sheet body) or a solid body.

Guides. The initial face must lie within the face, can be comprised of several elements and either be

smooth or have fractures. The directrix can be closed.

The surface being built is determined by two main features: Height and Angle.

Height. Determines the generatrix length set by the distance from the directrix to the free edge of the

surface.

Angle. Determines the angle between the generatrix and the normal to the initial face built at the

point lying at the directrix.

1 – Guides 2 – surface free edge 3 – Height 4 – Angle

Breakage processing

In case the directrix is not smoothly joint and has fractures, the surface being built can have breakages

or self-intersections. To deal with such cases there is a special option Extend for fracture processing in

the command. In this case the surfaces are extended to intersection or vice versa, cut along the

intersection line. In case there is no need for such processing, select the Split variant.
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Extend Split

Guides smoothly joint Guides not smoothly joint

There is the third processing variant: Round. In this case the breakage section will be filled with a

surface whose cross-section is a circular arc tangent to the surfaces.

If there is no breakage section, i.e. the planes were “cut” along the intersection line, the option

Round is not available.

Fracture rounding Fracture rounding is impossible

In case the directrix has fractures and lies at an uneven face, the Angle parameter can only be

equal to zero. In all other cases the Angle parameter can have any value.

Building a body

General parameters

Thickness can be added to the surface being created. In this case the surface will be pushed along the

normal at a given value. The pushing value of the surface is determined by Offset parameter. Pushing

variants can be selected from Thickness list. By default variant No is selected, i.e. the system builds a

surface by default.
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Roundings

In case the initial face belongs to a solid body, users can create grooves representing the trace of a

mill with the help of Law Extension command. To do it you need to build the surface inwards the

body: select Inside variant in Extension parameter. The groove thickness relative to the directrix is set

by thickness adding variants and Offset parameter value. To get the obtained body subtracted from

the body containing the initial face, select the Boolean operation Subtraction variant. End edges or

faces can be rounded which imitates the mill trace. To do this, select the rounding variant: Edges or

Faces. If you select Faces variant, end faces will be cylindrical surfaces with a radius equal to half the

thickness of the groove obtained. 

No rounding Edge rounding Face rounding

If the directrix has fractures, they can be processed when creating the body. Select the Round variant

in the Kinks parameter. In this case a rounding will be created at the external body bend which is

equal to half the body thickness. In case the Edges variant is selected in the Rounding parameter, the

external body bend will be rounded with a radius specified in the Radius field. The options listed

enable users to imitate a mill with a given diameter creating a groove. 
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Rounding radius equals half the thickness Rounding radius value is specified

It is possible to define Height and Angle via a graph depending on a guide length.

Clicking the  button invokes a graph type selection dialog. Then the graph can be edited using the

T-FLEX CAD Graph editor.

Constant height and angle
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Height defined via graph

Angle defined via graph

Topics in this section:

· Solid Body Creation when Extending by Line Law

· Surface Creation when Extending by Line Law

Solid Body Creation when Extending by Line Law

To create a body, do the following:

Realize all the steps of surface creation given above.

1) Change the Thickness parameter from the variant No to a variant from the list.

Outside. The surface offset direction coincides with the surface normal.

Inside. The surface offset direction is opposite to the surface normal.
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Symmetric. The surface offset is done along and transverse to the normal, symmetrically relative to

the surface.

Different. If this variant is selected, you can set different surface offset values for inwards and

outwards directions.

2) Set the offset. Specify the surface offset length in the Offset field. In case the thickness variant

Different is selected, there will be two input fields available: Offset (outside) and Offset (inside),

determining surface offset values for inwards and outwards directions.

3) Select the rounding variant from the list.

No. No rounding is performed.

Edges. End edges of the body are rounded at a given radius.

Faces. End faces of the body are rounded at a radius equal to half the thickness: end faces are

cylindrical surfaces.

Edges Faces

4) In case Edges rounding variant is selected, specify rounding radius in the Radius field.  

5) In case it is necessary to round external edges at fractures, select the Round variant in the Kinks

parameter. If the variants No or Faces are selected in the Rounding parameter, rounding will be

performed at a radius equal to half the body thickness. If the Edges variant is selected, rounding

will be performed at the radius set in the Radius field.

Kinks: Round. Rounding: No Kinks: Round. Rounding: Faces Kinks: Round. Rounding: Edges

6) Select a Boolean operation variant from the list.

No. No Boolean operation is performed.

Addition. The body with the initial face and the body being created are joined together.

Subtraction. The body being created is subtracted from the body with the initial face. The option is

only available for solid body modeling.
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A Boolean operation can be performed only in the case when the body with the initial face and

the body being created are of the same type: a sheet body can be joined with another sheet

body only, a solid body – with a solid body. In case the body with the initial face and the body

being created are of different types, the finish operation button is not available.

7) Finish the command by means of .

Surface Creation when Extending by Line Law

To create a surface, do the following:

1) Select a face relative to whose normals the incline of the surface being built will be set.

2) Select the directrix. It can be a path, a route, a profile, an edge or a sequence of elements. The

element selected should be closed. The sequence can contain both smoothly joint and not

smoothly joint elements. The sequence can form a closed contour. The directrix should entirely lie

within the specified face.

3) Select a variant to continue from the list. The Extension parameter determines the direction of

surface creation.

Outside. If a solid body face is selected, the surface will be created at the external side of the body. If

a surface face is selected, the direction is determined by the normal to the face. In this case the

direction of surface creation coincides with the normal direction. If the opposite direction is required,

select the Inside variant.

Inside. If a solid body face is selected, the surface will be created at the internal side of the body. If a

surface face is selected, the direction is determined by the normal to the face. In this case the direction

of surface creation is opposite to the normal direction. If the opposite direction is required, select the

Outside variant.

Symmetric. The surface is symmetrical to the face selected.

Different. This variant makes it possible to set different values for the surface height in inwards and

outwards directions.

4) Set the surface height. Specify the distance from the directrix to the surface edge in the Height

field. In case the Different extension variant is selected, two input fields are available: Height

(outside) and Height (inside) which determine height in corresponding directions.

5) Set the incline angle of the surface being created to the normals of the selected face: enter the

value in the Angle field. By default the value equals to zero. This means that the surface being

created is located along the normal to the selected face. If the value is 90°, the surface being

created is tangent to the face selected. In case it is necessary to change the incline direction to the

opposite one, set the flag in the Mirror option on.

6) Select fracture processing variant from the list in case the contour being created has fractures.

Split. Every section of a broken directrix forms its own face not connected with the faces formed by

other sections. 

Extend. Faces formed by a broken directrix are extended to intersection or vice versa cut along the

intersection line.
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Split Extend

Round. Faces formed by a broken directrix are joined by the surface formed by the circular arc of a

variable radius. This option is only available when there is a breakage between the surface faces. In

case of their intersection the option cannot be used.

7) Finish the command by means of .

Circle Arc Law

Only a surface can be created for the Circle Arc type.

Surface creation

To create a surface, follow these steps.

1. Select the face from which the surface will come out.

2. Select an edge tangent to face.

3. Select the boundary condition G1 or G2. For the G1 boundary condition, the setting of the radius and

the change of surface direction will become available. For the G2 boundary condition, the radius is

calculated automatically. The peculiarity of this condition is that it is not necessary to calculate the

radius of curvature of the edge at its point, but the radius of curvature of the surface in a given

direction (at the same point of the edge). If the curvature in a given direction changes its sign, then the

resulting surface at this point will bend in the other direction.

G1 connects the profile curves of the surface with continuity in touch to the boundary surfaces.

G2 connects the profile curves of the surface with continuity in curvature to the boundary

conditions.

For G2, it is necessary to choose non-planar faces, because the plane has no curvature.

4. Set the direction. There are two options available - Perpendicular and Isoparametric.

Perpendicular allows you to set the direction of the surface perpendicular to the selected edge.
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In some cases, it is not enough to continue the surface perpendicular to the edge. For example, in the

image below, the Perpendicular option does not give the necessary result.

For such cases, the Isoparametric option is designed, which allows you to create a continuation

tangentially to the isoparametric curves of the face at each point of the selected edge.
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5. Set the length of the surface to be created.

Length = 100 Length = 200

It is possible to set a dependency graph (see the Graphs section).

6. If the G1 boundary condition is selected, then it becomes possible to set the radius of the surface to

be created.

Length = 100, Radius = 100 Length = 100, Radius = 50

It is possible to set a dependency graph (see the Graphs section).

7. If the G1 boundary condition is selected, then it becomes possible to change the direction of the

surface.
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Normal direction of the

surface

 Reversed direction of the

 surface

8. Select a Boolean operation variant from the list.

No. No Boolean operation is performed.

Addition. The body with the initial face and the body being created are joined together.

Subtraction. The body being created is subtracted from the body with the initial face. The option is

only available for solid body modeling.

A Boolean operation can be performed only if the body with the source face and the created

body are of the same type, i.e. a surface can be combined only with a surface body.

9. Finish the command by means of .

Offset Surface

Calling the command:

Icon Ribbon

3D Model > Advanced > Offset Surface

Surfaces > Operations > Offset Surface

Keyboard Textual Menu

<3SO> Operation > Offset Surface

An offset surface enables users to create equidistant surfaces from body faces or surfaces. The offset is

performed by the normal to the faces chosen: along or contrary to the normal at a given value. The

operation is helpful for creating external surfaces of thin-walled parts basing on the built internal

surfaces or vice versa.
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Setting the operation

Select the faces which the offset is built from. The faces should belong to one body or surface, you

cannot select faces of different bodies or surfaces. The selected faces can be smoothly-joint, having

common edges, or not joint. Face selection mode is active automatically at calling the command.

<T> Select Face with different wall thickness

The faces selected are shown in the dialog in a special list. The list of selected faces can be edited:

you can remove a face from the list with the help of  or clear all the list with .

You can set its own offset value and direction for every face. The offset value is shown in Face Offset

field. You can change the direction to the opposite by means of . The offset value and direction can

be set at the 3D scene with the help of a dragger available for every selected face.

You can set the same offset parameters for several faces if you select them in the list holding the

<Shift> key down. In case you use draggers at the 3D scene, the draggers of the faces selected from

the list move jointly according to any of the draggers’ movements.

To finish the command with creating the surface according to the parameters set, do the following:
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<Сtrl+Enter> Finish input

To exit the command without creating the surface, do the following:

<X> Exit command

Additional operation parameters

Keep Source Body. This option enables you to leave the initial body or surface at the 3D scene along

with the result. This can be helpful when it is necessary to have both initial and resulting faces at the

same time.

Options

Dynamic preview. The option is standard for all the 3D Design commands. It enables a simplified

representation of the surface being built which dynamically changes when the initial parameters

change. The option is enabled by default.

Use draggers. The option is standard for all the 3D Design commands and is enabled by default. It

enables auxiliary graphical objects – draggers. There is one type of draggers in this operation: face

offset dragger.

Fill Hole

Calling the command:

Icon Ribbon

3D Model > Special > Faces > Fill Hole

Surfaces > Operations > Fill Hole

Keyboard Textual Menu

<3ZF> Operation > Surfaces > Fill Hole

This operation is intended to fill closed empty areas-contours in the surface of a body or a closed

"empty" area formed between the surfaces of different bodies.

In addition, you can use the operation to create surfaces without contours along a 3D path, 3D profile,

or a set of edges.
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The command is used for surface and solid modeling. The use of the command in solid modeling has

significant limitations. In addition, it can be useful when working with imported models, the bodies of

which have voids resulting from the loss of some faces during poor-quality export/import.

Topics in this section:

· Fill Hole. Main Concepts

· Contour Selection

· Contour Parameters

· Common Parameters

Fill Hole. Main Concepts

Selecting areas to fill

When performing an operation, you can fill several holes at once in one body.

Each hole is defined by its own contour - a set of edges that bound this area. To define the contour, it

is necessary to specify all the edges of the body included in it. The contours must be closed.

When defining contours, all edges of a closed contour are automatically selected, it is enough to

specify one of the edges of each contour.

There are three main scenarios for working with an operation:

1. There is a source operation and the result is merged into one body using the Merge option:

2. There is a source operation, the result is not merged, i.e. separate bodies are created:
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3. There is no source operation, the contour is selected separately:

If there is no source surface, then the system cannot determine the boundary conditions from it.

In an operation, it is possible to combine surface edges with 3D path or 3D profile edges.

Source surface and 3D path

Result surface created along the

edge of the source surface and 3D

path

In addition, it is possible to select edges from two different surfaces as one contour.
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1. First surface

2. Second surface

3. Contour consisting of edges of different surfaces

4. Result surface

Boundary Conditions

In the operation, you can control the overall smoothness of the created surface and the smoothness of

the surface at the edges (edges).

There are three types of the surface smoothing on the edges of the filling area:

· G0 – non-smooth conjunction of surfaces,

· G1 – tangent conjunction;

· G2 – smoothing with equal curvature on the edge of the surfaces conjunction.

G1 smoothing is set by default.

Smoothing can be set for each edge in a path.

Examples for G1 and G2 smoothing are given below.

G1 smoothing is set for all the edges G2 smoothing is set for all the edges

When the G1 smoothing is applied, the curvature changes dramatically. When the G2 smoothing is

applied, the curvature function has no breaks except for places that were obtained using other

operations: smoothing, contour extraction, etc.
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Contour Selection

After starting the command, the system prompts you to select the contour of the filled area. Several

3D paths (closed), several 3D profiles (closed) or a set of edges (closed) can be specified as a contour.

It is possible to simultaneously select 3D paths/3D profiles/edges as one contour.

1. Closed 3D Path

2. Closed 3D Profile

3. Closed set of edges

When you select a contour, the source operation to which the selected contour belongs is

automatically selected. A surface or a solid can be selected as the source operation.

It is recommended to use the surface bodies.

All contours (or part of the contours) must belong to the source operation.

In some cases, the source operation may not exist, for example, if you select a closed 3D path. In this

case, the surface will be created along the contour, but it will not be possible to set boundary

conditions for it.

Without boundary condition With source operation
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1. Closed 3D Path

2. Closed set of edges

3. Result surface

If an edge is selected as a contour element, the system tries to define the entire contour as a whole,

i.e. selects adjacent edges. The selected elements are placed in the Composition field, which displays

the element type and its  Boundary Condition.

With the Merge option, you can adjust the boolean addition operation, i.e. merge the created surface

with the source one. The option is enabled by default. If it is necessary to create a separate filling

surface, the option must be disabled.

With merging Without merging

1. Result single surface

2. Source surface

3. Surface filled along contour

Contour Parameters

After selecting the contour, you need to configure the parameters for creating the surface.

There are four parameters available - Method, Shape, Smoothness, and Auxiliary Condition.

Method

With this parameter, you can adjust the filling method of the area.

This parameter has two options Patch and Extend.

Patch enables you to fill an area in the classic way, leaving a "trail" of filling the area in the form of

edges.

Source surface Filling an area with patch method
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This option is the main method.

Extend is a special case and enables you to "tighten" the surface.

Source surface Filling an area with extend method

With this method, the selection of the remaining parameters becomes unavailable.

Shape

With this parameter, you can adjust the shape of the created surface.

This parameter has four options - Smooth, Non-smooth, Preferable Plane, Plane.

With the Smooth option, you can fill the area using the boundary condition G0, G1 or G2 for each

boundary edge, and also control the overall smoothness for the contour.

Source surface "Smooth" shape of the surface
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The Preferable Plane option can also control the overall smoothness, but you cannot set boundary

conditions for each edge. The system first tries to fill the selected area with a plane, and in case of

failure, a spline surface. In this case, the result will be similar to the Smooth option, but it will not be

possible to set edge conditions for the edges.

Successful plane filling Unsuccessful plane filling

With the Non-smooth option, the hole is filled, ignoring all smoothness requirements, using an

analytical solution where possible.
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Source surface
"Non-Smooth" shape of the

surface

With the Plane option, you can only fill the body with a flat surface. All smoothness requirements are

not available for this option.

Source surface "Plane" shape of the surface

Auxiliary Condition 

With the help of auxiliary conditions, you can specify the behavior of the created surface.

Auxiliary condition Points enables you to create a surface passing through a set of points, belonging

or not belonging to the contour.

Source surface Result surface over set of points
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1. Source surface

2. Set of points through which the result surface should pass

3. Result surface

A Normal can be specified for each point. After selecting the appropriate option, a menu for

specifying vectors will appear, similar to the Loft operation. The only difference is that the length of

the vector is taken from the unit length.

Result surface over set of points
Result surface over set of points with

indication of normal for points

Auxiliary condition Vertex enables you to select one point, which belongs or does not belong to the

contour, and create a surface relative to it. Under this condition, the type of Clamp can be selected.

Clamp type accepts three values - No, Auto, Normal. When the No mode is selected, the surface is

created without additional smoothness conditions.

Source surface
Result surface one vertex at time

without clamping

If the Normal mode is selected, the system works in the same way as the auxiliary condition Points

using the normal.

Auto mode allows the system to independently determine the required clamp.

Auxiliary condition Edges enables you to set guides for the surface being created. The principle of

operation is similar to the guides in the Loft operation. If the selected guides are longer than the

boundaries of the contour, then the contour of the guide that is inside the contour will be used when

creating the surface.
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Source surface Result surface by guides

1. Guides (3D Paths)

For guides, you can also select Composition.

If necessary, guides can be imprinted on a face, that is, split a face along a guide.

Without imprinting the guides

Result is one face

With imprinting the guides

Result is two faces

In this figure, the selected shape is Non-Smooth, because Smooth shape can be only if the

edges meet the condition of tangency to the contour body.

With the auxiliary condition Faces, additional faces are specified that will be converted to a filling

surface. If the faces are outside the area to be filled, then you can specify the source surface LCS and

the face LCS, with which the system can correctly determine where the area is filled. You can fill an

area along the edges of an additional surface with a trim by contour ...

Source and additional surfaces
Filling holes by faces of additional

surface with trimming by contour
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1. Source LCS

2. LCS of faces

... and trim by faces. In this case, you can fill in multiple contours.

Source and additional surfaces
Filling holes by faces of additional

surface with trimming by faces

1. Source LCS

2. LCS of faces

With the auxiliary condition Surface, the contour is projected onto the auxiliary surface along the

normal. The resulting projection is a bounding path on the selected surface. The surface obtained

inside the contour is the result of the operation. A workplane/surface, 3D profile, face, edge, or

operation can be selected as an additional surface. If you merge with the source body, then the result

must be on the source body.

Source and auxiliary surfaces
Filling holes by creating surface

without merging
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1. Source surface

2. Auxiliary surface (Workplane)

3. Result surface

For toroidal and spherical surfaces, face refinement may be required. For this, an auxiliary point is set,

thanks to which the closest face to this point is selected.

Common Parameters

Accuracy

The tolerance value at which objects are approximated or considered to be coincident. The default is

0.00001 m.

Split

When filling an area, a situation may arise when the resulting surface is divided by edges into several

separate faces. In this case, you can simplify the geometry using the Split option. This option works

similarly to the Split option in the Loft operation.

Thin Wall

By default, the thin-walled element option is enabled in the operation, i.e. a body-surface is created.

If the source surface is closed, then you can create a solid body by unchecking the thin-walled element

option.

Source surface Resulting solid body
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Sew

Calling the command:

Icon Ribbon

3D Model > Special > Surfaces > Sew

Surfaces > Operations > Sew

Keyboard Textual Menu

<3SS> Operation > Surfaces > Sew

This command unites a set of disjoint surfaces into one sheet body and, if necessary, creates a closed

volume, yielding a solid body.

To create the operation, you need to define the set of surfaces to sew. You can select 3D profiles,

faces or operations as the original surfaces. In the latter case, the operation must be a sheet body, for

example, the result of extruding or rotating a wire contour, or an import surface from other

applications.

The surfaces being sewn must adjoin without overlapping.

The result of sewing can be either a solid body or a new surface body. By default, a solid body is

created. In this case, the system attempts to create missing faces to make a closed volume.

 

Original model Surface body created Solid body created
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In some cases (for example, when the missing surface requires more than one face), the solid body

cannot be created.

     

To execute the command, do the following:

1. Select surfaces to sew.

2. Specify advanced parameters (optional).

3. Confirm operation creation.

Selection of sewing surfaces

To make a sewing, you need to specify the 3D elements defining the set of surfaces to sew. This can

be done with the help of the following automenu options:

<R> Select 3D Profile

<F> Select Face

<O> Select surface operation

...or corresponding filters in the filter toolbar.

The selected 3D elements are entered in the Elements list in the command's parameters window.

When selecting faces of some body (or several bodies), you can additionally tell the system which set

of faces of this body (bodies) to sew: Only Selected or All Excluding Selected. 
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There are two ways to cancel a 3D element selection:

· Pick this element again in the 3D scene using ;

· Pick it in the Elements list in the command's parameters window and click Delete Element

from the List.

To cancel the selection of all elements at once, use the option:

<K> Cancel selection

The Result parameter allows you to select the sewing result. The Solid option specifies whether to

create a solid from the sewing faces.

Quilting can be used for more than just combining disparate surfaces into one solid. This operation

can also be used to create a surface from one or more body faces. To do this, it is enough to select

this face or faces as sewing ones. In this case, you must select the Surface option. This will create a

new surface. In the future, it can be used to construct an equidistant (offset) surface using the Shell

operation. With the Default option, the system tries to create a solid body, and if this is not possible, it

creates a surface. This option is selected by default.

The Keep source bodies option allows you not to delete the bodies on the basis of which the sewing

was performed.

If the surface consists of several faces and these faces are smoothly joined, then by turning on the

Process smooth faces option, you can select one face, and it will find other smooth faces to it within

the same body. The Angular Tolerance field allows you to define the accuracy with which the faces

are smooth.

The Process faces independently option provides the ability to stitch together in one operation

several separate bodies that are not in contact with each other.
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Imprint Elements

Calling the command:

Icon Ribbon

3D Model > Special > Surfaces > Imprint Elements

Surfaces > Operations > Imprint Elements

Keyboard Textual Menu

<3ZS> Operation > Surfaces > Imprint Elements

This command is used for defining areas of specified shape on already existing faces. This might be

necessary, in particular, for imprinting separator lines and surfaces into a 3D model as part of

preparation for FEA analysis. Those elements could be used, for example, for defining forces applied

to the model.

     

An element being split (the imprint target) can be one or several sfaces, or a whole operation. Those

elements will serve as a basis for creating the new faces. Depending on the splitting method, the

shape of the new area is defined based on either the shape of the dividing element (the imprint tool),

as Face, Edge, 3D Profile, Operation, or based on the geometry of the imprint target elements.

To create the operation, do the following steps:

1. Select the splitting method.

2. Select the objects to split (the imprint targets).

3. Select the imprint tool objects (optional).

4. Specify the direction (optional).
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5. Confirm operation creation.

Selecting splitting method

A splitting method defines how the boundaries of the new faces will be determined, and, therefore,

what data you need to specify. Select the splitting method from the pulldown list of a combo box

located at the top of the property window. Upon entering the command, the method "Projection by

direction " is set by default.

Selecting imprint target objects

The imprint target are the objects that will be split as a result of the operation. 

It is possible to use multi-solid operations and multi-contour profiles as the imprinted elements.

To launch the imprint target selection mode, use the automenu options:

<B> Select target operation

<F> Select target faces

Another way to select is by clicking the mouse on an empty line in the Imprint targets pane. After that,

you can proceed with selecting the desired faces or operations in the 3D window. Selecting an

operation as the imprint target means that all faces of the operation will be selected for imprinting.

The system will correctly handle the situations when the number of the original operation's faces

changes after regeneration.

To cancel selection use option:

<R> Cancel target selection objects

Selecting imprint tool objects

Selection of imprint tools takes place only in the following imprinting methods: Projection by

direction, Projection by normal and Intersection. In the other cases, you do not need to select the

imprint tools.

It is possible to use multi-solid operations and multi-contour profiles as the imprinting elements.

In the first two cases, you can use the option:
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<С> Select tool contours

The option allows selecting elements (3D Paths, Edges, Profiles, Faces and Loops) that define

boundaries of new faces.

With the method Intersection, use either of the options:

<O> Select tool operation

(In this case, the system constructs an intersection with all faces of the operation), or the option:

<A> Select tool faces

(the system considers the selected faces only).

If an operation was selected as the imprint target, then you can select a plane as the tool. In this case,

use the option:

<P> Select tool plane

To cancel selection use option:

<K> Cancel selection of tool objects

Defining the direction 

You must specify the direction if using one of the following split methods, Projection by direction,

Projection as outline or Create isoclinical curves. In all those cases, the direction can be specified by

selecting two 3D nodes. For this purpose, use one of the options:

<1> Select first point

<2> Select second point

Alternatively, use the option:

<D> Select direction

That allows selecting elements for explicitly specifying the direction.

Make sure that the profile mapping direction is towards the imprint target objects, otherwise the

application will display a message about an error regenerating the model, upon confirming the

operation.

If the mapping direction is away from the imprint targets, use the option Reverse direction to flip the

direction. The option is located at the bottom of the property window.
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To cancel selection use option:

<U> Cancel selection of projecting direction

Topics in this section:

· Selecting Splitting Method

Selecting Splitting Method

Projection by direction 

In this method, the imprint tools are mapped on the imprint target objects along the specified

direction.

    

In this method, you need to specify the imprint tool and the imprint targets. Additionally, you need to

specify the mapping direction. If the imprint tool is a flat 3D profile, then the assumed direction is

along the 3D profile normal. Make sure that the profile mapping direction is towards the imprint

target objects. To use a different direction, specify it manually. 

It is possible that the imprint tool mapping occurs along the surface, or even on the opposite side of

the surface. In the Projection by direction method, upon selecting an imprint tool element, the option

Connecting disjoint components appears for selecting the mode of joining edges in this case.

No means the system will attempt to create new edges only on the visible faces as viewed in the

specified direction. Vertical means the system will attempt to create new edges on the faces visible in

the specified direction or parallel to this direction. All means the system will attempt to create the

edges on all faces, including the obstructed faces, as viewed in the specified direction. In this case, the

new edges on the obstructed faces must allow a connection with new edges on other faces.  The

following diagrams show the results produced by each option.
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                           No     Vertical      All

Projection by normal 

   

In this method, the boundaries of the new faces are determined by mapping the imprint tool objects

on each imprint target object along the normal to the imprint target. All you need to specify is the

imprint tool and target objects. 

If the imprint target is not flat, the normal changes from a point to a point of the surface. In such a

case, the imprint tool object is mapped on the target as follows: each point along the edges of the

imprint tool is mapped onto the point of the target that is the origin of the normal passing through

the point on the tool.

     

It is important that all points of the imprint tool had a unique mapping on the surface of the imprint

target. The command will fail otherwise.
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Intersection

In this method, the boundaries of the new faces are the intersection lines between the tool and the

target objects.

    

You need to specify the imprint tool and target objects. 

If sheet bodies are selected as the imprint target and tool objects, the combo boxes Imprint

completion and Completion method appear in the property window.

           

Those can be used in the case when the face of the tool sheet body does not fully intersect the imprint

target. In this case, setting Imprint completion to No results in no new edges created upon executing

the command. 

Alternatively, with the setting To nearest edge or To body boundary, the intersection line between

the bodies will be extended (in the first case – up to the nearest edge, in the second – through all

body), and that will be the edge.

The option Completion method lets you specify the direction of extending the edge: either tangent to

the edge, or normal (reverse normal). The effect of each parameter is shown on the diagram below.

Edge extended up to

the nearest edge

Edge extended up to

the sheet body

bound 

 Tangent direction  Normal   Reverse Normal 

Projection as outline

In this method, the boundaries of the new faces are determined by the outline edges of the imprint

target object.
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You need to specify the imprint target object and direction.

Create isoclinical curves 

In this method, the boundaries of the new faces are determined by an isocline. An isocline is a line

connecting points on the surface being split, in which the tangency line to the surface makes the same

constant angle with the specified direction. In 2D, this can be easily sketched (see the right-hand

diagram). In 3D, the system builds a set of points – a line.

            

Isoclines are convenient in mold design. In some cases, an isocline is required for making Taper

operation.
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Delete Faces

Calling the command:

Icon Ribbon

3D Model > Special > Surfaces > Delete Faces

Surfaces > Operations > Delete Faces

Keyboard Textual Menu

<3ZD> Operation > Surfaces > Delete Faces

General concepts

This command allows deleting one or several selected faces. Face deletion breaks solid body

topology. The introduced voids invalidate the closed volume. If required, the system can attempt

healing those by various means. Otherwise, the result will be a sheet body.

                            

The operation is used in surface and solid modeling, when local changes to the model topology are

desired, without affecting the original relations. It can also be helpful when preparing a model to

finite element analysis, for such tasks as removal of small model features that are insignificant to the

calculations.

You can directly select the faces to delete by explicitly picking the faces to delete. Alternatively, you

can indirectly specify such faces. In this way, you either select a chain of edges surrounding the faces

to delete, or a face on which the faces being deleted are dependent.

Using the command

To execute the command, do the following:

1. Select faces to delete.

2. Select a healing method.

3. Confirm operation creation.

Selecting healing method

Healing method determines the system actions after deleting the selected elements. It instructs

whether to close the introduced voids, and, if so, how. Select a method from the pull-down list of the

combo box in the property window. The command default method is Cap.
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Topics in this section:

· Selecting Faces to Delete

· Selecting Healing Method

· Advanced Parameters

Selecting Faces to Delete

The option Select Elements serves for selecting objects defining the faces to delete:

<F> Select Elements

You can also use the appropriate filters in the filter toolbar.

By default, you can select faces, edges and loops.

In the simplest case, you can select the exact faces to be deleted. However, besides that, there is a

convenient option of selecting a closed loop of edges that will define the faces to delete (the selected

elements are added to the "Faces" list). This option is not just for speeding up the selection of faces to

delete. In a parametric model, if a new face is created as a result of model modifications in the area

of faces deletion, this face will be correctly handled by the system.

  

A closed loop of edges divides all body faces into two sets: one to be deleted, and the other to be left

out. To determine what particular set of faces will be deleted and what left out, use the option Face

selection by edges.

The default option value is Auto, for the system to delete the set of faces with the least area. The

options Forward and Backward allow manual selection of the set of faces to delete.
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The set of faces to be deleted is automatically highlighted in the 3D window. Note that you can select

several closed loops of edges simultaneously (intersecting and nested loops are not allowed). This

makes possible defining more intricate sets of faces to delete. When selecting a set of edges, the

following option is turned on by default:

<G> Smooth edge chain selection mode

If you need to select specific edges, turn off this option.

Selecting Healing Method

No healing

In this case, the system just deletes the select faces, leaving the resulting void in the model as is. If the

original operation was a solid, then the model will lack the closed volume after the deletion, and will

become a sheet body.

    

Cap

In this way, upon deleting the faces the system tries to form a surface for closing the resulting void.

The capping surface must pass through all edges surrounding the void. As a result, this method works

in the cases, when all edges surrounding the voids are obtained by an intersection with a single

surface. This actually becomes the capping surface.
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Grow from parents

In this method, the system tries to close the voids caused by surface deletion by growing the faces

adjacent to the deleted faces.

  

Shrink

In this method, the system tries to close the voids caused by surface deletion not only by growing the

faces adjacent to the deleted (as in the previous method), but also by trimming them.

 

Advanced Parameters

Upon selecting the deletion method and the faces to delete, you can specify some advanced

parameters. 

When surfaces are deleted, one or several sets of new loops (of edges) can be created, surrounding

the model voids. By default, the system will try to process all those loops simultaneously, as part of

processing the model. In the process, the capping surface is being formed that is passing through all

loops (that's a ruled surface). However, in some case,s it is necessary to make separate capping

surfaces for each loop. 

The option Independent loops accounts for this.

The effect of this option can be demonstrated on the example of a hole with two chamfers. Suppose,

the surfaces of the hole and both chamfers are being deleted. In the course of the command, the faces
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of the hole are deleted, and two loops come into play (the upper and the lower loops), bounding the

void introduced in the body.

             Original model            Intermediate stage

If the option Independent loops is turned off, the system unites the two loops in order to close voids,

which results in another hole of a larger diameter than the original one. Instead, with the option

"Independent loops" turned on, the system processes each loop separately, which in this case results in

capping each with a flat surface. The hole completely disappears.

           Independent loops Off          Independent loops On

When using the Independent loops option, a situation can occur when two or more bodies are

produced by the operation, instead of one.

 

       Original model          Independent loops Off

 

          Independent loops On

The option Select blend edges is provided specifically for the cases of deleting faces created by

blending.  When deleting blends, one often needs to delete, besides the particular blend face, also

some other faces in order to correctly cap the voids introduced in the model.

Moreover, sometimes it is necessary to delete all blended faces adjacent to some flat face. Of course,

you could select such faces manually; however, more convenient is to select just the flat face. This lets

the system automatically select the blend faces to delete. Such automatic selection of faces insures

the model parametric behavior through changes in the number of blend faces, maintained by the

system.

The option Select blend edges method tells the system which faces to select and delete

automatically. There are several ways of selecting blend faces.
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Selected faces

The system will attempt to delete only the faces that were explicitly selected by the user.

    

Chains excluding branch faces

A smooth sequence of blend faces will be automatically selected for deletion. The sequence extends

up to the faces at which the chain branches into several chains of blend edges (up to branching faces).

  

Chains including branch faces

A smooth sequence of blend faces is automatically selected, extending up to and including the

branching faces.

   

Maximum chains

A smooth chain of as many blend faces as possible is selected automatically.
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Only dependent faces

Only those blend faces are selected automatically that are dependent on the faces selected by the

user. The user-selected faces themselves are not deleted.

 

Separate Faces

Calling the command:

Icon Ribbon

3D Model > Special > Surfaces > Separate Faces

Surfaces > Operations > Separate Faces

Keyboard Textual Menu

<3ZX> Operation > Surfaces > Separate Faces

This command allows excluding selected faces from an already existing body, and creating a new

body based on them. The resulting voids in the bodies can be closed by one of several methods.

    

When selecting the separation faces, that is, the faces that will be excluded from the existing body, the

same mechanism is used as in the command Delete Faces. The separation faces can be specified

explicitly or indirectly.
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To create the operation, do the following steps:

1. Select separation faces.

2. Specify the methods for processing the original and separated faces (optional).

3. Confirm operation creation.

Selecting separation faces

To select separation faces, use the option:

<F> Select Elements

...or corresponding filters in the filter toolbar.

When using this option, you can specify not only the particular faces to be separated, but also edges

and loops defining the faces to separate. All selected elements are automatically added to the list of

separation faces.

Specifying healing methods for original and separated faces

As a result of separating faces from the original body, voids may occur in the original and the

resulting bodies, that invalidate the closed volume. The options Healing source faces and Healing

separated faces allow selecting a healing method for such voids. The sets of methods for the original

and separated faces are the same.

 

Note that the original faces and the separated faces are either healed (Cap or Grow

parents/children), or left as is.

No healing

In this case, the system does not process the introduced voids. The resulting bodies are sheet bodies.

Cap

The system attempts to process the introduced voids by creating a single capping surface. The

capping surface must contain all edges surrounding the body's voids. Therefore, this method works in

the case when those edges result from intersecting the body with a single surface.

 

Depending on the original model geometry and the selected separation faces, more than two bodies

could result from the operation. In the model tree, the resulting bodies will have references to the

parent operation (the Imprint Elements) named: in the first two bodies - First part and Second part, in

other bodies – "Part", "Part_1", "Part_", etc.

Grow parents/children

In this case, the system tries to heal the introduced voids by growing the faces adjacent to the voids

(the child faces or parent faces).
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Depending on the geometry of the original model interfaces selected for separation, the operation

could yield more than two bodies.

To get the desired result on the original (source) and resulting faces, you can use various methods of

healing the voids (except for the "No healing" case).

Replace Faces

Calling the command:

Icon Ribbon

3D Model > Special > Surfaces > Replace Faces

Surfaces > Operations > Replace Faces

Keyboard Textual Menu

<3ZR> Operation > Surfaces > Replace Faces

This command allows replacing a geometrical surface underlying the selected face, by another

geometrical surface.

     

In the usual command flow, the faces to be replaced are selected in pairs with the replacement

surfaces (by selecting elements with these underlying surfaces). The surface underlying the face being

replaced is substituted by the replacement surface. As a result, the face being replaced changes its

shape according to the shape of the replacement surface. The side faces that bound the face being

replaced are extended or trimmed to the intersection with the replacement surface. If several pairs of

faces to replace - replacement surfaces were selected at once, this procedure is repeated for each

pair.



T-FLEX CAD 17 Help

1872

     

It is possible that no intersection between the side faces and the replacement surfaces will be found

despite extending the side faces. Then the command will end up in an error message.

   Command is successful                  Command fails

To create the operation, do the following steps:

1. Select sets (pairs) of faces to replace and the replacements.

2. Define advanced parameters (optional).

3. Confirm operation creation.

Selecting faces to replace and replacements

You can select multiple pairs of faces to replace and replacement surfaces.

To select faces to replace, use the option:

<F> Select replaceable faces

...or corresponding filters in the filter toolbar.

A face to replace could belong to a sheet body, but in that case it should be "surrounded" by

adjoining faces on all sides. 

To select replacement faces, use the option:

<R> Select replacement faces 

When specifying replacement faces, you can select not only faces, but also edges, workplanes and 3D

profiles. Selecting a workplane or a flat 3D profile is similar to selecting an appropriately positioned

flat face. If a non-flat 3D profile was selected, the system will use its underlying surface as the

replacement. An edge can be selected if it fully lies in a plane, but is not straight.

You can also start selecting a face to replace and a replacement surface via the property window.

Working with the "Faces" list is similar to working with other such lists.
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Besides simply selecting the replacement surfaces, it is also possible to select a sheet body. The

following option is used for this purpose:

<S> Select sheet body

When using this option, you can select sheet bodies, faces and 3D profiles.

The faces being replaced will be replaced by one or multiple new faces copying the shape of the

replacement sheet body.

  

While only a single sheet body is allowed, you can select multiple faces to replace at once.

When using a sheet body, the faces to be replaced may not have holes, otherwise the command will

fail. Besides that, the replacement sheet must be large enough, so that the intersection could be

constructed between the replacement sheet and the extensions of the adjacency faces.

To cancel selection of a particular pair of the face to be replaced - the replacement surface, you can

use the properties window and the button . As for canceling selection of all faces, you can use the

option:

<X> Cancel selection of all faces and surfaces

Selection of the replacement sheet body can be canceled by the option:

<K> Cancel sheet body selection

Defining advanced parameters

As was mentioned above, the adjoining faces are grown or trimmed to the intersection with the

replacement surfaces. If two intersections are found, which one will be picked by the system? By
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default, the intersection is accepted with the part of the surface where the normal points towards the

faces to be replaced. 

However, in some cases, you may want the system to pick the second intersection choice. For this

purpose, use the Reverse flag, located at the lower portion of the property window.

If the flag is set, the system will pick the intersection with the portion of the replacement surface,

whose normal points away from the face being replaced.

  

 
 

"Reverse" is Off

  

"Reverse" is On

Change Faces

Calling the command:

Icon Ribbon

3D Model > Special > Surfaces > Change Faces

Surfaces > Operations > Change Faces

Keyboard Textual Menu

<3ZC> Operation > Surfaces > Change Faces

This command allows modifying parameters of the faces whose underlying surfaces are analytical

(cylinder, cone, sphere and torus), as well as the parameters of faces created by a blend operation.

Most commonly, this command is used for handling imported models.

    

To use the command, select one or several faces to modify (faces being modified), and specify their

parameters. Parameters vary depending on the face type, and can be shared across all faces or be

specific to a face. The required condition for executing the command is, the face being modified must

be "surrounded" by adjacency faces.

To use the command, do the following sequence of steps:

1. Select faces to modify.

2. Define face parameters.

3. Define advanced parameters (optional).

4. Confirm operation creation.
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Selecting faces to modify

To select the faces to modify (the faces, whose parameters will be changed), use the option:

<F> Select faces

...or corresponding filters in the filter toolbar.

When selecting faces, the system allows selecting only the faces that can be modified, that is, cylinder,

cone, sphere and torus type surfaces and blend faces. It is allowed to select several faces at once, of

different types. The exception is the smoothing edges. They cannot be edited together with faces of

other types. When at least one smoothing face is selected, the selection of other types of faces is

blocked.

When selecting blend faces, you can use the Select blend edges method combo box. 

Exactly the same combo box is used among the properties of the command Delete Faces. The

command Change Faces utilizes this combo box in a similar way, except that the automatically

selected faces are subjected to parameter changes, rather than deleted. 

Once a face is selected, it is added to the Faces list. Working with this list is similar to working with

other such lists in the application.

To cancel selection of all faces at once, use the option:

<X> Cancel selection of all faces and surfaces

Defining face parameters

New parameters of surfaces are always defined in the property window. However, different

parameters can be defined depending on a face type. For the faces that are blends, cylinders and

spheres, you can define the radius. For cone faces, define the cone angle. For the faces – tori, define

the major and minor radii of the torus. Faces of different types may be selected when defining the

command. The appearance of the property window changes accordingly, depending on the type of

the face selected in the Faces list.

If you check the Relative Parameter option, the respective face parameter will be changing relative to

the original parameter.

For example, if the original cylindrical face had the radius equal to 20, then, with the option Relative

Parameter set, entering the radius value of 5 fields a cylindrical face with the radius 25 resulting from

the operation.
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By default, each face in the list of faces being modified has parameters shared across other faces,

while having the Common Parameters option set in the property window. To define specific

properties of a face, turn off this option. If necessary, you can turn off the Common Parameters option

for all selected faces.

Transform Faces

Calling the command:

Icon Ribbon

3D Model > Special > Surfaces > Transform Faces

Surfaces > Operations > Transform Faces

Keyboard Textual Menu

<3ZT> Operation > Surfaces > Transform Faces

This command applies a transformation to one or several selected faces. The command is mostly used

for handling imported models, however it can be helpful in other cases as well.

   

By executing the command, the selected faces are moved to a new position and, if requested,

extended (or trimmed) to achieve an intersection with the surfaces of the adjoining faces. The

adjoining faces, in turn, are extended (or trimmed) to the intersection with the faces being

transformed. 

The correctness of the command behavior can be guaranteed only if the topology of the resulting

model is unchanged. If the model topology changes, the result of the operation may be incorrect.

When selecting the faces to transform, the same mechanism is used as in the command Delete Faces:

the faces to transform can be specified directly or implicitly. Defining transformation parameters of

the selected elements is done similar to that in the command Transform Element.
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To use the command, do the following sequence of steps:

1. Specify faces to transform.

2. Define transformation parameters.

3. Confirm operation creation.

Specifying faces to transform

To specify the faces to transform, use the option...:

<F> Select Elements

...or corresponding filters in the filter toolbar.

When using this option, you can select not only faces, but also edges with loops. The selected

elements are put in the Faces list.

To cancel selection of all elements, use the option:

<X> Cancel selection of all faces and surfaces

If edges or loops are selected, the Face Selection Pattern parameter becomes available. The effect of

this option is described in the command Delete Faces.

When selecting a set of edges, the default option is:

<G> Smooth edge chain selection mode

To select individual edges, turn off this option.

Specifying a Transformation

Special manipulator appears in the scene after selection of the first element. It helps you to change

the position of the selected faces. Procedure of specifying transformations is described in detail in the

Transform Element command description. The exact values of translations and rotations can be set in

the properties window.

Use the following options to select the coordinate system relative to which the transformation will be

performed:

<1> Source CS on source operation

<2> Select LCS for current transformation

Option  is active by default. The manipulator is in the center of original operation bounding box.

The drop-down list of the option has the second variant of coordinate system positioning - option

. When you select this option, the manipulator will be in the center of the bounding box that

bounds all movable face.
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Source LCS on source operation LCS for current transformation

Option  allows you to select any LCS for specifying the transformations. 

The operation can be confirmed either at the stage of selecting the elements to transform or at the

stage of defining the transformation parameters.

Extend Faces

Calling the command:

Icon Ribbon

3D Model > Special > Surfaces > Extend Faces

Surfaces > Operations > Extend Faces

Keyboard Textual Menu

<3SX> Operation > Surfaces > Extending Faces

This command allows extending a selected face (or several faces belonging to a sheet body) in the

specified direction, for the specified length amount. The direction of extending the face is defined by

selecting the side edges of the faces being extended. 3D profiles can be extended as well. In this way,

an enlarged face will be created as a result of executing the command, identical in shape with the

underlying surface of the 3D profile.

Sometimes, self-intersections occur when extending a face. In such cases, the command execution

ends up in an error message.

To use the command, do the following sequence of steps:

1. Select the object to extend.

2. Select edges.

3. Specify extension amount.

4. Define advanced parameters (optional).

5. Confirm operation creation.
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Selecting object to extend

To select an object to extend, use the option:

<R> Select surface operation

...or corresponding filters in the filter toolbar.

When specifying an object to extend, you can select faces, 3D profiles and sheet bodies.

Selecting edges

Once the object to extend is selected, you can select one or several edges bounding this object. Those

edges will indicate the direction of extending the given object. To select edges, use the option:

<H> Select Edge

The default option for selecting edges is:

<S> Smooth edge chain selection mode

To select individual edges, turn off this option.

To select all edges surrounding the selected object, at once, you can use the option:

<A> Select all edges

To cancel selection of any of the edges, click it again.

Defining amount of face extension

The Distance parameter means the distance from the selected edge to the new edge bounding the

extended surface, as measured along the surface.

Enter the amount of face extension in the Distance input box of the parameters window.  
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Besides the parameters window, this value can be modified in the 3D window, using arrow-shaped

manipulators. The manipulators appear after selecting at least one edge. To "grab" a manipulator,

move the cursor to the tip of the arrow (the cursor will then change its appearance to ) and depress

the left mouse button.  Note that the same extension amount is applied in all specified directions.

Defining the advanced parameters

The parameter Modify source surface tells the system, whether to modify the original face topology,

or leave it as is. The effect of this parameter on the result is shown below.

 

     Original model   

 

"Modify source surface" parameter is off

 

"Modify source surface" is on

The parameter Keep source solid specifies, whether to leave the source body in the 3D scene (the

whole body altogether, rather than just the selected face). If this parameter is off, the source body

disappears upon the operation completion. The parameter Shape defines the shape of the new face

created as a result of executing the command. This parameter can take several values. 

Linear means, the face extends straight, staying tangent to the original face at each point of the

selected edge. In this way, the surface curvature has a jerk near the selected edge. With the parameter

value set to Of Source Surface, most of the newly created surface is linear (ruled), as in the previous

case. However, the surface curvature around the selected edge changes smoothly.
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  Original model     "Linear" Shape

      

"Of Source Surface" Shape

          

"Like Source Surface" Shape

In real life, the angular difference between the new surface with the Linear parameter and that with

the parameter Of Source Surface is about 3 degrees. Therefore, the difference between the two

results is practically vanishing.

The parameter Like Source Surface means the new surface will rely on the definition of the source

surface. The example below shows the effect of this parameter on a spline surface.

 
              

                  Original model
 

     Resulting model

Original faces may contain internal smooth edges. Internal edge is considered to be “smooth” when

converging faces that form this edge are tangent to each other at the point of intersection of the edge

with another edge that defines direction of surface extension. The “smooth” state of internal edges

may be affected in the process of surface extension. To avoid this set G1 mode for Smoothness option

(G1 - is geometric continuity by first derivative). This option will recommend system to retain tangent

continuity, keeping “smooth” state of the internal edge on surface extension. By default Smoothness

option is set as GO (recommendation to ensure only surface continuity).
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Arrays of 3D Elements

An Array of 3D elements is an operation in T-FLEX CAD for creating copies of already existing 3D

objects. 

Depending on the array class elements of array can be positioned:

· along the direction vector, at the specified step (  linear array); 

· on a circle about the specified axis (  circular array); 

· along a path (  array by path);

· at the specified 3D points (  array by points);

· following the prescribed parametric law (  parametric array);

· in a similar way to elements of another array or a set of holes created by a single operation (

 array by pattern);

· at points of Cartesian, cylindrical or spherical coordinate system with coordinates defined by

the database (  array by table).

The source objects for creating an array (copy objects) can be selected among 3D construction

elements, operations, bodies, faces, 3D fragments. The set of objects replicated in the array can

contain several elements, however, of the same type. The arrays are divided into the following types,

depending on the type of the objects to copy: 

·  arrays of construction elements;

·  arrays of operations;

·  arrays of bodies;

·  arrays of faces;

·  arrays of fragments.

All arrays of the same type share same creation and editing techniques, regardless of the array class.

Creating an Array

In order to create an array (regardless of its type and class), you have to call the corresponding

command an perform following steps:

1. Select a type of an array;

2. Select source objects of an array;

3. Select guiding elements and specify main parameters of an array (actions required at this

step depend on a class of an array);

4. Define limitations and exclusions (if necessary and applicable);

5. Specify optional parameters of an array (the set of available optional parameters depends on

a type of an array);

6. Confirm the array creation (  in the automenu or in the header of command's parameters

window).

Topics in this section:

· Types of Arrays of 3D Elements

· Selecting Source Objects for Array of 3D Elements

· Classes of Arrays of 3D Elements

· Layout and Half-Step Shift in Arrays of 3D Elements

· Limitations and Exclusions in Arrays of 3D Elements

· Referencing 3D Elements of Array
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· Optional Parameters of Array of 3D Elements

See also:

· Arrays of Drawing Elements

· Copy of 3D Elements

· Symmetry of 3D Elements

Types of Arrays of 3D Elements

All arrays are distinguished by the types of the copy elements as follows:

 Array of Constructions ;

 Array of Operations;

 Array of Bodies;

 Array of Faces.

 Array of Fragments.

Creation of any array begins from selecting its type. The type of array can be selected, using buttons in

the top area of the General Parameters tab of the command's parameters window.

The  Array of Faces and  Array of Fragments types are not available for the 

 Parametric Array.

Array type affects filters for selecting source objects, optional parameters and content of the Common

tab of the array's parameters dialog.

Source objects are not included in the array by default. A blank space is remains in place of the source

element (elements) in the array. However, an additional copy, coinciding with the position of the

source element, can be included in the array, using the Include Source Operation option.

 Array of constructions

Any 3D construction objects, except sections, light sources and cameras, can be selected as source

objects of array of constructions. Those could be 3D nodes, 3D paths, 3D profiles, workplanes, etc. The

same array can combine construction objects of different types, such as, for example, 3D profiles and

3D paths. 

When creating an array of workplanes of any class, 2D drawing pages of the Workplane type are

automatically created for each array element.
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Linear array of construction elements - source objects are the

workplane and the 3D profile drawn on it

Source objects are not included in the array by default. A blank space is remains in place of the source

element (elements) in the array. However, an additional copy, coinciding with the position of the

source element, can be included in the array, using the Include Source Operation option.

 Array of Bodies and  Array of Operations

Arrays of bodies and arrays of operations create copies of bodies already existing in the scene. The

source object for arrays of these types is an operation.

An array of operations copies results of a particular operation only. If another operation is created on

top of that one, such as, for example, blending an edge, the array will not be affected. On the other

hand, an array of bodies replicates the whole body, created by using the selected operation. If this

body is modified in the future, the array will be regenerated, accounting for new operations included

in the Body history.
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1 - Source body/operation

2 - Linear array of bodies

3 -  Linear array of operation

1 - Source body after modifications

2 - Linear array of bodies

3 -  Linear array of operation

When an array of bodies is built, a new 3D body is created which is actually the array. The source body

(bodies) is not included in the array (its place in the array is filled by a blank space). 

An array of operations requires a specific setting regarding whether or not to Include Source

Operation in the array composition. If the source operation is included in the array, it will be subjected

to all parameters defined for this array, such as the material, system-wide parameters (level, layer,

color), transformation parameters, etc. Besides, if the operation selected for array creation is the last

operation in the history of a body, then this body disappears upon the array creation, being replaced

by the array. 

In the cases, when the source operation is not included in the composition of the array, then the

operation itself and the body that it creates will remain independent objects of the 3D model. The

array in this case will have a blank space in the position corresponding to the source operation

location (just like in the case of creating a construction array).

The following options can be applied when creating any body arrays and operation arrays:

·  Separate to Solids – the created array is automatically divided into separate body copies;

·  Combine Result to one Solid – all array elements are merged together by the Boolean

addition.
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Source operation

Resulting array without combining result into one solid

(side edges of separate copies are visible)

Resulting array 

with combining result into one solid

 Array of faces

The main purpose of any array of faces is to add holes and protrusions to existing bodies of the 3D

model, repeating design features already present in the given body. Therefore, an array of faces is

always created based on one particular body in the model: all copied faces must belong to that body.

The set of copy faces resulting from the array creation will also be included into the source body. 

No array of faces creates a new 3D Body; rather, the existing one is altered by the array.
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Source body
Result of creating the array of faces (copied elements are

faces of the hole, the slot and the protrusion)

An arbitrary set of faces can be selected for creating an array, except that it has to fully define the

geometry of the hole, slot or protrusion of the part being copied. The copies must be created within

the bounds of the source body. 

Creation of an array of faces may not affect the topology of the source body. Therefore, arrays should

be created in such a way, that copies of faces intersect with faces of the source body in the same way

as faces of the source set. It can be done, using an Array by Path.

Using linear array of faces makes copies intersect with

the source body in the different way than the original

set (the array can not be created) 

Using array of faces by path makes copies intersect with

the source body in the same way 

as the original set

Example shown above requires applying the Minimal twist along path option.

When specifying the set to array, you can select:

· Edges surrounding a set of faces. A set of edges defines two possible sets of faces (we will

call them the "inner" and "outer" sets with respect to the specified chain of edges). The system

can automatically select the set to copy (judging by the least area) or let the user choose.

1 - Selecting the single edge is enough to include the blind hole into an array

2 - Selecting all external edges is required to include the slot into an array

3 - Selecting two bounding edges is required to include the through hole into an array
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The selected edges must make one or several close sequences (loops).

· All faces to be included in the source set of the array;

· The operation that created the desired set of faces (for example, the Hole operation). In this

case, the array will keep a link to the selected operation. If in the future the geometry of such

operation will change, the array will regenerate accounting for the changes.

The following options can affect the resulting array of faces:

· Copy to one face 

Use of this mode considerably reduces the array regeneration time. However, this mode can

only be used when all elements of the array lie on the same face as the source set;

· Extend Faces (used only in combination with the Copy to one face) 

This mode allows lifting up the requirement of "similar intersection" of the source set of faces

and all arrayed copies with the faces of the source body. The system will be automatically

extending or trimming the copied faces in order to insure their correct connection to the body.

Use of this mode is possible only in the case when all copies are located within the range of

the same body faces, as the source set.

Source body
Array of faces with the

Extend Faces option applied

1 - Set of faces to copy (source objects of array)

2 - Trimmed copy

3 - Extended copy

4 - Source face boundary

· Check Intersection with other Faces (used to avoid body self-intersections)

When using this mode, the system checks face copies for intersections with already existing

body faces. If such an intersection is encountered, then array creation is aborted..

Shown array of cylindrical protrusions can not be created 

in the Check Intersections with other Faces mode 

due to the intersection with the arc of the source body
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1 - Source set of faces (cylindrical protrusion)

2 - Copy not causing self-intersections

3 - Copy causing the self-intersection 

(intersecting with the arc of the source body)

· Do not check boundaries of body (enabled by default). 

When using this mode, the check of correctness of the resulting array is carried out once after

creation of all copies. In this case the system checks the resulting copies only by the following

criterion: they must lie within the limits of at least one of the faces of the body. This check

does not entirely exclude the occurrence of errors in cases when the faces-copies lie on the

boundaries of faces but nevertheless decreases, by several times, the time required for

construction of a big array. 

When the Do not check boundaries of body mode is disabled, the system, before the start of

copying, checks whether the result of copying is located beyond the boundaries of all faces of

the body. If yes, such faces-copies will simply not be created. The second stage of the check is

carried out after copying – the created faces-copies will be checked for intersection with the

boundaries of that face of the body onto which they were copied. If the intersection was

detected for a copy, this copy is removed from the array. This work mode guarantees better

safety of array construction mechanism but significantly increases the time of array

construction.

 Array of Fragments

This type of arrays is intended to be used in assemblies. It only allows selecting 3D fragments as

source objects.

All copies in an array of fragments are fully functional 3D fragments represented in the 3D model tree

inside an array object. It allows, for instance, applying transformations, animations and other

operations to particular copies within an array. Optional parameters of arrays are not applicable to

arrays of fragments.
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The ability to control inheritance of parameters is the important feature of arrays of fragments.

A particular copy fragment within an array may inherit some parameters from a source fragment,

while having some other parameters specified individually for this copy.
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 Affect of source objects type on array's parameters dialog

The parameters dialog of  array of operations,  bodies and  faces contains similar

parameters to other operations' parameters dialogs.

The parameters dialog of  array of constructions lacks body-specific parameters, because this type

of arrays doesn't affect bodies.

The parameters dialog of  array of fragments lack all parameters except name of operation,

suppress option and parameters defined in command's parameters window. 

The detailed information on parameters dialogs is available in the Common Parameters of 3D

Elements section.

Parameters dialog of array of fragments Parameters dialog of array of constructions
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Selecting Source Objects for Array of 3D ELements

Depending on the selected type of array, one of the following options for selecting the array source

objects will be available in the automenu:

<N> Select construction

<N> Select source 3D operation (for arrays of operations)

<N> Select source 3D operation (for arrays of bodies)

- Select faces resulted from operation

<N> Select faces to copy or their boundary edges or loops

The selected objects will be put into the list of array source objects in the command's parameters

window. The list in the parameters window and automenu options depend to each other - activating

an automenu option activates the list and vice versa. Array of fragments doesn't have the specific

automenu option for selecting source objects, activate the list instead.

Te list can be controlled, using buttons located on the right side:  Expand,  Collapse,  Clear

(delete all elements),  Delete Element from the List (deletes the selected row).  

Notice that once the first object to be arrayed is selected, switching the array type becomes

impossible. To change the array type, you need to remove all 3D objects from the list of the

array source objects. Only after that, you will be able to switch to another array type.

3D construction elements and operations are selected by simply picking those either directly in the 3D

scene (by ) or in the model tree. To select a 3D body, you can pick any of the operations

contributing to this body (again, either in the 3D scene, if that is possible, or in the 3D model tree).

The last operation of the given body will be automatically put in the list of the selected objects.

Selection of source objects for an array of faces requires more close consideration.

Selecting source set of faces for array of faces

By default, the  Select faces resulted from operation option is active upon calling the array of

faces creation command. While it's active, the filter toolbar contains only a filter for selecting 
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 faces, but selecting a face in the 3D scene results in putting its parent operation into the list of array

source objects. 

You can switch to the  Select faces to copy or their boundary edges or loops option if necessary.

It allows to select  operations,  faces,  edges or  loops.

Array of faces can be created only within a single body, otherwise it will result in error.

Which set of faces from the two possible sets, defined by the specified chain of edges, will be selected

as the source object for the array, is determined by the Alternative Face Selection checkbox located in

the bottom part of the General Parameters tab of command's parameters window. 

The checkbox has three states: 

 enabled by default, 

 enabled,

 disabled.  

To let the system choose the set of faces automatically (by the least area condition), leave the

checkbox in the default state . If further manipulations with the 3D model will alter the balance of

the areas, the system will automatically switch to the other set of faces as the source object of the

array.

In cases, when you want to specify one of two possible sets of faces explicitly, use the two other states

of the checkbox (  and ). Each of those will correspond with a particular set of faces. Which set of

faces corresponds to which particular state of the checkbox is arbitrarily defined by the system upon

specifying the set of edges. In this case, no future changes in the model will affect the set of faces

being arrayed.

Classes of Arrays of 3D Elements

Array classes. Specifics of each class of arrays

All 3D arrays created in T-FLEX CAD can be distinguished by the way of copying into the following

classes:

 Linear Array;

 Circular Array;
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 Array by Points;

 Array by Path;

 Parametric Array;

 Array by Pattern;

 Array by Table.

 Linear array

The algorithm of creating this type of arrays as well as command's interface are described in the

Linear Array of 3D Elements section.

The linear array is created by placing copies of the source objects along one, two or three direction

vectors. Depending on the number of the direction vectors, it will be one-dimensional, two-

dimensional or three-dimensional array. All elements of the one-dimensional and two-dimensional

linear array lie in one plane. All elements of three-dimensional linear array lie in parallel planes.

One-dimensional linear

array

Two-dimensional linear array Three-dimensional linear array

The direction vectors of a linear array are defined either by two 3D points (in this way, the vector will

be directed from the first selected point to the second one), or by a single 3D object suitable for

defining a vector in the space.

The array size along each direction is characterized by the number of copies, the placement step and

the total length of the array in the given direction. To define an array, you need to specify just two of

the three parameters. Depending on the mode used, it can be:

· Number of copies and step;

· Total length and step;

· Number of copies and total length.

The third parameters is calculated automatically by the system from two user-defined

parameters.
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1 - Vector of first direction (rows)

2 - Vector of second direction (columns)

3 - Vector of third direction (height)

4 - Array step in first direction

5 - Array length in first direction

6 - Array step and length in second direction

7 - Array step and length in third direction

The number of copies along each direction vector always includes the source object being copied

(even if it is not included in the composition of the array). For example, the array shown above

contains 3 copies in the first direction and 2 copies each in the second and third directions. 

A linear array allows creating copies not only forward, but also backward (reverse) along each

direction vector. Reverse copies are created with the same step as forward-going copies along the

given vector. The number of copies in the reverse direction can either be the same as in the forward

direction along this vector, or specified by a separate numerical value.

Keep in mind, that in case of defining number of copies in reverse direction by a numerical

value, the first copy of the forward direction and the first copy of reverse direction are the same

element (see picture below). Defining zero value for number of copies in the reverse direction

excludes the first copy of the forward direction from the array.
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Two-dimensional linear array

1 - Source object

2 - First direction (red arrow - forward, blue arrow - reverse)

3 - Second direction (red arrow - forward, blue arrow - reverse)

4 - Number of copies in first forward direction (three in all shown examples)

5 - Number of copies in first reverse direction (symmetric to forward direction in all shown examples)

6 - Number of copies in second forward direction (three in all shown examples)

7 - Number of copies in second reverse direction

Two copies in second reverse direction One copy in second reverse direction Zero copies in second reverse

direction

 Circular array

The algorithm of creating this type of arrays as well as command's interface are described in the

Circular Array of 3D Elements section.

In the circular array, the copies are placed on a circle about the array axis. The axis of revolution of a

circular array is defined, just as the direction vectors in a linear array, by selecting two 3D points or

one 3D element suitable for defining a vector in the space. The position of array elements about the

axis is determined by the number of copies, the rotational step per copy and the total angle of

elements rotation about the axis. 

To define an array, you need to specify just two of the three parameters. Depending on the mode

used, it can be:

·  Number of copies and step;

·  Total angle and step;

·  Number of copies and total angle.

The third parameters is calculated automatically by the system from two user-defined

parameters.

The copy rotational step determines, by what angle to rotate the source body about the axis to place

the first copy. The second copy is created by rotating the first one by the same angle, and so on. The

rotation is done in the clockwise direction, as watched along the array axis. 
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Optionally, the total angle can be defined, using two points: start and end point of rotation. In this

case, total angle is equal to angle between two planes: both passing through an array axis and each

passing through one of the aforementioned points. If a direction from start point to end point

coincides with the forward direction of rotation, then the step value is positive by default, otherwise -

negative.

Keep in mind that the number of copies can be handled in different ways depending on a value

of the total angle. Upon rotation by the full circle (360 degrees), the number of copies includes

the source object. Upon rotation by any other total angle, the number of copies doesn't include

the source object.

One-dimensional circular array with nine copies in forward direction

1 - Source object

2 - Array axis

3 - Start point of rotation

4 - End point of rotation

Total angle - 360 degree Total angle is defined by two points. 

Direction from start point to end

point 

coincides with forward direction of

rotation

Total angle is defined by two points. 

Direction from start point to end

point 

coincides with reverse direction of

rotation

Instead of using the start and end points for defining the total angle, they can be used for defining the

step.
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1 - Source object

2 - Array axis

3 - Start point of rotation

4 - End point of rotation

5 - Angle between planes passing through array axis and start and end points is used as array step

Backward rotation is possible, including simultaneous creation of copies in two directions – forward

and backward. The backward rotation is done with the same step as the forward one, while the

number of copies may differ.

Enabling the reverse direction, when total angle is above 180 degrees, may lead to creating

multiple copies in the same point. E.g.: enabling the reverse direction, when total angle is 360

degrees, leads to duplicating all copies in the array.

In case of defining number of copies in reverse direction by a numerical value, the first copy of

the reverse direction coincides with the source object.

Defining number of copies in reverse direction

1 - Source object

2 - Array axis

3 - Number of copies in forward direction (four in both cases)

4 - Number of copies in reverse direction
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Number of copies in reverse direction is defined as

Symmetric

Number of copies in reverse direction is defined by 

Value (five copies)

When copies are created, there are two options for a copy's orientation: Rotated (default) and Parallel

Offset. In the first case, a copy is created by actually rotating the source body about the array axis. In

the second case, the source body is copied without rotation about the axis (meaning that orientation

of each copy in the space is the same as the source body orientation).

One-dimensional circular array with total angle of 360 degrees

1 - Source object

2 - Array axis

Rotated copies Parallel Offset copies

The circular array also allows creating copies in the second and third direction. The second direction is

the radial direction of the array. In this case, array elements will be located in one plane, making up a

pattern of concentric circles. The third direction is along the array axis, with the array elements located

on a cylindrical surface. Number of copies, length and step for the second and third direction is

defined in same way as in the first direction. 
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Three-dimensional circular array with nine copies in first direction, 

two copies each in second and third directions and total angle of 360 degrees

1 - Source object

2 - Array axis

3 - First direction (rotation)

4 - Second direction (radial translation)

5 - Third direction (axial translation)

6 - Number of copies in second forward direction

7 - Number of copies in third forward direction

Forward directions are indicated by red arrows, reverse directions - by blue arrows

 Array by points

The algorithm of creating this type of arrays as well as command's interface are described in the

Array of 3D Elements by Points section.

To create a 3D array by points, select the base 3D point on the array's source object, and an arbitrary

number of target 3D points (into which the source object will be copied). The arrayed elements will be

placed in the specified 3D points.
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1 - Vertex of the source object selected as the base point

2 - 3D nodes used as target points

Target points are defined with successive selection of single 3D points (3D nodes, vertices, etc.) or

arrays of 3D nodes. The list of target points of an array may contain both 3D points and arrays of 3D

nodes.

 Array by path

The algorithm of creating this type of arrays as well as command's interface are described in the

Array of 3D Elements by Path section.

In the array by path, the placement of the array elements is defined by one or two 3D curves. Such an

array can be considered analogous to the linear array, however, with the copies placed along spatial

curves rather than straight lines. Those curves can be represented by arbitrary 3D curves (3D paths, 3D

profiles, edges, etc.).

Using a single guide curve results in a one-dimensional array, two guide curves – in a two-dimensional

array, three guide curves - in a three-dimensional by path.

Arrays by path

1 - First guide curve

2 - Second guide curve

3 - Third guide curve

4 - Source object (3D node)

Directions of guide curves are represented by red arrows
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One-dimensional array Two-dimensional array Three-dimensional array

By default, array is directed not along guide curves themselves, but along curves constructed by

combining guide curve's starting point with the source object. Starting points of closed curves are

detected automatically.

Directions of selected edges are indicated by small arrows in the 3D scene.

Direction of 3D paths and 3D profiles can be indicated in the 3D scene, using the Arrow on ends

of 3D paths/profiles option (Document Parameters > 3D > 3D).

Additionally a start point can be manually specified for each direction. The projection of said point

onto a guide defines a start of an array. In this case, a closed guide curve is used at its whole length,

while an open guide curve is trimmed, so that start point's projection becomes a start of a guide

curve.



Arrays of 3D Elements

1903

Two-dimensional array with closed guide curve used for defining second direction

1 - First guide curve

2 - Second guide curve

3 - Source object (3D node)

4 - Start point

Directions of guide curves are represented by red arrows

Start point is selected for second direction Start point is selected for first direction

The placement of copies (array elements) along the guide curve depends on the following array

parameters: number of copies, step and total length of the array along the given curve, and,

additionally, the copies' placement option. 

Number of copies, step and total array length along the guide curve are interrelated parameters. To

define the array, you need to specify just two parameters out of the three. The omitted parameter will

be calculated by the system automatically. The total array length can be evaluated by the guide curve

(the system will determine the curve length, and then take the resulting value as the length of the array

in the given direction).

The total array length may not exceed the length of the guide curve.

The placement option determines:

· The position of the copies' placement points (array elements) along the guide curve.

Depending on the used placement option, the step of the array by path determines either the

distance along the path between the fixing points of the copies or the path's chord length.

· The orientation of copies in the space. The position of copies in the space is determined by

bringing the target coordinate system of each copy over the source coordinate system of the

object being copied (that case, the source object of the array). The source coordinate system is

created at the start of the guide curve, while the target – at the fixing point of the particular
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copy. The axis orientation of either coordinate system is defined by the copy placement

option.

There are the following copy placement options:

· Translation along Path. The target coordinate systems of all copies are placed along the path

according to the specified step and "number of copies" parameters. The axis orientation of

those coordinate systems is fixed and does not depend on the 3D path geometry. This

placement option can be used, if you need to put copies of the source body along the guide

curve, preserving the spatial orientation of each copy as that of the source body.

· Minimum Twist along Path. The X-axis of the target coordinate system of each copy is

determined as to provide smooth rotation of the curvature vector from the start to the end of

the path. The Z-axis always points in the direction tangent to the path at the origin of the

current copy's coordinate system. An example of using an array by path with minimum twist by

path as a model of a conveyor belt.

This example can be found in the Examples library, in the Examples\3D

Modeling\Array\Conveyor.grb folder.

· By Chord. To find the position of the first copy, a sphere is created with the center at the path

start and the radius equal to the array step. The copy will be placed at the intersection point of

the sphere and the 3D path. Next, another sphere is constructed with the center at this point,

and so on. This is how attachment points of all copies are determined. The target coordinate

systems of the copies are placed in those points. The X-axis of a target coordinate system is

oriented by the incoming chord of the 3D path. A path chord is defined by the attachment

points of two neighboring copies. The source coordinate system is located at the start of the

path. Its X-axis points toward the first copy's position. With this copy placement option, the

array step is the chord length of the 3D path. This placement option can be successfully

implemented, for example, in caterpillar belt and chain drive design.
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A caterpillar belt design example is provided in the Examples library, in the Examples\3D

Modeling\Array\Track.grb folder.

The two-dimensional array by path is created similarly. The set of parameters is defined for the

second guide curve in the same way, including the number of copies, step and total length of the array

in that direction and the copy placement option. Note that the source object in the second direction

will be the complete set created by the one-dimensional array along the first guide curve.

Two-dimensional array by path 

with the Translation along Path option 

applied in the second direction

Two-dimensional array by path 

with the Minimal Twist along Path option 

applied in the second direction

Three-dimensional arrays along path can be created in the same way, except that it can only use the

Translation along Path placement option in all three directions. The two-dimensional array by first

and second guides is used as the source object in the third direction.

 Parametric array

The algorithm of creating this type of arrays as well as command's interface are described in the

Parametric Array of 3D Elements section.
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The parametric array uses a universal approach that allows creating an array by parametric copying of

the source element. The same approach is used in the Parametric Sweep operation and in one of the

3D path creation modes.

 The algorithm of face approach is described in details in the Parametric Sweep chapter.

Therefore, the current topic just briefly touches upon the algorithm description.

A parametric array can be an array of bodies, operations or construction elements only.

Parametric arrays of faces or fragments cannot be created.

To create a parametric array, you need to define the law of calculating the so-called coordinate

system of the current copy. The copying of the array source object is done in the direction from the

source coordinate system to the calculated target coordinate system of the current copy. 

The user can select one of the model's local coordinate systems as the source coordinates. If no local

coordinate system was selected, then the global coordinate system is used as the source coordinates.

The coordinate system of the current copy (particularly, its origin and axis orientation) can be defined

in one of the two ways: 

· Free copy orientation. Modifications of the coordinate system parameters of the current copy

are described by expressions. 

· Copy orientation by 3D curves or surfaces. To define the spatial position of the current copy's

coordinate system, use the appropriate 3D curves or surfaces of other bodies. By managing

the copy's coordinate system, you control the position of each copy.

The position of a copy's coordinate system is controlled by the array parameters. All parameters are

divided into two types:

· Driven parameters are the parameters whose values are calculated automatically during

element creation. One can introduce independent variables to read the values of such

parameters. 

· Driving parameters are the entries whose values are specified by the user. The entries for the

driving variables permit arbitrary expressions including any system variable. For example,

including a variable keeping the copy number, in such an expression, will make the given

parameter depend on the copy number.
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Some array parameters can be sometimes driving, and sometimes driven. The leading parameter

Number of copy is always driven. It definitely requires assignment of an independent variable that

will be tracking the current copy number during the operation processing. The copy number is

automatically incremented through the array calculation, starting from 1, up to the specified quantity,

with the step equal to 1.

The calculation is done in the following order: the copy number is assigned the next ordinal number,

then the driving parameters are calculated, then the driven parameters are calculated (if any), and,

finally, copying is done.

When using the free copy orientation option, just select the array source object, specify the number of

copies and assign independent variable to the Number of copy parameter. By using the variable

assuming the current copy number, one can introduce certain relations in the entries of driving

parameters, as well as in 2D or 3D constructions, and make the geometry of the original body, in turn,

depend on those relations.

An example of a parametric array with free copy orientation is a model of a spiral staircase, as shown

on the diagram at the beginning of this topic.

The copy orientation option by path or by surface is convenient in the cases when defining the

expression for the exact law of the copy parameters modification is not feasible. In such cases, it is

convenient to use various 3D curves or surfaces for specifying the position and orientation of the

current copy's coordinate system.

 Array by Pattern

The algorithm of creating this type of arrays as well as command's interface are described in the

Array of 3D Elements by Pattern section.

Array by pattern copies parameters of array from the pattern and replicates it. Arrays of any class can

be used as a pattern. It is also possible to use face of a hole as a pattern. In this case, an array is based

on all holes created by parent operation of selected face.
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 Array by Table

The algorithm of creating this type of arrays as well as command's interface are described in the

Array of 3D Elements by Table section.

Array by table allows using values from the database as coordinates of array's elements.
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There are 3 types of coordinate systems relative to which you can create an array by table - Cartesian,

Spherical and Cylindrical. Coordinates of array's elements in the selected coordinate system are

defined by a database.

There's also the Parametric Array option within the array by table command. It allows using values

from a database for defining model's variables.
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Topics in this section:

· Linear Array of 3D Elements;

· Circular Array of 3D Elements;

· Array of 3D Elements by Points;

· Array of 3D Elements by Path;

· Parametric Array of 3D Elements;

· Array of 3D Elements by Pattern;

· Array of 3D Elements by Table.

Linear Array of 3D Elements

Icon Ribbon

3D Model > Operations > Array > Linear Array

Assembly > Assembly > Array > Linear Array

Sheet Metal > Advanced > Array > Linear Array

Surfaces > Advanced > Array > Linear Array

Primitives > Advanced > Array > Linear Array

Support Geometry > Copy > Array > Linear Array

Keyboard Textual Menu

<3AL> Operation > Array > Linear Array

The command creates arrays by placing copies of source objects along a one, two or three directional

vectors. 
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Main concepts of creating a linear array are described in the Classes of Arrays of 3D Elements

section.

In order to create a linear array, perform following steps upon calling the command:

1. Choose a type of the array to be created (  array of constructions,  array of operations,

 array of bodies,  array of faces,  array of fragments);

2. Select source objects of the array;

3. Define a directional vector in the first direction

4. Define a number of copies, step and total length in the first forward direction;

5. Define a number of copies in the first reverse direction (optional step);

6. Define a directional vector and other parameters of array in the second and third directions

in the similar way as it was defined in the first direction (optional step);

7. Apply a layout and half-step shifts (optional step);

8. Apply limitations and exclusions (optional step);

9. Define optional parameters of the array (optional step);

10.Confirm the operation (  in the automenu or in the header of the parameters window).

Apart from the General Parameters (selecting a type of the array and source objects), Limitations,

Exclusions and Options tabs the command's parameters window contains three tabs similar to each

other:

· First Direction (rows);

· Second Direction (columns);

· Third Direction (height).
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These tabs contains the similar sets of parameters described below. The geometrical meaning of these

parameters is described in the Classes of Arrays of 3D Elements section.

Defining a Direction, number of Copies, Step and Length in the First Direction (rows) is mandatory

for creating an array. Two of the latter three parameters are defined by user, the third one is

calculated automatically from values of two others.

A directional vector can be selected upon activating  the Direction/First point input box on the

corresponding directional tab. These input boxes are connected to following automenu options:

<D> Select first direction

<J> Select second direction

<F> Select third direction

Activating the input box activates the automenu option and vice versa. In result, filters for selecting 

points and  directions become active on the filter toolbar, so you can select  the desired object

in the 3D scene or in the model tree. An icon representing a type of a selected element, its name and

name of its parent operation (in case of selecting a geometric entity) are displayed in the

Direction/First point input box. You can  Clear the selection, using the button located in the right

side of the input box. 

In case of selecting a  direction, no additional selection is required. 
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In case of selecting a  point, the additional Second Point input box becomes available in the tab of

the corresponding direction below the Direction/First point input box. Second Point input boxes are

connected to following automenu options:

<S> Select first direction ending point

<O> Select second direction ending point

<T> Select third direction ending point

Activating the input box activates the automenu option and vice versa. In result, filters for selecting 

 points become active on the filter toolbar, so you can select  the desired object in the 3D

scene or in the model tree. An icon representing a type of a selected element, its name and name of

its parent operation (in case of selecting a geometric entity) are displayed in the Second Point input

box. 

The array is created in direction from the first point to the second one. Regardless of whether the

direction is defined by a single object or by two points, you can  Reverse it, using the button

located to the right side of the Copies input box.

You can either  Clear the selection in Direction/First point and Second Point input boxes

individually, using buttons located in the right side of each input box, or clear both input boxes at

once, using one of the following automenu options: 

<K> Reset first direction selection

<L> Reset second direction selection

<H> Reset third direction selection

One of the following combinations of array's parameters can be selected in the Parameters drop-

down list, which is located below the Direction/First point and Second Point input boxes in each

directional tab of the command's parameters window:

· Number of Copies and Step;

· Total Length and Step;

· Number of Copies and Total Length.

Depending on the selected combination only two of the three input boxes located below (Copies,

Step and Length) are accessible, while the value in the third input box is calculated automatically.

By default, even if the selected combination of parameters allows manual input of total length's value,

the Length input box is inaccessible due to automatic application of the option, which defines total

length as the length of the directional vector. This option can be disabled, using the  By Vector

button, which is located to the right side of the Length input box. The similar button is located to the

right side of the Step input box, allowing to define the Step as the length of the directional vector.

Both options can not be applied at once for Length and Step in the same direction.

The Half-Step Shift checkbox is located below the Length input box. 

The detailed information on half-step shift is available in the Layout and Half-Step Shift in

Arrays of 3D Elements section.
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Bottommost parts of each directional tab in the command's parameters window contain the Reverse

Direction checkbox combined with the drop-down list. The drop-down list contains two options:

Symmetric and Value. The checkbox is disabled by default, so copies in each direction (rows, columns

and height) are positioned on the same side in relation to the source object (forward direction).

Enabling the checkbox applies the Symmetric option, so the number of copies in reverse direction

becomes equal to number of copies in forward direction. Upon selecting the Value option, the input

box for typing in the custom number of Copies in reverse direction appears below the drop-down list.

More information on the reverse direction of arrays is available in the Classes of Arrays of 3D

Elements section.

Topics in this section:

· Edit Linear Array of 3D Elements

See Also:

· Types of Arrays of 3D Elements 

· Classes of Arrays of 3D Elements 

· Limitations and Exclusions in Arrays of 3D Elements

· Referencing 3D Elements of Array

· Optional Parameters of Arrays of 3D Elements

· Preview of Operation Result 

· Common Parameters of 3D Elements

Edit Linear Array of 3D Elements

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual Menu

<3EAL> Edit > Operations > Array > Linear

This command is used for editing linear arrays.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<R> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command
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<R> Change Definition

<Del> Delete entity

<Esc> Exit command

<M> Transformation

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, start editing or changing definition. 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination excludes elements from selection).

Circular Array of 3D Elements

Icon Ribbon

3D Model > Operations > Array > Circular Array

Assembly > Assembly > Array > Circular Array

Sheet Metal > Advanced > Array > Circular Array

Surfaces > Advanced > Array > Circular Array

Primitives > Advanced > Array > Circular Array

Support Geometry > Copy > Array > Circular Array

Keyboard Textual Menu

<3AR> Operation > Array > Circular Array

The command creates arrays by placing copies of source objects on a circle about a selected axis. 

Main concepts of creating a linear array are described in the Classes of Arrays of 3D Elements

section.

In order to create a circular array, perform following steps upon calling the command:

1. Choose a type of the array to be created (  array of constructions,  array of operations,

 array of bodies,  array of faces,  array of fragments);

2. Select source objects of the array;

3. Define an axis of the array;

4. Select start and end points of rotation (optional step);

5. Define a number of copies, step and total angle in the first forward direction;

6. Apply the parallel offset (optional step);

7. Define a number of copies in the first reverse direction (optional step);

8. Define a directional vector and other parameters of array in the second and third directions

in the similar way as it was defined in the first direction (optional step);

9. Apply a layout and half-step shifts (optional step);

10.Apply limitations and exclusions (optional step);

11.Define optional parameters of the array (optional step);
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12.Confirm the operation (  in the automenu or in the header of the parameters window).

General Parameters

 

The General Parameters tab of command's parameters window contains the Axis/First Point input

box. It is connected to the following automenu option:

<A> Select axis of rotation

Activating the input box activates the automenu option and vice versa. In result, filters for selecting 

points,  axes and  directions become active on the filter toolbar, so you can select  the

desired object in the 3D scene or in the model tree. An icon representing a type of a selected element,

its name and name of its parent operation (in case of selecting a geometric entity) are displayed in

the Axis/First Point input box. 

Upon selecting a  direction or an  axis, a selected object fully defines an axis of array, so that no

additional selection is required. 

Upon selecting a  point, the additional Second Point input box appears below the Axis/First Point

input box. The Second Point input box is connected to the following automenu option:

<S> Select second point of Axis

Activating the input box activates the automenu option and vice versa. In result, filters for selecting 

points become active on the filter toolbar, so you can select  the desired object in the 3D scene or

in the model tree. An icon representing a type of a selected element, its name and name of its parent

operation (in case of selecting a geometric entity) are displayed in the Second Point input box. 

A direction from first point to second is considered an axis of the array

You can  Clear the selection in the Axis/First Point and Second Point input boxes individually,

using buttons located in the right side of each input box, or clear both input boxes at once, using one

of the following automenu options: 

<K> Cancel axis of rotation selection
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Either the total angle or the step of the array can be defined by two points. These points can be

selected upon activation of the Start Point of Rotation and End Point of Rotation input boxes in the

General Parameters tab of  the command's parameters window or using the following automenu

options:

<T> Select starting point of Rotation

<O> Select ending point of Rotation

Activating the input box activates the automenu option and vice versa. In result, filters for selecting 

points become active on the filter toolbar, so you can select  the desired object in the 3D scene or

in the model tree. An icon representing a type of a selected element, its name and name of its parent

operation (in case of selecting a geometric entity) are displayed in aforementioned input boxes.

You can  Clear the selection in the Start Point of Rotation and End Point of Rotation input boxes

individually, using buttons located in the right side of each input box, or clear both input boxes at

once, using one of the following automenu options: 

<L> Cancel selection of points for Rotation

Rotation (Rows)

The Rotation (Rows) tab containing parameters of array in the first direction is located below the

General Parameters tab in the command's parameters window. 

The Parameters drop-down list containing following combinations of array's parameters is located in

the top of the tab:

· Number of Copies and Step;

· Total Angle and Step;

· Number of Copies and Total Angle.

Depending on the selected combination only two of the three input boxes located below (Copies,

Step and Angle) are accessible, while the value in the third input box is calculated automatically.

By default, forward direction of array is the clockwise direction, when looking along axis of array.You

can  Reverse it if necessary, using the button, which is located to the right side of the Copies input

box.

If Start and End Points of Rotation are selected, the system automatically applies one of the options,

which defines ether the Step or the total Angle (depending on the combination selected in the

Parameters drop-down list) as an angle between planes passing through the axis of rotation and
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these points, thus values in the corresponding input boxes are non-editable. These options can be

disabled or enabled manually, using  By Two points buttons  located to the right side of the Step

and Angle input boxes. Both options can not be applied for Angle and Step at once.

The Half-Step Shift and Parallel Offset checkboxes are located below the Angle input box. 

The detailed information on parallel offset is available in the Classes of Arrays of 3D Elements

section.

The detailed information on half-step shift is available in the Layout and Half-Step Shift in

Arrays of 3D Elements section.

Bottommost parts of each directional tab in the command's parameters window contain the Reverse

Direction checkbox combined with the drop-down list. The drop-down list contains two options:

Symmetric and Value. The checkbox is disabled by default, so copies in each direction (rows, columns

and height) are positioned on the same side in relation to the source object (forward direction).

Enabling the checkbox applies the Symmetric option, so the number of copies in reverse direction

becomes equal to number of copies in forward direction. Upon selecting the Value option, the input

box for typing in the custom number of Copies in reverse direction appears below the drop-down list.

More information on the reverse direction of arrays is available in the Classes of Arrays of 3D

Elements section.

Radial Translation (Columns) and Axial Translation (Height)

The Radial translation (Columns) and Axial Translation (Height) tabs containing parameters of array

in the second and third directions are located below the Rotation (Rows) tab of the command's

parameters window.

   

Both tabs contain the same set of parameters listed below. Geometrical meaning of these parameters

is described in the Classes of Arrays of 3D Elements section. 

The Parameters drop-down list containing following combinations of array's parameters is located in

the top of the each directional tab:

· Number of Copies and Step;

· Total Length and Step;

· Number of Copies and Total Length.

Depending on the selected combination only two of the three input boxes located below (Copies,

Step and Length) are accessible, while the value in the third input box is calculated automatically.
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By default, the forward direction of the radial translation is pointed outside from array's axis; the

forward direction of the axial translation coincides with a direction of array's axis. You can  Reverse

directions if necessary, using buttons, which are located to the right side of Copies input boxes in each

directional tab.

By default, even if the selected combination of parameters allows manual input of array's step, a value

in the Step input box is non-editable due to automatic application of the option, which defines step

as the length of the directional vector. The similar option is available (but disabled by default) for the

Length parameter. The length of a radial translation's directional vector is a distance between an axis

of rotation and a source object's center of mass. The length of an axial translation's directional vector

is a length of array's axis.

These options can be disabled or enabled manually, using the  By Vector button, which is located

to the right side of the corresponding parameter's input box. Both options can not be applied at once

for Length and Step in the same direction.

The Half-Step Shift checkbox is located below the Length input box. 

The detailed information on half-step shift is available in the Layout and Half-Step Shift in

Arrays of 3D Elements section.

Bottommost parts of each directional tab in the command's parameters window contain the Reverse

Direction checkbox combined with the drop-down list. This option is described above.

Topics in this section:

· Edit Circular Array of 3D Elements

See Also:

· Types of Arrays of 3D Elements 

· Classes of Arrays of 3D Elements 

· Limitations and Exclusions in Arrays of 3D Elements

· Referencing 3D Elements of Array

· Optional Parameters of Arrays of 3D Elements

· Preview of Operation Result 

· Common Parameters of 3D Elements

Edit Circular Array of 3D Elements

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual Menu

<3EAR> Edit > Operations > Array > Circular

This command is used for editing circular arrays.

Available options:

<Esc> Cancel selection
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<A> Select All Elements

<R> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<Esc> Exit command

<M> Transformation

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, start editing or changing definition. 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination excludes elements from selection).

Array of 3D Elements by Points

Icon Ribbon

3D Model > Operations > Array > Array by Points

Assembly > Assembly > Array > Array by Points

Sheet Metal > Advanced > Array > Array by Points

Surfaces > Advanced > Array > Array by Points

Primitives > Advanced > Array > Array by Points

Support Geometry > Copy > Array > Array by Points

Keyboard Textual Menu

<3AN> Operation > Array > Array by Points

The command creates arrays, using the selected set of 3D points for positioning of elements.

In order to create an array by points, perform following steps upon calling the command:

1. Choose a type of the array to be created (  array of constructions,  array of operations,

 array of bodies,  array of faces,  array of fragments);

2. Select source objects of the array;

3. Select a base point;

4. Select target points (separate or arrays);
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5. Apply limitations (optional step);

6. Define optional parameters of the array (optional step);

7. Confirm the operation (  in the automenu or in the header of the parameters window).

The number of source object's copies is defined by the number of selected target points. Copies are

positioned by coinciding the base point with target points. The resulting copy is positioned in relation

to the target point in the same way, as the source object is positioned in relation to the base point.

Base Point

Base Point can be selected upon activation of the eponymous input box, which is located in the

General Parameters tab of command's parameters window. The input box is connected to the

following automenu option:

<S> Select point of source position

Activating the input box activates the automenu option and vice versa. In result, filters for selecting 

points become active on the filter toolbar, so you can select  the desired object in the 3D scene or

in the model tree. An icon representing a type of a selected element, its name and name of its parent

operation (in case of selecting a geometric entity) are displayed in the Base Point input box. You can

 Clear the selection, using the button located in the right side of the input box. 

Base point can be selected on the source object or at any arbitrary position in the 3D scene. The

only condition is that it shouldn't coincide with any of the selected target points.

Target Points

You can select individual points and whole arrays of 3D nodes as target points. It is possible to select

a whole array and some of its particular elements at the same time. In will result in creating two
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copies of the source object at such points. If you need to create several copies at the same individual

point, select such point several times.

Individual points can be selected upon activation of the Target Point list, which is located in the

General Parameters tab of command's parameters window. The input box is connected to the

following automenu option:

<T> Select point of target position

Activating the list activates the automenu option and vice versa. In result, filters for selecting  points

become active on the filter toolbar, so you can sequentially select  any number of points in the 3D

scene or in the model tree. An icon representing a type of a selected element, its name and name of

its parent operation (in case of selecting a geometric entity) are displayed in the Target Point list. 

Arrays of 3D nodes can be selected upon activation of the Array of Nodes list, which is located in the

General Parameters tab of command's parameters window. The input box is connected to the

following automenu option:

<A> Select Array of 3D Nodes as Target Points

Activating the list activates the automenu option and vice versa. In result, filters for selecting  arrays

become active on the filter toolbar, so you can sequentially select  any number of arrays in the 3D

scene or in the model tree. Only arrays of 3D nodes can be selected. An icon representing a type of a

selected array and its name are displayed in the the Array of Nodes list.

The Target Point and Array of Nodes lists can be managed, using buttons located in the right side of

each list:  Expand,  Collapse,  Delete Element from the List (deletes the selected row of the

list),  Clear (deletes all objects from the list). You can also clear both lists at once, using the

following automenu option:

<K> Cancel points selection

Topics in this section:

· Edit Array of 3D Elements by Points

See Also:

· Types of Arrays of 3D Elements 

· Classes of Arrays of 3D Elements 

· Limitations and Exclusions in Arrays of 3D Elements

· Optional Parameters of Arrays of 3D Elements

· Preview of Operation Result 

· Common Parameters of 3D Elements



Arrays of 3D Elements

1923

Edit Array of 3D Elements by Points

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual Menu

<3EAN> Edit > Operations > Array > By Points

This command is used for editing arrays by points.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<R> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<Esc> Exit command

<M> Transformation

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, start editing or changing definition. 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination excludes elements from selection).
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Array of 3D Elements by Path

Icon Ribbon

3D Model > Operations > Array > Array by Path

Assembly > Assembly > Array > Array by Path

Sheet Metal > Advanced > Array > Array by Path

Surfaces > Advanced > Array > Array by Path

Primitives > Advanced > Array > Array by Path

Support Geometry > Copy > Array > Array by Path

Keyboard Textual Menu

<3AP> Operation > Array > Array by Path

The command creates arrays, using guide curves for defining positions of elements. 

Main concepts of creating an array by path are described in the Classes of Arrays of 3D Elements

section.

In order to create an array by path, perform following steps upon calling the command:

1. Choose a type of the array to be created (  array of constructions,  array of operations,

 array of bodies,  array of faces,  array of fragments);

2. Select source objects of the array;

3. Select a guide curve in the first direction

4. Select a start point in the first direction (optional step);

5. Define a number of copies, step and total length in the first direction;

6. Choose a copy placement option in the first direction (optional step);

7. Define a guide curve, start point and parameters of array in second and third directions in the

similar way as it was defined in the first direction (optional step);

8. Apply limitations and exclusions (optional step);

9. Define optional parameters of the array (optional step);

10.Confirm the operation (  in the automenu or in the header of the parameters window).

Apart from the General Parameters (selecting a type of the array and source objects), Limitations,

Exclusions and Options tabs the command's parameters window contains three tabs similar to each

other:

· First Direction (rows);

· Second Direction (columns);

· Third Direction (height).
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These tabs contains the similar sets of parameters described below. The geometrical meaning of these

parameters is described in the Classes of Arrays of 3D Elements section.

Defining a Path, number of Copies, Step and Length in the First Direction (rows) is mandatory for

creating an array. Two of the latter three parameters are defined by user, the third one is calculated

automatically from values of two others.

A guide curve can be selected upon activating  the Path input box on the corresponding

directional tab. These input boxes are connected to following automenu options:

<T> Select first guide curve

<O> Select second guide curve

<J> Select third guide curve

Activating the input box activates the automenu option and vice versa. In result, filters for selecting 

wires (  3D profiles,  faces,  edges,  loops,  3D paths) become active on the filter

toolbar, so you can select  the desired object in the 3D scene or in the model tree. An icon

representing a type of a selected element, its name and name of its parent operation (in case of

selecting a geometric entity) are displayed in the Path input box. You can  Clear the selection,

using the button located in the right side of the input box. 

Upon selecting a  face, a sequence of edges forming its boundaries is used as the guide curve.

The direction of array is defined by a direction of a guide curve. You can  Reverse Direction, using

the button located to the right side of the Copies input box.



T-FLEX CAD 17 Help

1926

Additionally a Start Point can be selected for each direction upon activating  the eponymous input

box on the corresponding directional tab of command's parameters window. These input boxes are

connected to following automenu options:

<S> Select start point

<B> Select start point

<K> Select start point

Activating the input box activates the automenu option and vice versa. In result, filters for selecting 

points become active on the filter toolbar, so you can select  the desired object in the 3D scene or

in the model tree. An icon representing a type of a selected element, its name and name of its parent

operation (in case of selecting a geometric entity) are displayed in the Start Point input box. You can

 Clear the selection, using the button located in the right side of the input box. 

One of the following combinations of array's parameters can be selected in the Parameters drop-

down list, which is located below start point input boxes in each directional tab of the command's

parameters window:

· Number of Copies and Step;

· Total Length and Step;

· Number of Copies and Total Length.

Depending on the selected combination only two of the three input boxes located below (Copies,

Step and Length) are accessible, while the value in the third input box is calculated automatically.

By default, even if the selected combination of parameters allows manual input of total length's value,

the Length input box is inaccessible due to automatic application of the option, which defines total

length as the length of the guide curve. This option can be disabled, using the  By Path button,

which is located to the right side of the Length input box. The similar button is located to the right

side of the Step input box, allowing to define the Step as the relation of Length to the number of

Copies. Both options can not be applied at once for Length and Step in the same direction.

When using an open Path in combination with a Start Point, the guide curve is trimmed, so that

start point's projection becomes a start of a guide curve. 

Copy placement options for fist and second directions can be selected in drop-down lists, which are

located in the bottom of directional tabs. Following placement options are available:

· Minimal Twist along Path;

· Translation along Path;

· By Chord.

Copy placement options are not available for the third direction. Upon selecting a path for the

third direction, the Translation along Path becomes the only available option for the first and

second directions.

When using the By Chord placement option, the Number of Copies and Step becomes the only

available combination of parameters for this direction.
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The detailed information on copy placement options is available in the Classes of Arrays of 3D

Elements section.

Topics in this section:

· Edit Array of 3D Elements by Path

See Also:

· Types of Arrays of 3D Elements 

· Classes of Arrays of 3D Elements 

· Limitations and Exclusions in Arrays of 3D Elements

· Referencing 3D Elements of Array

· Optional Parameters of Arrays of 3D Elements

· Preview of Operation Result 

· Common Parameters of 3D Elements

Edit Array of 3D Elements by Path

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual Menu

<3EAP> Edit > Operations > Array > By Path

This command is used for editing arrays by path.

Available options:
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<Esc> Cancel selection

<A> Select All Elements

<R> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<Esc> Exit command

<M> Transformation

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, start editing or changing definition. 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination excludes elements from selection).

Parametric Array of 3D Elements

Icon Ribbon

3D Model > Operations > Array > Parametric Array

Assembly > Assembly > Array > Parametric Array

Sheet Metal > Advanced > Array > Parametric Array

Surfaces > Advanced > Array > Parametric Array

Primitives > Advanced > Array > Parametric Array

Support Geometry > Copy > Array > Parametric Array

Keyboard Textual Menu

<3AA> Operation > Array > Parametric Array

The command creates an array by parametric copying of s source object 

Main concepts of creating a parametric array are described in the Classes of Arrays of 3D

Elements section.

In order to create a parametric array, perform following steps upon calling the command:
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1. Choose a type of the array to be created (  array of constructions,  array of operations,

 array of bodies);

2. Select source objects of the array;

3. Select a source LCS (optional step);

4. Define a number of copies;

5. Select elements defining a coordinate system of a current copy (optional step);

6. Choose an axes direction calculation method (optional step, available if elements defining a

coordinate system of a current copy were selected);

7. Select driven variables (the set of available parameters is different in free copies orientation

mode and orientation of copies by curves or surfaces mode) 

8. Define driving variables (the set of available parameters is different in free copies orientation

mode and orientation of copies by curves or surfaces mode) 

9. Define optional parameters of the array (optional step);

10.Confirm the operation (  in the automenu or in the header of the parameters window).

Parametric array is formed by copying source objects from source coordinate system to coordinate

system of a current copy. The global coordinate system of the current document is used as the source

coordinate system by default. You can assign any LCS existing in the 3D scene as the source LCS, using

the following automenu option:

<6> Select Source LCS

It enables the filter for selecting  LCSes on the filter toolbar, so you can select  the desired LCS

in the 3D scene or in the model tree. Selected LCS is highlighted in green in the 3D scene. Source LCS

is not indicated in the command's parameters window.

You can cancel the selection, using the following automenu option:

<7> Cancel selection of elements defining coordinate system

Keep in mind, that this option also cancels the selection of elements defining a coordinate

system of a current copy in the orientation of copies by curves or surfaces mode.

The Number of copies can be specified in the Common tab of the command's parameters window.



T-FLEX CAD 17 Help

1930

Command's parameters window have different layout depending on a copies orientation mode.

Free copies orientation

The detailed information on this mode of copy's LCS orientation and geometrical meaning of its

parameters is available in the Free Instance Orientation in Parametric Sweep section.

By default, parametric arrays are created in the free copies orientation mode. Direction of copy's LCS

axes in this mode is defined by user-assigned expressions for driving variables. Therefore, this mode

doesn't require selecting curves or surfaces for defining copies orientation, and the Axis direction

drop-down list in the Common tab of command's parameters window is inactive.

The Variables tab of command's parameters window contains two groups of parameters - Driven

Variables and Driving Variables.

The Driven Variables group in this mode contains only a single parameter - number of copy. The

Number of Copy drop-down list contains names of all independent numeric variables available in the

current document. Selecting a name of a variable in the list makes this variable take values of number

of copy.

The Driving Variables group in this mode contains three tabs:

· Position

Contains input boxes for defining X, Y, Z coordinates of current copy's LCS origin.

· X

Contains input boxes for defining X, Y, Z coordinates of a point, which defines a direction of

current copy's LCS X axis.

· Y

Contains input boxes for defining X, Y, Z coordinates of a point, which defines a direction of

current copy's LCS Y axis.

· Z

Contains input boxes for defining X, Y, Z coordinates of a point, which defines a direction of

current copy's LCS Z axis.
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Orientation of copies by curves or surfaces

The detailed information on this mode of copy's LCS orientation and geometrical meaning of its

parameters is available in the Orienting Instances by Paths or Surfaces in Parametric Sweep

section.

This mode is activated by selecting a curve, which defines position of current copy's LCS origin. A

curve can be selected, using the following automenu option:

<1> Select Curve defining position of coordinate system

This option enables the filter for selecting  wires (  3D profiles,  faces,  edges,  loops, 

3D paths) on the filter toolbar, so you can select  the desired object in the 3D scene or in the

model tree. Selected object is highlighted in green in the 3D scene. It is not indicated in the

command's parameters window. Upon selecting a  face, it is highlighted in blue in the 3D scene

and the set of edges forming this face's boundaries is used as the curve defining position of

coordinate system.

The layout of command's parameters window changes upon selecting a curve:
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Optionally, current copy's LCS axes orientation can be defined either by curves or surfaces. For this

purpose curves can be selected, using following automenu options:

<2> Select Curve defining X direction of coordinate system

<3> Select Curve defining Y direction of coordinate system

Such curves are selected in same way as a curve defining position of coordinate system.

Surfaces can be selected, using following automenu options:

<4> Select Surface defining X direction of coordinate system

<5> Select Surface defining Y direction of coordinate system

These options enable the filter for selecting  geometrical surfaces (  3D profiles,  operations,

 faces,  worksurfaces) on the filter toolbar, so you can select  the desired object in the 3D

scene or in the model tree. Selected surface is highlighted in green in the 3D scene, while its contour is

highlighted in green. It is not indicated in the command's parameters window. 

Selection of curves and surfaces defining position of current copy's LCS origin an its axes orientation

can be canceled, using the following automenu option: 

<7> Cancel selection of elements defining coordinate system

Keep in mind, that it also cancels the Source LCS selection.
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Selection of all curves and surfaces is canceled at once. There's no way to cancel a selection of single

element leaving others intact.

If only a curve defining position of coordinate system  is selected, two options are available in the

Axis direction drop-down list located on the Common tab of command's parameters window:

· By minimal twist

A direction of an X axis of current copy's LCS coincides with a direction of selected curve's

curvature vector at the current copy's origin.

· By curvature

An X-axis is directed so to provide smooth rotation from a curvature vector direction at curve's

start to a curvature vector direction at curve's end

If curves defining axes direction  were additionally selected, the different set of Axis

direction options is available:

· By minimal distance 

A direction of a corresponding current copy's LCS axis is defined by a vector from current

copy's LCS origin on a curve defining a position to a nearest point of a curve defining a

direction.

· Orthogonal 

A plane is constructed orthogonal to a tangent direction of a curve defining position in a

current copy's LCS origin. A axis direction of a corresponding axis is defined by an intersection

point between the plane and a path defining direction.

· By parameter

A direction of a corresponding current copy's LCS axis is defined by a vector from current

copy's LCS origin on a curve defining a position to a point on a curve defining direction

defined by an expression in the Parameter input box.

· By offset. 

A direction of a corresponding current copy's LCS axis is defined by a vector from current

copy's LCS origin on a curve defining a position to a point on a curve defining direction

defined by an expression in the Offset input box.

If surfaces defining axes direction  were additionally selected, the Axis direction drop-down

list is inaccessible.

The Variables tab of command's parameters window contains two groups of parameters - Driven

Variables and Driving Variables.

The Driven Variables group in this mode contains the Number of Copy, Parameter and Offset drop-

down lists. Parameter and Offset both define the position of current copy's LCS origin on a curve

defining position. Parameter changes from 0 (at the start of the curve) to 1 (at the end); Offset is

measured in units selected for length in document parameters and is equal to length of a curve's

portion between its start and current copy's LCS origin.

Moreover the Driven Variables group contains three tabs:

· Position

Contains drop-down lists for assigning variables to X, Y, Z coordinates values of current copy's

LCS origin.

· X

Contains drop-down lists for assigning variables to X, Y, Z coordinates values of a point, which

defines a direction of current copy's LCS X axis.
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· Y

Contains drop-down lists for assigning variables to X, Y, Z coordinates values of a point, which

defines a direction of current copy's LCS Y axis.

· Z

Contains drop-down lists for assigning variables to X, Y, Z coordinates values of a point, which

defines a direction of current copy's LCS Z axis.

Each of the driven variables drop-down lists contains names of all independent numerical variables

available in the current document. Selecting a name of a variable in the list makes this variable take

values of the corresponding parameter.

Assigning at list one driven variable is mandatory for creating an array.

The Driving Variables group in this mode contains two input boxes - Parameter and Offset. Both

parameters serve the same purpose of positioning of a current copy's LCS origin, using different

approaches (see above). Therefore, both of these parameters can not be used as driving variables at

the same time. Defining one of them is mandatory for creating an array

Topics in this section:

· Example of Parametric Array of 3D Elements with Free Orientation of Copies

· Edit Parametric Array of 3D Elements

See Also:

· Types of Arrays of 3D Elements 

· Classes of Arrays of 3D Elements 

· Optional Parameters of Array of 3D Elements

· Preview of Operation Result 

· Common Parameters of 3D Elements

· Parametric Sweep

Example of Parametric Array of 3D Elements with Free Orientation of Copies

As was mentioned earlier, creation of a parametric array is similar to creating a Parametric Sweep.

Here, we will review the array creation on the example of a spiral staircase.

The model is built as a parametric array with free orientation of copies based on the 3D fragment of

one step of the staircase. 
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The example files are located in the Examples library, in the \3D Modeling\Array\Winding

Stairs.grb folder.

When creating an array in this way, just select a body, specify the number of copies and assign an

independent variable to the Number of copy parameter. By using the variable assuming a copy's

ordinal number, you can define certain relations in the driving parameters input boxes, as well as in

the 2D or 3D constructions defining the position and geometry of the source body. In this example, a

step of the staircase is copied with a change in the height and rotation angle about the staircase axis. 

For convenience of handling the model, the following variables are created in the variable editor:

 

The step of the spiral staircase is inserted in the document as a 3D fragment. This fragment is inserted

in such a way, that the axis of the staircase coincides with the global Z-axis. If the fragment were

located arbitrarily, then one would have to select a local coordinate system, using the option:
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<6> Select source coordinate system

Its Z-axis must have been directed along the staircase axis.

In this example, the expression defining the position of each copy depending on the copy count

number can be entered in the input boxes of the driving parameters. The array parameters can be

defined in the  Parametric Array command's  parameters window or in the  operation

parameters dialog.
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Positions of copies will be calculated by the linear law along the global Z-axis with the step defined

by the variable h. The X-axis of the current copy's coordinate system will be rotated about the axis of

the staircase. This moment of the X-axis is defined by the X-axis direction parameter group. The Z-

axis direction of a copy's coordinate system coincides with the staircase axis and with the global Z-

axis. The Y-axis direction of a copy's coordinate system should be calculated automatically, therefore

all driving parameters in this group are set to zero. 

Edit Parametric Array of 3D Elements

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual Menu

<3EAA> Edit > Operations > Array > Parametric Array

This command is used for editing parametric arrays.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<R> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<Esc> Exit command

<M> Transformation

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, start editing or changing definition. 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination excludes elements from selection).



Arrays of 3D Elements

1939

Array of 3D Elements by Pattern

Icon Ribbon

3D Model > Operations > Array > Array by Pattern

Assembly > Assembly > Array > Array by Pattern

Sheet Metal > Advanced > Array > Array by Pattern

Surfaces > Advanced > Array > Array by Pattern

Primitives > Advanced > Array > Array by Pattern

Support Geometry > Copy > Array > Array by Pattern

Keyboard Textual Menu

<3AC> Operation > Array > Array by Pattern

The command creates an array, using another array of any type and class as a pattern.  Hole

operations can also be used as patterns.

In order to create an array by pattern, perform following steps upon calling the command:

1. Choose a type of the array to be created (  array of constructions,  array of operations,

 array of bodies,  array of faces,  array of fragments);

2. Select source objects of the array;

3. Select a pattern (an array or a face of a hole);

4. Select a source LCS (optional step, available upon selecting a hole as a pattern);

5. Include a source operation into the array (optional step)

6. Define optional parameters of the array (optional step);

7. Confirm the operation (  in the automenu or in the header of the parameters window).
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Command's parameters window 

upon selecting a pattern array

Command's parameters window 

upon selecting a pattern hole

In order to select a pattern you need to activate  the Pattern input box in the General Parameters

tab of the command's parameters window. It activates filters for selecting  faces and  operations

on the filter toolbar, so you can select  the desired object in the 3D scene or in the model tree.

However, the only operations available for selection are arrays of any type and class, while the only

faces available for selection are faces created either by the  Hole operation, or by  arrays of

faces whose source objects are faces of holes. An icon representing a type of a selected element, its

name and name of its parent operation (in case of selecting a face) are displayed in the Pattern input

box. You can  Clear the selection, using the button located in the right side of the input box.

Despite having a name of a certain face displayed in the Pattern input box upon selecting a face of a

hole, actually all holes created by the same operation are used as a pattern.

Upon selecting a pattern hole the Source LCS input box appears in the General Parameters tab of the

command's parameters window. Activating  this input box enables filters for selecting  LCSes

on the filter toolbar, so you can select , the desired object in the 3D scene or in the model tree. An

icon representing a type of a selected LCS and its name are displayed in the Source LCS input box.

You can  Clear the selection, using the button located in the right side of the input box.

When using a hole as a pattern, copies in array are created by positioning a source object in the

following way:

· When creating an  array of fragments without selecting a source LCS, a global CS of a

fragment is coincided with an LCS of a hole.

· When creating other types of arrays without selecting a source LCS, either an LCS of a source

object (if such LCS exists), or the global LCS of the current document is coincided with an LCS

of a hole.

· When creating an array of any type with selecting a source LCS, selected LCS is coincided with

an LCS of a hole.
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Detailed information on coordinate systems of holes can be found in the Hole Orientation

section.

Depending on a type of a pattern hole, the particular instance of a hole, which created the faces

selected in the Pattern input box can be handled by in different ways. In some cases a copy of a

source object based on this instance is created by default, in other cases creating such copy requires

enabling the Include Source Operation checkbox in the command's parameters window. 

Green bolt - source object of array

Yellow bolts - dynamic preview of operation result

Pattern face is highlighted in blue

The Include Source Operation checkbox is disabled
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The Include Source Operation checkbox is enabled

Dynamic preview may ignore the result of enabling/disabling checkboxes until applying the

Preview of Operation Result .

When creating array, using another array as pattern, position of new array's source object doesn't

change. Thus, if position of new array's source object doesn't coincide with position of pattern array's

source object, then positions of copies do not coincide as well.

When using non-parametric array as pattern, positions of copies in relation to source object in new

array are same as positions of copies in relation to source object in pattern array.

When using parametric array (created either by the  Parametric Array command, or by the 

 Array by Table command with the Parametric Array option enabled) as pattern, new array inherits

only a number of copies, while all other parameters are ignored. Thus, all copies of resulting array are

located in the same point and have the same geometry, regardless of variables assigned to

parameters of the source object. Therefore, using parametric arrays as patterns is impractical.

Array by pattern inherits exclusion and limitations from pattern array. However, the result of applying

limitations to array by pattern may differ from the result of applying limitations to pattern array due

to different positions of arrays' source elements in relation to limiting elements. Limitations and

exclusions inherited from pattern are not displayed in array by pattern command's parameters

window.

The Dynamic preview ignores limitations. Use the Preview of Operation Result instead.

Pattern array before applying limitations;

Limiting faces is outlined in red;

1 - Source object of pattern array.

Pattern array after applying limitations.
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Pattern array is highlighted in blue;

Dynamic preview of array by pattern 

is highlighted in yellow (limitation ignored);

1 - Source object of array by pattern.

Actual result of array by pattern 

upon inheriting limitations is highlighted in green.

See Also:

· Types of Arrays of 3D Elements 

· Classes of Arrays of 3D Elements 

· Limitations and Exclusions in Arrays of 3D Elements

· Referencing 3D Elements of Array 

· Optional Parameters of Arrays of 3D Elements

· Preview of Operation Result 

· Common Parameters of 3D Elements

Array of 3D Elements by Table

Icon Ribbon

3D Model > Operations > Array > Array by Table

Assembly > Assembly > Array > Array by Table

Sheet Metal > Advanced > Array > Array by Table

Surfaces > Advanced > Array > Array by Table

Primitives > Advanced > Array > Array by Table

Support Geometry > Copy > Array > Array by Table

Keyboard Textual Menu

<3AD> Operation > Array > Array by Table
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The command creates an array, using a database. Values of database cells are used either as

coordinates of array's elements (in case of non-parametric array by table) or as values of model's

variables (in case of parametric array by table).

In order to create a non-parametric array by table, perform following steps upon calling the

command:

1. Choose a type of the array to be created (  array of constructions,  array of operations,

 array of bodies,  array of faces,  array of fragments);

2. Select source objects of the array;

3. Select a database;

4. Define a number of copies (optional step);

5. Choose a coordinate system (Cartesian, spherical or cylindrical);

6. Select a source and/or target LCS (optional step);

7. Set up a correspondence between columns of a database and coordinates of array's

elements;

8. Define optional parameters of the array (optional step);

9. Confirm the operation (  in the automenu or in the header of the parameters window).

Creation of a parametric array by table is described in the separate section.
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Array by table in Cartesian coordinate system
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Array by table in cylindrical coordinate system

Upon selecting source objects of array it is necessary to select a Database in the eponymous drop-

down list of the command's parameters window. The list contains all databases available in the

current document. You can create a new database if necessary, using the  Create Database button

located to the right side of the drop-down list.  

The detailed information on working with databases is available in the Databases section.

By default, the number of copies in the array is defined by the number of rows in the selected

database. It is displayed in the Number of Copies input box of the command's parameters window

and is non-editable. In order to manually change the number of copies, you need to enable the

checkbox located to the left side of the input box. Enabling the checkbox makes the Number of

Copies value editable, so you can type in a custom value, which should not exceed the number of rows

in the selected database. When using a custom number of copies, the array utilizes a corresponding

number of rows from the start of the database, while rest of the rows do not affect the operation

result.

The Coordinate System group of parameters contains the drop-down list, where you can switch

between Cartesian, Spherical and Cylindrical coordinate systems. The set of parameters available in
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the bottom area of the  General Parameters tab of the command's parameters window depends on

the coordinate system selected in the drop-down list.

Optionally, you can select Source and Target LCS in the 3D scene or in the model tree. If the Cartesian

coordinate system is selected in the aforementioned drop-down list, then coordinates of array's

elements are defined in the Target LCS. If Spherical or Cylindrical coordinate systems were selected in

the drop-down list, then coordinates of array's elements are defined in the automatically created LCS

of the corresponding type based on the Target LCS. Linear and angular coordinates of the Source LCS

in relation to the global coordinate system are added to coordinates of array's elements. 

By default, the Source LCS is not used; the global coordinate system is used as the Target LCS; the

corresponding input boxes of command's parameters window are empty.

Source and Target LCS can be selected in the 3D scene or in the model tree upon activating the

corresponding input boxes or using the following automenu options:

<S> Select Source LCS

<T> Select Target LCS

Upon selecting coordinate systems, you need to set up a correspondence between coordinates of

array's elements and columns of the selected database. Depending on the selected type of coordinate

system (Cartesian, Spherical or Cylindrical) bottom area of the General Parameters tab in the

command's parameters window contains one of the following sets of drop-down lists.

For Cartesian CS:

· X coordinate;

· Y coordinate;

· Z coordinate;

· Angle around X axis;

· Angle around Y axis;

· Angle around Z axis.

For spherical CS:

· Radial Distance

Distance from the origin of the Cartesian Target LCS.

· Polar Angle

Deviation from the positive direction of the Z axis of the Cartesian Target LCS.

· Azimuthal Angle

Angle from the X axis in the XY plane of the Cartesian Target LCS.

For cylindrical CS:

· Radial Distance

Distance from the Z axis of the Cartesian Target LCS.

· Azimuthal Angle

Angle from the X axis in the XY plane of the Cartesian Target LCS.

· Height

Distance from the XY plane of the Cartesian Target LCS.

Each of the drop-down lists contains names of database columns. Value in the selected column will

define the corresponding coordinate of array's elements. The same column can be selected in several

drop-down lists at the same time.

In addition to names of columns drop-down lists contain two more options:

· [not set]

The corresponding coordinate will be equal to zero.
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· [default] 

The corresponding coordinate will be taken from the source object of array. This option is not

applicable, if source and/or target LCSes were selected.

Topics in this section:

· Parametric Array of 3D Elements by Table

See Also:

· Types of Arrays of 3D Elements 

· Classes of Arrays of 3D Elements 

· Referencing 3D Elements of Array 

· Preview of Operation Result 

· Common Parameters of 3D Elements

Parametric Array of 3D Elements by Table

Parametric array by table allows to set up a correspondence between columns of a database and

variables of a model.

In order to create a parametric array by table, you need to choose a type of the array (  array of

constructions,  array of operations,  array of bodies,  array of faces,  array of fragments),

select source objects, select a database and, optionally, define a number of copies.

Next, you need to enable the Parametric Array checkbox located in the General Parameters tab of

command's parameters window.

Upon enabling this checkbox, the Coordinate System group of parameters as well as corresponding

automenu options disappear, while the set of drop-down lists in the bottom area of the tab is

replaced by a row containing two drop-down lists - Variable and Column. The Variable drop-down

list contains names of all variables available in the current document.

The detailed information on working with variables can be found in the Variables and Related

Parametric Tools chapter. 

The Column drop-down list contains names of columns of the selected database.

You need to select items in both drop-down list, so the content of the selected column will be used as

values of the selected variable.

The Add Variable button is located below. Clicking this button adds into command's parameters

window another row with another couple of Variable and Column drop-down lists. You can add as
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many rows as you need by sequentially clicking this button. Then you can to set up a correspondence

between variable and column in each row in the same way as described above. Any row, except the

first one, can be deleted, using the  Delete Variable button, which is located in the right side of the

row. 

The [not set] option is selected in all drop-downs by default. You don't have to select variables and

columns in each drop-down, non-set values do not prevent the array creation, if the correspondence is

set between at least one variable and one column of the database.

The same column can be used for defining values of several variables at once.

The system does not prevent selecting the same variable for several columns at once, however the

resulting array will use as values of such variable the content of the database column, which is selected

in the bottommost drop-down list.

You can also define optional parameters of array.

Upon specifying all necessary parameters, confirm the operation creation (  in the automenu or in

the command's parameters window).
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Parametric array by table, the database used for its creation and parameters of the source box primitive

See also:

· Array of 3D Elements by Table

· Types of Arrays of 3D Elements

· Classes of Arrays of 3D Elements

· Referencing 3D Elements of Array

Layout and Half-Step Shift in Arrays of 3D Elements

Following Layouts are available for  Linear and  Circular Arrays:

·  Standard;

·  Row Shift;

·  Column Shift; 

·  Custom. 

Layouts can be switched in the General Parameters tab of command's parameters window:
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Tabs of each direction in the command's parameters window contain Half-Step Shift checkboxes 

Switching a layout affects enables a particular combination of such checkboxes. And vice versa,

enabling a combination of Half-Step Shift checkboxes, which corresponds to a particular layout,

automatically activates such layout.

When checkboxes are enabled, each second row, column or height (depending on checkboxes'

direction) is shifted by half a step.

 Standard Layout

The Standard Layout is active by default upon creating an array. It means that Half-Step Shift

checkboxes are disabled in all directions.
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Here and further below:

1 - First Direction (Rows).

2 - Second Direction (Columns).

3 - Third Direction (Height).

Forward directions are shown in red. Reverse directions are shown in blue.

Source object is shown in green.

 Row Shift

Activating this layout makes the Half-Step Shift checkbox enabled only in the fist direction. As a result,

elements of each second column are shifted in the row direction.
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 Column Shift

Activating this layout makes the Half-Step Shift checkbox enabled only in the second direction. As a

result, elements of each second row are shifted in the column direction.

 Custom Layout

This layout cannot be selected directly in the General Parameters tab of command's parameters

window. However, it is activated automatically, when a user enables a combination of Half-Step Shift

checkboxes non-compliant to any of the three other layouts. Following combinations are possible:
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· Half-Step Shift is enabled in first and second directions (rows and columns).

As a result, elements are shifted both in each second row (shifted in the column direction) and

in each second column (shifted in the row direction).

· Half-Step Shift is enabled in first and third directions (rows and height).

Elements of each second column are shifted in the row direction (similar to the  Row Shift

layout), and elements of each second height are additionally shifted in the row direction.

· Half-Step Shift is enabled in second and third directions (columns and height).

Elements of each second row are shifted in the column direction (similar to the  Column
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Shift layout), and elements of each second height are additionally shifted in the column

direction.

· Half-Step Shift is enabled in all three directions (rows, columns, height).

Elements of each second row are shifted in the column direction, Elements of each second

column are shifted in the row direction, and elements of each second height are additionally

shifted both in column and row directions.

Enabling the Half-Step Shift only in third direction (height) activates the  Custom layout but

doesn't affect positions of array's elements.
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Half-Step Shift and Layouts are applicable to  circular arrays in the same manner as described

above; apart from difference in directions.

Limitations and Exclusions in Arrays of 3D Elements

Limitations and exclusions are used to exclude some of the created copies from an array.

Limitations

Main concepts of limitations in arrays of 3D elements are described below. The interface is

described in the Limitations in 3D Arrays section.

Setting a limitation means defining a subset of the 3D space to which copies creation is limited –

limitation scope. When in this mode, all copies that are created per the main array parameters are

checked by the system for falling in the limitation scope. If a copy fully falls within the scope, it will be

included in the resulting array. If a copy is located outside the limitation scope or fits in but partially, it

is not included in the resulting array.

Limitations are not available with all classes of construction element arrays, as well as with any

parametric arrays and arrays by table. Arrays by pattern inherit limitations from patterns.

The limitation scope is defined by a 3D element, which has a length and width, but doesn't have a

thickness – a face, 3D profile, surface body, worksurface. The selected element is extruded in both

sides along the limitation axis for the infinite distance. The resulting extrusion area will be the

limitation scope of the array. 

A limiting elements could be flat or not. Non-flat limiting elements should be open; an array can

not be created, using a closed limiting element. 
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The flat square 3D profile is selected as the limiting element of  the three-dimensional linear array

1 - Elements located fully outside the limitation scope (excluded from the array)

2 - Elements located partially outside the limitation scope (excluded from the array)

3 - Elements located fully inside the limitation scope (included in the array)

The operation result

If the limitation scope is defined by a flat 3D element, then the limitation axis coincides, by default,

with the normal of the selected element's plane. If necessary, you can specify an arbitrary direction of

the limitation axis by defining the axis directions by two 3D nodes or one 3D object suitable for

defining a straight line. 

In cases when the array limitation scope is described by a non-flat limiting element, the

limitation axis must be explicitly specified.

In cases when the array limitation scope is described by a flat limiting element, the limitation

axis must not be parallel to a plane of limiting element.
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The same array as in previous pictures, but the limitation axis is defined by points 1 and 2.

The limitation scope can also be defined by multiple 3D elements. All elements are extruded in the

same direction. The limitation scope will be the sum of extrusions of each limiting element.
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The non-flat limiting surface is selected in addition to the limiting profile

In cases when the array limitation scope is described by two flat limiting elements perpendicular

to each other, the limitation axis must be explicitly specified.
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Two flat square 3D profiles (1 and 2) parallel to each other are selected as limiting elements.

The limitation axis is defined by points 3 and 4.

5 - Copies located inside the extrusion area of the first limiting profile.

6 - Copies located inside the extrusion area of the second limiting profile.

Exclusions

Main concepts of exclusions in arrays of 3D elements are described below. The interface is

described in the Exclusions in 3D Arrays section.

Exclusions, or excluded elements are the array elements that shall not be included in the resulting

array. Any array elements can be excluded, except the source object.

Exclusions can be defined for  linear arrays,  circular arrays and  arrays by path. 

 Arrays by pattern inherit exclusions from a pattern.

An exclusion is specified by its position in the original array, that is, the column, the row, and the

height in the array, at whose intersection this element is located. The dimension of the array in the first

direction defines the number of rows, in the second - the number of columns, in the third - the number

of heights.

Rows, columns and heights in arrays are numbered as follows: 

- 0, 1, 2, …, N-1 – in the forward direction (N is the number of copies in a row/column/height in the

forward direction)

- -1, -2, …, -M+1 – in the backward direction (M is the number of copies in a row/column/height in the

backward direction).

Note that the column, row and height in which the source object of the array is located, have

number 0. This is important when defining exclusions.

Instead of the number of particular rows/columns/heights, one can use descriptive characteristics

defining their position in the original array:

· Starting - the row/column/height in which the source object of the array is located (the

number 0);

· Last - the row/column/height, which is the last in the forward direction of array creation;
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· Last in Opposite Direction - the row/column/height, which is the last in the backward direction

of array creation;

This way of specifying exclusion locations is convenient for removing elements of the outer

rows/columns/heights from the arrays of variable size, especially when the array dimensions are

defined by the total length and the step, or the total length and the number of elements. Suppose, for

example, that you need to exclude an element in a linear array of size 4x4x4, that is located at the

intersection of the last row, the last column and the last height of the array (assuming that the copies

are created in the forward direction only). One can simply specify the element at the intersection of

the row number 4, column number 4 and height number 4 as the element to exclude. However, should

the array grow (for example, to 5 rows, 5 columns and 5 heights), the excluded element will have the

same exact coordinates 4;4;4 (the last element of rows columns and heights now has the 5;5;5

coordinates). Instead, to have specifically the last element of the array always excluded, the exclusion

should specify the element at the intersection of "the last" row and "the last" column.

The source object of array is highlighted in green, the exclusion is highlighted in white

The first direction (rows) is indicated by the blue arrow, second direction (columns) - orange, third direction

(heights) - red.

Positions of elements in the each direction is indicated by numbers of the same color as the directional arrow.

The initial linear array The initial circular array



T-FLEX CAD 17 Help

1962

The result of increasing the size of the array by one element in each direction, if the position of the excluded

element was defined by numerical coordinates (2; 2; 2).

The result of increasing the size of the array by one element in each direction, if the position of the excluded

element was defined as Last in each direction.

Upon selecting an excluded element it is possible to additionally exclude the whole row, column or

height containing this particular element.
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The result of excluding the second row (framed in blue), second column (strikethrough in orange) and second

height (strikethrough in red) from arrays shown on the previous picture

· Cyclical Repeat. Enabling this option will cause deletion of not only the original exclusion, but

also the elements following it after the same number of rows and columns from the start of

the array. If this option is used together with the exclusion of rows/columns/heights, the whole

rows/columns/height will be excluded in the same way.
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The result of applying the cyclical repeat to the element in position 1;1;1 

in linear and circular three-dimensional arrays with 6 copies in each forward direction and 4 copies in each reverse

direction.

First forward direction (rows) is indicated by the blue arrow, second (columns) - orange arrow, third (height) - red

arrow.

Non-excluded elements are shown in black color. 

The source object of the array is shown in red color and green frame.

Excluded elements are shown in red color and blue frame.

Numbers indicate positions of excluded elements.
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The result of excluding the row (strikethrough in blue), 

the column (strikethrough in orange) and height (framed in red) 

containing the element 1;1;1 from arrays shown on the previous picture
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The result of applying the cyclical repeat to arrays shown on the previous picture

Topics in this section:

· Limitations in Arrays of 3D Elements

· Exclusions in Arrays of 3D Elements

Limitations in Arrays of 3D Elements

The interface of defining limitations is described below. The main concepts of limitations are

described in the Limitations and Exclusions in Arrays of 3D Elements section.

The Dynamic preview ignores limitations. Use the Preview of Operation Result instead.

The array creation command's window contains the Limitations tab, if limitations are applicable to the

selected type and class of arrays. This tab contains the list of limiting elements. In order to add an

limiting element, you need to activate  the list or the corresponding automenu option:

<1> Select limiting elements

Activation of the list in the parameters window activates the automenu option and vice versa. In result,

filters for selecting elements capable of defining a  geometrical surface  (  3D profiles, 

operations,  faces,  worksurfaces) become active on the filter toolbar, so you can sequentially

select  any number of suitable elements in the 3D scene or in the model tree. A type icon of a
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selected element, its name and name of its parent operation in case of selecting a geometric entity

are displayed in the Limitations list. Selected elements are highlighted in the 3D scene.

In order to cancel the selection of one of the selected elements, you need to click   it in the list and

use the  Delete button located to the right side of the list.

Defining the limitation axis by a single 3D element can be done, using the following automenu

option:

<2> Select auxiliary direction of limits

This option enables filters for selecting   directions on the filter toolbar, so you can select  a

suitable element in the 3D scene or in the model tree. The selected element is highlighted in the 3D

scene but is not displayed in the command's parameters window.

Defining the limitation axis by two points can be done, using following automenu options:

<3> Select first point of auxiliary direction of limits

<4> Select second point of auxiliary direction of limits

This option enables filters for selecting  points on the filter toolbar, so you can select  a suitable

element in the 3D scene or in the model tree. The selected element is highlighted in the 3D scene but

is not displayed in the command's parameters window. The option for selecting a second point

becomes available upon selecting a first point.

Regardless of whether the limitation axis was defined by a single element or by two points, you can

re-define the direction by selecting objects again, using the same automenu options, or cancel the

selection, using the following option:

<5> Cancel selection of auxiliary direction of limits

Exclusions in Arrays of 3D Elements

The interface of defining exclusions is described below. The main concepts of exclusions are

described in the Limitations and Exclusions in Arrays of 3D Elements section.
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The array creation command's window contains the Exclusions tab, if exclusions are applicable to the

selected type and class of arrays. This tab contains the list of excluded elements. In order to exclude

an element, you need to activate  the list or the corresponding automenu option:

<6> Select elements to Exclude

Activating the list in the parameters window activates the automenu option and vice versa. In result,

the filter toolbar becomes hidden and only previewed elements of the current array become

selectable in the 3D scene, using . Selected elements are highlighted in the 3D scene in white (if

solid) or in red color (if construction) and are listed in the Exclusions tab of the command's

parameters window.

The list of exclusions is a table where each row corresponds to a certain excluded element. Row,

Column and Height columns of the list contain position of the excluded element in the corresponding

direction. Enabling checkboxes in the  Whole Row,  Whole Column and  Whole Height

columns of the list allows to exclude the whole row, column or height containing the selected

element.

The Cyclical Repeat checkbox is located below the list of excluded elements. Enabling this checkbox

applies the cyclical repeat option to the selected item of the list.

You can  Add another element to the list,  Delete the selected item of the list,  Delete All

items from the list or  Edit the selected item.

The Exclude dialog window appears upon clicking the  Add or  Edit button. It contains the Row,

Column and Height drop-down lists. Index input boxes contain positions of excluded element in

corresponding directions. Following options are available in each of the aforementioned drop-down

lists:

· Starting

Excludes the zero position (i.e. the element coinciding to the source object of array) in this

row, column or height. Makes the Index equal to zero.

· Last

Excludes the last in the forward direction element in this row, column or height. Makes the

Index equal to "1000000".

· Last in Opposite Direction

Excludes the last in the reverse direction element in this row, column or height. Makes the

Index equal to "-1000000". 

· In Position

Allows to input the Index manually.
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Referencing 3D Elements of Array

When the number of copies in any array changes, then additions or deletions of elements occur

immediately before the last array copy in the given direction. The IDs of geometrical components in

the elements of the outmost array rows, columns and heights do not change through such additions or

deletions (outmost are the first and the last elements in any direction). 

Therefore, any operation created on an element of the first or the last row/column/height of the array

stays intact through any changes in the array dimensions. For example, an edge blend created on an

element of the last row in an array of bodies or operations, will regenerate correctly, regardless of

increases or decreases in the number of rows in the array.

Operations created on "inner" copies of the array could run into regeneration errors, as the array

dimension is decreased.
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Edge blend and Hole are based on the array element, 

which is last in all three directions (highlighted in blue). 

Source element is highlighted in green.

Result of increasing number of elements in array
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Result of decreasing number of elements in array

Optional Parameters of Array of 3D Elements

Optional parameters of all arrays are defined in the Options tab of the respective operation's

parameters window. The set of available parameters depends on the array type.

The following options are available for arrays of  construction elements,  operations and 

 bodies: 

Include Source Operation (available for arrays of  construction elements and  operations). 

If this checkbox is enabled, then the source objects are included in the array. The parameters assigned

to the array (color, material) also affect the array source objects.

Separate to Solids (available for arrays of  bodies and  operations). 

Enabling this checkbox divides the array into separate bodies (each array copy automatically becomes

a new body).

Combine Result to one Solid (available for arrays of  bodies and  operations). 

If this checkbox is enabled, then the array copies are merged together by the Boolean addition

operation.
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The source object of the one-dimensional linear array 

with three copies in the forward direction

The array is created without applying any options

The Include Source Operation option is applied

The Combine Result to one Solid option is applied The Separate to Solids option is applied
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The Include Source Operation and  

Separate to Solids options are applied

The Include Source Operation and 

Combine Result to one Solid options are applied

The Include in product structure switch is available for various types of array but is relevant only for

 arrays based on 3D fragments. It determines what will be put into product structure:

· Source

Only source fragment will be included into BOM regardless of array parameters. Results of

array creation are not taken into account in BOM;

· Array Operations 

The results of array creation are included into BOM. Depending on the status of the Include

Source Operation checkbox, the result can be either all copies of array (when the checkbox is

enabled) or copies of array and the source object (when the checkbox is disabled).

The set of optional parameters available for  array of faces is different:

Following checkboxes are available:

· Copy to one Face 
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· Extend Faces

· Check Intersection with other Faces

· Do not check boundaries of body (enabled by default) 

Enabling a checkbox activates the eponymous mode of the array creation.

Detailed information on this options is available in the Types of Arrays of 3D Elements section.
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Sheet Metal

Sheet metal commands and operations facilitate solving problems of modeling details manufactured

by the sheet metal stamping method. They allow to create an initial flat part (workpiece) of the

specified thickness and then perform various shape manipulations, such as bending about a selected

line, attaching flanges to the workpiece, creating punches and hems. Once modeling is finalized, the

part can be unbent to the unfolded sheet workpiece, you can create its drawing, bend table and then

re-bent to the actual part shape. 

Sheet Metal Example

The special forming feature command in the sheet metal group of commands helps to create various

commonly used forming features, such as beads, ribs, flanges, airways, cradle.

When working with sheet metal, you can use not only the specialized commands described in this

chapter but also general-purpose commands (Extrusion, Primitive, Boolean operations, Hole and so

on).

In some cases applying general-purpose commands may cause issues with unfolding.

In addition, it is possible to create flat patterns and sheet parts based on solids using the Convert

Body to Sheet Metal operation and to create sheet parts over two sections with the Lofted Bend

operation.

Note that the sheet metal operations do not account for possible material deformations. Rather, those

are based purely on geometrical calculations.

Topics in this section:

· General Information

· Main Commands

· Creating Drawings for Sheet Metal
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General Information

This section describes general information about working with sheet metal in T-FLEX CAD.

Topics in this section:

· Prototype for Sheet Metal Part Creation

· Sheet Metal Interface

· Draggers and Markers

· Common Parameters of Sheet Metal Commands

· Sheet Metal Default Parameters

· Creating Part

Prototype for Sheet Metal Part Creation

To create a sheet metal part, it is recommended to use a special Sheet metal Part prototype. 

Differences from the prototype 3D Model prototype are in the active Sheet Metal Ribbon tab, the

presence of the s variable (to control the sheet metal thickness when optimizing the part design), the

presence of the Nesting layer, and a special Flat Pattern page.

Sheet Metal Interface

When creating a sheet metal part and designing drawings on it, it is convenient to use the Sheet metal

Part tab in the Ribbon. The tab is context-sensitive and is divided into 3D and 2D parts. The 3D part

contains a set of commands required for designing a sheet metal part in 3D. The 2D part contains a

set of commands required to create and design a drawing of a sheet metal part and its unfolding, as

well as to create a bending table.

 

Draggers and Markers

During bending (after selecting the base line), auxiliary graphic elements - draggers and decorations -

are displayed in the 3D scene. 

Draggers are used to change sizes directly in the 3D scene. Working with draggers in sheet metal

operations is similar to their use in other 3D operations and commands (extrusion, primitive, etc.).

When you put the cursor on the dragger line the corresponding icon appears. If at this moment you

start moving the cursor with the button  pressed, the value of the corresponding parameter will

change in the value input window.
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1 - length dragger; 2 - angle dragger; 3 - bevel draggers; 4 - radius dragger; 5 - indentation dragger; 6 -

offset dragger of bend line; 7 - direction dragger; 8 - preview 

1 - Dragger; 2 - Radius marker; 3 - Face sequence number marker 

Up to eleven draggers can be in the 3D scene. However, depending on the sheet metal command

used, some of the draggers may be missing. 

If several elements are edited simultaneously in an operation, then to edit a specific element it is

necessary to move the mouse cursor closer to the desired element. All available draggers will be

displayed on the element, and the parameter window will correspond to the values of this element. 

Markers - these are markers consisting of pictograms schematically depicting the operation

parameter and indicating the parameter value. By clicking  on the parameter value on the marker,

you can call the parameter input window. Some labels allow you to change the type of parameter by

clicking  on the marker. So, for example, you can use the mark to change the type of overlap in the

Angle operation. 
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Attach Geometry using Dragger

The direction and length of the dragger, and, consequently, the geometry being created, can be

attached to 3D scene objects. To do this, call the context menu of the length dragger and select one

of the dragger orientation options based on 3D scene objects.

Move to Point. The length of the dragger will be determined by the length of its projection, which, in

turn, is given by the selected point. After choosing the considered option in the context menu, it is

necessary to indicate the 3D node or vertex in the 3D scene.

Move to Surface. The length of the manipulator will be determined by the point of its intersection

with the selected surface. After selecting the considered option in the context menu, it is necessary to

indicate a face, surface or workplane in the 3D scene.

Rotate Parallel to Direction. The direction of the dragger will be parallel to the selected direction. The

direction can be specified by an edge or a normal to the plane. After selecting the considered option

in the context menu, it is necessary to specify an edge, face, surface or workplane in the 3D scene. 

Rotate Parallel to Plane. The direction of the dragger will be parallel to the selected plane. After

selecting the considered option in the context menu, it is necessary to indicate a face, surface or

workplane in the 3D scene.

Preview

The preview schematically shows the shape and dimensions of the created operation, dynamically

changing when the command parameters are changed. With invalid parameter values, the operation

preview is missing. In such cases, it is necessary to override the operation parameters. If there is no

preview after setting the parameters in the 3D scene, it means that the parameters were set in such a

way that the system could not find a solution. In this case, the only way is to recreate the operation.

Common Parameters of Sheet Metal Commands

All sheet metal operations have a group of common parameters. You can set default values for some

of these parameters. 

The main operation of working with sheet metal is bending. Many operations create geometry, which

is the result of several bends in different ways or operations close to bending, but having their own

characteristics. Accordingly, the dialogs of commands for working with sheet metal contain bending

parameters that are the same for many operations. 

Some parameters are not available to the user in a single operation, which is explained by the logic of

constructing the geometry and the capabilities of the command as an analog of a real technological

operation.

· Radius

· Angle

· K-Factor

· Bend baseline

· Position

· Left Offset and Right Offset



T-FLEX CAD 17 Help

1980

· Length Reference

· Length

· Offset

· Bend Relief

· Gap type

· Gap

· Flange

· Corner Relief

· Options

· Operands

Radius

The parameter sets the value of the bend radius. The parameter has a custom default value. The

parameter has a manipulator in the 3D scene.

If you use a profile that sets the section of the sheet, the radius value will specify the fillet at the non-

rounded corners of the profile.

Angle 

The parameter sets the value of the bend angle, which determines the slope of the wall of the sheet

metal part. The parameter does not have a custom default value. For most of the operations, the

default value of the parameter is 90°. The Toggle bend direction  option allows inverting the

value. The parameter has a manipulator in the 3D scene. 

K-Factor

The parameter allows specifying the neutral layer coefficient. The parameter controls neutral factor

definition upon part bending and unbending. The parameter is required for all operations that have

an unfolding. The neutral layer of a workpiece is its longitudinal section, whose geometry does not

change during bending.

1 - Workpiece; 2 - Workpiece thickness; 3 - Neutral layer; 4 - Bend radius; 5 - Bend angle; 6 - Bent

workpiece

The neutral layer coefficient value can either be entered by the user or defined by the system

automatically, based on the table of The way of setting is determined by the drop-down list. To

automatically determine the neutral layer coefficient, select the option From Table. Another option

will allow you to set an arbitrary numeric value between 0 and 1. The value “0” means the neutral layer

coincides with the workpiece face selected for bending, while “1” sets the neutral layer on the

opposite face of the workpiece.
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The Neutral factor dependency table is stored with the model document. You can view and change

the table in the default parameters dialog for sheet metal.

Bend baseline

A baseline can be defined by two 3D points or a 3D object capable of determining a straight line. The

baseline serves several purposes:  it allows the system to define the body being deformed and the

base face of bending, determines the position and size of the bend area, determines the possibility of

creating one or another type of bending.

The baseline must lie in the plane of one of the workpiece faces being bent (normally, the top or

bottom face). The baseline does not have to fully fit within the boundaries of a base face; however, at

least some its portion must belong to the face.

Defining the baseline with an

open 3D profile (1)

Defining the baseline with the

edge of the workpiece (1)

Baseline Defining using two 3D

nodes

The face to which the baseline belongs is the base face of bending. The base face is used as the base

reference when defining bending parameters. 

1 - fixed part, 2 - bend line, 3 - bent part, 4 - rotatable part

The boundary between the fixed part of the workpiece and the bend zone will be called the bend line. 

Position

Position parameter defines the method of positioning a flange in relation to a baseline. Following

methods are available:

Icon Method name
Method applied to different angles

0°-90° 90° 90°-180°
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Bend Start

Bend End

Bend Center

By Outer Side

By Outer

Tangent

By Inner Side
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By Inner

Tangent

By External

Dimension

Since the position of the baseline at the bend start is the most common, in the future, this

option will be used to describe the possibilities of bending operations.

Left Offset and Right Offset

The length of the bend line can be adjusted by Offsets from the ends of the baseline. Offsets are

specified in the corresponding section of the properties window. Or they may be specified in the 3D

scene using manipulators. A special flag on the right allows you to offset symmetrically.

Offsets are used when the selected baseline accurately determines the desired bend position, but its

length exceeds the length of the workpiece section that needs to be bent.

Workpiece with 3D Profile Bend without offsets Bend with offsets

In some cases, the use of offsets allows creating a bend even if the original baseline was incorrect. This

could be, for instance, the situation, when the baseline for the bend does not fully fit in the face of the

workpiece. Without using offsets, bending cannot be created in this case. By offsetting from the line

end, one can reduce the length of the bend line in such a way, that the bend area fully fits in the

bending base face.
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Workpiece with a profile that

extends beyond the edge

Bending is built due to

offset

Length Reference

Length Reference parameter defines the method of applying the Length. Following methods are

available:

Icon Method name
Method applied to different angles

0°-90° 90° 90°-180°

Neutral Layer

Flat Part

Outer Side

Outer Tangent
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Inner Side

Inner Tangent

Length

The parameter determines the length of a flange. Method of appliying this length depends on the

Length Reference parameter. The parameter has a manipulator in the 3D scene.

Offset

The parameter allows shifting the bend area and, therefore, the bend line off the baseline. The

parameter has a manipulator in the 3D scene.

Depending on the sign of the offset, the bend zone moves in one direction or another from the initial

position: with a positive offset - to the bent/glued part, with a negative offset - from it.

Bend without displacement, 1 - bend line, is

set by two 3D nodes

Bend with offset, 1 - bend line, 2 -  baseline defined by

two 3D nodes, 3 - offset
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The baselines for flange gluing and flange

bending (1) match

Offset flange, baselines for gluing flange (1) and bending

(2) do not match

Shifting the bend line often helps in the cases, when the user is not satisfied with the location of

the bend area, or when bending creation is impossible in the current location.

Bend Relief

A group of parameters by which special grooves can be defined to reduce stresses in the metal,

concentrated at the bending angles.

Bending operations allow you to create a Bend Relief automatically when performing certain

operations. Reliefs are divided into Corner and Isolating. Isolating relief allows you to remove stress

in the bendable flange. Corner relief allows you to remove stress at the joint of the flanges and walls.

Corner reliefs can be specified with a separate Corner command.

1 - Corner relief; 2 - Isolating relief

The Isolating type has two variations, selected from the list: Round and Linear. The Extend Relief

option is available for each of the variants. 

No reliefs

Isolating relief
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Round reliefs Square reliefs Square reliefs through

Depth and Width parameters are available to determine the geometry of the isolating reliefs. For a

square relief, those define the width of the groove and the length of the groove part ahead of the

bend line, respectively. In the case of the round relief, the length of the head portion of the slot is

increased by the radius of the end fillet. The fillet radius is equal to half the groove width.

The rear part of a groove of any type can be arranged in one of two ways:

· to the depth equal to bend radius plus workpiece thickness;

· extended up to the borders of the workpiece (if the Extend Relief option is enabled) or to the

end of the workpiece, if gluing a flange inside the workpiece with material removal by the

flange length.

1 - bend line, S - workpiece thickness, R - bend radius, D - width, H - depth

Linear Reliefs (Non-Through) Round Reliefs (Non-Through)

1 - bend line, S - workpiece thickness, R - bend radius, D - width, H - depth

Square Reliefs (through to edge) Round Reliefs (through to edge)

Corner reliefs have three choices from the list: Round, Square and Welding.
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Round Square Welded

The radius of the circular hole is equal to the radius specified in the parameters. The square hole is

constructed by three or more points of intersection of the given radius circle with the planes selected

for the operation. 

When welding type is selected an optimal joint is formed in the bend area. The joint can be used for

welding.

Gap type

The parameter sets the position of the adjacent sheet faces relative to each other. From the drop-

down list, you can choose one of three items: Without overlap, Overlap, Reverse Overlap. 

Without overlap Overlap Reverse overlap

Gap

The parameter allows you to manually set the distance between adjacent sheet faces. 
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Flange

The Flange parameter group allows you to set various cropping modes during bending. The need to

reduce the flange when bending and gluing the flange is indicated using the flag Flange cutting.

When the flag is enabled, this mode will be activated and the gap between the part and the flange on

the unfolding will be equal to the specified value, by default 0.05.  

Bending after unbending Correct re-bending (with a decrease of the "flange")

Removing material to the edge of the workpiece Removing material to the length of the "flange"

The Limit cut to flange length flag allows you to set the method for removing the workpiece material

under the flange for gluing the flange: when the flag is set (default state), the material will be

removed only by the length of the flange. When the flag is disabled the material will be removed to

the edge of the workpiece.

Corner Relief

When attaching a flange, intersections may occur between the flange and the workpiece. In such a

case, automatic trimming can be performed. Trimming is done in such a way to leave a diagonal gap

of the specified width in the intersecting area. To perform clipping, you need to specify the Clipping

option in the Type list and set the gap thickness with the Gap parameter. 

When the value is set to No Clipping, intersecting parts will not be clipped.
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Clipping is possible if the flange and the intersected part of the workpiece have the same thickness

and lie in one plane. Certain exceptions from these rules are allowed, such as tolerance on flange

thickness and bending angle when matching with the workpiece.

Original solid body Flange without clipping Flange without clipping

Options

Use manipulators. When the flag is enabled the control manipulators in the 3D scene are shown.

Show labels. When the flag is enabled the special markers informing about the current parameter

values are shown, which can also be used to change the value of the operation parameters.

Dynamic preview. The flag enables/disables the dynamic preview of the command.

Bend face completely. When the flag is set, the body will be completely bent along the selected line.

This parameter is important when performing operations on the sheet metal of certain geometry (for

example, when it is required to bend the sheet body with a cut along the specified line).

Check self-intersections. It allows you to monitor self-intersection of bent sheet faces. When the flag

is set, system will not create bend that intersects with the source body.

Extend Wall Only. The parameter allows you to limit the length of the "flange" at the bend point.

Flange without activated option

"Extend Wall Only"

Flange with activated option

"Extend Wall Only"

Operands

All manually defined elements used in sheet metal commands are displayed on the Operands tab in

the options window: vertices, edges, faces and operations. 
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The Delete  button located on the right side of the Operands tab allows you to exclude the

selected item from the operation. It is also possible to delete the bend edge from the list by selecting

it with a mouse click and pressing the Delete button on keyboard. In the working window the edge

selection can be canceled by clicking on it again with the . 

The Up  and Down  buttons, located to the right below the Delete button, are used to change

the order of the operation for the given elements. This feature is not required for all the commands

and elements.

Sheet Metal Default Parameters

Calling the command:

Icon Ribbon

Sheet Metal > Defaults

Keyboard Textual Menu

<SMP> Operation > Sheet Metal > Defaults

The command brings up the dialog box Sheet Metal Parameters. In the dialog fields, you can set

default parameter values for all sheet metal operations of the created part.
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Common Tab

Material thickness. 

Defines the thickness of the workpiece that is used by default upon the sheet workpiece creation

command.

Bend radius. 

Defines the default bend radius used in Bend command.

Part width. 

Sets default value for the part width.

Neutral factor (K-Factor). 

The parameter controls neutral factor definition for part bending and unbending. The parameter value

can either be entered by the user or defined by the system automatically, based on the table of

Neutral factors versus “bend radius/workpiece thickness” ratio. The Neutral factor dependency table is

stored with the model document. To view or edit the table, use the button . Upon pressing the

button, an additional window Neutral factors opens. This window displays the Neutral factor table of

the current document. It represents a tabulated dependency of Neutral factor (the column “Value”) on

the ratio “bend radius/workpiece thickness” (the column “Parameter”). The Interpolation flag sets the

type of table data interpolation: the set flag means linear interpolation – the Neutral factor linearly

interpolated between the tabulated data; the cleared flag means piecewise constant interpolation –

the Neutral factor is maintained constant until reaching the next entry.
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The current table can be exported into a textual file by pressing the button Save.

The Load button allows you to change the table by loading new data from the user-created text file

*.tnf of the following format: the first line in the file should specify the type of interpolation:

“Interpolation” - linear, “Table” - tabular. Other lines contain the table data – the “bend

radius/workpiece thickness” ratios and the respective Neutral factor values. Table data can be

recorded in various ways- in one row or in several, spaces or tabs can be used as delimiters. For

example, the default table is written as follows:

Interpolation
0.5   0.25
0.8   0.3
1     0.35
2     0.37
3     0.4
4     0.41
5     0.43
10    0.47
12    0.5

Once loaded from a file, the table is stored in the document of the current model and is further used

in model manipulations.

Minimum gap. 

The parameter defines the width of a cut when creating operations with sheet metal. Defines the

Reduce cutting option. More info available in the Common Parameters of Sheet Metal Commands

section.

Bend/unbend face completely. 

This parameter is important when performing operations on the sheet metal of certain geometry (for

example, when it is required to bend the sheet body with a cut along the specified line). When this

parameter is enabled, the entire body along the selected line will be bent without violating the

construction logic. The parameter defines the setting/removal of the default flag for the Bend face

completely option in the dialog for creating bending operations. 
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1 - Bend Line

Check self-intersections. 

This parameter is important when creating the Bend operation. It allows you to monitor self-

intersection of bent sheet faces. When the flag is set, the system will not create bend that intersects

with the source body. Defines the default setting/clearing of the flag for the Check self-interactions

option in bending operations.

Activate manipulator. 

If the flag is set for Flange, Hem, Jog operations, the mode of defining a length using manipulator is

activated automatically, after selecting an edge or profile.

Simplify geometry. 

The parameter removes the edges that are formed as a result of flanges, hems, bridge bends, and

other sheet metal operations construction.
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Bend Parameters Tab

 

Bend position. 

Allows you to set the position of the bend zone relative to the bending baseline: Bend Start, Bend

End, Bend Center, By Outer Side, By Outer Tangent, By Inner Side, By Inner Tangent, By External

Dimension. Defines the default option for the Position parameter in the bend command dialog. More

info available in the Common Parameters of Sheet Metal Commands section.

Length Reference. 

You can select one of the following methods in the drop-down list: Neutral Layer, Flat Part, Outer

Side, Outer Tangent, Inner Side, Inner Tangent. The parameter defines the default option for the

Length Reference parameter in the bend command dialog. More info available in the Common

Parameters of Sheet Metal Commands section.

This group of parameters defines the type and sizes of the reliefs created by default when bending.

The type of reliefs can be selected in the drop-down list: None (no relief is created), Round, Square. 

Depth and Width parameters allow you to set default sizes for reliefs: the depth of the front part

(protruding beyond the bend line) and the width of the groove. The flag Extend relief enables cutting

of the groove to the borders of the workpiece. More info available in the Common Parameters of

Sheet Metal Commands section.

Flange. 

This group of parameters allows you to set default values for various cutting modes during bending.

The need to cut the flange when bending and gluing the flange is indicated using the Flange cutting

flag. When the flag is enabled, this mode will be activated by default. The Limit cut to flange length

flag allows you to set the method for removing the workpiece material under the flange when gluing

the flange. When the flag is set, by default the material will be deleted only by the length of the
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flange. When the flag is disabled the material will be deleted to the edge of the workpiece. More info

available in the Common Parameters of Sheet Metal Commands section.

Corner Relief. 

This group of parameters allows you to enable by default cutting of intersecting parts of the flange

with the workpiece. Enable the Clipping option with the specified Gap parameter (defines the default

value of the Gap parameter in the bending command dialog). When set to No Clipping, overlapping

parts will not be clipped by default. More info available in the Common Parameters of Sheet Metal

Commands section.

Offsets 

This group of parameters defines the default values for Left and Right Offset. The position of the

indentation (left or right) is determined by the system depending on the position of the created

geometry. More info available in the Common Parameters of Sheet Metal Commands section.

Parameter values set in the Defaults command will be used by default in all sheet metal

operations. In this case, values of textual and numeric parameters taken from defaults are shown

in square brackets, for example, Radius: [2].

Creating Part

Calling the command:

Icon Ribbon

Sheet Metal > Create Part

Keyboard Textual Menu

<SMD> Operation > Sheet Metal > Create Part

The operation allows you to create a sheet workpiece in two ways.

· Sheet Bound

· Sheet Cross-section

Both methods use a flat 3D profile as the source.

By sheet shape
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By section of the sheet

All sheet metal operations are created on the basis of a previously created workpiece. The workpiece

can be a solid body or imported body of virtually any shape. A system requirement for defining

various sheet metal operations is the existence of two flat parallel faces in the area of deformation.

One of such faces will be used as the base when defining the desired type of a sheet metal operation.

We recommend using a flat body as the sheet metal workpiece, with the side (end) faces

perpendicular to main (top and bottom) faces. 

Use of this specialized operation instead of extrusion or other general-purpose operation simplifies

workpiece creation, minimizing the number of parameters and settings to define. 

From now on throughout this chapter, any body subjected to a sheet metal operation will be

referred to as "workpiece" regardless of the means of body creation.

Command Parameters

Command parameters related to general ones are described in the corresponding section above. 

Select the way of creation.

Sheet Bound

Sheet Cross-section

Thickness. Input field for sheet thickness in millimeters.

A variant of the direction of extrusion to a given thickness.

Positive Direction

Reverse Direction

Symmetric

Width. The parameter sets the width of the workpiece if created using the Sheet Cross-section option.

Automenu Options:
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<Ctrl+Enter

>
Finish input

<P> Set entity parameters

<X> Exit command

<F5> Preview Operation Result

<R> Select 3D Profile

<W> Draw Profile

Finish input. The option allows to build geometry by given parameters. If there are not enough

parameters, the option is inactive.

Set entity Parameters. Invokes the standard dialog of the parameters of the 3D modeling command.

Exit command. The option closes the command with the cancellation of the specified parameters.

Preview Operation Result. The option enables/disables the standard option to view 3D modeling

results.

Select 3D Profile. The option allows to select the profile according to which the workpiece will be

built. The option is mandatory to create a workpiece.

Draw Profile. The option allows to create a workpiece using profile. The option allows you to switch

to drawing mode on the selected work plane to create the original profile. In this case, when you exit

the drawing mode on the workplane, the created profile will be automatically selected.

Creating a Base Part

To create a workpiece, just specify the source 3D profile. When entering the operation, the 3D profile

selection mode is activated automatically. The type of the selected profile will determine the option

to create a workpiece. If the contour is closed, then the option of creating according to the shape of

the sheet will be automatically selected. If the contour is not closed, then the option for the sheet

cross-section will be selected. Indicate the necessary parameters and complete the entry.

Sheet Bound. The initial 3D profile defines the contour of the future workpiece body. We recommend

using a single-contour 3D profile. However, it is allowed to use a multi-contour profile, which meets

the following requirements: A 3D profile should consist of only one wraparound contour and the

nested contours should be the first level.                   

Single-contour 3D profile Single-contour 3D profile: 1 - contour of the 1st

level of nesting, 2 - wraparound contour

When you select this way of the sheet workpiece creation you should specify the width of the

workpiece and direction of the profile extrusion. The selected profile is extruded by normal to the
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specified thickness of the workpiece sheet. Extrusion is done in one of three ways: upward relative to

the plane of the source profile, downward relative to the plane of the profile or in both directions

symmetrically.

3D Profile Symmetrically Down Up

Sheet Cross-section. The 3D profile determines the sectional shape of the workpiece body. In this

case, only a flat single-contour 3D profile can be used. It can be closed (which will result in a “pipe”-

type workpiece), or open. If you select a closed profile, you should manually change the type of the

workpiece.

As in the previous case, extrusion by the sheet thickness can be done in three ways relative to the

surface resulting from the first extrusion. The edges of the resulting sheet body (the corners of the

workpiece cross-section) are automatically rounded. The width of the workpiece (extrusion value) is

determined by the Width parameter. 

1 - 3D Profile 2,3 - Extrusion to the given width and thickness

Workpiece extrusion directions Workpiece by the given section shape

Main Commands

T-FLEX CAD provides a wide range of commands for creating sheet metal.

Topics in this section:

· Flange Group (Bending Operation)

· Bridge Bend

· Jog

· Corner

· Lofted Bend

· Forming Tool

· Gusset

· Normal Cutout

· Convert Solid to Sheet Metal

· Unbending
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· Re-bend

Flange Group (Bending Operation)

The group combines bending operations. The bending operations are in a pop-up list in the Ribbon,

the main operation is Flange. All the operations have a common interface and the ability to switch

between operations in the parameters dialog.

Flange

Hem

Contour Flange 

Bend

Cut and Bend

The bending operations can be subdivided into shape-changing - Bend, Cut and Bend – and shape-

forming Flange, Hem, Contour Flange.

Depending on the given base bending line the system automatically selects a preliminary bending

type. The selecting criterion is the kind and way of setting the base line. E.g. if you choose a lateral

edge of a workpiece as the base bending line, the system will offer to create a flange. In case of open

profile inside the workpiece option folding will be selected. The result of the selection can be seen in

the command dialog in the parameter window.

You can change the variant offered by the system by choosing another variant from the list.

Topics in this section:

· Flange

· Hem

· Contour Flange

· Bend

· Cut and Bend

· Edit Bend
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Flange

To create a flange on sheet parts Flange operation is used:

Icon Ribbon

Sheet Metal > Flange

Keyboard Textual Menu

<SMA> Operation > Sheet Metal > Flange

The flange thickness coincides with the part thickness and the width is determined by the base line

(taking offsets into account). The flange displacement can be either outside or inside. You can set

reliefs at the flange corners in the command and set treatment parameters of the intercepting

flanges. 

Command parameters 

The command parameters are common for the sheet metal commands and are described in the

corresponding subsection above.

The command menu options:

<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<L> Select Line

<M> Add Edges

<E> Select first Vertex or 3D Node

<S> Select second Vertex or 3D Node

<R> Select Profile

<W> Draw Profile

<A> Cancel Selection

Finish input. To build geometry according to the given parameters. In case the parameters are

insufficient, the option in not available.

Set entity Parameters. Call a standard 3-D design command parameters dialog. 

Exit command. Shuts down the command cancelling the given parameters. 

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design

commands. 
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Select Line. The option to select a line determining the base bending line. 

Add Edges. The option to select an edge determining the base bending line. The option as active at

entering the command on default. 

Select first Vertex or 3D Node. The option to select the first point determining the base bending line. 

Select second Vertex or 3D Node. The option to select the second point determining the base

bending line. 

Select Profile. The option enables you to build a flange whose shape is determined by the profile. This

option is not to be mixed up with Contour Flange command where the profile sets the flange cross-

section. In this case the profile sets the flange shape in the plane. The profile is to be closed. 

Flange by user 3D profile

Draw Profile. The option enables you to switch over to drawing work plane mode to create a profile.

The system automatically activates drawing on the work plane which coincides with the face where the

rib for building the flange was selected. In this case the created profile will be selected automatically

on exiting from the drawing on the work plane mode and you don’t have to set it with Select Profile

option. The profile is to be closed.

Cancel Selection. Cancel all elements selected and clear the operand window.

Flange creation

A typical procedure for creating a flange.

· Select a rib determining the base bending line. 

· Select a counting variant.

· Set the position.

· Set the angle.

· Set the parameters of the command determining the flange shape or select a profile.

· Set the relief and displacement parameters if necessary.

· Set the corner treatment parameters if the flange has intersections with the workpiece.

· Set the overlapping variant if adjacent ribs are selected.

· In case the flange is impossible to build, finish entering. Otherwise change flange parameters.

When moving the flange or building the flange by the base line which is not at the marginal edge of

the workpiece, there are some peculiarities of setting command parameters.

At positive displacement there appears an additional flat part at the glued lug. The length of the part

is determined by the Offset parameter. At negative displacement (i.e. displacement inwards of the
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workpiece) both lines are moved – the gluing line and the bending one. See subsection Common

Parameters of Sheet Metal Commands for details on the Offset parameter and the Position parameter

associated with it.

Workpiece Flange without bending

line displacement

Flange with bending line

displacement outwards 

Flange with bending line

displacement inwards

In most cases the lug is glued at one of the side edges (it is realized by selecting the correspondent

workpiece edge as a base line at zero displacement relative to it). However, gluing can be done inside

the workpiece as well, e.g. when the negative displacement is set at gluing to the side edge. In this

case the workpiece material replaced by the glued lug is removed. The removed part width is

determined by perpendiculars to the base line running from its ends (taking indents into account),

similarly to bending. There are two variants of removing: either all the material to the end of the

workpiece is removed or the material at the glued lug length is removed only.

Workpiece Flange Material removal to the

end of the workpiece

Material removal at the

lug length

Hem

Hem operation is used for flanging:

Icon Ribbon

Sheet Metal > Hem

Keyboard Textual Menu

<SMH> Operation > Sheet Metal > Hem

The operation enables users to “glue” a flange of the selected type to the outline of the workpiece.

For flanging you should select several workpiece edges belonging to one face. Flanging can build a

closed loop. 

There are 6 types of flanging available:
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Rolled Opened

Teardrop Closed

Double S-shaped

Command parameters

Command parameters are general for sheet metal commands and are described in the corresponding

subsection above.

The command automenu options are:

<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<M> Add Edges

<A> Cancel Selection

Finish input. Builds a geometry according to the given parameters. In case there are not enough

parameters set, the option is not available.

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters.

Exit command. Shuts down the command with cancelling all the set parameters.

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review.

Add Edges. Selects the edge determining the base bending line. The option is active by default on

entering the command.



Sheet Metal

2005

Cancel Selection. Cancels all the elements selected and clears the operand window.

Flanging creation

A typical procedure when creating flanging is:

· To select the edge determining the base bending line;

· To select the count variant;

· To set the location;

· To choose the flanging variant from the list;

· To set the command parameters determining the flanging shape;

· To set the relief and displacement parameters if necessary;

· To set the angle machining parameters is the flanging has intersections with the workpiece;

· To set the gap value if the flanging is given for adjacent edges.

· In case it is possible to build such a flanging – finish entering. Otherwise change the

parameters.

Contour Flange

To create a flange along a contour the Contour flange operation is used for sheet bodies.

Icon Ribbon

Sheet Metal > Contour Flange

Keyboard Textual Menu

<SMI> Operation > Sheet Metal > Contour Flange

The operation enables users to “glue” a flange whose cross section shape is determined by the

generatrix to the sheet body. The result of this operation is added to the edges of the base sheet

body.

1 - Generatrix

A 3D profile, a trace or a 3D path should be chosen as an outline defining the future geometry of the

flange. The generatrix cannot be closed. All of its points are to lie in one plane. The generatrix can be

set by straight lines or circular arcs.
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The operation requires selecting the generatrix and the edge along which the contour flange will be

built. If the generatrix start does not touch the edge, it is necessary to set an adjoining point and the

direction of the generatrix.

Flanges can form a closed loop. Weakening conditions and gaps at the joins of the flanges for all the

body can be set.

1 – Generatrix

Command parameters

Command parameters are general for sheet metal commands and are described in the corresponding

subsection above. There are some minor differences in Angle and Length Reference parameters.

· Angle 

The parameter determines the outline turning in the plane perpendicular to the edge around

the adjoining point. The parameter can be set by means of a manipulator or by a numerical

value.

The angle from the outline The angle is set manually

· Length Reference 

This parameter is inactive. The system only determines the push-out direction for the material

thickness. If the edge determining the outline position at the workpiece is the upper edge of

the workpiece, push-out is realized downwards. Vice versa, if the selected edge is the bottom

edge of the workpiece, push-out is directed upwards. 

Command automenu options are:

<Ctrl+Enter> Finish input
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<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<W> Draw Profile

<F> Select Flange Guide

<M> Add Edges

<V> Select Adjacent Point

<O> Select Profile Direction

<A> Cancel Selection

Finish input. Builds a geometry according to the given parameters. In case there are not enough

parameters set, the option is not available.

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters.

Exit command. Shuts down the command with cancelling all the set parameters.

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review.

Draw Profile. Builds a contour flange in transparent mode. Enables users to switch to drawing at the

selected work plane mode to create a profile determining the flange section. In this case when exiting

the drawing at the selected work plane mode the profile created will be selected automatically. The

profile should not be closed.

Select Flange Guide. Selects the 3D profile, trace or 3D path determining the flange section. The

selected element should not be closed.

Add Edges. Selects the edges determining the contour position relative to the workpiece.

Select Adjacent Point. Selects a point at the profile which coincides with the edge: you should choose

one of the end points of an unclosed contour.

Select Profile Direction. The option determines one of the two possible profile positions.

Variant 1 Variant 2

The direction can be set by any vector (defined by the edge, face or plane) having a meaningful

component when projecting onto the plane where the profile lies. The direction of this component

determines the profile direction.
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Cancel Selection. Cancels all the elements selected and clears the operand window.

Building a contour flange

To build a contour flange it is necessary to follow the procedure:

· To select a generatrix – a 3D profile, a trace or a 3D path with the help of Select Flange Guide

 option. If the profile is not built, it can be built in the transparent mode, choosing the

Draw Profile  option.

· To select the edges involved in the operation with Add Edges  option. Normal to the

plane where the generatrix lies either coincides with the edge or touches it in case the edge is

curvilinear.

If the end point of the selected contour is at one of the selected edges, the contour flange is built

right after the generatrix is selected. If necessary, you can change the contour direction with the option

described below. If the end point of the contour does not belong the generatrix, set an adjoining

point and the direction.

· To select a point at the contour, which coincides with the edge in the Select Adjacent Point

 option: one of the two end points of the unclosed contour.
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· To choose one of the two possible variants of contour direction with the help of Select Profile

Direction  option.

· To set relief and angle machining parameters.

· To finish entering.

Bend

To create bending at sheet bodies Bend operation is used:

Icon Ribbon

Sheet Metal > Bend

Keyboard Textual Menu

<SMB> Operation > Sheet Metal > Bend

When bending the initial workpiece is bent along the base line only, without cutting or removing any

of its parts. In this type of folding the bending line is formed by extending the base line set as a

segment sideways to crossing the base face side edges. There are two variants possible to extend the

base line.

Workpiece Not to fold all the face To fold all the face

When creating a bending it is impossible to set indents from the base line ends.
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Command parameters

Command parameters are general for sheet metal commands and are described in the corresponding

subsection above.

The command automenu options are:

<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<L> Select Line

<W> Draw Profile

<E> Select first Vertex or 3D Node

<S> Select second Vertex or 3D Node

<A> Cancel Selection

<D> Change the part to be bend

Finish input. Builds a geometry according to the given parameters. In case there are not enough

parameters set, the option is not available.

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters.

Exit command. Shuts down the command with cancelling all the set parameters.

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review.

Select Line. Selects a line determining the base bending line. The line can be set basing on the path,

profile or the trace.

Draw Profile. Sets the base bending line in transparent mode. When choosing the option you should

set the workpiece face (the system automatically switches to drawing at the selected work plane

mode), after which you should create the profile outline at the selected face. The outline should be a

segment. When exiting the drawing at the selected work plane mode the profile created will be

selected automatically. 

Select first Vertex or 3D Node. Chooses the first point determining the base bending line.

Select second Vertex or 3D Node. Chooses the second point determining the base bending line.

Cancel Selection. Cancels all the elements selected and clears the operand window.

Change the part to be bend. When folding one part of the workpiece remains stationary and the

second one moves in space according to the set folding parameters. This option enables users to

swap the moving and the stationary parts of the workpiece.

Creating the bend

A typical procedure when creating a bend is:

· To create the base line

· To select whether to bend all the face or at the extension to the nearest edges

· To change the bent part if necessary
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· To set the available standard bending operations parameters

· Finish entering.

Cut and Bend

To create bending at sheet bodies Cut and Bend operation is used:

Icon Ribbon

Sheet Metal > Cut and Bend

Keyboard Textual Menu

<SME> Operation > Sheet Metal > Cut and Bend

Only a certain part of the workpiece is folded when bending.

In this type of folding the base line should be a segment lying entirely within the base face

limits. You can also set the base line by one of the side edges of the workpiece but in this case it

is necessary to set the bending line displacement.

3D profile workpiece Result of bending

A special kind of bending is bending by 3D profile. An unclosed 3D profile built at the workpiece face

is used as a template for the bent lug. The base line is set by finite profile points.

3D profile workpiece Bending by 3D profile

When bending by profile the base line always sets the start of bending area. In this case it is

impossible to set bending line displacement and indents from base line edges.
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Command parameters

Command parameters are general for sheet metal commands and are described in the corresponding

subsection above.

The command automenu options are:

<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<L> Select Line

<E> Select first Vertex or 3D Node

<S> Select second Vertex or 3D Node

<W> Draw Profile

<R> Select profile to bend

<A> Cancel Selection

<D> Change the part to be bend

Finish input. Builds a geometry according to the given parameters. In case there are not enough

parameters set, the option is not available.

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters.

Exit command. Shuts down the command with cancelling all the set parameters.

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review.

Select Line. Selects a straight line determining the base bending line. The line can be set basing on the

path, profile or the trace. The line should be a segment lying entirely within the face limits.

Select first Vertex or 3D Node. Chooses the first point determining the base bending line.

Select second Vertex or 3D Node. Chooses the second point determining the base bending line.

Draw Profile. Sets the base bending line or a profile in transparent mode. When choosing the option

you should set the workpiece face (the system automatically switches to drawing at the selected work

plane mode), after which you should create the profile outline at the selected face. The outline should

be a segment lying within the workpiece face or an unclosed succession of lines also lying within the

workpiece face. When exiting the drawing at the selected work plane mode the profile created will be

selected automatically. 

Cancel Selection. Cancels all the elements selected and clears the operand window.

Change the part to be bend. If the bending line is a straight line, there are two variants of bending,

from two different sides. This option enables users to swap the bending side. In case of bending by

profile the option is not available.

Creating the bend

A typical procedure when creating a bend is:
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· To select an unclosed profile or a straight line lying within the workpiece face.

· To set general bending operations parameters.

· To change the bent part in case of a straight bending line if necessary.

· Finish entering.

Edit Bend

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3SM> Edit > Operation > Sheet Metal > Bend

This command is used for editing Bend.

Available option:

<A> Select All Elements

<R> Select an item by name

<I> Select another nearest item 

<P> Set Bend parameters.

<F4> Edit the element

<R> Change Definition

<Del> Delete an element (a group of elements).   

<Esc>  Exit the command.

<M> Conversion (calling the Transformation elements command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting).

If you select multiple items, you can delete them. Note that the <Shift>  combination can be used

for multiple selection (the <Ctrl>  combination cancels the selection).
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Bridge Bend

To build a bridge between two sheet parts Bridge Bend operation is used:

Icon Ribbon

Sheet Metal > Bridge Bend

Keyboard Textual Menu

<SM2> Operation > Sheet Metal > Bridge Bend

The operation enables users to create transition geometry with the given folding radius between the

edges of the two sheet bodies of equal thickness, combining these bodies into one.

There are two variants of a bridge realized.

Z/U From

Folded

There are three ways to build a bridge.

By both edges

By start edges

By end edges

Transition variants of U-shape.
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1 – initial edge, 2 – final edge U-shape, 2 folds U-shape, 1 fold

Creating a transition of Z-shape.

1 – initial edge, 2 – final edge Z-shape

In case of two sheet bodies intersecting it is possible to build a U-shape transition with one fold

between them.

1 – initial edge, 2 – final edge U-shape, 1 fold

If two sheet bodies are inclined towards each other (the edges for building the bridge are still

parallel), there are two types of a U-shape transition with one fold possible.
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1 – initial edge, 2 – final edge By displacement By radius

Conditions of building a bridge

Several conditions are to be followed when building a bridge between two sheet bodies.

· Sheet bodies must be of equal thickness.

· Only straight edges can be used for building the bridge.

· The initial and the final edges must belong to different sheet bodies.

· The initial and the final edges must be parallel.

Command parameters

Z/U From. The bridge will have two bending radii at each of the selected edges.

Folded. The bridge will have one bending radius which is equal to half the distance between inner

edges of the parts being connected.

By both edges. The bridge shape will depend on both edges. The bridge symmetry axis will be

determined by central points of the selected edges.

By start edges. The bridge shape will be determined by the first of the selected edges. The bridge

symmetry axis will run through the center of the first edge and will be perpendicular to the first edge.

By end edges. The bridge shape will be determined by the second of the selected edges. The bridge

symmetry axis will run through the center of the second edge and will be perpendicular to the second

edge.

Other command parameters are general for sheet metal commands and are described in the

corresponding subsection above.

The command automenu options are:

<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<F> Select start edge

<S> Select end edge

Finish input. Builds a geometry according to the given parameters. In case there are not enough

parameters set, the option is not available.

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters.

Exit command. Shuts down the command with cancelling all the set parameters.
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Preview Operation Result. Enables/disables the standard option of 3D modeling commands review.

Select start edge. Selects the edge at the first body. 

Select end edge. Selects the edge at the second body.

Bridge building

A typical procedure when building the bridge is:

· Choose the bridge variant: Z/U From, Folded.

· Select the edge at the first body.

· Select the edge at the second body.

· Choose the building variant: By both edges, By start edges, By end edges.

· Set general sheet material parameters.

· Finish entering.

Jog

To build a jog at sheet bodies Jog operation is used:

Icon Ribbon

Sheet Metal > Jog

Keyboard Textual Menu

<SMJ> Operation > Sheet Metal > Jog

The operation enables users to create a double fold at a sheet body at a random angle. Jogs can be

helpful when it is necessary to build overlapping flanges, increase sheet part structure rigidity or

provide a gap between two flanges.

The length and position of the flange built at the second fold is determined by the initial face: the

flange is parallel to the initial face and its length corresponds to the projection onto the initial face.

Command parameters

Command parameters are general for sheet metal commands and are described in the corresponding

subsection above.

The command automenu options are:

<Ctrl+Enter> Finish input

<P> Set entity Parameters
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<X> Exit command

<F5> Preview Operation Result

<L> Select Line

<E> Select first Vertex or 3D Node

<S> Select second Vertex or 3D Node

<W> Draw Profile

<D> Reverse side

<F> Select Face

Finish input. Builds a geometry according to the given parameters. In case there are not enough

parameters set, the option is not available.

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters.

Exit command. Shuts down the command with cancelling all the set parameters.

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review.

Select Line. Selects a straight line determining the base bending line of the first fold. The line can be

set basing on the path, profile or the trace. The line should be a segment lying entirely within the face

limits (or the segment projection onto the face should lie within the face – in case the segment does

not belong the face).

Select first Vertex or 3D Node. Chooses the first point determining the base bending line.

Select second Vertex or 3D Node. Chooses the second point determining the base bending line.

Draw Profile. Sets the base bending line of the first fold in transparent mode. When choosing the

option you should set the workpiece face (the system automatically switches to drawing at the

selected work plane mode), after which you should create a segment at the selected face. The

segment should connect opposite face edges or lie within the workpiece face. When exiting the

drawing at the selected work plane mode the profile created will be selected automatically. 

Reverse side. Jog creates two parallel faces, one of which coincides with the initial one staying

stationary by default. This option swaps the stationary and moving faces.

Select Face. Selects the face which the operation is applied to. By default the nearest one to the set

bending line is selected.

You can toggle bend direction with following button:
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Creating a jog

A typical procedure when creating a jog is:

· To select a rectilinear profile lying within the workpiece face or connecting opposite

workpiece face edges.

· Set general bending operations parameters: Height (Length in other operations), Angle etc.

· Finish entering.

Corner

There is a special operation Corner for setting corner parameters at sheet bodies:

Icon Ribbon

Sheet Metal > Corner

Keyboard Textual Menu

<SMC> Operation > Sheet Metal > Corner

The operation enables users to create relief at untreated corners of sheet parts and create

overlapping.
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The operation requires selecting an adjacent folds intersection vertex. When choosing the vertex

special markers appear.

· Overlapping marker, consisting of two parts: an icon of selecting the overlapping type and an

icon of gap value. The overlapping types are switched successively by pressing  on the

overlapping icon.

Overlap Without

overlap

Reverse overlap

When pressing  on the gap value icon there appears an entry field. 

· Corner relief marker, representing an icon depicting relief type. 

 - Round

 - Square

 - Welding

 - No

Weakening types are switched successively by pressing  on the icon.

Overlapping type, gap value and relief type can be set in the operation dialog.

Command parameters

Following common parameters are available for the command:

· Bend Relief (corner). With choosing between four variants from the list: Round, Square,

Welding and No (if no relief is required). 

· Gap type. With choosing between three variants from the list: Without overlap, Overlap and

Reverse overlap.

· Gap. 

When choosing Corner command corner treatment is done automatically.
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Command automenu options are:

<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<V> Select Vertex

<A> Select Bend

<C> Select Boundary Faces

Finish input. Builds a geometry according to the given parameters. In case there are not enough

parameters set, the option is not available.

Set entity Parameters. Calls a standard dialog of 3D modeling command parameters.

Exit command. Shuts down the command with cancelling all the set parameters.

Preview Operation Result. Enables/disables the standard option of 3D modeling commands review.

Select Vertex. Enables users to choose the corner to be edited. The option is active at calling the

command. It is necessary to select the adjacent elements folds intersection vertex. 

Select Bend. Alternative option of selecting the corner. Requires selecting adjacent elements folds.

Corner creation

A typical procedure when creating a corner is:

· To select a folds intersection vertex.

· To set general corner treatment parameters: Bend Relief, Gap type, Gap.

· Finish entering.
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Lofted Bend

Lofted Bend operation is used to build bending by sections:

Icon Ribbon

Sheet Metal > Lofted Bend

Keyboard Textual Menu

<SML> Operation > Sheet Metal > Lofted Bend

Lofted Bend operation is intended for modeling complex sheet bodies basing on two sections.

To build a sheet body you need to select two sections lying in two planes that can be either

parallel or not. The sections can consist of smoothly joined arcs or straight lines.

The number of arcs and straight lines in two sections is not necessarily the same. When building

the bend arcs will connect to arcs and straight lines – with straight lines, and cylindrical bend

segments will be formed.

The body obtained as a result of this operation can be unbent with the help of Unbend operation.
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Command parameters

General parameters section.

Faceted approximation. The option enables users to build a surface consisting of planes set by three

or four points. The surface obtained can be subsequently transformed into sheet metal, setting

appropriate bending radii and weakening for the edges.

Unfolding approximation. The option enables users to build a body by the surface which can be

unfolded.

Thickness. This parameter is general for all the sheet metal commands. The parameter value sets

thickness of the sheet body being built. By default it is set in Defaults command.

The variant of push-out direction at the given thickness relative to the plane built by the two selected

sections has three variants similarly to Create Part operation.

Outside

Inside

Symmetric

Radius. This parameter is general for all the sheet metal commands. The parameter value sets radius

for all the bends of the body being built.

Additional settings section:

Accuracy. The less is the value, the higher is the accuracy of building the body. High accuracy

increases number of bends and requires more time for building the body.

Bends. The option enables users to manually set total number of bends taking into account the

nearest possible number.
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30 bends 60 bends

Gap. This option enables users to set the gap at the sheet part in case of using closed contours.

Simplify. Eliminates (processes) the faces whose size does not allow to correctly build a 3D model

from calculation.

Command automenu options are:

<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<U> Select first section

<V> Select second section

<1> Select starting point for the 1st section

<2> Select directions for the 1st section

<3> Select starting point for the 2nd section

<4> Select directions for the 2nd section

Finish input. To build geometry according to the given parameters. In case the parameters are

insufficient, the option in not available.

Set entity Parameters. Call a standard 3-D design command parameters dialog. 

Exit command. Shuts down the command cancelling the given parameters. 

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design

commands. 

Select starting point for the 1st section. In case of an unclosed section the point will be selected

automatically. With the help of this option you can set the point manually, e.g. when only a part of the

unclosed contour is used. In case of a closed contour the point is to be set obligatory. The point will

be selected at the contour under the cursor at pressing , according to possible bindings. You can

also pre-create a 3D node. The point will determine the plane position by which the cutting will be

performed. If only the first section point is given, the plane will be perpendicular to the contour.

Select directions for the 1st section. In case of an unclosed contour the option is not obligatory. In

case of a closed contour it is necessary to set the plane or face determining the directing vector. The

vector projection onto the tangent to the contour in the initial point will determine the points

counting direction.

Select starting point for the 2nd section. The option is similar to the first section initial point. The

option is not obligatory: the initial point of the second closed section will be selected automatically as

the intersection point of the section outline with the normal plane set by the first section initial point.

Initial points of the first and the second sections (in case they are closed) determine the cutting plane

where the gap is set.
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Select directions for the 2nd section. The option is not obligatory. The counting direction at the

second section is automatically set the same as at the first one. The operation principle is similar to

choosing the direction for the first section. The directions at the first and the second contours must be

the same.

Creating a bend by sections

Unclosed sections

A sheet body can be built of two unclosed sections.

To select the sections automenu options of selecting the sections  and  are used.

If necessary a sheet body can be built by a part of the contour only. You need to select a point 

and counting direction  for the first and the second contours. The contour counting directions

must be the same.

In the example in the picture a plane is chosen to determine the counting direction.
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Closed sections

A sheet body can be built by two closed sections.

You need to additionally set the initial point and counting direction at least for the first section.

The cutting plane can be set by selecting the initial point at the first section. Selecting the initial point

at the second section enables users to set the cutting plane incline manually.

A 3D node at the upper section and

counting direction are chosen

Two 3D nodes at the sections and

counting direction are chosen
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Forming Tool

To create sheet forming elements a Forming Tool command is used:

Icon Ribbon

Sheet Metal > Forming Tool

Keyboard Textual Menu

<SMF> Operation > Sheet Metal > Forming Tool

The operation enables users to create forming elements at sheet bodies. Forming elements from

standard or user libraries can be used.

Pimple type can be chosen from a drop-down list or by an icon showing the pimple type. If a pimple

type whose icon is absent is chosen from the list, the last right icon will be replaced with the icon of

the last chosen type.

Pimple types and their icons are given below.

Emboss

Flange

Flange non-closed

Emboss non-closed
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Louver

Choosing from the standard list:

Collar, V-shape, U-shape Groove, U-shape, V-shape

Cradle, Airway, Round fold Flanging, Stamping

There is a Select point in the drop-down list of choosing pimple type. It enables you to choose

elements from user libraries. The content of the list is connected with the type chosen in the Standard

field. The list changes if the standard is changed.

The following option is used for choosing the forming libraries:
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<B> Library Configuration

More information about forming features creation can be found in Forming Feature Creation

chapter.

A special library of typical stamping elements Sheet Metal Features supplied with the system is used for

creating elements. If necessary, the library can be completed with the elements of your own.

If inches are set as the units of length in Document Parameters command in 3D tab, then Sheet

Metal Features Inch library will be used when creating pimple.

Command parameters

Type. Enables users to choose pimple type from the list or by icon.

Standard. Enables users to choose standard from the list. It is metric by default.

The rest of the parameters depend on the pimple type chosen.

Parameter dialog for every element contains a sketch of the element being created with entry fields

for all the geometric dimensions.

Command automenu options are:

<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<B> Library Configuration

<R> Select 3D profile

<W> Draw Profile

Finish input. To build geometry according to the given parameters. In case the parameters are

insufficient, the option in not available.

Set entity Parameters. Call a standard 3-D design command parameters dialog. 
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Exit command. Shuts down the command cancelling the given parameters. 

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design

commands. 

Library Configuration. The option calls library selection dialog.

Select 3D profile. The option chooses a 3D profile which will be the base for operation creation. The

option is active by default.

Draw Profile. The option enables you to build a profile in the transparent mode. You should choose a

workpiece face and the system automatically switches over to drawing work plane mode. Then you

build an outline within the face. The created profile will be selected automatically on exiting from the

drawing on the work plane mode.

Creating a pimple element

To create a pimple element you should follow these typical steps:

· Select a 3D profile which will be the base for operation creation. Profile choosing mode

activates automatically at entering the command.

· Choose the pimple element needed from the ones given in the library from the command

parameters window (a parameter dialog for the element chosen will appear in the bottom

part of the window).

· Set the appropriate values of the parameters.

· Finish entering.

Topics in this section:

· Custom Elements For Sheet Metal and Holes Libraries

· Edit Forming Tools

Forming Feature Creation

Creating a Forming Tool operation is a specialized 3D fragment insertion team prepared for the

implementation of frequently used sheet stamping operations.

The system is supplied with a set of such workpieceses - libraries <Sheet Metal Features> and <Sheet

Metal Features Inch> (for working with inch units of length). This section describes the sequence of

actions to create a new element of these libraries.

The elements of the sheet forming tool library are 3D models built according to certain rules. The 3D

model of each element is based on a basic 3D profile. It is an "external parameter" of the forming

tool element, similar to the external geometric parameters of adaptive 3D fragments.

Sheet metal feature elements are applied to a part by using the command Forming Tool. At that time,

a 3D profile is selected on the part, that defines the desired shape of the sheet metal feature. That

profile is passed by the command into the 3D model of the sheet metal feature and is used to

substitute its base profile. The 3D model of the sheet metal feature element is recalculated according

to the new shape of the profile and is inserted in the part's 3D model.

Let's review the creation of a new element using the example of the Emboss element included in the

standard T-FLEX CAD distribution.

The diagram shows a draft of the elements being created. The inner and outer surfaces of the

prospective element are marked by different colors. The dimensions indicate the parameters whose

values can be defined by the user. Besides those, the user will be able to select the blending radius of

the corners of the original profile. The new sheet metal feature element shall be created as a 3D

fragment in the assembly context. Therefore, first you need to create an auxiliary file with the

"workpiece" part, to which the forming feature will be applied. This is exactly the document, in which

the 3D fragment-forming feature will be created in the assembly context.
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An auxiliary file is required only for the process of creating a new sheet metal feature element.

You can delete it once the library element creation is complete.

Creating Auxiliary Document

Let's create an auxiliary document to create a sheet metal feature element. Create a new 3D model.

In the created document, let's build the "workpiece" part for the forming feature (by any familiar

means). The workpiece should have a simple shape and as few edges and surfaces as possible. The

forming feature element file size will depend on how simple the workpiece is, and so will the time to

open and recalculate the element. Best of all is to make it round and flat. Let's create the 3D profile on

the top faces of the workpiece, that will be the base profile of the forming feature element. The

profile should also be made as simple as possible. In this example, let's create a triangular profile.

Save the file under the name Part for emboss. Now we can proceed with creation of the forming

feature element itself.

Creating the 3D Model of a Sheet Metal Forming Feature Element

1. Create a new 3D fragment by calling the command Create Fragment in Assembly and specify an

arbitrary name for the prospective element, for example, "Emboss new". After clicking ОК, the

assembly context mode activates automatically (the source body will become transparent).

Make sure that the associative snapping mode is On. To do this, click the right mouse button on an

empty space in the 3D window and select the context menu item Snap Modes.

2. In the variable editor, create required variables that will define the element parameters: "Depth",

"Angle", "Radius_side", "Radius_below", "Radius_above". All variables must be external.
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3. To correctly create the forming feature, you need to know the thickness of the source workpiece. To

have this thickness defined automatically, you can use the top and bottom faces of the workpiece. Call

the command Measure, select the option Measure relation between two elements. Specify the top

and bottom faces of the workpiece, and click .

In the list of relations, select the Distance, in the Variables tab, click Add Variable, enter the name of

the Thickness variable and click . Now a variable Thickness has been created, the value of which

is equal to the distance between the selected faces (the thickness of the workpiece).
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4. Extrude the triangular profile lying on the top face of the source body. When creating the extrusion,

the top face shall be selected for the direction; click the  button in the parameters window to

reverse the extrusion vector. The window of the extrusion parameters should look as shown in the

figure.
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The end blending shall be defined by the "Radius_below", the side edges blending – by the

"Radius_side" variable. When creating an ordinary model, it is possible to skip using Blend Parameters

for the extrusion and instead use common blend operations. However, in the present case that is not

an option, since the model must correctly recalculate with any admissible 3D profile. If, for example,

we would change the number of joint points of the top 3D profile in the "Part for emboss" file, then

the 3D model in the "Emboss new" file would still recalculate correctly. If using an ordinary blend, then

this may not work if it fails to account for the increased number of profile edges. 

The extrusion we have created ("Extrusion_1") will be used to obtain the inner surface of the forming

feature. 

5. To obtain the external surface, we will use the Offset Body operation.  Call the command, select the

Select Body option, and specify the extrusion created in the previous step.

Select the type - Outside, in the Offset field, enter the name of the variable "Thickness". The Keep

Source Body checkbox should also be enabled.
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The created body will be named "Offset Body_1".

6. By now we created the inner portion of the "Emboss new" prospective element – "Extrusion_1", its

outer portion – "Offset Body_1" and the source workpiece – "Reference to Extrusion_1 (from

assembly)". But "Offset Body_1" comes out above the source body. This outcoming portion needs to

be deleted.

1. Offset Body_1

2. Extrusion_1

3. Reference to Extrusion_1 (from assembly)

To cut the extra portion, we will use the Cut operation. Select the top face of the source workpiece

body as the cutting plane. The resulting body will be called "Cut operation_1".
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7. It is now possible to add together "Cut operation_3" and the source workpiece (the latter being no

longer needed) using the Boolean operation.

In the Boolean operation properties set the flags Blend New Edges and Chamfer. The Radius

parameter value shall be defined by the following expression: 

Radius_above-Thickness>=0? Radius_above-Thickness:0. 

When creating the Boolean operation, chamfers will be created on new edges. The chamfer offsets

shall be less than the "Radius_above" defined by the user, by the "Thickness" amount, and cannot be

less than zero. This requirement conditions the above-written expression.  

8. What is left now is to generate the inner surface of the "Emboss new" element. To do this, we shall

use a Boolean operation again. Subtract the remaining body from the body obtained in the previous

step. Just like in the previous step, the option of chamfer creation on new edges shall be enabled in

the Boolean operation properties. 

At this point, the new forming feature model element can be assumed completed. Next, right-click

 on an empty space in the 3D window and select the context menu item Save Fragment and

return. The "Emboss new" file, which contains the created 3D fragment, will become a new element in

the sheet metal features library. 

What to do with the obtained sheet metal forming feature element will be described a bit later. For

now, let's verify the function of the created forming feature element. Upon finishing working in the

assembly context, the "Part for emboss" file will open again. You do not have to save it – we shall not

need it anymore. But, before the file is closed, change the number of segments in the source profile on

the "workpiece" of the part – the forming feature shall adjust accordingly.
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Creating a Dialog for New Library Element

Besides the 3D model proper, a new sheet-metal library element requires creation of a dialog to input

parameters of the given forming feature element (which is the external fragment element

parameters). This dialog will be coming up in the command Forming Tool when inserting our forming

feature element.

To create the dialog, open the file "Emboss new". Add a new 2D page to it to hold control elements

(the Control command). On this page, position the elements of the Static Text type with the

appropriate parameter names and the value input fields (Edit Boxelements) for all external variables

of the created fragment using the Create Control command. As a result, you will get a simple dialog

that will serve to help the user defining parameters of the forming feature being created. If desired, a

more complex dialog can be created, by introducing in it a schematic image of the element as in

standard sheet metal library element dialogs.

The forming feature dialog is automatically scaled in the Forming Tool command property window so

as to have the font size in it matching the Windows font size. Therefore, when creating a dialog, we
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recommend you not to change the font size set by default for the dialog page (it is set to be close to

a standard Windows font). This will help avoid distortions when displaying the dialog. 

Besides that, do not create too wide dialogs that do not fit within the standard parameters window.

After creating the dialog, save the file again.

Defining Limitations on the Source 3D Profile Type

Limitations can be imposed on the type of a 3D profile that will be used for creating the new forming

feature element in the Forming Tool command. To impose limitations, you need to create two

external variables named contour_type and profile_type. The values assigned to those variables will

define the 3D profile types allowed for the given forming feature element:

profile_type: defines the geometrical

appearance of the 3D profile contour

contour_type: defines the nesting of the 3D profile

contour

0 - any 

1 - closed 

2 - open 

3 - line segment 

4 - from polylines

0 - any 

1 – simple only (no nested contours and no multiple

contours) 

2 - no nested contours

When these variables are created, then, upon an attempt to select a 3D profile of an inappropriate

type in the forming feature creation command, the system will output an appropriate warning in the

Diagnostics window. As a result, the profile will not get selected. On the other hand, if the variables

were not created in the forming feature fragment, then, when applying it, any 3D profile types will be

allowed for selection. The fact that an incorrect profile was selected will then only be hinted by the

errors occurring when recalculating such a forming feature.

In our example, the "profile_type" variable must be equal to 1, and the "contour_type" variable must

be equal 0.

Adding a Created Fragment to the Sheet Metal Features Library

To use a created element in the Forming Tool command, you need to copy the "Emboss new" file into

the folder "T-FLEX Parametric CAD xx\Libraries\System\Sheet Metal Features". After that, select the

Select option in the type drop-down list.
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Then select a file from the list.

After that, our feature tool will be displayed in the Type tab.
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Item name and icon

In the Forming Tool command, our new forming tool element will be indicated by its file name and

with the standard T-FLEX CAD document icon. If desired, you can set a different, more understandable

and complete name for it. To do this, you need to call the Document Properties command in the

element file (in our example, this is "Emboss new") and fill in the Name field on the Summary tab.

The icon can be replaced using the Icon command.

Edit Forming Tools

Calling the command:

Icon Ribbon

-

Keyboard Textual menu

<3SF> Edit > Operation > Sheet Metal > Forming Tools

This command is used for editing Forming Tools.

Available option:

<A> Select All Elements

<R> Select an item by name

<I> Select another nearest item 
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<P> Set Bend parameters.

<F4> Edit the element

<R> Change Definition

<Del> Delete an element (a group of elements).   

<Esc>  Exit the command.

<M> Conversion (calling the Transformation elements command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting).

If you select multiple items, you can delete them. Note that the <Shift>  combination can be used

for multiple selection (the <Ctrl>  combination cancels the selection).

Gusset

To build stiffening ribs at sheet bodies Gusset operation is used:

Icon Ribbon

Sheet Metal > Gusset

Keyboard Textual Menu

<SMG> Operation > Sheet Metal > Gusset

The operation enables users to build stiffening ribs (gussets) at a given pitch, of a given number, of

different types including ones made by user 3D profile. There are two variants of cross sections

available for the gussets and the bending angles can be also different.

Gusset positioning and their number are set according to the chosen construction variant which is set

by icons in operation parameters window.

By Point
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Fit

Fill

Step

Another set of icons determines the gusset cross-section shape.

Round

Square

Gusset shape from the side is linear by default but it can be set basing on the user profile with the

help of  option.

Gusset of a standard linear shape Gusset based on user profile

Command parameters

Number, Step and Offset. The parameters determine the position and number of gussets at the given

bend. Depending on the chosen construction variant these parameters can be available or closed.

· By Point. Number and Step parameters are closed for this construction variant. The gusset

position at the bend is determined by the Offset parameter with a dragger in the 3D scene.

The Offset parameter determines the distance from the chosen face to the center of the gusset

cross section. The face from which Offset parameter counting starts is determined

automatically by the system. To change the position counting face, use  option and

choose another face or a plane.

· Fit. In this construction variant only Number parameter is available. The number of gussets set

is uniformly distributed (the pitch is calculated automatically and is the same) along the bend.

· Fill. Only Step parameter is available in this variant. Number parameter is calculated basing

on maximum possible number of copies. Offset parameter is equal to the pitch. The distance
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to the center of the last gusset to the end of the bend depends on the pitch and number of

copies, so the displacement counting face swap option  influences the result. 

· Step. For this variant Number and Step parameters are available. Offset parameter is equal to

the pitch. Changing the face of the reference - affects the result.

Depth, Width, Taper Angle, Punch Radius and Die Radius determine gusset geometry. Depth

parameter is not available in case the gusset shape is set by user profile. Punch Radius parameter is

not available in case of using a cross section of a round shape.

Command automenu options are:

<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<A> Select Bend Face

<F> Select Gusset Shape

<Q> Select Plane

<W> Draw Profile

Finish input. To build geometry according to the given parameters. In case the parameters are

insufficient, the option in not available.

Set entity Parameters. Call a standard 3-D design command parameters dialog. 

Exit command. Shuts down the command canceling the given parameters. 

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design

commands. 

Select Bend Face. Choosing the bend (cylindrical face) between two surfaces where it is necessary to

build the gusset. The option is active by default.

Select Gusset Shape. The option determines the gusset shape from the side. Gusset shape can be set

by profile, path or trace. The element determining gusset shape must lie in the plane perpendicular to

the faces on which the gusset is built.

Select Plane. The option to choose the plane determining the origin. Either a face or a plane can be

chosen. Displacement determines the distance from the selected plane or face to the center of the

gusset cross section.

Draw Profile. The option enables you to build a profile in the transparent mode. 

Creating a gusset

A typical procedure for creating a gusset is:

· Choose a bend face

· Choose the gusset cross section variant

· Choose the gusset shape profile (in case when other than linear shape is required)

· Set geometric parameters of the gusset

· Choose the variant to enter gusset position and number 

· Change the origin plane (if necessary)
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· Enter the gusset position and number parameters

· Finish entering.

Normal Cutout

Normal Cutout operation is used for creating cutouts at sheet bodies.

Icon Ribbon

Sheet Metal > Normal Cutout > Gusset

Keyboard Textual Menu

<SMN> Operation > Sheet Metal > Normal Cutout

The operation enables users to build a cutout with a gap at a sheet body with the edges perpendicular

to the main faces. Multiloop 3D profiles are supported.

There are three variants to create a cutout available in the command, switching between them is

realized by icons.

Thickness

Mid Plane

Nearest

A list helps you to determine which of the faces is to have a cutout: the nearest one or all having

intersections in the given direction.

Command parameters

Type. Intersection of the projected profile onto a tilted sheet gives different results in terms of

dimensions and position of the cutout depending on the surface to be considered the one for the

profile to be projected onto. There are three variants for obtaining a cutout available:

· Thickness. Maximum cutout size.

· Mid Plane. According to the profile projection intersection with the middle surface of the

sheet workpiece.
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· Nearest. According to the profile projection intersection with the nearest surface of the sheet

workpiece.

By thickness By middle By nearest

Cutout. There are two variants:

· To Nearest. The cutout will be made in the given direction at the nearest to the profile surface

of the workpiece only.

· Through All. The cutout will be made at all the surfaces of the workpiece that the profile

projection intersects in the given direction.

Symmetric. Symmetric direction of the profile projection.

Gap. Sets the gap by equidistance from the cutout obtained.

Round Corners. Profile corners rounding.

The command menu options are:

<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<B> Select Body

<W> Draw Profile

<W> Select Contour

<D> Select Direction

Finish input. To build geometry according to the given parameters. In case the parameters are

insufficient, the option in not available.

Set entity Parameters. Call a standard 3-D design command parameters dialog. 

Exit command. Shuts down the command canceling the given parameters. 

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design

commands. 
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Select Body. In case there are several bodies at the 3D scene, use this option to select the body where

cutout will be made. The option is active by default in case there are several bodies at the 3D scene.

Draw Profile. The option enables you to build a profile in the transparent mode. You should choose a

workpiece face and the system automatically switches over to drawing work plane mode. Then you

build a closed outline within the face. The created profile will be selected automatically on exiting

from the drawing on the work plane mode.

Select Contour. The option chooses a profile to create a cutout. You should choose a profile

determining the cutout. The profile must be closed. The option is active by default in case there is only

one body at the 3D scene

Select Direction. The option selects the profile projection direction. The direction is determined by a

vector that can be set by a face or a plane (the plane sets a normal along which the projection

direction vector is oriented).

Creating a cutout by normal

A typical procedure when working with Normal Cutout command:

· Choose a sheet body if there are several bodies at the 3D scene.

· Choose the profile determining cutout shape.

· Set the profile projection direction.

· Choose the cutout calculation type.

· Set the gap and other parameters if necessary.

· Finish entering.

Convert Body to Sheet Metal

To convert a body into sheet metal Convert Body to Sheet Metal operation is used. To call the

operation:

Icon Ribbon

Sheet Metal > Convert Body to Sheet Metal

Keyboard Textual Menu

<SMS> Operation > Sheet Metal > Convert Body to Sheet Metal

Convert Body to Sheet Metal operation is used to quickly create sheet metal bodies or unfoldings

from other bodies (solid or surface). The result of Convert Body to Sheet Metal operation is sheet

body unfolding or a sheet part preserving the shape of the initial object.

1 – solid body, 2 – sheet part unfolding, 3 – sheet part
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Operation description

Bodies (solid or surface) with flat faces can be used as initial bodies for the operation.

Stationary face

Body unfolding takes place relative to the first face chosen which is considered fixed and determines

the unfolding plane position. This face is called stationary face.

Any flat face of the body can be chosen as stationary one. The edges for folding that will be involved

in the operation are set relative to it. Stationary face is highlighted blue after being selected.

Stationary face selection

Edges for folding

After the stationary face is selected it is time to select edges for folding. The first of the selected

edges must be one of the stationary face edges. After the edge is selected the second of the faces

building it gets involved in the operation. The moment it is done, you can select other edges of this

face as folding edges. Therefore to select a face you need to select at least one of adjoining edges.

Further on when building a sheet body a bend will be created at the selected edges, whose radius

value is specified in the operation parameters.

All the faces which the selected edges refer to are highlighted gray. The faces which are not involved

in the operation are highlighted yellow. 

Selected edges are highlighted blue Selected faces

When selecting the edges, you should make sure that there are no collisions between the sheet

elements obtained. This is because it is impossible to obtain a self-crossing flat template with the help

of this operation.
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Selected edges are shown in the  Bend Edges list on the Operands tab of the command's

parameters window. If you select an edge in this list, then the Common checkbox will appear near the

Radius input box in the General Parameters tab of the command's parameters window. By default,

this checkbox is enabled, which means that the value in the Radius input box is common for all edges.

If you disable the checkbox, then the value will be individual for the particular edge. 

Adding thickness

An equidistant surface at a given distance equal to the specified thickness is created for every selected

face. The new surface is built inwards, outwards or symmetrically depending on the variant chosen in

the parameters window.

Outside

Inside 

Symmetric

After finishing the operation all the selected faces are converted into sheet metal and the faces not

selected are deleted.
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Selected faces are gray, deleted ones are yellow

By default, all the faces highlighted yellow will be deleted when the operation works. If it is necessary

to delete a selected face, <D> Select removable faces option is used. The selected face is added into

Removed Faces tab of the Operands group in the parameters window and is marked red if selected in

the list. In order to cancel face selection for deleting, switch to Removed Faces tab of the Operands

group, select the face and press Delete. The button is to the right from the faces list.

Operation parameters

Thickness enables users to set thickness of the obtained sheet metal. Thickness direction can be

specified. The following modes are available: inwards, outwards, symmetrically.
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Inwards Symmetrically Outwards

Radius enables users to specify the rounding radius of sheet metal faces. It is general for all the

commands of sheet metal working.

Neutral factor determines the way to specify neutral layer coefficient. It is general for all the

commands of sheet metal working.

Radius, Neutral factor and Thickness are taken into account when calculating unfolding length by

bending radius arc.

Remove bend edges. An absolutely smooth sheet body is created in the places of bend. When the

option is active, Bend Result operation is not executed.

Keep source body. The initial body is added to the current operation result. The option is useful for

evaluating how the bended part is inscribed in the initial body dimensions.

Corner group combines general commands parameters of sheet metal working and are described

above.

The following automenu options are available:
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<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<K> Select fixed face

<R> Cancel Selection

<B> Select bend edges

<D> Select removable faces

<E> Edit rip edges

<2> Change relief type to square at selected vertex

<C> Bend result

Finish input. To build geometry according to the given parameters. In case the parameters are

insufficient, the option is not available.

Set entity Parameters. Calls a standard 3D design command parameters dialog. 

Exit command. Shuts down the command canceling the given parameters. 

Preview Operation Result. Enables/disables a standard option for reviewing 3-D design commands. 

Select fixed face. Selects the stationary face relative to which the operation proceeds.

Cancel Selection. Cancels selection of all the faces and edges involved in the operation. The option

returns to the operation start. It is necessary to select a stationary face and edges again. All the values

specified in General Parameters tab (thickness, radius etc.) stay the same.

Select bend edges. Selects the edges by which bending radius will be built. After activating it is

necessary to select the edges bordering with the faces involved in the operation starting with the

stationary face edges.

Select removable faces. Removes faces from the operation. After selecting the faces involved in the

operation you can activate this automenu option and specify the selected faces to be removed as the

result of the operation. The edges adjoining the removed faces become unavailable for selection.

Edit rip edges. Enables users to select the edges for changing the gap and overlap type separately.

You should choose an edge joining two faces involved in the operation. In the center of the selected

edge there will be a marker consisting of two fields: overlap type switch icon and gap input field icon.

Overlap types are switched in series by clicking  on the overlap icon.

Overlap No overlap Reverse overlap

When clicking  on gap icon an input field appears. 
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Change relief type to square at selected vertex. Sets weakening at the given vertex. Weakening type

can be changed to other than the default one at the selected vertex. By default all the vertices have

round weakening. Weakening type can be chosen from a drop-down option list before selecting the

vertex: Change relief type to square at selected vertex or Change relief type to welding at selected

vertex. 

After you choose the vertex a special marker appears near it. The type set for the vertex can be

changed by clicking  on the marker. 

Square Welded

To cancel the change of weakening at a vertex, select the vertex again. If there is no special marker of

weakening change at this vertex, a default weakening of Round type will be created.

Bend result. Enables/disables an additional command - Re-bend. If the option is enabled, the sheet

body preserves the initial object shape. If the option is disabled, the sheet body will be unbent and

unfolding will lie in the plane set by the stationary face.

Sheet part (Bend result enabled) Sheet part unfolding (Bend result disabled)

After finishing the operation with Bend result option enabled, another operation - Re-bend – will

appear in construction tree, in addition to unfolding.

In case of properties change in an operation which was already created, Bend result automenu button

becomes unavailable. The reason for that is to preserve the logic of operations sequence in case there

are other operations in 3D Model window after Unbend.

Creating the operation

A typical procedure for creating the operation is as follows:
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· To select a stationary face of the body

· To set sheet material thickness and rounding radius of the faces, otherwise they will be set

from parameters by default

· To select the edges involved in the operation

· To enable/disable the options: bend result, flat body, initial body (if necessary)

· To set additional operation capabilities: weakening type, overlap type, gap between adjoining

edges (if necessary)

· To finish input.

Example of operation work

Using Convert Body to Sheet Metal operation is demonstrated in the example. Besides, a case when it

is necessary to change bending procedure is considered.

Enter sheet metal parameters:

Icon Ribbon

Sheet Metal > Defaults

Keyboard Textual Menu

<SMP> Operation > Sheet Metal > Defaults

Remove the flags from Bend/Unbend face completely and Check self-interactions options. Now in

case of self-intersections of metal sheets the system can show the body obtained this way at the

screen. If you leave the flags, the system will not be able to show the self-intersecting body and will

display an error.

   

To create Convert Body to Sheet Metal operation, call the following command:

Icon Ribbon

Sheet Metal > Convert Body to Sheet Metal

Keyboard Textual Menu

<SMS> Operation > Sheet Metal > Convert Body to Sheet Metal

The selection sequence of construction elements to create the operation is shown in the picture below.

First, a stationary face is selected. Then three edges of the body are selected in turn. Before executing

the operation it was specified in the Corner tab in the parameters window that sheet edges must

overlap.
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Selecting stationary face Selecting first edge Selecting second edge

Selecting third edge Result Result

After the operation is executed, we obtain a solid body with two sheets with non-deformed corners

crossing a rounded face. This is because the body folding sequence was given incorrectly.

This is exactly one of the cases when it is helpful to change edges folding sequence. It helps to avoid

self-intersection of the bodies, at the same time you don’t have to re-set the edges manually. 

Operands tab shows edges selection sequence for the operation. Use arrows  and  to change

folding sequence.
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Move the last of the selected edges two lines higher, selecting the required edge and pressing up

arrow and repeat operation creation. Now the sheets adjoin each other smoothly and don’t intersect.

Unbending

Unbend command is used to unbend the folds:

Icon Ribbon

Sheet Metal > Unbend

Keyboard Textual Menu

<SMU> Operation > Sheet Metal > Unbend

The operation enables users to “unfold” the part and obtain a workpiece model for the designed

sheet part. It can be helpful for making a sheet part unfolding drawing. 
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The operation works not only with the bodies created in bending operations. “Unfolding” of imported

bodies, cylindrical faces obtained by turning or extrusion is also possible. Several folds can be unbent

at a time.

The folds to be unbent are chosen by selecting cylindrical faces. If you select a body and not separate

unbending faces, the system automatically finds all the surfaces available for unbending and creates

unfolding. If unbending variant offered by the system satisfies the user, the cylindrical faces to be

unbent can stay unselected.

At the same time with the fold chosen, the ones coaxial with it can be unbent. Coaxial are the folds

that meet the following conditions: they belong to one and the same body, have bending lines lying

on one straight line, have the same radius, angle and direction of bend (relative to the workpiece).

Coaxial bends: one bending line, the same radius, angle and direction of bend relative to the workpiece

Not coaxial bends: different bending direction relative to the workpiece

Not coaxial bends: different bending angles
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Not coaxial bends: different bending radii

Not coaxial bends: different bending lines

When unbending, the workpiece neutral layer coefficient is taken into account. If a part created

without using sheet metal operations is unbent, the neutral layer coefficient is determined by the user

in command parameters.

The part section that is to remain stationary when unbending is chosen automatically by the system. By

default such a face is highlighted yellow at the 3D scene. If necessary, the stationary face can be

selected manually, using an automenu option.

The unbending operation preserves all the topology obtained before, when creating the folds, i.e. the

number of faces and edges of the body before and after unbending stays the same. It enables users to

see bending areas at the flat unfolding and use them for example for future re-bending.

The operation enables users to unbend unclosed conical faces of a body.

Unbending cylindrical sheet bodies, truncated conical sheet bodies and random unfoldable surfaces is

also available.

Operation parameters

Unbend operation supports working with both the bodies created with the help of sheet metal

commands and the bodies created in other ways. Therefore, unlike other sheet metal commands, there

is a wider range of NF setting variants. 
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· Custom. It is entered by the user. In case of selecting the bodies created not with sheet metal

operations, it is the default variant.

· From Table. Substitution from the table according to unbent body thickness and selected

cylindrical face radius.

· From Sheet Metal Operations. The option is for the bodies obtained in sheet metal

operations for which Neutral factor is already set. In case of selecting the bodies created with

sheet metal operations, it is the default variant.

All the faces involved in unbending are unbent with the same coefficient.

Reverse direction. The option is available for unbending closed body faces. It enables users to change

unbending direction relative to the selected cutting plane.

Gap. The field is only active when unbending closed body faces. It enables users to set the gap by cut.

Unbend coaxial bends. It sets the forced unbending mode for the folds coaxial to the ones being

selected in addition to them. The flag is on by default. When removing the flag only selected folds are

unbent.

The command automenu options are:

<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<A> Select operation операции

<E> Select cylindrical bend face

<K> Select immovable unbending face

<A> Cancel selection

Finish input. To build geometry according to the given parameters. In case the parameters are

insufficient, the option in not available.

Set entity Parameters. Calls a standard 3-D design command parameters dialog. 

Exit command. Shuts down the command canceling the given parameters. 
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Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design

commands. 

Select operation. The option to select a body for the operation. It is active by default at calling the

command. When selecting a body, the system itself searches for all the faces available for unbending

and creates the body unfolding.

Select cylindrical bend face. Selects separate faces for unbending. You can choose cylindrical, conical

and closed faces as well as other faces with unfolding.

Select immovable unbending face. Enables you to choose the stationary face manually. It is necessary

when the stationary face selected automatically by the system does not satisfy the user.

Select node to define split surface. The option is only available when selecting a closed face. You

need to select a 3D node which defines the position of the plane along which the body with the

closed face will be cut.

Select unbending direction. The unbent face lies in the plane coinciding with the one tangent to the

face being unbent in the point determining the cutting plane. The option enables you to define one of

the two possible directions: to the right or to the left of the cutting plane. The direction vector

projection onto the tangent line determines unbending direction. The direction vector can be

specified by an edge or a plane (the plane determines the normal vector). You can also change

unbending direction by setting the flag on/off in Reverse direction option.

Cancel Selection. Cancels selection of all the elements and clears the operands window.

Creating the operation

A typical procedure for creating the operation is as follows

· To select a body. The system offers an unfolding variant.

· To set the Neutral factor.

· To change the stationary face if necessary.

· Finish input.

If the result offered by the system automatically doesn’t satisfy the user, select bending faces

manually.

· Select bending faces.

· Set the Neutral factor.

· Change the stationary face if necessary.

· Finish input.

If the surface is closed:

· Select bending face.

· Select the point determining the cutting plane position.

· Set the unbending direction if necessary.

· Set the Neutral factor and Gap.

· Finish input.

Edit Unbending

Calling the command:
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Icon Ribbon

-

Keyboard Textual Menu

<ESU> Edit > Operation > Sheet Metal > Unbend

The command is intended for editing the unfolding operation.

Available option:

<A> Select All Elements

<R> Select an item by name

<I> Select another nearest item 

<P> Set Bend parameters.

<F4> Edit the element

<R> Change Definition

<Del> Delete an element (a group of elements).   

<Esc>  Exit the command.

<M> Conversion (calling the Transformation elements command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting).

If you select multiple items, you can delete them. Note that the <Shift>  combination can be used

for multiple selection (the <Ctrl>  combination cancels the selection).

Re-bend

Re-bend command is used for re-bending of all the surfaces unbent by unbending operation:
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Icon Ribbon

Sheet Metal > Re-bend

Keyboard Textual Menu

<SMR> Operation > Sheet Metal > Re-bend

This capability is helpful for saving the image of the unfolding obtained with unbending operation in

the model structure. E.g. unbending and re-bending operations can be used to create a drawing

showing both unfolding and finished sheet part.

Neutral layer coefficient used in unbending is used in re-bending.

Operation parameters

Command automenu options are:

<Ctrl+Enter> Finish input

<P> Set entity Parameters

<X> Exit command

<F5> Preview Operation Result

<A> Select operation

<E> Select face to bending

<K> Select fixed face 

<A> Cancel selection

Finish input. To build geometry according to the given parameters. In case the parameters are

insufficient, the option in not available.

Set entity Parameters. Calls a standard 3-D design command parameters dialog. 

Exit command. Shuts down the command canceling the given parameters. 

Preview Operation Result. The option enables/disables a standard option for reviewing 3-D design

commands. 
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Select operation. The option to select a body for the operation. It is active by default at calling the

command. When selecting an unfolding body, the system automatically bends all the unbending

faces.

The stationary face is determined automatically by the system.

Select face to bending. Manual selection of bending faces when the result offered by the system

doesn’t satisfy the user.

Select fixed face. Manual selection of the stationary face when the result offered by the system doesn’t

satisfy the user. The option is only available at manual selection of bending faces.

Cancel selection. Cancels selection of all the elements and clears the operands window.

Creating the operation

A typical procedure for creating the operation is as follows:

· Select the unfolding body. The system automatically bends the unfolding to the initial body.

· Finish input.

If the result offered by the system doesn’t satisfy the user, choose bending faces manually.

· Choose bending faces.

· Change the stationary face if necessary.

· Finish input.

Edit Re-bend

Calling the command:

Icon Ribbon

-

Keyboard Textual Menu

<ESR> Edit > Operation > Sheet Metal > Re-Bend

The command is intended for editing the re-bending operation.

Available option:
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<A> Select All Elements

<R> Select an item by name

<I> Select another nearest item 

<P> Set Bend parameters.

<F4> Edit the element

<R> Change Definition

<Del> Delete an element (a group of elements).   

<Esc> Exit the command.

<M> Conversion (calling the Transformation elements command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting).

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Creating Drawings for Sheet Metal

In order to create a drawing of sheet metal part you can use same commands as for any other

drawings (see 2D Drawings of 3D Models and Drawing Creation chapters).

Additionally, there are special commands available in the Sheet Metal tab of the ribbon, when 2D

view window is active. These commands allow you to create unfolded view, bend table and bend

notes.
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Topics in this section:

· Unfolded View

· Bend Table

· Bend Note

Unfolded View

The command can be called in one the following ways:

Icon Ribbon

Draw > 2D Projection > Flat Pattern Projection

Sheet Metal > Draw > Flat Pattern Projection

Keyboard Textual Menu

<3PF> Operation > Sheet Metal > Flat Pattern Projection

The command creates an unfolded drawing view of a sheet metal part. The command is available in

the ribbon, when a 2D view window is active and when drawing on an active workplane.

If necessary, folded and unfolded views of the sheet part can be placed at the same drawing page.



Sheet Metal

2065

The interface of the Flat Pattern Projection command is similar to the interface of the Arbitrary View

command. However, unlike the latter, the flat pattern projection's view direction is defined

automatically in such way, so it is normal to the unfolding.

In addition to common projection controls, there are following checkboxes available in the Options

tab of the command's parameters window:

· Opposite Side Projection

Switches view direction to an opposite one.
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· One Side Projection

Projects only the set of faces (surfaces) visible from the view direction instead of the whole

solid body. It helps to avoid the occurrence of breaks and extra lines in some complex cases,

and speeds up the recalculation of the projection.

To display bending zones on the projection, it is necessary to disable the Simplify Geometry flag on

the Additional tab in the projection parameters and enable the Smooth edges flag on the Lines tab.

To display the bending centerlines, enable the Axial lines flag on the Lines tab.

Bend Table

The command can be called in one of the following ways:

Icon Ribbon

Sheet Metal > Create Bend Table

Keyboard Textual Menu

<SMO> Operation > Sheet Metal > Create Bend Table

Using this command, you can create a table in the drawing, which will contain data on the bends of all

the bodies present at the scene.
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Sheet part           Table of bends

The bend table is the special kind of report. The template of bend table is included into the T-FLEX

CAD installation package. You can edit the template if necessary.

The detailed information on working with report templates can be found in the Create Report

Templates chapter.

The report uses data from the special type of product composition, which is also called Bend table.

Such composition can be created in one of the following ways:

· using the  Product Composition window;

· using the Bend Table Data command;

· automatically upon calling the Bend Table or Bend Note commands.

The detailed information on working with product compositions can be found in the Product

Composition, Reports, Bill of Material chapter.

Upon calling the Bend Table command, the preview of bend table's area starts following the cursor.

Place it in a desired location and click . The automatically filed table will appear on a drawing. If

you need to update an already create table, use either the  Update report command, which is

available in table's contextual menu, or the  Full Regeneration command with the Reports/Bills of

Materials checkbox enabled. The table may also be edited manually. Essentially, bend table on a

drawing is a paragraph-text containing a table. Therefore, it can be edited using the same techniques

as for editing paragraph-texts and tables. 

Keep in mind, that manual editing of values in bend table cells makes impossible auto-updating

of such cells. 

Bend Table Data command creates a new product composition of the Bend Table type:

Icon Ribbon

Sheet Metal > Bend Table Data

Keyboard Textual Menu

<SMT> Operation > Sheet Metal > Bend Table Data

Information on the bends is added to the corresponding product composition columns.
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Bend Table product composition can also be created manually using the  Product

Composition window.

Data from this composition can be used for placing bend table and bend notes on a drawing.

Bend Note

The command can be called in one of the following ways:

Icon Ribbon

Sheet Metal > Bend Note

Keyboard Textual Menu

<SMZ> Operation > Sheet Metal > Bend Note

Unfolding drawing with bending lines noted

The command can be used for designating bend lines on a drawing by placing  leader notes,

whose text contain a Bend Number parameter of a linked item from the Bend Table product

composition. If there's no such product composition, it will be created automatically upon calling the

Bend Note command.

Bend notes can be created either automatically at once for all available bend lines (if drawing

contains an unfolded view), or manually one by one.
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Automatic bend notes creation

If an unfolded view, is already placed on a drawing, then the preview of bend notes automatically

appear on it for all bend lines. Arrows of auto-created bend notes are attached to midpoints of

corresponding bend lines. Then you can confirm notes creation  or use additional options:

<N> Callout Without Leader

Activating this option makes length of leader note's arrows equal to zero, i.e. shoulders are placed

right at the starting node. Deactivate the option for restoring notes' default appearance.

<G> Group Alignment of Callouts

When this option is active, previews of bend notes are automatically aligned and follow the cursor.

Click  to fix notes' location. Group alignment of callouts is not available, while the Callout Without

Leader option is active.

<W> Show Product Composition Window

Activating/deactivating this option opens/closes the  Product Composition window.

By default, if there is an unfolded view on a drawing, notes are automatically created for all items

from the Bend Table product composition, upon calling the Bend Note command. You can cancel

selection of all items using the following option:

<C> Cancel Elements Selection

Following option can be applied for re-selecting all items:

<*> Select All Elements

After confirming  bend notes creation they can be edited in the same way as generic  leader

notes, e.g.: customize shape and position of arrows, add additional shoulders, change parameters of

arrows.

If there's no unfolded view on a drawing, then the automatic bend notes creation is unavailable. 
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Manual bend notes creation

Instead of creating all notes at once automatically, you can create them manually one by one for each

bend line. To do so, select  the desired item in the  Product Composition window upon calling

the Bend Note command. In result the  Leader Note command gets called with the Bend Number

of selected item used as leader note's Text. Then the creation of a bend note is performed in the same

way as creating a generic leader note. In the meantime, the corresponding bend line gets highlighted

on the unfolded view (if there is such view on a drawing). However, you are not forced to snap the

note to the highlighted line. Instead you can place it anywhere you like, even outside the unfolded

view. If you select additional items in the  Product Composition window,  while creating a note,

then the corresponding bend numbers will be added to additional shoulders. Selected items are

highlighted. After confirming creation of a particular note, the system returns to the Bend Note

command, so you can go on with creating more notes. Meanwhile, the highlighting of items, whose

notes are already created, remains active in the  Product Composition window, After creating all

necessary notes, use the following option:

<Esc> Cancel

In result, the system will switch to the starting state of the Callouts command, because the Bend Note

command is the sub-mode of the Callouts. Next you may proceed working with the Callouts

command or quit it .
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Routing

T-FLEX CAD provides a set of commands for wire cables, pipelines and ventilation systems design.

The commands allow to:

· build space routes manually or automatically;

· create elements of engineering communications according to certain technical requirements;

· specify compatibility for routing elements to eliminate design errors;

· set routing elements styles to specify similar elements connection only.

Commands for creating different routing types are divided into the following groups: Pipeline,

Electricity and Ventilation. The commands allow to control compatibility of different elements.

You need to activate Routing tab to gain access to the commands. Click  icon.

Select Routing item in the drop-down list. Here you can find the commands for each routing type and

some service commands.

You can select one of the three groups Pipeline, Electricity or Ventilation in the left part. Commands

for the selected routing type become available.

Each routing type has its own library of fittings.
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Fitting is a specially designed connecting part with the predefined behavior for certain modeling

situations such as branching, turns and transitions from one diameter to another. The fitting

behavior is specified with parametric tools and macro – API-based small programs built-into

model document.

More information about fittings can be found in “Fittings” section. 

The routing trajectory is specified in command Create Route. 

More information about routings creation can be found in “Routings” section. 

Functionality of the Electricity, Pipeline and Ventilation commands of Routing group is similar. Only

types of allowed connection points, routings and fittings are different for each type.

For example, pipeline parts can be connected only with another pipeline parts. Thus we can avoid

mistakes when working with various routings types within one project.

Elements without any specified type can be connected with any routing and fitting type.

More information about creation of routings types can be found in “Connectors types” section. 

Use the following command to create routings without any specified type:

Icon Ribbon

3D Model > Create > Pipeline

Keyboard Textual Menu

<3PI> Operation > Pipeline

The command allows usage of connections and endings from different routings types.
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Description of common commands without dividing into different routings types will be given in the

following sections.

Routing Updation

After changing the pipe parameters, it is necessary to call the Update Routings command, since full

model regeneration does not update the piping and fittings chain.

Topics in this section:

· Pipeline Creation

· Fittings

· Typing of Routings

· Harnesses

· Connection Points

· Automatic Laying of Routes

· Routing Styles

· Updating Routing Models
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Pipeline, Wire Cable, Ventilation

Using general methods and steps for creating pipeline routing model described below you may

create routing designs of other types as well. 

To create a pipeline model you may select Tools > Routing > Pipeline > Pipeline item.

Icon Ribbon

3D Model > Create > Pipeline

Keyboard Textual Menu

<3PI> Operation > Pipeline

The operation creates a pipe which will be presented as a solid 3D body. The body will be resulted

from sweeping of selected contour along a trajectory (route). The route can be created using one of

the commands from the Routing section: Laying Route  or Route . It can be also specified as a

model edge or any other element that determines wire geometry.

The pipe profile shape and dimensions are specified without additional constructions. They are set in

the Properties window that appears after the command activation. 

More information about the pipeline properties can be found in “Pipeline parameters” section.

You can create a pipe along the whole route or its part.

To define the operation, follow the steps:

1. Select 3D curve defining the trajectory.
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2. Select starting 3D point of the pipe (optional).

3. Select ending 3D point of the pipe (optional).

4. Define operation parameters (pipe diameter, wall thickness, etc.).

5. Confirm operation creation.

Pipe can be created using one of the two ways:

· In the first approach, the trajectory of the pipe is divided into separate segments – straight

lines, circular arcs and splines. A separate body will be constructed for each segment.

Depending on the segment type, this can be a cylinder or a torus, or a spline. The resulting

operation consists of multiple bodies. If necessary it can be subjected to the 3SD:Divide Solid

operation for getting individual bodies – the pipe segments.

· In the second approach, the trajectory is treated as a single path. The pipe profile will be

swept along this trajectory. The result is a single body whose surface consists of a set of spline

faces and faces of revolution (cylinder, torus). In some cases, system can simplify the resulting

body geometry by replacing (wherever possible) spline surfaces with analytical ones (portions

of cylinders or tori).

The first approach is used by default. It is faster than the second and reduces overall regeneration

time. However, pipe operation created in this way may behave incorrectly under certain operations

(for example, when creating 2D projections or in Boolean operations) because it is made of multiple

bodies. If this is your case you may apply the second approach (creating the single body pipe),

however, the model regeneration time may increase.

Pipeline Command Automenu

Upon calling the command, the following option is activated in the automenu automatically:

<T> Select trajectory

The option allows to define a trajectory (3D curve) for the pipeline being created. When the option is

active, you need to select a 3D object that presents wire geometry. The object will define a trajectory

for the pipeline.

If trajectory is presented as a 3D path based on 2D elements, then it can be also selected in the

2D window. 

The selected 3D curve and its defining elements will highlight.

You may use a route as a trajectory.  If the route does not exist or existing route must be edited, use

option:

<B> Create/Edit Route

More information about routes creation can be found in “Route” chapter.

When the route creation is finished press button . You will return to the pipeline creation

command.
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The pipeline parameters can be specified in the dialog window called via:

<P> Set entity parameters

More information about pipeline parameters is given in “Pipeline parameters” section.

You can define additional 3D points that specify pipeline limits – starting and ending points, using

options:

<L> Select starting point for pipe

<M> Select ending point for pipe

The options allow selection of any 3D object that can define a point as a corresponding pipeline end.

System creates a “cutting” plane, which is perpendicular to the pipeline routing. This plane becomes a

bound of the pipeline.

Pipeline ends cannot be located beyond the selected route.

You can edit location of starting and ending points of the pipeline using options:

<S> Edit start position

<E> Edit end position

Transformations window appears after selection of one of the options. The current location of bounds

is displayed there. The value can be changed manually.
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You can also define pipeline limits using manipulators. Point the cursor at the pipeline bound

manipulator and move it with pressed . Starting point is specified from the start of the path and has

symbol “+”. Ending point is specified from the end of the path and has symbol “-”.

Current offset value is displayed on the system toolbar.

To create a pipe insert, operation that modifies pipe for inserting other parts, use option:

<O> Select operation for pipe insert

The option allows you to select body for the pipe insert. 

Insert allows system to consider the pipeline as a singular object even if there are fittings that

divide it into parts. It is necessary for further pipelines quantity and length correct calculation.

The pipe inserts are displayed in Pipe inserts section of the Properties window.
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You can cancel source path and end points selection via option:

<K> Cancel selection of trajectory and end points

You can use the following option for the standards editing:

<G> Edit standards list

The Pipeline Standards window appears after its activation. Parameters of pipeline profile can be

specified here according to existing standards.

<С> Library Configuration

More information about configurations can be found in “Holes” chapter.

The pipeline creation can be used in combination with the further Boolean operation. For this, you

need to select first the type of Boolean operation.

Then select a body using option:

<Ctrl+T> Select target body for Boolean

More information about Boolean operations can be found in “Boolean Operation” chapter.

Properties Window

You can specify the following properties in Parameters window:

Pipeline Parameters

The pipeline profile properties are specified in the Parameters section.

Profile Type. You need to select one of the profile types from the drop-down list: Round,

Rectangular, Select Standard. According to the selected profile type, you can specify its dimensions.
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Round profile

Pipe Diameter. By default, it defines the outer diameter of the pipe. If the switcher is in Outwards

mode, the parameter defines inner diameter.

Wall Thickness defines the difference between the outer in the inner diameters of the pipe. By default,

the value is put inside the pipe (switcher is in Inwards mode).

You can change pipe diameter and thickness using manipulators in the 3D scene. Current value of the

parameter can be set on the system toolbar.

If smooth transition disappears between the two straight pipe segments when creating a pipe,

then you must fix correlation between the rounding radius and the pipe diameter.

Rectangular profile

Width, Height, Radius of Rounding specify parameters of outer pipe profile by default. If the switcher

is in Outwards mode, the parameter defines inner profile.

Permitted values for Radius of Rounding are from “0” (without rounding) up to half of the minimum

dimensions: length or height.
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If the radius is not within the value or the rounding cannot be created because of other reasons,

the system displays the diagnostic message.

Wall thickness. By default, the value is put inside the pipe (switcher is in Inwards mode).

You can change rectangular profile dimensions using manipulators. Current value of edited

parameter can be set on the system toolbar.

Select standard

If the profile type is specified by a standard, values of parameters are defined from the predefined list.

All parameters are divided into control and dependent.

Permitted values of a dependent parameter are defined according to the selected value of the control

parameter.

For the round profile type, diameter is the control parameter. Dependent parameters are walls

thickness, fixation of inside dimension and option for creating one body.

For the rectangular profile type, height and width are the control parameters. Dependent parameters

are walls thickness, fixation of inside dimension and blending.

You can manage the standards list using Standards window.

More information about the window can be found in “Standards” section.

If the specified value of any parameter does not match the standard, when you edit pipe profile

defined by a standard, the system will display a diagnostic message.

Common parameter

The following parameters are available for all profile types:
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Create one Body. Parameter specifies the way of pipeline creation. When the flag is not set, the first

way (separate segments) is used. The resulting operation consists of multiple bodies. When the flag is

set, the second way is used – the resulting operation will present a single body.

Don’t create Solids. When the flag is set, the operation will be created but it won’t be displayed in the

3D scene. It is useful in models with large number of pipes.

Simplify geometry. With this parameter set, the geometry of the resulting body will be simplified by

replacing (wherever possible) spline surfaces with analytical ones (cylinders or tori).

Tolerance. This parameter defines the accuracy of pipe construction, resulting with particular number

of intermediate steps when sweeping pipe profile along the spline trajectory to ensure the required

accuracy of surface.

Profile Orientation 

It is possible to specify rotation of profile while sweeping using flag Rotate Profile (available only for

rectangular profile). 

The profile orientation is the full angle of rotation according to the axis directed along the

tangent to the path. It is specified at the pipe ends with two parameters-angles:

Starting Angle is defined as an angle between Y axes of base LCS and source LCS.

Source LCS - X axis is directed along the tangent to the path, Y axis is defined by the principal normal

to the path.

Base LCS – LCS (connector or connection point) which is located on the pipe bound (starting or

ending). The X axis is directed along the tangent to the path, the origin merges with the bound of the

pipe (starting or ending).

Ending Angle is specified in the Properties window or using manipulator in 3D scene.

When you use manipulator, the current rotation angle is displayed on the system toolbar.
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Endings and Connections

There is possibility to set endings and connectors types in the Pipeline command by inserting library

fragments into the model. Bevels, flanges, threads and so on can be used as such fragments.

In the 3D Model window such pipeline is displayed as a single object, but physically in the model it

consists of several fragments (start, middle and end). If you edit any of these fragments the Edit

Pipeline command activates automatically.

Ending or connection type can be selected either from the quick access drop-down list or by clicking

the corresponding icon. If you select type from the list and it is not presented among the icons below,

the new icon will replace the last right icon. 

Item “Select” in the drop-down list allows you to select element from custom libraries added to

selection list.

The content of the selection list is linked with the value of the Standard field and will update

accordingly.

The elements of endings and connection are created as adaptive fragments. They are stored in

folder “..\Libraries\Routing”. If necessary, library can be supplemented with custom elements.
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To define selection from the predefined set of ending and connection elements use “Standard” data

field.

Use button  Edit variables to set external values of fragment variables. The Variables section

appears after pressing the button.

System checks for correctness of endings insertion and displays message if it is impossible to perform

the operation. It can happen if, for example, the ending length is greater than the pipeline length.

You can select ending or connection library using option:

<B> Library configuration

More information about configurations can be found in “Holes” chapter.

Pipe Inserts

This section of Properties window displays elements, used in option  Select operation for pipe

insert and elements, used to define  shape of cutting from the pipe.

These elements are not added to the 3D Model window. 

You can delete them using button  if necessary.

 

List of Standards Editor

This editor provides functionality for creating list of pipe standards. Here you can set main parameters

of a standard as well as define control and dependent parameters.

The editor is called via automenu option:

<G> Edit list of pipe standards

In the left part of the window there is the list of all available standards and pipeline parameters, which

are defined by the standards. In the right part you may see the detailed description of the standard.

The list of standards and parameters is stored in file PipeStandards.xml inside folder “..

\Program”.
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You need to specify available parameters values and dependencies between them. Press  to show

list of available values to the left from the standard name.

After selecting any parameter in the right part of the window you will see the list of available values.

The dependent parameter also has the list of dependencies. The dependencies show, which values the

control parameter can take according to the particular value of dependent parameter or in the

specified interval. 

The editor allows to change current standards and add the new ones. To add a standard you need to

press button  , select standard type (ISO, DIN and so on) from the drop-down list  and fill in

all necessary fields: Name, Route Type, Profile Type, Comment, etc.

Buttons on the toolbar will help you to cut , copy , insert  , and delete   a standard.

You can specify the following parameters for pipeline standard:

Name – name of standard that will be displayed in the list.

Route Type – defines type of route that may work with this standard.

Profile Type – sets round or rectangular profile.

More information on profiles types can be found in “Parameters” section.

· Inwards, Outwards. You can select type of thickness increment Note that in this case changing

method of thickness increment (Inwards/Outwards switcher in the Properties window) will be
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undesirable. I.e. the way of increment can be changed but it will lead to the diagnostic

message. 

· Use wall thickness. If the flag is set, the Thickness appears in the standards list. Without active

flag you cannot specify walls thickness.

· Create one body. The flag is identical so named flag from the pipeline parameters. It defines

the way of body creation for the current standard.

More information about the flag can be found in “Pipeline parameters” section.

After selecting parameter of standard in the left part of window, you can set its values and

dependencies in the right part.

The parameter values can be set using button , dependencies are specified using button .

To delete values and dependencies use buttons  and  or <Delete> button. To edit previously

created dependency use button . After pressing the button the following dialog box will appear.

In the Dependency window you can set value or interval of the values for control and dependent

parameters. To define interval you need to set flag in corresponding field. 
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Import/Export of Standards

There is possibility to export and import lists of standards from XML-files using commands File >>

Import, File >> Export from the menu.

There are two options available for import:

Replace. The current list will be replaced with the list from the external file.

Add. You can select standards that will be added to the list. Selection list will not display standards

that already exist in the list. 
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Icons at the bottom of the window allow you to perform the following actions with the list of

standards:

 - select all standards.
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 - cancel selection of all standards.

 - invert standards selection.

Fittings

Fitting is a connecting part of pipeline, which is usually located at branching places, turns and

transitions to another diameter. Fittings are used for sealed overlap of the pipeline and other auxiliary

purposes.

It is convenient to use smart-fragments as fittings. Smart-fragments adapt to objects already existing

in the model and affect geometry of connected fragments. 

For example, when you insert a cross fitting between two pipes, the crossing pipes will be

automatically divided each into two parts. Their ends will be automatically transformed according to

the requested connection type. 

Special variables, connectors, LCS and macro provide an automatic link with parameters of other

routing elements. The macro is included into the fitting document file.

When you need a new fitting you have to create a 3D model file with a special macros that will be

used as a 3D fragment. Creation and usage of each fitting type is described below.

Ready to use library fittings files include “Smart” suffix in their names. You can enlarge set of such

elements if it is necessary.

Fitting gets part of external variables values from the pipeline parameters. For example fitting can get

the pipe diameter. Fitting can also pass parameters values to the pipe, if it is set in the fitting file.

There are following fittings types defined by default: Cap, CornerFracture, CornerRadius, Tee, Crossing,

Adapter, Clamp, CornerEnd, Inset.

Fitting Insertion

It is easy to use drag’n’drop mechanism for fitting insertion. 

Options for defining fitting  location appears right after drag’n’drop of the fitting.

<P> Select path

<T> Select pipe

When option  is selected, the fragment is placed on the selected path point. When you select , 

system defines appropriate point for fixing on the selected pipe (for example, crossing), if necessary.
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There is a different set of options for each fitting type. It appears after path or pipe selection.

<R> Rotate fragment along main axis

<T> Rotate fragment along alternative axis

<V> Select next fixing point

Options  and  allow to rotate the fragment around main and alternative directions, changing

location of trunks and branches.

Option  is available if the fragment is located on the crossing of two pipes/paths. 

If the fragment (tee or crossing) is located at the crossing point of paths, you can’t rotate or

translate it using manipulator.

For CornerFracture, CornerRadius, CornerEnd:

<R> Rotate fragment

<F> Select next fixing point

The next suitable fixing point for fitting will be automatically found after pressing of  or 

options. The points will be cyclically searched upon further continuous option usage.

The corner can be located on trunks and endings of the pipe.

For Inset, Clamp:

<D> Select pipe for Y direction

<R> Rotate fragment

When the option  is active you need to select pipe, related to which the Y direction will be defined.

For Cap, Adapter:
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<R> Rotate fragment 

This type of fittings limits pipe on endings.

For all inserted smart-fragments the following options are available:

<E> Wireframe

<N> Insert new fragment after confirmation

Wireframe. Allows to switch between wireframe mode and rendering mode of the model.

Wireframe mode Rendering mode

Insert new fragment after confirmation. A new fragment similar to the inserted one will be added

after confirmation button pressing.

Fittings Basic Highlights

When you insert a fitting at the beginning or end of the pipe, the pipe is not divided. When you

change fixing type the pipe will be divided into two parts if possible. The original parameters of pipe

endings will be restored.
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After the fitting insertion or replacement system determines necessity of the pipe dividing.

Unused pipe part will be suppressed and removed after exiting the command.

Special manipulator is used to define fitting position. It allows to move fitting and rotate it around the

axis. 

If fitting does not match the pipe, the corresponding message will appear. 
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Special window Action appears when you edit a fitting. Here you can select option for editing the

current fitting, selecting a new fitting to replace the current or cancel editing. 

To replace a fitting choose option <Select from library> and select necessary library fragment in

Fitting Selection window. After selection, you need to press [Replace] button.

After fitting selection the system exit from edition command automatically.
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When you delete a fitting, linked pipes won’t be deleted.

Fittings Parameters Names

Table of external key variables of smart-fragment. 

Variable name Usage Description

DiameterIn1 Manages input diameter of main

direction fitting

Is necessary for Cap,

CornerXxx, Tee, Crossing,

Adapter, Clamp
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DiameterOut1 Manages output diameter of main

direction fitting

Is necessary for CornerXxx,

Tee, Crossing, Adapter

DiameterIn2 Manages input diameter of alternative

 direction fitting

Is necessary for Crossing

DiameterOut2 Manages output diameter of

alternative direction fitting

Is necessary for Tee, Crossing

External variable Diameter *** is responsible for link between the respective diameters of fitting and

pipe. Due to the variables, macro can get diameter of pipe to which fitting is attached and set the

appropriate diameter of  fitting.

When creating a smart fragment it is possible to use from one (lug, cross with identical diameters of

all branches) to four (cross with four different diameters) external variables, depending on the number

of input and output fitting diameters.

          

Table of smart-fragment key LCS.

Object Description

LCS_1 The fragment source LCS must be set as LCS

by default in the fragment document

parameters.

C_In1, C_Out1, C_In2, C_Out2 Connectors names of input/output main and

alternative directions  

LCSs listed in the table are responsible for cutting pipe for which fitting is inserted.

LCS_1 responsible for position of fitting on the pipe is the main LCS that must be created for joining

fitting with the fragment. The remaining four LCSs are responsible for joining pipes of appropriate

diameter and the emergence of the connecting elements (flange and thread) at coupling place of

pipe with fitting. These LCSs are considered in macro.

Table of key connector parameters that define smart-fragment insertion logic:

Parameter name Usage Description
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autoFilePipeEnd Pipe ending/beginning if

connector is located on pipe

end. 

Can be omitted.

Template of the parameter value:

<library>file_name.grb

Parameter functions:

- creates cosmetic thread on the pipe

- cuts the edge for  weld

- creates flaring

autoLength The fragments name in the

connector direction

Sum of input and output connector

lengths is equal to the length of the

direction (main or alternative)

autoDiameter Pipe diameter will be taken from

 fitting

If missed the original pipe diameter is

used.

autoThickness Pipe thickness will be taken from

fitting

If missed the original pipe thickness is

used.

Auto – manages the command operating logic when the smart-fragment with this connector is

inserted.

The above parameters allow you to specify additional options when you insert the fitting.

Fittings Smart-fragments Behavior in Pipe Systems

Variants of interaction with other fittings

1. Y-shaped bend

· Creates inner cosmetic thread on pipe

· Creates outer cosmetic thread on pipe

· Divides pipe segment into two segments

· Divides pipeline into more than two segments

· Modifies pipe diameter from larger to smaller and back

· Cuts edge for weld

· Inserted in the middle of pipe segment 

· Inserted on pipe ends

· Inserted on pipe rounds 

· Inserted on pipe corners

· Interaction with a single pipe

· Interacts several pipes

· Interacts other fittings

· Interacts intersecting branches of pipeline

2. Adapter

· Creates inner cosmetic thread on pipe

· Creates outer cosmetic thread on pipe

· Divides pipe segment into two segments

· Modifies pipe diameter from larger to smaller and back

· Inserted on pipe ends

· Inserted in the middle of pipe segment 

· Interaction with a single pipe

· Interacts several pipes

· Interacts other fittings

· Interacts with parallel branches of pipeline
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· Makes the flaring of pipe/tube/hose

3. Branch

· Creates a hole in pipe

· Cuts edge for weld

· Inserted in the middle of pipe segment 

· Interaction with a single pipe

· Interacts with several pipes

· Interacts intersecting branches of pipeline

4. Bushing

· Creates inner thread on pipe

· Creates outer cosmetic thread on pipe

· Divides pipe segment into two segments

· Modifies pipe diameter from larger to smaller and back

· Cuts edge for weld

· Inserted on pipe ends

· Inserted in the middle of pipe segment 

5. Lock nut

· Creates outer cosmetic thread on pipe

· Inserted in the middle of pipe segment 

· Interaction with a single pipe

6. Set-off pipe bend

· Creates inner thread on pipe

· Creates outer cosmetic thread on pipe

· Cuts edge for weld

· Inserted on pipe ends

· Cuts second part of pipe

· Modifies pipe diameter from larger to smaller and back

· Cuts edge for weld

· Inserted in the middle of pipe segment 

· Interaction with a single pipe

· Interacts with several pipes

· Interacts with parallel branches of pipeline

· Interacts other fittings

7. Valve

· Creates inner thread on pipe

· Creates outer cosmetic thread on pipe

· Divides pipe segment into two segments

· Cuts second part of pipe

· Modifies pipe diameter from larger to smaller and back

· Cuts edge for weld

· Inserted on pipe ends

· Inserted in the middle of pipe segment 

· Interaction with a single pipe

· Interacts with several pipes

· Interacts other fittings

· Interacts intersecting branches of pipeline

8. Bend

· Creates inner thread on pipe

· Creates outer cosmetic thread on pipe
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· Divides pipe segment into two segments

· Cuts second part of pipe

· Modifies pipe diameter from larger to smaller and back

· Cuts edge for weld

· Inserted on pipe rounds 

· Inserted on pipe corners

· Inserted in the middle of pipe segment 

· Interaction with a single pipe

· Interacts with several pipes

· Interacts other fittings

· Interacts intersecting branches of pipeline

9. Crossing

· Creates inner thread on pipe

· Creates outer cosmetic thread on pipe

· Divides pipe segment into two segments

· Cuts second part of pipe

· Modifies pipe diameter from larger to smaller and back

· Cuts edge for weld

· Inserted on pipe ends

· Inserted in the middle of pipe segment 

· Interaction with a single pipe

· Interacts with several pipes

· Interacts other fittings

· Interacts intersecting branches of pipeline

10. Coupling

· Creates inner thread on pipe

· Creates outer cosmetic thread on pipe

· Divides pipe segment into two segments

· Modifies pipe diameter from larger to smaller and back

· Inserted on pipe ends

· Inserted in the middle of pipe segment 

· Interaction with a single pipe

· Interacts with several pipes

· Interacts other fittings

11. Cap

· Creates inner thread on pipe

· Creates outer cosmetic thread on pipe

· Cuts second part of pipe

· Inserted on pipe ends

· Interaction with a single pipe

· Interacts other fittings

12. Pipe clamp

· Changes geometry of the 3D path

· Interacts with several pipes

· Interacts intersecting branches of pipeline

· Interacts with parallel branches of pipeline

· Interacts intersecting branches of pipeline

13. Reducer 

· Creates inner thread on pipe
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· Creates outer cosmetic thread on pipe

· Divides pipe segment into two segments

· Modifies pipe diameter from larger to smaller and back

· Cuts edge for weld

· Inserted on pipe ends

· Inserted in the middle of pipe segment 

· Interaction with a single pipe

· Interacts with several pipes

14. Tee 

· Creates inner thread on pipe

· Creates outer cosmetic thread on pipe

· Divides pipe segment into two segments

· Cuts second part of pipe

· Modifies pipe diameter from larger to smaller and back

· Cuts edge for weld

· Inserted on pipe ends

· Inserted on pipe rounds 

· Inserted on pipe corners

· Inserted in the middle of pipe segment 

· Interaction with a single pipe

· Interacts with several pipes

· Interacts other fittings

· Interacts intersecting branches of pipeline

15. Seal

· Interacts other fittings

16. Flange

· Divides pipe segment into two segments

· Inserted on pipe ends

· Inserted in the middle of pipe segment 

· Interaction with a single pipe

· Interacts other fittings

17. Pipe housing

· Inserted in the middle of pipe segment 

· Interaction with a single pipe

· Inserted on pipe rounds 

· Inserted on pipe corners

· Interacts with several pipes

· Interacts with parallel branches of pipeline

· Interacts other fittings

18. Compensator

· Divides pipe segment into two sections

· Cuts edge for weld

· Interaction with a single pipe 

· Inserted on pipe ends

· Inserted in the middle of pipe section 

· Interacts other fittings
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Macros Creation

When you create a new fitting a standard macro text is added into its file. One of the fittings types

that were listed above is specified in the macro. 

Here is example of typical macro text for the “Crossing” type.
using System;

using FittingImport;

namespace FittingImportNamespace

{

public class FittingImportClass

{

public static void Fitting_InsertAsFragment()

{

FittingImport.TFFittingImport.Create(FittingType.Crossing);

}

public static void Fitting_EditFragment()

{

FittingImport.TFFittingImport.Edit(FittingType.Crossing);

}

public static void Fitting_DeleteFragment()

{

FittingImport.TFFittingImport.Delete(FittingType.Crossing);

}

}

}  

More information about macro can be found in “Macros” chapter.

Also you need to set three message handlers “Fitting_InsertAsFragment”, “Fitting_EditFragment”,

“Fitting_DeleteFragment”.
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To compile the macro you need to add link to the FittingImport in the project.

Smart-fragment Creation Example

General steps for successful creation of a smart-fragment are listed in this example. 

For convenience, the smart-fragment creation is divided into four stages:

· Body for fitting creation

· Body for creation of the cutout shape in pipe

· Fitting parameters managing

· Macro creation
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There are special rules for LCS, connectors and variables when you create a fitting. Names of variables

and LCSs and their description are listed in “Fittings parameters names” section.

Fitting Body Creation

To begin with, you need to create a fragment body. The Rotation and Thread were used to create the

boss. 

More information about the rotation and thread operation can be found in “Rotation” and

“Thread” chapters.

Fitting Hole Body Creation

The next step is creation of a fitting hole body. 

Body for defining an insert in pipe is a fitting element that defines the form and shape of a hole

in pipe, in which the fitting is inserted. After insertion, this body disappears.

You need to specify input diameter of main direction fitting “DiameterIn1” and main LCS “LCS_1” for

the boss creation.

More information about variables names can be found in “Fitting parameters names” section.

Setting Diameter Variable

The diameter is specified in the variables editor. The variable defines diameter of pipe in which the

fitting is inserted and specifies fitting location.
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You can set any value for diameter variable. The macro automatically identifies pipe diameter and

add its value to the variables, when the fitting is inserted into an assembly.

You need to set External variable flag for the variable.

LCS Creation

Construction line was created in the example to specify LCS location. The line is at distance

“DiameterIn1/2” from the face of the boss cylindrical part. The pipe diameter is half divided that’s why

the boss will be located on the pipe. 

Line that defines LCS location Boss location on the pipe

The LCS is renamed to LCS_1. The name was taken from the “Key smart-fragments objects” table.

There is no need to create connectors (C_In, C_Out) because there are no fitting elements to connect

with the boss.

In this case, the fitting will not join any piping elements or other fittings, so  the creation of

additional connectors (C_In, C_Out), diameters (DiameterIn2, DiameterOut), or their parameters

are not required.
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Body Creation

The next step is to create a body to define shape of the cutout in pipe. Contour of the body should

follow the shape of the cutout in pipe, so that when you insert fitting there is no intersection of the

fitting and the pipe.

Length of body should depend on LCS_1 position. This is done in order to be able to adjust the

position of the fitting on the pipe depending on the pipe diameter.

It is better to have the body with the most simple geometry - a box or cylinder. This will reduce

the time of the pipeline regeneration.

If the body is not created, a cutout will have the form of the inserted fragment.

In this case, the body is obtained by rotating profile around  axis.
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Body to set the shape of cutout in the pipe should be hidden in the 3D scene and on the drawing. In

order to hide it you need to do the following.

In the editor of layers, create a new layer and name it - "Invisible" and put mark in the Visible only

when inserted in assembly.

In the parameters of created body on the General tab, you must specify the previously created layer

"Invisible", then the body will be hidden in the 3D scene
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Adjusting Fitting Parameters

After creating the fitting body it is necessary to set the parameters for its insertion into assembly as a

smart fragment. To do this, use Set Document Parameters command, go to 3D Fragment tab.

In the window that appears you must:

Set Type of Fragment Insertion – Smart Fragment (macro). System will use macro created in Macro

Editor when inserting this body.

Set flag In the Automatically create Boolean operation section. From the drop-down list, you must

should select operation type Subtraction from the drop-down list - subtraction, so that the body

create a cutout in the pipe, and in the drop-down list Create operation with select the name of the

body that will be used for Boolean operations. In this case - "Fitting_hole_body".
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Setting the above parameters allows system to automatically execute macro to create Boolean

operation when you insert the smart fragment.

After performing Boolean operation body used as a cutout in the pipe disappears. It will be

referenced in the section Pipe Inserts in the Properties window for the selected element of the

pipeline.

Macro Creation

The following is the sequence of actions to create a macro for inserting a smart fragment:

Use macro editor to create a new macro. Macro text for various fittings differs only in the type

indicated in parentheses. In this case, this is type "Inset".

The you need to define three message (event) handlers: 

· Inserting as a fragment (Fitting_InsertAsFragment), 

· Editing (Fitting_EditFragment), 

· Deleting (Fitting_DeleteFragment).

To set the handler you must select the project and from the context menu choose Message Handlers

....
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In the window that appears choose one after another three lines "Delete Fragment", Edit Fragment,

"Insert as a Fragment" and select them using the macro button [Set].

Since the main macro has been previously created in the macro editor, the list will appear from which

you can select the desired part of the macro. Macro can be set manually, if necessary, by pressing [Set

Manually].

In order to successfully compile the macro add link to FittingImport in the project.
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After completing all the above items, the fragment file must be saved. Now the created fitting can be

used for insertion into assembly using Drag’n’Drop method.

More information about creating macros can be found in the "Macros" chapter.

Example of creating pipe endings and connections

When you create models for pipe middles and endings you should considered a set of rules.

To add new models for pipe middles and endings into the library use command:

<С> Library Configuration

More information about configurations can be found in “Holes” chapter.

In the fragment file you must create the following variables:

· Diameter or D - pipe diameter (permissible values range from 0 to 10000)

· Thickness or T - pipe wall thickness (permissible values range from 0 to 10000)- 

· InnerDiameter or InnerD – flag for usage of internal diameter (possible values 0 or 1)

Note. Variable InnerDiameter (D)  can be used for the suppression of one of the bodies in the

fragment file. One body will be visible when using internal diameter, the second - using external.

Guidelines for creating fragment of ending and connection

After creating 3D model, you need to:

Create external 3D node (there must be only one). This node will limit the adjoining pipe. It should be

placed on the "inner end" of fragment body.

Create external LCS. This LCS should be placed on the "outer end" of fragment body. It will be used for

fixing the fragment. It must be assigned as a primary fixing LCS in the document properties command

on the 3D tab, button [Fragment].
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More information on how to create LCS can be found in the chapter "Local Coordinate Systems".

Create custom dialog for entering values of external variables (optional step). This dialog is

automatically embedded in the Properties window when you call editing of ending variables in the

command of pipeline creation/editing.

Learn how to create a dialog in the chapter "Controls. Creation of Custom Dialogs."
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Create icon with the command Tools > Special Data > Icon. (Optional step).

Learn how to create icons in chapter "Document Preview and Icons"

In the variable editor add diagnostics for invalid combinations of variable values.

Read more about diagnostics functions in chapter “Variables”.

Guidelines for creating fragment of the middle part of pipe

When you need to create some specific pipe geometry like corrugated pipe you may use special

mechanism for defining pipe “middle” using fragment.

In the fragment file you must create variables described in the beginning of this section: Diameter,

Thickness, InnerDiameter.

To create a 3D model of the middle of the pipe, you can use any convenient operation, such as

sweeping along a path. It is important that the body is based on a 3D path.

After creating 3D model, you must set parameters in Adaptive Fragment command. This will create a

pipeline using any selected route.
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Read more about how to create adaptive fragments in chapter "Adaptive 3D Fragments."

Name. Parameter specifies the name of operation, which will be assigned to the pipe using this

fragment.

Geometrical parameters:

· Path (3D path or route). Element that defines the path of the pipeline.

· 3D pipe start node

· 3D pipe end node

It is important to comply with sequence of geometrical parameters in the list. The first must be

path, and then the start and end points.

Creation of icons and dialog of external variables for the fragment is not a mandatory action.

Name that appears in the list of endings and connections in the command of pipeline creation can be

set in command File > Properties > Summary.
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After performing all the above steps, you must save the file.

Typing of Routings

In order to automate routings design process, objects can be associated with certain types. Types

allow you to exclude mistakes in operations of connecting routing elements to each other.

For description of objects compatibility rules and assignment of types use command Connection

Types. 

There, you can assign a valid correspondence between the routes and fittings, between the different

types of routes.

It is possible to create objects with basic typing. The basic types include Pipeline, Wire Cable,

Ventilation.

For these basic types menu Routing has commands to create connection points, routes, harnesses,

routing objects, as well as command for filling route with style.
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When you call Route command, system opens dialog of route command with the corresponding value

of Type parameter (Wiring, Ventilation and Pipeline). To clarify type use option Select type in the

drop-down menu. It will offer you types, which are the children of the base type.

In the drop-down list displays the 10 most recently used types. When you call one of the

commands with the base typing you will get types derived only from this base type. When you

use the general Route command you will get all used types.

To adjust compatibility of different types you can use Connection Types command. 

Connection Types command

Icon Ribbon

Routing > Options > Connection Types

Keyboard Textual Menu

<TI> Tools >> Routing >> Connection Types

With the help of editor of connection types you can set compatibility rules for various types of

routings. Compatibility rules help to avoid mistakes when working with various libraries and routings

within the same project. For example, avoid accidental connection of low-voltage and high-voltage

cables in the design process.
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In the left pane there is a tree of types. It consists of two main parts: "Objects" and "Routes".

Above the tree of types there is a toolbar for its editing.

 Create. Allows you to create a new type. Object will be added to the selected type from the list.

Parameters of a new type are described below.

 Cut. The selected object will be cut from tree. 

 Copy. Allows to copy type

 Paste. Allows to insert type. Works with options Cut and Copy.

 Delete. Allows to delete selected type.

 Editor of Physical Parameters. Provides access to the internal directory of the physical

parameters. Work with the directory is described below.

Parameters of type

The right pane displays the set of parameters of the selected type.
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Type. In this field you can specify unique name of the type to which the object belongs. Type name

will appear in the list on the left side of the Editor of Connection Types and the drop-down list of

types when you create objects (connection points and routes).

Object Name. Specifies the name of objects for a given type. This name will be displayed in the

model tree. Names can be the same for different objects.

Style. Specifies the number of axes required for the proper connection of objects.

For example, such connection as "plug - socket" requires two axes to match.

Style is taken into account when creating connection points and routes.

One axis Two axes Three axes

Icon. It allows you to set icon to be displayed to the left of the type. For selecting icon for the file you

can use the button . In the window that appears you can see the available standard icons. To

remove  element icon, use the button .

Comment. In this field you can enter a comment to the selected element. The number of characters

available for comment is displayed above the field.

For each element you can set a group of parameters.

Parameter Name. If two objects of the same type of parameter names coincide, these parameters are

compared. When incompatibility is found, you cannot connect the objects.

Condition. Condition can be selected from the drop-down list.

Value. Is taken into account when comparing parameters.
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Physical Parameter. From the drop-down list you can select the physical parameter. Physical

parameters are set in the Editor of Physical Parameters.

For more information about editor of physical parameters refer to section "Physical

Parameters" below.

Unit. After selecting the physical parameter you can use set the corresponding unit.

On the right side of the dialog there is a set of buttons to control the inheritance of parameters. By

default, objects inherit all parameters of the upper level objects.

Button  shows parameters that selected type inherits. To change the inherited parameters use

option . 

   - options allow you to add or delete parameters from the list.

Compatible types can be set in the bottom of the window.

Options  and  allow you to add compatible types and routes from the list. Options  and

 allow you to delete previously added types and routes. 

Option  allows you to control inheritance of parameter types. When enabled, all objects within a

type inherit all of its compatible elements. After disabling the option, you can delete all but one

inherited compatibility.

Only compatible types can be set for the routes.

The tree structure and description of types is contained in ConnectorType.xml file. To manage this file

from the "File" menu, use the following commands:

· Save (active, if any item in the tree has been changed): saves ConnectorType.xml file in “C:

\Users\User_name\AppData\Local\ Top Systems\ T-FLEX CAD 3D…” folder.

· Import: replaces the contents of the current ConnectorType.xml file with the contents of the

imported file. If ConnectorType.xml file has been modified before importing, system would

prompt to save it under another name.

When importing tree of types there are two options:

· With replacement: current list will be completely replaced by the list from external file.

· With addition of: the user will be prompted to select the types that need to be put in the

current list. The import list will be filtered not displaying the types that already exist in the

current list.
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· Export: saves ConnectorType.xml file to the specified location. If desired, you can specify a

different name for the file.

Compatibility Tree

Command “Tools/Compatibility Tree” of the “Editor of Connection Types” displays compatibility

rules in a separate window. For the element selected in the left part of window systems shows on the

right side all compatible objects and routes. Tree allows to see the current structure of compatibility.

Compatibility Check

Command “Tools/Compatibility Check” of the “Editor of Connection Types” allows you to check 

compatibility of any pair of elements in the list of objects and routes. Select item in the left pane and

item in the right pane. Message in the bottom will tell about the presence or absence of compatibility.
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Physical Parameters

Command “Edit\Editor of Physical Parameters” of the “Editor of Connection Types”   displays the

internal directory of physical parameters for the editor of connection types. For each parameter there

is a list of units with the name and the short name.

Flag Base sets the default measurement unit. For other units of measure there is Multiplication factor

for conversion to the base unit. List of parameters and units of measurement can be edited using the

following commands:

 - Add parameter

 - Add unit

 - Delete
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Harnesses

Harness is part of the hierarchical structure of the route, uniting a group of routes or other harnesses.

For example, harnesses may be used in automatic laying of routes.

To create a harness it is necessary first to build routes, which will then be combined into harnesses.

Call to create a harness command is carried out from Routing ribbon tab or textual menu. Every new

harness is set with the base type.

Icon Ribbon

           Routing > Construct > Harness

Keyboard Textual Menu

<> Tools > Routing > Pipeline > Harness

After activating the command, specify the routes, which will be combined into a harness. Selection of

routes is available with option  in automenu.

Obligatory condition of combining two routes into a harness is the presence of at least one

point of intersection of two adjacent segments.

All selected routes are displayed in the Properties dialog in Compound Elements section.
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To complete the creation of harness press .

Connection Points

To automate connection of routing elements to each other you may use connection points -

connectors. They represent LCS, which have certain types.

If the LCS type does not exist in the used hierarchy of types,  next to the LCS there will be "from

document" note.

When you create connectors, for their positioning you may use only objects with compatible type, or

objects with no type assigned. When typed element is added to a model, system checks whether a

given connection point may be used for connecting element, i.e. checks objects for compatibility.

For more information about creating connectors refer to chapter "Local Coordinate Systems".

Automatic Laying of Routes

To access the command:
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Icon Ribbon

Routing > Construct > Laying Route

Keyboard Textual Menu

Tools > Routing > Laying Route

Laying Route command performs automatic laying of route between selected nodes. To set path of

the middle route segment you can use also harnesses.

The algorithm of working with the command can be represented as follows:

Consider an example.

The route will go between the two LCS. Part of the route will pass through the harness.

After calling the command, the following options are available:

<F> Select start point

<S> Select end point
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<D> Cancel start and end points

<L> Select harness

<C> Cancel harness selection

<N> Next

<P> Back

<R>
Resume command operation after applying

changes

In Parameters dialog you can set parameters of the route being created:

· Tangency Offset – specifies the distance by which the segment of the route offsets's from the

intersection point with another segment to build tangential coupling between them.

· Rounding Radius – sets radius of rounding at the route break points.

· Route Type: polyline, spline by points, spline by polyline - can be set separately for each route

segment.

· Color – sets route color by default.

Laying the route takes place in several stages. At each stage a segment of the route is constructed. The

segment is laid along the edges of the manipulator-box or rectangle. This manipulator appears for
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each route segment. You can select edges, by which the route will be laid, and set the length of the

edges.

After the initial data for constructing the route - start LCS  ,  end LCS   and harness  - are set

press button   Next. 

After that you will see manipulator-box, with which you need to specify the variant of the route

approach to the first point along axis X. To specify the variant, you must select appropriate edges of

the manipulator.

Length of edges can be changed either directly with manipulator or in the Properties window.

After selecting necessary variant, press  and repeat the steps for the second point. At the next two

steps, system automatically finds the nearest points for connecting with harness and provides a way to

define path segments for these points. The action is performed similar to the previous one, by

selecting edges of the box. Similarly, you can construct path for  the route without using harness.
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The final step - a preview of the result. You can confirm the creation of the route by pressing , or

with  option  Return to the previous steps to adjust any settings.

After creation the route is available for editing by standard tools of editing routes: you can change the

types of segments, add rounding, etc.

Routing Styles

Style is a group of settings designed for automatic filling of routes with the routing objects. Styles

usually correspond to standards that are commonly used in the routing design. For example, parts of

the pipeline must often comply with certain requirements in length and diameter; in addition, these

parts should include fittings of certain materials.

Style definitions are managed in the editor of Styles. With the editor, you can view, add, edit, and

delete styles. The definitions of styles can be also imported and exported using file in .xml format. You
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can change any of the default styles, or use them as the basis for creating new custom styles. In

addition, custom styles can be created based on the empty style.

Editor of styles can be called from the Routing menu:

Icon Ribbon

Routing > Options > Styles

Keyboard Textual Menu

Tools > Routing > Styles

After calling the command you will see the dialog of Routing Styles editor.

There is a toolbar in the upper part of the dialog:

 Create Catalog creates new folder-catalog for styles.

 Create Style creates new style in the current catalog.

 Copy Style copies selected style.

 Paste Style paste copied style into selected catalog. 

 Delete deletes style or catalog.

 Update information about fittings – updates information about routing objects (fittings).

On the left there is a list of catalogs and styles available for usage.

Created styles can be exported and imported in *.xml format with the appropriate commands in the

File menu.
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Parameters of the selected style are displayed in the right pane.

Properties tab 

Name. In this field you can set the name of style that will appear in the list in the left pane.

Catalog. The drop-down list contains catalogs that may include the selected style. You can create a

new catalog by selecting the appropriate menu item from the drop-down list, if desired.

Weld length (default). When the flag is active, you can set the default weld length.

Use flange. Defines the usage of flanges for style.

Minimal and Maximal diameters define the permissible routing diameters.

Components window displays the list of fitting types and their corresponding files.

You may use the following button when working with the Components dialog:

 Delete Component. Deletes selected file from the list.

 Select Component. Adds file to the list.
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 Delete All Components. Deletes all files from the list.

After mouse click in the <Select> field or pressing button , the following window appears:

This window displays all library files available for selection.

If the fragment name is highlighted in red, it cannot be selected.

Rules tab.

Minimal pipe length, Maximal pipe length - set the minimal and maximal length of the pipeline

segment.

Increment of pipe length. You can specify the length of increment. Increment of length is a step with

which the system takes into account the above conditions.
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Use Pipe operation to fill indirect path segments. 

When the flag is set the pipeline will be bent with a given style.

List of libraries for selection consists of libraries marked as available for selection. Use Tools >

Libraries command of Routing Styles dialog menu to mark necessary libraries in the list of all system

libraries.

 

Updating Routing Models

To apply styles, use command route Fill route with style, available for all types of routings.

Icon Ribbon

Routing > Construct > Fill route with style

Keyboard Textual Menu

Tools > Routing > Pipeline > Fill route with style

The following actions are available in automenu after activating the command:

<P> Select Route

<B> Select start point on route

<E> Select end point on route

<D> Cancel start and end points

<A> Select alternative routes
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<L> Cancel alternative routes

<N> Next

<M> Back

<C> Clear Route

<R>
Resume command operation after applying

changes

 Upon activation, you need to select the main route to create routing.

 and  allow to set limit for routing. Element will be generated or deleted on the specified

segment of the route.

 Cancels selection of the start and end points.

 Allows you to choose alternative the routes. These routes must be connected with the main route.

 Cancels selection of all alternative routes.

 Provides preview of the operation result. After the first press preview is done on the main route

, after the next pressing – on alternative .

 Returns to the previous preview step.

 Deletes all routing components of a route - nodes, LCS, fragments.

 Allows you to create a new routing immediately after the creation of the current routing.

In the Properties window, you can specify parameters for the created element.

Pipe Style - one of the styles for filling routes can be selected from the drop-down list. The list stores

up to ten previously used styles.

Diameter – pipeline diameter is set here. Diameter should be in the range specified in the parameters

of the selected style.

Internal Diameter - when checked, the defined diameter is treated as internal.

Wall Thickness - allows you to specify thickness of the pipe wall.

Weld / length – this  field defines the gap between the components for welding.

Pipe bend. If library does not have appropriate fitting for rounding, then this option will bend the

pipe. When you bend pipe weld option is not taken into account.

Material of components. This list contains materials used in the current model.

Color of components. Color of shading for pipeline elements.

Green and red colors in the data fields show the possibility of correct usage of the entered value.
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Original route Route filled with style

Edit Pipe

The command can be called in one of the following ways:

Icon Ribbon

-

Keyboard Textual Menu

<3EPI> Edit > Operations > Pipe

This command is used for editing the Pipe operation.

Available options:

<Esc> Cancel selection
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<A> Select All Elements

<Z> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<X> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).



T-FLEX CAD 17 Help

2132

Welding

In T-FLEX CAD there is a group of commands intended for design of welded parts. Welding

commands are gathered in the Weld ribbon tab or Tools > Weld service toolbar. With the help of

these commands it is possible to create on a 2D drawing or a 3D model various types of standard

welded seams, and if necessary nonstandard ones. For created welded seams it is possible to

automatically create captions and make tables of welded seams.

Topics in this section:

· General Information

· Weld Window

· Weld Type

· Weld Annotation

· Weld Table

· 2D Weld

· 3D Weld

General Information

T-FLEX CAD allows us to create three types of elements intended for design of welded parts:

· welded seam types,

· welded seams,

· welded seam captions.

All these elements are interconnected. The structure of connections between them is displayed in the

tree of welded seams in the system’s service window Weld.

Welded seam type – a special element of T-FLEX CAD that itself stores characteristics (description,

name, regulatory norms, geometric parameters) of the welded seam used in the current document of

T-FLEX CAD. T-FLEX CAD document can contain several types of welded seams. 

Welded seam types created in the current document of T-FLEX CAD are common for 2D and 3D

welded seams.

Welded seams types required in the current document are determined by the user. To specify

characteristics of the welded seam types it is possible to use the standard database of welded joints

that is available in the system. If necessary, the user can specify arbitrary characteristics.

The types of welded seams created on the basis of welded joints of T-FLEX CAD are stored in

the current document of T-FLEX CAD. But the connection with the database is not stored. This

method of storage of welded seam types allows us not to worry about the presence of welding

database when transferring the document.

Specifying only the types of welded seams is not sufficient for design of welded parts. The types

determine which welded seams can be present in the current document of T-FLEX CAD, but they do

not specify the welded seams themselves. Using the welded seam types specified in the document, the

user has to create other elements of T-FLEX CAD – welded seams.

Welded seam – element of T-FLEX CAD that defines the welded joint existing in the given drawing (or

3D model). In T-FLEX CAD the welded seams are divided into 2D welded seams and 3D welded seams

depending on method of specification. 

This chapter describes only 2D welded seams, i.e., the seams that are not directly connected with

the elements of a 3D model. 
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When creating the welded seam, the user indicates to which of the types predetermined in the given

document the given seam refers. In doing so the basic characteristics of the created welded seam are

a number of individual parameters for a welded seam that are not defined in the corresponding type.

2D welded seam can be both free and associated with 2D drawing’s elements (graphic lines or paths).

Free seam is determined only by its type and, if necessary, by the individual parameters. It is not

associated with a 2D drawing, but it is present in the current document, displayed in a welded seams

tree and taken into account when making the welded seams table. The length of such a weld is

defined by the user.

If, when creating a 2D welded seam, we specify the elements of a drawing with which the seam must

be associated, then in the future these elements will be treated as the image of the given welded

seam on the 2D drawing. The length of such a welded seam can be either specified by the user or

automatically calculated by the system based on the length of 2D elements with which it is associated.

When creating a welded seam, the user must determine whether the welded seam being created

will be indicated on the drawing. If yes, then upon seam creation the user should indicate the

drawing’s elements which will be the image of the welded seam. Otherwise, it is sufficient to

create free, i.e., not associated with any drawing’s elements, welded seam.

Welded seam caption – a special element of the Leader Note type, which serves for designation of the

welded seam on the drawing. To create a welded seam caption, an additional command is used. It

constitutes an adapted version of the command for creating notes. Caption is automatically generated

on the basis of parameters of the indicated welded seam. If necessary, the user can edit parameters of

the note-caption of the welded seam. In the future created note-caption retains connection with the

parameters of the welded seam.

From welded seams created in the current document a table of welded seams can be created. Welded

seam table constitutes a text report about welded seams generated in the current document. The

contents of the welded seam table (available types of seams, number of seams of each type, the total

length of the seams of each type) are created automatically by the system. The table can be created in

the current document of T-FLEX CAD and also exported to the Excel document. If necessary, the user

can specify his own ways of creation of the welded seam table by creating corresponding macros.

Welds Window

Calling the command:

Icon Ribbon

Weld > Weld > Welds

View > Window > Tool Windows > Welds

Keyboard Textual Menu

<WW>,

<Shift>+<F8>

Tools > Weld > Welds

Customize > Tool Windows> Welds

All types of the welded seams specified in the current document of T-FLEX CAD, the welded seams

themselves and their captions are shown in the Welds tool window. 

In the given window the elements of welding (welded seam types, welded seams themselves and their

captions) are sorted by the types and are represented in the form of a tree. The welds tree allows us to

visualize intuitively all information on the welding’s elements created in the current document (in the

drawing or 3D model of a product).



T-FLEX CAD 17 Help

2134

The context menu invoked with the help of  when clicking on any point of the Welds window or

upon selection of any element in the given window contains various commands for creation and

editing of the welding’s elements.

Weld Type

Specifying the new type of the welded seam is carried out with the help of the special Weld Type

command. You can call this command from the Weld ribbon tab. In addition, the command to create

a new type of seam can be called directly from the command to create a weld.

In the additional fields on the right, you can specify:
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· Name

· Bead Pitch and Bead Length

Weld Annotation

Calling the command:

Icon Ribbon

Assembly > Assembly > Weld > Weld Symbol

Weld > Weld > Weld Symbol

Keyboard Textual Menu

<WN> Tools > Weld > Weld Symbol

After calling the command, the automenu and the properties window will become available, the

composition of the elements similar to the inscription creation command. There is an additional

option in the auto menu that allows you to select a weld in the drawing:

<R> Select Weld

To select a weld, move the cursor to the lines or 2D paths of the drawing with which the weld is

connected. When the weld is highlighted, you can select it by clicking . The text  symbol of the

selected weld will appear on the dynamic image of the symbol linked to the cursor. Next, the symbol

is attached to the drawing in the same way as a regular Leader Note.

Note that this way you can select only the welds associated with the drawing lines. 

Welds that are not connected to the drawing lines can only be selected in the Welds window.

You can also select such a weld using the Other item in the context menu, if you open the menu

in the 2D window in the command standby mode.

For ISO and ANSI standards, the weld symbols are set manually. To do this, in the properties window,

in the Type section, select the ISO or ANSI standard in the list.

All necessary label parameters are set in the Label Parameters dialog box. This dialog box is called by

clicking the  icon.
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For ANSI and ISO standards, dialog boxes that differ from each other will appear.

After confirming the entered values and specifying all the necessary parameters for the weld, a weld

symbol will be created in the drawing.

                    

The label parameters can also be set in the parameters dialog called by the automenu option:

<P> Set Leader Note Parameters

The parameters on the tabs of this dialog duplicate the parameters in the parameters window.
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The label parameters dialog can also be called in the command standby mode from the label

context menu (called by ). Due to this, it can be used to quickly change the parameters of

the label without calling the edit command.

T-FLEX CAD allows the user to enter their own weld symbols. Custom designations are created as

regular parametric fragments in the folder "...\T-FLEX Parametric CAD xx\Libraries\System\Welding

Symbols".

In the command parameters window there is an Additional section containing the following

parameters of the weld symbol:
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Drop-down list. Indicates on which side of the weld the symbol is set: On Front Side (the weld symbol

will be located on the shelf of the inscription) or On Back Side (the weld symbol will be located under

the label shelf).

                 

Show Full Specification. If this check box is enabled, then the full specification of the weld is indicated

on the specification. When the checkbox is disabled, an abbreviated specification is set containing the

number of the weld type and the individual parameters of this weld.

             

Show Weld Number. When this flag is set, the type number of this weld is set to the arrow of the

inscription-symbol. The parameter is available only when the Show Full Specification checkbox is

selected.

Show Number of Welds. This parameter is available only when the Show Weld Number checkbox is

selected. If it is set, the total number of welds of this type in the current document will be indicated

before the weld type number set to the label arrow.
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Hide Dimension. If this check box is enabled, the full weld specification does not display the size of

the weld cathet. When the checkbox is disabled, a full specification is set indicating the size of the

catheter.

Weld Table

Calling the command:

Icon Ribbon

Assembly > Assembly > Weld > Weld Table

Weld > Weld Table > Create

Keyboard Textual Menu

<WT> Tools > Weld > Weld Table

After this command is invoked, the dialog window appears in which the user has to choose the

method of creation of the table of welded seams. Initially two options are present:

Simple table of welded seams. Welded seam table is created on the first 2D page of the current

document. Approximate appearance of this table is shown on the figure below.

Export of welded seams into Microsoft Excel. Welded seam table is exported into the document of

Excel.
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Creation of welded seam table in both cases is carried out with the help of macros found in the folder

“…/T-FLEX CAD xx/Program/WeldReport”. If necessary, these macros can be modified independently

by defining inside them another type of a welded seams table. It is also possible to create user’s own

macros for creation of welded seams table and place them into the same folder. In this case in the

aforementioned dialog the additional options will be present that correspond to the user’s macros.

The work with macros is described in more detail in the Macros section.

2D Weld

Calling the command:

Icon Ribbon

Assembly > Assembly > Weld > Weld

Weld > Weld > 2D Weld

Keyboard Textual Menu

<WE> Tools > Weld > Weld

To create a welded seam, after invoking this command it is required to select the welded seam type in

the Weld section of the properties window. In the drop down list those types of welded seams which

were defined in the given document will be present. 

If the required welded seam type is not yet created, it is possible to use the Add button. When

pressing this button, the command of creation of the new welded seam type will be started. After

completion of the type creation the system will return to the command of welded seam creation.

Created seam type will automatically be selected.

If not a single welded seam type is defined in the current document at the moment of launching the

Weld command, the command of welded seam type creation will automatically be invoked. 

After selection of the type, it is possible to complete the seam creation. 2D welded seam not

associated with the drawing’s elements will be created. Its length by default is equal to zero. If

necessary, the length of the welded seam can be specified manually. To do so, it is required to enable

the Length flag and specify the desired length of the welded seam in the input field that appears to

the right.

To link the welded seam being created with the lines of a 2D drawing, it is required to indicate the

graphic lines or 2D paths in 2D window with the help of the options of automenu:

<I> Select graphic lines
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<P> Select paths

By default, both of these options are enabled. 

The elements selected in 2D window are added to the Elements list. To refuse selection of any

element, it is required to select it in the list with the help of   and press the Delete button.

By default the length of welded seam associated with the drawing’s elements is determined

automatically based on the length of selected lines or paths. If necessary, the length can also be

specified manually by enabling the flag Length.

In the sections Basic Parameters, Face Side Processing and Back Side Processing. it is possible to

specify individual parameters of the welded seam being created. 

In the Basic Parameters section the following parameters can be specified:

· Contour:

· No Contour;

· Open Contour;

· Weld all around;

· Assembly Weld: yes/no;

· Control Equipment.

In the Face Side Processing and Back Side Processing sections, the ways of processing the front and

back sides of the welded seam are specified. The Processing Type parameter found in each of these

sections allows us to select one of the following types of processing for each side of the welded seam:

No Processing, Face Reinforcement, Continuous. 
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To specify roughness of the front or back sides of the welded seam after machining, the Roughness

flag in the corresponding section of the properties window should be enabled. As a result the

Parameters button will become available to the right of the given flag. When pressing this button, the

roughness’s parameters dialog will open. After specifying the desired parameters and closing the

dialog, the image of the given roughness will appear in the preview field located below.

3D Weld

Calling the command:

Icon Ribbon

Assembly > Assembly > Weld > Weld

Weld > Weld > 3D Weld

Keyboard Textual Menu

<W3> Tools > Weld > Weld

The weld modeling commands of T-FLEX CAD allow creating welds not only in a 2D drawing, but also

within a 3D model. Welds appear in the 3D scene as special “cosmetic” bodies with a specific texture.

You can make an annotation for a 3D weld just like you do for a weld in a 2D drawing. The annotation

can be created directly in the 3D model (it will be a 3D leader note), or on a 2D projection of such

model.

When you create the table of welds on one of 2D pages of a given document, the 3D welds are

entered in it along with the 2D welds.

Basic Information about 3D Welds

A 3D weld can be created by various means. All methods of creating 3D welds can be classified in

groups:

· 3D welds created on faces of the 3D model;

· 3D welds created by guides:  By Path and By 3 Paths;

· 3D welds created on edges, 3D paths, 3D profiles, and operations;

· 3D welds created by already existing 3D welds.

For 3D welds created by edges and by guides a new “cosmetic” body is created in the 3D scene. These

welds do not influence the remaining part of the 3D model and are It is not entered in the 3D model

history. In the 3D model tree, a 3D weld body is put into a separate Welds folder. If a 3D weld is

created by other methods, the new body will not be created. The weld will be represented in the 3D

scene by the model elements on which it is based.
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The “WeldMaterial” material from the standard T-FLEX CAD materials library is used for the

weld body.

By using various methods of creating 3D welds in T-FLEX CAD, you can simulate various types of welds

in the 3D model.

   

For any 3D weld it is possible to specify to which weld type it belongs. The type determines all basic

characteristics of the weld (type of weld joint, structural elements, annotation). The type of the weld

does not depend on the way the weld was created.

The weld type is created as a separate model element. The weld types defined in the current

document are common across both the 2D and 3D welds. A detailed description of weld types is

available in the Weld Type section.

You do not have to specify the type of a 3D weld. Such a 3D weld would be called nonstandard. A

nonstandard 3D weld is not entered in the welds table. Besides that, nonstandard 3D welds are not

displayed in the welds tree of the Welds window. 

The nonstandard 3D welds can be used to decorate the 3D model. For example, suppose, the user

wants to draw a weld on the model simply to make it look more realistic, without an intention to

create weld documentation in the future. In such a case, it may not be justifiable to spend time on

creating a weld type. You can simply define a nonstandard 3D weld in the 3D model.

Please distinguish between the “nonstandard” 3D weld and a 3D weld created by the

nonstandard weld type, whose parameters were custom-defined by the user. The 3D weld of a

nonstandard type is entered in the welds table.

Methods of Creating 3D Welds

Creating 3D Welds on Faces

There are three methods to create a 3D weld on faces of the 3D model: 

· Creating a continuous fillet weld;

· Creating an intermittent fillet weld;

· Creating a butt weld.

In all such cases, the weld is created based on two sets of faces being welded. The sets define the

faces that must be “connected” by the weld. The number of faces in the sets doesn't have to match.

The selected faces must belong to one or two Bodies.

Continuous Fillet Weld

When creating a continuous fillet weld, you need to select two sets of faces being welded, the size of

weld and the contour type (flush, convex, concave). The result will be a weld between the surfaces of

the specified sets of faces, whose size will correspond to the defined size of weld.
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The size of weld is counted from the line of faces' intersection (see the figures). The weld contour

being created is specified as the maximum deviation of the curved face line of the weld being created

from the straight line. A positive deviation value means convexity of the weld, whereas negative – the

concavity. Zero value corresponds to the “Flush” contour.
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Intermittent Fillet Weld

An intermittent fillet weld is a kind of a fillet weld in which the continuity is broken by recurring

unwelded spaces. Therefore, it is generally created in the same way as a continuous fillet weld.

Additionally, you need to specify the length of weld and pitch. Please note that for some types of

welds, these parameters may be predefined by the type itself (if so required by the applicable

standards, such as GOST). In this case, the values defined for the weld, override the values prescribed

by this weld type.

              

Butt Weld

A butt weld connects the entire surface of the two sets of faces being welded. To ensure the correct

orientation of the butt weld, you need to additionally specify the top and bottom faces for each set of

faces being welded. Those define the required correspondence to construct the weld body. Specify

the top and bottom faces by picking ones among those having common edges with the faces being

welded.
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For example, when creating a butt weld between two pipes of the round section shape, you select the

outer cylindrical faces of both bodies as the top faces. The bottom faces in this case will be the inner

cylindrical faces. Or, you can do the opposite, as far as the outer face of one body matches with the

outer face of the other body, and so do the inner faces.

When creating a butt weld between two pipes with a noncircular section shape, select all outer faces

of both pipes as the top faces, and all inner faces - as the bottom faces. At the same time, if several

top faces are specified on each of the bodies, then the order of selecting faces on one body must

match the order of selecting faces on the other body. The same is true in the case of selecting several

bottom faces on each of the bodies.

When creating a butt weld between two plates, you select the top and bottom faces as the ones,

along which the weld will go. Please note that the top face on one plate must be on the same side as

the top face on the other plate. 

In the case of the butt weld, you can specify the contour type (flush, convex, concave) on either side of

the parts being welded (that is, on the sides of the top and bottom faces). The weld contour from

each sides of weld is specified as the maximum deviation of the curved face line of the weld from the

straight line. 
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Creating 3D Weld by Guides

Weld Created by One Guide

When creating the weld by one guide, the body of the weld is created by translation of the weld’s

profile along the arbitrary guide. The guide of the weld can be closed.

              

As a guide, the user can select edges, 3D paths, 3D profiles, etc. It is also possible to define the guide

by a group of 3D elements (edges, paths, etc.) on condition that all selected elements form a

continuous sequence.

The shape of the profile is selected from two options offered by the system: circle or isosceles

triangle. For the circular profile, the user defines the radius, for the triangular profile – the size of the

leg and the size of the angle between the legs.

For specifying precise orientation of the triangular profile, the user has to define direction of the

profile’s orientation and the angle of the profile’s rotation with respect to this direction. When

creating the weld, the vertex of the triangle is superposed with a point on the guide, and one of the

sides of the triangle is superposed with the given direction vector, and after that the profile is rotated

through a required angle.
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The length of the created weld is equal to the length of the guide. In cases where it is desirable to

create the weld longer than the guide, the user can specify the magnitude of extensions at the ends of

the guide. The body of the weld will be elongated along the tangent to the guide at its end points by

a specified extension length.

              

Weld Created by Three Guides

For creating the weld of this kind, three guides must be specified. The body of the weld, triangular in

cross-section, is formed in such a way that its lateral edges coincide with the guides.

For the guide, the user can select edges, 3D paths, 3D profiles, etc. It is also possible to define the

guides by a group of 3D elements (edges, paths, etc.) on condition that all selected elements of one

guide form a continuous sequence.

The length of the created weld is equal to the length of the first guide. In cases where it is desirable to

create the weld longer than the guide, the user can specify the magnitude of extensions at the ends of
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the guide. The body of the weld will be elongated (by a parallel shift of the end sections) by a

specified extension length.

For the weld by three guides it is possible to specify the contour type (flush, convex, concave) for the

side lying between the first and the second guides.

              

Creating 3D Welds on Edges, 3D Paths, 3D Profiles, and Operations

A 3D weld created on edges, 3D paths, 3D profiles, and operations, can be used in the cases when the

required appearance of the weld cannot be achieved by building it on the model faces. It serves to

indicate that some existing 3D model elements represent welds. The supply more information with the

created composite weld, you can specify, what parts it connects. Please note that such a 3D weld

cannot be nonstandard.

When the 3D weld is created, no additional “cosmetic” weld body is created in the 3D scene. You can

still “see” such a weld – as you select it in the welds window, the respective 3D objects will be

highlighted in the 3D scene.

If necessary, you can manually assign the “WeldMaterial” material to the body representing a 3D

weld.

A 3D weld created on edges, 3D paths, 3D profiles, and operations, is entered into the table of welds

along with other types of welds. The length of a composite weld is determined in the automatic

calculation mode as the sum of the perimeters or lengths of all 3D model elements that are involved

in it, except bodies (operations). The bodies that are involved in a composite weld, are not accounted

for when automatically calculating its length.

As an example, consider creating a flange-face weld. Suppose, we need to create a weld that connects

three parts (see the figure below). Neither the fillet nor the butt 3D weld is suitable in this case. We

will therefore create a 3D weld on two edges, and will additionally specify what bodies must be

connected by this weld.
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Creating 3D Welds by Existing 3D Welds

A 3D weld can be created based on a set of already existing 3D welds. Such a weld cannot be

nonstandard. Just like in the previous case, no additional body is created in the 3D scene when such a

3D weld is created. 

As an example of creating such a weld consider creating in T-FLEX CAD a two-sided Tee-weld. A Tee-

weld can be imitated by a pair of fillet welds. To make this pair of welds work as a single weld in the

future, you need to additionally join them into one weld. 

To add more information to the created composite weld, you can specify, what parts it connects.

The length of the composite weld in the automatic calculation mode is determined as the sum of all

3D welds that it includes. The properties of a composite weld created from a set of 3D welds are

determined by the type specified for this composite weld. The parameters of the source welds are

ignored. Please also note that the table of welds generally includes both the source 3D welds and the

resulting weld, which is based on them. To avoid duplicates, we recommend using nonstandard 3D

welds as the source welds. In this case, those will not be entered in the welds table.

Topic in this section:

· 3D Weld Creation
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3D Weld Creation

Calling the command:

Icon Ribbon

Assembly > Assembly > Weld > Weld

Weld > Weld > 3D Weld

Keyboard Textual Menu

<W3> Tools > Weld >3D Weld

To create a 3D weld, you need to:

1. Define type of the weld being created;

2. Select the method of creating the weld;

3. Select the source geometrical objects for the weld (depends on the weld creation method);

4. Define the weld length (if necessary);

5. Define additional weld parameters (the size of weld, the contour type or any other parameters

depending on the weld type);

6. Confirm the weld creation.

Selecting Type of 3D Weld

The type of the weld being created is selected in the command's properties window, in the “Weld

Type” drop-down list. The list contains all types of welds created in the current T-FLEX CAD document.

If the required weld type is not yet created, you can use the button Add. Clicking this button starts the

command of the new weld type creation. When the type is created, the system returns to the weld

creation command. The created weld type will be automatically selected.

If no weld types are defined in the current document at the time of starting the 3D Weld command,

then the weld type creation command will be launched automatically.

How to create a new weld type is described in the Weld Type section.

For T-FLEX Parametric CAD, only the Non-Standard option is available.

Selecting the Method of Creating a 3D Weld

You select a method of creating a 3D weld using the Weld Geometry drop-down list in the

command's parameters window.
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To create a 3D weld on model faces, you need to select one of the following entries in the list –

Continuous Fillet Weld (creation of a fillet weld), Intermittent Fillet Weld (creation of an intermittent

fillet weld), Butt Weld (creation of a butt weld). 

Welds by one guide or three guides can be created by selecting, from the list, the options By Path and

By 3 Paths, respectively. 

To create a 3D weld based on existing entities of the 3D model (except faces) you shall select the

option Compound Weld.

The Compound Weld option is not available in the list, if the Weld Type field specifies Non-

Standard.

Selecting the Source Geometrical Objects of a Weld. Advanced Weld Parameters

The source geometrical objects selection for the weld being created, as well as additional weld

parameters, depend on the method of creating this weld. Therefore, we will review different methods

of creating a 3D weld separately.

Welds on faces. Continuous and intermittent fillet welds

As you select the Continuous Fillet Weld or Intermittent Fillet Weld item in the list, the following

options become available in the command's automenu to select the two sets of faces being welded:

<1> Select Faces of First Set

<2> Select Faces of Second Set

The selected faces are entered in the lists Faces of First Set and Faces of Second Set. To remove some

face from a selected set, pick it in the respective list by clicking , and then click the button .

The size of leg and convexity can be defined using the same-name parameter in the properties

window. 

In the case of an intermittent fillet weld, you can additionally specify pitch and length of weld.
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Welds on faces. Butt Weld

The two sets of welded faces in the butt weld are selected using the same options  and , as in

the fillet welds. Additionally, there will be the options in the automenu to select the top and bottom

faces of the bodies being welded:

<T> Select Top Faces of First Set

<B> Select Bottom Faces of First Set

<Y> Select Top Faces of Second Set

<N> Select Bottom Faces of Second Set

The selected faces are entered in the lists Top 1, Top 2, Bottom 1, Bottom 2. To remove some face

from the selection, pick it in the respective list by clicking , and then click the button .

In the case of the butt weld, you can also specify Convexity on Face Side (that is, the contour type of

the weld on the side of the top faces) and Convexity on Back Side (the contour type of the weld on

the side of the bottom faces) in the parameters window.
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Weld by Created by Guide

For creating the weld by a guide, the user should select the option By Path found in the list Weld

Geometry. 

After that in the automenu the option for selecting the guide will be available:

<T> Select 1st Guide

The pull down list of this option contains the filters for selection of 3D objects – loops, edges, 3D

paths, 3D profiles, etc. The objects selected as the elements of the guide are put into the list Path 1 in

the command’s parameters window. To cancel selection of a 3D object, select it in the list with the

help of  and press the button .

If you want to cancel selection of the guide entirely, press the button  in the properties window or

use the following option of the automenu:

<D> Cancel Selection of 1st Guide

If the selected guide is not long enough, it is possible to increase the weld’s length by specifying the

magnitude of the extensions. This can be done with the help of parameters of the group Extensions

on End found in the command’s parameters window.

Parameters’ group found in the lower part of the section Weld of the parameters window allows the

user to select the type of the weld’s profile: Round (circle) or Triangular. When selecting the circular

profile it is necessary to indicate its radius.

For triangular profile you need to specify the length of the lateral side of the triangle (parameter Leg),

angle between the sides of the triangle (parameter Angle) and the angle of rotation with respect to

the direction of the profile orientation (parameter Rotation).
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The direction of the triangular profile orientation can be specified with the help of the following

option of the automenu:

<R> Select guide for defining profile orientation

To cancel selected direction, use the following option:

<U> Cancel selection of guide for defining profile orientation

 

Weld Created by Three Guides

For creating the weld by three guides, the user should select the option By Three Paths found in the

list Weld Geometry. After that in the automenu the following options for selecting the guides will be

available:
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<T> Select First Guide Curve

<D> Cancel Selection of First Guide Curve

<W> Select Second Guide Curve

<K> Cancel Selection of Second Guide Curve

<A> Select Third Guide Curve

<M> Cancel Selection of Third Guide Curve

Selected objects are put into the list Path 1, Path 2, Path 3 in the command’s parameters window.

The length of the created weld is equal to the length of the first guide. You can increase the length by

specifying the magnitude of extensions at the ends of the path with the help of the parameters of the

group Extensions on End.

In the dialog of the parameters window for the weld created by three guides, it is also possible to

specify the contour type of the weld (parameter Convexity).

Defining Weld Length

The method of calculating the weld length is determined by the state of the Length flag. When the

flag is off, the weld length is calculated by the system automatically. When the flag is enabled, the

length value is defined by the user in the input box next to the flag.
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Model Division and Simplification

To perform additional transformations on 3D models, there are commands Division into Bodies and

Model simplification. The Division into Bodies command is used to split objects that unite several

bodies into separate components. The Model simplification command is designed to remove

redundant edges or vertices from the specified operation body, as well as to simplify the geometric

base of faces and edges.

Topics in this section:

· Division into Bodies

· Model Simplification

Model Simplification

Calling the command:

Icon Ribbon

3D Model > Modify > Simplify

Assembly > Assembly > Simplify

Keyboard Textual Menu

<3SI> Operation > Model Composition > Simplify

The Simplify Model command serves for deleting extra edges or vertices from the specified operation

body, as well as for simplifying the geometrical base of faces and edges. The extra entities can occur

in the process of modeling, while performing certain operations. Presence of such elements in a

model is not an error; however, deleting those can be helpful in certain situations. This operation is

specifically intended for tackling problems in complicated cases, when extra edges or vertices

obstruct the target design (for example, in blend creation); additionally, this functionality can be used

for simplifying the contents of imported models. 

General Information

Deleting Extra Entities

When model is being simplified, only vertices or edges can be deleted. An extra vertex can usually be

excluded from the model when it belongs to a single closed edge (usually this would be an edge of a

surface of revolution) or belongs to two adjacent edges lying on one curve. An edge is usually deleted

if it is a part of an isolated open chain of edges within one face, or if it is an edge between two

adjacent faces lying on one surface.
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The operation allows selecting for processing vertices, edges, faces and operations. The admissible

entity types are processed as follows:

· a vertex will be deleted if it is identified as extra;

· if an edge is identified as extra, it will be deleted. If vertices of this edge are also identified as

extra, then those will be deleted along.

· upon selecting a face, any extra edges on it must be deleted. The extra vertices are then

deleted as well.

· if an operation is selected, all extra edges and vertices are subsequently deleted up until no

such are left.  If the operation's body contains spline faces or curves lying on one surface or

one curve, then those are merged to one face or one edge.

If the user selected an entity, which the system cannot exclude it from the model, it will be

ignored.

Simplifying Topology

Along with deleting extra topology, certain topological elements can be simplified. If spline edges or

faces lie on simple curves or analytical  surfaces (plane, cylinder, torus or sphere),  then the

geometrical base of those elements is substituted by simpler one. This functionality is identical to the

option «simplify geometry» that is available in certain operations (for example, Sweep or Loft).

As the input data for such processing, the user can select separate faces or a whole operation (as for

processing together).
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When simplifying a set of faces, when it is not possible to bring them to an analytical surface, i.e. a

plane, a cylinder, etc., the selected faces are replaced by one face with a smooth spline surface. This

simplification improves the surface quality. The resulting surface is less demanding on computer

resources.

Working with Command

This operation allows turning on each type of processing separately – either the model simplification

or deletion of extra elements – with the help of the appropriate flags in the properties window. A

specific list of entities to be processed can be composed for each type of processing. If a processing is

disabled then this type of processing is not performed and the entities list is inaccessible. 

For processing together, the user can select a whole operation (recommended). To select an

operation, you can use the automenu option:
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<O> Select Operation  

The name of the operation appears in the Operation field. The entities list for all types of processing

will remain empty in this case. If a list for processing is empty, that means the system will investigate

all topological elements of a given operation when performing the processing.

If the list of Simplify geometry processing is empty, the option Separately is accessible in the

properties window. Enabling this option activates a special mode that allows performing subsequent

simplification of a set of faces lying on one geometrical surface. Otherwise, simultaneous processing

of all faces is performed. For example, consider a set of faces lying on a geometrical spline surface

that is close to planar within a certain area. During the separate processing, the system would be able

to simplify the faces that happen to be within the «planar» area. In the simultaneous processing, the

system would not be able to simplify any face.

In certain cases, it might be possible for the user to do local changes to the model topology. The list

of entities for various processings are composed by the automenu options: 

<R> Select element to delete redundant

<G> Select face to simplify geometry

An entity can also be selected by placing the pointer in the list pane in the properties window. The

respective automenu option will turn on automatically. 

To cancel all elements selection use command:

<F> Cancel selection

The command also provides a useful feature for watching what model entities among the currently

selected are extra or simplifyable. The following automenu option is used for enabling such view:

<V> Show elements to be removed or simplified

While in this mode, the system will highlight all edges, their cases and faces of the selected operation

that can currently be subjected to processing. Deletable and simplifyable entities are highlighted in

different colors. 

The described mode is mostly useful for analyzing geometry of an operation as a whole. After

analyzing topology of the whole operation, the user would be able to use capabilities of local

processing with more confidence, if necessary at all.

In the operation parameters dialog, called by the  option, you can set common parameters of 3D

elements.
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Division into Bodies

Calling the command:

Icon Ribbon

3D Model > Advanced > Divide

Assembly > Assembly > Divide

Keyboard Textual Menu

<3SD> Operation > Model Composition > Divide into Solids

The command divides bodies, which consist of several physical parts, e.g. bodies resulting from:

· creating an array; 

· applying a boolean addition to bodies, which are not geometrically connected to each other;

· applying a split without separation. 

The command can also be used for dividing an imported model from other CAD systems consisting of

several bodies. Resulting bodies can be used in any other operations. 

The result of division is creating a separate body for each physical part of an original body. Operation

created by the Divide command is called Separation in the 3D model tree:
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Array before division

Array after division

Topics in this section:

· Create Division

· Edit Division



Model Division and Simplification

2163

Create Division

Upon calling the command, it is necessary to select an object of division in the 3D scene or in the

model tree using the following automenu option::

<F> Select Solid Body

Selected object is displayed in the Source Operation input box of the command parameters window.

Selected object can be Cleared  and re-selected using the button located in the right side of the

input box.

Upon selecting a source operation, resulting divided parts (  Reference Operation_? ) are

displayed in the Result list. Each part in the list has its own checkbox. All checkboxes are enabled by

default.  One of the following options can be selected in the Keep drop-down list, which is located

above the result list:

· Selected

Parts with enabled checkboxes are kept upon confirming the operation creation. Parts with

disabled checkboxes are deleted.

· All Excluding Selected

Parts with disabled checkboxes are kept upon confirming the operation creation. Parts with

enabled checkboxes are deleted.

If the dynamic preview is enabled, parts are highlighted in different colors in the 3D scene. The part,

which is currently selected in the list, is highlighted in red color (no matter if it is subjected to deletion

or not); parts to be kept are highlighted in yellow, parts to be deleted are highlighted in white.

See also:

· Common Parameters of 3D Elements
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Edit Division

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3ESD> Edit > Operations > Division

This command is used for editing Separation operations resulting from Divide command.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<R> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<Esc> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting).  Resetting the

element is exactly the same as the Divide command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).
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3D Assemblies

This section describes a technique for designing three-dimensional assembly models in the T-FLEX

CAD system. Various commands and operations can be used for the design of 3D assemblies. It also

describes in detail the rules for working with such system elements as 3D Fragments and Details.

Topics in this section:

· Create Assembly

· Mates and Degrees of Freedom

· Adaptive 3D Fragments

· Large Assembly Management Tools

· Updating Links

Creating 3D Assembly Models

What is three-dimensional assembly?

A three-dimensional assembly in T-FLEX CAD is a model that incorporates geometry of other 3D

models stored in separate files. An assembly component can be a 3D model created in T-FLEX CAD,

or a model from another system imported in T-FLEX CAD in one of the supported data exchange

formats. To be clear, the engineer may think of an assembly (by its definition) as a model built from

elements-operations within one document, rather than composed of separate part files. T-FLEX CAD

does support such functionality. However, we will not call such document an assembly, since it does

not refer to geometry taken from other documents.

An assembly document always maintains relations with assembly element (part) documents. As you

work with an assembly, the system constantly tracks the state of the involved files. In the event of

changes in an assembly component file, the system queries the user for updating the data. Each

updated component will be regenerated and reloaded into the assembly. An assembly cannot be

used without its components, while the each file involved in the assembly can be a fully independent

document and, in turn, be an assembly itself. The number of embedded levels of subassemblies is

unlimited in the system.

Use of parametric models

Any model in T-FLEX CAD can be built in such a way, that it can be modified by using external

variables. Using such a model as an assembly component brings significant benefits. This is

particularly effective, when such model is entered multiple times in one or several assemblies with
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different sets of external variable values. The same parametric part file can serve several assemblies at

once. Parametric components of the assembly can be managed from within the assembly document.

Creating BOMs

Each assembly component may contain data within for automatic creation of various kinds of reports

and Bills of Materials (BOMs). However, this chapter will not concentrate on creating BOMs. Detailed

information on this topic can be found in the Bill of Materials chapter.

Body intersection check

One of the typical tasks that require creation of an assembly is checking the model for assembling

compatibility, checking all bodies of the assembly against mutual penetrations. T-FLEX CAD provides

special tools for solving such tasks. You can start checking two selected bodies or all bodies in the

model for intersections, using such tools. You can also measure particular geometrical elements or

relations. For detailed information on this topic, refer to the chapter Model Geometry Analysis.

Assembly design techniques

There are two main techniques to creating an assembly distinguished by the way of creating their

components.

In many cases, it is convenient to take an already prepared model and insert it in the assembly by

defining its position in the assembly. This assembly design technique is conventionally called "bottom

up". In this framework, the components of a T-FLEX assembly are called 3D fragments. This approach

is convenient for designing complex assemblies or standardized mechanisms made to large extent of

standard parts. The inherent advantages of this approach are as follows.

· Designing parts in a separate file allows simplifying and subdividing the overall design

process of a complex product.

· The same 3D fragments are available for reuse in different assemblies and for including into

libraries of frequently used parametric 3D fragments.

· 3D fragments can be created with the provision for automatic positioning in the space based

on 2D fragments and the workplane (so-called "layout").
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Nevertheless, it is often easier and clearer to design a part once you have the idea about its position in

the assembly, and its size, based on geometrical elements of other parts in the assembly. We will call

this design technique "top-down", while the assembly components, whose geometrical base is within

that same assembly - Parts. An assembly model can be created "from scratch", as the engineer defines

the general layout of the assembly unit. In the next step, separate elements are identified and refined,

either in separate files or in the assembly context. This approach in some cases simplifies defining

element attachments to each other, providing parametric relations between those. Use of the "top-

down" technique sometimes allows avoiding use of external variables. The part parameters in this

case are defined by references. Changes at low levels of the hierarchy of the related parts trigger

automatic adjustment of all child parts in the assembly. Besides, the values of the original parameters

of the model can be derived directly from the assembly context, based on the reference elements. For

example, one can make holes in the cap based on the holes in the body. In this way, the engineer

deals with elements belonging to the fragments, while seeing the part surroundings and having access

to elements belonging to the assembly. This mode will further be referred to as working in the

assembly mode.

The inherent difference in the two approaches does not prohibit combining both when creating

assembly documents.

Topics in this section:

· Bottom-Up Assembly Design

· Top-down Assembly Design

· 3D Fragment Supplement

· Fragment Geometry Check

· Saving Geometry from Assembly to Separate File

· Moving Assemblies

· External Model

· 3D Picture

· 3D Placement

· 3D Layout

· Mechanism «Smart Fragment»

Bottom-Up Assembly Design

Assembly design based on the "Bottom-up" principle implies the creation of assemblies from 3D

fragments. At the same time, it is assumed that the main work on creating models of parts in separate

files has already been carried out and it remains only to include them in the assembly.

The command for inserting a 3D fragment is Insert 3D Fragment. The command is called as:

Icon Ribbon

Assembly > Assembly > Insert 3D Fragment

3D Model > Advanced > Insert 3D Fragment

Keyboard Textual Menu

<3F> Operation > Insert 3D Fragment

Rules for working with 3D fragments

To insert a 3D fragment into an assembly, you need to do the following steps:

1. Select 3D fragment.

The selection is done by one of the following ways:
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· insert a new 3D fragment by selecting a file;

· select an already inserted 2D fragment and use its three-dimensional model.

· if the symbol of the model file is dragged from the Windows Explorer or from the service

window of the T-FLEX CAD libraries to the 3D window, the 3D fragment insertion command

will be started automatically and the given file will be selected for insertion.

2. Select or Create Source LCS for the fragment. Selection can be done automatically if the 3D

fragment has exactly one or a specially designated LCS.

3. Select or create target coordinate system in the assembly.

4. Define the values of the fragment external parameters.

This step is skipped when using an existing 2D fragment or if the 3D fragment does not have external

variables.

The values of the variables can be set automatically upon attaching 3D fragment to the connector of

another 3D fragment.

5. Define fragment parameters (optional).

6. Finish input.

Topics in this section:

· Main Concepts

· 3D Fragment Selection

· 3D Fragment Attachment

· Transformations

· Creating Boolean Operation Based on 3D Fragment

· Work with 3D Fragment

· Edit 3D Fragment

· Parametric Fragment in Assembly

· Layout Creation

· Additional Features

· 3D Fragment Parameters

· Preparing a T-FLEX CAD Document for Use as a 3D Fragment

Main Concepts

Relation between assembly and 3D fragment file

There are two ways of selecting a 3D model file. The first is by explicitly selecting the model file. The

second way allows using the existing 2D fragments within the assembly drawing, that have the

respective 3D models. This is possible in the case when the 2D fragments were already used in the

current document, as, for instance, for initial creation of the drawing assembly.

The system always maintains the relation between the 3D fragment file and the assembly file. The

assembly file keeps, among each 3D fragment parameters, the reference to the 3D fragment file. T-

FLEX CAD automatically tracks changes in the 3D fragment files. If necessary, it reloads the 3D

fragment data into the assembly. To do this, the 3D fragment is searched using the store the reference.

The reference path to the fragment file can be full or relative. To provide greater system flexibility,

especially when porting models from one file system to another, we recommend using relative paths

for the references. When writing the relative paths, the assembly file and its location in the file system

are used as the guide. Another way of creating relative references relies on library configurations.

Fragment with variable reference

Just like in the case of using 2D fragments, a textual variable can be used as the reference path for 3D

fragments being assembled. The value of such variable is the path to the file of the currently used 3D

fragment. Depending on some conditions, this value can vary, becoming the reference to a different
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3D fragment file. This allows creating assemblies with changing elements. There is one limitation on

use of 3D fragments. All 3D fragments used in this scheme must have the original coordinate systems

with the same name or be defined in the world coordinates.

3D fragment attachment 

To insert a 3D fragment model in the assembly model, you need to decide on the attachment.

Attaching a 3D fragment means defining two coordinate systems – the source and the target one. One

of the systems belongs to the 3D fragment, while the other - to the assembly. The 3D fragments

geometry positioning is fully defined in the space upon placing the source coordinate system over the

target one. The source and the target coordinate systems are usually represented by assigning or

explicitly creating a Local Coordinate System (LCS) at the time of assembling the 3D fragment. If no

LCS is specified, then the World Coordinate System is used instead.
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1. Select edge of source fragment – create source LCS

1. Select edge of target fragment – create target LCS

In complicated cases, when fixing by coordinate systems cannot provide correct positioning of a

3D fragment, we recommend using Mates mechanism (see below the detailed description of the

Mates mechanism).

There is yet another way of defining the position of the 3D fragment based on the 2D fragment. This is

a technique called "layout". In this case, the 3D fragment orientation is done according to the 2D

fragment fixing vector. The fixing vector must reference a workplane. This results in two coordinate

systems. The source system is defined based on the fixing vector and its related workplane in the

fragment document. The target coordinate system will be defined based on the final position of the

fixing vector in the page of the assembly drawing and the selected workplane.
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The X-axis of the coordinate system coincides with the fixing vector and lies in the workplane. The Z-

axis is normal to the workplane. The Y-axis is the cross product of the two. In this way, no new LCS is

created for attachment. The three-dimensional data for the 3D fragment are loaded from the same

2D fragment file. This means, the 2D fragment is used for creating the plan (the drawing), while the 3D

fragment - for building the three-dimensional model. This technique is convenient in some special

design cases, when you need to place several three-dimensional objects on one level (plane). This can

be, for instance, the task of placing furniture in premises or equipment in a workshop. The three-

dimensional objects placing can be controlled in this case directly from the drawing by moving the

respective 2D fragments in the plan.

If the 2D fragment is created on a page without workplane, then the system will automatically

perform the transformation for carrying the X-axis over the page of the selected workplane.

Meanwhile, the fixing vector can be thought of as if carried over the page of the workplane with

the same coordinates in the page as it had in the original page of the document. Further

constructions are done as usual.

This capability can also be successfully used when creating common assembly drawings. The following

diagram shows a trivial model based on a two-dimensional assembly, whose fragments were attached

using the fixing vectors. No coordinate systems for attaching 3D fragments were created in the
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fragment files. Neither were target coordinate systems created in the assembly drawing. The model

was created by using the 3D layout technique. Try to realize the steps of building this model

independently, in order to check your understanding of this paragraph.

  

This drawing can be found in the folder "\Examples\3D Assemblies\3D Fragments\Assembly 3.grb".

Additional Transformations

Every 3D fragment can use Additional transformations as an auxiliary tool for making fragment

location more precise or, in some cases, even as an independent positioning type. These

transformations represent themselves translations along the coordinate axes of the insertion

coordinate system and rotations about these axes. The value of any additional transformation can be

defined via constants, variables or expressions as well as by snapping to geometric objects of a 3D

model.

3D fragment variables

Parametric relations of a 3D fragment are controlled by its external variables. When regenerating a

fragment, the required geometrical relations and data are loaded from the original file first, then the

values of the external variables are copied from those stored in the assembly for this fragment, and,

after that, the regeneration starts. Thus, the original file stays unchanged. The same assembly

document may have several instances of the same 3D fragment with unique sets of values of the

external variables. For example, the same bolt can be used in the assembly with different diameter

and length.

Using 3D connectors

3D connector is a special type of LCS which lets us automatically link external variables for jointed

parametric elements of assembled 3D models. Connectors significantly simplify parts positioning and

fitting of parameters upon design of the assemblies. When a 3D fragment is attached to a 3D

connector, the values of the variables are automatically transferred from the connector to the

fragment model, which is followed by model regeneration. Preliminary image of a 3D fragment

immediately takes the sizes corresponding to the values of the 3D connector variables.

For example, a nut М10 needs to be put on a bolt M10. When the bolt of size M10 is inserted into the

assembly, its connector automatically remembers this diameter. Upon insertion of the nut, a required

connector for attaching the nut is automatically chosen at the moment when the bolt elements are

being selected. For a variable taking over the nut diameter, instructions are given – ask the connector

the value of the variable. If the names coincide, the bolt connector passes the value М10 to the nut.

Thus, right after connector selection, location, parameters and image of the nut are brought in

accordance with the required bolt.

A user can create 3D connectors independently while preparing the 3D fragment model (See the Local

Coordinate Systems section). The elements of service libraries and standard parts, supplied with the

system (Fasteners, Holes etc.) already have embedded 3D connectors.
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Insertion rules, which remain active upon selection of the given connector in the assembly for

attaching the fragment, can be defined for a 3D connector. The insertion rule is a mandatory

additional way of defining fragment location by moving it along one of the coordinate axes or by

rotating it with respect to the axis (see the Additional Transformations above).

External geometrical parameters of a 3D fragment

External parameters of a 3D fragment can be not only external variables, but also geometrical

elements (a solid, 3D node, 3D path, 3D profile, workplane, LCS, vertex, edge, face, loop). Such 3D

fragment is called adaptive. Normally, such 3D fragments are most often used for direct modeling

(grooving, drilling nonstandard holes and similar elements), rather than for creating assemblies;

therefore, all information related to handling adaptive 3D fragments is separated into a dedicated

section in this book (see the Adaptive 3D fragments chapter).

Using 2D-fragment as «projection» for 3D fragment

It is possible to insert 2D fragments that present projection of corresponding 3D fragment. This

mechanism of operating with assemblies is useful when designing plans to deploy industrial

equipment. It helps you to create drawings of floor plans, plans of rooms, etc.



T-FLEX CAD 17 Help

2174

To use a 2D fragment as a projection of a 3D fragment, you should first select the workplane of the

drawing on which the 2D fragment will be located. This workplane will help to position it correctly in

the assembly. Then you need to select the 3D fragment that will be used as the source of the new 2D

fragment. The next step is to determine the type of 2D fragment. This can be done in the Fragment

command dialog box, where you can select the projection type or vector associated with a pre-

created 2D drawing. The vector must correspond to the workplane selected at the very beginning. The

drawing will be transferred to the selected workplane. As a result, a 2D fragment corresponding to the

original 3D fragment will be obtained. The position of both fragments will change when the position

of either of them changes.

For a detailed description of using 2D fragment as «projection» for 3D fragment, see Inserting

Fragments into a Drawing in the 2D Assembly Drawings chapter.

Relation between 2D and 3D fragments.

When inserting a new three-dimensional fragment, the system always creates the respective 2D

fragment referencing the same file. There is always an inherent relation between the 2D and 3D

fragments. Both fragments use the same data related to variable values, as well as some settings – the

file name, the way of including in a BOM, the status settings. Usually, the 2D fragment is not necessary

when creating a 3D assembly model; therefore, the system hides it by default. The 2D fragment can be

selected only by using the dedicated command for editing 2D fragments. Using this command may be

convenient, for example, when you need to modify a bulk of references to fragment files, since the

command provides convenient tools for simultaneous management of lists of the fragments. A 3D

fragment document may contain the two-dimensional drawing along with the three-dimensional

geometry. This drawing can be used for automatic creation of the assembly drawing, by following

certain rules. In this way, the image of each 2D fragment will be put in the first page of the assembly

document with the same page coordinates as those of the image in the original file.
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3D Fragment Selection

3D fragment can be selected with the help of the option:

<F> Select File

In this case, the fragment is selected in the standard dialog box to open the file. The fragment file can

be selected from the specified folder on the disk, or from the library.

In the options  drop-down list, you can select one of the options for the source of 3D fragments

and use the list of previous files:

In the transparent mode the following option is available:

<A> Select 2D Fragment

At this moment it is enough to select existing 3D fragment or a file from a library opened in the

Library Explorer, and the system chooses an indicated element for insertion as the new 3D fragment.

Upon selection of an existing 2D fragment in a 2D window the system will use its three-dimensional

model. 

After insertion of a 3D fragment, the path to its file will be stored in the operation properties. The

path can be complete relative to the file of the assembly or relative to the library being used.

In some cases, the system may automatically record the relative path to a reference with respect to the

assembly file. Detailed information on the format of the relative links (references) can be found in the

chapter 2D Fragments.

3D Fragment Attachment

Selection/creation of the source coordinate system 

The automatic sequence of the system steps for attaching a 3D fragment depends on whether

predefined local coordinate systems existed in the 3D fragment model, and, if so, how many:

· If there is exactly one LCS in the 3D fragment model, and its properties state that it can be

used for attaching the 3D fragment, it will be automatically selected by the system as the

source coordinates. The system will then proceed to the next step - defining the target

coordinate system. If there are more than one LCS in the 3D fragment document, but only one

of them is specifically designated as the source coordinates, the system behavior will be the

same. (Refer to the topic Preparing document for use as 3D fragment for details.)

· If a 3D fragment model contains several LCS all suitable for fixing the 3D fragment, then T-

FLEX CAD picks up the default fixing (by the global coordinate system) and proceeds to
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defining the target coordinate system. To select a coordinate system, you need to switch to

the special mode of selecting/creating the source coordinate system.

· If no local coordinate systems exist in the 3D fragment model, then T-FLEX CAD picks the

default fixing (by the global coordinate system) and proceeds to defining the target

coordinate system. To create a new source coordinate system, you need to switch to the

special mode of selecting/creating the source coordinate system.

Mode of selecting/creating source coordinate system 

Those type is operated in a separate 3D window, in which the 3D fragment model is loaded. This 3D

window is launched forced from the 3D fragment creation command by the option:

<S> Select or Create Source LCS

After opening the new window, in addition to standard options, the following options can be initially

found in the automenu:

<1> Select 3D node or vertex as LCS origin

<2> Select point to Define Direction of X-axis

<3> Select point to Define Direction of Y-axis

<C> Reset target LCS

<A> Rotate LCS around X-axis by 90°

<O> Rotate LCS around Y-axis by 90°

<Z> Rotate LCS around Z-axis by 90°

<9> Change LCS axes orientation

The option  remains active, indicating that the system is in a special mode of operation with the

source coordinate system. Selecting the option  returns the user to the assembly and enables the

task mode of the target LCS. This option is intended for switching to actions for setting the geometric

parameters of an adaptive fragment (for a detailed description, see Adaptive 3D fragments).

When the option  is running, the selection of an existing LSC is carried out in a 3D window or from

a list in the properties window.
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The system allows creating a new LCS based on the 3D fragment's geometry.  To activate the mode of

creating new source LCS, the first element for determining the origin of the coordinate system has to

be selected in a 3D model. At the same time, it is possible to select any appropriate elements of the

model in accordance with the active filters of the selector on the system toolbar. After choosing the

origin of the new source LCS, the remaining options for defining LCS will appear in the automenu.

Creation of the coordinate system is carried out by the same principles as in the specialized command

for creating LCS. Similar options and tools are used in both cases. The center and direction of the LCS

axes are prescribed. In addition, the options for cyclical rotation and rotation of axes by 90 degrees

are available. In this chapter we will omit detailed description of the LCS creation process.

When creating a new LCS, keep in mind that it is not created in the 3D fragment file. Rather, it

belongs to the current 3D fragment operation and is stored in the assembly document. The

created source coordinate system cannot be displayed in the assembly. To modify it, you need

to call the 3D fragment editing command and enter the mode of selecting/creating the source

LCS. 

When the new source LCS is being created, the new line Fixing by Fragment will appear in the Source

LCS list for the fragment.

To exit the mode of selecting/creating the source LCS, use the button . 
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Selection/creation of the target coordinate system 

The mode of selecting or creating the target coordinate system is turned on by the automenu option:

<T> Select or create target LCS

In most cases this option is activated automatically after choosing the fragment file and after exiting

the mode of creating the source LCS. If a suitable LCS is found in the assembly model then the user

actions amount to selecting the LCS in the assembly, to which the fragment source coordinate system

should be snapped. If no LCS is selected in the assembly, then the assembly world coordinates will be

used as the target coordinate system. 

One can also create a new target coordinate system based on 3D model elements. The target

coordinate system is constructed using the same tools as those for constructing the source one. The

main difference is in that the all actions are performed in the main 3D window for the current

assembly. The 3D fragment model is positioned in the space according to the properties of the target

coordinate system being defined. 

The options for defining elements of the new target coordinate system appear after selecting the

origin point of the LCS. Upon selecting the origin, you can proceed with orienting X and Y axes.

In case you couldn't orient the LCS as desired from the beginning, you can use the tools for coordinate

system redefinition. Those allow quickly rotating an existing LCS around its axes by 90 degrees ( ,

, ), cyclically reassign the axes of the coordinate system with the fixed origin (pressing 

switches the axes assignment).

 

  

Fragment position in

absolute coordinates 

Fragment position after selecting an

edge for target LCS

Fragment position after

using the tool of rotating

X-axis by 90°.

To reset all data currently used for defining the target coordinate system, use the automenu option:
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<C> Reset target LCS

Choosing 3D connectors

3D connector can be chosen in the mode of selecting or creating target coordinate system activated

automatically right after entering the fragment insertion command (option ). In this mode it is

necessary to make sure that the selector's filter for choosing connectors  is activated on the system

toolbar.

For searching connector on some part, bring the cursor to one of the elements associated with the

connector. In standard elements, for example, in bolts, the screw-threaded faces of the bolt shaft can

be chosen as an associated element. Already upon bringing the cursor to such element, the connector

is highlighted. Press  for choosing connector.

Transformations

Controlling additional transformations is carried out with the help of a manipulator in the 3D window

and group Transformations of the properties window and the Group of Transformations dialog of

the Main transformations section of the properties window. The manipulator is always present upon

insertion of a 3D fragment, if the option Use Variable Manipulators is turned on in the properties

window.

The manipulator enables to define an unlimited number of translational transformations along the

indicated axes in-plane shifts or rotations of selected axes by a required angle in the required plane.

The manipulator represents itself an image of the coordinate system. The coordinate axes are

connected to each other by color arcs; adjacent planes are connected with each other via conditional

small color squares, the manipulator center is marked by a grey ball. Different parts of the

manipulator are the active elements intended for defining certain transformations:

· the manipulator axes are intended for defining translations;

· the manipulator arcs are used for defining rotations;

· the manipulator center is used to manually enter the mode of dynamic snapping.

See the detailed description of manipulators in the LCS Manipulators for Transformations of 3D

Elements section.

For defining transformation with the help of the manipulator a user has to choose an active element

of the manipulator by pressing . Then, without releasing the mouse button a user can move the

cursor. The transformation will have been set upon releasing the mouse button.
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1. Begin with inserting a fragment (the minutes arm) by

selecting the edge on the arm pin to define the target

LCS (of the arm fragment position)

2. Turn the arm. To do this, select the desired element of

the manipulator and depress the left mouse button

3. Drag the mouse whilst holding the mouse button

down. Turn the fragment about the axis

4. Complete the transformation definition by releasing

the mouse button

Also, after manipulators selection it is possible to release the mouse button, shift the cursor and

choose a new element (indicate a new point in space) for fixing transformation by pressing  twice.
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1. Start inserting the fragment (the bearing)

2. Select the round edge to define the target coordinate

system (the fragment's position)

3. Click to select the manipulators axis to define the

translation along the axis

4. Select the round edge to define the final point of the

translation

Click at manipulator center signifies transition to operations for modifying the target coordinate

system. Simultaneously, the mode of dynamic snapping gets activated. In this mode, the fragment

image is attached to the cursor. Upon bringing the cursor to the elements of the model, the fragment

image will be immediately put in a position showing the location of the fragment in case the element

is selected. In this mode it is possible to click at the free spot in space or choose an element of the

model for attaching. In the first case, new additional transformations for placing the fragment at the

spot of a click are created. After choosing the new element of the model for attaching, all previously

defined transformations may be deleted.

Group Transformations in the properties window can be used for controlling, correcting numerical

values, creating or deleting transformations of a 3D fragment. In the special field the list of all

additional transformations, defined at the moment for a 3D fragment, is shown. Each transformation is

marked by a special symbol, denoting its type (translation or rotation about some axis). If the value of

the transformation is set via a constant, then this value is shown next to the symbol. If the

transformation was attached to the element of the model, then the name of the element is indicated

next to the symbol. The elements of the list  are shown in the order in which there were created.

Several successive transformations of similar type are automatically summed up.
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The user has also a capability of creating individual transformations groups for 3D fragments.

Classifying transformations into groups allows the user to create simultaneously several variants for

the 3D fragment locations in the assembly.

For example, let us suppose there is a variant of the room’s 3D layout. It is required that the fragment

(barrel) change its location depending on the location of walls and addition of new objects to the

layout.

 

To do so, in the properties window of the 3D fragment (barrel) in the Main Transformations section

we find the Groups of Transformations dialog. With the help of the  button we add the

transformations group, namely we specify the values for translations along the X and Y axes and

rotation around the Z-axis.

It is important to remember that by default all transformations for a 3D fragment are created in

a single transformations group.
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Each transformations group has it name. The elements of the list are shown in the order that

correspond to their creation.

To control visibility of various locations of the fragment there is the Suppress flag. Next to the flag

there is a field where the numbers can be entered or the numeric variables can be written down. If the

value different from zero is entered into the field, the transformations group becomes suppressed. To

make the work in the assembly more convenient let us specify the visibility of the fragment’s locations

with the help of the variable.

After specifying several positions of the fragment (barrel) with the help of the transformations group

we obtained the capability of manipulation of its translation in the easiest and fastest way.

In this case for displaying the changes in the transformations in the 3D window it is required to use the

3D model update button .

Upon attaching a fragment to the connector, the system can automatically move to defining

additional transformation, if the corresponding instructions are set in the connector (see Local

Coordinate Systems section).

After insertion 3D fragment all prescribed additional transformations are recorded in the common

transformations list of the 3D fragment. A separate record is generated for each additional

transformation  in the transformations list of the 3D fragment.
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For more information about transformation 3D elements, see Transformations of 3D Elements

section.

Creating Boolean Operation Based on 3D Fragment

Just like other operations, 3D fragments can be used in Boolean operations. For example, you can

subtract the body of a 3D fragment from another part. If necessary, you can define a property in the

3D fragment document, that will specify what type of the Boolean operation will be automatically

performed upon inserting this document into an assembly (see the Preparing document for use as 3D

fragment section). If such property is defined, then, upon inserting the 3D fragment, you need to select

one of the bodies in the assembly. If the assembly consists of a single body, it is selected

automatically. This body will be used as the target body in the Boolean operation. The tool body will

be one of the bodies of the 3D fragment, or the fragment altogether, depending on the property

setting. 

The option can be useful, for example, when inserting holes into the body of a part, or in mold design,

when subtracting the part body from the block yields the stamp or master form.

The following options are used for selecting the target body of the Boolean and for undoing the

selection:

<B> Select solid to create Boolean

<D> Cancel selection of solid for Boolean creation

Work with 3D Fragment

In the course of working with an assembly, you may need to access auxiliary information about the

state of 3D fragments. This can be querying their position in the assembly tree, reviewing existing

errors, etc. Various tools are provided for this purpose. We will review those tools within the current

topic.

3D fragments and Parts are displayed in the 3D Model window. This window shows the complete

hierarchy of the assembly model. It allows finding the place of each 3D fragment in the model

structure among other 3D operations and construction elements. 3D fragments can be displayed at

the root of the model structure, along with Bodies and Arrays.
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If a 3D fragment is an assembly itself, containing embedded 3D fragments, the structure of all its

embedded elements is reflected in the general 3D model tree as well. For embedded fragments of

any level the commands of editing external variables and creation of detail drawing are available in

the context menu. 

To ensure the full support of handling the embedded 3D fragments, you need to bring into the editing

environment the subassembly that hosts the fragment of interest.  

Embedded fragments can also be selected directly in the 3D scene. The special  Select

embedded subassemblies by bodies mode of selection allows to select separate bodies of

sublassemblies' fragments. You can open fragment's document, start detailing or editing

variables of a selected fragment.

In the 3D Model window for 3D fragments, besides the name of the file and the operation, various

additional information can be shown, if needed, – file path, identifier, memory size allocated for

mesh, memory usage for geometry, recalculation time, the name and notation for specification. The

amount of displayed information can be set in the dialog box of the Appearance command. This

command can be called from the context menu by pressing   in the 3D Model window.
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If errors are detected in the model, the affected elements are marked in the model tree with the

special symbols:

1. If an error was detected within a 3D fragment model or its coordinate systems, a mark is displayed.

2. The 3D fragments, whose files were not found by the specified reference, are marked by a red

cross. 

3. The suppressed 3D fragments are marked by a blue cross. 

When suppressing fragments or an array/copies/symmetries of fragments in the 3D model tree,

suppression immediately extends to all reference elements, raised objects and created

fragments.

Detailed information about all errors is displayed in the Diagnostics window. Right clicking  over a

message brings up the context menu. If the message refers to a 3D fragment of the first level, then you

have access to all commands for handling that 3D fragment. If the message reports an error within

embedded fragments, then the only command for handling the fragment is Show Fragment

Structure.
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The fragment, within which the error was identified, is automatically highlighted, showing the branch

of the assembly tree that includes the failing fragment. 

The right pane of the window displays the information about variables used in the fragment: their

names, values and comments. To fix the error in the fragment file, you can open the file by pressing

the Open button. For example, the error in the fragment model can be caused by an invalid variable

value. To open the fragment with the current variable values use the Detail button.

Normally, the assembly tree displays only its contributing 3D fragments. To view the full assembly

structure, use the Assembly Structure window.

Reference update 

Let us explain the use of the option Update fragment data.

When inserting a 3D fragment, the system internally creates a copy of the fragment three-dimensional

model in the assembly drawing. Upon a new regeneration of the assembly, the system no longer loads

the 3D fragment geometry data; rather, it uses the saved data. To maintain the assembly up to date,

the system constantly tracks the file. The latter changes if the fragment file was edited and saved. If

files changed, the system instantly offers updating the references to the documents, that is, loading

new geometry data of the modified 3D fragments.
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Pressing the Yes button refreshes the data of all modified fragments. If the assembly contains a

significant number of fragments, the updating procedure may take significant time, even though only

one fragment actually required update. Therefore, you can press the No button instead, and then

select a specific fragment and refresh only its respective data.

Local update of a selected 3D fragment is possible with the Update command of the context menu

coming up upon right clicking  over the 3D fragment operation.

Updating of all modified fragments can be forced by the Move Assembly > Update Links command

in the Assembly ribbon tab, Component Links group.

However, if some of the 3D fragment files were not modified, then the 3D fragments are regenerated

neither upon the full regeneration nor upon refreshing the 3D fragment references. To guarantee the

regeneration of the full assembly with all its member 3D fragments, use the file converter with the

parameter set, Don't Check Documents Versions (Resave All).
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Edit 3D Fragment

Calling the command:

Icon Ribbon

-

Keyboard Textual menu

<3EF> Edit > Operation > 3D Fragment

This command is used for editing 3D fragments. Note that you can call the command using the

right mouse button. When the system is in command standby mode, point the mouse cursor at

the 3D fragment element and click it.
Available option:

<A> Select All Elements

<R> Select an item by name

<I> Select another nearest item

<P> Set Elements parameters

<F4>
Edit the element (if you select this option, you can re-set the elements that

define the operation-the Bottom-Up Assembly command).

<R> Изменить способ задания

<Del> Delete an element (a group of elements). 

<Esc> to Exit the command.

<M> Conversion (calling the Transformation command)

You can delete an element, edit its parameters (using either the dialog box or the system toolbar),

select another nearby element, or proceed with editing (reassigning).

If you select multiple items, you can delete them. Note that the <Shift>  combination can be

used for multiple selection (the <Ctrl>  combination cancels the selection).

Parametric Fragment in Assembly

Upon selecting the file, the properties window is filled with parameters of the 3D fragment. One of its

groups deals with external variables. The external variables can be displayed as a list – just as in the

variable editor. If a custom dialog was created for managing external variables, it will be

automatically built in the 3D fragment properties window. If necessary, you can switch between the

two modes of displaying the external variables. This is done by toggling the List of Variables flagin

the properties window.
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The information about external variables is displayed as long as the 3D fragment creation command

is active. You can modify at any time the values copied from the fragment file. To update the 3D

window for the changes in the properties window, use the provided button .

If you find it inconvenient to modify the values of the external variables in the property window (as,

for instance, because of the large size of the custom dialog), you can put the group of variables into a

separate window and enter changes there. Calling the separate window is done by using a special

button at the upper right corner of the group.

If the 3D fragment model does not have any external variables, then, upon executing the 3D

fragment insertion command, no tools are displayed for managing external variables.

When a 3D fragment is attached to a connector, the values of the fragment variables can be assigned

automatically (see the Using 3D Connectors section).

Parametric relation definition

Defining relations between parts is the main task for designing parametric assemblies. It demands

from the engineer understanding of the T-FLEX CAD tools for maintaining such relations. The first tool

that you need to master is the variable editor. The variable editor itself or similar environment is used

by the system in multiple occasions, as, for instance, when defining the values of the fragment external

variables. Working with the editor, variables, functions and such is described in the Variables chapter.

Here, let's review a simple showcase for relating part parameters in order to control them from the

assembly model. Here we will skip the description of the steps that are not related to the parametric

assembly creation (the description of creating part files, attachment, etc.).

Consider the task – to create a switchboard that includes the mounting plate and a set of switches. The

switches can be of two types. The types of the switches differ in some dimensions, however, can be

composed from the same parametric parts. The switch lever must snap to two positions "On/Off". The

switch itself is made of the following separate parts - the body, the pin and the lever. These parts are

parametric, as they rely on the necessary external variables. By using those we can create a parametric
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model of the switch, whose external parameters define the switch type and the lever position. We

need to create a switchboard assembly by using this parametric model of the switch.

The upper illustration on the left shows the details of the switch. To the left of each part is a table of

external variables of each part. These tables are taken from the dialog for setting external variables

when inserting each 3D fragment. It can be seen that the corresponding assembly variables were

substituted as the values of the external variables of the fragments (at this stage this is the switch file).

The assembly model of the switch is shown in the right part of the upper illustration. The lower

illustration shows variables from the variable editor. You can see on the diagram how the switch

parameters are managed: the variables <R> and <h> change depending on the variable <Type>

value that defines the switch type. The former two define geometrical characteristics of the

contributing parts. The variable <a> is responsible for the lever position and defines the model

property "On/Off". The external variable <r> will relay the pin radius value to the next assembly.
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The next step is building the assembly (the switchboard) from the created parametric model of the

switch. The left-hand side diagram shows the model of the switch and the two tables of its external

variables with different values assigned when composing the assemblies. You can see from the

diagram, that the variables <Type> and <a> are assigned numerical values, while the variable <r> is

related, instead of a value, to the variable <r> of the assembly. This is how the parametric assembly is

built. The variable editor of the switchboard provides control over the value of the switch pin radius. 
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Other switch parameters are left fixed. To modify those in the future, you could call the command for

editing 3D fragment variables. 

When connectors are used, parametric relations between two parts can be established directly,

skipping the step of creating the common variable in the assembly. At the same time, the

variables of the new part, attached to the connector of another part already inserted into the

assembly, will depend only on the values of the first part's variables (see the Using 3D

Connectors section).

Layout Creation

To create a 3D fragment using the layout technique, use the following option in the main automenu of

the 3D fragment insertion command:

<G> Create 3D Fragments by Workplane (Layout)

Upon calling this option, the mode of selecting 2D fragments is activated, as indicated by the glyph

attached to the pointer and the pushed icon in the automenu. Now, you need to select a 2D fragment

or a set of 2D fragments to use for creating the 3D layout. 

Upon selecting 2D fragments, specify the workplane on which the 3D fragments will be placed. The

workplane for the 3D fragment orientation can be defined anew, regardless of the workplane that was

hosting the 2D fragment. The workplane selection is done by the option:

<W> Select Workplane to set view direction of projection

The selection can be done either in the 2D or in the 3D window, provided, that the display of the

workplane in the 3D window is turned on.

Upon confirming the selection by pressing , the 3D layout will be displayed in the 3D scene,

created based on the 2D fragments.

Operation errors

If errors occur when creating a layout, for example, if the vector of the 2D fragment was not

associated with the workplane, the system positions the 3D fragment in the absolute coordinates

without a possibility for attaching to an LCS until the fixing vector is associated with the workplane in
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the fragment document. Besides, a warning is displayed, "Can not find associative Workplane in

Fragment document".

There is a capability of controlling location of the 3D fragment directly in the 3D window domain. To

change location of the 3D fragment in the 3D window domain it is required to use the option in the

automenu of the 3D fragment insertion command:

<L> Layout mode

When the layout mode is enabled only the axes of the workplane are displayed on the manipulator.

All transformations with 3D will automatically be transferred onto the 2D drawing after pressing .

Transformations with translation of 3D fragments are displayed on 2D only with the layout mode

enabled.

The layout mode is used only for 3D fragments with fixing vector.

For the 3D fragments for which a 2D fragment has a fixing vector, when choosing the source

coordinate system there is an option of fixing by the workplane.

Orientation of the source coordinate system of the fragment snapped to the workplane coincides with

the orientation of the fixing vector on 2D.

For more information about the layout, see 3D Layout section.

Additional Features

Fragment updating

<Q> Update 3D fragment automatically in case of changed parameters

If option is set, a fragment will be automatically updated when its variables or adaptive parameters

are changed.

Also you can update fragment manually by pressing Update button in the upper part of the

Parameters window.

Adaptive fragments parameters

<R> Show geometric parameters of adaptive fragments 

This option is intended for switching to actions for setting the geometric parameters of an adaptive

fragment (for a detailed description, see Adaptive 3D Fragments).
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3D Fragment Parameters

Detailed setting of many parameters for a 3D fragment can be accomplished at any moment in the

parameters dialog box. It is called with the help of the option of the command for creating and

editing the fragment, and, also, from the context menu by selecting operation: 

<P> Set entity parameters

The dialog contains four tabs.

Common tab

The Common tab contains the common parameters for all 3D elements.

Operation tab

Configuration. If there are configurations in the fragment document, then this parameter allows you

to select from the list of configurations the one that will be used for this part. By default, the value is

set to Without Configuration. For parts created in the context of an assembly, this option is not

available.
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Use Parameters of defines the source of the fragment parameters specified in the Set Document

Parameters command.

· Fragment. The fragment parameters will be taken from the fragment file.

· Current Drawing. The fragment parameters will be taken from the current document file.

Use as. This parameter can take one of the two values: One Solid or Separate Solids. With the value

Separate Solids used, the additional operation Divide is applied for dividing the fragment into the

separate bodies. This is necessary in the cases when the 3D fragment itself is made of several bodies,

while just one of them should be used, for instance, in a boolean operation with another assembly

element. It will be impossible to select a particular body of the 3D fragment without dividing into

separate bodies. Instead, you will be always getting the whole operation 3D Fragment selected as

one object. The operation Divide can also be done manually after inserting the 3D fragment, with the

same result.

Include in new Product Composition. In the field, you can set the conditions for including a fragment

in the product composition. The parameter controls the entry of information about the fragment into

the assembly product. It can take the following values:

· Don't Include - the fragment is not included in the product composition.

· Without Embedded Elements - the fragment is entered into the product composition. If the

fragment is an assembly unit, then only information about the fragment is entered into the

product composition. Information about embedded elements (lower-level fragments) is not

entered.

· With Embedded Elements - the fragment is entered into the product composition together

with the embedded elements.

· Embedded Elements Only - only embedded elements are entered into the product

composition.

If the method of inclusion in the product composition was not specified when applying the fragment,

or it is necessary to establish a connection with the specific composition of the assembly drawing for

the fragment, then the dialog box for the parameters of this fragment can be called after the

fragment has been inserted into the assembly.

To do this, click the Include in Product Composition button, which displays a window with a list of

existing product compositions in the current document and the parameters for including a fragment in

each of them.
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If necessary, you can select any product composition from the list and change the value of the

parameter responsible for the inclusion of the fragment. When the Assign Product Composition name

flag is set, you can select the fragment product composition, the data from which will be included in

the assembly product.

You can also specify how to include this fragment in the assembly using the Include in Product

Composition command.

Use only in 3D. This flag allows turning off the display of the two-dimensional representation of the

fragment in the 2D view window. By default, the checkbox is enabled. If you disable the checkbox, a

2D fragment will be displayed in the model tree.

This 2D fragment will not be visible until the fragment editing command is called. After calling the

command, the system will warn that a 2D window will be opened and switch to editing mode. Further

actions are performed according to the description given in the  Inserting Fragments into a Drawing

section.

Use fragment mates. When a different assembly unit, in which the mates have been created and the

degrees of freedom have already been defined, is inserted into the assembly, there is a possibility to

transfer the entire mechanism into the new assembly by using only operation of insertion of a 3D

fragment. To insert such fragment-mechanism into the assembly, the option of using the fragment As

Separated Bodies and the option Use fragment mates have to be turned on simultaneously.
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Autosave. When changing the values of external variables of the fragment in the assembly the

fragment’s file is resaved according to the new values. The fragment’s file is updated at the moment

of saving the assembly file. This flag can be conveniently used for obtaining detail drawings. If

projections are used in the file of the fragment, then for their recalculation during autosaving the

mode of automatic update must be selected in the projection’s properties.

Autosave configurations. This parameter allows you to save configurations automatically.

Save file of fragment to assembly folder. If this flag is enabled, then next to the assembly file the

folder is created, which has the name of the assembly file, and the fragment’s file is saved into the

folder. The relative path for the fragment is created.

Do not use parameterization. When this flag is enabled, external variables of the fragment cannot be

changed. The Variables window is not invoked from the context menu of the fragment and does not

appear during the fragment editing.

Hide connectors. When this flag is enabled connectors of the fragment are not shown in 3D scene and

in the tree of a 3D model.

Do not show coordinate systems in the tree of a model. When this flag is enabled external

coordinate systems of the fragment are displayed in 3D scene, but are not shown in the tree of a 3D

model.
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Transformations tab

Via the Transformations tab, it is possible to work with list of all geometric transformations which

have been applied to the given operation of a 3D fragment. Among those, there could be:

· additional transformations defined upon creating or editing 3D fragment;

· transformations, assigned in the command Transform Element;

· transformations for the Exploded View mode;

· specific service transformations for performing the functions of attaching a 3D fragment.

Any transformation can be applied either permanently or only in the special mode of exploded view

for the assembly. This is controlled by the corresponding flag in the settings of each transformation.

3D fragments and Parts can be subject to a special type of a transformation called Attachment.

Instead of somehow transforming the body of a 3D fragment in the space, this type of transformation

merely defines the attachment by the coordinate systems. This transformation is introduced

automatically by the system upon inserting each 3D fragment. Its name depends on the attachment

type of the 3D fragment:

· Fix by Fragment LCS - is the 3D fragment attachment transformation in which the fragment

LCS was used as the source coordinates. 

· Fix by Assembly LCS - is the 3D fragment attachment transformation in which the source

coordinate system was created on the fly in the transparent mode when inserting the 3D

fragment. 

· Fix by Workplane - is the 3D fragment attachment transformation in which the attachment is

defined by the 2D fragment (layout).
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When suppressing the transformation defining a 3D fragment attachment, the fragment model

is positioned in the scene by snapping the 3D fragment world coordinate system to the

assembly world coordinates. 

To disable any transformation, set the flag Suppress in its properties. The input box next to the flag

check box allows entering numerical values or non-textual variables. The transformation is considered

suppressed whenever the entered expression is not equal 0.

3D fragments possess another special type of transformation, providing for the automatic 3D

fragment exploding data copying from the properties of its source coordinate system. The respective

chapter about local coordinates reads: if you plan to use a given LCS as the source coordinates for

attaching a 3D fragment, then you can define, among its properties, the necessary translation/rotation

for future exploding. This transformation is called Source LCS Transformation. It only becomes

available, when the source LCS of the 3D fragment actually has those properties defined. Such

transformation cannot be modified in any way. 

A special Apply exploded view transformation of base elements flag allows exploding a given 3D

fragment with respect to its fixing point, accounting for exploding transformation of the base

elements. That means, turning on the flag additionally moves the fixing point of this 3D fragment per

the transformation of the base element.

The Uniform Scale flag is located at the bottom of the window, which allows you to adjust the scale

of the fragment. If this flag is set (by default), then one field M is displayed to set the numerical value

of the fragment scale, which is applied simultaneously on all axes. If the flag is unchecked, then

instead of the above field, three fields X, Y and Z are displayed to set individual values of the

fragment scale on each axis.

Mate Transformations

In this tab, you can delete transformations of conjugates created after inserting a fragment (see the

Mechanism Motion section).

Parameters window of 3D Fragment

When inserting or editing a fragment, the following options are available in the options window:

· Use Move/Rotate Manipulator. When the flag is set, the LCS manipulator is displayed, which

is convenient to use to change the position of the fragment in the assembly. The values of the

displacements are recorded in the parameters of the Transformations section.

· Use Variable Manipulators. If the flag is set, when editing a fragment, manipulators of

external variables created in the fragment file are displayed.

· Semitransparent View. When the flag is set in the create and edit commands, the fragment is

displayed in an edge view.

· Create Internal Fragment. When the flag is set, the fragment is saved in the assembly file. The

link to the fragment will be internal.

If the inserted fragment contains embedded internal fragments, the flag will be set

automatically, i.e. such a subassembly can only be inserted as an internal fragment.
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Preparing document for use as 3D fragment

Any T-FLEX CAD document can be customized to simplify in certain circumstances its usage in

assemblies as a 3D fragment. 

Customizing document status

3D fragment tab in Set Model Parameters command provides possibility to specify default LCS used

for fragment fixing, specify type of insertion, set parameters for automatic Boolean operation.

In the Set Document Parameters command dialog on the 3D Fragment tab, you can specify the name

and save folder of the fragment file when it is inserted into the assembly, the method of insertion and

the general fixing LCS, the layer in the assembly on which this fragment will be automatically placed;

set the default source coordinate system, configure parameters for automatic Boolean operation.

Automatically create Boolean Operation

When inserting a 3D fragment, one can automatically create a Boolean operation of a specified type.

The target body will be the selected body in the assembly, while the tool body - one of the bodies of

the 3D fragment, or all fragment bodies at once.

Setting up automatic creation of Boolean operation is performed with the help of several parameters:

Operation Type. This parameter defines the type of the Boolean operation (addition, subtraction,

intersection) that will be created upon inserting the fragment in the assembly. The type can be

selected from the list.

Create operation with:

· Use the whole Model. With this option checked, the whole 3D model of the fragment will be

used as the target body of the Boolean operation.

· Use single operation. Selecting this option makes the Boolean use just a single operation within

the fragment. The desired operation can be selected from the list of all existing operations.
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In the case when a body is used in the Boolean, that is not visible when working with the

document of the 3D fragment, it is possible to place it in a special layer marked as Visible only

when model is used as a Fragment.

Let's take an example of the use of automatic creation of a Boolean operation when inserting a

fragment. Suppose there is a 3D model of the wall of the house in which you need to insert a window

as a 3D fragment.

1. House wall model

2. Window model in a separate fragment

To do this, the window model must be created in a certain way. You need to specially create a

parallelepiped body on top of the window, along which an opening in the wall will be cut to insert the

window.

Then you need to open the document parameters, the 3D Fragment tab (see above). Set the

Operation Type - Subtraction, Create operation with - operation of creating a parallelepiped body

(for example, Extrusion_2).

Then you need to go to the fragment with the model of the wall of the house, call the fragment

insertion command, insert the window fragment into the desired location and click .
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As a result, the inserted window fragment will be subtracted from the model of the house wall.

3D Fragment

Fragment Name. The parameter specifies the name with which the fragment will be displayed in the

assembly model tree in the format Name_1 (ISO 3D Model 1.grb).

Fragment name (displayed). The parameter specifies the name with which the fragment will be

displayed in the assembly model tree in the format Name_1. The fragment name can be set to a

variable, for example - {a}. When inserting such a fragment into an assembly, its name may be

different depending on the value of the variable.

Folder Name. This parameter specifies the name of the folder into which the fragment will be placed

in the assembly’s model tree.

Fragment’s name and folder’s name are read from the fragment’s file only upon creation of the

new fragment. If the values of these parameters are changed, then upon update of the fragment

in the assembly the name and the folder will remain the same.

Insertion method. From the drop-down list one of the options can be selected:

· Standard. Upon insertion into the assembly the translation of the fragment is possible only

with the help of the manipulator of LCS  (dynamic translation is disabled);

· Fastener. When inserted into the assembly the fragment dynamically moves after the cursor of

the mouse;

· 3D arrangement. This method of insertion is used for quick creation of the arrangement in 3D

scene. In the fragment’s file special attachments to the floor, walls, ceiling, horizontal surfaces

must be created. These attachments are defined by means of connectors with the specific

parameters;

· By points. A fragment can be fixed to the selected in the 3D scene points upon insertion. Its

size changes according to the distance between the points.

· Smart fragment (macro). This method of insertion is used for parametric fragments whose

insertion scenario is described in the program (macro) stored directly in the file of the given

fragment or in the external module (DLL). When inserting the file as a fragment the user-

specified macro will be executed.
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Default LCS used for Fragment fixing is selected from the list. The list contains all local coordinate

systems of the model that have the flag Use for Fragment insertion set. When inserting such

document as a 3D fragment, the thus defined coordinate system will be automatically offered as the

source LCS.

If necessary, the permitted degrees of freedom can be set in the properties of the prepared

coordinate system, which will insure the correct behavior of the given 3D fragment in an assembly in

the mode of moving mated elements (see the Mates and Degrees of Freedom chapter).

For uncomplicated parts, which can be conveniently inserted into the assembly in the mode of

dynamic snapping, the given mode can be turned by default.

Insert 3D fragment on layer. This parameter defines the name of the layer onto which the fragment

will be placed upon its insertion into the assembly. If in the fragment’s document the “Insert on layer”

parameter is enabled, but upon insertion of the fragment into the assembly this layer does not yet

exist, then this layer is created automatically upon request.

Don’t show the message “Fragment doesn’t have bodies”. By default this parameter is disabled. In

this case the system does not allow for insertion, into the 3D assembly, of the fragment in which the

3D model is absent or suppressed. The corresponding message in the diagnostics window appears as

comments. When this flag is enabled the system allows for insertion of “empty” fragment without

issuing any messages.

You can define options for section views on 2D projections on the Sections tab.

For some models (future components of assemblies) it can be helpful to define special settings for

preventing their cutting when used in section views of 2D projections. For example it is known that

bolts should not be cut on section views of assembly drawings. This option will help to avoid time

consuming manual customization of 2D projection parameters for assemblies that contain such parts.

New condition can be created with the help of + button. Section Application Condition section will

appear with the lists of conditions and LCS names. 
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Conditions are organized in relation to the alleged source fragment LCS that exists in a document of a

future 3D fragment. For example a part may remain uncut if a section plane goes through a specified

axis of the source LCS, or coincides with one of the main LCS planes.

Assembly variable definition 

You can assign an assembly variable counterpart for any external variable of the current document.

This can be done in the case, when the external variable drives, for instance, a characteristic parameter

(such as, say, diameter), while the assembly variable name has already been defined (for example, D).

When assembling this document as a fragment, this assembly variable name will be automatically

substituted for the fragment variable in the dialog for defining external variable values (provided that

this variable exists in the assembly).

The assembly variable name can be defined in the variable editor. Detailed information on working

with the variable editor is available in the Variables chapter.

Using fragment dimensions in assemblies

3D dimensions placed inside the fragment document can be "raised" into the assembly. To do this, in

the properties window of the size creation/editing command, on the Common tab, you need to

enable the Show on 3D fragments checkbox.
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Dimensions raised in 3D into an assembly of fragments can be used for two purposes:

· As decorative - they show the nominal size; 

· As control dimensions - such dimensions are used to set the values of the external variables of

the fragment by editing their nominal value. To do this, you need to set the nominal value type

Manually in the dimension parameters, and write the name of the external variable in the

expression field. Editing a value of this dimension in the assembly will be available both when

the 3D fragment editing command is running, and according to the usual scheme of changing

the control dimensions in the Dimension command.

Top-down Assembly Design

When you use "Top-down" design, you can create parts in an assembly based on the geometry of

other parts of the assembly. This is a fundamental difference from "Bottom-up" design, where parts

are edited separately, independently of other parts in the assembly. That's why we will see how parts

in the assembly will contact with each other only when we have finished editing the part and updating

the assembly. In "Top-down" design, an assembly defines the dimensions, position, and contact

elements of its parts and subassemblies, which means that top-down design requires top-down

communication: the relation between an assembly and assembly fragments. The relation between the

assembly and the assembly fragments is performed by the Reference Element. Reference Element

borrows geometry from assembly to part. The Reference Element may borrow major elements of the

model and topological elements. Control of relations between fragments and their relations with the

assembly, the fragments variations, navigation through the assembly are performed in "Assembly

Structure" window.

The Top-down design principle and the Reference Element mechanism allow you to solve problems

that arise in the development of complex assemblies. For example, the user can borrow the geometry

of elements from the elements of higher-level fragments in the assembly structure, or from fragments

located in "parallel" subassemblies. The user can receive changes of the uploaded geometry from the



3D Assemblies

2207

source document or update the source document in accordance with the changes in the uploaded file

at any time. 

Thanks to the Reference Element mechanism, it is possible to work effectively in a team, where each

user performs his task. For example, when designing an excavator cab, the cab body parts are

developed by one user, and other users do not have access to this file. The geometry of the cabin can

be uploaded to a separate document so that several users can work in parallel. 

On the basis of these unloaded elements another user can create equipment in the cabin, having full

data on the current dimensions of the cabin. In this case, it is possible to snap to the unloaded

geometry and update the unloaded geometry in accordance with the changes in the source file of the

cabin. Then the changes made in the cab may be transferred to the general assembly. 
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The "Top-down" design method cannot be considered suitable for all assembly design cases. It has a

number of limitations:

· a more complex scheme of the organization in comparison with "Bottom-Up" method;

· less resistance to topological changes in the 3D model;

· parts are less convenient when using the same 3D model in different assemblies;

· higher requirements to computer resources.

"Top-down" and "Bottom-up" design methods can be combined. The "Bottom-up" design method is

useful when adding standard parts to an assembly, parts with strictly defined geometry. The "Top-

down" design method is preferably used in the design of parts and assemblies that provide

interconnection and fastening in the assembly of structural elements that have a strictly specified

geometry. 

Create Assembly Features Using Top-down Design

The commands for creating assembly elements.

· Insert 3D Fragment. Allows you to insert a fragment by LCS. It is used during "Bottom-up"

designing.

· Create 3D Fragment. Allows you to create a fragment in the structure of an existing assembly.

It is used during "Top-down" designing.

· Detail. Detail > Create and Detail > Unload. Allows you to create a fragment on the basis of a

body in the assembly. Creates a detail file that depends on the body or fragment in the

assembly. The command is available in the context menu of the fragment or body.

· Reference Element. Allows a fragment to borrow geometry from an assembly or another

fragment. Reference elements carry out the relationship on which the principle of "Top-down"

design is based. You can only create reference elements in the context of an assembly (except

for internal references to resolve recursions – see the "Reference element" subsection).
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· Open in Context: The command is available in the context menu of the fragment or body. Edit

in Context: the command is available in the Create 3D Fragment command dialog. 

· Assembly Structure. The command opens the "Assembly Structure" window. The window is

required to navigate the assembly and control assembly changes.

Various options of these commands, their combination when creating assembly elements, allow you

to create assemblies with complex hierarchical relationships. Fragments can depend on both the

assembly and other fragments in different ways, you can combine the "Top-down" design principle

with the "Bottom-up" design principle. The types of fragments and how they relate to each other and

to the assembly are described in the section "Variations of fragments relations with assembly when

designing ’Top-down’".

Two Basic Ways to Create Parts in Assembly

Creating a primary hierarchy of subassemblies and parts is already considered above. The

recommended and convenient way to work is to create an empty detail file using the Create 3D

Fragment command, and then fill it with geometry and create Reference Elements in the context of

the assembly. In T-FLEX CAD terminology, in General, any subassembly and any part is called a

fragment. Therefore, the creation of the fragment may mean the creation of subassemblies and the

creation of the part (if there are no other parts in the part). 

It may happen that you need to create a fragment based on the body in the fragment for the correct

assembly structure. The fragment with the body will become an assembly, the created fragment - a

part in the assembly. The fragment with the body may already contain other fragments, i.e. already be

an assembly. To create a part based on a body in a fragment, there is a set of options for the Detail >

Create command. This is the second way to create parts in "Top-down" design. Consider these two

ways to create parts in a simple example.

Topics in this section:

· Create Assembly Structure in «Assembly Structure» Window

· Create 3D Fragment

· Create Detail

· Multi-level Assemblies

· Assembly Unit Creation

· Working in Context of Assembly

· Reference Element

· Filling an Assembly with Geometry

· Unload Geometry with Possibility of Subsequent Updates

· Parts That Do Not Depend on Assembly

· Re-insert Part

· Detail Duplicate

· Positioning, Scaling, and Variation of Fragments in Assembly (Fragment Transformations)

· Variations of Fragments Relations with Assembly when Designing Top-down

Create Assembly Structure in «Assembly Structure» Window

You can create an assembly structure both during operation and in advance. The recommended way

to operate using "Top-down" design is to create a structure of hierarchically related fragments, and

then edit them, starting with fragments that are independent of others, moving on to the fragments

that will be built on the basis of those that have already been created. It is difficult to fully guess the

final structure, so you can create only part of it, and to supplement the structure in the process.

To create a hierarchical assembly structure, you should create an assembly file. 
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Then you should save the assembly file. Open the Assembly Structure window.

Next, in the Assembly Structure window, you should call the context menu for the created file.

Select the Create 3D Fragment command. In the appeared dialog, specify the name, and do not

enable Edit in Context option, because first you need to create the assembly structure. You can edit

the fragments both in context and not in the context of the Assembly later, when the user begins

designing. After you finish working with the fragment creation dialog, the fragment file will be saved

in the specified folder. By default, the new fragment file will be saved to the folder where the

Assembly file is located.
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Working with the fragment creation dialog is described in the corresponding section below. 

Similarly, by calling Create 3D Fragment command from the context menu, you can create a structure

of any complexity for the fragment for which you want to create a embedded fragment.
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After you have finished creating the structure, you need to save the main Assembly file in which you

worked to create the structure. Next, you need to fill the fragments with geometry. This should be

done in the context of the Assembly if you want to create Reference Elements. 

Create 3D Fragment

Calling the command:

Icon Ribbon

Assembly > Assembly > Create 3D Fragment

Keyboard Textual Menu

<FM> File > Fragment > Create 3D Fragment

The command to create a fragment when working with assemblies on the "Top-down" principle.

The fragment creation dialog appears when the Create 3D Fragment command is called.

The prototype of a fragment: "3D Model", "3D Assembly" or "Sheet Metal Part" - affect its properties

in the assembly structure and the commands available by default in the ribbon. In the assembly

structure, the fragment type can be changed, and the commands in the ribbon can be switched, i.e. the

choice of a prototype is not so important, but to reduce time, of course, it would be better to

immediately select the desired prototype.  
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The Part Number and the Description automatically create a file name on the disk. The principle of

creating a file name can be customized. To do this, click the icon  in the Description field and a

special Naming Rule dialog appears. Using the icon , you can update the file name according to

the selected naming rule.

By default, the file is saved to the folder where the assembly is located. 

Fragment Name. Defines the first part of the fragment name in the assembly when displaying the

fragment in the 3D Model and Assembly Structure. The fragment name and file name create the full

name of the fragment in the assembly.

Edit in Context of an assembly. Setting this flag combines the 3D scene of the edited fragment with

the 3D scene of the assembly in which the file was called for editing. In the assembly context mode, a

selection of assembly elements is available for editing the fragment.

Example of using the command when working with Top-down assemblies

Create a Box Cover for Box Body. Go to the assembly file "Box" (creation of which is described in the

previous section). Select the Create 3D Fragment command.

If you set the Edit in Context flag in the appeared dialog, then after saving the file to disk, the created

fragment will be automatically opened in the context of the assembly. Then all the elements that are

currently in the assembly will be available for constructions creation. In this case, only the geometry of

the "Box Body" fragment will be available, because there are no other fragments in the assembly yet. 



T-FLEX CAD 17 Help

2214

We want to set the relationship between Box Body and Box Cover: between the upper face of the

body, its centering edge and the mate parts on the cover. This should be done using Reference

Elements. You need to create Reference Elements in the context of the assembly – so specify the Edit

in Context flag. 

In the create fragment dialog specify the name of the file and select the prototype "3D Model".

In the "Fragment Name" field, change the default name to "3D Fragment_2", because in our case the

box Cover fragment will be the second in the assembly. In General, the logic of naming fragments in

the assembly is up to the user, because neither the formation of the assembly structure nor the

structure of the part is affected by the name of the fragment.

Since the Edit in Context flag was specified, the assembly geometry will become semi-transparent,

and a special panel will appear in the upper right corner of the 3D scene to control the main options

of the fragment in the context of the assembly. 
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In the Ribbon, on the Assembly tab, select the Reference Element command (more information about

this command can be found in the Reference Element subsection). Select two faces of Box Body: the

top defines the centering edge of the body, the bottom – the surface on which the cover leans. In the

command properties window, you can see a list of faces. To expand the list of reference elements,

click the icon next to the field indicating the number of reference elements.
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The Create geometric adaptive parameters option flag means that the created reference element will

be placed in the geometric parameters of the fragment, and the edited fragment will become

adaptive. Create Geometric adaptive parameters is only possible when specifying the source

geometry in the assembly.

If the option flag Do not update geometry when recalculating is not set, the Reference Elements will

be automatically updated when you recalculate the references from the Assembly Structure window. 

Geometry Source - Assembly (for more information about variants, see the subsection Geometry

Source). If a Reference Element is created between the assembly and the first level fragment (as in this

case, because we specified Geometry Source: Assembly) the default reference will be the geometric

parameter, and when recalculating the assembly will change the fragment without updating the
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Reference Elements, but only in the assembly. The geometry of the fragment inside its file will remain

unchanged until the link is updated: manually or through the Assembly Structure window. You can

learn more about the options for linking fragments to an assembly in the corresponding section

below.

Click the icon  to exit the fragment editing in the context of the assembly with saving the changes

in the fragment file.

It is important to pay attention to the Assembly Structure window. The fragment of the box cover is

adaptive, because it has geometric parameters, the fragment of the body is non-adaptive, because it

does not contain geometric parameters.

Further creation of the box Cover geometry can be carried out both in the context of the assembly and

simply by opening the fragment file. On the basis of reference geometry, you need to use three-

dimensional modeling commands to create a Box Cover geometry. 

If you work with the fragment file in the context of the assembly, it is better to disable the Select

Assembly Elements  option. In this case you will not create links accidentally. After the

completion of the constructions creation you should exit the context of an assembly by clicking the

icon .

If you create the fragment geometry outside the context of the assembly, you should update the

assembly after you save the fragment file. When you open the assembly file, in the dialog that appears

automatically when you edit and save the assembly fragments, you must specify the update of the

assembly.
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Now, to explain the work of Reference Elements and Geometric Parameters, let's change the geometry

of the Box Body.

Open the fragment "Box Body". You can open a fragment in the context of an assembly or simply

open the fragment file. Open the fragment in the context of the assembly. To do this, in the Assembly

Structure window, call the fragment using . Change the length of the Box Body.

A fragment of Box Body has changed its length, Box Cover-did not, because the assembly does not

know about the changes. Only after we leave the context  the changes in the box Body fragment

will be saved. After leaving the context, you are back in the Box assembly file. In the assembly file, the

reference to the Box Body file is automatically updated,and the assembly will already have the

modified body geometry. The Box Cover fragment automatically changed the geometry, and Box

Cover corresponds exactly to the new geometry of the case: after we changed the length of the
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container body - the source geometry of the adaptive reference elements was rebuilt, and a new value

was assigned to the geometric parameters of the box Cover fragment in the assembly. 

Open the Box Cover file separately. In the Box Cover file, the geometry has not changed (if we open

the cover fragment in the context of the assembly, its geometry in the assembly will be displayed, not

the geometry in the source file). This behavior of the fragment is caused by the fact that its reference

elements are geometric parameters, which means that the geometric parameters in the assembly will

be set according to the values of the geometric parameters in the assembly, and in the source file

geometric parameters will have the value before the changes. In this case, the Reference Element,

which is a geometric parameter, behaves as an External Variable that can take a value in the assembly

other than the value that takes in the source file. 

When creating Reference Elements, you did not specify the Do not update geometry when

recalculating option flag - then you can update the Reference Elements through the Assembly

Structure window. You can update all links, but only in a separate fragment. In this case, there is no

difference, because only one fragment of the assembly contains reference elements.  

Open the Box Cover fragment file again.
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Reference Elements were updated (a new version of the source geometry was borrowed), the Box

Cover geometry was automatically recalculated and saved.

Create Detail

The detail creation dialog can be opened for any body (multiple bodies) or fragment via the context

menu.

Detail > Create

The command allows you to create a fragment based on a body (or multiple bodies) in an assembly,

and assembly units based on fragments. The command also allows you to open a body or fragment in

a separate document.

· You can select a body and place it in a fragment.

· You can select multiple bodies and place them in a fragment. The selected bodies will be

moved to the fragment.

· You can select multiple bodies and a single fragment and place them in the fragment. The

selected bodies and the selected fragment are transferred to the fragment.

· If you want to put several fragments in a separate fragment in the assembly, i.e. to create a

build unit, this action can be performed using the Assembly Structure window: Create

Subassembly, or via the context menu: Subassembly > Create (see  Assembly unit creation

section). The command for assembly units creation will be carried out through the fragment

creation dialog. 
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Prototype. The option affects the default commands in the Ribbon and the standard. You can switch

commands in the Ribbon. 

The Part Number and the Description automatically create a file name on the disk. The principle of

creating a file name can be customized. To do this, click the icon  in the Description field and a

special Naming Rule dialog appears. Using the icon , you can update the file name according to

the selected naming rule.

Create a new document by unloading the selected bodies and fragments, without changing the

structure of the current model.
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Do Not Save further in the text.

This option allows you to open a body or fragment in a separate document without saving. If

necessary, you can save the viewed document with Save command.

Create a new fragment, replacing the selected bodies.

Create Fragment further in the text.

 The body to which you applied the Create Fragment command is replaced with a fragment with a

separate source file. All body model tree is moved into the fragment file. If necessary, reference

element and (or) derived objects will be created (see Reference element section for details).

Create a new adaptive fragment with reference elements as parameters, replacing the selected

bodies.

Create Adaptive Fragment further in the text.

 The body to which we applied the Create Adaptive Fragment command is replaced with a fragment

with a separate source file. All body model  tree is moved into the fragment file. If reference elements

are created during the command execution, they will be added into the geometric parameters of the

fragment.

If you create an adaptive fragment (Create Adaptive Fragment) from a body (or bodies), and

the body can be completely transferred from the source file to the generated fragment file,

reference elements will not be created. Accordingly, the geometric parameters of the fragment

will not be created, and the fragment will be non-adaptive. 

Any fragment created with the Detail > Create command (both Create Fragment and Create

Adaptive Fragment) can then be edited in the context of the assembly and reference elements can be

created with the Reference Element command. 

Open Saved Document. If the flag is enabled, after selecting Create Fragment or Create Adaptive

Fragment, the created fragment will be opened in T-FLEX CAD. 

Additional options for creating fragments are available in the drop-down list.

Assembly document parameters. When this option is enabled, all parameters from the assembly

document (the document from which the body is placed in the fragment) that are set in the

Document Parameters command are passed to the part (the fragment to be created) .

External variables. When this option is enabled, all variables from the assembly file are passed to the

part (the created fragment).

Geometry of the assembly document. This option is used for fragments created in the context of an

assembly or adaptive fragments. Allows you to unload changes of the geometry on the basis of which

a fragment was created in the context of an assembly or adaptive fragment. For example, an adaptive

fragment was added to an assembly. If you have added an adaptive fragment and the geometry of its

associated features has changed, you can upload the changes to the detail file. If the flag is disabled,

the part is created based on the geometry that existed when the adaptive fragment was inserted.
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Supplement from assembly document. Allows you to immediately move a fragment or body

supplements from the assembly to the detail. For example, a fragment was added to an assembly and

a hole was made in it. The supplement option has been activated for this hole. This supplement can be

transferred to the part file with the fragment.

Combine initial operations. If a fragment contains several bodies, they can be combined into one

body from the assembly. For example, if the bodies of a fragment were supplemented in an assembly

in such a way that elements of different bodies were used in the same command, such supplement

cannot be transferred to the fragment without combining the bodies.

Example of using the command when working with Top-down assemblies

One of the features of the Detail > Create command is to create a detail based on the bodies in the

source file. The source file will become an assembly for the created detail.

Let's continue with the example of Box creation. Let's consider the user has built the body of Box Clip

in the file Box Cover. We do not recommend this way, but it is acceptable.

  

It is necessary that the box Cover fragment contain only one body – Body Cover, and the Body Clip

and all related constructions should be in a separate file. In addition, the Body Clip should be a

fragment in the Box Cover file.

Call the context menu for the Body Clip using . Select the Create command.  

You need to specify Part Number and Description (or fill in only one of the fields). By default, the new

file will be saved to the folder where the file in which we use the Create command is located. Select
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the way to create an adaptive fragment (Create Adaptive Fragment), so that the created fragment of

Box Clip is also adaptive (like the fragment of Box Cover) and contains reference elements in the

geometric parameters.

As a result, a fragment appeared in the Assembly Structure window and the 3D Model window of the

Box Cover file. The fragment has a Reference Element for those builds that cannot be retrieved from

the source file. A fragment of Box Clip has an icon  of adaptive fragment, which has geometric

parameters. The geometric Parameters of this fragment can be seen in the corresponding tab of the

Assembly Structure window. Automatically created reference elements are added to the geometric

parameters, because you have specified the option of an adaptive fragment creation.

The Geometric Parameters Tab.
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When you use the Detail > Create command, the generated fragment relative to the original assembly

will always be a fragment of the first level, so its reference elements will always be geometric

parameters, in a case that we have chosen the option of creating an adaptive fragment.

In the general case there are several options of how a detail is created on the basis of the body of the

assembly.

· Reference Elements will be created (see Automatic Creation of Reference Elements for

details).

· Derived objects will be created (see Automatic Creation of Derived objects for details).

· Both Reference Elements and Derived objects will be created.

· Neither Reference Elements nor Derived objects will be created. This will happen if the body

can be completely extracted from the assembly.

As you can see in the "Assembly Structure" window of the Box Cover file, after executing the Detail >

Create command, the resulting structure is similar to the one we got in the previous case when we

used the method of creating a detail in the context of the assembly. However, in this case, the

reference element was created automatically. 

The ability to receive a detail with automatically created reference elements and fully editable

model tree in the detail file, after it was built in the assembly is used to correct the user error,

when user creates bodies in the assembly file. Therefore, using the command Detail > Create

instead of the command Create 3D Fragment using references is not recommended.

When you save a body in a separate file and rearrange it in the assembly, Reference Elements and (or)

Derived objects are automatically created, the number of which and the geometry contained in them

we do not control when creating. 

When you try to select a complex body from the assembly as an adaptive fragment, recursions

may occur that will be eliminated by additional internal Reference Elements or by creating

additional subassemblies. 

Detailed information about troubleshooting recursions with the help of reference elements you can

find out in the section Elimination Recursions Using Reference Elements.

"Top-down" design requires the user to understand the dependencies of the fragments on each other,

it is not recommended to use methods to create fragments that complicate the understanding of the

relationships in the assembly and complicate the structure of references in the assembly.

The created fragment in the general assembly "Box" became a fragment of the second level. For

fragments of the second level (and below) in the Assembly Structure window, you cannot see the

geometric parameters, but we can see the reference elements.



T-FLEX CAD 17 Help

2226

If you create a fragment using the command Detail > Create, an update is available for its

automatically created reference elements during recalculation. Therefore, the fragments created in

this way will update the geometry in the fragment file when you update the references from the

Assembly Structure window.

 

Tab of geometrical parameters.

If you make changes to the geometry source reference elements in the assembly "Box" that will

change the geometry of the fragment "Box Cover" (because the Cover is a fragment of the first
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adaptive level for general assembly). The fragment "Box Clip" will also change his position and (or)

the geometry, because it is adaptive relative to the assembly "Box Cover".

You can create a serial chain of adaptive fragments "Assembly > Fragment of the first level"

where each subsequent fragment has a reference element a level higher in the geometric

parameters.

Multi-level Assemblies

There are two main ways to create multi-level assemblies.

· Create an assembly structure in the Assembly Structure window by using the Create 3D

Fragment command (see Create Assembly Structure in «Assembly Structure» Window) and

then work with the selected fragment in the context of the general assembly.

· Create first-level fragment chains by creating and editing fragments only in the context of an

assembly at a higher level (see "Two basic ways to create parts in an assembly"). In this way,

you can create adaptive fragment assemblies.

Since the example of creating a chain of fragments of the first level were  already considered above,

now let's consider an example of working with fragments in the context of the assembly at two or

more levels above.

Create a Box Clip in the context of the general Box assembly. We assume that the structure of the

assembly, in which the clip is a part of the assembly unit Box Cover is preferable for us, but to create a

Box Clip is more convenient for us both on the basis of the faces of Box Cover, and on the basis of the

faces of Box Body. Both fragments (Box Body and Box Cover) are available only in the general Box

assembly.

Open the previously created Box assembly. The assembly already contains fragments of Box Body and

Box Cover, and the fragment of Box Cover is an adaptive fragment of the first level. Create a Box Clip

part in the Box Cover subassembly. To create a part in a subassembly, you need to open the context

menu of the selection fragment, in which you can select the Create 3D Fragment command. Call the

context menu of the Box Cover fragment. Select the Create 3D Fragment command, its dialog

window appears. Enter Description: Box Clip, enable the option Edit in Context flag . Editing will be

performed in the context of the assembly in which we are at the moment. In our case, the created

fragment will be opened in the context of the Box assembly. For the Box assembly, the created

fragment is a second-level fragment.
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In the Assembly Structure window we can see the resulting structure: the generated fragment is a

second-level fragment for the assembly in the context of which we are editing the fragment. The chain

of fragments, from the edited fragment to the assembly, is italicized. This way of representation

allows you to better understand the position of the edited fragment in the general hierarchy.

Create reference elements. Choose two faces on the Box Cover and the two faces of the Box Body.

Two faces on the Box Cover will set the position of the clip axis and its width. The two faces of the Box

Body are the dimensions of the groove. That is, you just need to create four reference elements.

Reference elements are created using the Reference Element command.
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The default settings will be used: specify the creation of geometric adaptive parameters and specify

the source of geometry in the assembly file, i.e. the source geometry will be located in the "Box" file.

Create links and exit editing in the context of the assembly with saving .

In the Assembly Structure, you can see that the fragment has four reference elements. The file of the

source geometry for them is a "Box" file, at the same time, despite the chosen option, the geometric

parameters of the reference elements were not included. This is because the assembly part is a second

level fragment, and the creation of geometric adaptive parameters is only available for the "Assembly

> first-level fragment" relationship.
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Building a Box Clip on the basis of reference geometry can be done both in the context of the

assembly and not. When working in the context of an assembly, it is recommended to disable the

Select assembly Elements (the icon  should not be active) option so as not to create random

reference elements. After the completion of the constructions creation you should exit the context of

an assembly by clicking the icon .

If you create the fragment geometry outside the context of the assembly, you should update the

assembly after you save the fragment file. In the dialog box that appears automatically when you

change the assembly fragments, you should specify the update of the assembly, when you open the

assembly file.
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Here is a comparative example of changing the fragments of the first level (containing a reference

element in the geometric parameters) and the second level (not containing reference elements in the

geometric parameters).

Change, as before, the length of the Box. The length of the Box depends on the length of the Box

Body. Decrease the length of the Box Body.

Box Cover is an adaptive fragment and changed its geometry only in the assembly. In the fragment

file, the geometry remained unchanged until we update the reference elements. Box Clip is a non-

adaptive fragment (without geometric parameters) and remained unchanged. Update the reference

elements for the entire model.
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Confirm the update and save. References have been updated. The geometry of the Box Clip has

changed in both the assembly and the fragment file. The "Box Cover" fragment file has also changed

its geometry.

Assembly Unit Creation

The subassembly creation command is available in the Assembly Structure window and in the context

menu of the fragments selected in the 3D Model window. This command allows you to change the

hierarchy of fragments in the assembly structure: place the fragments in the subassembly by changing

their level to n-1, where n is the current fragment level. 
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In the Assembly Structure window, select the fragments to be placed in a separate subassembly and

click the Actions  icon, select the Create subassembly command from the list of commands. 

The detail creation dialog box appears. To create a new assembly unit, select the second option.
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You can see the assembly structure changes in the Assembly Structure window. The selected

fragments moved to a lower level, and a new assembly unit appeared in their place.

The fragments in the new subassembly will retain their transformations according to the assembly

from which they were placed in the new subassembly. The reference elements will retain both the

source of the reference geometry and the source of the document parameters.

If the fragment being moved down a level was adaptive to the assembly (subassembly), then it will

cease to be adaptive, because the connection "Assembly > fragment of the first level" will be broken.

Working in Context of Assembly

When you edit a fragment in the context of an Assembly, the 3D scene of the fragment is combined

with the 3D scene of the Assembly from which the fragment editing in the context was invoked. 3D

scenes are combined with the transformations that the fragment received in the Assembly. While

operating in the context of an Assembly, we are in a fragment file. All the changes we make only

affect the fragment file. The 3D Model window displays the construction elements a fragment file.

Assembly Structure window shows the structure branch starting from the Assembly in the context of

which you are working. Working in the context of an Assembly has two main functions.

· It allows you to understand the position and dimensions of the fragment directly in the

Assembly.

· It allows you to create Reference Elements.

The main tool for linking an Assembly to fragments in "Top - down" design is the Reference Element.

Reference Elements can be created automatically or manually. More information about the cases in

which a reference element is created automatically is written in the Reference Elements subsection.

You only need to create reference elements manually in the context of an Assembly using Reference

Elements command. 

In order to open a fragment in the context of an Assembly, you need to double click  on it in

Assembly Structure window or in the context menu of the fragment to choose the  Open in

Context command. The context menu of the fragment can be called in the 3D Model window or in the

Assembly Structure window.



3D Assemblies

2235

The fragment will be opened in the context of the Assembly we are in when we call edit a

fragment in context. The Assembly Structure window displays the Assembly structure starting

with the Assembly we are in when we call the open command in the context of the Assembly.

When you open a fragment in the context of an Assembly, all Assembly constructions will be semi-

transparent, except for the body of the edited fragment. In the upper right corner of the 3D scene, you

will see a menu with the most important commands in the context. 
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Apply

Cancel (exit without saving changes)

Select Assembly Elements

Create geometric adaptive parameters for reference element

Reference Geometry Source 

The edit mode in the context of an assembly is primarily required to create reference elements, that's

why Select Assembly Elements, Create geometric adaptive parameters for reference element, and

Reference Geometry Source options refer to the creation of reference elements.

If the  option is active (icon on a blue background), then during the creation of the geometry of

the fragment, constructions of the assembly will be available. It can be constructions related to the

fragments of subassemblies a level lower, and to fragments of the same level as the edited fragment,

and to fragments a higher level. In other words, all build constructions regardless of which fragments

or bodies they belong to.
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If a construction from the assembly was chosen to perform any operation when editing a

fragment in the context of the assembly, a Reference Element will be automatically created for

this geometry.

The options for creating reference elements with automatic updating and selection of a source

document will be described in the subsection Reference Element.

Exit context with saving  (Apply). When editing a fragment in the context of an assembly, we work

in a fragment file. If we exit context, we close the fragment file. We can close the file with saving or

without saving changes. If we exit without saving - then you need to use the icon  (Cancel). Saving

when working in context, with the command Save – will save the fragment file. To save an assembly,

you need to exit the context and save assembly.

All assemblies of the upper level, which includes the fragment edited in the context of the assembly,

will be marked in italics in Assembly Structure window. This will simplify the search for the edited

fragment.

Reference Element

Calling the command:

Icon Ribbon

Assembly > Assembly > Reference Element

Keyboard Textual Menu

<3RE> -

The command allows you to create a top-down relationship, between an assembly and a fragment, or

between fragments, through geometry borrowed by a fragment from an assembly, or one fragment

from another fragment.  The reference element in the fragment is an element, which constructions tree

is not available. The constructions tree of the source geometry of the reference element is in another

fragment file. This file will be called a geometry source file (Geometry Source). Reference Elements

allow you to borrow three-dimensional objects geometry to perform subsequent operations on the

edited assembly fragment. The basic elements of the model (3D nodes, coordinate systems,

workplanes, 3D profiles, 3D paths, bodies of various types), and topological elements (edges, faces,

vertexes) can be borrowed.

As mentioned above, a reference element should be created only in the context of the assembly

(except when you want to create an internal reference to eliminate recursion).

Topics in this section:

· Reference Element Creation

· Updating of Reference Element

· Geometry Source

· Automatic Creation of Reference Elements
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· Reference Element in Geometric Parameters

· Derived Object

· Eliminating Recursions Using Reference Elements

· Detach

Reference Element Creation

To create a reference element, you should call fragment editing in the context of the assembly (see

Working in Context of Assembly). Call the Reference Element command. Select any available

assembly element or group of elements. Selected elements are added to the Source Objects list in the

Reference Parameters tab of the command's parameters window. You can Expand , Collapse ,

Clear  the list or Delete Element from the List  using buttons located on the right side.

When you create a reference element, you should specify:

· Is it required or not to update the geometry in the recalculation (see section Updating of

Reference Element);

· Is it required or not to create geometric adaptive parameters (for more information, see

Reference Element in Geometric Parameters);

· The source of the geometry, that is, specify how to update the reference element (for more

information, see Geometry Source).

Complete the creation of the reference element using the icon  or <Ctrl>+<Enter>.

The reference element always has the source geometry located outside of the fragment (except for

internal references, eliminating the recursion). Reference elements cannot change their geometry, they

can only borrow geometry, according to a reference to another file that contains the source geometry.
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The source geometry can be changed in the file where it is located, then the reference element needs

to be updated. It borrows a new variation of the source geometry. 

Reference elements of the fragment can be seen in the Assembly Structure window. The name of the

geometry to the reference element, the name of the file which contains the source geometry and the

file name of the source document settings are shown in the Reference Elements tab. In this case, the

transformation parameters are meant (you can read more in the section Positioning, Scaling and

Variation of Fragments in Assembly). The parameter source file is always the assembly in the context

of which the reference elements of the fragment were created. The source geometry file (Geometry

Source) you choose when you create a reference element.

You can see the reference elements of the fragment in the 3D Model window of the assembly. If the

assembly is a file that contains the source geometry, you can also see the source geometry of the

reference element in the 3D Model window.

A reference element can be seen in the 3D Model window of the fragment.
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Updating of Reference Element

You can update reference elements from the Assembly Structure window of an assembly, or from a

subassembly, and only the reference elements that are included in that subassembly will be updated.

You can update the reference elements of all the fragments in the assembly (subassembly).

You can also update the reference elements of a specific fragment. To do this, select the fragment and

select the command shown in the figure.
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You can update one specific reference element only in the 3D Model window of the fragment file that

contains the reference element by calling the Update Geometry command in the context menu of the

reference element. 

You can update reference elements through the Assembly Structure window only if the reference

element does not have an option: Do not update geometry when recalculating. If the option is active

for the reference element, the reference element need to be updated independently. You should use

the Update the Geometry command in the context menu of the reference element in the 3D Model of

the fragment file containing the reference element. 
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When creating a reference element, you may or may not specify the Do not update geometry when

recalculating option. By default this option is not active. When automatically creating reference

elements using the Detail > Create command, the option is not active.

By default, all reference elements (except internal references) are created with the ability to

update when recalculating.

The Do not update geometry when recalculating option is available in the parameters of the

reference element when it is created. 

If you activate the option, the reference element will be fixed and can only be updated manually via

the context menu of the reference element in the 3D Model window.
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In the 3D Model window of the fragment file, you can find out whether its reference element is fixed

or not. The fixed elements have a different icon (with a picture of a pushbutton), and the Do not

update geometry when recalculating option is active in the context menu.  

The reference element is fixed:

· the icon has a pushbutton;

· the Do not update geometry when recalculating option is active.

This reference element can only be updated manually.

Reference element is not fixed:

· the icon is normal, without pushbutton;

· the Do not update geometry when recalculating option is not active.

This reference element can be updated through the Assembly Structure window.

Geometry Source

In order to determine which file will contain the source geometry of the reference element, you need

to specify one of three options:

· Assembly,

· Fragment of first level,

· Initial fragment.



T-FLEX CAD 17 Help

2244

The Fragment of first level is set by default.

If you specify not set when you select a file that contains the source geometry of the reference

element, the selected element in the context of the assembly will be used upon the fragment

construction, but will be fixed and cannot be updated.

As mentioned above, a reference element can only be created in the context of an assembly. To do

this, open the assembly file, and then through the Assembly Structure window open the fragment for

editing (for more details, see Working in Context of Assembly). In the Assembly Structure window, we

see only those fragments that are included in the assembly. The entire structure above (if we opened

the subassembly file) will not be visible to us, neither in the scene nor in the Assembly Structure

window, and do not affect the creation of reference element.

In this case, we mean the current hierarchy of fragments, which determines which file on the disk

should be accessed in the future to find the source geometry of the reference element. This option is

valid only once, when creating a reference element. If the file containing the source geometry has a

different hierarchy in the final assembly, the system will find it. If the file is deleted, the link will not be

updated, because the source geometry will not be found. 

Assume that the source geometry to which a reference element refers upon update was specified in

the assembly. No geometry is created directly in the assembly, all geometry in the assembly is

determined by the fragments that are included in it. This means that in order for the source geometry

of the reference element to be available in the assembly, it must contain the fragment in which the

source geometry is located. Therefore, if you remove a fragment from the assembly, the source

geometry will not be found by the reference element when you update. 
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The edit panel in the context of the assembly (upper right corner of the 3D scene) duplicates the

option to specify the selection of the file containing the geometry source. 

You should carefully monitor this option when automatically creating reference elements in the

context of an assembly.

Automatic Creation of Reference Elements

Reference elements will be created automatically in two cases.

· If you edit a fragment in the context of an assembly with the enabled selection of assembly

elements  (Select assembly Elements), and an assembly element was used during

execution of any command.  

· If we use the Detail > Create command for the body in the assembly.

When automatically creating reference elements, the Do not update geometry when recalculating

option is not active. 

All auto-generated reference elements (except auto-generated internal links to eliminate

recursion) will be updated during recalculation.

If necessary, you can disable the update of the created reference element. To do this, in the context

menu of the reference element (called in the 3D Model window of the fragment file) you need to

specify the flag of the Do not update geometry when recalculating option.

When you use the Detail > Create command on a body in an assembly, reference elements will be

created for those constructions that cannot be moved to the created fragment file.

If there are elements among the parent elements of a body that depend on other bodies, such parent

elements cannot be taken from the assembly. In this case, a reference element is created.

For example, a profile is built on the face of the body, which is the parent of the body that we want to

save to a separate file. This profile cannot be taken from an assembly without the body on which it is

built. But we do not need the second body in the created file. Then a reference element will be

automatically created for the profile. In the created file, the specified profile will be a reference

element.

Reference Element in Geometric Parameters

The presence of a reference element in the geometric parameters allows you to change the geometry

in the assembly without updating the reference elements in the fragment files to obtain a new

execution of the adaptive fragment. In this case, the reference element will behave as an external

variable: the execution of the fragment in the assembly does not depend on the execution of the file



T-FLEX CAD 17 Help

2246

fragment. Reference elements in geometric parameters allow you to create adaptive assemblies. If the

assembly has fragments of the second level and below, it is possible to create a chain of adaptive

fragments, as it was shown in the subsection Detail > Create command. 

The presence of reference elements in the geometric parameters of the fragment is shown in the

Assembly Structure window.

The reference element will be placed by default in the geometric parameters of the fragment if you

create it in the context of the subassembly for which the fragment is a fragment of the first level (you

should specify the geometry source in the assembly Geometry Source: assembly), while the

subassembly itself, for a general assembly, can be a fragment of any level. If the reference element is

placed in the geometric parameters of the fragment, then, when you change the geometry, the source

of the reference element, the adaptive fragment will change its geometry, according to the change of

the source geometry, but only in the assembly. At the same time, there will be no changes in the

fragment file where the reference element is located. To change the geometry inside the fragment

file, you should update the reference element according to the change in the source geometry.

The reference element will be in the geometric parameters of the fragment if it is created in the

following ways.

· Using the Reference Element command. The fragment for which the reference element is

created should be opened in the context of the assembly for which the fragment is a level 1

fragment, and the Geometry Source: assembly, and the Create geometric adaptive

parameters options should be specified.

· When editing a fragment of the first level in the context of an assembly with the automatic

creation of reference elements (when the option  is active and you use the assembly

elements in the fragment constructions), the Geometry Source: Assembly and the Create

geometric adaptive parameters options should be selected.
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· The reference element is created automatically when you run the Detail > Create command

with the third option. 

You can cancel the creation of geometric adaptive parameters based on the reference element. 

To do this, disable the Create geometric adaptive parameters option flag in the Reference element

command parameters when creating a reference. 

Control of the Create geometric adaptive parameters option is duplicated by the icon in the panel

available when working in the context of the assembly (upper right corner of the 3D scene).

If the icon  is active - the created reference elements will be placed in the geometric parameters

of the fragment (in the case when a source is an assembly ). IF the icon is disabled, they will not be

placed.

You should carefully check this icon when automatically creating reference elements in the

context of an assembly. In some cases, the adaptability of the fragments may lead to recursion.

More information about recursions and their elimination can be found in the Elimination Recursions

Using Reference Elements section. 
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In the case of recursion, you can remove the reference elements from the geometric parameters. To

do this, call the context menu of the adaptive fragment and select  Edit. Next, in the Geometric

parameters tab, remove the reference element from the geometric parameters using the icon  or

remove all the geometric parameters using the icon .

Derived Object

The derived object (derived from object) allows you to transfer the geometry directly from a fragment

at any level to the assembly file. The basic elements of the model (3D nodes, coordinate systems,

workplanes, 3D profiles, 3D paths, bodies of various types), and geometric elements (edges, faces,

vertexes) can become derived elements. 

The derived element transfers the geometry from bottom to top. Therefore, all the principles of

working with assemblies on the "Bottom-up" principle are valid for the derived element. 

If we change the geometry in the fragment, including the geometry referenced by the assembly,

and then save the fragment, the geometry of the derived element will be updated when the

assembly is updated.

In General, an analogy can be drawn between a reference element and a derived one. A reference

element provides a "Top-down" relationship (and a link between fragments), a derived element

provides a "Bottom-up" relationship. But since the principles of updating the reference elements and

derived elements are still different, you should not confuse them.

Derived object is similar to external element (External) by the principle of operation. You need to

transfer sequentially on all levels from subassembly to subassembly only the external element, and the

derived element can be transferred to assembly at once. 

In an assembly, the derived element will be an element whose constructions tree is not available. 

Derived Element Creation 

The command for deriving an element is available in the context menu of any element (listed above).

To derive an element from a fragment to an assembly (or subassembly), you should first open the

assembly (or subassembly) file. There are two ways to select the desired fragment element to derive it

into the required assembly.

· Open a fragment in the context of an assembly, then open the context menu of the element by

selecting it in the 3D scene or in the 3D Model window and specifying Derive to assembly.
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· In the 3D model window of the assembly file, expand the fragment constructions, find the

required element and use its context menu to call the Derive to assembly command.
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In the assembly file, we can see the derived elements. For an assembly, it will be a reference element,

so the elements derived from the fragment, in the assembly file, are in the Reference elements folder.

For a fragment, these are derived elements. In the 3D Model window of the assembly file, you can find

a list of the derived elements in the corresponding folder of the fragment from which you derived the

elements. 
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Automatic Creation of Derived Element

Automatic creation of derived elements is possible when we use the command Detail > Create and

create a fragment (both adaptive and non-adaptive). 

If there are  parent elements of other bodies among the child elements of a body (which you want to

keep in a separate fragment) then such elements cannot simply be taken from the assembly. In this

case, the Derived Object is created. Derived Object will depend on the fragment and will define the

geometry of the dependent bodies in the assembly. 

For example, on a face of a body (which we want to save as a fragment), a profile is created, which is

the parent of another body. This profile will be saved with the body to a fragment file. To ensure that

the body dependent on the profile does not lose the parent element, a derived element will be

created. The derived element will return the profile that is saved in the fragment file, to the assembly.

Elimination Recursions Using Reference Elements

Upon creating adaptive fragments (the Detail > Create command the Create Adaptive Fragment

option) may be a recursion if the constructions "pulled" from the assembly depends on each other.

Let's explain this with a simple example.

Let's say you have two boxes. Construct circle profiles on one of the faces of each of the boxes. It turns

out that one profile is a child of the first box, and the second is a child of the second.

Extrude the profiles, and then subtract the resulting cylinders from parallelepipeds using Boolean

operation. You should subtract the cylinder, created by the extrusion profile, which belongs to the first

box, from the second box. And the cylinder, created on the profile of the second parallelepiped (box)
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should be subtracted from the first box. As a result, it turns out that each of the parallelepipeds has

another parallelepiped as its parent and its child. 

Call the context menu for the first parallelepiped and choose the command Detail > Create. In the

command dialog, specify the Create Adaptive Fragment option.

 

Click "OK". A dialog box with a message about recursion appears.

Four variants of recursion elimination are proposed.

1) Do not create adaptive parameters. That is, it is proposed not to place reference elements in

geometric parameters. Reference elements, unlike geometric parameters, are themselves recursive.

Recalculation of fragment begins with updates of the borrowed geometry, then the rest of the

constructions tree of the fragment is recalculated. After the fragment is recalculated, the changes
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appears in the Assembly. Changes in the geometry of a fragment causes a change in the source

geometry of the reference element of the fragment in an assembly, . But this change will only be

passed to the fragment the next time it is recalculated. This eliminates looping recalculations on

themselves. 

In this case, the fragment will be non-adaptive.

2) Break recursion in assembly element. In this case, an internal reference to the profile will be

created inside the assembly file, the parent of which is the body in the assembly (the second

parallelepiped). Therefore, for a fragment reference element, the source geometry will not be a

profile in the assembly, but an internal reference to that profile in the assembly. Since the source

geometry, for the internal reference, which is the source geometry for the reference element of the

fragment, is in the assembly, the method itself is called "Break recursion in assembly". An internal

reference that is updated only manually breaks the recursion. Since the reference is not updated when

recalculating, the geometry of the reference element is fixed, and does not depend on the change of

the parent element, and there is no recursion when recalculating the geometry of the adaptive

fragments. For the body of the second parallelepiped, a reference element is also created. The source

geometry of the reference element is the profile of the first parallelepiped derived from the fragment.

For the first parallelepiped such element is called derived.

The fragment will be adaptive in this case: there will be a reference element in its geometric

parameters.
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The internal reference that breaks the recursion is updated only manually. You cannot update it

from the Assembly Structure window.

You can find out that the internal link is fixed and is not automatically updated by its icon with the

image of a pushbutton button. To update a link, open its context menu and select Update geometry. 

3) Break recursion in reference element. In this case, an internal reference to the reference element

will be created inside the assembly file. The source geometry of the reference element is the profile of

the fragment of the first parallelepiped. For the fragment, such element is called derived. Since the
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source geometry of the reference element to which the internal reference is created, is in the

fragment, the method itself is called Break recursion in detail. An internal reference that is updated

only manually breaks the recursion. At the same time, the fragment itself also has a reference element.

The source geometry for the reference element is a profile, whose parent element is the second

parallelepiped. The body of the parallelepiped is in the assembly. 

As in the previous version of the recursion elimination, the created fragment will be adaptive: there

will be a reference element in its geometric parameters.

 

4) Add depended object to the detail. In this case, the generated fragment will contain both bodies

and will be non-adaptive (an assembly unit will be created).

The user himself can eliminate recursions with the help of internal reference elements. To create an

internal reference element, you need to call the Reference Element command while in the edited file

(not in the context of any assembly) and select the model element from the 3D scene or model tree in

the 3D Model window. 

Detach

The Detach command is based on using reference elements. The command enables you to detach a

model and all its following constructions from the specified parent element. The selected parent

element will become a reference element in this case. 

You can call the command from the context menu of the operation parent element in the 3D model

tree.
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The created reference element will be automatically fixed. In this case, it becomes unavailable for

updates upon the model recalculation or when calling the reference elements update command from

the Assembly Structure window.

After the reference element creation (detaching), all the previous operations and constructions can be

deleted. The source profile can be deleted in the given example.

The detach command will be performed automatically when the deleted model elements cannot be

deleted without losing child elements and you use the Delete command with the Exclude selected

elements from model tree option. The information about reference elements creation will be

displayed in the Delete command window.
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Filling an Assembly with Geometry

As mentioned above, when working with assemblies "Top-down", design is performed from an

assembly to its parts. The part geometry is defined by a set of parts included into the assembly. That

is, the geometry of some parts is determined by others, taking into account their position in the

assembly. As a rule, there are parts or subassemblies that do not depend on other parts – these are

parts of large frameworks, various cases, frames, fuselages, etc. This details should be created first.

They will fill the assembly with geometry, on the basis of which it will be possible to design from

assembly to parts. 

Consider a simple example. You should design a Box, the geometry of the Box Body is determined by

the required volume, dimensions, wall thickness and method of the cover fixing. Box Body defines all

other parts of the assembly, while other parts do not affect the geometry of the Box Body,

respectively, the design of the Box should start with the "Box Body" part. Create an assembly, which is

a fragment of the Box Body. There are two ways to do this.

· Create a new document from 3D Model prototype and build a Box Body, then create another

document of the 3D Model  prototype (Box file) and set the fragment Box Body into an

assembly Box using the command 3D Insert Fragment. 

· Create a new document from the 3D Model prototype, then use Create 3D Fragment

command to create a new fragment, and then create a box Body in the context of the

assembly or not in the context of the assembly (in this case it does not matter, because Box

Body does not depend on other constructions). Before you create a case, you can create the

entire Box assembly structure at once.

The first method corresponds to "Bottom-up" principle of design, the second to "Top-down" principle.

In this case, both the first and the second way will lead us to exactly the same result. In General, when

you create assemblies, you can apply both design principles at the same time.

Let's use the second method. Create an assembly file. Save it and call it "Box". Select command Create

3D Fragment. In the appeared dialog box, enter the description of the part, or Part Number, or both.

Working with the fragment creation dialog is described in the Create 3D Fragment section. Select the

3D Model prototype. The Edit in Context flag can be omitted, because there are no other bodies in

the assembly at the moment and there is no need to create reference elements for the body.

After clicking OK you are still in the "Box Body" file. In the Assembly Structure window is shown that a

fragment has appeared in the assembly. Its icon  indicates that the fragment is not adaptive. To

edit a fragment, open its context menu and select Open. In the file there are no constructions, the

coordinate system of the file coincides with the coordinate system of the assembly. Create a body Box

Body on the basis of the primitives or by creating the required standard workplanes.
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Unload Geometry with Possibility of Subsequent Updates

The dialog of the detail unloading command can be called for any single body or a single fragment

via the context menu.

Detail > Unload

There are four options for unloading are available in the dialog. 
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The first option of unloading allows you to save the body in the Parasolid format.

The first and second variants of unloading are considered in the section Save geometry from assembly

in separate file.

The third and fourth variants of unloading are considered in this section. 

The Part Number and the Description automatically create a file name on the disk. The principle of

creating a file name can be customized. To do this, click the icon  in the Description field and a

special Naming Rule dialog appears. Using the icon , you can update the file name according to

the selected naming rule.
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By default, the file is saved to the folder where the file is located from which the upload is made.

Upload the geometry with the possibility of subsequent updates

If the body was created in an assembly (subassembly of any level), you can unload it by making a part.

To do this, select the Detail command in the context menu of the body. You should select the third or

fourth option of the body unload in the Detail > Unload command, for a fragment to be created as a

fragment with a geometric parameters, but without reference elements

· Unload a detail (the Detail > Unload command) with the option Create Part Operation (Save

Solid to File that can be updated when assembly changes).

· Unload part (the Detail > Unload command) with the Create Associative Part Operation

(Save Solid to File and replace it with Fragment Operation) option.

The build tree is not available in the fragment files created by the third or fourth variant of the

Unload command. The geometry in the files is an external model. You can edit the geometry of

the fragments only when you change the geometry of the body in the assembly file. The

possibility to edit fragment files after they are created on the basis of bodies in the assembly is

given by the Detail > Create command. 

It is rational to apply the options for the creation of fragments in the assembly described in this

subsection in the case, when unloading the body using the command Detail > Create leads to

recursions (more information about recursions and their removing can be found in the section

Elimination Recursions Using Reference Elements). The other case is when you want to make a part

dependent on an assembly without using reference elements.

The two ways for creating fragments are not recommended if the fragments you are creating are

subassemblies.

Again consider the example, when we designed the Box Clip in the Box Cover file fragment and want 

to create a fragment based on Box Clip body (this example was already discussed in the section

Create Detail).

Call the context menu of the Body Clip body and select the command Detail > Unload.
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In the appeared dialog, specify the Create Part Operation (Save Solid to File that can be updated

when assembly changes) option. The principle of entering the name of the file and the choice of the

prototype is similar to the principle when working with dialog of fragment creation. In the beginning

of this section you can see a brief information about this dialog.

As a result of the command, an adaptive fragment will appear. In the 3D Model window you can see

that an adaptive fragment appeared in the Body Clip body structure.

A fragment of the first level also appeared in the Assembly Structure window of the "Box Cover" file.

This fragment contains geometric parameter "Imported Solid_1" and does not contain reference

elements. 
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The Reference Elements Tab.

The presence of the "Imported Solid_1" geometric parameter provides the link of the "Box Clip"

fragment file with the "Box Cover" assembly, i.e. the link with the file from which the geometry was

unloaded. You can transfer changes made to the source body in the assembly file to the fragment file.

To do this, select the Update command.

Only changes made for operations, which are located in the body tree before unloading, will be

transferred to the fragment file. 

For example, we can change the length of the Box Clip by changing the profile of the extrusion

operation, which is located before unloading. After changing the geometry of the clip body, call the

Update command via the context menu.
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After executing the Update command, the fragment file will be updated according to the body

changes in the assembly and saved.

You cannot transfer changes in the geometry of the body, performed due to operations that are in the

body tree after unloading, to the fragment file. For example, if we make a hole in the Body Clip and

the operation is located after unloading, the Update command will not pass the changes to the

fragment file.  
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We can add operations in an unloaded tree of the body. To do this, call the context menu of the last

operation of the body and select the Rollback Model command. Call a rollback command for the

Body Clip.

Add a hole to the Box Clip geometry. As you can see from the picture, hole was added to the tree of

body operations. To finish editing the body, you need to call the context menu for body operations or

call the context menu in the free space of the 3D scene, and select Finish Rollback.
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A hole created in this way can be passed to the fragment. To do this, select the Detail > Update

command in the context menu of the clip body. The fragment file will be updated, modified

according to the assembly, and saved.

We can pass the changes made in the fragment to the assembly. To do this, use the command Detail

> Restore Associativity. 

Make a hole in the Box Clip, not in the assembly, but in the fragment file. To do this, open the Box Clip

fragment file and make a hole in it, then save the fragment file. In the "Box Cover" assembly, call the

command Detail > Restore Associativity in the context menu of the Body Clip body.

As a result of the operation, the changes made in the fragment will be transferred to the assembly.

The Detail > Restore Associativity command will be available in the context menu only if changes

have been made to the fragment file. 
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Consider the fourth option to unload Create Associative Part Operation (Save Solid to File and

replace it with Fragment Operation). 

As in the previous case, call the command Unload through the context menu of the Body Clip body in

the assembly, but this time specify the fourth option.

Displaying the created fragment in the 3D Model and Assembly Structure windows is similar to the

previous variant of unloading.

As in the previous case, the fragment has no reference elements and has a geometric parameter

("Imported Solid_1"). The Geometric parameter connects the fragment with the assembly.

As in the previous case, the generated fragment has a link only to the assembly file from which it was

unloaded.

As in the previous case, we can make changes to the body operations that were created before the

unload and then use the Update command to upload them to the fragment file.

As in the previous case, we can add operations to the body tree before unloading – using the Rollback

Model command. 

Unlike the previous unload option, changes made to the fragment will be automatically transferred to

the assembly. That is, to update the assembly according to the changes in the fragment file, we do not

need to use the command Detail > Restore Associativity.

Make changes to the clip fragment: create a hole, then save the fragment. If you open the file "Box

Cover" then, as in the case of changing all the fragments, you will be asked about updating the

assembly. After the update is confirmed, the fragment in the assembly will be updated. 
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Parts That Do Not Depend on Assembly

The design principle of "Top-down" implies the dependence of the parts from the assembly. However,

this dependence is not always possible. For example, you may know exactly which geometry elements

of one fragment will define the elements of another, but  you don't know in which assembly you can

make them dependent on each other. Such a case is possible when the final structure of the assembly

is not yet clear, or it is hidden because of the secrecy. Then you can assign a link not through the

assembly, but directly between the files. In any case, you should specify the link between the

fragments via the assembly file. But in this case it can be temporary.

Keep in mind that the use of temporary assemblies, or the unavailability of the assembly when

editing fragments, should be caused by a real production or design need. In all other cases, it is

not recommended to apply the temporary assembly and remove the assemblies. The very

concept of "Top-down" design implies the presence of an assembly that defines all the parts

included in it.

Let's consider the case when the "Box Cover" fragment depends on the geometry of the Box Body

regardless of the Box assembly. Suppose we have an assembly "Box", in which one fragment is "Box

Body". Create a new fragment "Box Cover" with the command Create 3D Fragment, and enable its

editing in the context of the assembly. Create two reference elements using the Reference Element

command: select the top face that defines the fixing edge and the face on which the cover will rest. In

the parameters window, specify Geometry Source: initial fragment.

Exit the context of the assembly with saving . Check through the Assembly Structure window how

the reference elements were created. From the Assembly Structure window, you can see that the

fragment "Box Cover" has two referenced elements. After selecting the update option from the source

fragment (in this case we could choose the update option from the fragment of the first level, because

the result would be the same), we specified that Geometry Source is in the "Box Body" file. Source
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parameters (Get Parameters from the Document) is always the assembly file in the context of which

the reference element was created.

Despite the fact that the fragment "Box Cover" is a fragment of the first level, because when creating

the reference element, we did not specify that the geometry source is in the assembly, then there is no

connection in the reference element Assembly > fragment of the first level, and the reference

element did not fall into the geometric parameters, i.e. the created fragment is not adaptive. As you

can see, when changing the geometry source option from the assembly to another option, the option

to create geometric parameters is not available.

Let's create a Box Cover geometry based on the created reference elements.

If we change the "Box Body" fragment, the "Box Cover" fragment will convert its geometry according

to Box Body changes only after updating the reference elements. You can do it in the Assembly

Structure or 3D Model window, as shown earlier.

When the source geometry does not depend on the assembly file, we can delete the assembly

file, the fragments will not lose their links via the reference elements. 
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For example, delete the file "Box" and create a new assembly file "Box_2". Insert fragments "Cover

Box" and "Box Body" into using the Insert 3D Fragment command.

In the Assembly Structure window of the new "Box_2" assembly, you can see that the "Box Cover"

fragment as before contains reference elements whose geometry source is the "Box Body" fragment.

The source of the document parameters (Get Document Parameters from) is still the deleted "Box"

file. This means that if we needed to move, rotate, or scale a fragment for correct positioning in the

assembly, we would have to do it again. In this case, no transformation parameters were passed from

the remote assembly to the fragment, because we did not move or scale the fragments in the

assembly. 

Change the length of the Box Body in the new "Box_2" assembly, and update the reference elements

through the Assembly Structure window.
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The new assembly file "Box_2" has been updated as if we were working in the original assembly file

"Box".

Re-insert Part

Through the Assembly Structure window, you can specify to re-insert a part or subassembly. 

Any fragment of any level will be re-inserted as a fragment of the first level for the assembly file

that we are currently editing.  

Let's continue the example with the Box assembly. We need to insert the Box Clip to all remaining

positions. A fragment of Box Clip is a fragment of the second level within the subassembly "Box

Cover". If we want the "Box Clip" fragment to be a second-level fragment included in the "Box Cover"

subassembly when re-inserting, we need to open the "Box Cover" fragment. If we want to position the

fragment "Box Clip" only on the basis of binding to the geometry of the cover – you can just open the

fragment file "Box Cover". If you want to bind to all elements of the general assembly when

positioning the clip, you should open the "Box Cover" fragment in the context of the "Box" assembly.

All elements of the general assembly, to which was bind a fragment of the "Box Clip", will be

reference elements for "Box Cover" fragment.  

Let’s consider both cases.

Open the "Box" file, open the "Box" fragment in the context of the Box assembly. Turn off the

selection of assembly elements by making the icon  inactive. In this case, the binding will be only

to the cover elements. 

In the Assembly Structure window, call the context menu for the "Box Clip" fragment and choose the

Additional > Repeat insertion command.
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Next, according to the LCS insertion principle, as for the "Bottom-up" assembly, determine the

position of the fragment. Specify the source LCS on the axis of the Box Clip and the target LCS at the

axis of the Box Cover foot. Turn around the axes to determine the correct position of the Box Clip.
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Exit the context of the assembly with saving . The second fragment of the second level appeared

in the Assembly Structure window. It has a link to the same source file of the "Box Clip" fragment and

the same reference elements, because reference elements belong to the source file of the fragment.

Once again, open the "Box Cover" fragment in the context of the assembly. Now turn on the selection

of assembly elements, by making the icon  active. In the Assembly Structure window, use the

context menu of the fragment to specify re-insertion. Select the source LCS at the top of the

rectangular Box Clip hole, and the target LCS at the top of the Box Body edge (that is, the assembly

element in which you are working). Rotations around the axes determine the correct position of the

clip.
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In the Assembly Structure window you can see that a new fragment of Box Clip has appeared. It is

important to note that the fragment "Box Cover" has a new reference element. This reference element

was created automatically when the vertex was selected to specify the target LCS when the fragment

was inserted. Since the vertices of the edge Box Body in the fragment "Box Cover" is not present, it

should be borrowed from the assembly. A corresponding reference element was created.

Since the "Box Cover" fragment is a first-level fragment of the assembly, the new reference element is

also a geometric parameter of the fragment.
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Detail Duplicate

The Detail > Duplicate command is available in the context menu of each fragment. The duplicate

makes both a copy of the fragment in the assembly, with all the values of its parameters (External

Variables and Geometric Parameters), and a copy of the source file on the disk, also with all the values

of the parameters. That is, it creates two identical links in the assembly: "fragment in assembly >

source fragment file", storing parameter values both in the assembly and in the source file.

Considered an example. You have the Housing assembly, where you already placed all the screws

D4хL6. Each fragment has the same source file "Pan Head Cross Recess Screw ISO 7045". In addition,

there is one screw D5хL8, and it also has a source file - "Pan Head Cross Recess Screw ISO 7045". 

The file "Pan Head Cross Recess Screw ISO 7045" has external variables. The values of variables in the

source file and in the fragments of screws D4хL6 and screw D5хL8 are different. Create a duplicate link

"Fragment Screw D5хL8 > Pan Head Cross Recess Screw ISO 7045.grb". To do this, call the context

menu of the D5хL8 screw fragment in the Assembly Structure window. Select the command Detail >

Duplicate.

A dialog box appears in which you specify the name of the new source file and its location.
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As a result, a new fragment was created, exactly repeating the original, and a new source file, also

exactly repeating all the parameters of the duplicate.

A new fragment will have the same location in the assembly as the original, i.e. in this case, there will

be two screws in a hole. The position of the fragment, as well as all its parameters, can be changed.

Positioning, Scaling, and Variation of Fragments in Assembly (Fragment

Transformations)

In "Top-down" design, a reference element is created in the context of an assembly based on the

geometry of the fragments, taking into account the transformations of the fragment in the assembly

(i.e., its movements, rotations, scaling, and the values of its parameters). Accordingly, each reference

element needs to "know" not only the Source Geometry but also "know" the transformation of the

source-geometry in the assembly. Information about the transformations of the fragment, on the basis

of the geometry of which the reference element was created, is located in the assembly file, since it is

the assembly that determines the position and execution of all fragments. Therefore, for each

reference element, you specify not only the source file where the Geometry Source is located, but also

the assembly file in the context of which the reference element was created. For a reference element,

the assembly file is the source of the document parameters (Get Document Parameters from). 

The source of the document parameters (Get Document Parameters from) will always be the

assembly file in the context of which the reference element was created.

Considered an example. We have the Holder assembly. For example, while you do not understand

exactly how it should be located Bracket on the Support and do not understand what should be the

length of the Bracket. Therefore, you set the length of the Bracket using external variable, and the

Bracket in the assembly is located approximately.
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You need to design a Hanger. Let's create two Reference Elements that will be edges of Bracket holes.

Since you have only approximate assembly, then you should specify the file, which will contain the

source geometry – a fragment of the bracket. To do this, we specify Geometry Source: initial

fragment. 

As a result, the created fragment will have a geometry source of reference elements in the "Bracket"

file, and the source (Get Document Parameters from) of parameters (transformations) of the fragment

will be an assembly file "Holder".
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Let's create a Hanger geometry.

Suppose that our assembly was incorrect. The length of the Bracket should be different, and its

location also need to be changed. Create a new "Corrected Holder" assembly.

In the new assembly change the position of the Bracket and change its length by changing the value

of the external variable, which determines the length of the Bracket. Insert the fragment "Hanger".

The fragment will be located according to the location in the old assembly. In addition, since the

fragment "Bracket" changed its geometry only in the assembly (according to the value of the external

variable), and in the source file remained the original length, the Hanger is not located correctly along

the Support and along the Bracket.
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The example shows that the geometric reference itself is preserved, but the fragment "Hanger" has no

information about transformations of a fragment of "Bracket" in the new assembly, because  the

assembly file "Holder" remained the source (Get from Document Parameters) of parameters

(transformations) of the fragment.
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This example only shows the importance of the information contained in the assembly. Keep in

mind that the use of temporary assemblies, or the unavailability of the assembly when editing

fragments, should be caused by a real production or design need. In all other cases, it is not

recommended to apply the temporary assembly and remove the assemblies. The very concept

of "Top-down" design implies the presence of an assembly that defines all the parts included in

it.

Variations of Fragments Relations with Assembly when Designing Top-down

When designing "Top-down", the fragments should depend on the assembly. In T-FLEX CAD, there are

three mechanisms by which such a relation can be made:

· Reference Element,

· Geometric Parameter,

· External Variable.

External variables and geometric parameters of adaptive fragments can be used in the "Bottom-up"

design, and are not a new feature of T-FLEX CAD. The use of external variables and adaptive

fragments is described in the appropriate subsections: Parametric Relation definition and Adaptive 3D

Fragments. 

Creating a Reference Element is a feature of T-FLEX CAD that is specifically designed to provide link

from assembly to fragments (or directly between fragments). The reference element can be placed in

the geometric parameter of the fragment – then such a fragment becomes adaptive. 

The presence of a Reference Element in the Geometric Parameter makes it possible to receive a new

adaptive fragment variation when changing the geometry in the assembly, without updating the

reference elements in the fragment files.

Consider the possible combinations of reference elements and geometric parameters of the

fragments in the "Top-down" design. 

· The fragment is non-adaptive, without reference elements (a frequent case when a fragment is

inserted into an assembly on a "Bottom-up" design basis with the use of LCS).

· The fragment is adaptive, containing reference elements in geometric parameters (a frequent

case when working with fragments of the first level).

· Adaptive fragment containing geometric parameters (outdated methods of detail unloading)

· Adaptive fragment containing reference elements both in geometric parameters and

reference elements not in geometric parameters (a common case when working with

fragments in the context of different assemblies).
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· The fragment is non-adaptive, containing reference elements (a frequent case when working

with fragments of the second and deeper levels).

In the Assembly Structure and 3D Model windows, fragments with geometric parameters are

specified using a special icon.

The presence or absence of geometric parameters of fragments of the second and lower levels cannot

be seen in the Assembly Structure window. To do this, use the 3D model window, or open a fragment

in the context of the subassembly for which it is a fragment of the first level. 

Non-adaptive Fragment or Fragment Containing Only Reference Elements

Adaptive fragment containing geometric parameters or reference elements

in geometric parameters

External variables of the fragment, its geometrical parameters and reference elements can be seen in

the Assembly Structure window. 
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If the fragment was not created as adaptive, it can be made adaptive by adding a geometric

parameter. If the fragment was created without reference elements, you can add them by

opening the fragment in the context of the assembly and using theReference Element

command. If a fragment does not have reference elements in geometric parameters, you can

create them by opening the fragment in the context of the assembly in which it is a fragment of

the first level and using the Reference Element command. Any fragment can be made non–

adaptive. To do so, you need to delete all its geometric parameters.

In other words, we can change the variants of the fragment dependence on the assembly. 

Reference elements-cannot be removed, because they are based on the body of the fragment. 

You can prevent a reference element from being updated (either when it is created, or later through

its context menu in the 3D Model window).In this case the fragment will behave as a fragment without

a reference element, since further borrowing of the source geometry for the reference will be

prohibited.

A non-adaptive fragments without reference elements are files with geometry elements (or even

without them) that do not have Geometric Parameters.

You can create a non-adaptive fragment without reference elements  in the following ways:



T-FLEX CAD 17 Help

2282

· Using the Create a 3D fragment command without using reference elements or other

geometric parameters of the fragment.

· Use the Detail > Create command with the Create Fragment option. A construction should not

depend on other constructions in the assembly. 

·  Insert 3D Fragment is a standard command when designing "Bottom-up".

Non-adaptive fragments without reference elements should be created only if the part is not going to

change. The created fragment should be the main one in the assembly, all other fragments should

depend on it, and the fragment itself should not depend on changes in other fragments. In the case

when changes in the assembly are made using "Bottom-up" design.The fragment is adaptive and

contains reference elements in geometric parameters. Such a fragment can be created if the reference

element automatically is automatically added to the geometric parameters – detailed information is

given in the Reference Element in Geometric Parameters section.

The geometric parameters of any adaptive fragment can be seen in the properties window of the 3D

Fragment command. To call this command for an already created fragment, you can select  Edit

from the fragment context menu.

The fragment is adaptive, containing geometrical parameters. This type of fragment provides a link

only between the assembly and the first level fragment. 

When designing "Top-down", the primary binding element of the assembly is the reference element.

You can also use other tools to link a fragment to an assembly: variables and geometric parameters.

As mentioned above, a reference element can be a geometric parameter, but in this case we consider

a fragment that does not contain reference elements at all, but contains only geometric parameters.

The case when during "Top-down" designing the fragment has no reference elements, but has

geometric parameters can occur if:

· the user select the last two options of the Detail > Unload command; 

· the user calls the Create 3D Fragment command, but does not create reference elements, and

using the Adaptive Fragment command, creates geometric parameters for the fragment; 

· the user uses the Bottom-up design principle and inserts a fragment (Insert 3D Fragment) that

is created as an adaptive Fragment (Adaptive Fragment).
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The adaptive fragment is adaptive and contains reference elements in the geometric parameters and

in the reference elements not in the geometric parameters. Fragments, in which part of the reference

elements were in the geometric parameters, and part is not is a possible case. Such fragments can be

created as follows.

· If you create reference elements for a fragment in the context of different assemblies, one of

which is a fragment of the first level.

· When you edit a fragment in the context of an assembly for which the fragment is a first-level

fragment, you specify Geometry Source in the assembly for part of the reference elements, and

specify Geometry Source in the assembly for part in the fragments.

· When you create a reference element in a context of any other assembly (it is not the

assembly, where the fragment was created) for a fragment received using the Detail > Create

command with Create Adaptive Fragment option.

You must remember that adaptive fragments change their geometry according to the value of the

geometric parameters in the assembly, so the execution of the geometry in the fragment file and the

execution of the fragment in the assembly may differ. If you want a fragment that has a reference

element not in geometric parameters, to change its geometry in the assembly, you must update the

reference element in the fragment file. Accordingly, those reference elements that are in the

geometric parameters of the fragment will change the geometry of the fragment without updating

the references in the fragment file, and those that are not in the geometric parameters will change the

geometry of the fragment only after the update.

If a fragment contains a part of the references in the geometric parameters, and some – out of

geometrical parameters, it should be understood that simultaneously two different

communication methods of a fragment and the assembly are used. If you change the source

geometry of reference elements you should take care of the changes order and order of the

reference elements updates .

If you have problems updating the geometry of a fragment, you can remove the reference element

from the geometry parameters.

To remove a reference element from the geometric parameters, open the fragment's context menu

(via the 3D Model window or the Assembly Structure window) and select  Edit. You should expand

the Geometric Parameters tab in the properties window of the fragment and delete the geometrical

parameter by pressing  icon.

Non-adaptive fragment with reference elements. This variant of the fragment is one of the most

common. This fragment can be created in the following cases:
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· the user creates a fragment in the context of an assembly for which the fragment is a second-

level fragment or lower;

· the user specifies the source geometry not in the assembly, but in the fragments;

· the user cancels the Create geometric adaptive parameters option when creating a reference

element;

· the user selected the Create Fragment option in the Detail > Create command;

· the user removed reference elements from the geometric parameters of the fragment. 

3D Fragment Supplement

If you have two or more fragments in an assembly that have the same source file, but you want to

supply the geometry of only one of these fragments, you can supply the geometry of the fragment in

the assembly. It is important to change the geometry of a fragment in the assembly file without

having to edit the fragment in the context of the assembly. If you go to edit a fragment in the context

of an assembly, we will change the source file of the fragment, which means you will change the

geometry of all fragments in the assembly that refer to the edited file.

In the case when you need to supply the geometry of only one fragment of several that have one

source file – editing mode in the context of the assembly is not suitable.

Using the 3D geometry build commands, you need to modify the fragment in the assembly file, and

then re-insert the modified fragment into the assembly using the Detail > Create command with the

Create Fragment option (or the Create Adaptive Fragment option if you want to place possible

reference elements in the geometric parameters of the fragment). 

Creation of Body on the Basis of Fragment

In an assembly, you can apply all available operations to the fragment geometry. In this case, a new

body is created in the assembly, the construction tree of which will include a fragment. The resulting

body can be saved to a separate file and automatically inserted as a fragment. 

Considered an example. In the "Box Cover" assembly, there are six identical fragments Box Clip,

having one source file "Box Clip.grb".
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Modify the geometry of one of the Box Clip: Make one Clip longer than the Box and add a hole with

the help of 3D modeling commands. As a result, a new body appeared in the assembly. The edited

fragment is included into the model tree.

Now re-insert the modified fragment into the assembly. Call the context menu  for the created body

fragment and choose the Detail > Create command.
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The system will ask about the option to save the fragment file. 

If you apply, and use the fragment as a workpiece – then operations performed in the assembly will

be added to the model tree of the fragment file (inside the new fragment file you will get the model

tree with new operations done in the assembly file). If necessary, reference elements are automatically

created. If the answer is negative, then the model tree from the assembly will be moved to a new

body file: the model tree of the created fragment file contains the fragment that was edited in the

assembly. 

Lets transfer the operations made for the fragment in the assembly-to the fragment model tree

(answer yes).
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In the appeared detail creation dialog specify Create Fragment and enter its Description.

As a result of the command execution, a new fragment was created and automatically added to the

assembly. In the Assembly Structure window you can see that instead of the old one, there is a new

clip fragment with the original file "New Clip.grb".

Operations performed in the assembly were added to the model tree of the new fragment. Also, the

fragment has new, automatically created, reference elements. Reference elements were created for

those parent elements of operations from the assembly that cannot be transferred from the fragment

assembly (for more information about automatically created reference elements, see the Reference

element section).
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Supplement in Special Mode

You can rework the fragment in the assembly in a special mode: 3D fragment supply mode 

option . This option is available in the automenu of commands, which can be applied to the fragment:

Hole, Blend, Boolean (the first operand must be an editable fragment), Rib, Cut, Face Taper, Apply

material, Simplify, Deformation.

The3D fragment supplement mode option allows you to avoid creation of the bodies in the assembly

on the basis of fragments. Starting from the 16th version of T-FLEX CAD there is an opportunity to

create a fragment based on the body in the assembly, with saving a fragment of the whole

constructions tree in the file (command Detail > Create). So that this option can be considered

outdated. 

For stable operation of the system, it is not recommended to mix the two ways of the fragments

reworking: standard editing of a fragment in the assembly and editing using 3D fragment

supplement mode mode.

As in the previous case, after rework, the fragment can be re-inserted into the assembly. This is

necessary if you want to create a new source file of the fragment that contains the changes made to

the assembly in the mode of the 3D fragment supplement mode option. To do this, use the command

Detail > Create with the option Create Fragment. 

Consider the example of the Box Cover assembly. Add a hole to one of the Box Clip fragments. Call

the Hole command. Select a face on the Box Clip fragment. 
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Once the system has determined that the command is being executed for a fragment, the <Num0> 3D

fragment supply mode option  icon appears in the command automenu (at the bottom). Let's

make this option active. Enter the desired hole diameter and finish typing using  or <Ctrl+Enter>.

A hole appeared in the fragment. In the 3D Model window of the assembly, you can see that unlike in

the previous case (the 3D fragment supply mode option variant), a body based on a fragment was

not created. But a folder (Supplement) will appear in the edited fragment. It contains information

about the operations made in the rework mode.

You can save the supplemented fragment to a separate file and automatically move it to the

assembly. Call the context menu for the modified fragment and choose the command Detail > Create.

By analogy with the previous case, specify the Create Fragment option in the dialog and enter the

name "Clip with Hole".

In contrast to the previous version of the fragment supplement, the system will not ask about the use

of the fragment as a workpiece, because the body was not created in the assembly, and the fragment

will be saved in a new file with the model tree. The operations made in the assembly will be added to

the model tree in the mode of 3D fragment supplement mode option.

As a result of the command execution, a new fragment was created and automatically added to the

assembly. In the Assembly Structure window you can see that a new fragment of Box Clip with the

original file "Clip with Hole" will appear instead of the old.
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In the 3D Model window of the fragment, you can see that the hole created in the assembly is added

to the chain of the body model tree.

The 3D fragment supplement mode option, followed by the fragment creation, allows you to achieve

the same final result as saving the body from the assembly (created on the basis of the fragment) with

the indication to use the fragment as a workpiece (the first method of supplement described above).

The 3D fragment supplement mode option requires the user to be careful. it is necessary to specify

this option when executing the command, in addition, the possibility of the 3D fragment supplement

mode option is slightly less than the supplement of the fragment with the creation of a new body in

the assembly. Therefore, using the 3D fragment supplement mode option when editing fragments in

an assembly is less preferable.  

It should be remembered that any revision of a fragment in the assembly file is justified only

when there are several fragments with one source file in the assembly, and one of the fragments

needs to be changed. In all other cases, you should edit the fragment in the context of the

assembly or simply edit the source fragment file.

Fragment Geometry Check

To check the current geometry of the fragment, use the command Detail > Create with the Create a

new document by unloading the selected bodies and fragments, without changing the structure of

the current model option. The command should be called from the fragment context menu.
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Checking the geometry of a fragment may be necessary, for example, when working with parametric

fragments (containing External Variables or Geometric Parameters), because their variation may

differ from the variation in the original fragment file. To view the geometry of the fragment in a

particular variation, it is convenient to open it in a separate document, without saving it to disk.

You also need to check the fragment when you have various problems with its recalculation in the

assembly: you should understand whether the problem is at the fragment level or at the assembly

level.

Another case takes place when the fragment in the assembly was supplied with the help of 3D

modeling. Sometimes you need to understand how the original fragment looks like and what

operations it has.

For example, make holes in the housing Base fragment of the Housing assembly in the assembly. As a

result, you get a body (Body_1 Housing with Holes) where one of the operands is a fragment.
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To make it easier to understand how the fragment and the created body look like,  open the body  as

a separate document and a fragment as a separate document. 

Call the context menu in the 3D Model window for the body, call the command Detail > Create,

specify the first option.

As a result, the body for which the Detail > Create command was called is displayed in a separate

document.

You should do the same with the fragment: call the context menu of the fragment and create a detail

without saving.
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As a result, the fragment will be opened as a separate document without writing to disk.

Saving Geometry from Assembly to Separate File

To create drawings of details that have different variations in the assembly, it is convenient to save the

part to a separate file. Detail models saved from an assembly to a separate file can be transferred to

other users who, for some reason, do not need to work with the entire assembly. Therefore, a

mechanism by which the bodies or fragments that go into the assembly can be saved to a separate

file was implemented. The file can be updated according to changes in the assembly, but the changes

made in the file will not be transferred to the assembly. 

· The Detail > Unload command with the option Save body as a new detail file that will

automatically update when assembly changes.

· The Detail > Unload command with the option Export to Parasolid.

· The Detail > Create command without creating fragments (first option).

In case of changes in the assembly, a file in the Parasolid format should be saved again. Consider

these options to save the geometry in a separate file.

If there were drawings in the fragment that was saved as a separate file, they will be changed

according to the changes in the fragment in the assembly.

Save Geometry with Update Possibility

In cases when you want to save a particular variation of a body or a fragment (for fragments with

External Variables or Geometric Parameters) in a separate file, for example, to create a drawing, or

transfer to another user, you need to use the Detail > Unload command with the option Save body as

a new detail file that will automatically update when assembly changes. If you use this command, the

model constructions tree will not be available to the user.
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Suppose you have a Housing assembly (file "Housing.grb") in which there is only one fragment of the

Housing Base. The fragment has no reference elements and no geometric parameters, i.e. it is non-

adaptive and is created in the assembly using the Create 3D Fragment command.

Let's say that you started to create a cover in the assembly. The side cover should be unloaded to a

separate file and the changes from the body should be transferred to the file. At the same time, you

do not need to create a correct assembly structure and reinsert the saved body as a fragment.

In the 3D Model window, call the context menu for the Side Cover body and choose the Detail >

Unload command .
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In the dialog that appears, select the Save body as a new detail file that will automatically update

when assembly changes option. A brief description of the dialog box can be found in the Unload

Geometry with Possibility of Subsequent Updates section. As a result of the operation, a "Side Cover"

file was created.grb", and a related item appeared in the constructions tree (in the Linked details

folder). The command did not affect the assembly structure, and there will be no changes in the

Assembly Structure window. You can make multiple separate files for a single body.

You can place the generated file as a fragment in an assembly by using the Insert 3D Fragment

command. 

Insert the "Side Cover.grb" file into the assembly. A new fragment appeared in the 3D Model and

Assembly Structure windows.



T-FLEX CAD 17 Help

2296

 

Make changes to the Side Cover body and add a hole.
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To upload changes to the "Side Cover.grb " file you need to use a special command.

Icon Ribbon

-

Keyboard Textual Menu

- File > Assembly > Update Linked Details

You can call the Update command Linked Details in the Assembly Structure window through the

Actions menu (see the section Assembly Structure window).

You can update a specific detail by calling the context menu for the linked detail. In this case, there

will be no difference because there is one detail.
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The command adds a hole to the part file, and if you update the assembly, the "Side Cover" fragment

also changes its geometry.

Other context menu commands.

Delete the link with detail. Allows to break the link to the uploaded detail: the detail is no longer

associated with the assembly and cannot be updated.

Open. Opens the detail file.

Show in Folder. Show the detail file in Windows Explorer.

The Update Linked Details command is also available in the context menu. It allows you to update

details for selected objects.
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Maintain Variation of Parametric Fragment Geometry

Another important feature of the Detail > Unload command with the Save body as a new detail file

that will automatically update when assembly changes option is the ability to unload different

variations of parametric fragments, i.e. fragments with External Variables and (or) Geometric

Parameters.  

Let's go back to the Housing example. Side Covers are connected with the Housing Base by means of

screws D4хL6 and with Bracing by means of screws D5хL8. 

From the Assembly Structure window, you can see that different screw versions (D4xL6 and D5xl8)

refer to the same file. I.e. a fragment of the screw is parametric (contains External Variables) and

allows to implement all possible variations according to the standard. 

If you need to fix some specific variations of parametric fragments (for example, to create a drawing),

you need to create a separate file with one or another variation of the parametric fragment. However,

you don't need feedback to this file, but we need to be able to pass changes to the file if the variation
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of the fragment in the assembly has changed. Using the Detail > Unload command, create two files

associated with the assembly: the first with the D4хL6 variation and the second with the D5хL8

variation. 

In the 3D Model window or in the Assembly Structure window, call the context menu for the D5xL8

screw fragment. In the context menu, select the Detail > Unload command. Specify the Save body as

a new detail file that will automatically update when assembly changes option in the dialog box .

Call the file so that its variation is clear.

As a result "Screw D5хL8.grb" file was created. This action does not appear in the Assembly Structure

window. 

In the 3D Model window, you can see the created file in the Linked details folder.  As in the case

described above, when the command Detail > Unload (with the option of unloading) was applied to

the body in the assembly, you have the opportunity to transfer the geometry changes from the

assembly to the created file.
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To update the geometry of the "Screw D5хL8.grb" file, according to the changes of the fragment in

the assembly, you need to use the Update Linked Details command, or in the "3D model" window

through the context menu of the related part to call the update command for a specific file.

You can create a file with the variation of the screw D4xL6 in the same way.

Save Geometry in Parasolid Format

When you select the first item in the dialog of detail unload: "Export to Parasolid" a dialog for

exporting part to Parasolid appears. The selected items are saved in a separate Parasolid file (*.x_t).

The file does not depend on the assembly. The export operation has no effect on the assembly model

structure. 

Save Document View

If necessary, you can save a document that is opened after execution of the Detail > Create command

with the Do Not Save option. For this, open document and execute the Save command. 

Such actions are required in the case, when you need a model tree in the file of the geometry, saved

from the assembly. At the same time, the link of such a file with the assembly should be controlled

manually. if reference elements are automatically created when you run the Detail > Create command,

they should be updated in the created file if the assembly changes. You can insert the generated file

as a fragment in assemblies by using the Insert 3D Fragment command. 

Let's continue with the example of the Housing assembly. Let's say you need to save the Bracing body

that was created in the Housing assembly, as a separate file. It should be possible to work with the

constructions tree of the body. In this case, the assembly does not need the changes made in the file,

but you need to transfer the changes made in the assembly  for the detail file. This is necessary, for

example, when Bracing has different versions. Then, to create a drawing of the second version of

Bracing, you will have a 3D model in which, due to the available model tree, you can make the

required changes. The Bracing 3D model has a link with the assembly by means of the reference

elements. In case of changes, Bracing will receive the actual geometry when updating the reference

elements. You can create as many separate 3D models of a single body or fragment as you want.

Call the context menu for the Bracing body in the 3D Model window. Select the command Detail >

Create. This dialog box was described above. Select the Do Not Save option.

Enter Description: "Bracing". As a result, the "Bracing.grb" file was created. 

There will be no changes in the 3D Model and Assembly Structure windows of the Housing assembly

file.

A model tree is available  in the file "Bracing.grb". A reference element for the profile, which parent

elements cannot be taken from the assembly, was automatically created. The profile depends on the

assembly and will link the model to the assembly by means of the reference element. To update the

reference geometry, call the Update Geometry command from the context menu of the reference

element.
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You can edit the constructions and create a new variation of the detail. For example, edit the

constructions that define the profile and change the number of holes.
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You can create separate documents not only for bodies, but also for fragments. At the same time,

when you save the fragment document, the constructions tree will also be available. In this case, you

create a copy of the fragment file, but only in the variation in which the fragment is in the assembly.

Save the "Box Cover" fragment from the "Box" assembly into a separate file.

The "Box Cover" fragment has reference elements.

In the 3D Model or Assembly Structure window call the context menu for the fragment "Box Cover",

choose the command Detail > Create, and select the first option. View the opened document of the

Box Cover fragment. If the document fragment was opened correctly, save it. As a result, a separate

file is created in which the 3D model Box Cover is located. The whole constructions tree is available
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for the model. The reference elements of the fragment were also saved. They can be updated to get

the latest geometry from the assembly. 

Moving Assemblies

Calling the command:

Icon Ribbon

Assembly > Component Links> Move Assembly

Keyboard Textual Menu

<AM> File > Assembly > Move Assembly

The command serves for moving a composite document to another location in the filesystem or for

zipping the assembly into one file.

After calling the command, the Move Assembly dialog box will be displayed. In it, you need to specify

the new location and name of the moved document and the moving method:



3D Assemblies

2305

Embedding. In the embedded moving, all linked files are stored within the assembly file. This method

is convenient when you need to move a composite file to another computer, since it resolves in one

common file.

Substitution. When moving by substitution, all linked files are gathered into one folder named after

the file of the main document and located in the same folder.

In the lower pane of the Include Library Elements dialog, specify the list of libraries whose elements

are used in the current document. The flags before the names of each library allowed specifying

whether to move the library elements, to which there are links in the current document.

If necessary, you can include elements located in system folders by using the appropriate option.

External Model

Calling the command:

Icon Ribbon

3D Model > Advanced > Insert 3D fragment > External Model

Assembly > Assembly > External Model

Keyboard Textual Menu

<3MO> Operation > External Model 

The command to insert a Parasolid-format model is intended for inserting 3D models in the

Parasolid, STEP, ACIS , IGES, Siemens NX (Unigraphics), Creo/ProE, SolidWorks, Catia V5, Catia V4,

Autodesk Inventor, Solid Edge, Rhino, I-Deas, JT, PRC, VDA-FS formats. The model inserted in this

way becomes a normal operation of T-FLEX CAD. Remember, however, that an external model that is

made of several operations becomes a single object upon inserting in T-FLEX CAD. To do further

manipulations over a separate body of such model, you first need to use the Divide operation.
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Inserting an external model resembles creation of a 3D fragment, however, with limited capabilities.

Thus, for example, you cannot set the values of external variables. Neither can you select the original

attachment coordinate system (the model global coordinates are used instead).

Modes of working with external model

When inserting an external model, the current document keeps the reference to its file and its original

geometry. In the future, the user can select one of the two modes of working with the external model:

·  In the first mode, the system tracks all changes to the external model file. If the file modifies,

the external model adjusts in the current document.

·  In the second mode, the changes to the external model file are ignored. When working with

the model, the geometry is used that was stored in the current document upon the last

exchange with the model file. Nevertheless, the reference of the model file is saved in the

current document anyway, which allows reverting to the first mode. Use of this mode provides

fast handling of the current document with less memory required, however, it increases the

size of the document when saved on the disk. This mode supports working with the document

with an external model inserted in it, even when the external model file is absent.

The second mode is turned on automatically, if the system fails to find the external model file.

External model insertion

To insert an external model, you need to do the following steps:

1. Select external model file. The selection of the external model file is done in the command

property window or by the option:

<F> Select External Model

There are two additional information fields in the external model properties dialog below the file

name input field. One of them displays the full path to the selected external model file, the other one

- the external model source file (that is, the file based on which the Parasolid-format model was

created).

Information about the source file is displayed if the corresponding information is stored in the

source file.

The Open Source File command will be available in the context menu of the created external

model. This command opens the source file if it exists in the path specified, by using the

application matching the given file type.

2. Select or create source coordinate system. 
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Selection or creation of source coordinate system can be done by option:

<S> Select or create source LCS

Coordinate system of external model is used by default.

3. Select or create target coordinate system. 

Selection or creation of target coordinate system can be done by option:

<T> Select or create target LCS

This option is set automatically upon selecting the external model. Selection of the target coordinate

system amounts to selecting an LCS at which the external model’s coordinate system should be

placed. If no coordinate system is selected, the global coordinate system is used by default.

Selection of the target coordinate system can be undone by the option:

<C> Reset target LCS

The process of selection/creation of source and target coordinate systems is described in the 3D

Fragment Attachment section.

4. Define the external model parameters (optional). 

The following parameters can be defined in the operation parameters window:

· Update geometry. This parameter defines the mode of working with the external model.

When the flag is set, the first mode is used (tracking all changes in the model file). Unsetting

the flag turns on the second mode. 

· Use imported materials. This parameter supports use of the original materials of the external

model.

· Fix file version. If the parameter is enabled, the current version of the file will always be used,

if it is disabled, the older version of the file will be used when updating. By default, the

parameter is enabled.

The external model parameters can be defined in the common operation parameters dialog box

called by the option:

<P> Set entity parameters

4. Complete operation creation (  in the property window or in the automenu).

The external model will be displayed in 3D only after the creation of the operation is completed or

when previewing the result of the operation using . While creating an external model, the system

runs the consistency check on the imported model. If there are errors in the model, then a window is

displayed with the error message and suggestions for possible actions.

An external model can also be created by executing the command Importing Documents.
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Break Link with Source File

Added the ability to break the link with the source file of the external model. When this option is

activated, all parameters associated with the source file will be removed from the operation context

menu.

Topics in this section:

· Edit External Model

· External Model Parameters

Edit External Model

You can change position of chosen external model or replace it with another one, loaded from a file

with the help of this command.

Calling the command:

Icon Ribbon

-

Keyboard Textual Menu

<3EMO> Edit > Operations > External Model

Available options:

<Esc> Cancel selection
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<A> Select All Elements

<R> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4> Execute Edit Command

<R> Change Definition

<Del> Delete entity

<Esc> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the External Model command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

External Model Parameters

Common tab

The General tab sets the common operation parameters.

Operation tab

The Operation tab duplicates parameters from the service parameters window (see External Model

section).

Transformations Tab

This tab allows you to perform the necessary transformations for the external model (see

Transformations section).

Mate Transformations Tab

On this tab, you can delete transformations of mates created after creating the external model (see

Mechanism Motion section).

Common properties

Set as Default. When this option is activated, the selected set of parameters will be set for subsequent

operations to be created.
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3D Picture

Calling the command:

Icon Ribbon

3D Model > Advanced > Insert 3D Fragment > 3D Picture

Assembly > Assembly > 3D Picture

Keyboard Textual Menu

<3I> Operation > 3D Picture

Unlike fragments, a 3D picture is a hull of a three-dimensional object, without parametric properties

and relations between the picture elements. 3D pictures are used for creating three-dimensional

assembly structures.  

3D pictures cannot be used as the references for creating other elements, since their faces cannot be

selected. You cannot use 3D pictures in Boolean operations either. Their 2D projections cannot be

created. The Exploded View command cannot be applied to 3D pictures.

You can insert into a T-FLEX CAD document the 3D picture files in the following graphic formats: *.grb

(T-FLEX CAD files), *.wrl (VRML files), *.iv (Open Inventor files), *.x3d, *.tf3d, *.3ds, *.ply, *.obj, *.stl,

*.dxf, *.dwg, *.3mf, *.glb, *.gltf.

To save a 3D picture is part of a T-FLEX CAD document, that already contains a 3D model, set the

parameter Save 3D Picture on the Save tab of the document parameters dialog box. 

To save a 3D picture in a separate file in the *.iv, *.wrl, *.3d, *.ply, *.obj, *.stl, *.3mf, *.glb, *.gltf formats,

use the  File > Export command.

It should be remembered that when storing a 3D picture inside a T-FLEX CAD file, the amount of

space occupied on disk increases significantly. The size of the 3D picture, in turn, depends on the

grid density set in the document parameters at the time of picture creation.

Upon calling the command, you get the access to the following actions:

<Q> Repeat existing 3D Picture

<F> Select 2D Fragment

<S> Select or create source LCS

<T> Select or create target LCS

<O> Select file

<R> Repeat previous 3D Picture

<I> Multiple iterated insertion of 3D picture 

To insert a 3D picture into an assembly, you need to do the following steps:

1. Select a 3D picture. 

The selection can be done in two ways:

· By applying a new 3D picture (the option );
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· By selecting an already inserted 3D picture (the option );

· By selecting an already inserted 2D fragment, using its 3D model (the option ).

2. Select or create the 3D picture's source coordinate system (the option ).

3. Select or create the target coordinate system (the option ). Only existing coordinate systems in

the current document can be used as the target coordinate system.

4. Define the 3D picture parameters (optional).

5. Finish inputting the 3D picture (  in the automenu or in the property window).

Files can be selected either from the T-FLEX CAD library or from any folder on the disk.

In the drop-down list of option  you can choose one of the three sources for the 3D picture.

When you select option Select and make embedded, inserted 3D picture will be stored in the current

document, not in an external file. Option Select Embedded Document appears only for files with

embedded documents.

The name of the selected/internal document will be shown in the command's properties window. Grey

(not accessible for editing) field, located a little below is informational and shows the absolute path

to the file from which the picture is taken.

If you click on the button to the right of the file path after selecting the file path, a drop-down list will

appear:

The first three options are the same as for option .

Option Make external allows uploading of the embedded picture to an external file. Option Clear

allows quick removing of the pathname.
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After adding 3D picture, you can change its position in space with special manipulator that appears in

3D window. By default, the origin of the manipulator is located in the center of the bounding box. If

necessary, you can change the position of the manipulator by using option  Select or create

source coordinate system. Unlike the creation of 3D fragment, the original coordinate system of the

3D picture cannot be bound to the picture, because it has no geometric data. In the rest, the process

of selection/creation of source and target coordinate systems is similar to the process of inserting 3D

fragments. This process is described in the Transformations of 3D Elements section.

When creating a 3D picture, you cannot set the values of external variables. The 3D image is

inserted with the values of the variables that are set in the 3D image drawing file at the time of

its saving.

Use of 3D Pictures for Creating Layouts

When creating layouts based on objects with fixed dimensions, we recommend using 3D pictures.

When rebuilding such 3D assembly models, 3D picture regeneration is much faster than assemblies

consisting of 3D fragments.

The layouts using 3D pictures are created in the same way as those based on 3D fragments, with the

only difference that the 3D picture is not created automatically when inserting a 2D fragment. The 3D

picture is inserted manually by selecting the 2D fragment.

You can get the detailed description of this system capability in the section 3D Layout with the

corrections for 3D pictures.

Only fragments that were saved with enabled option Save 3D Picture, can be used for layouts.

Transformations Tab

Transformations of 3D picture (translations and rotations) are displayed in the Transformations tab.

Optionally section of the parameters window. Optionally, you can specify exact values for any

transformation in the list.
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Scaling Tab

In the parameters window, you can specify the scale of 3D picture. The scale may be uniform along all

axes or can be set separately for each axis. To specify a non-uniform scale it is necessary to remove

the flag Uniform scale.

Options Tab

In Options tab you can set flag Create internal document. If the flag is active, the picture file is saved

in the current document. This allows you to increase the speed of data loading. Otherwise, when you

open a document, the system loads an external picture file.

Usage of Coating Materials

You can apply coating material for 3D pictures. There are two ways to do it.

The first way is to apply the coating material to the 3D picture using “drag'n'drop” function. For this

purpose, you need to open window Materials and to use the coating material from the list of model

materials or from the Coatings library.

The second method is to choose the coating material in the properties window of 3D picture. To do

this, press option  in automenu and choose the Common tab. Then, in the drop-down list of field

Source select option From Document. After that, the field Material becomes available. In this field,

you can select the coating material for 3D picture.
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It is important that the coating material can be applied only for the entire 3D picture, because it

represents a single object.

The option Apply by UV coordinates is available in the parameters of 3D Image. The option allows to

apply material by UV coordinates that are stored in the 3D image file.

Additional Information

For the inserted 3D picture can be specified the units of measurement. After that, its size will be

automatically recalculated. This function is useful for formats, which do not contain data about source

measurement units of the picture. In this case, system will use measurement units specified in section

3D of Set Document Parameters  command.

Topics in this section:

· Edit 3D Pictures

· 3D Pictures Parameters

Edit 3D Pictures

To edit a 3D picture use command:

Icon Ribbon

-

Keyboard Textual Menu

<3EI> Edit > Operations > 3D Picture

More information about this command can be found in the chapter Editing.

When editing a 3D picture it is possible to replace it with another one. This new picture can be either

loaded from a file or can be defined by selecting other existing picture from the scene. For the last

case, you need first to use option:

<F4> Execute edit command 

Next you need to select option  in automenu and click on any existing 3D picture in the scene.

Current 3D picture will be replaced with it.
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Available options:

<Esc> Cancel selection

<A> Select All Elements

<R> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4> Execute Edit Command

<R> Change Definition

<Del> Delete entity

<Esc> Exit command

<M> Transformation (calling the Transformations command) 

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). Resetting the

element is exactly the same as the External Model command.

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).
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3D Pictures Parameters

Common tab

· Name. In this field, you can specify the name of the operation.

· File Name. This option is available after the file for creating a 3D picture is selected. The file

name or path to it is entered automatically or manually in the field of this parameter. If the file

name is not known, then you can use the button with three dots. If you specify a name without

a path, then you should specify the extension and in the Set System Options command (Folder

tab) set the directory in which the file will be searched.

· File Path. This parameter is informational and shows the path to the file where the 3D picture

is stored.

· Internal Document. Allows you to make a 3D picture embedded.

· Units. The parameter specifies the units of measurement for the 3D picture.

· Level. Layer. System-wide parameters.

· Hide. A parameter that controls the visibility of the 3D picture in the scene. If the value is 0, the

image is visible, if it is 1, it is not. The parameter can be controlled using a variable.

· Material (see the 3D Picture section).

Transformations Tab

This tab allows you to perform the necessary transformations for the 3D pictures (see

Transformations).
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Mate Transformations Tab

On this tab, you can delete transformations of mates created after creating 3D pictures. (see the

Mechanism Motion section).

Common properties

Set as Default. When this option is activated, the selected set of parameters will be set for subsequent

operations to be created.

3D Placement

T-FLEX CAD has additional mechanism of 3D fragments positioning – 3D placement. It allows you to

quickly create arrangements in 3D scene by using special attachments to the floor, walls, ceiling, and

horizontal surfaces. Attachments are determined with the help of connectors with the specific

parameters. 

Fastenings for 3D Placement 

3D placement fastening – is LCS - connector, which contains the value with special name

<prefix>_<type> type, where

<prefix> substring defines fastening type for the LCS and may take one of the following values:

· SOURCE (SOURCE_<type>) –initial fastening. This type is specified for objects that will be

moved in scene (for example, furniture elements).

· TARGET (TARGET_<type>) –target fastening. This type is specified for objects that define

attachment planes (for example, wall or floor) or fastenings. 

<type> defines type of connectors that interacts with the current LCS. Acceptable versions of <type>

depend on the attachment type.

There are two available types of attachments: LCS –planar face and LCS-LCS.

· LCS – planar face – a fragment with the connector SOURCE_ <type> will be moved in the

plane of object with connector TARGET_<type> if they have the same <type>.
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Sofa moves on the floor plane

· LCS-LCS – the connector with SOURCE_ <type> fastening will be matched with one of the

existing in assembly connectors with type TARGET_<type>, if they have the same <type>.

Cupboard is attached to one of the “LCS-LCS” fastenings.

More information about attachment types can be found below.

A single connector can contain several <prefix>_<type> values simultaneously. Thus, it can define

several fastenings for 3D placement.

SOURCE_<type> fastening will be attached to the TARGET_<type> fastening according to the

3D placement rules, only if fastening is defined in the document of 3D placement object. You can find

example of the fastening creation below.

Fastening TARGET_<type> can be specified based on any connector of the current document.

Attachment rules

As it was said above 3D placement objects can be attached according to the LCS–planar face and/or

LCS–LCS rules.  

Attachment Rule LCS–planar face 

There are the following types of the LCS–planar face attachments: <type> = {WALL, FLOOR, TABLE,

CEILING}. Below are pairs of initial and target fastenings corresponding to these types:

SOURCE_WALL TARGET_WALL

SOURCE_FLOOR TARGET_FLOOR

SOURCE_TABLE TARGET_TABLE

SOURCE_CEILING TARGET_CEILING
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To specify the LCS–planar face attachment it is necessary to define the attachment plane and a set of

associated faces of the target fastening connector. 

The associated faces are highlighted with yellow color. 

The attachment plane is specified by the center of target fastening LCS and by the attachment axis. 

The X-axis of the target fastening LCS is the attachment axis for the WALL type.

The Z-axis of the LCS of the target fastening is the attachment axis for the FLOOR, TABLE and CEILING

types. In addition, the associated faces of the connector must lie in the attachment plane. 

Face outside the attachment plane will not be considered in the placement mode. 

You must follow particular rules for successful result:

· The Z-axes of all fastenings inside the fragment of 3D placement must be coaxial. The

placement object orients itself according to the Z-axis of global coordinate system upon

insertion;

· The Z-axes of all other fastenings must be coaxial with the Z-axis of the global coordinate

system;

· The initial fastening of every separately taken type SOURCE_<type> must be unique in the

fragment document for the 3D placement.

Example of Fastening with Target Type Creation 

LCS was created for the “Floor” object. Its Z-axis is coaxial the Z-axis of the global coordinate system.

The LCS is set as connector.

  

The attachment of target fastening TARGET_FLOOR is set for the connector. Position of LCS center and

direction of Z-axis specify the plane in which the inserted fragment with SOURCE_FLOOR fastening is

moved. 
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The associated face lying in the attachment plane is specified. The face is highlighted with yellow

color.

System analyzes all “SOURCE” type connectors in fragment’s document when you insert the fragment

into assembly and selects possible attachments. Only the pairs of connectors with the values of the

same type can be attached. For example, it can be “SOURCE_WALL” and “TARGET_WALL”.

If the associated face is not set, the fragment is moved in such way that axis of the LCS of the

initial and target fastenings coincide and the center of the LCS of the initial fastening lies in the

attachment plane.

Attachment Rule LCS–LCS

You can specify any name for <type>, when you use LCS-LCS attachment rule. The only exception is

that you can’t specify names used for LCS-planar face rule given above. For example, you can specify

source fastening name SOURCE_POINT.

You can specify several connectors with the same names. In this case, the set of fastenings will be

created and the fastening of the inserted fragment will be linked with it.

When you insert a fragment with initial fastening, it will be transformed in such a way that the LCS of

the initial and target fastenings coincide.

If there are any associated elements specified for fastening, they will be automatically selected when

you point the cursor on them.

Source Fastening Creation

For a fastening creation, you need to follow the next steps:

1. Create a new LCS. Its Z-axis direction should coincide with the Z-axis of the global coordinate

system. On the General tab specify type Connector and select the Use for Fragment Insertion option.

Next, you need to specify the connector name on the Connector Values tab, according to the

described above rules. In the example, SOURCE_FLOOR name is specified. SOURCE means that the

initial fastening was created for the chair. The Expression is set to “1” for all fastenings.
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2. It is necessary to set Type of insertion – 3D Placement in the status of the fragment to insert it using

the 3D placement mechanism. You need to activate Set Document Parameters command for this

purpose and open 3D Fragment tab.

Insert 3D Placement Element 

Fragment insertion is performed using command:
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Icon Ribbon

3D Model > Advanced > Insert 3D Fragment

Assembly > Assembly > Insert 3D Fragment

Keyboard Textual Menu

<3F> Operation > Insert 3D Fragment

If the fragment insertion type is set to 3D placement, the Placement command activates

automatically. 

To attach the fragment by the 3D placement method it is required to create source placement

fastenings (SOURCE_<type>). Target fastenings should exist in the assembly file (TARGET_<type>).

They can be created directly in the assembly document or be raised from 3D fragments that already

exist in the assembly.

The body intersection checking is dynamically enabled when inserting 3D fragments in the 3D

placement mode to ensure correctness of elements placement.

The fragment is moved and rotated using special manipulator, which degrees of freedom depend on

the attachment type. 3D placement object with the specified single attachment LCS–Planar face can

be rotated around axis of the attachment, if this attachment has the type FLOOR or TABLE. For

rotation, it is possible to use manipulators.
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You can translate fragment along the attachment plane after clicking  on it. The fragment will

follow cursor according to the attachment rules.

You need to enter its edit mode and to select item Edit in the fragment context menu to activate the

3D placement mode for the existing fragment.

3D Placement Properties

The 3D Placement properties window appears after pressing button Edit.
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Objects Tab

You can specify translations for several fragments in assembly without exiting 3D placement mode.

Selected fragments will be added to the Objects list in the properties window. The last selected

fragment is highlighted with green color.

You can select fragments from the list again, to continue their movement.

All objects movements made in the 3D placement mode are stored consequently. When you press

, the last performed movement will be discarded.

Use button  to delete a fragment from the list and discard all its changes.

3D Placement Tab

The set of available LCS–Planar face attachments is displayed in the 3D Placement list of the

properties window. The attachments can be single (for example, Floor, Wall) or double (Wall–Floor).

Consider snap borders. The parameter allows to consider borders of attachment object. In this case,

you cannot translate fragment over boarder of the target object. For example, movement of a table

will be limited by the floor space.

Consider intersections. When the flag is set, objects can’t intersect each other. 

Connection distance. The flag specifies distance between two LCS – LCS fastenings at which they will

be activated. 

Automenu Options

There are following options in the automenu:

Option  Apply changes appears if at least one fragment was moved. The option allows applying

all changes to all fragments in the Objects list without exiting command. Currently selected fragment

stays in the Objects list.
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Option  allows to change location of a fragment manipulator. It is located in the center of bound

box   by default. The manipulator is placed according to the LCS position when option  is

selected.

When the option  is active the fragment will be automatically updated after applying changes in

its variables.

Positioning of 3D Placement Objects

Single LCS–Planar face attachments are specified by parameters of the connector in the3D fragment

document. Double attachments are formed by the procedure of insertion of 3D placement object

from all possible pairs of single attachments satisfying the condition: double attachments can only be

WALL–FLOOR, WALL–TABLE and CEILING-WALL.

When object is positioned by a single LCS–Planar face attachment, it is required to point the cursor of

the mouse at the associated face of the target fastening of the desired type.

It is required to point the cursor at the associated face of the target fastening of the WALL type when

positioning an object based on the double attachment.

The presence of the FLOOR or TABLE target fastening is determined by the positioning

procedure. If the second attachment is absent, the object will not be positioned based on the

double attachment.

Attachments by LCS–LCS rule are displayed in the scene only when the attachments by the LCS–Planar

 face rule are not used. In this case the Without attachment option is selected for the inserted

fragment in the Attachments list. All possible target fastenings by the LCS–LCS rule are displayed in

the scene with the green sphere. Upon selection of one of these spheres the connection between the

initial and target fastenings is established, and the selected target fastening will be highlighted with

red color.
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Attachments by the LCS–LCS rule can be used indirectly, when attaching a fragment by the LCS–Planar

face rule. When you move the fragment in 3D scene, system can automatically “grab” the LCS–LCS

attachment.

When the fragment with connector value TARGET_<Type> is moved, the related fragment will be

moved too, if attachment LCS – LCS is set between them.

3D Layout

In the 3D fragment command, there is a way to manage 3D fragments created from 2D fragments –

Layout mode. In layout mode, 2D and 3D fragments are linked to each other, which allows

synchronous movement of both 2D and 3D 

In the layout mode, 2D and 3D fragments are bound to each other, which ensures synchronous

movement of both 2D and 3D objects using manipulators.
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In order for 2D fragments to be bound to 3D fragments, the following steps must be performed:

1. Create a 3D model drawing on the required view.
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It is important that the overall dimensions of the drawing and the 3D model are the same. If the

model is parametric, then the created image should also be rebuilt when the parameters

change.

2. Create a drawing fixing vector by linking it to the required workplane:
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3. Insert a 3D fragment into the assembly by enabling layout mode:
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4. Go to the 2D drawing, enable the display of workplanes on the page using the Pages command in

the Edit ribbon tab and go to the page of the required workplane.

5. Call the Fragment command in the Assembly ribbon tab.

Activate the automenu option:

<W> Project 3D fragments to workplane

Select the required workplane and body.
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As a result, a 2D fragment corresponding to the source 3D fragment will be created. The position of

both fragments will change when the position of either of them changes.
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For more information on using a 2D fragment as a projection for a 3D fragment, see Inserting

Fragments into a Drawing section.

Mechanism «Smart Fragment»

The Smart Fragment mechanism allows us to develop parametric library elements whose insertion

scenario is described in the program stored directly in the file of the given library element or in the

external module (DLL). Settings of T-FLEX CAD macros and also the program interface (Open API)

allow us to describe settings in such a way that upon insertion of the file as a fragment or upon its

editing/deletion the user-specified macro will be executed.
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The macro can contain code realizing the required logic of the user’s interface on

insertion/editing/deletion of the given fragment. For example, the adaptive model «Groove» was

developed that has a set of external variables and adaptive parameter – circular edge which must be

substituted upon insertion of the fragment.
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This model can be found in the examples library - Examples > 3D Assemblies > Smart fragment

> Groove.grb.

The «Groove.grb» file contains the macro InsertGroove which performs selection of exclusively circular

edges located at the intersection of the external cylinder and the planar face. Upon insertion of the

given groove from the library the macro is launched automatically. Instead of regular command of

insertion of a 3D fragment with the full interface, the simplest command is working at this moment

that allows us to select the edges satisfying the given condition and to change the values of external

variables of the inserted fragment.
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The result of insertion of the fragment by this scenario is the small groove on the shaft.
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This model can be found in the examples library - Examples > 3D Assemblies > Smart fragment

> Shaft.grb.

This mechanism allows users-programmers to create the most convenient scenarios of fragments

insertion in various applied fields.

3D Connectors Usage

The 3D connector is a LCS, which is assigned named values. Named values contain information

(variable values) that the 3D connector must pass to the 3D fragments connected to it. For example,

among the bolt fragments included in the library of the standard T-FLEX CAD elements, 3D fragments

containing data about the current diameter of the bolt were created. Upon snapping the fragment-nut

(from the same library) to such 3D connector, the nut diameter will be automatically replaced with the

value taken from the 3D connector.

For more information about 3D connectors, see the 3D Connector section.

Example of working with 3D connectors

As mentioned above, when connecting a 3D fragment (for example, a washer) to the 3D connector of

another 3D fragment (for example, to a bolt), the diameter of the washer will automatically be

assigned a value read from the 3D connector. For successful automatic connection of variables with

the 3D connector, certain conditions must be met:

1. The 3D connector should be assigned named values. The names of these values will later be the

link between the variables of the 3D fragment having a 3D connector (bolt) and the variables of

the connected 3D fragment (washer).

It is recommended to set semantic names for the named values of the 3D connector, adhering to

the same naming rules in all 3D models. This will simplify the establishment of connections

between the values of the connector and the external variables of the fragments attached to it.

For example, a named value of DiameterOuterMetricThread can be set for a bolt, from which it can

be understood that we are talking about the nominal diameter of the outer metric thread (this

diameter is regulated in the bolt by the variable "d")...
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If necessary, you can also set associative elements and insertion rules (see the 3D Connector

section).

2. Since the inner diameter of the washer (variable "d0" of the washer) must take the value of the

outer diameter of the bolt (variable "d" of the bolt), a named value corresponding to the value of

the mating 3D connector, i.e. DiameterOuterMetricThread, must be set for the corresponding

variable washer ("d0"). You need to set the value name for the variable in advance in the fragment

file in the variable editor by changing the variable parameters.
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The result should be the following connection:

3D Connector value in the

LCS command

3D Connector value in the

Variable Editor

Bolt DiameterOuterMetricThread -

Washer - DiameterOuterMetricThread

3. When inserting a 3D fragment of the washer, you need to select the 3D bolt connector. The

variable "d0" of the washer is automatically assigned the value of the variable "d" of the bolt

immediately after selecting the 3D connector. The geometry of the 3D fragment of the washer is

recalculated according to the new value of the variable "d0".
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An example of creating and using 3D connectors is also described in Lesson 4: Library Item

Creation in the Parameterization section of the T-FLEX CAD tutorial.

Mates and Degrees of Freedom

In the process of designing solid assembly models in T-FLEX CAD, it is often necessary to specify

mutual position of parts, which may not always be accomplished by the conventional technique of

fixing by LCS adopted at T-FLEX CAD. This is due to the fact that changes in part positions may have

to be reciprocal. A given part can simultaneously have multiple contacts with other movable parts.

When using the approach based on LCS, recursive dependencies of references may occur in such cases

(a part's dependency on itself). Such tasks may occur, for example, when building models of

mechanical systems (mechanisms). To handle such tasks, mates are introduced which are the system

elements that allow imposing various dependencies on the geometrical objects of two component

operations (3D points, axes, curves, planes and surfaces).

 

A model of a mechanism designed with the use of mates can be animated in the special command,

where you move its parts by the mouse.
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To fix a 3D fragment using LCS, you can specify additional conditions in the way of the permitted

degrees of freedom. If such a 3D fragment is later attached via an LCS to another constrained

element, then it will be included in calculations of the constrained mechanism. The method of

positioning the selected parts by using mates is to be used as an auxiliary way of fixing together with

the use of fixing by local coordinate systems. The use of mates requires additional computational

resources for evaluating solutions. Therefore, we recommend using mates in the cases when other

approaches to the described tasks are not suitable for some reasons.

What is a mate?

The "Mates" tool serves for mutual attachment of assembly model elements. It allows positioning

those according to the specified geometrical conditions. These conditions define the mutual situation

of the three-dimensional model objects (such as faces, edges, vertices, characteristic points, axes of

surfaces of revolution, etc.) with respect to each other. The system automatically resolves the specified

set of mates and situates the objects in the way satisfying the specified conditions. Mates allow

precisely positioning the parts of the mechanism being designed with respect to each other. Those

allow to impose certain properties in a mechanism's model and determine how its components move

and turn with respect to other parts. Combinations of different mates can be used for more precise

definition of the restrictions on an assembly element's position with respect to another element.

Relations between pairs of components are associative. If one part is moved then another part will

move along. For example, if a screw is tied to a hole, then relocation of the hole will cause the screw

to follow along.

Mates are imposed on pairs of geometrical objects. Those either connect two components together or

fix a body to its environment (with respect to a fixed object). A fixed object is an object with all its

degrees of freedom restrained or a one whose position in the space remains still. It is recommended

that at least one component be fixed in the space. This creates a "ground" for all other constrained

parts and can prevent an unexpected dislocation of a mechanism's components.

Each mate appears as a model object having its place in the model structure. As a fully functional

system object, a mate has a name, working properties and is displayed in the 3D model structure. The

user can turn off some of the mates in order to temporarily exclude those from the general solution.

This allows experimenting with various types of mates without redefining the mechanism

interdependencies.
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Binding a 3D fragment by LCS

A 3D fragment applied to an assembly using local coordinate systems can also participate in a 3D

model built on mates. To determine the behavior of a 3D fragment relative to the binding LCS, the

allowed degrees of freedom are set in the fragment parameters. There are 6 degrees in total – 3 for

movements and turns relative to the axes of the LCS. For each degree of freedom, an additional

restriction of movement can be set in the form of a range of values.

You can also pre-set the degrees of freedom in the parameters of the source LCS, in the fragment file.

When inserting a 3D fragment, conditions with degrees of freedom are copied into an instance of the

3D fragment and subsequently taken into account when calculating the complex of interfaces of the

designed 3D assembly model.

If the target LCS was not specified when creating the 3D fragment, i.e. the fragment was bound

"by default", then the mechanism of degrees of freedom will not be applicable to it.

When designing integral assemblies-mechanisms using degrees of freedom and mates, it is important

to take into account the following point. A 3D fragment that is added to an assembly with an LCS

binding can either be associated with some component of the assembly, or not. In the latter case, the

behavior of the component when moving assembly components may not correspond to what is

expected. For example, it will remain in place when the surrounding parts move, or, conversely, its

movement will not cause the neighboring parts to move.

In order for a 3D fragment to be connected to another component, it is necessary that its target

binding LCS be built on the geometric objects of this component. Otherwise, it will be tied to a

stationary environment.

To create complex assemblies, the "Aggregates" mechanism is implemented in the system. This

mechanism allows you to create interfaces first in the 3D fragment model, which will later be

automatically taken into account when such a 3D fragment is working in the assembly.

To create a mate, use the Create command in the Assembly tab, the Mates group.

To dynamically view the movements of the assembled mechanism, use the Move command in the

Assembly tab, the Mates group.

Optimal length of mated chains

When creating a mechanism, one part "clings" to the external environment, other parts are joined to

each other by means of mates. Thus, a number of parts sequentially docked with each other can be

represented as a chain of mates. If several other parts are connected to one part at the same time,

then the chain of mates branches. When creating mechanisms, it is necessary to strive for the shortest
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possible chains. Shorter chains are solved faster and at the same time there is less error in

calculations. 

Consider the following typical example - it is necessary to create a model of a simple mechanism

shown in the figure. The mechanism is a joint of a hinged type, combining three parts together - a

support, a lever and an axis. The most rational way in this case would be to create two small chains of

mates, rather than one long one.

The lever must be immediately tied to the support with the help of alignment mates and the

coincidence of flat faces. The axis is also tied to any part, for example, to a support, using alignment

and coincidence. It turns out two chains of mates: support-lever and support-axis. In this case, it would

be irrational, for example, to tie an axis to the support, and to tie a lever to the axis, since a longer

chain of "support-axis-lever" conjugations would result.

Mechanism example Mechanism parts

Complicating the mechanism (adding new mates)

Of course, in such a simple example, there will be no noticeable deterioration in system performance,

but in more complex cases, the difference becomes noticeable.
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                     Rational chain                                                                           Irrational chain

Topics in this section:

· Types of Mates

· Creating Mates

· Techniques for Working with Ready-made Mates

· Mechanism Motion

· Recommendations on Combined Use of Fixing by LCS and Mates

· Processing Possible Errorneous Cases

Types of Mates

When defining geometrical ties in the form of mates, you can use only the following geometrical

terms: 3D point, axis, curve, plane, surface. In order to specify the geometrical data, the user selects

topological elements of the model or construction elements. Use of 3D construction elements is

possible under the condition that those are constructed based on an operation body. Otherwise, the

second component will turn out to be bound to the still environment. 

Upon fixing by construction elements, you lose the capability of dynamical articulation of the

given connection in the constrained mechanism; therefore, if possible, prefer to use the model's

topological elements (vertices, edges, faces, etc.)

When creating mates, make sure to understand the difference between the geometrical data used by

mates and topological objects used for selection. For example, a flat face has boundaries, while the

plane used in the mate is infinite. Therefore, the created geometrical relation based on a flat face will

still be valid beyond the boundaries of this face.

If necessary, you can mate 3D fragments through 3D nodes derived in them and other

construction elements.

Coincidence

This type of mate insures full coincidence of one geometrical object with another one. The number of

remaining degrees of freedom depends on the geometrical type of the objects being joined. For

example, aligning two points will create a spherical joint that blocks any translation while allowing

any rotation. Aligning a point and a curve will allow elements to rotate, and also to slide along the

curve. The following table shows the possible combinations of geometrical elements when using the

coincidence:

A point can be aligned to any geometrical object. If two flat faces are selected, those will lie in one

plane. Coincidence of an axis and a plane will insure the axis' placement on the plane of a flat face.

The condition of coincidence between a point and a solid insures the point's placement being

maintained on the solid's surface.

Upon selecting a circle and a conical surface, matching of the selected surface and the circle is

realized in such a way that the plane of the circle is perpendicular to the axis of the cone.

Using the coincidence in combination with other types of mates allows imitating various mechanical

connections. For example, coincidence of a pair of 3D points provides for a spherical joint.



T-FLEX CAD 17 Help

2344

Parallelism, perpendicularity

These types of mates represent a special case of the "angle" mate type. These insure mutual

parallelism and perpendicularity of the selected geometrical objects. The following table presents the

possible combinations of geometrical elements when creating parallelism or perpendicularity mates:

Tangency

Tangency insures a constant physical contact between two geometrical objects. Depending on the

geometry type of the interacting objects, a contact may be occurring in one point (example: a plane

and a sphere) or along a line (a plane and a cylinder). This type of mate can be set between two

planes, a plane and a surface, two surfaces. Tangency between an arbitrary body and a surface works

only for a spherical surface. 

Sometimes, there are several possible solutions to connecting the selected objects. For example, if a

plane and a sphere are selected, then the solution yields two tangency points. In the case of a non-

unique solution, the system makes a decision automatically. Normally, the nearest point to the current

location of the mechanism is accepted as the solution. To transit to another solution domain

attainable by the moving mechanism, use the "dragging" motion mode (see below).

1. First solution for tangency 

2. Spherical surface (first constraint member)

3. Cam surface (second constraint member)

4. Second solution for tangency 
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In the case of a non-unique solution, it is recommended to bring the components being

constrained into the area of the desired result before creating the mate. Parts of a constrained

mechanism can be moved within the command Move Mated Components. The components that

were not yet subjected to mates, can be moved by using the command Transformation.

Concentricity

"Concentricity" is a special case of the "coincidence" mate type. It insures coincidence of two axes.

This type of mate is a most commonly used one. Normally, this mate type is engaged in combination

with other types. For example, to snap a part with an axis to a hole, coincidence (of flat end faces) is

used quite often in combination with concentricity. To define concentricity, one can select model

elements suitable for defining an axis (surfaces of revolution, elliptical edges, straight edges, etc.).

The diagrams show constraining parts of a schematic hydraulic cylinder by concentricity. Other parts

of the simple mechanism arc connected by local coordinate systems. For viewing convenience, some

parts of the mechanism are sectioned along the axis.

1. Attachment by LCS - Allowed is the rotation about X-axis

2. Attachment by LCS - Allowed is the rotation about X-axis

3. Attachment by LCS - Allowed are rotations about and translation along the X-axis

4. Concentricity constraint has been created

Distance

The "Distance" mate defines a relation between two objects by fulfilling the condition of maintaining

a specified distance between two geometrical objects. One can specify the conditions of types "no

greater than", "no less than" or "equal" to the specified value.

The following table presents the possible combinations of geometrical elements when creating the

"distance" mate:

This type of mate can be used, for example, for defining an object's shift or for restricting mutual

penetration of faces. To define a restriction on mutual penetration of faces of different parts, you just

need to specify the distance condition "no less than" zero. This can be used for mechanisms whose

operation relies on physical contact (collision) of its parts.

Continuing with the hydraulic cylinder example, let us show how to use the "distance" mate. The

mechanism created at the previous step will operate incorrectly in certain motions, because some
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parts of the hydraulic cylinder may penetrate each other. This problem is resolved by the "distance"

mate. One can specify the condition that the distance between the respective faces of the piston and

the cylinder must be greater than or equal to zero. When mates are dragged kinematically, this will

yield the correct representation of the mechanism's behavior.

1. Constraints are defined as the distance condition between faces being no less than zero

2. Constraints enabled

3. No constraints

Angle

This mate defines angular distance between two geometrical objects. The turn angle can be used for

rotating a component referencing the desired position. Just as in the "distance" case, this mate type

supports use of conditions. When defining such connection, normally there are two or more solutions.

Bond

This type allows you to create a mate of two objects so that they move as one.

«Gear-Gear» Transmission

This type of mate serves for creating conditions for the interaction of two bodies spinning about their

respective axes. The conditions are specified as a transmission ratio between two spinning objects,

that is, the number of revolutions made by one of the components while turning the other one. Upon

introducing such a mate, a two-sided relation is formed. This type of mate is convenient for

monitoring mechanisms that incorporate dented wheel or belt drives. 

Remember that this type of transmission relation, just like any other transmission mate, merely

tells the system the mutual ratio of angular (in this context) velocities. Also note that each

component must be fully fixed in its place by the time of creating a transmission mate and be

assigned all required degrees of freedom and constraints.
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To create such a mate, select two axes of revolution and specify the transmission ratio. In this case, the

shape of the dented wheel is not significant for the system, as the wheel dents can be created for

«cosmetic» purpose only. The law of the mechanism's movement will be defined solely by the mate

conditions.

«Gear-Rack» Transmission

This type of mate serves for creating the conditions for two interacting bodies, in which one

component spins, while the other one moves about one or multiple axes. This type of mate allows

modeling, for instance, a nut being picked up by a screw, a transmission link of the type «pinion-rack»,

etc. The mate conditions are defined as the amount of the distance traveled by the movable

component along the specified axis while the other component makes one full turn. A two-directional

relation results from creating this kind of mate.

To create a mate, you need to define the axis for each of the two components and specify the

distance in the model units that one component would travel while the other component rotates by

360 degrees. The first one defines the «pinion» axis, the second one - the «rack» axis.

«Linear Movement» Transmission

If there are two objects in the model moving in their respective axial directions, then you can specify a

ratio using the mate being described, that would characterize the mutual displacement of the two

objects. With such a relation established, the travel distance of the second component will be

calculated by multiplying the first component's travel by the specified ratio. The relation can work in

the reverse direction as well (from the second component to the first one); in this case, the system will

use the ratio which is the reciprocal of the specified one. This type of mate helps modeling the

mechanisms representing systems of pulleys, hydraulic mechanisms, etc.

To create a mate, you need to define the axes for each of the two components, and enter the value of

the velocities ratio of the moving components in the provided input box. 
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Creating Mates

To create a mate, use the command:

Icon Ribbon

3D Model > Additional > Create Mate

Assembly > Mates > Create

Sheet Metal > Additional > Create Mate

Keyboard Textual Menu

<3CT> Tools > Mate > Create Mate 

To create a new mate, complete the following steps:

1. Select the mate type. 

2. Select the first object.

3. Select the second object.

4. Define parameters of the selected mate type (if necessary).

5. Confirm the selections.

Selecting mate type

A mate type selection is done in the properties window. To make a selection, set the radio switch into

the desired state. For Distance and Angle mates, one can define a condition with respect to the

specified value. Pressing the button before the numerical value cyclically switches its condition sign.

Selecting mate elements

The modes of selecting the first and second geometrical objects are engaged by the following

options:

<F> Select first element
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<S> Select second element

Upon selecting the first element, the system automatically turns on the option for selecting the second

element. If it is necessary to return to defining the first element, turn on the respective mode manually.

For some mates, a number of options may be unavailable or temporarily inaccessible (see the tables

of combinations above). Each option turns on a set of filters for selecting objects suitable for defining

the required geometrical element.

Selected objects are highlighted. Also highlighted are the operations whose geometrical elements are

selected. Simultaneously, the system offers a preliminary choice of solving the mate. According with

this, the system moves the elements as to fulfill the mate conditions. If one or both elements already

have mates with other bodies or fixed still to the environment, then the new solution is calculated by

accounting for all earlier imposed restrictions.

Fixing mate member

When creating a mate, one of the two mate members can be fixed in the space. Fixing is done by

pressing the button marked by an anchor image, in the properties window. 

Upon fixing, the object becomes "frozen" in the 3D space in its current position. It will neither be

affected by any new transformations nor by changes in parameters of existing translations. The "*"

mark will appear before the name of the fixed operation in the model tree.

Repressing  button cancels fixing of the mate component.

It is also possible to fix a body in space outside the command of mate creation. Use Fix Component

from the context menu of any body if the current 3D assembly contains any mates or uses degrees of

freedom for 3D fragments.

The command Fix Component is always available in the context menu of the fixed component. The

icon corresponding to this command is pressed if a component is fixed. Applying this command will

disable fixing in this case.

Selecting elements for defining transmission ratios

You need to specify numerical parameters (transmission ratios) when defining transmission mates. An

additional capability is provided in the cases of Gear (angular speeds) or Worm (pinion-rack), which

is using geometry of the mated elements to automatically determine the numerical transmission ratio.

The options for defining the transmission ratio appear automatically in an additional section of the

automenu when selecting the appropriate mate type.

The transmission ratio for the «gear» transmission is calculated as the ratio of the two selected

elements' radii. The following options are used in the automenu:
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<G> Select first element to define transmission ratio

<D> Select second element to define transmission ratio

<Z> Cancel transmission ratio selection

In the case of the Worm mate, the transmission ratio is calculated based on the connecting thread

parameters. The following options are used in the automenu:

<T> Select threaded face to define transmission ratio

<R> Select edge or face to define transmission ratio

<Z> Cancel transmission ratio selection

Additional mate parameters

· Reverse Direction. This option rotates the second (or the remaining movable) component

being connected by a 180 degrees or moves it into another solution domain. For the

transmission mates, this parameter alters the direction of the second component motion.

· Reverse Normal. This option works only with the "distance"-type mate between two planes. In

addition to the previous option, it allows changing the direction of counting the distance. 

· Maximum Calculation Time is the parameter controlling the number of passes the system is

allowed to use in search for the solution with the specified precision. This limitation is necessary

to avoid too long system computations due to an accidental user error, that are possible when

searching for solutions in complicated cases. This parameter is set by a slider. 

If no solution was found after the current number of iterations, try to increase the allotment. On

the other hand, it could be sufficient instead to manually move the components being

connected toward the probable solution domain in the Move command.

· Don't Recalculate – this parameter suppresses mates calculation at the time of creation. This

capability can be used in order to save time when working with large assemblies. This could be

useful, for instance, when the user adds several mates one after another. To search for a

solution, you will need to do full model recalculation. In this case, note that upon adding

several complex mates or simply a too large number of mates, the system might not finally find

the correct solution. 

· Positioning Only – this parameter allows you to create a mate only for positioning two objects.

When using this parameter, no mate will be created after the command is completed, but an

additional non-associative transformation will appear in the model tree for objects.
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Techniques for Working with Ready-made Mates

When working with the model tree, the created interfaces are displayed in the 3D Model window. All

work with the created mates is mainly carried out through this service window. A separate folder is

created in the model tree, into which the system automatically places all the mates. For each type of

mate, an icon corresponding to the type of mate is drawn. There is a sign  next to each mate. If you

click  on it, the objects based on which the mate was created will be displayed in the expanded

branch of the model tree. All the mates folders are indicated by an icon .

Mates suppression

Any mate can be suppressed. The command to suppress the mate and cancel the suppression is in the

context menu when selecting  a mate. Suppressed mate is marked with a blue cross in the model

tree and excluded from the calculation of mates.

Mechanism Motion

Calling the command:

Icon Ribbon

3D Model > Additional > Move Mated Components

Assembly > Mates > Move

Sheet Metal > Additional > Move Mated Components

Keyboard Textual Menu

<3CM> Tools > Mate > Move Mated Components

Upon calling the command, you are required to select the desired part of the mechanism for defining

motion. Motion is defined by dragging the selected part by the mouse. In this way, the user stimulates

an influence on the mechanism as if a force is applied to the selected point on the part in the

direction of the mouse pointer in the screen plane. The part of the mechanism starts moving under the

influence of the force. The motion is restricted by the specified mates with other parts and the outer

environment. The selected part pulls another one, and so on, until the whole mechanism is involved in

motion. In this simulation, masses and moments of inertia of the moved components are correctly

accounted for.
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Any translation and rotation parameters of mated (constrained) objects are recorded in the

properties of each mate operation. A special transformation type, namely, Mate

Transformations, is created within the operation's parameters. All quantifiable properties of this

transformation are automatically calculated by the system.

Several important considerations shall be kept in mind when moving mated elements:

1. Exact numerical parameters cannot be specified for a translation.

2. Upon completing the translation command with , the parts cannot be brought back in the exact

previous state. If urged, this can be done only by undoing the steps in the current session.

3. When moving the model of the mechanism for which an assembly drawing was furnished, there is a

danger of irreversible changes to the original drawing created by projecting. This could happen after

refreshing the projection, due to the new positioning of the assembly parts and complications on the

way of the exact rollback to the previous state of part positions.

The setup of the motion modes is done in the properties window.

The Calculation method sets one of two available calculation methods – Precise or Fast. The Precise

method should be applied for systems containing up to several dozen hinges, the greater the order of

the system, the slower the calculation will work. For systems involving hundreds of hinges, the

calculation may work unsatisfactorily slowly. In such cases, a Fast method should be used, which copes

equally well with both large and small systems. Auto mode allows the system to select the calculation

method independently, depending on the complexity of the model.

The mode of the kinematic manipulator is used for moving parts in a mechanism. This results in

smooth motion. It is a simulation of the effect of applying a force at the point at which the user pulls

the part. The motion is generated by accounting for all specified restrictions. As the boundary of the

solution domain is reached, the mechanism stops. 

Movement Accuracy. This allows reducing the level of calculation precision for faster calculations and

for maintaining the constraining conditions during a mechanism's motion.
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Maximum Calculation Time. Sets the number of computational passes allowed to the system for

reaching the required computational accuracy during the motion.

Dragger Power. This setting adjusts the degree of the mouse impact on the dragging point of the

body. This setting controls the applied force and, therefore, how fast the dragged parts will move

after the mouse. 

Use material density. For more precise simulation of mechanism motion, a provision is made for

accounting for the actual density when calculating mass properties of its parts. Otherwise, the density

is assumed the same for all components.

Consider contacts. To improve accuracy of movement simulation there is an opportunity to consider

the intersection of objects.

Mark dragged body. This is an auxiliary parameter for switching On/Off highlighting of the

mechanism part being pulled at the user for inducing the motion.

Mark dragged point. This parameter turns on highlighting of the point which is pulled by the mouse

pointer. The point is marked by a cross. This functionality can be used when the body highlight is off. 

Disable transmission mates. This option allows disabling transmission mates. Such a capability is

convenient for bringing transmission members to the starting mutual configuration (for example, the

correct interlocking of wheel dents).

Avoid inertia of dragging. This parameter allows to switch on/off the consideration of the body

inertia.

Inertial motion mode. This parameter allows to consider the inertia without its fading over time.

Record Animations for Moving Mated Elements

In the command to move the mated elements, there is a possibility to record an animation. This

feature is activated by clicking the Create Animation option.

After clicking the option, the system goes into standby mode for moving the mated objects. While

objects are moving, animation will be recorded. During the movement, frames and time are recorded.

After the end of the move, the options for editing the record are activated.

 - Play
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 - Stop

 - Create Video File. Opens the video creation settings window. The option is available after

pressing the Stop button.

The general parameters of this window are similar to the parameters of the Record Scenario window.

The exception is the presence of buttons  for selecting the Optimal video duration without frames

quantity changing and selecting the Optimal step of frames without video duration changing.

It is possible to save the file in *.avi and *.wmv formats. After setting the settings, the system will start

processing frames and after processing is completed, the video will be saved to the specified location

on the disk.

- Take Snapshot. Opens the 3D window snapshot settings window.
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In this window, there is an option to select the frame number for the snapshot and some of the

parameters from the video creation window.

It is possible to save the file in *.png, *.bmp and *.jpeg formats. After setting the parameters, a

photorealism generation window will open, in which the system will process the image properly and

save it to the specified location on the disk.

- Export Results. The option is active only after pressing the Stop button. After activating the

option, a settings window opens, similar to the Export Scenario window.  It is possible to export the

script in the format *.wrl, *.x3d, *.pov, *.3d, *.pdf.

- Trim Left. Allows you to trim frames to the current position.

- Trim Right. Allows you to trim frames after the current position.

- Delete Record.

- To Start. 

- Rewind. Allows you to rewind the animation by holding down the left mouse button.

- Playback. Allows you to start the animation in the opposite direction.

- Previous Frame.

- Next Frame.

- Fast Forward. Allows you to fast-forward the animation by holding down the left mouse button.

- To End.

Recommendations on Combined Use of Fixing by LCS and Mates

In this section, we review the recommended rules of combined use of mates and fixing by LCS when

creating assemblies. Fixing parts by mates shall mainly be used together with fixing by LCS. Note also

that priority shall be given to the traditional way – fixing fragments by coordinate systems. This

approach has a number of advantages over mates.

Firstly, some types of geometrical relations, including the most commonly used (as a single-axis joint),

can be solved by one LCS, while in the mate approach it may require bundling two or more mates. In
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particular, a single-axis joint is defined by two mates (concentricity + coincidence of end faces), or just

one LCS (with rotation allowed about one axis). This main advantage has more consequences:

· Overall, the system works faster (the chain of mates becomes shorter, computational errors are

reduced, calculations become simpler).

· A simpler model structure results from avoiding extra elements (the mates).

· The model becomes more robust to topological changes (due to minimized use of

topological body elements).

So then, when the use of mates is justified? To answer this question, let's review the process of

designing an assembly. In regard to the posed question, the designer typically faces 2 tasks.

Task 1 

Creating an assembly model without the possibility of "movement" of the mechanism. The user knows

in advance that he is designing, that his model will not have to move after the assembly is completed,

he does not need it. For example, if we are designing a TV or a house, it is unlikely that we will need to

"revive" them in dynamic mode.

When the user is faced with a similar task, when filling the assembly with parts, one main question is

solved – how to correctly position the part on the assembly. The most effective solution is provided by

the "traditional" method – inserting 3D fragments using LCS. In addition to the general advantages of

this method, fewer actions will be required from the user. The 3D fragment insertion mechanism

requires less time due to the fact that fewer elements need to be defined:

1. The source LCS (selection can be performed automatically).

2. The location of the binding (the choice of the target LCS or geometry for its creation is carried out

in the 3D window).

At the same time, each new mate would require the definition of geometric data for two components,

and for the exact location of the component, as a rule, you need to create several mates.

It is necessary to resort to the use of mates:

· in complex cases of geometric interaction;

· when it is required to place a part on the assembly that has contact with other parts in several

places.

Task 2

Building an assembly with the possibility of "reviving" the designed mechanism in the command of

moving the mated elements. In this case, all parts of the assembled mechanism must interact correctly

with each other. For all moving parts, the necessary conditions for calculating the coupling system

during the movement of the mechanism must be described.

In this situation, it is recommended to follow the rules given below.
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· For parts that should not change their position relative to the elements to which they are

attached, it is recommended to use a LCS without degrees of freedom. For example, a nut

placed on a bolt should always follow the bolt and should not have movements relative to the

bolt.

· For parts that change the mutual position, first of all you need to use a LCS with degrees of

freedom. This will give a win for all the main advantages (see above).

· Mates are used when binding parts in the following cases:

· For parts that have complex geometric interactions.

· For parts that have more than one contact with several moving adjacent parts.

· To close the mated chains. At the same time, each chain can be created using LCS with

degrees of freedom.

The platform is paired with three adjacent parts. Three chains of mates are closed

· To set various restrictions, for example, on the mutual penetration of parts. As an example, we

can consider a hydraulic cylinder, where restrictions are set in the form of the condition

"distance =0" (see the Types of Mates section).
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Processing Possible Errorneous Cases

Errors in mates might occur at various stages of handling the model. The system may not always

output the detailed reason for such failures; therefore, we will list here the most common erroneous

situations and typical techniques of correcting those. All erroneous situations can be divided into two

types – errors occurring at a mate creation, and errors occurring in mates during model recalculation.

The problems occurring at the time of creating mates could be due to two reasons. Firstly, a mate

solution may not be found as it simply does not exist. For example, this may happen when the

previously imposed geometrical relations in the model are such, that the system cannot relocate the

selected components to satisfy the new conditions. In such a case, you need to check up the model. It

is possible that excessive, unnecessary relations are present somewhere. If that's the reason, then you

could try freeing up some system components or relieve extra geometrical relations. This may often

be achieved by suppressing (and later deleting) a certain «obstacle» mate or allowing an additional

degree of freedom in the parameters of the respective 3D fragment. Secondly, it could be so that a

theoretical solution exists but the system fails to find it. There could be several reasons for that –

either too short maximum calculation time is specified, or the system cannot find the solution with the

current model components configuration. In such cases, there are combinations of measures helping

the system to find the solution. First of all, you could defined the longer maximum calculation time to

allow the system run more calculations. Also, before creating a new mate, you should manually move

the components of the mechanism to the expected solution area (by using the command of moving

mated elements). This would help the system to find the desired solution in complicated cases.

A separate reason for a failure to review is when the user attempts to specify such relations that lead

to recursion (self-dependency). Suppose, for example, that two components were initially fixed by

LCS. Later, the user wants to impose an additional mate between two components. Meanwhile, the

LCS axis of one of the components relies on geometry of the second component for orientation.

Moving the second component leads to a change in the first component's position. Satisfying the

mate conditions implies that both components move. In such a recursive situation, the system will

never be able to find a solution. To escape the trap, you would need to exterminate the reason of the

recursion – which in this case means redefining the LCS of the first component to make it independent

of the second component.

Errors may occur on an initially correct model after performing the regeneration operation. Mates are

calculated by groups (chains). Should an error occur in a group, each mate in this group is marked in

the model tree by a red cross. The reasons for regeneration errors could be of two types. It could be

so that the model underwent such changes due to which the solution satisfying all conditions is no

longer feasible, or the relation between mates and component geometry is broken (as, for example, a

missing topology element that was used in a mate). In such a case, restoration of mates is possible

under the condition that the parent elements are restored. Otherwise, the mate needs to be redefined. 

Another example is a correct model yet the system failing to find the desired solution. This may

happen, for example, due to insufficient allotted maximum calculation time. Another reason could be

the model getting into a trap from which the system cannot escape. In such a case, you could first try
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to suppress all erroneous mates, and then one by one reenable them in the model. Simultaneously

with that, you could move the components to help the system find the solution. It could also be

helpful in such a case to extend the maximum calculation time. This can be done with Time flag on the

3D tab of the Set Document Parameters command.

Adaptive 3D Fragments

Calling the command:

Icon Ribbon

Tools > Adaptivity > Adaptive Fragment

3D Model > Advanced > Adaptive fragment

Keyboard Textual Menu

<3U> Tools > Adaptive Fragment

An adaptive fragment in T-FLEX CAD is a 3D fragment with the external parameters being not only

external variables, but also geometrical elements. A geometrical parameter can be represented by

any Adaptive Elements (a solid, 3D node, 3D path, 3D profile, workplane, LCS, vertex, edge, face,

loop). The idea of the approach is using the substitution geometry of an assembly element instead of

the original geometry of the external parameter in the structure of an adaptive 3D fragment when

regenerating a particular instance of its model. In this way, the 3D fragment acts as if "adapting" to

the objects of the assembly model. For example, on the basis of adaptive 3D fragments, specialized

operations are performed for inserting holes, creating stamps or protrusions in the corresponding

commands of the system.

1. Source model

2. 3D Profile as the instantiating value of geometrical parameter

3. Adaptive fragment

4. 3D Profile as geometrical parameter

5. Result of inserting an adaptive fragment

To use a 3D fragment as an adaptive model element, define in advance the set of geometrical

parameters that can have relations with objects of an assembly model. Just like a set of external
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variables, a set of geometrical parameters is defined in the document of the given 3D fragment. The

system allows defining geometrical parameters and their values actually at the time of inserting or

editing a 3D fragment; however, the created relations will be used in this case only in the current

assembly model. In such a case, this information will not be saved in the 3D fragment's document.

When inserting an adaptive 3D fragment, the user specifies the values of geometrical parameters. The

type of the instantiating object must be the same as the type of the object which is the parameter of

the 3D fragment. For example, the instantiating value for a 3D profile can be defined only by a 3D

profile.

The use of geometrical parameters for a 3D fragment can be combined with use of external variables

and attachment coordinate systems. However, while doing so, keep in mind the specifics of

instantiating a parameter object, as the substitution affects both the geometry of the adaptive

parameter and its position in the assembly. As we know, the position of a 3D fragment in an assembly

is defined by the source and target coordinate systems. Those coordinate systems can be specified by

LCS or defaulted to the global coordinate systems of a 3D fragment and an assembly models.

When instantiating the geometrical parameter, the system runs a "reverse" transformation by carrying

the object from the assembly to the 3D fragment model, from the target LCS of the assembly towards

the source LCS of the 3D fragment. 

Upon instantiating the values, an adaptive 3D fragment is regenerated and inserted into the assembly

model. The user needs to insure correct orientation of the parameter object instances to have them

positioned according to the design intent upon embedding in the 3D fragment model.

On the diagrams below, a 3D profile instance substitutes the original profile defining a hole in a wall

of a 3D fragment. According to the intent, the new profile instance will serve for creating an array of

holes in a wall of a 3D fragment. Among the two possibilities, in the first case the profile instance will

be suitable for creating holes upon embedding in the 3D fragment model, while not so in the second

case. 
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Let's review in details what happens with the 3D fragment model in the second case. Since a different

instance of the 3D profile is used in this case, oriented differently with respect to the target LCS, then

the result differs in the final position of the profile in the 3D fragment model. The detail view clearly

shows that protruding the array of profiles in the second case does not lead to hole creation (to

demonstrate that, the second operand of the Boolean subtraction was left in the scene); therefore, the

3D fragment is inserted in the assembly without holes in its wall. 

If, upon inserting an adaptive 3D fragment, it is necessary to use the source coordinate system,

then make sure that it is created based on 3D fragment Adaptive Elements (3D nodes, edges,

vertices) that are independent of the external geometrical parameters. In other words, the

parents of the source coordinate system shall not change upon instantiating adaptive elements.

Setting up adaptive 3D fragment

To make a 3D model suitable for use as an adaptive 3D fragment, a set of objects (adaptive elements)

needs to be defined, whose geometry will be driven by the assembly objects.

Upon calling the command, you can fill in the item Name in the properties window (optional). The

entered string will be the name of the 3D fragment in the model. If the name is not specified, the

default "Part_No" is used in the model. The Comment item may contain a text explaining the intended

uses of the given 3D fragment.

To add a new object to the list of adaptive elements, select it in the 3D view window or in the model

tree. The selected element appears in the upper list, Adaptive Elements, in the properties window.

Upon selecting an object, the system automatically adds to the list the topological elements of that

object (edges, vertices, faces) that are referenced by the object's children. 
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The Adaptive Elements list provides an intuitive display of interrelations of the selected object

with its children and adds a capability of selecting elements that are not at the top level of the

model hierarchy as the geometrical parameters. 

The contents of the adaptive elements list can be managed by graphic buttons in the properties

window: 

- for the Adaptive Elements list:

·  transfer to the list of external parameters

·  deleting current element;

·  deleting all elements;

·  deleting unused elements. This button becomes accessible if the list contains objects

deleted from the model. Such objects are marked in the list by the icon .

- for the External Elements list:

·     moving current element around the list;

·   creating a new folder. The list of external parameters can be organized into a tree

structure, by distributing the list elements over different levels or over different folders in one

level. When inserting a 3D fragment into a model, its geometrical parameters will be

displayed according to the defined structure;

·   renaming selected external parameter. For each external parameter you can assign the

meaningful name;

·   deleting current element;

·   deleting all elements.

When creating or editing a 3D fragment in the assembly context (the "Top-down" design flow), the

Adaptive Elements list is built automatically. The system creates this list based on the objects that are

referencing assembly adaptive elements (3D profiles, workplanes, 3D nodes, etc.). If a 3D fragment is

intended for insertion in other assembly models, the user can compose the list of external geometrical

parameters by using the already built Adaptive Elements list.

Creating an adaptive fragment

To give an example of composing a list of external geometrical parameters, let's consider a 3D

fragment that defines creation of protrusion (see the picture at the beginning of the chapter). The first

item in the Adaptive Elements list will be the 3D profile based on which the extrusion is created.

The second element of the list is assigned to Extrusion_0. At the same time, the system adds the face

of this operation to the list, since the face is the parent element for the Extrusion_0 operation.
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The set of object types allowed for selection is defined by the option:

<V> Select type of parameter

The drop-down list will help setting up the internal command filters for selecting objects of a certain

type: workplane, worksurface, coordinate system, operation, 3D path, 3D node, 3D profile.

The default active option in the automenu is:

<M> Show parameter in Fragment document

It enables highlighting of the objects that are not at the top of the model tree hierarchy. For example,

if the given operation is active, then upon selecting a face of the operation Extrusion_0 in the list of

objects, this face will be highlighted in the model (at the same time, all children of Extrusion_0 will be

temporary removed from the 3D scene).

If the option is not active, then highlighting will only work if the current element in the list is a top-

level operation. 

The next required action is composing the External Elements list. This list gets the elements from the

"Adaptive Elements" list, that will be instantiated upon inserting the 3D fragment into an assembly

model.
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We recommend putting in the list of external parameters all topological children of the model

object, that were entered in the upper list, and instantiate them as values in the assembly.

Suppose, the external parameters list of an adaptive 3D fragment does not contain all topological

children of the selected model object, or some of those objects are not instantiated upon inserting

this fragment into an assembly. In this case, upon regenerating the 3D fragment model (at the time of

inserting it in the assembly) errors will occur when creating the operations (or other objects) that are

based on the uninstantiated topological elements. 

To avoid a large number of unnecessary dependent elements in the list of geometrical parameters,

prefer building the 3D fragment model in such a way that the Adaptive Elements used as geometrical

parameters are at the highest possible level in the model tree structure. Move elements by selecting in

the upper list and pressing the graphic button . You can enter a comment for any element in the

list of external parameters. The entered string will pop up as a tooltip in the properties window when

selecting the parameter instantiating value in the command 3D Fragment.

If necessary, an external parameter can be renamed by editing the default name that is the same as

the name of the model object. When selecting an element in the list of external parameters, the

respective element is automatically highlighted in the list of model objects. This allows easily tracking

the renamed model object that was used for creating an external parameter. The 
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Auto Select flag can be used for objects whose children are external parameters themselves. For

instance, in the current example, Auto Select can be set for Extrusion_0 in order to reduce the number

of items to select.

Inserting adaptive 3D fragment, instantiating adaptive elements

In the 3D Fragment command, for a 3D fragment with specified adaptive elements, by default, the

focus is in the Value of the first external parameter field in the properties window, the Geometric

Parameters tab.

To set the value, specify an object of the same type as the external geometric parameter of the 3D

fragment in the 3D view window or in the model tree.
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If the 3D fragment selected for inserting has the geometrical parameters preset, the following option

will be available in the automenu:

<R> Show Geometric Parameters of Adaptive Fragment

It allows you to see in a separate window a 3D model of the inserted fragment with the highlighting

of the current external parameter.

When selecting an object, the system also selects values for those parents of the current parameter

that have the Auto Select flag set.

The values selected automatically can be changed by specifying a different model object.

To complete the insertion of the 3D fragment, the option  is used.
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If errors have occurred in the 3D fragment model at the specified values of geometric parameters, the

3D fragment is not displayed in the scene, and the corresponding messages will appear in the

diagnostic window.

Defining adaptive elements of an existing fragment

The system supports defining the list of external parameters and their instantiating values for both

inserting new fragments and editing existing fragments in an assembly. To add an additional

parameter, call the command for editing a 3D fragment. In the Geometric Parameters section of the

properties window, press the button  and select the 3D fragment model's element to become an

external parameter. The next step will be either instantiating its value or adding more parameters to

the list. The difference of this approach from the steps described in the Setting up adaptive 3D

fragment section is that such changes in the list are remembered only in the current assembly. When

inserting this 3D fragment into another assembly model, the elements added to the list will not be

available. Therefore, any 3D fragment of an assembly model can be converted to an adaptive 3D

fragment, and the predefined list of geometrical parameters of an existing adaptive 3D fragment can

be extended.

Large Assembly Management Tools

To optimize working with assembly models, the system provides specialized large assembly

management tools. Those allow working only with the subassemblies of concern, save the overall used

memory and facilitate spinning the 3D scene when it is densely populated with objects.

   

With the Default type, the assembly will be loaded without bodies, which speeds up the loading

process. With the Full type, the bodies of all fragments will be loaded. With the Minimal type,

fragments will not be loaded, the assembly tree with fragments will be available to the user, but the

3D scene will be empty.
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For more information about the settings when opening the assembly, see Open Model.

After loading the assembly, you can also configure the loading method for each fragment. This allows

you to both load the necessary elements of the fragment and unload the extra ones, options are

available:

· Solids, Meshes and Supporting Geometry ; 

· Meshes and Support Geometry ; 

· Support Geometry  ; 

· Don't Load .

Each selected option affects performance. By default, as noted earlier, the fragments have meshes

loaded, which allows you to see their visual display, and the support geometry is loaded, which shows

the external objects of the fragments. If an assembly fragment is selected as an element of any

modeling or measurement operation, bodies will be automatically loaded for it. You can load the

bodies, meshes, the support geometry of the fragment, or vice versa, you can unload it through the

context menu of the selected fragment.

You can control the completeness of the fragments loading either in the 3D Model window or in the

Assembly Structure window. A special Load Contents column is available in the windows, in which the

completeness of loading fragments is illustrated using an icon.

In the  Set Document Parameters command on the Large Assembly Management tab, it is possible to

adjust the display of small 3D objects using the Don't show parts smaller than parameter.

3D objects whose size does not exceed the specified value (in model units) will be considered small.
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Updating Links

Updating links manually

Calling the command:

Icon Ribbon

Assembly > Component Links> Update Links

Keyboard Textual Menu

<UL> File > Assembly > Update Links

After calling the command, the model is recalculated (all data of fragments and images used in the

model are updated). After recalculation, the image of the current drawing is automatically updated.

Automatic link updates

When opening a document, the system automatically checks the relevance of links to files used in the

current document (fragments, pictures, etc.). If files with a modified modification time are detected, a

dialog box is displayed on the screen:

The appearance of this dialog is affected by the update modes of current links assigned in the Set

System Options, Fragments tab command.

If a positive answer is selected, then all modified documents are updated. The list of documents that

require updating can be viewed using the Details button. If the No button is selected, then the links

contained in the list are considered relevant and no updates occur. In further work, to update links, you

can use the Update Links command (see above) or a Full Regeneration.

Unlike the Update Links command, which updates all links in the current document, this dialog allows

you to update only modified files and, if necessary, monitor the appearance of outdated links in the

process.

Don't show this message again on document activation - if the flag is set, then when you go to the

window of the current document from another application or from the window of another T-FLEX

CAD document, the links will not be checked for relevance. When setting the flag, the Fragment
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Actuality Check > On document activation parameter takes the value Don't Update (see section Set

System Options, Fragments tab).

From the drop-down list, you can select the mode in which the failure to check the relevance of links

will be performed:

· for this Document

· for this Session

· for this and future Sessions

Don't show this message again on document opening - setting this flag sets the refusal to check the

relevance of links when opening documents. When setting the flag, the Fragment Actuality Check >

On document opening parameter takes the value Don't Update (see section Set System Options,

Fragments tab).
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2D Drawings of 3D Models

To create a 2D projection, use the command Create 2D Projection. 

The command can be called in one of the following ways:

Icon Ribbon

3D Model > Additional > 2D Projection

Draw > Projection > 2D Projection

Assembly > Additional > 2D Projection

Sheet Metal > Draw > 2D Projection

Surfaces > Additional > 2D Projection

Weld > Additional > 2D Projection

Primitives > Additional > 2D Projection

Keyboard Textual Menu

<3J> Draw > 2D Projection

The command can also be called from the dynamic toolbar invoked by clicking  on an empty

space in the 2D window.

2D projection is a two-dimensional image located in the 2D window, obtained by projecting a three-

dimensional model or its selected portion on the specified plane. Projections can be used for creating

the necessary views on a 2D drawing, with their subsequent decorating, as well as for obtaining local

views and sections. One can project whole bodies or even groups of bodies, as well as selected

elements of the model, such as faces or edges. If you are working with large 3D models, use the

method of creating 2D projections in a separate file. 2D projection should not be confused with

projecting elements onto active workplane. However, 2D projection can be created on active

workplane as well. 

You can build some 3D elements (for example, working planes and 3D sections) based on the 2D

projection. Corresponding options are available in automenus of commands for creating these

elements. You can add construction lines, dimensions, design elements, etc. to 2D projections. When

creating construction lines, the object snap to the projection elements works, which distinguishes arcs

of circles, ellipses, splines, segments, extreme points of the line (nodes), the center of the arc, etc.

Topics in this section:

· Main Concepts of 2D Projection

· Types of 2D Projection

· Boundaries of 2D Projection

· View Styles of 2D Projection

· Contextual Menu of 2D Projection and its Elements

· 2D Projection by External Model

· Breaks on 2D Projections and Drawing Views

· Cropping 2D Projection
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· Managing elements of 2D Projection

· Placing Drawing Design Elements on 2D Projection

· Scaling of 2D Projection

· Parameters of 2D Projection

· Edit 2D Projection

Main Concepts of 2D Projection

The main concepts on all tabs of the 2D Projection command is described below.

"General Parameters" Tab

After calling the command, the first option that you can see is General Parameters. The general

parameters are divided into 3 categories:

· Projection view

· Projection type

· Projection view style

The user is presented with a choice of 10 standard views for forming a projection:

Top view

Left view

Front view

Right view

Bottom view

Back view

Axonometric (front)

Axonometric (back)

Axonometric (bottom front)
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Axonometric (bottom back)

If necessary, you can change the position of the buttons of the projection views and position of the

views in the Three Standard Views projection type, depending on the ISO (First Angle) or ANSI (Third

Angle) standard.

ISO view buttons position ANSI view buttons position

By default, the ISO position of the view is used. You can change the position of the view in the Set

System Options, 3D tab.

You can also choose one of 8 standard projections:

<1> Create three standard projections

<2> Create section view

<3> Create additional view

<4> Create local section view

<5> Create set of standard projections

<6> Workplane projection

<7> Projection By Projection

<8> Arbitrary View

The process of creating each type of projection is described in the section 2D Projection Types.

Angle is the parameter defining the rotation angle of the 2D projection on the 2D view about the

fixing point. The positive values define rotation in the counterclockwise direction.

In the Scale field, you can set the scale of the projection displayed in the drawing. By default, the value

is taken from the document.

The Perspective Projection checkbox determines the type of the created projection: parallel or

perspective. When checked, a perspective projection is created. Dimensions created from elements of

this 2D projection are also displayed in perspective.
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Parallel Projection Perspective Projection

The Consider Hidden Lines checkbox determines whether information about hidden lines will be

saved in the projection data. Without setting this flag on the projection, it is impossible to display

hidden lines. The parameter is unavailable for projections of the Shading, Rendering, as well as for

sections.

2D Projection View Style

After activating one of the basic parameters option, it becomes possible to select the projection view

style. T-FLEX CAD allows creating 2D projections of the following types:

Precise (Graphic Lines)

Vector Picture

Rendering

Shading

Wireframe

Precise (Graphic Lines). The view of the projection of this view style represents itself a collection of

the graphic lines;

Vector Picture. The view created on the projection of this view style entirely corresponds to the type

Precise (Graphic Lines). However, in this case the graphic lines themselves are not created, and the

projection is drawn as a picture. This mode allows a user to reduce the 2D projection generation time,

and also reduce the memory usage required for creating a large number of graphic lines;

Rendering. The view of the projection is drawn in the form of rendering which corresponds to the

mode of the same name in the 3D window;

Shading. The view of the projection is drawn in the form of shading which corresponds to the mode

of the same name in the 3D window
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Wireframe. The view of the projection is drawn as a wireframe which corresponds to the mode of the

same name in the 3D window. In this mode, the parameter Remove Hidden Lines is available

depending on which the removal of the hidden lines is carried out or not.

Projections of the view styles Precise (Graphic Lines), Shading, Rendering, Wireframe have the

following limitations:

· it is not possible to hide (remove) separate elements (lines) of the projections or modify their

parameters;

· it is not possible to project 3D construction elements (3D paths, 3D profiles). Only bodies

(operations) can be selected for projection.

All view styles of 2D projections support the creation of the service elements based on the projection

types. On the projection of the view style Precise (Graphic Lines), the service elements are attached to

the projection lines, for the rest of the projection types – the service elements are attached directly to

the elements of the 3D model.

Creating projections of all view styles is carried out similarly.

Before you begin creating drawings using projections, it is recommended that you determine

the format of the drawing, how many pages it will occupy and what will be the scale on each

page. All of these parameters are defined on the Page tab in the command Document

Parameters. Each page uses its own settings. The settings can be modified at any time.

For more information on projection view styles, see 2D Projection View Styles.
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"Additional Parameters" Tab

The Update option allows you to select in which cases the projection will be updated. There are 3

options in the dropdown list:

· Auto.

· Manually and on Full Regeneration.

· Manually.

Auto. When this option is selected, the projection will be updated automatically (with any changes to

the model).

Manually and on Full Regeneration. When this option is enabled, the update process is performed

manually using the Regenerate  or Full Regeneration commands. For example, this option is suitable

for the stage of work at which work is still underway with the 3D model and there is no need to spend

computer resources to update the projection. It makes sense to set this option in cases when work is

carried out with complex models, for a complete recalculation of which considerable time is spent.

Manually. The update process is completely controlled by the user. This is necessary in cases where

the projection is complex and its updating takes a significant amount of time.

Regeneration of the projection of the Vector Picture view style, if updated manually or upon

request, is performed in parallel mode. When you start regeneration, the 2D projection image

on the screen is replaced with a simplified image. After that, you can work with the system, for

example, create a drawing according to this projection. In parallel, at this moment, an accurate

calculation of the projection will be performed. Upon completion of this calculation, the

simplified projection image is replaced with the results of the accurate calculation. This

approach makes it possible to simplify the work with projections that have a long conversion

time. You can continue working with the system immediately after creating or editing a

projection, without waiting for the completion of projection calculations.

The option Calculation of Bodies Penetration allows you to choose 3 variants:

· No. Body penetration will not be counted.

· Consider Intersections. When projecting a group of bodies that penetrate each other, you can

enable the intersection analysis feature. When this parameter is set, the system will build a

projection taking into account the intersection of bodies. This parameter increases the

projection calculation time.

· Yes. Allows you to create more accurate sectioned isometric projections.

When the Exploded View Scenario flag is activated, it becomes possible to create projections of

models during the disassembly animation.

It becomes possible to select a scenario of disassembly animation in the drop-down list. Stage flag

allows you can select the stage that will be projected. When the Project Trajectories check box is
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enabled, the drawing will show the paths of the object paths that move during the dismantling

animation.

If the model has configurations, then during projection it becomes possible to select the

Configuration that you want to project.

The Precision flag sets the accuracy of drawing projection lines. The minimum parameter value is

0.000001.

"Options" Tab

 

Recognize Straight Lines, Recognize Circles and Convert Polylines to Splines. These parameters

include special algorithms that allow, within a certain accuracy, to recognize segments or circles

(circular arcs). This is necessary for cases when complex geometry is being projected. For example, if

you accurately project an anti-aliasing with a variable radius, you get a polyline. When this option is

enabled, the polyline is replaced with a circular arc. The resulting arc can now be dimensioned. When

using these options, there is a slight loss of projection accuracy. Because of this, sometimes problems

may arise with automatic hatching on sections and cuts - breaks may appear in the contour, and such

a contour may not be hatched. To solve this problem, a special option has been created that controls

the accuracy of the hatch contour search (see the View tab).

Simplify Geometry. When checked, the Simplify Model operation is applied to the projected objects,

and then the projection is created. This option significantly increases the projection calculation time,

therefore it is disabled by default. this option must be disabled when creating a projection of a

flattened sheet metal part, when you want to show bending zones using smooth fillets (the option to
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enable smooth fillets is on the Lines tab). When the geometry simplification option is enabled, bend

zones will not be shown.

Original sheet body Simplified projection Projection with fold lines

Save Information for 3D Dimensions. This option allows you to add spatial dimensions to non-

standard and volumetric views (for example, isometric).

Create Outline Area. With this option, outline invisible hatching is built on all projected bodies with a

priority one less than the priority of the projection itself. Thus, you can build applications of some

projections on top of other projections.

This option does not work or produces incorrect results if paths, edges, faces, cycles are selected

for projection, or if the projection method is selected without removing hidden lines. Also this

option does not work for sections.

For a 2D projection created on existing 2D projection, this option is automatically enabled.

Latest Version of Projection Algorithm. This parameter is displayed only for projections created in

previous versions of the system and serves to ensure compatibility with the current version of T-FLEX

CAD. The checkbox is disabled by default.

Displaying the checkbox in the projection properties dialog indicates that this projection is

being recalculated according to the old algorithms. If you check the box, the projection will be

recalculated according to the algorithm of the current version. This can lead to various changes

in the identification of projection elements.

Compatibility Mode. Enabling this checkbox allows to create a projection in the T-FLEX 16 format. It

can only be enabled before selecting the projection view and projection type. After selecting view and

type this checkbox is only displayed if it's enabled.

Geometry Search. If this checkbox is selected, when recalculating a 2D projection, the search for

design elements on the projection is performed by the projection geometry, and not by model

identifiers.

When searching by geometry, the old position of the original projection element (lines, arcs, etc.) is

taken and the nearest element of the same type is searched within the tolerance. Search by

identification is performed regardless of the geometry by internal IDs of projection elements

generated from the history of element creation.

It is recommended to use geometric search when the model has undergone significant changes and

the usual search does not give results (for example, when updating the projections of the imported

geometry after changing the imported model by an external application).

The option Welds allows you to choose how welds will be displayed on the projection. There are 3

options in the dropdown list:

· Consider.

· Consider and Fill.
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· Don't Consider.

Consider Consider and Fill Don't Consider

Minimum size of the elements. This parameter allows you to reduce the time for building and

recalculating projections by refusing to project small details. In addition, due to the exclusion of

bodies in some cases, you can achieve better readability of the image.

The minimum size is specified in the current units of the model. All smaller bodies will not be shown in

the projections.

                     Minimal size: 0  Minimal size: 100

Time of projection calculation: 0,577 sec.    Time of projection calculation: 0,088 sec.

Process Bodies with Errors. Upon creating a projection, the system checks if there are errors in bodies

to be projected regardless of the state of this checkbox. Next, if the checkbox is enabled, the system

excludes faces with errors and tries to sew a body from the remaining faces. If sewing is impossible,

then the whole body gets excluded from the projection.

If the checkbox is disabled (by default), then an attempt to project a body with errors invokes the

dialog, where you're asked to enable this option:
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Upon selecting the Yes answer, the checkbox gets enabled and then the system performs actions

described above. Upon selecting the No answer, the system tries create a projection without excluding

errors; if projecting is impossible the projection won't get created. 

Upon regenerating a projection, the check for errors is only performed, if the checkbox is enabled.

Therefore, if the checkbox is disabled, errors occurred in bodies after creating a projection might

cause projection regeneration errors.

Enabling the errors processing option decreases performance. Therefore, it is recommended to

enable this checkbox, only if there are known issues with 3D model geometry (e.g. for imported

bodies) and if it's impossible to generate a projection without it.

Delay Regeneration. After completing the creation or editing of the projection, the system will not

regenerate it. This option is not available in the modal properties window.

Dynamic Preview. Upon defining mandatory minimum of parameters required to create a projection,

its preview appears in 2D window. Preview automatically updates, upon parameters change. When

working with complex documents, containing large number of objects, preview might slow down the

system. It can be disabled if necessary by disabling this checkbox.

Hide Constructions. If it's enabled, 2D construction elements belonging to this projection are only

displayed upon projection's activation.

Show Projection Scale. Allows you to customize the display of the projection scale above the

projection itself (see the section 2D Projection Scaling).

"Elements" Tab

By default, for Bodies and operations the mode All Elements is set, whereas for profiles, paths and

coordinate systems – mode Selected Elements. For geometric elements (faces, edges, loops) the

method of projection is not specified (only selected elements are always projected).

You need to select elements in cases where you need to project not the entire model, but only

individual elements (specific operations, Solids or construction elements / topological elements) or if

the projection will be used to create 3D elements. In addition, there are often cases when some

objects of the model simply cannot be seen on the projection due to the fact that they are covered by

other bodies. For example, some parts may be inside the case. In this case, it is useful to exclude from

the projection those objects that are still not visible. This will save time when recalculating such a

projection.
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In order to select individual elements of the model, you must use the option that is available in each

projection mode:

<E> Select model elements to project

This option has a drop-down list of filters to select the desired objects. You can select Bodies,

Operations, Welds, 3D Profiles, 3D Paths, Coordinate Systems, 3D Axes, Cable Products and Geometric

Elements. The set of filter options for selecting objects is duplicated on the system panel.

When the option is activated, the Elements section automatically opens in the properties window. This

section contains a list in which selectable items are entered. The list is divided into separate tabs

according to the type of selected objects.

Bodies and operation

Welds

3D Profiles

3D Paths

Coordinate System

3D Axes

Cable Components

Geometric Elements

You can also activate the selection mode of projected elements using the dialog of the

properties window. It is enough to place the cursor in a free line of the list marked with an

ellipsis, and the option  is turned on automatically.



T-FLEX CAD 17 Help

2382

For each type of selected elements, you can specify the projection method:

· All Elements - all elements of this type in the scene will be projected;

· Selected Elements - only selected elements of this type will be projected;

· All Excluding Selected - all elements of this type will be projected, except for the selected

ones;

· From File (only for Bodies and Operations) - this option is set if the projected operations and

Bodies are selected from an external file (see the section 2D Projection by External Model).

When this item is selected in the command automenu, the file selection option  is

automatically enabled ;

· As in Operation (only for welds) - the method of projecting welds will depend on the method

set for the operation and Bodies. If the operations are set to All Elements, then all welds are

projected. If any other method is set for operations, the welds are not projected.

Coordinate system projection has a number of features. Coordinate systems are projected over the

entire 3D model without regard to visibility. Coordinate system projection lines are not considered

when defining projection boundaries.

Projections of the coordinate system are formed from three graphic lines with arrows. The color of

each line-axis coincides with the color of the corresponding axis of the global coordinate system in

the 3D scene. The style of the lines can be modified as for the standard graphic lines of the drawing.

The length of the coordinate system axes is controlled by the parameter View > Size > LCS in

the dialog of the command Set Document Parameters, 3D tab.

Projecting of the global coordinate system is enabled separately by enabling the Global CS checkbox.

Selected method for projection of LCS does not affect projection of global coordinate system.

The automenu provides a separate option for quick selection of all operations currently present in the

3D scene:

<A> Select all Solids in current scene

The difference between the behaviors of the option Select all Solids in current scene and that of the

mode of projecting the whole scene can be described as follows. The list of all operations selected in
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the 3D scene is formed at the time of using the option and stays unchanged unless intentionally

modified. Therefore, the new bodies added to the scene do not appear in the list of the elements to

be projected.

"Lines" Tab

On the Lines tab, you can change the parameters of the projection lines separately for each 3D

construction element, body or fragment.

The upper part displays a list of selected elements for which you can change the line parameters.

You can select the elements for which you want to change the lines by clicking on the symbol ... in the

list in the Properties window.

In the center is a list of projection line categories. To display the lines of the selected category on the

projection, set the flag to the left of the category name.
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Line categories:

· Basic lines. Allows you to set the parameters of the Basic lines.

· Hidden lines. The parameters of this group control the presence and parameters of displaying

hidden lines on a 2D projection.

· Smooth edges. Smooth fillets of faces can be shown on the projection (when no sharp corner

is formed at the seam). This group of parameters controls the rendering of smooth fillets, sets

the display method (type, color, etc.) of the graphic lines used for this. Upon selecting the

Smooth Edges in the list of categories, additional option appears below the line parameters:

o Shorten Line. The effect is shown in the picture below.

· Axial lines. When projecting surfaces of revolution (cylinder, cone, torus), you can

automatically add axis lines. In the case when the body has several surfaces of revolution. Axial

lines checkbox also controls the drawing of the bend axes on the projections of bodies

obtained by the Unbend operation. Upon selecting the Axial lines in the list of categories,

additional options appear below the line parameters:

o Unite (enabled by default). This option is useful, when projecting several rotated surfaces. It

helps to avoid duplicating axes.

o Radial Axes (enabled by default). This option is useful, when projecting holes that are placed

along a circle. The effect is shown in the picture below.
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· Threads. When creating 2D projections, the threads present in the model are automatically

recognized. When this option is enabled, thread designation lines are created in cases when

the thread is visible in this projection from the front, from the side, or the plane of the cut

coincides with the thread axis. When dimensioning from such an image of the thread, the

system automatically substitutes the required designation. The data for the designation is

taken from the parameters of the thread creation operation. Upon selecting the Threads in the

list of categories, additional input box appears below the line parameters:

o Minimum Thread Height. Minimal distance between thick and thin lines of a thread on a

drawing. Measured in units set for a Page in the Document parameters (by default, it's

millimeters for ISO documents and inches for ANSI documents).

Also see the Thread Display on 2D Projections section.

· Hidden smooth edges. This category includes smooth mates that are invisible on the

projection.

· Bend edges display bend lines in projections of sheet metal parts.

· Section lines. Used to draw visible edge segments that were obtained by intersecting

projected bodies with stepped planes orthogonal to the projection direction.

The Lines tab allows to adjust the parameters of the lines (for more details, see the section 2D

Projection Parameters).

It also contains the Create Auxiliary Lines checkbox. Enabling this checkbox makes auxiliary all lines of

the projection.
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"Sections" Tab

Description of the Sections tab can be found in the Sections and Section View section.

Breaks

Description of the Breaks tab can be found in the Breaks of 2D Projection section.

General Algorithm of Creating 2D Projection

The general algorithm of creating a 2D projection includes several required and optional steps:

1. Define the projection direction (required) by one of the following ways:

· Using one of the options for creating standard projections (the options , ).

· Automatically by the system, depending on the section line position, in the case of creating a

section or local section view (the option ).

· From the direction of the detail view specified by the detailing element (the option ).

· Same as the direction of the original projection, when creating a local area view ( ).

· By a workplane (the option ).

· By 3D model elements, such as a flat face, using the set of additional options.

· By defining the directional vector of projecting and the rotation angle about this vector in the

projection parameters.

· Along the projecting direction of an existing 2D projection (the option ).

In most cases, the system attempts to determine the type of the projection being created by the

first selected element. For example, if a section is picked, the system will offer creating a cut;

picking a hatch prompts a local area view; picking a face – a general view, etc.

2. Define the attachment point in the 2D window (optional). Normally, you need to specify the

location on the drawing via a 2D node or free point at which the projection is to be created. In this

case, the projection to be created is shown as a blue preview box.

3. Select section to be used on the projection (optional). This step is necessary when creating a local

view or section.

4. Select bodies to subject to the section (optional). This step is necessary when creating a local view

or section affecting only selected elements of the model being projected.

5. Select model elements to project (optional). By default, the whole 3D scene is projected in its

current state; however, it is also possible to project separate Bodies, operations or specific topology

elements (faces, edges).

6. Define projection parameters (optional). Some properties, such as scale, can be specified in the 2D

Projection Parameters dialog box or in the properties window.

7. Select the view style of 2D projection being created: Precise (Graphic Lines), Vector Picture,

Shading, Rendering, Wireframe;

8. Confirm the input (required). As in any 3D command, the element creation must be confirmed

upon competing definition of all parameters. This step is possible, when the option becomes

accessible in the automenu: 

<Y> Finish input
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Types of 2D Projection

As mentioned earlier, there are 8 different types of projections.

<1> Three Standard Views

<2> Section Cut and Section View

<3> Arrow View

<4> Local Section View

<5> Standard View Set

<6> Projection to Workplane

<7> By Projection

<8> Arbitrary View

Three Standard Views

The command can be called in one of the following ways:

Icon Ribbon

Draw > Projection > Three Standard Views

Assembly > Additional > Three Standard Views

Sheet Metal > Draw > Three Standard Views

Weld > Additional > Three Standard Views

Keyboard Textual Menu

<3КJ>

It is also available as option in the 2D Projection command:

<1> Three Standard Views

It should be noted that the location of standard views depends on the established standard of

projection views: ANSI, ISO (Set System Options, 3D tab).

When creating standard views, the automenu has several additional options common for all types of

projection (options for creating broken views and handling sections). Working with those will be

described separately.

If overall size of a projection exceeds the page size, system will open the dialog box with options for

correcting inconsistency between the projection and the page. The dialog box offers the following

options:

· Change projection scale; 

· Change page scale; 

· Change page size; 

· Don’t change anything. 
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All correctional parameters are calculated automatically. User can agree with them or set custom

values.

Next, you need to position the projections on the drawing. Three pink frames appear in the 2D

window, attached to the pointer. These frames mark the extents of the projections being created.

Currently, all three projections are selected. Position a particular view, selected first. 
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View selection is done by clicking once within the pink box or by selecting an item in the combo box

in the properties window. After selecting a projection, you need to select the fixing point in the 2D

view. Click , and the projection will be attached to the position of the pointer. The option of

positioning a view allows fixing a projection to an unconstrained point (right under the click) or to a

2D node. 

The mechanism of positioning a projection on the drawing is common to all types of

projections; therefore, we will skip its detailed description in the future.

If the front (main) view is being positioned, the rest of the views maintain their position with respect

to the main one. When adjacent views are positioned, the projective relation is maintained with

respect to the main view. The projection centerpoint snaps to the attachment point. If you need to

align the attachment point with a specific element of the 3D model (3D node or vertex), then you

should create a projection using the set of additional tools in the 2D Projection command.

By default, the adjacent views maintain the projective relation with the main view. 

Identical parameters are set for all views created simultaneously. In the case when different settings

are required for a particular view, select it in the properties window. After that, you can define the

specific elements to be projected on this view or select a 3D section to be used on the view. In some

cases, this approach to creating views can save time.
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If necessary, one can select model elements to project using the option . Selection of bodies for

projecting is described in details below, as this command is common for all types of projections (see

the section 2D Projection. Main Concepts).

Section Сut and Section View

The command can be called in one of the following ways:

Icon Ribbon

Assembly > Additional > Section View

Weld > Additional > Section View

Keyboard Textual Menu

<3SJ>

It is also available as option in the 2D Projection command:

<2> Section View

Before beginning with creating a local view or section, have certain elements available. First, you

should create in advance either a 3D section (the Create 3D Section command), or a 2D section on the

drawing (the Section command). Note that the latter element should be constructed on one of the

existing projections. Only in this case it can be used for creating sections.

Next, you need to call the Section View command and select a 2D section on the 2D drawing or a 3D

section using options:

<S> Create 2D Projection based on 3D Section

<L> Create 2D Projection based on 2D Section

The normal to the section plane defines the projection direction. 

Next, define the projection attachment point in the 2D view using the appropriate options.

Breaking or reinstating the relation between the projection being created and the specified section is

done using the option:

<K> Break link of Projection with Front View

After that, you can select elements for projecting and elements to be sectioned. 

When creating a projection from 3D section, by default, the system automatically recognizes, which

elements the 3D section is applied to, and selects them as elements for projecting. When creating a

projection from the 2D section, by default, all elements are selected for projecting. Alternatively, you

can select elements for projecting manually. Selection is performed using the automenu option:
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<E> Select model elements to project

By default, the section is applied to all bodies selected for projecting. However, this is not always

required. There is a provision for specifying the list of operations or Bodies to be subjected to the

section.

When creating a local view or section on the basis of 2D section view, the presence of a gap on the

initial projection is taken into consideration.

The parameters for controlling the sections that are in use are joined in one group and positioned on

the Sections tab of the properties window. The used sections are displayed in the list Use Sections.

This list displays the names of 3D sections or IDs of section notations. To select an additional 3D

section, placed the pointer at an empty line marked by an ellipsis, and then select the desired element

in the model space or in the 3D Model window. 

Alternatively, a section can be selected by the automenu option:

<O> Select 3D Sections to apply  

The type of the projection created by using sections can be selected from the combo box: Section

View, Only Section Planes, Unfold/Radial Section and Section with Unfolding. 

Unfolding can be done only if a composite section was used (a one containing multiple

segments).

Each of the sections can be applied to all objects being projected at once, or just to the specifically

selected objects among those being projected. The list of operations/Bodies subject to the selected

section is displayed in the "Use Sections" list. To select elements, use the list in the properties window

or the automenu option:
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<Ctrl>+<O> Select Operation to which 3D Section will be applied 

This option allows selecting not only operations, but also Bodies. 

The way of using the list of bodies can be set in the combo box. The available options are All

Elements, Selected Elements, All Elements Excluding Selected, From 3D Section Parameters. The All

Elements option is set by default in the used if the elements list is empty. When choosing the From 3D

Section Parameters option the section application rules are taken from the 3D section properties.

It is possible to specify beforehand that a 3D fragment will NOT be cut by a section when

creating a section view of an assembly. This option can be set in Set Document Parameters

command and is usually used in the libraries of standard parts.

The option Unfold/Radial Section can work in one of two modes. This depends on what type of

multiple-point section is used in the case. If a multiple-point section is composed of all straight

segments, the whole section will be fully unfolded. If at least one segment of a multiple-point section

is a circular arc, then the radial section mode turns on. In this case, all arcs are skipped when unfolding

the section.

The option Section with Unfolding always creates full section unfolding, even when the section

contains circular arcs.
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In the following example, two sections are created, both based on the main view. In the first case, the

section was applied to the shroud only, while in the second case – to all bodies.
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The following additional settings are provided in the sections handling group of parameters: 

Fill Element Outline. This setting helps correctly draw threaded connections in which elements

penetrate each other (due to the specifics of this type of connection). Additionally, some elements of

the threaded connection (for example, the standard elements) can be exempted from section. 

 

Hatch. This parameter defines whether to hatch the section or local view. The precision of defining the

hatch contour can be set in the provided box. 

Scale. The hatch scale 

Accuracy. This is the accuracy of tracing the hatch contour. Adjusting this parameter helps in

complicated cases, when the system cannot hatch the contour under the previously specified

accuracy. 

Fit Angle. Sets the choice of automatic hatch angle definition for crosscut parts. The combo box

provides two choices: 45, -45 only and 30, 45, 60, -30, -45, -60.

Fit Step. Sets the upper and lower limits on the values, within which the system automatically picks up

a hatch step. The step size is determined relative to the area of the hatch contour.
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By Graphic Lines. This option is available only for projection of the type “Precise (Image Lines”). When

this flag is on, the hatch on cuts/sections is formed by graphic lines of the projection, when it is off –

by faces which appear on the projected body as a result of applying 3D section.

By default this flag is turned off, i.e., the hatches are created by the faces of the section (since the

graphic lines on the projection do not always form a closed contour due to loss of accuracy while

projecting).

It is recommended to turn on the flag By Graphic Lines if the hatch being created will be used later

for construction of 3D profile or local section view.

Managing hatch properties in cuts and sections

The drawing standards require that all cut or sectioned parts are hatched in a certain way. If the

material the part is made of requires hatching by a special pattern, then the appropriate pattern hatch

type must be set in the material properties. In all other cases, the material is hatched in the sectioned

areas by the repeating lines with a certain slope and step. If multiple bodies are involved in a section,

then the hatch slope and step must differ across them. When creating a cut or sectioned for the first

time, the system automatically picks different hatch properties (slope angle and step) for different

parts. Note also that the hatch parameters that were once picked for a certain part (operation) are

automatically remembered in the model, and the same hatch parameters will be used for the same

part in any cuts or sections on other views. 

Those hatch properties are stored together with the original operation and are propagated on

child operations, whenever those have the flag set, Attributes from Source Operation.

However, user can edit hatch parameters. Upon confirming hatch parameters change, the system asks

to Save Hatch Parameters in source Operation in order to use in other Section Views:

This dialog appear only if changes are made using the hatch parameters dialog and the Hatch is

used both as initial and final filling methods. 

If you answer Yes, new hatch parameters are saved in model and will be used as default hatch for this

part on all sections. If you answer No, new hatch parameters are only applied to current projection.
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To revert the individually specified hatch properties back to the properties assumed from the 2D

projection, one would need to right-click this hatch  and in the coming up context menu

select the item Properties from Projection. 

Another useful item in the context menu of a cut hatch is Do not Apply Section. Upon calling this

command, the operation for which the cut hatch was created will be added to the list of the

operations that shall not be subjected to sectioning in the given projection. After that, the projection

will be automatically rebuilt.

Arrow View

The command can be called in one of the following ways:

Icon Ribbon

Assembly > Additional > Arrow View

Weld > Additional > Arrow View

Keyboard Textual Menu

<3АJ>

It is also available as option in the 2D Projection command:

<3> Create arrow view

Before creating an Arrow View it is necessary to add to the drawing an arrow defining a direction of

an arrow view.

Activate a view, from which the projection will be taken, call the Section command and select the

following option:

<3> Arrow View

Now you can put an arrow on the drawing, it is possible to snap to any objects in the model or to

place it at any place. By default, the arrow is directed to the right, for more precise direction setting,

you can use the automenu options:

<N> Select node

<B> Select first attachment point

<E> Select second attachment point

<Z> Changing view direction

<H> Changing text placement

With the help of the option , you can select the first attachment node to the projection, for

convenience, the system automatically extends the lines, for more convenient placement of the arrow:
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Then the system automatically prompts you to select the second attachment node.

Additionally, you can use the options  and . The option  is used to change the position of

the arrow rotates the arrow clockwise by 90 degrees with each activation, and the option  is used

to change the position of the text moves the text in two possible positions - above the arrow or below

the arrow.

After the arrow has been created, you can start forming the projection. 

To do this, call the Arrow View command and then select the newly built arrow in the drawing.
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An additional one will be built relative to the main view. By default, the secondary view maintains a

projection relationship with the main view. In order to break the connection with the view, you must

deactivate the option in the automenu:

<K> Set / Break link with projection

Last steps - position the projection in the drawing and, if necessary, select the elements of the model

for projection.
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Local Section View

Local section allows to cut a particular area of a projection. Cut area is limited by a hatch contour's

spline or polyline. Cutting plane is parallel to a parent projection's plane and passes through a node

selected by the user. It could be either 3D point in 3D scene or 2D node on another projection.

There are two methods of creating a local section:

1. As separate projection. 

Local section projection gets created as a separate object and superposes the parent projection.

This method allows to cut only a single area at once. In order to cut several areas within the same

parent projection, you would have to create several local section projections. Either 2D node or 3D

point can be used for positioning the cutting plane.

2. Within main projection.

Local section gets created as a part of a main projection. There's no separate projection object.

This method allows to cut several areas by several planes on a same projection at once. Only a 3D

point can be used for positioning the cutting plane. 
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Local Section as Separate 2D Projection

The command can be called in one of the following ways:

Icon Ribbon

Draw > Projection > Local Section View

Assembly > Additional > Local Section View

Sheet Metal > Draw > Local Section View

Weld > Additional > Local Section View

Keyboard Textual Menu

<3DJ>

It is also available as option in the 2D Projection command:

<4> Local Section View

This command allows creating local section views on an existing projection.

The boundaries of the local section view are defined by the hatch contour. You can use an existing

hatch or create a new one directly in the Local Section View command. 

Use the following automenu option to select an existing hatch:

<1> Select Hatch as boundary of local section view

Upon completing creation of the local section, the hatch becomes invisible, while screening out

a portion of the main projection. The lines of the local section will be drawn with higher priority,

than those of the hatch and the main projection.

Geometry of the graphic lines bounding the contour of the original hatch can be taken into

consideration when defining the boundaries of the local section view. For example, if the hatch

contour pattern was set as waves, the boundaries of the local section view will also have waves

pattern. A user can toggle on/off the lines type switch found in the parameters of the local section

view.

Use the following automenu option to create a new hatch directly in the Local Section View

command:

<6> Create Hatch by Spline

Upon selecting this option, click  on a drawing sheet. 

If cursor is inside boundaries of any existing projection (the projection gets highlighted in this case) at

the moment of clicking , then the spline command will be launched:
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Upon finishing spline creation, the system returns to local section view command and selects this

spline as a section boundary.

If cursor is outside boundaries of any existing projections at the moment of clicking , then the

projection selection dialog appears. Upon selecting a projection, the system launches the same  spline

command as described above.

Next, define the position of the section plane. The plane normal automatically coincides with the

viewing direction of the main projection – the one used for creating the local section view. Thereafter,

position the view plane either by a 3D node or by a 2D node in another projection. For example, if you

are creating a local section on the Left View, then the 2D node can be selected in one of the adjacent

standard views: Front, Top, Bottom, Back.

The 2D or 3D node can be selected using the options:
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<3> Select 3D Point, defining section position

<2>
Select 2D Node on other Projection, defining section

position

The local section view is automatically tied to the projection on which it was created. However, this tie

needs to be broken in some situations, in order to attach the local view to the drawing at a different

location. The option to break the tie is:

<K> Set / Break link with projection

Once the tie is broken, the following option is available for attaching the projection to the drawing

(an unconstrained attachment or snapping to a 2D node).

<5> Move Local Section View

When creating a local section view, we recommend selecting specific model elements to be

projected. Selecting the elements that actually fall in the area of the local section view speeds

up regeneration of the projection.

Local Section within Main 2D Projection

When creating most of the projection types, there's the following automenu option:
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<G> Add Local Section View

Upon selecting this option, the dialog appears, where you can choose a type of contour limiting local

section area on the projection.

 

Spline

Selecting the Spline type of contour launches the command for creating a spline.

Set the desired spline configuration and confirm its creation . Then the system returns to the 2D

projection command, where you have to switch to 3D view window and select a point in 3D scene.

When switching to 3D scene, filters for selecting  points become active on the filter toolbar.

Selected point will define the position of cutting plane. 

Upon selecting a point, the creation of the current local section ends. Next you can add another local

section to the same projection, edit the existing one or proceed with the projection creation.

Local Section Views created this way are listed in the Sections tab of 2D Projection command's

parameters window. Views can be selected in the list using . The list can be managed using

Expand , Collapse , Delete Element from the List  and Clear  buttons located to the right.
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Input boxes below the list indicate Hatch (spline) and 3D Node used for creating a currently selected

local section view.

Circle, Ellipse, Rectangle

Upon selecting the Circle, Ellipse or Rectangle type of contour, the system automatically constructs a

contour of a corresponding shape. Additional input boxes appear in the bottom of the Sections tab of

the command's parameters window, where you can customize contour parameters. Radius can be

customized for Circle, Width and Height - for Ellipse and Rectangle. To the right of such input boxes

you can find buttons controlling the position of a contour in relation to the anchor point (  centered,

 to the left,  to the right,  above,  below). Button of a currently applied option is

highlighted. Anchor point is defined by projection of a 3D node, which defines the position of cutting

plane.

 

Automenu options for editing the local section

Following automenu options can be applied for editing the local section view currently selected in the

list:

<8> Edit Current Local Section View

Launches editing the spline limiting the section area. This option is not available, when using the

Circle, Spline or Ellipse contour.
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<7> Change Node, defining cutting plane position

Allow to re-select a point defining the cutting plane's position. Alternatively, the point can be re-

selected upon clicking  the corresponding input box in command's parameters window.

<9> Delete Local Section View

Deletes the local section view currently selected in the list. Alternatively, the view can be deleted using

the Delete Element from the List  button.

Three options mentioned above are combined into a drop-down list within the automenu. Only one

option is displayed permanently. Click and hold  on it in order to display rest of the options.

Standard View Set

The command can be called in one of the following ways:

Icon Ribbon

Draw > Projection > Standard Views

Sheet Metal > Draw > Standard Views

Keyboard Textual Menu

<3ТJ>

It is also available as option in the 2D Projection command:

<5> Standard View Set

This command can be used to create an arbitrary number of standard views.

Upon calling the command, a dialog box appears for defining the projections to obtain.

The principle of working with an arbitrary number of standard views does not differ from the principle

of working with three standard views and is described in the Three Standard Views section.
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Projection to Workplane

The projection on a workplane is used when working with active workplanes. For example, when

creating a new workplane based on a flat face, the selected face can be automatically projected on

that workplane. More details about projection of elements can be found in the corresponding section.

If the workplane is present in the 2D view, sometimes it is convenient to use that workplane for

projecting model elements. The following the option is provided for this purpose:

<6> Projection to Workplane

The workplane can be selected either in the 3D window or on the 2D view. The projection will be

created in the same page of the drawing as the selected workplane. You do not have to explicitly

position the projection on the drawing. The position of the projection is determined automatically,

since each workplane has its specific position in the 3D space. The objects are projected on the

workplane along its normal direction.

By Projection

To create such a projection, the  option is used. Upon selecting this mode, the following options

become available in the automenu:

<V> Select source Projection to specify Parameters

<E> Select model elements to project

<A> Select all Solids in current scene

<F> Select File with 3D Model to create Projection

<O> Select 3D Sections to apply

<Ctrl>+<O> Select Operation to apply 3D Section

First, the source 2D projection is to be specified in order to use its properties for the projection being

created. The new 2D projection will match the source one in its position, orientation, and the use of

broken views. The rest of the projection parameters can be edited: you can change the list of the

objects to be projected and the applied sections, the projecting (mapping) method, available line

styles, and hatch parameters.

The newly created 2D projection is automatically assigned the priority which is by five points greater

than the source projection. In addition, the flag Create Outlined Area is set in the properties of the

new 2D projection (see the section 2D Projection Parameters).

This method of creating a 2D projection can be used to construct projections of threaded connections

where both the “screw” and the “nut” of the connected pair are sectioned. The thread lines of both the

“screw” and the "nut" will be overlapped on the projections in which both parts are simultaneously

sectioned. To insure the correct appearance of a threaded connection, what one can do is originally

create the projection of the sectioned “nut”, and then create another 2D projection based on the first

one, where you specify the “screw” only in the “to be projected” list.
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Arbitrary View

The command can be called in one of the following ways:

Icon Ribbon

Draw > Projection > Arbitrary View

Sheet Metal > Draw > Arbitrary View

Keyboard Textual Menu

<3ZJ>

It is also available as option in the 2D Projection command:

<8> Arbitrary View

Upon calling the command, following actions are available:

<F> Select Plane to define view direction

<N> Select Point for superposing with the attachment point

<K> Cancel setting of view direction.

<O> Select 3D Sections to apply

<E> Select model elements to project

First, define the position of the projection on the drawing – select the attachment point. The

axonometric projection of the whole scene is created by default in the world coordinates. The

projection of the world coordinates origin is snapped to the point on the 2D view selected at the

previous step. 
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A 3D point can be selected to define the point in the space for aligning with the fixing point on the

projection. 

The projecting direction can be changed by one of the following means: 

· Select projection plane. The projecting direction will be defined by the normal to this plane.

To select a plane, use the option:

<F> Select Plane to set view direction

· Define the viewing point in the properties window. It can be defined using coordinates or by

selecting one of the standard or custom views.

The coordinates of the view direction can be defined in the properties window. The X, Y and Z are

entered in the respective input boxes of the end point of the direction vector. The start point of the

vector is the origin of the world coordinate system.
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Angle is a parameter that sets the rotation angle of a 2D projection in a 2D view relative to the anchor

point. A positive value specifies counterclockwise rotation.

Defining the coordinates and the rotation angle is possible only after creating an arbitrary view. When

creating other types of view with projective relation, such as standard or section view, the coordinates

are defined by the system, and so these fields may be blocked.

In the general parameters of the projection, there is a set of basic arbitrary isometric views -

Axonometric (Front), Axonometric (Back), Axonometric (Bottom Front), Axonometric (Bottom

Back).

Boundaries of 2D Projection

Boundaries of 2D projection are represented by a rectangular contour drawn in a dash line. By default

inactive projection's boundaries are light gray, active - light magenta. These colors can be changed in

the Colors tab of System Options.

Inactive projection Active projection

Projection can be selected or activated using the mouse within area enclosed by its boundaries.

Boundaries are not printable. In general, projection's boundaries works in a same way as drawing

view's boundaries. The main difference is that projection's boundaries are defined automatically. An

offset between a boundary and graphic lines of a projection is defined by Document Parameters. You

can customize it if necessary (Document Parameters > Paper > Projection View > Expand projection

boundaries). Graphic lines added by user after creation of a projection do not affect its boundaries.
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Default boundaries Customized boundaries expansion

View Styles of 2D Projection

The view style of 2D projection created (regardless of the method of creation) is defined in the

command properties window, in the General Parameters section.

Precise (Graphic Lines)

Vector Picture

Rendering

Shading

Wireframe

Working with Precise (Graphic Lines) 2D projections

2D projection of the Graphic Lines style is a special element of the system. In the drawing, you can see

only the direct descendants of this element, namely the graphic lines and hatches. The combination of

these elements forms a projection image. The main part of the parameters of each element is taken

from the projection parameters dialog during creation. For example, the type of various projection

lines, color, scale of strokes, priority, etc. However, if you wish, you can change the individual

parameters of each element. This can be done in the element parameters dialog, which can be

conveniently called from the context menu.
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Depending on which element was selected when pressed  (the 2D projection itself or its

element is a descendant), the context menu has a different composition.

If a direct descendant of the projection (graphic line or hatch) is selected, then its own context menu

will additionally contain some specific commands for working with 2D projection.

The work of the standard  Delete command is somewhat different. In this case, it does not delete,

but only allows you to hide the selected item. Thus, you can suppress some unnecessary elements of

the projection.

You can link construction lines, dimensions, design elements, etc. to precise (graphic lines) 2D

projections. When creating construction lines, the object snap to the projection elements works, which

distinguishes arcs of circles, ellipses, splines, segments, extreme points of the line (nodes), the center

of the arc, etc.

Working with 2D projections of the Vector Picture, Rendering, Shading, Wireframe view styles

2D projections of the Vector Picture, Rendering, Shading, Wireframe view styles in the drawing are

single objects (unlike 2D projections of the Graphic Lines style). The parameters of individual image

elements of such projections cannot be changed.

Otherwise, working with 2D projections of these types is similar to working with a projection of the

Graphic Lines type. The context menu of such 2D projections repeats the context menu of a 2D

projection of the Graphic Lines type.

When creating 3D design elements on 2D projections of the Vector Picture, Rendering, Shading or

Wireframe view style, the created design elements are attached directly to the elements of the 3D

model.

Contextual Menu of 2D Projection and its Elements

Contextual menu of 2D Projection 

The contextual menu of 2D Projection contains several specific commands:
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·  Activate

·  Activate in new window

·  Edit Breaks

· Explode Projection

Calling the command invokes the dialog window, where you can select one of the following

options:

o Explode projection and create drawing view

Converts projection into a regular drawing view, which is not linked to 3D model. This option

is not available, if a projection is created using the compatibility mode, contains breaks or

cropped.

o Explode projection, without creating drawing view

Converts projection into free graphic lines, hatches and drawing appearance elements, which

belong to the current drawing page and are not linked to 3D model.

o Explode projection, uniting objects into group, without creating drawing view.

Converts projection into a group of free graphic lines, hatches and drawing appearance

elements, which belong to the current drawing page and are not linked to 3D model. A

name of a group contains of a name of exploded projection and group's number. 

Additionally, there is the Don't show this message again checkbox in the bottom of the

dialog window. If you enable this checkbox, then the selected option will be applied

automatically upon using the Explode Projection command again in the current T-FLEX

CAD session. In such case, the dialog for selecting options won't be displayed. 

· Create 2D Annotations 

· Hide constructions

· Process Bodies with Errors

· Synchronize Page Parameters

When this checkbox is enabled (by default), parameters of view's page are synchronized with

parameters of document's page, which contains this view. So changing view's page parameters

changes document's page parameters and vice versa. On the first synchronization parameters

of document's page are applied to view's page.

· Apply Breaks in Active View

· Restore deleted elements

Restores graphic lines and hatchings, which were deleted using the  Delete command.

· Update locally

The command saves time when working with complex models and drawings. Unlike the 

 Update command, it doesn't recalculates child elements. This comes useful when working

with complex projections that are linked to each other.

· Delete unused projection elements

Enhances performance and optimizes projection regeneration by deleting elements without
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geometry. Such elements are formed upon updating a projection after changes in visibility of

3D elements. E.g., if a new 3D element blocks the view of currently projected elements, then

upon updating the projection, lines of blocked elements won't be displayed, but still remain in

the structure of the projection. Use this command in order to delete such elements. Upon

future updates, deleted lines will be restored, only if corresponding 3D elements become

visible again. 

Contextual menu of 2D Projection Elements

The Projection item in the contextual menu of precise (graphic lines) 2D projection elements contains

commands for working with the whole projection:

·  Edit 2D Projection

Same as using the  Edit command in projection's contextual menu.

·  Delete 2D Projection

Same as using the  Delete command in projection's contextual menu. 

·  2D Projection Parameters

Same as using the  Parameters command in projection's contextual menu.

·  Update 2D Projection

Same as using the  Update command in projection's contextual menu.

·  Create 2D Annotations

·  Restore deleted elements
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2D Projection by External Model

The mode of constructing a projection by a model from an external file is useful when working with

complex 3D models and assemblies, in which cases you can significantly save the computational

resources by avoiding the 3D model recalculation. When creating a 2D projection, the system takes

from the external file only geometrical data saved in this file.  It is also possible, if necessary, to

compose a single drawing from different 3D models (different versions, individual fragments, etc.).

The option to select an external file to construct a projection is available in the command's automenu:

<F> Select File with 3D Model to create Projection

If the user calls the command to create a 2D projection, but no 3D model is present in the current

document, then at the beginning this will be the only option in the automenu. Upon calling this

option, the standard dialog window to select the file will appear. Once you selected a file with the 3D

model, all the rest of the options to construct the projection would become available in the

automenu. After that, the projection is constructed as usual. At the same time, there are restrictions on

selecting elements to map (project). In this case, it is always the entire 3D model contained in the

selected file that will be mapped (projected).

If it is necessary to create several projections based on an external file, you do not have to select

it over each time. When constructing  related views (a related standard view, cuts and sections,

arrow views), the data about the 3D model is automatically accessed from the initial projection.

The information about the used external file is recorded in the 3D model tree next to the 2D

projection name. If you right-click on the 2D projection , then you will see in the contextual menu

the  Open command, which open the external file used for projection. The name of the file used to

construct the 2D projection can be found on the Elements tab of the 2D Projection Parameters

window.

The mode of constructing a projection based on the model from external file can be also

activated by setting the method of projection From File in the group of the properties window

Elements for Bodies and operations. Simultaneously, the option  will be activated

automatically.
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Breaks of 2D Projections and Drawing Views

Main Concepts of Breaks

When drawing long parts, it is often necessary to limit the part view to a certain portion for keeping

the drawing compact. T-FLEX CAD provides tools for creating projections, drawing views and detail

vies with breaks. Breaks can be added for all types of projections, except for the local section view and

the unfolding section view. 

Pay attention to the following details when working with broken views: 

· When attaching a radial dimension or both legs of a linear dimension to lines of such

projection or their children, the system automatically adjusts the dimension to obtain the true

value. 

· If the broken view was created in an already existing projection (when editing it) with some

elements attached to it, such as dimensions, then these elements may get lost due to changes

in the projection topology after creating the broken view.

If you create a new projection by a projection with break, a break from the main projection will

be copied to the dependent projection.

The breaks are created only in two orthogonally related directions. The number of breaks in either

direction is unlimited. A break is defined by a rectangular area. Two of its boundaries are determined

by the extents of the projection, while the other two are defined by the user using the mouse and the

appropriate options.

The rectangular area of the break is hatched by the lines at the time of creating and editing, the lines

direction indicating the direction of the view reduction (orthogonal to the breaking lines).

The following diagram shows an example of a projection with a broken view.

After creation, the activated projection is displayed by default with the break applied.
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Apply Breaks in Active View

Contextual menus of broken projections and drawing views contains the Apply Breaks in Active View

checkbox. For drawing views it is located at the upper level of the menu, for projections - in the

Additional section. The checkbox is enabled by default. In result, in active state the view is displayed

with breaks applied (same as inactive). If you disable the checkbox, then active view will be displayed

without breaks. However, the break areas will be marked by decorations similar to the break

manipulators. Unlike the manipulators, the decorations can not be interacted with, i.e. you can't drag

them using mouse in order to edit the break area. For editing use the  Edit Breaks command.

Adding breaks, when creating projections and drawing views

Automenu of projections and drawing views creation commands contains following options:

<B> Add or edit Broken View

This option switches the 2D Projection command into the breaks editing mode. In this mode a click

 within the drawing window adds a break to the current projection. The type of such break

depends on the direction of mouse movement at the moment right after clicking (horizontal

movement adds a vertical break, vertical movement adds a horizontal break). After the first click ,

the manipulator of break boundary starts following the cursor movement, while the cursor itself

changes the appearance to  or   depending on the break type. Move the manipulator to the

desired position and click  again. The position of the first boundary will be fixed, and the

manipulator of the second boundary will start following the cursor. Move the manipulator to the
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desired position and click  once more. The position of the second boundary will be fixed, and the

break will be complete. Next you can add more breaks in the same manner. You can use the object

snapping for selecting a point, while moving a manipulator of break boundary. Snapping a

manipulator to a point creates an associative link between a position of a break boundary and

position of a point, i.e. upon future changes in a position of a point, a position of a break boundary

will be updated accordingly.

Breaks manipulators may have different colors depending on condition of a break:

1 - Break base point marker is blue;

2, 3 - Breaks with no issues are green;

4, 5 - Breaks intersecting with other breaks of the same type are red;

6 - Breaks, that can not be constructed for some reason, are gray.

Active break, as well as inactive break under the cursor, 

are displayed in more bright versions of corresponding colors and have thicker boundaries.

Colors of manipulators can be customized in the system options (Options > Colors > Drawing Views

with Breaks).

Intersections between breaks of the same type are ill-advised, due to extending time of recalculating

the projection, but do not prevent the construction of a break.

Parameters of all added breaks are displayed in the Breaks tab of the parameters window. For the 2D

Projection command this tab unfolds automatically upon calling the breaks adding automenu option.

For the Drawing View command the breaks adding automenu option is available only, when view

already contains graphic lines. In such case, the option launches the  Edit Breaks command and

opens the selected page. Then, upon finishing the breaks editing, the system returns to the creation of

the view on the initial page.
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A break is considered "active", when it is selected in the list of breaks in the Breaks tab. In order to

edit break boundaries, move the cursor over the manipulator of the desired boundary and click .

The break will become active, and the selected boundary will start following the cursor. Establish the

new position of the boundary and click  again to confirm the changes. Positions of breaks

boundaries correspond to the Start and End parameters located in the Breaks tab. You can reposition

boundaries by typing in new values of these parameters instead of using the manipulators.

The detailed information on the content of the Breaks tab is available in the Parameters of

Breaks paragraph.

The break base point marker indicates the position of the breaks alignment center. By default, the

center of projection/view is used as base point. The  Edit Breaks command provides the custom

base point selection option. Arrow of the marker indicates the breaks slope angle. At zero angle the

arrow is pointed to the right horizontally. 

<V> Add vertical break

Adds a vertical break with default boundaries positions. Default positions set value of the Start

parameter to 40 and the End parameter - to 60 in units defined by the Measure parameter.

<H> Add horizontal break

Adds a horizontal break with default boundaries positions similar to the previous option.

<5> Copy break lines positions from other Drawing view

Allows applying the breaks of another projection to the current one, if there is a projection link

between these projections. The option contains the drop-down list of all projections linked with the

current one. Click and hold  on the option's icon to invoke the list; then select a desired projection

in the list. Breaks of the selected projection (if there are any) will be applied to the current projection.

A short click  on the option's icon copies breaks from the main view without invoking the list.

Copying doesn't create an associative link between breaks of involved projections, i.e. future changes

in breaks of the source projection do not affect breaks of the current one.
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<R> Enter angle

Breaks are either horizontal or vertical by default. This option allow to make them sloped. Activate the

option, then click and hold , while moving the cursor around the base point. Breaks manipulators,

arrow of base point marker and projection's bounding box will rotate following the cursor movement.

The counterclockwise direction is considered positive. During rotation the bounding box will be re-

sized in order to fit the whole projection. Set the desired angle of rotation and release . The angle

value is displayed in the Angle input box in the Breaks tab of the parameters window. Alternatively,

you can set an angle by typing in the value into the input box.

Parameters of Breaks

Also additional settings of broken views are done with the help of the properties window.
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Breaks of a current projection are listed in the Breaks tab of the parameters window. You can select

breaks in the list by clicking . You can  Add Vertical Break,  Add Horizontal Break, 

 Delete the selected break or  Delete All breaks using buttons located to the right of the list. For

each break the list displays a break type icon (  - vertical,  - horizontal) and following parameters:

· Start

Position of a boundary closest to the origin.

· End

Position of a boundary farthest from the origin

Values of the Start and End parameters are defined, when using the manipulators of break

boundaries. Alternatively, you can type in values into Start and End input boxes below the list. These

input boxes contain parameters of a break currently selected in the list. Values can be defined using

variables; then names of variables are displayed in the list in square brackets after numerical values.

Unit of measurement for these parameters are defined by the selected Measure option. Origin and

direction of measurement are defined by the alignment options (see further).

Below the Start and End input boxes there are following parameters, common for all breaks in the list:

· Measure

Units of breaks positions measurement. Following options are available in the drop-down list:

o Percentage

Position is measured in percents of projection's bounding box dimensions.
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o In Model Units

Position is measured in absolute length units set in the Document Parameters for the current

drawing page (by default: inches for ANSI drawing, millimeters for ISO drawings). 

· Horizontal Alignment

Defines origin and direction of horizontal breaks position measurement. Following options are

available in the drop-down list:

o  Bottom

Position is measured upwards from bottom boundary of projection.

o  Center

Position is measured upwards from center of projection.

o  Top

Position is measured downwards from top boundary of projection.

· Vertical Alignment

Defines origin and direction of vertical breaks position measurement. Following options are

available in the drop-down list:

o  Left

Position is measured to the right from left boundary of projection.

o  Center

Position is measured to the right from center of projection.

o  Right

Position is measured to the left from right boundary of projection.

· Angle

Breaks are either horizontal or vertical by default. In order to make them sloped, you should

define a slope angle. Angle is defined either by typing a value into the Angle input box, or

using automenu option (see above).

· Direction Line

When editing breaks, you can define a brakes angle by setting the arrow of base point marker

parallel to a construction line. In such case, a value in the Angle input box becomes non-

editable, and the Direction Line input box indicates an icon and a name of a selected line. You

can  Clear the selection using the button located in the right side of the box. Clearing the

selection restores the zero angle.

· Distance

Distance between adjacent broken parts.

· Length of Extension Lines

This checkbox is disabled by default. In such case, break lines are drawn only through bodies

on projections and only between outermost graphic lines on drawing views not linked to the

3D model. Enabling this checkbox extends breaks lines on each side at a distance set in the

input box located to the right of the checkbox.

· Don't Move Broken Parts

This checkbox is disabled by default. In such case, broken parts of projection are placed at the

distance from each other set in the Distance input box. Enabling this checkbox makes broken

part stay in initial positions.
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· Break lines type

You can select one of the following line types in the drop-down list:

Thin Zigzag Thin Waves Thin Dashdot

T - Period, A - Amplitude, D - Distance

Keep in mind, that the more complex the break line is, the longer it takes to regenerate a broken

view.

· Thickness

Thickness of break lines in absolute length units set in Document Parameters for the current

drawing page (by default: inches for ANSI drawing, millimeters for ISO drawings).

· Color

This checkbox is disabled by default. In such case, break lines are colored in black. Enabling

this checkbox allows to select a color from the drop-down list, or from the catalog, as

described in the Color section.



2D Drawings of 3D Models

2423

· Amplitude

The geometric meaning of this parameter is shown in the figure above. This parameter is not

available for the dashdot line.

· Period

The geometric meaning of this parameter is shown in the figure above. This parameter is not

available for the dashdot line.

Edit Breaks

The  Edit Breaks command is available in the contextual menu of projections and drawing views. It

provides extended capabilities of breaks editing, compared to the 2D Projection command. Upon

calling the  Edit Breaks you can add and edit breaks using manipulators in the same manner as

described above. I the meantime, the command's parameters window contains the Breaks and

Exclusions tabs, and the automenu contains following options:

<Ctrl>+<Enter> Finish Page View editing

Exit the command and save changes.

<C> Select Base Point

The center of projection is used as the base point by default. You can select custom base

point using this option. Upon activating the option, move the cursor over the desired

location in the drawing and click . The base point marker will be relocated to the

selected location, and breaks positions will be recalculated in new coordinates if necessary.

You can either place the base point in an arbitrary location in a drawing, or snap it to the

existing 2D object. Use the Filter toolbar for controlling the object snapping. Snapping the

base point to an existing object doesn't create an associative link, i.e. further changes in

position of a selected object do not affect the position of the base point.

<A> Select Line Setting Break Direction

As an alternative to manual defining of breaks angle, you can link the angle to an existing

construction line belonging to the current projection. Activate this option and select the

desired line. The Direction line box of the parameters window will indicate the icon and

name of the selected line, and the Angle of breaks will be defined as the angle between the

selected line and the horizontal direction. The associative link is created between the angle

of the line and angle of the breaks.

If you activate the line selection option, when a line is already selected, then the following

option will be available:

<B> Break relations

This option breaks the link between the breaks angle and the construction line.

Alternatively, you can break the link using the  Clear button located in the right side of

the Direction Line input box in the parameters window.

<L> Select Lines Setting View Bounds

By default, break lines are drawn only between outermost graphic lines on drawing views

not linked to the 3D model (or get extended beyond that at the specified distance, if the
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Length of Extension Lines checkbox is enabled). Drawing detailing elements (dimensions,

texts, etc.) and graphic lines with the Don't trim exclusion are ignored, when calculating

endpoints of break lines. Upon activating this option, you can manually select two graphic

or construction lines (straight, spline, function) that will define the endpoints of break lines.

Selected lines are highlighted in red during breaks editing. This option is non-applicable to

2D projections of 3D model. After selecting lines, following option becomes available:

<U> Cancel Break Lines Usage

This option is available only in the lines selection mode, which is activated by the previous

option, if some lines are selected. Activating this option clears the selection.

<H> Add horizontal break

<V> Add vertical break

<R> Enter angle

Within the  Edit Breaks command these options work in the same way, as described

above.

<Esc> Exit command

If you made some changes, while working with the command, then  activating this option

invokes a question: "Save changes?". Click Yes to exit the command with saving changes, or

click No to exit without saving.

When using the break boundary manipulators within the  Edit Breaks command, the additional

option is available in the automenu:

<N> Select insertion Node

If you click  anywhere in the drawing, upon activating this option, then current break boundary will

be snapped to the 2D node nearest to the cursor location. The associative link is created between the

node and the break boundary (same as when you select a node without using this option), i.e. upon

future changes in a position of a point, a position of a breaks boundary will be updated accordingly.

Excluding an elements from a break

When using the  Edit Breaks command, the parameters window contains the Exclusions tab. The

tab lists Object to which breaks and clipping contours are not applied. Move the cursor over the list

and click  to activate the mode of selecting objects to be excluded. Contour of the list and its

name will get highlighted. Then you can select  any element of the current view. the selected

element will be put in the list with the Don't trim exclusion mode, i.e. breaks and crop will not affect

such element. the detailed information on the exclusion is available in the Managing elements of 2D

projection and Managing elements of Drawing View sections.
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Cropping 2D Projection

Automenu for most projection types contains the following option:

<T> Crop View

Spline creation command is launched upon selecting this option:

Upon finishing spline creation, the system returns to projection command and selects this spline as a

view outline.
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Use the following automenu option to cancel view clipping:

<Y> Reset view outline

It can be used both, when creating a new projection, and when editing an existing one using the Edit

option in projection's contextual menu.

Managing elements of 2D Projection

Following Breaks and Clipping Contour options are available in the contextual menu of active

projection's elements:

· Don't draw

· Don't consider when calculating break lines

· Don't clip

Elements affected by these options are added to the list in the Exclusions tab of projection's

parameters:

You can can switch between options for a particular element in the list using the  Change button.

Don't draw

Click  on active projection's element:
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Select Breaks and Clipping Contour > Projection_# > Don't draw in the appeared contextual menu:

Selected element is not drawn anymore:

Don't consider when calculating break lines

This option is available both on 2D projections and on basic drawing views. However, on 2D

projections it only affects lines representing contour of 3D model body. User-created graphic

lines on 2D projections are not considered when calculating break lines anyway, no matter if this

option is enabled or not.
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The option is enabled for the red line

Don't clip

Click  on active projection's element:
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Select Breaks and Clipping Contour > Projection_# > Don't clip in the appeared contextual menu:

Selected element is not clipped anymore:
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Placing Drawing Design Elements on 2D Projection

To design a drawing created on the basis of a 2D projection, you can use the standard 2D commands

- Create Dimension, Create Leader Notes, Create Roughness. This requires activation of the projection,

which occurs either automatically when trying to place a line or design element on the desired

projection, or using  on the drawing view. Deactivation of the drawing view is performed with

 outside the drawing view or using the Close Drawing View button located next to the View

toolbar. When the projection page is active, it is automatically ensured that it is impossible to set

dimensions and other symbols attached to different projections.

All dimensions specified on the projection page are attached to it, and when it is moved, they move

with it.

With a significant change in the 3D model and recalculation of 2D projections based on it, the

composition of the projection lines and the identification of some elements can sometimes

partially change. In this case, some of the design elements created on the lines of 2D projections

may lose their connection with the original elements. The system will notify about this by

displaying messages in the diagnostic window.

3D and 2D design elements

The 3D model may contain 3D Annotation - dimensions, inscriptions and roughness, set directly in the

3D window along the edges of the model. They allow you to make a 3D model more visual, to

simplify the change of its geometric parameters. In addition, information specified in 3D Annotation

can be transferred to similar 2D design elements on the projections of this model.

If the current 3D model has 3D dimensions or roughness symbols, then when creating 2D dimensions

and roughness along the corresponding projection lines, the system can independently find the

correspondence of the created element to a similar element in 3D. If such a link is found, all

parameters from the 3D dimension or roughness (rating, tolerance, text strings, etc.) are transferred to
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the 2D element being created. If you need to change these parameters of a similar 2D element, then

you need to change the corresponding element in 3D.

Data transfer from 3D dimensions to 2D projection can also be carried out by direct projection of

dimensions from 3D space to 2D projection. This is done using the  Create 2D Annotations

command available in the context menu when a 2D projection is selected.

When calling the command, the system determines which of the existing 3D dimensions in the model

can be transferred to the selected view (projection). The dimensions selected by the system are drawn

on the projection in red. The user needs to indicate which of the dimensions suggested by the system

he would like to put on the given 2D projection.

The choice of dimensions is carried out using the options of the command automenu:

<M> Select 3D Annotation

<M> Deselect 3D Annotation

<*> Select all elements

<End> Finish input

When this option  is active, the selection of dimensions that should be created on this projection

is performed. It is enough to point with the cursor to the required size in the 2D window and click 

to select a dimension. The selected size will turn blue. Thus, any number of sizes can be selected

sequentially.

Activation of this option  turns on the mode of deselecting dimensions. In this mode, pointing to

a dimension with  deselects it. As a result, the size changes its color to red again.

The effect of the option  depends on which of the above options is active. When the option 

is active, the choice of this option leads to the selection of all the dimensions proposed by the system,

with the active option , on the contrary, to the deselection of all dimensions.

You can confirm the creation of the selected dimensions on the projection using the option .

Modes of displaying dimensions in 2D projections

Dimensions in 2D projection lines can be displayed in two ways. The first method is the standard

display of dimensions (in a plane perpendicular to the direction of view). The second way is a spatial

representation of design elements. It is usually used for non-standard and volumetric views (for

example, isometric). In this mode, the dimensions created from the projection lines will be drawn

located in the plane of the selected elements. For example, if you are dimensioning an ellipse that

corresponds to a circular edge, the dimension will be in the plane of the edge's circumference. This

feature allows you to affix dimensions to isometric projections with real values.

This feature is activated by the Save Information for 3D Dimensions option on the Additional

parameters tab in the 2D projection properties. After enabling this parameter, the projection must be

updated.
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Dimensions in 2D projection in normal mode  Dimensions in 2D projection in 3D mode

The spatial way of displaying dimensions in a drawing is applicable to all types of dimensions,

except for construction ones.

Using Projected Dimensions to Control a 3D Model

2D dimensions set on the projection, in some cases, can be used to change the 3D model. This is

possible if the system was able to find a correspondence between the projection elements on which

the dimension was created and the controls of the 3D model. These elements include the faces of the

3D model, which depend on the geometric parameters of the operations, or on the 2D constructions

that underlie the operations of the 3D model. The system searches for such a match automatically

when constructing dimensions on a 2D projection. If the system manages to find a match, then

changing the size value will change the 3D model and its projections. Changing the dimension value is

carried out using the command Set values.

Scaling of 2D Projection

The scale of the projection can be set both before its direct creation, and after.

To set the scale before creating the projection, set the required value in the Scale field in the

projection parameters.
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If necessary, you can select a scale from the drop-down list using. .

Note that the square brackets [] indicate the default scale. This means that when you change the

default scale from Document Parameters or the Paper Scale command in the View toolbar, the

scale of the selected projection will also change. When manually setting a value in the Scale

field, the scale of the selected projection is no longer associated with the default value and is

indicated without square brackets. This means that changing the default scale will not change

the projection scale.

If you set an arbitrary projection scale in the parameters window, then after creation, its designation

will automatically appear above the projection.

If necessary, you can disable this feature using the Show Projection Scale option in the Options tab.

In order to set the scale of an already created projection, go to the 2D Projection Parameters and set

the required scale value.

Parameters of 2D Projection

Setting some parameters of 2D projection can be done in the parameters window during creation and

editing. 

In addition, at any time you can call the parameters dialog from the context menu or when editing the

projection, when the option is available:

<P> Set elements parameters 

2D Projection parameters dialog may contain following tabs:
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· General

· Additional

· Projection Elements

· Lines

· Breaks

· Exclusions

Some of the parameters are also available in the Parameters window upon selecting one or several

projections in 2D window or in model tree.
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General

On this tab, you can set the type of projection, its angle of inclination, scale, and also use the

Perspective projection and Calculate Hidden Lines options (see 2D Projection. Main Concepts). In

addition, 4 standard parameters can be set:

· Level. Visibility level value.

· Layer. The name of the layer to which the coordinate system belongs.

· Name. Here you can set a name for the projection.

· Color. This color is used to draw a projection.

Additional

Detailed description of this tab can be found in this section.

Projection Elements

Description of the parameters section Projection Elements is the same as the functionality of the

options from the Elements menu.
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Lines

The main options of this tab are described in the 2D Projection. Main Concepts section in the Lines

subsection.

The line parameters available for editing are displayed at the bottom and depend on the selected

category.

You can select several lines at the same time and set general parameters for them.

Use bodies color. When this option is enabled, the color of all projection lines and hatches in the

section is determined by the color assigned for projected operations. The body color is used when

displaying in tonal mode.

Type. From the drop-down list, you can select the line type for the selected category.

Thickness. Sets the thickness of the lines

Scale factor. Lets you set the amount of strokes for non-solid lines.
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Color. You can select a color from the drop-down list or specify the number of the desired color.

Breaks

This tab of the 2D projection parameters dialog contains same parameters as the eponymous tab of

the command parameters window.

Exclusions

The content of this tab is described in the Managing Elements of 2D Projection section.

Edit 2D Projection

Icon Ribbon

-

Keyboard Textual menu

<3EJ> Edit > Draw > 2D Projection

The command can be used for editing 2D projections.

After calling the command, following options are available:

<Enter> Select 2D Projection

<A> Select all elements

<Z> Select element by name

<Esc> Cancel selection

After selecting a 2D projection, you will additionally have the following options:
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<I> Select other element

<P> Set entity parameters

<F4> Execute edit command

<R> Change definition

<Del> Delete entity

If you have selected the fixing point of a 2D projection to change, the following options become

available:

<Enter> Select fixing point

<N> Select node

<Esc> Cancel selection

Note that the combination <Shift>+  can be used for multiple selection (the combination <Ctrl>+

 cancels the selection).

If one projection from the set of standard views was selected for editing or a view linked by a

projection link to another view, then the selected projection and all views associated with it will be

highlighted. If the main view has been selected, when changing its fixing points, the associated

projections will also move (to change the fixing point of other views, you must first select a projection

and then reset its fixing point). If the 2D projection is anchored to a 2D node and as a result of

parametric changes or editing of construction lines the position of the 2D fixing node has changed,

then to redraw the projection, call the Regenerate projection command.

If during editing it is necessary to set a break on one projection from the set of standard views, then

you need to select a projection (the rest of the views will temporarily stop highlighted on the screen)

and start defining the break using the  option described in the General Algorithm of Creating 2D

Projection command. To create the same breaks in several projections, it is convenient to use the 

 option of copying the parameters of an existing break to the edited projection.



Product Composition, Reports, Bill of Material

2439

Product Composition, Reports, Bill of Material

T-FLEX CAD provides convenient set of tool for creating standard and custom BOMs and reports. 

Report is a flexible mechanism for creating technical documentation in customized formats. This

mechanism can be used for a standard BOM creation as well as for your own reports based on the

product composition. Thereby program technical documentation tools can be adapted for various

specific industries.

BOM in program is a table containing data about fragments (parts, subassemblies) inserted into the

main assembly. If necessary, one drawing document may contain several BOMs. 

BOM data is automatically copied from fragment files or added manually by user. In addition to

fragments, the data from other sources can be included in the product composition – from 3D objects

or drawing elements.

BOMs and reports can be created on the base of prototypes or report templates.

The BOM prototype is a program document that contains empty BOM table with preset properties.

The BOM prototype describes composition of columns and sections for the created table. Prototype-

based BOMs is a legacy mechanism and is not recommended for usage in the new documents.

The report template is a more flexible mechanism with extra options comparing to BOM prototypes.

When you work with the product composition, the templates usage is preferable because of various

advantages.

The report template is a program document file. BOM format and its data composition are described

in this file according to certain rules. Tables and data description are inserted as text entities that are

created in the template.
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The template may contain macros (special microprograms) for additional template data processing,

for example, empty rows adding.

Each macro has some number of attributes. Their values can be set for inputting when you create a

report. Report is filled according to the product composition and the report template.

Report and BOM data is displayed in Product Composition window.

The Product Composition is used to collect technical documentation data. The data about the

composition and the hierarchy of a product can be added to product composition manually or

automatically. You can specify sorting, grouping and displaying rules for data in the table. There are

commands for callouts creation, export to Excel, report generation, etc.

New product compositions are created on the base of product composition types either included in

the program installation or custom. Each type specifies various properties and column composition.

Several product compositions can be created for one product. Each of them will display appropriate

data for further generation of reports and BOMs.

Topics in this section:

· Product Composition Window

· Product Composition Types

· Create Report / BOM

· Variant Report / BOM Creation

· Creation of Callouts on the Drawing

· Editing BOM Sections

· Include in Product Composition

· Save Product Composition to DOCs

· Create Report Templates
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Product Composition Window

Product Composition window is used for managing the product composition.

To open this window use option:

Icon Ribbon

Bill of Materials > Product Composition > Product Composition Window

Keyboard Textual Menu

<Alt+9> Customize > Tool Windows > Product Composition Window

BOM data, collected from fragments and other objects or inserted manually, is displayed in Product

Composition window. Also there are additional tools for assigning data. When you fill in the title

block, all its data is automatically included in the document product composition, because title block

and product composition fields are associated by variables.
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Product composition for assembly documents is automatically compiled on the base of product

composition data of parts.

Data from various assembly sources can be added to the product composition. It can be

fragments, bodies, 2D elements, etc. By default fields of the product composition records are set

as automatically filled to use data from the source elements.

Icons indicate the field filling method. Automatic fields are indicated with  icon.  Manually assigned

fields have  icon. The third field type  appears for specific fields that are also assigned

automatically – titles, zones, page format, etc.

By default the new product composition has General BOM type. 

Any product can be presented as the hierarchical composition (tree) in the Product Composition

window. The product itself is a root and its constituent components are presented as hierarchical

records.

The product composition record is presented as a row in table with columns. It contains information

about parts, quantities, materials, documents, etc. All data is inserted into data cells corresponding to

the columns.
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Product Composition window has control toolbar that is located in the upper part of the window. It is

used for various operations with the product composition.

Rest of the option are located in drop-down menu.

A product composition record is a string that can contain data about parts, assemblies,

selections, materials, documents, etc. Data is entered into special fields - data cells.

Under the toolbar you may see the main product composition window that contains list of records,

which are included into the current product composition. 

The following columns are displayed by default: Description, Part No, Quantity, Position and two

columns for specifying inclusion of the records into reports and assemblies. If necessary, you can

add/remove columns to be displayed in window manually.

Every product composition may have various “representations”. Representations allow to display the

same product composition data according to the preset rules. For example, similar parts of assembly

can be merged and their quantity can be displayed in the corresponding column. Or some data may

be filtered out. To use representations press:

<Shift+G> Apply product composition representation

Necessary representation can be then selected from the drop-down list.
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Each representation has its own properties set: displayed columns, sorting and grouping rules, filters,

etc.

More information about representations can be found in Representations Tab section. 

Without representation With representation

On the right side of the Product Composition window you may open Parameters window via toolbar

option:

<Shift+P> Show record parameters window

All product composition columns and their content for the selected record are displayed here. Here

you have access to all fields of the product composition record even those that are not displayed in

the main window.
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It is also possible to manage reference elements in the assembly through the panel of the Assembly

Structure window.

If necessary, you can set the parameters of several records at the same time. To do this, select the

records using Ctrl or Shift and select the Parameters of Records option.

Toolbar 

Product composition window toolbar provides options for:

· creating and deleting the product compositions;

· editing the product composition properties;

· data adding, grouping and sorting;

· setting relations between product composition records and objects in the current document;

· reports generation and updating;

· callouts creation;

· export to Excel.

Product composition name is displayed in the field:

Every new document already contains the product composition called General BOM created on the

base of General BOM product composition type. 

If you want to create another product composition you need to select «New product composition...»

item.

After that in New Product Composition dialog box you can specify Product Composition Name and

other parameters of the product composition.
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Product Composition Type. The drop-down list contains all available product composition types.

Copy document template records when creating a new product composition. Product composition

records will be copied from the selected template to the new product composition. User can select

any document as a prototype if he select User-defined item in the drop-down list.

Product composition type is a set of properties for product compositions used as a template for

new product composition creation. Properties include columns composition, grouping rules,

sorting and records filtering. Each product composition type is stored in the separate file.

New product composition types can be created with Product Composition Types command.

You can set the following parameters in New Product Composition dialog box:

Export product composition to T-FLEX DOCs. If the flag is set, the current product composition will

be saved when the file is exported to T-FLEX DOCs application. If there are several product

compositions, but no one was set for export, then the first one composition from the list is exported. 

Get location zones from fragments. If the flag is set, zones values are defined by the fragment

location. If the flag is not set, the zone is defined by the callout location.

Zones are used for simplifying search of parts in big assemblies. You need to open Paper >

Zones tab in the Set Document Parameters command. Set the corresponding flags.
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Exclude hidden objects. When the flag is set, only visible objects will be included in the product

composition. Object no visible on the drawing/model, for example, hidden using levels mechanism or

suppressed, will not be included. 

Create hierarchy by tree of fragments. When the flag is set, the hierarchy, that exists in the fragment

file, will be added to the assembly product composition. When the flag is not set, all items from the

fragment file will be added to the same level in the assembly product composition.

When you create a new product composition based on the selected type, all properties will be copied

and saved in the current file. 

More information about the properties can be found in Properties Tab section.

<Ctrl+L> Add record

Option creates a new empty record (item) in the Product Composition window.
 

All new records are added to the zero hierarchical level. By default only records from first and

upper levels are displayed in  Apply product composition representation mode. That is why

the new records will not be displayed in this mode. 

If there are several sections in the product composition, the new record will be created in the section

that has input focus. Data is entered manually. Each data cell can be associated with a variable by

setting the flag in the field.

 

After setting the flag, the Expression Constructor window for setting the link will open.

To manage all existing data cells of the current record use  Show record parameters window

option.
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List of columns (cells) can be sorted using  Categorized and  Alphabetical options in the top of

the window.

<Ctrl+G> Add child record

This option is used to form the hierarchical composition of a product. It creates an embedded record

relative to the current. The new record is indicated with  icon.

<Ctrl+I>  Add record to section

This option is used to add a new record to the section. 

 

If there are any records existing in the required section, you can point the cursor on one of them and

add a new record with  option.

Also you can specify the record section in the parameters window , by pressing on the

corresponding field in the drop-down list.
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<Del> Delete record

This option deletes the current record from the product composition.

<Ctrl+Down> Move records up

<Ctrl+Up> Move records down

These options allow to move selected records in the product composition. Moving is allowed only

inside one section and with inactive sorting.

- Link selected objects with product composition record

This option allows to set links between product composition records and document objects (3D

operations, 3D construction elements, 2D drawing elements).

The option is available only for manually created records. Such link cannot be set for records

from fragments or any other data sources.

To set the link, perform the following actions:

1. Select record in the Product Composition window. The string will be marked.

2. Select object in the scene with mouse click (it will be highlighted).

3. Press  icon.
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When the record is selected in the Product Composition window, the linked objects are highlighted in

the scene and in 3D Model window.
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It is possible to link one record with several objects.

You can delete the link using option:

- Delete link of product composition record with objects

Use Create BOM Callout command to create callouts:

- Create BOM Callout

More information about the command can be found in section Creation of Callouts on the

Drawing.

<Shift+V> Show variable names

When option is active, the variables names are showed in cells that have link with those variables.

When the option is inactive, the variables values are shown.

- Include in product composition

Use Include in product composition command to manage parameters of the fragments inclusion into

the product composition. 

More information about fragments inclusion can be found in section Include in Product

Composition.



T-FLEX CAD 17 Help

2452

Update. The command updates current product composition after changes in the assembly document

or fragments.

Update all. The command is updating all existing product compositions. First, existing positions are

updated, then – linked records.

- Product composition properties

This option opens dialog of the current product composition properties. Modifications are saved in

the current assembly file.

You can change name of the current product composition in appropriate field. With a special flag you

can mark product composition for be used when exporting assembly to T-FLEX DOCs.

Button Save properties as type will save the current product composition properties as a product

composition type in *.xml format. 

When a new product composition is created, it uses one of the product composition types that defines

its properties and behavior. The original product composition type may change later due to various

system improvements or customization. If this file with product composition type changes, system

reflects this case with a warning message: “Properties of product composition differ from properties

of type used for its creation. You may update properties from the modified type or ignore this

warning”.
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You may either ignore this message and leave the original behavior of the product composition or

update product composition properties from the modified type using Update properties button.

If necessary, you may also reassign product composition properties by reading them from any

arbitrary product composition type by using Read properties from type button.

The information about product composition properties can be found in Product Composition

Types section.

Use option Export Product Composition to Excel to export the current product composition to Excel

format.

You can specify exporting of only columns visible in the product composition window by setting

appropriate flag in the dialog that appears. If the flag is inactive, all product composition columns will

be exported.

Export hierarchy allows to export hierarchy of product composition record into Excel.

You can set decimal separator for the exported values.

If export is used in  Apply product composition representation mode, the Show titles of

sections flag will appear. These titles will be added to the additional column of the resulting

excel table.

After that you can specify file name, folder and necessary Excel format - .XLSX or .XLS.

Additionally, you can export to XML and CSV formats. A list of all export options can be seen in the

drop-down list:

Export to XML is done without any settings. When exporting to CSV format, the following window

appears:
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Unlike export to Excel, it becomes possible to indicate text values ??in quotes, separate fields and text

with different characters.

From a product composition you may generate various reports, like for example BOM tables on the

drawing page.

Option Save product composition to T-FLEX DOCs... appears only after connection to the T-

FLEX DOCs. 

To show all reports and BOMs created in the current document use Report/Bill of Material command.

- Report/Bills of material

Option Delete product composition allows to delete the current product composition.

- Delete product composition

The search bar is located in the right part of the toolbar. It simplifies data search inside the product

composition.

Input search string or a substring in the field or select from one of the previously used search strings.

The corresponding record will be selected after pressing <Enter> or  button. Repeated pressing on

<Enter> or  button gives next search result.

The data will be searched in both visible and invisible columns. When found, the corresponding record

will be marked.

Reports

To create a report use option:

- Create report based on Product Composition

Window with the list of reports available for the current product composition will appear. This

contents of this list is unique for each product composition and originally is taken from the product

composition type used for product composition creation.
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Preview is located to the left from the list. It can be hidden using button .

Properties of the product composition reports are displayed in the lower part of the window. You can

change them for each created report if necessary. Lists of reports and their properties are stored in the

product composition properties.

Report creation:

1. Select template for the report with preset rules for filling its fields;

2. Set properties of the selected template (optional);

3. Press [Run] button.

Use option to update the already existing reports:

- Update product composition reports

More information about report creation can be found in Create Report/BOM section. More

information about report generator properties can be found in Reports Tab section.
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Commands of the Product composition Window Header Context Menu

You can find some commands for managing  product composition in context menu of header. The

context menu is called by right mouse click in the title of the product composition table. It includes

the following commands:

Columns. The drop-down list of this command allows you to select columns to be displayed in the

Product Composition window.

A column is displayed in Product Composition window when the flag is set near the column’s

name.

Show All. When option is active all columns existing in the product composition will be shown. 

Show Only Predefined. When option is active only columns with the preset flag Show Column in

Product Composition Window will be shown. The option can be set on Columns tab in Product

Composition properties window.

Show Linked object. The option adds Linked Object column to the table. The column shows names

and icons of the data sources (for example, data of fragments).

Main Data. Includes main and manually created columns.

You can create a new category for columns. All manually created columns can be added to any

category, except Parameters of Include.

More information about columns can be found in the Columns Tab section

Inclusion Data. Presents the following columns: Position, Include in Report/BOM of Current

Document, Include in Assembly.
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Include in report/BOM of current document and Include in Assembly columns displays flags that

allow to include records into the current document reports and product composition of the upper

level assembly.

Sort by. The drop-down list contains the most commonly used columns for sorting records.

Sort Ascending, Sort Descending. Sets sorting order for the current column of the product

composition.

Cancel Sorting. Cancels sorting rules.

Show Grouping Tool Window. Activates special tool area in the upper part of the window to simplify

grouping. To set grouping by column you need to drag its header to this area.

Group by This Column. When this mode is enabled, all records in the product composition will be

organized as groups with the same value in the current column. Sequence of grouping is displayed in

the upper part of the window. Marker near the header allows to change sorting sequence.

Group by Representation Rules. The grouping mode is set from the product composition properties.

Each representation can have its own grouping rules set. Data is not grouped, when the flag is

disabled.

The option is available only in  Apply product composition representation mode.

Cancel Grouping cancels usage of all groupings rules set in the context menu or in the representation.

Borders. Allows to manage display of table borders in the Product Composition window.



T-FLEX CAD 17 Help

2458

Alignment specifies text or icons alignment in the fields of the product composition for the column.

Hide Column. The selected column will be hided in the main window of the product composition.

Adjust Width. The option is adjusting width of columns to show their full names in the Product

composition window. In case of insufficient space the priority goes to the column which header was

used for command activation.

The Product composition item provides quick access to several commands that also exist in the

toolbar.

Summation results command allows to assign sums of values in columns to variables. Summation of

values is specified on the Sum tab in the product composition properties. 

More information about the summation can be found in section Sum Tab.

Context Menu of Product composition Records

Context menu of a product composition record includes options for the product composition and the

record itself.
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You can create a child record for the selected record using option Add child record. 

To restore the original position of a record in the Product Composition window, you need to select

item Restore location of record in product composition.

Option Expand All/Collapse All allows to show/hide grouped records.

Create BOM Callout. Activates command for creating callout in the current document. After callout

creation, you can select another record and continue working with the command.

Restore location of record in product composition. You can restore locations of child records.

You need to select Restore location of record in product composition option to restore the source

position of a record. The record appears on the source position after the product composition update.

Copy/paste options:

· You can copy the selected records using the clipboard;

· All records pasted from the clipboard will be added as “created manually”;

· If there were hierarchical relations between records before copying, they are retained after

pasting.

· Links between records and variables persist while copying within one document. When you

paste records into another document or text, only values will be copied;

· Hotkeys <Ctrl+C>/<Ctrl+V> are available for coping;

· When you paste records in the 2D window, they are inserted as text. Only columns visible in

Product Composition window are copied as text.

Product composition item in the context menu is similar to the same item from the headers context

menu.

3D Fragment item appears in the context menu of each fragment. Its drop-down list contains all

standard options for working with a fragment.

Reports item allows you to select report template from the drop-down list. The report will be

generated after  selection. Its properties are preset in the product composition properties.

Fragment Copy modes

The modes Associative copy of a fragment and Array of fragments have the ability to disable

associative connection with the source fragment. Multiple fragments or a group of fragments

controlled by a single set of variables are positioned independently, or by an array.
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Product Composition Types

Calling the command:

Icon Ribbon

Bill of Materials > Options > Product Composition Type

Keyboard Textual Menu

<BY> Tools > Report/Bill of materials > Product Composition Type

The product composition type is a file that contains the product composition properties. The product

composition type is a prototype for creating new product compositions in documents.

Product Composition type command is used to create new product compositions types and edit the

existing ones.

You can also open the same window for the current product composition using  option on the

toolbar.

The list of existing product composition types is located in the left part of the window. Tabs with their

properties are located on the right side.
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Each product composition type is stored in *.XML file. Settings from such type will be copied to the

current document when type is used for creating a new product composition or for an update of

product composition. Path folder with the product composition types is set in Set System Options

command on the Bill of Materials tab in Product Composition Types field. The folder by default: C:

\Program Files\T-FLEX Parametric CAD 17\Program\ProductStructs.

If the user makes changes to the properties of the product composition or creates a new composition,

the folder is automatically moved to "\Users\user_name\AppData\Local\Top Systems\T-FLEX CAD ....

\Eng\ProductStructs". All products saved in this folder are prototypes and can be used in any T-FLEX

CAD document.

New documents already contain General BOM product composition created on the base of Default

product composition.xml file.



T-FLEX CAD 17 Help

2462

When opening files with a specification created before version 14, all the properties specified in

this specification are taken into account as part of the product and stored in the source file in

the *.grb format.

The following icons are located at the top of the Product Composition Types window:

Open type from file

This options loads description of the product composition type from the *.XML file.

Save type as

This option saves description of the product composition type into the XML file.

New type

This option creates a new type based on the “empty type”. Properties of such a type are not set.

Delete type

This option deletes the current record from the list of product composition types.

Copy type

This option copies properties of the current product composition type.

Paste type

Creates a new product composition type based on the copied properties – columns, groupings,

sorting, representations, etc. 

To rename the product composition type, click   on its name and fill in text.

Note that if you create a BOM table based not on the product composition report template but on the

legacy mechanism based on the BOM prototype file, the prototype properties will be used along with

the product composition properties. The prototype properties can differ from the product

composition properties. In this case, the created BOM may differ from what you see in the Product

Composition window, because the prototype properties like grouping and sorting will be applied to it

after the product composition properties.

Topics in this section:

· Properties Tab

· Columns Tab

· Sources Tab

· Filters Tab

· Representations Tab

· Sum Tab

· Reports Tab
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Properties Tab

The following properties of the product composition type can be specified on Properties tab:

Define zone by. When you work with large assemblies, they are divided into zones to simplify

fragments searching. If the Fragments location flag is set, the zone value is determined by position of

the fragment’s bounding box that encloses elements belonging to the fragment.

When the Callout flag is set, the zone is defined according to the callout location.

Don’t include invisible objects. If the flag is set, only visible fragments will be included in the product

composition. Fragments that are invisible on the drawings or 3D models, i.e. hidden using various

mechanisms, will be ignored.

Create hierarchy by tree of fragments. When the flag is set, the hierarchy that exists in the product

composition of fragment will be retained in the assembly product composition. If the flag is not set,

all the records from the fragment’s product composition will be placed on the single level in the

assembly product composition.

This option does not affect records that were automatically generated based on fragments or

other sources and then manually moved inside the assembly product composition.

Example:

Product composition “Subassembly 1” contains two item-records for two fragments – Bolt and Screw.
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The flag set in the  column means that records will be included when the Subassembly 1 is inserted

into the upper level assembly.

Next, the assembly “Assembly example” with its own product composition was created using With

embedded elements mode in option .

The “Assembly example” has the following product composition:

After inserting “Subassembly 1” into file “Assembly example” as a fragment and updating the product

composition you will receive the following results.

If the Create hierarchy by tree of fragments flag is set in the current product composition, then all the

records from the fragment becomes “child” for the assembly record of the product composition. Both

the hierarchy of assembly example and the hierarchy of Subassembly 1 are taken into account. 

If the flag is not set, all the records from the fragment file will be placed on the same level of the

product composition.

Update product composition considering changes entered manually in the embedded product

compositions. If the flag is not set, records added manually inside items constituting the product

composition, will not be included in the current product composition.

Report Options Group

Merge Records. When the flag is set, all records with the same content will be merged. Flag Ignore

parameter when comparing records to merge for particular columns will be also taken into account.
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More information about the parameter can be found in Columns Tab section.

For example, records with the same descriptions and different quantities can be merged.

Merging is performed in the following way:

A record in the product composition is compared with the following record in the list. If their columns’

content is the same, they are merged and comparison with the following record in the list is

performed.

For correct merging list of records should be first sorted prior to merging. Sorting is performed by

specifying sorting rules.

More information about the sorting rules can be found in Representations Tab section.

Option disabled:

Option enabled:

Reverse order

When the flag is set, records in the Product Composition window will be organized in reverse order,

starting with the highest position number.

 Sort by positions. If there are manually set values for positions in the product composition, they will

be organized by order after setting this flag.

Without sorting by order             With sorting by order

Number positions in the group after maximum value in the previous group. 

The option is used to correctly support reservation of strings and positions when some positions are

omitted for possible further usage. If there are manually created positions in the sections and their
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value is higher than position values in the following group, automatic numeration in the following

group will begin according to the highest value of manually created positions.

If the flag is not set, the “missed” positions values from the precious section will be used.

Inactive option Active option

All options are used only when  Apply product composition representation mode is active.

New Product composition group

Name of new product composition on creation sets name to be used when creating new product

compositions of the current type.

Copy document template records when creating a new product composition. You can enter

filenames of prototypes from “Program/Template” folder in the fields. Records from the templates

will be added to the new product composition created using the current type.

Positions Assignment 

Use column for positions assignment on the drawing. You can select a column from the drop-down

list. The column will be used upon callouts creation instead of the Position column.

Columns Tab

You can add new columns for the product composition type and modify properties for already

existing columns on Columns tab.
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There is a the set of standard BOM columns and their properties in the product composition by

default. Buttons Add , Properties , Delete , Up  and Down  are located on the right side.

The columns on the right side present flags from the column properties. 

When you create a new column the Column properties window appears:

Properties group

Name. Sets the column name.

Synonym name is used to simplify the entry of the element in the report template. It is recommended

to specify a synonym without spaces. For example, instead of the {param name = "Part No."/} element,

you can write the {PartNo/} element.

Category. Columns can be grouped into categories. Categories are displayed in the product

composition parameters window and in the header’s context menu.

The “Inclusion parameters” category is reserved for the system columns “Include in Report/BOM of

current document”, “Include in assembly” and “Position”. 
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If the column has no category, it will be placed to the “Main Data” category. You can select any other

category from the drop-down list. When you enter a new category name, it is added to the list.

Type. Parameter sets type of data in the column.

String. The column contains text string.

Real. The column contains real values.

Integer. The column contains integer numbers. When the real number is entered into the column, its

fractional part will be omitted.

Boolean. The value is used as a toggle. If the column field is linked with a variable, then the “0”

variable value switches the field off (value “False”), other values switch the field on (value “True”) 

You can specify accuracy of real values for the Real type.

Column width. Parameter sets column width in pixels in the Product composition window by default

for the new product compositions. 

Show column in Product composition window. When the flag is set, the column is shown in the

Product composition window. This flag is taken into account only in Product composition window.

Group by column. When flag is set, all records with the same value in this column will be merged into

groups. This flag is taken into account only in Product composition window.

Sum values when merging. When this flag is set, the values in this column will be summed for the

merged records, for example the values in “Quantity” column will be summed, if there are similar parts

in the assembly. 

The flag is taken into account when the column is selected on the Sum tab.

Several algorithms for the summation are available: 
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Summation – the result is the arithmetic sum.

Concatenate strings – the result is the sequential combining of values with separator if necessary.

Concatenate unique strings – the result is the same as above but without duplicated values.

Concatenate Unique Values with Quantity - the result is the summation of unique values, taking into

account the number when combining strings.

In the last three cases, the result presents one combined string.

In the right field, you can specify any symbol for values separation. E.g. you may generate single string

enumerating positions of merged items. 

Concatenate string, Concatenate unique strings and Concatenate Unique Values with

Quantityoptions only for text strings.

Ignore on comparison. When the flag is set, the content of the column will be not taken into account

when the product composition records are compared. I.e. if there are several records, which

parameters differ only in this column, these records can be merged - the column will not affect

merging.

Value group

Default value. The entered value will be automatically set in the column data cell for each new

manually created record.

List of values. Allows to create preset list of values for a column. When you enter text into the string it

will be added to the list after pressing <Enter>. After that you may enter another string to the list. If

list exists for a column it will be available for selection in the Product composition window.

Data Assignment group

Data can be entered in the column cell manually or automatically. You can select data source from the

drop-down list of the Data Assignment group.
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Data from fragment field, variable of current document or variable – data assignment method set

by default.

Zone. Format. The column is automatically set with zone or format values for fragment-based

records.

Zone is taken from the assembly drawing and depends on Getting location zones from fragment flag.

Format. The drawing format is used for the parts. For subassemblies, BOM format used in

subassemblies is assigned.

Fragment Name. Name and folder of the fragment file of the product composition item.

Variation Name.  Name of the fragment variation that is used in assembly. You can specify the

variation name in Model Configurations and Variations command.

Fragment Variable. Fragment variable value will be used as value. You need to specify the fragment

variable name. If there is no such a variable in the fragment file, the field will stay empty.

Compound Column. Allows you to compose the value using values of other columns. Data can be

taken from any other columns. Mathematical and logical operators can be applied to the columns.

Compound Column Creation

Option  adds a new element to the compound column sequence.

The new element will be added after the selected element. The element type can be selected from the

drop-down list.

· Column. Element-column  will be added to the string. You can select the column name from its

drop-down list.
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· Text. Text constant element will be added to the string.

· Parentheses. Parentheses allow to set sequence of mathematical and logical operations.

· Mathematical operations: «+» - addition, «-» - subtraction, «x» - multiplication, «/» - division,

«%» - division remainder.  Operations allow to apply mathematical formulas/relations for the

neighboring elements of the string.
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· Concatenation «Concat»/ conditional concatenation «CondConcat» - merge element/ merge

conditional (the operation is performed if both elements are not empty). The result of

CondConcat operation for the “Compound column” is shown below.

· Conditional operator «->» - if A, then B. The B will be included in the column if A is not empty,

not equal “0”, is “True”.  In particular it is useful to use this operator to control separation

symbols, e.g. usage of separation symbol “-“ in various situations.

     

We may create condition to not display separations symbol when the column “Part No” is empty.

· Logical operators: «&&» - "And"; «||» - "Or"; «!» - "Not". These operators allow to perform

logical operations on the neighboring elements. 

For example, with logical operation «&&» you can output the separation symbol only when both

“Description” and “Material” columns are not empty.

· Operators of string comparison. «StrEq», «StrNotEq» - A equal B, A is not equal B. This

operators perform comparison of text values. The result is “True” or “False”. 

For example, you can set the condition: display value of “Quantity” if the field “Parameter 1” is equal

to “Parameter 2”.

If the condition is satisfied, the composite column contains data. If not - it will be empty.
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· Operators of string comparison. «StrSubstr», «StrSubstr», «StrStartWith», «StrEndsWith» work

in the same way. The only difference is that the selected column is compared to some text

constant.

Example: If the “Company Standard Parts” section is set for the record, the “Quantity” column data is

displayed in the column.

· Operators of numerical comparison. «==» - А is equal В; «!=» - А is not equal В; «>» - А is

greater than В; «<» – А is less than В. The operators perform comparison of number values. The

result is “True” or “False”.

Round. Rounds decimal number the nearest integer.

Floor. Largest integer that is not greater than the argument. 

Ceil. Smallest integer that is greater than or equel to the argument.

Format. Converts a number to a string. Allows you to output any resulting value with the required

number of decimal places. The text after the Format operator must consist of two numbers: the first

number specifies the number of decimal places, the second - to discard the last zeros or not. A value

of 1 is to discard zeros, a value of 0 is not.

The picture below shows the result of formatting the numbers 1.23400 and 32.00.

Unit. Displays the units of the measurement. As the right argument, you can set the type of the

displayed name - ShortName/GlobalName/FullName. The default is ShortName.

    

Convert. Converts a value to another unit of measurement. The right argument is the name of the unit

to which you want to convert the value.
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Sources Tab

Along with fragments you can use any objects of drawings or 3D models as items-records of the

product composition. You can specify types of objects, included in the product composition, and set

their selection conditions in Product Composition Properties window. The selected objects can be

used as data sources.

For example, all created pipe operations can be automatically included into the product composition.

Source tab is used for this purpose. Here you can set sources and data, which must be set for various

columns.

 

<Product composition from fragment> source exists in the product composition by default. It

provides receiving data from files of fragments inserted into the current document. All data that is

included in the product composition of fragment will be included in the product composition of

assembly as well.

To create a new data source use option . The Data source properties window will appear. (This

window is called with option  for existing strings).
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Name. Sets the data source name.

Object type. The drop-down list contains available types of source object.

Filters. Filters are used to set conditions for selecting objects of the specified type. Filter may consist

of unlimited number of conditions combined with logical operations "And" and "Or", which will be

used in combination. One of the two logical operations may be assigned when you add the second

and other next condition to the list.

Filters section options

Add condition

This option creates a new condition in the properties list. Objects included in the product composition

will be selected according to these rules. 

There are three columns: Parameter, Operation, and Value.

 

Parameter. The parameter can be set as: 

· measured characteristic of object; 

· value of variable (only for fragments); 

· attribute – internal object property, usually assigned by add-on applications; 

· object property.
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Next to Parameter column there is parameter name field.

For Measure parameter you need to set the name of one of the object’s measured properties. Name

of the property must coincide with the name in Measure command.

To specify Variable parameter, you need to enter name of variable that exists in the fragment

document.

Attribute name is set for Attribute parameter. The object attribute can be found using Information

command in its context menu.

For Property you to specify the property name from the Properties window.

You can use only common properties of objects for filter. They are displayed in the Properties

window when several objects of the same type are selected.

Operation. You need to select an operation from the drop-down list. It will be performed for the

Parameter and Value values. Some notes on them:

· Contains no data, Contains any data are used for numeric parameters.

· Empty, Not empty are used for string parameters.

To set additional conditions for adding objects to the product composition is possible to use the

mechanism of Masks. Mask - is a specialized pattern that when used in filter is applied to the string

values of objects parameters. It allows to include or vice versa do not include objects into the product

composition depending on the string content. To set a mask it is necessary first to choose one of the

Operation option Matches mask or Doesn’t match mask, and in the Value data field set the mask

itself by a combination of symbols.
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The following mask symbols are allowed:

Symbol Description Example

%
Any string with zero

or more symbols

«А%» - returns all values that

starts with А

_(bottom

dash) Any single symbol

«А_» - returns all values that

has two symbols length and

starts with (А1, А2, Аа and so

on)

[ ]

Any single symbol

within the specified

range ([a-f]) or set

([abcdef])

«[12][0-9]» - returns all values

from 10 to 29

[^ ]

Any single symbol

not within the

specified range ([a-

f]) or set ([abcdef)

«[^0-9]%» - returns all values

that do not start with a

number.

You can manage order of logical operations in filters using brackets.

· Value. In this field, you can enter value that will be compared with the selected parameter.

Delete condition

Option deletes the current condition from the list.

To create a group of conditions you must select several filters in the list using <Shift> or <Ctrl> and

press button:

Group conditions

Grouped conditions will be considered as a single operand in the list.

To cancel grouping, you need to select its header and press:

Ungroup conditions

Copy and Paste options use the clipboard for conditions creation.

Copy

Paste

Up and Down options allow to change order of the created conditions.
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Up

Down

Data Source Assignment 

You can set data that will be set to column data cells of product composition for each data source.

Assignment of data sources to columns section is used for this purpose.

There are two strings available. You can use them to set the conditions. The data receiving method is

specified in the upper string. It is similar to the Parameter field from sources filters. 

The data can be:

· result of object measuring;

· variable value;

· attribute;

· object property;

· constant. 

You can specify the name in the second string. To specify Measure parameter you need to set the

name of one of the object measured properties (name of the property must coincide with the name in

Measure command). To specify Variable parameter, you need to enter the name of variable that exists

in the fragment document. Attribute name is set for Attribute parameter. Object attribute can be

found using Information command of its context menu. To specify Property parameter, you need to

set property name. Only the general properties of objects can be used to specify the source. These

properties are displayed in the Properties window when multiple objects of the same type are

selected.

Constant parameter defines a constant value that will be used for all records in the selected column.

Filters Tab

Filters specify data arranging conditions for representations. You can specify various filters that can be

used in different representations. For example, from the whole set of product composition records you

can select only records about materials to receive the corresponding report.

You can read about representations in Representations tab section.

Buttons Add , Delete , Copy/Pastle / , Up  and Down  are located on the right side.
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When creating a new filter you can select one of two types: By Condition or By level of hierarchy. You

can change filter name by pressing   on its name.

· By level of hierarchy. This filter helps to define level in assembly hierarchy for which to gather

product composition data. 

You can specify Comparison type and Level for this filter. The levels values begin from “0” (the

product is on a zero level). For example, filter “<= 1” will gather data in the assembly file and the

fragment files of the first level.

 

· By Condition. This type allows to specify conditions using content of product composition

columns.

Filter creation is similar to the previously described data source filter creation. The only difference is

that the Parameter drop-down list contains columns of the product composition.

You need to select a column and specify condition for the values selection.
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Representations Tab

Representation is a set of rules (for example, grouping and sorting) for displaying Product

composition data in various forms and further usage in generating report tables. One product

composition may have several representations that correspond to different report tables.

In the upper part there are icons for creating, deleting, copying/pasting through the buffer and

moving representations in the list. The name of the view can be changed after clicking in the name

field.

All the conditions specified on Representations tab work only in  Apply product composition

representation mode.

 

All existing representations are displayed in the corresponding field.
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Properties of each representation are managed on Grouping rules and Representation properties

tabs. The Grouping rules are managed on Properties of grouping rule and Sort tabs.

The following flags are located near representations names: Use for positions assignment ,

Consider records hierarchy while grouping , Use position column .

Representation Properties

You can specify common representation properties on Representation Properties tab.

 

Consider records hierarchy while grouping. If the flag is set, the grouping will be performed

separately on each level of hierarchy. It allows to assign positions and receive reports for different

“branches” of the product composition tree if necessary. The flag is not available when Use for variant

reports flag is active.

Important! It is required the topmost record of the product composition tree to be included into

reports of the current document for correct data processing in this mode.

For example, you want to create BOM table only for the “1.1” subassembly. For this purpose, you need

to select it in the product composition and create report  with Only selected elements and Only

first level parameters.

Ignore option “Include in product composition”. If the flag is set the representation will show records

with disabled Include in product composition option.

Filter. Specifies the filter  set on the Filters tab that will be used for the current representation. The

drop-down list contains filters from Filters tab.

Synonym name. You can specify a synonym name for the representation. The synonym name may be

helpful if you plan to output summation results in Summation results window or link them with

variable.
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More information about the window can be found in Sum tab section.

Use for positions assignment. If the flag is set, positions for representation are assigned

automatically. Otherwise, positions will not be assigned for this representation Note, that this flag will

be used in combination with analogous flags for automatic position assignment set for each grouping

rule if any exists.

Use “Position” column. If the flag is set, the specified position is entered into Position column. If the

flag is not set, the position is entered in the column specified in Column for position field. 

Positions will not be displayed in the product composition if the flag is not set and the column name

is not specified.

If flag Assign positions automatically is not set, this flag will be ignored. 

Column for position. In the drop-down list, you can select the column in which the positions of this

view will be displayed. The parameter is available only when the Use “Position” column flag is

unchecked.

Use for variant reports. When the flag is set, the representation data is processed in a specific way to

generate a variant report. Report type can be selected from the drop-down list of Type of variant

report field.

More information about variant reports can be found in Variant Report / BOM Creation chapter.

Grouping Rules

Rules for grouping records in the product composition window are specified on Grouping rules tab.

You can set name for a grouping rule. For each grouping rule there is also possible a set of positioning

options: create positions for group, positions increment, create independent positions for each

resultant group, number of skipped positions at the beginning and number of skipped positions at

the end of the group.

Every grouping rule has its type. According to the grouping rule type, you may set additional options

on Properties of grouping rule tab. 

The following types are available:

· By condition. You may specify one or several conditions for the rule.  Conditions are similar to

the filters from the Filters tab. 

· By parameter. When you create this type of grouping rule, you can select column from the

drop-down list. Records will be grouped according to the values in this column.  

Values from the column will be used as groups names if the flag Consider records hierarchy

while grouping is not set.

· By BOM sections. Product composition records will be grouped by BOM sections. Each section

is included into a separate group. BOM sections are defined in Edit BOM sections command.

· By default. This type merges all records into one group.
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If there are several grouping rules in one representation, they are applied sequentially. Initially

the first rule that distributes records to the groups is applied. Some of the records may be not

included in any group after that. The second rule is used for these records. The following rule is

used for the remaining “Free” records and so on.

Sorting

Sorting can be specified for each grouping rule (group) on the Sorting tab. 

To the right of the sorting list there are icons for creating, deleting, copying/pasting through the

buffer and moving lines in the list.

To create a new sorting rule at first you need to select a grouping rule. Then, you need to create a

sorting rule using icon  Add. You can select column name in the Column field from the drop-down

list. The data will be sorted by this column. After that, you need to select limits of comparison region

for the columns.

From – defines the beginning of the comparison region.

You can select one of the following values from the drop-down list:

· character ?  - the character serial number.  For example, three will mean that comparison

region will begin from the third character of the selected column string.

· substring – the serial number of the selected character sequence occurrence, for example, from

the first substring “Part” occurrence.

· character ?  from end – the character serial number from the end of the string, for example,

the third char from the end.

· substring from end – the serial number of the selected character sequence occurrence from the

end of the string, for example, the first appearance of “ISO” substring from the end.



T-FLEX CAD 17 Help

2484

?  - the serial number of the string or substring.

“ ” – the sequence of substring characters here.

To – defines limits of comparison region.

· character ?   - the character serial number.

· substring - The serial number of the selected character sequence occurrence, for example, to

the first appearance of the “-” substring.

· end of string –all characters to the end of string will be compared.

Compare. The field specifies comparison type.

If the first position of the first of the compared data cells contains a number, the system selects a

numeric substring from the beginning of the row of the data cell and compares its value with the

numeric substring found in the second data cell. If no number is found in the first position of the

second data cell, then the substring from the first field is compared with an empty numeric substring. 

Then, a substring containing characters is allocated in the first cell, and the characters are compared in

both data cells, starting from the position following the last number of the substring used in the

previous comparison step. Thus, the contents of both fields are analyzed until the end of the first field.

If a digit is found in the first position of the field, then the contents of the field is considered an empty

character string.

· Character –content of two data cells of the table will be compared as two character strings.

· Numeric – content of two data cells of the table will be compared as two numeric values. If

string contains non-numeric characters they will be omitted on comparison.

· Mixed – The strings will divided into substrings that contain character and numeric values. After

that, same-type substrings will be compared.

If sorting rules for the group are not set, the records of the product composition will be placed

in an arbitrary order.

Important! The order of applying sorting rules depends on their order in the list.

To edit the sorting parameters, point to the required entry in the list.

Position priorities

· If both numbers and characters are located on the same position in the data cells, the priority

goes to numbers;
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· If there are character sets “AA” and “AAA” on the same position, priority goes to the shortest

record.

Example of sorting creation

Sorting will be set for the Part No. column for all records in the Grouping rule_1 section.

Each data cell of Part No. column will be searched for the first “Part” substring from the beginning.

Searching is performed to the end of string. Type of comparison is set to Mixed, i.e. all characters and

numbers after the specified substring will be taken into account.

The data was inserted into the table after specifying the sorting conditions. They are sorted by order

of creation.

 

After activation of  Apply product composition representation mode, the sorting rules were

applied to the records of the Part No. column.

The characters and numbers before Part substring were not taken into account.

Initially the comparison was made by the first position after the Part substring. 

Numbers on the first position were selected from each cell (1). They were combined into substrings

with nearby numbers (11, 12). After that, they were compared.

Then all chars on the first position were selected (A, B). They were combined into substrings with

nearby characters, if available (AA). They were compared.

Then symbols on the second position were compared and so on until the end of the string.
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Sum Tab

You can specify rules for summation in the product composition columns on Sum tab.

The following icons are located on the right: Add , Delete , Copy/Paste / , Up , Down  .

Summation rule will be displayed in Summation of product composition records list after creation.

There is the following set of specified properties for each summation rule in Properties group:

Name. Specifies name for the summation rule.

Synonym name. You can specify synonym name in the field. The synonym name is displayed in

Summation results window. The window is described above.

Column. You need to select column from the drop-down list. Its data will be summed.

If Sum values when merging parameter is specified for the selected column it will be taken into

account.

Filter. You can select a filter from the drop-down list. The filter is created on the Filters tab. The filter

will be applied for the values summation. I.e. only records that satisfy conditions of the filter will be

summed.

Display results in product composition window. When the flag is set, the summation result is

displayed in the bottom part of Product composition window when  Apply product composition

representation mode is on.
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Summation results

You can assign value of summation result to a variable. You need to perform the following sequence

of actions to do that:

First, you need to select the Summation results item in the context menu of the product composition.

Summation results window will appear. 

The product composition name is displayed in Product composition name field.

You need to activate Create variable flag and enter the variable Name. You can also enter a

Comment to the variable.

The expression for getting variable value is displayed in Expression field.
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You need to select necessary item from the list of summation rules. Each item name is a combination

of representation and summation rule.

Press OK button to create the variable.

Summation results are created separately for each representation.

Example: There are four representations in the product composition. Five records will appear in Name

of summation rule field if you create one summation rule for the product composition.

Four of them refer to representations. They calculate sum in the specified column for records

included in the representation.

The fifth record displays total amount in the column, but the representations are not taken into

account. I.e. all the existing records data is summed.

Selected Filter is used for each of the five records.

The Summation rule name consists of two parts. The first part is the name/synonym name of the

representation (Bill_of_Materials), the second – the name/synonym name of the summation rule

(Weight).

If synonym names are specified for representations or summation rules, they will be displayed in

the field. Otherwise, the names will be displayed.

Information about the selected summation rule is displayed in Value and Description fields when you

select any record in Name of summation rule list.

Reports Tab

Parameters of reports and appropriate template files can be set on Reports tab. The reports list is

located on top of the window. Preview window is located to the right. You can change scale in the

preview window using mouse wheel. You can hide the preview with  button.

Buttons for creating, deleting and changing report properties are located on the right side. You can

change reports order in the list using icons , .
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You can change properties of reports and their generators using Report properties and Generator

properties tabs.

Add New Report

After pressing Add button you can select one of the available generator types. The generator

processes existing data according to certain rules and forms reports.

After selecting generator, a new report will appear in the list. You can change default name by

pressing   on its name string.

Report properties assigned for particular reports generator define values that will appear

automatically in the corresponding data fields when a new report is created. This data can be then

modified.

You can specify the following properties for the report:

  

Representation. Specifies representation which data and rules will be used in the report. If

representation is not selected, the field contains value “By default” and the first representation will be

used.

Report contents specifies mode of data inclusion in the report. If All records of product composition

item is set, all its data will be included into the report. If Only selected records item is set, only

selected product composition “branch” data will be included. It allows creating reports for

subassemblies embedded in the main assembly file.

Hierarchy specifies levels of the product composition tree that will be included into the report. The

“root” record of the tree is considered the zero level. There are several options: 
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Template file. Specifies name of a report template file. Button  is used for the file selection. 

Template file creation is described in section Report Template Structure.

Report file specifies name of the file in which report, if created in a separate document, will be stored.

The report file will be saved in the same folder that contains the product composition file.

Overwrite existing reports. If the flag is set, a new report created with the sane generator will replace

the existing one. If the flag is not set, a new report will be created as a new table.

Open report document after creation. The flag is taken into account when you create report in a

separate document. If the flag is set, report file will be opened after creation. Otherwise, the current

document will stay active.

Location:

· In new document. After selection, a new document will be created. Its name is specified on

the Report tab. The system creates a new document with the specified name and opens a new

window with the report.

· On new page. A new drawing page with the report table is created in the current document.

The table matches the selected template.

· On existing page. 

Automatic snap flag activates mode of automatic snap of the report table to the two predefined

nodes named “BOM1”, “BOM2” that define table position (upper left and bottom right points).

Names can be assigned to nodes in node edition command.

The snap requires that both named nodes exist on the same page. Standard title blocks already

contain these nodes by default.

If the nodes are not found on the current page, system displays warning message and allows you to

specify the table placement manually. 

You need to specify placement of the top left corner of the table.

Name format for new pages.

In general case name format for new pages looks like: “BOM name” {#o} Page {#p}

For each page:

{#o} – will be replaced by the sequence number of the BOM of the current type. 

{#p} – will be replaced by the sequence number of the BOM page.

Generator Attributes

Generator attributes is the list of options that additionally control the result of report generation.

These attribute are linked with macro program that is contained in the report template file, and that

you can manage. The set of attributes may differ for various generators. Examples of such attributes:

· EmptyRows_CountBefore and EmptyRows_CountAfter – value sets number of empty strings

before/after each record of the table.



Product Composition, Reports, Bill of Material

2491

· EmptyRows_SkipFirst and EmptyRows_SkipLast – when“0” value is set, empty strings that were

set by attribute EmptyRows_CountBefore/EmptyRows_CountAfter will be displayed for all

records. When another value is set, the empty strings will not be created for the first/last

record in the section.

Create Report / BOM

Calling the command:

Icon Ribbon

Bill of Materials > Bill of Materials > New

Keyboard Textual Menu

<BC> Tools > Report/Bill of materials >New…

The command is used to create report or a BOM for the current assembly drawing. There are two tabs

in the dialog box of this command: Report/BOM List and BOM by Template. The latter corresponds to

the legacy mechanism and is not recommended for usage.

Report Creation

You can create report or BOM table using template mechanism on Report/BOM List tab.

1. Select product composition for the report;

2. Select report generator from the list.
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3. Set report parameters. 

Parameters description can be found in Product Composition Types section.

4. Confirm creation using Create button.

You can also initiate new report creation  with the toolbar in the Product composition window using

option  Create report based on product composition or from the context menu of the selected

record. In the second case, you can’t change the report properties before its creation. They are just

copied from the product composition properties.

BOM Creation

You can also create a BOM using obsolete prototypes mechanism on the BOM by template tab.

1. Select location type:

· In new document

· On new page

· On existing page

Automatic snap flag is available only for On existing page type.

2. Select product composition for the BOM;

3. Select Prototype that will be used for BOM (The preview of the document will be shown in the

preview window);

4. Confirm creation using Create button.

When you select the <new prototype> prototype, the BOM is created based on the

BOMStructure.mdb database that contains only standard fields. I.e. you need to create all other

parameters (column width, sorting rules, etc.) manually. It differs from the new prototype creation only
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in the fact that the specified parameters and properties of the BOM will be used only in the current

document. 

If you want to use this prototype for any other BOMs, you need to save it in the “…

\Program\Template\BOM” folder.

Variants of BOM location are described in Product Composition Types section.

If there are BOMs created in previous versions of the BOM creator, the Convert old specification

flag will appear. When it is set, the old BOM data will be converted according to the selected

type.

If parameter Include in product composition was enabled for fragments in assembly drawing file and

any data was set for the fragment drawings, the created BOM will contain an appropriate records

number. If the conditions were not met, the BOM will be empty.

After the BOM creation, the editing mode is automatically activated (except for BOM on existing

page). If BOM is empty, the following window appears:

Using this window, you can manually enter a new record to any section. You can decline it by pressing

Cancel button.

It is recommended to set Transparent text editing parameter on Preferences tab in Set

document parameters command. It allows to enter edit mode after pressing on any record.

Variant Report / BOM Creation

To create a variant report/BOM you need to perform the following sequence of actions:

1. You need to create variations in the assembly file using  option in Model Configurations and

variations command. You need to choose  Name and Variant BOM of Product Composition Type

for the new variation in the following window:
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After saving the variation, the same product composition will be automatically created in the

document.

Note that variations creation is not available until the current document is not saved.

Optionally, you can specify subtitles of variations directly in the variations list.

2. Select base variation of variant BOM by setting the flag in the list of variations. If base variant is not

specified, it will be set to the first variation in the list.

3. Select the variation in the Product Composition window. Enable the  Apply product

composition representation mode. After that, a selection of product composition views will

become available. Specify the option you need. The window displays a set of data that will be

output to the report.

Its content can be edited if necessary.

4. Activate  Create report based on Product composition command. Report template

corresponding to the selected variation will appear.

5. Select the report location on the right. The report will be created after Create button pressing.
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Creation of Callouts on the Drawing

Calling the command:

Icon Ribbon

Bill of materials > Positions> Callouts

Keyboard Textual Menu

<BL> Tools > Report/Bill of materials > Callouts

There are three options in the automenu:

<W> Show product composition window

<A> Create All Callouts

<Esc> Exit command

If  Show product composition window option is active, Product composition window will

appear.
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There are two ways to create callouts after calling the command:

1) You need to select a record in the Product Composition window. A callout cursor for the record

will appear. Callout is a specific type of leader note element. The corresponding fragment will be

highlighted in 2D and in 3D windows. Then you need to specify fixing points of the callout in one

of the existing windows.

Position number will be assigned to Text field of inscription/callout Properties window automatically.

More information about leader notes creation can be found in Leader Notes chapter.

The By default parameters for leader notes, callouts of the product composition and bend notes

are stored in the system separately.

2) You need to select an object on the drawing. A callout for the record, which corresponds to the

object, will appear. You need to specify its location on the drawing. The Product Composition

window is not necessary in this case.

Create BOM callout command provides links between records of product compositions and callouts.

If there were any changes which lead to the position number change, callouts will update.

You can update positions using the following commands:

Automatic Callouts Creation

Create All Callouts  command is used for multiple callouts creation. 

The following options are available in the automenu of the command:

<G> Group Alignment of Callouts

<N> Callout without Leader

<*> Select All Elements

<C> Cancel Elements Selection

The Group Alignment of Callouts  option allows to align all callouts after their creation.
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If the option Callout without Leader  is enabled, the callouts will be created without leaders.

Numbers of positions will be snapped to the center of objects that linked with the record in the

product composition.

You can select all records in the product composition and create callouts for them using the option

Select All Elements . 

If there are several projections (2D views) created for a product composition item, callouts are

created for each of them.

Use the Cancel Elements Selection  to cancel selection of all records.

After all options are specified, you should press .

Callouts without leaders are created immediately.

If the option Group Alignment of Callouts  is activated, the callouts will automatically follow the

cursor. The following options will appear in automenu:

When the callouts are assigned automatically, placement of leader note arrows is defined as the

middle of the bounding rectangular for each 2D fragment or the middle of the selected

projections lines of 3D fragments.

You need to press  to finally set the callouts location. 

The callouts use standard parameters of leader notes except for arrow ending type (the point is used)

and priority (127 is used). If there are several positions corresponding to one fragment, the callout

with several jogs is used. 

Arbitrary data cell of product composition selection 

You can output content of an arbitrary product composition cell to the callout. Use the  Specify

column for linking with callout option for this purpose.
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System waits until you select the product composition column after the option activation. The selected

column will be highlighted and Use specified column for linking with callout  mode will be

activated.

The next step is to select string of the product composition. Its content will be set to the callout string. 

The selected column is stored. You can disable option  (the column will not be highlighted) and

continue callouts creation in an ordinary way. You can enable link with the selected column again, if

necessary. The next callout will be linked with the selected cell of the column.

Additional Jogs

Use option  to create several jogs. After the option activation, you need to select all records of the

product composition that should be added to the callout.

You can use existing callouts to show additional positions on the drawing. Therefore, several records

may be associated with one callout. For this purpose, point the callout using the mouse cursor, press

 and select Edit item from the appeared automenu. 

You need to select the record of the product composition and create a new jog using  button on

the Multiple jogs tab in the Properties window.

Use  and   buttons to change the order of jogs. To delete jogs use  button. 

To change position on the existing jog, select it and specify any other record in the Product

composition window.

Multiple jogs list contains the main leader note jog. Do not delete it.

The symbols “{{ }}” means that the callout is linked to the product composition and is updated in

accordance with it. If you remove these symbols, then the link will be broken.

Transparent Call of Create BOM Callout Command

Create BOM callout command is available in the context menu of the selected record.
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The command also activates automatically when you drag a record into the scene using Drag’n’Drop

mechanism. For this purpose select a record in the product composition, move it and release in the 2D

or 3D window. The command of callout creation will be activated.

Editing BOM Sections

Calling the command:

Icon Ribbon

Bill of materials > Options > Sections…

Keyboard Textual Menu

<BG> Tools > Report/Bill of materials > Sections…

The command is used to create/edit a list of specification sections. By default, the composition of the

sections is stored in the database file BOM Groups.mdb. You can set/change the name and path of

the database by section in the Set System Options > Bill of Materials command.

Upon calling the command, the Sections dialog box appears.
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The top line displays the installed name and path of the database file by section. 

Each element of the section tree is assigned an identifier (number), which provides a link between the

section database file and the specification database file of the current document. 

The presence of two elements with the same identifier value is not allowed.  

Tree elements with a "+" icon to the left of their name contain nested elements. To expand the

sublevels of the element, point the mouse cursor at the "+" icon and click the left mouse button.

To change the composition of the partition tree, the graphical Add and Delete buttons are used. To

enter a new section, select the tree element to which you want to add the section and click Add. After

that, you need to enter the name of the section and the value of the identifier (the system suggests a

possible default value of the identifier). To delete a section, select the appropriate item and click

Delete. 

If necessary, you can save the database of specification sections to a file with a different name. To do

this, use the Save As button.

Include in Product Composition

Calling the command:

Icon Ribbon

Bill of materials > Product composition > Included Fragments

Keyboard Textual Menu

<BI> Tools > Report/Bill of materials > Included Fragments

This command is intended for more visual control of the way to include document fragments in any

specification or report created based on the product composition. You can change the value of the

Included Fragments parameter by calling the fragment parameters window. However, with a large

number of fragments, this method takes a lot of time. Using this command, you can quickly and

visually view/change the mode of enabling a fragment (several fragments).
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When the command is called, a dialog box appears on the screen containing a list of product

structures and a list of fragments. When you select <New Product Compositions> from the drop-

down list, the specified inclusion parameters will be used for new product compositions.

Using Assign Product Composition name parameter you can select a product composition from the

fragment file, which data will be included in an assembly product composition When selecting a

fragment in the lower part of the window, the method of inclusion set for it in the specified

composition of the product is marked. If necessary, you can specify any other value.

Multiselect. You can select several elements from the fragments list using tapped button <Shift>.

Tapped <Ctrl> button allows you to add/remove fragments from the selected list. Button Select all

allows to select all fragments. Button Deselect all allows to deselect all fragments. When you select

fragments, each of them is highlighted in 2D and 3D windows. If there are more than one fragment in

the list, selected parameters are applied to all of them.

Save Product Composition to DOCs

Save Product Composition to T-FLEX DOCs command is available in the File text menu when

integration with T-FLEX DOCs is enabled. Integration rules are configured in the Set System Options

command, T-FLEX DOCs tab.
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Saving of the product composition in DOCs is performed based on the contents of the Product

Composition window. Only those records that are displayed in this window are exported.

Only one root element is supported when saving a product composition to DOCs.

Let's take a look at a simple example. The picture below is an example of the product composition of

an assembly unit.
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After calling the command Save Product Composition in T-FLEX DOCs, a window appears in which

you need to select a folder to save the document and click the Save button.

After that, a window appears with a list of saved files.
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After clicking OK, the Product Composition window is displayed on the screen. On the left side, the

Assembly Structure is displayed, on the right - the DOCs Product Composition. Note that the record

The second root record is not passed in DOCs. After pressing the OK button, the saving will be

completed. For a more detailed description of working with this window, see the T-FLEX DOCs

documentation.

Create Report Templates

The report/BOM template is a specially prepared GRB file that contains data and options for

generating reports. The report format and data composition are described in this file according to

certain rules. 

This file contains table created using command Text and various compositiond data in its cells. System

installation has various predefined report templates. Path to the report templates folder is specified

on the BOM tab in Set System Options command.

Creation of report template:
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1. Create a new document based on “ISO Drawing” template and save it into the folder with

templates. Path to report templates is set in Set System Options command on the Folder tab. 

2. Set A4 format and portrait orientation on the Paper tab in the Set Document Parameters

command.

3. If the template will be used for creation of reports on a separate page or in another document,

insert the 2D fragment of a title block, which contains a table header and lines.

4. If the template will be used for creation of reports on the current page, you can skip this step.

5. Create a paragraph text using command Create Text. Attach it to the nodes of the title block

fragment or in absolute coordinates.

Press  after selection of attaching points. After that, you need to specify coordinates for new text

rectangles using Change paragraph size parameters  option from automenu. Records, which

don’t fit on the first page, will be moved to new rectangles.

If the template is for the current page, select Create rectangle on current page. Note that its position

should not coincide with the coordinates of the existing rectangle. If the template is for a new page

select Create new page with rectangle. Its coordinates should coincide with the nodes on the

following BOM or report pages. You should set rectangle coordinates manually in the Rectangle

Coordinates section.
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6. Add a table header into the created paragraph text. If the template is for a separate page, you can

skip this step.

Header should be between {summary} and {/summary} tags. You should create a table with column

names there. The table is filled in manually.

7. Add tags {group} and {/group} for group of records output.

8. Create a table for a group header. Name of the BOM section is a header of the group in standard

BOM.

Note! Total width of all tables should match with the first table.

Add {Section/} tag to a column. It will display name of the section, which is used for grouping records

in the report.
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9. If a group header has no text (for example, if it is a group of records without section), the table will

be empty and should not be displayed in the report. You need to add a condition. First, you need

to find name of the corresponding group in the product composition. Its name is No group.

You need to add the filter {group hide_table="Group_name = 'No group'"} which will replace the

opening tag of the group.

10.Add table for new BOM records. Add {list} and {/list} tags.
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11.In the third table, you should specify names of product composition columns. Data from the

columns will be added to the report. If there are no spaces in the column name, you should type

{column_name/}. You can use a synonym name instead of the name of the column.

If there is a space in the column name, use the following record:

{param name="Column name"/}

Example of filling of the third table cells, which do not have additional filters:

You can manage value output using filter. For example, the following filter allows you to display only

the non-null field values in the column:

{Quantity filter="Quantity != 0"/}
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Creation of the simplest report template is finished. Finish paragraph text edition using  and save

your document.

Note! Text of report template should fit paragraph text rectangle. It should not go beyond it by

height or width.

Report template should be used for a report generator. 

Report generator properties are described in Reports section of Product Composition Types

chapter.

If a new report generator is created for a product composition type, not for a product composition in

the document, it can be used in all documents where the product composition type is used.
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It will be necessary to update product composition properties for the existing documents

according to the properties of the updated product composition type.

Additional Features

· Add a summation result to the report.

For example, if you need to display total weight use {outcome name="Weight"

out_operation="numeric_sum"/} record in a separate table between {summary} and {/summary} tags.

· Formatting of the value in the column may be performed using argument parameter.

For example, the following record will display the summation result with accuracy of two decimal

places: 

{outcome name="Weight" out_operation="numeric_sum" argument="F2"/}

· You can display variable value in a report using variable name element. 

For example, {variable name="$Date"/}.

The variable should exist in the file based on which the report is created.

· You can display records of all levels for the representation using recursive attribute.

{list recursive="true"}

You can find description of elements and attributes for report template in Report/BOM

template section.

· You can add macros. Additional data processing can be performed using a macro, which may

be added to the report template file. You can add and edit a macro in the Macro editor.
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A macro can process product composition records or data, which is displayed in a table cell.

In the first case a macro is called using {group_macro name="Name "/}. Name is a name of the macro,

which should be run before the table is filled in. 

You can use filter attribute, when you call a macro. The macro will be applied only for groups that

correspond the condition. 

Example: {group_macro name="Gen.Gen.GroupMacro" filter="Section = 'Industry Standard Parts '"/}

The macro for processing of textual value in the table cell is used in param and outcome elements.

The macro is called using {param name="Column name" str_proc_macro="Name"/}. Name is a name of

the macro for string processing.

Example: {param name="Quantity$$00" str_proc_macro="Gen.Gen.XAmount"/}

Topics in this section:

· Report Template composition

Report Template Structure

The report composition is similar to the XML language. The composition represents tree of elements.

One or two tags specify an element. The element has embedded elements, attributes and contents. 

Allowed elements names (without register):

1. group is used only for table framing.

2. container is used for variant reports (more information can be found in a report generator

description).

3. list – The list of elements. It is used for table framing.

4. param – The parameter is used only in the table. Content is ignored. An element is replaced by the

value from the product composition column. Should not be embedded into each other. 

5. group_macro – The macro for group processing. Should be used as embedded element for

element group.

6. summary – The result. Used only for table framing.

7. outcome – The resulting value. Used in summary element.

8. frag – insertion into the fragment cell.

9. sum_res - The result of the summation described on the “Sum” tab in the product composition

properties. Used only in the summary table.

10. variable – The value of the variable. The variable should exist in the file on the basis of which the

report is created.

11. table_hider – The element to hide the table. Used with the filter.

Only group and list can be the top-level elements.

Allowed attributes values:

1. name is used only for param element. 

2. filter is used in all elements. 
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3. recursive is used only for group and list elements. If there is hierarchy in the input data, it will

influence the result of product composition records sampling. 

4. recursive_template. The attribute shows that the element is a template for all groups.

5. str_process is used in param and outcome elements for post-processing or text value retrieving

from the record. This attribute is used if insignificant processing of text value is necessary. For

example, to specify the formatting and adjust the number of decimal places.

6. str_proc_macro is used in param and outcome elements for post-processing or a text value

received from the record. This attribute uses the specified macro for text processing.

7. hide_table is used in table framing elements. Specifies the rule according to which the table doesn’t

displayed.

8. source is used with frag element.

9. sorce_macro is used with frag element.

10. from_item is used with frag element.

11. regenerate 3d is used with frag.

12. index is used with table_hider.

The elements have two forms of recording:

1. {list}element content{/list} - 2 tags and the content.

2. {param name=”Description ”/} – 1 tag and no content.

When the report is generated the group and list elements copy the content (table) for each

group/ product composition record to the report 

Element group 

Param elements are filled in the table of group element as follows: you take the first record from the

group and its values are substituted. 

All embedded list elements will operate merged data (those data that will be shown in Product

composition window in  Apply product composition representation mode).

Element list 

If list element is not embedded into group element, it is operating all records of the product

composition (as they look like in Product composition window in  Apply product composition

representation mode). 

If the input data has the hierarchy:

· By default, recursive attribute is disabled, i.e. only the composition records of the top level

will be displayed.

· If you set recursive as true, all records will be displayed.

It is allowed to create an embedded list element in the existing list element. In this case, the table

from the embedded list element will be created and filled in for each product composition record

with child records.

Element param 

Element param is replaced with the corresponding value of the product composition record cell.

Full element record: {param name=”Description”/}. A full element record should be used if the

column name contains spaces.

The element has a simplified record: 

1) {param Description/} – the name is an attribute by default, thus its specifying is not necessary; 

2) {Description/} – a param is an element by default, , thus its specifying is not necessary.

For example,  record {Part No./}  is not recognized as correct. For names of two or more words, you

need to use a full record.

Names Pos, Position are allowed to display positions.
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Element summary 

The element frames the table. It can be used as a top-level element. The table is just copied to report

in this case.

When you use the element in group and list elements, information obtained by processing group/list

records can be output into the table. The information is output using outcome element.

Optional element before=”true” outputs table before group/list records.

Example of top-level summary element:

 Header EmptyGlobal

Header

Example with embedded group and list elements:

Header EmptyGlobalHe

ader

  {Section str_process="str = .SpecGroup(str)"/}  

EachGroupHead

er:

At all: {outcome name="Quantity" out_operation="numeric_sum"

argument="F4"/}

EachGroupFoote

r:

At all: {outcome name="Quantity" out_operation="numeric_sum"

argument="F4"/}

AllGroupsHeade

r:

At all: {outcome name=" Quantity " out_operation="numeric_sum"/}

AllGroupsFooter: At all: {outcome name=" Quantity " out_operation="numeric_sum"/}

AllGroupsFooter: All names: {outcome name="Description" out_operation="str_concat"

argument="-;"/}

AllGroupsFooter: Unique names: {outcome name="Description"

out_operation="unique_strs" argument=";"/}

Header EmptyGlobalFoo

ter

Element outcome 

The element is used to output resulting information inside framed table {summary}.

Main attributes:

1.name – a name of parameter which is used to gather resulting information. 

2.out_operation – values processing type:

· numeric_sum – numerical sum of all values;
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· str_concat – strings sum;

· unique_strs – list of unique values.

3.argument – additional string parameter conveyed to out_operation.

· numeric_sum – string output format;

· str_concat – delimiter between summed strings for values enumeration;

· unique_strs – delimiter between summed strings for unique values enumeration.

You can also specify attribute for sorting records that will be used in calculation using source_filter

attribute (works similar to filter parameter). You can use str_process for the string post-processing.

Examples:

{outcome name="Description " out_operation="unique_strs" argument=";"/}

At all: {outcome name="Quantity" out_operation="numeric_sum" argument="F4"/}

Element sum_res

The sum_res element is used for summation result output. The summation is set on the “Sum” tab in

the product composition properties.

Main attributes:

name – a summation name. The name can be found in the product composition window. To do so call

Product composition > Summation results from the context menu.

The name can be omitted. Then it will be selected automatically (Representation name + Name of

the first summation).

You can use filter attribute.

You can use str_process for string postprocessing.

Examples:

{sum_res/}

{sum_res name="Mass"/}

Total: {sum_res Mass/} 

Element variable

The variable element is used to output document variables into report. It can be displayed in the

summary header table or in group and list tables. 

Main attributes:

name – a variable name.

If there is no variable in the document, an empty string will be outputted.

You can use filter attribute. 

You can use str_process for a string postprocessing.

Examples:

{variable name=”nCount”/} 

{variable name=”$Number”/}

Formatted output of valid values (1 decimal place):

{variable name="nCount" str_process="str = str.AsDouble().Format(1)"/}

Element group_macro 

The Group_macro element is a group processing macro. This element should be used as an

embedded element of group element. Can use attribute filter – the macro will be applied only for

the groups, which satisfy the condition.

Name of the element must be specified. The name specifies macro that should be started before the

table filling. The macro prototype: void func(MacroCallContext context, GroupItemInfo group);

The first parameter contains context for the macro call.
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Example:

{group}

       {group_macro name="Gen.Gen.GroupMacro" filter="Section = Company standard parts"/}

…

{/group}

The macro example:
using System;
using System.Linq;
using TFlex.Model;
using System.Collections.Generic;
using TFlex.Model.Model2D;
 
using TFlex.CadReportGenerator;
 
namespace Gen
{
    public class Gen
   {
        public static bool GroupMacro(MacroCallContext context, GroupItemInfo
group)
       {
              var generAttrs = context.Properties.Attributes;// The report
attributes check.
                if(!generAttrs.HasAttribute(“attrName”) 
                        || generAttrs[“attrName”].ValueAsBool == false)
                        return true;
                //%%TODO: fill in
                return true;
       }
    }
}

You need to add link to TFPSCadReportGenerator for the macro compilation.

Element frag 

The element is used only in tables, one element per cell. Fragment is inserted instead of it. 

One of the four ways can specify the path to the fragment:

1. The filename is taken from the product composition column: {frag name=”Remarks”/};

2. The filename is specified explicitly: {frag source=”<3D Assemblies>Cam.grb”/};

3. The name matches the current element name (the fragment from which the data was raised will be

inserted): {frag from_item=”true”/};

4. The name is received from the macro (look through source_macro): {frag

source_macro=”Gen.Gen3.SourceMacro”/}.

You can specify page name in the fragment document, its image will be inserted into the cell:

{Frag Source="<Fitting_v2>Sketch.grb" page="sketch_p"/}

or

{Frag Source=«<Fitting_v2>Sketch.grb» page_macro=«Gen.Gen.FragPageMacro»/}

The format of macros source_macro and page_macro:

String func(MacroCallContext context, ItemInfo currentItem);

You can also use filter attribute (filter=”…”) similar to param and outcome elements.

You can specify the regenerate_3d attribute (regenerate_3d="true") to ensure that the pasted

fragment always recalculates 3D when recalculating 2D (used with projections).

You can use the attribute auto_width="true/false" - automatic selection of the width of the fragment

so that it fits into the cell. The default is true.
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Element table hider

You can add several tables between tags that specify an element. Element table hider allows to

specify logic for hiding tables. 

Main attributes:

· index – an index of the table, which is embedded into the parents tag (indexing from 0). 

· filter – a filter for hiding tables.

Attributes

In the general case the attributes are recorded like attrName=”attrValue” in the tag that opens

element.

Attribute filter 

Example of a filter record:

{group filter="section = 'Company standard parts'"}

First lexical unit – product composition column name

Second lexical unit – operator

Third lexical unit – value

The filter operator (in this example - ‘=’) is recorded with the space in opposite to the attributes

that have no space. A string value is recorded in single quotes.

You can specify logical relation between expressions: AND / OR.

{group filter="Section = ‘Company standard parts' OR Section = ‘Unknown’"}

You can use parentheses in the filter ( ). 

{group filter="(Section = ‘A' AND Quantity = 1) OR (Section = ‘B' AND Quantity = 2)"}

Special symbols in the column name processing

If the column name contains spaces or symbols, you need to change them 

· ampersand "&" replace with "&amp;" 

· less "<" replace with "&lt;"

· more ">" replace with "&gt;"

· quotes """ replace with "&quot;" 

· apostrophe "'" replace with "&apos;" 

· space " " replace with a "&#032;" 

For example:

{param name="Total Quantity" filter="Total&#032;Quantity != 0"/}

When the condition formed &#032 is replaced by the space.

Attribute hide_table

The attribute is similar to the attribute filter. It specifies the condition for the current element.

According to the condition, the table will not be displayed. It can be used for the elements that are

framing the table.

Example:

{group hide_table="Section = 'No' OR Section = '' "}

…

{/group}

For the groups without the section or it is “No” the heading table will not be created. 
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List of valid operators:

· = 

· !=

· >

· >=

· <

· <= 

· IsOneOf – included in the list

· IsNotOneOf– not included in the list

· IsNull  -does not contain data

· IsNotNull –contains any data

· ContainsSubstring -contains

· NotContainSubstring –does not contain

· StartsWithSubstring –starts with

· EndsWithSubstring –ends on

· IsEmptyString- does not contain text

· IsNotEmptyString –contain text

· MatchMask –merges mask

· NotMatchMask – does not merge mask

Attribute str_process

The attribute is used in param and out_come elements for the post-processing of text value that is

received from the element.

Example: The value of the attribute is recorded using C#. The resulting variable is “str”.

str_process="str = str.Replace('R', 'V')"

There are pre-determined methods allowed in “P” class:

· P.SpecGroup – processes full BOM section name and lefts only subsection name after

last ‘\’.

str_process="str = P.SpecGroup(str)".

· P.AsDouble – converts string to real number:

str = (str.AsDouble() * 1.2).ToString()

· P.AsInt – converts string to integer number: 

str = (str.AsInt() * 2).ToString()

· P.Format – converts number to string with formatting (by default there are two

characters decimal places):

str = (str.AsDouble() * 1.2).Format(1) -one character decimal places.

str = (str.AsDouble() * 1.2).Format() - two characters decimal places.

Example of composite processing:

{Section str_process="str = P.SpecGroup(str).Replace('R', 'V').ToLowerInvariant()"/}

Attribute str_proc_macro

The attribute is used in param and outcome elements for the post-processing of a textual value,

retrieved from product composition record. The attribute value should specify the post-processing

macro name.



T-FLEX CAD 17 Help

2518

The attribute example:

{param name="Title_1" str_proc_macro="Gen.Str.ConstVarReplacer"/}

The macro example:

using System;
using TFlex.Model;
using TFlex.Model.Model2D;
using TFlex.Model.Model3D;

using TFlex.CadReportGenerator;

namespace Gen
{
 public class Str
 {
         public static string ConstVarReplacer(MacroCallContext context, String
originalValue)
         {
                 if(String.IsNullOrWhiteSpace(originalValue))
                         return originalValue;
                 else if(originalValue == "ConstPart")
                         return "Variations constant data:";
                 else if(originalValue == "VarPart")
                         return " Variations variable data:";
                 else
                         return originalValue;
         }
 }
}

Attribute from_item

The Boolean attribute used with frag element. It means that the path to the fragment is formed from

the current element (a fragment from which the data was raised will be inserted).

Example:

{frag from_item="true"/}

Attribute source

Used with frag element. Specifies a path to the fragment file that should be inserted: 

Example:

{Frag Source="<Fitting_v2>Sketch.grb"/}

Attribute source_macro

Used with frag element. Specifies a path to a fragment file that should be inserted using macro: 

Example:

{frag source_macro="Gen.Gen3.FragSourceMacro"/}

Macro example:

using System;
using System.Linq;
using TFlex.Model;
using System.Collections.Generic;
using TFlex.Model.Model2D;
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using TFlex.CadReportGenerator;
namespace Gen
{
public class Gen3
{
        public static string FragSourceMacro(MacroCallContext context, ItemInfo
item)
        {
                string val = item["Annotation"];
                return String.IsNullOrWhiteSpace(val) ? "<Fitting_v2>Sketch.grb" :
val;
        }
}
}

Attribute page

Used with frag element. Specifies name of inserted fragment page:

Example:

{Frag Source="<Fitting_v2>Sketch.grb" page=”Page_2”/}

Attribute regenerate 3d

Used with frag element. Activates flag of the inserted 2D fragment.

Example:

{Frag Source="<Fitting_v2>Sketch.grb" page=”Page_2” regenerate_3d=”true”/}

Attribute recursive_template

The attribute is used in group elements.

The attribute is important for representations, which consider hierarchy when grouping.

Example:

recursive_template=”true”
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Template example

Variant Report/BOM Generator (TFPSCadVersionReportGenerator)

The generator is a specialized version of standard (TFPSCadVersionReportGenerator) generator

described above. It is used to generate reports for variant product compositions.

The main differences are:

· Container element is used instead of group element;

· Param element has special syntax.

BOM Old Version

Working with BOM on Prototypes

Mechanism of BOM creation used in the earlier program versions will be described below. Unlike BOM

on templates mechanism, BOM on prototypes mechanism is left inside the program for compatibility

reasons only and is not recommended for usage for the new projects due to its limitations. 

This mechanism also provides tools for automating bill of materials (BOM) composition in the formats

recommended by various standards and in customized user-defined formats.

To work with this mechanism you need to use the set of commands from Tools > Reports / BOMs text

menu or options from BOM main toolbar.
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You can use standard BOM prototypes or custom prototypes when creating BOM.

The prototype is a BOM with empty records. It defines table contents and the rules for its formatting.

The prototype also defines text type for the BOM. The text can be of two types:

· Multiline text (text is not translated to another line cause of growing strings number);

· Paragraph text ( text can be translated to a new page or a new area on the existing page

cause of growing strings number)

User defines columns number and their data in BOM properties. You need to select standard fields for

the BOM table from the list and to create additional BOM table fields. Information for the table is

taken from fragment files or is inserted manually.

For automatic filling of the BOM table, it is necessary that:

· BOM data is defined in the Product composition window of the fragment documents

(otherwise the string of the table that corresponds the fragment without data will be empty);

· The parameter Include in product composition in the fragment properties is set to one of the

options:

· Without Embedded Elements – the fragment data is included into the product composition.

The elements that are embedded in the fragment drawing are not included;

· With Embedded Elements - the fragment data and the embedded elements data are included

into the product composition;

· Embedded Elements Only – only embedded elements are included into the product

composition.

Each assembly fragment corresponds to the table record when you create a BOM. Additional strings

are added manually when the table is edited. For manual editing you need to unselect  Automatic

field option for a cell/column/string in which you need to enter a new data.

Text formatting parameters, strings height and columns width are specified in the table properties. 

The table header is a fragment, which contains text with the header table. That is why you need to

make corresponding changes in the headers table if table columns content or columns width were

changed.

BOM sections composition is stored in the database file. The name and the path to the file can be

specified in Set System Options on the tab Bill of Material (“BOM groups.mdb” file is specified by

default).

Upon calling this, the dialog box appears on the screen with the list of all reports and BOMs existing in

the document. This dialog box allows creating a new BOM, deleting an existing one (by selecting from

the list) or viewing its properties.

It also allows renaming a BOM file if it was created as a separate document. If such BOM was selected,

the graphic button [Save As…] becomes enabled, allowing the name and folder change.

Note! It is required the separate document file and the current document file to be saved.



T-FLEX CAD 17 Help

2522

To create a new BOM, use the command “Create Bill of Materials”. The command can be called by

one of the following means:

Icon Ribbon

-

Keyboard Textual Menu

<BC> Tools > Report/Bill of Materials > New…

Upon calling the command, the dialog box “Create report/Bill of Materials” will come up on the

screen. Use this dialog to create the BOM table either in a new document or as a new page in the

current document. This command also allows creating a new prototype based on an existing one.

The delete BOM from the current document, use the command Delete Bill of Materials:

Icon Ribbon

-

Keyboard Textual Menu

<BX> Tools > Report/Bill of Materials > Delete…

Should multiple BOMs exist in the current document, a dialog box comes up for selecting the BOM to

be deleted.

Another command is Include in Bill of Materials:

Icon Ribbon

-

Keyboard Textual Menu

<BI> Tools > Report/Bill of Materials > Elements…

The command is intended for maintaining a binding between BOM and respective fragments. Call to

this command results with the dialog box that comes up on the screen and contains the list of all

existing fragments in the document. The controls provided by this dialog let you set or modify the

method of inserting any fragment into the BOM.

The BOM table and callouts can be updated following the assembly modifications by the command

Update Bills of Materials and Callouts:

Icon Ribbon

-

Keyboard Textual Menu

<BRA> Tools > Report/Bill of Materials > Update All

Should the callouts position numbers change in BOM (as, for instance, a result of changing the rules of

sorting records), the command Update BOM Callouts lets updating the callouts in the assembly:
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Icon Ribbon

-

Keyboard Textual Menu

<BRP> Tools > Report/Bill of Materials > Update Callouts

To set callouts in assembly, use the command  Create BOM Callout:

Icon Ribbon

-

Keyboard Textual Menu

<BL> Tools > Report/Bill of Materials > Callouts

For editing an existing BOM, use the command Edit Bill of Materials: 

Icon Ribbon

-

Keyboard Textual Menu

<BE> Tools > Report/Bill of Materials > Edit

The command allows modifying the contents and parameters of the BOM table (see the section

“Editing BOMs”). If several BOMs exist, the dialog for BOM selection appears first.

Next is the command Toggle: Assembly/BOM Pages:

Icon Ribbon

-

Keyboard Textual Menu

<BT> Tools > Report/Bill of Materials > View Assembly/BOM

The command allows switching between the assembly and the BOM, if the BOM is located on another

page or in a separate document. If several BOMs exist, the dialog appears first for selecting the BOM

to switch to.
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The command Edit BOM Sections:

Icon Ribbon

-

Keyboard Textual Menu

<BG> Tool > Report/|Bill of Materials > Sections…

This command allows modifying a database file containing information about BOM sections (the

default file is "BOM Group.mdb"). The name and the path to the database sections can be

defined/modified by the command Set System Options > Bill of Material (see the section “Editing

BOM sections”).

Command Export BOM:

Icon Ribbon

-

Keyboard Textual Menu

<BS> Tools > Report/Bill of Materials > Export…

This command allows you to export the BOM data or the BOM itself to the Excel file (xls). The export

is carried out by a special macro located in the folder “…/Program/BOMExport”.

BOM composition

Any BOM is composed of the following elements:

· A BOM template is a textual table with a certain number and type of columns. The table

properties defined formatting of the BOM columns. The table is created based on the "Text"

element type ("Paragraph text" or "Multiline text"). The text parameters define the behavior of

the BOM as it is being filled with information: the direction of the BOM "growth", the

capability of continuation on the new page. Thus, for instance, a prototype based on a

"Multiline text" template element does not support multipage BOMs.

· A fragment with the title block image or just the BOM header (depending on the BOM type).

The parts of the template used when creating a title block fragment or a BOM header depend on the

type of the BOM. If the BOM is located on the drawing page, then the table fragment is used that

describes the image of the table header with the column titles only. Such a fragment is described in

the BOM properties as the table header or footer. Since the table height is unlimited in this case and

depends on the number of records in the BOM, the table grid lines are defined in the template

properties as the table boundaries. Besides, automatic continuation to the new page is not supported

for BOMs created on the drawing page.

If the BOM is located on a separate page or in a separate document, the table size and appearance

are predefined and do not depend on the actual number of records in the BOM. In this case, the

fragment is inserted in the BOM page that contains the full image of the BOM title block, including the

header, the main text and the table grid. The table boundaries are not specified in the template in this

case. What is required in this case is that the distance between the horizontal lines of the table grid in

the fragment was equal to the height of the template cells. In this case, the template (the textual

table) is applied "over" the fragment and is tied to its nodes.
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Such a BOM is allowed to occupy several pages. Once the table is filled up on one page, the BOMs

continuation is automatically created on the new page. The BOM title block fragment inserted in the

new page is defined in the BOM prototype under the command "Set Document Parameters", the

"Fragments" tab.

When creating a BOM, the template and the title block are created automatically according to the

selected BOM prototype. The BOM prototype is a document containing the empty BOM only. It has

the BOM template defined (the latter being the empty paragraph text with a table of certain type and

formatting), BOM properties and the title block fragment. The drawing settings define which title

block fragment to insert when continuing on the new page (for automatic creation of additional BOM

pages). All these data are obtained from the mentioned prototype when creating a BOM. In future,

when working with the created BOM, the user can manually change the BOM template, its properties

and the title block. 

Creating BOM 

To create a BOM based on prototype, use the command Create Report/Bill of Materials:

Icon Ribbon

-

Keyboard Textual Menu

<BC> Tools >> Report/Bill of Materials >> New…

Upon calling the command, the dialog box “Create Bill of Materials” will be displayed. Use the

controls provided by the dialog box and create BOM table either in a new document or on a new

page of the current document, or else on the current drawing page.
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When creating a BOM, one can select a BOM prototype describing the composition of the columns

and sections of the table being created. The list of prototypes is provided in the Prototype pane.

To create an individual BOM tables and new BOM prototypes, use the “<Empty Template>” template. 

System offers BOM templates in various standards that are based on the paragraph text functionality.

The “Preview” pane allows previewing the image of the selected prototype.

When creating a BOM on menu or the current page, it is assigned a unique name “Bill of materials 1”,

“Bill of materials 2”, etc. The name of a BOM created as separate document includes the name of the

respective assembly. For example, if the assembly is named “Assembly 1”, then its BOM created in a

new document will be named “Assembly 1 (Bill of materials 1)”. The latter name can be modified in

the command Bills of Materials.

When creating a BOM, we recommend setting the parameter ‘Transparent’ Text editing (Set

Document Parameters command, View tab), that allows entering BOM editing mode by simply

clicking  one of the records.

Creating BOM on New Drawing Page or New Document

Call the command Create Report/Bill of Materials. In the coming up dialog box set parameter On

New Page and select a prototype (for example, “ISO_BOM.grb”). Press [OK]. As a result, a new page

will be created in the document, displaying the BOM being created in editing mode (subsequent BOM

pages are also created automatically). 
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If any data was specified for inserted fragments and they were included in the assembly product

composition, this data will be added to the product composition after its updating. The data will be

automatically added to the BOM.

In the cases, when the data was not defined or relation with fragments was not established, an empty

BOM is displayed on the screen. In this case, the dialog box Add record to section will be displayed.

This dialog box appears any time when editing an empty BOM. By using this dialog, you can add the

desired records to any of the sections. If the specified group does not exist in the BOM, it will be

created automatically. You can abort BOM creation by pressing the button [Cancel].

An edit mode is activated after BOM creation.

Display options and sorting rules of the BOM table will be taken from the prototype. 

More information about BOM editing can be found in section “Editing BOM”.

BOM creation is confirmed by option:
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<F5> Finish input

Alternatively, you can right click , with the pointer being outside the BOM table area.

Creating BOM on Existing Drawing Page

Call the command BC: Create Report/Bill of Materials. In the coming up dialog box set parameter On

Existing Page and select the desired prototype. To automatically position the BOM prototype on the

drawing, check the optional parameter “Automatic snap” (recommended). Usually, such BOMs are

created on the drawings with their title blocks already in place.

If using the automatic snap, the system will automatically search for snapping nodes when creating

the BOM. The standard title block fragment has the default nodes defined, with the reserved names

“bom1” and “bom2”. In this case, the BOM will be positioned above the title block. If such nodes do

not exist on the title block, the system will search for them among other drawing elements. You can

create such nodes manually. What is important is that the nodes are not aligned vertically nor

horizontally, with the horizontal distance between them sufficient for fitting the BOM prototype in

between.

For a BOM prototype based on a multiline text, just one node, “bom1”, is sufficient. If the nodes not

found, the system displays the respective message and switches to the mode of manual snapping

point input. 

In the case of manual BOM positioning, a box rubber bands on the screen defining the BOM

boundaries. Position the box as desired and click . Note that in this case the BOM table is Lower

Limit-justified and will grow upwards as records are added.

For confirming the BOM creation use the option:
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<F5> Finish input

Creating BOM from Empty Prototype

By selecting the prototype named <Empty Template>, you will be independently creating a BOM

based on an empty drawing. This is different from creating a new prototype (see the section “BOM

prototype”) in that the parameters and BOM properties being defined will be used in the current

document only. An empty prototype-based BOM can be used as a prototype for creating other BOMs

only by saving the current document in the folder “…\Program\Template\BOM”.

Switching Between the Assembly and BOM Document

The command Toggle: Assembly/BOM Pages allows opening a BOM from the current assembly that is

located on a different page or in a different document:

Icon Ribbon

-

Keyboard Textual Menu

<BT> Tools > Report/Bill of Materials > View Assembly/BOM

If the document contains several BOMs the dialog box Select Bill of Materials appears.

Select the BOM to open and press [OK]. The selected BOM document will open. The returned to the

assembly, called the command Toggle: Assembly/BOM Pages again.

When creating a BOM in a separate document, there is yet another way of switching to the assembly

drawing. You can select the item Assembly in the BOM context menu.

If several BOMs exist in the document, one of which is placed on the first page of the assembly

drawing, then any other BOM created on a separate page or in a separate document will have to

be opened manually.

Filling in BOM Title Block 

A BOM title block can be filled in by two ways:

1. Since the BOM table title block is a fragment, the title block can be filled using this fragment

variables. To do this, call the command Edit Fragment.
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Then select the BOM table fragment with the mouse. A dialog box will come up on the screen

representing the title block of the BOM page that you selected. Alternatively, this dialog box can be

called as follows. While the system is in the command-waiting mode, move the pointer over the BOM

table fragment and right click . In the coming up menu, select the item “Variables”.

Fill in all required entries of this dialog box. Upon confirming by pressing the graphic button [OK], the

records from this dialog box will be entered in the title block of the BOM page you have selected.

2. Another way of filling in the title block is by direct input in the drawing, without calling the

fragment variables. To do so, set the textual pointer inside the title block box to be filled, and click .

Start typing the text as soon as you see the blinking cursor in the specified box. The button with an

arrow appears to the right of the box allowing selecting values from the list. In usually, the list is

empty (except for the entries in the “Date” column). If it is necessary to fill in the list for selecting

values from the list in future, fill the box with the desired text, and then in the context menu called by

right clicking , select the item “Add Value to List”.

Editing BOM

When creating a new BOM, the BOM editing mode activates automatically. To activate this mode for

an existing BOM, simply move the pointer to the BOM area and click  (this will work in the case

when the transparent text editing setting is activated for the page, by the command "Set Document

Parameters" on the View tab). Alternatively, you can call the command "Edit Bill of Materials":

Icon Ribbon

-

Keyboard Textual Menu

<BS> Tools > Report/Bill of Materials > Export…

Besides, you can enter BOM editing from the context menu. To do so, move the pointer over the BOM

text and right click . In the coming up menu, select the item "Edit Contents". Any of these efforts

lead to entering the BOM editing mode. 

On the main toolbar of the T-FLEX CAD (if its state is not locked), the button set “BOM” which has

options for editing Bill of Materials will appear.
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The automenu options are intended for inserting various elements and formatting the text of the

BOM. The text can also be formatted by using the system toolbar. Details of these options and the

system toolbar were provided in the description of the command "Text", the sections "Paragraph

Text" and "Multipage Text". If after the text formatting it is necessary to restore the formatting

defined in the BOM table default template, simply highlight this text and press the option:

Default Format

To edit the BOM table template, use the option:

Edit Template

For the system will enter the table creation command. On the main toolbar the button set “Table” will

appear with the help of which editing the template (see the chapter "Text").

If the following option is turned on the main toolbar (in the button set “BOM”):

Automatic Update

Then, the BOM will be updated automatically (updating the table accounts for the specified sorting

conditions). This mode is recommended; this is why the icon is turned on by default. If the automatic

updating hinders the operation, this icon should be turned off. In this case, the BOM records can be

updated manually, using the icon:

Update

Remember, that the sorting conditions are not applied automatically when saving the BOM. 

To update the BOM outside the editing mode (as, for instance, after assembling fragments), one can

use the context menu. To do this, position the pointer over one of the BOM records and right click 

. In the coming up menu, select the item "Update BOM".

The Automatic Field option is turned on for all records into the BOM automatically from the inserted

fragment data, as indicated by the pushed icon:

Automatic Field

This means, the manual input is disallowed in the fields of this record. If such a necessity exists, this

option can be turned off. Remember however that the later modifications to the assembly do not

affect the records created manually.

To manually input a record in the BOM table, first insert an empty row. To add a row to the current

group, simply position the pointer at the row, before or after which the record should inserted, and

press one of the following icons:

Add Record Before

Add Record After

As a result, an empty row will be inserted in the current group, allowing for entering a record

manually. The position will be defined for the added record. Remember, that upon updating (the

automatic update does not work in this case), the added rows will be moved according to the defined

sorting parameters (see "BOM Properties").

To add a record to an arbitrary BOM group, use the command:

Add Record into Group or Create Group

In the coming up dialog box select the group to which the record should be added, and enter the

number of rows in the parameter "Number of records". Upon confirming, empty rows will be created

in the group. This records are also accounted for, when setting the positions. Empty rows appear in the

beginning or in the end of the group depending on the sorting rules. If the specified group does not

exist in the BOM, then the specified group header will appear in the BOM upon confirmation. This

capability can be used when searching for a group in the case of multipage BOMs.
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The delete a record, place the pointer over the record entry to be deleted and press the icon:

Delete Record

If all records are deleted in the group, then the group header will also be deleted.

The deleted records still exists in the BOM, they are just not displayed. Those can be viewed using the

option:

Show Hidden Records

Upon turning on this option, all deleted records will be displayed in the BOM. The record entry is will

be color-marked (the color can be modified in the command "Customize > Options > BOM"). To

restore a deleted records, simply select it with the mouse and press the icon:

Restore Hidden Records

To hide deleted records again, turn off the icon "Show Hidden Records".

The hidden records that were entered manually are kept until the BOM is updated. 

A record can be moved up and down by the options:

Move Up

Move Down

These options are only accessible when the sorting is turned off (see "BOM Properties"), and only for

the records that can be a moved without violating the sorting conditions (such as identical records).

If the records should be moved in such a way, that one record always follow the other specific one, it

should be tied to the previous using the option:

Snap to Previous Record

To have a BOM row ignored when setting the positions, one should set the option for it:

Skip Position

To insure that a record has the same position under any assembly or BOM modifications, set the

option for this record:

Lock Position

The options:

Insert Empty Row Before Current Record

Insert Empty Row After Current Record

Low editing rows, serving as record separators, before or after the record pointed by the mouse. Such

rows are assigned the parameter "Automatic Field". No text can be entered in such rows.
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The accessed by the following option BOM properties dialog box allows defining the order of setting

positions, decoration of the BOM group headers, column properties and sorting conditions (see the

section "BOM Properties"):

BOM Properties

BOM editing is completed using the automenu option:

<F5> Finish input

BOM Properties

While in the BOM editing mode, the properties dialog box of the BOM being edited can be called

using the option:

BOM properties

This option is located on the main toolbar (button set “BOM”).

The BOM properties dialog box can also be called by different means. For example, it can be accessed

from the dialog box of the command "Bills of Materials". Alternatively, in the command – waiting

mode, move the pointer over one of the current BOM records and right click , and then in the

coming up context menu select the item "BOM Properties". If this item is not available in the context

menu, then first select the element "BOM" by using the item "Other". 

As the result of all these steps, the dialog box "BOM Properties" will appear on the screen. The dialog

title bar will be displaying the name of the BOM that owns the properties.

 "BOM" tab

Merge Records. Allows merging BOM lines with identical records. 
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Example: suppose, the same fragment is inserted into assembly several times. In this case, the data are

compared, and since there is no difference, the records of these fragments are merged in one row, as

directed by the flag. 

Reverse Order. With this flag set, the records in the BOM table will be coming in the reverse order,

that is starting with the row with the highest ID number. The order of records in the table is defined by

the sorting rules (see below).

        

Don't Include Invisible Elements. When this flag is on, BOM will contain only visible fragments.

Fragments invisible on the drawing (e.g. hidden with levels) will not be added to BOM.

Sort by Position. If BOM contains explicitly defined positions, when this flag is set, records in BOM

tables will be sorted according to those positions along with the usual sorting rules.

Begin position number in group after maximum value in previous group. Setting of this flag will

bring the following behavior: if any BOM group contains explicit positions with numbers greater than

assigned automatically, numbering in the next group will begin from the values following the

maximum explicitly specified number.

Zones. This parameter defines the zones when using the automatic zone definition mode (see the

section "Preparing data for BOM table"). Takes the following values:

By Fragment Location. The zones will be defined by the fragment location. 

By Leader Note Text Location. The zones will be defined by the location of the leader note that marks

the fragment position. 

The following two parameters define the name of the document containing the table header image,

used in the prototype file:

Page Header Fragment. This parameter entry specifies the path to the file containing the BOM table

header. (The case of using the header).

Page Footer Fragment. (The case of using the footer).

Link with external database for update. This parameter is used for connecting with a BOM based on

an external database. Data exchange between the BOM and the database occurs only upon updating

the BOM. 

The parameters "Assembly Document" and "Bill of Materials Document" specify the path to the file or

files containing the assembly and the BOM documents. 
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"Sections" tab

A box in the upper portion of this tab displays the path to the active groups database.  This tab

contains a table with the list of groups displayed as a tree, in its first column, and the rest of the

columns displaying the parameters of the respective groups. The set of groups can be modified in the

command "Edit BOM Sections". The order, in which the groups are listed in this table, will be

maintained as the groups are inserted in a BOM. For example, in the case represented by the above

table, the group "Military standard parts" upon inserting in a BOM will be located after the groups

"Company standard parts", and before the group "Industry standard parts". The existing group order

can be changed using the graphic buttons [Up] and [Down].

To modify group parameters, select this group in the list. The parameters of the active group will

appear in the entries in the lower portion of the tab. You can input the desired values of the following

parameters: 

Empty Rows: Before and After. Define the number of empty lines before and after the group header.

These lines serve as separators, not allowing entering records. 

Positions: Controls the group positions appearance. With this parameter set, positions will be set. If

the parameter unset, this group will be ignored when setting the positions. 

Step. Defines the step of setting the positions in the group. 

Skip. Specifies the number of positions to skip for the beginning of the group. The number of the first

position in the group will be equal to the number of the last position in the previous group plus the

amount defined by this parameter. 

Header. This parameter defines, whether the group header title is displayed in the BOM. The graphic

button [Font] is used to call the dialog box for defining the font parameters of the group header title.

The button [Paragraph] calls the respective dialog box for defining various parameters for group title

formatting (see the chapter "Text").
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"Columns" tab

This tab contains the list of columns and their respective parameters. The columns are inserted in the

BOM table, that are checkmarked in the box before the column name. The top-down order of columns

in the list defines the column position in the BOM (left to right). A column position can be modified

using the buttons [Up (to the Left)] and [Down (to the Right)]. Remember, however, that changing a

column position will not affect the position of the respective column in the BOM table template, nor

change its width. 

The correspondence between the fragment data and the standard BOM table columns is defined

by the type of the column, rather than its name.

The following are the only parameters of the current column allowed for modifications: "Accumulate

Values for Merged Rows", "Ignore When Comparing Records", "Show Group Header".

When inserting the same fragment several times into the assembly, its data are compared, and, since

identical, entered into the BOM as one record (in the case when the parameter "Merge Records" is set

on the tab "BOM"). In this case, it is necessary that the records be summed up in the column

"Quantity". This behavior is supported by the following two parameters.

Accumulate Values for Merged Rows. With this parameter set, the numerical figures will be summed

up when merging the positions.

Ignore When Comparing Records. With this parameter set, the columns will be excluded from

comparison (that is considered equal). If the parameter "Accumulate Values for Merged Rows" is set,

then this parameter is also set automatically.

Show Group Header. The column with this parameter defined will display the group header.
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In text of the united records with flags “Accumulate Values for Merged Rows” and “Ignore

When Comparing Records” it is not possible to use variables that change their values

depending on the assembly parameters. Such variables will be replaced with constants on

uniting.

The list of columns can be modified using the graphic buttons [Add…] and [Delete…]. 

The graphic button [Add…] is used for creating a new column. It brings up a dialog box for defining

all necessary parameters for the column being created.

Column Name. This entry is for specifying the column name.

Column Type. Defines what fragment data will be entered in the column being created.

Standard. Presents the standard BOM data. The entries are copied from the respective section of the

fragment BOM data. The data entry name for the BOM is selected from the combo box on the right

hand side. By default, the column name coincides with the name of the selected entry. If necessary, the

user can define an arbitrary column name. The BOM table can include two columns with the same

standard BOM entry (for example, one can have a column presenting the weight of one part, and

another column presenting the combined weight of several parts). If the list of columns contains

records with coinciding entry names, the system of box a warning message.

Variable. Such a column will be displaying the value of the fragment variable. The variable name is

entered in the box on the right hand side. The default column name will be the string "Variable 

'variable_name'", however, if necessary, the user can specify an arbitrary column name. Only those

boxes in the column will be filled in, that correspond to the fragments with the namesake variables

defined. If the variable data type mismatches the data type of the BOM column being defined, the

system automatically converts the data types.

Custom. Selecting this parameter provides access to the list of names for additional BOM entries. The

list displays only the names of the entries that are added to the installation package (the file "…

\Program\BOM Custom Data.txt"). The names of the entries that were defined among the fragment

data by the user independently (see the section "Preparing data for BOM table"), are not displayed in

this list. The specify one of those, place the pointer over the parameter entry "Column Name" and

enter its name.

If necessary, the file containing the list of additional BOM entries can be manually edited, with

one's own data included in it. The thus defined entries will be displayed in the list of additional

entries of the above-described parameter.
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When entering an arbitrary column name, the are two possibilities:

· If the data was defined under the same name in the fragment documents, then the created

column will contain the respective data from the fragments;

· If the user creates a column with a unique name, then its data has to be entered manually. To

use this feature, select the column while in the BOM editing mode and clear the default option

"Automatic Field".

The "Data Type" combo box offers one of the following values:

Integer. Integer numbers only.

Real. Real numbers only.

Text. Arbitrary textual information.

The delete a column, select it in the list and press the graphic button [Delete].

"Sort" tab

This tab is used for defining and editing the sorting rules for the BOM Records. By default, this tab

reflects the sorting rules specified in the BOM prototype that was used for the BOM creation. The

sorting rules are defined for each BOM group separately. Those appear as a set of conditions for

comparing the contents of the selected BOM columns. The pane "Document Groups" defines the

BOM group, for which the sorting rule is being defined or modified. The sorting defined for the group

"Documents", affects the records that do not belong to any BOM group. The rule itself is displayed in

the entry "Sort Order in Selected Group" in the form  of a table,  in  which  all  the conditions  are 

collected,  that  will  be used for  comparing  lines  in  the   group concerned. The order of applying

the sorting conditions corresponds with their order in the table. If sorting rules are not defined for a

group, then the records in the table will be placed in the order of the entering in the database.

The diagram shows that in the example the row comparison in the "Company Standard Parts" group

will be done by two columns: "Part Number" and "Part Description". First, the lines will be compared in



Product Composition, Reports, Bill of Material

2539

the column "Part Number", since this column appears first in the table. If several lines in this column

will be identical, then their further comparison will be performed based on the records in the column

"Description". The order of comparing the BOM lines by columns can be changed by altering the

record positions in this table. This is done using the graphic buttons [Up], [Down].

To create or modify existing rules for sorting a group, do the following steps:

1. Select the desired group from the BOM group tree in the "Document Groups" pane. The list of

columns with a currently defined set of sorting conditions will then be displayed in the "Sort Order in

Selected Group" table.

2. Select the column whose sorting conditions are to be modified. The specified sorting condition

settings will appear in the parameter fields on the right from the group list section. 

3. Defines the required settings of the sorting parameters:

Columns List. Defines names of columns. 

Compare Zone. Defines the excerpt of the table entry content to be used in comparison.

From. Defines the start of the excerpt to be compared.

Char # - the number of the character position (example: from the third character in the entry).

Substring – the number of a subsequent string occurrence in the entry (example: from the first

occurrence of the string "ISO").

Char # from end – the number of the character position, counted from the end of line.

Substring from end - the number of the subsequent string occurrence in the entry, counted from the

end of line (example: from the first occurrence of the string "ISO" from the end of line).

To. Defines the end of the excerpt to be compared.

Number of chars - defines the position number of the last character in the excerpt (example: until the

character number 10 in the entry).

Substring - the number of the subsequent string occurrence in the entry (example: until the first

occurrence of the string "-").

End of line – to the End of line. 

Compare Type.

Character. Realizes comparison by ASCII characters (the contents of the two table entries are

compared as two strings of characters). If the first character in the record entry is a number, the record

is considered empty and is moved to the start or end of the group as prescribed by the parameter

"Placement". If the several such records, their relative positioning will be random.

Numeric. Compares numbers (the contents of the two table entries are compared as two numbers). If

the first character in the record entry is a letter, the entry is considered empty.

Mixed. If a non-numerical character appears on the first position of the first entry in the comparison,

then the system identifies the substring of characters starting from the first position and compares it

with the respective substring found in the second entry. If the second entry does not begin with a non-

numerical character, then the first entry sub string is compared against the empty string. Next, the

numerical substrings are identified, and the respective numerical values of the two entries are

compared, starting from the first position after the last character string used in the previous step of

the comparison. Thus, the contents of both entries are analyzed until reaching the end of the first

entry. If a digit is found in the first position, the contents of the entry are considered an empty string of

characters.

Placement. Defines the order of records placement. Case-sensitive. 

Ascending. Begin with the first letter in the alphabet and the smallest number.

Descending. Last letters in the alphabet and largest numbers come first.

Empty Record. If empty lines exist in the group, intended for inputting records, this parameter will

define whether these lines will be moved To Start or To End of the group.

To add a sorting condition in the table, first, unselect the existing records in the table. Next, set the

necessary parameter values on the right of the list of groups, and press the [Add] graphic button.
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Alternatively, select one of the existing conditions in the table, then add it to the same table by the

[Add] button and edit its settings.

The graphic button [Copy] allows copying one of several lines of the table with the sorting parameters

defined to the clipboard, and then pasting them in another group. To select all lines, hold down the

<Shift> key, several rows with the <Ctrl> key.

To delete one of the sorting conditions from the table, select this condition and press the graphic

button [Delete].

With the "Automatic Update"  mode set, the new records added the BOM table are instantly

placed in the position defined by the specified sorting conditions (except the manually edit records).

"Sum" tab

This tab is intended for defining the rules of summing up the data in BOM columns for evaluating the

bottom line. A specified rule is not recorded in a database; rather, it becomes an attribute of the text

and can be used in future for evaluating the bottom line of a BOM column. As an example, select the

text used for creating some BOM table, and right click . From the coming up menu select the

command "Measure…". The element with the name of the summing rule will be present in the list of

the text attributes.

If necessary, you can create a variable with the value equal to the sum, calculated based on the

specified rule.

To define a new rule for summing up a column, specify the following parameters:

Sum. Specify the target column of this summing rule.

Group. Specify the BOM group to apply this rule to. The "<None>" setting means the rule will be

applied to all records in the table.
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Condition. Defines limitations on the BOM table records to be included in the bottom line evaluation.

Select a column, a comparison condition and a value to compare the entry against. Selecting

"<None>" means the condition is applied to all records in the table.

To input the defined settings, press the graphic button [Add]. The new rule will appear among the list

of rules, named by default "New condition", with the summing parameters defined. The graphic

button [Delete] deletes the current record from the list of summing rules. To modify a whole name,

point at the entry "Name" of the desired column and double-click . The rule name will then be

focused on, so that you can edit it. 

Creating and Editing BOM Prototype

A BOM prototype is a T-FLEX CAD document, containing only an empty BOM with specific defined

properties. Since a prototype is not an assembly, its BOM does not have any records. The text

formatting parameters and the tables defined in the prototype will drive the graphic shape of the

BOM based on this prototype.

Should a BOM prototype need modifications, it can be opened as a common T-FLEX CAD document

and be edited. One can also create one's own custom BOM prototypes and use them in future.

The files used as prototypes are stored in the folder whose name and path are defined by the

command "Customize|Options", the tab "Bill of Material", the parameter "Template Folder". The

default folder setting is "…\Program\Template\BOM". The standard BOM table prototypes are stored

there upon the system installation. 

To create a custom BOM prototype, use the command "Create Bill of Materials". In the coming up

dialog box, select one of the prototypes in the BOM list. If the new BOM has just insignificant

difference from a standard BOM, then the most closely matching prototype should be selected. To

create a BOM, whose table differs in a relevant manner from the tables of the standard BOMs, use the

"Empty Template". Upon selecting a BOM prototype, press the graphic button [Create New

Template].

Creating BOM prototype based on existing prototype

The first step will be defining the name of the new prototype (a new prototype is always created in a

new document). By default, the document is created in the folder defined in the command "Set

System Options", the tab "Bill of Material" (by default, "…\Program\Template\BOM"). This insures the

presence of the created document in the list of prototypes when creating a new BOM. After that, a

window opens with the new document created based on the selected one.

To make modifications to the table header, open the title block or the BOM title fragment and modify

the names of columns, then number and with as desired. Save the title block under a new name.

Returned to the document of the prototype being created. If the prototype being created is intended

for creating a BOM, that will occupy a separate page or separate document, specify the name of the

edited title block in the properties of the title block fragment. In the case of a BOM prototype for

positioning on the drawing page, modify the fragment name in the BOM properties. If the prototype

provides for automatic continuation of the BOM to the new page, make the respective changes to the

subsequent pages of the title block fragment, as specified in the parameter "Insert Fragment on new

Page creation" in the command "Set Document Parameters", the "Fragments" tab.

Upon modifying the title block or the BOM header fragment, modify the properties of the BOM

template as well. In the BOM context menu select the command "BOM Properties…" and enter the

necessary changes (see the section  "BOM Properties"). The BOM template will be automatically

edited according to the introduced changes. The same can be done by calling the command "Tools >

Bill of Materials > Bills of Materials…" and pressing the button "Properties".

The size of the table cells and their contents formatting parameters is done by using the option "Edit

Template", called in the BOM editing mode.
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Creating BOM prototype based on "Empty Template"

When selecting the "Empty Template" as the prototype, BOM creation stars "from scratch", based on

an empty drawing. In this case, the BOM table has to be created manually.

First, in a separate document create either the complete BOM title block with a header and the ruled

BOM table, or just the table header, depending on the purpose of the prototype being created. Upon

saving the created title block, one can proceed with creation of the BOM prototype itself.

Call the command "Create Bill of Materials". Select the "Empty Template" as the base prototype.

Upon pressing the graphic button [Create New Template] a window appears for selecting a new

document prototype (the default is the prototype of a new 2D document "NONAME<No.> .grb"). 

Next, define the name of the prototype being created. The system will then open a new window with

the created document, and the automenu will display the options for creating the BOM template text:

<M> Create Multiline Text

<R> Create paragraph text

<P> Set Text parameters

<N> Set relation with Node

<Esc> Exit command

Creating BOM title block 

A prototype for a BOM on a separate page requires creation of a complete BOM title block including

the title block text, header and grid lines of the BOM table being created. The table itself will be

created with indivisible borders in this case.

Fixing of the title block as a fragment in the BOM prototype document will be done in absolute

coordinates. Therefore, it is not necessary to create fixing points or a fixing vector. All you need is just

to position the title block drawing correctly with respect to the page borders.

The title block text entries are created based on "Text" elements, driven by the external variables in

the document. To simplify entering the title block text, one can create custom dialog boxes.

To create a BOM prototype to be placed on an existing drawing page, all you need is to create just

the table header. The grid lines will be defined by the borders of the table text, that should be made

visible in this case.

A fixing vector needs to be created in the table header file, using two points. The fixing vector should

pass along one of the horizontal borders of the created table. The fixing vector direction determines

the position of the header as the BOM grows. 

The fixing vector should be the directed from left to right in the case the left justification is set for the

BOM table template, and the right to left if the right justification is set to for the template. When

creating the BOM, the system will fix the header at upper or lower nodes of the text, reserving the

necessary space for the header. 

If the prototype is intended for creating multipage BOMs (usually, those are BOMs located on a

separate page), one needs to create an additional title block for the second and the subsequent pages

(also in separate document).

As an example, one can review the standard BOM title blocks located in the library "Standard",

the folder "Titleblk".
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Creating prototype for BOM located on separate page

As an example, let's create a BOM prototype, whose table will have the following columns:  "Item No",

"Quantity", "Description", "Part Number", "Material", "Price".

Let's begin the prototype creation with creating BOM title blocks for the first and subsequent pages in

separate T-FLEX CAD documents.  

The title block for the subsequent pages may differ from the title block specified for the first

page. 

After that, one can proceed with creating the BOM prototype

itself. Call the command "Create Bill of Materials". In the coming

up dialog box select "<Empty Template>" and press the graphic

button [Create New Template]. After selecting the new document

prototype and entering the name for the prototype being

created, the system activates the text creation command. The

BOM table is created based on the paragraph text or multiline

text. If you want the system to support automatic continuation of

the BOM table onto the new pages as records are added (with

automatic new page creation) or into a different area on the

current page, then select the paragraph text. If you select the

multiline text, then your BOM table will grow high without the

capability of transferring it onto another page.

Select, for example, the option  ("Create paragraph text").

You should set vertical justification among the text parameters of

the table being created. This should better be done before

entering the text.

Call the text parameters dialog box using the <Р> option. If you want your BOM to grow from bottom

up as records are added, then set Lower Limit justification, to grow from top down use Upper Limit

justification (Upper Limit justification is set by default). When creating a BOM prototype on separate

page, the vertical justification is usually required to be the Upper Limit one.

If you use the paragraph text, the rest of parameters can be left unchanged. When using the multiline

text, additionally set the right horizontal justification. When using the paragraph text, the vertical

justification can later be changed by calling the properties dialog box for the rectangular text area

(see the chapter "Text"). After that, we need to define the boundaries of the box where the created

BOM table will be placed. To do this, specify two arbitrary points in the case of the paragraph text, or

just one in the case of the multiline text.
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To continue with the BOM creation, click  inside the paragraph text or press . The BOM

property window will appear on the screen (see the section  "BOM Properties"). In the case of using

the multiline text, the BOM property window will appear right after selecting the fixing node.

Default BOM properties (names and types of the columns, the sorting rules and the groups) are

copied from the file …\Program\BomStructure.mdb.

The number of columns, their position and composition can be defined on the tab "Columns". The

columns that are checkmarked in the table on this tab are the ones that will be included in the created

BOM table. In the example shown on the diagram, the BOM table will have the six check marked

columns, their positioning left to right being determined by the relative positions of the checkmarked

entries on this tab in the top down direction.

Note that the number, names and order of the columns should correspond with the BOM title

block.

The "Sort" and "Sum" tabs allow defining (or modifying default) sorting rules of the BOM records and

summing up rules for its cells.

Upon confirming the specified properties, the system will activate the BOM table editing mode. The

dialog box “Add Record into Group or Create Group” will appear on the screen. The BOM prototype

should not contain any records; therefore, close the dialog window by pressing the graphic button

[Cancel].

To format the columns of the created table, enter the template editing mode. This can be done using

the option:

Edit Template

This option is located on the main toolbar (in the button set “BOM”).

Upon calling the option, the system activates the table editing mode. On the main toolbar (if it is not

locked), the button set “Text” will be shown.

The options of this set allow changing the height, width and formatting of the columns. Besides, the

following options become available in the automenu:

<F9> Format Font

<F10> Format Paragraph

<Ctrl><F5> Parameters of changing Paragraph size

<F11> Edit in separate window

Let's format the created table. The columns width was set automatically when inputting the text based

on the size of the input paragraph text. (When using the multiline text, the width is set by default). The

width of each column must be changed according to the width of the columns in the BOM title block.

The height of the template rows must be equal or (for multiline records) a multiple of the distance

between the horizontal grid lines in the title block. 
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Select the whole table by clicking  or with the following option on the main toolbar (button set

“Text”):

Select Table

Then, using the option , call the paragraph parameters dialog box. The parameter "Between

(interval)" should be assigned the value "Exactly" and the numerical value equal to the height of the

rows in the title block table (in this example - 8). Press the [Ok] button to close the dialog box. The

height of the table rows should be changed accordingly, and the border display should be turned off.

To do this, keep the table highlighted and call the option on the main toolbar (button set “Text”): 

  Table Properties

On the "Row" tab, set the following row parameters: the row height, as well as the line spacing

interval, is set equal to the distance between the horizontal grid lines in the title block. The parameter

"Mode" should be assigned the value "Multiple". This allows increasing the height of the rows with

long entries in the table so that they exactly match the rows of the title block. Additionally, one can set

the parameter "Allow wrap". This will allow prolonging the BOM table on the next page.

Since the BOM table grid is defined by the title bar, the display of the template table border lines

should be turned off. To do this, on the tab "Borders" of the same dialog box clear the respective

flags. Upon confirming the entered changes, the system returns to the BOM editing mode.

Keep calling the same dialog box for each separate cell in the template table, setting the desired

width of each cell in the "Cell" tab, along with text offsets from the beginning and the end of the cell,

if necessary. Besides, one can set horizontal justification mode for various table cells, and force no-

line-break for the text, using the automenu option .

Table creation and editing capabilities are described in details in the chapter "Text".

To complete BOM template editing, one can use the option:

<F5> Finish input

The system will then return to the BOM editing mode.  To complete working with this functionality,

one can also use the option . After that, the system returns to the text creation command. To

continue working with the system, with this command. Next, let's insert the predefined title block

fragment in the drawing. To do this, use the command "Create Fragment". Then call the command

"Edit" from the BOM context menu and snap the created text to the fragment nodes ("Node 1" and

"Node 2" on the diagram) for the exact match between the BOM template and the title block lines.
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The final step will be insuring the correct BOM continuation onto the subsequent pages. For this

purpose, call the command "Set Document Parameters" and on the "Fragments" tab specify the title

block fragment names for the second and other subsequent pages of the BOM. You will have to enter

the template editing mode again and call the option . In the coming up dialog box on the tab

"Height" set the action upon the text outgrowing the rectangle bounds as "Create new rectangle on

next page".  The new rectangle coordinates are set according to the coordinates of the outer nodes of

the table (similar to the nodes on the previous diagram) on the title block drawing for the subsequent

BOM pages.

Note that the described order of steps in defining the BOM template parameters is not

mandatory. All these steps can be performed in an arbitrary order.

Creating prototype for BOM located on existing drawing page

The sequence of steps for creating such a prototype is mostly the same as in the previously described

situation. As in the case of creating a prototype for a BOM on the separate page, the prototype

creation should begin with creating the BOM header in a separate file.

In the following example, let's create the table header consisting of the same four columns as in the

previous case. Let's position the fixing vector along the top border of the header directed from right

to left. The vector direction choice is based on the requirement, that the BOM table template located

on the existing page has right justification.

Save this file. Then call the command "Create Bill of Materials". In the coming up dialog box select

"<Empty Template>" and press the graphic button [Create New Template]. After selecting the new

document prototype and defining the name of the prototype being created, the system activates the

text creation command.

In the text parameters dialog box, called by the option , set the Lower Limit vertical justification (a

BOM located on the drawing page should grow from bottom up). In the case of the multiline text,

additionally define the right horizontal justification.
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After that, define the boundaries of the rectangular area for fitting the BOM table being created. Upon

defining the text boundaries, the BOM property window will appear. In it, select the required BOM

columns, sorting and summing rules, etc.

Additionally, specify the table header (footer) fragment on the tab "BOM" of the same window. If the

header is used in the table, specify the path to the header fragment. Otherwise, if the footer is used in

the table, enter the path to the footer. The path can be defined using the button . Upon confirming

the specified BOM properties, the  system  will  switch  to the BOM table editing mode. The dialog

box “Add Record into Group or Create Group” will again appear on the screen. On the main toolbar

(if it is not locked), the button set “BOM” will appear.  The BOM prototype should not contain any

records; therefore, close the dialog box by pressing the button [Cancel].

To format the columns of the created table, enter the template editing mode using the option . in

the Paragraph parameters dialog box (the automenu option ) specify the line spacing for the table

cells, as well as the text horizontal justification modes and the requirement of keeping the text as one

line.

In the "Table properties" dialog box, called by the option  on the main toolbar (set “Text”), change

the width of each column according to the width of the columns in the header fragment. The height of

the table rows does not have to be set in this case. Also, turn on the table border display (is on by

default). On the "Table" tab, the right horizontal justification should be set for the table. This will allow

automatically keep the BOM being created toward the right hand side of the drawing above the title

block text. 

Note that the justification defined in the table parameters must correspond with the fixing

vector direction of the BOM header.

The template editing, as well as the whole BOM editing, can be completed using the option . Exit

the text creation command and save the resulting prototype.



T-FLEX CAD 17 Help

2548

Model Configurations and Variations

Configuration – saved in the document additional version of the model’s geometry satisfying several

given conditions. Geometry of configurations is not shown in the 3D scene of the document.

By default, the T-FLEX CAD document stores only the geometry corresponding to the last saved

state of the 3D model of the given document.

The main domain of application of configurations is for design of 3D assemblies. Geometry saved in

the configuration can be inserted into the assembly instead of the actual geometry of the fragment.

The use of configurations allows the user to rapidly download the required version of the fragment

without additional recalculation and transformation of fragment’s model.

Variation is a special configuration type intended to work with the product structures. The variations

are used for variant BOMs creation.

T-FLEX CAD document can contain any number of configurations. Each configuration is assigned the

unique name.

Depending on conditions defining the saved configuration, configurations can be divided into 2 types:

· Configurations by a total collection of bodies – store the geometry of all bodies of 3D

model;

· Configurations by optional collection of bodies – store the geometry of an optional

collection of bodies corresponding to any operations and Bodies from the model’s tree.

If the document contains external variables, in each configuration a collection of values of external

variables is also stored, for which the geometry of configuration was calculated.

Configurations can be also created in the 2D documents. In this case, configuration is capable to

store only collection of values of document’s external variables. Such configurations can be used

while working with 2D fragments for quick specification of values of fragment’s variables.

Using Configurations

When inserting a document with configurations as a 3D fragment, as usual, it is possible to either

specify the values of external variables of fragment required in the assembly (if a fragment has them)

or specify one of the configurations saved in the document.

When specifying the values of variables, the system has to recalculate the entire model of the

fragment according to the values specified in the assembly. The geometry obtained as a result of

recalculation is put into the assembly.

When using configuration (created in the document of a fragment in advance), recalculation of the

fragment’s model is not carried out, - the geometry stored in the configuration is inserted right away.

Geometry inserted into the assembly contains only the bodies which were saved in the configuration.

Since there is no recalculation of the fragment’s model upon insertion of configurations, the time

spent on assembly construction is significantly reduced. This is especially evident when inserting the

fragments containing quite complicated constructions and the large number of operations. The

possibility to control the structure of the geometry saved in the configuration provides even wider

capabilities for design of 3D assemblies.

Mechanisms, purpose and operation with the first and second types of configurations are considerably

different, thus, a separate description of each is required.

Configurations by a total collection of bodies

When creating configuration by a total collection of bodies the user specifies only the values of those

external variables of the document to which geometry of the configuration has to correspond.

Geometry of all final bodies of the 3D model is saved in the configuration.
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The use of configurations of this type for 3D fragments allows the user to avoid the recalculation of

fragment’s model in the assembly. To take advantage of this capability, upon the fragment’s insertion,

instead of entering the values of the variables, the user needs to specify one of the configurations of

the fragment. Geometry of the indicated configuration will be downloaded into the assembly.

The system can use the geometry from the configuration of the fragment automatically. This happens

when for 3D fragment the user specifies the values of the variables coinciding with the set of values

for one of the configurations of the fragment. If this coincidence takes place, then instead of

recalculation of the fragment’s model, the system downloads the geometry from the corresponding

configuration. Note that this rule is valid only for configurations by a total collection of bodies.

Configurations by optional collection of bodies

When creating configuration by an optional collection of bodies, in addition to a collection of values

of external variables, any arbitrary set of operations and Bodies from the model’s tree of the

document is specified. The geometry that will be stored in the configuration represents a collection of

all selected operations/bodies. When using the current document as a fragment, such configuration

will be inserted as a multi-body fragment.

Multi-Body fragments can be automatically divided into several separate bodies, if, in the

properties of the fragment in the assembly, the parameter Use As (Operation tab) is assigned

the value Separate Solids.

Insertion of configuration by an optional collection of bodies into the assembly can be carried out

only by explicit specification of the name of the required configuration in the fragment’s properties.

Configurations by an optional collection of bodies can be used in cases requiring different

representation of the model’s geometry in the fragment and in the assembly. For example, inside the

assembly they allow displaying the bodies corresponding to the operations in the middle of the

model’s tree of the fragment. Example – the parts with completed finishing of welded joints. Finishing

of welded joints requires creation of a large number of additional operations complicating the model

and increasing the recalculation time. In the 3D model of the part itself, the finishing of welded joints

is necessary, but in the assembly it is often unnecessary and significantly burdens the assembly model.

In such situation in the fragment it is possible to create configuration containing the part’s geometry

without finishing of welded joints. The list of bodies stored in this configuration will consist from one

operation which precedes the operations simulating the finishing of welded joints. If, upon the

insertion of the fragment into the assembly, the user selects this configuration, the part will be

displayed in the assembly without finishing of welded joints.

Configurations can be also used for fragments whose structure must be modified from one assembly

to another. For example, assume that the fragment’s model contains a collection of bodies, but it is

required to include only some of them into different assemblies, and, moreover, in different

combinations. In this situation, in the fragment’s document the user can create several configurations

with different collection of stored operations, and download them into the assemblies as needed.

As another example of the use of configurations consider the following: often, in the assembly the

user needs to create a hole adjusted for a non-standard part, and then insert, as a fragment, the part

itself. To do that, in the document of the fragment-part the user can create configuration storing a

simplified state of the model (operation from the middle of the model’s tree) and a final view of the

part (operation from the top of the tree or a Body). When inserting such configuration into the

assembly with the use of fragments’ partitioning into the bodies one of the inserted Bodies can be

used for creating a hole (with the help of Boolean operation of subtraction), another Body – for

obtaining the fragment-part itself.

Creating and Editing Configurations

For creating and editing configurations the Model Configurations command is used:
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Icon Ribbon

Parameters > Tools > Model Configurations

Keyboard Textual Menu

<Shift+F4> -

This command can be unavailable if the current document was not saved. 

Calling the command brings up the service window for managing configurations of the current model:

The left half of the window displays a list of existing configurations and variations for the current

model. In order to start working with any configuration, you need to select it in this list. If there are no

configurations in the document yet, the list will be empty.

Option  Create configuration is used to create a new configuration.

Option  Create variation is used to create a new variation.

A new name may be assigned for the new configuration or variation.

You can specify a Product Composition type for the new variation.

When the Show Only Types Suitable for Variation option is disabled, all types of product

composition will be available, however, it is recommended to leave the option enabled, then the list

will display a type suitable for variation - Variant BOM.

If the field Part No. is filled, it will be set as configuration/variation name by default. If it is empty, the

current document name will be used.
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The product composition will be automatically created after the variation saving. Its name matches

the source name.

For already created configurations/variations, you can change the name and, if necessary, specify the

subtitle by editing the corresponding cell in the table.

The set of variable values that corresponds to the current state of the model is assigned for a new

configuration/variation, by default.

There are following options in the context menu:

Delete allows delete configuration or variation.

Copy allows copy configuration or variation.

Change type to “configuration”/”variation” allows to switch type of currently selected element.

Sort allows to activate sorting by Name column or In order of Creation Ascending/Descending.

Delete Product Composition deletes product composition for the currently selected element. You can

reassign the product composition in the Product Composition window by clicking Create…

Base Variation. The flag to the left from the name is used for the base variation selection. The

properties of product composition corresponding to the base variation are used for data display in
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the Product Composition window in the Apply product composition representation mode. If the flag

is not set for any variation, the first variation in the list is considered to be the base.

For selected configuration, the list of external variables values is shown in the table Variables in the

upper right pane of the command’s window.

The values of variables can be modified in the table. 

You need to save changes using the Load option to make them actual. Some external variables can be

deleted, and some can be created when you edit the model. 

Select Operations and Bodies  option opens a window with a list of model operations and bodies

saved in the selected configuration.
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All value is displayed in the list after creating configuration. If the configuration creation is completed

at this stage, configuration by a total collection of bodies will be created. Uploaded operations and

bodies configuration by an optional collection of bodies is created when you select Selected value.

For filling in the list, you need to set a desired filter in parameter Select: Bodies or Operations. After

that, it is possible to select any Bodies or Operation in the 3D scene or in the 3D model tree.

Configuration by a total collection of bodies Configuration by an optional collection of bodies

Using the Operations and Bodies option, you can display the items selected in the Select Bodies and

Operations option in separate columns.
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To work with configurations/variations, the following options are also used:

 Update Configuration and Variation Names by Document Part Number - allows to update the

names of all configurations and variations according to the specified document part number.

  Copy/Paste - allows to copy or create a new configuration/variation based on the existing

one. You need to specify name for the new configuration. The variables values and the product

composition type are copied from the source object.

 Import Configurations and Variations from Clipboard - allows  to import configurations and

variations from the clipboard, where the first line is the names of the lines, and all subsequent ones are

the values ??of the configuration or variation variables. For example, there is a 3x4 table:

After copying the table to the clipboard and clicking the  option, the import window will appear.
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Using the separator, you can select the view of the copied table.

Configurations are created by default. To create variations, you must use the Variations option. When

this option is active, it becomes possible to create product compositions.

If the number of lines with variable values ??coincides with the number of selected configurations, then

you can not create configurations, but substitute the values ??of variables in the selected ones. Then the

option Create Configurations/Variations will be inactive:

After that, you need to set the match between the columns and variables. To do this, click on the VAR

icon in the correspondence table. A window for selecting a variable will appear and after matching

columns with variables, the result will be as follows:
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 Load - regenerates model with a variable values defined in the selected configuration. This

command allows viewing geometry of each configuration.

 Update - assigns current values to the external model variables in the current

configuration/variation.

 Delete - deletes the selected configuration/variation.

 Delete all - deletes all configurations/variations.

 Create new variations table – creates variations table of the model.
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Variables and Related Parametric Tools

T-FLEX CAD variables are auxiliary elements of the system that allow you to define various types of

non-geometric relationships between drawing elements.

For example, variables can be specified as parameters for construction lines. In this case, the value of

the construction line parameter will be determined by the value of the variable. If the value of the

variable changes, then the value of the construction line parameter associated with it (for example, the

radius of a circle or the position of a straight line) will automatically change. Using variables, you can

set the color and visibility of drawing elements, hatch parameters, text content, various parameters,

etc. Variables can also be used when creating a 3D model.

By setting the relationship between the values ??of the variables that determine the parameters of the

construction elements and the drawing image, you can achieve automatic change of the entire

drawing when the value of one or more base variables changes.

Variables can be created in the T-FLEX CAD system in different ways:

· using the variable editor;

· when setting and editing the parameters of construction lines, as well as other elements of the

drawing or 3D model;

· in the text editor;

· when specifying text strings in the parameters of some elements;

· when setting the values of almost all real parameters of elements (levels, priorities, etc.).

The main tool for working with variables is the variable editor. With its help, you can perform all

actions on them.

Topics in this section:

· Variables and Rules for Their Creation

· Variable Editor

· Functions for Working with Variables

· Variables Window

· External Variables

· Global Variables

· Adoption Variables and Databases

· Control Elements

· Links

· Relations

· Recalculate

· Databases

· Graphs

· Set Value

· Recalculate Tolerances

· Optimization

Variables and Rules for Their Creation

Variables Characteristics

Before getting to description of the variables editor itself and how to work in it, let's consider the

main characteristics of any variable of the T-FLEX CAD.

Upon creating any variable of the T-FLEX CAD, it is necessary to indicate:

· a unique name of the given variable which enables to uniquely identify it in the document and

also  determine the type of the given variable (text or real);
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· expression, based on which the system will calculate the current value of the variable. 

Moreover, there is also a number of additional characteristics of variables, which can be specified in

case of need. Several of them enable to impart additional properties to the variables (for example,

the indication of external variable). Others are used exclusively for simplifying the work with a large

number of variables in the document (comment of variable, group of variable).

Rules for assigning variables' names

The name of any T-FLEX CAD variable must represent itself a string of characters. The letters, numbers

and the character “_” (underlining) can be used in the name. There is no limitation on the length of the

variable's name.

The variable's name determines the type of the variable: real or text. The type of the variable shows

what sort of values the given variable may take. The type is determined by the first character in the

name of the variable. The name of the real variable must start with the letter, text variable – with the

symbol $.

Examples of correct variable names:

VAR1; VVVVVVVVVV; VAR_1; $TEXT; WIDTH; width;

Note that the two last variable names are considered different, as the names are case-sensitive.

Local language extensions of US ASCII are supported for the names. Local language users shall

keep in mind that some language characters (particularly, Cyrillic and Greek) resemble the

standard US ASCII, while their system codes may be different. Therefore, care should be taken in

entering names, as the system will not recognize a name with the same appearance yet actually

composed of different characters.

Examples of inappropriate variable names:

1_VAR (the first character is not a letter);

!_VAR! (inadmissible “!” character is used);

V A R (the name may not contain “space” characters).

Expression for variable

An expression is specified for each variable so that the system could calculate the value of the

variable at any moment of time.

An expression – is a mathematical formula, containing standard algebraic operations, logical

operations, conditional operations, calls to mathematical functions and the T-FLEX CAD functions,

various constants (real or character, depending on the type of variable), the values of other variables.

As a result of the expression calculation, the value of the variable is obtained.

An expression can contain operands (real constants and variables, text constants and variables) and

operations (a set of actions on these operands). Expressions can also contain functions.

When working with variables, you can use the following types of functions:

· Mathematical Functions

· Trigonometrical Functions

· Special Functions

· Text Functions

· Convertation Functions

· Database Fucntions

It doesn't matter which symbols are used to spell the function name: uppercase or lowercase.

Upon specifying the expression for the variable, the type of the variables should be taken into account.

Real variables can take only numeric values (12; 125; -234; 781.234; 3.834e+6), text variables – only

character values (“Text”; “String”; “Name”).

An expression can represent itself just a constant (numeric or character depending on the type of

variable).
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Variables-functions

Besides various mathematical and special functions, predetermined in the system, upon compose the

expressions for the variables, it is possible to define and use user's own functions. For example, if,

upon defining the variables, many similar, bulky expressions, differing only in separate arguments, are

used in the expression, it is possible to define user's own function, a call to which can replace the

expressions. User's functions are defined with the help of variables of a special kind – variables-

functions.

Variable-function represents itself the definition of the user's function. The expression for the variable-

function is composed according to the same rules as those for the standard variable. The entry of the

arguments of the function into the expression is denoted in the following way (the number of the

arguments is not limited):

#1 – the first argument,

#2 – and second argument and so on.

The function defined in such way can be used in the variables editor upon specifying the values of

other variables. Upon calling this function, the names of the variables and numeric expressions serve

as the arguments. The number of actual arguments must be equal or more than the number of formal

arguments.

For example, if the variable-function was defined in the following way:

FUNC=(#1+#2)*10,

the call FUNC (L, 20, 30) will not be a mistake.

In the list of the variables of the current document, the empty brackets “()” are automatically

added to the name of the variable-function.

The list of variable's values

For any T-FLEX CAD variable it is possible to define a list of values. To be more precise – a list of

expressions since the list for the variable can include any values, not necessarily the constants. The list

of various expressions can be defined even for a variable-function. After that, the value of any

variable, more precisely, of any expression, determining this value, can be selected from the created

list.

The list is created as a set of lines, containing required constants or expressions. Moreover, the list can

be created on the basis of already existing file, internal database, the list of materials in the 3D version

or the calendar two last items are available only for text variables.

The list defined for the variable will appear in all places in which the value of the given variables is

specified (in the variables editor, in the command Edit Model Parameters, upon assigning the

variables of a fragment). The field for the entry of the values of such variable will include the graphic

button  which enables to call the list of values. To access the list of values, it is enough to point at

this button with the cursor of the mouse and press . As a result, the list will pop up on the screen,

and the new value (expression) can be selected from the list.
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Variable units

The unit of measurement of the variable is indicated in the Unit column. All real variables can be

dimensionless when the unit of measure is not specified, or have a specific unit of measurement. Unit

can be specified by the user or determined automatically based on an expression. When calculating

the values of expressions, the compatibility of the units of measurement is checked. In case of non-

compliance, the system issues a warning message in the diagnostic column. The units of the variable is

optional and in many cases unnecessary.

Comment of variable

If necessary, for any variable the comment can be specified. It represents itself an arbitrary text string.

The comment enables to “attach” certain clarifications to the variable. For example, the comment may

clarify the variable's designation (the width of the part, the radius of the circle, etc.) or the range in

which the value of the variable is changed.

The comment of the variable, if it is specified, will appear in the dialog for inserting a variable (this

dialog can be called, for example, from the context menu of all fields of the system dialogs), and also

from the list of the values of the fragment upon its insertion into a drawing or 3D model.

Group of variables

If necessary, for any variable the group can be identified. When the variables are broken down into

the groups, it becomes easier to control the large list of variables of the complicated drawing.

The Group, as well as the comment, is an additional characteristic of the variable specified for

simplifying the work with a large number of variables. The fact that the variable belongs to a certain

group does not affect in any way the use of this variable.

External Variables

Any variable, the value of which is specified by a constant (numeric or character), can be given an

attribute “external”. External variables are used for organizing parametric connection between the

assembly document and the fragments. The values of the external variables, defined in the fragment,

can be modified from the assembly document.

The variables, marked as external, can be exported to the external text file with the possibility of

reading from this file afterwards. This enables to use external variables for organizing connection

between the T-FLEX CAD and other systems and application programs. 



Variables and Related Parametric Tools

2561

Hidden Variables

For regulating the work with a large number of variables, the mechanism of hidden variables can also

be used.

Any variable, created in the T-FLEX CAD document, can be marked as hidden. By default, such

variables are not displayed in the window of the variables editor or in the windows of other T-FLEX

CAD dialogs dealing with the variables. Thus, it is possible to hide various auxiliary variables.

All standard templates of the T-FLEX CAD documents already contain a list of hidden variables

providing automatic cross-reference between the fields of the drawing format (the title block) and the

BOM data. In other words, the textual strings of these variables are substituted in both the appropriate

title block fields and the respective entries of the BOM data.

Used and unused variables

In order that the value of the variable could affect the structure of the drawing (or 3D model) of the

given document, it is not sufficient just to create this variable in the T-FLEX CAD document. The given

variable has to specify a characteristic of the elements of the drawing or 3D model: location of a line

or a node, the radius of a circle, the level of visibility of the image line or 3D bodies, etc.

The variables the values of which take part in specifying characteristics of other elements will be

further called used. Also, the variable is considered to be used, when its value is used for evaluating

the value of another variable.

Consequently, the variables the values of which are not used anywhere on the drawing or in the 3D

model and also upon calculation of the values of other variables are considered to be unused. Such

variables, being equal variables of the T-FLEX CAD document, do not have any influence on its

content.

General information

In any dialog for entering or editing parameters and variables, you can use the function keys.

When you press <F11>, a window appears on the screen for entering the parameter value in degrees,

minutes, seconds.

The <F12> key calls the Measure command, which allows you to enter the values of the measured

distances or other properties of the drawing elements in the parameter field. When it is started, the

dialog from which it is started disappears and reappears when the measurement command is

completed. In this case, the resulting value or expression is automatically inserted into the current edit

field.

In all system dialogs, you can create a menu of values in the controls where you can enter numbers

and strings. When you create a menu of values, a menu selection button appears on the right side of

the edit field. To create a menu of values, you can use the context menu or the <F2> key.
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In the list, in addition to the values themselves, you can include vertical (Separator) and horizontal

(Column Break) separators, which allows you to design the drop-down list in the form of a table.

At any time, the current value of the edit field can be inserted into the list of values using the F3 key or

using the context menu.

The lists of values are stored in a separate file " DlgData_METRIC. ini "for the metric system and"

DlgData_INCH.ini " for the inch system.

For more information about variables and the variable editor, see the Variable Editor section.

Topics in this section:

· Expression Operands

· Expression Operations

Expression Operands

Members of expressions

Numerical constants may not contain spaces.

Examples of correctly defined constants:

2; 3.344; -2.34; 1.234e+5; 1.2344E-32; 0.0034;

Examples of incorrectly defined constants:

2,34 – the comma is not allowed as the decimal symbol.
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1.234 e+5 – inadmissible "space" symbol is used in a constant.

Note for local language users: in the exponential number representation, use only the US ASCII "E" or

"e".

String constants.

A string constant is an arbitrary string entered in quotes:

"This is a string constant!"

Should a string constant include the quote symbol  ("), it must be preceded by the backslash symbol

(\).

"This is another \"string\" constant!"

The above is the way to enter a string constant, whose value is to read, 

This is another "string" constant!

To have the backslash symbol a part of a string constant, it must be duplicated.

Example:

"This \\is\\ t\w\o\!"

The value reads,

This \is\ two!

Note that a single backslash is ignored throughout.

Constant

In the system, it is possible to assign constant values to variables g,e, phi.

g(). Sets free-fall acceleration value.

e(). Sets Euler's value.

phi(). Sets golden ratio value.

Expression Operations

The string members can only be subject to the operation concatenate, or, simply, addition of two

strings ( + )

"T-FLEX"+" CAD" = T-FLEX CAD

The numerical members are subject to common arithmetic operations, as 

· addition ( + );

· subtraction ( - );

· multiplication ( * );

· division ( / );

· unary negation (minus).

You can't divide by zero. This results in an error.

You can use any number of spaces inside expressions. Spaces sometimes give more visibility.

An important point is the order of operations (priority). For example, the multiplication operation

takes precedence over the addition operation. To change the order of operations, use parentheses.

Using parentheses correctly avoids unexpected results.

The separator between the integer and fractional parts must be a dot. When entering values in the

variable editor and in the command value input fields, an erroneous separator is autocorrect: if a

comma was placed instead of a dot separator, autocorrect will be performed.
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· exponentiation ( ** or ^ )

Example:

2 ** 3  = 8

-3 ** 3 = -27

When performing this operation, errors may occur (for example, an overflow when the result value is

too large). If one of these situations occurs, the following message appears:

· getting the remainder of the division ( % )

Example:

23 % 5 = 3

23.7 % 5.5 = 1.7

-23 % -5 = -3

23 % -5 = 3

-23 % 5 = -3

The result of the operation member1 % member2 is the remainder of dividing member1 by member2.

The value of member2 may not be zero. In the case member2 = 0, the error occurs, "Division by zero".

Logical operations 

· Greater than ( > )

· Less than ( < )

· Greater than or equal ( >= )

· Less than or equal ( <= )

· Inequality ( != )

· Equality ( == )

· Logical AND ( && )

· Logical OR ( || )

· Logical NOT ( ! )

Examples:

23 > 45 && 56 < 34 

This example expresses the question: Is the number 23 greater than the number 45 and the number 56

less than the number 34? Obviously, the answer will be - no, therefore the value of this expression is

zero.

The expression !VAR_1 is the same as VAR_1 == 0
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Logical operations are usually used for comparing the value of a variable against a constant or a value

of another variable. A shortcoming here is that only two values are possible as the result of evaluating

a logical expression - 0 or 1. 

Another form of using logical operations is a conditional statement.

A conditional statement has the following structure:

condition ? value1 : value2

Example:

VAR_1 > 100 ? 1 : -1

If the value of VAR_1 is greater than 100, then the statement will yield 1, otherwise it yields -1.

One can use arbitrary expressions for the condition, value1 and value2.

VAR_1 ? 1 : -1

or, just the same thing,

VAR_1 != 0 ? 1 : -1

VAR_1 != 0 && VAR_2 == 0) ? (VAR_3 + 1) : (VAR_4 -1)

A good example is the select and switch functions, which can be viewed in the corresponding section.

Variable Editor

Calling the command:

Icon Ribbon

3D Model > Additional > Variables

Draw > Additional > Variables

Assembly > Additional > Variables

Title Block > Additional > Variables

Bill of Materials > Additional > Variables

Parameters > Additional > Variables

Measure > Additional > Variables

Analysis > Additional > Variables

Sheet Metal > Additional > Variables

Surfaces > Additional > Variables

Weld > Additional > Variables

Primitive > Additional > Variables

Keyboard Textual Menu

<V> Parameters > Variables

Variable Editor window

The work with the editor can be carried out in two ways. The first way – the work in the main window

of the variables editor, called with the help of the Variables command. The dialog box of the given

window enables to use the entire functionality of the variables editor and possesses a convenient

interface. However, all changes made in the given window will be applied to the model only after

closing the window of the dialog box.

The second way – is to use a special service window of the system – the Variables window. This

window enables to work with variables in transparent mode.
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In this chapter the description of work with the variables editor will be further presented by taking the

standard window of the variables editor as an example. However, the same operations can be

performed in the Variables window. 

The variable editor window contains a list of all variables of the current T-FLEX CAD document,

regardless of the way they were created (new variables can be created not only in the variable editor).

When the command is called in a document in which no variable has been created, the variable editor

window will be empty.

Detailed information about the types of variables, functions, etc. see Variables and Rules for

Their Creation.

Variable usage in T-FLEX CAD

Variables and expressions created inside the variable editor have no effect on the drawing. Separately,

the variable editor is just a powerful calculator. But there are many possibilities of using variables in

the T-FLEX CAD system.

In the editor window, the variables list is displayed as a table, the form of which can be freely edited

by a user. It is possible to modify the number and content of the displayed columns, the parameters

for grouping and sorting the rows of the table, parameters of the grid of the table. 

The variables editor has its own textual menu and the toolbar containing the main commands for

working with the variables.

Editing the expression of existing variables is performed transparently in the Expression field.

Recalculation of the entered expression and, accordingly, the values of all other variables occurs when

the user proceeds to edit the expression of another variable, that is, moves the cursor to another line. 

If necessary, you can regenerate the model without closing the variable editor window immediately

after changing the variable value. To do this, click the Apply button at the bottom of the variable

editor.

The system provides for automatic replacement of the separator of the integer and fractional parts of

the number with a comma by a dot.
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Such a replacement is performed if the constant is not inside the parentheses when calling a

function with several arguments. In this case, commas are retained because they can be used as

separators for function operands.

If you enter the separator of the integer and fractional parts of a number by mistake, the syntax will be

corrected automatically.

For each variable, you can specify the unit of measurement, and the system will automatically

diagnose the correctness of the units of measurement in the calculated variables. You can borrow

variables from other fragments directly from the editor.

If the expression was entered correctly, the result of the expression calculation will appear in the Value

column.

The visibility of the menu and toolbar is controlled using commands in the context menu.

In the same place, you can turn on/off the color display of expressions. 

The Multiline mode flag enables displaying long expressions in multiple lines.
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In multiline mode, it is possible to add a line break with the <Ctrl>+<Enter> key combination to

format expressions in a human-readable way.

Hints are implemented in the variable editor window. When you hover over a variable, the comment

for the variable is displayed.
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When you hover over a function, a brief description and an example of how the function is used

appears.

If the field belongs to a database, the names of the database and field are displayed, as well as

comments.
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For text constants, a model object is searched for by the corresponding name or identifier. If a text

constant specifies the name of an object, then information on this object is displayed for it.

Hints are active. When you click on a hint, an action is performed that is different for different data

types:

· Variable name. Jump to the line of this variable;

· Function name. Help is called with a section containing a description of the function;

· Referring to a database field. The database editor window appears;

· The identifier or name of the model element. The Information dialog for this item is called.

When you enter an expression, a drop-down list of matching functions, variables, databases and

database fields appears. This list contains descriptions and comments for list items.



Variables and Related Parametric Tools

2571

To call a list of all available variables and functions, use the <Ctrl>+<Space> combination.

When the user selects a function from the dropdown list, the brackets and delimiters required for the

selected expression are automatically inserted.

Selection and calculation of units of measurement of variables

Specifying the units of a variable is optional when creating a variable or using a variable. It is rational

to use variable units for internal calculations in the variable editor, as a way to simplify engineering

calculations inside CAD. If the variable determines the size of the model, then you need to remember

about the document unit of measure (specified in the Document Parameters) and unnecessarily do

not use units other than those common for the document. 

You can specify the unit of measurement for the variable in the properties of the variable by selecting

the desired unit of measurement from the list provided.
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Or in a special column of the units variables editor. To call the list of unit of a variable, press  in

the Unit column of the variable.

In addition to a specific unit of measure, there are also options Automatically and (not set).

Not set. The default is when no unit is specified for the variable.

Automatically. The unit of the variable will be determined from the expression. If a unit of

measurement is not specified in the expression, or variables with an unspecified unit of measurement

are used, then the unit of measurement of such a variable will remain unset. 

In the Expression field, you can specify the unit of measure when performing calculations. The

expression will be calculated based on the unit of measurement, and the value will be converted to

the unit of measurement of the variable. The unit of measurement is indicated by an abbreviation. 
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If the abbreviated designation of the unit of measurement contains additional characters, for example

"/", then it must be enclosed in parentheses. 

If the units of measurement of the variable are defined as Automatically, and the expression contains

a unit of measurement or contains variables with the specified units of measurement, then the unit of

measurement of the variable will automatically be set to some unit of measurement. This will indicate

that the unit of measurement for the variable is assigned automatically. 

If the Automatically option is specified for the unit of measure of the variable, but the expression

does not contain the specified units of measure (or variables with the specified units of measurement),

then the unit of measure of the variable will remain unset. 

If the variable determines the size of the model, then changing its unit of measurement will

change the geometry of the model. 

Expressions containing units of measurement can be written in all value entry fields that support

working with variables. You can also specify units of measurement via the context menu. 

Units are supported in the variable expression syntax. The unit of measurement in the expression is

specified by the abbreviated name, using Latin or Cyrillic letters. If the name contains symbols "/" or

brackets, then it must be enclosed in parentheses. When calculating the values of expressions, where

possible, unit conversion is used.

An additional item Insert unit of measurement has been added to all input fields for values that

support working with variables. When called, a menu with a list of units of measurement appears.
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The selected unit is added to the expression.
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When calculating the values of expressions, the compatibility of the units of measurement is checked.

In case of non-compliance, the system issues a warning message in the diagnostic column.

When using variables for which the unit of measurement is specified as the parameters of the model

elements, automatic conversion of the value to the model units is used.

Removing Variable

It is possible to delete the variable with the help of the following command of the variables editor:

<Ctrl>+<DEL> Edit > Delete

The Delete command can be also called from the context menu upon choosing the variable in the list

of variables.

After calling this command, the variable, for which this command was called, will be removed. Note

that, only unused variables can be removed (in the Not used column a symbol ? will be standing next

to such variable). The command Delete is not available for used variables.

The T-FLEX CAD system automatically determines which variables are not used in the drawing. The

fact that a variable is not used means that it is not included in arithmetic expressions that set other

variables in the variable editor, and is not used as a parameter in any graphic element of the drawing.

In case if the variable is currently used, the user has an option of either deleting the chain of

dependent elements or replacing the selected variable with a constant value.

Canceling Operations in Variables Editor

Any actions in the variables editor can be canceled/repeated with the help of step-by-step

commands:

<Ctrl><Z> Edit > Undo

<Ctrl><Y> Edit > Redo

The number of cancellation steps is limited only by general setting of the system (parameter

Undo/Redo Buffers in the dialog of the Set System Options command, the Performance tab).
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Show/Hide Hidden Variables 

Show/Hide hidden variables command  shows or hides hidden document variables in one click. State

is maintained in user settings.

Finding Variables

Upon working with a large list of variables, it is sometimes convenient to use the command of

searching for variable by name:

Icon Ribbon

-

Keyboard Textual Menu

- Edit > Find

After calling this command the dialog window pops up, in which the search parameters are required

to be specified. After specifying the parameters, the button Find Next has to be pressed. If the search

process was completed successfully, the cursor is moved to the column Expression for the found

variable. If the variable was not found, the cursor stays at the same place, and in the message line of

the editor the message appears: Cannot find specified string.
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Upon specifying parameters it is important to pay attention to the state of the Match Case flag. By

default, this flag is activated. In this case the system looks for the variable, the name of which

coincides exactly with the specified string in the field Find what. When this flag is off, the system

searches for the variable for which the text, specified in the field “Find what”, enters the variable's

name as a substring.

In all columns. The option allows finding of the specified string in all columns.

You can also use the quick search bar.

Copying Variables

The T-FLEX CAD makes it possible to copy variables from one document to another with the help of

the clipboard.

For copying one variable to the clipboard it is necessary to select it in the table of variables with the

help of , and after that call the Copy command:

<Ctrl><C> Edit > Copy

For inserting the already copied variable, the Paste command is used:

<Ctrl><V> Edit > Pastle
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If the document to which the insertion is carried out already contains a variable with the same name

as the inserted one, a corresponding message is displayed with a proposal to replace the current value

of the variable with a new one.

The commands of copying/insertion can be also called from the context menu for the variable:

For copying several variables simultaneously, a multiple selection with the help of <Shift>+  and

<Ctrl>+  is used. For selecting all variables of the given document at once, the following command

is used:

<Ctrl><A> Edit > Select All

Duplicate Variable

Any variable can be duplicated using Duplicate Variable:

<Ctrl><D> Duplicate Variable

After clicking the button, a new variable will be created in the variable editor, completely similar to

the duplicated one. The corresponding index will be added to the name of the new variable.
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Printing List of Variables

For printing the content of the variables editor the Print command can be used:

<Ctrl><P> File > Print

After calling this command the standard printing options dialog appears. As a result, all content of the

variables editor will be sent to printer in the same form as it was displayed on the screen.

Before calling this command, separate lines from the table of variables can be picked out in the

window of variables editor with the help of , <Ctrl>+ , <Shift>+ . Then by setting on the

Print range > Selection flag in the printing options dialog, it is possible to print out only selected

lines and not the entire content of the editor.

See also:

· Functions for Working with Variables

· External Variables

· Global Variables

· Variables Window

Topics in this section:

· Variable Creation

· Customizing Window of Variable Editor

· Grouping Variables

· Sorting Variables

· Import/Export of Document Variables

· Diagnostics of Errors

· Assistant Window

Variable Creation

In the variables editor the new variable can be created by using the New Variable command :
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<Ctrl><N> Variable > New

After calling this command, the window for specifying properties of the variable being created

appears. For creating a variable it is necessary to indicate the name, type of the variable (numeric or

text), and also specify an expression, which will determine the value of the given variable.

An expression can be a constant, or it can contain operands and operations, as well as functions.

The field Name and the toggle Numeric/Text work in a synchronized manner. For example, if

the specified name of the variable starts with the symbol “$”, then the type toggle is

automatically switched to the value Text. And vice versa – upon changing the type of the

variable, the symbol “$” is automatically added/removed to/from the name of the variable

Parameters Comment and Group do not have to be specified.

By default, the parameter Group takes the same value as the variable selected in the table of 

variables upon calling the command New Variable.

The flag External is turned on if the variable being created has to be external.

In the variable table, the names of external variables are shown in bold.

The flag Hidden is turned on if the variable being created has to be hidden.
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The flag Function is set on only in case it is necessary to create a variable-function. For functions in the

Expression column, enter an expression whose arguments are the "#" character and a number equal to

the ordinal number of the argument. The function defined in this way can be used in the variable

editor. When calling a function, variable names or numeric values are used as arguments.

If the current document is going to be used as a fragment, you can also specify the name of the

assembly variable and/or a list of Connector Values for its external variables in the Variable

Parameters dialog (what this is will be described in detail in the Specifics of Handling Assembly

Drawings section). The name of the assembly variable is set in the Assembly variable parameter field

in the When used as a fragment variable get value from.

The list of connector values is set in the Connector Values dialog box that appears when the

corresponding button is clicked.

The list Connector Values… is filled up for external variable of a document, used as a fragment

with fixing by connector. Upon inserting such fragment into an assembly, the system has to

automatically change the value of the fragment's external variable in accordance with the given

(“values”) of the indicated connector. The system selects the name of the required value of the

connector in the list Connector values for the external variable. Upon fixing the fragment to the

connector, the system will be first looking for the first name from the list, among the named

connector values, and if it is not found – the second name and so on.

The list of connector values may contain arbitrary number of elements.

For creating a new element of this list, the button  is used in this window, for removing already

existing element – the button . The buttons  and  enable to move elements up and down along

the list (the order of the elements in the list is set by a priority of elements in the list upon searching

for the coincidences with the connector values).

The group of parameters Value List enables to create and edit the list of values for a variable. If a

given variable does not have the list, then the value No will be specified in the drop-down menu of

the given group. For creating the list it is necessary to select from the menu the required creation

method: Text, Database, File, Data, Materials. More detailed description of various methods of
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creating the list of variable’s values is presented below in the section Creating List of Variable’s

Values.

The Color parameter specifies the color that displays the variable name in the variable editor.

As you can see in the image below, the variable name has become a light green color.

The Document parameter allows you to establish a relationship between the value of a variable and

file properties. The drop-down list allows you to select the name of the property that will be equal the

value of the variable. These properties cannot be seen in the Windows Explorer, but can be accessed

by external applications (e.g: T-FLEX DOCs) without reading the whole file.

After pressing OK the created variable appears in the list of variables.

It is recommended to use uncomplicated names for the variables in order not to write lengthy

expressions. It is a good thing to write a comment for each variable.

The command New Variable can be also called from the context menu at any place of the list of

variables.
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Besides the use of the aforementioned method, it is possible to create a new variable by other means.

It is enough to put the name of yet non-existing variable into the expression of some variable. After

recalculation of the given expression the system will find that such variable (for example, the variable

“С”) has not been defined, and a message will pop up on the screen: “Create variable “C”?”. If the

question is answered positively, the new variable will automatically appear in the list of variables, and

the focus of input will be moved to its field “Expression” – for specifying the expression for this

variable. In case of a negative answer, the new variable is not created and the error message is

generated.

Creating List of Variable's Values

The list of variable’s values is created with the help of the parameter Value List in the variable’s

properties window. The method by which the variable’s list is created is chosen from the pull down

menu of this parameter: Text, Database, File, Data, Materials.

After selecting the list creation method on the basis of text, the window of the text editor will appear,

in which the necessary list of values can be formed. Each value has to be located in a separate line.

Upon creating the list, all options of the text editor become available.
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When the list is created on the basis of database, already existing internal database or the database at

the link is used (databases are created using the Database command). For example, let's suppose

there is database shown on the picture. After calling the command for creating the list on the basis of

database, the dialog window will appear. The parameters for forming the list have to be indicated in

this window.

One has to choose:

· the name of the database from the list of databases for the current document;

· the column in the database from which the values will be selected. The first line of the list –

Record Number can be also chosen. In this case, the selected record number will be a value

being returned;

· columns which will appear upon creating the list.

The field Filter enables to specify conditions for the values selected from the database (upon creating

the list of values). These conditions are specified with the help of logic expressions, which are made

up by the same rules as those for the expressions for the variables (see Expression Operations section).

For example, the use of the expression, shown on the picture above (d<5), will lead to the result shown

on the picture below (for comparison, the list obtained in the same example without specifying the

condition in the field Filter is shown as well).
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List on the basis of database obtained with the use of

filter

List on the basis of database obtained without using

the filter

When the list is created on the basis of file, the dialog window for selecting already existing or

creating the new file (file of format *.LST) appears. The data in the file must be stored in the form of

sections with the lists of values. Upon creating the list, the required section is indicated. Also, it is

possible to create the new section or remove already existing section from the file with the help of

buttons  and  (buttons in the left pane of the dialog).

The list of values for the selected section is shown in the field on the right. The buttons , ,  and 

in this pane of the window enable to edit the list of values of the selected section.

The created file can be used while working with other T-FLEX CAD documents.

When the list is created on the basis of date, the dialog window pops up, in which the date

representation format can be specified, for example, “DD.MM.YY”. The variable, for which this list is

specified, has to be a text variable. After that, upon making a selection from the list, the window in the

form of a calendar will emerge, in which any required date can be chosen.
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Also, it is possible to form the list on the basis of materials list. Such list can be formed only for the

text variable. Upon creating the list, the window of the text editor appears, in which all materials, used

in the 3D model of the current document, are included by default. If necessary, the list can be edited

manually.

In order to edit the created list, it is necessary to use the button Edit… of the group Value List. For

each type of the list, the corresponding edit method will be called.

For removing any list of values, it is enough to put again the value No in the drop-down list of the

group List. If the list is created on the basis of database, then only connection with the database will

be broken, the database itself will be preserved.

Variable Parameters

To change the name, expression, or other characteristics of already created variables, use the Variable

Parameters dialog:
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<Ctrl>+<M> Variable > Parameters...

The Parameters command can also be called from the context menu called by  when you select a

variable in the variable list. Or, you can call it by simply pointing the cursor at the variable name in the

variable list and clicking .

After calling the command, the same dialog box appears on the screen as when creating the variable.

In this window, you can change the name of a variable, its expression, comment, and group using the

appropriate dialog fields. You can mark a variable as external or hidden (check the External and

Hidden boxes), and so on.

The Parameters command is also available when you select multiple variables at once. In this case,

when the command is called, a window appears in which a single parameter can be set for the

selected variables: a group. Choice of several variables is done by using <Ctrl>+ , <Shift>+ .

Customizing Window of Variable Editor

The appearance of the table of variables in the window of the variables editor can be customized with

the help of command:

View > Options...

Moreover, this command can be also called from the context menu at any place of the variables

editor.

After calling this command the window Options opens up. At the left pane of the window, the list of

all possible columns from the table of variables will be displayed.
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The majority of the columns correspond to some characteristic of the variable (name, type, usability,

expression, current value, and so on). The columns State and Message are used for output of system

messages about errors upon evaluation of the value of variable.

The columns displayed at the current moment are marked with a tick before the name. To add the

column into the table, it is enough to select it in the list and with the help of  put a tick before its

name. For removing a column from the table, it is sufficient to take off a tick next to its name.

In the right pane of the window Options there are other various parameters of the table of variables:

The group Number Format sets the format for the real numbers in the column Precision and Trim

Trailing Zeros.

The Save in Document option allows you to save the parameters of the Number Format group for

the current document. Thus, after transferring the document to another workplace, the user will retain

the set of previously set parameters.

The group Grid Lines defines the appearance of the grid of the table of variables:

Vertical. The appearance of vertical lines of the grid of the table: No, Small dots, Large dots, Dashed,

Solid.

Horizontal. The appearance of horizontal lines of the grid of the table: No, Small dots, Large dots,

Dashed, Solid.

Show Hidden Variables. This check box controls the display of hidden variables in the Variable editor

table.

Show Grouping Area. This parameter controls how the grouping zone is displayed above the variable

table (see below).

Syntax Highlighting. This flag controls whether color highlighting is enabled in variable expressions.

The Colors button allows you to customize the syntax highlighting colors for the following categories:
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The color for highlighting the variable name can be set in the properties of the variable itself.

Multiline Mode. Allows you to display a variable expression in multiple lines.

Show Auto-substitution List. When the flag is enabled, when the mouse cursor hovers over the

variable name or object ID, auxiliary information is displayed on the screen.

Hints are displayed only in the variable expression editing mode.
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The Font… button enables to set the font used upon displaying the table of variables in the window of

the variables editor.

The visibility of single columns of the table can be customized without calling the command Options.

To do that, it is enough to call the context menu from any place on the header of the table of

variables. Submenu Columns enables to quickly turn off/turn on the display of the columns.

The order in which the columns are displayed in the table of variables can be easily changed just by

pulling over the columns into the required places. To do that, it is enough just to bring the cursor to

the column, hit  and without releasing the mouse button, drag the header of the column to the

required place. Red arrows on the screen suggest where the column will be inserted.
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Grouping Variables

 By default, in the variables editor all variables are grouped by the characteristic Group (if this

characteristic is specified for variables of the current document). However, it is possible to use other

parameters of variables for grouping, including several parameters at the same time.

For customizing the grouping parameters it is convenient to use the grouping area. It is turned on via

the dialog of the command View > Options… or via the context menu in the header area of the table

of variables. The grouping area is situated over the table of variables. By default, the label Group is

displayed in the grouping area. This means that the variables are grouped by the characteristic

“group”.

In order to turn off the grouping, it is enough to point with the cursor at the label in the grouping area,

press  and without releasing the mouse button, drag the label to any other place outside the
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grouping area. If the label is moved to the headers' bar of the table of variables, the column with the

same name will be added to the table. If the label is moved while holding the key <Ctrl>, the label

will be copied – it will remain in the grouping area, and at the same time the corresponding column

will appear in the table.

When the mode of grouping is turned off, the message Drag Column Header here to group by

Desired Parameter is displayed in the grouping area. 

To activate the mode of grouping by some characteristic, it is enough to point at the header of the

corresponding column of the table of variables, press  and without releasing the mouse button,

drag the header of the column to the grouping area. After that, the label of the chosen characteristic

will appear in the grouping area, and the variables in the table will grouped by this characteristic. If

the headers of two columns of the table are moved to the grouping area, the grouping will be carried

out by two characteristics simultaneously. Location of the labels in the grouping area shows the order

of grouping.
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Note that upon moving the header of the column into the grouping area, the column is removed from

the table. In order to keep this column in the table, it is necessary to hold the key <Ctrl> while moving

the header. 

It is also possible to control grouping with the help of the context menu. It is sufficient to point the

cursor at the column header of the table of variables and call the context menu with the help of .

The flag Group by this Column will be accessible in the context menu. In order to activate grouping

by this column, this flag should be set on. To cancel grouping by selected column, it is enough to take

this flag off.
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Sorting Variables

In addition to grouping, for the list of variables it is possible to specify sorting by any column. By

default, the sorting is turned off. To turn it on, just move the cursor to the header of the column of the

variable table by which you want to sort the variables and click . As a result, the rows of the

variable table will be sorted by the selected characteristic.

By default the mode of sorting in an ascending order is turned on initially. Pressing  on the header

of a column repeatedly turns on the sorting in a descending order. For sorting by another

characteristic, it is enough to press  on the header of the corresponding column.

Sorting can be canceled with the help of the command Cancel Sorting in the context menu called

from the headers' bar of the table of variables (i.e. in the area of the header of any column of the

table). This command is available only when the mode of sorting is turned on. Also, in the context

menu the commands Sort Column Ascending and Sort Column Descending are available. They

activate sorting by the column for which, in the column header, the context menu was called.
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The sorting parameters are saved in the document file and restored when you re-enter the editor.

When sorting capability is turned off the user can also utilize <Ctrl>+<ArrowUp>,

<Ctrl>+<ArrowDown> to change the order of the lines in the variable editor. 

These commands are also accessible via the text menu of the variables’ editor:

The changes in the sequence of the lines are saved in the document’s file separately for the main

window of the variable editor and for the auxiliary window Variables (see Working with variable

editor in transparent mode section).

Import/Export of Document Variables

The main way of connecting T-FLEX CAD with some external procedures (especially design or

calculation programs) is to transfer parameter values. Moreover, you can both transmit data and

receive it.

This is accomplished with a ".par" parameter file.

Files of parameters can be used when you need to save several versions of the same drawing. In this

case you save several files of parameters with the values of external variables and, if necessary, read

the values from a specific file. As a result, a finished drawing with the required parameters is obtained.

It is convenient to use the files of parameters for connection of the T-FLEX CAD with other

computational software. In the system you can create a parametric drawing with certain set of

parameters. Your computational procedure receives the values of these parameters through the file.
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You calculate the remaining parameters of the drawing in your software and create either a new file of

parameters or update the old one. From the T-FLEX CAD you read the file and obtain a modified

drawing on the basis of the parameters calculated by you. Thus, the file of parameters serves as an

intermediate link for connection between the T-FLEX CAD and your software. 

Saving variables to external file

The values of variables can be written into the file of parameters by using the Save command:

After starting the command, a dialog for saving variables appears, in which you can specify the path

to save the file with parameters and export settings.

The comment is written on condition that one of the following parameters has been set on With

Expressions or With Comments.

If in the export dialog box the flag Marked Only is activated, then only external variables of the given

document will be written into the resulting file. When the flag is taken off, all visible variables are

exported. 

Hidden variables are not exported by default. In order to write them into the external file as well, it is

necessary to set on the flag Export Hidden Variables.

For example, suppose there is the following list of variables in the editor:
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When writing the file, the following parameters were set: With Expressions, With Comments. The

result should be a ".par" file with the following content (you can open it with any text editor):

b = 100; /*Width*/
a = 9; /*Length*/
c = a+b; /*Sum*/

aa = (#1+#2)*10+3; /*Function*/
$IT = "Text"; /*Text*/

f = aa(3,4)*10+200; /*Variable f*/

If you select Export Connector Values, the output file will have values added from the corresponding

column.

If you select Export Only Selected Variables, the output file will have only selected rows.

If you select Export Group Names option, the names of the corresponding groups will be added to

the file.

Loading an external variable file

The values of external variables can be read from the parameter file using the Load command:

After starting the command, a dialog for reading variables appears, in which you can specify the path

to save the file with parameters and import settings.
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Replace Comments – replaces comments when the variables in the editor and the imported file

match.

Create New Variables – adds variables that are only present in the imported file.

Only Marked Variables – only adds variables marked as external in the imported file.

Load Connectors - adds information about the connectors specified in the Connector Values option

in the variable parameters.

Group Variables - allows you to take into account the names of groups specified during export.

Diagnostics of Errors

Upon creating the new variables and also the further work with the variables, various errors can arise.

Usually these are the syntax errors in the expression of the variable. In this case, for the problem

variable the sign ! will be shown in the column State. Upon bringing the cursor to this sign, a tooltip

about the type of the error will appear. At the same time, the color of the field Value will be changed

to red manifesting the existence of the error. In addition, for the given variable a detailed description

of the arisen error will appear in the column Message (by default this column is turned off).

In spite of the existence of errors, it is possible to finish the work in the variables editor, and get back

to their correction later. The existence of errors in the variables editor does not affect the recalculation

of the 2D/3D model elements of which depend on the incorrect variables.
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If necessary, you can track the use of any variable in the model with the help of the Variable Usage

command found in the context menu of the variable. This command calls the Information window, in

which you can view a list of objects using a variable or an expression with this variable.
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The second Show variable usage command enables the highlighting of the name of the selected

variable in expressions of other variables.

Assistant Window

To specify the values of the variables, the user can use a special auxiliary Assistant window:

<Ctrl><H> View > Assistant

Assistant is used for quick insertion of functions’ names, records from the databases, variables already

existing in the document, frequently used constant, etc. into the expressions of variables.
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For convenience the contents of the Assistant is divided into several categories. The list of available

categories is displayed in the upper part of the Assistant window in the Category: field. The contents

of the category selected in the field Category is displayed in the lower part of the window. For

example, on the picture to the right the list of standard mathematical function of the T-FLEX CAD is

shown in the Assistant window. For each function there is a short description.

To insert a function (a link to a field in the database, an operation, a variable, etc.), the user needs to

select a desired category in the Assistant window, then select a required line in the category contents

list and finally press  or Insert button. The item is inserted in the main window of the variables’

editor into the space corresponding to the position of the cursor before activating the Assistant

window.

There are 5 categories in total - Functions, Operations, Variables, Databases, Constants, Favorites.

The Functions category displays a ready-made set of functions, divided into the following groups: 

· Mathematical Functions

· Trigonometrical Functions

· Special Functions

· Convertation Functions

· Text Functions

· Database Functions

All available operations are displayed in the Operations category.

The Variables category displays all the variables used in the current document.

The Databases category displays all database fields used in the current document.

The Constants category displays constant values.

You can add your own groups to the Favorites category and fill them with the required item and

comments. To do this, press  in an empty space of the window and select Insert. In the window

that appears, fill in the necessary fields and click OK.
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To successfully create a record, you need to fill in at least two fields - Group and Item.

As a result, the corresponding group with the specified item and comment will appear in the Assistant.

When working in the variable editor, the Assistant window can be permanently on the screen.

Functions for Working with Variables

There is a ready-made set of functions for working with variables in T-FLEX CAD.

Topics in this section:

· Mathematical Functions

· Trigonometrical Functions

· Special Functions

· Convertation Functions

· Text Functions

· Database Functions

Mathematical Functions

abs( ) - Return absolute value

ceil( ) - Find integer ceiling

floor( ) - Find largest integer less than or equal to argument

hypot( , )        - Calculate hypotenuse of right triangle

int( ) - Round to nearest integer

log( ) - Calculate natural logarithm

log10( ) - Calculate base-10 logarithm

max( , ) - Find the maximum value among the input set
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min( , ) - Find the minimum value among the input set

random( , ) - Return random value in given range

round( , ) - Round the first value with accuracy of the second

root( )  - Find root of given number with given degree

sqrt( ) - Find square root

All functions except hypot( , ), max( , ), min( , ), round( , ), random( , ), root( , ) have one real

argument. Any expression (including function calls) can be used in function arguments, the result of

which must be a real number.

The above functions have two real arguments, separated by a comma.

Trigonometrical Functions

acos( ) - Calculate arccosine

acosh( ) - Hyperbolic arccosine

asin( ) - Calculate arcsine

asinh( ) - Hyperbolic arcsine

atan( ) - Calculate arctangent

atanh( ) - Hyperbolic arctangent

cos( ) - Calculate cosine (angle is in degrees)

rcos( ) - Calculate cosine (angle is in radians)

rsin( ) - Calculate sine (angle is in radians)

rtan( ) - Calculate tangent (angle is in radians)

racos( ) - Calculate arccosine (angle is in radians)

rasin( ) - Calculate arcsine (angle is in radians)

ratan( ) - Calculate arctangent (angle is in radians)

sin( ) - Calculate sine (angle is in degrees)

tan( ) - Calculate tangent (angle is in degrees)

All functions have one real argument. Any expression (including function calls) can be used in function

arguments, the result of which must be a real number.

Special Functions

The following special functions are available in T-FLEX CAD:

· check(,)

· distance(,)

· distance_u(,,)

· measure(,,)

· measure_u(,,,)

· error()

· message()

· fixnodename()

· get(,)

· get_u(,)

· get_lcs(,)

· get_lcs_u(,)

· getv(,)

· setv(,)

· graph(,)

· isfragment()

· tget(,)

· switch(,,)
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· select(,)

· tgetv(,)

· tmgetv(,)

· getg(,)

· setg(,)

· tgetg(,)

· tsetg(,)

check("File name", Type)   -   Checks for the existence of a file (the file name is specified with the

extension). The file type is specified by the following values:

0 - indefinite,

1 - T-FLEX CAD system document,

2 - font,

3 - database,

4 - texture,

5 - BOM.

The search is carried out in the current directory, and then in the directories specified in the System

Options command, the Folders tab. If the specified file is found, the function returns 1, otherwise it

returns 0.

distance("Name1", "Name2")   -   Get the value of the distance between two 2D or 3D elements (the

parameters specify the names of the elements or their identifiers).

The function will be automatically substituted as expression for a variable if such variable is

created when measuring distance between two 2D or 3D elements in Measure command.

Function syntax:

· distance ("name1", "name2");

· distance ("name1", "name2", "name_LCS") - if an LCS is specified;

· distance_u ("name1", "name2", "name_unit") - if the units are specified;

· distance_u ("name1", "name2", "name_LCS", "name_unit") - if LCS and units are specified.

name1 - the name of the first element or its identifier;

name2 - the name of the second element or its identifier;

name_LCS - LCS name;

name_unit - unit name.

You can determine the distance using the distance() function for the following pairs of 2D and 3D

objects:

· 2D elements – is the distance between a 2D node and another 2D node, construction line,

graphic line or hatch (the order of selecting the measurable entities is not significant);

· 3D objects – is the distance between two arbitrary 3D objects that are 3D construction

entities (except for LCS), operations or such topological objects as an edge, loop, face, vertex.

Function distance() also measures distances for such geometrical 3D objects as vertices, edges, loops,

faces. This is possible only for already named objects. Assignment of a name (for example, "Vertex_1"

or "Edge_3") is carried out automatically in the Measure command or when using this object in any

3D operation. The name assigned to the object and must be used as its identifier when working with

the distance () function.

Distance function examples

Distance between two 3D nodes "3D Node_0" and "3D Node_1" can be measured with the following

call of distance() function:

distance ( "3D Node_0", "3D Node_1" )



Variables and Related Parametric Tools

2605

Distance between image line with ID 0x3000014 and 2D node named as "Node 1" will be returned by

the following call:

distance ( "0x3000014", "Node_1" )

Measure command is recommended for using distance().

measure("Name1", "Name2", "Ratio")   -   Get the specified ratio between two 2D or 3D objects (the

names of the elements or their identifiers and the type of the ratio are specified). 

The function will be automatically substituted as expression for a variable if such variable is

created when measuring any relation (except distance) between two 2D or 3D elements in

Measure command.

Function syntax:

· measure("name1", "name2");

· measure("name1", "name2", "name_LCS") - if an LCS is specified;

· measure_u("name1", "name2", "name_unit") - if the units are specified;

· measure_u("name1", "name2", "name_LCS", "name_unit") - if LCS and units are specified.

name1 - the name of the first element or its identifier;

name2 - the name of the second element or its identifier;

name_LCS - LCS name;

name_unit - unit name.

Function calculates the following types of relations:

for 2D elements:

"Angle" – is the angle between two lines, segments or a line and a segment.

for 3D objects:

"Angle" – is the angle between directional vectors of two 3D objects. Listed below are 3D objects, for

which a direction can be defined (and, therefore, this relation can be calculated). Additionally

specified is what will be selected as the direction vector for each object:

·  for a 3D path or open 3D profile lying on a straight line – the line direction;

·  for a 3D path or open 3D profile lying on an ellipse (circle) – the vector directed from the

center of the ellipse (circle) normal to the plane of the ellipse (circle);

·  for a flat 3D profile; workplane; an operation body consisting of one face lying in a plane –

the normal to the plane;

·  for a cylindrical worksurface; 3D profile lying on a cylinder; an operation body consisting of

one face lying on a cylinder – the axis of the cylinder;

·  for a 3D profile, lying on a cone; an operation body consisting of one face lying on a cone –

the axis of the cone;

·  for a toroidal worksurface; 3D profile or face lying on a torus; an operation body consisting of

one face lying on a torus – the axis of the torus.

"AxisDistance" – is the distance between the axis of two 3D objects. The same 3D objects can be

selected as the objects of the measurement as in the previous case (when identifying "Angle"), except

for workplanes. In the latter case, the axes of the selected objects coincide with the directional vectors

of the planes.

“DX” – Shift of two 3D nodes or 3D points with respect to each other along the X-axis;

“DY” – Shift of two 3D nodes or 3D points with respect to each other along the Y-axis;

“DZ” – Shift of two 3D nodes or 3D points with respect to each other along the Z-axis.

“Distance” – is the distance between two arbitrary 3D objects that are 3D construction entities (except

for LCS), operations or such topological objects as an edge, loop, face, vertex.

“GeomDistance” – is the distance between 3D points, 3D curves or surfaces corresponding to two

respective 3D objects of the types: 3D node, vertex, edge, face.
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“MaxDistance” – Maximum distance between two 3D objects (between two points the most distant

from each other).

“MaxGeomDistance” – Maximum distance between two geometric elements (3D points, 3D curves or

surfaces).

Analogous to distance(),  measure() can calculate relations between various topological 3D objects -

vertices, edges, loops, and faces,  if these objects have already been used in any operation and were

automatically named. 

One more additional relation  can be measured for vertices, edges and faces, as well as for a pair

"geometrical object – 3D node":

"GeomDistance" – is the distance between 3D points, 3D curves or surfaces corresponding to two

respective 3D objects of the types: 3D node, vertex, edge, face.

Input parameters for distance() and measure() functions can be specified using either small or capital

letters analogous to get() function. If an incorrect element name or relation name is input, then the

function returns 0.

Measure function examples

Axial distance between cylinder axis resulted from extrusion operation named "Extrusion_1" and torus

axis from "Rotation_2" operation can be calculated with the following call to measure() function:

measure ("Extrusion_1", "Rotation_2", "AxisDistance")

Measure command is recommended for using distance().

error(" ")   -   Display the user's message on the screen in an error warning window.

warn(" ")   -   Displays a user message in the diagnostic window, but unlike the previous command

does not interrupt the model recalculation process. An item identifier can be used instead of a name,

for example "0x01000010".

message(" ")   -   Display the user's message on the screen in a message box.
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fixnodename(n)   -   Get the name of the fragment's node used for inserting the current document as

a fragment by fixing points. This function is helpful for creating the libraries of logical and algorithmic

schemes. It helps to orient direction of connecting arrow between elements. Input parameter: the

number of the fragment's fixing point.

get("STR","P")   -   Get the value of the real parameter P of the system element named STR. Instead of

an element name, you can specify its identifier (ID). 

This function returns the value of the requested property of a 2D or 3D element, as well as the current

drawing page. Sets of accessible properties vary depending on the queried element.

The function will be automatically substituted as expression for a variable if such variable is

created when measuring properties of 2D or 3D element in Measure command.

The calling sequence:  

· get("string1", "string2")

· get("string1",…,"string1_n", "string2)

· get_u("string1", "string2","string3") – if units are specified

· get_lcs("string1", "string2","string3") – if LCS is specified

· get_lcs_u("string1", "string2","string3","string4",) – if LCS and units are specified

string1 - element name or its identifier;

string1_n - element names or their identifiers in case of multiple dimensions;

string2 – parameter name;

string3 – unit name if suffix "_u", LCS if suffix "_lcs" or suffix "_lcs_u";

string4 – unit name if suffix "_lcs_u".

Multiple dimension is valid for all types of functions: get_u(), get_lcs(), get_lcs_u(). In case of multiple

measurements, distances are measured using the get() function, with the parameter name "distance".

All 3D elements and operations are assigned Ids (unique identification numbers). They are also

assigned a Name parameter that is automatically initialized by a system default. The name can be

changed by the user if necessary. The 2D elements by default only get an Id. Names can be assigned

to some 2D elements, particularly, to 2D nodes and graphic lines. The names are assigned in the

editing commands, such as Edit Node or Edit Graphic Line, using the  option. 

The get() function allows you to get certain values of graphic items in the Variable Editor. The

elements whose parameters can be got by the described function, are:

· the drawing's 2D pages;

· construction lines;

· nodes;

· graphic lines;

· text;

· fragments;

· hatches;

· 3D elements;
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· 3D operations;

· faces, edges, loops.

This function is automatically substituted into the variable expression if the value of the selected

property is saved in the variable in the Measure command.

The following reserved names are used for the available parameters:

for 2D pages of a drawing:

"ZONES_STEP_X" - the size of one zone along X-axis (the step size along X-axis);

"ZONES_STEP_Y" - the size of one zone along X-axis (the step size along Y-axis_;

"ZONES_OFFSET_X" - the offset of the area being divided into the zones from the point (0,0) - along

X-axis;

"ZONES_OFFSET_Y" - the offset of the area being divided into the zones from the point (0,0) - along

Y-axis;

"ZONES_COUNT_X" - the number of zones along X-axis;

"ZONES_COUNT_Y" - the number of zones along Y-axis.

The parameters of dividing a drawing page into zones are defined in the command Set

Document Parameters, on the tab Paper > Zones.

for nodes:

"X" – X-coordinate of the node 

"Y" – Y-coordinate of the node

for construction lines:

lines:

"X", "Y" – the coordinates of the first node the straight construction line is passing through. 

"P1", "P2" - the coordinates of the second node the straight construction line is passing through. 

circles and ellipses:

"LENGTH" – the length of the circumferential

"P1" – the radius of the circle (this parameter is specific to circles)

"X", "Y" – the coordinates of the center of the circle

splines, 2D paths, functions and offsets:

"LENGTH" – the entity length 

for graphic lines:

segments:

"LENGTH" - the segment length

"START_X", "START_Y" – the coordinates of the start point of the segment

"END_X", "END_Y" – the coordinates of the end point of the segment

based on circles: 

"LENGTH" – the length of the circle arc;

"CENTER_X", "CENTER_Y" – the coordinates of the circle center;

"ANGLE" – the angular arc length of the graphic line;

"RADIUS" – the radius of the circle;

based on ellipses, splines, 2D paths, offsets and functions:

"LENGTH" – the entity length;

for graphic lines constructed as a circular or elliptical arc, portion of spline, 2D path, offset or

function, there are following additional parameters:

"START_X", "START_Y" – coordinates of the arc start point;

"END_X", "END_Y" – coordinates of the arc end point;

for hatches:

"AREA" – the hatch area

"PERIMETER" – the hatch contour perimeter
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"XMASS" - X-coordinate of the center of gravity

"YMASS" - Y-coordinate of the center of gravity

“XAREAMOMENT” – 1x component of inertia moment;

“YAREAMOMENT” – 1y component of inertia moment;

“PRODUCTAREAMOMENT” – Centrifugal inertia moment of area;

“XINERTIARADIUSVALUE” – Radius of inertia X;

“YINERTIARADIUSVALUE” - Radius of inertia Y;

“XAREAMOMENTMAINVALUE” – 1x component of principal moment of inertia relative to mass center;

“YAREAMOMENTMAINVALUE” – 1y component of principal moment of inertia relative to mass center;

“MAINAXESROTATIONVALUE” – Rotation angle of principal axes.

for text:

"WIDTH" – the text width

"HEIGHT" - the text height

"X", "Y" – X and Y coordinates of text fixing point;

“TEXT” – text content;

for fragments: "string 1" represents the fragment name or Id, "string 2" – the name of the fragment

variable. The function returns the value of the variable.

In addition, the following parameters are available for 2D fragments:

“BoundBoxLeft” – left coordinate of bound box (X-coordinate);

“BoundBoxRight” – right coordinate of bound box (X-coordinate);

“BoundBoxTop” – top coordinate of bound box (Y-coordinate);

“BoundBoxBottom” – bottom coordinate of bound box (Y-coordinate);

“BoundBoxCenterX” –X-coordinate of bound box center;

“BoundBoxCenterY” –Y-coordinate of bound box center.

In the three-dimensional version of the system, the following 3D element parameters are accessible:

for operations:

"AREA" – the surface area

"MASS" – the mass of the body (material density accounted)

"XMASS", "YMASS", "ZMASS" - X, Y, Z-coordinates of the center of gravity

"IX", "IY", "IZ" – the moments of inertia about the axes X, Y, Z respectively

"IXY", "IYZ", "IZX" – the products of inertia with respect to the planes XY, YZ, ZX

"VOLUME" – volume

for "Apply Material" operation the following additional parameter is used:

"MaterialArea" – total area of faces with the attached material;

for all 3D Arrays (except arrays of faces) the following additional parameter is used:

"CopyCount" – actual number of copies in the array (with account of limitations and exclusions);

for 3D nodes:

"POINTX""POINTY""POINTZ"   - X, Y, Z-coordinates of the 3D node

for a 3D profile:

"AREA" – the area of the surface surrounded by the 3D profile

"PERIMETER" – perimeter of a closed 3D profile or length of an open one

for a 3D path:

"PERIMETER" – the length of the 3D path

for a face:

"AREA" - the area of the face surface

"PERIMETER" - the perimeter of the face border

special for a flat face:

"LocationX", "LocationY", "LocationZ" – X, Y, Z-coordinates of the face's underlying plane origin

"NormalX", "NormalY", "NormalZ" – X, Y, Z-coordinates of the normal to the face's underlying plane
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"RefDirectionX", "RefDirectionY", "RefDirectionZ" – X, Y, Z-coordinates of the reference vector on the

plane (the plane vector defines the direction of the X-axis of a flat plane)

special for a cylindrical face:

"RADIUS" – the radius of the cylinder 

“Diameter” – cylinder diameter

"CENTERX", "CENTERY", "CENTERZ"   – X, Y, Z-coordinates of the center

"AXISX", "AXISY", "AXISZ"  – X, Y, Z-coordinates of the axis

for a toroidal face the following additional parameters are used:

"MaxRadius", "MinRadius" -  major and minor torus radii

"CenterX", "CenterY", "CenterZ" – X, Y, Z-coordinates of the torus center

"AxisX", "AxisY", "AxisZ" – X, Y, Z-coordinates of the torus axis

for a spherical face additional characteristics are used:

“Radius” – sphere radius

“Diameter” – sphere diameter

“CenterX”, “CenterY”, “CenterZ” – X, Y, Z-coordinates of sphere center

for an edge:

"PERIMETER" – the edge length

"STARTX", "STARTY", "STARTZ"  - X, Y, Z-coordinates of the start point

"ENDX", "ENDY", "ENDZ"  - X, Y, Z-coordinates of the end point

special for a straight edge:

"VECTORX", "VECTORY", "VECTORZ"   - X, Y, Z-coordinates of the edge direction

for a circular edge or along circular arc:

"Radius" – circle radius

“Diameter” – circle diameter

"CenterX", "CenterY", "CenterZ" – X, Y, Z-coordinate of the circle center

"AxisX", "AxisY", "AxisZ" – X, Y, Z-coordinates of the circle plane normal

"StartAngle" – arc start angle

"EndAngle" – arc end angle

special for a elliptical edge:

"MajorRadius" – ellipse major radius

"MinorRadius" – ellipse minor radius

"CenterX", "CenterY", "CenterZ" – X, Y, Z-coordinate of the ellipse center

"AxisX", "AxisY", "AxisZ" – X, Y, Z-coordinates of the normal to the ellipse plane

"MaxDirectionX", "MaxDirectionY", "MaxDirectionZ" – X, Y, Z-coordinates of the ellipse major axis

"MinDirectionX", "MinDirectionY", "MinDirectionZ" – X, Y, Z-coordinates of the ellipse minor axis

"STARTANGLE" – the start angle

"ENDANGLE" - the end angle.

for loop:

"Perimeter" – loop perimeter.

The parameter names are case-insensitive. If an incorrect element name or parameter name is input,

then the function returns 0.

Get function examples

Get the X-coordinate of a node named NODE_1 by calling the function GET () as follows,

get ( "NODE_1", "X" )

Get the length of a graphic line named IMAGE_1 as follows,

get ( "IMAGE_1", "length" )

Get the perimeter of the contour of the hatch Id 0x9000001 as follows,

get ("0x9000001", "PERIMETER")
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Get the volume of the 3D body of a 3D fragment named 3D fragment_11 as follows,

get ("3D fragment_11", "volume")

To compute the total length of a chain of connected graphic lines, one could call the function GET()

for each line and sum up the results. However, a more efficient way is to construct a 2D path that

follows along the chain of the graphic lines, and create a single graphic line from this path. In this

case, the 2D path is considered a spline. Then it is easy to get the length of this single graphic line.

Functions getv() and setv()

Functions setv() and getv() allow the user to obtain and specify the values of real service

characteristics of the T-FLEX CAD documents, such as the number of pages in the document, scale and

font size, assigned for each page, coordinates of corners of the title block, volume of all bodies in the

3D scene (if the document contains a 3D model), etc. The values of these characteristics can be used,

for example, for transferring data between the assembly drawing and the fragments.

getv("NAME",N)   -   Get the value of the service parameter of the document named NAME. Some

parameters are defined separately for each 2D page of the document. In this case, "_Page" is added to

the parameter name, where "Page" is the name of the required page of the current document. If no

page name is specified, the parameter value for the first page of the document is returned.

setv("NAME",N)   -   Set the value N for the global system parameter named NAME.

The T-FLEX CAD system defines several service parameters that affect the display of the drawing on

the screen. These parameters are:

SCALE – scale of current drawing;

XL – coordinate X of the left border of the drawing; 

XH – coordinate X of the right border of the drawing;

YL – coordinate Y of the lower border of the drawing;

YH – coordinate Y of the upper border of the drawing;

_XL – coordinate X of the left border of the assembly drawing when using the current document as a

fragment;

_XH – coordinate X of the right border of the assembly drawing when using the current drawing as a

fragment; 

_YL – coordinate Y of the lower border of the assembly drawing when using the current drawing as a

fragment; 

_YH – coordinate Y of the upper border of the assembly drawing when using the current drawing as a

fragment;

FSIZE – font size of the drawing.

LTHICK – thickness of main lines in the drawing.

TLTHICK - thickness of thin lines in the document.

EXPLODE – state of exploded view mode for the fragments of 3D model of the current document (0 –

exploded view mode is turned off, 1 – turned on).

XSIZE, YSIZE, ZSIZE – measure the overall dimensions of the 3D model along the X, Y and Z axes of

the global coordinate system.

The following group of parameters allows you to perform page numbering in the formats of a multi-

page document or specification.

APAGES - returns the total number of pages in the document containing a given fragment;

APAGE - returns the number of the page which contains a given fragment;

DPAGE – the number of the current drawing’s page;

DPAGES – total number of drawings’ pages in the document;

BOMPAGES – returns the total number of pages in the BOM of the document containing a given

fragment;
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BOMPAGE – returns the number of the page of the BOM which contains a given fragment.

getv_u allows you to return units of measurement.

The following service parameters are provided for three-dimensional models:

getv("mass",0) - mass of all bodies in the 3D scene of the current document;

getv("volume",0) - volume of all bodies in 3D scene of the current document;

getv("area",0) - surface area of all bodies in 3D scene of the current document;

In the setv function, the parameters _XL, _XH, _YL, _YH, EXPLODE, PAGES, PAGE, BOMPAGES,

BOMPAGE are not used.

In addition to these parameters, you can create your own service parameters.

The setv() and getv() functions allow you to set and receive the values of service parameters in the

variable editor, respectively.

The setv() and getv() functions can receive and set the values of parameters set in the  Set Document

Parameters command of any page. To do this, when calling this function, it is necessary to form the

name of the first operand from the old name (their list is given above), the underscore and the page

name. For example, to get the scale of the second page, you need to call the function:

getv("SCALE_Page 2",0) – returns the value of the scale specified for the page of the current

document with the name “Page 2”. If this page is absent in the document, the function returns the

value “1”;

getv("mass",0) – returns the value of mass of all bodies in the 3D scene of the current document. If the

3D scene is empty, the function returns the value “0”;

setv("SCALE_Front_0",2)

If the page name is not specified, the parameter value for the first page of the document is returned.

Function syntax:

getv("NAME",N) 

This call means: get the value of the service parameter of the system, where NAME is the name of the

service parameter, N is the value that the function will return if it does not find the specified

parameter.

You can get the value of any drawing parameter set by the setv() function.

setv("NAME",M) 

This call means: set the value of the service parameter, where NAME is the name of the service

parameter, M is the value that will be set for the specified parameter. A variable or an expression can

be used as M.

If you specify a new name, the system will create a new service parameter for the current drawing.

Service parameters can be used when transferring values between an assembly drawing and its

component parts (fragments). 

For example, in an assembly drawing, you use function

setv ("TMP", 50)

to create a service parameter TMP with a value of 50, and in fragments, using function

getv ("TMP", 0),

you get the value of the service parameter TMP equal to 50.

graph("Graph name",X) - Get the value of the function F(x), corresponding to the value of the X

argument, for a graph named Graph name.

isfragment( )   -    Get a sign of using a drawing as a fragment. This function returns the value 0 if the

drawing is current (loaded for editing), 1 if the drawing is a fragment of the first nesting level, 2 - of

the second, etc.

The function is convenient if you need to extinguish any elements of the drawing when using it as a

fragment.
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tget( , )   -   The function allows you to get the text properties of elements: the name of the material of

3D operations, the values of the text variables of the fragment.

$text = tget("0xD000001","$razrab") – get the surname of the developer of the drawing.

$mater = tget("Extrusion_1","Material")  – defining the material for the "Extrusion_1" operation.

switch(Condition, Value1, Result1, Value2, Result2, … , Default result)   -   The function is used to

select a value option by one condition.

The result will be accepted as the value of the variable, the value of which corresponds to the

condition.

select(Condition1, Result1, Condition1, Result2, … , Default result)  -   The function is used to select a

value option for several conditions.

The conditions and results that will be specified if the condition is met are listed separated by

commas.

The result of the first fulfilled condition, or the default result, will be accepted as the value of the

variable.

If none of the listed options is suitable, and the default value is not set, the value of the variable will

be zero.

tgetv( , )   -   This function is intended to get the value of text system variables or characteristics of the

current drawing.

The function has two parameters. The first parameter is a text value. The second parameter is

responsible only for the date/time output format for the parameters "PRINTDATE", "CREATEDATE",

"SAVEDATE".

Calling example:

$TIME = tgetv ("TIME")

$TIME= tgetv ("CREATEDATE", "yyyy:MM:dd  hh:mm:ss")

The first parameter of the function can be one of the reserved values:

"USER

NAME"

Name of current user of the system;

"YEAR" Current year

"MON

TH"

Current month (number)

"DAYO

FWEEK

"

Current day of week (number);

"DAY" Current day of month (number);

"HOUR

"

Current hour;

"MINU

TE"

Current minute;
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"USER

NAME"

Name of current user of the system;

"SECO

ND"

Current second;

"DATE" Current date (the name) in accordance with system’s current settings;

"TIME" Current time in accordance with system’s current settings;

"REGN

AME"

User name on whom the system is registered;

"REGC

OMPA

NY"

Name of company on which the system is registered;

"TITLE" Title of current drawing;

"SUBJE

CT"

Subject of current drawing;

"AUTH

OR"

Name of author of current drawing;

"KEYW

ORDS"

Keywords of current drawing;

"COM

MENTS

"

Comment of current drawing;

"TEMP

LATE"

Template of OLE document;

"LASTA

UTHOR

"

Name of author who last saved the drawing by;

"REVN

UM"

Number of revision of current drawing;

"EDITTI

ME"

Total editing time of current drawing;

"PRINT

DATE"

Date of the last print of current drawing;

"CREAT

EDATE

"

Date of creation of current drawing;

"SAVE

DATE"

Date of last save of current drawing;

"FILEN

AME"

Name of current file (the returned line contains full path to current document and the file

name with extension);

"SHOR

TFILEN

AME"

Name of current file (the returned line contains the file name only);

"FORM

AT"

Title block of current drawing;

"SCALE

"

Scale of current drawing;

"SCALE

VALUE

Scale of the current drawing (the returned string contains the value of the scale without the

letter М);
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"USER

NAME"

Name of current user of the system;

"

"_FOR

MAT"

Title block of current drawing;

"FORM

AT_BO

M"

Returns the format of the first page of the "BOM" type. If there is no such page, it returns the

format of the first page;

"_SCAL

E"

Scale for the drawing of the page on which the current fragment is inserted;

"_SCAL

EVALU

E"

Scale of the current drawing (the returned string contains the value of the scale without the

letter М);

"PAGE

NAME"

Name of the page on which the current fragment is inserted;

"PAGE

TYPE" 

Type of the page on which the current fragment is inserted.

The second (optional) parameter of the function can be one of the reserved values:

"d" Day of the month without zero at the beginning;

"dd" Day of the month;

"ddd" Abbreviated name of the day of the week;

"dddd

"
Full name of the day of the week;

"M" Month without zero at the beginning;

"MM" Month;

"MMM

"

Abbreviated name of the month;

"MMM

M"

Full name of the month;

"yy, y" Last two digits of the year;

"yyyy,

yyy"

Year;

"h" Clock in 12-hour format with no zero at the beginning;

"hh" Clock in 12-hour format;

"H" Clock in 24-hour format with no zero at the beginning;

"HH" Clock in 24-hour format;

"m" Minutes without zero at the beginning;

"mm" Minutes;

"s" Seconds without zero at the beginning;

"ss" Seconds;

"t" Abbreviated designation of the part of the day (before or after noon) for the 12-hour format,

if there is one in the current system language;

"tt" Full designation of the part of the day (before or after noon) for the 12-hour format, if there is

one in the current system language.
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Extra characters in the parameters are ignored (for example, "ss" and "sssssss" will give the same

result), the remaining characters are copied without changes. If there are single quotes or parameter

letters in the text to be copied to the result, then it must be enclosed in single quotes, and to copy the

quotation mark itself, you need to write two in a row.

tmgetv( )   -   This function works similarly to the tgetv function, but to get the values of the system

variables of an assembly drawing in the case of using the current drawing as a fragment.

Functions for global variables

To access the values of global variables of real type, the following functions are used:

getg("NAME", N)  - get the value of the global variable of the system (NAME is the name of the

global variable, N is the value that the function returns if the variable "NAME" is not found).

setg("NAME", N) - set the value N for the global system variable named NAME. If a variable with the

specified name does not exist, then it will be created.

To access the values of global variables of a text type, the following functions are used:

tgetg("NAME", STR)  - get the value of the global system variable (NAME is the name of the global

variable, STR is the text string (the name of the text variable), which the function returns if the "NAME"

variable is not found).

tsetg("NAME", STR) - set the STR value for the global system variable named NAME. If a variable with

the specified name does not exist, then it will be created.

The second parameter can be a variable name or an expression.

In addition to using functions to set the value of global variables, you can call the Parameters >

Global Variables command (the Edit option allows you to change the name, value, and type of the

selected variable).

For example, in one document, you use the function...

setg ("TMP", 50) 

...create a global TMP variable with a value of 50, and in other documents using the function...

getg ("TMP", 0) 

...get the value of the global variable TMP equal to 50.

Convertation Functions

angle(45, 10, 15)   -   Forms the decimal value of an angle from degrees, minutes, seconds, or from

degrees and minutes. Those. the function has three or two arguments.

atof("0.25")   -   Convert string "0.25" to real number 0.25.

ftoa(0.25)   -   Convert real number 0.25 to string "0.25".

This function can contain the format of the returned record, for example:

ftot(0.25)   -   Convert real number 0.25 to string "0.25" using comma instead of period.



Variables and Related Parametric Tools

2617

ftot_u(0.25, "mm")   -   Convert a real number 0.25 to the string "0.25" using a comma instead of a

period in the specified units.

atot( )   -   Convert the angular value of a function parameter to a text string.

Function call syntax:

atot (angle, accuracy, standard, number), where

· angle - the real value of the original angle

· accuracy - the precision with which to convert the value

· standard - angle form; can take the following values:

· 1 - decimal form, e.g. 1.123

· 2 - in the form of degrees, minutes and seconds, for example 1 2'30 "

· number - the number of significant digits after the decimal point in decimal notation

Example:

$text1 = atot(1.1234,0.001,2,6)

$text2 = atot(1.1234,0.001,1,6)

After calculation, $text1 is 1 7'23 "and $text2 is 1.123000

ltot( )   -   Convert the linear value of a function parameter to a text string.

Function call syntax:

ltot (length, accuracy, standard, number),

where

· length - is a real value of the original length

· accuracy - the precision with which to convert the value

· standard - form of representation of length; can take the following values:

· 1 - decimal form, e.g. 1.123

· 2 - in the form of inches

· 3 - as inches and fractions

· 4 - as feet, inches and fractions

· 5 - decimal form (separated by commas), for example 1.123

· number - the number of significant digits after the decimal point in decimal notation

satot( )   -   Converts a real number of an angular value into a string of text.

The conversion parameters are defined by the settings of the Set Document Parameters command on

the Dimensions tab.

The function satot( ) specifically uses the definitions from the Angular Dimensions group. Suppose,

the following parameters are defined in the Set Document Parameters command. 

In this case, calling satot(120.34567) leads to the following result: 12%%d30'

The character combination %%d stands for the degree symbol (°).
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In order to realize this character combination as the degree symbol, the variable must be used as a

parameter of some detailing element, such as a text (string text only), dimension, leader note, etc.

Let's clarify the above on the following example. Suppose, the following value is assigned to the

variable $str by the function call:

$str = satot(120.34567) = 120%%30'

We will then create a dimension with the "Before" string containing the variable in braces instead of

the default. The following result will then be displayed:

         

The variables that are assigned return values of such functions can also be entered (in braces) in string

text. Such text will then be correctly displayed as well.

Modifying the Units parameter in the command Set Document Parameters as shown leads to the

following result:

satot(120.34567) returns  ®  120.5%%d

The Accuracy parameter allows controlling the accuracy of the returned result:
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satot(120.34567) returns  ®  120%%d21ў

The Minimum Digits parameter is used only for decimal representation:

satot(120.34567) returns  ®  120.500%%d

The function sltot( ) differs from the previous one only in that the value to be converted is considered

a linear value. Therefore, the conversion formats change accordingly. There are four standard formats

for this function:

1 – decimal format. Example: 1.123;

2 – in inches;

3 – in inches and fractions; 

4 – in feet, inches and fractions. 

The following settings showing in the pictures result in: sltot(120.34567) returns ®  120.35

Text Functions

strlen("String1")   -   Get the value of the length of the string "String".

tfind("String1", "String2")   -   Search for substring "String2" in string "String1". Returns an integer

value equal to the number of the first occurrence of the substring, starting from 1. In case of an error

(the substring was not found), the value 0 is returned.

trepalce("String1", "String2", "String3")   -   Replacing the substring "String2" with the substring

"String3" in the string "String1". Returns the text value, with the replaced value.

tword( )   -   This function allows you to get a word from a sentence.

The function takes two parameters: the first text parameter is the original sentence, the second real

parameter is the number of the word to be received.

Example:

$NAME = tword ("Queen Elizabeth II ", 2)

In this case, the $NAME variable will be assigned the value "Elizabeth".

tpart( )   -   This function allows you to get part of a string.

It takes three parameters: the first is textual - the original string, the second integer is the number of

the starting character of the substring to be obtained, the third integer is the number of characters to

be included in the substring.

Example:

$date = tpart ("24.02.97",1,2)
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In this example, the variable $date will be set to "24".

reverse("str")   -   Reflects a string or number in reverse order.

Any number or string can be directly placed in the reverse() function.

You can specify a variable whose value will be reflected.

The type of the variable must match the type of the value.

Database Functions

The functions for working with databases are divided into functions for selecting values from internal

and external databases.

Functions for selecting values from internal databases

Before describing the functions of selecting values from internal databases, it is necessary to explain

how you can refer to a specific field in the database. 

The syntax for accessing a database field is as follows:

<base name>. <field name>

For example:

base.field_1

The base.field_1 entry means that you need to refer to the field_1 field in the base database.

There are several functions for selecting values from the internal database (database by reference).

rec(condition), 

where condition is an expression that evaluates to true or false. The expression can contain references

to database fields as operands.

For example:

rec(BASE.F1 > 10 && BASE.F2 < 5)

Such a function call means: searching for a record number in the internal BASE database that meets

the following conditions: the value of the F1 field in this record must be greater than 10 and (&&) the

value of the F2 field is less than 5. The search starts from the first record. If a record does not meet the

specified condition, then the next record is taken. If there is no record in the database that meets this

condition, then the function returns 0, otherwise - the number of the found record. The syntax of the

condition is fully consistent with the syntax of an arithmetic expression. Instead of the "&&" operator,

you can use the "," sign. Therefore, the function call can be written differently: 

rec (BASE.F1 > 10, BASE.F2 < 5)

With this record, the function works faster because if the first condition is false, then the second

condition is not evaluated. It is also recommended that when accessing the database in the first

condition, use a field whose value is different for different records.

For example, consider a BASE database with fields F1 and F2:

F1  F2

 1  6

 2  6

 3  6

 4  6
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 5  6

Function call:

rec(BASE.F1> 4, BASE.F2 == 6)

will run faster than the following:

rec(BASE.F2 == 6, BASE.F1> 4)

frec(argument_1, argument_2, argument_3, argument_4)   -   Get the number of the record, the value

in the specified column of which most closely matches the one specified in the call of this function,

where 

· argument_1 is the column in the database for which the search is performed (necessarily of real

or integer type);

· argument_2 is the desired value;

· argument_3 is the search criterion. Possible values:

· 0 - the nearest value is found;

· -1 - the nearest lower value is found;

· 1 - the nearest higher value is found.

· argument_4 is a parameter indicating the ordering of data in the column being searched for.

Possible values:

· 0 - the values are arranged in an unordered manner and the search is carried out in all

records of the base;

· 1 - the column is ordered in ascending or descending order. As soon as the difference

between the desired value and the value in the current column of the base is greater than in

the previous one, the search stops.

The parameters argument_3 and argument_4 are optional. If they are not specified, then the default

values are used.

· argument_3 = 0 (search for the nearest value);

· argument_4 = 0 (unordered column).

For example, frec(BASE.F1, 2.5, 1, 1) 

This call means: get the number of the record for which the F1 field contains the nearest higher value

than 2.5 (the values in the F1 column are ordered). For our example, the function will return 3.

If there is no record in the database that satisfies the search condition, the function returns 0. For

example, frec(BASE.F1, 0.5, -1, 1).

val(record_number, database_field, offset)   -  Get the value of the field from the record with the

specified number, where

· record_number - any arithmetic expression whose value is an integer,

· database_field - referring to the field,

· offset (optional) - the number of the column from which the value will be selected. The number is

counted from the field specified by the second parameter. The offset can be set by a variable, it can

take both positive and negative values. If the offset value is 0, then the function returns the field

specified by the second parameter. The same will happen if the third parameter is not used.

Examples:

val(4, BASE.F2)

This call means: select the value from line 4 from the F2 field of the BASE database.

val(4, BASE.F2, 3)

This call means: select the value from line number 4 from the field, the third to the right relative to the

field F2 of the BASE database.

val(n, BASE.F2)

val(n<1?error("record_number < 1"):n,BASE.F2)
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If there is no record with the specified number in the database, then the function displays the error

message "Invalid record number".

Erroneous calls to the val function can be monitored without calling it. To do this, write the following

line in the variable editor:

n<1 >  > n>BASE.#? error("wrong number n"):val(n,BASE.F2),

where BASE.# - special designation of the number of records in the BASE database.

find(database_field, condition)   -   Function returns the value of the specified field "database_field"

from a record that satisfies the condition. If such a record does not exist, the function returns an error

message Invalid record number.

This function is the union of the val() and rec() functions.

Examples:

find(BASE.A, BASE.F1 > 4)

find(BASE.A, BASE.F2 == 6 && BASE.F1 > 4)

Functions for selecting values from external databases

dbf(arg1, arg2, arg3)   -   Allows you to select data from external dBASE databases, where 

· arg1 is the name of the database. The database name can be specified as a text constant,

variable, or expression.

· arg2 is the name of the field from which to select. The data field name can be specified as a text

constant, variable, or expression.

· arg3 - selection condition. When setting a condition, you can use text constants, variables and

expressions.

For example:

dbf("DBF_NAME", "COL1", "COL2 == 30")

This means: select a value from the DBF_NAME database from the COL1 field, provided that the value

of the COL2 field is 30.

Examples:

dbf($NAME, "COL1", "COL2 <= {GRM_VAR}")

dbf($NAME, "COL1", "TEXT = \"GRM_TEXT\"")

dbf("<*>DBF_NAME", "COL1","COL2 > 30")

In the last example, the database name can be preceded by a sequence of characters <*>. It means

that the database with the name DBF_NAME will be searched for in the same directory as the drawing.

That is, when changing the path, you will not need to change the name of the database in the Variable

Editor in all calls to the dbf () function.

It is recommended that when creating drawings related to external databases, specify the database

name using the "<*>" character sequence. This will make it easier for you to work with these drawings

later.

The filter condition when calling the dbf() function is a boolean expression that corresponds to the

filter concept in a classic relational database. Condition (filter) syntax conforms to dBASE

requirements. Its constituent parts can be database field names, constants, logical and arithmetic

operations, dBASE functions. In addition, the filters can use T-FLEX CAD system variables, as well as

Variable Editor logical operations. When variables are used in a filter, they are enclosed in curly

braces.

The return type of the function corresponds to the type of the database field and can be either text or

real.
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Due to the slower process of retrieving information from an external database, use the dbf( )

function only in cases where it is impossible to use the database by reference based on the "*

.xls" and "* .txt" formats.

The dbfwin() function has the same parameters as the dbf() function. This function is used for the

correct reading of Russian-language texts (transcoding the text into Windows format).

mdb (arg1, arg2, arg3, arg4, arg5)   -   Allows you to select data from external databases in MDB

format. where 

· arg1 is the name of the database. The database name can be specified as a text constant,

variable, or expression.

· arg2 is the name of the table in the database. Can be specified as a text constant, variable, or

expression.

· arg3 is the name of the field from which to select. The data field name can be specified as a text

constant, variable, or expression.

arg4 - selection condition. When setting a condition, you can use text constants, variables and

expressions.

arg5 is the value returned if no entry with the specified condition was found. The value can be either

textual or real, which is defined by the user, and must correspond to the type of the variable. This

parameter is optional.

For example:

mdb("C:\\Example\\T-FLEX_USER.mdb", "USER", "Name", "Code={code}")

or

mdb("T-FLEX_USER.mdb", "USER", "Name", "Code={code}", "Not found").

This means: select the value from the USER table of the T-FLEX_USER database from the Name field,

provided that the value of the Code field is equal to the value of the code variable (in our case, 15).

The second option adds a fifth parameter that returns the value "Not found" if there is no value 15 in

the Code field. If the database file is located in the same folder with the T-FLEX file, then you do not

need to specify the full path to the file.

It should be noted that the fourth operand of the function, which specifies the condition for selecting

records, can be written in the form of an SQL query and must correspond to the "WHERE" clause of

the "SELECT" command. If text variables are used when writing a condition, the expression will look

like this:

mdb("С:\\T-FLEX_USER.mdb", "USER", "Name", "Position=\"{$Pos}\""). 

Due to the slower process of obtaining information from an external database, use the mdb()

function only in cases where it is impossible to use the database by reference based on the "*

.xls" and "* .txt" formats.

Functions for working with ranges of cells in databases

Functions for working with ranges of cells should be used when working with databases requires

functionality similar to the functionality of a spreadsheet, for example, in Excel.

db_sum(interval)   -   Calculates the value of the sum of cells in an interval.

db_mid(interval)   -   Calculates the average of the cells in an interval.

db_max(interval)   -   Calculates the maximum cell value in an interval.

db_min(interval)   -   Calculates the minimum cell value in an interval.
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The interval can be set as follows:

1. Specifying the name of the database column. In the picture below, the sum and the average value

for the column are calculated.

2. Specifying the name of the column and the initial line number. The picture below calculates the

sum and the average for column "aa" starting from the second row.

3. Specifying the start and end of the line. In the picture below, the sum and average value from the

1st to the 4th row is calculated. 

Variables Window

Working with Variables Editor in Transparent Mode

To work with the variables editor in the transparent mode (while working simultaneously in the

drawing or 3D model window), the service window of the system Variables can be used. Similar to

other service windows of the system, the window Variables can operate in floating and popup mode.

Also it can be placed along one of the sides of the main window of the system.
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By functionality the window Variables duplicates the main window of the variable editor. But the

textual menu and the toolbar are absent in the Variables window. All operations with the variables in

the Variables window can be carried out only with the help of the context menu and hot buttons. Such

simplification of the interface is completely compensated for by the transparent operation with the

variables. With the help of the Variables window, it is possible to edit variables while being in any

command. Upon changing the expression of the variable in the Variables window, automatic

recalculation of the drawing (or 3D model) is carried out. All changes are immediately displayed in

the window of the system.

External Variables

For editing variables, marked as external, besides the variables editor, the External Variables

command can be used.

Calling the command:

Icon Ribbon

Parameters > GUI Control > External Variables

Keyboard Textual Menu

<M> Parameters > External Variables

External variables are usually widely used in the T-FLEX CAD documents for organizing parametric

connection between assembly document and fragments, and also for organizing connection of the T-

FLEX CAD with other systems and applications.

In contrast to the variable editor, only those variables of the current document which are marked as

external are displayed in this command. This command does not allow a user to create new variables.
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Thus, if there are no external variables in the drawing, the message No external Variables is produced

and the command is not called.

The kind of the dialog box used in this command depends on the attribute setting External Variable

Editor in the command Set Document Parameters (the External Variables tab). This attribute can

assume one of the following settings:

· Internal Editor.

· External Program. In this case, the appearance of the dialog box is defined by the external

custom application;

· Control. The user might have created a custom dialog box using interface elements (see the

Control Elements chapter). In such a case, calling the command External Variables brings up

this dialog box.
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The External Variables command can be used for modeling the process of editing external variables

of the fragment in an assembly. One more possible way of using this command – when too many

expressions are specified in the current drawing. In this case it is possible to mark the variables on

which the remaining variables depend as external ones, and, if necessary, modify their values in the

external variables editor.

Upon changing the values of the external variables with the help of the command External Variables,

only constants can be used as admissible values of variables.

After completing the command, all variables are recalculated per the changes to the external

variables, and the drawing is regenerated with the new parameters.

Topics in this section:

· Rules for Working with External Variables

· External Fragment Variables Editor

· External Variables Manipulators

Rules for Working with External Variables

An expression of an external variable can only be a constant. The variable is marked as external in the

variable editor using <Ctrl><D>. However, if the variable is not set as a constant, it will not be marked

as external. Usually all other variables depend on external variables. The dependency is defined by the

formulas that you enter in the Expression column. When you change the values of external variables,
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the values of the other variables are calculated, and the drawing changes after you exit the Variable

Editor.

External variables are the main link between the T-FLEX CAD system and other systems and

applications. You can write external variables to an ASCII file in the Save parameters command and in

the variable editor using <Ctrl><W>, read them from the ASCI file in the Load parameterscommand

and in the variable editor using <Ctrl><R>.

External variables also serve to organize a parametric relationship between the main drawing and

parametric fragment drawings.

External variables for fragment drawings are written to the Assembly Drawing structure file in the

Report command and are read when the assembly drawing is automatically generated from

fragments.

When creating new variables as parameters of certain graphical elements of the system, you can visit

these variables as external ones.

To edit external variables, use the External Variables command. You can assign editing tools for

external variables.

To do this, in the Set Document Parameters command, under the External Variables tab, select one of

the following parameters:

· internal editor (called the t-FLEX CAD variable editor).

· external program (the user-specified software tool is called).

· control (calls control dialogs created by the user on the specified drawing pages).

External Fragment Variables Editor

The option  opens a dialog box for setting values to external fragment variables. It is available in

the Inserting fragment into Drawing - 2D fragment, 3D fragment - 3D fragment when drawing an

assembly element, or in the context menu for an existing assembly element.

Depending on the set value of the External Variable Editor parameter of the Set Document

Parameters command (the External Variables tab) in the fragment document in the assembly, this

option will call the built-in variable editor, an external program, or a user dialog created using control

elements.

The internal variable editor contains a window with a list of the fragment's external variables. The

editor window consists of three columns.

Name. Displays the name of the marked (external) variable. The field is not editable.

Comment. It displays a comment on the variable. The comment is set in the Variable Editor command.

The field is not editable.

Value. You can change the value of an external variable.

Available option:

<Ctrl><R> Read parameters.

<Ctrl><W> Write parameters.

<Up>  Move row up.

<Down> Move row down. 

<PgUp> Next page.

<PgDown> Previous page. 

<Ctrl><PgUp> Move to the top of the list. 

<Ctrl><PgDown> Move to the end of the list. 

<Ctrl><Z> Save changes and exit. 

<Esc> Exit without saving.

The list of variables parameter becomes available if there is a fragment of the user's dialog in the

document. If this flag is set, the built-in external variable editor works, otherwise the user dialog works
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(described below). When the View flag is set, the window displays an image of viewing the contents

of the fragment document.

When drawing a 2D fragment, the Page fields are added to the external variable editor window

(selecting the drawing page whose contents will be applied to the assembly drawing as a fragment),

and the Fixing Vector (selecting the binding vector used when inserting the fragment). When you

change the values of the fragment's variables, the preview window is updated automatically.

The user dialog must be created in the fragment document using controls (the Control command).

This dialog appears instead of a list of variables and can consist of multiple bookmarks or contain

nested dialogs.
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External Variables Manupulators of 3D Fragment

Calling the command:

Icon Ribbon

Parameters > Tools > Manipulators

Keyboard Textual Menu

<3CV> Parameters > Manipulators

To specify the values of external variables of a 3D model, the user's draggers can be created.

Manipulators are created using the Parameters > Manipulators command.
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Manipulators of external variables can be used in two ways:

· to change parameters of the model in the scene;

· to change values of external variables on the fragment upon insertion of the model into the

assembly.

To create manipulators it is required that the external variables that control parameters of the given

model be present in the current 3D model.

In order to show or hide the manipulators in the scene, you need to use the corresponding command

in the View toolbar:
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Creating manipulator

In this command it is possible to add new manipulators, remove existing ones, change manipulator’s

description. Creation of the following types of manipulators is possible:

· linear manipulator – arrow the length of which is equal to the variable’s value;

· radial manipulator – ring the radius of which is equal to the variable’s value;

· diametrical – ring whose diameter is equal to the variable’s value;

· angular manipulator by three points and  angular manipulator by axis and initial point – a

segment of a circle whose angular dimension is specified in degrees and equal to the

variable’s value;

· list – for external variable the list of admissible values is available. The list can be tied to an

arbitrary point on a 3D model. Manipulator of this type is shown as a small ball and upon

pressing on this ball the list for variable’s value selection will appear.

When calling the Parameters > Manipulators command the list of already existing in the given

document manipulators is displayed in the properties window. If there are no manipulators in the

document yet, the list will be empty.

To create a manipulator ,the cursor has to be placed over the line   in the list, and afterwards

parameters of the manipulator must be specified in the fields below.

Manipulators already created in the document are displayed in 3D window with a gray color. In order

to edit the parameters of already existing manipulator, it is required to select it – with the help of 

in 3D window or in the list of the properties window. The selected manipulator is highlighted in 3D

window with a color (by default – red color). 
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Variable section

List for manipulator’s type selection:

· Linear

· Radial

· Diametrical

· Angular by three points

· Angular by axis and initial point

· List

Field for specifying the manipulator’s name. The name (text string) can be typed manually. Also it

can be specified automatically based on the name of external variable with which the given

manipulator will be linked. For this case, it is required to leave the field empty. After selection of the

variable from the list below, the system itself will fill in this field according to the format Variable’s

value“Variable_name”.

List of external variables of document – allows us to indicate the external variable whose value will be

controlled by the manipulator being created.

Hide. This flag allows us to control manipulator’s visibility on the screen. As a value for this parameter

it is possible to use the real variable. Manipulator will be hidden if the value of the variable is not

equal to zero.
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Parameters of the Scroll step group specify the step with which the manipulator’s value changes: 

· By default – the step is selected automatically depending on the scene’s scale;

· Value (the user can specify the exact value for the step); 

· By list of values (the list is generated by the user).

Parameters of the Range group specify the limits for the change in the manipulator’s value and scale:

· Limit at the beginning. This parameter allows us to specify the minimum admissible value of

the manipulator;

· Limit at the end. This parameter allows us to specify the maximum admissible value of the

manipulator;

· Multiplier. With the help of this parameter the coefficient by which the manipulator’s value will

be multiplied can be specified.

Manipulator’s visualization section

In the command’s parameters window there is additional section with the manipulator’s visualization

parameters:

 

Size. Size of the manipulator in 3D scene. This parameter affects only the manipulator’s visualization;

Colors/Draw. The color with which non-active manipulators will be drawn in 3D scene;

Colors/Selection. The color with which the manipulator will be drawn in 3D scene when the cursor

comes near the manipulator;

Colors/Active. The color with which the active manipulator will be drawn in 3D scene;

Radius from a point. This parameter is available only for the angular manipulator and specifies the

radius of the manipulator’s arc. By default this flag is enabled, the radius is determined automatically

by the points specified by the user (when defining manipulator’s geometry). When this flag is disabled,

the radius value can be specified manually.

Geometrical parameters of the manipulator are specified with the help of the options of the

automenu. The set of these options is different for each type of the manipulator.

For a linear manipulator:

<A> Select axis of manipulator 

<F> Select start point of manipulator

<S> Select end point of manipulator

These options allow us to specify the image of the manipulator in 3D scene by two ways – either to

specify the initial and final points of the manipulator’s vector or to select a 3D object that is capable

of defining the manipulator’s vector.
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For radial and diametrical manipulators:

<A> Select axis of manipulator 

<F> Select start point of manipulator

<S> Select end point of manipulator

These options allow us to specify the axis of the circular manipulator either by specifying two points

or by selection of a 3D object capable of defining the axis entirely. The radius of the manipulator will

correspond to the value of the variable linked with the manipulator.

For angular manipulator by three points:

<1> Specify first point of arc

<2> Specify second point of arc

<3> Specify third point of arc

The arc of the angular manipulator of the given type is determined by three points: central point of an

arc (selected with the help of the  option), initial point of the arc (the  option) and final point

of the arc (the  option).

For angular manipulator by axis and initial point:

<A> Select axis of manipulator 

<F> Select start point of manipulator

<S> Select end point of manipulator

<B> Select initial point of rotation

For the angular manipulator of the given type it is required to specify the manipulator’s arc axis – by

selection of two points (the  and  options) or one 3D object (the  option). After the axis

has been specified the initial point of the manipulator’s arc must be specified. The arc length will be

determined by the system automatically based on the value of the variable linked with the

manipulator.

For manipulator of the type “List”:

<B> Select point

This option allows us to indicate a 3D point in which manipulator in the form of a small ball will be

created.
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To complete creation/editing of the manipulator it is required to press  after all parameters have

been specified.

Using manipulators

When using manipulators, i.e. when changing the values of model variables using manipulators, an

additional control appears in the filter toolbar – to set the exact numeric value of the manipulator.

See also:

· External variables manipulators of 2D fragments

Global Variables

Global variables are created by the Global Variables command.  The command is called by one of the

following means:

Icon Ribbon

Parameters > GUI Control > Global Variables

Keyboard Textual Menu

<SG> Parameters > Global Variables

A global variable is a named value of one of the two types: text (string) or real. Global variables are

accessible for editing in the variable editor or via the special functions across all currently open

documents. The list of global variables and their values are saved automatically upon exiting the

application (in the registry) and are restored upon launching the application.

The Global Variables command is used to set global variables and their values. As mentioned above,

the list of global variables and their values is common for all documents used in one workstation of

the T-FLEX CAD system. When the command is called, a window appears containing a list of existing

global variables. The graphical buttons New, Edit, Delete allow you to make changes or add to the list

of global variables.

To create a new global variable, click the corresponding button and specify the name, value and data

type (real, text).
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To change the set values for the selected variable, click the Edit button.

To delete a variable, select the corresponding line in the list and click the Delete button.

The created global variables will be stored until you delete them or until you update the system

settings (global variables are stored in the system registry).

In any dialog where variables are allowed, or in the variable editor, you can get the value of a global

variable by accessing it using the getg() or tgetg() function (for text values). You can set the values ??of

global variables using the setg() and tsetg() functions. The syntax of the functions is described in the

Functions for Working with Variables section.

If the drawing, in which the global variable was created using one of the setg() or tsetg() functions, is

opened on another computer, then the same global variable will be automatically created at the new

workstation.

It should be noted that global variables can be used, for example, to automatically generate

documentation for a drawing. Let's say the user creates a global variable - the last name of the

developer. In the title block of the format template, using the described functions, you can set the

reading of the value of this variable. Thus, when inserting the formatting, part of the stamp will be

filled in automatically.

For example: in the variable editor of one of the drawings, create a new variable of the appropriate

type (real or text) and enter a function there that allows you to read a global variable of this type.

If a global variable with the specified name ("number") is present on this computer, then its value will

be displayed in the field of the Value column. If the specified global variable is not found, then the

value specified after the comma will be displayed in the field of the Value column.

In addition, a global variable can be created or changed its value in the usual variable editor or in any

dialog where the use of variables is allowed. The functions are intended for this:

setg("Name", N) - sets the value of a real global variable;
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tsetg("Name", N) - sets the value of the text global variable.

In this case, the first operand is the name of the global variable, and the expression after the comma

determines the value of the global variable.

For example: in the variable editor, create a new variable ("var_2") and enter a function to set the

value of the global variable.

If a global variable with the specified name already exists, then its value will be changed.

If a variable with the specified name does not exist, then it will be created and will appear in the main

window of the global variables dialog.

If the drawing, in which the global variable was created using one of the setg or tsetg functions, is

opened on another computer, then the same global variable will be automatically created at the new

workstation.

Adoption Variables and Databases

There are two ways to work with assembly document and fragment document variables:

· variables are stored only in the corresponding build or fragment file. To change this variable

value in the build and in the fragment, the user must change the variable in the specific

fragment file.
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· adopting variables. You can create a document that stores all variables and databases. The

document you need to add all the documents in which the variables and the database will be

used.

The user can choose which variables to adopt for each file. These variables can be used as normal

fragment variables when creating the geometry. In this case, you will need to change the variables in a

single file.

To adopt data from a fragment, use a special command in the context menu of the selected fragment.

A window is called where you can specify which variables and databases will be used in the assembly.
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All selected variables are added to the variable editor.

In addition, you can adopt variables directly from the variable editor: the Adopt Variables command

must be called from the context menu of the variable editor.

Variables can be adopted from the same fragment with different values of external variables. For

example, if the same bolt fragment is inserted into the assembly, but with different diameters and

lengths.

For this type of adopting, you need to set a suffix when adopting variables from a fragment. This suffix

will be added to all adopted variables after the "@" symbol.

Use the Open Source Document option to open the fragment from which the variable was borrowed.
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If you call the Cancel Adopting option, you can break the link between the variable and the source. In

this case, the variable will become a normal assembly variable.

Control Elements

To create a dialog box, use the Control command.  It can be called by one of the following means:

Icon Ribbon

Parameters > GUI Control > Control

Keyboard Textual Menu

<TR> Draw > Control

When working with parametric models and while building an assembly, the user often needs to edit

the values of external variables of the models being designed or fragments being a part of an

assembly. The T-FLEX CAD general variable editor can be used for handling external variables.

However, it is much easier and simpler to work with specially created custom dialogs containing

Windows-native tools (input boxes, drop-down lists, "Yes/No" switches, etc.). 

A custom user-defined dialog provides a quite convenient and easy way of editing variables in a

parametric model. It is developed by the user when creating a model or fragment. Special T-FLEX

CAD system elements, namely, control elements, are used for creating a custom dialog. When creating

a dialog, the developer can make it clear and easy to use by adding necessary explanations and

comments in the dialog and by structuring the input of the model parameters in a most

comprehensible way.

In the future, a custom dialog will be called instead of the general variable editor whenever necessary

to edit external variables of a given model or fragment. A custom dialog will be coming up upon

calling the command for modifying external variables, Parameters > Model, in the current document

and in the parameters window when inserting the current document as a fragment.

General information and types of control elements

T-FLEX CAD system supports the following types of control elements for use in the custom dialogs. 



T-FLEX CAD 17 Help

2642

The control elements Static Text, Frame and Group Box are not related to any variables and are used

for making a clear dialog layout and providing hints.

· Static Text is a text string positioned in the specified area of the dialog box.

· Frame is a rectangular frame or rectangular area of the specified color. By default, this is a

black frame or a rectangle of the background color.

· Group Box is a frame with a text aligned with the top border of the box.

The two last elements are used for enhancing and structuring the visual appearance of control

elements in the dialog box. Other visual means can also be used for this purpose.

Other elements – Edit Box, Button, Combo Box, Check Box, Radio Button, Preview - are related to

variables or the model pages and is intended for manipulating those in certain ways.

Edit Box is a rectangular field for editing the value of the variables associated with this box. Edit box

is used for variables without lists of predefined values. It is possible to work in a mode when the

displayed value cannot be edited (in this case, in the Edit Box field the value of the connected to this

field variable will be shown but this value will not be possible to modify).

Button.  A button defines the sequence of actions performed upon pressing it. Such actions can be: 

For more information, see General principles of creating control elements. 

Combo Box is a rectangular field with a pulldown list button  on the right. A combo box is used for

modifying a variable value when there is a predefined list of values. The element parameters define

whether it is possible to edit the input value.



Variables and Related Parametric Tools

2643

Check Box switches between the two values of the selected variable. The particular value depends on

the check box state.

Radio Button switches between the variable values defined in the radio group parameters. Radio

buttons can be conveniently used for variables with several fixed choices of values. (In the case of just

two choices, Check Box can be used instead.) In this case, a radio group of switches is created for the

variable, each representing one of its values.

The custom dialogs allow creation of Preview controls.

Such an element allows displaying a preview pane for a page per the specified fixing factor in the

dialog box for editing the fragment external variables. Preview is not available in the dialogs called by

the command Parameters > External Variables.

When creating a dialog box, besides the control elements proper, you can use any drawing elements:

nodes, construction lines, images, pictures, etc. Construction lines and nodes are not displayed as part

of the dialog box window, however, those can be used for precise positioning of control elements

when creating complicated dialogs.

Graphic elements and pictures can be used as additional detailing elements in the dialog box along

with the standard control elements, such as Frame, Group Box, Static Text. Those elements can be

used, for example, for creating a simplified parametric drawing on the page of the dialog box. In this

way, the user can evaluate the changes made to the model parameters by this drawing.

Dialog pages

All control elements of a dialog should be located on one page. Dialog elements can be placed on a

drawing page or on an additional manually created page. However, we recommend placing control

elements on a separate page of Controls type, created automatically. Such page is assigned Custom

format with the paper height and width recommended for dialog boxes, as well as optimum font size

and grid step for dialogs.

The dialog box size is defined by the value of the Paper Size parameter in the command Set

Document Parameters (the Paper tab), defined for the dialog page. The size of the dialog box can be

modified via the parameters of the mentioned command or by using the Edit ribbon tab > Page Size

command.  

For automatically created Controls-type pages, grid display is turned on for easy positioning of

control elements. To turn off the grid or to change its step, use Edit ribbon tab -  Grid the command. If

necessary, you can turn on snapping to existing 2D nodes (option  <N>) or use the absolute

coordinates (option  <A>).

The dialog box can be used in the future for editing the model external variables. Therefore, the

automatically created dialog page is added for convenience to the list of pages on the External

Variables tab of the command Set Document Parameters.
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The page name will be used as the dialog box title. The page name can be modified using the

command Pages… or with the help of the command Rename found in the context menu for the tab of

the given page.

Multipage dialogs

A T-FLEX CAD document may contain an arbitrary number of dialog pages. You can build separate

dialogs for various groups of parameters and specify different scenarios of the dialogs interaction.

The two main scenarios of the dialogs interaction are as follows:

· Complex multi-tab dialog box. Separate dialog boxes are joined into a complex one with

tabs, each tab corresponding to a particular contributing dialog box;

· Main-subordinate dialog scheme. In this scheme, one of the dialogs is rendered main and

appears upon calling the command Parameters > External Variables, while the rest of the

dialog boxes are called, if necessary, via the controls of the main dialog. 

The combination of the two schemes is also possible.

When creating a dialog box with tabs, keep in mind that the pages of the dialogs being joined must

have same size. Otherwise, all pages and their respective elements will be forced to scaling to the size

of the first one.

The second scheme that relies on using several dialog boxes allows different page sizes.

General principles of creating control elements

Upon calling the command, the following options become available in the automenu:

<S> Create Dialog Page

<F> Frame
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<T> Static Text

<E> Edit Box

<G> Group Box

<B> Button

<C> Check Box

<R> Radio Button

<O> Combo Box

<V> Preview

<P> Edit Control Parameters

<A> Set absolute coordinates

<N> Set relation with Node

<F4> Edit Control

<Esc> Exit command

Creation of All control elements can be fit in the following scheme:

1. Defining the size and position of the element being created. This is done by specifying two

diagonal points of the box defining the element extents on the dialog page. 

2. Defining the element parameters in the Control Parameters dialog box. This dialog is launched

automatically. 

3. Defining additional parameters - of the variable bound to the control, or of the sequence of

actions performed upon activating the control. 

Depending on the type of the control, some of the steps in this scheme can be skipped. For example,

when creating the Frame and Preview controls, all you need to specify is the position. Other

parameters of these controls are defined by default. Additional parameters need to be defined only

for the elements Edit Box, Combo Box and Button. 

The  (<S>) option creates a new page (by default it is assigned the Dialog type) with the

recommended dimensions. Those in the Set Document Parameters command (Paper tab), the User

format is set for it with the appropriate height and width. When a page is created, it is added to the

list of pages on the External Variables tab in the Set Document Parameters command and is marked

with a checkbox opposite the page name. This means that the dialog created on this page using the

controls will appear on the screen when the External Variables command is called and in the dialog

box for setting the values of the external variables of the fragment when the current document is used

as an assembly element.

The controls do not have to be on a separate page. You can place them on any of the existing pages

or create a new page for them using the Pages command.
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If there are several dialog pages marked with flags in the Pages edit mode, one dialog with tabs is

created. The number of tabs corresponds to the number of marked pages (the name of the tab is the

same as the name of the corresponding page).

Frame . This element is created to decorate the dialog box. You must specify two points that

define the border of the frame. In this case, a rectangular area of the specified dimensions will be

displayed in the dialog window. In the parameters for the frame, you can specify its type (Frame or

Rectangle) and color (sets the color of the frame lines or the background color of the rectangle).

Static Text  is also used to decorate the dialog box. This element is a text string located in the

specified area of ??the dialog window. Pick two points that define the boundaries of the rectangle in

which the text will be positioned. After that, the parameters window will appear on the screen, in

which you can set:

· the content of the text in the Capture field;

· system-wide parameters Level, Layer;

· text color and background color on which the text will be displayed. To change the default

values, check the boxes next to the name of the corresponding parameter.

· the vertical and horizontal alignment mode determines the position of the text relative to the

borders of the selected rectangle.

· on the Font tab you can set the text font parameters.

Edit Box  - rectangular field for editing the value of the associated variable. Specify two points

that define the boundaries of the variable value input field. Then the Expression Constructor window

appears, containing a list of existing external variables. Setting the Real, Text flags determines the

presence of variables of the corresponding type in the list. To assign a variable, point to an element of

the variable list with the cursor and press  (the variable name will appear in the Expression field)

or enter the variable name in the Expression field. When you enter the name of a non-existent

variable, the dialog for creating a new variable is called. After confirmation, a new external (by

default) variable with the specified value is created.

The parameters of this type of control are:

· Multiline EditBox.

· Show Expression. This parameter affects the work with the custom dialog when using

variables. Usually, if, when inserting a fragment into an assembly, a link to an assembly variable

is assigned in the control input field or an expression is entered, the name of the assembly

variable (expression) is not shown in the dialog. This option enables the display of variables in

dialog fields. In this case, the value of the assembly variable or expression is displayed next to

the input field.

· Read Only. When this checkbox is enabled, the editor will work in the "read-only" mode, i.e.

the editor field will reflect the value of the associated variable, but this value cannot be

changed.

· System-wide parameters Level, Layer.

· text color and background color on which the text will be displayed. To change the default

values, check the boxes next to the name of the corresponding parameter.

· on the Font tab you can set the text font parameters.

It should be noted that when specifying the values ??of text variables, you can enter multi-line text. To

do this, the Multi-line editor flag must be set in the control's parameters, and the characters

"\n" (<Shift><Enter>), which are a line break sign, must be added to the contents of the text variable.
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Group  is another element of the dialog box design. A group is a combination of the previous

two elements, i.e. it is a frame with text positioned at the top border. The parameters are set in the

same way. 

Button . When creating a button, you can assign a sequence of actions to be performed after

clicking on it. The first step is to specify two points that determine the size of the button and its

position in the dialog box. Then, in the parameters window in the Text field, enter the name of the

button and, if necessary, the following parameters:

· system-wide parameters Level, Layer;

· text color (to change the default value, check the box next to the name of the corresponding

parameter);

· vertical and horizontal alignment mode (determines the position of the text relative to the

borders of the button);

· on the Font tab you can set the text font parameters.

After confirming the parameters (pressing the OK button), the Actions window appears, in which you

must define the action (sequence of actions) that will be performed when this button is pressed.

Such actions can be:

· Activate Page (show contents of the specified page in the current dialog box); 

· Open Page in Dialog Box  (displays the dialog box contained on the specified page, in a new

window); 

· Set Variable Value  (assigns the specified value to the selected variable).

· Run Macro (a macro is a program written in some programming language using T-FLEX CAD

API functions.

· Regenerate 3D Model.

· Open Model (open document of T-FLEX CAD);

· Edit Fragment Variables (open the edit dialog for variables of the specified fragment); 

· Run Command (it is a tool for applications developers; the application identifier and the name

of the command that processes this application are specified. When clicking on the specified

application, the call with the command’s name is initiated).
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· Zoom Limits (maximizes the image in the same way as the Zoom Limits command).

1. Add Action. Select one of the actions from the list.

Click the Add button. Depending on the selected action, a window will appear for specifying

additional settings for the action (for each type of action, additional parameters will be different).

After that, the action is added to the list of actions for the created button.

2. Delete Action. Specify the required line in the list of actions (it will be highlighted) and click the

Delete button.

3. Properties Action. Specify the required line in the list of actions (it will be highlighted) and click the

Properties button (a dialog will appear for selecting additional settings for the action).

4. Move Action. The order in which the actions are performed corresponds to the order in which they

appear in the list. To change the order of actions, specify the required line in the list of actions (it will

be highlighted) and move it using the Up or Down buttons.

It should be noted that the actions assigned to the button are performed in the order in which they are

assigned. If the sequence includes calling a dialog, all subsequent actions after it will be performed

only after closing this dialog by pressing the <OK> key. If the call to the dialog ended by pressing the

<Cancel> key, then all subsequent actions are ignored.

Check Box . This element allows you to set one of two values ??for the selected variable, depending

on the state of the switch. The first step is to specify two points that define the area of ??the switch. Then

the Expression Constructor window appears, in which all external variables existing in the document

are located. Flags Real, Text control the presence of variables of the corresponding type in the list.

Select the variable in the list, the value of which will be controlled by the created switch, and confirm

the selection by pressing OK. Next, the parameters window will appear on the screen, in which you can

set:

· Set Variable Value. On - the value that is assigned to the variable when the switch flag is set,

Off - the value that is assigned to the variable when the switch is off. The required value

(numeric or symbolic) is entered into each parameter. If the field is left blank, the variable is

assigned a null value (empty string).

· Caption. Sets the text for the name of the switch.

· system-wide parameters Level, Layer;

· Text color. To change the default value, check the box next to the name of the corresponding

parameter. The background color determines the color of the area highlighted for the radio

button.

· the vertical and horizontal alignment mode determines the position of the title text in relation

to the area boundaries.

· on the Font tab you can set the text font parameters.

Radio Button . This element allows you to change the value of the selected variable. This type of

switch is convenient to use if there are several variants of its value for a variable (in the case of two

values, the previous type of switch can be used). Then a group of radio buttons is created for this
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variable, each of which sets one of its values (for example: the Step variable can take values: small,

medium, large).

This type of switch is created in the same way as the previous one. The only difference is the

unavailable value of the Off parameter.

Combo Box . The combo box is created for the user to enter the values ??of a variable and/or select

it from the list. It should be noted that the creation of the list and the entry of its contents is carried

out in the variable editor. As with other controls, you first set two points that define the area of ??this

item (the value edit field and the list button occupy the entire selection). Then the Expression

Constructor window appears to select a variable, the value of which will be changed by the created

element. If necessary, you can set the following values ??in the parameters:

· Editable (For ComboBox). When the flag is set, it is allowed to edit the value of the variable,

otherwise only selection from the list is possible.

· Show Expression. This parameter affects the work with the custom dialog when using variables.

Usually, if, when inserting a fragment into an assembly, a link to an assembly variable is

assigned in the control input field or an expression is entered, the name of the assembly

variable (expression) is not shown in the dialog. This option enables the display of variables in

dialog fields. In this case, the value of the assembly variable or expression is displayed next to

the input field.

· Value Selection. It is used to link the values of external variables with each other. For example,

automatically select the appropriate thread pitch from the list when changing the thread

diameter. If this option is disabled, the thread pitch will not change depending on the

diameter.

· system-wide parameters Level, Layer;

· Text color. To change the default value, check the box next to the name of the corresponding

parameter. The background color determines the color of the area highlighted for the radio

button.

· on the Font tab you can set the text font parameters.

If the list of variable values ??was created based on a file, then by enabling the Editable option, you can

change the list right on the dialog page. To do this, point the cursor to the input field and call the

context menu with the right mouse button. The Add to List command allows you to add the contents

of a value input field to the list of values ??for a variable. The Edit List command allows you to change

the values ??of the list items.

If the list of values ??contains a comment (a text string separated by the “;” symbol from the variable

value), then if the Editable parameter is disabled, the input field of the control and its drop-down list

will reflect not the numeric values ??of the variable, but their text alternatives.

Preview . This element allows you to display a preview window in the dialog for editing external

variables of a fragment (in the dialog of the External Variables command, the preview is not

displayed). To display the drawing in the viewing area when calling the dialog in the External

Variables command, you can align the positions of the Preview control and the Picture element of the

image. Unlike the preview, the picture is not associated with the drawing file and therefore will not
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change when the values ??of the variables are changed. The viewport displays the page corresponding

to the selected anchor vector. Pick two points that define the size and position of the viewport. The

following fields are available in the parameters:

· frame type (frame, rectangle);

· system-wide parameters Level, Layer;

The next three parameters have no effect on this type of control.

· color, background color;

· horizontal and vertical alignment mode;

· on the Font tab you can set the text font parameters.

Controls have an order that affects the transition to the next element when the <Tab> and <Shift-

Tab> keys are pressed, and a priority that determines the order in which the item images are stacked.

By default, both properties are set by the sequence of elements creation (i.e., transitions will be

performed from the first created element to the next, and the element's image has a higher priority

than the previous one, but less than the next one). You can reassign the order of elements (and hence

the priority) in the command for editing controls.

For existing controls, the Copy, Move options are available in the context menu, allowing you to

create new elements by copying or change the position of the selected element.
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Parameters of control elements 

Properties tab

The default value of the Level parameter is "0", the parameter Layer" – "Main, the font parameters –

By default. 

The general parameter "Priority" is assigned automatically in the process of control element creation,

reflecting the order of creation: the first control is assigned priority "0", next – "1", etc. 

Besides the general system parameters, control elements have a set of additional parameters:

Caption (the text displayed on the control);

Color of characters (in the cases of "Frame" and "Preview" – the color of the frame strokes or the box

background);

Background Color of the control element (for the element "Group Box" – the background color

under the group name);

Vertical Alignment.

The two latter parameters define the caption text position with respect to the control element

boundaries.

Some of the above-mentioned parameters are omitted in certain control elements. For example, the

"Button" control omits the parameter "Background Color", while the "Group Box" does not require

the parameter "Vertical Alignment", since the group name is always positioned along the top

boundary. Note that, when defining parameters of a particular control element, only its relevant

parameters will be accessible in the "Control Parameters" dialog box.

Some control elements also have their own specific parameters:

Frame: 

  Frame Type: frame or rectangle.  

Edit Box: 

  Multiline EditBox – used for text variables only. Permits entering multiple lines. 

Show Expression. This parameter affects custom dialogs when using variables. Usually, names of the

variables are not displayed in the dialog boxes, when such variables or expressions are used as

parameters of the fragments being inserted into assemblies. This option outputs name of a variable in

edit fields of the dialog boxes. At the same time variable’s value or expression is displayed nearby.

Read Only. When this flag is turned on, the editor will work in a regime “read only”, i.e., in the Edit Box

field the value of the connected to this field variable will be shown but this value will not be possible

to modify.

Combo Box: 

  Editable – allows direct input of variable values without selecting from the list. 

Value Selection. Option is used for binding external variables  between each other. For example to

select the thread pitch from list, according to the thread diameter, automatically. If the option is not

activated, the thread pitch will not change according to diameter.

Check Box: 

  On – defines the value assigned to the variable when the box is checked;  

  Off – the value assigned to the variable when the box is cleared.  

Radio Button: 

  On - defines the value to assign to the variable when switched on.

In the further description of the controls, only the elements will be mentioned that are specific to this

control element.

Control elements modification

To modify control elements, the control editing command is provided, "Edit Control"
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Icon Ribbon

-

Keyboard Textual Menu

<EO> Edit > Draw > Control

The command is intended for editing controls created using the Control command.

Upon calling the command, the following options become available in the automenu:

<*> Select All Elements

<R> Select element from list

<T> Change Controls Tab Order

<S> Set Recommended Page Parameters

<Esc> Exit command

The option  allows you to reassign the order of elements, which determines the sequence of

transitions between them when you press <Tab> or <Shift> <Tab>. By default, the order of items

follows the order in which they were created. After calling the option, each element displays its serial

number.

If you need to change the order of the elements, select them in the required sequence. Press the 

or <Enter> icon to confirm your changes.

The option  is used for assigning default parameters of a dialog page to the current page (those

set at creation by the option ). The page being modified is assigned the type Controls. This page

is automatically check marked in the list of pages under the External variable editor parameter in the

command Set Document Parameters.  The parameter itself switches to the Pages setting. The option

is used on the pages created or modified by using the Pages, Page Size or Grid commands.
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To change the position of an element or its size, just select it (point with the cursor and press ),

and then make the necessary changes.

The control of the list of multiple selection of elements is carried out by key combinations:

<Shift>    Add an element for editing.

<Ctrl>    Remove item from selected list.

With multiple choice, you can use the options:

<P> Edit Control Parameters

<V> Change Control Variable

<I> Select Other Element

<Del> Delete selected Element(s)

<Esc> Cancel selection

When you select the  (<P>) option, you must mark the parameters that you want to edit in the

dialog box. By default, all parameters of the selected elements are subject to editing. If the parameter

should not change, it is necessary to "deselect" it. After you have specified a set of parameters for

editing and clicked OK, the standard window for setting parameters of the selected elements

becomes available to you. Parameters that cannot be changed are not editable. Please note that some

of the general parameters (such as layer, level, etc.) can be edited using the system panel.

When selecting one item, you can use the following options:

<P> Edit Control Parameters
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<V> Change Control Variable

<Y> Create Name for selected Element

<А> Edit Action Lish

<I> Select Other Element

<Del> Delete selected Element(s)

<F3> Call the command Frame - set image scale

<Esc> Cancel selection

The option  (<V>) becomes available only for those controls that are associated with variables. It

allows you to override a variable whose value is controlled by the selected item (all actions in this

case coincide with the process of creating a control).

The option  (<А>) is available only for a button control. It allows you to add/remove actions

performed when you click on the selected button.

It should be noted that the options for editing controls can also be called from the context menu.

Point to the control and right-click. The following commands will become available in the menu that

appears: 

· Edit (Call the Edit Controls command).

· Copy (Copy the selected item).

· Paste (Create a copy of the control).

· Move (Change the position of the selected control).

· Delete (Deletes the selected control).

· Properties (Calling the Control Parameters dialog box).

· Information (View items (nodes, variables, etc.) associated with the selected).

In the free T-FLEX CAD tutorial there is a lesson on creating a control dialog - Parameterization,

Lesson 3 - Control Dialog Creation. You can download the tutorial at the corresponding link.

Links

The command is called as follows:

Icon Ribbon

Parameters > GUI Control > Link

Keyboard Textual Menu

<SR> Parameters > Links

As a result of calling the command, the dialog box appears, listing all the variables of the drawing and

their values in a tree layout. By default, only the visible variables are in the list. To view all variables of

the given document (including hidden), set the flag Show Hidden.

https://www.tflex.com/resources/tflexcadst/download/
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The "+" glyph in a box before a variable indicates a collapsed branch. Such a branch contains a list of

one or more drawing elements that rely on the variable. To expand the list, point and click the left

mouse button over the box. The list contains element types and IDs.

The listed elements, in turn, may be constructed based on other elements. In such a case, their

branches will also be preceded by the box with the plus inside.  The base (independent) elements in

construction hierarchy are on plain branches, not prefixed with the box. The pane on the right-hand

side of the dialog box displays information about the selected element. Besides that, the selected

element is highlighted in the drawing or in the 3D window.

Besides viewing relations of variables with drawing elements, you can additionally perform certain

manipulations with 2D or 3D elements selected in the list, using the following buttons:

Parents. Upon clicking this button, the dialog window displays the tree of parent elements for the

element selected in the list, instead of the list of all variables. This button is unavailable for the

elements without parents.

Children. Works similar to the previous button, but instead of the parent element tree displays the

children's tree for the selected element.

Delete. Closes the command window and calls the command to delete the selected element.

Edit. Closes the command window and calls the command to edit the selected element.

Show. Closes the command window. The current drawing (model) working window is adjusted so as

to fully display the selected element on the screen.

Select. Closes the command window. The selected elements stay selected for further manipulations.

Measure… Calls the command Measure for the selected element.

Properties… Calls the parameters dialog for the selected element. After finishing working with the

dialog, the Links command window is resumed.

Close. Exits the command.s

Information. This field displays a brief information about the selected object.

Attributes. This field displays information about the attributes assigned to the selected element.
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Expression Constructor

The expression constructor is called when you need to specify a link with a variable. For example,

when inserting a variable into a text field or associating the value of a Product Structure data cell with

a variable.

The content of the window depends on its method of calling. For all call methods, all existing

document variables will be displayed in the window.

See the features of filling the Expression Constructor window in the relevant sections.

Selecting the External only, Real, Text and Hidden checkboxes only determines the presence of the

appropriate type of variables in the list. You can select a variable using , or by entering its name in

the Expression field. When you enter the name of a nonexistent variable, the dialog for creating a new

variable is called.
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After confirmation, a new variable with the specified value is created and the constructor window

closes.

If necessary, you can specify an expression consisting of several variables, as well as use preset

functions to work with variables.
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The last selected function will be added to the constructor window.
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The buttons of the last selected functions will be displayed until the current session with T-FLEX

CAD is finished.

Relations

The command is called as follows:

Icon Ribbon

Parameters > GUI Control > Relations

Keyboard Textual Menu

<REL> Parameters > Relations

To quickly track geometrical dependencies in drawings and manage them, T-FLEX CAD has a special

type of 2D elements – Relations. Relations serve to visually render on the drawing screen the types

and parameters of geometrical dependencies between construction elements. Using the relations one

can modify parameters of those dependencies without calling the editing commands of the respective

construction elements. 

Relations are auxiliary objects that are displayed in the drawing field in the way of special marks.

Those are not printed and are not exported. The information about the type of the geometrical

dependency and the numerical parameter of the object, to which a relation pertains, is displayed on

the relation mark. If a parameter is related with an expression or with a variable, then the relation

mark displays both the expression and its current value. 

Relations can be created automatically by the system (temporary Relations) or manually by the user. 
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The automatic creation is done in the command for editing construction lines and graphic lines

created based on construction lines. The system creates relations and displays them on the screen: if a

construction line is edited – then for that line itself, if a graphic line is edited – then for the

construction line, on whose base the graphic line is created. When exiting the editing command, such

Relations are deleted automatically. Temporary Relations can be used to modify construction line

parameters in the transparent mode.

Manual creation of Relations is done by the user in the Relations command. In this case, it is possible

to create Relations either for individual construction elements or for all construction elements in a

given drawing. Relations that are explicitly created by the user exist in the drawing up until the user

deletes them by the same command. By default, those are permanently displayed in the drawing.

Using those you can analyze parametric relations in the model, as well as modify construction line

parameters. If necessary, all or specific existing Relations can be hidden from the current 2D window

or completely over the entire document (such hidden Relations will not be displayed in any 2D

windows opened for this document).

Using Relations when Working with Drawings

Relations serve the two main purposes: 

· Visualizing geometrical relations in the model; 

· Modifying geometrical parameters of the model in the transparent mode. 

The first goal is achieved by creating Relations, when the user can visually examine geometrical

relations without using the command ? > Information.

To modify an existing geometrical parameter using Relations, point the mouse at the parameter value

in the Relation mark and click . The mark will turn to an edit box displaying the parameter value it

controls. Just like in other system fields for editing values, the user can create here the list of frequently

used parameter values and use it with the help of a special button for selecting the value from the list.
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This list is created with the commands of the context menu called by  in the editing mode of

selected Relation. Font command can modify font that will be used for displaying the Relation marks.

Font parameters are common for all marks: Relation marks, dimension marks used for editing

dimension values in transparent mode, dragger marks in 3D operations.

The new parameter value can be fixed by clicking the  button on the mark itself or in the

automenu.  

If the parameter described by a Relation is bound to an expression or a variable, then the Relation

mark displays both the expression and its current value. The user can edit the expression itself in the

same way as its value.
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Sometimes, a Relation mark may obstruct working with the model by overlapping a portion of the

drawing. To fix the situation, you can delete or hide from display such Relation (how to do it will be

described a bit later), or simply move the Relation mark aside. 

To move a Relation mark, point the mouse at the Relation icon. Once the cursor changes to ,

depress  and, while holding the mouse button, drag the mark image to the desired position. The

moved mark will be connected with the Relation image by a leader line.

You can move not only the relation mark, but also the Relation image that appears as an arrow

connecting the 2D element, for which this relation is created, and its parent element. To do this, simply

move the cursor to the Relation arrow and click . After that, the Relation image will rubberband

along with the cursor. Move it to the new position and fix by clicking  again.
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Creating Relations with the Command "Element Relations"

The following options are available in the command automenu:

<C> Create Relations for selected Elements

<P> Create Relations for parent Elements chain

<D> Delete Relations mode

There are three ways to create Relations:

1. Automatic creation of Relations for all construction elements in the current drawing. 

2. Manual creation of Relations for individual construction elements with the option . After

calling the option, select the construction elements in the 2D window, for which you need to create

relations.

3. Manual creation of Relations for chains of dependent elements with the option . After calling

the option, select the element in the 2D window, which will be the last in the chain. Relations will be

created for the specified element through the entire chain of parent elements up to the base ones

(those that are independent of other construction elements).

The created Relations will be always shown on the drawing, whether in the command waiting mode or

inside any 2D command. Some of the existing Relations can be hidden from display, if you specify in

the command properties window, which Relations shall be visible. This is done with the help of flags

defining the visibility/invisibility of each Relation type (all flags are enabled by default):

Relations for construction lines

Parametric Relations – Relations for construction elements that use geometrical parameters, which

can be defined by variables. Such geometrical parameters include, for example, an offset line parallel

to another line, an angle of a line inclined with respect to another line or to the horizontal, a circle

radius etc. The exception is vertical and horizontal lines, for which Relations visibility is controlled by a

special flag (see below).  

Symmetry – Relations for lines constructed as the symmetry axis for two other lines. 

Tangency – Relations for elements constructed with the tangency condition.

Horizontal/Vertical – Relations for vertical and horizontal lines.

Orthogonal – Relations for the lines constructed as perpendicular to other lines.
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Relations for nodes

Free Nodes – Relations for the free nodes, meaning those defined by two coordinates - X, Y.

Relative Nodes – Relations for nodes defined by an offset relative to another node.

Parametric Nodes – Relations for nodes having one numerical parameter. Such nodes include the

nodes on construction lines (circles, splines, functions etc.), as well as a node relative to another node

on a line.

The flags in an additional Variables section serve to control the visibility of Relations depending on

whether variables were used to define geometrical parameters of those elements (by default, those

flags are disabled): 

Only Related to Variables. When this flag is enabled, the 2D window will display the Relations only

for those construction elements, which were defined using variables. 

The list below shows all numerical variables in the current document. An additional flag Show Hidden

Variables serves to display in this list also the hidden numerical parameters of the current document.
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Using the list, you can specify the variables that shall be considered when determining which Relations

to show. To select a variable, you need to set the flag beside its name using .

All variables in the list can be quickly marked with the button . Checks can be cleared off all

variables in the list by the button .

After exiting the command, the Relations hidden by the above-described flags will stay hidden from

the drawing. Nevertheless, they exist in the model. To make them visible, you need to call the

Relations command again and set the respective flags in its property window. You do not need to

create Relations anymore in this case.

Hide on Current View

When enabling this flag, all created Relations become invisible in the current 2D window. However,

those will be visible in other 2D Windows of the same drawing (if any are open). Just like in the case of

using the previously described flags, to alter the relations visibility/invisibility once out of the

command, you would have to call it again and change the status of the given flag in the property

window.

Relations are deleted with the options  and . When clicking , all previously created

Relations will be automatically deleted. The option  is used to delete individually selected

Relations. After calling this option you need to sequentially select any Relations to be deleted.

Displaying Relations in the "Information" Command Window

When the Information dialog is activated for selected or all model elements, the relation objects are

displayed in this dialog in a special way. An existing relation icon is displayed beside the element, to

which it pertains.
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Recalculate

The command is called as follows:

Icon Ribbon

-

Keyboard Textual Menu

<REC> Parameters > Recalculate

When this command is called, the values ??of the model variables are recalculated. This feature is used

when changes are made to external data files. For example, after calling the command, the values ??of

the variables are recalculated taking into account the updated database fields.

Databases

The command is called as follows:

Icon Ribbon

Parameters > Tools > Database

Keyboard Textual Menu

<ID> Parameters > Database

T-FLEX CAD has a capability of creating databases.

The usage of databases in T-FLEX CAD allows us to realize the whole catalogs of products in one

single drawing. It is possible to create elements of structures by specifying their parameters from the

databases.

For a description of the functions for working with databases, see the Database Functions

section.

In T-FLEX there are several ways of storing the data. In the first method, the database is not actually

created, and the T-FLEX CAD model uses data from an external file of one of the standard formats

(for example, MDB format). Such files can be created both with the T-FLEX CAD system and with any

other programs designed for this. A significant inconvenience of this method - in case of loss of the

source file, it becomes impossible to work with the parametric T-FLEX CAD model that uses it.

The second method – store data inside a specific drawing. Databases that are stored together with the

drawing are called internal databases, all other databases are called external databases.

The second way - a database table is created and stored directly inside a specific T - FLEX CAD

document - the so called internal database. This method allows for faster access to the information

you need, does not clutter up disk space with auxiliary files, and makes it easier to transfer drawings

from one place to another.

There is also a third, intermediate option - when a copy database is created on the basis of an

external data file in a T-FLEX CAD document, which retains the connection with the external source

file. Such a database is called a database by reference. The content of the database by reference can

be updated from the source file, automatically or at the user's request. Moreover, if there is no

external file, then the parametric model continues to work using a copy of the base inside the

document. And when the source file becomes available again, the link with it is automatically
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updated. The speed of working with such a database is the same as when using an internal database.

This method of working with external data files allows you to save parametric models that use

referenced databases in case the database file is lost.

The databases stored together with the document will be called internal databases (hereinafter

referred to as databases or DB), all the rest - external databases or databases by reference.

The command provides the following capabilities:

· create new internal database;

· create database by reference to external file;

· edit the contents and the header of the existing database;

· save the internal database into the external file of the format dBase or Access;

· transform the database by reference to the internal database;

· delete the database.

When invoking the Parameters > Database command, additional window of the current document is

created in which the database editor is displayed. The window contains a table of the database (if the

document does not have a database, the table will be empty) and the list of databases of the current

document with the help of which it is possible to switch from one database to another. 

Owing to the fact that the database editor dialog opens in a separate window, it is possible to

simultaneously work in the main window of T-FLEX CAD document and in the editor’s window, and

also simultaneously edit several databases of a single document.
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All basic commands for working with the database have been moved to the Database ribbon tab (it

becomes available when working with the database editor).

If there are no other databases in the current document, then only the create New database

command is available. With this command, you can create a new internal database or a

referenced database.

Creating an internal database

To create a new database, on the Database tab of the ribbon, call the New option. In the appeared

Database Properties window, specify its name and comment (if necessary).
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Each database has its own unique name. The name of a database – a string of symbols (no more

than 10). It is important to pay attention to the fact that the upper-case and lower-case letters

when entering the name lead to creation of different names. The name BASE_1 and base_1 –

different names. The same is true for the names of columns of the database.

It is also possible to specify the background color for the cells of database’s table with the help of the

Background parameter. When creating new database the background color is selected in a special

field located in the upper part of the Database Properties window. Different databases can have

different background color. When opening another database, the color of the background will change.

After pressing ОК the Database Properties window will close. The system automatically transfers to

the database table creation mode. The dialog window for specifying parameters of the first column of

the created database will appear on the screen:
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Name. Defines the name, by which the access to the values of a database will be carried out.  A field

is identified by its name. The length of the field name should not be greater than 10 characters. The

field name can be an arbitrary string of letters, numbers and the underline sign ( _ ). The string should

begin with a letter. All field names within one database should be unique.

Comments. Explanatory text for the column of length of no more than 80 symbols.

Type. Defines the information representation format for the given column. Columns can be of one of

the following types:

· Integer

digit sign integer);

· Real

+3.4 ×1038 (7 digits);

· Text. In this column it is possible input any text information;

· Double precision

digits);

· Long Integer

integer).

Length. Defines the maximum admissible number of symbols when entering and editing the value in a

column of the textual type.

Alignment. This parameter defines the way of displaying the values in a column: with alignment by

the left margin of the column, right margin or the center.

Order number. Shows order number of chosen column in database.

If the Create Next flag is selected, after entering the values and pressing ОК, the column’s properties

dialog will appear again which will allow us to specify parameters of the next column, etc. If the flag is

disabled, after closing the dialog window the system will transfer to the mode of filling in the

database. 

Filling in and editing the database

After specifying parameters of the database and its columns, on the screen will appear an empty table

of the database that contains one row and those columns which were specified by the user.
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Note that in the database table there is always an additional, service column with the name “? ”.

This column contains line numbers of the table.

To create additional rows, you can use the options on the Database ribbon tab, in the Component

Links group:

Insert Row Before

Insert Row After

Insert Rows

Also, you can create an empty line if you press <Enter>, when the cursor is located at the last line of

the table.

To remove the lines, use the option:

Delete Rows

All options are repeated in the context menu that can be invoked with  for any string of the table

(out of the mode of editing the contents of a specific cell of the table).

You can add and remove the columns to/from the database table by using the following options of

the ribbon:
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Insert Column Before

Insert Column After

Insert Columns

Remove Columns

The same options are accessible from the context menu in the area of columns headers of the

database table:

In addition, in the context menu the following commands for a column are available:

· Sort Column Ascending. As a result of applying this command, the lines of the table are

displaced in such a way that the contents of the cells of the current column are sorted in the

ascending order;

· Sort Column Descending. As a result of applying this command, the lines of the table are

displaced in such a way that the contents of the cells of the current column are sorted in the

descending order;

· Adjust Width. Selects the width of the current column according to the contents of the

column’s cells;

· Adjust width of all columns. Invokes the dialog of column’s parameters (the same as used

upon creation of a database). In the dialog you can change the name and the type of already

existing and completed column. It should be taken into account that upon changing the

column type its contents can be lost. In addition, the change in the column’s name to which the

links were already created in the Variable Editor, will lead to the errors in the variables, which

can be corrected only by the user.

The column’s parameters dialog can also be invoked without using the context menu, i.e., simply by

clicking  on the column’s header.

Moving across the lines when editing the contents of the database is carried out in the following

ways:

· With the help of pointing at the required string with the cursor and pressing ;
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· With the help of pressing the keys <Up> or <Down>. In this case, the cursor moves one line up

or down, respectively;

· With the help of the key <Enter> in any line, except the last one. As a result, the cursor moves

to the next line;

· With the help of pressing the keys <PageUp> or <PageDown>. In this case, the cursor moves

one page up or down, respectively, i.e., to the first/last string in the current window;

· With the help of pressing the keys <End>/<Home>. In this case, transition to the first/last lines

of the database table is carried out.

The user can move rows and the data contained in them inside the database table with the help of the

following options:

Move down

Move up

The same actions can be performed by pressing the key combination:

· <Ctrl>+<Down> - to move the row downwards

· <Ctrl>+<Up> - to move the row upwards

To specify the contents of cells of the data’s table, it is required to enter into the mode of editing the

required cell with the help of . The selected cell is highlighted with an inverted rectangle (the

background color becomes the text’s color and vice versa) and the blinking cursor appears in the cell.

To speed up the work of filling in the database table, it is possible to use the options of

copying/insertion. It is possible to copy both the contents of individual cells and the entire strings of

the database table. It is allowed to copy both inside a single database and from one database to

another, even if the second database is inside another document of T-FLEX CAD. 

To copy the contents of a specific cell, it is required first to select the contents and choose the

required command from the context menu. Insertion of the copied data into another cell is carried out

in a similar way. The commands of insertion of symbols, variables, fractions, etc. are also available in

the context menu for the cell’s contents of the data’s table. A detailed description of these commands

is given in the Texts section of this user’s manual.
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Copying the entire string or several strings simultaneously is carried out in a similar way. To select a

string, it is possible to use two options. The first option – indicate the desired string with the help of

, which right away also invokes the context menu with the commands of copying/insertion of

strings. The second option – select a string with the help of , by indicating the very first, service

column of the database table, with the name “? ”. To select several strings, you can use the selection

with the help of <Ctrl> and <Shift>, as is done elsewhere in the system.

For insertion of the copied string/strings, it is sufficient to choose the desired place (string) in the table

and invoke the Paste command from the contextт menu. Insertion will be carried out after the line at

which the cursor was at the moment of invoking the insertion command.
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You can also use the Copy, Paste, and Copy database to clipboard commands on the ribbon to

copy/paste entire rows. Please note - these commands work only with entire rows.

To select the entire contents of the table, the option is provided:

Select Table

For the contents of the cells of the database’s table there is a capability of simultaneous sorting by

several columns. Such sorting can be used in order to group the data with equal values in one single

column, and then carry out sorting of another column in these groups with equal values.

To sort by several columns, the ribbon provides the option:

Sorting

After calling this option the Sorting dialog window will appear in which it will be possible to indicate

the sorting options for several columns. 

For example, suppose there is a database of parameters of flange couplings.
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It is required to group the data that has equal values in the column isp, then execute sorting of the

column d in these groups with equal values.

To do so, on the main toolbar invoke the Sorting option. In the window that appears in the fields of

the columns 1 and 2 specify conditions for sorting the values of parameters isp and d, respectively.

After pressing ОК, the data of the table will be grouped according to the specified conditions.

Parameterization of databases

The values of cells in databases can be specified as variables and expressions with the help of the

Parameterization parameter. This parameter can be enabled when creating the database. 
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The value of such a cell is recalculated when recalculating parametric model. When being displayed

the value of the cell in the table, specified either as a variable or expression, is highlighted with bold

font.

When clicking the cell the expression appears instead of the value and it can be edited.

Along with the functions for working  with databases, the value in a cell can depend on other cells.

In the given example the 6th row contains the sum of all five previous rows:
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Recursive specification of values is not allowed in this case. In case of appearance of the recursion the

cell will be highlighted with red color. In this example this event can occur if the range of rows 1, 5 is

removed:

The message about recursion is also sent to the diagnostics window.  Cross-like specification of cell’s

values from one table to another is also possible, but also without recursion.

A more detailed description of functions for working with ranges of cells is described in the

Database Functions section.

Databases by Reference

As with internal database creation, to create a database by reference you need to invoke the New

command. In the Database Properties window that appears it is required to specify the name of the

future database, comments (if necessary), data source file and mode of updating the database. 

For specifying the source file it is required preliminary to enable the Reference flag. After that the File

Name field becomes accessible. To select a file, use the corresponding button on the right. The

standard window of the file selection dialog will open, in which selection of the required file format

and its location is carried out.
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To create a database by reference, it is possible to select the files of the following formats:

· Microsoft Access Files (*.accdb, *.mdb);

· Files of the format dBase (*.dbf);

· Microsoft Excel Files (*.xls);

· FoxPro Files (*.dbf);

· Paradox Files (*.db);

· Text Files (*.txt, *.csv).

When creating the database on the basis of the file of “*.xls” format, it is required to specify

additionally that part of the information from the Excel book which will be used as the database

contents. Selection is carried out with the help of the drop down list of the Table Name parameter. By

default, the system prompts the user to select one of the pages of the Excel document. In this case, as

the contents of the created database, the entire page of the Excel book will be used. The columns’

headers will be created on the basis of the first string of the selected page.

When it is required to use only a part of the page’s contents, it is possible to preliminary create the

named data domain in the Excel document (select the desired cells in Excel and perform

Insert\Name\Assign). In this case, when creating the database by reference, this name will also appear

in the list of the Table Name parameter. The first line of the selected information will also be treated

by the system as the string with the columns’ headers of the database table.

When creating the database on the basis of the file of “*.accdb” and “*.mdb” format, it is required,

in addition to the file’s name, specify the table’s name from this file. The contents of the selected table

will be transferred to the database being created. The list of all tables in the selected file will

automatically be placed in the drop down list of the Table Name parameter.

When creating the database on the basis of the file of “*.dbf” and “*.db” formats, you need to

specify only the file’s name (the Table Name parameter is not available). In addition, the DOS

Codepage flag is available. When this flag is disabled (default state), the system assumes that the

format of the external file is Dbase-Windows. When this flag is enabled, the external file is opened
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only as a file of the format Dbase-DOS. This allows us to correctly open the databases that contain

Russian names for the columns and the contents of the text cells.

When creating the database by reference on the basis of the file of textual format, this file must

have the following structure:

· the first line must contain the column’s names that are delimited by a symbol. The symbol of

delimitation is specified in the database properties;

· the following rows contain the records of the database. The contents of the fields in each

record are also separated by this symbol.

    

In the case when the T-FLEX DOCs system is installed on your computer, one more option of

creation of the database by reference is available – the database by reference to the T-FLEX

DOCs dataset.  This is described in more detail in the T-FLEX DOCs user manual.

The mode of updating the created database can be selected from the drop down list of the Update

Mode parameter:

· Auto. Updating the data is carried out when opening the file of the model.

· On Full Regeneration. Updating the data is carried out when performing the total recalculation

of the model with the update of references.

· Manually. Data updating is performed only manually using the special Update option in the

Database tab of the ribbon.

By pressing OK you complete creation of a database by reference. The Database Properties dialog is

closed, and the table of the new database appears on the screen. It can be viewed but editing the

contents is not allowed. The access to the data from a database by reference is carried out similar to

the access to internal databases, i.e., by using the name of the database by reference similar to the

name of the internal database. In this case the syntax of functions remains the same.

Additional Commands of Database’s Editor

Let us review still not mentioned commands of the main toolbar that are designed for working with

databases.

The Save command in the Database ribbon tab allows you to copy the internal database to an

external file of the "*.accbd" or "*.dbf" format. The base itself does not change, it remains internal. This

option can also be applied to the database by reference, in this case the current internal version of the

database will be copied to the external file.

The Update command in the Database ribbon tab is used for referenced databases and allows you to

force a update (from a file) of the contents of the database.

The Table Properties command on the Database tab of the ribbon allows you to edit database

attributes. For internal databases, you can edit the name and comment. You can also convert it to a

database by reference by selecting the appropriate checkbox and specifying the name of the external

source file. In this case, the existing content of the database will be lost. For a referenced database,
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using the Database Properties command, you can change the name, comment, path (including the file

name), and table name.

To link the parameters of your drawing with an external database, use the functions for selecting

values from external databases - dbf( , , ), dbfwin( , , ), mdb( , , , ).

To select values from an internal database or a database by reference, use the functions for selecting

values from internal databases - rec( ), frec( , , , ), val( , ), find( , ).

When working with the database editor, a mechanism for copying/pasting data between windows and

with external data sources is supported. The order of the columns in the table can be changed by

simply dragging and dropping their headers.

When working with the database editor, there is a single system-wide mechanism for undo/redo

actions.

Read about the peculiarities of using databases when creating Libraries of Parametric Elements

libraries of parametric drawings in the corresponding chapter.

See also:

· Database Functions

· Adoption Variables and Databas

Graphs

The list of graphs is accessed via the command:

Icon Ribbon

Parameters > Tools > Graphs

Keyboard Textual Menu

<PL> Parameters > Graphs

There is a special object type in the T-FLEX CAD system - the Graph. A graph is a function based on a

set of points in its own two-dimensional coordinate system, connected by a polyline or by a smooth

curve. This versatile instrument serves to define dependencies of different nature, for example, to

specify a variable load in Analysis modules, or to create a parametric dependency based on an array

of numbers from a database. Graphs are also used to store and display results of a dynamic motion

analysis. Graphs can be used in the variables editor to read the values that they define. 

Creating and editing graphs 

Graphs can be created in several ways - using the Graphs window and directly from operations where

graphs are set, for example, in a graphical form, you can also set the laws of scaling or torsion in the

Sweep operation, in the properties of the equidistant 3D path to set the offset of the equidistant, in

the Blend Edge operation to define a variable radius. 

Graphs are created and stored in the document together with the drawing and the 3D model.

The system provides a specialized editor to create and edit graphs. It serves to manage arrays of

points and their coordinates, supports multiple point selection as well as clipboard handling

(copy/paste), undo/redo actions, axial zoom control, points dragging etc.



T-FLEX CAD 17 Help

2682

In addition, graphs can be used in dynamic calculations using the variable editor.

For this, the dynamic motion analysis module must be installed.

In the Dynamic Motion Analysis module, graphs are used in several cases:

1. To display the result of a dynamic calculation - to record time-varying coordinates, forces,

moments, etc.

2. To set variable loads, springs.

The finished graph can be used in the variable editor for further calculations by reading the values of

its function in the variable editor using the graph expression (graph name, argument value).

For more information, see the Dynamic Motion help.

Topics in this section:

· Graphs Window

· Graph Editor

· Using Graphs in 3D Operations

Graphs Window

Working with graphs is done via a special dialog window - the Graphs window, which displays the list

of all graphs in the current document, and the buttons to start all required commands. 

After calling the command, the Graphs window appears.
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To create a new graph, use the Create Graph… button. When creating a new graph, you are prompted

to select the connection type of the graph nodes: by a spline (a smooth curve), by a polyline or by

function. A newly created graph is empty. It is assigned its own name – "Graph_1", "Graph_2" etc. If

desired, the user can modify the graph name using the button Rename or in its properties (see below).

The buttons Delete and Delete All serve to delete existing graphs from the current document.

Graph Properties

A dialog with descriptive and defining graph properties can be accessed by clicking the Properties…

button in the graphs manager window.

The graph name and type are displayed in the upper part. You can edit the graph name. The graph

type is defined at creation and is not changed later.

You can define the following graph properties in the Units parameters group: 
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· The labels for the graph's coordinate axes – in the fields Argument Axis Title and Function

Axis Title;

· The Function/Argument Scale Factor parameter defines the units scale along one axis relative

to another one when plotting the graph. It is used to setup the image when individual axis

scales need to be used. The graph editor can set this value automatically (see below);

Function/Argument Scale Factor = 1

  

Function/Argument Scale Factor = 2

· The Minimal Argument Step parameter determines the minimum allowed distance between

two neighboring nodes of the graph in the X-direction. 

The Current Limits group of parameters displays the information regarding the current graph bounds.

You can also deliberately impose graph limits by the argument and by the function. When limits are

enabled, the system will not allow creating points out of the limit bounds. By default, limits are not

imposed.

The Boundary Conditions group of parameters defines the conditions for the ends of the graph line.

Such parameters can be used only for the "smooth curve" graph type. You can define the tangent of

the curve direction slope at the graph start and end. You can also set equalities of first and second
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derivatives at the graph start and end. Such boundary condition allows obtaining a smooth transition

between copies when having a master graph segment repeated cyclically.

The Return Closest Functions Value for Arguments out of Graph Limits flag serves to use the graph

for any argument values, including those outside the existing defining range. This parameter is used to

work with the function graph("GRAPH NAME", ARGUMENT VALUE) of the variables editor.

The Read Only Mode flag prohibits modifying properties and coordinates of graph points. 

The Show Nodes flag enables the display of function nodes on the graph.

The Show Limits flag turns on graphic rendering of the range-of-definition bounds and the values

range (actual) for the given graph. Graph bounds are displayed as a dotted frame.

The flag Logarithmic Argument Scale sets the logarithmic scale along the argument axis of the graph.

The Auto Repeat group of parameters defines a cyclic repeating of a master graph segment in both

directions. When repeating in the positive direction, then each copy of the master segment is attached

by its start point at the end point of the graph, and vice versa when in the negative direction.

Graph Editor

Graphs are edited in a special graph editor. The editor is called by selecting the desired graph in the

Graphs window and clicking the Edit… button, or by double-clicking on the graph's row. To

simultaneously edit several graphs, select them into graphs manager using <Shift> and use the Edit…

button as well. All graphs will be simultaneously displayed in the editor. At the same time, one of

them will be active and editable. To switch between graphs, use the interface control (the drop-down

list) with graph names.

The main portion of the editor window is occupied by the workspace, in which graphs are displayed.

The workspace is ruled for convenience with an automatically scalable coordinate grid. Image moving

(panning) and scaling (zooming) is done by the mouse wheel – in the same way as when drawing in T-

FLEX CAD.
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The coordinate rulers are displayed along the borders of the workspace. You can use these rulers in

the same way as in the T-FLEX CAD drawing window – to pan and zoom the image. The graph editor

allows separate zooming along the coordinate axes. Separate zooming is done using a ruler, when the

appropriate mode is enabled in the graph properties, or by the  icon on the editor's View toolbar.

A specified ratio of coordinate axes units is automatically stored in the graph properties. 

Clicking  in the workspace creates a new graph point. All points are connected by a line (curve) of

the specified type (a polyline or a spline). For user convenience, the current cursor position

coordinates are displayed in the status bar in the lower-right corner of the graph editor.

At the right of the workspace there is the table of graph point coordinates. Point coordinates can be

edited directly in this table. You can start editing coordinates after double-clicking  in the

desired table cell. To input changes, press <Enter> or switch the input focus to another window. The

edited (selected) graph point is highlighted. To select several points, use the keys <Shift> or <Ctrl>.

A graph point position can be modified with the cursor, by grabbing the point with  and dragging

it to the new position. When double-clicking  on a graph point, a special dialog appears to

edit point coordinates. Here you can enter the absolute point coordinates (when switched to position)

or set offset coordinates with respect to the current point position (when switched to offset). If, when

double-clicking , several points were preselected (for example, in the table of coordinates),

then only the offsets can be used. This is convenient, if you need to move a segment of the graph by a

certain distance (see an example below).
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Graph Editing Tools

The graph editor has three bars with various tools and icons to launch utility commands.
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The Standard toolbar looks like this: 

It contains:

· Commands to close the graph editor with or without saving changes:

Save changes and close

Cancel changes and close

<Ctrl><S> Save to File (allows you to save the edited graph in *.tflaw format) 

<Ctrl><L> Load to File (allows you to save the edited graph in *.tflaw format allows you to

replace the edited graph with another graph from an external *.tflaw file. As a result of the command

execution, all starting points are deleted, and the main properties are replaced by others)

· A drop-down list to select the name of the graph being edited is used when several graphs are

edited simultaneously.

The Edit toolbar looks like this:

It contains:

· An icon to call the edited graph properties dialog:

<Ctrl><P> Graph Properties

· A drop-down list (combo box) to define the colors of the graph line:

- Graph Color

· Commands to work with the clipboard:

<Ctrl><A> Select all nodes

<Ctrl><C> Copy

<Ctrl><X> Cut

<Ctrl><V> Paste

To copy graph points to the clipboard, you first need to select points in the table of coordinates or in

the workspace. Next, you can use the command Copy or Cut. When copying graph points, the system

must remember the reference point for future snapping when pasting from the clipboard. 

To define the point, the Copy… dialog window appears. The user can define the coordinates of the

reference point or select it on the graph. To select a point in the workspace, you need to enable the

option Show on Graph and click OK. Next, the system goes into the mode of waiting for point

selection. The respective help message appears at the bottom of the graph editor in the status bar

line. The user can point at any location in the workspace or select any of the existing graph points. If

the user did not specify a reference point, the system will use the origin instead. 
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When adding the copied points from the clipboard to the graph, the system will prompt for defining

the target point to snap the insertion to. The Insert Nodes dialog window will appear. In it you can

also define the coordinates of the insertion target point or enable the mode of selecting such point in

the workspace. If the user did not define the reference point at the time of copying, then, when

defining the coordinates for the insertion, the user will thus define the offsets of the new graph points

from the original position. When specifying the target point, the preview image of new graph points

rubberbands with the cursor.

· Commands to work with graph nodes: 

<Ctrl><N> Add new Node by Coordinates

<Ctrl><E> Edit Node Coordinates

<Del> Delete Selected Nodes

<Ctrl><Shift><Del> Delete All Nodes

· Commands to undo unwanted actions and redo undone actions:

<Alt><BackSpace> Undo

<Ctrl><BackSpace> Redo

· Options to enable the modes of selecting nodes and object snapping:

- Mark / Select nodes

- Snap to Nearest Point

- Snap to Nearest Node

<Ctrl> Move Nodes by Coordinate Axes

The View toolbar look like this:
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It contains:

· The command to refresh the image:

<F7> Update Window

· Commands to zoom in and out the image:

<Ctrl><Shift><PgUp> Zoom In

<Ctrl><Shift><PgDown> Zoom Out

· The command to automatically fit the entire image within the workspace window bounds:

<Ctrl><Shift><End> Zoom All

· Commands to pan (move) the image:

<Ctrl><Shift><Left> Left

<Ctrl><Shift><Right> Right

<Ctrl><Shift><Down> Down

<Ctrl><Shift><Up> Up

· The button to enable the mode of separate zooming by axes:

- Zoom separately by axes

· The command to enable/disable the mode when a special vertical marker is displayed that

reads the argument position and returns the respective function value. This command is

duplicated with a special switch flag in the graph editor options (see below):

- Argument Marker

· An icon to call the graph editor options dialog (see options description below):

<Ctrl><O> Options

The drop down list, which pops up upon pressing the symbol  to the right of the button, allows the

user to customize the view of the graph editor window (display of the toolbars, rulers, grid, etc.).

Setting Up the Graph Editor

The dialog contains interface controls to set up the graph editor appearance.
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The Show group of options contains the switches to enable/disable auxiliary utility objects – the ruler,

the automatically scalable coordinate grid, coordinate axes, the argument marker. 

The pane in the Current View group of options displays the coordinates of the displayed area for the

user reference. 

The flag Independent Zoom by Axes controls the mode of independent scaling along the axes. If it is

turned on, then upon scaling with the help of the ruler the visual scale factor along the X-axis changes

independently of the scale along the Y-axis.

The flag Logarithmic Scale by Argument Axes is a reference flag and is always unavailable for

editing. This flag shows what argument scale is set in the properties of the graph being edited.

In the right part of the dialog there is a group of controls to set up the colors of various objects in the

graph editor.

With the help of the parameter Ruler Font Size you can also define the font size for the graph editor

ruler.

«Views Placement» command

Using the command Views Placement, the graph editor can be placed in a separate document

window. When working with a graph, a special Graph ribbon tab will be automatically activated.
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Using Graphs in 3D Operations

Graphs can be used for a more intuitive way of defining tabular dependencies in some 3D modeling

commands. For example, in the Blend Edge command – to define the law of changing a variable

radius, in the Sweep operation – to define the law of changing the twist angle or scaling of the

contour or in the Transition Surface operation to control the discriminant value. It can be used

wherever you need to define the law of changing some operation's parameter over a certain range,

whose length is defined in percent (0%-100%). 
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To define a dependency by a graph, use the special Graph button in the operation properties window,

next to the field for defining the entries of tabular dependencies or a value entry field. Upon clicking

the button, the graph editor opens, in which there is already a graph constructed based on the input

data. (By default, those are the point positions 0% and 100% with the respective parameters.) The

graph type in this case is always a smooth curve. 

Depending on the operation type, we can distribute various properties using a graph. The definition

range and the graph values range are also limited depending on the operation type. The range of

values allowed for input in the X-axis is always from 0 to 100. This defies the position of each point. In

the Y-axis we reckon the operation parameter values for each point. For example, for a variable round

blend, one can define the law of the radius distribution along the span of the selected edges. In this

case, the system will not allow setting the function value less than zero, since this is restricted in the

blend operation.

The result is shown below:
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To save the results of editing a graph, exit the editor by clicking the button . After closing the

editor, the system will transfer all graph points to the properties window to display the dependencies

in the tabular form.

In some operations (for example, Transition Surface), it is possible to create a dependency graph with

the ability to customize its type, axis type and units of measurement without entering the graph

manager. By connecting such a graph, you can control, for example, the magnitude of the

continuation of the surface or the radius of the arc, thereby making these values not constant. To do

this, in the required operation, click the Add Graph graph button.
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If any graph already exists in the model, then it can be selected from the Use Existing Graph.

Existing graphs are also displayed in the Graphs Window.

Graph types Polyline and Cubic Spline are used for linear parameter variation and cubic variation law.

At each point of a cubic spline, the parameters of the tangent angle and the scale of the tangent

vector are available: this makes it possible to describe with high accuracy any mathematical or

empirical dependence.
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Graph type - Polyline

Graph type - Cubic Spline

If you select the option of the graph type By 3D Curve, then in the case of a transition surface - the

discriminant, the system will offer to additionally select two curves in the 3D scene.
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The first one will define the X-axis: Support Curve. The second, Law Curve, will determine the distance

from the reference curve, thereby setting the value of the function.

The dialog for creating a graph also allows you to define the type of value along the X axis and the

unit of measurement for length, if the option for the X axis is selected as length.

Set Value

The command is called as follows:
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Icon Ribbon

Parameters > Tools > Set Value

Keyboard Textual Menu

<PE> Parameters > Dimensions > Set Valueaphs

This command is intended to change the model (3D model or 2D drawing) using dimensions. The user

can specify a new value for the nominal dimension, and the system will automatically recalculated the

3D model or drawing based on parametric relationships. This editing is available both for 2D

dimensions (i.e. dimensions in a drawing) and for 3D dimensions (dimensions in a 3D model), as well

as their corresponding dimensions in 2D projections.

This command allows you to edit the drawing and 3D model by changing the nominal values of the

dimensions affixed to them.

When the value of the dimension number changes, the system tries to find the construction elements

responsible for the dimension value. If such elements are found and their construction method allows

changing the parameter value, then they are recalculate in accordance with the new value of the

nominal dimension. If several suitable construction elements are found, the system will choose the one

that changes will lead to changing as few other dimensions as possible. Otherwise, the model does

not change.

The action of the command is similar to the execution of the command Edit Constructions, i.e. when

the position of any construction line is changed, the 2D elements (construction lines and/or graphic

lines, dimensions, labels, etc.) associated with it will be recalculated. If the position of the recalculated

elements was determined by variables, their values are automatically changed, the system will issue a

request for an automatic change from the values.

To enable the command in the transparent mode, you need to set the flag Dimension edit is

transparent in the Set System Options command, the tab 2D. In this mode, when the left mouse

button is pressed on the image of the dimension number, it is selected in a rectangular area for

editing. The selected dimension value is highlighted, ready for editing. If the "transparent mode" is not

set for this command, dimension values can be selected for editing only after the explicit command

call.

Besides that, this command is available in the context menu when selecting a dimension (whether a

2D dimension or a 3D dimension).

Upon calling the command, the following icons appear in the automenu:

<Enter> Finish Value input
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<Esc> Exit command

Select the dimension and enter the new nominal value:

Then confirm the input by pressing the <Enter> key or . As was already mentioned, the drawing

changes only when it is possible. 

The command will not work correctly in the following cases:

· the dimension parameters are set to Nominal > Manually or No;

· the referenced construction elements definition does not allow their position modifications.

For example, you cannot change the value of a circle radius if the circle is tangent to three

entities.

· changes in the construction entity positions caused by the dimension modification make the

system unable to define the position of some element with respect to other affected entities.

In all of these cases, the dimension reverts to the original value, with no changes done to the drawing.

If construction elements, the position of which changes when a new value of the nominal dimension is

entered, are associated with a change, then the value of the variable will also be recalculated.

Recalculate Tolerances

The command can be called by one of the following means:

Icon Ribbon

Parameters > Tools > Recalculate Tolerances

Keyboard Textual Menu

<PN> Parameters > Dimensions > Recalculate Tolerances

The command performs correction of the denominations of all dimensions at the lower, upper limits

or in the middle of the tolerance field. Accordingly, in the case of recalculation to the middle of the

tolerance field, the new dimension tolerance field becomes symmetrical. This function is convenient to

use when adapting a 3D model for calculating toolpaths in the CAM module.
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After calling the command, the recalculation parameters dialog opens:
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For each selected dimension, you can specify your own recalculation option.

Recalculate to Lower Limit of Tolerance

Recalculate Middle of Tolerance

Recalculate to Upper Limit of Tolerance

Restore Tolerance Values

After choosing the recalculation option, you must select the required dimensions. This can be done

manually by selecting dimensions in the 3D scene, or using the buttons Add Dimensions from Current

View , Add Dimensions from All Pages , Add All Variables with Tolerance .

In order to add variables, it is necessary to set the tolerance in the variable parameters in advance.
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For each dimension, you can open the Information window .

In order to recalculate the values changed after recalculating the tolerances, the corresponding option

 is used.

The dimensions are recalculated by pressing the  icon. You can preview the recalculation result

using the  option.

When previewing the result of the recalculation, the system highlights the dimensions that it managed

to recalculate and those that could not be recalculated or they were recalculated incorrectly with

different colors. By default, correctly recalculated dimensions are marked in blue, incorrectly

recalculated dimensions are marked in red. If necessary, you can set your own markup colors in the

parameters window.

As the deviation value, both symmetrical values obtained as a result of recalculation and zero values

can be specified. The selection is made by setting/unsetting the checkbox Delete Symmetrical

Tolerances. When the checkbox is unset, symmetric deviations are entered into the parameters of the

recalculated dimensions, when the checkbox is set, zero deviations are entered.

Optimization

Optimization of the model is done by using the Optimize command:

Icon Ribbon

Parameters > Tools > Optimize

Keyboard Textual Menu

<PO> Parameters > Optimize

The command is intended for solving problems of optimization of a 2D drawing or 3D model. The

solution to the problem is to select the values of the existing variables that best satisfy the stated

conditions. The command can be called only if there are numerical variables in the document. 

After calling the command, the Optimization Tasks window appears, containing a list of generated

optimization tasks.
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The column Name displays the name of the variable, whose value is optimized by the current task. The

column Comment contains textual strings entered by the user. 

A T-FLEX CAD document may contain any number of optimization tasks.

The graphical buttons at the bottom of the dialog box allow the following actions:

· Add. Entering a new optimization task.

· Delete. Deleting the task of the current list item.

· Properties. Displays Optimization Parameters dialog box of the current list item task.

· Run. Starts the optimization computations. The system seeks for the solution according to the

specified optimization parameters and regenerates the drawing or the 3D model with the

found variable values.

· Close. Exits the command.

Optimization task definition

Upon pressing the Add button, the Optimization Parameters dialog box is displayed that contains the

following fields:



T-FLEX CAD 17 Help

2704

Goal. Keeps the textual string that is the comment of this optimization task. Next are the combo box

for selecting the target function (Make Equal, Minimize, Maximize), the variable Name combo box

and the Tolerance input box. The variable is selected from the list containing all numerical variables

present in the document. If the selected function type is Make Equal, then the input box becomes

accessible for entering the target value of the variable.

The tolerance value defines the admissible range of the values of the target variable within which the

optimization task is considered solved. 

Limitations. Defines the list of restrictions on the model variables when performing the optimization.

New limitations are entered upon pressing the Add button.

 In the Variable box, set the name of the desired variable (one variable can be subject to multiple

restrictions). In the "Condition combo box, select one of the comparison types (<, >, <=, >=) for

comparing the variable against the target value (the Value input box). To modify the entered
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limitations, use the button Properties that allows editing all fields of the current line in the limitations

list. Pressing the Delete button deletes the current line of the limitations list. 

Variables. This is the list of variables whose values will be the subject to the optimization process. The

range of admissible values is to be defined for each variable. To be formulated correctly, the

optimization task requires defining the range of admissible values for at least one variable. The

graphic buttons Add, Properties and Delete work similar to those described in the previous section.

To define a new record, you need to fill in the following entries:

Set the variable name by selecting from the list in the Variable combo box (each variable can have

only one the range of admissible values).

The entries Minimum and Maximum define the bounding values of the variable's range of admissible

values. When solving the optimization task, the values of the variables are tried that satisfy the set of

the limitations and fall in the range of admissible values. Once a limitation is defined for a variable, its

name is no longer available for defining the range of values, and vice versa. The variable whose value

is the target of the optimization is not included in the lists of variables when defining limitations and

the value ranges. 

Run. This parameter takes one of the following values: 

· User. The optimization task will run only upon user pressing the bottom Run in the

Optimization Task dialog box. Optimizing may take long time on complicated drawings or 3D

models. The described setting allows skipping optimization when regenerating the model.

· On optimal Model Regeneration (<F7> - for 2D window, <3><G> - for 3D window). The

optimization task will run upon partial (optimal) model regeneration (when only modified

elements are regenerated). 

· On full Model Regeneration (<Ctrl><F7> - for 2D window, <3><R><G> - for 3D window). The

optimization task will run upon full model regeneration.

Optimization algorithm selecting

1. Fast Search. This method is suitable for functions with one or two extremes. 

2. Iterative Search. This method is suitable for functions with complicated behavior and multiple

extremes.

3. Dichotomy. This method is suitable for functions of one variable. 
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· Show current result. If this flag is set, the Finding Solution window dynamically displays the

variable values as the solution progresses.  

· Recalculate 3D model. Setting this flag forces the 3D model regeneration at each step of the

optimization algorithm. If the target function of the optimization (the variable) is related to 3D

elements, then this flag is required for proper optimization process.

Bottle volume optimization task 

This example clarifies use of optimization for 3D models. The file for the example is located in the

library Examples\Additional resources\Optimization\Bottle.grb". 

The example presents the solution to the bottle volume problem. In this example, the variable

"Volume" is created, equal to the bottle capacity, that is, the volume of its contents. The variable "H"

defines the height of the bottle, while "HW" – the level of the liquid in it. The optimization task is to

maintain the constant bottle capacity (0.5 liter = 500000 mm3) while varying the bottle height and the

level of the liquid in it. To achieve this goal, we need to find the value of the variable "D" driving the

median diameter of the bottle (the widest portion diameter). The optimization task "Volume" was

defined in the command Optimize Model as follows. 

The target function equates the variable "Volume" to 500000 with the tolerance equal 1. The

modifiable variable is "D", in the range from 70 to 90. No additional conditions are imposed on the

model variables; therefore, no restrictions are defined. To visualize the optimization process, the flags
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are turned on, Show current result and Recalculate 3D model. The dichotomy method is selected for

the optimization algorithm, with the maximum number of iterations equal to 100. The parameter Run

is set to the option User, so that the optimization is run only upon the user request.

After specifying the optimization task, let's modify the model. For example, let's reduce the bottle

height and, respectively, the level of the liquid in it, by changing the values of the variables H and HW.

This reduces the capacity of the bottle.



T-FLEX CAD 17 Help

2708

To adjust the bottle diameter, simply call the Optimize Model command, select the Volume task in

the coming up dialog box and press the Run graphic button. The shape of the model will be changing

on the screen according to the current values of the variable being optimized as the solution

progresses.



Variables and Related Parametric Tools

2709

By accepting the found solution by pressing the button OK, we get the bottle 220 mm high and 0.5

liter in capacity.
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Model Geometry Analysis

Topics in this section:

· Measure

· Mass Properties

· Model Check

· Intersection Check

· Check Changes

· Curve Curvature

· Surface Curvature

· Surface Curvature by Sections

· Deviation Control

· Surface Deviation

· Surface Gap

· Normal Deviation

· Surface Smoothness

· Model Separation Check

· Contour Check

Measure

Calling the command:

Icon Ribbon

Measure > Measure > Measure

Analysis > Additional > Measure

Support Geometry > Additional > Measure

Keyboard Textual Menu

<PM>
Parameters > Measure

Tools > Geometry Analysis > Measure

The Measure command allows you to measure various geometric characteristics (coordinates, length,

perimeter, area, volume, etc.) of a 2D or 3D object, as well as the relationship (distance, angle, etc.)

between two objects. Based on the measured characteristic, a new variable can be automatically

created or the value of an existing one can be changed. Measurement results can be saved, displayed

in a report and illustrated with decorations.

The following options are available in the command's automenu:

<Y> Finish input

<Esc> Exit command

<B> Body measurement mode

<N> Create 3D Node
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<S> Save Measure Result

The options  and  are available only after selecting the measurement object, and under the

conditions specified below: the option  is described in the Decorations subsection, the option

 is described in the 3D Node Based on Measurement Results subsection. The additional mode

 is described in the following subsection.

There are three measurement modes available, switching between which is carried out using the

corresponding icons.

Measure one element parameter

Measure relation between two elements

Measure Multiple Elements

After activating the selected mode, pick the object or objects to be measured in the 2D or 3D window.

The state of element selection filters in the system toolbar affects the selection. The set of filters

depends on which type of window is currently active in the system (2D or 3D).

Dialog fields

The following fields are available in the command dialog.

Element. Contains the selected item.

If two elements are measured, two fields will be available in the dialog: First Element and Second

Element. If several elements are measured, the Elements field will be available, which will contain an

editable list of selected elements:  - delete the selected element,  - clear the entire list.

Filter. Contains a list of options for filtering measurement results. By default, all available

measurements are displayed.
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If the filter selects only measurements that are not available for the selected element, the

measurement window will be empty.

System of units. Contains a list of available options for displaying units of measurement.

From document. The units of measurement set for the document will be used in the Set Document

Parameters window in the Units group.

SI. International Metric SYSTEM.

MKGSF. Meter, kilogram-force, second.

Imperial. Foot, pound.

CGS. Centimeter, gram, second.

For each selected value, you can configure the unit of measurement separately in the Value field. The

Expression field specifies the selected units of measurement.

In this case, the syntax of the expression entry will change: instead of the get() function, there will be a

get_u() function. Similarly for other functions: distance() and distance_u(), measure() and measure_u().

If you need to specify the LCS and change units of measure at the same time, then you first need to set

the LSK, and then change IT. In this case, the function will take the form gt_lcs_u(). For the distance()

and measure() functions, the suffix "_lcs" is not added.

Value. Displays the measurement value in the selected unit of measurement.

Expression. Displays an expression, according to the syntax of the variable editor, for the specified

dimension. The expression can be written to a variable and automatically recalculated when the

original measurement objects change. To write an expression to a variable, you need to use the

expandable part of the Variables dialog.

The Measure command has the following measurement functions used in the Expression field:

· Measure the parameter of one element:  get(), get_u(), get_lcs(), get_lcs_u(), getv(), tgetv();

· Measure the ratio between two elements: distance(), distance_u(), measure(), measure_u();

· Measure several elements: get(), get_u(), get_lcs(), get_lcs_u().

For more information about the functions of the Measure command, see the get(), getv(), tgetv(),

distance() and measure() sections.

Field with measures. The measurement window is displayed as a table with a configurable number of

columns. All columns are displayed by default.
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Select Property for Report. When the flag is set, the measurement is included in the report (available

only if the Add to Report option is enabled).

Description. Brief explanatory information about the measurement.

Value. Displays the measured value in the selected system of  units of measurement.

Units. Displays the accepted abbreviation for units of measurement.

Property. Displays the system name of the measurement (object property).

To customize the displayed columns, you need to call the context menu for the column header.

Reset. Returns the order and number of displayed columns to the original variant.

Measurement report

All measurements can be displayed in a report in .txt format. To do this, activate the Add to Report

option and select in the measurements window those parameters that should be included in the

report. When the option is activated, a new tab Measurements for Report will appear, allowing you to

select a presentation option and copy or save the report.

The list of results added to the measurement report is specified by flags in the special column Select

Property for Report.

The set flags are applied to all the subsequent measurements performed in a single session of the

Measure command. In addition, the command stores the list of results specified for different types of

measured elements. When you re-measure elements of the same type, the desired results

automatically appear in the report window. It is convenient when you need to measure several groups

of the same type of elements and analyze them by the same parameters.

Measurement results from the report window can be saved using the Measurements for Report tab.

The tab is initially minimized in the command dialog, but you can drag the window to a convenient

location on the screen or to a second monitor. 
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The window has two options for representing Text or Table. Both options of the results output enable

us to understand for which items all the measurements were performed and what were the results. The

Table option displays results with horizontal scrolling of measurements and automatic grouping by

measurement method, while the Text option displays measurements with vertical scrolling.

To save the report, press the  button.

Decorations

The decorations are a small window with brief information about the measured object. For some

measurements, the decorations contain graphic explanatory elements.

To display decorations, the Show Decorations checkbox must be checked.
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In this case, when you select any property from the list of the measurement window, a special window

with brief information about the measurement will appear in the 3D scene. Decorations are not

available for 2D windows.

A measurement with decoration can be saved. To do this, use the  automenu option and

complete  the command.

<S> Save Measure Result

Only one measurement can be saved per command session. You can only save a measurement with a

decoration. If the Show decorations flag was not specified, and the measurement was saved, then the

decoration will be created automatically.

After saving the measurement result, the corresponding object will appear in the 3D model window.

Measurement results can be merged into one decoration. If you select several measured properties

using “Ctrl” or “Shift” and set the Merge Labels option flag, then the properties will be displayed in

one decoration window.

 

Measurement coordinate system

It is often necessary to obtain the characteristics of an element relative to a given coordinate system.

For example, when measuring the moment of inertia around given axes. In this case, in the dialog, set

the checkbox of the Measurement Coordinate System option. In this case, the LCS field will become

active and the LCS selected in the 3D scene will be displayed in it.



T-FLEX CAD 17 Help

2716

The LCS field is editable: by pressing  you can remove the selected LCS from the field and set

another one by re-selecting. Or do not specify LCS again - then the measurements will be performed

in the global coordinate system.

If LCS is specified, the syntax of the function in the Expression field will be changed: instead of get(),

there will be get_lcs(), and the specified LCS will be indicated in the expression.

For the distance() and measure() functions, the suffix "_lcs" is not added.

If LCS and units of measurement are specified simultaneously, the function name will be changed

according to the addition of LCS and units of measurement: get_lcs_u(). At the same time, the selected

LCS and the units of measurement will be indicated sequentially in the comma-separated expression.

In the case of using measure(), the LCS is indicated in the expression before the name of the measured

property, and the units of measurement is indicated after, while the suffix "_lcs", as already indicated,

is not added.

Variables based on measurement results

The expression of each dimension can be written to a variable. All variables created to record

measurement expressions are displayed in the drop-down part of the Variables dialog. The variables

added in the current session of the Measure command are displayed, as well as those created earlier.

The created variables will automatically change their value when the measured properties change. To

add a variable, you need to perform the following procedure.

· Select the required measurement from the list of measurements.
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· In the expandable part of the Variables dialog, call the Add Variable  command. 

· In the Variable Properties dialog box that appears, the Expression field will already be filled in

based on the Expression field in the Measure command dialog. It is necessary to enter the

variable name, if necessary, specify other parameters (working with the variables dialog is

described in the Variable Editor section).

· Confirm the creation of the variable by pressing the <OK> button. After that, the created

variable will appear in the command dialog, in the Variables section. The variable will only be

available in the variable editor after the Measure command is completed . If the

command was completed and canceled, the variable will not be created. It is not necessary to

terminate the command immediately after adding the variable. You can continue to work in

the command, including adding other variables, and all actions performed in the current

session will be accepted or canceled depending on the option to exit the command.

The Variables section of the dialog has the following commands for working with variables.

Add Variable

Change Expression

Delete Element from the List

Add Variable. Adds a variable to record the expression of the selected dimension. It described above.

Change Expression. Changes the expression of an already added variable to the expression of another

user-selected dimension. To replace the expression with a variable, you must perform the following

procedure.
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· Select the measurement to whose expression you want to change the expression in the already

added variable.

· Select the variable whose expression you want to replace.

· Click . In the dialog, in the list of variables, the expression for the selected variable will be

changed. The replacement will only be accepted after the Measure command is completed

. If the command was completed and canceled, the expression replacement will not be

performed. It is not necessary for the command to terminate immediately after the expression

replacement is performed. You can continue to work in the command, and all actions

performed in the current session will be accepted or canceled, depending on the option for

exiting the command.

You can replace the expression both for variables added in the current session of the Measure

command, and for variables created earlier.

Delete Element from the List. Deletes the selected variable in the list. Only variables added in the

current session of the Measure command can be deleted. Previously created variables can only be

deleted in the variable editor.

3D Node Based on Measurement Results

A 3D node based on the measurement results can be created for the following properties of the

measured elements:

· for properties: StartX, StartY, StartZ, EndX, EndY, EndZ - a 3D node is created on the path (at

the beginning or end, respectively);

· for properties: LocationX, LocationY, LocationZ - a 3D node is created on the surface at the

starting point of the surface;

· for the Xmass, Ymass, and Zmass properties, a 3D node is created in the center of mass;
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· for Distance, a 3D node is created on the first point of the segment that represents the

minimum distance between the selected elements (the first point of the segment belongs to

the first selected element).

If one of the above properties is selected, an additional option appears in the automenu:

<N> Create 3D Node

Clicking the  icon will create a 3D node.

Body Measurement Mode

The body measurement mode  is available only for the Measure one element parameter option.

You need to select an option in the automenu and select a body in the scene.

<B> Body measurement mode

The body measurement mode allows you to create a measurement expression in which the measured

object is a body. This is how it differs from measurements in the mode of selecting bodies using a

selection filter.

In the mode of selecting bodies using a filter, not the body will be written to the measurement

expression, but the last operation of the model tree. For example, when measuring the volume of a

body in the  mode and when selecting a body using a filter, the expression will have a different

record.
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Body measurement mode Selecting body using filter

Both measurement options may be desired. For example, if you create a variable in which to write the

expression obtained in the mode of measuring bodies, then with further changes in the tree of the

body model, the value of the variable will be recalculated accordingly: by adding a hole to the body,

we will change the volume of the body and this will be taken into account in the variable. On the other

hand, if we need to know the volume of a certain body without taking into account further changes in

its model tree, then we need to make a measurement by selecting the body using a filter: in this case,

the measurement will be made only before the operation, which at the time of measurement was the

last, and all subsequent changes to the body model tree will not be taken into account.

Measurement of material properties

The Measure command is available for the material of the 3D model. To measure material properties,

you need to activate the command and select the material in the 3D model tree.



Model Geometry Analysis

2721

Measured values of physical properties of materials can be written into variables for use in

calculations, which eliminates the need to enter them manually.

Intersection volume measurement

The measurement of the volume of the intersection of two bodies is available. If you have created the

result of the intersection of several bodies, you can measure the volume of the intersection between

the two selected bodies. To do this, in the Measure command, you must first select the intersection

result, and then the two necessary bodies.

Measure one element parameter

To measure the properties of one 2D or 3D element (length, perimeter, area, volume, etc.), you need

to enable the Measure one element parameter option. After enabling this mode and selecting the

measured object, it will be displayed in the command dialog in the Element field. The Element field is

editable: using  you can deselect the element and re-select it. In addition, the system automatically

resets the object if you specify a new item.
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Measured properties

The set of properties that can be measured depends on the selected measurement object. Below is a

list of properties for all 2D and 3D objects.

2D elements

2D nodes:

X – X-coordinate of the node;

Y – Y-coordinate of the node;

Construction entities:

Straight lines:

X, Y – coordinates of the first point through which the construction line passes;

P1, P2 – coordinates of the second point through which the construction line passes;

Circles and ellipses:

LENGTH – length of the circle or ellipse;

P1 – circle radius (this parameter is specific to circles);

X, Y – coordinates of the circle or ellipse center;

Splines, 2D paths, functions and offsets:

LENGTH – element length;

Graphic entities:

Straight segments:

LENGTH – segment length;

START_X, START_Y – coordinates of the segment start point;

END_X, END_Y – coordinates of the segment end point;

Circles:

LENGTH – arc length;

CENTER_X, CENTER_Y – circle center coordinates;

ANGLE – angular length of a graphic entity;

RADIUS – arc or circle radius;

Ellipses; splines; curves constructed by 2D path, offsets and functions:

LENGTH – element length;

for graphic lines constructed as a circular or elliptical arc, portion of spline, 2D path, offset or

function, there are following additional parameters:

START_X, START_Y – coordinates of the arc start point;

END_X, END_Y – coordinates of the arc end point;

Hatches:

AREA – hatch area;

PERIMETER - hatch perimeter;

XMASS - X-coordinate of center of mass;

YMASS – Y-coordinate of center of mass;

XAREAMOMENT – Ix component of inertia moment;

YAREAMOMENT – Iy component of inertia moment;

PRODUCTAREAMOMENT – Centrifugal inertia moment of area;

XINERTIARADIUSVALUE – Radius of inertia X;
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YINERTIARADIUSVALUE – Radius of inertia Y;

XAREAMOMENTMAINVALUE – Ix component of principal moment of inertia relative to mass center;

YAREAMOMENTMAINVALUE – Iy component of principal moment of inertia relative to mass center;

MAINAXESROTATIONVALUE – Rotation angle of principal axes.

Text:

HEIGH – text height;

WIDTH – text width;

X, Y – X and Y coordinates of text fixing point;

TEXT – contents of the text;

2D fragments:

fragment parameters are defined by the values of the fragment's real (numerical) variables.

In addition, the following parameters are available for 2D fragments:

BoundBoxLeft – left coordinate of bound box (X-coordinate);

BoundBoxRight – right coordinate of bound box (X-coordinate);

BoundBoxTop – top coordinate of bound box (Y-coordinate);

BoundBoxBottom – bottom coordinate of bound box (Y-coordinate);

BoundBoxCenterX –X-coordinate of bound box center;

BoundBoxCenterY –Y-coordinate of bound box center.

Dimensions:

FIT – fitting dimension;

LOWER_DEVIATION – lower value of tolerance;

UPPER_DEVIATION – upper value of tolerance;

TEXT_BEFORE – text before (the dimension’s value);

TEXT_AFTER – text after (the dimension’s value);

TEXT_UNDER – text under (the dimension’s value);

TOLERANCE – dimension’s tolerance;

VALUE – dimension’s value;

Leader Notes:

INSCR_TEXT – leader note text;

INSCR_TEXT_UNDER – text under leader of the leader note;

TEXT_ON_LEADER – text on the arrow;

TEXT_UNDER_LEADER – text under the arrow;

INSCR_ZONE – zone in which the leader note is located;

2D connectors

Connector’s values are returned as connector’s characteristics.

3D objects

Operations:

Area – surface area;

Mass – body mass (according to the material density);

Xmass, Ymass, Zmass - X,Y,Z-coordinates of the center of mass;

IX, IY, IZ – Moments of inertia with respect to the axes X, Y, Z;

IXY, IYZ, IZX – Inertia value with respect to the planes XY, YZ, ZX;

Volume – volume;

Density – body density;

Material – operation material;
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CoatingName – operation coating;

for Apply Material operation the following additional parameter is used:

MaterialArea – total area of faces with the attached material;

for all 3D Arrays (except arrays of faces) the following additional parameter is used:

CopyCount – actual number of copies in the array (with account of limitations and exclusions);

for Hole operation the following additional parameter is used:

HoleCount – actual number of holes;

3D nodes:

POINTX, POINTY, POINTZ – X, Y, Z-coordinates of a 3D node;

3D profiles:

Area – surface area of a 3D profile;

Perimeter – perimeter of a closed 3D profile or length of an open one;

Geometry – type of geometry;

3D paths:

Perimeter – length of a 3D path;

Geometry – type of geometry;

For a 3D path, characteristics similar to an edge are added (see below).

Faces:

Area - surface area;

Perimeter - face perimeter;

Geometry - type of geometry;

for a flat face the following additional parameters are used:

LocationX, LocationY, LocationZ – X, Y, Z-coordinates of the plane origin;

NormalX, NormalY, NormalZ – X, Y, Z-coordinates of a flat face normal;

RefDirectionX, RefDirectionY, RefDirectionZ – X, Y, Z-coordinates of a plane vector (the plane vector

defines the direction of the X-axis of a flat plane);

for a cylindrical face the following additional parameters are used:

Radius – cylinder radius;

Diameter – cylinder diameter;

CenterX, CenterY, CenterZ – X, Y, Z-coordinates of the center;

AXISX, AXISY, AXISZ – X, Y, Z-coordinates of the cylinder axis;

ThreadStandard – standard of thread;

ThreadSide – side of thread;

ThreadDiameter – diameter of thread;

ThreadStep – step of thread;

ThreadHeight – height of thread;

ThreadNumberOfVisits – number of thread;

ThreadDirection – thread hand;

ThreadNotation – notation of thread;

ThreadStartOffset – offset from thread start;

ThreadEndOffset – offset from thread end;
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ThreadFaceDiameter – face diameter;

for a toroidal face the following additional parameters are used:

MaxRadius, MinRadius -  major and minor torus radii;

CenterX, CenterY, CenterZ – X, Y, Z-coordinates of the torus center;

AxisX, AxisY, AxisZ – X, Y, Z-coordinates of the torus axis;

for a spherical face additional characteristics are used:

Radius – sphere radius;

Diameter – sphere diameter;

CenterX, CenterY, CenterZ – X, Y, Z-coordinates of sphere center;

for a conical face additional characteristics are used:

Radius – cone radius;

Diameter – cone diameter;

ConeRadiusMax – cone largest radius

ConeDiameterMax – cone largest diameter

ConeHeight – cone height;

ConeHeightFull – full cone height;

CenterX, CenterY, CenterZ – X, Y, Z-coordinates of the cone center;

ThreadStandard – standard of thread;

ThreadSide – side of thread;

ThreadDiameter – diameter of thread;

ThreadStep – step of thread;

ThreadHeight – height of thread;

ThreadNumberOfVisits – number of thread;

ThreadDirection – thread hand;

ThreadNotation – notation of thread;

ThreadStartOffset – offset from thread start;

ThreadEndOffset – offset from thread end;

ThreadFaceDiameter – face diameter;

Edges:

Perimeter – edge length;

StartX, StartY, StartZ – X, Y, Z-coordinates of the start point;

EndX, EndY, EndZ – X, Y, Z-coordinates of the end point;

Geometry – type of geometry;

for a straight edge the following additional parameters are used:

VECTORX, VECTORY, VECTORZ – X, Y, Z-coordinates of the segment direction;

for a circular edge or along circular arc:

Radius – circle radius;

Diameter – circle diameter;

CenterX, CenterY, CenterZ – X, Y, Z-coordinate of the circle center;

AxisX, AxisY, AxisZ – X, Y, Z-coordinates of the circle plane normal;

StartAngle – arc start angle;

EndAngle – arc end angle;
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additional parameters for the elliptical edge are:

MajorRadius – ellipse major radius;

MinorRadius – ellipse minor radius;

CenterX, CenterY, CenterZ – X, Y, Z-coordinate of the ellipse center;

AxisX, AxisY, AxisZ – X, Y, Z-coordinates of the normal to the ellipse plane;

MaxDirectionX, MaxDirectionY, MaxDirectionZ – X, Y, Z-coordinates of the ellipse major axis;

MinDirectionX, MinDirectionY, MinDirectionZ – X, Y, Z-coordinates of the ellipse minor axis;

StartAngle – start angle of the elliptical arc;

EndAngle – end angle of the elliptical arc;

Loops:

Perimeter – loop perimeter.

3D connectors:

Connector’s values are returned as connector’s characteristics.

It is also possible to measure the circles of imported parts without selecting the Create Precise

Edges option.

Measuring relation between two elements

To measure relations between two 2D or 3D objects, activate the mode Measuring relation between

two elements and subsequently select two measured objects. The selected objects will be highlighted

and entered in the fields First Element and Second Element of the properties window. The fields are

editable: with  you can deselect an element and re-select it. The relationships that can be measured

for the selected items are shown below.

Measured relationships

The list of relationships that can be dependent on the selected measurement objects. Below is a list of

relationships with an indication of the pairs of 2D and 3D objects for which you can define these

relationships.

2D elements

Distance – is the distance between a 2D node and another 2D node, construction line, graphic line or

hatch (the order of selecting the measurable entities is not significant);

Angle – is the angle between two lines, segments or a line and a segment;

DX – Offset on X;

DY – Offset on Y;

3D objects

Distance – is the distance between two arbitrary 3D objects that are 3D construction entities (except

for LCS), operations or such topological objects as an edge, loop, face, vertex.

GeomDistance – is the distance between 3D points, 3D curves or surfaces corresponding to two

respective 3D objects of the types: 3D node, vertex, edge, face.

GeomAxisDistance – is the distance between 3D node, 3D path, surface and axis.

GeomFaceDistance – is the distance from element to axis.

Angle – is the angle between directional vectors of two 3D objects. Listed below are 3D objects, for

which a direction can be defined (and, therefore, this relation can be calculated). Additionally

specified is what will be selected as the direction vector for each object:

· for a 3D path, edge or open 3D profile lying on a straight line – the line direction;
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· for a 3D path, edge or open 3D profile lying on an ellipse (circle) – the vector directed from

the center of the ellipse (circle) normal to the plane of the ellipse (circle);

· for a flat 3D profile; workplane; flat face; an operation body consisting of one face lying in a

plane – the normal to the plane;

· for a cylindrical worksurface; cylindrical face; 3D profile lying on a cylinder; an operation body

consisting of one face lying on a cylinder – the axis of the cylinder;

· for a 3D profile or face, lying on a cone; an operation body consisting of one face lying on a

cone – the axis of the cone;

· for a toroidal worksurface; 3D profile or face lying on a torus; an operation body consisting of

one face lying on a torus – the axis of the torus.

The angle between curves is measured as the angle between their tangents.

· The angle is measured for two curves between tangents at the first intersection point of the

curves.

· If there is no intersection, it is measured at the intersection point of the tangent of the first

curve and the second curve.

· If the tangent does not intersect the second curve, the angle is measured at the point where

the tangents intersect.

AxisDistance – is the distance between the axis of two 3D objects. The same 3D objects can be

selected as the objects of the measurement as in the previous case (when identifying "Angle"), except

for workplanes. In the latter case, the axes of the selected objects coincide with the directional vectors

of the planes;

AxisGeomDistance – is the distance between the axis and element geometry.

DX – Offset on X;

DY – Offset on Y;

DY – Offset on Z.

MaxDistance – Maximum distance between two 3D objects (between two points the most distant

from each other).

MaxGeomDistance – Maximum distance between two geometric elements (3D points, 3D curves or

surfaces).

CenterDistance – is the distance between the centers of circles/arcs of circles.
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for a LCS the following additional parameters are used:

direction cosines of LCS2 relative to LCS1:

ProjXToX – Direction cosine Х,Х

ProjXToY – Direction cosine Х,У

ProjXToZ – Direction cosine Х,Z

ProjYToX – Direction cosine Y,Х

ProjYToY – Direction cosine Y,Y

ProjYToZ – Direction cosine Y,Z

ProjZToX – Direction cosine Z,X

ProjZToY – Direction cosine Z,Y

ProjZToZ – Direction cosine Z,Z

Eulerian angles by which the LCS1 must be rotated in the sequence Rx, Ry, Rz for alignment with the

LCS2:

EulerRX – Eulerian angle around X

EulerRY – Eulerian angle around Y

EulerRZ – Eulerian angle around Z

Measure Multiple Elements

To obtain the total value of the characteristics of the same name for several elements, select the

Measure multiple elements mode. After turning on this mode, it is necessary to select the

measurement objects. In the command properties window, in the Element field, the names of the

selected objects will be displayed. The field is editable: you can delete elements selectively , or the

entire list at once . The Property table will list those total characteristics that can be calculated for

the selected set (for example, total length or mass). In this mode, only the following parameters can

be measured:

Mass (total mass of the elements);

Perimeter (total perimeter of the elements);

Area (total area of the elements);

Length (total length of the elements).

Distance (minimum distance between elements);

MaxDistance (maximum distance between elements);

XSIZE, YSIZE, ZSIZE (measurements along the corresponding axes);

xmass, ymass, zmass (coordinates of the center of mass);

XMAX, YMAX, ZMAX, XMIN, YMIN, ZMIN (maximum and minimum coordinates along the

corresponding axes).

Measurement of Intersection Value

You can measure the volume of the intersection of two bodies explicitly. If you have created an

intersection result for multiple bodies, you can measure the amount of intersection between the two

selected bodies. To do this, select the intersection result in the Measure command, and then select the

two desired bodies.



Model Geometry Analysis

2729

Additional Methods of Calling Command

Calling Command from Context Menu

This method is convenient when you need to measure parameters of a single object. For this, select an

object in the 2D or 3D window, whose parameters are to be measured, and right-click . In the

coming up context menu select the item Measure…. This will result in launching the Measure

command in the mode of measuring parameters of a single object. The 2D or 3D object over which

the context menu was accessed gets automatically selected for conducting measurements. Further

steps within the command are fully identical with the described above.

Calling Command in Transparent Mode when Defining Parameters of 2D or 3D Elements

When defining numerical parameters of any T-FLEX CAD element (construction or graphic line, 3D

node or operation, etc.) one could need to relate one of the parameters with a certain geometric

characteristics of the given model. This could be, for example, the distance between two of the model

elements or the length (angle, perimeter, area etc.) of another element. 

To define such relation, simply set the course are in the input field of the respective parameter in the

properties window or the parameters dialog and press <F12>. Alternatively, you can access the

context menu at this moment (by right clicking ) and select the Measure item in it.
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The properties window (or parameters dialog) of the element being edited temporarily disappears,

while the Measure command is launched. 

Next, you need to select the command mode (measuring one or two objects), the object or objects to

measure and the desired measurement parameter.  

Using the Expression/Value radio switch, specify in what form the value of the selected parameter will

be returned: as an expression (using the function get(), distance() etc.) or a constant. 
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Clicking  completes the command. After that, the original parameters dialog reappears on the

screen, that launched the command. It will already have the geometrical parameter value or

expression that was used to evaluate it, in the parameter input field.

Mass Properties

Calling the command:

Icon Ribbon

Measure> Measure > Mass Properties

Routing > Additional > Mass Properties

Keyboard Textual Menu

<3MP> Tools > Geometry Analysis > Mass Properties

This command allows you to calculate exclusively the mass-inertial characteristics of the selected

operations, unlike the Measure command, where a full calculation is available.

After entering the command, the operation selection filter in the Filter Toolbar is active by default:

Filter allows selecting the operation, whose properties need to be calculated. 

To calculate the characteristics of all operations present in the scene, you should use the option:

<A> Measure All Boides

After selecting the operations, the measurement results will appear in the Measurement field:
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Otherwise, working with the Mass Properties command is similar to working with the Measure

command.

Model Check

Calling the command:

Icon Ribbon

Measure > Geometry Analysis > Model Check

Analysis > Additional > Model Check

Surfaces > Additional > Model Check

Weld > Additional > Model Check

Primitives > Additional > Model Check

Keyboard Textual Menu

<QM> Tools > Geometry Analysis > Model Check

This command serves for analyzing the selected body in order to expose errors in its geometry. Errors

may become an obstacle on the way of future manipulations with the model. Errors in geometry may

occur, for example, due to deficiencies of importing 3D models from other systems. Sometimes,
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however, errors may be introduced at the time of creating a 3D model in T-FLEX, since only a local

model check is automatically performed when creating a 3D operation. Meanwhile, the full check may

take some time, depending on the model complexity.

Examples of some typical errors are shown below.

Mismatching loops         Self-intersection     Mismatching faces

Once in the command, you can select elements to check. Those could be edges, faces or whole

operations (in the latter case, all edges and faces belonging to this operation will be checked

simultaneously). Use the following options for selection:

<E> Select Edge or cancel Edge selection

<F> Add/Remove selected Face

<B> Add/Remove all Faces of Solid

To select all operations at once, you can use the option:

<A> Select all operations

Once selected, the element is put in the list Check results. 

This list displays the type of the element and whether it was already checked or not. If it was, then the

results of the analysis are displayed as well. 

To cancel selection of one of the elements, click it again in the 3D window. To cancel selection of all

elements, use the option:

<R> Cancel selection

To run the check on the selected elements, use the option 
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<Enter> Finish input

After picking this option, the system will check the selected elements and display the results in the

Check results pane. If there are no errors, OK will be put next to the element.

If, on the contrary, an error was found, then the list of the detected errors will be displayed next to the

element name.

If you quake a particular error, then the erroneous part of the model will be highlighted red in the 3D

window.

When clicking on an error, the Create Object button also becomes available, which creates a

topological link (the Geometric entitie  folder in the model tree) to the problematic elements to

simplify their removal and subsequent correction of the model. 

A topological link is created after exiting the command.

You can immediately select more elements to check, without leaving the command.
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Intersection Check

Calling the command:

Icon Ribbon

Measure > Geometry Analysis > Intersection Check

Assembly > Additional > Intersection Check

Analysis > Additional > Intersection Check

Routing > Additional > Intersection Check

Keyboard Textual Menu

<QI> Tools > Geometry Analysis > Intersection Check

This command allows checking the model for intersections and contacts of the selected bodies. The

command is particularly helpful when working with assemblies.

 

The command offers two checking modes: checking intersections of all bodies in the scene, and

checking intersection of the selected bodies. The desired mode is selected in the parameters window.

After entering the command, the Bodies parameter is set in the parameters window, which allows you

to directly specify the bodies whose intersection with each other needs to be checked. This is

necessary if there are many bodies in the scene and they have complex geometry, so that checking for

the intersection of all bodies in the scene does not take a long time.

After selecting a specific body, it will be added to the verification list, and the results of the

verification will be automatically displayed in the Intersections Found field.
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To delete a specific body from the check list, use the  button.

To disable automatic intersection checking, you need to use the automenu option:

<U> Automatic data update

If you click an intersection report, the intersecting bodies will become semitransparent in the 3D

window and change the color, while the intersection region will be brightly highlighted. The volume of

the bodies' intersecting region will be displayed in the Volume pane.  

If the intersecting region is too small, you can use the button Zoom in , and the image of the

intersection region will be magnified.

If you need to save the result of measuring the intersection of bodies as a separate element of the

model, you need to use the automenu option:



Model Geometry Analysis

2737

<R> Create Result

Depending on the specified additional parameters, the analysis results will be displayed differently in

the Intersections Found filed. 

The command provides two additional parameters, Adapt Threads, Consider Tangent Faces and

Consider Self-Intersections.

Often, one part is connected with another one by a thread. In this case, with the Adapt Threads

parameter set, the system will be taking into the account thread parameters of the intersecting

operations and, in the case of finding a mismatch in some thread parameters (for example, the pitch),

the message Unsuitable Thread 0 will be displayed in the Intersections Found filed. If you click this

message, the respective faces with the thread will be marked in the 3D window by dashed lines. 



T-FLEX CAD 17 Help

2738

By default, the system accounts only for intersections of the bodies penetrating each other. If the

Consider Tangent Faces option is set, the system will be also accounting for touching contacts,

besides intersections of operations. Therefore, the touching faces of the operations will be mentioned

in the Intersections Found field, besides intersections and mismatching thread parameters.

If you click a report about a touch, the respective faces will be marked by dotted lines in the 3D

window.

Using the Consider Self-Intersections option, the system allows you to exclude self–intersections from

the analysis of intersections - for example, when a 3D fragment has more than one body intersecting

with each other. This option is enabled by default.

Check Changes

Calling the command:

Icon Ribbon

Measure> Geometry Analysis > Check Changes

Keyboard Textual Menu

<QA> Tools > Geometry Analysis > Check Changes

The command for checking modifications of the model allows the user to reveal the differences

between two solid bodies of the 3D model. With the help of this command, the user can compare

different bodies or the same body at various stages of creating modifications. Also, upon the presence

of the saved configurations in the model, you can compare between each other two versions of the

same part. In addition, the command is able to calculate the volume of the modified space, which

allows us to estimate the extent of differences more accurately.
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After entering into the command, the user has to specify the model operations/configurations to be

compared.

For comparing two bodies the following options are used:

<F> Select first Solid

<S> Select second Solid

With the help of these options, the user can select different solid bodies of the same model as well as

operations applied at different history levels to the same body. For selecting operations, you can use,

for example, the tree of the 3D model. The selected operations are put into the fields First Operation

and Second Operand in the command's properties window.

This option allows selecting one of the configurations saved in the model as the second operand for

comparison.

The way of comparing the selected operands can be chosen in the dialog of the command's

properties window with the help of the drop down list Type:

Subtraction (1-2). The result of comparison will be similar to the outcome of the boolean operation of

subtraction of the first operand from the second;

Subtraction (2-1). The result of comparison will be similar to the outcome of the boolean operation of

subtraction of the second operand from the first;

Intersection. The result of comparison will be similar to the outcome of the boolean operation of

intersection of the first and second operands;

Union. The result of comparison will be similar to the outcome of the boolean operation of union of

the first and second operands.
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The way of comparing can be also selected in the auto menu of the command by turning on one of

the following options:

<-> Subtraction (1-2)

<Ctrl><-> Subtraction (2-1)

<*> Intersection

<+> Union

After pressing  the result of comparison of the selected operands is highlighted in the 3D window

with the red color.

For calculating the volume of the modified space, you additionally need to set the flag Calculate

Volume in the dialog of the command's properties. The precision and units for calculating the volume

are set with the help of the group of parameters below the given flag.

Let's give an example. There is the following model with a linear array of holes:

Add blend to two linear array objects:
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Choose a linear array as the first operand, and blend as the second. Next, select the type of operation

Subtraction (1-2) and click . As a result, the difference between the two stages of model creation

will be displayed.

Curve Curvature

Calling the command:

Icon Ribbon

Measure> Geometry Analysis > Curve Curvature

Support Geometry > Additional > Curve Curvature

Keyboard Textual Menu

<QC> Tools > Geometry Analysis > Curve Curvature

This command allows measuring curvature and the curvature radius of the selected curves. You can

select edges and 3D Paths to measure curvature.
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Upon entering the command, you need to select one or several elements, whose curvature needs to be

measured. To select, use the options:

<E> Select Edge or cancel Edge selection

<T> Select 3D Path

Right after selecting an element, its curvature will be measured and displayed in the 3D window as a

multiplicity of colored lines stemming from the curve, called curvature plot. 

To remove a specific item from the list, use the Delete Element from the List option. To delete all the

elements, use the Clear option.

To regulate the height of the curvature plot, the Trim command is used, followed by setting a specific

value.

By default, Extremum Markers and Inflection Point Markers are marked on the selected element in

the 3D window. If necessary, you can disable their display in the parameters window.

You can modify two parameters: Curvature and Curvature Radius. Depending on the selected

parameter, rendering in the 3D window will appear differently.
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If Curvature is selected, the colored plot lines will be pointing in the direction away from the center of

curvature. The lines originate on the curve. Their length corresponds (to a certain scale) to the

curvature at the point, from which the line originates. The scale coefficient that relates the curvature of

the curve and the length of the colored lines is defined in the properties window by the parameter

Size.
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The Autoadjust button allows you to automatically set the scale value.

If the Radius parameter is evaluated, the colored lines will be connecting points on the curve with

their respective centers of curvature. The length of the colored lines corresponds to the radius of the

curve's curvature. 

The density of the colored lines is controlled by the Density parameter both in the case of curvature

evaluation and in the case of the curvature radius evaluation. The Density and Scale parameters can

be used as variables.
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If you need to save the result of measuring the curvature or radius of curvature of curves as a separate

element of the model, you need to use the auto menu option:

<R> Create Result

The created measurement result will be displayed both in the model tree and in the scene. When

recalculating the model, such an element changes its display. In order for the created result to be

monochrome, the corresponding command is applied in the properties window.

The decorations of the analysis result saved in the Created result will be displayed during editing of

the original objects (3D paths, Routes).
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Working with the "Colors" tab

The plot lines are painted in different colors, depending on the value of the curvature at the point.

Color distribution within the range of the measured parameter is set up on the Colors tab, located in

the parameters window.

A color scale is displayed on the tab. The values at the left of the scale correspond to certain colors on

the scale. The black triangular markers at the right of the scale are used for adjusting the scale. Each

marker relates to a certain color. The colors of the scale change smoothly from one marker to another.

You can move the markers along the color scale. To do this, you need to "grab" a marker with the

mouse and drag it to the new position. As you do this, the color scale will change its appearance, and

so will the image in the 3D window.
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To define the color of a certain marker, right click  this marker, and in the coming up menu select

"Color". After that, you can select the color in the standard color selection window. The scale can have

two markers (for the maximum and the minimum values), or more. To add a marker, right click 

where you want to add it, and in the coming up menu select Add. To delete a marker, right click 

this marker, and in the coming up menu select Delete.

The marker placement scheme and the colors can be saved and unloaded to a file (the file extension

is "*.col"). To do this, use the menu items (Save and Load), coming up upon right clicking 

anywhere on the Colors tab.

The range of the color scale for the measured parameter can be modified as well. To do this, use the

parameter Scale Type at the top of the properties window. 

By default, the parameter is set to Auto. This means that the minimum and maximum values on the

scale correspond to the minimum and maximum parameter values of the selected elements.

In this case, the entries from and to cannot be edited, since these parameters are defined

automatically.
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Note that the plot lines defining the amount of curvature are displayed only on the portions of the

curve whose curvature falls within the specified range. Thus, if using the automatic scale, the colored

plot will be displayed along the whole curve.

If the parameter is set to Custom, then the values in the entries from and to can be specified manually.

Note that the plot will be shown only along the portions whose curvature falls within the specified

range.

Thus, for example, the minimum curve of the curve shown on the diagram is equal to zero. Therefore,

setting a positive value in the "from" input box (in the example, set to 0.18), will make the plot

disappear on some parts of the curve. The plot coloring will also be different.

Besides the color-coded curvature display, a provision is made for reading the curvature at a specific

point. To do this, use the option:

<C> Measure curvature at arbitrary point

When you click anywhere on the curve, a decoration appears with the value of the curvature and the

radius of curvature at this point. Such decorations can be moved and they are saved using the Create

Result option.
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The decoration is created only if the Create option is set on the Measure Curve Curvature tab.

To delete all the decorations, use the Clear All button. The Displayed Value switches adjust the

display of data on the decoration. If the parameter Displayed value is set to All, the newly created

decoration will have a position and both values: curvature and curvature radius. If the Displayed

Value is set to Current, only the position and the value that is being measured at the moment will be

indicated for the newly created decoration. 

If the Collect Data parameter is set on the Results tab, when clicking on the point, the parameters

Position, Curvature and Curvature Radius will be recorded in the curvature measurement report.

The created log can be copied to the clipboard (the button ) or saved in a text file (the button 

).To clear the log, use the button . 

To find the point of maximum curvature, use the option:

<M> Find point with maximal curvature

When using this option, the system will automatically create a decoration indicating the point on the

curve with the maximum curvature.
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Surface Curvature

Calling the command:

Icon Ribbon

Measure> Geometry Analysis > Surface Curvature

Keyboard Textual Menu

<3VV> Tools > Geometry Analysis > Surface Curvature

This command allows measuring the curvature and radius of curvature of one or several selected

faces. 

You can view the overall distribution of the curvature on a face (for this, the model will be colored

appropriately), or find the curvature value at a specific point.

To measure the curvature, you can select both individual faces and operations as a whole (that is, all

faces of this operation).

Immediately after selection, the face will change its color according to the type of curvature selected

for measurement and the settings on the Color tab. Working with colors when measuring the curvature

of surfaces is carried out in the same way as it is done in the Curve Curvature command. 

When selecting additional faces, the range of curvature values changes, so the color of the previously

selected faces may change.

Types of measured values

As with measuring the curvature of a curve, in this command you can select the measured value:

Curvature or Curvature Radius. However, it is also necessary to specify the type of the measured

value.

Minimal

Maximal
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Mean

Gaussian

U

V

The type of the measured value is defined with the help of the Type combo box, located at the top of

the properties window.  The surface curvature at a specific point depends on the direction, in which

the curvature is measured. The curvature will be maximal in one direction and minimal in another

direction. Due to these facts, the system allows measuring the following types of values: 

Minimal or Maximal. With these parameter settings, measurements of the maximum or the minimum

value will be done at each point of the selected surface.

Mean - is half the sum of the minimum and the maximum measured values.

Gaussian - is the product of the minimum and the maximum measured values.

U and V - these parameters require the measurement to be done in just one of the directions.

To find the points of maximum and minimum curvature on the face, use the option:

Find Points of Maximum and Minimum Curvature

When using this option, the system automatically creates a decoration that shows  the points of the

surface where the curvature is maximum and minimum.

To create 3D nodes at the maximum points of curvature, use the option:

Create 3D Nodes

When this option is selected, a field with the selected elements appears. To create a 3D node at the

point of maximum curvature of the selected element, use the  option, and then finish input .

If you need to save the result of measuring the curvature of the surface as a separate element of the

model, you need to use the automenu option:

Create Result

The created measurement result will be displayed both in the model tree and in the scene. When

recalculating the model, such an element changes its display.

Working with the Results tab is done same as in the Curve Curvature command.
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Surface Curvature by Sections

Calling the command

Icon Ribbon

Measure> Geometry Analysis > Surface Curvature by Sections

Keyboard Textual Menu

<QF> Tools > Geometry Analysis > Surface Curvature by Sections

This command allows you to create a section to display the curvature or curvature radius of one or

more selected faces according to various options of the sections.

There are five section options.

By UV

By Manipulator

Radius

Curves Flattening

Parallel Planes

By UV option allows you to create a section to display the curvature or curvature radius of the

selected faces by setting the step along U and V:

 

By Manipulator option allows you to create a section to display the curvature or curvature radius of

the selected faces by setting the step along X, Y, Z or using the manipulator:
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Radius option allows you to create a section to display the curvature or curvature radius using two

points - the central point and the direction point, as well as specify the number of lines and the

angular step.

 

Curves Flattening option allows you to create a section to display the curvature or curvature radius

using an additional edge of an individual body.  To do this, you need to select the faces sequentially,

and then the edges. 
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Parallel Planes option allows you to create a section to display the curvature or curvature radius by

drawing planes parallel to different viewpoints. There are 5 modes for creating parallel planes - X, Y,

Z, View, Plane.

In the case of choosing the X mode, a plane is created parallel to the X axis. In the case of choosing

the Y and Z modes, planes are created parallel to the Y and Z axes.

View mode allows you to draw a plane parallel to the current point of view. For example, with a

random point of view, the following section is provided on the cone:
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After creating a section and changing the point of view, the cone in the front view will look like this:

In the Plane mode, you must select the anchor plane, i.e. any plane without curvature.

Then, sections will be created from the selected plane with a certain step:
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Using the Direction button, you can reverse the display of the curvature plot on the selected face.

For each section creation option, it is possible to disable the preliminary display of plots using the

Show Faces option.
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Option Show Faces is enabled Option Show Faces is disabled

The Show Traces option enables traces of plots on selected faces:

Option Show Traces is disabled Option Show Traces is enabled

It is possible to add a specific point for measurement. To do this, use the following option:

<P> Add Point on Face

It allows you to add points on the face to the Measurements at Points field. You can remove the

display of these points using the Show Points option, or leave only points in a certain direction (U or

V).
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To find the point of maximum curvature, use the option:

<M> Find point with maximal curvature

When using this option, the system will automatically create a decoration indicating the point on the

curve with the maximum curvature.

If you need to save the result of measuring the surface curvature of sections as a separate element of

the model, you need to use the automenu option:

<R> Create Result

The created measurement result will be displayed both in the model tree and in the scene.

It is possible to determine the curvature at a certain point. To do this, use the option:

<C> Measure curvature at arbitrary point

When you click anywhere on the curve, a decoration appears with the value of the curvature and the

radius of curvature at this point. Such decorations can be moved and they are saved using the Create

Result option.
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The Color tab works similarly to the Curve Curvature command.

Deviation Control

Calling the command:

Icon Ribbon

Measure> Geometry Analysis > Deviation Control

Keyboard Textual Menu

<QT> Tools > Geometry Analysis > Deviation Control

The command for the analysis of the coincidence of geometric elements Deviation Control allows

you to analyze the accuracy of the coincidence of the edges of the selected faces.

There are three types of analysis:

Edge-Edge

Face-Face

Edge-Face

The first type allows you to analyze the accuracy of matching edges.
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The second type allows you to analyze the accuracy of matching faces.

The third type allows you to analyze the accuracy of matching edge and face.
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Parameters of the created points are displayed in the Measure Result window.

The number of deviation analysis points can be set by user or determined automatically based on

preliminary analysis of the curvature of the contacting elements.

Points can be hidden using the special Control Points command.

The option to activate the tolerance value is also available - Linear Tolerance and Angular Tolerance.

The tolerance value indicates the allowable deviation value by distance or angle.

Here is an example of Face-Face analysis with the Linear Tolerance option activated. In the figure

below, the base of the cone and the side face are selected. Those measurements for which the

deviations in distance are acceptable are shown in black arrow, and those measurements for which the

deviation value is greater than the established tolerance of 29 are shown in red arrow.
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The measurement result can be copied to the clipboard in the form of a table using the Copy Table

option.

If you want to save the result of measuring the curvature or radius of curvature of the sections as a

separate element of the model, you need to use the following option:

<R> Create Result

Surface Deviation

Calling the command:

Пиктограмма Ribbon

Measure> Geometry Analysis > Surface Deviation

Клавиатура Textual Menu

<QD> Tools > Geometry Analysis > Surface Deviation

This command allows finding deviation of the normal from the specified direction for the selected

face.
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The colored image of the face allows viewing the deviation over all face area. It is also possible to

measure deviation at a specific point.

Upon entering the command, you need to specify the direction, with respect to which the surface

deviation will be determined. You can select faces, edges, 3D profiles, workplanes, and coordinate

systems as directions. 

For point selections, you can use 3D nodes, vertices, edges, coordinate systems, sphere or torus faces.

The selected direction can be reversed using the  option.

After choosing the direction, you need to select the faces, the deviation of which needs to be

calculated. They need to be specified in the Elements field.

You can select all operations in the scene using the option:

<A> Select all operations

If the direction is specified, selected faces will change color according to the scale located on the

Colors tab. Working with this tab is exactly same as in the Curve Curvature command. 

To measure deviation at a specific point, use the option:

<C> Measure slope at point

By default, if you click on a specific point on a face, a decoration will be created with the value of the

face deviation at that point.

If necessary, the decoration can be omitted by deselecting the Create option in the 3D Labels tab.
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In addition, the values of the coordinates of the point and the angle of inclination will be recorded in

the measurement report.

Working with the Results tab is the same as in the Curve Curvature command.

Surface Gap

Calling the command:

Icon Ribbon

Measure> Geometry Analysis > Surface Gap

Keyboard Textual Menu

<QH> Tools > Geometry Analysis > Surface Gap

This command allows evaluating the gap between two or several selected faces or edges. The system

evaluates the distance between edges. In this case, the command is used for evaluating the distance

between edges throughout their extent, rather than the direct measurement of the distances between

two points on the edges. To measure the exact distances, use the Measure command.

The command is mostly used for analyzing models resulting from deficiencies of an import or export.

The distances between edges are calculated in the planes perpendicular to the edges. Therefore, for

example, two choices of the distance it is used for a pair of nonparallel edges: from the first edge to

the second and from the second edge to the first. 

The image below depicts two lines: a and b. The distances from a to b are shown by dashed lines (the

segments l1a, l2a, l3a) and from b to a (the segments l1b, l2b, l3b).  These are the exact distances (the

dashed lines on the diagram), whose set is displayed in the 3D window as the distances between

edges.
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Upon entering the command, you need to select faces or edges, between which you want to measure

gaps. To select the faces, use the option:

<F> Add/Remove selected Face

To select edges use command:

<E> Select Edge or cancel Edge selection

When several faces are selected, colored "quill" lines appear between the edges, indicating the gaps

between the faces. 

Each line of the quill is painted depending on its length, in an appropriate color according to the

color scale. The color scale setup is done on the Colors tab. Working with this tab is similar to that in

the Curve Curvature command.

To measure the gap at a specific point, you must use the option:

<C> Measure gap at arbitrary point

If you click on a specific point on a face or edge, a decoration will be created with the value of the

gap between the faces or edges at this point.
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Working with the Results tab is the same as in the Curve Curvature command.

Normal Deviation

Calling the command:

Icon Ribbon

Measure> Geometry Analysis > Normal Deviation

Keyboard Textual Menu

<QN> Tools > Geometry Analysis > Normal Deviation

This command allows measuring deviation of the normals on the adjacent faces at the selected

edges. 
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The quills displayed in the 3D window allow viewing deviation of normals across the extent of an

edge. You can also measure the angle of normal's deviation at a specific point.

Upon entering the command, you need to specify edges, at which you need to measure the deviation

of normals. To select all edges belonging to a certain face, use the option:

<F> Add/Remove selected Face

To select a specific edge, use the option:

<E> Select Edge or cancel Edge selection

Upon selecting an edge, a plot diagram is displayed reflecting differences between the normal

directions. The quill color varies according to the color scale defined on the Colors tab. Working with

this tab is same as in the Curve Curvature command.

Depending on the difference in the face normals, the length of the plot lines may vary as well as the

color. The way in which the length changes depending on the angle difference is defined by the

Length parameter.

The length of a plot's lines can be proportional to the angle, inversely proportional to the angle, or

constant. 

To measure normals' deviation angle at a specific point on an edge, use the option:

<C> Measure deviation at point

If you click on a certain point of the edge, a decoration will be created with the value of the angle at

that point.
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Working with the Results tab is done same as in the Curve Curvature command.

Surface Smoothness

Calling the command:

Icon Ribbon

Measure> Geometry Analysis > Surface Smoothness

Keyboard Textual Menu

<QZ> Tools > Geometry Analysis > Surface Smoothness

This command allows evaluating regularity of the model.
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This type of rendering allows to visually determine whether the adjoining faces are connected

smoothly with tangency transitions, or with continuous transition of curvature.

If all surfaces adjoin tangentially, then the texture stripes appear continuous, although may sharply

change the direction. If the surfaces have smooth transition with continuous curvature, then the texture

stripes are not just continuous, they also transit smoothly.

Right after entering the command, the model coloring changes. By default, it will be a two color

pattern. You can change the color to one color lines or specify the format file yourself .bmp, .jpeg, .gif,

or .png containing the image used to display the smoothness of the model.

The color used for one color or two color stripes is set using the Color 1 and Color 2 fields.
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The width, relative width, the rotation angle of the stripes and accuracy of their rendering are also

defined in the properties window. 

You may find the default pattern most convenient. In this way, the higher is the curvature, the finer are

the stripes of the pattern applied on the model. The colored stripes are widest on flat faces.

The stripes that paint the faces can be drawn in different directions. However, if the faces adjoin

smoothly in terms of continuous tangency, the stripes are neither interrupted nor shifted with respect

to each other, but can sharply change the direction. If the faces connect smoothly with continuous

curvature, the stripes are not interrupted and smoothly change the direction.

 

Non-smooth 

connection faces

Smooth 

(continuous tangency)

connection of faces

Smooth 

(continuous curvature)

connection of faces

Rendering of the colored stripes in the 3D window is noticeably affected by the parameter Mesh

Quality, defined on the 3D tab in Set Document Parameters. We recommend using highest

accuracy of the mesh quality when examining the model regularity.

Model Separation Check

Calling the command:
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Icon Ribbon

Measure> Geometry Analysis > Model Separation Check

Keyboard Textual Menu

<QS> Tools > Geometry Analysis > Model Separation Check

This command serves for checking, whether an injection or die-cast mold used for making the model

part is separable.

The command allows finding the faces of the regions preventing the mold from parting. Additionally,

the faces are highlighted, whose taper angle with respect to the selected direction is less than

specified. There are two types of direction:

By Object

By Points 

By default, the By Object type is used. After entering the command, you must select the operation

whose faces will be analyzed. To select an operation, use the option:

<B> Add/Remove all Faces of Solid

Next, you need to set the direction of the shape connector. To select the element that sets the

direction, use the option:

<D> Select Direction

When using this option, it is possible to select faces, edges, 3D profiles, workplanes and coordinate

systems. The selected object is entered in the Object That Defines Direction field.

When using the By Points type, you need to set the direction by specifying two 3D points:
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<S> Select First 3D Point

<E> Select Second 3D Point

To specify points, you can use 3D nodes, vertices, edges, coordinate systems, spherical and toroidal

faces. The points are entered in the First Point and Second Point fields, respectively.

Upon selecting the objects, the operation's faces change in color. By default, highlighted red are the

faces of the regions preventing the mold from parting. The blue color marks the faces, whose taper

angle with respect to the selected direction is less than specified. The green marks the faces that are

sufficiently tapered with respect to the selected direction and do not prevent the mold from parting.

If multiple bodies are selected simultaneously, the system will run the separation check on all

bodies together as if it was one part. Therefore, the results of checking several bodies separately

and together will be different.

Besides the colored rendering in the 3D window, the check results are displayed in the Measure

Results pane. It contains overlapping faces (that prevent the part from ejecting) and faces with

insufficient slope. The upper and lower faces are also specified here. The upper and lower faces – not

overlapping faces with sufficient slope that ensures that the part ejects properly from the tooling.

These faces define the mold working region.

The display is available in the form of a table or a tree.

If you expand the list of reports and click the name of a problematic face, the face will be highlighted

in the 3D window.

If the Keep Selection flag is set, then, upon leaving the command, the highlighted faces will stay

selected. This is done for convenience. 

The Minimal Slope parameter sets the minimum permissible taper angle of the faces with respect to

the selected direction.

If you need to save the result of model separation check as a separate element of the model, you

need to use the automenu option:

<R> Create Result

The created measurement result will be displayed both in the model tree and in the scene.
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Contour Check

The command can be called in one of the following ways:

Icon Ribbon

Measure > Contour Check > Contour Check

Workplane > Analysis > Contour Check

Keyboard Textual Menu

<QP> Tools > Geometry Analysis > Contour Check

The command checks contours formed by graphic lines for errors on an active workplane, on a

drawing page or within active drawing view. It is useful on active WP, when checking contours, that

will be used for creating 3D profiles. When working with a drawing, you can select a Page to be

checked using the drop-down list in the top of the command's parameters window. If there are no

active drawing views on the selected page, then the command checks elements not belonging to

views. If there are is an active drawing view, then the command checks content of such view. When

working with a 3D scene with no active workplanes, the Page drop-down list contains all existing

workplanes. Selecting a workplane in the list activates it. When working on an active workplane, the

current workplane is selected automatically and there are no other options in the drop-down list.

In the panel below you can select categories to Check for:

·  Intersections

Intersections of two or more lines.
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·  Self-Intersections

Lines intersecting themselves.

·  Gaps

Distance between lines within the specified range.

·  Overhangs

Partially coinciding lines.

·  Short Objects

Lines, whose lengths fall into the specified range.

·  Objects without Geometry

Objects, whose geometry cannot be constructed. For instance, if you construct an arc by three

nodes first, and later make such nodes lay on the same straight line, then the arc will become

the object without geometry.

·  Duplicates

Fully coinciding lines.

There are color samples near some of the categories in the Check for panel. The results of the

corresponding type get outlined in the drawing or WP using such colors, upon performing the check.

Colors can be customized using the system options dialog (Options > Colors > Contour Check). The

system checks for categories, whose checkboxes are enabled. Checkboxes could be enabled or

disabled by clicking  them directly or using buttons in the right side of the panel (  Select All,

 Unselect All,  Invert Selection). 

The Consider Line Color checkbox is available below the Check for panel. The checkbox is disabled

by default. Enabling it excludes from the results  Intersections,  Gaps and  Overhangs

between lines of different colors.

Following Options are available in the eponymous tab of the command's parameters window:

· Search Criteria for Gaps / Short Objects

 Gaps and  Short Objects are detected if gap value or object length fall within range

between Minimum and Maximum Value. The range includes the minimum value, but doesn't

include the maximum.

· Show Intersection Labels

If this checkbox is enabled, then labels will appear on a drawing or WP upon performing the

check. Each label marks an intersection point and contain its coordinates as well as names of

intersecting lines. Precision of coordinates is defined by document parameters (Document

Parameters > Page > View > Linear > Precision).

Set the desired check parameters and press , <Ctrl>+<Enter> or <Enter>. The list of results will

appear in the Results panel. Results in the list are grouped by categories.  You can fold a group by

clicking the   button, which is located to the left side of a body name. When folded, the button

changes to . Click it again to unfold a group. The number of results in a group is shown in brackets to

the right side of a group's name. Index number (? ), names of affected lines (Element 1, Element 2), as

well as X and Y coordinates (if applicable), are shown for each result in the list. Endpoint's coordinates

of one of the affected lines are shown for gaps, coordinates of an intersection point are shown for

intersections and self-intersections. Results can be selected in the list using . As you select a result

in the list, affected lines get selected in the drawing/WP and an outline (if applicable) changes color

to light magenta. You can  Zoom In camera to the selected result using button located at right side

of the results list.
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Upon receiving check results you may change command's parameters and launch check again ( ,

<Ctrl>+<Enter> or <Enter>), or exit the command ( , , <Esc>, <Shift>+<Esc>, <X>).
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Engineering Analysis

Besides the geometry analysis commands described in the previous paragraph, the T-FLEX CAD

complex provides additional modules serving to conduct advanced model analysis: Finite Element

Analysis and Dynamic Motion Analysis.

Finite Element Analysis – this is a T-FLEX Analysis module that serves to perform various types of finite

element calculations:

· Static analysis allows calculating the state of stresses and strains in a structure under the

impact of constant in time forces applied to the model;

· Frequency analysis allows calculating natural (resonant) frequencies of a structure and the

respective vibration modes;

· Buckling analysis is important when designing structures, whose operation implies lasting

influence of loads ranging in intensity;

· Thermal analysis is the module providing the capability of evaluating a heated product

behavior under the impact of sources of heat and radiation.

· Forced oscillation analysis is carried out to predict the behavior of a structure under the

influence of external influences that change according to a harmonic law.

· Fatigue analysis allows you to study the strength of a material under varying loads.

T-FLEX Analysis is oriented at solving physical problems in the three-dimensional formulation. All

calculations rely on the finite element method (FEM). The product's mathematical approximation uses

its equivalent replacement by a mesh of tetrahedral elements. At the same time, an associative

relationship is maintained between the three-dimensional model of a part and the finite element

model used in the calculations. Parametric modifications of the original solid model are automatically

propagated into the meshed finite element model.

Results of finite element modeling (displacements and stresses)

The standard T-FLEX CAD distribution kit includes only a limited trial version of the finite element

analysis module – Express Analysis. The Express Analysis is a light version of the T-FLEX Analysis

module, specifically tuned for running simplified yet qualitatively sound strength studies. The user is

provided with the necessary selection of load and restrained types. Based on the T-FLEX CAD model

geometry, the automatic mesh generator creates a quality finite element discretization within the

Express Analysis. Once the calculations are completed, the stress, strain, displacement and strength

safety factor are output in a graphic form.
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The fully functional T-FLEX Analysis finite element analysis module is sold separately.

For details on working with the finite element analysis module, please refer to the T-FLEX

Analysis manual.

Express calculation

The express calculation module is designed to familiarize with the functionality of the T-FLEX Analysis

system and conduct simplified strength calculations. The express analysis module is included in the

delivery of the T-FLEX CAD system and does not require special licenses.

Express calculation is a static calculation that has limitations. If there is no license for the full version,

this type of calculation is the only one available when creating a new study.

The data recorded in the file containing the express calculation studies can be read if there is a license

for the full module: at the same time, it is possible to perform calculations for a more complex

calculation model.

Express Calculation has the same menu items as the full module, while commands that are not

available in express calculation are inactive.

Express calculation limitations

· The calculation model can consist of only one element, i.e. individual parts can be calculated,

but not the assembly unit as a whole.

· The FE-grid has a simplified dialog for setting parameters. The grid parameters are controlled

by the "coarser/more precise" control.

· From the set of loads, only forces and pressures are available.

· Only full restraint is used as a restraints.

· When starting the calculation, there is no possibility to configure the solver.

· There is no export of calculation results.

· The list of results is limited to the following types: "Factor of safety by equivalent stess",

"Equivalent stress", "Displacement, magnitude".

Dynamic Motion Analysis – this is the module that serves to run studies on dynamic behavior of

various three-dimensional mechanical systems. 

The dynamical analysis module is capable of solving the following studies:

· Analysis of the motion trajectory, velocity and acceleration of any point of a component in a

mechanical system due to applied forces;

· Analysis of performance times of a mechanical system (the time to the target point, the time

for vibrations to settle, etc.);

· Analysis of forces building up in components of a mechanical system during motion (reaction

forces at the supports, joints, etc.).

A mechanism's model is defined as a system of solid bodies, joints, and loads. The data for the

analysis is automatically accessed directly from the geometrical model created in the T-FLEX CAD

system. The familiar tools of T-FLEX CAD are used in modeling, with mates and degrees of freedom

employed to define relations between three-dimensional bodies. The system also provides the means

of modeling the contact between arbitrary solid bodies, being capable of processing a simultaneous

contact of hundreds and thousands of solid bodies of arbitrary shape.

Loads on solid bodies are defined as the initial linear and angular velocities, forces, moments, springs,

gravity, etc. To read the results, special sampling elements are used. Numerous values are available for

the analysis: coordinates, velocities, accelerations, reaction forces in joints, forces in springs, etc. The

user can observe the model behavior from any viewpoint immediately during the actual calculation.

One can create animation clips from the obtained results of a dynamic calculation.

The T-FLEX CAD standard distribution kit includes only a limited trial version of the dynamic analysis

module – the Express Dynamic Analysis. The Express Analysis has certain limitations on load types and
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the ways of rendering dynamic analysis results (the tools to obtain numerical calculation results are

not available). In the commercial module, the calculation results are displayed as graphs, dynamic

vector arrows and as an array of numbers (graph points).

The fully functional dynamic analysis module can be purchased separately whenever needed.

More details on working with the dynamic analysis module are provided in the T-FLEX Dynamic

Analysis manual.
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Libraries

Library configuration is a convenient tool for organizing work with large sets of documents, as well as

created libraries of parametric elements that can be used as fragments.

Library configurations are stored in files with the tws extension. A library configuration can be

composed of libraries or library groups. A library group can include other groups or libraries. Thus,

library configurations can be hierarchical. The library contains information about the path to the folder

on the disk where the document files are stored. Thus, in order for the document files to get into the

library, it is enough just to place them in the required folder on the disk.

Topics in this section:

· Library Configurations and Library Explorer

· Creating Libraries of Parametric Elements

· General Commands

Library Configurations and Library Explorer

Direct work with libraries and document files included in them is carried out in the document menu.

The library explorer is a window displaying the open library configurations with all its files. The user

has access to files for opening and for inserting fragments and pictures in the commands Create

Fragment,  Insert Picture, Insert 3D Fragment, Insert External Model.

Icons of library explorer elements:

 Configuration  Library (Folder)

 Active configuration  Not found library (folder)

 Libraries (folders) group  Duplicated library (folder)

Icon created in command Create/Edit icon is displayed for files.

Library Explorer window can be activated via  > Tool Windows > Library Explorer.
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Toolbar Options

There is a special toolbar for Library Explorer window.

The toolbar allows to:

1. Create a new configuration .

2. Open a configuration .

Drop-down list of all installed library configurations appears after pressing down arrow next to Open

Configuration command icon. It is helpful for opening and closing existing library configurations.

3. Use search bar.
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When you start search, all documents, which names satisfy the search request are shown in the Library

Explorer.

4. Select a columns .

Columns contain information about library explorer elements. The information can be edited. Records

can be sorted by columns.



Libraries

2783

Visibility column allows to hide configurations, libraries and files in the window. You need to click 

icon next to the element for this purpose. You may control visibility of the hidden elements by clicking

icon in the column header.

Path column displays path to the library and allows to change it manually. There is an option  in the

column, which allows to select a new directory for the library.
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The columns Author, Company, Comment, Name, Subject, Category and  Keywords display the

information specified in the file properties.
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You can insert information for configurations, libraries and libraries groups in Author, Company and

Comment columns. The information will be stored in a configuration file.

Context Menu Commands

Library configurations are filled via the library explorer. The library explorer commands are called by

mouse right-clicking in the Library Explorer window. The menu of the currently available commands

pops up on the screen. The context menu contents depend on where the mouse cursor is pointing to
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at the moment (the window title, the name of a library configuration, a group name, a library name,

filename, etc.).

Common Commands of Context Menu

Context menu commands that can be used for different type of library explorer elements are

described in the section.

            

Open Window . Opens a separate library window. This command is available in the context menu

of libraries and libraries groups. You can also simply drag and drop the icon of the desired library

from the library explorer into the document window.

Individual windows can be opened for several libraries. Like any service windows, windows with

libraries can be combined into a common window with tabs.
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Add Folder /Add Group . Allows to add a new library/libraries group. The commands are

available in the context menu of configurations or libraries groups.

Open Folder . The command is available in context menu of configurations, libraries and files. A

Windows folder with the selected configuration, library or document will be opened after the

command activation.

Delete . The command deletes groups, libraries or library elements.

If you delete a group, all libraries and groups included in it will not be deleted from the configuration.

If you delete a library, its folder will not be deleted from the disk.

If you delete a file, it will be deleted from the library explorer and from the disk.

Rename . Use this command to rename library, group of libraries or file.

Library Configuration. Set of commands that allow to work with libraries configurations.

 New. Creates a new library configuration. The command brings up a dialog box for inputting the

name of the newly created configuration file and defining saving location on the disk.

 Open. Opens the library configuration file. Several configurations can be opened in the Library

explorer window.

 Save All. Saves all open library configurations.

 Close All. Closes all open library configurations. If changes were made to some library

configuration, a query about saving changes will be made before closing.

The commands for managing configurations and libraries can be called from the main menu File >

Libraries. 

Note that in absence of the Library explorer window in display, library configuration creation

and loading operations will not be noticeable until the user opens the “Library explorer” window

on the screen. 

Exclude/Include. The option Exclude allows to hide selected files and folders. The option Include

allows to show the hidden elements in the library explorer,

Show excluded/Hide excluded. When the option Show excluded is enabled, all hidden elements are

shown in the library explorer with grey. Use the Hide excluded to hide them again. 
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View:

Tree. Preset hierarchy of configurations, libraries groups, libraries and files is displayed in this mode.

Libraries Only. Only libraries and their content are displayed in this mode.

Preview. The library explorer window allows opening an additional preview pane. The preview pane

displays the file image or content of libraries/libraries groups. 

Position of the preview pane can be controlled by choosing the way the windows are split: vertical or

horizontal.
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Note that for the preview to appear in the preview pane, it needs to be created first. The image can be

saved either as a bitmap, or as vector graphics. Different way of saving preview may be preferable in

different drawing situations. Parameters for saving the drawing preview can be specified in the

command Set Model Status on the Save tab . 

For detailed information on saving a preview or icon image refer to the Icon or Preview/Slide

section.

You can change preview window size or hide it by moving separation line.
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Show invisible elements / Hide invisible elements .The option appears in the automenu if

there are any invisible elements in library explorer. The option allows show/hide the elements in the

list.

Library Configuration Management Commands

Active Configuration . Marks selected configuration as active.

The search for a fragment file when opening or regenerating the document begins in the active library

configuration. If the element is not found, the search continues in all the rest of open configurations.

If several library configurations are open then one of those is the active one, with the icon outlined in

red.
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 Save. Saves the changes in the current library configuration. 

 Save As. Saves the current library configuration in a new file. 

 Close. Closes the current library configuration. 

Alternative file names. The command is used when you want to rename a file in the library and save

links of the file with already existing assemblies. You should specify new and alternative names of the

file in the command dialog. 

Assemblies will use the alternative name to search for the file, so it should match the old name.
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Library Context Menu

New command allows to create a new file in the library. You can select prototype from the drop-

down list.

Create Toolbar . This command adds a new toolbar to the application interface. A separate button

corresponds to each file from the selected library. If the document has an icon it will be displayed on

the button. Name of the file is displayed on the button if there is no icon. Pressing the button will

insert appropriate library element into the document as a fragment. This feature allows you to create

customized toolbars based on standard and custom libraries.

Delete from hard disk . The option allows to delete libraries folders from the disk. An empty

library will exist in library explorer. Its folder is colored grey. 

This library can be re-associated with the folder by writing a new path to the folder on disk or

using the  option if the Path column is enabled.

If there are libraries with duplicated names in library explorer, they are pointed with blue folder icons.
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Replace command appears in context menu when you select several libraries. It allows to change path

or its part for all the selected libraries.

Replace Library Path dialog appears after its activation.
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File Context Menu

Open command allows to open the selected file in T-FLEX CAD.

Insert as Picture  activates Create Picture command and inserts the selected file as a picture into

the current open document.

Insert as Fragment  allows to insert the selected file as a fragment into the current open

document. Insert Fragment or Create Fragment command is activated according to the active - 2D or

3D - view in the document.

A library name can be used in the commands for inserting external files into a T-FLEX document,

such as Create Fragment, Create Picture,  Insert Fragment. For example, if a fragment drawing

fragment.grb is located on the hard disk in the catalog C:\TFW32\LIB\FRAG, and there is a library

named “Parts” referencing this path, then the following name can be used for inserting the

fragment:  “<Parts> fragment”. This way is convenient not only in that it replaces a long and

possibly sludgy path with a slick one, but also helps to save paths to fragment files upon

transferring documents to another disc or computer. You just need to open the library

configuration.

Properties. Calls the property dialog box of the selected file.
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To have complete information displayed about the drawing, fill the informational fields Show Model

Properties. To make a preview appear in the preview pane, create it by the command Save Preview.

Creation of Configurations, Groups of Libraries and Libraries

You can use option New configuration  on the toolbar to create a new library configuration. You

can also use Library configuration > New item from the context menu.

Command Add Folder / Add Group  adds a new library/libraries group. The commands are

available in context menu of configuration or libraries group. The element is created on the current

library configuration hierarchy level.

When you create library it is necessary to select folder with necessary files.

An example of library explorer elements creation can be found in Example of configuration

creation section below.

Add Files to Libraries

There are several ways to add a new .grb file into the library:

1. Add file to the catalog, which is linked with the library.

Library Explorer window is automatically updated if document files included into library were

deleted, added or renamed. Thus, files added to the folder in Windows Explorer are displayed in the

Library Explorer window.

2.  Transfer files from Windows Explorer to Library explorer window using Drag’n’drop or

Copy/Paste options.
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3. Create a new file using one from the prototypes using New option from the context menu.
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Moving of Library Explorer Elements

You can move libraries groups, libraries and files using Drag’n’Drop mechanism. For example, to move

several files into another library, first select the group of files (hold down <Shift> or <Ctrl> key as

appropriate). Then, move the cursor over the highlighted files and press . Next, hold the left mouse

button down and drag the group of files into another library. This amounts to performing first Cut,

and then Paste command.

Cut , copy , paste . These commands are available in context menus to move/copy libraries,

libraries groups and files. 

If a file is dragged into the drawing window, it will be inserted as a fragment. Dragging a file

icon into the menu or toolbar area opens it for editing.

If you move the file icon to the menu and toolbars area, it will be opened for editing.

Example of configuration creation

We need to create a new configuration and add Bolts Library and Screws Library into it. The folders

include all necessary files and are stored on the disk.

1. Create a new configuration using New Configuration  command from the toolbar. 
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2. Create libraries group using Add group  from the configuration context menu. 

3. Rename the created libraries group using Rename  command from the context menu.

4. Select Add Folder  item from context menu of the libraries group. Select Library Folder dialog

will appear. Select folder and press Select Folder. The selected folder with all its files will be added

to library explorer.

All the files that will be subsequently added to the selected catalogs will also be displayed in library

explorer.

5. Save the configuration after adding all necessary libraries. Configurations are stored in textual tws

file, which contains information about included libraries. To save the configuration, use Save as 

command from the context menu of the configuration and select folder where it will be stored. You

can also change name of the configuration upon saving.

It is recommended to store configuration files and their libraries folders on the same level.
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Specifying Relative Paths to the Catalog

A relative path to the library or libraries group catalog can be specified with respect to the installation

home of the T-FLEX CAD application, or with respect to the configuration file that includes this library.

A relative path allows use of symbols “*”, “..” and “.”.

The symbol “*” in the beginning of the path stands for the path to the T-FLEX CAD home.

The symbol “.” denotes the path to the folder of the library configuration file.

The symbol “..” means ascending one level up the folder.

Suppose, for example, that the T-FLEX CAD application is installed in the С:\Program Files\T-FLEX

Parametric CAD 3D folder, and a library configuration is stored in the file С:\Library\A library1.tws. In

this case, the relative paths to libraries and groups of libraries are written out as follows:

Path relative to T-FLEX CAD home

folder

Path relative to the

library configuration

file

Absolute path

*\Library\Bolts

.\..\ Program Files\T-

FLEX Parametric CAD

3D\Library\Bolts

C:\Program Files\T-FLEX

Parametric CAD

3D\Library\Bolts

*\..\..\Screws .\..\Screws C:\Screws

*\..\..\Library\Rods \Rods С:\Library\Rods

*\..\..\Library\Bolts\Normal \Bolts\Normal С:\Library\Bolts\Normal

In the case of inputting a path to a non-existent folder, the system changes library icon to grey

folder.

You can change paths using one of the following ways:

Activate Path column displaying in library explorer. Here you can change path to the folder.
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Since the configuration file is on the disk at the same level as the libraries, the path to the files will be

displayed as .\Screws Library\.

If necessary, you can display the full path by entering it in the appropriate field:

Change paths for several libraries at once. You need to select the libraries with hold down <CTRL>

button and select Replace… item in their context menu.

Replace Library Path dialog appears. Here you can input an old path or its part and replace it with a

new one.
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After that select Save option in the context menu of the configuration to save configuration changes.

Relative paths will be saved in the configuration file.

Creating Libraries of Parametric Elements

Any drawing/3D model created in the system can be a fragment, that is, a drawing/3D model

included in another drawing/3D model. For the convenience of working with fragments, you can

organize their storage in libraries. Such a library could be, for example, a bolt library, a bearing library,

etc.

Several libraries of various standard elements are supplied with the T-FLEX system. All of them are

parametric, that is, each element can be used exactly in the form in which it is necessary in each

specific case. Since the elements of the library are ordinary models prepared in the T-FLEX system, you

can create any of your own libraries.

As practice shows, the most common models are of two types.

1. A parametric model with two or three defining parameters and a table of values ??for the rest of the

model parameters. This type usually includes standard parts such as fasteners, bearings, structural

elements, metal castings and rolled products, and much more. For such models, it is very convenient to

have a database of possible values ??of the parameters of this model. As a result, instead of several

models of various standard sizes and designs, you have one universal model.
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2. The second type is elements of various schematic images. These include elements of fundamental

kinematic, hydraulic, electrical circuits, etc. These elements are also standard, but their dimensions do

not change in accordance with the table, only their correct location in the drawing is important.

Creating parametric library elements

Parametric library element creation can be divided into several steps:  

1. Creating databases (if necessary). 

2. Creating variables, including those relying on databases.

3. Creating a parametric drawing and/or 3D model.

4. Creating fixing vectors and fixing LCS;

5. Creating 2D and/or 3D connectors;

6. Creating a dialog box of fragment’s parameters.

7. Adding the element to the library.  

Some of these steps can be skipped. For example, you may not need a set of values from a database,

or you're not creating a 3D model, 2D or 3D connectors.

For a detailed description of creating a parametric library element, see lesson 4 in the

Parameterization section of the tutorial.

General Commands

New Library Configuration

Call the command:

Icon Ribbon

-

Keyboard Textual Menu

<WSN> File > Libraries > New Configuration

This command allows you to create a new library configuration. The default name for the element

being created is "New configuration1" and a dialog box appears for saving the configuration file. In

this section, you can change the name of the configuration you are creating and define a folder to

save it in.

Open Library Configuration

Call the command:

Icon Ribbon

-

Keyboard Textual Menu

<WSO> File > Libraries > Open Configuration

This command opens the library configuration file. In the Library Explorer window, you can open

several library configurations, one of which is active.

https://www.tflex.com/resources/tflexcadst/download/
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Show Library List

Icon Ribbon

-

Keyboard Textual Menu

<WL> File > Libraries > Libraries...

When the command is called, the Library dialog box is displayed.

The window displays a list of libraries – all configurations or one of your choice.

Open Library Window

Call the command:

Icon Ribbon

-

Keyboard Textual Menu

<WSL> File > Libraries > Open Library

The command opens the library as a separate window. This is also the responsibility of the menu item

Open context menu window when right-clicking on the library name. The window displays a list of

library drawings in the form of drawing slides (if they were created). An unlimited number of library

Windows can be opened at the same time, and they can be on the screen, even if you close the Library

Explorer window. It is convenient to perform various actions on files from libraries using the mouse.

Click and hold the left mouse button. The file icon will move with the cursor. You can move a file or

selected group to another open window. If you move the file to the drawing field, it will be inserted as

a fragment. If you move the file icon to the menu and panel area, it will be open for editing.

The same commands are available from the context menu that appears after right-clicking on the file

icon.

Open Folder Window

Call the command:

Icon Ribbon

-

Keyboard Textual Menu

<WSD> File > Libraries > Open Folder

It works the same way as the Open Library Window command. Any folder opens as a separate

window.

Save All Library Configuration

Call the command:
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Icon Ribbon

-

Keyboard Textual Menu

<WSA> File > Libraries > Save All Configurations

This command is intended for saving changes in files for all library configurations.

Close All Library Configuration

Call the command:

Icon Ribbon

-

Keyboard Textual Menu

<WSC> File > Libraries > Close All Configurations

This command closes all library configuration files.
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Service Commands and Tools

Service commands are designed to work with finished models - preparing and displaying images,

working with materials, and so on.

Topics in this section:

· Remarks

· Printing a Single Document

· Printing Several Documents

· Print 3D

· Converting Documents from Earlier Versions

· Application

· Information Window

· Adding user's Commands

· Icon

· Preview. Slide

· 3D Annotations

· Materials

· Apply Material

· Photorealistic Images

· Light Sources

· Animation and Exploded View

· Cameras

· Report

Remarks

Calling the command:

Icon Ribbon

View > Window > Tool Windows > Remarks

Keyboard Textual Menu

<Shift+F3> Customize > Tool Windows > Remarks

The development of mechanisms for annotating 3D models is a transition to a new way of working

with design documentation: without drawing up drawings and unnecessary paperwork. The designer

can indicate all technical requirements and comments directly on the 3D model, and then transfer it to

the contractor or for revision. For the convenience of managing extended annotations, a special

window for working with remarks has been developed. Remarks can be made out using the

annotation tool: dimensions, leader notes, texts, etc., or you can imitate handwriting using spline

drawing.

There can be several annotations in one document. The annotations can be created by different

people. A list of all document annotations is stored in GRI file.

Remarks are created in the Remarks window.

Topics in this section:

· Remark Window

· Create Remark
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· Remarks in the T-FLEX DOCs Integration Mode

Remarks Window

To create, delete, edit remarks, use the special Remarks window.

A set of icons at the top of the window enables you to manage comments.

New Remark

Edit

Show

Delete

Create Remark Plane

Update

The window enables you to search for and configure the displayed columns.

Visibility. The first column of the window is always available. Click the icon  to determine the

visibility of the remark in a 3D scene or drawing. 

Name. Name of comment.

Autor. Author of comment.

Date. Date of comment creation.

Text. A remark object is a graphical object, so it is sometimes convenient to explain it with text.

File. Specifies the location and name of the file containing the remark. From the point of view of CAD

system objects, a remark is an object created in a context. By default, the remark file is saved to the

folder where the file to which the comments were created is located.

Create Remark

To create a new comment, use the icon   in the Remarks window. The system automatically

activates the dialog for selecting the plane on which the remark will be created.
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The Remarks tab automatically becomes active in ribbon.

Remark and sketch tools are available on the tab. The combination of remark elements and sketch

elements enables you to create a comment on a model or drawing in a free, hand-drawn style. For

example, in the spline drawing mode (Red Pencil command), you can create a remark that indicates a

defect in the model, on the selected remark plane. 

After creating a comment, you need to exit the context. As mentioned above, a comment is an object

created in the context and written to a special file.  To exit the context, you need to use the panel for

working in context.

You can also create remarks in drawings.
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If a remark is created in the integration mode with T-FLEX DOCs, the remarks are saved as T-FLEX

DOCs objects without using files representing a remark fragment.

Remarks in the T-FLEX DOCs Integration Mode

When working with T-FLEX DOCs data, it may be necessary to peer review system objects. For

example, in the process of document correction and approval, employees may need to initiate the

process of issuing remarks on the document, and the department head may give tasks to his

employees to create remarks. Thus, the T-FLEX DOCs remarks management mechanism helps organize

teamwork with system data in terms of their approval and peer review.

The remark management mechanism of T FLEX DOCs allows you to create remarks for system objects,

as well as generate requests for creating remarks. Remarks can be created for any system objects,

including T-FLEX CAD files.

Creating remarks for T-FLEX CAD files in integration mode is done through the viewing toolbar tools.

You must select the object associated with the T-FLEX CAD file, or the file itself, and open the View

tab on the property panel.

Printing a Single Document

Calling the command:
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Icon Ribbon

-

Keyboard Textual Menu

<PT> File > Print

T-FLEX CAD documents are printed out using the command File> Print… (Print Model), which is

similar to printing commands of most Windows applications. This command allows outputting a

single (current) T-FLEX CAD document to a printer or other hardcopy-making device.

2D drawings can be printed as well as 3D models. It is important, which window was active at the time

of calling the print command. Printed are all elements that are visible on the screen, except those on

the layer assigned the Screen only attribute. Please also keep in mind that construction elements are

not printed by default.

After calling the command, elements for setting up printing appear on the screen.

Copies. The number of copies of the document to be printed.

Printer. Specifies the printer from the list. The list displays all installed printers. 

The button Printer settings calls the Windows dialog for setting up properties of the selected printer;

it allows specifying print quality, page parameters etc.
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Current Page. Upon setting this parameter, the printout will contain the image displayed in the

current window, including portions of the image outside the format frame.

Current window. Upon setting this parameter, the printout will contain only the contents that fit inside

the format frame.

Whole document. All document pages of “Normal”, “Text” and “Bill of materials” type will be printed.

If a 3D view was active upon calling print command, it will be also printed.

Selected pages. When printing a multi-page drawing, you can specify which pages to print. A list with

available pages appears. You need to set the flag near required pages or use one of the options.

 Select all. All pages available in the list will be selected.

 Deselect all. Cancels pages selection.

 Invert selections. Invert pages selection.

 Only print odd pages. Only odd pages will be selected from the list.
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 Filter. Allows to select pages types that will be displayed

in the list.

You can also select 3D view for printing, if it is available in the current window. Upon 3D view printing,

dynamic selection of the printed bitmap resolution depending on the printer DPI and scale is

performed.
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Orientation from page allows to specify each page orientation individually.

Portrait orientation. Sets portrait orientation for all printed pages.

Landscape orientation. Sets landscape orientation for all printed pages.

From document. Paper size is controlled by settings of the current document.

From printer’s settings. Size of the paper that will be printed out will be determined by settings of the

printer. This mode is enabled by default.

You can also select paper size from the list manually.
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Center (Scale: 100%). Makes the image automatically centered on the sheet at 100%.

Center. Makes the image automatically centered on the sheet. You can set its scale manually.

Fit to page. Setting this parameter scales the drawing so as to fully fit on one page.

Custom. Allows you to specify image position on the drawing and its scale manually.

Left and Top. These parameters define the left and top margins of the paper sheet, respectively.

Width and Height. Set the width and height of the printed image.

Scale. Sets the image scale.

If one of the three latter parameters is manually modified, the other two are adjusted automatically to

maintain the drawing’s aspect ratio.

 

Don’t split into pages. A drawing will be printed on one page.
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Split into pages. Use this option when a drawing needs to be printed at a strictly defined scale while

the full image does not fit on one page. The option will let you automatically distribute the drawing

over multiple pages. The result can be preliminarily evaluated in the preview pane.

Upon selecting the option Custom parameter for image location is activated.

Activate Split lines option to print split lines. The option appears only in Split into pages mode.

You can select skipped pages using option .

Overlap. This option sets the amount of overlapping between the neighboring sheets when using the

Split into pages option. The overlap can be used for gluing separate printed sheets together.

Without constructions. Construction elements will not be printed.

Print Constructions. Setting this parameter makes construction elements printed as well.

Selected elements only. Enabling this flag allows us to print out only selected elements of the

drawing.

The parameters managed in Print dialog are retained and displayed upon subsequent opening

of the print dialog.
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Output settings

Hidden Line Removal. You can specify the method of removing hidden lines from the drawing: Raster

or Vector removal. This option is important when outputting a drawing to pen plotters that require

vector hidden lines removal.

Monochrome. This option makes the drawing printed all in one color.

Keep Line Width. Setting this parameter helps avoid variations in line thickness when printing a

document at a scale other than 100%.

Preview window is located in the right pane of the dialog.

Its scale can be specified in the right bottom corner.

To zoom in and zoom out use options  and . Option  allows to fit page.

Options  and  allows to select pages in preview window.
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Several pages can be shown in preview window when you zoom out. If their display takes a long time,

their content is not displayed and  button appears in the bottom of the dialog.

Selected page is highlighted with orange frame.

Option  allows to select position and scale of the printed area manually. You can move printed

area with pressed left mouse button. Mouse wheel rotation allows to change scale of the printed area

when the option is active. The drop-down list switches to the corresponding location parameter

according to the changes.

 

Printers fields are showed with grey in preview window. There are no fields for virtual printer.

After all parameters setting press Print button in the top left corner.

Dialog from the previous versions of T-FLEX CAD is also available.

If you want to use legacy version of printing dialog box, you need to set option Legacy printing on

Additional Options tab in Options command.
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To print several documents, use the Printing Several Documents command.

Printing Several Documents

The document printing application is an external T-FLEX CAD application that allows you to create the

required package of drawings and optimize their arrangement for printing on sheets of a given size.

The generated package is created in the current T-FLEX CAD document. The drawings included in the

package will be presented in the resulting single document using internal 2D images while

maintaining links with the original files. The resulting document is then printed out just like a regular

T-FLEX CAD document.

In general, preparing a package of documents for printing using the Document Printing Utility

application boils down to the following sequence of steps:

1. Set parameters (sizes and orientation) of sheets on which printing will be carried out.

2. Add the required pages of T-FLEX CAD documents.

3. If necessary, change the position of the pages on the sheets (manually or using the optimization

mechanism).

4. Send the generated package for printing.

Before calling the command, it is recommended to open a new document, which will be used for

placing documents for printing.

The application Document Printing Utility can be called by the following T-FLEX CAD command:

Icon Ribbon

-

Keyboard Textual Menu

- File > Print Documents

To work with the application, make sure that it is running. By default, it is always started. If,

however, the application is shut down for some reason (this can be instantly determined by the

absence of the command in the textual menu), it can be loaded by the External Applications

command .

The batch of documents will be composed on the basis of the document opened in the active window

of the T-FLEX CAD upon invoking the print module. The pages of the base document correspond to

the print paper sheets. The images of the documents which need to be printed out are placed on

these paper sheets. When carrying out the batch layout for printing, new pages can be automatically

added to the base document, and also the settings of already existing pages can be modified. Thus,

before calling the print module, it is recommended to create a new blank drafting which will become

the basis for compiling the batch of documents.

In the print module, only the pages of the base document having the type “Normal” are

displayed and used.

The documents selected as components of the batch are put into the base document as internal

pictures with the preserved connection with the source files.
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Formation of the batch of documents is carried out in a separate Document Printing window. This

window is split vertically into two panes: the structure of the composed batch of documents is shown

on the left, the window with the preview of the composed document is shown on the right.

Formation of the batch for printing is usually performed in the following way: with the help of the

commands of the textual menu and toolbar the documents which have to be included into the batch

are indicated. A user can select the T-FLEX CAD documents and the documents of all graphics formats

available for insertion in the Create Picture command. For the T-FLEX CAD documents added to the

batch and multi-page pictures, it is possible to specify the pages which will be printed.

The images of all documents included into the batch for printing, by default are placed on the current

page of the base document. Afterwards, during the batch layout, the images are distributed in a

rational way over pages of the base document.

The batch layout (creating new pages, modifying parameters of already existing pages, placing the

images over different pages) can be carried out both manually or automatically with the help of the

special command.

The compiled batch of documents can be sent to a printer straightway or can be saved as the T-FLEX

CAD file.

Forming the Structure of Documents Batch

For adding the document to a list, the following commands of the print module are used:
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Keyboard Textual Menu Icon

- File > Add Image from File…

- File > Add pages from DOCs…

- File > Add Image from Open Document…

The command File > Add Image from File… allows a user to add arbitrary T-FLEX CAD documents to

the batch, and also raster and vector images. When this command is invoked, the file selection

window appears.

When among the selected documents there is at least one multi-page document, the dialog window

Add Image is opened additionally. The list of the selected documents together with the specified

pages of the given documents as well as the area for the preview of the pages contents are displayed

in this window.

By default, in the dialog all pages of the selected documents are marked with the tick (next to the

page name). If everything is left unchanged, after pressing OK, the images of all pages of the selected

documents will appear in the preview window of the print module. If for some page the tick is taken

off, the image of that page is not put into the compiled batch of documents. To take off the tick, it is

enough to point at the desired tick with the cursor and press .

Now the added documents will appear in the batch structure (in the left pane of the print module

window). Note that if dimensions of the added image are larger than the dimensions of the current

page of the base document, the system can automatically change the scale of the image so that it

could fit on the page (the system actions will depend on the settings of the print module).

The File > Add Image from Open Document command allows a user to add to the composed batch

the T-FLEX CAD documents opened at the present moment. After invoking this command, the window

Add Image (analogous to the described above) with the list of the currently open documents and their

pages will appear.
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Before closing the dialog Add Image the system checks if any changes were made in the open

T-FLEX CAD documents (since the last save).

If the unsaved modifications were found in any of these documents, the system displays the

message with the prompt to save the given document. If the user denies saving, the given

document can not be added (it will not be shown in the list of the documents in the window

Add Image).

After compiling the list of the documents of the batch (with the help of any command described

above), additional customization of the batch can be carried out by taking off/setting on flags for any

image in the batch structure. The images for which the ticks are taken off remain in the batch structure

but will no longer be displayed in the preview window of the print module (and as a result will not be

printed out). The tick controlling page visibility in the batch can be taken off/set on with the help of

 or by using commands Image > Show and Image > Hide:

Keyboard Textual Menu Icon

- Image > Hide -

- Image > Show -

When forming the structure of the documents batch, the following commands of the print module can

be also used:

Keyboard Textual Menu Icon

- Image > Duplicate…

This command allows a user to “duplicate” selected images (from the list of the documents already

added to the batch being formed). The images can be selected in the batch structure (in the left pane

of the print module window) or directly in the preview window of the print module. The dialog in

which the number of the copies being created will have to be specified appears on the screen. Thus,

several copies of any image can be printed out.

Keyboard Textual Menu Icon

- Image > Rotate

After invoking this command, the images of the documents selected in the list or in the preview

window  turn by 90° counterclockwise.

Keyboard Textual Menu Icon

- Image > Delete

This command removes selected images from the list of images of the composed batch.
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All commands for dealing with the images of the batch can be also invoked from the context menu of

the image.

The Delete Document command allows a user to remove the selected document entirely from the

structure of the composed batch. This command can be also called from the context menu for the

document.
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Keyboard Textual Menu Icon

- File > Update Images

This command allows a user to synchronize the contents of the base document in the main T-FLEX

CAD window and in the print module.

The document print module works in parallel with the main T-FLEX CAD window. This allows a  user to

make changes in the base document concurrently in the print module and in the main T-FLEX CAD

window. For example, simultaneously with the print module functioning, via the T-FLEX CAD window

of the base document a user can modify the page settings, picture parameters or modify the

documents on the basis of which the images have been created in the print module. As a result, the

situation may arise when the print module lags behind in tracking down these changes. The command

Update Images of Document is intended to resolve these situations. It removes all data on created

images and used documents from the print module, and then restores this data according to the

contents of the base document from the T-FLEX CAD window.

Print Module Options

Options of the print module are specified in the command Set Editor Options:

Keyboard Textual Menu Icon

- View > Options…

This command invokes the dialog Options:
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The parameters group Editor defines general settings for dealing with the print module:

Show Images. This parameter controls the display of the images in the preview area of the print

module. When the flag is turned off, only the image bound box is displayed in the preview area. By

default, this flag is turned on.

Offset Step. This parameter defines the offset step for moving the images selected in the preview area

with the help of the keyboard keys (<>, <Ї>, <¬>, <®>). The step size is specified in page units.

Snap Distance (Pixels):. This parameter defines the maximum distance in pixels at which the sides of

the selected images will be snapped to the sides of other images on page (horizontally and/or

vertically). This parameter is taken into account when moving the image with the help of the mouse

(recall that the images can be also moved with the help of the keyboard keys (<>, <Ї>, <¬>, <®>).

Prompt to automatic Image adjustment if it does not fit on Page. This parameter defines the system

response in cases when the image does not fit on the page of the base document (for example, when

adding a large image). When this parameter is turned off, the system automatically moves and scales

the images in such a way that they will fit on the page. When the parameter is on, the prompt about

the necessity of image translation/scaling will be shown.

The parameters group Auto Layout defines layout parameters:

Use Image Rotation. Allows a user to apply rotation to the image by 90 degrees when selecting ways

of the image placement.

Distance between Images. This parameter sets the minimum allowable distance between the images

after the layout. The distance magnitude is specified in the units of the corresponding page of the

source document.

Show Free Areas. If this parameter is turned on, the areas of the base document pages not occupied

with the images are marked with green color after performing the layout.

Delete Empty Pages. This parameter affects the work of the mode of layout of all pages in the print

module. When this flag is enabled, pages, which after performing the automatic layout, ended up

being empty (i.e., not containing any images) are automatically removed. When this flag is turned off,

such pages remain in the structure of the print batch (they can be deleted manually afterwards).

Auto Layout of the Documents Batch

For automatic layout of the images within the scope of one page, the following command is used:
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Keyboard Textual Menu Icon

- Layout > Layout Current Page

This command distributes images placed on the current page within the scope of this page in such a

way that they will not overlap with each other and occupy the least area. In case when the system is

not able to place all images on one page, the message Layout errors appears with the list of

“problem” images.

For automatic layout of all images of the documents batch, the following command is used:

Keyboard Textual Menu Icon

- Layout > Layout All Pages

This command distributes the images of the batch over different pages of the base document. When

carrying out the layout, the required number of the base document pages is automatically added. The

size of the added pages will be the same as that of the last existing page of the base document. If

after successful completion of the layout, the blank pages will still remain in the base document, they

can be removed automatically (this operation is performed by setting on the flag “Delete empty

pages” in the dialog of the print module options).

The pages are not considered empty if they contain hidden images (images which were added

to the batch for printing but for which the flags were taken off later in the batch structure). Such

pages can be deleted only after removing hidden images.

If the size of some image exceeds the size of both existing and automatically created pages of the

base document, the dialog window Error optimizing page Layout will appear on the screen with the

list of problem images. The flag Change Image Size and Run Optimization Again found at the

bottom of the given dialog allows a user to choose further actions of the system.

If this flag is disabled, after pressing OK the layout will be completed. The images which could not be

placed automatically will have to be placed manually.

When this flag is on, after pressing OK, the dialog for page format selection, similar to that invoked by

the command Page > Page Size…, will appear. By default, the smallest by area format which

accommodates any visible images counting gaps is set in this dialog (see chapter Print Module

Options). After selecting the format and pressing OK, the dialog Page parameters is closed,

parameters of all pages of the base document are automatically modified and the repeated layout is

carried out.



Service Commands and Tools

2825

“Manual” Layout of Documents Batch

Print module allows a user to enter “manual” corrections into results of automatic layout: change

location and size (scale) of images, their distribution over the pages of the batch, etc.

To make the work with the created batch more convenient, the frames of all images in the preview

area are marked with a certain color. Non-active images (i.e., not selected for modification of position

and size) are marked with a frame of dark-green (if they fit on the current page) or dark-red (if they

do not fit on the current page) color. If the placement of the non-active image could not be adjusted

upon automatic layout, the color of its frame will be dark-red.

Selected (active) image is marked by default with sky-blue color (the color is specified in the

command Set System Options, Colors tab, 2D Elements Highlighting > Additional Color parameter).

In addition, at the corners of the frame of the selected image, square-markers are displayed.

A user can select the image in the list or directly in the preview window with the help of .
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When bringing the cursor to the borders of the frame of the selected image or to the markers at the

corners, the cursor takes the form of a two-directional arrow ( ,  or ). If at this moment a user

presses  and without releasing the pressed mouse button, moves the cursor, the image boundaries

will move along with the cursor. After releasing the mouse button, the size of the image bound box

will be modified (thus, the scale of the image view will be modified). The same result can be achieved

if after the first click on , a user releases the mouse button straightway, moves the cursor to the

desired place (corresponding to the desired location of the image bound box) and presses the 

again.

When moving the cursor, the scale magnitude is rounded off up to the second digit after the comma.

A user can refuse to round off the scale by keeping the <Ctrl> key pressed while moving the borders

of the image bound box.
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In order to move the image over the page, after the image selection put the cursor in any place inside

the image bound box. The cursor will take the following form: . Press  and without releasing the

mouse button, move the cursor to the required place on the page. Also, another way of working with

the dragger can be used here – if after pressing , the mouse button is released, the image bound

box will start to follow the cursor motion. Second click on  will fix the image in a new place.

When moving the image with the help of the mouse, the snapping of the selected image to the

sides of other images on the current page of the document is performed (taking into account

the value of the parameter Editor/Snap Distance (Pixels) in the options dialog of the document

print module).
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It is also possible to move the image with the help of the keyboard keys <>, <Ї>, <¬>, <®>.

Selected image can be also moved to another page of the base document. To do it, point with the

mouse inside the image bound box, press  and without releasing the pressed mouse bring the

cursor to the tab of the desired page. The selected page will be automatically opened in the preview

area. After that, it will remain only to place the image on that page and release the mouse button. If

after the image selection,  a user presses  and immediately releases the mouse button, the

translation will be completed after the second click of the  (already on the selected page of the

batch).

The scale, the placement page and the location of the selected image within that page can be also

modified with the help of the Edit Image Properties… command:

Keyboard Textual Menu Icon

- Image > Properties…

Upon invoking this command, the Image Properties dialog window with the parameters of the

selected image is opened:
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Picture. This field carries picture ID in the base document of the batch.

Source File. Path of the source file with the given image

Displayed Page. This parameter indicates the page in the source document used for creating the

given image.

Page. This parameters shows the page of the base document on which the current image will be

placed. The drop down list allows a user to select another page of the base document for placing the

image.

Location. Parameters of this group define the image location within the page of the base document.

Size. This is the parameters group showing the real dimensions of the given image (taking into

account the specified scale).

Scale. Scale of the view of the current image on page of the base document.

Rotate. When this flag is enabled, the image is turned by 90° (with respect to the initial position). This

parameter is enabled automatically if the image was rotated upon the auto layout.

For modifying scale and position of several images on one page at once, multiple selection can be

used. For example, you can use selection with window (in the preview area) or successive selection

with the help of <Shift>+  (<Ctrl>+  cancels your selection of the image). Note that multiple

selection can be used only for images placed on one page of the base document.

Selected images are marked with common frame. Modification of size (scale) and location of a group

of images is carried out the same as when dealing with one selected image.

In this dialog, the scale field will be left empty if selected images have different scales. If the scale

magnitude is specified, then after pressing OK and closing the dialog, the specified value will be set

for all selected images. If the field is left empty, the scale of the elements will not be changed.
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Invoking the Edit Image Properties… command when selecting several images at once makes the

Image Properties dialog window appear. In the title of this window it is shown to how many images

the settings of this dialog will be applied.

Change of Parameters for Pages of Base Document. Adding/Deleting Pages

To modify parameters of any page of the base document, the Page Size… command found in the

print module is used:

Keyboard Textual Menu Icon

- Page > Page Size…

Upon invoking this command, the Page Properties dialog is opened.

With the help of this dialog, you can modify the format (by selecting it from the list of the standard

formats or by specifying desired width and height) or orientation of the current page of the base

document. The Apply to all Pages flag allows a user to apply specified settings of the given dialog to

all pages of the base document at once.

If needed, a user can add a page to the base document manually. To do it, the Page  > Add command

is used:
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Keyboard Textual Menu Icon

- Page  > Add

A user can delete the current page of the base document (under condition that it does not contain any

images), with the help of the command Delete Current Page:

Keyboard Textual Menu Icon

- Page > Delete Current Page

Note that if on the apparently empty page there are hidden images (i.e., the images for which the flag

next to the name has been taken off in the batch structure), then the removal of such image will be

impossible. In this case the Delete Hidden Images command can be used:

Keyboard Textual Menu Icon

- Page > Delete Hidden Images

This command removes from the document structure unused images located on the current page of

the base document. After executing this command, the current page can be deleted.

Printing Composed Batch of Documents

A user can print out the composed batch of documents directly from the print module with the help of

the following command:

Keyboard Textual Menu Icon

- File > Print…

This command in turn invokes the Print Model command.

The composed batch of documents can be also sent to a printer from the main T-FLEX CAD window

by calling the Print Model command for the base batch of documents.

Print 3D

Calling the command:
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Icon Ribbon

-

Keyboard Textual Menu

<P3D> File > Print 3D

The Print 3D command activates STL export command.

When exporting to the Stereo Lithography format, the geometrical shape of the 3D model surfaces is

translated by faceting surfaces into a set of triangular elements. The accuracy of the surface

representation depends on the three-dimensional mesh parameters.

The Export Parameters window for *stl format contains the following options:

Pack to Archive. The .stl file will be packed in .7z format.

Separate file for each body. A separate mesh file of the selected format will be created for each body

in the assembly.

Color Support. You can choose from two standard formats: VisCAM and SolidView Format or

Materialise Magics Format. You can also select Without Color.

File Type:

· Binary (with color support) – binary format with color support. The bodies are stored in one

large mesh.

· ASCII (multibody) – text format without color support. The bodies are divided into separate

meshes.

Mesh Quality sets the image quality of the exported model.

Source CS. In the drop-down list, you can select one of the LCS of the model, which will be considered

the main one. This means that when the file is imported, this LCS will be aligned with the origin.

Open File. Allows you to immediately open the .stl file after its creation.
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Document Converter

Calling the command:

Icon Ribbon

Get Started > Files > Document Converter

Keyboard Textual Menu

<AC> File > Document Converter

This command regenerates and re-saves assemblies with fragments and/or files containing individual

parts. The need to perform this procedure arises when switching to a new version of the system,

because this changes the current GRB file format. When you open a file created in one of the previous

versions of the system, a full regeneration is automatically started to write data in the format of the

new version, so the time for opening old files increases. However, after saving the regenerated file,

reopening is much faster (in this case, there is no regeneration anymore). To increase the speed of the

system with the assembly model (drawing), it is necessary to regenerate and save all the fragments

included in it. Resave should be done from the "bottom up" the assembly structure. The document

converter of previous versions allows you to perform this procedure automatically, i.e. defines the

entire hierarchy of the fragments included in the assembly and performs their regeneration and saving

in the necessary sequence (first, fragments of the lower level are opened, regenerated and saved, then

the previous, etc., up to the assembly file). In the process of converting files, a report is generated in

which the results of the work (warnings, informational messages, errors) are recorded. The original

files can be saved as backups.

After calling this command, the converter window will appear on the screen. It is divided into 3 areas:

· Area with the list of files (upper left);

· Area with the service information and buttons (upper right);

· Area of diagnostics and display of messages about the progress on the conversion process

(the lower part of window).
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The list of files selected for conversion is shown in the upper left field of the converter dialog. By

default, the list of files is empty.

If some documents were open in T-FLEX CAD at the time of calling the command, the system will

prompt you for closing them (this is required for successful converter operation) and will

automatically add them to the list of files to be converted. If necessary, the user can remove some files

from the list and/or add other T-FLEX CAD documents to the list.

To add files to the list, the Add Files, Add Folder and Add from T-FLEX DOCs (if the T-FLEX DOCs

integration mode is enabled) buttons found on the toolbar of the converter can be used. These

commands can be also called from the textual menu.

The first button allows adding separate documents to the list, while the second one – all T-FLEX CAD

documents in the selected folder. If the selected folder has subfolders, the system will ask you,

whether to add those to the list.

To delete a file from the list, select it in the list and press the Delete Files from List button or the

button <Del>. To complete creation of the file list for conversion, press the Next button .

In the progress of conversion, the system may automatically decide to add to the conversion list the

necessary fragment files of the assemblies being converted, upon analyzing the structure of the model

to be converted. This behavior can be controlled by a conversion parameter (see the Customization of

Converter section).
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Performing Conversion

After forming the list of converted files, press the button Next in the right part of the converter

window. After pressing this button, the contents of the upper left area of the converter window will be

modified. The list of the converted files will be replaced by the list of the T-FLEX CAD libraries. At this

stage, a user has to indicate the elements of which libraries should be subject to transformation, if

they are found in the structure of the converted documents. The libraries the elements of which can be

converted are marked with a “tick” in the list of the libraries (to mark it, point with the cursor at the

symbol  next to the name of the library and press ).

Parameters shown at this step in the right part of the converter window duplicate parameters in the

conversion options dialog (see the Customization of Converter section).

After specifying libraries the elements of which can be modified upon conversion, press the button

Next again to proceed to the next step.

To return to the step of selecting documents (for example, if you need to modify the list of selected

files), use the graphic button Back.

At the next step, the structure of relations of converted files will be shown in the upper left area of the

converter window. If necessary, additional files are added to the list, that correspond to the fragments

of the assemblies being converted.
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To start regeneration of selected files, press the button Next again.

The step of library selection and viewing the document connections structure can be skipped, if for

proceeding to the next step of the conversion process, a user does not press the button Next, but

rather calls the Preview command and Convert command found on the toolbar or in the textual menu

of the converter. In this case, for the library elements the default settings will be used (by default,

conversion is allowed only for user-defined libraries; standard libraries supplied with the system are

not converted).

In the process of regeneration of selected files, the information on the progress and results of the

converter actions will be displayed in the lower part of the converter window, whereas in the upper

left area a user can view again the list of the files being converted in which the current state of

working with each file is shown. A progress bar of files being processed is displayed in the lower right

corner.
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When converting documents containing a specification of the old type (using a database in an

external file), a message will be displayed about converting the specification to a new format and

breaking the link with the database file.

After completing the file transformation, in the lower part of the converter window, the message

about the process completion and indicating the number of occurred errors will be displayed.

To close the application press the graphic button Exit.

Customization of Converter

The conversion process settings dialog is called from the text menu Options > Options….
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The group of parameters "When Error Occurred" defines the system response on the occurrence of

errors during regeneration or saving of the documents:

Stop – stop the conversion; 

Save – saved the document despite the errors; 

Do Not Save – do not save a document if errors occurred during its regeneration; 

Ask – display a dialog box with the error message and ask the user about further actions. 

The group of parameters Backup Copy allows turning on the mode of creating backup copies of all

the files with the specified extension. 

The group of parameters Log is provided for controlling the information displayed in the lower part

of the converter window and in the protocol file.

The flag Save Log allows saving the information about the conversion process in the protocol file. The

name and the path of the protocol file can be specified to the right of this flag. If this flag is disabled,

the protocol file is not saved.

The parameters Output List of Documents with Errors and Output List of not found Fragments

control the output of certain information into the log.

The group Multithreading has only one parameter Number of Treads Limit:. It allows a user to limit

the maximum number of simultaneously started processes upon the conversion.

Upon conversion, the T-FLEX starts several processes in which simultaneous regeneration of not

depending on each other files takes place (if they do not have relationship parent/child in the

assembly). While doing it, by default, to achieve the maximum effectiveness, the number of started

processes is equal to the number of processors on the computer (this allows engaging all resources of
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the computer). This parameter allows put a limit on the number of processes and the computer

resources used by the processes.

The parameter Convert Selected Documents Only (ignore children) is provided for selecting the

mode of assembly conversion. If set, only the selected files will be converted. The fragment

documents that belong to the current assembly, yet are not specified in the file list, will not be

converted.

Don't Check Documents Versions (Resave All). If not set, the documents in the up to date version of

T-FLEX CAD format will not be converted (except the assemblies, whose fragments were converted). If

set, all files will be converted, regardless of the format.

The following group of parameters is used only when converting documents containing 3D models:

Use geometry search. With this parameter turned on, if errors occur during the model element

regeneration (for example, an error regenerating a 3D node created at a body vertex, or an error

regenerating an edge or face blend), the geometry search procedure is launched, that allows restoring

the lost geometry references.

Use of the mode Use geometry search is strongly recommended with the files of the versions

earlier then 7.2. However, in some rare cases, use of this procedure may result in establishing

incorrect references within the model.

Use geometry search on projections. This parameter turns on handling of the regeneration errors that

occur in the elements based on 2D projection lines. The error handling procedure restores references

of these elements.

Regenerate drawing projections. With this parameter set, all 2D projections are regenerated

regardless of the projection parameter setting "Update". Regeneration of projections and sections of

complex models may take considerable time, therefore it should be unchecked if desired.

Update BOMs. This parameter controls recalculation of all BOMs of the document. It is disabled by

default.

Recalculate All Model Configurations. If this parameter is set, then the configurations present in the

document being converted are resaved when converted.

Copy variables and BOM data from template drawing. If this parameter is set, hidden system

variables for working with data for the specification (based on document prototypes) are

automatically created in files converted from formats of versions 7.2 and below.

Variables are copied only if there is no variable in the converted document that matches the name of

the variables in the prototype. The data for the BOM is copied if there is no data for the BOM in the

document and the variables were copied. For drawings, a 2D drawing prototype is used, for 3D

models - a 3D model prototype.

Recommended order of steps when converting models from older versions of T-FLEX CAD

1. Set aside backup copies of documents.

2. Make sure that the complete regeneration of the model in the previous version of T-FLEX CAD

passes without error messages, and the assembly opening without messages about missing fragment

files.

3. Run the converter with the default values ??(the modes Recalculate all model configurations,

Recalculate drawing projections are enabled).

4. For models with complex projections (sections, sections) - the Use geometric search on projections

and Recalculate drawing projections checkboxes make sense to use when the transformation with

disabled modes did not lead to the desired result (especially for the Use geometry search on

projections mode). Enabling these modes can lead to a significant increase in conversion time.

5. In case of problems with the search for design elements in the drawing, restart the converter with

the added flag Use geometry search in projections.
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6. If on very large assembly models the system fails to recalculate projections due to lack of RAM, then

conversion is possible with the Recalculate drawing projections flag turned off.

Enabling the Use geometry search mode is especially recommended for files created in versions

earlier than 7.2. However, its inclusion in a number of rare cases can lead to the construction of

incorrect links in the model.

Application

Calling the command:

Icon Ribbon

Get Started > Options > Applications

Applications > Applications

Keyboard Textual Menu

<AP> Customize >Applications

The command is designed to launch external applications. After running the command, a window will

appear on the screen containing a list of applications with the following fields:

Name - app name.

DLL Name - name of the application file.

Status - application status (for example, 'Started').

There are the following options for working with the list of applications:

· Start. Launching a non-working application.

· Properties.  Calling a dialog window with the following settings:



Service Commands and Tools

2841

o Auto Start. If the flag is set, the application will be launched when T-FLEX CAD starts.

o Start before opening main window. When the flag is set, the application will start working

before loading the main system window.

· Add. Adding to the list of available applications.

· Delete. Removes the selected application from the list.

· Close. End command execution.

By default, the list contains various applications, such as:

· Printing several documents (PrintLayout.dll)

· Animation scripting module (TFAnimate.dll)

· Converting documents from earlier versions (TFConv.dll)

· Drawings design module (Titleblk.dll)

· Nesting module (TFSheo.dll). This module contains a separate help file that is called when the

application starts.

Information Window

Calling the command:

Icon Ribbon

-

Keyboard Textual Menu

<Alt+F1> ? > Information

Calling this command brings up a dialog box that provides access to all current document elements

for editing and information querying. 
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This dialog box displays all 2D and 3D elements. The size of the window and the size of the fields

located on the right can be changed in any way. There is another way to call a command - with the

right mouse button. When the system is in command standby mode, point with the mouse cursor to

the object of interest and click . In the menu that appears, you can select the Information item. In

this case, the window will display information related only to the selected element. In the same way,

you can select a group of elements using the window specified by moving the mouse with the left

button pressed. In this case, the information window will display information about the set of selected

items.

Sequentially expanding the list items, you can get a tree of links of the selected item.

If relations have been created in the document, they are shown in the tree of links with special icons

(the icon of an existing link is shown next to the element to which it belongs).

The following buttons become accessible for selected elements:

· Parents. The button is available if the current element is based on other elements. The tree

displays the selected element and the structure of the parent elements.

· Children. The button is available if other elements are created based on the current element.

The tree displays the selected element and the structure of elements that are its descendants.

· Delete. Deletes the current item.

· Edit. Calling the command for editing an element.

· Show. The Show Selected Items command is executed for the current item.

· Select. The current element is placed in the selector (considered selected) and the dialog box

is closed.

· Measure. Calls the Measure dialog box for reading geometrical data of the selected element.

· Properties. View and change the parameters of the current element.

· Close. Closes this dialog box.
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Information tab. This window contains all system information about the current item. The type and

identifier are required attributes of any element. The availability of other data depends on the type of

the selected object.

Attributes tab. Displays the name, type, and value of an element (the listed fields are populated by

external applications).

When working with the Information window, the user has access to all navigation tools between

windows and pages of the current document. Available commands for changing the scale of the

drawing and other actions that do not change the composition of the current document. The dialog

closes automatically when switching to a window of any other document, when closing a document,

when deleting objects of the current document, as well as when changing their properties or creating

new objects.

When you open the Information dialog, if the document contains a large number of objects (more

than 1000), the objects in the dialog are grouped into folders corresponding to the types of objects.

Adding user's Commands

T-FLEX CAD lets a user add to the textual menu of the system or on the toolbars his own commands

that enable him to start external applications and macros, open a document, a window with a folder

or a library. For the added command an icon can be assigned (file *.ico).

For adding user's command the following command is used:

Icon Ribbon

-

Keyboard Textual Menu

- Customize > User Commands…

After calling this command the User Commands dialog window will appear on the screen. In this

window the following items are defined: the command's type (what sort of operations this command

will do), command call parameters, command name, a line of a tooltip for a command and its icon for

displaying in the textual menu or on the toolbars of the system. 

To add the command, it is necessary to press the Add button.
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Upon pressing this button a drop down list for choosing the type of the command being added will

emerge:

· Macro – adding the command for calling a macro. When this item is selected, a window of an

auxiliary dialog box for choosing a macro is opened. A macro can be selected from the list or

assigned manually;

· External Application – adding the command for calling an external application (without

exiting the T-FLEX CAD). When this item is selected, a window of an auxiliary dialog box for

selecting an external application and start-up parameters will emerge. An additional flag Wait

for application completion prohibits continuation of work in the T-FLEX CAD before closing

the window of external application;
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· Open Document – adding the command for opening the T-FLEX CAD document. When this

item is selected, the standard file selection dialog box will appear;

· Open Folder Window – adding the command for opening a certain folder with the T-FLEX

CAD documents. Upon choosing this item, the standard folder selection dialog box will be

opened;

· Open Library Window – adding the command for opening the T-FLEX CAD library. Upon

choosing this option, the dialog box for assigning the library name will appear.

· Insert Fragment allows to add the Insert Fragment command. If you select this option, you

can create a path to the fragment file, which will be inserted into the current document when

you click on this button. The icon image for such a command can be taken from the fragment

file itself.

· New Document from Template - adding the command to create a document from the

selected template. Upon choosing this item, the standard folder selection dialog box will be

opened;

For each command being added it is possible to assign a name, a brief tooltip and an icon. To do this,

it is necessary to choose a desired command in the list and put the required information into the

Command Name, Prompt, Button Image fields.

To remove an unnecessary command, one can select it in the list and press the Remove button.

For the command selected in the list, the Properties button calls for the same dialog box as the one

used upon addition of the given command. Thus, one can change parameters of the command (for

example, indicate another file for opening or another macro).

The Run button calls for the command selected at the moment in the list of the commands. 

Upon defining user's commands one should keep in mind that the commands defined in the

dialog box User Commands, by default, are not added to the textual menu or toolbars of the

system. Access to these commands is possible only with the help of the button Run of the given

dialog box. To simplify an access to the user's commands, it is possible to add them to the

textual menu or toolbars of the system with the help of the Customize command (Commands

tab).

The list of the user's commands can be saved in the external file *.tfcmd with the help of the Export

button. The list of the user's commands can be read from the external file with the help of the Import

button.
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Icon

Calling the command:

Icon Ribbon

Tools > Special Data > Icon

Keyboard Textual Menu

<IC> Tools > Special Data > Icon

After invoking this command, the dialog window Document Icon is opened. In the Icons field of this

dialog, there is a list of icons created in the current document. After selecting  the icon in the list,

in the preview area (to the right of the list) the image of the selected icon appears. If there are no

icons in the current document, the list will be empty.

Icons can be created automatically. The regime of automatic icon creation is set in the

command Set Document Parameters (Save tab).

To create an icon in the current document, the Add (“manual” creation of icon image) or From

Drawing (automatic creation of icon image) buttons can be used. When pressing any of these two

buttons, the dialog appears in which a user will be prompted to select the size of the created icon:

one of the standard values or arbitrarily specified size. 
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Large icons (of size 32x32, 48x48, 64x64, 128x128 pixels) can be used in the windows of the T-

FLEX CAD libraries.

After selection of the icon size with the use of the Add button, the window of the icon editor (see

below) is opened.

When the From Drawing button is used, the command response after selection of the icon size

depends on which way the Create/Edit icon command was invoked. In case it was invoked while the

2D window was active, the window of the command gets closed temporarily, and the rectangular box

snapped to the cursor appears on the screen. The box allows a user to select the area in the 2D

drawing on the basis of which the icon image will be created. If the command was invoked from the

3D window of the system, then the icon image will be created on the basis of the contents of the

entire 3D window of the current document.

There is one more button in the command dialog which allows a user to create icons – Auto Create

button. This button creates all four icons at once. The icon image is specified in the same way as when

using the From Drawing button.

In addition to creating icons, in the Create/Edit Document Icon command it is possible to edit and

remove already existing icons. To edit the icon, select it in the list (with the help of ) and press the

Edit button. As a result, the window of the icon editor will be opened in which the current icon image

can be modified.
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To remove already existing icon, it is enough to select it in the list and press the Delete button.

The Export button allows a user to save all created in the current document icons in one external file

of the *.ico format. With the help of the button Import, it is possible to load the icons from the

external file.

Preview. Slide

The Save Preview command is provided for creating a preview. The command is called by one of the

following means:

Icon Ribbon

Tools > Special Data > Preview

Keyboard Textual Menu

<PV> Tools > Special Data > Preview

Preview is a vector graphic (T-FLEX CAD Metafile) or bitmap (Windows BMP) image of an arbitrary

size saved together with the drawing file. The preview is displayed in the preview pane in the Library

Explorer window.

Preview can be created automatically. The regime of automatic icon creation is set in the

command Set Document Parameters (Save tab).

Creating preview

Upon calling the command, a dialog box appears on the screen.
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This dialog box serves for creating a preview (in the BMF or BMP format) importing a preview from an

external file and exporting a preview into an external file. 

A preview (bitmap) stored in an external file can be edited using a graphic editor, such as Paint. 

Creating preview in the T-FLEX CAD Metafile (BMF) format is possible only upon invoking the

command from 2D window. Such preview is created on the basis of the image of the active 2D page

of the current document. The area of the page, the image of which will copied into the preview, can

be determined by the system automatically or specified by the user.

For automatic determination of the area of the drawing for which preview is created, the Save

Automatically flag should be enabled. The state of the toggle below the flag determines how the

system will select the area:

By Window Size. The preview image is created by the image of the current 2D window;

Maximize Image (By image size). The preview image is generated by the whole image of the current

page of the drawing;

By Paper Size. The preview image is created by the image of the drawing found itself within the

drawing border of the given page.

After turning on the Save Automatically flag and setting up the desired toggle state, it is enough to

press OK and the preview will be created in the current document.

To manually specify the area of the drawing, the Save Automatically flag should be turned off. In this

case, after pressing OK and closing the Preview dialog window, in the 2D window it is necessary to 

specify the rectangular domain of arbitrary size. To do it, bring the cursor to one of the corners of the

intended rectangle and press , then bring the cursor to another corner and press  again. After

that, the preview creation will be completed.

Preview in the raster Windows Bitmap (BMP) format can be created when invoking the command

both from the 2D or 3D window. As in the previous case, the preview is created on the basis of the

whole image or part of the image of the active 2D page. The used area of the page can be

determined by the system automatically or specified by the user.

The size of the created raster picture (in pixels) is specified via the group of parameters Bitmap Size.

The same parameters determine the dimensions of the rectangular box which is used for specifying

manually the area of the drawing for creating the preview.

Creating preview with automatic determination of the area of the drawing is carried out in the same

way as for the BMF format: it is necessary to set on the Save Automatically flag, select the desired

approach for determination of the area of the drawing and press OK. 
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For manual specification of the area of the drawing, the Save Automatically flag should be turned off.

After pressing OK and closing the dialog window of the command, a rectangular box attached to the

cursor will appear on the screen (its size will coincide with the size of the picture being created). To

create preview, bring the box to the desired area of the 2D window and press .

The settings of the command Set Document Parameters can be disabled in favor of the

described command settings. This will happen if you use the None or Auto value in the Save

combo box on the Save tab of the command Set Document Parameters. Upon confirming the

parameter settings, a message would be displayed that the preview would be created manually.

The preview created in the current document can be exported to the external file of the BMF or BMP

format (according to in which format the preview of the current document was created). And vice

versa, any picture from the external file of the BMF or BMP format can be imported to the current

document. To do it, after invoking the command, select in the list the required operation Save

preview, and then in the appeared standard window for saving/opening files specify the name of the

external file.

The preview saved in the external file of the BMP format can be edited by using tools of any graphics

editor.

3D Annotations

T-FLEX CAD allows creating drawing detailing elements (dimensions, leader notes, roughness's)

directly on faces of a 3D model.

General information

The capability of creating 3D annotations allows instantly introducing in the 3D model not only

geometrical, but also technological process and other information that can later be used when

creating drawings by projections, as well as in other applications, for example, in the process design

modules or when creating CNC control sequences. 

For example, if a dimension between faces or a dimension on a cylindrical face (radius or diameter)

uses a tolerance or additional text lines, then, when creating the dimension in the drawing you select

the respective lines on a projection - this information is automatically passed on to the dimension on

the 2D projection. The same happens when creating a roughness symbol on a face – if you create a
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roughness symbol on the respective lines of the 2D projection image, then the roughness parameters

will be copied from the 3D model.

Data transfer from 3D dimensions to a 2D projection can be done also by a direct

"projection" (mapping) of dimensions from the 3D space onto the 2D projection. In this case, the

system automatically determines, which of the existing 3D model dimensions can be "transferred" to

the current 2D projection. The user just needs to select, which out to the system-offered dimensions

one would like to put on this 2D projection. This functionality is described in detail in the 2D Drawings

of 3D Models chapter.

3D dimensions can be used to manage dimensions of the 3D model. When creating various 3D

operations, the systems allows for an automatic creation of "driving" 3D dimensions. A driving

dimension is directly related with the operation that created it, or, more precisely, with its geometrical

parameter. As soon as its nominal value is modified in the Set Value command, the respective

parameter of the dimension-producing operation will change.
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The driving 3D dimensions can also be created by the user manually. To do this manual dimension

creation, select the faces, whose positions are determined by the operation's geometrical parameter.

For example, you can use the opposite faces of a body created by extruding, or a cylindrical face

created by blending. By using such dimensions, you can also modify the operation parameters and,

therefore, the entire 3D model.

2D dimensions can also be used to modify an operation's parameter values, which are created

between the lines of 2D projections that correspond to the body faces driven by that operation's

geometrical parameter. The system finds this correspondence automatically.

Besides that, the system can in some cases automatically find correspondences between various 3D

dimensions, which are not the control dimensions (the ones not related with the operation

parameters), and 2D constructions used for the body creation, on whose faces those dimensions are

based. This also allows managing the 3D model by modifying the nominal values of such 3D

dimensions. When the nominal value of such a dimension is modified, the system will attempt to

automatically find the 2D constructions, which shall be modified in order to accommodate for the

new nominal value of the given 3D dimension. For example, if a 3D dimension is created between two

side faces of a 3D profile extrusion operation, then the system is able in a number of cases to restore

the constructions train: 3D profile а Profile contour on the workplane а 2D constructions that
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determined the 3D profile contour. In this case, as soon as the dimension nominal value is modified,

the system will adjust the corresponding 2D constructions, the 3D profile based on them and the body

itself, which resulted from the extrusion operation.

3D annotations can be hidden or displayed in each particular window using the Hide 3D Annotations

command :

Icon Ribbon

-

Клавиатура Textual Menu

<SN> View > Hide 3D Annotations

Creating 3D Annotations

3D annotations can be created as follows:

·  In the 3D window, using the common commands for creating dimensions, leader notes and

roughness symbols (Create Dimension, Create Leader Note, Create Roughness Symbol);

·  As 2D detailing elements on workplanes and their consequent display in the 3D window.

Creating 3D Annotations in the 3D Window

Creating 3D Dimensions in 3D Window

To create a 3D dimension, call the Create Dimension command while in the 3D window. 

3D dimension can be drawn:

· Between two planes. When choosing two planar faces, a linear dimension is drawn (for parallel

planes) or an angular dimension - (for nonparallel planes);

· Between a plane and a line. A linear dimension is drawn if a line is parallel to a plane, and a

radial one – otherwise;

· Between a plane and a point. A linear dimension is drawn between a given plane and a point;

· Between two lines. A linear dimension is drawn if the lines are parallel to each other, and a

radial one – otherwise;

· Between a line and a point. A linear dimension is drawn between a given line and a point;

· Between two points. A linear dimension is drawn between selected points (vertices);

· On a single rotation surface. A radial/diametrical dimension is drawn for selected face.

The planes are specified by selecting a planar face or a planar curvilinear edge, the rotation surfaces –

by selecting a face of revolution lying on the given surface. The lines are specified by selecting straight

edges or the axes of the rotation surfaces. The axis of the rotation surface is specified by selecting the

corresponding face of revolution. The points are specified by selecting vertices of the 3D model solid

bodies and 3D nodes.

By default, in the 3D window the user can select planar faces, faces of rotation surfaces, edges and

vertices of solid bodies without turning to the corresponding auto menu options.

If upon creating a 3D dimension, the user selects first the edge-circle/circular arc, or the face of

revolution of type cylinder, sphere, torus, then the system will automatically start creating a

radial/diametrical dimension. In other cases, the system will wait for selection of the second object

(face, edge, vertex) for creating a linear or angular dimension.

Creating 3D Leader Note and 3D Roughness in 3D Window

To create a 3D leader note or 3D roughness, you need, while in the 3D window, to call the Create

Leader Note or Create Roughness Symbol command. When creating a leader note/roughness, you

select the face, on which the element being created shall be placed. The face can be of any type. The
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snap point of the leader note or roughness is the point on the selected face where the cursor was

positioned at the time of selecting the face. For a leader note, you need to additionally specify its jog

position in the space. 

Other than that, creating 3D dimensions, 3D leader notes and 3D roughness symbols is same as

creating the respective 2D elements.

Creating 3D Annotations by 2D Detailing Elements on a Workplane

To create 3D annotations by 2D elements on a workplane, you need to first create the respective 2D

dimensions, leader notes, roughness symbols on the page of the workplane. To display them in the 3D

window, you just need to enable the Show 2D Annotations on 3D View flag in the workplane

parameters dialog box.

For working convenience, this option is also available in the context menu of the plane (Show

Dimensions in 3D).

Such dimensions can be used for modifying the display parameters on the workplane page and,

respectively, the 3D elements created based on it (profiles, operations etc.). They can also be used for

auto-dimensioning projections (under condition that the workplane is parallel to the projection

plane).

Automatic Creation of 3D Dimensions

Automatic creation of driving 3D dimensions, that is the 3D dimensions related with the geometrical

parameters of 3D operations, is made either directly when creating the operation, or from the context

menu of an already existing operation.

When creating a 3D operations, you just need to enable the Create Driving Dimensions flag in the

operation's properties dialog (the Options section). The driving 3D dimension will appear in the 3D

window once this operation creation is completed.

If an operation was already created, call the context menu (by right-clicking ) and select the

Create Driving Dimensions command in it. This will also result in creating a 3D dimension that

controls the geometrical parameter of the given operation. If several operations are selected, then you

can still access the control 3D dimension creation command in the context menu. This command is

also available in the Body's context menu. In the latter case, the control 3D dimensions will be created

in all operations used for creating the Body, wherever possible.

Using fragment dimensions in assemblies

3D annotations, set inside the fragment document, can be "raised" into the assembly. To do this, in the

properties window of the command for creating/editing dimensions, on the General tab, enable the

Show on 3D fragments checkbox.

Dimensions raised in 3D into a slice assembly can be used for two purposes:

· As decorative - they show the denomination of the dimensions;
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· As driving - such dimensions are used to set the values of external variables of a fragment by

editing their denomination. To do this, in the size parameters, you need to set the

denomination type Manually, and in the expression field write the name of the external

variable. Editing the value of such a size in an assembly will be available both when the

command for editing a 3D fragment is launched, and according to the usual scheme for

changing driving dimensions in the Set Value command.

3D Annotations Display Options

By default, parts of 3D Annotations hidden behind non-transparent elements of a 3D model are not

displayed. If necessary, you can enable the Display annotations over 3D model option (Options > 3D

> 3D).

Materials

A material is a T-FLEX CAD element. It contains a list of characteristics of a real material with which we

deal in reality. A material is used as a parameter for all 3D operations, and, additionally, by a special

command of applying material to individual faces.

Material characteristics can be roughly divided into two types. Characteristics of the first type affect

the appearance of three-dimensional objects in the 3D window. Characteristics of the second type are

various physical-mechanical parameters of a material, such as density, elasticity coefficient, etc. Those

parameters are taken into the account when calculating mass-inertia properties, as well as conducting

structural computations in the analysis module. Besides that, materials are accounted for when

creating hatches on sections of 3D models. You can define parameters of such hatch for a particular

material.

General Information

For each model we can associate a set of materials that were assigned to Bodies, operations or

individual faces. These materials are called the materials of the current model. Material – is a 3D

element containing a set of characteristics of the real material with which we are dealing in reality.

The element “material” has parameters such as density, reflection power, absorbing capacity, etc. 

For any Body of the model it is possible to specify the basic material and coating material.
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Basic material is used for calculation of mass-inertial characteristics and engineering analysis, and also

for displaying the Body in 3D scene in the Render visualization mode (if the additional material of the

cover is not specified).

Coating material – is an additional material for defining parameters of the model display in the 3D

window. It allows us to specify the material different from the basic one to be used for visualization

purposes, creating the effect of the Body “painting”. At the same time for engineering calculations the

basic material will still be used.

1 - basic material, 2 - coating material

The material can be applied on individual faces of the body. When the face’s geometry is changed as

a result of further transformations of the model the material that was applied onto the face is

retained. When applying the material on individual faces, the body itself does not change its own

material. You can apply material on individual faces only when the Apply as coating material flag is

enabled.

Materials used in the current model are displayed in the tree of the 3D model, in the operations

properties dialogs, and in the Materials service window.

Material can be set as a default parameter (see the Default Parameters section).

Materials in 3D model tree 

Materials used in the current model are displayed in the tree of a 3D model in the special folder –

Materials.
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Different icons are used in 3D model tree to identify coating and basic materials. 

The icon  is used to identify basic material. The icon  is used to identify coating material. 

If the material is applied to any body in scene, the icon  appears to the left of the materials name. If

you press this icon, the list of objects to which the material is applied will appear. Icon do not appear

near not applied materials. 

It is possible to edit material properties or delete the material from the current model using 3D model

tree. The commands for deleting and editing the material properties are available in the context menu

of the 3D model tree. 
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Note that upon deletion of the applied material, the system will also prompt you to delete the

operations to which the given material was applied.

“Materials” service window

Special service window – “Materials” is used to work with materials. It is available even if there is no

open document. 

To display this window, the following commands can be used:
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Icon Ribbon

Tools > Appearance > Materials

3D Model > Appearance > Materials

Draw > Appearance > Materials

Assembly > Appearance > Materials

Sheet Metal > Appearance > Materials

Surfaces > Appearance > Materials

Weld > Appearance > Materials

Routing > Appearance > Materials

Primitives > Appearance > Materials

Support Geometry > Appearance > Materials

Keyboard Textual Menu

<Alt+8>,

<3MT>

Customize > Tool Windows > Materials

Tools > Materials

There are two tabs in the Materials window: Document (materials of the current document) and

Libraries (a list of libraries with materials), as well as a preview window of the material view. By

default, the material list of a model contains one item - Steel.

Materials Toolbar Options

To view/edit the material’s properties it is required to select the material (in the list of materials of the

current model or in the library) and press the Show Materials Properties window  button in the

upper part of the window or press . If the window is “fixed”, a separate dialog window of

parameters of the selected material will appear.
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When the Materials window is in “floating” mode, the dialog of parameters of the selected material

will appear in the right part of the “Materials” window itself. The dialog of parameters can be hidden

by pressing  again.
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The Create Material  or Create Coating Material  buttons allows to create a new material.

Material is created either in the current model or in the library, according to the currently selected part

of the window.

The Create color-based material  button allows to create the cover material based on color. After

activation, the dialog for selection from the colors catalog appears.
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After selection of the color the new material is assigned the same name as the selected color (for

example, “RAL 1000”). After confirming color selection, in the current window of the materials library

or of the model the cover material is created with the corresponding name and properties.

The flag “Apply as coating material” is automatically set for a created coating material. 
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To navigate across the material libraries you can use search toolbar. With its help, the material can be

found by the name or by part of the name.
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For searching, you need to enter the name of material or part of its name into the text field. After

pressing <Enter> or  the focus of the model tree will be placed on the desired material. Repeated

pressing of <Enter> or  initializes the transition to the next search result in the library. The entered

name of the material if it does not yet exist must be added to the list in the text field. 

The search among materials of the model is not carried out.

The Create Library  button allows to create the new user-defined library of materials. If the library is

located in any non-system folder and can be edited, it is highlighted with a yellow icon . If the

library is located in the system folder, then it is read-only and is displayed with a green icon .

By default, material libraries are stored in the ...\Program\MaterialLibrary folder. If the created library

was moved, changed or deleted by the user outside of the T-FLEX CAD system, then the next time the

system is started after these changes, the icon  will appear in the Materials window next to the

changed library.

The Open Library  button serves for opening already existing materials library, similar to the

context menu command.

The Open T-FLEX DOCs Dataset  button allows to open the T-FLEX DOCs dataset if there is

integration with T-FLEX DOCs (see the corresponding section of the T-FLEX DOCs documentation).

The Open library from T-FLEX DOCs  button allows to open a library from T-FLEX DOCs if there is

integration with T-FLEX DOCs (see the corresponding section of the T-FLEX DOCs documentation).

The Save changes in libraries  button allows to save the changes introduced into the materials

library. This can be adding/removing material from the library, changing the properties of any library

material, or changing the structure of the library (for example, creating folders in it).

The Create copy of material  button allows to create a copy of the selected material.

The Link Materials  button allows to link the materials of the document to the materials of the

selected library. When you click the button, a material linking window opens, which displays all the

materials in the document, the source library and the title in the source library.
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The  icon means that the properties of the current material differ from the properties of the

material with the same name in the source library and can be updated.

The  icon means that several source materials with the specified name have been found for the

material, which are listed in the Name in Source column. In this case, the Update button will have no

effect.

The  icon means that the properties of the current material match the properties of the source

material of the same name.

If the icon is absent, then the link with the material with the source has not been established.
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 -  Refresh. Updates the material to match the source material in the source library.

 -  Link with Library Material. Allows to link the selected material to any material from the library.

When you select an option, an additional window opens with a choice of material. It is possible to

select a material from the current document, provided that this material has a source.

 - Link with Same Library Materials. Allows to link a material to a material with exactly the same

properties from the selected library.

 - Unlink. Allows to reset the link with the source.

More information about working with libraries of materials can be read below.

Materials of the Current Model

The list of the current models materials provides quick access to the most frequently used materials

without searching through the libraries. It contains all materials that were used in the current

document. 

To identify coating materials icon  is used. To identify basic materials icon  is used. To identify

materials that were applied previously but not in use, there are icon  and icon .

The following actions can be executed with the list of materials of the current model:

· Change the material of bodies in the scene (The Apply to model option in the context menu);

· Set as main material;

· Add information about the material to the report and BOM (the Add to Product Composition

option in the context menu);

· Create material;

· Create copy of material;

· Delete materials from the model;
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· Copy material to clipboard. You can copy material to another document;

· Paste material from clipboard;

· Open material properties.

Materials libraries 

The list of material libraries is an archive with basic and coating materials that are most frequently

used in design. These materials are sorted by categories. There are three libraries that are opened by

the default: Metals, Non-metals and Coatings. They are identified by  icons.

Materials from these libraries can’t be changed inside the libraries. For this purpose, they should

be moved into Current model materials window or into created library.

The obsolete libraries of previous T-FLEX CAD versions are also available and can be opened if

necessary.

For various operations with libraries and materials you can use commands from right button context

menu of “Materials” window or materials toolbar.

Material Libraries Creation

You can create your own libraries with customized set of materials.

For this purpose, use option  on the materials toolbar or Create Library item in context menu. The

user-created library is identified by icon . The newly created library appears in the list of available

libraries and has the default name New Library.
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Material can be created only in custom library open for editing. You cannot create material in

system readonly folders identified with  icons.

The created library is not automatically saved to disk. To make the library available on subsequent

system launches, you need to use the  option on the toolbar or the Save As context menu item.

When saving, the library can be given a new name and a save path. Extension for material libraries in

the T-FLEX CAD system - .mtr.

File in .mtr format can be opened in any text editor.

In a case, when changes in library were not saved before closing, system will offer you to save these

changes. 
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Catalogs of Materials Creation

For convenience, you can combine materials within the separate catalogs for each group of materials.

To create a new catalog you need to select library, in which it will be created, press  and select

Create Catalog item from the context menu. Created category will be called New Catalog. You can

rename catalog directly after creation or rename it later using Rename item from the context menu.

Created category can be deleted using Delete item from the context menu.

To copy all materials from a catalog to the list of materials of the current model, use command Copy

from the context menu or drag the category manually.

Within one library, you can create any number of catalogs. In each catalog, you can create additional

folders with materials (sub-catalogs).

The catalog can be copied and transferred to another library or catalog.

Materials Creation and Applying 

To create a material in the new libraries and catalogs, use command New Material or options , 

 and  on the materials toolbar.

To apply a material to objects in the scene, you can use Apply to Model item from the context menu

or "drag&drop" method.
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If there are several bodies in the scene, the following dialog window appears:

If you press OK or if there is just one body in scene, the following window appears:
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The Change body material item allows to assign a selected material to one or several bodies in the

scene.

The Set as main material item allows to set the selected material as the base material for the model.

Information about the material will be included in the title block of the drawing.

The Add to Product Composition item allows to immediately enter data about the material and its

assortment into the product composition. More information about this can be found at the end of the

section.

In case, when changes in one or several materials from library were not saved before closing, system

will offer you to save these changes. 

To move materials within a library or from one library to another or between catalogs and lists of

materials of the current model you can also use "drag&drop".  The individual materials can be copied,

using the context menu commands Copy and Paste.

If the material or catalog is copied to a material library or catalog that already contains an

element with the same name, the copied item will be automatically renamed and numbered

with (1), (2) and so on suffix.

Preview

The preview window allows to estimate material visually, without applying it to the objects in the

scene. The mode is activated by item Split Horizontally from the context menu.
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Selected material can be displayed on the cubic or spherical surface. To switch between these modes

click  on the picture.

Change Material Using Variables

A text variable can be used to set the material.

For that purpose you should use existing or create a new text variable using Variable Editor command.

In the expression field you need to enter or copy from the library the name of the material that will be

used for the model.

In order to generate a list of several materials, select the Materials option in the List field.
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In the window "Value List for Variable" you need to specify all materials that can be used for this

model.

It is important that the names of materials must match similar names in the library.
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After creating a variable, you need to go to the model parameters, and enter the name of the created

variable in the Material field. In this way, you can define both the base material and the coating

material.

After completing these steps, you can change the material of one or more bodies with the drop-down

list in the variables window.
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To display the new material in the scene, you need to update the 3D model using the Apply button.

In addition, it is possible to explicitly indicate the library in which the material is located when it is set

through variables or by entering into the appropriate text fields of the operation parameters dialog.

The syntax is the same as for specifying libraries in file links: "<library> material".
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Material’s properties dialog

The material’s properties dialog contains all physical-mechanical properties of the material, displays

parameters of the material in 3D scene and on projections, and parameters for creation of

photorealistic image (see the Photorealistic View section).
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To call properties dialog window you need to select material (in the current model materials list or in

the library) and perform one of the following actions:

·  press  icon on the materials toolbar;

·  press  on the material name;

·  select item Properties from the context menu.

«View» Tab

This dialog combines parameters that are responsible for the characteristics of color, reflection,

transparency and self-illumination of the material.

The image of the material on this tab is available in two versions: in the form of a ball with a recess

and in the form of a cube, for a more complete display of the visual characteristics of the material.

Also in the View tab, in the Name field, you can edit the name of the material.

The Description field displays the name of the catalog in which the selected material is located. This

information is necessary to a greater extent for grades of material, so that it is clear what type of

material is used, because the type of material is not indicated in the brand name.

For the material of the model, this field can be edited by entering the required description.

When copying material to the library directory, it is assigned the name of the directory to which it was

copied.
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«Colors» Group

This group combines parameters defining characteristics of material’s color. To specify the color for

one of the parameters, it is required to click into the color rectangle and use the standard mechanism

for color selection.

Main. This parameter controls the color of the material lighted up by direct light. This is a base color

of the material.
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Ambient. This parameter controls the color of the material lighted up by dispersive light. It

significantly affects the color of the material’s surface since at the given moment of time only a small

portion of object is subject to the action of direct light.

Specular. This parameter controls the color of blinks that appear on the surface of object. The brighter

the color, the more intensive the blink is.

Self-illumination. This parameter controls the intensity of the light radiated by the material. If the

material does not radiate the light, the black color is specified.

«Effects» Group

This group of parameters allows us to customize the following optical characteristics of materials:

Shininess. This parameter controls the power of reflection of light sources on object’s surface. It is

specified as a single number that can range between 0 (minimum) and 1 (maximum). Large values

create the appearance of smoother and shinier material whereas the decrease in their values imitates

dull surfaces.

Transparency. This parameter controls the value of transparency of the object’s surface. It changes

between 0 (nontransparent surface) and 1 (totally transparent surface).

Reflection. This parameter controls the value of the specular reflection of the material. It is specified

as a number in the range between 0 (reflections of surrounding objects will not be shown on the

material’s surface) and 1(entire reflectivity of the material is provided).

Index of Refraction. This parameter characterizes the deflection of light rays as they pass through the

transparent material. Using the index of refraction you can set the value of this parameter for a

transparent material. This option is taken into account when generating photorealistic images.

If the Apply as coating material parameter is enabled, the material is applied as a cover’s material

and not as the basic material.

«Texture» Tab

This tab combines parameters that control the material’s texture specification. Texture – is an image

that is stored in the file and helps us to display special features of material’s surface coloring.
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«Diffuse Map Texture» Tab

File. File of the image containing the picture of the texture. To specify the texture, the files of the

formats bmp, gif, jpg, jpeg, tga, tif, tiff and png can be used.

The work with texture files is realized according to the general algorithm of working with references

to external files (similar to fragments, pictures, files of databases by reference etc.). This means that:

1. Texture files can be located in the same folder as the model’s file that uses this texture;

2. Color texture and relief texture can be specified by different files;

2. Texture files can be moved with the Move assembly command similar to other types of files;

3. Texture files can be included into the file of the model that uses the texture (embedded textures);

4. To specify the path to the texture file the library’s name can be used;

5. To specify the path to the texture file, the relative paths that includes the folders names or transition

to the upper level (..\) can be used.

When you choose texture file folder Program\Textures is opened by default.

«Texture transformation» group

This group of parameters serves for customizing the appearance of the texture, translation of the

texture, changing its scale and for rotation.
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Translation X. This parameter defines the shift of the texture’s start point along the horizontal axis.

Translation Y. This parameter defines the shift of the texture’s start point along the vertical axis.

Scale S. Texture’s scale along the horizontal axis. The scale’s value can be negative. If, for example, we

axis.

Scale Т. Texture’s scale along the vertical axis. The scale’s value can be negative.

Rotation. Texture’s rotation angle. The texture is rotated around the center located in the plane

perpendicular to the direction of texture’s projection.

«Relief Texture» group

This parameter group is responsible for creating the visual relief of surface material. The essence of

relief is that by adding shadows and highlights, the effect of a relief on the surface of the material is

created, while in fact it remains completely flat.

There are three main ways for creating effect of relief surface corresponding to texture type:

Normal Map. This texture like bump map allows to simulate bumps and roughness of the surface. This

texture more accurately renders surface relief compared to bump map texture. It is set by default.

Bump Map. This texture allows to create the illuminated and shaded areas to simulate simple bumpy

surfaces, flat protrusions or dents.



T-FLEX CAD 17 Help

2882

Parallax Map. If you use this texture surface relief becomes three-dimensional and looks differently

from various angles.

File. File of the image containing the picture of the texture’s relief. To specify the texture it is possible

to use the files of bmp, gif, jpg, jpeg, tga, tif, tiff и png formats.
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 «Hatch» tab

When creating sections and cut views in the 2D Projection command there is a capability of automatic

hatching of the section. Hatching used in the section is defined with the following parameters:

Type. Hatching type.

Size. Distance between the neighboring hatching lines.

Angle. Angle of rotation of hatching lines. When selecting the hatching, the tilt angle of 0 degrees

signifies the hatching with horizontal lines 

Line thickness. Parameter allows to specify the thickness of lines.
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«Physical properties» tab

In the window of this dialog, you can specify physical-mechanical properties of the material. These

parameters are used in calculation of mass-inertial characteristics and also when performing structural

calculations in the analysis module.

In the upper part of this window, the physical-mechanical properties can be specified. In the lower

part of the window, the units of measurement can be selected. 

When changing the parameters of the units of measurement, the values of physical-mechanical

properties are recalculated automatically.

You can specify the physical-mechanical properties with variables.

A more detailed description of the physical properties of materials can be found in the T-FLEX

Analysis help in the Defining Material section.
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«POV-Ray» tab

In the window of this dialog, you can specify parameters that are used upon creation of photorealistic

view (see the Photorealistic View chapter).

In POV-Ray tab, a large number of characteristics of surfaces and inner space of bodies are used for

description of the 3D scene. All materials from the materials libraries supplied with the system already

have the POV substitutions (libraries from POV-Ray, for example, textures.inc, are used in them).

In the POV-Ray tab, the following parameters can be specified:

Include files. The field of the given parameter shows the files in which available characteristics for the

specified material are stored.

“Texture” group

Description. Name of texture that is specified in one of the included files is displayed in this field.

Here you can specify custom properties if you know POV-Ray programming language.

Scale. Defines way of displaying for the specified texture, when applied to a body.

· Don’t scale. The specified texture will repeat without scale changes.

· By default. The texture will be stretched on the whole surface.

· Minimum/maximum size. The scale will be maintained by the minimum/maximum size of

surface to which the texture is applied.
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Apply to:

· Bodies. The texture display will look more real. Most of all it refers to wood textures. In this case,

slice of the wood fibers will be displayed on one of the body’s faces.

· Individual faces. All body faces will have similar texture display.

“Interior” group

Interior properties are specified in this group: index of reflection, light dispersion in volume, etc.

Parameters Description and Scale are similar to the parameters above.

Allow rotation. If this parameter is set, texture, applied to the interior space of a body will be rotated

together with the body.

There is also the Apply Material command that allows to apply a specific material to one or more

model faces. Moreover, when the geometry of the face changes, as a result of further transformations

of the model, the material imposed on the face is preserved. The command does not change the

geometry of the model, but is displayed in the model tree and is an independent operation.

Apply Material

Calling the command:

Icon Ribbon

3D Model > Advanced > Apply Material

Keyboard Textual Menu

<3AM> Operation > Apply Material

The Apply Material command allows applying a certain material on one or several model's faces. The

applied material will be maintained through the future model modifications despite changes in the

face’s geometry. The command  does not change the model geometry, but it is displayed in the

model tree, standing as an independent operation.

The command is convenient for accurate texture positioning using different applying laws and in

situations, when you need to dye only selected faces. 

You can apply material using “drag’n’drop”. In this case Apply Material operation is automatically

created.

Upon entering the command, the automenu provides options that allow selecting of body faces. The

following option is automatically enabled:

<F> Select Face

You can select faces using this option. At the same time, you can only select the faces belonging to a

single operation body. The selected faces are entered in the Faces list in the command's properties

window.

Using the Material Application parameter, you can specify on what faces the material will be applied:

the Selected Faces or the All Except Selected Faces.

If you plan to assign the same material to several faces of one body, it is recommended to select

all of them within one material application operation. This will help avoiding the unnecessary

complications to the model structure.
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To select all faces of the operation body, you can use the option:

<O> Select Operation

When using this option the material is applied to all faces of the selected operation body.

To select a material to apply, you can use field Material in the properties window. Material of the

current model can be selected from the drop-down list. To open properties window use  button.

To call the operation parameters use option:

<P> Set entity parameters

To cancel selection of all faces, use the option:

<K> Cancel selection of all faces

In the command's properties window, additional parameters of the texture mapping can be specified:

The Mapping mode group allows us to select the material mapping mode and the scale of the texture

along different axes.

 In the drop-down list of mapping modes the following options are available:
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1. From material – all parameters are taken from the properties of the material.

2. Plane – mapping is carried out as if the texture is projected along the normal to the plane on

which the texture is located, i.e., on the XY-plane of the manipulator. 

3. Sphere – mapping is carried out as if the texture is located on a segment of the sphere. This option

is convenient for mapping textures on spherical and close to spherical surfaces. Parameters of the

sphere determine the scale of the texture of the material and are controlled by the manipulator.

4. Cylinder – similar to the sphere but the type of the surface is different.

5. Box – it is assumed that the textures are mapped on the faces of a parallelepiped and are

projected from these faces. For this mapping mode, additional scale along the third coordinate is

used. The scales thus define the dimensions of the «template surface».

6. By surface coordinates – this mapping is useful for curvilinear surfaces. For this mapping mode, the

texture coordinates are associated with internal coordinates of the surface. It can be considered as

a generalization of the texture mapping on a sphere or a cylinder. The texture is always displayed

on the surface in a unique way, therefore, the manipulators are not used.

The “Texture transformations” group allows us to specify for the texture the mapping parameters that

are different from those specified in the properties of the material itself. The “Without properties of

material” flag determines the source for the parameters of the mapping. By default it is disabled and

the mapping parameters are taken from the properties of the material. When the flag is enabled, the

user can specify new values of the parameters (“Direction S”, “Direction T” and so on.)

To control the mapping of a texture and its accurate positioning, the intuitively clear manipulators are

used. The view of a manipulator depends on the selected mode of material mapping. All parts of the

manipulator are functional. For each element of the manipulator there is the context menu with

various fixings and commands. 

More information about manipulators can be found in the LCS Manipulators for Transformations of

3D Elements section.
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Example of Applying Image to a Face 

An image of a wristwatch dial will be applied to the face of a watch body as an example of using

Apply Material command.

First, you need to create the coating material. Color texture of the material will be specified by image

file. The Clock-face.jpg image file used as the color texture. It is located in the folder T-FLEX

Parametric CAD xx\Libraries\Examples\3D Modeling\Apply Material.
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The example is located in library Examples\3D Modeling\Apply Material\Watch.grb.

In order to apply the material "Clock-face" on the selected face of the watch base you should:

1. Open the file with watch body on which the material will be applied;

2. Add Clock-face material to the list of materials of the current model.
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3. Activate Apply Material command;

4. Select required watch face with the help of Select Face option;

5. Select Clock-face from drop-down list in Material Application window;

6. Select Plane in Mapping Mode drop-down list.

7. Specify positioning of material on the face with the help of special manipulators in the 3D scene

and the Texture Transformation group in properties window.
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8. Press  to finish input.

Topics in this section:

· Edit Material Application
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Edit Material Application

The command is used for editing the Material Application operation:

Icon Ribbon

-

Keyboard Textual menu

<3EAM> Edit > Operations > Material Application

Available options:

<Esc> Cancel selection

<A> Select All Elements

<R> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<Esc> Exit command

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Photorealistic View

Ray tracing of the 3D scene is a special way of rendering the scene that accounts for shadows cast by

the objects, as well as for such phenomena as light reflection and refraction.

There are three different mechanisms of photorealistic images generation. First of them uses

integrated NVIDIA OptiX technology, the second uses Embree – ray tracing kernel developed by Intel,

the third uses POV-Ray application.  

Photorealistic View (GPU NVIDIA)

The first mechanism for generation of the photorealistic images uses NVIDIA OptiX technology. It is

used for creating of high quality images based on lighting and material properties such as

transparency, refractive index, surface properties, etc.
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The mechanism allows obtaining photorealistic images directly from T-FLEX CAD environment,

providing convenient interface of 3D scene parameters management, control over the quality of result

and possibility to print result or save it into a file.

With this mechanism, photorealistic image can be generated not only from three-dimensional solid

models, but also from imported 3D models.

The NVIDIA OptiX technology is used for creation of photorealistic videos when you record 3D

model exploded view animation in Exploded View command.

Photorealistic View (CPU NVIDIA)

The second mechanism for generation of the photorealistic images uses Embree – ray tracing kernel

developed by Intel. 

Embree uses CPU for its calculations and provides high performance and image quality.

User interface for NVIDIA OptiX is similar to the Embree. They will be described together in the

following chapters

Ray-tracing (POV-Ray)

The third mechanism uses POV-Ray technology, a program that uses a ray tracing method. See the

detailed description of the mechanism in the POV-Ray section.

It is recommended to use NVIDIA GPU or CPU mechanisms.

Selection and settings of image quality

It is rather unlikely that a satisfactory photorealistic image will be created on the first try. Usually,

several test photo renderings are required that help adjusting the camera position, brightness and

position of the light sources, and checking the animation correctness. After that, the final rendering is

run.

However, photo rendering could take unspecified time, depending on the scene complexity and the

parameters defining the image quality. Understanding these parameters helps avoiding excessive time

spending on test renderings, on one hand, and helps achieving higher quality of the final image, on

the other hand.

There are various parameters for adjusting the quality of the resulting ray-traced image.

Mesh density. This parameter is defined in the document parameters (the Set Document Parameters

command), and, besides the photo rendering, affects the quality of rendering objects in the 3D

window. 
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In addition, the image quality setting can be called using the View toolbar.

Command of Photorealistic View

To activate the command use:
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Icon Ribbon

Tools > Appearance > Photorealistic View > Photorealistic View (GPU NVIDIA)

Keyboard Textual Menu

<3RV> Tools > Photorealistic View (GPU NVIDIA)

Icon Ribbon

Tools > Appearance > Photorealistic View > Photorealistic View (CPU)

Keyboard Textual Menu

<3RU> Tools > Photorealistic View (CPU)

After activation new window with generated image appears.

Quality of the generated image depends on the number of iterations. The iteration is evaluation of

image pixels color. The evaluation process depends on image size, mesh quality and number of

objects.

The iteration number is displayed in the lower part of the window.

Process of the image generation can take from several minutes to several hours according to

your computer power, model complexity and image quality.

Options for the operation are displayed on toolbar.
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Image Parameters. Allows defining the image generation parameters. More information about it can

be found below.

Fix generation parameters. Allows fixing the image view and scale. Model rotation becomes

unavailable. 

Pause Photorealistic View generation. Allows to pause generation of the image. This option stops

calculations and releases computer resources.

Update generation of photorealistic view. Restarts photorealistic view generation. All current results

are canceled. 

Image quality. You can set one of four kinds of quality from the drop-down list.

The low and standard qualities are used for rough drafts of images. When one of them is set, the

minimum quantity of iterations for generation of the image with certain level of “noise” is evaluated

by the system. 

To generate the most realistic images you need to choose high or maximum quality. When the quality

set to maximum, the number of iterations is not limited.

Select of current active camera. Allows to select one of the cameras existing in scene. Image will be

generated according to the camera location. 

Save image. Allows to save generated image in *.bmp, *.jpg, *gif, *tiff, *tif, *.png, *.tga formats. You

can set the file name and specify folder.

Print image. Allows to print generated image.

An important role in the photorealistic image creation plays Mesh Quality parameter. You can change

it with the drop-down list on the 3D tab in the Set Document Parameters window (see above). The

higher the quality the higher is the density of the mesh. To create the most realistic images, it is

recommended to set Fine or higher quality. 

This configuration is especially important for models with rounded faces.

Difference between images with different quality.

Ultra Coarse Standard Ultra Fine

Generation of photorealistic images requires high computer characteristics. More information

about requirements can be found on our website or in the System Requirements section. 

The image generation can be paused anytime. Its result can be saved to disk with Save Image option

or printed with Print Image option.
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Source model

Photorealistic image

Examples of photorealistic image generation can be found in library Examples/Additional

resources/Materials and Photorealistic View.
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The photorealistic image and 3D model windows can be displayed simultaneously. For this purpose

use Views Placement command.

In the dialog window select Photorealistic View from the drop-down list. You can set convenient

windows placement with the help of four drop-down lists. 
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Image Parameters

Use current view size. When active, the option allows to set the generated image size. After

activation, option Fix generation parameters on the toolbar automatically activates. 
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Fit to window. The option is enabled only when the Use current view sizeflag  is set. When the option

is active, image of the current size is fully displayed. 

Size of the image is specified in pixels. The image of specified size will be generated completely, even

if it does not fit the window. To generate images of the highest quality it is recommended to set the

largest current view size.

Image quality. The option duplicates the drop-down list of settings from the toolbar. The only

difference is the possibility to set the number of iterations manually. You need to select user quality

and specify the number of iterations.

Reflection max depth. The option is important for generation of refractions and reflections.

All texture parameters are similar to the standard parameters of 3D view. 

More information about them can be found in Set 3D View Parameters section.

Luminance factor of environment. Allows to set luminance by adjusting the amount of light coming

to objects. 

Photorealistic Images Examples

NVIDIA Optix:

Embree:

Topics in this section:

· POV-Ray
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POV-Ray

Icon Ribbon

Tools > Appearance > Photorealistic View > Ray Tracing (POV-Ray)

Keyboard Textual Menu

<3VY> Tools > Ray Tracing (POV-Ray)

Ray Tracing

This mechanism uses POV-Ray, a ray tracing program which generates images from a text-based

scene description exported from T-FLEX CAD. POV-Ray installation is included in T-FLEX CAD

installation package or can be downloaded from appropriate web site.

T-FLEX CAD rendering Ray tracing (POV-Ray) rendering

Note that the POV-Ray application requires separate installation (see POV-Ray official website).

When creating a ray-traced image, the 3D scene is exported into POV format, using the settings

of the current 3D window. Next, the POV-Ray application is automatically launched for

generating the photorendering. Once generated, the resulting image can be viewed in the View

window and, if desired, saved in a file.

POV-Ray processing runs parallel to other systems; therefore, you can continue working with T-FLEX

CAD after launching this application. However, depending on the complexity of the image being

generated, POV-Ray may consume more resources, and so T-FLEX CAD operation could be delayed.

Command operation

To create a ray-traced image, use the command Ray Tracing (POV-Ray). This command will be

available if the 3D window is active. Before calling the command, set the 3D scene in the desired

orientation, apply the desired materials to the operations, place light sources (one can use the light

sources on the camera). Prefer the perspective projection when creating a ray-traced image.

The command is called as follows:



Service Commands and Tools

2903

T-FLEX CAD saves the information about the location of POV-Ray application and checks its

availability upon each call to this application. The first time POV-Ray is called, as well as in the

cases, when the system cannot find this application, T-FLEX CAD requests the path to the

application. In such a case, a dialog box is displayed that allows defining the path to the POV-

Ray application. Normally, the path to this application is: Program Files\POV-Ray\v3.7\bin. If

this folder is missing, the application may not be installed.

Upon calling the command, the following dialog box will be displayed.

Width and Height. These define the width and height of the ray-traced image being created, in pixels.

The default size is that of the current 3D window.

Antialiasing. Provides smooth color transition in the generated image. The value of this parameter

must be greater than 0. 

The smaller is this value, the softer will appear the transition from one color to another; however, the

rendering (image generation) will take more time in this case. The value of this parameter can be

selected from the list or specified manually.

Use Material substitutions. POV-Ray uses a special language for describing the 3D scene. It allows

specifying a large variety of properties for material surfaces and insides. Due to this, T-FLEX CAD uses

special instructions for materials, determining, how a material would appear when visualized in POV-

Ray (the Materials command, material properties, the POV-Ray tab). When the Use Material

substitutions flag is set, those instructions are passed to POV-Ray. All materials included in the system

distribution possess special instructions for POV-Ray. Besides the materials, the light sources and

additional instructions for light sources will also be exported in POV (see Light source parameters, the

item POV Instructions).

If the Use Material substitutions flag is off, then the instructions will be passed on to POV-Ray, that

are automatically generated by T-FLEX CAD based on such material properties as color and

specularity.

Export Light on Camera. By default, one or more light sources are attached to a camera in the 3D

window. These light sources have specified orientation with respect to the camera and move together

with it (see the manual on 3D View Parameters). If the flag Export Light on Camera is on, those light

sources are passed to POV-Ray.

Save result in. This item displays the path to the temporarily created output file that used by POV-Ray

for setting the resulting image in the bmp format, and by T-FLEX CAD for reading it. Therefore, if T-
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FLEX CAD is closed before the result is created, the image in this file can be viewed later, using any

other program for viewing images.

All temporary files created during the image generation are stored in the folder pointed at by

the system variable TEMP. Upon completing the image, all files except the output one are

deleted. The output file itself will remain in this folder up until creation of another ray tracing.

Information for users with experience in POV-Ray

Light source parameters. When creating a photorealistic image by using conventional light sources,

the objects cast well-defined shadows because the light sources are infinitely small. In the reality, this

happens very seldom; therefore, shadows are often blurred. The use of the diffused light sources

allows making shadows smoother and enhances the image quality and realism. The diffused light

sources use multiple concentrated light sources offset from each other, instead of one such light

source. The more those are offset, the less sharp will be the shadow. The more concentrated light

sources are included in a diffused light source, the more the shadow is blurred and the longer time it

takes for the rendering.

 

           Conventional light

 

                 Diffused light

A diffused light source in POV-Ray is made of multiple concentrated light sources. These light sources

are placed in a rectangular array oriented in a certain way with respect to the specified center. The

number of light sources along each of the rectangle's sides can be different. To make a light source

created in T-FLEX CAD a diffused light source in POV- Ray, enter the following in the POV Instructions

input box for the light source properties:

area_light <0.035, 0, 0>, <0, 0.035, 0.035>, 5, 5 adaptive 1 jitter

Above, the coordinates of the opposite corners of the rectangle are entered in the angle brackets with

respect to the origin point (the point where the diffused light source is positioned). "5, 5" - is the

number of light sources in each direction. In this way, the total number of the concentrated light

sources is equal to 5x5=25. "adaptive 1 jitter" - are the additional parameters directing optimization

of shadow calculation. 

Antialiasing. In conventional rendering, the phenomena of jagging and dashing of thin lines could be

encountered. Smoothing by additional calculations may reduce the negative impact of such

phenomena.
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  Jagged edges

 

  Antialiasing is on

Antialiasing involves increasing the resolution when visualizing some parts of the scene. This slows

down the scene rendering. Therefore, avoid using antialiasing in test renderings. However, antialiasing

is preferable in the final rendering. 

Radiosity. In conventional renderings, only the direct light is accounted for, that illuminates only the

objects directly lightened by the light source. However, in the real world, the light originates not only

from the sources. It is also reflected from the objects illuminated by the direct light. POV-Ray provides

an option of turning on the method of calculating radiosity, that in certain cases enhances the image

realism.

 
  Conventional light

 
    Radiosity

Due to bulky additional calculations, use of radiosity mechanism may cause significant slowdown of

rendering. Therefore, use low resolution when including radiosity in test renderings.

To turn on the radiosity mechanism, enter the following expression in the Include statements input

box of the Ray Tracing Options window:

global_settings {

radiosity { count 500 minimum_reuse 0.018 brightness 0.8}}

Refer to the POV-Ray application manual for the meaning of the quoted instructions, as well as for

additional information regarding the radiosity mechanism.

Image resolution. This parameter noticeably affects the time used for rendering. With the image

quality defined, the speed of rendering is directly proportional to the size of the resulting image. You

can restrict test renderings to small resolution, for example, 320*240.

Additional INI file: When the POV-Ray application is started, a file is created with the extension ini,

recording the exported settings. If necessary, different settings can be specified in this file, even

redefining those generated in T-FLEX CAD. Should this be the case, enter the desired filename in this

input box of the dialog.

Include statements: You can type expressions in this pane, in the POV format, that will be inserted in

the exported file.

Clarification: When launching the command, a file in the POV format is created that has the following

structure: 

· <generated variables>

· <included expressions>

· <exported 3D scene>. 

Generated variables.

The following variables are included in the exported file:

· fAspectRatio – Width / height screen ratio. When redefining the Width and Height settings in

the additional INI file, you need to also redefine this variable by using <included expressions>.
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· vSceneMin and vSceneMax – the corners of the box outlining the 3D scene in the 3D space.

· vSceneCenter – the center of the box.

· fSceneSize – the length of the box's diagonal.

· vCameraPos – the camera's position.

· vCamera2Scene – the vector from vCameraPos to the box center.

· fCamera2Scene – the vCamera2Scene vector length.

· cBackColor – the background color.

These variables can be redefined or used in <included statements>. 

Example:

#declare cBackColor <0.1, 0.1, 0.1>

fog {

fog_type 2

distance fCamera2Scene / 2

rgb <0, 0, 1>

fog_offset vSceneMin . z

fog_alt (vSceneMax . z -  vSceneMin . z) / 4

up <0, 0, 1>

      }

redefines the background color and sets blue fog that depends on the orientation and size of the 3D

scene.

Upon defining all necessary parameters for creating a ray tracing, press the button OK. Sometimes,

when running POV-Ray, the About POV-Ray(tm) for Windows dialog box may pop up. In such a case,

to run the application, simply press the button OK.

When creating an animation with photo rendering turned on by using the command Animate

Model, you are advised to wait until the first frame visualization starts in POV-Ray, to make sure

that the About POV-Ray(tm) for Windows window does not pop up and does not interfere with

the animation creation.

Once POV-Ray is launched, control returns to T-FLEX CAD so that you can continue working with it.

Upon completing the image generation or in the case of its termination, a message is displayed on

the screen:

To view the resulting image, press the button Yes. As a result, the view window opens allowing to save

the image in a file. If viewing and saving the resulting image is not necessary, press the button No. In

this case, the resulting ray tracing will remain in the system folder TEMP (until the creation of another

ray tracing).

POV-Ray can be started again before completing an image generation (the number of starts is

not limited). In such a case, T-FLEX CAD exports data in POV, and then, once the process of the

previous image generation finishes, will launch another POV-Ray application. This creates a

queue of image generation tasks, with a new task launched upon completing the previous one. 
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Examples of ray-traced images of T-FLEX CAD models

\

Photorendering Prototypes

The standard distribution includes the prototypes designed specifically for quick creation of ray

tracings. To create documents based on such prototypes, call the  Create New Document Based on

Prototype command, and on the Ray Tracing tab select one of the two prototypes: Room or Flying

around object.

Each of these prototypes has several predefined light sources, a camera and a coordinate system for

fixing a 3D fragment. The placement of these elements can be modified as desired by moving the

respective elements in the drawing window. Additionally, the 2D window provides a brief instruction

on using the prototype.

Normally, you work with these prototypes as follows. Create a new document based on one of the

prototypes. Insert a 3D fragment in this document as the 3D fragment or 3D picture (using the

appropriate scale), whose ray tracing needs to be generated. Next, do several test renderings to

determine the appropriate placement of the light sources and the camera. After that, run the final

rendering.
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The settings required for test and final renderings will be described below. Before that, let us mention

distinct features of each of the prototypes.

The Room prototype is intended for creating a static image. The scene in this prototype appears as a

“room”, with two light sources and a camera. Additionally, a coordinate system is created in advance

for convenience of fixing the 3D fragment. By default, the two walls and the ceiling of the “room” are

not visible; however, those can be made visible by clearing the “Hide ceiling” flag in the 2D window.

The Fly around object prototype is intended for creating either a static image or a photorealistic

animation in which the camera moves around the object. The scene appears as a large round

platform, with three light sources and a camera. A coordinate system is provided in advance with the

scene for fixing a 3D fragment. Additionally, the camera position is driven by an expression and

depends on the particular frame of showing the scene. The animation duration needs to be defined in

the 2D window (this is the time, in which the camera completes the flight around the object and

returns to the original position). The scene in animation needs to be related to the variable “frame”,

considering the number of frames per second equal to 25.

You may find the example on using Flying Around Object template in the library Examples,

folder “Additional resources\Ray Tracing\Flying around object. After opening Flying around

object.grb file activate camera Camera in 3D scene using Select Camera…. Then use Animate

Model command and apply animation by variable “frame” from 0 to 250 with step 1.

Light Sources

Calling the command:

Icon Ribbon

View > 3D Model > Light Source

Keyboard Textual Menu

<3L> Construct > Light Source

A light source is an element serving for rendering three-dimensional objects and helping controlling

the lighting of the three-dimensional scene. Light sources are snapped to 3D nodes. Their directions

are also defined by 3D nodes. There are three types of light sources - point, directional and projector.

· Spot light source emits the light from one point in all directions over the whole 3D scene.

· Direction light source emits the light in a certain direction over the whole 3D scene.

· Projector light source emits a light cone from a given point in a certain direction with the

specified drop-off rate.

A light source is displayed as a small "radiant" sphere. 

Spot light Directional light Projector light

3D window rendering uses simplified lighting calculations: the lightness (and, respectively, the color)

of the surface depends only on the angle of the incident light to the surface. The effects of shadowing,

reflecting, refracting and scattering of light are not present. To create more realistic scene rendering,

use the Photorealistic View command.
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A light source can be hidden from display while maintaining the lighting effect. By default, lighting of

the 3D scene also involves a light source (one or multiple) on the camera, oriented along the viewing

direction. The parameters of those light sources are set by the Set 3D View Parameters command.

One scene allows creation of an arbitrary number of light sources. However, the number of light

sources affecting the resulting rendering of the 3D window depends on the type of a video card

installed on the computer.

Creating light source

After calling the command, the following options will appear in the automenu, along with the general

system options:

<1> Select position of Light Source

<2> Select direction of Light Source

<L> Point Light Source

<D> Directional Light Source

<S> Projector

To define a light source, you need to use a special manipulator. 

User may also select a 3D node or point of an object in the scene to define position for the light

source. For this purpose activate the option .

Use the option  to define the direction of light propagation for the directional light source  or

projector  . You should select a 3D node or point of an object in the scene to define the direction.

The initial color of the light source is white.

Point light source

Point light source has no direction of light propagation. You should specify only position of the light

source for its creation.

You should call the following option for the point light source creation:

<L> Point Light Source

Diagram of light propagation from a spot source

Directional light source

To create a directional light source call the option:
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<D> Directional Light Source

You should specify a position of the light source and direction of the light propagation for a

directional light source creation. Then press OK.

Diagram of light propagation from directional source

Projector

Select the following option for the projector creation:

<S> Projector

You should specify a position of the light source and direction of the light propagation for a projector

creation. Then press OK.

Diagram of propagation of light from projector

The drawings with sample constructions of all types of light sources can be found in the

Examples library located in the folder: Additional resources/Light Sources.

Light source parameters

To define parameters of a light source, bring up the parameters window.
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Type. This parameter indicates the type of the light source (spot, directional, projector). It is defined

automatically during the construction. 

Intensity. Defines the intensity of the light source. The higher the light intensity, the more it affects the

image in the 3D window, and the higher is lightness of the resulting image. 

Drop off rate. Defines the projector's drop-off angle. 

Cut off rate. This rate defines the smoothness of transition from light to dark across the boundary of

the projector's light spot. The diagram on the right clearly shows the effect of this parameter with the

values 0 and 1 respectively.
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Light source parameters

Common tab

The Name parameter allows to specify a unique name.

The Level, Color and Layer parameters are system-wide and set the display mode of the light source

on the screen.

The Suppress parameter is responsible for excluding the Light Source operation from the calculation

of the 3D model.

Show Image in 3D View. Checking this parameter makes visible the image of a light source existing in

the 3D scene. If the parameter is cleared, the light source will be hidden, but the lighting effect

remain. To select, or modify properties of, a light source made invisible in the 3D window, use the

model tree.

Show on Fragment. If a model is used as a 3D fragment, then the light source with this parameter set

will be exported into an assembly model.

POV Instructions. You can enter instructions in this parameter's field, that will be appended to the end

of the description of the light source upon exporting the given file into POV for creating a

photorealistic image.

Light Source tab

This tab duplicates tool windows parameters.

Transformations Tab

This tab allows you to perform the necessary transformations for the light sources (see Assigning

Transformations to 3D Entities).

Mate Transformations Tab

On this tab, you can delete mate transformations created after creating a light source.

Common properties

Set as Default. When this option is activated, the selected set of parameters will be set for subsequent

Light Source operations to be created.

Topics in this section:

· Edit Light Source
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Edit Light Source

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3EL> Edit > Construction > Light Source

This command is used for editing Light Sources.

Available options:

<Esc> Cancel selection

<A> Select All Elements

<R> Select element by name

<I> Select Other Element

<P> Set entity Parameters.

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change Definition

<Del> Delete entity

<Esc> Exit command

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). 

If you select multiple items, you can delete them. Note that the <Shift>+  combination can be

used for multiple selection (the <Ctrl>+  combination cancels the selection).

Animation and Exploded View

T-FLEX CAD provides wide variety of tools for animating models and drawings:

·  Animate command allows to create simple animations by a step-by-step modification

to some parameter defined by a variable. 

·  Animation Editor allows to create more complex animations with multiple parameters

changing simultaneously, where dependencies of parameter on time are described by

diagrams.
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·   Exploded View Scenario command allows to animate disassembling of 3D assemblies

by sequentially applying transformations to fragments. 

·  Exploded View command allows viewing animations, that were created using the 

 Exploded View Scenario command. 

 

Animate

The command can be called by one of the following means:

Icon Ribbon

Tools > Animation > Animate

Keyboard Textual Menu

<AN> Parameters > Animate 

Drawing animation is implemented by a step-by-step modification to some parameter defined by a

variable. The drawing is simultaneously redrawn at each step. Suppose, we have created a drawing of

a kinematic mechanism. 

The drawing is assembled from fragments, each of which is a link in the mechanism. Now, we would

like to view the behavior of the mechanism as the position of the driving link is varied. The driving link

position is defined by the parameter of a construction line defined as a line passing through a node at

an angle to the horizontal. This parameter is the angle of rotation. One can assign a variable to drive

this parameter. Let's call it "alpha".
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To animate the mechanism, use the Animate command of the Tools ribbon tab.

When entering the command from the 2D window, a dialog box with the command parameters is

displayed on the screen.

Let's define the first four parameters. 

The specified values realize the variation of the "alpha" variable from the value "0" to "360" with the

step equal to "10". The drawing will be displayed at each step.

Press OK, and the result shown on the right hand side diagram will soon be displayed on the screen.

By performing these steps on your computer, you will see the drawing "animate".  Consider a few

more examples. In those, several variables are made dependent on the driving variable, which results

in an interesting behavior. 

An animation of the drawing of a cutting tool appears as if "machining" of a cog wheel:
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Next is the example of a drawing that creates a function diagram by using animation.

 

What was entered in the variable editor is as follows: the variable "h" is equal to "10", and the variable

"l" is defined by the expression "^1.2/Cos(h)".

Note, that when calling the Animate command while in the 3D window, the animation parameters

dialog box has a slightly different appearance. In this case, to create a multimedia file, one needs to

define the following groups of parameters: 

You can select one of three variants in the Photorealistic View Generation section.

· Non-photorealistic rendering – the exploded view scenario is recorded according to the

current view in 3D scene.

The following variants are used for photorealistic view creation. Each frame of the video is processed

using selected photorealistic view mechanism.

· Photorealistic rendering using OptiX – the video is created using NVIDIA OptiX mechanism.

· Photorealistic rendering using Embree – the video is created using Embree mechanism.

You can set Image Quality and Number of Ray Tracing iterations for the previous two variants.

· Photorealistic rendering using POV-Ray – the video is created using the POV-Ray mechanism.

You can find more information about photorealism in Photorealistic View section.

View Point. Defines the position and direction of the animation recording camera. 

· Use Current View Point. The view point is defined by the system camera present in any 3D

window by default.  

· Use Camera. The other possibility is specifying a user-defined camera.

A more advanced tool for creating animations is the Animation Screenplay Application.

Topics in this section:

· Animation Parameters
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Animation Parameters

Variable name. You can specify the name of the variable whose value will change. The variable name

can be set manually or selected from the attached list (this list includes all real drawing variables). The

variable cannot be text-based.

Starting value. The value of the variable to start changing it from.

Ending value. The value of the variable at which the command will end.

Step. The number that will be added to the value of the variable at each step of the animation.

Clear screen. When this option is set, the screen will clear at each step. Otherwise, the image will be

overlaid and you will be able to see the dynamics of movement and changes in the drawing at each

step.

Change color. When this option is set, the image will be displayed in a different color at each step.

This option is useful if you want to compare different results when changing drawing parameter

values.

Pause. If you set this option after redrawing the drawing at each step, the system will require you to

confirm the next drawing.

Show control panel. When this option is set, a window will appear on the screen during the command

processing process, in which the variable values corresponding to it at each time will be displayed.

This window also contains buttons that allow you to stop the animation process or slow it down (then

the process can be continued).
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Output File. When this option is set, the image resulting from the animation will be saved in a

metafile drawing. Then you can print the metafile to a printer or plotter, include it in your T-FLEX

drawing, or export it to a different format. Note that when the "Clear screen" mode is enabled, output

to the metafile is not performed.

Save Report. When this option is set, the animation will be written to the specified report file at each

step (you must specify its name in the operation parameters).

To stop animation while running, press <Esc>.

Create Multimedia File. Setting this flag allows you to set parameters for a multimedia file in the *.AVI

format.

File Name. Allows you to select a location to save the file and give it a name.

Number of frames per second. The recommended frequency is 24 frames per second.

The graphic button Compression for the *.avi format invokes the dialog box for customizing

multimedia file compression parameters:

Compressor. Selects a compressing application.

Compression Quality. Defines the quality grade for multimedia file compression. 

Key Frame. Defines the number of frames between the key frames. 

Data Rate. Defines the data transfer rate (kilobytes per second).

The graphic button Configure brings up the dialog box for entering the required settings of the

selected compressing application.

Video quality parameter is available for the *.wmv format.

You can specify sizes for the video in the Size group.

Use Current View Size. With the flag turned on, the whole contents of the current 3D view window is

recorded. With the flag off, the user can define one's own width and height parameters of the image

being saved.

In the Logotype group, you can use your own logo to place it in the selected location in the media

file.
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Animation Editor

This command is intended for creating animation of 2D drawings and 3D models. Animation allows

you to manipulate parameter values and view or write to a file the dynamically changing state of the

model. Animation helps visually illustrate the influence of parameter modifications on the shape

and/or spatial situation of the objects, model the function of kinematic mechanisms and check

permissible ranges of the variable values. 

The application is activated using the Customize > Application command.

If the application is running, then its application is called in the same way as any system command is

called:

Icon Ribbon

Tools > Animation > Animation Editor

Keyboard Textual Menu

Parameters > Animation Editor 

Animation creation is intended for displaying the model when changing the values of its variables.

Therefore, the creation of a parametric model is a necessary, but not sufficient condition for creating

animation. When designing a drawing or model, the user must assign variables that are responsible

for the variable parameters - the geometric shape or position of the elements. Note that the

animation screenplay functionality is accessible only when the document has at least one variable that

is not a textual (string) variable. A T-FLEX CAD document may contain several animation screenplays,

defining the different ways of modifying variables. Upon calling the application, the dialog box is

displayed on the screen for entering the name for a new screenplay (New) or selecting an existing

one. If an existing screenplay is selected then the provided graphic buttons allow running, recording or

reviewing the animation defined by this screenplay, or proceed with editing (Open) or deleting

(Delete) the data. 

In order to open the Editor of Animation Frames, you need to create a New screenplay or Open one

of the Existing screenplays.

Creation of an animation script provides for the formation of a time dependence of the values ??of a

variable. This dependence is presented in the form of a graph, the coordinate axes of which are the

time and the value of the variable. The specified changes in the value of each variable are drawn in

the form of a separate graph. In the left part of the window there is a list of model variables, their
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values ??and comments. Dependent variables (defined by a function or expression) are marked with a

different background (the specifics of working with them will be described below).

What happens when the animation is generated? The system determines the number of animation

steps based on the specified range and the value of the animation time increment. Then, sequentially,

for each step, the values of the variables are read from the plotted graphs and the model is

recalculated with the current set of parameters.

Creating new diagram

Click  the desired line in the variable list, and then select the following option in the Diagram

section of main menu or in the bottom toolbar:

<Ins> Add...

This option, as well as some other options described below, is also available in the contextual menu of

selected element.

The Diagram parameters dialog box will appear next. 
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In future, you can call this dialog again for modifying the specified values, using the Properties...

option in the Diagram section of the main menu or following option in the top toolbar:

<C> Diagram Properties

The Diagram parameters dialog contains following parameters:

· Variable value range (Min value, Max value)

Defines limits of the displayed variable value range. By default range is set from 0,5 to 1,5 of

the current value.

· Load from file

Upon enabling the checkbox you can click the [...] button and select a *.tfg file. A Diagram will

be loaded from the selected file. If there's a diagram already created in the current document,

it will be replaced by a diagram from the selected file

· Color 

Color of the diagram line.

· Background 

Color of the diagram background.

Upon confirming the diagram parameters, it's pane opens. The ruler on the left side of the diagram

pane represents the scale for the variable values, while the one on the top side of the diagram pane

reflects the time scale. Both scales reflect the defined range is of the values (the default time interval

is from 0 to 60 seconds). At the beginning, the variable diagram is a constant equal to the current

variable value. The user can now add an arbitrary number of points, defining the variation of the

variable values along the specified time interval. If the screenplay already has another variable

diagram in the window, then upon selecting a variable, the following option becomes available in the

Diagram section of the main menu and in the top toolbar:

<G> Add Diagram To Active Window...

The current window is outlined by a frame, whose color is defined by the parameter Active window

color in the Screenplay Properties dialog. This dialog can be invoked using the Screenplay... option

in the  File section of the main menu or following option in the top toolbar:



T-FLEX CAD 17 Help

2922

Screenplay Name...

This option invokes dialog, where you can change Active window color and Current screenplay

name. Clicking OK after changing the name renames the current scenario. Clicking Save as after

changing the name saves a copy of the current scenario under the new name.

To select the current window, point the mouse to the desired diagram and click . The option of

adding a variable to the current window allows overlapping several diagrams in one coordinate

space. If several diagrams are present in one window, the last modified diagram is considered

selected. Its line is thicker, and the respective entry is highlighted in the list of a variables. A diagram

sharing the window with other diagrams can be moved to a separate window using the following

option in the Diagram section of the main menu and in the top toolbar:

New Window

Adding/modifying diagram points

As the pointer moves inside the diagram window, its current coordinates are displayed in the lower

right corner. Upon clicking , a new node is created under the pointer position, and is connected by

straight segments with the neighboring points in the diagram. To create a new node dividing an

existing segment of the diagram in the two, point the mouse to the diagram line and select the item

Add Node from the context menu.

To modify the node position, point the mouse to it (the mouse pointer will change its appearance).

Then, dragging the mouse with the  depressed, place this node of the diagram in a different
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position. To specify the exact node coordinates, right click , select in the coming up automenu the

item Properties and enter the values for the Т- and Y-coordinate. In the case of multiple selection of

the nodes in the diagram, the selected group of points can be translated using the  Move... option in

the Edit > Diagram section of the main menu or the following option in the top toolbar:

<М> Transfer

Upon selecting this option, a dialog box appears for inputting the shift values along the Т and Y axes.

As a result, the selected group of points will change its position per the specified values.

Using the clipboard

Adding points to a diagram can also be done using the following options in the Edit section of the

main menu or in the top toolbar:

<Ctrl>+<X> Cut

<Ctrl>+<C> Copy

<Ctrl>+<V> Paste

Use of these options implies existence of least one diagram with two nodes. Select several nodes

(those will be highlighted) and pick one of the options, Cut or Copy, in the control toolbar. Then select

the fixing node for inserting the selected fragment of the diagram and pick the option Paste.

Thereafter, the Insertion dialog box appears. 

Besides the Clipboard, a source for insertion can be a diagram saved in a file (*.tfg). The insertion

particulars are defined by the fixing node of the diagram fragment being inserted (Left Node, Right

Node) and by the number of insertions. If the flag Symmetrical, horizontal is set, then the insertion
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fragment will be a copy of the original mirrored about the vertical line passing through the fixing

node.

    

The leftmost picture shows the highlighted points of the diagram fragment being copied to the

Clipboard. The second picture shows the insertion with the option Left Node, the third one - that with

additional use of the flag Symmetrical, horizontal.

In the case when the time span of the diagram fragment being inserted is greater than the time

interval of the remaining portion of the diagram to the right of the fixing node (when using left node

fixing), or to the left of the fixing node (for right node fixing), the system aborts the insertion

operation. This is done to prevent violation of the time segments order.

To add nodes to the selected diagrams at the point of the intersection with the main ruler, that

defines the current time instant (highlighted in blue), use the following option in the Edit > Diagram

section of the main menu or in the top toolbar:

Add Nodes...

Upon calling the option, a window appears containing the list of variables for each of the existing

diagrams:

The column Value contains the variable values at the current time instant. Check the variables in the

list, whose diagrams are to be added nodes. Upon pressing the OK button, new points will be created

in the respective diagrams at the point of the intersection with the time main ruler marker. Setting the

flag Use values of variables from model positions the new nodes along the time main ruler, using the

variable values defined for the model. In this case, the new node is connected by straight segments to

the neighboring points in the diagram.

This capability allows defining diagrams by modifying variables in the model and then adding nodes

with their values at the certain time instant.
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Selecting diagram nodes

Point the mouse at the desired node and click  - the point on the diagram will be outlined by a

box. Multiple selection is done by one of the following means:

· With the <Shift> key held down, a sequence of nodes is selected between the two specified

ones;

· With the <Ctrl> key held down, the directly picked nodes are selected.

Selection of all nodes in the diagram is done using the following option in the Edit section of the

main menu:

<Ctrl>+<A> Select All

Box selection of a group of nodes is done using the Selector option in the contextual menu of

diagram window or the following option in the top toolbar:

<S> Select Nodes

Deleting diagram nodes

The Delete option in the Edit section of the main menu and the following option in the top toolbar

can be used for deleting selected nodes:

<D> Delete Node(s)

Once a node(s) is deleted, the neighboring points in the diagram are connected by straight segment.

Smoothing diagram

Upon adding new nodes, the diagram is formed as a polyline. If necessary, you can obtain a smooth

curve by replacing the polyline segments by curved segments. To do this, point the mouse to the

desired segment in the diagram and right click , and then select the item Bezier Curve. Two nodes

will appear on the selected segments dividing it in equal parts.

 

The segment can be transformed into a curve by modifying the position of each node. 

 

The reversed transformation of a curve segment into a straight segment is done by the command

Straighten, available in the context menu upon its selection.
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Grid

To apply vertical and/or horizontal ruler lines in the diagram pane for easy orientation in the

coordinate space when constructing diagram points, use the Rulers grid... option in the View section

of the main menu or the following option in the top toolbar:

<Ctrl>+<R> Grid

The respective flags in the Grid dialog box control the presence of vertical and horizontal rulers. For

each type of ruler, the following parameters are defined: 

· Start Time or Start Value

Defines the position of the first ruler; 

· Number of rulers 

Defines the number of rulers; 

· Step by time or Step by value

Defines the distance between rulers. 

To define a ruler crossing at a point with specific coordinates, use the following option in the Edit

section of the main menu:  
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<R> Rulers crossing...

To add an individual vertical of horizontal ruler, set the mouse pointer at the image of the scale (time

or variable), and click . In the coming up menu select the item Ruler and specify the point on the

scale, for the ruler being created to pass through.

  

Driven diagrams

If the model has variables defined by functions or actions, then it is possible to obtain a special type

of a diagram – driven. Since the values of such variables are dependent values, the system creates

their diagrams automatically. The lines corresponding to the dependent variables in the list of the

animation screenplay dialog box are grayed out. A "driven" diagram cannot be edited; it merely

illustrates the variation of the variable during an animation. Note that a driven diagram is regenerated

upon starting an animation. This type of a diagram can be used for analyzing mutual positions of

various model elements. A variable can be created for this purpose, whose value would be the

function of the distance measured between two bodies, vertices, etc (see the Measure command).

When modifying the model parameters, the diagram of such a variable will reflect changes in the

distance concerned.

General animation parameters

Besides the described above, a number of options are available in the top toolbar and in the Edit

section of the main menu:

<T> Time Scale

This option sets the limits of the Time axis portion visible in the diagram pane.
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<Ctrl>+<S> Save Diagram

This option allows saving the current diagram or the selected nodes in a *.tfg file. In future, the

file contents can be inserted into another diagram or another screenplay. 

<F7> Update List

Reloads the changes in the model variable list. 

<Alt>+<A> Animation Parameters

Invokes the dialog box, where you can defines the values of the following parameters:

· Start time

The time instant from which the animation should begin.

· End time

The time instant at which animation ends.

· In real time 

With this flag set, the animation is performed in real time.  The latter option means the

following. At the beginning, the model is regenerated with the variable values defined for

the starting instant of the animation. The next set of values corresponds to the instant

when the first model regeneration completes. Therefore, in this case, the animation step is

actually the duration required for the model regeneration.

· Animation step 

The time step for sampling the variable values.

· Delay

Delay after each step of the animation.
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Block Diagram

This option allows excluding a variable variation diagram when forming an animation (in this

case, the above icon appears before the variable name in the variable list). A repeated call to

the option removes the variable diagram block.

Zooming diagram window

When working with the diagram, it is often necessary to change the scale of the diagram image. The

listed below options allow manipulating the drawing image in various ways.

<Ctrl>+<T> Zoom In By T

Two points specified by clicking , define the boundaries of the new interval on the Time

scale.

<Alt>+<T> Zoom Out By T

This option results in doubling the current interval on the Time scale.

<Ctrl>+<Y> Zoom In By Y

Two points specified by clicking , define the boundaries of the new interval on the Value

scale.

<Alt>+<Y> Zoom Out By Y

This option results in doubling the current interval on the Value scale.

<Z> Zoom Window

Two points specified by clicking , define the box diagonal. The vertical and horizontal size

of the box area in the window defines the displayed intervals on the Time and Value scales.

<Ctrl>+<PgUp> Zoom In 

Doubles the current intervals along the Т and Y-axes. 

<Ctrl>+<PgDn> Zoom Out 

Halves the current intervals along the Т and Y-axes. 

<Ctrl>+<G> Zoom All Diagrams

This option pans/zooms the current window in such a way to fit all the existing diagrams in this

window. 

Manipulating animation

The following graphical buttons are located in the bottom toolbar as well as in the Diagram section

of the main menu and in the contextual menu of the list of variables:
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<Del> Delete

This option is available for variables with existing diagrams. It deletes the diagram of the

current variable.

<Ins> Add

This option is available for variables without diagrams. It creates the variable diagram in a new

window.

<P> Apply

This option regenerates the T-FLEX CAD model with the variable values per the diagram

readings at the current time instant. The current time instant is set using the time ruler

(highlighted in blue on the Time scale). As the Time ruler is moved, the variable values are

automatically updated in the list.

<A> Animation

This option starts executing the animation. A sequence of the 3D model (drawing)

modifications is displayed, reflecting the model regeneration per the variable values defined in

the screenplay. The animation execution is controlled by the buttons Pause/Continue and Stop

in the Animation window.

<F> Save To *.avi

This option is for recording an  *.avi or *.wmv file. Upon starting the recording, the system

offers to select a compressing application of the video image. The "Video compression" dialog

box allows selecting one of the installed applications on your computer and setting its

parameters. 

Exploded View Scenario

Calling the command:

Icon Ribbon

Tools > Animation > Exploded View Scenario

Keyboard Textual Menu

<3TE> Tools > Exploded View Scenario

The command is used for setting or editing exploded view parameters. You can perform the following

steps in Exploded View Scenario command:
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· Create and edit exploded view scenarios. It is possible to create several exploded view

scenarios.

· Create your own scenario of fragment exploded view as part of the general scenario.

· Define animation parameters.

· Control bodies visibility on each stage of exploded view scenario.

Several exploded view scenarios can be created for an assembly. For example, assembly parts

exploded view, assembly sequence, etc. Each scenario may consist of several stages. Stage includes

sequence of actions. Action is an execution of individual transformation – translation or rotation of

selected elements group. Group composition for various actions can be different.

Creation of Exploded View Scenario

After activation you need to select objects which will be used for explosion view. For this purpose use

options:

<O> Select object for individual transformation

<M> Select objects for transformation

When  is selected it is possible to select only one object for transformation. You can select several

elements using <Shift>. 

Upon selection of  it is possible to simultaneously select several objects for transformation.

There is the possibility to choose dependent objects. For this purpose use special option in automenu:

Levels of dependence mean hierarchical dependence of assembly elements. The zero level

corresponds to the fragment that is selected in the assembly. The first level corresponds to all the

fragments in the assembly that depends on the first one.
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The option Don’t select dependent objects  is active by default, that’s why only one fragment is

selected in the scene.

If you activate option Select dependent objects of the first level  and select the same fragment,

all the fragments that are directly dependent on the fragment will be selected.
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If you activate option Select dependent objects of the second level , the fragments dependent

on the first level fragment will be also selected.

If you activate option Select dependent objects of all levels , all elements that directly or

indirectly depends on the first selected fragment will be selected.

Using of the option is convenient in case of working with complex assemblies, for example, when you

need to translate object together with its dependent objects.



T-FLEX CAD 17 Help

2934

Creation of new or edition of existing explosion view scenario is made in the section Scenario

Selection.

You can create a copy of an already existing script.

You cannot create a new script, if work with the current one is not finished.

The following objects can be selected as objects of the scenario: bodies, fragments, cameras, light

sources. 

To edit scenario properties use section Properties.

Using this section, you can edit name of scenario, set duration, type and speed of the exploded view

animation. 

Each scenario contains stages, divided into actions. 

Full sequence of creating assembly from parts and subassemblies can be traced with the help of

several stages.

For creating and editing stages of exploded view  use [Contents] section.
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This dialog box contains information about created stages, actions, and objects, used in stages.

The stages can be grouped using a special column:

Several graphical buttons are located to the right of the transformations list. 

Button  is used for creation of a new exploded view stage. When you press  button, a new

action for selected stage is created. Button  is used to delete all transformations of a stage. Button

 deletes last exploded view stage in the list. To delete an action use button , located near

actions name.

When you press   buttons, the sequence of exploded view stages is changing. With the help of

 button, you can control stages visibility. Using the button , you can control the visibility of

trajectories in stages. The Hide option affects not only the current stage, but also all following stages,

until the activation of Show option. All bodies are visible by default.

There is a possibility to manage visibility and delete individual objects with the help of buttons.

Hidden objects are shown in gray in the list.



T-FLEX CAD 17 Help

2936

You can manage objects visibility only in current document.

Button  allows to copy selected stage. The copied stage is added to the end of the list.

Each action has one object or a group of objects and the chain of transformations for them. As a

coordinate system for the chain of transformations you can use local coordinate system or coordinate

system of the first group object (in a case of group transformations). A special option from automenu

is used for the coordinate system selection:

<L> Select LCS for current transformation

In case, when it is not possible right away to orient LCS in a desired way, the functions of additional

coordinate system specification can be employed. These functions allow you to quickly rotate the

constructed LCS around its axes by 90° ( , , ), perform cyclic turning of the axes of the

coordinate system around the origin (when pressing  the axes change their places).

All transformations are shown in the Transformations section of the properties window.

Several graphical buttons are located to the right of the transformations list. Button  is used to

add a new transformation. You can select required transformation from the transformations list that

appears after pressing the button. This this list can be also called from the context menu, after

pressing  in the “Transformations” window.

After type selection a new string appears in the transformations list. You can specify transformation

value in the value input field.



Service Commands and Tools

2937

Transformation values can be assigned numerically or using variables and expressions.

  

When pressing button  the last transformation in the list is deleted. Pressing   buttons changes

sequence of transformations.

To save the transformations you need to press Enter. Also, a special manipulator in 3D window can be

used to define transformations. This manipulator is moving according to the selected type of

transformation.

Group transformation can be performed either in the “common” coordinate system, or in own

coordinate system of each group member.

Mode of setting transformations in the common coordinate system is activated by default after

selection of several objects for transformation:

<G> Set transformations of selected objects in common CS

If this option is switched off, the group transformation is transferred into own coordinate system of

each group member. I.e. when you move several fragments, each of them is moving along its own X

axis.
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Each bolt is translated in its own coordinate system    Bolts are moved in the common coordinate system

Thus, usage of the group transformations can significantly reduce time spent on specifying elements

transformations.

You can enable display of one of three positions: start, end and current, using options:

                  Start position             Current position                  End position

To improve convenience of objects selection use option:

<N> Group selection of objects by rectangle

You can select rectangular area, holding . There are two selection conditions:

1. All objects, which are completely covered by rectangular area, will be selected for the

transformation. Common manipulator for these elements will appear. The cursor is moving from

left to right.
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2. All objects that intersect the rectangle will be selected. Common manipulator for these elements

will appear. The cursor is moving from right to left.

The area color differs for each condition.

Exploded View of Subassembly Elements

If there are subassemblies in the assembly you can move elements of the subassemblies separately.

Use one of the following ways for this purpose:

If there is an exploded view scenario in the subassembly document, you can use it in the assembly. You

need to select the subassembly fragment in the scene and choose one of its scenarios. 

The second way to move subassembly elements separately is to divide subassembly using Divide

command. The way is not preferable, because the link between the product structure and subassembly

is lost after division. This method can be used if the assembly document is used only for visualization.
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Exploded View Animation

In Exploded View Scenario command, you can create animation of assembly/exploded view. While

defining animation you specify position of assembly elements in each period. 

The Player section in properties window is used to manage animation.

All elements movements are displayed on the time scale. Time scale represents horizontal line with

slider. Slider indicates the playback time of current stage and total duration of animation. When you

move the slider, current animation position changes and model is accordingly updated. 

In the lower part of the section there are graphical buttons, which manage animation parameters.

·  - Play. Starts animation.

·  - Pause. Temporary stops the animation at the current stage.

·  - Stop. Stops animation.

·  - To Start. Scrolls animation to the beginning.

·  - To End. Scrolls animation to the end.

· Animation starts in one of the following modes:

·  - Forward Back. Plays the animation once from the beginning to the end.

·  - Forward Reiterated Playback. Plays the animation in a circle (from the beginning to the

end, from the beginning to the end, and so on) until the button  is pressed.

·  - Loop Playback. Plays the animation in a continuous cycle (from the beginning to the end,

from the end to the beginning, and so on) until the button  is pressed.

·  - Reverse Playback. Plays the animation once from the end to the beginning.

·  - Reverse Reiterated Playback. Plays the animation in a circle (from the end to the

beginning, from the end to the beginning and so on), until the button  is pressed.

·  - Normal playback speed. Playback speed set by default.

·  - Slow down playback. Playback with half speed.

·  - Speed up playback. Playback with double speed.

The animation mode can be selected either before pressing Play button  or while animation

playback.

You can manage animation without activation of Exploded View Scenario command. For this

purpose, the special tab on the Ribbon is used. It is called using the Exploded View command.
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You can activate the command for scenario editing on the tab.

Main options for the exploded view playback are in the Control group. You can also select the

scenario in the group.

You can stop animation by pressing<ESC>, model recalculation or reactivation of the Exploded

View command.

In the Output group there are commands for record and export of the scenario.

Animation Record 

The Record Scenario option allows animation recording in *.avi and *.wmv formats. General scenarios

and scenarios by default are supported.

Record Scenario window appears when you select the option. Here you can set the following

parameters:

You can select one of three variants in the Photorealistic view generation section.

Non-photorealistic rendering – the exploded view scenario is recorded according to the current view

in 3D scene.

The following variants are used for photorealistic view creation. Each frame of the video is processed

using selected photorealistic view mechanism.

Photorealistic rendering using OptiX – the video is created using NVIDIA OptiX mechanism.

Photorealistic rendering using Embree – the video is created using Embree mechanism.

You can set Image quality and Number of Ray Tracing iterations for the previous two variants.

Photorealistic rendering using POV-Ray – the video is created u sing the POV-Ray mechanism.

You can find more information about photorealism in “Photorealistic view” chapter.
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You can set view point using View point section.

· Use current view point. The video is recorded according to the current view point in 3D scene.

· Use camera. Video is recorded according to the selected camera from the list. It is available

only if there are any cameras in the scene.

You can find more information about cameras in Cameras chapter.

You can set File name and Number of frames per second. The path to the created file is shown in the

File name field. You can specify name, file path and file format using  button.

Video quality setting is available for the *.wmv format. The video quality and file size are changed

according to its value.

If the flag Use current view size is active, the video is recorded according to the active view size.

Otherwise, you can set size manually.
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The Reverse flag allows to record exploded view video in the reverse direction to the given in

scenario.

When the flag Repeat scenario in cycle is active, you can set Number of cycles. It sets number of

exploded view scenario repeats.

In the Logotype section, you can add an image file and place it in any corner of the screen.

The Video recording window appears after the OK button pressing.

Number of processed frames and time until video creation are shown here.

Using buttons you can pause recording Pause, stop record on current frame Stop or cancel recording

Cancel. When you stop recording, already created part of the video is saved.

The preview window appears when you use photorealism. 

Export Scenario

Save scenario allows to export exploded view scenarios to *.wrl, *.x3d, *.pov, *.u3d, *.pdf formats.

The window Export Scenario appears after the command calling.

File path is displayed in the File Name field. You can select filename, its path and file format using

button .
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· Save used elements only. All elements that are not used in the scenario will be not included in

the file, when the flag is active.

· Export light sources. Light sources are included in the file.

· Save textures. The objects textures will be saved to the file. Otherwise they are not saved and

the material of the object will be displayed instead of them.

· Save model edges. Model edges are saved when the flag is set. The flag is enabled only for

*.wrl and *.x3d formats.

· Reverse. The scenario will be exported in the reversed direction.

Local Exploded View

It is possible to create a local exploded view of the fragment in the assembly. To do this, select the

Exploded View item in the context menu of the fragment.

If there are several exploded view scenarios for a fragment, then a list of them will be available from

which you can select the necessary one.

If the fragment is already locally exploded, the Assemble button appears.

If the model exploded view script is running, then you cannot run the local explosion of the fragment

in parallel. If a fragment is already being exploded locally, then this fragment will not participate in

the exploded view scenario of the model.

If, when running the Exploded View Scenario command, the model is assembled, but there are

exploded fragments, then their assembly will be performed.

Exploded View

Calling the command:

Icon Ribbon

Tools > Animation > Exploded View

Keyboard Textual Menu

<3VX> Tools > Exploded View

T-FLEX CAD provides a special command for exploding 3D models made of several operations

(normally, this is an assembly 3D model). The exploding transformations can be defined in the

parameters of any three-dimensional operation or in the Exploded View Scenario command. The

operations that require an LCS for creation, such as 3D fragments, 3D copies, etc., are positioned

according to the transformations defining translations (offsets) and rotations with respect to the

attachment LCS. Other operations can be transformed to world coordinates or the center of the

outline box. This is defined in the transformation settings. More details on transformations are

provided in the chapter Transformation.

Command execution

The exploding mode is off by default.

After activation, the Exploded View ribbon tab appears.
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More information about it can be found in section Exploded View Scenario.

Calling the command transforms the current parameters that define positions of the operations. The

parameters on the Transformation tab define the permanent transformations, as well as the

exploding mode transformations. When the exploding mode is turned on, the transformations are

applied that were defined for the exploding mode.

The exploding mode can be used when you need to create a 2D projection of the product assembly

taken apart. All necessary settings are collected in the 2D projection parameters. More information

can be found in the chapter 2D projections.

How to correctly set transformations for exploded view

It is most convenient to set new or edit the set exploded view parameters when Exploded View mode

is enabled. In this mode, any transformation specified for any operation in the Transformation

command will be applied only at the time of exploded view. If the Exploded View mode is disabled,

the transformations obtained as a result of applying the Transformation command do not affect the

exploded view parameters.

So, the actions that the user needs to perform in order to obtain the final result of exploding the

product are as follows:

1. Enable exploded view mode. Check the position of objects. If you need to enter new

transformations for exploded view, then go to step 2.

2. Call the command Transformation.

3. Move all the assembly parts sequentially to the desired position to obtain a exploded view of the

product.

4. Exit the Transformation command and turn off the exploded view mode. All bodies should take

their starting position. Exploded view transformations will be activated only when exploded view

mode is enabled.
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Cameras

A camera is necessary element for visualizing three-dimensional objects, that determines the point

and direction of viewing the 3D scene. Each 3D window provides a system camera installed "by

default". The user can additionally create one's own cameras and make one of them active. 

A camera has its own coordinate system and a set of manipulators.  The manipulators allows you to

translate the existing cameras around the 3D scene and change their viewing direction. This can be

used when examining inner elements of the scene and creating animation clips.

The system camera activates upon opening a new 3D window. Initially, it is located at the distance

that permits watching all elements in the 3D scene.

Topics in this section:

· Create Camera

· Select Camera

· Camera Parameters

· Edit Camera

Create Camera

Calling the command:

Icon Ribbon

View > 3D Model > Select Camera > New Camera

Keyboard Textual Menu

<3CA> Construct > Camera

Or you can create camera using View toolbar:

The camera is an element for visualizing three-dimensional objects that determines the point and

direction of looking at a 3D scene. Each window has a default system camera. The user can create his

own cameras and make one of them active.

The camera has its own coordinate system and a set of manipulators. Manipulators allow you to move

the created cameras around the 3D scene and change the direction of their gaze. This can be used

when inspecting the interior of a scene and creating animations.

When a new 3D window is opened, the system camera becomes active. At the initial moment, it is

located at a distance that provides an overview of all elements of the 3D scene.

When calling the command, the following options become available to you:

<Y> Finish input

<P> Set entity Parameters
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<I> Select Other Element

<Esc> Exit command

<F5> Preview Operation Result

<L> Select target LCS

The camera creation steps include:

· 1. Set location and direction of viewing of the camera (you can use manipulators or select one

of the existing local coordinate systems);

· 2. Setting parameters (optional);

· 3. Confirming camera creation.

Defining camera

Upon calling the command, the option automatically sets in the automenu:

<L> Select target LCS

Use this option to select a local coordinate system in the 3D view window.

Once a coordinate system is selected in the 3D view window, a schematic image of the camera will be

displayed. The initial camera direction is always along the X-axis, with the Y-axis always directed up,

and the Z-axis to the right. 

After that, you can set up parameters (if necessary), and then confirm the camera creation by pressing

.

If there is no LCS existing in the scene you can specify the camera position using manipulators.
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1. Manipulator for adjusting the perspective projection angle

2. Manipulator for adjusting the length of a perspective projection

3. Manipulator for map movement

4. Manipulator for rotation

Preview window is displayed in the upper right angle of working window in camera creation mode. It

shows the view from the camera in real time.

Moving camera

To watch the 3D scene via a moving camera, you need to make that camera active. 

Selected camera mode enables “walking” around the current 3D scene. It is especially convenient

when creating floor plans of buildings.

A separate mechanism for cameras movement is used. When camera is active you can move inside

designed areas, rotate camera and perform operations as usually in T-FLEX CAD. 
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If camera is moved inside the solid body in the scene, a wireframe mode is activated for the

body.

Controls in active camera mode:

Note! Controls for the perspective camera are described below. Result of the key combinations

usage may differ for the parallel camera, because of the parallel projection properties.

·  - camera rotation.

To eliminate rotation around view axis you need to activate Panorama  mode.

· Arrow keys allow to move camera forward/backward.

· Page up/Page down keys allow to move camera up/down.

It is recommended to disable object snap  on View toolbar upon movement in selected

camera mode.

·  + CTRL – movement in the screen plane.

·  + SHIFT – zoom.

·  + ALT – rotation around vertical axis.

· Pressed mouse wheel + CTRL – mode of smooth move forward/backward. Movement speed

changes according to the cursor position.

A cross will appear on the screen that will become the reference center for the direction vector (the

vectors are not displayed). The motion occurs in the following way: moving the pointer by the mouse

with the button depressed upward from the cross moves the camera forward. Moving the pointer

downward from the cross will move the camera backwards. Moving the pointer in the horizontal

direction right or left of the cross will make the camera rotate about its vertical axis right or left,

accordingly. Moving the pointer along a diagonal with horizontal and vertical components (see the

diagram) will make the camera both move in the respective direction and rotate. Note that,

depending on the pointer's bias to one or the other main vector, the translation or else the rotation

will dominate to some degree. The farther the pointer is moved away from the cross, the faster the

camera will move.
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1. Backward

2. Forward

3. Rotation around its vertical axis to the left

4. Rotation around its vertical axis to the right

5. Forward with a turn to the right side

· Mouse wheel rotation – zoom: move the camera forward/backward.

· Mouse wheel rotation + CTRL – zoom: perspective angle changed without camera movement.

Long press left mouse button (until the cross symbol appears) – orbital rotation around the selected

center. The center is selected using the existing in the scene geometry.

Special 3D - User camera tab in the Document Parameters dialog is used for camera management. 

Active Camera Options

Additional options for camera are available on the View toolbar after selecting camera as active.

Options available when camera is active:

Option  allows to restore original/last saved position of the camera.

Option  allows to reset vertical orientation of the camera. 

This option performs a one-time action. In this way, the values of the coordinates resulting from

spinning the camera and setting its vertical position reset to the original values, which are those

recorded as a result of the last call of the  command.
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1. Original camera position

2.Camera position after rotation

3. Camera restored to original vertical position

Option  allows to save current position and perspective of the camera. If you didn’t activate the

option after movement/rotation of the camera, the camera will return to the original position after

exiting selected camera mode

Select Camera

Calling the command:

Icon Ribbon

View > 3D Model > Select Camera

Keyboard Textual Menu

<3VC> View > Camera

After calling this command, a dialog window will appear containing a list of all cameras present in the

3D scene. It is necessary to select the camera from which the 3D scene will be reviewed.

The second way to select a camera as active is available when the system is in command standby

mode: you can move the cursor to the camera in the 3D window and press  and select Select from

the menu that appears.
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The camera can be selected from the context menu called by clicking , when pointing the cursor to

a free field of the 3D window.

Also, camera selection is available from the model tree.
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Sometimes, when choosing a camera as the active one, the view obscures the image of the LCS,

on which the camera was created. In this case, you can hide the LCS using the corresponding

icon from the model tree.

If you set the presence of two 3D windows on the screen (using the Split Vertically command), then in

the second 3D window you can observe the movement of the selected camera from the system

camera.

If the camera is used in any 3D view, it cannot be selected. You can create a camera and set its

parameters in the Create Camera command. You can change existing cameras and their parameters in

the Create Camera command or by selecting them in the 3D Model Tree window.

Camera Parameters

Common tab

The Name parameter allows to specify a unique name.

The Level, Color and Layer parameters are system-wide and set the display mode of the light source

on the screen.

Show Image in 3D View. Setting this parameter makes the image of an existing camera visible in the

3D scene. If the parameter is not set, the camera will be hidden, but the effect of its presence remain.

Parameters tab

The Type parameter defines the method of projecting the objects in the 3D scene when visualizing

with the help of the given camera. 

The projection can be Orthogonal – defining parallel mapping without respect to the distance from

the viewpoint, or Perspective – defining perspective mapping that accounts for the distortion as the

distance between the camera and the watched object grows.

Angle. Defines the watching angle of the perspective projection. The height of the rectangle adjusts

with changes in the view angle.

Height. Defines the watching height of the projection. The view angle adjusts with changes in the

height.
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Length. Defines distance to the projection.

Height-to-width ratio defines projection height to width ratio. You can select a value from the drop-

down list or manually.

Height-to-width ratio is applied when you record explode animation.

More information about exploded view can be found in Exploded View Scenario section.

External. If a model is used as a 3D fragment, then the model’s cameras with this parameter set will

be also available in an assembly. The position of such camera will be defined by the position of the

3D fragment. Parameters of such camera cannot be modified in an assembly. 

Transformations Tab

This tab allows you to perform the necessary transformations for the camera (see Assigning

Transformations to 3D Entities).

Mate Transformations Tab

On this tab, you can delete mate transformations created after creating a camera.

Common properties

Set as Default. When this option is activated, the selected set of parameters will be set for subsequent

Camera operations to be created.
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Edit Camera

Call the command:

Icon Ribbon

-

Keyboard Textual menu

<3CA> Edit > Construct > Camera

This command is used for editing Camera.

Available option:

<A> Select All Elements

<R> Select an item by name

<I> Select another nearest item

<P> Set Cameras parameters

<F4>
Edit the element (if you select this option, you can re-set the elements that

define the operation-the Camera" command)

<R> Change definition

<Del> Delete an element (a group of elements)

<Esc> Deselect

<M> Conversion (calling the Transformation elements command)

If you have selected one item to edit, you can delete it, edit its parameters (using either the dialog

window or the system toolbar), select the next closest item, or start editing (resetting). 

If you select multiple items, you can delete them. Note that the <Shift>  combination can be used

for multiple selection (the <Ctrl>  combination cancels the selection).

A call to this editing command is also possible in one of the following ways.

· When the system is in standby mode, you need to move the cursor to the 3D element in

the 3D window and press the right mouse button. Next, from the menu that appears,

select the Edit item, after which the command to edit the 3D element will be called up.

· When the system is in standby mode, it is possible to select an item in the tree of

operations in the Structure window of the 3D model and click the right mouse button.

Next, from the menu that appears, select the Edit item, after which the command to edit

the 3D element will be called up.
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Report

Calling the command:

Icon Ribbon

Tools > Special Data > Report

Keyboard Textual Menu

<REP> Tools > Special Data > Report

The command is intended to create text documents - reports.

A report is a text document that can be saved to disk, and in which the values of drawing variables can

be used. 

When you enter the command, a dialog box appears on the screen in which you can set the following

parameters:

Name. Displays the name of the current report. There can be multiple reports for one drawing. You

can select a report name from the list. If you have not created any reports, this item will be empty and

only the Create New Report button is available in the entire parameters window.

New. When you click the button, a window opens with specifying the name of the report.

Output Path. Specifies the name of the file in which the report will be saved and the full path to this

file.

Autosave. Determines how the report is saved when working with a drawing. With the specified

option, the report will be automatically saved every time the drawing is saved. Otherwise, in order to

save the report to disk, you must use the Save option.
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Substitute variables. Determines how variables are written in the document when the report is saved.

When the option is set, the values of the variables will be substituted instead of their textual

representation. If this option is disabled, the report template will be saved in the file.

Delete. When you click on this option, the current report is deleted with confirmation of the user's

actions. 

Rename. When you click on this option, you are prompted to rename the current report.

Edit. Allows you to create and edit the content of the report. When you click on this option, a text

editor is loaded to create and change the content of the report template.

Save When you click on this option, the current report is saved to disk.

Preview. When this option is selected, the report will be presented in the form in which it is stored in

the file (with or without substitution of variable values, depending on the specified options).

Example of displaying information about drawing values using the Report

You can usually display information about the values of drawing parameters using the parameter files

created with the Save Parameters command. But there is another mechanism for storing this

information - the use of reports.

For example, you have a drawing with a set of numeric and text variables created.
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In the Report command, you can create a text template with the following content:

Parameters of cylindrical gear with helical teeth

Module = {m}
Teeth number = {z}
Helix angle = {$b}
Tooth line direction = {$n}
Base diameter = {d0}

Variable names are written in curly braces. Now you can save the report to disk to a file containing the

following content:

Parameters of cylindrical gear with helical teeth

Module = 2.5
Teeth number = 30
Helix angle = 26°46'
Tooth line direction = Right
Base diameter = 78.931

As you can see, a text file is saved on the disk in the form in which it was created, but with substituted

variable values.

Thus, you can save in any form information about the parameters of your drawing. Then you can use it

to prepare some supporting documentation or as input for other programs.

Example 1. Solution steps of clipped cone unfolding creation task

As a simple example of using the report mechanism together with the command Animate Model,

consider the solution to the task of constructing a clipped cone unfolding.

To create the unfolding, a line tilted with respect to the vertical is created at the cylinder's end face.

The line parameter (angle) is defined by the variable alpha. A horizontal line is constructed through

the intersection point of the former line and the circle. A segment is constructed along the intersection
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line of the horizontal line and the side outline edge of the cylinder. Its length is read into the variable

Length by means of the get function.

Additionally, a report template was defined in the document for saving the values of the variables

alpha and Length. After that, the entire drawing was animated by varying the value of the variable

alpha. In the course of the animation, the variable values were output to the report.
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Based on the generated report, a database was created in Excel, which was later used for creating a

function in T-FLEX CAD defining the unfolding contour.

Report (the file Report0.rep):

0  81
1  80.9957
2  80.9826
3  80.9609
…
179  24.0043
180  24
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Function on the basis of database

The result of creating can be viewed in the Examples library (file Additional resources\Text

report\Unfolding.grb).
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Editing

This chapter gives basic ideas and recommendations on editing a 3D model and its related elements

of a 2D drawing in T-FLEX CAD. By editing, we mean certain user actions aimed at making changes to

an existing 3D model. There could be various reasons for editing:

1) correcting model flaws in the event of getting critical errors in the diagnostics window;

2) introducing improvements to existing model geometry, rearranging or rectifying a model, inserting

sequences of operations in the middle of the model tree;

3) rearranging graphic elements in a drawing or in 2D constructions. Replacing elements. Resolving

recursive references;

4) redefining geometrical or other properties of individual model elements;

5) modifying variable values;

6) modifying the model structure, reordering operations within the model tree;

7) modifying the methods of snapping and relations between 3D assembly elements, optimizing

mates and setting up the function of a mechanism model;

8) deleting elements, excluding model objects from a sequence of related elements. Deleting

sequences of related elements, deleting “extra” elements. Other.

A T-FLEX CAD model is usually a parametric one. Therefore, depending on a case it may become

necessary to undertake a group of measures aimed at editing the model, since certain changes, once

introduced, often cause a need to correct other relations. Therefore, before going ahead with

profound editing, it is advisable to do some research and prepare the best plan of actions. When you

do such preparations, you may face the following tasks:

1) identifying (researching) the model structure and the steps and methods of its creation;

2) identifying the sequence of related parents and children for a given model element;

3) finding elements:

· operations;

· 3D construction elements;

· 2D construction or graphic elements;

· variables that control the specific parameters;

4) tracing parametric dependencies: geometrical relations and element dependencies on variables;

5) geometry measurements and checks;

6) identifying invalid elements and the reasons behind model regeneration failures.

In this chapter we review the system tools that may be useful in various scenarios of the editing

process. The specifics of editing certain elements is given in dedicated chapters of the documentation,

which describe the workflow specifically for those elements.

We recommend to set aside a backup copy of the source file before proceeding with significant

modifications to the model structure.

Topics in this section:

· Before You Edit

· Editing Techniques

· Editing and Recreating Elements

· Deleting Elements

· Element Editing Commands
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Before You Edit

Researching the Model Structure and Selecting Elements

The user may often face the task of understanding the sequence of the model creation, the order in

which elements and operations are calculated, and identifying relations between model elements. In

particular, you may face this task if you need to modify a model created by another author. The

following model research approaches are possible:

· reviewing the model structure in the model tree window;

· using the rollback function to determine the sequence of operations creation and analyzing

the methods used for creating operations at various steps of model creation;

· “Destructive method”. This implies sequential deletion of operations and detailed analysis of

the model at certain creation steps, identification of individual operation creation methods,

experimenting with the model in various ways at its early stage of creation. We recommend

doing this kind of experiments with a copy of the source file;

· going into an operation editing mode, but then canceling the editing, in order to see what

elements this operation was based on and how it was created. When you enter the editing

mode, the time is spent solely to calculate the rollback state, and when it is canceled, the

original state is quickly restored.

3D Model Window

The 3D Model tool window serves to display the information about the 3D model structure and its

creation history, as well as for selecting and managing the model elements. The 3D model tree

displays all 3D construction entities and operations of the model. This information is displayed as a

tree. One can select 3D elements either on the tree branches which illustrate the history of creating

Bodies of the given a model, or on the auxiliary Constructions and Operations branches, where the

elements are sorted by types.

The model structure can be traced by expanding the model tree branches and watching the order of

operations creation. Each model tree branch represents the history of creating a certain Body of the

model. Upon pointing the cursor to a 3D element name in the model tree, the respective element is

highlighted in the 3D scene. If you select  an operation which is buried deep in the model

structure, the system will attempt to highlight in the 3D window the model topology elements (edges,

faces, vertices), which were created by this operation. This is possible only if such elements are still

identifiable within the final Body. Such highlighting helps to understand what part of the model is

represented by a given operation. By subsequently selecting operations in the model tree, one can

understand the order and the purpose of the operations. This is how you proceed with the preliminary

general analysis of the model structure. 

When analyzing the structure, it is helpful to know that the last operations in the creation history of the

model's Body, that is the ones that are displayed in the 3D window, are by default titled in black in the

model tree. Other operations are titled in blue. The names of the visible 3D construction elements are

also titled in black in the 3D model tree. The invisible elements (that is, those hidden through the use

of layers, the hide command or otherwise) are titled in gray in the 3D model tree. When selected in

the 3D model tree or simply pointed to with the cursor, the hidden 3D elements are highlighted in the

3D scene.

Detailed information on working with the model tree can be found in the 3D Model chapter.
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Rollback Model

The system provides the function of rolling back a three-dimensional model to the level of a specified

operation. This functionality is helpful in the cases when it is necessary to work more on the model

somewhere in the middle of the model tree, that is, revert it to an earlier creation stage. 

Detailed information on rollback can be found in the Rollback Model section.

Sometimes, it is helpful to subsequently delete elements and operations in order to get a

detailed understanding of the model structure as part of other experiments. In this case, the

system will not be spending time for saving and rebuilding relations, unlike in a rollback. But the

model itself may be damaged by this, therefore this method should be used on a copy of the

source file.

Tracing parameter dependencies and relations between variables

One may often need to find out what elements directly depend on a given variable, or which

geometrical or parametric relation makes the selected element interact with other objects in the

model. This information is not reflected in the 3D Model window. 

The  Information command brings up a special dialog window in which the full model structure is

displayed that pertains to all model elements. Sequences of related elements are displayed as a tree.

Unlike the 3D Model window, the Information window's structure provides more details not only on

3D elements, but also on drawing elements and all auxiliary objects. 

This command can be conveniently called from the context menu of the selected element of interest.

In this case, the model structure in the command's window is given relative to the selected element or

group of elements. The model structure can be displayed in two relational directions: Parents-

Children or Children-Parents.

Detailed information on this command can be found in the Information section.

The  Links command serves to trace the elements which are directly controlled by each system

variable or expression that involves that variable. This command's dialog window is similar to the

window of the  Information command. It displays all system variables and expressions, and

structural sequences of dependent elements relying on those variables and expressions.

Detailed information on this command can be found in the Links section.

Element Search

You can use the search to select an element, if you know its individual name or ID. To search for an

element use the  Find command.

Detailed information on this command can be found in the Find section. 

Selecting elements in the 3D scene

Selecting elements in the 3D scene is described in the Selection of 3D Elements section.

Geometry Measurements and Checks

The system has various tools to perform various checks and measurements of geometrical data. 

Detailed information on such tools can be found in the Model Geometry Analysis chapter.

Sometimes, to perform a series of distance measurements between various elements of a part, it may

be helpful to construct a temporary 2D projection somewhere on the 2D page and create the required
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dimensions. Once done with measurements, you can delete that projection unless useful for other

purposes. 

Diagnostics Window

The “Diagnostics” tool window serves to output various system messages regarding errors in the

model encountered during a recalculation, as well as warnings and information messages.The user

shall be able to correctly interpret those in order to proceed with a sound and quick fix to the source

of errors and restore the model validity.

Since model elements are related to each other, a failure in one element may simultaneously cause a

sequence of errors in other elements. In a case like that, you need to start fixing problems from the

very first failing element. Therefore, if you see several messages, first pay your attention to the

beginning of the list in the upper part of the diagnostics window. 

Sometimes, it is not the element triggering a recalculation error that actually needs to be fixed, but

rather one of its parents. For example, a 3D profile doesn't cause regeneration errors by itself, but its

geometry may not support valid calculation of a further operation. In such a case, you need to look for

the reason why the 3D profile changed. Maybe, that reason originates on the workplane page that

contains the source construction for the profile. After that, the error in the child 3D element may

disappear automatically.

Working with the diagnostics may be enhanced by using the 3D model tree for finding the desired

element. The model elements within which errors are detected are marked by special signs:

· A red cross on an element's icon ( , , ) means the failure occurred in that particular

element. 

· A red arrow on an element's icon ( , , , , ) means an error was detected among its

parents. By tracing the history of the element's creation along the model tree branch, you can

reach the first failing element. If there are errors, then the red arrow is also show on special

folders of the model tree containing lists of elements ( , ).

· A blue cross on an element's icon ( ) means an operation was suppressed by the user. This is

just an info message, rather than an error.

To reach the failing element, you need to expand the branches of the model tree and follow the tree

structure, finding the marked elements.

Editing Techniques

Transparent editing

The transparent editing is enabled by default in the T-FLEX CAD for all 2D elements and some of 3D

elements. Transparent editing of 2D elements means that elements editing command (similar to the

result of selecting the  Edit item in element's contextual menu) is called automatically upon clicking

 an element in the 2D window.
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Transparent editing of drawing graphic line

The transparent editing of 2D elements can be disabled by disabling the Transparent element

editing checkbox (Options > 2D)

The transparent editing of 3D elements works in a different way. It doesn't call the element editing

command, but invokes manipulators in the 3D scene, which can be used for editing an element (e.g.:

3D fragment's transformations manipulators, primitives key dimensions manipulators). The transparent

editing is not available for most 3D elements.
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Transparent editing of 3D fragment

Transparent editing of box primitive

The transparent editing of 3D elements can be disabled by disabling the Allow transparent

editing commands checkbox (Options > Additional Options)

Modifying Element's Parameters Without a Rollback

Each system element possesses a certain combination of parameters. One can view and modify those

parameters in the element parameters dialog window. This is convenient when the full-function
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editing command is not required, in avoidance of forcing the system to run a potentially time-

consuming recalculation up to the edited element.

Select the desired element to call its parameters dialog. This can be done directly in the 3D or 2D

view window, in the  3D model tree, in the  model elements window or using the  Find

command. Click  on selected element to access the contextual menu, and then call the 

 Parameters command. Element's parameters dialog can also be called by double clicking 

such element.

Detailed information on 3D elements' parameters dialogs can be found in the Common

Parameters of 3D Elements section. Information on parameters dialogs for elements of other

types can be found in chapters describing the particular type of elements. Information on some

parameters, which are common for elements of all types, can be found in the General Elements

Management chapter.

When selecting the element by clicking , the  Parameters tool window displays certain

parameters which can be modified without calling the dialog. You can handle common parameters of

multiple simultaneously selected elements in the same way. 

Information on this parameters editing technique can be found in the Define Element

Parameters section.

If transparent editing mode is enabled for 2D elements, then this technique is applicable to 2D

elements only upon multiple selection.

Edit and Recreate commands 

See the Editing and Recreating Elements section.

Elements editing commands

See the Elements Editing Commands section.

Retain Operation Geometry after Recalculation

Upon the activation of the editing and recreating commands, the system rolls back the model to the

state in which it was at the time of creating the element. The elements remaining in the scene are

those independent from the edited object. When executing a rollback, a part of the model requires

regeneration, therefore the command may take some time to activate.

To eliminate this regeneration phase and thus speed up the command activation, you can enable

saving the intermediate geometry for a certain operation. This increases usage of computer memory

and the model file size to some extent, but helps to speed up editing. In fact, saving geometry can be

used as a temporary measure while experimenting with model editing. To enable geometry saving,

right-click  the operation (for instance, in the model tree) and choose the Additional > Retain

Geometry after Recalculation” item in the context menu. The system will query the user as to when it

shall regenerate the model in order to calculate the geometry to be saved - immediately or upon the

next recalculation:
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When the Retain Geometry after Recalculation option is enabled, the operation icon in the model

tree is marked with the green pin symbol .

Elements Deletion

See the Deleting Elements section.

Source Geometry Editing Command

This command allows to quickly select for editing the geometrical elements used for creating the

selected 3D element. The list includes the 2D objects (hatches, 2D paths, 2D nodes, etc.), which were

used for creating the selected 3D element and its parent elements. If a 3D element, for example, a 3D

profile, was created based on a set of graphic lines on a workplane, then the “geometry” list also

includes the workplane itself.

When you select a 2D element in the list of the source geometry, the appropriate drawing page opens

and the mode of drawing on the workplane activates; at the same time, the editing command for the

selected element is launched. Therefore, this command can be conveniently used to quickly go to the

page of the source workplane of a given 3D object. 

The  Edit Profile command is available in contextual menu of operations, created from 3D profiles

(for example extrusion and rotation), and workplanes, on which 3D profiles were created. The

command activates the workplane on which the source 3D profile is located. 

Handling the Drawing Elements while Editing

When modifying a 3D model, one may often have to deal with drawing elements, since those may be

used as references for constructing base 3D model elements (3D profiles, 3D paths, 3D nodes, etc.).

The user may proceed with the same editing techniques for 2D elements as one uses when working

with a conventional drawing. To modify the shape of a 3D element constructed on the basis of 2D
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elements, you need to appropriately redefine the source 2D elements. Some of them, for example,

hatches directly related with 3D profiles, cannot be deleted and built anew, unless the entire model

tree branch is to be deleted together with the children of that hatch. In order to redefine such hatches,

one should use the function of editing hatch contours. Otherwise, the model's structural integrity can

be broken. If a 3D profile was created based on a set of graphic lines on a workplane, then those lines

can be freely modified, including deletion and subsequent new creation. When the session of drawing

on the active workplane is over or when the system undergoes the next calculation, the 3D profile will

be rebuilt according to the modifications to the graphic lines. 

If a certain 2D construction element needs to be modified but cannot be deleted, then you can rebuild

it by using another creation method for it in the editing command. The option to rebuild 2D

construction elements is available in the automenu of the construction lines editing command.

Sometimes it is helpful to use the  Replace Element command. It allows to transfer all relations

with parents and children from one 2D construction element to another one, and then delete the

original element. In this case, the other construction element may use a different construction method

and maintain its own relations or dependent elements.

Avoiding Recursion

When creating long chains of element dependencies, the user may run into an attempt of creating a

recursive dependency, that is, a dependency of a certain element on itself. In most cases, the system

automatically checks the created relations and does not allow saving the changes that cause a

recursion. Yet in isolated cases a recursion may occur. Such dependencies are seen most of the times

in complex chains of relations like "3D elements - 2D elements - 3D - 2D and so on". One danger of

the situation for the user is that the one may save the file with a recursion and not be able to undo the

erroneous actions when opening this file later. In such case, it won't be possible to normally work with

the file in which the system detects a recursion, up until it is rectified. 

In such situation, elements shall be edited in a special way. As was already mentioned, upon an

attempt to make any changes, the system will run a check for invalid relations in the modified chain of

dependent elements. If such invalid relations are found, the system will disallow the changes. This

creates certain complications for the user in one's attempts to delete or edit elements. 

The user's goal shall be detecting a recursive relation and breaking the chain of dependencies at any

suitable point, all in one editing step. It is often enough to change the definition method of a certain

element in the recursive chain. This could be either a 2D or a 3D element. You can redefine the

element by changing its definition method - for example, define its position in absolute coordinates

or relate it with some other independent elements. 

Such elements can be identified with the help of the  diagnostics window - names of elements are

indicated in the recursion warning line. Next, you need to investigate the dependencies between the

elements - you can call the Information window for that purpose. After identifying the causes of

the recursion, one can proceed to editing. Once corrections are made, run the model recalculation to

check and make sure there are no new warnings.

Techniques of Simplifying the Model Structure and its Display in the 3D Window

T-FLEX CAD system provides means for speeding up primary work processes - this is achieved by

freeing additional computer resources when some secondary processes and model details are

temporarily dropped.

1. Display simplification:

· Usage of the wireframe display mode in most cases helps the system to recalculate objects in

the scene faster and speeds up the scene spinning and object selection;

· The image quality deterioration affects the display of 3D objects in the scene. The objects

appear coarser but are drawn faster. The image quality can be controlled via the Image
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Quality command as well as via the document parameters dialog (Document Parameters >

Document > 3D > Mesh Quality)

· You can lower the main system 3D visualization quality (Options > 3D > Graphics Settings)

· Any element in the 3D scene can be made invisible. Reducing the number of elements in the

scene helps speed up the display. An element can be hidden by changing the level settings,

the layer, or by using the  Hide command in the Visibility sub-menu of the contextual menu

invoked by right-clicking  the element.

2. Element Suppression. By suppressing individual operations, the user not just hides them from the

3D scene, but also excludes them from the regeneration process. This also helps reduce the total

model regeneration time. An operation can be suppressed by calling the  Suppress command

from the contextual menu or by enabling the element suppression in the General tab of the

element parameters dialog.

3. You can enable the automatic exclusion from visualization for elements, whose size is below the

specified value. It is controlled by the Don't show parts smaller than parameter (Document

Parameters > Document > Large Assembly Management).

4. You can change the system performance options (Options > Performance) and individual

performance options for a certain document (Document Parameters > Document >

Performance).

Editing and Recreating Elements

There are  Edit and  Recreate commands available in the system. The difference between them

will be explained by applying them to the box primitive shown in the picture below:

Initial creation of the box

Editing elements

The  Edit command is available in the contextual menu of 2D and 3D elements. It temporarily rolls

back the model to a point of the selected element's creation and launches the command, which was

used for creation of such element. Initial parameters of creation command correspond to parameters

of the edited element.



Editing

2973

Result of applying the  Edit command to the previously created box

Recreating elements

The  Recreate command is available in the contextual menu of 3D elements. It temporarily rolls

back the model to a point of the selected element's creation and launches the command, which was

used for creation of such element. The creation command is launched with default parameters.

Usually, the recreation is used instead of deleting an old element and creating a new one from the

scratch in cases, where an ID and name of an old element should be retained in order to avoid

breaking links to child elements.
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Result of applying the  Recreate command to the previously created box

Recreating geometric entities

When faces, edges or vertices are used as a support geometry for creating 3D modeling operations,

links to selected elements are added into the model tree. They can be found inside the created

operation as well as in the special Geometric entities folder.

If you need to replace the geometric entity in the operation that is already created, you can do it

without editing the operation itself. In such case the  Recreate command can be used. It is available

in the contextual menu of the geometric entity.



Editing

2975

Upon calling the  Recreate command, the model is temporarily rolled back to the state that was

actual at the moment of creating a link to the geometric entity, which is being recreated. Filters for

selecting the corresponding type of geometric entities is activated in the Filter toolbar. Then you

should select a new geometric entity in the 3D scene using  and confirm the recreation .

Upon confirming the recreation, the rollback is finished and the operation is regenerated on the basis

of the newly selected geometric entity.

You can also Detach a geometric entity, so that it will be replaced by a reference element. 
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Edit operation

The  Edit operation command is available in contextual menus of  faces,  edges,  vertices

and  loops. It is similar to applying the  Edit command to an operation, which has formed a

selected element.

Let's click  in the 3D scene on the face formed by the  Rotation operation and select the  Edit

operation in the contextual menu.

The  Rotation editing is launched in result.
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Deleting Elements

There are several ways to delete elements from a model. Depending on the case, it may be possible

to delete groups of dependent objects or eliminate isolated objects from the model's structure, if

possible. The system also allows to automatically trace the objects unused downstream in the model,

and delete them.

The Delete Command

The  Delete command is called from the context menu when an element or a group of elements is

selected. The command serves to delete one or several elements (3D or 2D). When selected objects

are deleted, their parent elements can also be deleted automatically, upon the condition that the

latter are not referenced anywhere else in the 3D model.

When the command is called for the selected 3D element(s), there are two possible scenarios. 

If the selected element(s) has neither dependents nor parent elements not referenced anywhere else

otherwise, then the deletion will be instant and without any prompts. If the above condition doesn't

hold, then, once the command is called, the Delete Elements dialog window will appear.

In the left-hand side of the dialog window, you will be able to select one of the possible options of

the command's function:

· Delete Selected Elements and all related Elements. 

If this option is chosen, then the selected elements will be deleted together with all their

dependents.

o To have the unreferenced parent elements (if any) deleted too, you shall enable the Delete

unused parent elements checkbox. If there are workplanes among such elements, those will

be deleted together with their respective pages.

o If some of the selected or dependent 2D objects are named, then the additional Don't

delete named 2D elements checkbox is available. With this checkbox is enabled, the found

named 2D objects will be excluded from the deletion list.
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o When you delete layout elements (schematic images of 3D fragments on the assembly

workplanes) the Delete 3D Fragment when deleting its projection checkbox becomes

available. You can delete 3D fragment that is linked with the deleted layout element.

o When you delete a 3D fragment, which has a layout, the Delete all projections of 3D

Fragment checkbox becomes available. It allows to delete all its schematic images from all

workplanes.

o The Keep position of mated elements checkbox is available, when deleting mates. Enabling

this checkbox retains mated elements' positions after deleting a mate. Otherwise, mated

elements return to positions, which they had before creating a deleted mate.

In some cases, geometry or elements of deleted fragments can be left in the scene. For

example, if extrusion was created using external profile from the fragment document, the

profile and the extrusion will be left in the assembly after fragment deletion.

Another example: when two elements are connected using LCS-connector, the connector will

be left in assembly after one of the elements deletion.

Workplanes, nodes and LCS-s remain in a document if their parent element was deleted. Their

location is kept according to all transformations. If such object is created using several other

objects, and one of the objects is deleted, the link with all other parent objects will break too.

The only exclusion are 2D nodes that define workplane borders. The workplane can’t break links

with them.

· Delete only selected elements modifying type of related elements. 

This option is available only when selecting 2D elements (for example, graphic lines on a

workplane), which have dependent 2D objects. As a result of choosing this option, only

selected 2D elements will be deleted. As for children of deleted elements, the system finds an

alternative definition for them.

· Exclude selected elements from model tree (by reassigning references of dependent

elements to other elements). 

When this method is used, the system attempts to switch references of the dependent

elements to other model objects. When an operation is deleted, references of its dependent

3D elements are reassigned to the operation that stands before the deleted one in the 3D

model tree. This option is available only in the case when the deleted 3D element has both a

parent operation and a dependent 3D element.

The list of the elements to be deleted is displayed in the right-hand side of the dialog window. The

elements are sorted by types and are placed into the appropriate folders. To view the information on

the elements selected for deletion, you can click the Information… button.

If the Show this dialog only with the pressed Shift key checkbox is enabled, then the Delete Elements

dialog will not be displayed upon subsequent calls to the command. To display it when the command

is called, you will have to additionally hold <Shift>. The command will be working in this way until the

user changes this setting or until the end of the current T-FLEX CAD work session.

The Delete Body Command

When a Body is selected (which can be done in the 3D model tree) then instead of the  Delete

command the contextual menu contains the  Delete Body command. This command will delete

from the 3D model all the operations which are part of this Body's creation history. Beside that, the

command allows to delete parent elements used in this Body's operations.

The Delete Elements dialog pops-up upon calling the  Delete Body command in the same way as

described for the  Delete command above.
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The Purge Command

The  Purge command serves to delete all 2D or 3D construction elements that were used neither

for creating graphic lines of the 2D drawing nor for operations.

Detailed information on this command is available in the Purge section.

Element Editing Commands

Special commands for editing particular types of created elements are available in the T-FLEX CAD.

Such commands can be found in the Edit item of the textual menu divided into following groups:

· Construction

This group contains commands for editing 2D (2D construction, Node, Fixing vector) and 3D

construction elements (Workplane, Worksurface, 3D Node, 3D Profile, 3D Path, Route, Section,

LCS, Light Source, Camera).

· Draw

This group contains commands for editing 2D elements. Elements might be located either on

a drawing page or on a workplane.

· Operations

This group contains commands for editing 3D modeling operations.

Each particular command is described in chapters describing a particular type of elements. 

Depending on the set of available options, editing commands can be divided in two groups:

· 2D elements editing commands;

· 3D elements editing commands.

In addition to commands dedicated to editing a particular type of 3D operations, there's a common

commands for editing all types of 3D operations. Common command shares the same set of options

with type-specific commands; the only difference is the elements selection filters.

Commands mentioned above could be used for editing a single element or multiple elements at

once. Specifics of using editing commands with multiple selected 2D elements are described in the

Multiple 2D Elements Editing section.

In most cases, the key sequence for calling a 3D element's editing command differs from the

respective creation command by just one letter “E” (Edit). Examples: “3N” – “3EN” – these are

commands to construct and edit a 3D node, “3X”– “3EX” – the commands to create and edit an

extrusion operation. Icons of editing commands differ from icons of respective creation

commands in the added scissors symbol . 

2D Elements Editing Commands

Usually, upon calling 2D elements editing commands, following options become available in the

automenu:

<*> Select All Elements

<R> Select element from list



T-FLEX CAD 17 Help

2980

<Esc> Exit command

Then you have to select one or several elements for editing using options described above or .

<Shift>+  combination can be used for multiple elements selection. <Ctrl>+  combination

excludes element from selection.

Upon selecting one or several elements, following options become available in the automenu:

<P> Set selected Element(s) Parameters

<Alt+P> Copy Properties from Existing Element

<I> Select Other Element

<Del> Delete selected Element(s)

<Esc> Cancel selection

The  Set selected Element(s) Parameters option invokes the selected element's parameters

dialog. If several elements are selected, then you have to specify the set of parameters to edit before

opening the parameters dialog.

Upon using the  Copy Properties from Existing Element option, you have to select an element

whose parameters will be applied to the initially selected element. Additionally, if you want to set

copied parameters as defaults for all elements of the same type created in future, use the following

automenu option:

<S> Set Properties as Default

If only one element is selected, then the following option might be available:

Create Name for selected Element

Apart from common options described above, each editing command contains options specific for a

particular type of elements. Such options are described in sections with descriptions of a particular

editing command.

Multiple 2D Elements Editing

2D elements editing commands allow to simultaneously edit parameters of multiple selected

elements using the following automenu option:
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<P> Set selected Element(s) Parameters

In such case, activating the option invokes the Change Parameters dialog. There you have to select

which parameters should be edited.

Change Parameters dialog for construction lines

Change Parameters dialog for dimensions
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Change Parameters dialog for graphic lines

By default, all parameters are selected for editing. You can enable/disable checkboxes for

particular parameters manually using  or via the Select All and Deselect All buttons.

Upon selecting set of parameters to be edited and clicking OK, the standard elements' parameters

dialog becomes available. Elements, whose checkboxes were disabled in the Change Parameters

dialog are non-editable in the elements' parameters dialog.

Edit All Types of 3D Operations

Call the command:

Icon Ribbon

-

Keyboard Textual Menu

<3EE> Edit > Operations > All Types

The command is intended for editing operations of any type.

Upon calling the command, following options become available in the automenu:

<Esc> Cancel selection

This option clears the selection of the selected objects.

<A> Select All Elements

This option selects all objects in the model, that fulfill the command's selection filter. By default, only

visible elements are selected. Selection of invisible elements can be enabled in Document Parameters

> Document > 3D > View > Selection > Element Selection.
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<Z> Select element by name

The list of elements available for selection will appear.

<I> Select Other Element

If the first 3D element was selected by the parent 2D element, then using this option will cause

subsequent selection of all 3D elements of an editable type based on 2D elements. If an element was

selected in the 3D window, then the selection will loop through all similar 3D elements laying on the

selection ray. The selection ray is directed perpendicular to the screen plane and goes through the

point of the cursor position at the selection instant. Only those elements will be selectable which are

located close enough to the point of the cursor. 

<P> Set entity Parameters

<F4>,

<Ctrl>+<E

>

Execute Edit Command

<R> Change definition

<Del> Delete entity

<X> Exit command

<M>  Transformation

If several elements are selected in the editing command, the only options available in the automenu

will be the transformation and deletion. 

<Shift>+  combination can be used for multiple elements selection. <Ctrl>+  combination

excludes element from selection.

Apart from this command, there are separate commands for editing each particular type of

operations and 3D constructions. Such commands have the same set of options with the All types

command; the only difference is the elements selection filters.
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Importing Documents

Calling the command:

Icon Ribbon

File > Import

Keyboard Textual Menu

<IM> File > Import

Importing in T-FLEX CAD is supported from the following formats:

Only for 2D drawings:

· AutoCAD files (*.dwg);

· AutoCAD DXF files (*.dxf);

· AutoCAD DXB files (*.dxb);

· Catia V5 files (*.CATDrawing);

Only for 3D models:

· Parasolid (*.xmt_txt, *.x_t, *.x_b, *.xmt_bin);

· AutoCAD DXF 3D/DWG 3D (*.dxf, *.dwg);

· STEP (*.stp, *.step);

· IGES ЗD (*.igs, *.iges);

· ACIS (*.sat, *.sab);

· SolidWorks (*.sldprt, *.sldasm, *.sldlfp, *.asm);

· Autodesk Inventor (*.ipt, *.iam);

· Siemens NX (Unigraphics) (*.prt);

· Creo (ProE) (*.prt.*, *.neu.*, *.asm.*, *.xas, *.xpr);

· Catia V5/V6 (*.3dxml);

· Catia V5 (*.CATPart, *.CATProduct, *.CATShape);

· Catia V4 (*.model, *.dlv, *.exp, *.session);

· Solid Edge (*.asm, *.par, *.psm, *.pwd);

· Rhino (*.3dm);

· Revit (*.rvt, *.rfa);

· I-Deas (*.arc, *.unv, *.mf1, *.prt, *.pkg);

· VDA-FS (*.vda);

· JT (*.jt);

· PRC (*.prc);

· CGR (*.cgr);

· U3D (*.u3d);

· FBX (*.fbx);

· IFC (*.ifc);

· IDF (*.brd, *.emn).

3D Images

· TF3D (*.tf3d);

· Open Inventor (*.iv);

· AutoCAD (*.dwg, *dxf, *.dxb),

· VRML 2.0 (*.wrl);



Importing Documents

2985

· X3D (*.x3d);

· 3DS (*.3ds);

· 3MF (*.3mf);

· PLY (*.ply); 

· OBJ (*.obj);

· STL (*.stl);

· GLTF (*.gltf);

· GLB (*.glb).

An additional license is required to import in the Creo/ProE, Catia V5, Catia V5/V6, Catia V4, I-

DEAS formats.

You can also import the  *.x3d, *.ply, *.3mf, *.obj, *.glb, *.gltf, *.3ds, *.dxf, *.tf3d, *.stl files, VRML

2.0 (*.wrl), AutoCAD (*.dwg, *dxf, *.dxb) and Open Inventor (*.iv) files by the 3D Picture

command.

Documents of raster images in formats *.bmf, *.bmp, *.jpg, *.jpeg, *.gif, *.dib, *.pcx, *.tga, *.tif,

*.tiff, *.png, .grb drawings, Windows metafiles (*.wmf and *.emf)  may be inserted into a 2D

drawing with the help of Picture command.

After calling the command, the standard file open dialog appears on the screen. In this dialog, specify

the name of the file to import and its format. Then the dialog window for specifying additional import

parameters appears.

You can also import the file by moving it to the 3D scene of the opened file using drag'n'drop.

To import files of various formats, you can also use the External Model command. 

When you open a file using the command Open Model, you can select the Open or Open with

parameters option.

If you select Open with parameters, a dialog similar to the import dialog for the specified format

opens.

T-FLEX CAD can be set as the default program for formats that can be opened with the Open

command.

Topics in this section:

· AutoCAD formats

· Parasolid Format

· Other CADs Formats

· IFC format

AutoCAD formats

When importing AutoCAD documents into T-FLEX CAD, you need to specify the following parameters:

Create new Document. This option directs where the result of the import shall be placed: in the

current T-FLEX CAD or in a new document.

Convert Text to Windows coding. Setting this option converts all imported text to Windows

encoding. This flag shall be used when importing an AutoCAD document of one of its earlier versions

running under DOS.

Convert Blocks into Fragments. This option defines method of processing AutoCAD “block” entities.

When the flag is on, blocks will be converted into T-FLEX CAD fragments. If this flag is cleared, blocks

are converted directly into T-FLEX CAD entities. 
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Converting blocks to T-FLEX CAD fragments may significantly slow down conversion if there are too

many blocks and/or they have multilevel hierarchy.

Scale lines thickness on layouts. This parameter scales thickness of lines for drawings views and is

helpful after importing from AutoCAD.

Import line thickness instead of line weight. The parameter defines the method of assigning thickness

for imported lines. 

Split polylines into lines. Imported polylines are divided, if possible, in several lines with simple

geometry (segments, splines, arcs). On these lines you can create dimensions. 

Create Nodes. Imports points as free nodes. 

The next two groups of options (Convert Dimensions to and Convert Hatches to) define the method

of converting AutoCAD elements (dimensions and hatches) into T-FLEX CAD elements. An additional

flag for hatches Automatic area search enables the automatic hatch tracking (by the coordinates of

points specified in AutoCAD at hatch creation - Pick points). Its use is recommended in the cases when

hatch import fails in the normal mode (when the flag is cleared).

During the import, the points of the source AutoCAD drawing are converted (wherever possible) to

free 2D nodes within T-FLEX CAD. A large number of such introduced nodes might interfere with

further manipulations over the imported drawings. This can be avoided by setting the flag:

Optimize Construction. Upon setting this option, the nodes that are closer to each other than the

specified Join Distance, will be merged in one node. 

If the flag is cleared, then nodes coincidence is not tested. This helps speed up the import process,

while could significantly clutter the drawing.

Note that since the drawings in the DXF and DWG formats are not parametric, those remain

non-parametric in T-FLEX.

Images. An image from the source document is exported without specifying of a special option. 

3D Geometry. This parameter is used when the source AutoCAD file contains 3D solid geometry:

Ignore. When selecting this parameter, 3D geometry is ignored at conversion;

Ignore 3D as 2D. In this case, at conversion 3D bodies from the source AutoCAD model are projected

onto 2D drawing, 3D geometry is absent in the resulting T-FLEX CAD file;

Import only 3D. 3D geometry of the source file is transformed into 3D geometry of the T-FLEX CAD.

· Solids and Surfaces – exact solid and surface geometry will be imported.

· 3D Lines to 3D Paths –3D AutoCAD lines will be imported as 3D paths.

· 3D Points to 3D Nodes - 3D AutoCAD points will be imported as 3D nodes.

· 3D Meshes to 3D Pictures – AutoCAD mesh models will be imported as 3D Pictures.

Parasolid Format

When importing Parasolid 3D models you should define the import mode: Assembly or Set of Bodies

or One body.

This mode is important only when importing multibody models or assemblies. If original file is

presented as one solid, the result will be the same in all modes.

When importing in Assembly mode the model will be imported into multiple files retaining assembly

structure. Parts and subassemblies will be stored in the newly created documents. The root assembly

file will be opened after import completion.

When importing in the mode Set of Bodies, the model will be imported as a set of independent

external models corresponding to separate parts of the assembly. The imported model is added to

the current T-FLEX CAD document.

One body mode will insert the resulting single body in the current document. The result is similar to

the result of using the External Model command.
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In the Entity Types to Import group you can select the objects to be imported into the document:

Solids, Sheets and Wires.

Update Product Structure. Option manages the creation of product structure based on data from file:

Description (Product name) and Part No (Product ID). It should be used only if records for the product

structure exist in the imported file.

Add BOM items for bodies. If the option is active, records about bodies will be added to the product

structure.

Heal Geometry. If there are problems with imported geometry the system will try to fix them.

Check Solids. If the option is active, the import will check the correctness of the imported geometry. If

errors are detected, messages will be displayed in the diagnostics window.

In Destination folder field you can specify folder for the created parts and assembly documents.

Neutral and Other CADs Formats

Similar import parameters dialog is used for all of the formats.

In the Assembly mode, the model will be imported with the creation of the assembly structure. New

documents are created on the disk for storing of the fragments and the assembly. After the import is

completed, the created assembly file will be opened in the T-FLEX CAD window.

Set of Bodies. The model will be imported as a set of independent external models corresponding to

the individual parts of the assembly. The imported model is added to the current T-FLEX CAD

document.

If you select One Body the result of the import is single body. The result is similar to the result of using

the External Model command.

In the Entity Types to Import group you can select the objects to be imported into the document:

Solids, Sheets, Wires, Mesh geometry, bodies From active layer only, Point clouds, Hidden bodies,

Annotations, Layers.

If Point clouds option is active, all points from the file are imported into T-FLEX CAD as 3D Nodes.

Geometry Healing. You can select one of the three variants: Auto, Yes, No.

If you select Yes, the system tries to correct the erroneous geometry in the imported model and

receive a correct body. Potential errors may take place due to the presence of self-intersections or

non- sewed surfaces in the original model. The resulting body after healing may differ from the

original one.

The Geometry Healing option does not guarantee obtaining absolutely correct data.

If you select Auto, the system decides whether it should try to heal it or not.

If you select No, the model is not healed, which accelerates the import process.

Simplify Geometry. The option, if possible, removes the redundant topology from the imported

bodies.

Sewing Accuracy. If the surfaces can form a solid body with a given accuracy, they will be sewn into a

solid body. Otherwise, the surfaces will remain surfaces 

Create Precise Edges. You can select: Yes, No, Auto. Enabling the option is recommended only for

attempting to correct the geometry if errors occur in the model.

Check after import. If the option is active, the imported geometry will be checked and all found errors

will be listed in the diagnostics window and all objects with errors will be marked in the model tree.

Special warning will also be displayed at the top of the screen.

To get a more detailed description of the problem, you can use the Check Model command.

Check Solids. If the option is active, the import will check the correctness of the imported geometry. If

errors are detected, messages will be displayed in the diagnostics window.
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By default for options Geometry healing, Create precise edges and Check solids the optimal

variants are set in terms of performance and result. It is recommended to change them only if

there are problems in the imported model. 

Update Product Composition. Option manages the creation of product structure based on data from

file: Description (Product name) and Part No (Product ID). It should be used only if records for the

product composition exist in the imported file.

Add BOM items for bodies. If the option is active, records about bodies will be added to the product

composition.

In Destination folder field you can specify folder for the created parts and assembly documents.

IFC format

The geometry from the file of IFC format can be imported as: Solids and T-FLEX CAD Operations.

When you select T-FLEX CAD Operations the system tries to create T-FLEX CAD operations and the

import will be slower.

Wireframe. Wireframe data will be imported.

Import model structure. Hierarchy of the source IFC file will be shown in the 3D Model tree.

Default units. Allows to specify units of the imported geometry in case that they were not specified in

the source file.
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Exporting Documents

Calling the command:

Icon Ribbon

File > Export

Keyboard Textual Menu

<EX> File > Export

T-FLEX CAD allows exporting its 2D drawings and 3D models into following graphical system formats:

Only for 2D drawings

· Windows Metafiles (*.wmf);

· Enhanced Windows Metafiles (*.emf);

· AutoCAD files (*.dwg);

· AutoCAD DXF files (*.dxf);

· AutoCAD DXB files (*.dxb);

· T-FLEX CAD Metafiles (*.bmf);

· T-FLEX CAD Metafiles without hidden lines (*.bmf).

For 2D drawing and 3D models

· Raster Image (*.bmp, *.jpg, *.gif, *.tif, *.tiff, *.png);

· Files in PDF format (*.pdf)

Only for 3D models

3D documents

· Parasolid files (*.x_t);

· Parasolid Binary files (*.x_b);

· STEP (*.stp, *.step);

· IGES ЗD (*.igs, *.iges);

· JT (*.jt);

· ACIS (*.sat, *.sab);

· RGK Zip (*.RGK_ZIP);

· RGK (*.RGK_XML);

· PRC (*prc);

· RGP (*.RGP).

Mesh geometry

· AutoCAD DXF 3D files (*.dxf);

· Stereo Lithography (*.stl);

· PLY files(*.ply);

· OBJ files(*.obj);

· VRML 2.0 files (*.wrl);

· U3D files(*.u3d);

· X3D files (*.x3d);

· POV-Ray (*.pov);

· Open Inventor files (*.iv);

· Rhino Model (*.3dm);
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· IFC (*.ifc);

· 3MF (*.3mf);

· T-FLEX Scene files (*tf3d);

· GLTF (*.gltf, *.gld);

· «EULER» (*.ect).

When porting models from T-FLEX CAD to other systems and from other systems to T-FLEX CAD,

you are strongly advised to prefer the STEP to the IGES format whenever possible as the more

advanced one.

You should select one and press Export button on the top of the screen.

After calling the command, the corresponding parameters for exporting formats will be displayed in

the system Parameters window.

Next, depending on the selected export format, either the file will be saved at once (as in the formats:

Windows Metafiles, Enhanced Windows Metafiles, T-FLEX CAD Metafiles, Metafiles without invisible

lines), or additional parameters, described in the subsections of this section, must be specified

3D Mesh Formats Export Parameters

When models are exported to 3D mesh formats, their geometrical shape is converted into a set of

triangular elements. You may control the accuracy of representation which determines the number of

triangular elements and thus the export file size.

Topics in this section:

· AutoCAD system formats: DXF, DXB, DWG

· Raster Image

· PDF Format

· Parasolid Formats
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· Rhino Model Format

· STEP Format

· JT, ACIS, PRC Formats

· IGES formats

· DRAGON Format

· EIA Format

· Polygon Mesh Formats

AutoCAD system formats: DXF, DXB, DWG

When exporting 2D drawing into one of the AutoCAD system format (DXF, DXB or DWG) specify the

following parameters: 

AutoCAD version.

Convert Lines to, Convert hatches to. These parameters determine into which AutoCAD system

elements T-FLEX CAD lines and hatches will be converted;

Convert dimensions to. For T-FLEX CAD dimensions, one can select one of the following export

options:

· Dimensions. In this way of converting dimensions, T-FLEX CAD dimension parameters  are 

translated  into  AutoCAD dimension   parameters.  This   may   suffer some loss of dimension

text data that is not supported by AutoCAD (for example, tolerances containing letters in their

notation). Converting some dimensions not supported by AutoCAD could also create additional

strokes, notations and text unrelated to the AutoCAD dimension, used for accurate

representation of the respective T-FLEX CAD dimension. For example, this is possible when

exporting certain dimensions with the text put on a bent leader or on a leader extension.

· Dimensions and Text. Selecting this option also makes AutoCAD dimensions (sometimes, with

additional lines). However, the textual fields of the resulting dimensions get hidden by AutoCAD.

Instead, those get objects of the type Text inserted that appear as T-FLEX CAD dimensions yet

are not related to the AutoCAD dimension.

· Lines and Text. In this case, AutoCAD dimensions are not created in the conversion. The T-FLEX

CAD dimension images are translated as lines and text.

Text Conversion. This is the group of parameters defining the method of exporting text:

· Convert Text. This parameter defines the method of converting elements of the type String text:

to text or to line strokes in AutoCAD;

· Convert Multitext. This parameter defines the method of converting Multiline text, Paragraph

text and Table text types. Three options are available in the combo box: 

· To Multitext. T-FLEX CAD text of the specified types is converted to AutoCAD multi-text

(mtext). Subscripts, superscripts, GD&T symbols which are part of T-FLEX CAD text content,

are not translated to AutoCAD. The contents of T-FLEX CAD tables is written in one column.

The fractions contained in T-FLEX CAD text are converted correctly only upon the condition

that those do not use nested fractions;

· To Text and Lines. T-FLEX CAD text is exported to ordinary AutoCAD text and lines;

· Select. During the conversion, T-FLEX CAD text is checked for presence of tables, fractions,

subscripts, superscript, GD&T symbols, roughness's, etc. If any of those entities is found, then

the text is exported into ordinary AutoCAD text and lines. Otherwise, the text is converted to

AutoCAD multi-text.

· Code Page. This parameter allows selecting the desired text encoding. The default encoding

corresponds to the language used in T-FLEX CAD. When exporting a file that contains characters

of a language other than that used in T-FLEX CAD, you may need to change encoding. 

Convert splines into. Parameter that controls the transfer of graphic lines-splines from GRB file to the

AutoCAD file:
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· Polylines. Spline is created as a polyline with division into segments.

· Polylines with interpolation by arcs. Segments of the spline are replaced by arcs where it is

possible.

Tolerance. This parameter specifies allowable offset of the location of polyline points from the

original spline.

Images. Images are exported without additional options. 

The Export group allows us to find out which pages of the original T-FLEX CAD drawing must be

exported into AutoCAD document. The drop down list of export modes offers the following options:

· All pages;

· Current page; 

· Selected objects. In this case only the objects which were selected on the drawing are exported;

· Selected pages. Only the pages selected in the list below will be exported. Page selection is

carried out in the same way as upon printing out a document.

Export only to the space of the model. When this parameter is enabled, the export is carried out to

the tab “Model”, but the pages are not created in the file (layouts).

If the drawing being exported uses SHX fonts missing in AutoCAD, you can add those to

AutoCAD by copying those fonts into its working directory.

Do not create blocks for pages. The drawing will be exported without blocks creation.

Raster Image

The following parameters are defined in the raster image export dialog:

File group of parameters displays and allows to edit the name and format of the output file defined in

the previous step.

Export group of parameters defines the export image:

Current View. This setting means exporting the current window image;

Current Page. This setting means the current 2D page image will be exported;

Rectangular Area. This setting serves to manually define a rectangular area of the 2D page, whose

content will be recorded in the resulting file. There are two ways to specify the area:

· By defining the lower-left and upper-right corner coordinates of the area (Left Bottom and

Right Top). The coordinates are entered in the respective fields;

· By selecting a rectangular area in the 2D window. To select an area, click the button Select. The

dialog window will temporarily disappear from the screen, and you will be able to specify the

desired area with the cursor. To return to the dialog, click  in the automenu.

Note that the Export group is only available when calling the export command from a 2D

window. When calling a command from a 3D window, the Current View option is forcibly set,

and the entire group is unavailable for editing.

An additional Hide Constructions flag (set by default) has an effect on exporting 2D and 3D

construction elements. When this flag is set, the construction elements are not exported.
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Note that the Area to Export parameter, as well as the fields to define a rectangular area, are

available only when calling the export command from a 2D window. If calling the command

from a 3D window, then the Current View setting is forced. Besides that, when called from a 3D

window, the command dialog gains another flag – Hide Annotation Elements. When this flag is

set, the 3D annotation elements are not exported.

The Hide screen layers flag is also available only when exporting from a 2D window. This parameter

determines whether the drawing elements from the layers for which the Screen option is set will be

exported.

Image group of parameters

This group serves to define parameters of the file being created: the image dimensions, resolution and

background color:

Width, Height. These are the width and height of the image in the resulting file. If these parameters

are set, the system will force saving the image aspect ratio.

Units. This parameter defines the units in which the height and width of the image are specified:

Pixels, Millimeters, Centimeters, Inches.

Resolution. This parameter defines the resolution of the file being created. You can additionally select

the resolution units: Pixels per Inch or Pixels per Centimeter.

An info parameter Size in Pixels serves to assess the size of the resulting file.

Background Color. This parameter defines the background color of the picture being created: Auto

(same as the active window background), White, Black, Other (any color from the drop-down list at

the right).

If you export a 3D scene, the option Transparent is available for PNG format. The option allows you to

set a transparent background for the image.

Quality. This parameter is available only when exporting the *.jpg format. It defines the rate of

compression for the file. The higher the compression quality setting, the less image loss and the larger

the file size will be.

PDF Format

You should select a path for saving the exported file after calling the command for exporting to PDF.

A dialog window appears after that. Here user can specify export parameters.

In the Pages field user should select pages for export.

Buttons to the right of the field allows to control the selection of pages for export.

Buttons Up and Down allows to position the 3D view at the beginning of the PDF document or at the

end.

The Settings button is available for the 3D view. The button calls the 3D PDF export dialog.

Convert to raster image. All pages will be converted to raster images. You can specify image

resolution in the field to the right.

Create layers. If the flag is set, layers will be created in the PDF document. The layers will be similar to

the layers in the T-FLEX CAD document.

Monochrome. Allows to specify single color for the drawings on all pages. By default the color is

black.

Open file. If the flag is set, the PDF document will be opened when the export is complete.
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Parasolid Formats

When exporting into the Parasolid format, you need to specify the Parasolid Version.

By default, the Parasolid version number is set to the one that T-FLEX CAD system is running (the

maximum number).

Data organization. Specifies export type: Assembly or Set of Bodies.

· Assembly. The model is exported with assembly hierarchy, if it exists.

· Set of Bodies. The model is exported without assembly hierarchy.

In the Entity Types to Export group, you can specify which objects will be exported:

· Solids;

· Sheets;

· Wires.

Color. Allows to select one of the following color sources: Material or Shading. In the first case the

scattering color of material (is specified in the material parameters in T-FLEX CAD) is exported.

Otherwise, shading is exported.

Simplify geometry. The option, if possible, removes the redundant topology of the exported model

bodies. As a result the size of the output file is reduced. The option does not change the quality of the

model.

For example, it can be "extra" ribs, breaking a cylindrical surface into segments. With this option, the

export time and memory consumption are increased.

Export welds. Manages export of welded seams.

Export 3D path. Manages export of 3D paths, routes.

Export profiles (sheet). Manages export of profiles.

Copy geometry of arrays. If the flag is set, copies of all of the elements of the array will be created.

File size in this case increases.

Rhino Model Format

Export options for this format specify types of T-FLEX CAD elements for exporting to Rhino model:

Solids and Surfaces. When this flag is set, all visible solid and sheet bodies will be exported.

3D Profiles. This flag enables 3D profiles for exporting as Rhino curves. If flag Closed 3D Profiles as

Sheet Bodies is set, Rhino surfaces will be generated instead of curves-bounds for the closed 3D

Profiles.

3D Paths. When this flag is set, 3D Paths will be exported as Rhino curves.

Visible only. This option controls 3D Profiles and 3D Paths to be exported. When this flag is active

only visible objects will be exported. Solid and sheet bodies are not affected.

STEP Format

The Export Parameters dialog window appears after the STEP format selection after specifying the

file name. Here you can specify the process parameters.

Protocol provides compatibility of STEP files with old CAD system versions. By default, the new

protocol is enabled. The old AP203 version of the protocol does not support color 

Data Organization group

The group defines the export mode for model that includes several bodies. 

Assembly. The exported model is converted as an assembly with structure preservation. 

Set of bodies. The geometry from the converted file is exported as a set of bodies without assembly

structure creation. Each of the model bodies is exported independently.
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Entity Types to Export group

Solids. The option enables export of solid bodies in the form of a boundary representation based on

geometry. Object type is preserved. 

Sheets. The option enables sheet bodies export. Object type is preserved. 

Wires. If there is a wire body in the external operation, it will be exported. 

3D Images. Export objects of 3D image type. 

3D Nodes. The option enables 3D nodes export. Object type is preserved.

Annotations. The option enables 3D annotations. Type of objects in STEP is an annotation.

Welds. The option enables welds export. Welds are converted into bodies.

Curves. The option enables paths export. Paths are converted into wire geometry.

Profiles. The option enables profiles export. Closed profiles are converted into sheet bodies. Non-

closed profiles are converted into wire geometry. 

Options

The Color option defines body color source: main body color or the color of the hue. 

The Simplify geometry option removes excess topology from the model and reduces the file size. By

default, it is disabled, as export time and memory consumption increase when using this option.

JT, ACIS, PRC Formats

Similar dialogs are used for JT, ACIS and PRC formats.

For JT Format you can additionally specify JT Version.

Data organization. Specifies the export type:

· Assembly. The model is exported with assembly hierarchy, if it exists.

· Set of Bodies. The model is exported without assembly hierarchy.

Entity Types to Export group

Solids. The option enables solid bodies export. The object type is preserved.

Sheets. The option enables sheet bodies export. The object type is preserved.

Wires. The option enables export of wired body.

3D Images. The option enables export of 3D images. Object will be exported as tessellation. In case of

a solid both solid geometry and tessellation will be exported so it is not necessary to specify this

option.

3D Nodes. The option enables 3D nodes export. The object type is preserved.

Annotations. The option enables 3D annotations. Type of objects in STEP is an annotation.

Welds. The option enables welds export. Welds are converted into bodies.

Curves. The option enables paths export. Paths are converted into wire geometry.

Profiles. The option enables profiles export. Closed profiles are converted into sheet bodies. Non-

closed profiles are converted into wire geometry. Only closed formats export is available for JT and

ACIS formats.

Formats Solids Sheets Wires 3D
Images

3D
Nodes

Anno
tation
s

Welds Curves Closed
profile

Non-
closed
profiles

JT + + - + - - + - + -
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ACIS + + - - - - + - + -

PRC + + + + + - + + + +

Options

Color. Allows to select one of the following color sources: Material or Shading. In the first case the

scattering color of material (is specified in the material parameters in T-FLEX CAD) is exported.

Otherwise, shading is exported.

Simplify geometry. The option, if possible, removes the redundant topology of the exported model

bodies. As a result the size of the output file is reduced. The option does not change the quality of the

model.

For example, it can be "extra" ribs, breaking a cylindrical surface into segments. With this option the

export time and memory consumption are increased.

IGES Format

The IGES export dialog is similar to the dialog for STEP, JT, ACIS and PRC formats, but two additional

parameters are available for the IGES format.

Using NURBS. Setting this flag allows use of rational splines (NURBS) when converting a model. If the

flag is cleared, all exported geometry is described solely by polynomial splines.

Save Bodies as Sets of Faces. Instead of preserving a solid body, a set of its faces will be preserved,

each face as a separate surface.

DRAGON Format

The export of this format is possible when the profile is output from the T-FLEX CAD system.

Below is an example of exporting a profile to DRAGON format.

The drawing shown in the example has a profile consisting of two contours (a polyline that includes

segments and two arcs, and circles).

In the example, the initial node of the profile is highlighted and the arrow shows the direction of

traversing the profile.

When you select this format, the following file is created:

File Profile.drg:

START 205.740000 188.900000

LINE 224.180000 122.540000

LINE 79.630000 122.540000

LINE 79.630000 139.400000
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ARC 96.490000 156.260000 96.490000 139.400000 -16.860000

LINE 139.540000 156.260000

LINE 139.540000 172.480000

ARC 155.960000 188.900000 155.960000 172.480000 -16.420000

LINE 205.740000 188.900000

END

PROFILE 2

START 195.470000 143.280000

ARC 195.470000 143.280000 182.490000 143.280000 12.980000

END

The profile-file consists of a sequence of lines. Each of the lines starts with a keyword and has a

specific format. Keywords can be as follows:

PROFILE

START

LINE

ARC

END

Each new contour has a heading:

PROFILE N, where 

N - the number of the contour in order.

For example:

PROFILE 1

...

...

...

PROFILE 2

...

Each contour starts with the keyword START and ends with the keyword END.

String formats:

START X1 Y1

END,

where 

X1, Y1 - real coordinates of the starting point of the contour.

For example:

START 57.000 108.000

...

...

END

Between the keywords START and END there is a set of strings consisting of the keywords LINE and

ARC (arc or circle).

String formats:

LINE X2 Y2,

where

X2, Y2 - real coordinates of the end point of the line.

ARC X2 Y2 XC YC R, where
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X2, Y2 - real coordinates of the end point of the arc of the circle (for the circle - the coordinates of the

point on the circle).

XC YC - real coordinates of the center of the circle.

R - radius of the circle. The radius of the circle is positive if the arc contour was traversed

counterclockwise, and the radius of the circle is negative if clockwise.

For example:

LINE 97.000 108.000

ARC 117.000 88.000 97.000 88.000 -20

LINE 117.000 68.000

ARC 127.000 58.000 127.000 68.000 10

EIA Format

For the example given below, we will describe the EIA format that can be obtained when the profile is

output from the T-FLEX CAD system.

The part shown in the example has a profile consisting of two contours (a polyline that includes

segments and two arcs, and circles).

In the example, the initial node of the profile is highlighted and the arrow shows the direction of

traversing the profile.

When setting the output format "EIA", you can change the following output options:

Coordinate system. Sets the point relative to which the profile coordinates will be calculated. You can

choose from the list:

· From (0,0)
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· From contour beginning

· Incremental

Code for clockwise circles. Sets the code for determining the arcs set clockwise.

Code for counter-clockwise circles. Sets the code for determining the arcs set counterclockwise.

Number of leadings digits. Sets the required number of digits up to the decimal point when writing

numbers to a file.

Precision. Sets the precision of rounding numbers when writing to a file.

Number of trailing digits. Sets the required number of digits after the decimal point.

Reverse direction. Getting the coordinates of the profile in the opposite direction to the specified

one.

Use decimal point. This parameter is required to specify a hard format without a decimal point.

When choosing the EIA format, the following file is created:

File Profile.eia.

X205.74 Y188.9

X224.18 Y122.54

X79.63 Y122.54

X79.63 Y139.4

G2 X96.49 Y156.26 i0.0 k16.86

X139.54 Y156.26

X139.54 Y172.48

G2 X155.96 Y188.9 i0.0 k16.42

X205.74 Y188.9

 

X195.47 Y143.28

G3 X195.47 Y143.28 i12.98 k0.0

Polygon Mesh Formats

When models are exported to polygonal mesh formats, their geometric shape is converted to a set of

triangular elements. You can set the accuracy of the polygon model. As the accuracy increases, the

number of triangles and the size of the final file increases.

Topics in this section:

· X3D, U3D, IV, 3D PDF3D, VRML 2.0, TF3D Formats

· 3D PDF, U3D Formats

· POV format

· PLY, OBJ Formats

· STL (Stereolitography) Format

· DXF 3D format

· 3MF Format

· GLTF and GLB Formats

· IFC Format

· EULER ECT Systems Format

X3D, U3D, IV, 3D PDF3D, VRML 2.0, TF3D Formats

You may define various export parameters for x3d, iv, vrml 2.0, tf3d formats (these parameters are

also used in most of the formats described in the following sections):
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Pack to Archive - reduces the size of resulting file and stores all relevant data in one compressed file.

For example, you can store main scene file and textures.

Object Caching. If there are several identical elements in the document, and the flag is active, the

elements will be saved in a single instance. Transformations are used to create all elements based on

this instance. If the flag is disabled, a separate instance is created for each of the elements and the file

size will be larger.

Export Light Sources - adds light sources of active view.

Export Edges – adds model edges as separate graphical items.

Export Materials – when the flag is set, the materials will be exported. Otherwise model colors will be

exported. 

Export 3D Annotations. Allows to export 3D drawing elements, such as dimensions and GD&T

symbols, in polygonal formats.
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T-FLEX CAD  3D PDF

Texture Type: 

· Without texture - file is saved without data on textures; 

· Embedded texture – texture is stored inside the file;

· External texture – adds only links to the texture files; 

Mesh Quality specifies image quality for the exported model. Higher quality produces bigger files.

Default; 3,27 Mb Increased mesh quality; 13,1 Mb Decreased mesh quality; 13,1 Kb
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When you select Custom, the advanced quality parameters appear. Set desired values of mesh quality

parameters and click the Apply button. If the Dynamic Preview checkbox is enabled (see below), then

the mesh preview in the 3D scene will be regenerated in accordance to the specified parameters.

More information about mesh quality settings can be found in the Document Parameters, 3D

tab.

Source CS. Allows you to select the LCS that determines the initial orientation of the model when you

open the exported file.

Exploded View Scenario. Allows to select an exploded view scenario, which will be added to the

exported file.

Dynamic Preview. Allows you to display the mesh of the model. This mechanism accurately gives an

idea in what form the model will be obtained.

3D PDF, U3D Formats

These formats have the same options as described in the X3D, U3D, IV, 3D PDF3D, VRML 2.0, TF3D

Formats section and several additional options.

Create Layers. When it is enabled, all layers from T-FLEX CAD document will be created in the file.

Export Attributes. Attributes may be set for 3D model objects. These attributes will be saved in the

resulted file on export.

Threads can be exported into the 3D PDF format. Textures export should be enabled for this purpose.

Open File. Allows to open file in the program, associated with the format.

POV format

The parameters for the *.pov format differ from the parameters of the X3D, U3D, IV, 3D PDF3D, VRML

2.0, TF3D formats by the presence of the Additional settings button.

After pressing the button the POV-Ray Export window appears. 

More information about the window can be found in Photorealistic View section.

PLY, OBJ Formats

All export parameters of this format are similar to the parameters described in the X3D, U3D, IV, 3D

PDF3D, VRML 2.0, TF3D Formats section.
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STL (Stereolitography) Format

Some of the export parameters of this format are already described in the X3D, U3D, IV, 3D PDF3D,

VRML 2.0, TF3D Formats section. The difference between the parameters for the DXF 3D format is the

presence of the following fields:

Separate file for each body. Separate files will be created for each body in the assembly.

STL color model. You can select color from one of two standard formats: VisCAM and SolidView

Format or Materialise Magics Format. You can also select Without color.

File type: 

· Binary (with color support) - binary format with color support. Bodies are stored as a single

large mesh.

· ASCII (multibody) - text format without color support. The bodies are divided into individual

meshes.

Open file. Allows to open file in the program associated with the format.

DXF 3D format

Some of the export parameters of this format are already described in the X3D, U3D, IV, 3D PDF3D,

VRML 2.0, TF3D Formats section. The only difference is a Layers Assignment field. You can select one

of the following variants:

· One layer – all bodies will be placed on the same layer.

· Layer for each body – bodies will be placed on different layers.

· T-FLEX CAD layers – layers specified in T-FLEX will be used.

3MF Format

3MF is an XML-based mesh format created for use in additive production and 3D printing. The format

includes additional information (for example, about the material and color of the model).

All export parameters of this format are similar to the parameters described in the JT, ACIS, PRC

Formats section. The only difference is that the result of the export is a mesh geometry.

GLTF and GLB Formats

GLTF is a file format for storing 3D scenes and models, the structure of which is written in the JSON

standard. This format compresses three-dimensional scenes well and minimizes processing during the

execution of applications using WebGL and other APIs. A binary version of this format is also

available, which is called GLB, the only difference of which is that everything is stored in a single file

with the GLB extension.

All export parameters of the *.gltf format are similar to the parameters described in the X3D, U3D, IV,

3D PDF3D, VRML 2.0, TF3D Formats section.

All export parameters of the *.glb format are similar to the parameters described in the Parasolid

Formats section.

IFC Format

IFC is a file format that includes data of the construction industry.

Export to this format is started without selecting additional parameters.

The result of the export is a mesh geometry.

EULER ECT Systems Format

Export is carried out using a special software module that provides the output of a 3D model into the

dynamic analysis system of multicomponent mechanical systems EULER. For this purpose, the
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exchange format of the EULER * .ect system is used. The format allows to export the mass-inertial

characteristics of the models and grid geometry.

All export parameters of this format are similar to the parameters described in the X3D, U3D, IV, 3D

PDF3D, VRML 2.0, TF3D Formats section.
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Tool Windows

To display tool windows, use the command on the ribbon tab View > Window > Windows. The same

dialog can be called from the drop-down list of the system settings menu in the upper right corner of

the system window. The icons of the enabled windows will be highlighted. Some system windows can

be invoked using key combinations.

You can read more about tool windows in the following sections:

· Library Explorer

· Diagnostics

· 3D Model Tree

· Parameters

· Macros

· Variables

· Assembly Structure

· Materials

· Product Composition
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· Bird's Eye View

· Model Elements

· Structural Elements

· Model Configuration

· Layers

· Studies

· Welds

· Quality Control

· Find Command

Library Explorer

Calling a window:

Icon Ribbon

View > Window > Tool Window > Library Explorer

Keyboard Textual Menu

<Alt>+<1> Customize > Tool Windows > Library Explorer

The library explorer menu window can be used for opening documents for editing, along with the

Open Model command. It comes up on starting the application and docks by the left border of the

application window. It also can stay floating. The user can control visibility of the library explorer

window via the textual menu item Customize > Tool Windows > Library Explorer or in the context

menu on right mouse button click over any toolbar. 

The library explorer shows the content of the open libraries.  It allows to select libraries, open

documents for editing and insert documents into the current one as fragments or pictures. The library

explorer window may have a preview pane at its bottom or right-hand side. This pane will display the

preview image or the properties of the selected document. 

The library explorer window can have various different settings accessible by .  More details on

working with the library explorer window and library configurations follow in later chapters. 

For a detailed description of working with the Library Explorer window, see the section Library

Configurations and Library Explorer.

Diagnostics

Calling a window:

Icon Ribbon

View > Window > Tool Window > Diagnostics

Keyboard Textual Menu

<Alt>+<2> Customize > Tool Windows > Diagnostics

Error messages and various system warnings are displayed in a special tool window - the diagnostic

window. Errors can occur when setting incorrect operation parameters, with an invalid value of a
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variable, recalculating a model with incorrect parameters, etc. The system will try to recognize the

cause of the error and display a message in this window. A diagnostic window is created

independently for each document opened in the T-FLEX CAD application.

The appearance of the table of messages in the diagnostics window is determined by the user. It is

possible to select the columns which will be displayed in the table, modify the rules for sorting and

grouping the messages. All these actions are carried out with the help of the context menu of the bar

of headers of the diagnostic window.

The context menu that is invoked inside the table of messages will have another view. If the

diagnostics window is empty (no errors), only the service commands will be accessible in the context

menu:
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Hidden errors list. This command invokes the dialog window with a list of hidden messages. To cancel

the locking of messages of a certain type, it is sufficient to clear the flag to the right of the message.

Show window automatically. If this flag is set, the diagnostics window will automatically open when

the new messages arise. This mode can be useful when combining several tool windows (including

diagnostics windows) into the one common window with tabs.

Hide window. This command closes the diagnostics window. The user can again open the window

with the  “Customize > Tool Windows > Diagnostics Window” command.

Update. This command updates the list of errors in the window.

Group Fragment Messages. This flag of the context menu controls the grouping of messages that

come from one fragment. When the flag is set, the messages from different fragments are grouped by

folders.

Enable Sound. This command turns on/off the sound signal when the error arises.

The context menu that is invoked upon pressing  on the error message also contains the set of

standard commands of editing a faulty element of a 3D model or a 2D drawing. For example, it is

possible directly from the diagnostics window to launch the Edit command for a faulty element.
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In the context menu that appears upon selecting one error message, the following command is also

accessible:

Hide this message. This command allows us to hide the message in the diagnostics window. When

invoking this command, the dialog window with additional query appears: “Hide Messages only for

Selected Element? Yes/No/Cancel”. Depending on the answer of the user the following variants of the

command's action are possible:

· Yes. All messages of the selected type for the same object (2D or 3D element) will be

suppressed (2D or 3D element);

· No. All messages of the selected type for all objects will be suppressed (in the framework of

the current T-FLEX CAD document).

· Cancel. The execution of the command is canceled.

Hidden messages are put into the list of hidden messages. They will not be displayed in the

diagnostics window until the mode of locking is canceled. The action of this command is also

extended to the subsequent sessions of work with the given file/system. It is possible to view the list of

hidden messages of the current document and, if necessary, edit it with the help of the Hidden Errors

List command.

In the diagnostics window it is possible to select several messages simultaneously by using <Ctrl>+

. When selecting several messages the following command will appear in the context menu:

Delete linked elements. This command allows us to delete all 2D and 3D elements linked with the

selected messages.
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The Message field displays information about the error that has occurred. The message line,

depending on the type of error, can be indicated by an icon.

 - file open error

 - announcement

 - error when selecting a drawing element

 - bug to fix

 - warning

The Element field, if necessary, contains the name or identifier of the drawing element with which the

situation is associated. The line in this field can also be accompanied by an icon  that reflects the

type of element . Error recalculating node "0x200000D" of the fragment "f1.grb". Node 0x2000006.

Consider below the most common errors that occur when recalculating a model:

Error text Explanation

 Geometry is too complex The geometric parameter specified in the properties of the operation

(for example, the blend radius) does not allow obtaining the correct

result under the current conditions. To eliminate the error, you need to

explore the surrounding geometry around the place of the operation, or

change the value of the geometric parameter.

 Error regenerating

source/parent element

One or more elements, on the basis of which the operation indicated in

the message is created, for some reason dropped out of the

regeneration process. Due to the absence of the source element, the

operation cannot be regenerated. To fix the error, you must either try to

restore the source item or rebuild the operation.

 Degenerate element The source data used in the construction of the element (usually a 3D

profile or 3D path), for some reason, exclude the possibility of the

correct construction of the element. To correct this error, you need to
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check the source 2D constructions (self-intersecting hatches, violation of

the integrity of the contour, etc.).

 Error opening Fragment file

"..."

Link to non-existent file: 

The system could not find the required file either from the specified link

or from the folder of the assembly file.

 Element regeneration error The system detected other errors while recalculating the element,

leading to the impossibility of obtaining the result.

 Invalid input data set The source parameters of the operation do not allow obtaining the

result. It is required to change the source elements or the geometric

parameters of the operation.

 Missing operand in Boolean

operation

The disappearance of the operand of a Boolean operation can be

associated with an error in its regeneration or with parametric changes

in the model that lead to the disappearance of the body. In this case,

only one operand remains, and the presence of a Boolean operation in

the chain of model operations becomes meaningless. However, when

creating various parametric versions of a part, it may be necessary to

create "flashing" elements. There is an option in the parameters of the

Boolean operation to allow the absence of operands.

 Fragment model recalculation

error

General message informing that during the regeneration of the Part or

3D fragment, errors occurred in its model. To fix the error, you need to

explore the fragment model.

 Recursion when specifying an

element

In most cases, the system warns the user in advance with such a

message about an attempt to create recursive links (i.e., an element's

dependencies on itself). The appearance of such a message when the

model is regenerated means that the model already contains recursive

links. To continue normal functioning, it is imperative to find and break

the recursion by regenerating the elements that have incorrect links.

If an error occurs inside the fragment file, the diagnostic window displays links to those operations

from the fragment model that caused the error, and the Show Fragment Structure command

becomes available from the context menu.

Show Fragment Structure

The fragment inside which the error was detected is highlighted automatically. In the right window,

you can observe information about the variables of the fragments: variable names, their values and

comments. To eliminate the error, you can open the fragment file by clicking the Open button.

An error in the fragment model can be caused if an incorrect value of the fragment variable is

specified. To open a fragment with the current values of variables, use the Detail button.
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3D Model Tree

To open the 3D model tree window use the command  

Icon Ribbon

View > Window > Tool Windows > 3D Model Tree 

Keyboard Textual Menu

<Alt>+<3> Customize > Tool Windows > 3D Model Tree 

The window titled 3D Model will appear at the left side of the screen. This tool window reflects the

structure of the 3D model as a tree. 

The search panel allows to find an element in the 3D model tree by its name or part of the name.

Elements, which names match the required name, will be displayed in the tree after searching.

The search panel can be moved or hided.
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Columns allows to change elements parameters and to receive information. You can change

parameters for several elements at once.

For example, if you want to hide several workplanes, it is necessary to select the planes and press 

in the Visibility column.

If any parameter can’t be changed, its symbol will not appear in the column.

The drop-down list is used to select columns:

Bodies are put at the root of the model tree. Depending on the Body geometry type (solid or sheet

object), the respective icon will be used for it in the model tree.

Each model Body is assigned a unique name, by default composed of the word “Body” and a number,

for example, “Body_1”. If necessary, any Body can be assigned an arbitrary individual name in the

Body parameters.
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The 3D Fragment, Part and 3D Array creation operations can be displayed at the top level of the

model structure, along with Bodies.

The Body knots are marked by the glyph . It allows watching the history of the given body’s creation.

Point the mouse at the glyph  and click . 

As the model tree branch with the Body history expands, the glyph changes to . The Body history

consists of a sequence of their defining operations, displayed as a list. The list is formed from top

down in the order of creating or using operations. To hide the Body history, point to the glyph  and

click .

Each model element entered in the Body history has a unique name. By default, the name consists of

the name of the element type and a number, for example, “Extrusion_6”. If desired, the element, just

like a Body, can be assigned an arbitrary individual name.

Named elements can be further used to perform measurements, search for source elements when

creating operations by name (for example, Blend operation). Named elements are available for

obtaining information about the dependencies in Information command dialog. Option Delete that

removes dependent objects is also available for them. Named elements, when used for subsequent

creation of new operations based on them, retain their names. If the named geometric element is

located on a visible body, it is marked in the 3D window when it is selected in the model tree.
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You can change the geometric element name using the Parameters command in its context menu.

Names may be set for vertexes, edges, cycles, faces.

The   glyph before the element means this element is based on other elements. To expand this model

tree branch and view the element’s parents, point the mouse to the glyph  and click . After that,

the glyph will change to . If there is no glyph before the element, this means the element is the last

one on this branch of the 3D model tree.

If the creation history can be built for an operation, then the history will be displayed instead of the

parents. In this way, the  glyph is put before the operation name instead of the  glyph. An operation's

history is displayed in the same way as a Body’s history.

The Boolean operations are displayed in a special way in the history. The type of Boolean (addition,

subtraction or intersection) is drawn before the icon of the operation that comes as the second

operand of the Boolean. The diagram shows the history of the operation “Boolean_1”: the body

“Box_1” is subtracted from the body “Box_2”.

In addition to the list of Bodies, in the root of the model tree there are also special branches of the

tree in which all 3D elements created in the current model are enumerated. Auxiliary 3D elements are

put on the branch 3D Construction. All operations are on the second branch, Operations. 3D

annotation (3D dimensions, 3D leader notes, etc.) are put into the branch 3D Annotations. The Mates

branch lists all constraints created in the given model. All elements are sorted into the folders by

types: 3D Nodes, Workplanes, 3D Profiles, etc.; within the folders, the elements are sorted

alphabetically. The number next to the folder name and the colon means the number of elements of

this type contained in the model. By expanding branches of the model tree, you can access any

element of the 3D model.
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Separate branches-folders can be created for grouping Bodies, 3D fragments and 3D array. To do it,

in the context menu for the Body which you want to put into a separate folder, invoke the command

Move to Folder > New folder from the context menu. A window for specifying the name of the folder

being created will appear on the screen. After specifying the name and pressing [OK], there will be a

folder having the specified name in the tree of the 3D model, and the selected Body will be put into

this folder.
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If in the tree of the 3D model at least one Body folder has been already created, in the context menu

for each body in the submenu Move to Folder, a list of existing Body folders will be also present. The

folder that contains the current body will be marked. For moving Body into one of the already existing

folders, it is enough to select the folder in the list.
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It is also possible to move Bodies from the root of the model tree to the folder and backwards just by

dragging Bodies while pressing .

In certain cases, operations can be reordered by moving their labels within the model tree. This

effectively changes the model structure and geometry. Press  on the element label and drag it to a

new location in the tree. The following diagrams demonstrate the result of reordering an element in

the model tree. In the beginning, the operation Shell_1 followed the subtraction operation (Boolean)

Then, the Boolean, together with its tool body operand Extrusion_2 (a cylinder), was reordered to be

after the shell operation.

The model tree helps quickly create Boolean operations of all types. If you select a Body and drag it

over another Body, the indicator of the Boolean “addition” will appear at next to the pointer. If you

additionally press the key <Ctrl> or <Shift>, the type of the Boolean changes to subtraction or

intersection, respectively. Instead of Bodies, you can select operations that are last in their histories.
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3D Model tree in 3D scene

The 3D Model window can be also displayed in the 3D scene. For this purpose press  icon in the

top left corner of the 3D scene. 

If the 3D Model window becomes at some point not available when working with a 3D model, the

model tree is automatically expanded in the scene. This occurs, for example, when entering

commands of 3D elements creating or editing. If the expansion of the tree upon commands activation

is not required, it is enough to close it once using  and the system will remember this status.

The model tree has a toolbar that is similar to the toolbar in the 3D Model window. The only

difference is the number of columns to be displayed. To hide this toolbar you need to click on a

special button.

The tree can be expanded or narrowed. To do this place the cursor on the right edge of the toolbar

and move it holding the left mouse button.
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If necessary, you can enable the search panel for the model tree in the 3D scene:

Topics in this section:

· Contextual Menus of 3D Model Tree

· Parameters of 3D Model Tree

· Rollback Model

Contextual Menus of 3D Model Tree

By pointing to an element in the model tree, you can access the context menu (by pressing ).

The context menu consists of standard commands for working with element (Edit, Copy/Paste,

Parameters and so on) and with 3D Model window.

The context menus may vary depending on the element selected in the 3D Model window.

Besides the common commands for managing the selected element, the context menu contains some

additional commands for working with particular Bodies, operations and the model tree as a whole:

Delete Body (for Bodies). This command serves to delete all the operations which are part of this

Body's creation history. In addition, all parent 3D construction elements of this Body can be deleted,

or just those parent elements that are not referenced by other created Bodies.

Delete (for operations and auxiliary 3D elements). The command deletes the selected operation or 3D

construction element.

More information about deletion of bodies and other elements can be found in the Deleting

Elements section.

Detail command allows to unload a body or a fragment from the assembly into a separate file.

Remove mate transformations. Option allows to remove all mate transformations of the selected

object and to return it to the initial state.

Rollback model option allows to rollback a three-dimensional model to the level of the specified

operation.

More information about this option can be found in the Rollback Model section. 

Retain geometry after recalculation option allows you to save intermediate geometry for the

operation, thereby accelerating transition to its editing.

More information about this option can be found in the Editing Techniques chapter.
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Selecting objects with the help of the model tree is sometimes very convenient in many commands,

for example, when selecting this element in the 3D window is difficult for some reasons.

The Visibility group contains commands for controlling the visibility of elements.

More information about these commands can be found in the Using Contextual Menu for

Controlling Elements Visibility section.

Suppress (for operations). This command excludes the operation from regeneration. This allows user

to temporarily remove 3D model elements. To select a suppressed operation, use the "3D Model"

window or do the element search.

Only selected elements will be displayed in the tree upon using Go to elements command. Status

switching options , ,  are used to return to the normal mode.

You can create a separate window for the selected elements using Open in new window command.

This window can be moved around the screen. It retains all the functionality of the 3D Model window.

This window eliminates having to move the cursor across the screen to select an element in the model

tree.

After using Hide element command, the selected elements will not be displayed in the model tree.

For example, you can hide unused items, so as not to be distracted by them.
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If the flag Show hidden elements is active, all hidden elements are displayed but greyed. The

elements names are shown in italic to distinguish them from the suppressed elements.
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To display elements again you may use Show element command or you can show all items at once

using the Show all elements button.



T-FLEX CAD 17 Help

3024

Parameters of 3D Model Tree

Commands and options for customizing the display of the model tree, such as Parameters, Use active

View Filter, Appearance are located in the general parameters of the model tree:

Parameters

The View group in the Parameters dialog is different for the 3D model window and the model tree in

the 3D scene.

Use active View Filter. The 3D window selector can be adjusted for selecting elements in the model

tree. To activate the filter, flag this item in the context menu. When you move the cursor over the items

in the tree, only the elements corresponding to the active filter will be highlighted. 

Indent of sub-elements parameter allows to specify the indentation of child elements in the model

tree relative to the parent element in pixels.

Tree Structure parameter allows to set visual representation of the tree structure. The following

options are available: don’t display, lines, dots.
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Blur background borders and Rounding of background box corners parameters are available for 3D

Model window in the 3D scene.

In the Parameters dialog, you can set colors for: the 3D Model window, selected elements, invisible

elements, marked elements and hidden elements. In each of the listed groups, you can set the text

color and background color.

Use active View Filter

It duplicate the appropriate flag from parameters.

Appearance

This command allows a user to customize information which is displayed in the tree of the 3D model.

Upon calling this command, the settings dialog window appears.

The Appearance dialog allows to select data, which will be displayed in the tree for elements of

various types. Element Type can be switched using the drop-down menu in the top part of the dialog.

The Show list contains data, which is currently displayed in the tree. The Available Data list contains

data, which is currently not displayed. Use [<<] and [>>] buttons in the center of the dialog to transfer

data between lists. Rows of the Show list can be reordered using the Up and Down buttons. Data,

which is displayed top-down in the Show list, will be displayed left to right in the tree. Depending on

the selected Element Type following data might be available:

· Name;

· File name;

· Description (according to BoM);

· Part No. (according to BoM);

· ID;

· Recalculation Time in seconds;

· File Path;

· Projecting time (for projections).

If user selects an empty set of data to show, the system uses the default set.

An arbitrary user-defined Text Before and Text After can be added to any row in the Show list, so it

will visually separate this data when displayed in the tree. 
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Settings specified in the Appearance dialog are saved in the document file and used upon its

subsequent opening.

Hide fragment connectors

When the flag is active, fragments connectors are not displayed in the 3D scene.

In Order of Creation

When this flag is on, the 3D model tree is displayed in the order in which the elements were created.

All elements of the 3D model are displayed as root elements in the form of a list in the order in which

they were created.
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Standard View

In Order of Creation View

Rollback Model

If you need to make edits to an already created 3D model, you can use the mode of rolling back the

3D model to the level of a certain operation. This feature is useful when you need to do some work in

the middle of the model tree. In rollback mode, the 3D model returns to an earlier stage of creation.
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Elements and operations that are in the history of the model after the rollback point are suppressed in

rollback mode and become unavailable for selection. At this point, they are marked with semi-

transparent icons. All elements and operations created in rollback mode are automatically embedded

in the 3D model tree between the operation to which the rollback was performed and subsequent

operations unloaded from the scene. Several rollbacks are allowed sequentially.

When you exit rollback mode, the system automatically regenerates the model relationships to restore

subsequent operations. If, for any reason, as a result of the changes made to the model, errors occur,

the system will offer to restore the original state of the model, which was before the rollback. This

protects the user from making incorrect changes to the model. The rollback mode is called and

completed using the commands in the context menu of the operation in the model tree or in the 3D

view window. The rollback will be performed to the level of the operation from the context menu of

which the command was called.

Let's look at the use of rollback with a simple example. In this model, you need to add blending of the

corner edges.

Rollback the model to the basic extrusion operation. In this case, the operation Shell_1 is unloaded

from the scene.
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Blend the edges (the Blend_1 operation is added to the model tree).

Finish the rollback by clicking  on any operation in the model tree or anywhere in the 3D scene.

As a result, we get the model shown in the following figure.
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The Rollback column is intended for convenient work with rollback. The red arrow indicates the

operation to which the model was rolled back, the blue arrow indicates all subsequent

operations, and the gray arrow indicates all the previous ones.
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Parameters

To open property window use the command: 

Icon Ribbon

View > Window > Tool Window > Parameters Window

Keyboard Textual Menu

<Alt>+<4> Customize > Tool Windows > Parameters Window

The parameters window is used in most commands for creating drawing elements, 3D construction

elements and operations to set the parameters of the created or edited object. By default, on the left

side of the screen, there is a window that combines the system windows Parameters, Library Explorer

and 3D Model. Switching between windows is carried out using the tabs of the same name. If

necessary, any window can be positioned anywhere on the screen. To do this, press the right mouse

button inside the window, select the Set floating command from the context menu, and then drag it

to a location convenient for you. The context menu command Hide allows you to hide this window.

Another context menu item in the Parameters window is Show window automatically. It makes sense

to set this flag if the window is hidden. Then, when calling a command or accessing the parameter

window of some element, the window will appear on the screen, and when exiting, it will disappear. If

the window is floated, the Auto size window option will appear in the context menu. When the option

is enabled, the window size is selected automatically in accordance with the size of the parameters

dialog of the current command, otherwise, when a new command is called, the window sizes will

coincide with the dimensions of the parameters window of the previous command.       

If the command parameters assume the possibility of using variables, then to the right of the value

editing field, there is a field that shows the current value if it is set using a variable or expression. If the

value of any parameter is set to From document or Default, then the real value of this parameter is

displayed to the right of this field.
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The title and contents of the window depend on the currently active command and its options.

The parameters displayed in the window can be changed by directly entering the necessary

value from the keyboard. The current field for entering values can be set by pointing at it with

the cursor and pressing , or using the keyboard. The keyboard shortcut for switching to a

particular field of the parameters window is displayed in the hint when you hover the cursor over

this field.

A non-modal dialogue can be collapsible, i.e. dialog parameter groups can be hidden. If you open a

part of a dialog, then this sign is saved for this particular dialog, and the next time you enter this

command, the window view will be saved. In the commands for creating 3D elements and operations

in the Parameters window, the Finish input, Preview Operation Result and Exit command buttons are

available, which work synchronously with the corresponding options in the automenu.

 

Using window to set command parameters

Most of the T-FLEX CAD commands use the Parameters window to set the parameters of the element

or operation being created. However, some of the parameters can only be accessed by calling the

option  (<P>). For example, setting the transformation of 3D construction elements and

operations.

Using window to set the parameters of the selected objects

When you select several elements of the same or different types, you can edit their parameters using

the Parameters window. If the parameters window is disabled (Hide option), then its call is available

through the Parameters context menu command if more than one item is selected.



Tool Windows

3033

 

The window displays the number of selected elements and a complete list of the parameters of these

elements. When the Only Common checkbox is enabled, only those parameters that are available for

all selected elements are placed in the list. The drop-down list at the top of the (Selected) dialog

allows you to see what type of items are currently selected. In addition, when you select a specific type

of elements in this list, the properties of elements of only this type will be set. The From Element

button allows you to select an element on the screen, the property values ??of which will be used as the

current values. The lower drop-down part of the Parameter Sets dialog allows you to save the current

set of parameters with a specific name for later use. You can load such a set using the button of the

drop-down list, which contains the names of the saved sets. At the top of the dialog document, there

are 3 buttons Finish input, Apply Changes and Exit command.

When you use Finish input, the selected properties are applied and the items are deselected.

When you click Apply Changes, the selected properties are applied, but the selection is not canceled.

When you click Exit command, the selection is canceled and the dialog is closed.

Topics in this section:

· Contextual Menus of Input Boxes

Contextual Menus of Input Boxes

When working with the Parameters window or various dialog windows containing input boxes, you

can call a contextual menu by placing the cursor in the input box and pressing :
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Depending on the type of data to be inputted into a box, a contextual menu may contain various

commands of the following set:

Undo <Ctrl>+<Z>. 

Undo the last change.

Cut <Ctrl>+<X>. 

Cut the selected text to the clipboard.

Copy <Ctrl>+<C>. 

Copy the selected text to the clipboard.

Paste <Ctrl>+<V>. 

Paste the selected text from the clipboard.

Delete <Del>. 

Delete the selected text.

Select All <Ctrl>+<A>. 

Select all text in the current box.

Insert Symbol <Alt>+<F9>. 

Insert a symbol from a basic symbol table. Working with the table is similar to described for inserting

symbols into text.

Not the symbol itself is shown in the input box, but its code from the table (for example, %%066 is the

diameter symbol). By default, if text defined by some input box is shown in italic font on the drawing,

then the inserted symbol is also italic. However, if you enable the Ignore font angle checkbox, when

selecting a symbol in the table, then the "minus" is added to the symbol's code after %%, and the

symbol is shown in regular font, while the rest of the text remains italic. Minus may also be added to

symbol's code manually by typing it from the keyboard.
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If you know the code of the symbol, you can type it into the input box manually using the keyboard

without calling the Insert Symbol command. 

Additionally, the T-FLEX CAD allows defining most common symbols as well as text formatting modes

using the special codes similar to the ones used in other systems:

%%c - diameter;

%%d - degree;

%%p - plus-minus;

%%u - enable/disable underscore;

%%o - enable/disable overline;

Repeat Symbol <F9>. 

Reinserting a symbol.

Infinity. 

Insert variable… <F8>. 

Inserting a variable from the list of already created ones. The variable name in curly braces is inserted

into the dialog box. The value of the variable is displayed on the drawing. You can change the values

of variables in the variable editor or, in some cases, directly in the drawing.

Enter angle… <F11>. 

This command converts the angle value to a decimal number. The command calls a dialog box, in the

corresponding fields of which you can enter the angle value in degrees, minutes, seconds. This value

will be converted to decimal.

 

Dictionary. <F6>. 

Insert text from a T-FLEX CAD dictionary. Working with dictionaries is described in the Inserting Text

from Dictionary section.

Insert Fraction <Ctrl>+<F>. 

Inserting a fraction into the input box. Can be used, for example, when specifying the content of text

boxes for dimensions, labels, texts, etc.

When the command is called, an auxiliary dialog window appears on the screen for specifying the

parameters of the fraction.
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Measure <F12>. 

This command allows you to read geometric data from existing drawing elements and use it when

creating new elements. In doing so, you can create parametric dependencies between elements. For

more information, see the Measure section.

Spin increment… <F4>. 

You can set the increment of the parameter value when scrolling. In the scrolling step settings window,

you can set one of three positions: Default, Value, By Value List.

· Value. 

Set the numerical value of the value increment.

· By Value List. 

Setting this option will allow scrolling through the list of values, if, of course, a list of values

has been created for the current dialog field.

Edit value list… <F2>. 

You can create lists of values for input boxes. For some boxes, such lists are created by default (for

example, the Value field in the GD&T Formlimits dialog box). The command calls the window for

editing the list of values. The list can be split into columns, as well as separate groups of data in a

column with horizontal separators.
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Add value to list <F3>. 

This command adds the current value from the input box to the list. If there is no list, then it is created.

Copy value list <F5>. 

The command copies the list of values of the given input box to the clipboard.

Replace value list <F6>. 

The command replaces the list of values available for the given input box with the list of values from

the buffer. The list must be copied to the clipboard in advance using the Copy value to list command.

Check Spelling <Ctrl>+<F11>. 

Check the spelling of the contents of the input box for which the context menu was invoked.
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Macros

By default, the tool window for working with macros is not shown in the T-FLEX CAD window. It can be

made visible with the help of the following command:

Icon Ribbon

View > Window > Tool Windows > Macros

Keyboard Textual Menu

<Alt>+<5> Customize > Tool Windows> Macros

This window can be also invoked from the context menu by clicking in the zone of toolbars of the T-

FLEX CAD window.

The main purpose of the Macros window is displaying of the macros available for execution. For

launching a macro it is required to select it in the window and double-click .

The user can launch any macro displayed in this window.

Launching a macro can be carried out automatically as well when working with the user-defined

dialog (if this operation is defined for the control element Button). Moreover, to launch a macro,

the user can define a special user-defined command and add it to the text menu or the toolbar.

This option is described in more detail in the Control Elements and Adding user's Commands

sections.

The standard macros included in the T-FLEX CAD package have a simple structure which does not

make use of namespaces. In the window “Macros” they are displayed as a list of macros of each

Project. The Projects with more sophisticated hierarchy can be displayed as a multilevel structure of

the namespace (the folders with the icon ), classes (the folders with the icon ) and macros

contained in these classes .

For detailed information see the Macros section.
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Variables

To work with variables, you need to call the window:

Icon Ribbon

View > Window > Tool Windows > Variables

Keyboard Textual Menu

<Alt>+<6> Customize > Tool Windows> Variables

You can learn more about working with this window in the Variables Window subsection,

Parametrization section.

Assembly Structure

Calling the window:

Icon Ribbon

Assembly > Component Links > Assembly Structure

View > Window > Tool Windows > Materials

Keyboard Textual Menu

<Alt>+<7> Customize > Tool Windows > Assembly Structure

The Assembly Structure window provides functionality for managing the multilevel structure of the

assembly model. Information is presented in the form of a tree structure. 

When you select assembly elements, a list of their variables, geometry, and references is displayed.

The Open in Context option is available for assembly elements of any level: through the context menu

or by double-clicking on the assembly element. All geometry borrowed from other files is displayed

on the Reference Elements tab. The Create 3D Fragment context menu command is available at any

level of the assembly structure. The command allows you to set the basic parameters of the new

assembly component, and, if necessary, go directly to its editing in the context of the assembly. Any

selected assembly element will be highlighted in the 3D scene.

The top bar of the Assembly Structure window allows you to execute commands, customize the

display of assembly elements, and perform search.

The icon  (Update) updates the assembly structure: displays new items, updates information about

item relevance, and so on.

The icon  (Filter) opens the filters menu. You can use filters to customize the display of object types.

The icon  (Actions) opens the menu of possible actions (see the subsection below for details).
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The icon  (Group by Links) changes from the structure display to the references display and back.

The search bar allows you to find the desired assembly element by its designation, name or fragment

name.

The icon  (Options) opens the settings menu, where you can choose to display the necessary

columns (see subsection below for details) and customize the display of the options panel.

Actions in "Assembly Structure" Window

The following actions are available in the Assembly Structure window:

Update Links. The option updates links to the file fragments. If changes have been made and saved in

the fragment, the Assembly Structure window will show it. An icon  will appear in front of the

fragment. The icon indicates that you need to update the reference to the fragment file so that the

changes made in the fragment appear in the assembly. After the Update Links command is executed,

the icon will change and the assembly will show the changes made in the fragment.

Update Linked Details. If in an assembly, a body or fragment has been saved to a separate file with

the ability to update (for more information, see Save geometry with update possibility), then you can

update the geometry of the saved details, according to the changes in the assembly, using this

command: 

Create subassembly. The command places the selected fragments in a separate new file with the

ability to substitute the created assembly unit into the assembly (for more information, see Assembly

unit creation). The new fragment file is part of the assembly structure.

Update Reference Element Geometry. The command will update all reference elements in the

specified fragment, recalculate the fragment completely, and save it.

Update Geometry of all Reference Elements. The command will update all the reference elements of

all the assembly fragments, completely recalculate the fragments and save them.

Update Assembly. The command will consequently save all of the fragments from the fragments of

the lower levels to the upper ones. The command is used to consequently update all changes in

fragments and save them in all subassemblies. 

Refresh Files. The command will update and save files of adaptive fragment and fragments with

external variables according to their variations in the assembly. 

If there is a fragment in the assembly, which has multiple variations due to geometric parameters or

external variables, then when this command is executed, the last of the created variations will be

substituted inside the fragment file.
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The command is not suitable for creating a detailing if the assembly has fragments with multiple

executions, i.e. with different values of geometric parameters and external variables.

Report. Creates a file in the "str" format (you can open it with any program that allows you to open

files in the "txt" format) The file contains a full path and external variables of each fragment.

Save All. Saves all the fragments currently open in the system.

Group by Links

The Assembly Structure window displays the assembly structure by default: that is, the number of

parts and subassemblies (fragments in an assembly) and their nesting level.

An assembly structure may contain many executions of a fragment that has one source file that it

references. For example, the assembly shown in the figure consists of 14 fragments, and it took only 6

files to create it. One of the files is the assembly "Housing.grb". The Link column displays links

between fragments. 

The figure shows that all screws (except one) in the assembly refer to a single file "Pan Head Cross

Recess Screw ISO 7045". You can display an assembly not by its structure, but by its references. I.e.

show the number of source files and which parts refer to these files. To do this, click the icon  (Group

by Links) on the top panel of the Assembly Structure window. 

The Assembly Structure window now shows the source files. Each file contains links of fragments in

the assembly to it. Let's open the nested links.
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You can return the structure display by pressing the icon  again.

Columns

There are 15 columns available in the Assembly Structure window. Seven of the columns are

displayed by default. The Object column is the main one, and always displayed in this window. The

figure shows which columns are displayed by default.

Link. The column shows the file referenced by the assembly element.
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File Type. The column specifies the file extension. The column is needed to understand whether the

assembly element is a T-FLEX CAD document or an external model of other formats ("stp", "igs", etc.).

Link Type. The columns shows type of the link - external or internal. The link is called external when

the file is saved separately from the assembly. The link is called internal is when the file is attached to

the assembly file.

Full Path. The column displays the full path to the assembly element. 

Actuality. The column shows the relevance of an item in the assembly with respect to geometry

updates in the source file. Icon  - indicates that the link is not current and you need to update the

element in the assembly. Icon  - indicates that the file is not found.

Object Type. The column shows the type of an object to which the assembly structure element

belongs (3D fragment, document parameters, external references, standard elements).

Modified. The icon  indicates the presence of changes in the assembly element file.

Mass. The column shows the mass of the detail or subassembly (depending on whether the item is a

subassembly or a detail)

Number of Bodies. Specifies the number of fragments and/or bodies within the assembly structure

element.

Descriptions. Shows the Descriptions that you specified when creating the assembly element in the

fragment or detail dialog box.

Part Number. Shows the Part Number you specified when creating the assembly element in the

fragment or detail dialog box.

Saved. The icon  - indicates that there are unsaved changes in the assembly element file. 

Visibility in Assembly. Clicking the icon  makes the assembly element invisible. Pressing the icon

again shows the element in the 3D scene again.

Also see the Controlling Elements Visibility chapter.

Transparency in Assembly. Clicking the icon  makes the assembly element transparent. Repeated

click returns the original display of the element in the 3D scene.

Parameters Toolbar

By default, the Parameters Toolbar is located at the bottom of the Assembly Structure window. Three

tabs are available in the options pane for each assembly item.

Reference Elements. The column shows the number of reference elements in the fragment, the name

of the reference elements, the source file for the geometry of the reference elements, and the source

file for the parameters of the reference elements. 

Geometric Parameters. In this tab, geometric parameters will be shown for the adaptive fragments.

Variables. If the fragment has External Variables, they will be shown in this tab. 
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Materials

To work with materials, a special tool window is provided - Materials, which works even if no

document is open.

To display a window on the screen, you can use the command:

Icon Ribbon

3D Model > Style > Materials

Assembly > Style > Materials

Sheet Metal > Style > Materials

Surfaces > Style > Materials

Weld > Style > Materials

Routing > Style > Materials

Primitives > Style > Materials

Support Geometry > Style > Materials

Tools > Appearance > Materials

View > Window > Tool Windows > Materials

Keyboard Textual Menu

<Alt>+<8> Customize > Tool Windows > Materials

More details about this window can be found in the Materails section.

Product Composition

Calling the window:

Icon Ribbon

Assembly > Bill of Material > Product Composition

View > Window > Tool Windows > Product Composition

Keyboard Textual Menu

<Alt>+<9> Customize > Tool Windows > Product Composition

More details about working with this window can be found in the Product Composition Window

section.
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Bird's Eye View

Calling the window:

Icon Ribbon

View > Window > Tool Windows > Bird's Eye View

Keyboard Textual Menu

<Alt>+<0> Customize > Tool Windows> Bird's Eye View

The Bird's Eye View window helps quick navigation around the drawing. It always displays the whole

drawing image, regardless of the working window size currently set for the active drawing window. 

The Bird's Eye View window can be docked along any of the application window borders or stay

floating.

The modes of the Bird's Eye View window can be controlled via the context menu coming up on right

mouse button click within the window.

Pan. In this mode, to move around the drawing, you need to specify two corners of the rectangular

area in the general view window. To do this, move the cursor to the general view window, press and

hold the left mouse button, move the mouse so that the appeared cursor in the form of a "rubber

thread" captures the desired part of the drawing, and release the mouse button. After that, the

specified area in the general view window will be highlighted in a different color, and the

corresponding area of the drawing, proportionally enlarged, will be drawn in the window of the

current drawing.

Zoom. In this mode, if you move the cursor over the general view window, a rectangle cursor will

appear showing the area of ??the drawing that you want to select. The size of the rectangle is

proportional to the size of the current drawing window. If you keep the left mouse button pressed and

move the rectangle across the general view window, the drawing image in the current drawing

window will dynamically change in accordance with the movement of the rectangle.
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The modes are controlled by setting the corresponding option in the menu, which is called by pressing

the right mouse button when the cursor points to the general view window. Using the menu, you can

update the drawing in the general view window by selecting the Update option, you can remove the

general view window from the screen by selecting the Hide option.

To set the general view window redrawing modes, select the Properties option from the menu.

A dialog box for setting the window Update mode will appear on the screen. The mode After all edits

means that the drawing image in the general view window will be updated only when changing

(recalculating) the drawing model. The After redraws only means that the image in the window will

be updated along with the update of the drawing in the current drawing window. The Don't Update

mode means that the image in the window will only be refreshed when the Update option is selected

from the menu.

Model Elements

Calling the window:

Icon Ribbon

View > Window > Tool Windows > Model Elements

Keyboard Textual Menu

<Shift>+<F1> Customize > Tool Windows> Model Elements

A Model Elements window is used to display all elements in the document.

Both 2D and 3D elements may be displayed in this window. Context menu with the corresponding set

of commands is available for each element.
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When you select elements from the list, they are highlighted on the drawing and in the 3D scene.

In the window, you can select elements to be used in the current operation, for example, select

graphic lines for the Copy operation.

This window is particularly useful when working with drawings. It provides information on each

element of the drawing on the current page or on all pages of the document. 

Toolbar

The toolbar is used for the window management.

To update the content of the window option  is used.

Option  helps to enable or disable the grouping of elements by type.

The drop-down list is used to configure the display of elements in the window. 
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Current View – shows elements in the current active view.

2D Elements – show all 2D elements, existing in the document.

3D Elements - show al3D elements, existing in the document.

All Elements - show all elements, existing in the document.

In the right corner of the window, you can select a column, which will display information about

elements: type, ID, name, page and layer.

You can search for elements using the search bar.

Sorting and grouping are available for records of the Model Elements window.
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Structural Elements

Calling the window:

Icon Ribbon

View > Window > Tool Windows > Structural Elements

Keyboard Textual Menu

<Shift>+<F2> Customize > Tool Windows > Structural Elements

This window is intended for displaying the existing structural elements.

Structural elements are elements of the T-FLEX CAD data model that allow describing the applied

information data model and relationships between model objects, regardless of their geometric and

parametric relationships. They form a "parallel" applied structure of the model with their own

parameters and relationships. Each element has a type (class), the description of which stores the

composition of parameters, links, as well as methods that allow you to implement any application

functions of such objects. To describe the data stored in structural elements, as well as the

relationships between structural elements and other objects of the model, a special tool is available in

the system - the Editor of Structural Element Types.
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Here you can form a tree of types of structural elements and describe their composition. Using the

mechanism of structural elements, you can solve the following tasks:

· modeling communications of various types;

· modeling of metal structures;

· modeling of electrical products;

· description of the structure of design and technological elements for subsequent use in the

process of technological preparation of production;

· addition of the geometric model with user data for transfer to third-party application systems.

To work with structural elements, a special program interface is provided as part of the Open API T-

FLEX CAD. It allows you to develop applications that use structural elements as carriers of application

information. Structural elements can be created not only using applications, but also manually - using

the appropriate commands.

Structural elements available in the model are displayed as part of the model tree. They are grouped

by type and show relationships with other objects in the model in a tree view.
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Remarks

Calling the window:

Icon Ribbon

Remarks > Create Remark > Remarks Window

View > Window > Tool Windows > Remarks

Keyboard Textual Menu

<Shift>+<F3>
Tools > Remark

Customize > Tool Windows> Remarks

To create, delete, edit remarks, use the special Remarks window.

A more detailed description of the functionality of this window is described in the Remarks Window

section.

Model Configurations

Calling the window:

Icon Ribbon

Parameters > Tools > Model Configurations

View > Window > Tool Windows > Model Configurations

Keyboard Textual Menu

<Shift>+<F4> Customize > Tool Windows > Model Configurations

This window is intended for working with configurations and variations of the model.
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See Model Configurations and Variations for a detailed description of working with this window.

Layers

Calling the window:
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Icon Ribbon

3D Model > Style > Layers

Draw > Style > Layers

Assembly > Style > Layers

Sheet Metal > Style > Layers

Surfaces > Style > Layers

Weld > Style > Layers

Routing > Style > Layers

Primitives > Style > Layers

Support Geometry > Style > Layers

Remarks > Style > Layers

Edit > Document > Layers

View > Window > Tool Windows > Layers

Workplane > Style > Layers

Keyboard Textual Menu

<Shift>+<F5> Customize > Tool Windows > Layers

The window is non-modal, allows you to manage layers and their parameters in transparent mode.

Layer parameters are displayed by columns.

The window supports:

· column management: the composition, order, and width of columns is preserved and restored

between sessions;

· search by name or part of a name;

· grouping by group name;
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· multiple selection to set parameter values for several selected items at the same time.

Studies

Calling the window:

Icon Ribbon

Analysis > Study > Studies Window

View > Window > Tool Windows > Studies

Keyboard Textual Menu

<Shift>+<F6> Customize > Tool Windows > Studies

The Studies window displays the studies of finite element and dynamic analysis available in this

document. It used to work with studies.

Welds

To access the command:

Icon Ribbon

Weld > Weld > Welds

View > Window > Tool Windows > Welds

Keyboard Textual Menu

<WW>,

<Shift>+<F8>

Tools > Weld > Welds

Customize > Tool Windows> Welds

The Welds window contains a list of welds in the current document.
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For more information on welds, see the Welding section.

Quality Control

Quality control is a tool for automatic control and documents checking in accordance with corporate

rules. In the system window, you can call a special file with the extension "* .tfqms" - a check script that

contains control methods and controlled parameters. Each company can develop its own checking

algorithm or use a standard one.

To work with quality control tools, a special tool window is provided - Quality Control.

Icon Ribbon

Tools > Quality Control

View > Window > Tool Windows > Quality Control

Keyboard Textual Menu

<Shift>+<F9> Customize > Tool Windows > Quality Control

Displaying check results, setting check parameters, loading and executing check scripts is carried out

through this window. All actions for checking of models depend on the scenario. The script can

automatically check fonts, the thickness of lines, dimensions, technical requirements, absence of

"adjusted dimensions" when the nominal value is corrected manually, absence of intersection of

bodies, absence of model and variable recalculation errors, etc. 

In addition, the script can automatically check files for hiding confidential information, which is

necessary for the security service. You can check for hidden texts, layers, and working planes, check for

encrypted texts in element names, and check for "extra", unused structures.  

«Quality Control» Window

The Quality Control window displays the quality control script in a tree structure, allows the script to

run, and displays the check result.
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The following columns are available in the window.

Name. Displays the name of the script, action, result, and any other script object.

Information. Provides an explanatory comment on the action, displays the result of the action and

corrections.

Selection. The column contains a special field next to each action. Setting or removing the flag in the

field determines whether the action will be performed or not. 

The following commands are available in the window.

Update

Open Script

 Settings – opens the Options window, in which you can configure the folder with scripts, the

default script and activate loading on start

Script Parameters

Run Script

Run Script for Folder

A search is available. The search is similar to the search in other windows.

Quality Control Scenarios

The quality control script is a file in the "* .tfqms" format where the check set is registered. This file is

an XML program code for calling model validation methods through a special library based on the T-

FLEX CAD Open API. 
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In the Quality Control window, by default, a standard script is available, which contains the most

frequently used tests.

The standard quality control script can be independently expanded or adjusted by the user, or written

again, taking into account the rules for calling the loaded library and displaying data in the Quality

Control window. 

Any script has 4 subfolders – Parameters, Actions, Results and Fixes.

Parameters. This folder displays general check parameters that are required to generate a report.

Therefore, for example, you can specify the author of the check, what general settings were used, etc.

In a standard scenario, the parameters folder is empty, since this scenario does not provide any

additional parameters.

Actions. This folder displays the actions that you can take on the document in question. It is possible

to customize the grouping of actions. By default, grouping by 2D actions, 3D actions and 2D/3D

actions is active. If necessary, you can configure the grouping by other parameters.  
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Results. After the running of the script, all performed actions are placed in the Results folder.

All actions are displayed in this folder in a hierarchical structure, accompanied by icons  and . If

the action of the script passed a satisfactory check, the result is marked as . If deviations were found

during the check, then it marked as .

Some of the results can be expanded. They contains links to model objects to which you can apply the

basic commands of the context menu.
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By clicking  on the check result, you can call up a pop-up hint that allows you to correct detected

errors, save the result in the "* .tfqms" format, or close the check result.
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When you click Fix, the fixed results go to the Fixes folder.

Fixes. As it was said above, the fix results go to this folder. Successful fixes are flagged as .

Unsuccessful fixes are flagged as . The corresponding comment is displayed in the Information

field.

Each fix result can be expanded.



Tool Windows

3061

As well as the result of the check, the result of the fix can be saved in the "* .tfqms" format.

The script can also be run against the folder with T-FLEX CAD files, and they do not need to be open

in the system. In this case, the Results folder will contain the scan results of all files from the folder.
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Gray text means that the selected documents are not currently open. In order to open a linked

document, you should use the appropriate command.

In addition, you can fix, save, and close the selected scan results for each file.

When you click Fix, the corrected results of all files are placed in the Fixes folder.
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Script Editing

As mentioned earlier, the "* .tfqms" file contains the XML program code. You can edit this file in any

text editor.

The action is identified using a GUID.

Uid is generated independently using external sources.

LogicUid is hardcoded id. LogicUid can be copied from installation actions. If you create actions

yourself, then when registering the Uid action, you must do the following:
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It is possible to write your own actions in C#, as well as create a plugin or class library.

Find Command

Use the Find command for a quick command search.

Icon Ribbon

View > Window > Tool Windows > Find Command

Keyboard Textual Menu

- Customize > Tool Windows > Find Command

You should enter name of the command in the upper field and then the system will show the search

results.

The following commands are available in the context menu:

· Run command. Calls the selected command.
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· Add command to the ribbon. Adds a command to the active ribbon tab.

· Help. Calls Help window for the selected command.

· Search by synonym. When the flag is active, the search takes into account the names of the

commands accepted in other CAD systems.
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Document Protection

It is possible In T-FLEX CAD to set restrictions on working with documents. The developer of a

document or a set of documents (library) can set protection on them using this command and

subsequently, if necessary, change the parameters of this protection.

Topics in this section:

· Type Of Protection

· Type Of Access

· Document Protection

Type Of Protection

The following types of document protection can be set:

·  Not using HASP Plug. This type of protection is set for any user. This type of protection

allows, for example, setting the access only for "Preview" and "Edit variables". Then, any user

working with this will be able to open it view-only, without being capable of other actions,

such as editing or copying the information. This is convenient if a developer intends to pass

the document to the user solely for getting acquainted with the contents. In this case, the user

is not required to possess HASP protection key, since previewing a document can be

performed by the T-FLEX Viewer application that does not require a HASP protection key. 

·  Specific T-FLEX CAD HASP Plug or list of HASP Plugs. This type of protection is used in the

cases when the developer knows in advance the IDs of protection keys for T-FLEX CAD users

who will be working with the protected documents. Enter the IDs of the T-FLEX CAD

protection keys in the document protection parameters. The access to the protected document

will be granted on any computer with this particular T-FLEX CAD protection key installed. If

using the network key, then the access can be gained on any computer on the network.

·  Password with T-FLEX CAD HASP Plug. This type of protection is convenient if the developer

does not know in advance the IDs of T-FLEX CAD protection keys of the users who will be

working with the protected document. This type of protection is generally used when

distributing a document or library (a set of documents). By setting this type of protection on

the document once, you do not have to change the document protection for each new user.

After that, the user shall send his (her) T-FLEX CAD protection key ID to the developer of the

document. The developer uses the currently described command to generate a password

based on the protection key ID, and passes it to the user. When accessing a protected

document, the user must enter this password for gaining the access to the document.  

·  Another specific HASP Plug or list of HASP Plugs. A document protection can be set not only

by T-FLEX CAD HASP protection key, but also by any other HASP protection key. This type of

protection is similar to the type "Specific T-FLEX CAD HASP Plug or list of HASP Plugs";

however, in this case the developer needs to specify, among the parameters, a special

password for the protection key in use, which shall be obtained from the manufacturer of this

protection key.

·  Password with another HASP Plug. This protection type is similar to the type "Password with

T-FLEX CAD HASP Plug", except that it can be set on any HASP protection key, provided that

the specific password is known for accessing this protection key, as supplied by the key

manufacturer.
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Type Of Access

For each protection, its specific document access types can be set. The command supports the

following Access types:

· Change access. This access type is set for the user who will be allowed to modify or delete

protection types and access types of this protected document. Normally, this access type is set

by the document developer for himself.

· Edit. The user with this access type can open, edit and save a given document. Editing access

means full access except the ability to "Change access".

· Preview. This access type implies permission for opening, previewing and printing a protected

document. When opening such document in T-FLEX CAD, all commands that can modify it are

blocked.

· View as fragment. A document permitted to this access type can be opened from an assembly

document if it is used in this assembly as a fragment, a picture or an OLE object.

· Edit variables. This access type permits editing document variables and regenerating the

document with the set values. When setting this access type, additionally, the "Preview" and

"View as fragment" access is granted automatically.

· Insert as Fragment. The document with this type of access granted can be inserted as a

fragment, the chair or an OLE object into another document. If a document is assigned this

access type, then the "View as fragment" access is assigned automatically as well.

Document Protection

The document protection command can be called by one of the following means:

Icon Ribbon

File > Document Protection

Keyboard Textual Menu

<AF> File > Document Protection

Upon calling the command, a dialog will be displayed on the screen in which you can select one of

the following actions:
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To modify document protection, do the following steps:

1. By using the option "Set or Modify Access Rights for Documents", protect the intended documents

by the sets of access types.

2. In the case of "By password"-type protection, the developer shall use the option "Generate

Password for Document or Library" and generate the password for a user to access a document by

the key ID received from the user.

The option "Get Current HASP Plug ID" allows the user to check the key ID currently installed on his

machine. 

Setting access to documents

Upon selecting the option "Set or Modify Access Rights for Documents", the dialog will be launched

for selecting files subject to setting or modifying the access.  

Use the buttons [Add files…] and [Add Folder…] provided in the dialog for selecting the separate files

or specifying a folder whose files will be added to the list. 

To set protection on files, their version must be the same as the current T-FLEX CAD version. The

selected files will be added to the list. The icon before a file indicates its current state.

·   – Indicates the file in the format corresponding to the current version of T-FLEX CAD. In

this case, the file will be protected successfully.

·   – Indicates the file in the format of one of the previous versions of T-FLEX CAD. In this case,

the file needs to be resaved in the current version. This can be done by the converter of the

older versions of files. Without that, the file protection will not be set.

·   – The file is write-protected or used by another application. In this case, either clear the file

attribute "Read-only" or close this file in the other application, respectively. After that, retry

protecting the document.
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Node that in the cases when multiple documents (a library) need to be protected by the same

password, preferably select all files of this library at once. This is because each newly created

protection of the type "By password" is unique and requires generation and input of a unique

password.

Once you selected the desired files and pressed the button [Next], the dialog for modifying document

access will appear.

This dialog allows setting a new protection by the button [Add]. The button [Edit] serves for

modifying the type of an existing protection. Upon pressing one of these buttons, a dialog will be

displayed, offering selecting a protection type.
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In this dialog, select a protection type and define its name. If the protection type "Another specific

HASP Plug or list of HASP Plugs" or "Password with another HASP Plug" is being set, then for these

types enter a special password for access to the HASP protection key in the "Password" and

"Password 2" input boxes. This password is issued by the manufacturer of the HASP protection key. If

this is a network key, then fill in the entry "Net HASP program number". This information is also

distributed by the manufacturer of the protection keys.

When setting up document protection by key, it is possible to enter an alternative text password. This

password may be needed in the case when the protection key with administrator's privileges is lost

(that is, the protection key with the access type "Change access").

Once the new protection is set, its name will be displayed in the list of protections in the "Change

access rights for T-FLEX CAD documents" window.

 

For the created protection, define access types. Using the buttons [Add] or [Add Current HASP Plug

ID], enter the key ID, if this type of protection relies on key protection.

Let's review in details one of the ways of setting document protection. The diagrams above illustrate

two protections set to a document. The first protection, named "Administrator", has the type "Specific

T-FLEX CAD HASP Plug or list of HASP Plugs". The key ID was entered for it, and the "Change access"

access type set. This means that the user working with the protection key ID 72815448, can change

protection parameters of this document. The second protection, named "Bolt library", has the type
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"Password with T-FLEX CAD HASP Plug", with the access types set for modifying variables and

inserting fragment. For the user to gain access to a document with this protection, the following steps

are required:

1. The user for whom this protection was set needs to send the ID of his T-FLEX CAD protection key to

the developer.

2. The developer shall generate the password based on the received protection key ID, by using the

command "Generate Password for Document or Library" (see the description below) and send this

password back to the user. 

3. When accessing the document, the user shall enter this password in order to gain the access.

All protection settings can be saved in a file in a special format *.tfdat, using the button [Save

settings...]. A protection can be loaded into document from a *.tfdat file, using the button [Load

settings...]. This functionality may be helpful when one needs to add a document to an already

protected library (a set of documents). To do this, one can save the protection parameters from a

protected document, and then load those settings into the new document.

Upon pressing the [Finish] button, the protection will be set on the selected files.

Generating password for accessing document or Library

As was mentioned earlier, in the case of protecting a document by password with the protection key,

the developer shall supply the password for accessing the document to the user, that was generated

by the user's key ID. To do this, use the option "Generate Password for Document or Library". 
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In this dialog, select a document that is already protected. After selecting the document, in the

appropriate field enter the key ID, for which the document access password will be generated, and

press the button [Generate Password]. Since a document might contain multiple protections

simultaneously, the list of protections will be built, with an individual password generated for each of

them. The button [Copy Password to Clipboard] copies the selected password to the clipboard.

Getting ID of the current T-FLEX CAD protection key

If this option is selected in the "Document Protection T-FLEX CAD" dialog, the information will be

read from the current protection key. The acquired ID can be passed to the developer of the protected

document for generating the password.

 

Working with protected document

If a document was protected by a specific HASP protection key, then, when the user works with this

document (opening, inserting as a fragment, etc.), the current user's HASP Plug ID will be matched

against the ID of the key set in the document protection parameters. In the case of matching IDs, this

user will be allowed the access corresponding to the given protection. If the IDs do not match, the

access to the document will be banned.

If a document was protected by password with access key, then, when the user attempts to open the

document, one will be prompted to enter password.

The user shall enter the password in this dialog, that he received from the document developer. (See

"Generating password for access in document or Library").
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Once the password is entered, it can be automatically saved in a special file DocAccess.ini, created

into "Program" folder. When opening documents with this protection in the future, the password will

be taken from the file DocAccess.ini.

If the password is not known at the time of opening the document, one can set the option "Don't ask

password for this Library or document". Then, when using this document in the future, the password-

querying dialog will not be displayed, and the access protection will be set to "Not using HASP

Plug" (if this protection type was set in the document). Otherwise, if the protection type "Not using

HASP Plug" was not assigned to the document, the access to the document will be banned.

When working with a protected document, the access is set that is the most of the allowed accesses.

For example, if one protection grants document editing, and the other bans it, then editing document

is considered allowed. 

Modifying document protection

The procedure of modifying access to protected documents is similar to setting access to documents.

First, by using the option "Set or Modify Access Rights for Documents", select the protected

documents or a folder with protected documents. In the list of files, select a file, from which the

protection parameters will be read. If no such file is selected, then the protection parameters will be

read from the first file in the list.

Depending on what type of  "Change access" protection was used, the possibilities are as follows:

1. If the protection type was "Specific HASP Plug or list of HASP Plugs", then, upon matching Key IDs,

the access for change will be granted.

2. If the protection type was "Password with HASP Plug", then, upon pressing the button "Next", a

dialog will appear, requesting the password for this protection. Upon entering the password, the

access for changing the protection will be also granted. 

3. Otherwise, if the hardware key is missing that was used at the time of setting this protection, or the

password for accessing this protection was not entered, then you can press the button "Cancel". In this

case, an alternative access password will be asked. Upon entering the alternative password, the access

to changing the protection will be granted. Next, a dialog will be displayed with the protection

parameters set for the document. You can delete or change the parameters in this dialog.
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Macros

The design process in T-FLEX CAD is often associated with performing various kinds of calculations.

Some tasks can be solved using the variable editor. But the calculations in the variable editor are

limited. For example, you cannot use loops there. This narrows the range of tasks that could be solved

directly inside T-FLEX CAD.

Another problem that users face during the design process is spending a lot of time performing

repetitive actions. For example, you may need to create a set of layers in one drawing similar to the

set of layers in another drawing and place objects in the first drawing on the newly created layers. This

is quite a painstaking job, considering that the number of layers in a document can be large.

These problems can be easily solved using macros.

Topics in this section:

· Working with Macros

· Creating Macros, Macro Editor

· Compiling and Running Macros

· Creating Macros with Screen Forms

· Handling Document Events Using Macros

· Running Macros from User Dialog

Working with Macros

Macro in T-FLEX CAD is a program written in one of the programming languages ??using the Open API

TFLEX CAD functions. Using macros, you can automate the execution of various actions with T-FLEX

CAD documents, reducing the number of actions. performed by the user to a minimum.

The macro is executed as one command, i.e. once the macro is run, the entire set of actions inside it

(calculations, work with T-FLEX CAD objects, output of results, etc.) will be performed.

For a detailed description of the API functions, see the Open API help. Help can be called in the

Help drop-down menu in the upper right corner of T-FLEX CAD.

Macros can be used to work both with a 2D drawing and with elements of a 3D model. Let's give one

more example. In the process of creating assembly three-dimensional models, when connecting parts,

the user has to create grooves and holes in the attachment points and insert fragments of fasteners

with certain parameters. You can reduce the number of user actions by writing a special macro, when

you run it, the user will only need to select the LCS. And to create holes in the part, select the required

set of fasteners with certain parameters and insert it into the assembly will be a macro. In this case, a

large number of actions that the user had to perform manually is replaced by two: running a macro

and selecting an LCS.

These are just a few examples of where macros can be used.

Macros are created and stored inside T-FLEX CAD *.grb files. From a programming point of view, the

*.grb file in which macros are created is a Project. Each Project can contain an unlimited number of

macros.

To display the macros available for execution and actually launch these macros for execution, a

special service window Macros is used. In order for a macro to be available for use and displayed in

the Macros window, a document with it must be open in TFLEX CAD.

Storing a macro inside a specific *.grb file does not mean that this macro can only be used in this

document. Any macro from the Projects currently open in T-FLEX CAD can be run for execution

(regardless of which document is active in the T-FLEX CAD working window).
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You can make macros of any Project available for execution without opening the Project file in the T-

FLEX CAD window. To do this, just place the Project file in a special folder “… T-FLEX Parametric

CAD/Program/Macros/”. Macros from files in this folder are always available.

By default, the folder “…T-FLEX Parametric CAD/Program/Macros/” contains projects with

standard macros included in the delivery. The user can create his own library of macros by

simply placing the *.grb files with macros in the “/Program/Macros/” directory.

Creating Macros, Macro Editor

Macro Editor window

A special Macro Editor is intended for creating macros. It is an integrated macro development

environment in T-FLEX that contains a complete set of editing and debugging tools. You don't need

any other applications or programming systems to write a macro. All tools are located inside the

Macro Editor.

You can open the macro editor using the command:

Icon Ribbon

Tools > Tools > Macro Editor

Keyboard Textual Menu

<WM> Tools > Macro Editor

The macro editor works in parallel with the main T-FLEX CAD window. That is, when the macro

editor window is open, you can perform various actions in the window of the T-FLEX CAD

application itself (open/close documents, for example).

The figure below shows the basic tools of the Macro Editor.
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1. Properties window

2. Projects window

3. Standard toolbar

4. Textual menu

5. Project toolbar

6. Window tabs for open modules and forms

7. Debug toolbar

8. Tools window

9. Macro editor working window

10. Output window

11. Breakpoints window

You can control the display of service windows and toolbars of the macro editor using the View

textual menu.

The location of all service windows of the macro editor can be configured in the same way as it is

done with the service windows of the main T-FLEX CAD window. They can be “fixed” to the edges of

the working window, made “pop-up” or put into “floating” mode. In order to save screen space, part

of the windows can be combined in one group window. Unused service windows can be disabled.
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The Projects window displays the Projects available for editing. These are files opened in the T-FLEX

CAD window, as well as documents from the “…/Program/Macros” directory. Using this window, you

can view the structure of Projects, as well as perform various actions on their elements (create

modules/forms, open them for editing, etc.).

The Projects window of the macro editor and the Macros service window work synchronously. If

you close the Project file (document) in T-FLEX CAD, it will also be closed in the Projects

window of the macro editor. Similarly, after creating and debugging a macro in the Macro

Editor, it will appear in the Macros window of T-FLEX CAD.

Creation/editing of module codes and the contents of the Project forms is carried out in the working

window of the macro editor. This is the main window of the macro editor. The code of each module

or form of the Project opens in a separate window. To switch between the windows of modules and

forms, use the tabs of these windows, located in the upper part of the working window of the macro

editor. Code windows can be grouped vertically or horizontally.

The Properties and Tools windows are necessary for creating/editing graphic forms of Projects. The

Breakpoints and Output windows are used during compilation and debugging of the created module.

Project management. Project structure

The Projects window is used to manage Projects in the macro editor. When you open the macro

editor, this window displays all currently available Projects. These are all documents open in the

current T-FLEX CAD application, as well as Projects stored in a special folder “… T-FLEX Parametric

CAD/Program/Macros/”. Work with several Projects can go in parallel.

Each Project is displayed as a hierarchical structure that includes a set of modules, forms and links.



T-FLEX CAD 17 Help

3078

When writing macros in the T-FLEX CAD environment, modular programming is used. Modular

programming is the organization of a program as a collection of small independent blocks

called modules, the structure and behavior of which obeys certain rules.

Module is a program unit that includes various components (types, constants, variables, namespaces,

classes, procedures and functions). From the point of view of the program code, a macro is a

procedure - a part of a program designed to perform a separate specific task.

Form is a macro dialog box on which controls (text, buttons, editors, radio buttons, etc.) can be placed

to use when running a macro. Working with this window will be discussed in more detail later in the

Creating Macros with Screen Forms section.

References are needed in order to access the properties, methods and events of a specific object and

use this object when programming a macro. For example, to use T-FLEX CAD commands in the

Project, you must have a reference to TFlexAPI.dll. When creating a new project, basic links have

already been added to it for using system objects, as well as T-FLEX CAD data and objects.

A project can include any number of modules, forms, and references. In turn, each module of the

Project can contain any number of macros.

To avoid the problem of duplicate macro names in complex projects, namespaces can be used.
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A context menu with a set of special commands is available for any object of the Projects tree

(Project, module folder or separate module, form, referance). These commands allow you to rename

the selected Project, add a new module or form to it, etc. Some of these commands can also be called

from the Project textual menu and from the toolbar of the same name.
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Project creation. Project Properties

To create a new Project, open a new document in T-FLEX CAD. A new Project will automatically

appear in the Projects window in the macro editor. The structure of this Project will only contain links.

The default programming language for any new Project is C#. If you need to use another

programming language, you must specify this immediately after creating a new Project. Changing the

programming language of the Project after the creation of modules and forms leads to the

irrelevance of the code of already existing modules and forms. In such a situation, it will be necessary

to delete all modules and forms of the Project, and then create them anew.

The programming language of the Project (macro) is specified in the Project properties dialog:

Icon Ribbon

-

Keyboard Textual Menu

<WM> Project > Properties...

The Project properties dialog can also be called from the context menu of the Project in the

Projects window.

After calling this command, a dialog with the properties of the current Project will be displayed. The

name of the Project is shown in the Project field of this dialog. The Document field displays the name

of the T-FLEX CAD file that contains this Project.

In the Language drop-down list, you can select the programming language of this Project. At the

moment the choice of the following programming languages ??is possible: Visual Basic, C#.
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The additional parameter Debug Method is used only in macro debugging mode. If the debug mode

is not used, then the method can be omitted.

To set the debugged method, click the Edit button. As a result, a dialog with a list of methods of the

current project will be called. Working with this dialog is described in the Debugging, Compiling and

Running Macros section.

Creation of modules. Module code window

After choosing the programming language of the Project, you can create the necessary modules and

forms.

It is easy to create a new module in the Project. It is enough to place the cursor on the Modules

heading in the Project tree (Projects window), press  and call the Add command from the

appeared context menu. You can also call the command from the text menu or from the Macro Editor

Project toolbar:

Icon Ribbon

-

Keyboard Textual Menu

- Project > Add Module

As a result, a new window with the module code will open in the working window of the macro editor.

In this window, a part of the code will already be automatically created, references, namespace, class

and procedure are declared.

To create a simple macro, it is enough to write one procedure and compile the Project.

Note that by default a new Project contains only the standard links to the four libraries. If a macro will

use a library that is not referenced in the standard list, the user needs to add it to the list of references

himself. To do this, you can use the command:
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Icon Ribbon

-

Keyboard Textual Menu

- Project > Add Reference

This command can also be called from the context menu of the Projects window. To do this, select the

References section in the current Project tree and press . In the context menu that appears, the

Add command will be available.

Managing code windows of modules

The code of each module of the Project opens in a separate window. To switch between module

windows, use the tabs located in the upper part of the working window. Code windows can be

grouped vertically or horizontally.

The commands of the Window textual menu are used to control the windows of the modules.

Code editor settings

The module code window is a text editor with standard text editing capabilities (Copy, Paste, etc.).

Commands for working with text are available in the context menu, on the Standard toolbar and in

the Edit textual menu. In addition, in the settings dialog of the working window, you can set specific

settings for the code editor: automatic line numbering, automatic indentation, color highlighting of

various syntactic code units, etc.

Module code editor settings are set using the command:

View > Editor options...
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When you call the command, the code editor settings window opens.

The following parameters are set on the Editor tab:

Window settings group of parameters:

Vertical scrollbar and Horizontal scrollbar. These parameters control the display of scroll bars in code

windows;

Line Number. The parameter responsible for displaying the line numbers of the code;

Label Number. This parameter controls the display of the assigned tab labels and breakpoints on the

left side of the code windows;

Collapsible Nodes. Show/hide nodes that allow you to collapse parts of the code.

Auto identation. If this check box is selected, each new line of code that is created is automatically

assigned the same indentation as the previous line;

Virtual space. When this option is enabled, the cursor can be placed anywhere in the code window.

When disabled, the cursor is positioned only within the existing text;

Syntax Colorization. The parameter allows highlighting different syntax structures of the code in

different colors. The color scheme of the selection is set on the Syntax Color tab of this dialog;

The Tabs > Tab size parameter sets the length of the tab characters used to create automatic

indentation of lines of code. The unit for specifying the length is the width of the space character;

The Overwrite Caret parameter group determines the type of the cursor in the text replacement

mode.

The last parameter of this tab - Automatic reload of externally modified files - is used in situations

when a Project document is opened simultaneously in several T-FLEX CAD applications. If the

checkbox is selected, the Project will be automatically synchronized in all applications.

On the other two tabs of the settings dialog - the Editor Font tab and the Syntax Color tab - you can

set the parameters of the font used to display the code, and the parameters of the color highlighting

of various syntax structures of the code.
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Using bookmarks

For the convenience of working with large code in the code editor window, you can assign bookmarks

(labels) to individual lines of code. Bookmarks allow you to quickly move in the code window from

one marked line of code to the next.

To add a bookmark, place the cursor on the required line of code and call the Toggle Bookmark

command:

Icon Ribbon

-

Keyboard Textual Menu

<Ctrl+F2>- Edit > Bookmarks > Toggle Bookmark

After calling the command, a bookmark label will appear in the code window to the left of the

selected line (if the label area in the code window is enabled).

After “placing” the bookmarks, it will be possible to quickly move through the text of the module

using the commands:
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Icon Ribbon

-

Keyboard Textual Menu

<F2> Edit > Bookmarks > Next Bookmark

Icon Ribbon

-

Keyboard Textual Menu

<Shift+F2> Edit > Bookmarks > Prev Bookmark

The label of the active bookmark (that is, the bookmark on which the cursor is currently located) is

highlighted in color.

Deleting a bookmark is performed by calling the Toggle Bookmark command again for the marked

line of code.

Macros example 1

As an example, let's create a macro that will automatically build a construction line - a circle and line

text, fixed to a node and this circle.

To do this, create a new 2D document in T-FLEX CAD. In the macro editor, select its Project in the

project tree (Project window) and create a new module in it. In the module code window, paste the

following text.

// Declaring references
using System;
using TFlex;
using TFlex.Model;
using TFlex.Model.Model2D;

// Declaring class
public class NewMacroClass
{

// Declaring procedure (macro name)
public static void CreateText()
{

//Creating document object – the currently active document
Document document = TFlex.Application.ActiveDocument;

// Opening block of document changes
document.BeginChanges("Creating text");

// Creating text object– string text
LineText text = new LineText(document);

// Creating free nodes in the document, with the coordinates (150,100) and (150,140) 
FreeNode node1 = new FreeNode(document,150,100);
FreeNode node2 = new FreeNode(document,150,140);

// Creating circle by the center and a point to pass through
CircleConstruction circle = new CircleConstruction(document);
circle.SetCenterAndNode(node1,node2);

// Defining object text parameters
text = new LineText(document);
FontStyle style = text.FontStyle;
style.FontName = "Arial";
style.Bold = true;
style.Italic = true;



T-FLEX CAD 17 Help

3086

text.Color = 1;
text.Node = node2;
text.Circle = circle;
text.TextValue = "Text on circle";
text.HorizontalAlignment = TextHorizontalAlignment.Center;

// Closing block of document changes
document.EndChanges();

}
}

After writing the macro code, you need to compile its Project.

Debugging, Compiling and Running Macros

Compiling project

To start compilation, use the following option:

Icon Ribbon

-

Keyboard Textual Menu

<Ctrl+F7> Project > Compile

Compiling the project is a necessary action before running the macro for execution. During

compilation, the system analyzes the macro code and identifies errors. Any errors found are displayed

in the Output window.

Compilation errors occur when the system cannot interpret the entered text. These errors can be

caused by incorrect syntax of the statement or by setting the wrong method or property.

Output window

The Output window is located at the bottom of the macro editor. It serves for displaying messages

about the current state of the project. Errors and warnings resulting from project compilation are

displayed in this window.

An error message displayed in this window contains information about the error location in the code

window (line and column number) and the error number.

To jump to an error location in the code window, you can either double-click  or call the

option Go To Error from the context menu accessible by right clicking .

The error type and information about the error can be found in the Microsoft Developer Network

(MSDN) application development guide by the code displayed within the error message in the Output

window.
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Upon a successful project compilation, the macro will be added into T-FLEX CAD Macros window and

can be executed thereafter.

The figure below shows the result of running a macro that creates a construction line - a circle and line

text fixed to this circle. The code for this macro was given above when describing the module code

window.

Macros debugging. Breakpoints

If, after running the macro for execution, it becomes obvious that the macro does not work correctly,

you can use the macro debug mode to detect code errors.

In debug mode, the macro is compiled (if necessary) and then launched for execution with the

possibility of stopping at intermediate points - breakpoints. At the moment of stopping, you can

check the current states of the macro objects using the Quick Watch command.

Setting up breakpoints

You can create a breakpoint using the Breakpoint command:
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Icon Ribbon

-

Keyboard Textual Menu

<F9> Debug > Breakpoint

The breakpoint is assigned to the line of code where the cursor was at the time the command was

invoked. That is, to create a breakpoint, you need to position the cursor on the line of code before

which you need to stop the execution of the macro, and press <F9> (or call the command in another

way). The breakpoint mark  will appear in the label area to the left of the selected line of code, and

the line itself will be highlighted. To create another breakpoint, you need to position the cursor on the

next line and call the Breakpoint command again, etc.

A list of all assigned breakpoints is displayed in the Breakpoints window.

To delete a breakpoint, just position the cursor on the line with the breakpoint and re-call the

command - Breakpoint.

Running macros

You can start debugging a macro using the following command:
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Icon Ribbon

-

Keyboard Textual Menu

<F5> Debug > Start Debug

Since a module can contain multiple macros (procedures), you need to tell the system which

procedure to run. To do this, you need to select the default method (macro) in the command Project

Properties.

If the method was not specified initially, the Choose Macro dialog appears, letting you to select the

method to be run by default. In this dialog, you can select any desired method from the list provided

for the current project, or click the button Set Manually and type in the method manually in the

coming up Set Macro dialog: defining the namespace, the class and the name of the procedure to be

run.

After choosing a method, it will be launched. If the module code has been changed since the last

compilation, the system will offer to recompile the project before starting the debug mode.

Working in debug mode

Once started, the macro runs until the first breakpoint in the code and stops. The execution of the

macro is passed to the macro editor in the line with the code going up to the breakpoint. The main T-

FLEX CAD window becomes inactive. At this moment, you can call the Quick Watch command:
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Icon Ribbon

-

Keyboard Textual Menu

<Ctrl+Alt+Q> Debug > Quick Watch

This command allows you to check the value of any code object at the time of the macro stop. An

object can be either system type (string, integer, real, etc.) or user-defined.

You can resume the execution of the macro (until the next breakpoint) by calling the Start Debug

command again. To fully execute the macro, this command will have to be called as many times as

there are breakpoints in the code.

To quickly terminate the macro (without stopping at breakpoints), use the Stop Debug command:

Icon Ribbon

-

Keyboard Textual Menu

- Debug > Stop Debug

Creating Macros with Screen Forms

Sometimes it is necessary to provide the user with the ability to set some parameters during the

execution of a macro using a specially created graphical dialog. For these purposes, the Macro Editor

has the ability to create screen forms with controls. Below we will consider the tools of the Macro

Editor, which allow you to create macros with screen forms.

Form creation

To create a form in the current Project, use the command:

Icon Ribbon

-

Keyboard Textual Menu

- Project > Add Form

The command can also be called from the Project window. To do this, place the cursor on the heading

of the Forms section in the tree of the current Project and press . The Add command will be

available in the opened context menu.

After adding a new form to the Project, a new form window will automatically open in the working

window of the macro editor. It contains an empty form layout, ready to be filled with controls. The

title of the window contains the name of the form with a qualification in brackets - “(Design)”.

In addition, when the form window is opened, the Properties and Tools service windows are

automatically opened.
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When you add a form to the Project, two new links are automatically added to the list of links:

“Systems.Windows.Form” and “Systems.Drawing”.

Tools window

The Tools window opens automatically when you create a new shape. You can independently call the

Tools window from the textual menu of the macro editor: View > Tools.
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The Tools window contains a set of controls that can be placed on a form. Elements in this window

appear only when the form is active. Otherwise, the window is empty.

Properties windows

The window can be called from the textual menu of the macro editor: View > Properties It is intended

for viewing and setting properties and events (methods) for the form and elements located in the

form. This window remains empty until a form or an element on the form is selected.

Control properties are parameters that define the characteristics of an object (name, color, position,

etc.).

Control events are actions performed on a control object, such as clicking a button control. During the

execution of the program (macro), the event of the control is associated with the execution of certain

commands. For example, the event of clicking on the Button control can be associated with the

creation of an object in T-FLEX CAD.

In the upper part of the Properties window there is a list with form elements. To view and change the

properties of a form element, select it in the list or use  to select an element on the screen form

itself.

The Properties window works in two modes:

· If the Properties  option is active on the window toolbar, the properties of the element will

be displayed in the window.

· If the Events  option is active, then the events are displayed in the window.

The Properties window is divided into two parts. The left column displays the object property names.

The right column displays the property values.

If the window is in the event display mode, the right column of the window displays events that are

possible for this type of element. In the left column, the names of the functions that are currently

being used for this item and event.

Using the  and  buttons, you can sort the list of object properties either alphabetically or by

type, respectively.
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1. Property names

2. Property values

3. Event names

4. Event procedure names

5. Property description

6. Event description

7. Element list

For some properties, strictly defined values can be set. In this case, the field for entering a value will be

a combo box, when expanded, the property values that are allowed for selection are displayed.

Placement of controls on the form. Setting item parameters

To place controls on a form, you need to do the following:

· Select the form to which you want to add the control.

· Select the required element in the Tools window.

Then you can proceed in two ways. The first way is to press  anywhere on the form. This adds the

selected standard size control to the form. You can then drag the control to the desired location on

the form and resize it.

The second way is to specify by two clicks  the position of the opposite diagonal corners of the

control rectangle. This immediately sets the position and size of the control.
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You can set the parameters for the controls applied to the form using the Properties window. You can

select the editable element directly in this window (in the drop-down list above) or in the form using

. After selecting an element, its parameters will be reflected in the Properties window.

If necessary, you can view the automatically generated code for creating a graphic image of the form.

This can be done using the Open Code (Design) command in the context menu for this form in the

Project window. The form design code window also opens in the working window of the macro

editor. The title of the window includes the name of the form with a qualification in brackets -

“(Design)”.

The name of the form design code window is the same as the name of the form window. They

differ in icons:  - at the form window,  - at the form design code window.

After placing all the necessary form elements, you can proceed to setting the form code.

Writing Procedures for Controls in Forms

After you place the controls on your forms, you need to associate those controls with code.

The form code is created in a separate window, similar to the module code window. The title of the

window contains the name of the form with a qualification in brackets - “(Code)”.

This window can be invoked in three ways:

·  In the Projects window, from the context menu for the selected form, call the Open Code

command. This will open a window with the form's code, where you can add event

procedures for controls in this form.

· By calling the Open Code command from the context menu for any form control.
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· By  on a control on a form. In this case, a procedure for processing the control

method for the corresponding element will be automatically created in the window that

opens. Events for each control are set by default.

You can switch between the form window and the code window either using the context menu

commands for this form (Open Design, Open Code), or using the corresponding tabs located at the

top of the working window of the macro editor.

Like the module code windows, the form code window is a text editor. By default, the form code

window contains only the form initialization routine.

   

The form code usually consists of a form initialization procedure (it is created automatically when the

form code window is first opened) and event handling procedures for form controls.

To create an event handling procedure for a form object, select the required element, switch the

Properties window to the Events mode, select the required event in the list and press . An

empty procedure for handling the selected event for this form element is automatically added to the

code window. The body of the procedure is empty, it is filled in by the user.

For some controls, you can also use simply double-clicking  on an item in the form. This adds a

procedure for handling the main event of this control to the form code.

An example of macro with display form

Consider an example of a macro written in the Visual Basic programming language. When executing a

macro, a line is created between two 2D nodes. The coordinates of these nodes are set in the dialog.

Initially, in the “CreateLine.grb” project, the “LineForm” form was created and controls are placed on it,

in which the coordinates of 2D nodes will be set. A control element has been added to the form - a

button, when clicked, a function will be launched that creates 2D nodes and a line between them.
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After placing the controls on the form, you need to create a handling of the event of clicking on the

control - the button. To do this, select this element in the form, go to the Properties window and set

the event mode  in this window. In the right column of the “Click” event, click , this will create

the “button1_Click” procedure. The same effect could be achieved by pressing  on the button

control.
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In the form code window that opens, you need to write the “button1_Click” procedure.

The figure below shows the form code window with the “button1_Click” function, in which the

variables “X1”, “Y1”, “X2” and “Y2” are assigned values from the controls - editors textBox1, textBox2,

textBox3 and textBox4, and the function is called (macro) "CreateLine".

After that, create a module in the Project. The module code will consist of two functions. The

“ShowDialog” function (a standard development environment function) will display the screen form

after running the macro. The “CreateLine” function, which has been defined, creates 2D nodes whose
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coordinates are the values specified by the user through the “LineForm” form dialog, and the line

between these nodes. The code for this module is shown below.

'Declaring references
Imports System
Imports TFlex
Imports TFlex.Model
Imports TFlex.Model.Model2D

'Declaring namespace
Namespace NewMacroNamespace

'Declaring class
Public Class NewMacroClass

'The function, which will display the screen form «form» when executed
Public Shared Sub ShowDialog()

Dim form As LineForm
form = new LineForm()
form.ShowDialog()

End Sub
'The function with parameters (the macro), which creates a graphic line between two 2D
nodes.
'Coordinates of those nodes are input in the function as the dialog parameters 

Public Shared Sub CreateLine(ByVal NodeX1 As String, ByVal NodeY1 As String,
                                        ByVal NodeX2 As String, ByVal NodeY2 As String)

Dim document As Document
document = TFlex.Application.ActiveDocument

'Opening block of documents changes
document.BeginChanges("Creating graphic lines")

'Creating graphic line and 2D free node objects
Dim line As ConstructionOutline 
Dim node1 As FreeNode
Dim node2 As FreeNode

Dim X_1, Y_1, X_2, Y_2 As Double

X_1 = System.Convert.ToDouble(NodeX1)
Y_1 = System.Convert.ToDouble(NodeY1)
X_2 = System.Convert.ToDouble(NodeX2)
Y_2 = System.Convert.ToDouble(NodeY2)

'Creating 2D free nodes
node1 = new FreeNode(document,new Parameter(X_1),new Parameter(Y_1 ))
node2 = new FreeNode(document,new Parameter(X_2),new Parameter(Y_2 ))

'Creating graphic line between two nodes
line = new ConstructionOutline(document,node1,node2)

'Closing block of document changes
document.EndChanges()

End Sub

End Class

End Namespace

After running the macro in T-FLEX CAD, the “LineForm” dialog will be called. When you click on the

control - the OK button, a segment between two nodes will be drawn in the drawing field.
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Handling Document Events Using Macros

Macros can be executed not only at the user's command, but also when any document event occurs.

To set the connection of document events with macros, use the Message Handlers command dialog:

Icon Ribbon

-

Keyboard Textual Menu

- Project > Message Handlers

When this command is called, the Message Handlers dialog opens. This dialog presents events, with

the occurrence of which you can associate the execution of the macro:

Closing Document - an event that occurs before the document is closed;

Document Full Regenerated - an event that occurs after the document is recalculated;

Document Open - an event that occurs after opening a document;

Document Saved - an event that occurs after the document is saved;
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Dynamic Analysis Simulation After Step - an event that occurs after the execution of a step for

solving a dynamic analysis study;

Dynamic Analysis Simulation Before Step - an event that occurs before the execution of a step in

solving a dynamic analysis study;

Dynamic Analysis Simulation Finished - an event that occurs after the end of the solution to the

dynamic analysis study;

Dynamic Analysis Simulation Started - an event that occurs after the start of solving a dynamic

analysis study;

New Document Created - an event that occurs after the creation of a new document;

Saving Document - an event that occurs before the document is saved;

View Activated - an event that occurs after activation of a 2D or 3D document window;

View Deactivated - an event that occurs after the deactivation of the document view.

To set a handler for any event, select the required event in the list and click the Set button or .

A dialog with a list of macros for this document will appear on the screen.

Running Macros from User Dialog

As mentioned above, a macro can be launched for execution from the Macros window, from the

macro editor in debug mode, or automatically when any document event occurs. However, there is

another way to run a macro. This can be done from a custom document dialog by assigning a macro

launch function to a button control.
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More details about Button control actions can be found in the Control Elements section.
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